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Introduction to Installing Thermo-Calc

This guide is NOT applicable to installations of the Free Educational Package, 
which does not require a license file and is not currently available with the new 
license system. Installation instructions are available separately after you 
request the free version from this page on our website.

In this section:

Key to Using this Guide 4

Typographical Conventions and Terminology 6

About the Thermo-Calc Installed Components 9

System Requirements 11

Platforms Tested and SDK Availability 12

License Activation and Installation Types 13

https://thermocalc.com/academia/free-educational-package/#download
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Key to Using this Guide

Starting with the 2025a release, Thermo-Calc Software is migrating to a new 
License Entitlement System. The new license system greatly simplifies the 
licensing process and brings many advantages to our customers. Licenses will 
now be handled through a login (where user credentials are entered), rather 
than downloading and storing license files on a computer. The majority of users 
will be migrated to this new system. However, a few users will continue to use 
the old license file system for the short term. For more information about the 
changes and migration plan, read the latest Release News on our website. 

In this guide learn how to: 

 l Download and install the software on Windows, macOS, and Linux operating 
systems. This is applicable to new users and existing users who are installing a new or 
updated version of Thermo-Calc, where the new version is installed next to the old 
version.

 l Activate your license using user credentials or a license file/license server. 
 l Locate various items in the default installation directories (i.e. databases, Database 

Checker, TDB Editor, materials, custom Property Models).
 l Install selected components using the custom installation option.
 l Install the TC-Python and TC-Toolbox for MATLAB® SDKs. 
 l Work with existing installations, i.e. add new components, update or uninstall the 

software.
 l Deactivate online or offline user credentials licenses.
 l Install silently over a network (unattended installations) 
 l Troubleshoot to solve common installation problems related to the license 

file/license server activation type.

This guide is NOT applicable to installations of the Free Educational Package, 
which does not require a license file and is not currently available with the new 
license system. Installation instructions are available separately after you 
request the free version from this page on our website.

Installation instructions are generally organized based on the license activation type: 

https://thermocalc.com/news-category/release-news/
https://thermocalc.com/academia/free-educational-package/#download
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 l User credentials: The new License Entitlement System, where  a user name and 
password are entered after the installation is complete. This new system is available 
for standalone (SUNLL) and floating network licenses (NWL) (i.e. on a Cloud Hosted 
License Server), but not currently for On Premise License Servers.

 l License file: The soon-to-be phased out license system  where the license file is 
installed on either a standalone computer or a network server. This includes On 
Premise License Server installations involving the Sentinel license management 
software. 

Visit our website to watch the new installation video showing how to install with 
user credentials (in both online and offline mode), which will replace the license 
files. The video library also includes the installation videos using the old method 
(license files) and other installations such as for TC-Python.

This guide is available in PDF format: (1) On the website or (2) when in 
Thermo-Calc go to Help → Manuals Folder → Installation.

https://thermocalc.com/support/video-tutorials/installation/
https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
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Typographical Conventions and Terminology

Typographical Conventions

Convention/Name Definition

User credentials

This indicates that the information is applicable to the new 
license entitlement system. User credentials are a type of license 
activation type where a user name and password are entered 
after installation and when Thermo-Calc is first launched. The 
information is managed via an online portal system as well as 
from within Thermo-Calc. 

License file 

This indicates details related to the Thermo-Calc license file, 
which contains the license keys and is installed on either a 
standalone computer or a network server. This is a license 
activation type that is being replaced by user credentials.

Important Provides important information and indicates that more detail is 
located in the linked or named topic.

Note The information can be of use to you. It is recommended that 
you read the text or follow the link.

Forward arrow →
The forward arrow symbol → instructs you to select a series of menu items in a 
specific order. For example, File → Save Project is equivalent to: From the File 
menu, select Save Project.

Boldface font
A boldface font indicates that the given word(s) are shown that way in on a 
toolbar button or as a menu selection. For example, if you are told to select a 
menu item in a particular order, such as File → Save Project, or to click Save.

Italic font An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or elsewhere in the guide.

code and code bold A code font indicates you are to make a keyboard entry. It also shows a 
programming code or code examples. The code bold font highlights the entry.
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Installation Terminology

Term Definition

client*
A computer without a license file of its own but connected through the network to a 
computer with the license information. The client receives a license token from the 
computer where the license management software is installed.

consolidated network*

A type of network installation where the Thermo-Calc software and a Thermo-Calc 
licensing software are installed on a single server computer. This allows all computers 
in the network to access both the software and a license on the server via a client 
installation.

distributed network*

A type of network installation where the Thermo-Calc software is installed on one 
server computer in a network and the Thermo-Calc licensing software is installed on a 
different computer. After a thin client installation, all computers in the network can 
access both the software and the network license key via the server.

host ID* The MAC address on the computer that a license is locked to. 

license file*
The file (called lservrc) that contains all the purchased license keys. It is issued by 
Thermo-Calc Software, usually by email. This is a license activation type that is being 
replaced by user credentials. 

license key* The information contained in the license file that represents the products purchased 
and which is then authorized for installation.

license management 
software (see Sentinel 
RMS License Software)*

The Thermo-Calc license management software. When working in Windows it is called 
License Manager (full name is Sentinel RMS License Manager by SafeNet) and on 
Linux it is called License Server (full name is Sentinel License Sever by Safenet). 

license server*

The use of the term license server (lower case letters) is reserved for use for scripts 
and option files (for example, in an Unattended or Silent Network Client Installations 
(License File)). For the purposes of the step-by-step instructions it is not used to refer 
to the type of network installation that runs the license management program. See 
Sentinel RMS Software below. 

Network Floating License 
(NWL)

A license type available and activated using user credentials. A NWL can only be used 
on one specific computer that hosts the licensing software. It is still referred to as an 
NWL license but is different than the one used with license file activations.

The software may be used on the number of sites you have paid for and by the 
number of persons you have paid for on any number of network connected 
computers.

Network License (NWL)*

The license type used with the Sentinel RMS licensing software. The NWL can only be 
used on one specific computer that hosts the licensing software. This restricts license 
usage to a certain subnet or subnets.

The software may be used on the number of sites you have paid for and by the 
number of persons you have paid for on any number of network connected 
computers.
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Term Definition

Operating system The operating system is named when the information is specific to a Windows, 
macOS, or Linux machine.  

Sentinel RMS License 
Software*

The Thermo-Calc license management software that supplies the client computers in 
your network with license tokens when it runs the Thermo-Calc software. This is 
available for both Windows (called the License Manager) and Linux (called the License 
Server, but not to be confused with license server in lower case letters reserved for 
scripts).

Single User Node Locked 
License (SUNLL)

A unique license that can be used for one designated computer at one designated 
site. It cannot be copied or moved outside the site. If the software is installed on a 
portable computer, it can be temporarily used off-site. 

For license file activation types, a file is automatically installed on the computer, upon 
activation, and the license can be used without network access (to the License 
Server).

standalone computer A computer which uses a SUNLL license type. 

TC-Toolbox The short name for the  TC-Toolbox for MATLAB® SDK. 

thin client*
An installation where the software is installed on a file server but is run from a client 
computer. The licensing software may be installed on the file server (consolidated 
network installation) or on a different computer (distributed network installation).

user credentials
A type of license activation type where user credentials (a user name and password) 
are entered after installation and when Thermo-Calc is first launched. The information 
is managed via an online portal system as well as from within Thermo-Calc. 

XQuartz An open-source X Windows System, which is required to run Thermo-Calc on a Mac.

* A term only applicable to license files or license server systems, which are being replaced by the user credentials 
licensing.
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About the Thermo-Calc Installed Components

What is Installed?

At the start of the installation process, you choose the license activation type (license file, 
licensing server, or user credentials) and whether to install all features. 

The following components are installed when you choose any of the options, Full 
Standalone, Full Network Client, or User credentials. If you want to exclude a component 
(perhaps one of the SDKs), then click the Custom button instead (see below).

A full installation (Install all features) means that all listed feature components are installed 
but the availability of the individual components is based on the license you have.    This is 
also applicable to the user credentials option, as well as databases and software 
development kits (SDKs).  

Thermo-Calc

The Thermo-Calc software "component" includes several add-on features and capabilities 
that are packaged with the software and included with a full standalone, network client, or 
user credentials type installation. For example, there are the specialized add-on products, 
such as the Diffusion Module (DICTRA), Precipitation Module (TC-PRISMA), Process 
Metallurgy Module, and Additive Manufacturing (AM) Module. There are also material 
specific Property Model libraries included such as the Steel Model Library, Nickel Model 
Library, etc. For some of these specialized features, demonstration (demo) versions and/or 
examples are available for all users but advanced features are only available with a license. 

Databases

All the latest databases are installed. As with the software features, availability of a specific 
database in the software itself is based on license. However, several demonstration 
(demo) databases are included and available to all users. 



Thermo-Calc Documentation Set

Installation Guide ǀ 10 of 199

 Software Development Kits (SDKs) 

When the Full Standalone, Full Network Client, or User credentials option is chosen, it also 
installs the software development kits (SDKs).

 l TC-Python: The TC-Python program is installed when the Full Standalone, Full 
Network Client, or User credentials option is chosen, but there are additional steps 
required to complete the installation as described in the TC-Python Installation 
Guide, which is available in this guide or as a standalone guide.

 l TC-Toolbox for MATLAB®:  If a MATLAB® installation on your computer is found 
during this installation process,  the TC-Toolbox for MATLAB® (available only for 
Windows) is automatically installed, otherwise you may need to do a manual 
installation. For details, see the section related to TC-Toolbox for MATLAB Installation 
Guide®.

 l TQ-Interface: The TQ-Interface program is installed when the Full Standalone, Full 
Network Client, or User credentials option is chosen. However, it is currently only 
available with the license file activation type.  For more information about the 
changes and migration plan, read the latest Release News on our website. 

What is the Custom Option?

During the installation process, there is some flexibility to choose what to include or exclude 
with the installation by choosing the Custom option. This is primarily to the level of being 
able to choose the SDKs or to exclude all databases or Thermo-Calc itself. That is, you cannot 
choose specific Thermo-Calc features or databases as these are controlled by the license and 
not the installation procedure. 

https://thermocalc.com/news-category/release-news/
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System Requirements

General

About the Thermo-Calc Installed Components

A full list of system requirements and program availability is found on the Thermo-Calc 
website. You can also see the roadmap for platform support to use for planning purposes. 

Network Client Installations: Sentinel RMS License Software

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

Network client installations using the Sentinel RMS license management 
software require the use of the most recent version, 9.7.

For details of the system requirements to install Sentinel RMS, see Windows: About 
Installing the License Manager and Linux: About Installing the License Server.

For macOS, the Sentinel RMS License software is installed on a Windows  or 
Linux  computer server where the Thermo-Calc license file must also be located. 

https://thermocalc.com/system-requirements/
https://thermocalc.com/roadmap-for-platform-support/
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Platforms Tested and SDK Availability

A full list of system requirements and program availability is found on the Thermo-Calc 
website. You can also see the roadmap for platform support to use for planning purposes. 

Platforms Tested

Thermo-Calc and its components are tested on these platforms for Thermo-Calc 2025a:

Windows macOS1 Linux2

 l Windows 10 

 l Windows 11

 l Sequoia (15.1)

 l Sonoma 14.x

 l Red Hat 9

 l OpenSUSE 15.6 (Leap)

 l Ubuntu 24.04 
(Noble Numbat)

 l Ubuntu 22.04 (Jammy 
Jellyfish)

1 Works with Rosetta 2 emulation on all M1, M2 and M3 Macs (2020, 2022, 2023).

2 Thermo-Calc Software cannot guarantee full functionality if the software is installed on other Linux distributions.

SDK Availability by Platform

The software development kits (SDKs) are available as follows for the indicated platforms:

SDK Windows macOS Linux

TC-Python x x x

TQ-Interface x not available x

TC-Toolbox for MATLAB® x not available not available

https://thermocalc.com/system-requirements/
https://thermocalc.com/roadmap-for-platform-support/
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License Activation and Installation Types

There are two license activation types available starting with Thermo-Calc 
2025a: One using a license file that is installed on your computer (this also 
includes the different network installation types using  Sentinel License 
Management Software), and the new type where user credentials (user name 
and password) are entered after installation and when you first open (launch) 
Thermo-Calc.  

This guide is NOT applicable to installations of the Free Educational Package, 
which does not require a license file and is not currently available with the new 
license system. Installation instructions are available separately after you 
request the free version from this page on our website.

Installation procedures are based on the license types, license activation types, installation 
type, and the operating system. 

User Credentials Activations

About User Credentials License Activations

License type Installation Type Windows macOS Linux 

Single User Node 
Locked License 
(SUNLL)

Standalone (aka 
Single User) Yes Yes Yes

Floating Network 
License (NWL)

Cloud Hosted 
License Server Yes Yes Yes

On Premise License 
Server* No No No

* A few users will continue to use the  License Management Software system for the short term until the change over 
is complete and implemented in a future release. Until then, users who require an On Premise License Server need to 
use License File and License Server Activations, see the next section.  For more information about the changes and 
migration plan, read the latest Release News on our website. 

https://thermocalc.com/academia/free-educational-package/#download
https://thermocalc.com/news-category/release-news/


Thermo-Calc Documentation Set

Installation Guide ǀ 14 of 199

License File and License Server Activations

For macOS, the Sentinel RMS License software is installed on a Windows  or 
Linux  computer server where the Thermo-Calc license file must also be located. 

License type Installation Type Windows macOS Linux 

Single User Node Locked 
License (SUNLL) Standalone Yes Yes Yes

Network License (NWL)

Consolidated network Yes No Yes

Distributed network Yes No Yes

License installations on a server 
network Yes Yes Yes

Sentinel RMS License Management Software: Use Current Version

The most recent version (9.7) of the Sentinel RMS License Manager (Windows) and License 
Server (Linux) is included with the network license Thermo-Calc software download. 

However, due to security issues reported by the vendor, it is important that previous 
network license installations of the Sentinel RMS are upgraded to this version number. 

For more information for your operating system, see Windows: About Installing the License 
Manager and Linux: About Installing the License Server
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User Credential License Activation Installations

Starting with the 2025a release, Thermo-Calc Software is migrating to a new 
License Entitlement System. The new license system greatly simplifies the 
licensing process and brings many advantages to our customers. Licenses will 
now be handled through a login (where user credentials are entered), rather 
than downloading and storing license files on a computer. The majority of users 
will be migrated to this new system. However, a few users will continue to use 
the old license file system for the short term. For more information about the 
changes and migration plan, read the latest Release News on our website. 

In this section:

About User Credentials License Activations 16

Windows® User Credentials Installations 19

macOS® User Credentials Installations 26

Linux User Credentials Installations 33

Custom User Credentials Installations 40

Unattended or Silent Network Installations (User Credentials) 48

Deactivating Online or Offline Licenses 50

https://thermocalc.com/news-category/release-news/
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About User Credentials License Activations

All users are being migrated to this new user credentials license activation type. 
For this type of activation, the information is managed via an online portal 
system as well as accessible from within Thermo-Calc. Customers are being 
contacted directly by email to provide the necessary information to install and 
use your purchased products. During the transition from using the old license 
file activations, some users may need to contact support for assistance. 

Visit our website to watch the new installation video showing how to install with 
user credentials (in both online and offline mode), which will replace the license 
files. The video library also includes the installation videos using the old method 
(license files) and other installations such as for TC-Python.

What is Not Available in the New License System as of Thermo-Calc 
2025a

 l TQ-Interface
 l Floating licenses for TC-Python and TC-Toolbox for MATLAB®
 l Free Educational Package installations
 l On Premise License Server installations

With respect to downloading and installing the software, there are subtle 
differences based on operating system (Windows, macOS, or Linux). One 
benefit of the new user credentials license activation type is that its use is 
independent of OS and the activation steps are the same across platforms. 

Although many steps are the same, separate instructions are available for all 
the OS and for custom single user installations: Windows® User Credentials 
Installations, macOS® User Credentials Installations, or Linux User Credentials 
Installations. There are also instructions for Custom User Credentials 
Installations. 

https://thermocalc.com/support/video-tutorials/installation/
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Viewing Product License Information

After you have installed Thermo-Calc and activated your license by entering your user 
credentials, you can view the license information by selecting Help →  Show License Info. 

In the License status window, it is an overview of your license as well as where you can 
check for updates, sign out or deactivate the license, and review its status and when it 
expires. 

Checking for  License Updates

After you have installed Thermo-Calc and activated your license by entering your user 
credentials, you can remotely check to see if your product license is up-to-date. 

Internet access is required. If you are working with an offline license, this 
option is therefore not available. 

 1. Open Thermo-Calc.

 2. Select Help →  Show License Info.

 3. In the License status window, click Check for an updated license. 

 4. The program synchronizes with the license software management database and 
updates the licenses accordingly.

TC-Python Additional License Activation Steps

When you also have a license for TC-Python, there are additional steps required to complete 
the activation. This is covered in the sections: 
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 l TC-Python: Configuring a License
 l TC-Python: Setting Environment Variables

TC-Toolbox Additional License Activation Steps

When you also have a license for TC-Toolbox for MATLAB®, there are additional steps 
required to complete the activation. This is covered in the section: 

 l TC-Toolbox: Configuring a License

Reminder that TC-Toolbox is not available with macOS or Linux installations.
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Windows® User Credentials Installations

There are two license activation types available with Thermo-Calc 2025a:  (1) 
User credentials, which are entered after installation and managed via an 
online portal or (2) where a license file is installed directly on the computer or a 
licensing server. Many users will start using the user credentials activation type 
as of this release and all users will eventually be migrated to the new system.

Visit our website to watch the new installation video showing how to install with 
user credentials (in both online and offline mode), which will replace the license 
files. The video library also includes the installation videos using the old method 
(license files) and other installations such as for TC-Python.

This section is applicable to:

 l Operating system: Windows 
 l Installation type: Single User (SUNLL) or Floating Network Licenses (NWL)
 l License activation type: User credentials (online and offline)
 l Upgrading to a new version of Thermo-Calc (maintenance plan only)

For instructions about other operating systems, network installations, or 
installing an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the 
Thermo-Calc Installation Guide, which is also available on our website. You can 
also review the Licensing Options included on our website. 

Step 1: Download  Thermo-Calc Software

Administrative rights are required to complete this installation. An email from 
Thermo-Calc Software (or from someone in your organization) includes the 
links and information you need to access and activate the current version of the 
software you want to download. 

https://thermocalc.com/support/video-tutorials/installation/
https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
https://thermocalc.com/licensing-options/
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 1. Click the link from the email and the first page of the Download Center opens. Under 
the Windows section, select the OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 

 3. On the Download Center page under Software, click the .exe link to download the 
file for the current software version (2025a).

Step 2: Install Thermo-Calc Software

 1. Once the download is complete, navigate to the folder where you downloaded the 
software. Double-click the downloaded program file (the suffix is based on the 
operating system). Remember that administrative rights are needed, so when you 
are prompted for that user name and password, enter those credentials here, not 
the ones sent to you from Thermo-Calc.  

 2. Click Yes to continue.

 3. On the Setup - Thermo-Calc 2025a window click Next. 

 4. On the License Agreement window click to accept the license agreement. Click Next. 
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 5. In the Select License and Installation Mode window click User credentials and then 
click Next. 

 6. TC-Python is automatically installed when the User credentials option is chosen. The 
Install TC-Python page is a reminder for users of TC-Python that additional 
installation and license credential procedures are needed after Thermo-Calc is 
installed. Read the separate installation instructions (also included in the full 
installation guide) for more information if applicable. Click Next.

 7. In the Ready to Install window click Next. The software continues installing. 

 8. At the end of installation, click Finish. Once this is done,  open Thermo-Calc either 
from the shortcut on your desktop or from the menu. 

Step 3: Activate the License

If you are in a secure environment that does not allow Internet access, you will 
need to use the option Create offline activation file. See the last section for 
details.
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 1. Open Thermo-Calc. The first window includes highlights from the current release. 
Click Close.

 2. In the License status window, enter the User and Password provided to you. 

Your license user credentials are sent to you in an email from 
Thermo-Calc or a representative. This is different from the Download 
Center login details. If you have not received the information, first ask 
the main Thermo-Calc contact in your organization. Or email us at 
support@thermocalc.com.

 3. If you use a proxy server, click Proxy settings. Click Use proxy and enter your 
information. Click OK.

 4. Click Activate online.  Once activated you will see the License status window with a 
list of the products you have access to. Click Close and start using Thermo-Calc.

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Step 4: Optional Offline License Activations 

Offline activations are only available for single user (SUNLL) licenses.

These instructions are a continuation from previous steps and assume you have 
already installed  Thermo-Calc and entered your user credentials.

Offline activations are useful for users who are in a highly secure environment that does not 
allow Internet connections. You will need access to the Internet to complete the activation. 
You can do this either by:

 l Accessing the Internet temporarily from the computer you will use Thermo-Calc on, 
or

 l Activating the license on another computer then transferring the license to the 
computer you will use Thermo-Calc on.

 1. Click Create offline activation file. The License status window opens with 
instructions you can refer to.

 2. A local file to use for the offline activation is created and the link to where it is 
downloaded to your computer is provided. The file is named ls_activation.req. 
Click the link to go to this location on your computer. 
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If you have downloaded the file to a computer that does not have 
Internet access, then copy this file to one that does and continue the 
process. Later you will copy the generated offline license back to the 
computer where Thermo-Calc is installed.

 3. On the computer that has Internet access, go to the URL shown on the License status 
window: https://offline.licensespring.com. 

 4. Navigate to the ls_activation.req file on your computer and drag and drop it into 
the center of the window. The program generates another file and downloads it to 
your computer. This file is named ls_activation.lic.

 5. Navigate to the downloaded ls_activation.lic file. If needed, this is when you 
copy this file back to the computer where Thermo-Calc is installed. In both cases the 
new file should be copied back to the same folder where the original file ls_
activation.req is located.

 6. Once the two files are in the same folder, you are ready to generate an offline 
license. 

 7. Go to the License status window and click Activate using offline response file. Once 
activated you will see the License status window with a list of the products you have 
access to. Click Close and start using Thermo-Calc.

https://offline.licensespring.com/
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 8. You do not need to keep the files you downloaded. Return to where these files are 
downloaded and delete them. 

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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macOS® User Credentials Installations

There are two license activation types available with Thermo-Calc 2025a:  (1) 
User credentials, which are entered after installation and managed via an 
online portal or (2) where a license file is installed directly on the computer or a 
licensing server. Many users will start using the user credentials activation type 
as of this release and all users will eventually be migrated to the new system.

Visit our website to watch the new installation video showing how to install with 
user credentials (in both online and offline mode), which will replace the license 
files. The video library also includes the installation videos using the old method 
(license files) and other installations such as for TC-Python.

This section is applicable to:

 l Operating system: macOS
 l Installation type: Single User (SUNLL) or Floating Network Licenses (NWL) 
 l License activation type: User credentials (online and offline)
 l Upgrading to a new version of Thermo-Calc (maintenance plan only)

For instructions about other operating systems, network installations, or 
installing an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the 
Thermo-Calc Installation Guide, which is also available on our website. You can 
also review the Licensing Options included on our website. 

Step 1: Install Required macOS Software

To install and run Thermo-Calc on a Mac computer with an ARM processor, 
Rosetta first needs to be installed.

The XQuartz open-source X.Org X Window system is required to run Thermo-Calc on macOS. 

https://thermocalc.com/support/video-tutorials/installation/
https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
https://thermocalc.com/licensing-options/
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 1. In a web browser go to https://www.macupdate.com or to download it directly from 
XQuartz, https://www.xquartz.org/.

 2. In the Search Mac Apps field, enter XQuartz.

 3. Click the XQuartz search result. For example, based on the recent version, the name is 
XQuartz-2.8.5.dmg.

 4. Click Download. 

 5. Double-click the XQuartz-<version>.pkg file. Follow the instructions.

 6. Click OK when the message about logging out displays and click Close when the 
installation is successful.

Step 2: Download  Thermo-Calc Software

Administrative rights are required  to complete this installation. An email from 
Thermo-Calc Software (or from someone in your organization) includes the 
links and information you need to access and activate the current version of the 
software you want to download. 

 1. Click the link from the email and the first page of the Download Center opens. Under 
the macOS section, select the OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 

 3. On the Download Center page under Software, click the .zip link to download the file 
for the current software version (2025a).

https://www.macupdate.com/
https://www.xquartz.org/
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Step 3: Install Thermo-Calc Software

 1. Once the download is complete, navigate to the folder where you downloaded the 
software. Double-click the downloaded program file (the suffix is based on the 
operating system). Remember that administrative rights are needed, so when you 
are prompted for that user name and password, enter those credentials here, not 
the ones sent to you from Thermo-Calc.  

 2. Click Yes to continue.

 3. On the Setup - Thermo-Calc 2025a window click Next. 

 4. On the License Agreement window click to accept the license agreement. Click Next. 

 5. In the Select License and Installation Mode window click User credentials and then 
click Next. 

 6. TC-Python is automatically installed when the User credentials option is chosen. The 
Install TC-Python page is a reminder for users of TC-Python that additional 
installation and license credential procedures are needed after Thermo-Calc is 
installed. Read the separate installation instructions (also included in the full 
installation guide) for more information if applicable. Click Next.

 7. In the Ready to Install window click Next. The software continues installing. 

 8. At the end of installation, click Finish. Once this is done,  open Thermo-Calc either 
from the shortcut on your desktop or from the menu. 

Step 4: Activate the License

If you are in a secure environment that does not allow Internet access, you will 
need to use the option Create offline activation file. See the last section for 
details.
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 1. Open Thermo-Calc. The first window includes highlights from the current release. 
Click Close.

 2. In the License status window, enter the User and Password provided to you. 

Your license user credentials are sent to you in an email from 
Thermo-Calc or a representative. This is different from the Download 
Center login details. If you have not received the information, first ask 
the main Thermo-Calc contact in your organization. Or email us at 
support@thermocalc.com.

 3. If you use a proxy server, click Proxy settings. Click Use proxy and enter your 
information. Click OK.

 4. Click Activate online.  Once activated you will see the License status window with a 
list of the products you have access to. Click Close and start using Thermo-Calc.

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Step 5: Optional Offline License Activations 

Offline activations are only available for single user (SUNLL) licenses.

These instructions are a continuation from previous steps and assume you have 
already installed  Thermo-Calc and entered your user credentials.

Offline activations are useful for users who are in a highly secure environment that does not 
allow Internet connections. You will need access to the Internet to complete the activation. 
You can do this either by:

 l Accessing the Internet temporarily from the computer you will use Thermo-Calc on, 
or

 l Activating the license on another computer then transferring the license to the 
computer you will use Thermo-Calc on.

 1. Click Create offline activation file. The License status window opens with 
instructions you can refer to.

 2. A local file to use for the offline activation is created and the link to where it is 
downloaded to your computer is provided. The file is named ls_activation.req. 
Click the link to go to this location on your computer. 
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If you have downloaded the file to a computer that does not have 
Internet access, then copy this file to one that does and continue the 
process. Later you will copy the generated offline license back to the 
computer where Thermo-Calc is installed.

 3. On the computer that has Internet access, go to the URL shown on the License status 
window: https://offline.licensespring.com. 

 4. Navigate to the ls_activation.req file on your computer and drag and drop it into 
the center of the window. The program generates another file and downloads it to 
your computer. This file is named ls_activation.lic.

 5. Navigate to the downloaded ls_activation.lic file. If needed, this is when you 
copy this file back to the computer where Thermo-Calc is installed. In both cases the 
new file should be copied back to the same folder where the original file ls_
activation.req is located.

 6. Once the two files are in the same folder, you are ready to generate an offline 
license. 

 7. Go to the License status window and click Activate using offline response file. Once 
activated you will see the License status window with a list of the products you have 
access to. Click Close and start using Thermo-Calc.

https://offline.licensespring.com/
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 8. You do not need to keep the files you downloaded. Return to where these files are 
downloaded and delete them. 

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Linux User Credentials Installations

There are two license activation types available with Thermo-Calc 2025a:  (1) 
User credentials, which are entered after installation and managed via an 
online portal or (2) where a license file is installed directly on the computer or a 
licensing server. Many users will start using the user credentials activation type 
as of this release and all users will eventually be migrated to the new system.

Visit our website to watch the new installation video showing how to install with 
user credentials (in both online and offline mode), which will replace the license 
files. The video library also includes the installation videos using the old method 
(license files) and other installations such as for TC-Python.

This section is applicable to:

 l Operating system: Linux
 l Installation type: Single User (SUNLL) or Floating Network Licenses (NWL)
 l License activation type: User credentials (online and offline)
 l Upgrading to a new version of Thermo-Calc (maintenance plan only)

For instructions about other operating systems, network installations, or 
installing an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the 
Thermo-Calc Installation Guide, which is also available on our website. You can 
also review the Licensing Options included on our website. 

Step 1: Download  Thermo-Calc Software

Administrative rights are required to complete this installation. An email from 
Thermo-Calc Software (or from someone in your organization) includes the 
links and information you need to access and activate the current version of the 
software you want to download. 

https://thermocalc.com/support/video-tutorials/installation/
https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
https://thermocalc.com/licensing-options/
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 1. Click the link from the email and the first page of the Download Center opens. Under 
the Linux section, select the OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 

 3. On the Download Center page under Software, click the .run link to download the 
file for the current software version (2025a).

Step 2: Install Thermo-Calc Software

 1. Once the download is complete, navigate to the folder where you downloaded the 
software. Double-click the downloaded program file (the suffix is based on the 
operating system). Remember that administrative rights are needed, so when you 
are prompted for that user name and password, enter those credentials here, not 
the ones sent to you from Thermo-Calc.  

 2. Click Yes to continue.

 3. On the Setup - Thermo-Calc 2025a window click Next. 

 4. On the License Agreement window click to accept the license agreement. Click Next. 
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 5. In the Select License and Installation Mode window click User credentials and then 
click Next. 

 6. TC-Python is automatically installed when the User credentials option is chosen. The 
Install TC-Python page is a reminder for users of TC-Python that additional 
installation and license credential procedures are needed after Thermo-Calc is 
installed. Read the separate installation instructions (also included in the full 
installation guide) for more information if applicable. Click Next.

 7. In the Ready to Install window click Next. The software continues installing. 

 8. At the end of installation, click Finish. Once this is done,  open Thermo-Calc either 
from the shortcut on your desktop or from the menu. 

Step 3: Activate the License

If you are in a secure environment that does not allow Internet access, you will 
need to use the option Create offline activation file. See the last section for 
details.
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 1. Open Thermo-Calc. The first window includes highlights from the current release. 
Click Close.

 2. In the License status window, enter the User and Password provided to you. 

Your license user credentials are sent to you in an email from 
Thermo-Calc or a representative. This is different from the Download 
Center login details. If you have not received the information, first ask 
the main Thermo-Calc contact in your organization. Or email us at 
support@thermocalc.com.

 3. If you use a proxy server, click Proxy settings. Click Use proxy and enter your 
information. Click OK.

 4. Click Activate online.  Once activated you will see the License status window with a 
list of the products you have access to. Click Close and start using Thermo-Calc.

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Step 4: Optional Offline License Activations 

Offline activations are only available for single user (SUNLL) licenses.

These instructions are a continuation from previous steps and assume you have 
already installed  Thermo-Calc and entered your user credentials.

Offline activations are useful for users who are in a highly secure environment that does not 
allow Internet connections. You will need access to the Internet to complete the activation. 
You can do this either by:

 l Accessing the Internet temporarily from the computer you will use Thermo-Calc on, 
or

 l Activating the license on another computer then transferring the license to the 
computer you will use Thermo-Calc on.

 1. Click Create offline activation file. The License status window opens with 
instructions you can refer to.

 2. A local file to use for the offline activation is created and the link to where it is 
downloaded to your computer is provided. The file is named ls_activation.req. 
Click the link to go to this location on your computer. 
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If you have downloaded the file to a computer that does not have 
Internet access, then copy this file to one that does and continue the 
process. Later you will copy the generated offline license back to the 
computer where Thermo-Calc is installed.

 3. On the computer that has Internet access, go to the URL shown on the License status 
window: https://offline.licensespring.com. 

 4. Navigate to the ls_activation.req file on your computer and drag and drop it into 
the center of the window. The program generates another file and downloads it to 
your computer. This file is named ls_activation.lic.

 5. Navigate to the downloaded ls_activation.lic file. If needed, this is when you 
copy this file back to the computer where Thermo-Calc is installed. In both cases the 
new file should be copied back to the same folder where the original file ls_
activation.req is located.

 6. Once the two files are in the same folder, you are ready to generate an offline 
license. 

 7. Go to the License status window and click Activate using offline response file. Once 
activated you will see the License status window with a list of the products you have 
access to. Click Close and start using Thermo-Calc.

https://offline.licensespring.com/
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 8. You do not need to keep the files you downloaded. Return to where these files are 
downloaded and delete them. 

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Custom User Credentials Installations

This section is applicable to:

 l Operating systems: Windows, macOS, or Linux
 l Installation type: Single User (SUNLL) or Floating Network Licenses (NWL)
 l License activation type: User credentials (online and offline)
 l Upgrading to a new version of Thermo-Calc (maintenance plan only)

Use the Custom option to have more control over what component features to include or 
exclude, for example, to exclude an SDK. 

About the Thermo-Calc Installed Components

Add New Components to an Existing Installation 

Step 1: Download  Thermo-Calc Software

This section uses Windows as an example, but download the applicable OS for use.

Administrative rights are required to complete this installation. An email from 
Thermo-Calc Software (or from someone in your organization) includes the 
links and information you need to access and activate the current version of the 
software you want to download. 

 1. Click the link from the email and the first page of the Download Center opens. Under 
the Windows section, select the OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 
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 3. On the Download Center page under Software, click the .exe link to download the 
file for the current software version (2025a).

Step 2: Select the Components to Install 

 1. Once the download is complete, navigate to the folder where you downloaded the 
software. Double-click the downloaded program file (the suffix is based on the 
operating system). Remember that administrative rights are needed for Windows 
and macOS, so when you are prompted for that user name and password, enter 
those credentials here, not the ones sent to you from Thermo-Calc.  

 2. Click Yes to continue.

 3. On the Setup - Thermo-Calc 2025a window click Next. 

 4. On the License Agreement window click to accept the license agreement. Click Next. 

 5. In the Select License and Installation Mode window click Custom. Click Next.

 6. On the Specify Configuration window the Create Shortcut on Desktop checkbox is 
selected by default. Click Next.
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 7. In the Select Components window, click to select or deselect the checkboxes as 
needed. Click Next.

For 2025a, TQ-Interface is not yet available with the user credentials 
system.

Step 3: Finish Installing Thermo-Calc

 1. In the Installation Directory window, either accept the default path or enter a path 
to where you want to install the software. Click the file button  to Browse for 
Folder and navigate to another directory. 
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 2. In the Choose Setup Type window, click User credentials.

 3. TC-Python is automatically installed when the User credentials option is chosen. The 
Install TC-Python page is a reminder for users of TC-Python that additional 
installation and license credential procedures are needed after Thermo-Calc is 
installed. Read the separate installation instructions (also included in the full 
installation guide) for more information if applicable. Click Next.

 4. In the Ready to Install window click Next.

 5. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to 
finish the installation.

For macOS installations and if you have previous Thermo-Calc installations: 
When you launch Thermo-Calc with the new or updated version, the splash 
screen hides the Import User Settings dialog box. In order to proceed you need 
to click the splash screen and then click Yes or No in the dialog box. 

Step 4: Activate the License

If you are in a secure environment that does not allow Internet access, you will 
need to use the option Create offline activation file. See the last section for 
details.
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 1. Open Thermo-Calc. The first window includes highlights from the current release. 
Click Close.

 2. In the License status window, enter the User and Password provided to you. 

Your license user credentials are sent to you in an email from 
Thermo-Calc or a representative. This is different from the Download 
Center login details. If you have not received the information, first ask 
the main Thermo-Calc contact in your organization. Or email us at 
support@thermocalc.com.

 3. If you use a proxy server, click Proxy settings. Click Use proxy and enter your 
information. Click OK.

 4. Click Activate online.  Once activated you will see the License status window with a 
list of the products you have access to. Click Close and start using Thermo-Calc.

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Step 5: Optional Offline License Activations 

Offline activations are only available for single user (SUNLL) licenses.

These instructions are a continuation from previous steps and assume you have 
already installed  Thermo-Calc and entered your user credentials.

Offline activations are useful for users who are in a highly secure environment that does not 
allow Internet connections. You will need access to the Internet to complete the activation. 
You can do this either by:

 l Accessing the Internet temporarily from the computer you will use Thermo-Calc on, 
or

 l Activating the license on another computer then transferring the license to the 
computer you will use Thermo-Calc on.

 1. Click Create offline activation file. The License status window opens with 
instructions you can refer to.

 2. A local file to use for the offline activation is created and the link to where it is 
downloaded to your computer is provided. The file is named ls_activation.req. 
Click the link to go to this location on your computer. 
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If you have downloaded the file to a computer that does not have 
Internet access, then copy this file to one that does and continue the 
process. Later you will copy the generated offline license back to the 
computer where Thermo-Calc is installed.

 3. On the computer that has Internet access, go to the URL shown on the License status 
window: https://offline.licensespring.com. 

 4. Navigate to the ls_activation.req file on your computer and drag and drop it into 
the center of the window. The program generates another file and downloads it to 
your computer. This file is named ls_activation.lic.

 5. Navigate to the downloaded ls_activation.lic file. If needed, this is when you 
copy this file back to the computer where Thermo-Calc is installed. In both cases the 
new file should be copied back to the same folder where the original file ls_
activation.req is located.

 6. Once the two files are in the same folder, you are ready to generate an offline 
license. 

 7. Go to the License status window and click Activate using offline response file. Once 
activated you will see the License status window with a list of the products you have 
access to. Click Close and start using Thermo-Calc.

https://offline.licensespring.com/
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 8. You do not need to keep the files you downloaded. Return to where these files are 
downloaded and delete them. 

At any time you can view the product license information by selecting Help → 
Show License Info from the menu in Thermo-Calc.
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Unattended or Silent Network Installations (User 
Credentials)

Sometimes it is convenient to install Thermo-Calc network clients without providing user 
input after the installation is initiated (an unattended network installation), i.e. a silent 
installation. This is available for Windows and Linux operating systems.

Create an Option File in a Text Editor to Enter the Options

Below is a example for installation when you have a license activation type user credentials:

installation_mode=custom

setup_type=licenseSpring

Go to the Directory Where the Installation File is Saved 

Thermo-Calc can only be installed in unattended mode from the command line 
prompt.

Start the installation in unattended mode using the option file created with this command:

 l Windows: <installationfile>.exe --mode unattended --optionfile 
<path\optionfile> 

 l Linux:  <installationfile>.run --mode unattended --optionfile 
<path/optionfile>

To see other options when you start the Thermo-Calc installation program from the 
command line prompt, run this command:

 l Windows: <installationfile>.exe –-help
 l Linux: <installationfile>.run –-help

Activate the User Credentials Type of License

 1. In the installation folder these files are found based on OS: 
 l Windows: License-manager.bat  
 l Linux: License-manager.sh
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 2. From the command line prompt, run the command once for every product you want 
to activate:

 l Windows: License-manager.bat <product> activate <user> <password>
 l Linux: License-manager.sh <product> activate <user> <password>

<product> can be TC-Application, TC-Python, or TC-Toolbox. <user> and 
<password> are the user credentials provided by email from Thermo-Calc or a 
representative.

The license manager can be used for activation, updating, and so forth. Run the 
command License-manager.bat --help and it shows the available options.
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Deactivating Online or Offline Licenses

Deactivating an Online License

 1. Open Thermo-Calc.

 2. Select Help →  Show License Info.

 3. In the License status window, click Sign out and deactivate. 

 4. The login window opens where you enter the user credentials and the license is 
deactivated.

Deactivating an Offline License

 1. Open Thermo-Calc.

 2. Select Help →  Show License Info.

 3. In the License status window, click Sign out and use an offline deactivation file. 

 4. A local file to use for the offline deactivation is created and the link to where it is 
downloaded to your computer is provided. The file is named ls_deactivation.req. 
Click the link to go to this location on your computer. 

Since you have downloaded the file to a computer that does not have 
Internet access, then either temporarily access the Internet, or copy the 
file to one where you can continue the process. 
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 5. On the computer that has Internet access, go to the URL shown on the License status 
window: https://offline.licensespring.com. 

 6. Navigate to the ls_deactivation.req file on your computer and drag and drop it 
into the center of the window. The Offline Licensing window confirms that the 
license is deactivated.

 7. You do not need to keep the file you downloaded. Return to where the deactivation 
file was downloaded or saved and delete it. 

https://offline.licensespring.com/
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Default Installation Directories
The default directories where the software and its components are installed, including 
where the license file is stored, vary by platform and user type. 

If you want to select specific components to install or if you want to install the software in a 
non-default installation directory, then do a custom installation (Windows and Linux only). 
In the table, <user> stands for the user name and <version> for the version of Thermo-Calc, 
for example 2025a.

In this section:

Installation Default Directory: Windows 53

Installation Default Directory: macOS 54

Installation Default Directory: Linux 55

Installation Default Directory: Databases, Database Checker, and TDB Editor 56

Installation Default Directory: Materials 58

Installation Default Directory: Process Metallurgy Materials 60

Installation Default Directory: Custom Property Models 61
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Installation Default Directory: Windows

Administrative rights are required to install and uninstall Thermo-Calc. 

Windows User 
Type Default Directory

Administrator

The Thermo-Calc program is installed here: 
Program Files\Thermo-Calc\<version>

The default folders where documents, materials files, examples, and other folders that 
sometimes require additional licenses are installed under Public Documents for ALL USERS. 

For a local user these files are copied to the user’s Documents folder where this local copy is 
associated to the user login. The Public Documents folder always contains the original set of 
contents as per the installation.

C:\Users\Public\Public Documents\Thermo-Calc\<version>

After installing Thermo-Calc, and when you first open the program, the set of folders is copied 
from the source Public Documents location into a user Documents folder:

C:\Users\<user>\Documents\Thermo-Calc\<version>

It is recommended that you work with the files that are copied to the user 
folder.

In some cases when an interim software update is installed there is also a 
backup folder created in this folder. For details, see Updating the Software for 
Interim Releases.

Server network

This section is applicable to installations involving a license file activation 
type.  This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

License software installations on a server network (the License Manager software)

C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License 
Manager\WinNT\
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Installation Default Directory: macOS

macOS User Type Default Directory

Administrator (user 
name and password 
required)

The Thermo-Calc program is installed in the Applications folder: 
Thermo-Calc-<version>.app and uninstall-Thermo-Calc-<version>.app

The documents, materials, examples, and other folders that sometimes require 
additional licenses are installed here: 

/Users/Shared/Thermo-Calc/<version>

In some cases when an interim software update is installed there is also 
a backup folder created in this folder. For details, see Updating the 
Software for Interim Releases.

To go to this folder, in Finder, from the Go main menu select Go to folder. Enter the 
above file path and click Go.
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Installation Default Directory: Linux

Linux User Type Default Directory

Non root user
The Thermo-Calc program including the documents, materials, examples, and 
other folders that sometimes require additional licenses are installed here:

/home/<user>/Thermo-Calc/<version>

Root user

The Thermo-Calc program including the documents, materials, examples, and 
other folders that sometimes require additional licenses are installed here:

/opt/Thermo-Calc/<version>

In some cases when an interim software update is installed there 
is also a backup folder created in this folder. For details, see 
Updating the Software for Interim Releases.

License software installations 
on a server network (the 
License Server software) 

This section is applicable to installations involving a license file 
activation type.  This licensing method is gradually being replaced 
by the user credentials activation type starting with Thermo-Calc 
2025a. 

If you are doing a network installation then these files are available as a tar-file 
from the Thermo-Calc website. Contact Support for more information.

In the downloaded tar-file, there is a restart_lserv script file, which can be used as 
a template for creating a script that starts up the License Server.

https://thermocalc.com/support/
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Installation Default Directory: Databases, Database Checker, 
and TDB Editor

The standard Thermo-Calc databases and the database initialization file tc_initd.tdb are 
located in a subfolder to the Thermo-Calc installation. For example, in a Windows 
Standalone installation, you can find these in a folder called data where the file path is 
C:\Program Files\Thermo-Calc\<version>\data.

Database Checker

The Thermo-Calc software package includes a program to check that the syntax of 
unencrypted database files is correct. The program applies the syntax rules set out in the 
Database Manager User Guide and reports errors and issues warnings. This program is 
intended for advanced users who develop and manage databases. 

Thermo-Calc  accepts some deviations from these syntax rules. Although 
warnings can be ignored, errors must be corrected. Reported errors must be 
corrected in the TDB file before the database can be loaded by the application. 
Sometimes the warnings can also reveal the need for additional corrections as 
shown in the example below. 

For example,  a warning is generated if a phase name is detected that is also an abbreviation 
of another phase name in the database. Although allowed, it is not recommended as this 
can (in some cases) lead to unexpected results because abbreviations are also used  when 
entering commands in the Console and included in macro files. The following shows why in 
this case an abbreviation is not recommended. 

Imagine that a macro file uses the abbreviation ABC to refer to a phase in a database that is 
named ABCDE. As long as there is no other phase in the database with the same exact name 
or initial abbreviation, it works. But if a new phase is added to the database and is actually 
named ABC then the macro can in error refer to the wrong phase. The macro still runs but 
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now refers to the phase ABC instead of ABCDE because ABC is an exact match, which takes 
precedence over abbreviations.  The Database Checker displays a warning because this 
situation can only occur when one phase name is an abbreviation of another.

With respect to using this tool, the executable DatabaseChecker file is found in the 
Thermo-Calc home directory. 

The program can also be launched by selecting Tools → Database Checker  from the main 
menu in Thermo-Calc.

TDB Editor

The TDB Editor is an editing tool for those who develop their own custom databases for use 
with Thermo-Calc or other applications. The tool speeds up the database editing process by 
providing immediate feedback through syntax coloring, syntax checking, and by allowing 
formatting and easy navigation to items of interest in the TDB file.  

During installation, the tdb-language-support.vsix file is installed in the Thermo-Calc 
home directory. 

In order to access the most-up-to-date version of the VSCode plugin, it must be 
updated every time a new version of Thermo-Calc is installed. 

For information about installing the TDB Editor, which is separate from the main 
installation and can be done later, see the Database Manager's User Guide 
contained in the Thermo-Calc Documentation Set or press F1 in Thermo-Calc 
and search the help.
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Installation Default Directory: Materials

When you are working with the System Definer or Material to Material Calculator you can 
open the default  Materials folder included with your installation. 

At the bottom of the window under Material, click Load material to navigate to a material 
file. 

There is a separate folder for materials saved using the Process Metallurgy 
Calculator. See Installation Default Directory: Process Metallurgy Materials.

For the Additive Manufacturing (AM) Module, the Material Properties library is 
managed by the software. 

The default directory where these material files are stored is based on operating system:

Operating 
System Materials Installation Directory

Windows C:\Users\<user>\Documents\Thermo-Calc\2025a\Materials

Linux
On Linux all user files are installed where the program is installed. If installed as root the 
default is:

/opt/Thermo-Calc/2025a/Materials
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Operating 
System Materials Installation Directory

macOS /Users/Shared/Thermo-Calc/2025a/Materials
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Installation Default Directory: Process Metallurgy Materials

With the Process Metallurgy Calculator you can save materials to work with again. This is the 
default folder where these are stored based on your operating system:

Operating System Process Metallurgy Materials Installation Directory

Windows C:\Users\<user>\Documents\Thermo-Calc\2025a\ProcessMetallurgyMaterials 

Linux
On Linux all user files are installed where the program is installed. If installed as root the 
default is:

/opt/Thermo-Calc/2025a/ProcessMetallurgyMaterials

macOS /Users/Shared/Thermo-Calc/2025a/ProcessMetallurgyMaterials
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Installation Default Directory: Custom Property Models

All Property Models (whether these are predefined or custom models) must be 
located in a subdirectory of the Property Model directory. You can go to the 
Options window then on the General tab the Model directory field displays the 
default directory.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

Predefined models included with the Property Model Calculator are installed in the locations 
below based on your operating system. If you create your own models using TC-Python, this 
is the default directory where these are saved. 

Operating System Property Model Installation Directory

Windows C:\Program Files/Thermo-Calc/2025a\PropertyModels

Linux

On Linux all user files are installed where the program is installed. If installed as root the 
default is:

/opt/Thermo-Calc/2025a/PropertyModels

or: 

/home/<username>/Thermo-Calc/2025a/PropertyModels

macOS /Applications/Thermo-Calc-2025a.app/Contents/Resources/PropertyModels
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License File and License Server Installations

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

In this section:

About License Keys and Files 63

First Steps of Installation 64

Installation Default Directories and the License File 65
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About License Keys and Files

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

To run Thermo-Calc and its components you need a valid license key for each product. The 
license keys are included in the license file emailed to you by Thermo-Calc Software.

You can copy the license file to the applicable computer(s) before or after installing the 
software––the license file itself is not required during the installation process. However, it is 
required to make calculations in Thermo-Calc. 

Request a License File from Thermo-Calc Software  
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First Steps of Installation

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

This section reviews some of the things you need to do before installing the Thermo-Calc 
software. 

 l Learn about the different default directories where the software and license files are 
installed. 

 l For network installations, collect subnet information.
 l Make sure the person installing the software has administrator rights for Windows 

and macOS.
 l For macOS, install XQuartz and make sure the security preferences are set correctly.
 l For a Linux Cent OS 7 installation, also install gtk2 before you run the installation 

script.

yum install gtk2

Should I get my license file before or after software installation? The 
Thermo-Calc license file itself is not required during the installation process. 
However, it is required to make calculations in Thermo-Calc. The license file has 
details about your computer(s) that in some cases cannot be determined 
accurately until after installation (especially for a network installation). For 
most users it is recommended you request the file before you start installing.

You do not need a license file if you are provided with user credentials to 
activate your license. See About User Credentials License Activations and 
proceed to the relevant installation instructions.
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Installation Default Directories and the License File

You do not need a license file if you are provided with user credentials to 
activate your license. See About User Credentials License Activations and 
proceed to the relevant installation instructions.

The default directories where the software and its components are installed, including 
where the license file is stored, vary by platform and user type. 

If you want to select specific components to install or if you want to install the software in a 
non-default installation directory, then do a custom installation (Windows and Linux only). 
In the table, <user> stands for the user name and <version> for the version of Thermo-Calc, 
for example 2025a.

License File Installation Location for All Operating Systems

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The Thermo-Calc license file is installed outside of the installation program folder. If you 
have more than one version of Thermo-Calc installed then there are additional folders by 
version number with only one license file. 

For macOS the license file is put in /Users/Shared/Thermo-Calc. The example below is for a 
Standalone Windows installation. 

More Information

See the following for more information:
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 l Installation Default Directory: Windows
 l Installation Default Directory: macOS
 l Installation Default Directory: Linux
 l Installation Default Directory: Databases, Database Checker, and TDB Editor
 l Installation Default Directory: Materials
 l Installation Default Directory: Process Metallurgy Materials
 l Installation Default Directory: Custom Property Models
 l Installation Default Directory: TC-Python
 l Installation Default Directory: TC-Toolbox and the Examples
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Standalone Installations (License File)

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

You can either do a full or a custom standalone installation. The license type is called a 
Single-User Node-Locked License (SUNLL).

In this section:

Standalone Installations (SUNLL) 68

Full Standalone Installations 69

Windows® Standalone (License File) Installations 73

macOS® Standalone (License File) Installations 77

Custom Standalone Installations (License File) 82



Thermo-Calc Documentation Set

Installation Guide ǀ 68 of 199

Standalone Installations (SUNLL)

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The standalone installation is used with the Single-User Node-Locked License (SUNLL). The 
Thermo-Calc software  and a Thermo-Calc license file   are installed on a standalone 
computer. You can do a full (all operating systems) or a custom installation (Windows and 
Linux only).

To get started, go to (1) First Steps of Installation and then (2) Standalone 
Installations (License File).
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Full Standalone Installations

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The following describes a full standalone installation. These steps assume you have 
completed the section First Steps of Installation.

Request your License File from Thermo-Calc Software

Upgrading to a new version of Thermo-Calc: Skip this section if you are 
upgrading to a new version of Thermo-Calc (and you have a maintenance plan), 
or you have already been provided with the license file.  

For license file activations, follow the instructions for your operating system in the section 
Request a License File from Thermo-Calc Software. Also note that the license file name must 
be the same as the existing file name to ensure there are no errors during the update.

You do not need a license file if you are provided with user credentials to 
activate your license. See About User Credentials License Activations and 
proceed to the relevant installation instructions.

Download your Thermo-Calc Installation Software

Administrative rights are required for Windows and macOS to complete this 
installation. The email from Thermo-Calc Software (or from someone in your 
organization) includes the links and information you need to access the current 
version of the software you want to download. 
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 1. Click the link from the email and the first page of the Download Center opens. Under 
the applicable operating system section (Windows, macOS, or Linux), select the 
OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 

 3. On the Download Center page under Software, click the relevant link for your 
operating system to download the file for the current software version (2025a).

Run the Applicable Installation File for your Operating System

 1. Navigate to the folder for your operating system and click the link to download the 
software package, then go to the folder where you downloaded it. 

Windows

Double-click the .exe file  to launch the Setup program. 

macOS

Double-click the downloaded file then follow the instructions.

For macOS and when you first run the installer, you may see a message that 
Thermo-Calc-osx-<version> can't be opened because Apple cannot check it for 
malicious software. If this happens, select Show in Finder. Then, in the opened 
Finder window right-click the downloaded file Thermo-Calc-osx-<version> 
and select Open.

Linux

To start the Setup Wizard in a Terminal window, enter these commands in the directory 
where the installation file is saved: 

> chmod +x linux-installation-x64-2025a.run

> ./linux-installation-x64-2025a.run



Installation Guide

Select the License and Installation Mode and Install the Software ǀ 71 of 199

If you are an openSUSE root user, see Linux Installation Notes for some 
information about your installation.

 2. On the Setup window click Next. 

 3. On the License Agreement window click the button to accept the license agreement 
then click Next. 

Select the License and Installation Mode and Install the Software

About the Thermo-Calc Installed Components

 1. In the Select License and Installation Mode window click Full Standalone: Install all 
features.

If you want to exclude a component (e.g. an SDK), then  use the Custom 
option. See Custom Standalone Installations (License File). For TC-
Toolbox for MATLAB®, also see Installing TC-Toolbox with the Custom 
Option. 

If you also have a license for TC-Python, it is installed when the Full 
Standalone or Full Network Client option is chosen, but there are 
additional steps required as described separately for this SDK. 

 2. For a Full Standalone installation, in the Choose a license file field either enter the 
file path or click the file button  to navigate to where you saved the license file 
emailed to you from Thermo-Calc Software.
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The license file is called lservrc. Click Next. To prevent errors, leave this 
field blank if you did not get a license file yet. If you did not get your 
license file see Request a License File from Thermo-Calc Software.

TC-Python is installed for all users even if you do not have a license. The 
Install TC-Python window  is a reminder that additional installation 
procedures are required after Thermo-Calc is installed. See the TC-
Python Installation Guide.  

 3. In the Ready to Install window click Next. Click Finish and start using Thermo-Calc. 

Additional Notes

For Linux users, log out and log back in to finish the installation.

For macOS installations and if you have previous Thermo-Calc installations: 
When you launch Thermo-Calc with the new or updated version, the splash 
screen hides the Import User Settings dialog box. In order to proceed you need 
to click the splash screen and then click Yes or No in the dialog box. 
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Windows® Standalone (License File) Installations

There are two license activation types available with Thermo-Calc 2025a:  (1) 
User credentials, which are entered after installation and managed via an 
online portal or (2) where a license file is installed directly on the computer or a 
licensing server. Many users will start using the user credentials activation type 
as of this release and all users will eventually be migrated to the new system.

This section is applicable to:

 l Operating system: Windows 
 l Installation type: Full Standalone (SUNLL) 
 l License activation type: License file where the software and the license file are 

installed together on one computer. 
 l Upgrading to a new standalone version of Thermo-Calc (maintenance plan only)

For instructions about other operating systems, network installations, or 
installing an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the 
Thermo-Calc Installation Guide, which is also available on our website. You can 
also review the Licensing Options included on our website. 

Step 1: Request a License File

Upgrading to a new version of Thermo-Calc: Skip this section if you are 
upgrading to a new version of Thermo-Calc (and you have a maintenance plan), 
or you have already been provided with the license file.  

 1. Your license information is sent to you in an email from Thermo-Calc or a 
representative. When you are sent a license file, save it to your computer to use 
during software installation. You may also need to provide some information that is 
accessed from Thermo-Calc. 

Select Help → Show License Info. 

https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
https://thermocalc.com/licensing-options/
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 2. Copy the information from the License Information window. A lot of information 
may be shown below the initial screen, so make sure you scroll down to the end 
when you select and copy the window's contents. (Alternatively, you can copy the 
same information from the console by using the SYS module command DISPLAY_
LICENSE_INFO.)

 3. Send an email to support@thermocalc.com. Make sure to include the following in 
the subject line:

License diagnostic information from <Name> where Name is replaced with your 
name, the organization name and the Site Number. You can find the five-digit site 
number on an invoice or any correspondence from Thermo-Calc Software. 

 4. A representative from Thermo-Calc Software replies to the email and attaches your 
license file(s).

 5. Save the license file(s) to your computer or network.

mailto:support@thermocalc.com?subject=License diagnostic information from <Name>
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Step 2: Download Thermo-Calc Software

Administrative rights are required to complete this installation. An email from 
Thermo-Calc Software (or from someone in your organization) includes the 
links and information you need to access and activate the current version of the 
software you want to download. 

 1. Click the link from the email and the first page of the Download Center opens. Under 
the Windows section, select the OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 

 3. On the Download Center page under Software, click the .exe link to download the 
file for the current software version (2025a).

Step 3: Install Thermo-Calc Software

 1. Navigate to the folder where you downloaded the software. Double-click the .exe 
program. Remember that administrative rights are needed, so when you are 
prompted for that user name and password, enter these credentials here.  Click Yes 
to continue.

 2. On the Setup - Thermo-Calc 2025a window click Next. 

 3. On the License Agreement window click to accept the license agreement. Click Next. 
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Step 4: Select License and Installation Mode 

 1. In the Select License and Installation Mode window click Full Standalone: Install all 
features. 

If you also have a license for TC-Python, it is installed when the Full 
Standalone or Full Network Client option is chosen, but there are 
additional steps required as described separately for this SDK. 

 2. For a Full Standalone installation, in the Choose a license file field either enter the 
file path or click the file button  to navigate to where you saved the license file 
emailed to you from Thermo-Calc Software.

The license file is called lservrc. Click Next. To prevent errors, leave this 
field blank if you did not get a license file yet. 

TC-Python is installed for all users even if you do not have a license. The 
Install TC-Python window  is a reminder that additional installation 
procedures are required after Thermo-Calc is installed. See the TC-
Python Installation Guide.  

 3. In the Ready to Install window click Next. Click Finish and start using Thermo-Calc. 
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macOS® Standalone (License File) Installations

There are two license activation types available with Thermo-Calc 2025a:  (1) 
User credentials, which are entered after installation and managed via an 
online portal or (2) where a license file is installed directly on the computer or a 
licensing server. Many users will start using the user credentials activation type 
as of this release and all users will eventually be migrated to the new system.

This section is applicable to:         

 l Operating system: macOS 
 l Installation type: Full Standalone (SUNLL)
 l License activation type: License file where the software and the license file are 

installed together on one computer.  
 l Upgrading to a new standalone version of Thermo-Calc (maintenance plan only)

For instructions about other operating systems, network installations, or 
installing an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the 
Thermo-Calc Installation Guide, which is also available on our website. You can 
also review the Licensing Options included on our website. 

Step 1: Request a License File

Upgrading to a new version of Thermo-Calc: Skip this section if you are 
upgrading to a new version of Thermo-Calc (and you have a maintenance plan), 
or you have already been provided with the license file.  

 1. From the Apple main menu, select System Preferences.

 2. Click Network.

 3. In the left column select Ethernet or Built-in Ethernet (do not select a WiFi 
connection as a local static MAC address is required).

 4. Click Advanced → Hardware. The Network window shows you the MAC Address. For 
example, the MAC address (the host ID) might be 3c:07:54:28:5f:72.

https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
https://thermocalc.com/licensing-options/


Installation Guide

Step 2: Install Required macOS Software ǀ 78 of 199

 5. Send an email to support@thermocalc.com and copy and paste the MAC address 
into the body of the email. Make sure to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your 
name, the organisation name and the Site Number. You can find the five-digit site 
number on an invoice or any correspondence from Thermo-Calc Software.  

 6. A representative from Thermo-Calc Software replies to the email address provided 
and attaches your license file or files. 

 7. Save your license file to your computer or network.

Step 2: Install Required macOS Software

To install and run Thermo-Calc on a Mac computer with an ARM processor, 
Rosetta first needs to be installed.

The XQuartz open-source X.Org X Window system is required to run Thermo-Calc on macOS. 

 1. In a web browser go to https://www.macupdate.com or to download it directly from 
XQuartz, https://www.xquartz.org/.

 2. In the Search Mac Apps field, enter XQuartz.

mailto:support@thermocalc.com
https://www.macupdate.com/
https://www.xquartz.org/
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 3. Click the XQuartz search result. For example, based on the recent version, the name is 
XQuartz-2.8.5.dmg.

 4. Click Download. 

 5. Double-click the XQuartz-<version>.pkg file. Follow the instructions.

 6. Click OK when the message about logging out displays and click Close when the 
installation is successful.

Step 3: Download  Thermo-Calc Software

Administrative rights are required  to complete this installation. An email from 
Thermo-Calc Software (or from someone in your organization) includes the 
links and information you need to access and activate the current version of the 
software you want to download. 

 1. Click the link from the email and the first page of the Download Center opens. Under 
the macOS section, select the OS version. Click Go to download page.

 2. In the Sign in to access this site window, enter the Username and Password (found 
in the email) and click Sign in. 

 3. On the Download Center page under Software, click the .zip link to download the file 
for the current software version (2025a).
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Step 4: Install Thermo-Calc Software

For macOS and when you first run the installer, you may see a message that 
Thermo-Calc-osx-<version> can't be opened because Apple cannot check it for 
malicious software. If this happens, select Show in Finder. Then, in the opened 
Finder window right-click the downloaded file Thermo-Calc-osx-<version> 
and select Open.

 1. Navigate to the folder where you downloaded the software. Double-click the .zip 
program. Remember that administrative rights are needed, so when you are 
prompted for that user name and password, enter these credentials here.  Click Yes 
to continue.

 2. On the Setup - Thermo-Calc 2025a window click Next. 

 3. On the License Agreement window click to accept the license agreement. Click Next. 

Step 5: Select License and Installation Mode

 1. In the Select License and Installation Mode window click Full Standalone: Install all 
features. 

If you also have a license for TC-Python, it is installed when the Full 
Standalone or Full Network Client option is chosen, but there are 
additional steps required as described separately for this SDK. 

 2. For a Full Standalone installation, in the Choose a license file field either enter the 
file path or click the file button  to navigate to where you saved the license file 
emailed to you from Thermo-Calc Software.
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The license file is called lservrc. Click Next. To prevent errors, leave this 
field blank if you did not get a license file yet. 

TC-Python is installed for all users even if you do not have a license. The 
Install TC-Python window  is a reminder that additional installation 
procedures are required after Thermo-Calc is installed. See the TC-
Python Installation Guide.  

 3. In the Ready to Install window click Next. Click Finish and start using Thermo-Calc. 

Import User Settings

For macOS installations and if you have previous Thermo-Calc installations: 
When you launch Thermo-Calc with the new or updated version, the splash 
screen hides the Import User Settings dialog box. In order to proceed you need 
to click the splash screen and then click Yes or No in the dialog box. 
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Custom Standalone Installations (License File)

Use the Custom option to have more control over what component features to include or 
exclude, for example, to exclude an SDK.  

This topic describes how to do a custom installation on a standalone computer for either a 
Windows or Linux operating system. These steps assume you have completed these 
sections:

 l First Steps of Installation 
 l Steps 1 to 3 of a Full Standalone Installations where you  request your license file, 

download the software and then have started to set up the program up to the Select 
Installation Mode window.

 Choose the Components to Install 

About the Thermo-Calc Installed Components

 1. In the Select License and Installation Mode window click Custom. Click Next.

 2. On the Specify Configuration window the Create Shortcut on Desktop checkbox is 
selected by default. Click Next.
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 3. In the Select Components window, click to select or deselect the checkboxes as 
needed. Click Next.

 

Set the Installation Directory and Choose the License File

 1. In the Installation Directory window, either accept the default path or enter a path 
to where you want to install the software (see Installation Default Directories and the 
License File). Click the file button  to Browse for Folder and navigate to another 
directory. 

To prevent errors, leave this field blank if you do not have a license file 
yet. 

 2. In the Choose Setup Type window, click Standalone.
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 3. In the Choose a license file field enter the path to your license file (called lservrc) or 
click the file button  to navigate to a location on the computer and open the file. 

 4. TC-Python is automatically installed when the User credentials option is chosen. The 
Install TC-Python page is a reminder for users of TC-Python that additional 
installation and license credential procedures are needed after Thermo-Calc is 
installed. Read the separate installation instructions (also included in the full 
installation guide) for more information if applicable. Click Next.

Install the Software and Start Using Thermo-Calc

 1. In the Ready to Install window click Next.

See the separate instructions for TC-Toolbox for MATLAB®.

 2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to 
finish the installation.

For macOS installations and if you have previous Thermo-Calc installations: 
When you launch Thermo-Calc with the new or updated version, the splash 
screen hides the Import User Settings dialog box. In order to proceed you need 
to click the splash screen and then click Yes or No in the dialog box. 

If you did not get your license file see Request a License File from Thermo-Calc 
Software.
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Network Client Installations (License Files)

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

This installation type is available for all operating systems, however for macOS the License 
Server must be run on a Windows or Linux computer. It is applicable to the consolidated and 
distributed network types of installations as well as for the licensing installation on a server 
network.

About the Thermo-Calc Installed Components

In this section:

Subnet Information for Network Licenses 86

Multi-User Network Installations (NWL) 87

Full Network Client Installations 90

Windows: About Installing the License Manager 92

Windows: Installing the Sentinel RMS License Manager 94

Linux: About Installing the License Server 97

Linux: Installing the Sentinel RMS License Server 100

Thin Client Installations 103

Custom Network Client Installations 106

Unattended or Silent Network Client Installations (License File) 109
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Subnet Information for Network Licenses

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

This is related to Full Network Client Installations.

For network licenses, the subnet information is also required. Ask your network 
administrator for the network address for the subnet. Additional requirements are included 
elsewhere for network installations.

 l Subnets should be in the format aaa.bbb.ccc*** (for example: 192.168.29.0/24 or 
192.168.29.* 

 l When installing on Sentinel RMS License Server version 9.7, a maximum of seven (7) 
subnets are permitted.

An alternative way to get this information is to run the command:

 l Windows: ipconfig /all  
 l macOS/Linux: ip a  
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Multi-User Network Installations (NWL)

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

There are different types of multi-user network installations: consolidated, distributed, and 
where the licensing software is installed on a computer network. There is also a subtype of 
installation called thin client, which is a step done with the consolidated and distributed 
network installations.

Thin client installations: A thin client installation is where the Thermo-Calc 
software is installed on a computer server but is run from a client computer. 
The licensing software can be installed on the computer server (a consolidated 
network) or on a different computer (a distributed network). This type of 
installation is available for Windows and Linux operating systems. The client 
computer must have the Thermo-Calc software installed. This type of 
installation mainly sets environmental variables and paths on the client 
computer.

Consolidated Network Installations

The consolidated network installation is used with a Network License (NWL) and it is 
available for Windows and Linux operating systems.
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The Thermo-Calc software  and the license management program are installed on the 
same server where the license file   is also copied. A thin client installation allows all 
computers (the clients) in the server network to access both the software and the licensing 
on the same computer server.

To get started, go to (1) First Steps of Installation and then (2) Network Client 
Installations (License Files).

Distributed Network Installations 

The distributed network installation is used with a Network License (NWL) and is available 
for Windows and Linux operating systems. 

The Thermo-Calc software  is installed on one computer server in a network and the 
licensing software is installed on a different computer server where the license file   is 
also copied. A thin client installation allows all computers (the clients) in the server network 
to access both the software and the licensing on the two computer servers.

To get started, go to (1) First Steps of Installation and then (2) Network Client 
Installations (License Files).

License Installations on a Server Network 

When a license file is installed on a server network, it is used with a Network License (NWL). 
It is available for all platforms. However, for macOS the server containing the licensing 
software must be set up on Windows or Linux.
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The licensing software is installed on a computer server where the license file   is also 
copied. The Thermo-Calc software  is installed on every computer in the network that 
needs it. 

To get started, go to (1) First Steps of Installation and then (2) Network Client 
Installations (License Files).
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Full Network Client Installations

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The following outlines how to do a full network client installation. 

Install the Sentinel RMS Management License Software

Follow the instructions for your operating system:

Windows
 l Windows: About Installing the License Manager
 l Windows: Installing the Sentinel RMS License Manager

Linux
 l Linux: About Installing the License Server
 l Linux: Installing the Sentinel RMS License Server

Complete Steps 1 to 3 of a Full Standalone Installation

These steps assume you have completed the instructions for Full Standalone Installations to 
download and run the software up to the Select Installation Mode window. It is up to you 
whether you get the computer information for the license files before or after installing the 
software.

Choose the Installation Type and Enter the Computer Server 
Details

About the Thermo-Calc Installed Components
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 1. In the Select Installation Mode window click Full Network Client to Install all 
features. 

If you want to exclude a component (perhaps one of the SDKs), then use 
the Custom option and see Custom Network Client Installations.

 2. In the field, enter the name or IP number of the computer where the licensing 
software is installed. Click Next. 

 3. TC-Python is installed for all users even if you do not have a license. The Install 
TC-Python window  is a reminder that additional installation procedures are required 
after Thermo-Calc is installed. See the TC-Python Installation Guide for details.

 4. In the Ready to Install window click Next. 

 5. When the Completing the Thermo-Calc Setup Wizard window opens, click Finish. 
For Linux users, log out and log back in to start using Thermo-Calc. 

For macOS installations and if you have previous Thermo-Calc 
installations: When you launch Thermo-Calc with the new or updated 
version, the splash screen hides the Import User Settings dialog box. In 
order to proceed you need to click the splash screen and then click Yes 
or No in the dialog box. 

If you did not get your Thermo-Calc license file see Request a License File from 
Thermo-Calc Software.
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Windows: About Installing the License Manager

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

If you have previously installed an older version of Sentinel RMS License 
Manager, you must first uninstall the old version then reboot the server before 
starting with a new installation.

The Sentinel RMS License Manager service supplies the client computers in your network 
with license tokens when it runs Thermo-Calc software. The Sentinel RMS License Manager 
software is installed on a computer that acts as a license server in your network. This is 
related to Full Network Client Installations and administrative rights are required for all 
steps.

Remember to collect subnet information before beginning. See Subnet 
Information for Network Licenses.

A network license can only be used on one specific computer that hosts the 
License Manager. The network license determines which client computers 
receive license tokens using the IP addresses and IP ranges.

Supported Windows Versions

These Windows operating systems are supported for the installation of Sentinel RMS License 
Manager. When ready, go to Windows: Installing the Sentinel RMS License Manager.

For macOS, the Sentinel RMS License software is installed on a Windows  or 
Linux  computer server where the Thermo-Calc license file must also be located. 
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Windows 32-bit Operating Systems
 l Windows 7
 l Windows 8.1
 l Windows 10 v1909
 l Windows Server 2008

Windows 64-bit Operating Systems
 l Windows 7
 l Windows 8.1
 l Windows 10 v1909
 l Windows Server 2008
 l Windows Server 2008 R2
 l Windows Server 2012
 l Windows Server 2012 R2
 l Windows Server 2016
 l Windows Server 2019 
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Windows: Installing the Sentinel RMS License Manager

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

First review Windows: About Installing the License Manager. Then if this is a 
new installation of the Sentinel RMS License Manager, start with Step 2.

Uninstall Any Older Versions of Sentinel RMS License Manager

 1. With Administrator rights, log onto the server that hosts the Sentinel RMS License 
Manager.

 2. Save a copy of the license file LSERVRC found in the default directory—the license file 
can be saved as a text file: C:\Program Files (x86)\Common 
Files\SafeNetSentinel\Sentinel RMS License Manager\WinNT\. 

After saving the existing license file and uninstalling the old version of 
Sentinel RMS, ensure you delete the old license file (LSERVRC) in the 
above folder.  This license is not required anymore.

 3. Reboot the computer hosting the Sentinel RMS License Manager.

 4. Continue with the installation and use the preselected default settings.

Download and Install Thermo-Calc

This step is not required to complete the server installation, however some administrators 
may want to do it at this point.

 1. Download Thermo-Calc. 
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 l Web downloads: For web links sent in an email from Thermo-Calc Software, 
go to the URL and log in with the information provided to download the 
software.

 l DVD installations: Insert the DVD and follow the instructions. 

 2. Install Thermo-Calc. For testing purposes, and in order to confirm the installation is 
working correctly, install the Thermo-Calc software on the same computer as the 
Sentinel RMS License Manager. If required after testing, Thermo-Calc can always be 
uninstalled. 

Install the Sentinel RMS License Manager Software

 1. From the download, extract the files license_server_win_9.7.zip and LS_tools_
win.zip.

 2. Right-click setup.exe and select Run as Administrator from the menu.

Choose the Installation Directory

 1. Click to accept the license agreement. 

 2. Enter your User Name and Organization and select to install the License Manager for 
All users. 

 3. In the Destination Folder window click Next to accept the suggested destination 
directory or Change to select another directory. 

Choose the Setup Type and Install the Software

 1. In the Setup Type window, select Complete. Click Next. 

 2. Select the Unblock the system firewall for the Sentinel RMS License Manager 
checkbox.

Selecting the checkbox is required to run Thermo-Calc.

 3. Click Next and then Install.

 4. Click Finish to exit the InstallShield Wizard.
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Install the Thermo-Calc Network License Using WIAdmin

Only the WlAdmin tool can be used to update the network license used by the 
License Manager.

 1. Save the source file containing the license code. The source file can be kept as a .txt 
file

 2. Go to the previously saved file LS_tools_win.zip.

 3. Right-click the file WlmAdmin.exe and select Run as Administrator from the menu.

 4. If the license server is not found under subnet servers, go to Edit → Defined Server 
List. 

 5. Enter the host name or IP address of the license server.

 6. Click Add and then OK.

 7. Click View → Refresh All to update the list.

 8. In the left main window right-click the name of a License Manager.

 9. From the menu select Add Feature → From a File → To Server and its File.

 10. To add the license from a file, select From a File. This permanently adds the license 
code to the License Manager license file as well as to the License Manager memory.

 11. In the windows that open, browse to the source file that contains the license code 
and click Open.

Install Additional Tool Options

Sentinel RMS License 9.7 Tools
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Linux: About Installing the License Server

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The Sentinel RMS License Server service supplies the client computers in your network with 
license tokens when it runs Thermo-Calc software. The Sentinel RMS License Server software 
is installed on a computer that acts as a license server in your network. This is related to Full 
Network Client Installations. 

Preparing for Installation

Read and be aware of the following before you begin the section Linux: Installing the 
Sentinel RMS License Server.

Remember to collect subnet information before beginning. See Subnet 
Information for Network Licenses.

Uninstall Older Versions of the License Server

 l Older versions of the License Server must be stopped by with  lsrvdown before 
running the new installation. This is Step 1 in Linux: Installing the Sentinel 
RMS License Server.

 l If you have a license server: Upgrade your license server if the new one is a higher 
version than the present one. Clients work with newer license servers (managers) but 
not necessarily with ones older than the client.

Requires Root Access or  sudoers List

Root access to your computer is required or you need to be on the sudoers list.

Linux 32-bit Installations on a 64-bit OS

To run a license server 32-bit on a Linux 64-bit OS, 32-bit library support is 
needed.
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Thermo-Calc License File

The name of the license file must be in lower case letters (lservrc) because 
Linux commands and operations are case-sensitive.

 l You need a valid lservrc network license file supplied by Thermo-Calc Software 
(Requesting the License File for Windows or Linux) as well as the actual License 
Server—a file (program) called lserv. 

 l The Thermo-Calc license file needs to be readable and writable by the license server 
(license manager).

Differences Between 32- and 64-bit Scripts

Sentinel RMS License Server version 9.7 supports both 32- and 64-bit. However, when 
writing scripts be aware of script naming and do not mix the scripts.

 l All 32-bit scripts are named <script_name>, for example restart_lserv
 l All 64-bit scripts are named <script_name>64, for example, restart_lserv64

It is not possible to use Linux 32-bit scripts/tools to manage license server 64-
bit and vice versa, you cannot use Linux 64-bit scripts/tools to manage license 
server 32-bit

openSUSE Administration (sudo) Users 

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc 
using this command:

sudo ./Thermo-Calc-linux-<full-version-number>.run

When this command is used, you will do a text-based installation instead of having a 
graphical interface to guide you. The information  is the same, just without the user 
interface. 

For example, the <full-version-number> is not just 2025a, it is what is found in 
the Help → About window in Thermo-Calc and it changes every release. You 
can find the current full version number listed on our website.

https://thermocalc.com/current-software-versions/
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Supported Linux Operating Systems and Versions

For macOS, the Sentinel RMS License software is installed on a Windows  or 
Linux  computer server where the Thermo-Calc license file must also be located. 

Both Linux 32-bit and 64-bit operating systems are supported for the installation of Sentinel 
RMS License Server.

 l Red Hat Enterprise Linux (RHEL) 7.x
 l Red Hat Enterprise Linux (RHEL) 8.x
 l SUSE Linux Enterprise Server (SLES)12.x
 l SUSE Linux Enterprise Server (SLES) 15.x
 l Debian Linux 9.x
 l Debian Linux 10.x
 l Ubuntu Linux 16.x (LTS)
 l Ubuntu Linux 18.x (LTS)
 l Ubuntu Linux 20.x (LTS)
 l OpenSUSE Leap 42.x
 l OpenSUSE Leap 15.x
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Linux: Installing the Sentinel RMS License Server

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

First review Linux: About Installing the License Server. Then if this is a new 
installation of the Sentinel RMS License Server, start with Step 2.

Sentinel RMS License Server version 9.7 supports both 32- and 64-bit. However, when 
writing scripts be aware of script naming and do not mix the scripts.

 l All 32-bit scripts are named <script_name>, for example restart_lserv
 l All 64-bit scripts are named <script_name>64, for example, restart_lserv64

It is not possible to use Linux 32-bit scripts/tools to manage license server 64-
bit and vice versa, you cannot use Linux 64-bit scripts/tools to manage license 
server 32-bit

Stop Older Versions of the Sentinel RMS License Server 

 1. To  stop an old version of the License Server  already running, go to the directory 
where the old file is found, and enter the commands:

 l 32-bit license server

>chmod +x <lsrvdown>

>./lsrvdown <host_name>

 l 64-bit license server

>chmod +x <lsrvdown64>

>./lsrvdown64 <host_name>
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 2. Edit existing scripts that start the older version of the License Server so that they 
start the newer version instead. 

For more information about the lservdown utility, go to 
https://docs.sentinel.thalesgroup.com/softwareandservices/rms/

Write a Script to Start the License Server

The following is an excerpt from the template script for starting the License Server found in 
the restart_lserv file. 

Replace the paths for LICENSE_SERVER_DIR, LICENSE_FILE_DIR and LOG_DIR to match your 
system. Save it as a script:

# set the directory where the executables are located

LICENSE_SERVER_DIR=/usr/local/Thermo-Calc/2025a/Licensing-files

# set the directory of the license file lservrc

LICENSE_FILE_DIR=/usr/local/Thermo-Calc/2025a/Licensing-files

# set the directory where you wish to save the log-files

LOG_DIR=/tmp

# stop the running server

# (omit this line if calling this script at startup)

$LICENSE_SERVER_DIR/lsrvdown $HOSTNAME

# start the license server

$LICENSE_SERVER_DIR/lserv -s $LICENSE_FILE_DIR/lservrc -l $LOG_DIR/lserv_use.log 
-f $LOG_DIR/lserv_err.log

Confirm the HOSTNAME variable and open the UDP port

The hostname should always correspond to the DNS record verify this by doing the 
following.

 1. Before starting the License Server make sure that the value of the $HOSTNAME 
variable is correct. This value can be shown by typing the > nslookup $HOSTNAME 
command in the terminal window:

The value should be the same IP address that is shown when you use the ifconfig 
command. 

 2. Open the UDP port 5093 in your firewall. In case you have installed SELinux you 
might also need to disable it by setting SELINUX=permissive in the 
/etc/selinux/config file.

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/
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Start the License Server

 1. To start the License Server, run the script created as root. Enter these commands in 
the console:

> chmod +x <name_of_script_file>

> ./<name_of_script_file>

 2. If you want the License Server to start when you boot the system, put a copy of the 
start script under /etc/rc.d/init.d and start the script from the file 
/etc/rc.d/rc.local.

Install Additional Tool Options

Sentinel RMS License 9.7 Tools
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Thin Client Installations

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

This topic describes how you install a thin Thermo-Calc client to run Thermo-Calc from a file 
server. It is applicable to consolidated and distributed network installations for either a 
Windows or Linux operating system.

Installation Requirements

 l You need access to the directory where Thermo-Calc is installed on the file server. 
 l You need the IP number or name of the computer where the license file is installed.
 l For Linux you may have to disable your firewall. If SELinux is installed, try disabling it 

by setting SELINUX=permissive in /etc/selinux/config.

Windows Installations 

The following details may also be of use to those installing in a Windows environment.

 l Requests license server name or address and sets LSHOST as a user environment 
variable accordingly.

 l Sets TC<version>_HOME (where <version> is the software version, e.g. TC22A_
HOME) as a user environment variable to point to the location from which the thin 
client installer is running.

The default folders where documents, materials files, examples, and other 
folders that sometimes require additional licenses are installed under Public 
Documents for ALL USERS. See Installation Default Directory: Windows. 
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How to Install a Thin Client on Windows 

 1. Map the file server share as a network drive so that it gets an assigned drive letter 
(e.g. E:).

 2. Open the \Thermo-Calc\<version>\ directory on the file server, where version is the 
current version of the software.

 3. Open the directory Thin-client. Double-click the Thermo-Calc-client-windows-
<version>.exe file.

 4. Click to accept the terms of the license agreement. Click Next.

 5. Enter the name or IP number of where the license file and the License Manager 
software is installed. Click Next.

 6. By default the Create Shortcuts on Desktop checkbox is selected. Click Next. 

The shortcuts to the program are added to the user's Windows roaming 
profile as well as placed on the user's Desktop (not the system's).

 7. In the Ready to Install window, click Next. 

 8. Click Finish. To start Thermo-Calc find the program on the server and start it from 
there. 

How to Install a Thin Client on Linux

 1. Add the following to the smb.conf file, where <user> is your user name:
[public]

path=/home/<user>/Thermo_Calc/2025a

public=yes

writable=yes

comment=smb share

guest OK=yes

force user=<user>
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 2. From the client, mount the directory on the server computer that contains the 
Thermo-Calc server installation (by default, this directory is called 
/Thermo-Calc/2025a). How the directory is mounted depends on the Linux 
distribution being used as well as how the Thermo-Calc directory on the server 
computer is shared. Use the Linux command mount. For example:

> mkdir public

> sudo mount -t cifs //ip_number_server_computer/public ./public -o 
user=<user>

 3. Open the mounted directory on your computer, and run client-install-linux-
x64.run or client-install-linux-x86.run in the /Thin-client directory. 

 4. If you do this from the terminal window, use the following to start the installation 
(assuming that the file server is a 64-bit computer):

> ./client-install-linux-x64.run 

 5. Click Forward and click to select the license agreement. Click Forward.

 6. Enter the name or IP number of the License Server. Click Forward. 

 7. If you are installing as a non-root user, by default, the Create Shortcuts on Desktop 
checkbox is selected. Click Forward.

 8. In the Ready to Install window click Forward. 

 9. Click Finish. Log out and log back in to start using Thermo-Calc.
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Custom Network Client Installations

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

This installation type is available for all operating systems, however for macOS the License 
Server must be run on a Windows or Linux computer.The requirements are the same as for a 
full client installation.

Install the Licensing Software

Follow the instructions for your operating system:

 l Windows: About Installing the License Manager, or
 l Linux: About Installing the License Server

Complete Steps 1 to 4 of a Full Standalone Installation

Follow the instructions for Full Standalone Installations to download and run the software. It 
is up to you whether you get the computer information for the license files before or after 
installing the software.

Select the Installation Mode and the Components to Include or 
Exclude 

About the Thermo-Calc Installed Components

 1. In the Select License and Installation Mode window click Custom. Click Next.

 2. On the Specify Configuration window the Create Shortcut on Desktop checkbox is 
selected by default. Click Next.
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 3. In the Select Components window, click to select or deselect the checkboxes as 
needed. Click Next.

 

Set the Installation Directory and the File Path to the License

 1. In the Installation Directory window, either accept the default path or enter a path 
to where you want to install the software (see Installation Default Directories and the 
License File). Click the file button  to Browse for Folder and navigate to another 
directory. Click Next. 

To prevent errors, leave this field blank if you do not have a license file 
yet.
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 2. In the Choose Setup Type window, click Network Client and enter the name or IP 
number of the computer where the licensing software is installed. Click Next.

If you have selected to install TC-Python there is a reminder window 
that additional installation procedures are required after Thermo-Calc is 
installed. See the TC-Python Installation Guide.

Install the Software and Start Using Thermo-Calc

 1. In the Ready to Install window click Next.

See the separate instructions for TC-Toolbox for MATLAB®.

 2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to 
finish the installation.

For macOS installations and if you have previous Thermo-Calc installations: 
When you launch Thermo-Calc with the new or updated version, the splash 
screen hides the Import User Settings dialog box. In order to proceed you need 
to click the splash screen and then click Yes or No in the dialog box. 

If you did not get your license file see Request a License File from Thermo-Calc 
Software.
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Unattended or Silent Network Client Installations (License 
File)

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

Terminology note: The use of the term license server (lower case letters) is 
applicable to the option files as described in this section. For the purposes of 
the step-by-step instructions it is not used to refer to the type of network 
installation that runs the licensing software.

Sometimes it is convenient to install Thermo-Calc network clients without providing user 
input after the installation is initiated (an unattended network client installation), i.e. a silent 
installation. This is available for Windows and Linux operating systems.

Make sure you know the name or IP number of the computer where the 
licensing software and the license file are to be installed.

Create an Option File in a Text Editor to Enter the Options

The following is an example of an option file for a custom network client installation, where 
<name/IP number> is the name or IP number of the computer where the license file is 
installed:

installation_mode=custom

setup_type=client

enable-components=thermo,databases,tq,toolbox,tcpython

icons=1

license_server=<name/IP number>

Below is a shorter example, specifying that a full Thermo-Calc network client should be 
installed:

installation_mode=full_client

license_server=<name/IP number>
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Go to the Directory Where the Installation File is Saved 

Thermo-Calc can only be installed in unattended mode from the command line 
prompt.

Start the installation in unattended mode using the option file created with this command:

 l Windows: <installationfile>.exe --mode unattended --optionfile 
<path\optionfile> 

 l Linux:  <installationfile>.run --mode unattended --optionfile 
<path/optionfile>

To see other options when you start the Thermo-Calc installation program from the 
command line prompt, run this command:

 l Windows: <installationfile>.exe –-help
 l Linux: <installationfile>.run –-help
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TC-Python Installation Guide
In this section:

About the TC-Python Documentation 112

Which TC-Python Installation Should I Choose? 114

Installing TC-Python with a Bundled Python-interpreter 115

Installing TC-Python Into a Python-interpreter of Your Choice 119

Installation Default Directory: TC-Python 124

macOS: Setting Environment Variables 125

Fixing Potential Issues with the Environment 126

Optional Packages 127

TC-Python: Configuring a License 128

TC-Python: Setting Environment Variables 130

Updating to a Newer Version 132

TC-Python Diagnostic Script 133
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About the TC-Python Documentation

The TC-Python help is available on the Thermo-Calc website where you can also 
access additional resources. You can alternatively access the locally installed 
documentation from the Help menu in Thermo-Calc. 

Opening the  Locally Installed Documentation

 1. In Thermo-Calc from the menu, select Help → Manuals Folder. 

You can also navigate to the Manuals folder outside of Thermo-Calc and 
based on your operating system installation location.

https://www2.thermocalc.com/docs/tc-python/latest-version/html/
https://thermocalc.com/products/software-development-kits/tc-python/
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 2. In the window that opens, double-click to open the TC-Python folder. 

 3. Double-click the Index HTML file (or any of the HTML files).

 4. The API reference documentation opens as a searchable HTML file in your local 
browser. 
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Which TC-Python Installation Should I Choose?

A license is required to run TC-Python. Also remember to review the System 
Requirements page on our website.

There are these options to install TC-Python.

See the Videos about TC-Python page for additional learning resources. 

Install with the Bundled Python-interpreter

This is a straightforward installation where TC-Python is preinstalled together with some 
popular Python packages. 

This is the recommended option for new users to TC-Python who may only want to run the 
examples. The available preinstalled packages (e.g. numpy, scipy, scikit-learn, pyvista, and 
matplotlib) can also be sufficient for many advanced users. 

Installing TC-Python with a Bundled Python-interpreter.

Optional Packages

Install with a Python-interpreter of Your Choice

This installation requires additional steps and is the recommended option for more 
advanced use and has full flexibility. 

Installing TC-Python Into a Python-interpreter of Your Choice.

https://thermocalc.com/system-requirements/
https://thermocalc.com/system-requirements/
https://thermocalc.com/support/video-tutorials/tc-python/
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Installing TC-Python with a Bundled Python-interpreter

TC-Python can be installed using a Python-interpreter that is bundled to Thermo-Calc. This 
interpreter has TC-Python preinstalled together with some popular Python packages. This is 
the recommended option for new users to TC-Python who may only want to run the 
examples.  

The bundled interpreter package is also used to run the Property Models in 
Thermo-Calc. Do not make changes to interpreter packages or this can stop 
Thermo-Calc from working correctly. To fix issues caused by changes to an 
interpreter, completely uninstall Thermo-Calc and start over, either with the 
bundled interpreter package or using interpreters of your choice. 

If you are planning to do more advanced calculations that require other 
external packages then you may want to follow these instructions instead: 
Installing TC-Python Into a Python-interpreter of Your Choice

Limitations

The following examples cannot be run with the bundled Python-interpreter as 
additional packages are required: pyex_M_01_Input_from_file.py (pandas) 
and pyex_M_02_Output_to_file.py (pandas, lxml, h5py).

The bundled Python 3 interpreter contains the following major packages:

 l colour-science
 l matplotlib
 l numpy
 l scikit-learn 
 l scipy
 l pandas
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 l pyvista 
 l TC-Python
 l tmm

If you have recommendations for additional packages to include (see below), 
send an email to Thermo-Calc Support.

These TC-Python examples require additional packages that are not available in 
the bundled Python-interpreter, and thus cannot be run:  pyex_M_01_Input_
from_file.py and pyex_M_02_Output_to_file.py.

Install an IDE (Integrated Development Environment)

Any editor can be used to write the Python code, but an IDE is recommended, e.g. PyCharm. 
These instructions are based on the use of PyCharm.

Use of an IDE gives you access to code completion, which  helps when you use the API as it 
gives you the available methods on the objects you are working with.

 1. Navigate to the PyCharm website: https://www.jetbrains.com/pycharm/download. 

 2. Click to choose your OS and then click Download. You can use the Community 
version of Pycharm. 

 3. Follow the instructions. It is recommended you keep all the defaults.

For Mac installations, you also need to set some environment variables as 
described below in macOS: Setting Environment Variables.

 Configure PyCharm to Use the Bundled Python-interpreter

Open PyCharm and configure the interpreter:

mailto:support@thermocalc.com?subject=Suggestion for new TC-Python packages with the bundled installation
https://www.jetbrains.com/pycharm/download
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 1. Go the menu File → Settings.

 2. Navigate in the tree to Project: YourProjectName and choose Project Interpreter.

 3. Click on the settings symbol close to the Project Interpreter dropdown menu and 
choose Add.

 4. Select System Interpreter and add the bundled Thermo-Calc Python 3 interpreter, 
which is located in a folder based on the operating system: 

Operating 
system Path to the bundled Python-interpreter

Windows C:\Program Files\Thermo-Calc\2025a\python\python.exe

Linux /home/UserName/Thermo-Calc/2025a/python/bin/python3

macOS /Applications/Thermo-Calc-2025a.app/Contents/Resources/python/bin/python3

 5. Select the interpreter and confirm.

Run a TC-Python Example

It is recommended that you open one or more of the included examples to both check that 
the installation has worked and to start familiarizing yourself with the code.

If you have a license activation type based on user credentials you first need to 
activate your license. See License Activation with User Credentials.

Open the TC-Python Project in PyCharm

When you first open the TC-Python project and examples, it can take a few 
moments for the Pycharm IDE to index before some of the options are 
available.

 1. Open  PyCharm and then choose File  → Open. The first time you open the project 
you will need to navigate to the path of the TC-Python installation based on your 
operating system.
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Operating 
system Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2025a\SDK\TC-Python

Linux /home/UserName/Thermo-Calc/2025a/SDK/TC-Python

macOS /Users/Shared/Thermo-Calc/2025a/SDK/TC-Python

 2. Click the Examples folder and then click OK.

 3. From any subfolder:
 l Double-click to open an example file to examine the code. 
 l Right-click an example and choose Run.

If you are not following the recommended approach and create a new project 
(File → New Project…), you need to consider that by default the options to 
choose the interpreter are hidden within the Create Project window. For this, 
click Project Interpreter: New Virtual Environment and in most cases choose 
your System Interpreter containing the Python bundled to Thermo-Calc instead 
of the default New Virtual Environment.
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Installing TC-Python Into a Python-interpreter of Your 
Choice

TC-Python can be installed using a Python-interpreter of your choice. This is the 
recommended option for any more advanced usage and provides full flexibility. 

If you are new to TC-Python and want to mainly run the examples, then it is 
recommended you install the bundled Python-interpreter.  The available 
preinstalled packages (e.g. numpy, scipy, scikit-learn, pyvista, and 
matplotlib) can also be sufficient for many advanced users. See Installing 
TC-Python with a Bundled Python-interpreter.

Install a Python Distribution

If you already have a Python distribution installation, version 3.8 or newer, skip 
this step.

These instructions are based on using the Anaconda platform for the Python distribution. 
Install version 3.8 or newer to be able to work with TC-Python, although it is recommended 
that you use the most recent version. 

INSTALL ANACONDA

 1. Navigate to the Anaconda website: https://www.anaconda.com/download/. 

 2. Click to choose your OS (operating system) and then click Download. Follow the 
instructions. It is recommended you keep all the defaults.

Install Thermo-Calc and the TC-Python SDK

 1. Install Thermo-Calc. 

 2. When the installation is complete, open the TC-Python folder that includes the *.whl 
file needed for the next step. There is also an Examples folder with Python files you 
can use in the IDE to understand and work with TC-Python. 

https://www.anaconda.com/download/
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Install TC-Python

Updating to a Newer Version

On Windows, it is recommended you use the Anaconda distribution prompt (i.e. Anaconda), 
especially if you have other Python installations. 

Do not use Virtual Environments unless you have a good reason to do so. Also 
see Fixing Potential Issues with the Environment.

 1. Open the command line. For example, in Anaconda on a Windows OS, go to Start  → 
Anaconda  → Anaconda Prompt. 

 2. At the command line, enter the following. Make sure there are no spaces at the end 
of the string or in the folder name or it will not run: 

pip install <path to the TC-Python folder>/TC_Python-<version>-
py3-none-any.whl

On Linux, and depending on the interpreter, pip3 is typically used.

Operating 
system Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2025a\SDK\TC-Python
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Operating 
system Path to the TC-Python folder

Linux /home/UserName/Thermo-Calc/2025a/SDK/TC-Python

macOS /Users/Shared/Thermo-Calc/2025a/SDK/TC-Python

 3. Press <Enter>. When the process is completed, there is a confirmation that 
TC-Python is installed.

If your computer is located behind a proxy-server, the default pip-
command will fail with a network connection error. In that case you 
need to install the dependency py4j in a special configuration:

pip install -proxy user:password@proxy_ip:port py4j jproperties

Go to the TC-Python Help Troubleshooting section for detailed 
information. This can be found on our website or from the installed 
documentation where you can search for "pip install fails" with “Failed 
to establish a new network connection” or similar.

Install an IDE (Integrated Development Environment)

Any editor can be used to write the Python code, but an IDE is recommended, e.g. PyCharm. 
These instructions are based on the use of PyCharm.

Use of an IDE gives you access to code completion, which  helps when you use the API as it 
gives you the available methods on the objects you are working with.

 1. Navigate to the PyCharm website: https://www.jetbrains.com/pycharm/download. 

 2. Click to choose your OS and then click Download. You can use the Community 
version of Pycharm. 

 3. Follow the instructions. It is recommended you keep all the defaults.

For Mac installations, you also need to set some environment variables as 
described below in macOS: Setting Environment Variables.

https://www2.thermocalc.com/docs/tc-python/latest-version/html/
https://www.jetbrains.com/pycharm/download
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Open the IDE and Run a TC-Python Example

After you complete all the software installations and set up the pip install path, you are 
ready to open the IDE to start working with TC-Python.

It is recommended that you open one or more of the included examples to both check that 
the installation has worked and to start familiarizing yourself with the code.

If you have a license activation type based on user credentials you first need to 
activate your license. See License Activation with User Credentials.

Open the TC-Python Project in PyCharm

When you first open the TC-Python project and examples, it can take a few 
moments for the Pycharm IDE to index before some of the options are 
available.

 1. Open  PyCharm and then choose File  → Open. The first time you open the project 
you will need to navigate to the path of the TC-Python installation based on your 
operating system.

Operating 
system Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2025a\SDK\TC-Python

Linux /home/UserName/Thermo-Calc/2025a/SDK/TC-Python

macOS /Users/Shared/Thermo-Calc/2025a/SDK/TC-Python

 2. Click the Examples folder and then click OK.

 3. From any subfolder:
 l Double-click to open an example file to examine the code. 
 l Right-click an example and choose Run.
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Also see Optional Packages if you are using the Additive Manufacturing Module 
for simulations. 
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Installation Default Directory: TC-Python

These are the default paths to the TC-Python folder based on your operating system.

Operating 
system Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2025a\SDK\TC-Python

Linux /home/UserName/Thermo-Calc/2025a/SDK/TC-Python

macOS /Users/Shared/Thermo-Calc/2025a/SDK/TC-Python

For a bundled Python-interpreter installation, these are the paths to this location based on 
your operating system. 

Operating 
system Path to the bundled Python-interpreter

Windows C:\Program Files\Thermo-Calc\2025a\python\python.exe

Linux /home/UserName/Thermo-Calc/2025a/python/bin/python3

macOS /Applications/Thermo-Calc-2025a.app/Contents/Resources/python/bin/python3
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macOS: Setting Environment Variables

In order to use TC-Python on macOS you need to set some environment variables.

TC25A_HOME=/Applications/Thermo-Calc-2025a.app/Contents/Resources

User Credentials License Activations
TC_LICENSE_SPRING=y

License File Type Activations

If you use a license server:

LSHOST=<name-of-the-license-server>

If you have a node-locked license:

LSHOST= NO-NET

LSERVRC=/Users/Shared/Thermo-Calc/lservrc

PyCharm IDEs

In PyCharm, you can add environment variables in the configurations. 

Select Run  → Edit Configurations to open the Run/Debug Configurations window. Enter 
the environment variable(s) by clicking the button to the right of the Environment Variables 
text field. Now the environment variables(s) will be set for each new configuration by 
default. 

Existing configurations need to be removed and recreated to obtain the 
environment variables in them.

The same way for configuring the environment variables can be used on other operating 
systems as if necessary.
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Fixing Potential Issues with the Environment

In most cases you should run TC-Python within your global Python 3 interpreter and not use 
Virtual Environments unless you have a good reason to do so. 

If there are problems with the interpreter settings, for example, a common problem when 
you first use TC-Python is the message No module named tc_python, which you can resolve 
in the Settings window as follows:

 1. Go the menu File  → Settings.

 2. Navigate in the tree to <Project.YourProjectName> and choose Project Interpreter.

 3. Click on the settings symbol close to the Project Interpreter drop-down menu and 
choose Add.

 4. Now choose System Interpreter and add your existing Python 3 interpreter.

 5. Select your added interpreter and confirm.

If you are not following the recommended approach and create a new project 
(File → New Project…), you need to consider that by default the options to 
choose the interpreter are hidden within the Create Project window. For this, 
click Project Interpreter: New Virtual Environment and in most cases choose 
your System Interpreter containing the Python bundled to Thermo-Calc instead 
of the default New Virtual Environment.

If you really need to use a Virtual Environment, it is recommended you review 
the hints provided in the Best Practices section in the full TC-Python HTML help 
or PDF.
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Optional Packages

Plotting results of Additive Manufacturing simulations requires the package pyvista. It is 
automatically installed if using the option [am-plotting] during the installation: 

pip install <path to the TC-Python folder>/TC_Python-<version>-py3-none-any. 
,!whl[am-plotting] 

The bundled interpreter contains pyvista by default.
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TC-Python: Configuring a License

TC-Python requires a license to run. If you do not yet have the information about your 
license, contact Thermo-Calc Support at support@thermocalc.com.

If you have no valid license, an exception is thrown that states: NO LICENSE: No 
activated license for TC-Python.

Depending on the type of license, different steps are required to configure TC-Python to use 
it.

Environment Variables

Some environment variables need to be set. On Windows this is normally done during the 
installation of Thermo-Calc, but on Linux and macOS this needs to be performed for each 
used IDE or terminal. 

TC-Python: Setting Environment Variables

License Activation with User Credentials

This section is applicable to licenses that are activated after entering user 
credentials (i.e. user name and password). You need to activate the TC-Python 
license directly on your computer. The TC-Python license is a separate license 
from the Thermo-Calc software license. 

The activation is done with the methods in the class tc_python.license.LicenseManager. 
Depending on the type of license various methods are available, for example for online and 
offline activation.

It is recommended to simply run the example Miscellaneous/pyex_M_04_license.py to 
perform the activation and deactivation. By default an online activation is performed, but 
you can choose another method by activating another method among those being 
commented out at the end of the file.

mailto:support@thermocalc.com?subject=License Request
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To switch computers, the license must be deactivated on the first computer 
before activating it on a second computer. 



Installation Guide

TC-Python: Setting Environment Variables ǀ 130 of 199

TC-Python: Setting Environment Variables

macOS and Linux

In order to use TC-Python on macOS and Linux you need to set some environment variables.

TC25A_HOME=/Applications/Thermo-Calc-2025a.app/Contents/Resources

User Credential License Types

If you have a license based on user credentials:

TC_LICENSE_SPRING=y

License File Type Activations

If you use a license server:

LSHOST=<name-of-the-license-server>

If you have a node-locked license:

LSHOST=NO-NET

LSERVRC=/Users/Shared/Thermo-Calc/lservrc

If running in the terminal these can be set using export LSHOST=NO-NET, etc.

PyCharm IDEs

In PyCharm, you can add environment variables in the configurations.

For other operating systems, the configuration can be done in the same way as 
described below.

 1. Select Run → Edit Configurations to open the Run/Debug Configurations window. 

 2. Choose Templates and then Python. 

 3. Enter the environment variable(s) by clicking the button to the right of the 
Environment Variables text field. Now the environment variables(s) are set for each 
new configuration by default.
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Existing configurations need to be removed and recreated to obtain the 
environment variables in them.



Installation Guide

Updating to a Newer Version ǀ 132 of 199

Updating to a Newer Version

If you are using the bundled Python-interpreter automatically installed with 
Thermo-Calc, these steps are not required.

These steps are required if you have previously followed the instructions in 
Installing TC-Python Into a Python-interpreter of Your Choice.  

When updating to a newer version of Thermo-Calc, you always need to also install the latest 
version of TC-Python. It is not sufficient to run the installer of Thermo-Calc (except for 
bundled versions of the Python interpreter). 

pip install <path to the TC-Python folder>/TC_Python-<version>-py3-
none-any.whl

In case of problems you may wish to uninstall the previous version of TC-Python in advance:

pip uninstall TC-Python

pip install <path to the TC-Python folder>/TC_Python-<version>-py3-
none-any.whl

However, this should not normally be required. 

On Linux typically pip3 is used.

You can check the currently installed version of TC-Python by running:

pip show TC-Python
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TC-Python Diagnostic Script

A diagnostic script is available to help you if you have problems running TC-Python.

It is important to run the diagnostic script EXACTLY the same way as you run 
your TC-Python script (in the same IDE, same project, same Python 
environment, same Jupyter notebook, etc).

The script automatically prints useful suggestions that, in many cases, will help you to fix the 
problem yourself. If you are unable to solve the problem, contact us for support. You can 
find the script in these locations:

 l Miscellaneous example (diagnostics.py) 
 l In the Troubleshooting section of the TC-Python API Reference Documentation. Also 

refer to the Best Practices in the same guide to see if there are any other solutions or 
tips.

 l On our website. 

https://www2.thermocalc.com/downloads/support/diagnostics-py/
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TC-Toolbox for MATLAB® Installation Guide
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About TC-Toolbox for MATLAB®

TC-Toolbox for MATLAB® (TC-Toolbox) provides an interface to the commonly used 
MATLAB® software for scientific and engineering computing. This software development kit 
(SDK) is ideal for fast realization of ideas and visualization of results during research and 
development activities. The TC-Toolbox API includes calculation types available in Thermo-
Calc such as single point equilibrium, property (step) and phase (map) diagrams, Scheil 
solidification simulations, as well as all the general Thermo-Calc Property Models (e.g. yield 
strength, spinodal, driving force, etc.). 

With the addition of licenses for the applicable software and databases, you can further 
maximize your integration with MATLAB® to include the capabilities of the Steel Model 
Library Property Models (e.g. bainite, pearlite, etc.), as well as access the range of 
functionality included with the Diffusion Module (DICTRA) and the Precipitation Module (TC-
PRISMA). Generally, all the functionality available in Graphical Mode or via the TC-Python 
SDK is available.

TC-Toolbox for MATLAB® is available on Windows platforms.

A license is required to run TC-Toolbox for MATLAB® and MATLAB® must also 
be installed on your computer prior to the TC-Toolbox installation. Also 
remember to review the System Requirements page on our website.

https://thermocalc.com/system-requirements/
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TC-Toolbox Documentation

There are various locations and formats of the documentation you need related to this SDK. 

The TC-Toolbox for MATLAB® API Reference Documentation is available from 
these general locations (1) within the MATLAB® environment—both as help and 
as part of the tab completion (2) directly on the Thermo-Calc website, and (3) 
locally in the Thermo-Calc installation (Help>Manuals Folder). 

API Reference Documentation 

The TC-Toolbox for MATLAB® API Reference Documentation is available either as interactive 
help (in HTML format or when in MATLAB® using tab completion or accessed via different 
menus or key combinations) or as a standalone PDF. 

There are these ways to access the content:

 l Directly in MATLAB® via the Help menu then under Supplemental Software click 
TC-Toolbox. Help is also available when writing code and using the tab completion 
feature and/or pressing different key combinations as described in the Best Practices 
section of the help. 

 l From the website: HTML Help or PDF
 l Locally in a Thermo-Calc installation: 

 l HTML: Help > Manuals Folder > TC-Toolbox_MATLAB, then click any 
HTML file.

 l PDF: Help > Manuals Folder > Software Development Kits (SDKs), then 
double-click to open the TC-Toolbox for MATLAB® API Programmer Guide. 
This is a copy of the HTML API reference documentation.

Installation Instructions

The installation instructions  are only included in the Thermo-Calc help (press F1), and in the 
PDF version of the main installation guide found, for example:

 l On our website as part of the full Thermo-Calc Installation Guide.
 l Once Thermo-Calc is installed:

 l Locally in a Thermo-Calc installation: Help > Manuals Folder >Installation 
Guides.

 l Press F1 in Thermo-Calc to search the help.

https://www2.thermocalc.com/docs/tc-toolbox/latest-version/html/
https://www2.thermocalc.com/docs/tc-toolbox/latest-version/html/
https://thermocalc.com/content/uploads/Documentation/Current_Static/tc-toolbox-for-matlab-programmer-guide.pdf
https://thermocalc.com/content/uploads/Documentation/Current_Static/thermo-calc-installation-guides.pdf
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Thermo-Calc Help (Limited)

For TC-Toolbox, there is limited content included in the Thermo-Calc help (press F1 when in 
Thermo-Calc) because it is replaced by the TC-Toolbox for MATLAB® API Reference 
Documentation.  The exception is installation instructions to describe how to install the SDK.
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Installation Default Directory: TC-Toolbox and the Examples

The software component and the examples are installed as described below. 

This is the default path to the installation folder for the TC-Toolbox component on Windows 
operating systems. Be aware that the initial installation files and examples are placed in 
Public\Documents, then after opening Thermo-Calc for the first time, these are copied to 
the Documents folder for each user. The documentation is installed elsewhere and as 
described in TC-Toolbox Documentation.

There are included examples with all TC-Toolbox installations. These are generally the same 
as the examples included with TC-Python although with a different suffix (matex) and prefix 
(*.m or *.mlx) in the file name. Not all examples included with TC-Python are available for 
this SDK. You can read summaries about the examples as described in the online help.

Path to the TC-Toolbox folder

Both the installation files AND the examples are installed in the following folders. 

The default Windows folders where the TC-Toolbox examples are installed starts with the original installation placing 
these under Public Documents for ALL USERS. 

For a local user, and after Thermo-Calc is opened for the first time, these files are copied to the user’s Documents 
folder where this local copy is associated to the user login. The Public Documents folder always contains the original 
set of contents as per the installation.

C:\Users\Public\Public Documents\Thermo-Calc\<version>\SDK\TC-Toolbox-MATLAB

After installing Thermo-Calc, and when you first open the program, the set of folders containing the examples is 
copied from the source Public\Documents location into a user Documents folder:

C:\Users\<user>\Documents\Thermo-Calc\<version>\SDK\TC-Toolbox-MATLAB\Examples

It is recommended that you work with the files that are copied to the user folder.
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Installing TC-Toolbox

There are automatic or manual installation instructions for TC-Toolbox for MATLAB®.

Automatic Installation of TC-Toolbox

When the following conditions are met, Thermo-Calc automatically installs the TC-Toolbox 
for MATLAB® component on your computer.

 1. MATLAB® is already installed.

 2. There is only one Windows user on the computer where TC-Toolbox is being 
installed.

Administrator privileges are needed when you start the Thermo-Calc 
installer.

Then  follow the regular installation instructions for Thermo-Calc, choosing whether you use 
a Standalone or Network installation. If required also see Testing a TC-Toolbox Installation.

A reminder regarding the license. Although you do not need to have a license 
file during the installation process (it can be added after the fact), you do need 
to have purchased a license for TC-Toolbox for MATLAB® to run the program 
within MATLAB®.

Manual Installation of TC-Toolbox 

The installation is not automatic if:

 l There are multiple Windows users on the same machine, or
 l The installer cannot find the directory path to the MATLAB installation.

Multiple Windows Users on Same Machine

If there are multiple windows users on the same machine, then the following manual steps 
are done at the end of the automatic installation. 
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 1. A message at the end of the Thermo-Calc installation process displays with 
instructions. 

 2. An Explorer window automatically opens to the 
C:\Users\Public\Documents\Thermo-Calc\2025a\SDK\TC-Toolbox-MATLAB folder.

 3. Double-click the InstallTCToolboxMATLAB.cmd file to finalize the process. This 
briefly launches MATLAB® and installs TC-Toolbox. If required see Testing a 
TC-Toolbox Installation.

Installer Cannot Find the MATLAB® Installation Directory

If the Thermo-Calc installer cannot find the MATLAB® installation directory, 

 1. Start the version of MATLAB® that you want to install TC-Toolbox in.

 2. Open and run the MATLAB® script included with your installation of Thermo-Calc. 

For example on Windows, C:\Users\<username>\Documents\Thermo-
Calc\2025a\SDK\TC-Toolbox-MATLAB\setupTCToolbox.m

You can also follow the instructions for Installing TC-Toolbox with the Custom 
Option.
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TC-Toolbox: Configuring a License

TC-Toolbox requires a license to run. If you do not yet have the information about your 
license, contact Thermo-Calc Support at support@thermocalc.com.

Depending on the type of license, an additional step is required to configure TC-Toolbox for 
MATLAB® to use it.

License Activation

This section is applicable to licenses that are activated after entering user 
credentials (i.e. user name and password). You need to activate the TC-Toolbox 
license directly on your computer. The TC-Toolbox license is a separate license 
from the Thermo-Calc software license. 

The activation is done with the methods in the class tc_toolbox.LicenseManager. 
Depending on the type of license various methods are available, for example for online and 
offline activation.

It is recommended to simply run the example Miscellaneous/matex_M_04_License.m to 
perform the activation and deactivation. By default an online activation is performed, but 
you can choose another method by activating another method among those being 
commented out at the end of the file.

To switch computers, the license must be deactivated on the first computer 
before activating it on a second computer. 

mailto:support@thermocalc.com?subject=License Request
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Installing TC-Toolbox with the Custom Option

MATLAB® must be installed before you install TC-Toolbox.

As described in Installing TC-Toolbox, if MATLAB® is already installed, then Thermo-Calc  
automatically installs the files you need either using the Full Standalone or Full Network 
Client installation where you install all features. Otherwise you need to use the Custom 
installation.

The following generally describes the Custom option for either a Standalone or Network 
installation. Use the Custom option if MATLAB® is installed but the Thermo-Calc installer is 
not finding the directory path so you need to enter the path manually.

Some steps are described in more detail in other parts of this guide. 

Request your License File from Thermo-Calc Software

A reminder regarding the license. Although you do not need to have a license 
file during the installation process (it can be added after the fact), you do need 
to have purchased a license for TC-Toolbox for MATLAB® to run the program 
within MATLAB®.

Download your Thermo-Calc Installation Software 

Install MATLAB®

 Run the Thermo-Calc Installation File as an Administrator

 1. Locate the Thermo-Calc installation file on your computer. Right-click the .exe file 
and choose Run as administrator to launch the Setup program. 

 2. Accept the License Agreement and click Next.
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Select the Custom Installation Type

 1. In the Select Installation Mode window click Custom. Click Next.

 2. On the Specify Configuration window the Create Shortcut on Desktop checkbox is 
selected by default. Click Next.

 3. In the Select Components window, click to select  the TC-Toolbox for 
MATLAB checkbox. 

Remember, you must have MATLAB® already installed and may need to 
know the file path to the MATLAB® folder. If the TC-Toolbox for 
MATLAB checkbox is NOT selected, this confirms that the Thermo-Calc 
installer did NOT locate the MATLAB® installation (or it is not installed 
yet). 

 4. Click Next.

 5. If you selected the TC-Toolbox for MATLAB checkbox, the MATLAB directory 
window opens. 
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 l If MATLAB® is already installed but the Thermo-Calc installer could not find 
the path, then enter the file path to the MATLAB® installation directory or 
click the file button  to Browse for Folder and navigate to the directory. 
Click Next.

 l If MATLAB® is NOT installed, click Cancel to exit the Thermo-Calc installer 
program. Once MATLAB® is installed you can return to this process.

Set the Thermo-Calc Installation Directory and Choose the Setup 
Type

 1. In the Installation Directory window, either accept the default path or enter a path 
to where you want to install the Thermo-Calc software. Click the file button  to 
Browse for Folder and navigate to another directory. 

 2. In the Choose Setup Type window, click Standalone or Network Client.
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 l For a Standalone installation: In the Choose a license file field enter the path 
to your license file (called lservrc).

 l For a Network installation: Enter the details as required into the Enter the 
name or IP number of the licensing server field. Click Next.  

If the TC-Python checkbox is also selected to be installed (which 
it is by default), the Install TC-Python window  is a reminder that 
additional installation procedures are required after Thermo-Calc 
is installed. 

Install  and Start Using Thermo-Calc as an Add-on in MATLAB®

 1. In the Ready to Install window click Next.

If MATLAB® is not installed (and you selected the TC-Toolbox checkbox) 
a message displays to confirm that TC-Toolbox will not be installed until 
you complete the MATLAB® installation. If MATLAB is installed, click 
Back to confirm that the installation path is correct, otherwise Cancel 
this Thermo-Calc installation, install MATLAB and start again. 

 2. Click Finish. 

Test the Installation

Testing a TC-Toolbox Installation
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Testing a TC-Toolbox Installation

Generally you can check the installation by first looking in the Home tab to see if the 
program is in the menu. Then proceed to running the diagnostic script or another example. 

To check the installation, in MATLAB®:

 1. From the Add-Ons menu, select Manage Add-Ons. 

If TC-Toolbox is in the list it is likely it installed correctly but it is recommended you 
run the diagnostic script or another example to confirm.

 2. Run the diagnostics script from the folder C:\Users\<user>\Documents\Thermo-
Calc\2025a\SDK\TC-Toolbox-MATLAB\Examples\Miscellaneous or open and run 
any other example to test.

The TC-Toolbox diagnostic script is also available from our website.

https://www2.thermocalc.com/downloads/support/diagnostics-m/
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TC-Toolbox Installation Troubleshooting

Below are some suggestions to help troubleshoot a TC-Toolbox for MATLAB® installation.

Diagnostic Script

A diagnostic script is available to help you if you have problems running TC-Toolbox. 

It is important to run this script EXACTLY the same way as you run your 
MATLAB® script.

The script automatically prints useful suggestions that, in many cases, will help you to fix the 
problem yourself. If you are unable to solve the problem, contact us for support. 

The script is based on the version of Thermo-Calc installed and named tc-toolbox-
diagnostic-script-2025a.m. You can find the script in these locations:

 l As an example (diagnostics.m) located in this folder 
C:\Users\<user>\Documents\Thermo-Calc\2025a\SDK\TC-Toolbox-

MATLAB\Examples\Miscellaneous 
 l In the Troubleshooting section of the TC-Toolbox for MATLAB® API Reference 

Documentation. Also refer to the Best Practices in the same guide to see if there are 
any other solutions or tips.

 l On our website. 

 MATLAB® Installation Directory Not Found

For Windows installations of the TC-Toolbox for MATLAB® component, you may get an error 
message or window asking for the MATLAB® installation directory path. 

The most common reason for this is that MATLAB® is not installed. If this is the 
case, exit the Thermo-Calc installation, install MATLAB® and then run the 
Thermo-Calc installation program again.

If MATLAB® is installed and Thermo-Calc just did not find the file path during the installation 
setup process, then enter the path in the field when prompted. 

https://www2.thermocalc.com/downloads/support/diagnostics-m/
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Determining the Licensing Software Version (Network Installs)

Sometimes you may need to know the version of License Manager (Windows) or License 
Server (Linux) software being used. This can be useful while troubleshooting network 
installations.

 l On Windows open a command prompt and go to the directory where lservnt.exe is 
found. For example:

>C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT

Type the command >lservnt.exe –help and the version is displayed.

 l On Linux open a Terminal window and go to the directory where the lserv script is 
saved. For example:

>cd opt/Thermo-Calc/<version>/Licensing-files

Type the command >./lserv –help and the version is displayed.

Silent Installations

Administrative rights are required to install the Thermo-Calc software package. If you or 
your IT department are having problems silently installing  TC-Toolbox over a network, 
perhaps to multiple computers, you need to run a file that is available after Thermo-Calc is 
installed.

 1. Install Thermo-Calc as usual (requires administrative rights). 

 2. After Thermo-Calc is installed, navigate to this folder: 

C:\Users\Public\Documents\Thermo-Calc\<2025a>\SDK\TC-Toolbox-MATLAB\.

 3. Double-click the InstallTCToolboxMATLAB.cmd file to run it 

The InstallTCToolboxMATLAB.cmd file must be run by the user who is 
going to use TC-Toolbox for MATLAB®, i.e. anyone with admin rights can 
install Thermo-Calc, but for TC-Toolbox, the user must be logged in to 
run this file. 
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Uninstalling TC-Toolbox for MATLAB®

Uninstallation requires that the user is logged in with administrator rights and Thermo-Calc 
is installed for this same user. Then the uninstallation is automatically completed as part of 
the uninstallation of Thermo-Calc.  Otherwise a manual step is required.

To uninstall TC-Toolbox (when not automatically uninstalled):

 1. Start MATLAB®. 

 2. In the Home tab from the Add-Ons menu, select Manage Add-Ons. 

 3. Right-click TC-Toolbox and choose Uninstall.
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Working with Existing Installations
Also see Uninstalling TC-Toolbox for MATLAB®

In this section:

Add New Components to an Existing Installation 151

Updating the Software for Interim Releases 152

Uninstalling Thermo-Calc 158
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Add New Components to an Existing Installation 

If you want to add new components to an existing Thermo-Calc installation (for example, 
you purchased a license for TC-Toolbox for MATLAB®), run the  installation again.

Custom User Credentials Installations and Custom Standalone Installations 
(License File)

 1. For Windows and macOS you need to have administrative level rights. For example in 
Windows, when you double-click the executable Thermo-Calc installation .exe file to 
launch the Setup program. 

Linux OS: If Thermo-Calc was not installed by root the first time, then 
administrative rights are not required. 

 2. Click Next. Click to accept the license agreement. 

 3. Select the additional component(s) to install.  

 4. Click Next to start the installation, which adds the new component(s). 

Use the Uninstall program to remove components. See Uninstalling 
Thermo-Calc or Uninstalling TC-Toolbox for MATLAB®.
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Updating the Software for Interim Releases

The full version of Thermo-Calc software is released twice a year. The software releases are 
named after the year of the release followed by an “a” for the first release of the year or a 
“b” for the second release of the year. For example, this release is 2025a.

Occasionally after a full release, an interim release version, an update, is required to fix a 
serious bug or to address an external issue that occurred after the full release. Software 
licenses come with a free 12 month Maintenance & Support Subscription, starting from the 
time of purchase, and this includes these software updates. 

Go to our website to confirm the current distributed software version and 
determine if there are updates, or to learn more about Maintenance and 
Support options. 

Check for a Software Update

You can set your software to automatically check for updates upon start up.

 l From within the software on the Options window, General tab, set Check update 
interval to On start up. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> 

on the keyboard.

 l If you do not have Automatic Updates on you can go to Help →  Check for 

https://thermocalc.com/current-software-versions/
https://thermocalc.com/maintenance-and-support/
https://thermocalc.com/maintenance-and-support/
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Updates.

Follow the Installation Instructions for the Applicable OS

After the software has checked for updates and determined there is one, the applicable 
installation file for your operating system is downloaded. Then follow the instructions 
provided in the Installation Guide for the specific operating system and license type. 

For an update to the software, no additional license files or user credentials are 
required.  

Option to Save Backup User Created Files

There are significant operating system differences regarding what backup files 
are saved if you are installing an update on Windows versus macOS or Linux. 

During the installation process, several default folders are added to your system that include 
documentation, materials, and example files. This is the same for all operating systems. 
During an update, Thermo-Calc runs a check of these default folders to determine if there 
are changed or new user files that are saved in these folders. For example, you might have 
saved a completely new project *.tcu file into the Examples folder, or after running one of 
the included examples such as T_06_Serial_Equilibrium_Calculators.tcu, the default file is 
changed and now includes results. 

On Windows operating systems,  Thermo-Calc gives you the opportunity after the installation 
to specifically save a backup of these user created or modified files to your Documents 
folder when you open Thermo-Calc for the first time after the update. 
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However, for macOS and Linux operating systems, the behavior is different due to 
limitations enabling the identification of changes to some files. 

Operating 
System

When does 
backup occur? What files are copied?

Windows

After installation, 
when you open the 
software for the 
first time

Documents, Materials, and/or Examples files are copied when you 
choose Yes at the prompt (see the Windows section for details).

macOS

During installation

There is an option during the installation process to save a backup copy 
of the Examples folder even if no changes are made to files (see the 
macOS or Linux sections for details). 

Materials and Documents folders are not automatically 
copied even if there are file changes or additions. 
However, you can always manually back up these 
folders (see the macOS or Linux sections for details). Linux

Windows

First complete the installation update. Then when you open Thermo-Calc for the first time, 
and if Thermo-Calc identifies that there are changed files, you are prompted with a Software 
Update - Action Required window that identifies the folders where the applicable files are 
changed or added. 

These file types are not kept, i.e. these are excluded: dll, exe, lib, mltbx, pdf, 
whl, html, and htm.

Click Yes to save a backup of these  changed files or No to continue opening Thermo-Calc as 
normal where the default set of folders are copied from the source Public Documents 
location into a user Documents folder. 

If you choose to save a backup of the files, the new backup folder is added to this same 
location, for example:

C:\Users\<user>\Documents\Thermo-Calc\2025a_backup

Installation Default Directory: Windows 
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macOS

During the installation process you are prompted with a Software Update - Action Required 
window. 

This window always displays whether there are changes or additions to the 
folders or not. 

The Materials and Documentation folders do not automatically have a backup 
saved. If you think there are user files you want to keep it is recommended that 
you click Cancel at this prompt to exit the installer, then manually copy the 
folders to another location. Then start the installation update process again. 

To create a backup copy of the Examples folder, including changed files (i.e. all files are 
copied, not just the changed or new ones). Options at this prompt are to click:

 l Yes to create the backup.
 l No to replace all files. 
 l Cancel to exit the installation process, i.e. to manually save a backup of any other 

folder.

The default backup folder containing a full copy of all the contents of the Examples folder is 
saved to this location, for example:

/Users/Shared/Thermo-Calc/2025a/Examples_backup
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Installation Default Directory: macOS

Linux

During the installation process you are prompted with a Software Update - Action Required 
window. 

This window always displays whether there are changes or additions to the 
folders or not. 

The Materials and Documentation folders do not automatically have a backup 
saved. If you think there are user files you want to keep it is recommended that 
you click Cancel at this prompt to exit the installer, then manually copy the 
folders to another location. Then start the installation update process again. 

To create a backup copy of the Examples folder, including changed files (i.e. all files are 
copied, not just the changed or new ones). Options at this prompt are to click:

 l Yes to create the backup.
 l No to replace all files. 
 l Cancel to exit the installation process, i.e. to manually save a backup of any other 

folder.
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The default backup folder containing a full copy of all the contents of the Examples folder for 
Linux depends if you are a root super user requiring administrative privileges or a common 
user. 

For example, for a common user:

/home/<user>/Thermo-Calc/2025a/Examples_backup

For example, for a root user:

/opt/Thermo-Calc/2025a/Examples_backup

Installation Default Directory: Linux
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Uninstalling Thermo-Calc

Uninstalling TC-Toolbox for MATLAB®

Windows 11

 1. From Start , go to Settings → Apps → Installed Apps.

 2. In the list of programs, locate the version of Thermo-Calc you want to uninstall. Click 
the three dots to the right of the row.

 3. Select Uninstall. Select Uninstall a second time.

 4. Enter your admin level user credentials. 

 5. In the Setup window, Uninstallation Mode dialog box, choose to uninstall the Entire 
application or Individual components. Follow the instructions to finish.

You can also directly launch the Thermo-Calc uninstaller program:

 1. Navigate to where the Thermo-Calc program is installed, i.e in the Program Files 
folder. 

 2. Locate the uninstaller program, named Thermo-Calc-<version>-uninstaller.exe.

 3. Double-click and enter your admin level user credentials. 

 4. In the Setup window, Uninstallation Mode dialog box, choose to uninstall the Entire 
application or Individual components. Follow the instructions to finish.

Windows 10

 1. From the Control Panel Desktop app, go to Programs → Programs and Features → 
Uninstall or change a program.

 2. In the list of programs, locate the version of Thermo-Calc you want to uninstall. Click 
to highlight that row.

 3. Click Uninstall/Change.

 4. In the Setup window, Uninstallation Mode dialog box, choose to uninstall the Entire 
application or Individual components. Follow the instructions to finish.
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macOS 

Deleting the program from the Applications folder does not remove the program from your 
operating system. Run the Thermo-Calc-<version>-uninstaller program located in the 
Applications folder. 

 1. Go to the Applications folder and double click the file that starts with Thermo-Calc-
<version>-uninstaller. Enter the administrator’s user name and password.

 2. Click Yes to choose Entire application or select individual components. Otherwise 
click No to quit.

 3. The Uninstalling Thermo-Calc window shows the progress. Click OK when prompted.

Linux

 1. To start the uninstallation procedure, in the Thermo-Calc installation directory use 
the command
./Thermo-Calc-2025a-uninstaller.run

For Thin Client installations, use the command 

./Thermo-Calc-client-2025a-uninstaller.run

 2. To remove the whole application, including all its components, select Entire 
application and click Forward, or to remove specific components, select Individual 
components and click Forward. 

If you intend to reinstall Thermo-Calc 2025a it is important to (1) Restart the 
computer before you reinstall the software and (2) remove the environmental 
variable TC25A_HOME. 
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Request License Files

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

In this section:

Request a License File from Thermo-Calc Software 161

Getting License Information for License File Activations Using Thermo-Calc 162

Requesting the License File for Windows or Linux 163

Requesting the License File for macOS 165
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Request a License File from Thermo-Calc Software

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The following explains how to retrieve the necessary diagnostic and network adaptor 
information about your computer and then send an email to Thermo-Calc Software to get 
your license file(s) containing the license key(s). 

To set up the correct licensing: 

 1. Make a note of your company or organization’s site number. You can find the site 
number on an invoice or any correspondence from Thermo-Calc Software.

 2. Retrieve your computer diagnostic and network adapter information.

 3. Email Thermo-Calc Software with this information.

 4. A Thermo-Calc Software representative emails you the license file. Save the license 
file lservrc (there is no file suffix) to a location where you can easily access it later.

 Thermo-Calc Support Center on our website

https://thermocalc.com/support/
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Getting License Information for License File Activations 
Using Thermo-Calc

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

Viewing and using the license information is based on the license activation type. When you 
have a license file activation type, you may need to copy information to provide to Thermo-
Calc. 

In Graphical Mode, and if you have already installed Thermo-Calc, you can view the license 
information by selecting Help →  Show License Info. 

In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.

 1. Open Thermo-Calc.

 2. Click the Switch to Console Mode button  . 

 3. At the SYS: prompt, enter DISPLAY_LICENSE_INFO.You can output the information to 
a FILE or to the SCREEN.

 4. For both options, the information is displayed on screen. Copy the section containing 
the Ethernet and IP address. You can save it to a text file or paste it directly into an 
email. If you choose FILE as the output, then you can attach the file to an email. 
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Requesting the License File for Windows or Linux

Upgrading to a new version of Thermo-Calc: Skip this section if you are 
upgrading to a new version of Thermo-Calc (and you have a maintenance plan), 
or you have already been provided with the license file.  

 1. Your license information is sent to you in an email from Thermo-Calc or a 
representative. When you are sent a license file, save it to your computer to use 
during software installation. You may also need to provide some information that is 
accessed from Thermo-Calc. 

Select Help → Show License Info. 

 2. Copy the information from the License Information window. A lot of information 
may be shown below the initial screen, so make sure you scroll down to the end 
when you select and copy the window's contents. (Alternatively, you can copy the 
same information from the console by using the SYS module command DISPLAY_
LICENSE_INFO.)

 3. Send an email to support@thermocalc.com. Make sure to include the following in 
the subject line:

License diagnostic information from <Name> where Name is replaced with your 
name, the organization name and the Site Number. You can find the five-digit site 
number on an invoice or any correspondence from Thermo-Calc Software. 

mailto:support@thermocalc.com?subject=License diagnostic information from <Name>
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 4. A representative from Thermo-Calc Software replies to the email and attaches your 
license file(s).

 5. Save the license file(s) to your computer or network.
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Requesting the License File for macOS

Upgrading to a new version of Thermo-Calc: Skip this section if you are 
upgrading to a new version of Thermo-Calc (and you have a maintenance plan), 
or you have already been provided with the license file.  

 1. From the Apple main menu, select System Preferences.

 2. Click Network.

 3. In the left column select Ethernet or Built-in Ethernet (do not select a WiFi 
connection as a local static MAC address is required).

 4. Click Advanced → Hardware. The Network window shows you the MAC Address. For 
example, the MAC address (the host ID) might be 3c:07:54:28:5f:72.

 5. Send an email to support@thermocalc.com and copy and paste the MAC address 
into the body of the email. Make sure to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your 
name, the organisation name and the Site Number. You can find the five-digit site 
number on an invoice or any correspondence from Thermo-Calc Software.  

mailto:support@thermocalc.com
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 6. A representative from Thermo-Calc Software replies to the email address provided 
and attaches your license file or files. 

 7. Save your license file to your computer or network.
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Troubleshooting and Miscellaneous

There are diagnostic scripts available for TC-Python and TC-Toolbox for 
MATLAB® (these are included as examples in the Miscellaneous folder).  These 
scripts are also available on our website.

In this section:

macOS Installation Notes 168

Linux Installation Notes 170

License Errors 171

Determining the Current License File Directory Path 173

Specifying a New Server Name or IP Number 175

Firewalls 177

Client/Server Mismatch 178

macOS Installations: Running the License Initialization Script 180

Linux Installations: Running the License Initialization Script 181

https://thermocalc.com/support/documentation/
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macOS Installation Notes

How to Restart After an Installation

In some types of installations (e.g. a network installation), you may have to restart your Mac 
to use Thermo-Calc for the first time. 

Rosetta is Required when there is an ARM Processor

To install and run Thermo-Calc on a Mac computer with an ARM processor, 
Rosetta first needs to be installed.

How to Install XQuartz

The XQuartz open-source X Windows system is required to run Thermo-Calc on macOS  but it 
is not required to install Thermo-Calc. Before installing Thermo-Calc, you may also need to 
ensure that the computer security permissions are set.

The XQuartz open-source X.Org X Window system is required to run Thermo-Calc on macOS. 

 1. In a web browser go to https://www.macupdate.com or to download it directly from 
XQuartz, https://www.xquartz.org/.

 2. In the Search Mac Apps field, enter XQuartz.

 3. Click the XQuartz search result. For example, based on the recent version, the name is 
XQuartz-2.8.5.dmg.

 4. Click Download. 

 5. Double-click the XQuartz-<version>.pkg file. Follow the instructions.

 6. Click OK when the message about logging out displays and click Close when the 
installation is successful.

https://www.macupdate.com/
https://www.xquartz.org/
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How to Enable the Security Settings

 1. From the Apple main menu, select System Preferences.

 2. Click Security and Privacy.

 3. Click General. At the bottom of the Security & Privacy window, click the lock icon to 
make changes. Enter the administrator password as required.

 4. If you have already tried to launch the Thermo-Calc installer, you can click Open 
Anyway to proceed. Otherwise, under Allow apps downloaded from: click Anywhere 
and then Allow from Anywhere.

 5. Continue with the applicable installation type (standalone or network). 

Remember to reset your security after installing Thermo-Calc.
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Linux Installation Notes

The following are details you need to know regarding your Linux installation as well as how 
to open Thermo-Calc.

openSUSE Administration (sudo) Users 

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc 
using this command:

sudo ./Thermo-Calc-linux-<full-version-number>.run

When this command is used, you will do a text-based installation instead of having a 
graphical interface to guide you. The information  is the same, just without the user 
interface. 

For example, the <full-version-number> is not just 2025a, it is what is found in 
the Help → About window in Thermo-Calc and it changes every release. You 
can find the current full version number listed on our website.

Opening Thermo-Calc in Linux

To open Thermo-Calc double-click the Thermo-Calc-2025a application or from the 
Thermo-Calc installation directory enter $ ./Thermo-Calc-2025a.sh in the terminal.

https://thermocalc.com/current-software-versions/
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License Errors

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

Issue Platform Installation 
type Action or link to more information

How do I add or update a 
standalone (SUNLL) license 
on a Windows computer 
where Thermo-Calc is 
already installed?

Windows Standalone Determining the Current License File 
Directory Path

How do I add or update a 
standalone (SUNLL) license 
on a Linux computer where 
Thermo-Calc is already 
installed?

Linux Standalone Determining the Current License File 
Directory Path

How do I add or update a 
network license on 
Windows?

Windows Network Determining the Current License File 
Directory Path

How do I add or update a 
network license on Linux? Linux Network Determining the Current License File 

Directory Path

No license file found. Copy a 
valid license file to the 
installation directory after 
completing the installation.

All All

You get this message if the wrong path or 
no license file is found at a path entered 
during the installation process. See 
Installation Default Directories and the 
License File and Determining the Current 
License File Directory Path

TC-Toolbox for MATLAB® Windows All TC-Toolbox Installation Troubleshooting

Warning Environment 
variable “LSHOST” is not set. 
Software will not function 
properly.

All Network Specifying a New Server Name or IP 
Number

Problem running post-install 
step. Installation may not 
complete correctly. 

Linux and 
Mac Standalone

macOS Installations: Running the License 
Initialization Script or Linux Installations: 
Running the License Initialization Script
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Issue Platform Installation 
type Action or link to more information

Unable to run post-
installation script, run the 
license initialization script as 
root after the installation.

Firewall warnings related to 
license management 
software (License Manager 
and License Server)

Windows and 
Linux Network Firewalls

Client / Server naming 
mismatches

Windows and 
Linux Network Client/Server Mismatch

InstallScript engine missing Windows Network 

You are not notified if the InstallScript 
scripting engine is not installed. Install the 
ISScript.msi file and then run the 
downloaded file from Thermo-Calc again as 
described in Windows: About Installing the 
License Manager  

License initialization warning 
on a Mac with ARM 
processor

Mac Standalone

To install and run Thermo-Calc on a Mac 
with ARM processor, Rosetta needs to be 
installed. Cancel any installation in 
progress, install Rosetta, then start the 
installation again. 
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Determining the Current License File Directory Path

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

This topic explains how to find out where your license file is installed, either by default or if a 
different directory was chosen for previously installed versions. For new installations, where 
you may not have had a license file when you installed Thermo-Calc, you can also use these 
instructions to determine the correct file path. 

From Thermo-Calc

If you have already installed Thermo-Calc, you can view the path to the license file in the 
GUI. Select Help → Show License Info. 

In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.

Windows Standalone Installations

How do I add or update a standalone (SUNLL) license on a Windows computer where 
Thermo-Calc is already installed?

 1. Unpack the .zip file that contains your standalone license and save the LSERVRC file 
on your computer. Find out where to place the new license file by opening a 
Command Prompt Window (cmd.exe) and type in the command line:

>set LSERVRC

 2. Press Enter. The output from the command is the path to the license file (including 
the name of the license file). For example: if the output is

LSERVRC=C:\Users\<user>\Documents\Thermo-Calc\lservrc

then the new license file should be placed in C:\Program 
Files\Thermo-Calc\2025a\

Linux Standalone Installations

How do I add or update a standalone (SUNLL) license on a Linux computer where 
Thermo-Calc is already installed?
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Find out where to place the new license file by opening a Terminal window and type in the 
command line:

echo $LSERVRC

Windows Network Installations

How do I add or update a network license on Windows?

Only the WlAdmin tool can be used to update the network license used by the License 
Manager. See Install the Thermo-Calc Network License Using WIAdmin.

Linux Network Installations

How do I add or update a network license on Linux?

Replace your current license file with the new license file. The license file is located in the 
same directory as the license server.
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Specifying a New Server Name or IP Number

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

The Thermo-Calc Setup wizard does not warn you if the name or IP number entered to the 
server (with the license management software) is incorrect. 

If the name or IP number is not set at all, or if it is set to an empty string, then when you 
start Thermo-Calc the following message displays: Warning Environment variable “LSHOST” 
is not set. Software will not function properly. 

Windows

This section explains how to specify or change the name or IP number of the server where 
the License Manager is installed and for a consolidated network client installation.

To install a license for an existing Thermo-Calc program, follow these steps:

 1. Close all running Thermo-Calc programs.

 2. Open a command line window. 

 3. Specify the name or IP number of the licensing software server. Type: 
set LSHOST=<name/IP number>

To display the current name or IP number, type:
set LSHOST

macOS

Permanently set the environmental variable LSHOST to specify a new licensing server name 
or IP number. Refer to the file /Applications/Thermo-Calc-
2025a.app/Contents/Info.plist. 

In this file, you can manually set the TC25A_HOME variable, which specifies the home 
directory of the Thermo-Calc program. See the Info.plist file for an example.
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Linux

You can set or change the name or IP number of the license server at a later time by setting 
the environmental variable “LSHOST” to this name or number.
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Firewalls

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

Windows

For a Windows License Manager installation you may have to change the system firewall 
settings to allow the License Manager to communicate with the computers running the 
client applications. Go to the Windows Firewall settings window to see if there are any 
problems. If prompted, select Unblock the system firewall for the Sentinel RMS License 
Manager and click Next.

Linux

For a Linux License Server installation you need to open the UDP port 5093 in your firewall. 
In case you have installed SELinux you might also need to disable it by setting 
SELINUX=permissive in the /etc/selinux/config file.
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Client/Server Mismatch

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

For some network installations there can be a naming mismatch that causes errors. The 
server (where the license management software is installed) gets information from its DNS 
servers that an IP address (aaa.bbb.ccc) belongs to a computer (Computer A). But the client 
computer identifies itself as having a different IP address (aaa.bbb.ccc.eee) for the same 
computer (Computer A).

Even if the IP address of the client computer belongs to a subnet range listed in the license 
file, there is a problem with accessing the license file because the computer name does not 
match the information.

You may need your organisation’s network administrator to assist with this issue.

How to Check

Compare computer names on the client computer and server

 1. On the client computer, start a command prompt cmd.exe and type ipconfig /all. 
Press Enter. A variety of data is displayed on screen. Write down the following 
information for later comparison:

 l Hostname
 l DNS Suffix
 l Current IPv 4 Address

 2. In the command window, type nslookup <client_computer_name>, where client_
computer_name is the actual name of the client. Press Enter. 

This shows what information is saved on the DNS Servers used by the client 
computer. This information should match what is shown in the output from 
the first step.

 3. On the server that holds the license management software, open a command 
prompt and run the command line: nslookup client_computer_name. The output 
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lists the information for this server.

Does it match the information given by the command ipconfig /all on the 
client computer? If not try the following.

Try these options to correct the issue

 1. If the client computer has a dynamic (DHCP) IP address, either change it to a static 
one or make a reservation on the DHCP Server so that the computer always get the 
same IP address. 

 2. Update the records on the DNS Servers used by both the client computer and the 
server computer. 

You can also configure the computer names and IP addresses in the local Hostfile of the 
client and server:

 1. On the client computer, make a backup copy of the file 
C:\Windows\System32\drivers\etc\hosts. 

 2. Open the original in a simple text editor.

 3. Add a new line which contains the IP and name of the server, for example: 
192.168.29.27 license_server.thermocalc.se. 

 4. Save the changes.

 5. On the server, make a backup copy of the file /etc/hosts.

 6. Open the original in a simple text editor. 

 7. Add a new line which contains the IP and name of the client, for example: 
192.168.29.47 Computer_A.thermocalc.se.

 8. Save the changes.

 9. In the host file, there is an example of how the operating system (Windows or Linux) 
wants the line in the hosts file to look like.
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macOS Installations: Running the License Initialization Script 

As part of the Standalone installation of Thermo-Calc, the Setup runs a license initialization 
script. If this part of the installation process did not complete properly for a standalone 
installation, you must manually run the license initialization script. You need the 
administrator username and password for these steps.

How to Run the Script

For this script to successfully initialize the license, the license file must be called lservrc and 
be located in the folder: 

/Users/Shared/Thermo-Calc

Installation Default Directory: macOS

 1. Open a terminal window. The Terminal application is in the /Applications/Utilities 
folder.

 2. At the prompt, enter this command:
$ sudo /Applications/Thermo-Calc-
2025a.app/Contents/Resources/license-initialization-macOS-x86_
64.sh

If you are not already logged in as an administrator, you probably cannot run the 
sudo command. If this is the case, then you can use the su command in the terminal 
window to login as an administrator. Contact your local system administrator for 
help.

 3. Enter the administrator password and press Enter. 

 4. When you restart your computer and run the license initialization script, you are 
ready to start using Thermo-Calc. 

If you did not install a license file during this procedure, you can still 
start Thermo-Calc although you will get the No license file found 
message. 
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Linux Installations: Running the License Initialization Script

As part of a Standalone installation of Thermo-Calc, the Setup runs a license initialization 
script. If you get a warning message during the standalone installation Unable to run 
post-installation script, run the license initialization script as root after the installation, 
then you need to manually run the script as root.

openSUSE Administration (sudo) Users 

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc 
using this command:

sudo ./Thermo-Calc-linux-<full-version-number>.run

When this command is used, you will do a text-based installation instead of having a 
graphical interface to guide you. The information  is the same, just without the user 
interface. 

For example, the <full-version-number> is not just 2025a, it is what is found in 
the Help → About window in Thermo-Calc and it changes every release. You 
can find the current full version number listed on our website.

How to Run the Script

For this script to successfully initialize the license, the license file must be called 
lservrc and be located in the directory where you have installed Thermo-Calc. 

Installation Default Directory: Linux

 1. In the console, go to the Thermo-Calc installation directory. 
 l The license file is put in /home/<user>/Thermo-Calc  if you are installing as a 

non-root user, where <user> is your user name. 
 l If you are installing as root, then this directory is opt/Thermo-Calc/.

 2. Enter this command:
$ sudo sh license-initialization-linux.sh

https://thermocalc.com/current-software-versions/
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If you are not able to execute the sudo command because you are not on the sudoers 
list, you must log in as a root user with the command su, and then use sh to run the 
license initialization script. For example, on a 64-bit computer, enter the following:

$ sh license-initialization-linux.sh

 3. Log out of Thermo-Calc and then log back in to save these changes. 
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Sentinel RMS License 9.7 Tools

This section is applicable to installations involving a license file activation type.  
This licensing method is gradually being replaced by the user credentials 
activation type starting with Thermo-Calc 2025a. 

These tools relate to Network Client installations of the Sentinel RMS License software.

Windows: Installing the Sentinel RMS License Manager or Linux: Installing the 
Sentinel RMS License Server

In this section:

GetHostID: Get HostID/Mac Address 184

lsmon: Monitor License Manager Transactions 185

lspool: Maintain Redundant License Manager Pool 186

lsrvdown: Shut Down the License Manager 188

lswhere: Display a List of License Managers 189

WlmAdmin Administrative Tool 190

Sldemo: Show Basic API Functions 194

Wechoid: Get a Computer Locking Code 198
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GetHostID: Get HostID/Mac Address

GetHostID is a tool that retrieves the HostID/Mac address from the computer hosting the 
license server and saves it to a text file.

For Linux the output file is called gethostid.log. For Windows it is called TC_
Hostid.txt.

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager (Windows) or Server (Linux), version 9.7. 

 l The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. 
See Windows: Installing the Sentinel RMS License Manager or Linux: Installing the 
Sentinel RMS License Server.

Windows

 1. Extract getHostID_win.zip.

 2. Right-click getHostID_win.bat and select Run as Administrator from the menu.

The output is saved in a file: TC_Hostid.txt located in the same folder as 
getHostID_win.bat.

Linux 32-bit

 1. Extract gethostid.tar.

 2. Run the command: >./gethostid. 

The output is saved in a file: gethostid.log located in the same directory as 
gethostid.

Linux 64-bit

 1. Extract gethostid64.tar.

 2. Run the command: >./gethostid64. 

The output is saved in a file: gethostid.log located in the same directory as 
gethostid64.
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lsmon: Monitor License Manager Transactions 

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager (Windows) or Server (Linux), version 9.7. 

 l The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. 
See Windows: Installing the Sentinel RMS License Manager or Linux: Installing the 
Sentinel RMS License Server.

Platforms

Windows, Linux 32-bit, Linux 64-bit

The tool retrieves information about all features currently licensed by the Sentinel RMS 
License Manager, licenses, and clients.

On UNIX computers, you can use "Poll-interval-in-seconds" to specify that lsmon should 
keep monitoring and reporting usage activity instead of displaying information once and 
stopping. If specified, lsmon waits for that many seconds between re-polls of the License 
Manager. 

lsmon monitors all licensed applications supported by a License Manager. If the License 
Manager supports licensed applications from multiple vendors, then all licenses for all 
vendors are displayed.

 l On Windows, use lsmon [Server-host] 
 l On Linux 32-bit, use lsmon [Poll-interval_in_seconds] [Server-host]
 l On Linux 64-bit, use lsmon64 [Poll-interval_in_seconds] [Server-host]

OPTIONS

 l Poll-interval_in_seconds: Enable periodic update at indicated rate. This option is 
supported on UNIX only).

 l Server-host: The name of the computer on which the License Manager is running. If 
Server-host is omitted, lsmon will attempt to talk to the Sentinel RMS License 
Manager on the computer indicated in the LSHOST environment variable or in the 
LSHOST (or lshost) file. If the variable or the file does not exist, then it will attempt to 
contact a License Manager using the broadcast mechanism. If lsmon fails to find a 
Sentinel RMS License Manager, it will display an error message and exit.
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lspool: Maintain Redundant License Manager Pool

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager (Windows) or Server (Linux), version 9.7. 

 l The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. 
See Windows: Installing the Sentinel RMS License Manager or Linux: Installing the 
Sentinel RMS License Server.

lspool is a redundant License Manager administration utility (command-line) for Windows 
and UNIX. 

OPTIONS

 l h Displays a list of lspool usage options.
 l a <license manager> Adds the License Manager to the redundant License Manager 

pool. Specify the hostname or IP address of the License Manager system. Modifies 
the redundant license file.. On Windows, dynamic addition of License Manager in an 
existing redundant pool is not supported.

 l d <license manager> Deletes the License Manager from the redundant License 
Manager pool. Specify the hostname or IP address of the License Manager system. 
Modifies the redundant license file. On Windows, dynamic deletion of License 
Manager in an existing redundant pool is not supported.

 l l Displays the host name of the leader redundant License Manager.
 l p Displays the list of License Managers in the redundant License Manager pool.
 l g < feature> <version> Displays the license token distribution criteria for the specified 

feature/version. If the version is not specified, it must be replaced with empty 
quotation marks: " ".

 l L <event> <OFF|ON> Disables/enables logging for an event. The events you select 
will be logged into the License Manager trace log file (only if error logging is 
enabled).

LSPOOL - L OPTIONS

Events that can be logged using the -L option are given below. The following events are 
temporarily logged (except 1) and need to be set each time the License Manager is 
restarted.
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 l 0 Logs all events.
 l 1 Logs when the License Manager is up. On by default. 2 Logs election of the leader 

License Manager.
 l 3 Logs the two-way redundant License Manager heartbeat:> Leader License Manager 

periodically logs the update status received from all its followers

> Follower License Manager periodically logs the update about the contact 
established with the current leader License Manager

 l 5 Logs the usage information event, shared by the leader, regarding the number of 
tokens issued. 7 Logs the license token distribution information synchronization 
event.

 l 9 Logs when the License Manager is down.
 l 11 Logs addition of a license into the file or memory. Also logs deletion of a license 

from the memory.
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lsrvdown: Shut Down the License Manager

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager (Windows) or Server (Linux), version 9.7. 

 l The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. 
See Windows: Installing the Sentinel RMS License Manager or Linux: Installing the 
Sentinel RMS License Server.

lsrvdown utility is used to shut down the named License Manager. 

Platforms

Windows, Linux 32-bit, Linux 64-bit

 l On Windows and Linux 32-bit use lsrvdown host-name
 l On Linux 64-bit use lsrvdown64 host-name

lsrvdown can be run from the operating system command prompt by an administrative user 
on a client or License Manager computer. 

 l On UNIX, only the user logged in as “root” can use lsrvdown. 
 l On Windows, any user with administrative privileges may use lsrvdown unless the 

License Manager was started by a user logged in as Administrator, in which case only 
Administrator can shut the License Manager down. The computer on which you are 
running lsrvdown must be in the same network domain as the License Manager 
computer. 

The same user must install the Sentinel RMS License Manager and also 
run this utility.
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lswhere: Display a List of License Managers

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager (Windows) or Server (Linux), version 9.7. 

 l The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. 
See Windows: Installing the Sentinel RMS License Manager or Linux: Installing the 
Sentinel RMS License Server.

Platforms

Windows, Linux 32-bit, Linux 64-bit

lswhere command displays the network names of the computers running the License 
Manager. By default, lswhere displays for each License Manager the address of the 
computer on which that License Manager is running as well as its host name.

lswhere can be run on Windows and UNIX. lswhere should be run from the operating system 
command prompt by an administrator or application user on a standalone, client, or License 
Manager computer.

lswhere should be run in the following format:

 l Windows and Linux 32-bit: lswhere [option] 
 l Linux 64-bit: lswhere64 [option]

OPTIONS

 l d Displays details on the License Managers found on the network.
 l r Displays only the IP addresses of the License Managers found on the network 

(resolves the host names). lswhere can also be run without specifying any command 
line options.
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WlmAdmin Administrative Tool

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager for Windows, version 9.7. 

 l The tool is applicable to Windows  operating systems. See Windows: Installing the 
Sentinel RMS License Manager.

WlmAdmin performs a variety of administrative functions for the license management 
activities. It displays elaborate information that includes the License Manager information, 
feature information, and license and client information.

Platform

Windows

WlmAdmin can administer a remote Linux license server. 

WlmAdmin Functions

 l Provides information on the License Managers.
 l Details on licenses and clients using them in the network. For example, the 

administrator can see which users have acquired that license and who are in a queue 
waiting for the license.

If you are using redundant License Managers, you can use WlmAdmin as an informational 
tool to: 

 l Add or delete a redundant License Manager from the redundant License Manager 
file.

 l Display a list of all License Managers in the redundant License Manager pool and 
display the name of the License Manager leader.

 l Display the distribution criteria for specific licenses (only high assurance model is 
allowed, where the reigning leader server keeps all the license tokens).
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View License Manager Information

 l Click the name of a License Manager in the left-hand pane of the main window. In 
the right-hand pane of the display, you see the IP address of the computer containing 
the License Manager and its host name.

Add or Remove a License Manager from the Defined Server List

 l To add a License Manager:  Right-click the name of a License Manager in the list of 
Subnet Servers. From the menu select Add to Defined List.

 l To remove a License Manager: Right-click the name of a License Manager in the list 
of Defined Servers. From the menu select Remove from Defined List.

Add a License Code to the License Manager from a File

 1. Right-click the name of a License Manager in the left-hand pane of the main window.

 2. From the menu select Add Feature > From a File > To Server and its File.

 3. To add the license from a file, select From a File. This permanently adds the license 
code to the License Manager license file as well as to the License Manager memory.

 4. In the new windows, browse to the source file that contains the license code and 
click  Open.

 5. Select the license code file.

Delete Old License Features from the License Manager

 1. Right-click the file WlmAdmin.exe and select Run as Administrator.

If the license server is not found under subnet servers, go to Edit > Defined Server 
List.

 2. Enter the host name or IP address of the license server.

 3. Click Add and OK.

 4. Click View > Refresh All to update the list.

 5. Right-click the name of a License Manager in the left-hand pane of the main window.

 6. From the menu select Remove all Features

Shut Down a License Manager

 l Right-click the name of a License Manager in the left-hand pane of the main window. 
From the menu select Shutdown Server.
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Setting WlmAdmin Preferences

WlmAdmin allows you to choose what to display when it starts.

From the Edit menu, select the Preferences command to view WlmAdmin Preferences: 

 l Timeout Interval: The number of seconds after which WlmAdmin will stop trying to 
contact a License Manager. If you have a large network or a slow one, you might 
want to increase this number if you find WlmAdmin has difficulty retrieving 
information from License Managers.

 l Broadcast Interval: Specify the number of seconds between broadcasts to the 
network to discover License Managers.

 l Server Port: To set any custom port (other than the default port 5093) on which the 
RMS License Manager is running.

Set this port number before you add that License Manager in the list of 
defined servers.

 l Discover subnet servers on startup: To automatically discover and display the 
License Managers on your subnet.
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 l Discover defined servers on startup: To always show the License Managers you have 
defined.

 l Show client library error handler messages: To pass license management error 
messages from Sentinel RMS to WlmAdmin.

 l Save these preferences to a file: To save your choices.
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Sldemo: Show Basic API Functions

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager for Windows, version 9.7. 

 l The tool is applicable to Windows  operating systems. See Windows: Installing the 
Sentinel RMS License Manager.

slmdemo is a Windows-based graphical sample program to show basic API functions. 
Evaluate it using the steps described here to understand the basic API calls and test the 
connectivity between client and license server

slmdemo can be used to test the connectivity to a remote Linux license server

Platform

Windows

Right-click on the executable and select Run as administrator. slmdemo calls the 
VLSinitialize API when the application is invoked successfully.

https://docs.sentinel.thalesgroup.com/softwareandservices/RMS/RMSDocumentation/Vendor/Content/DevGuide/Chapter 5_LicensingAPIs/Getting Started With API.htm#Initiali


Thermo-Calc Documentation Set

Installation Guide ǀ 195 of 199

Set the contact server (License Manager) under the Connect To > Server menu option. Enter 
a hostname , which is the hostname or IP address of the License Server.
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Click  OK and enter in the field one of the license features available in the network license 
file. Where Feature is the name of the feature ex. TC_FULL and Version is the license version 
in the NWL (Network) license. Click  Get License. The message The call returned a 
success status of 0x0 means that the connection client <> license server works.
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To save the log, click File > Save log.
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Wechoid: Get a Computer Locking Code

 l This is related to the Full Network Client Installations using the Sentinel RMS License 
Manager for Windows, version 9.7. 

 l The tool is applicable to Windows  operating systems. See Windows: Installing the 
Sentinel RMS License Manager.

Before your software vendor creates a license code with any computer restrictions, you 
must get the locking code for your computer with the Wechoid program. Your software 
vendor will tell you which computers you must run Wechoid on. The Wechoid utility outputs 
either one or two hexadecimal locking codes depending upon how your software vendor has 
configured it. You will send all locking information to your software vendor. Your software 
vendor will use this information, which is specific to your computers, to generate new 
license codes.

Platform

Windows

When launched, the utility shows the available lock criteria (a checkmark is added next to 
each) and the values. Click to clear (uncheck) all checkboxes except for Ethernet Address.
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Thermo-Calc Software

Thermo-Calc Software develops computational tools used to predict and understand 
materials properties, allowing you to generate computational materials data without costly, 
time-consuming experiments or estimations based on the limited data available.

Thermo-Calc can be used to fill the gaps in material property data and make predictions of 
material behavior throughout the materials life cycle. With Thermo-Calc, you can make 
better decisions about your products and improve your material processing conditions with 
accurate, reliable materials data.

The Thermo-Calc software (also referred to as the Thermo-Calc program or the software to 
distinguish it from the company name) is used to perform thermodynamic calculations. It 
can calculate complex homogeneous and heterogeneous phase equilibria, and then plot the 
results as property diagrams and phase diagrams. 

The software fully supports stoichiometric and non-ideal solution models and databases. 
These models and databases can be used to make calculations on a large variety of materials 
such as steels, nickel, aluminum, magnesium, titanium and titanium aluminide-based alloys, 
high entropy alloys, copper, slags, salts, ceramics, solders, polymers, subcritical aqueous 
solutions, supercritical electrolyte solutions, non-ideal gases, and hydrothermal fluids or 
organic substances. The calculations take into account a wide range of temperature, 
pressure, and compositions conditions.

There are several resources available on our website to help you learn how to 
use Thermo-Calc and other Add-on Modules. Go to the Getting Started Guides 
page and choose one of the guides that provides new users an introduction to 
setting up simple calculations in Graphical Mode. The information there is also 
in this help documentation.

Databases 

There are over 40 high quality kinetic, properties and thermodynamic databases for use in 
our software. Each database is developed for a specific materials system or application, and 
all databases are developed using the proven CALPHAD methodology.

https://thermocalc.com/support/getting-started-guides/
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The quality of the predictions in Thermo-Calc is strongly dependent on the quality of the 
databases because they provide the data for the calculations. This makes the databases as 
important, if not more so, than the software itself.

Thermo-Calc Software has long experience in the field of database generation using the 
proven CALPHAD methodology. We employ a highly qualified team of people working on 
database development internally and through international collaboration projects. With our 
kinetic, properties, and thermodynamics databases, you can rest assured that you are 
working with the most advanced CALPHAD databases available.

Go to our website to review the databases available. The online help contains 
all the content including technical information and examples.

https://thermocalc.com/products/databases/
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About the Thermo-Calc Add-on Modules

Thermo-Calc Software offers several Add-on Modules that allow users to extend the 
functionality of the software in your area of specialization. All Add-on Modules are built into 
the Thermo-Calc platform, so there is no need for additional installation. This also creates a 
unified workflow and allows data to move seamlessly between the modules.

Go to the Add-On Modules page on our website for more information about 
license requirements, which is also mentioned throughout the documentation.

Additive Manufacturing (AM) Module

The Additive Manufacturing (AM) Module (also referred to as the AM Module) is an Add-on 
Module to Thermo-Calc and it is available in Graphical Mode as the AM Calculator. The aim 
of the Additive Manufacturing Module is to better understand the laser powder bed fusion 
(LPBF) process by predicting the temperature distribution and melt pool geometry as a 
function of process parameters and using material properties from the Thermo-Calc 
thermodynamic and properties databases. Special focus is to have a unified treatment of 
alloy-dependent material properties and process parameters when solving the multiphysics 
problem of a moving heat source that melts and solidifies metal powder. The multiphysics 
simulation involves thermal conduction, fluid flow, evaporation-, radiation-, and convective-
heat loss.

The Module can simulate the transition from conduction- to keyhole-mode.  With 
experimental melt pool data you can calibrate the heat source. The calibrated heat source 
can be used to predict additional process conditions and/or to construct printability (aka 
process) maps.

Furthermore, once you have the temperature distribution, for instance as a function of time 
and space, you can also use this information for other Thermo-Calc Add-on-Module 
simulations such as with the Diffusion Module (DICTRA) or the Precipitation Module (TC-
PRISMA), or for input to other external finite element programs.

Diffusion Module (DICTRA)

The Diffusion Module (DICTRA) is an Add-on Module to Thermo-Calc. It is used for 
simulation of diffusion controlled transformations in multicomponent systems. The 
simulation calculations are both time- and space-dependent. The Diffusion Module (DICTRA) 
is available in both Graphical Mode (as the Diffusion Calculator) and Console Mode (as the 
DICTRA module). 

https://thermocalc.com/products/add-on-modules/
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The Diffusion Module (DICTRA), which is often just referred to as DICTRA, is ideally suited to 
solve diffusion simulations that include a moving boundary (Stefan problems). The 
multicomponent diffusion equations in the various regions of a material are solved under 
the assumption that thermodynamic equilibrium holds locally at all phase interfaces. 
Simulations are one-dimensional and three different geometries can be performed: planar, 
cylindrical, and spherical. 

Examples of cases that have been simulated using the Diffusion Module (DICTRA) include:

 l Microsegregation during solidification
 l Homogenization of alloys
 l Growth/dissolution of carbides, nitrides and intermetallic phases
 l Coarsening of precipitate phases
 l Interdiffusion in compounds, e.g. coating systems
 l Austenite to ferrite transformations in steel
 l Carburization, nitriding and carbonitriding of high-temperature alloys and steels
 l Post weld heat treatment
 l Sintering of cemented-carbides

Precipitation Module (TC-PRISMA)

The Precipitation Module, or TC-PRISMA, is an Add-on Module to Thermo-Calc and it is 
available in Graphical Mode as the Precipitation Calculator.

The Module treats concurrent nucleation, growth/dissolution and coarsening under 
arbitrary heat treatment conditions in multi-component and multi-phase systems using 
Langer-Schwartz theory and the Kampmann-Wagner numerical approach. It is a general 
computational tool for simulating kinetics of diffusion controlled multi-particle precipitation 
processes in multicomponent and multiphase alloy systems.

You can use the Precipitation Module for:

 l Concurrent nucleation, growth/dissolution and coarsening of precipitates
 l Normal grain growth and Zener pinning
 l Temporal evolution of particle size distribution
 l Average particle radius and number density
 l Volume fraction and composition of precipitate
 l Nucleation rate and coarsening rate
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 l Time-Temperature-Precipitation (TTP) diagrams
 l Continuous-Cooling-Transformation (CCT) diagrams
 l Estimation of multi-component interfacial energy
 l Estimation  of yield stress using the Yield Strength Property Model

Process Metallurgy Module

The Process Metallurgy Module is an Add-on Module to Thermo-Calc and it is available in 
Graphical Mode as the Process Metallurgy Calculator. The Add-on Module is designed to 
model reactions that occur in metallurgical processes. Although primarily used in 
steelmaking and steel refining processes—such as basic oxygen furnaces, electric arc 
furnaces, ladle furnace metallurgy, and so forth—applications are not limited to 
steelmaking. 

There are two main branches of calculations possible: Equilibrium and Process simulation. 
Equilibrium calculations do not consider any kinetics, the process simulation includes 
reaction kinetics.

In general, for both types, the main difference compared to using a standard Equilibrium 
Calculator is that it is easy to handle the different materials present in a metallurgical 
process. The materials used in the process can be pre-defined, saved and used for the 
equilibrium calculations. Metallic materials can be defined in element weight percent, oxide 
materials in weight percent of oxide components, the gas phase in volume percent of gas 
components and its amount can be defined in normal cubic meters, and so forth. In principle 
this can be done in a standard Equilibrium Calculator. However, it is much easier when using 
the Process Metallurgy Calculator as this is designed for this specific purpose.

When using the Equilibrium branch of calculations, both isothermal and adiabatic 
calculations are possible. Adiabatic calculations assume no heat and mass exchange with the 
environment during the equilibrium reaction, meaning that the temperature changes as a 
result of exothermal or endothermal reactions taking place. 

For a Process simulation branch of calculation, the reaction kinetics of the process are 
considered. This is done by dividing the system into zones. Typically one would have one 
steel zone containing liquid metal and a slag zone containing liquid oxide (slag). The kinetic 
model assumes that only a fraction of the steel zone reacts with a fraction of the slag zone 
per time step. This reacting fraction of the whole system is termed the reaction zone (in 
literature it has become known as Effective Equilibrium Reaction Zone or EERZ).

You can use the Process Metallurgy Module to calculate the following:
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 l The equilibrium between custom-defined steels, slags, and gasses.
 l The equilibrium between other metallic and non-metallic phases.
 l Desulfurization, dephosphorization, and decarburization.
 l Any partition coefficient, for example the partitioning of sulfur between the liquid 

steel and slag phase.
 l Slag characteristics, such as slag basicity or sulfur capacity.
 l The fraction of liquid and solid in the slag.
 l The temperature change in an adiabatic process.
 l Kinetics of the reaction between phases. Typically this is the reaction between a 

liquid metal and slag phase, but it could also be the reaction between a solid oxide 
and slag (simulation of refractory wear) or between a solid metal and liquid metal 
(simulation of dissolution of alloy), etc.

Material Specific Property Model Libraries

There are specialized Property Models available for those working with specific materials 
such as steel, nickel, and titanium. The libraries, also sometimes referred to Add-on 
Modules, are available with the Property Model Calculator and the applicable database 
licenses.

 l The Nickel Model Library includes the following models specially designed for those 
working with nickel alloys: Antiphase Boundary Energy, Coarsening, Equilibrium with 
Freeze-in Temperature, Solvus for Ordered Phase, and Strain-Age Cracking. 

 l The Noble Metal Alloys Model Library includes the Optical Properties Property 
Model. 

 l The Steel Model Library  includes the following models for those working in the steel 
industry: Bainite, CCT Diagram, Critical Transformation Temperatures, Ferrite,  
Martensite Fractions, Martensite Temperatures, Martensitic Steel Strength, Pearlite, 
and TTT Diagram.

 l The Titanium Model Library includes the following models specially designed for 
those working with titanium alloys: Alloy Strength and Martensite Temperatures.
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Graphical Mode vs Console Mode

There are two interfaces available in Thermo-Calc: Graphical Mode with a graphical user 
interface (GUI) and Console Mode, which uses a command line interface. Thermo-Calc and 
the Diffusion Module (DICTRA) are available in both modes, and all other Add-on Modules 
are only available in Graphical Mode.

If you are a new user, Graphical Mode is a good way to learn how to work with Thermo-Calc. 
Depending on what you want to simulate, in some cases Console Mode can have more 
functionality but until you are comfortable with the concepts, it is recommended you start in 
Graphical Mode, and for all new Add-on Modules, these are only available in Graphical 
Mode.

In Graphical Mode calculations are set up, carried out, and visualized as part of a 
project. The steps in the project are performed with activities. There are 
templates and a Wizard available to guide you through the process of defining 
the project. See Getting Started Links and Templates.

In Console Mode you work with modules, which are managed using commands 
typed at a prompt. Some modules, called response-driven modules, ask you a 
series of questions that typically take you through the process of defining your 
system, setting calculation conditions, performing calculations and plotting the 
results.

How to Switch Between Modes

The first time you open Thermo-Calc, it defaults to Graphical Mode. For any future instance 
it defaults to the last mode used. 

Along the top of the GUI is the Graphical Mode Toolbar where you switch between modes. 

In Console Mode, except for the Switch to Graphical Mode button, the toolbar is not used.
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See Menu, Toolbar, and Keyboard Shortcuts for information about the Tools, 
Window, and Help menus, which are available in both modes.

File Extensions

The file extensions are different based on the mode you are in. In Console Mode the 
extensions are also based on whether you are working with Thermo-Calc or the Diffusion 
Module (DICTRA). 

In Graphical Mode, the Thermo-Calc project files have the extension *.tcu. This 
includes the examples for the Add-on Modules. 

In Console Mode, Thermo-Calc macro files have a *.TCM extension and the 
Diffusion Module (DICTRA) file extension is *.DCM. In addition to macro files in 
Console Mode the are also Log files and Workspace files, which also differ. 

Modes Run Simultaneously

The two modes can be run simultaneously, but there is no communication between them. 
What you do in Graphical Mode does not affect the state of the Console Mode session and 
vice versa. One exception is the plot settings. 

Global Settings: Graphical and Console Mode Plotting

Data Optimization and Thermodynamic / Kinetic Assessments

Although many calculations can be done in either mode, data optimization (i.e. 
PARROT) and thermodynamic or kinetic assessments (i.e. custom database 
development) are only available in Console Mode or using an SDK such as TC-
Python. 
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Graphical Mode Activities vs Console Mode Modules 

Although many calculations can be done in either Graphical Mode (GM) or Console Mode 
(CM), only data optimization and thermodynamic or kinetic assessments are available in 
Console Mode. Conversely, certain Calculators are only available in Graphical Mode as 
indicated in the table.

About the Activity Nodes (Graphical Mode) and Console Mode Modules

Graphical Mode (GM) versus Console Mode (CM)

GM Activity CM module 
(Short Name) Primary Functions

AM Calculator –

Run additive manufacturing (AM) simulations using the Add-on Additive 
Manufacturing (AM) Module. In addition, probe data generated from an 
AM calculation can be used with the Diffusion Calculator and/or 
Precipitation Calculator. Additional licenses are required for full access to 
this Add-on Module and/or the extended use of the probe data. 

Binary Calculator BIN Calculate binary phase diagrams. Access to specific databases designed 
for BIN, such as TCBIN, is required.

System Definer DATA Select appropriate databases, define chemical systems and retrieve the 
data required for calculations. 

Diffusion 
Calculator DICTRA

Run simulations of diffusion controlled transformations in Thermo-Calc 
using the Diffusion Module (DICTRA). An additional license is required for 
full access to this Add-on Module.

– DIC_PARROT

This is to do data optimization for the Diffusion Module (DICTRA) and 
Precipitation Module (TC-PRISMA). It allows you to assess experimental 
data and use such data to optimize calculations. An additional license is 
required for full access to this Add-on Module.

– ED_EXP Part of the PARROT submodule, use it to edit experimental data points to 
make reliable optimizations.

This is the 
calculation engine GIBBS or GES

Handles thermodynamic models and quantities. Generally you do not 
need to use this, but you can get information about models, and list, add 
or amend the thermodynamic parameters in use. 

– PARROT Used for data optimization to assess experimental data and use the data 
to optimize calculations. 
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GM Activity CM module 
(Short Name) Primary Functions

Precipitation 
Calculator –

Set the conditions for, and perform, a precipitation calculation using the 
Precipitation Module (TC-PRISMA). An additional license  is required for 
full access to this Add-on Module.

Property Model 
Calculator –

Predict and optimize material properties based on their chemical 
composition and temperature. There are preconfigured General Models 
available for all users and specialized material specific models such as 
Nickel Models, Noble Metal Alloys Models, Steel Models, and Titanium 
Models available with additional licenses.

Equilibrium 
Calculator POLY Equilibrium calculation command module. Specify conditions and make 

calculations.

Material to 
Material 
Calculator

– To calculate materials transitioning from one into the other.

Plot Renderer POST
This is a submodule to POLY and is for post-processing and plotting of 
calculation results. Modify property and phase diagrams, add labels, 
change the diagram colors and so forth. 

Ternary Calculator POTENTIAL Calculate and plot gas potential diagrams in a ternary system. The 
potential of two gas species are used as the diagram axes. 

– POURBAIX
Calculate and plot pH-Eh diagrams (Pourbaix diagrams) and property 
diagrams for heterogeneous interaction systems involving aqueous 
solutions. 

Process 
Metallurgy 
Calculator

–

Use this  to model with the Process Metallurgy Module and for reactions 
that occur in metallurgical processes. Although primarily used in 
steelmaking and steel refining processes (such as basic oxygen furnaces, 
electric arc furnaces, ladle furnace metallurgy and so forth), applications 
are not limited to steelmaking. An additional license is required for full 
access to this Add-on Module.

– REACTOR Simulate chemical reaction processes in several feed-forward steady-
state stages or in several dynamic stages.

Scheil Calculator SCHEIL
Simulate and plot Scheil-Gulliver solidification processes with no 
diffusion in the solid phases and with/without consideration of back 
diffusion of interstitial components (such as C, N, O, S). 

– SYS Interact with the operating system and change environmental settings. 
Create and execute macro files.
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GM Activity CM module 
(Short Name) Primary Functions

– TAB Tabulate properties of chemical reactions and substances (stoichiometric 
or solution phases).

Ternary Calculator TERN Calculate ternary phase diagrams.



Graphical Mode vs Console Mode: Calculation Types

When you are using Thermo-Calc and the Add-on Modules, you generally first set up a system, select the databases to use, and then define 
various parameters related to the simulation you want to conduct. Once this is set up you decide what Calculation Type to perform, choose a 
Plot type (or a table for single equilibrium, for example) to use and then eventually get a result.

How Thermo-Calc handles the calculation behind the scenes is the same whether you use Graphical Mode (GM) or Console Mode (CM). 
However, there are differences with the workflow and for historical reasons some calculation types are named differently based on whether 
you are in one mode or another. 

Calculation Types in Graphical Mode and Graphical Mode vs Console Mode: Calculation Types

In addition, the plot types (diagrams) you choose to output the information are also different based on whether you are in Graphical or 
Console Mode. These plot types are often based on the type of calculation being done, where in some cases you can only do it in one mode 
and not the other. For example, precipitation calculations are only available with the Precipitation Calculator, GM only, but you can do 
diffusion calculations in both modes.

Comparison of Calculation Types in Graphical Mode vs Console Mode

The table lists most of the calculation types that you will want to perform. The first column is primarily based on the calculation types you 
can select when working in GM and when using the various calculators as indicated in the second column. The third column is the module or 
command in CM that you would use to perform the same, or similar, type of calculation. 

Calculation Type Graphical (GM) Console (CM) Definition

Equilibrium 
calculations Equilibrium Calculator POLY3 module

An equilibrium defines the amount(s) and composition(s) of one or several phases that have the 
minimum Gibbs energy at a given temperature and pressure. A prerequisite for a successful 
equilibrium calculation is that the number of degrees of freedom according to Gibb's phase rule 
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Calculation Type Graphical (GM) Console (CM) Definition

must be zero. This means that  the right number of independent conditions must be set in order to 
successfully be able to calculate an equilibrium.

Single equilibrium 

Property Model Calculator 
(Equilibrium 
model), Equilibrium 
Calculator, and Material to 
Material Calculator

POLY3 module

To calculate a single equilibrium. The results from this calculation are displayed as follows: 

 l Graphical Mode: In the Visualizations window for a Table Renderer or in the Event Log 
window (for the Property Model Calculator)

 l Console Mode: With the LIST_EQUILIBRIUM command.

Single  (no axes)
Property Model Calculator 
and Process Metallurgy 
Calculator

POLY3 module

To calculate a single point. The results from this calculation are displayed as follows: 

 l Graphical Mode: In the Visualizations window for a Table Renderer or in the Event Log 
window. 

 l Console Mode: With the LIST_EQUILIBRIUM command.

One Axis

Property Model Calculator, 
Equilibrium Calculator, 
Material to Material 
Calculator,  and Process 
Metallurgy Calculator

POLY3 module To vary a quantity on the X-axis.

Property diagrams 

One Axis: available with 
Equilibrium Calculator, 
Material to Material 
Calculator, and Property 
Model Calculator

POLY3 module, 
STEP command

A property diagram is calculated by stepping one of the conditions that were defined for the 
equilibrium calculation and plotting some other property against this variable. For example 
stepping through temperature and plotting equilibrium composition of a certain phase, or stepping 
through composition and plotting equilibrium phase fractions, and so forth.

Phase diagrams 

Equilibrium Calculator, 
Binary Calculator,  Material 
to Material Calculator, and 
Ternary Calculator

POLY3 module, 
MAP command, 
BINARY module, and 
TERNARY module

The Material to 

A phase diagram is mapped within a specific space constructed by two (or more) independent 
mapping variables. These are mostly temperature and composition, but can be many other, such 
as temperature and pressure, activity of oxygen and activity of sulfur, and so forth.
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Calculation Type Graphical (GM) Console (CM) Definition

Material Calculator is 
not available in 
Console Mode

Scheil calculations Scheil Calculator Scheil module Simulate a non-equilibrium transformation or partial-equilibrium transformation, also called a 
Scheil-Gulliver solidification. 

Gibbs energy curves Binary Calculator BINARY module To calculate at a constant temperature over the whole composition range.

Activity curves Binary Calculator BINARY module To calculate at a constant temperature over the whole composition range.

Phase fractions Binary Calculator BINARY module To calculate as a function of temperature at a constant composition.

Isothermal section Ternary Calculator TERNARY module To calculate the ternary system for the whole composition range at a constant temperature.

Monovariant lines Ternary Calculator TERNARY module To calculate the variation of the liquid compositions with temperature.

Liquidus projection Ternary Calculator TERNARY module The projection liquid surface and the monovariant lines are calculated over the given temperature 
range.

Potential diagrams not available
Potential Diagram 
module and POLY3 
module

A potential diagram uses the activities of two major species in the gaseous mixture phase as 
mapping variables. For example, use this for a metal-oxide/sulphide-gas interaction system to 
calculate a diagram based on a specific temperature and pressure .

T0 temperature 
simulations

This is available as the T-
Zero Temperature Property 
Model using the Property 
Model Calculator

POLY3 module The T0-temperature is the temperature at which two phases have the same Gibbs energy for a 
certain composition for a certain alloy composition. 

Paraequilibrium not available POLY3 module A paraequilibrium is a partial equilibrium where one interstitial component, such as carbon (C) and 
nitrogen (N), in a multicomponent alloy can diffuse much faster than the other components (the 
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Calculation Type Graphical (GM) Console (CM) Definition

substitutional elements, including the matrix element and alloying elements). 

Grid

Property Model Calculator, 
Equilibrium Calculator,  
Process Metallurgy 
Calculator, and 
AM Calculator

not available

With the Equilibrium Calculator, it computes the equilibrium of each grid point in a two-
dimensional grid.

With the Property Model Calculator and Process Metallurgy Calculator, it evaluates two axis 
variables of the selected quantities in the specified range and number of steps. 

For the AM Calculator it is available with the Additive Manufacturing (AM) Module and a Steady-
state simulation. It  evaluates two axis variables of power and scanning speeds in the specified 
range and number of steps.

Batch Property Model Calculator 
and AM Calculator not available

With the Property Model Calculator, it allows for high throughput calculations and reads data from 
a file, such as a spreadsheet, rather than, for example, having a fixed grid or random values.  
Results from these batch calculations can then be compared to experimental values (as long as this 
data is included).

For the AM Calculator it is available with the Additive Manufacturing (AM) Module and a Steady-
state simulation.It is to include power and scan speed data, which is read from a file such as a 
spreadsheet.  You can optionally include experimental melt pool width and depth (if there is data), 
and compare this to the calculated results.

Min/Max Property Model Calculator not available Evaluates the Property Model(s) for all variations of the selected quantities at the given limits.

Uncertainty
Property Model Calculator  
and Process Metallurgy 
Calculator

not available Evaluates the Property Model(s) where the values of the quantities are sampled from Gaussian 
distributions.

Aqueous solutions, 
Pourbaix diagram Equilibrium Calculator

Pourbaix Diagram 
module, 
POLY module

A Pourbaix diagram is a kind of phase diagram that shows the stability boundaries for a metal-
aqueous interaction system. The phase boundaries are shown as a function of pH (acidity) and Eh 
(standard hydrogen electronic potential).  

Tabulation reaction not available TAB module To tabulate thermodynamic functions of any type of substance, stoichiometric phase or solution 
phase, or reaction. 
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Calculation Type Graphical (GM) Console (CM) Definition

Diffusion simulation Diffusion Calculator DICTRA monitor Detailed simulation of diffusion controlled reactions in multicomponent systems.

Isothermal See below POLY3, DICTRA 
monitor

Isothermal calculations in general can be done in all Console Mode modules, for example an 
Isothermal diffusion in DICTRA monitor and an isothermal calculation in POLY3 using the 
STEP command.

Isothermal and non-
isothermal Precipitation Calculator See above

You can calculate nucleation, growth/dissolution and coarsening of particles size classes under 
these conditions: isothermic (precipitation simulation at constant temperature) or non-isothermic 
(precipitation simulation with user-defined temperature profile).

TTT and CCT Precipitation Calculator not available The TTT (Time-Temperature-Transformation) and CCT (Continuous Cooling Transformation) 
diagram can be simulated for one or more particles.

Heat source 
calibration AM Calculator not available

This is available for the Additive Manufacturing (AM) Module for Steady-state simulations, import 
parameters for a range of experimental melt pool data then store the calibrated heat source for 
further use.
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About the File Types and Formats

The file formats (and the file extensions / suffixes) are based on whether you are working in 
Graphical or Console Mode, and in Console Mode, whether you are working with 
Thermo-Calc and/or the Diffusion Module (DICTRA). 

Graphical Mode

In Graphical Mode you work with one file type, a project file, which has a *.tcu file 
extension. This is applicable to Thermo-Calc and all the Add-on Modules and Property Model 
Libraries.

Console Mode

In Thermo-Calc Console Mode there are file types—macro (including log files) and 
workspace—and extensions —*.TCM, *.POLY3, *.GES5, *.PAR, *.POP, and *.EXP. 

A reminder that Linux and macOS are case sensitive; when applicable ensure 
you enter file extensions with capital letters.

Workspace files are not currently available with GES6. 

Working with the Console Mode File Types



Thermo-Calc Documentation Set

The Thermo-Calc Software User Guide ǀ 20 of 42

Displaying Thermo-Calc License Information

You can start (and install) the software without a valid Thermo-Calc license but you cannot 
do any calculations. To show information about the available and installed licenses, from the 
main menu select   Help →  Show License Info. 

This is an example of part of a License Information window for a network installation. It only 
shows the fields you would expect to see as the details are unique for each installation.

Network Licenses

For a network license, under each license type with instances checked out, there is a list of 
who checked out each license. 
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In Graphical Mode, an instance is checked out when an Equilibrium Calculator 
activity is created, and checked back in when that Equilibrium Calculator is 
removed. For the Add-on Diffusion (DICTRA), Precipitation (TC-PRISMA), Process 
Metallurgy, and/or Additive Manufacturing Modules this also applies to the 
Diffusion Calculator, Precipitation Calculator, AM Calculator, and Process 
Metallurgy Calculator, respectively.

In Console Mode, an instance is checked out when you enter the POLY module 
and is checked back in when you exit the POLY module. 

 l The Features column is a list of the specific software, databases and API licenses 
purchases.

 l The Version is an internal version number for the feature.
 l The number of licenses column is how many instances of each license type available 

to be checked out simultaneously.
 l The in use column shows how many license instances are checked out.

Console Mode License Restrictions
 l If you start Thermo-Calc without a valid Thermo-Calc license you cannot leave the 

SYS module.
 l If all the licenses are checked out for a network client installation of Thermo-Calc, 

you may not be able to enter the POLY or DICTRA modules until a license is available. 
 l To enter the DICTRA and the DIC_PARROT modules, you need a valid Diffusion 

Module (DICTRA) license key.
 l If you enter and use either the DIC_PARROT module or the PARROT module, then 

you cannot enter the other module in the same session. You must close down 
Thermo-Calc and launch the program again to enter the other data optimization 
module. 

Network Computer License Restriction

If you have a network computer installation of Thermo-Calc, then you may not be able to do 
any calculations even if you have access to a valid network license file. This is because others 
who are part of your network installation may have checked out all allowed instances of the 
software. 
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If you are running a network installation of Thermo-Calc, you can see how many instances of 
the client licenses are currently checked out and how many of them are left. You can also 
see which client computers have checked out the licenses. 
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About the Documentation and Examples
In this section:

Examples, Manuals, and Materials Folders 24

About the Manuals (Documentation) Folder 29

About the Examples 35

Help Resources 39

Typographical Conventions 40
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Examples, Manuals, and Materials Folders

There are several ways to access the examples, manuals (containing PDF documentation), 
and materials data folders.

Item Main 
Menu

My Project 
Configuration 
window

System 
Definer or 
Material to 
Material 
Calculator

From the 
Windows 
Start 
Menu

On your 
Computer Website

Manuals (PDF 
documentation, 
DATAPLOT EXP 
files, TC-Python 
and TC-Toolbox 
for 
MATLAB® HTML 
help)

x - - x x x

Software 
Development 
Kits (SDKs) 
(TC-Python, 
TC-Toolbox for 
MATLAB®, 
TQ-Interface)*

x - - - x x

Examples 
(project and 
macro files)*

x x - x x x

Materials** - - x x x x

Property Models - - - - x -

Process 
Metallurgy 
Materials***

- - - - x -

* The SDK folder is installed  during installation and available when you have a license for the applicable SDK. There are 
also differences based on the API as to where examples are installed.

** The Material Properties libraries for the Additive Manufacturing (AM) Module are handled by the software.

*** The Process Metallurgy Module user-defined material compositions are saved from the Process Metallurgy 
Calculator and managed from the Options tab.



Thermo-Calc Documentation Set

The Thermo-Calc Software User Guide ǀ 25 of 42

From the Main Menu

Once your Thermo-Calc software is installed you can open the Examples and PDF 
documentation (Manuals) from the main menu:

 l To open the Manuals folder select Help → Manuals Folder.  Note for Linux openSUSE 
users: This link is not functional. To access the folder, navigate to the default location 
based on your installation type

 l To open the Examples  based on whether you are in Console Mode or Graphical 
Mode,  select File → Examples Files or Help → Examples Files. 

My Project Configuration Window

When in Graphical Mode, click the My Project node. In the Configuration window under 
Getting Started, click Example Files.

Installed Materials Folder

When you are working with the System Definer or Material to Material Calculator you can 
open the default  Materials folder included with your installation. 

At the bottom of the window under Material, click Load material to navigate to a material 
file. 

There is a separate folder for materials saved using the Process Metallurgy 
Calculator. See Installation Default Directory: Process Metallurgy Materials.

For the Additive Manufacturing (AM) Module, the Material Properties library is 
managed by the software. 
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The default directory where these material files are stored is based on operating system:

Operating 
System Materials Installation Directory

Windows C:\Users\<user>\Documents\Thermo-Calc\2025a\Materials

Linux
On Linux all user files are installed where the program is installed. If installed as root the 
default is:

/opt/Thermo-Calc/2025a/Materials

macOS /Users/Shared/Thermo-Calc/2025a/Materials

Start Menu (Windows Only)

On Windows, once Thermo-Calc is installed, you can locate the Examples and Materials 
folders, plus all the Manuals. Go to the Start menu and in the search field enter 
Thermo-Calc. A list of the installed versions is provided or click the Apps or other tabs to 
browse search results. 

On Your Computer (All Operating Systems)

The PDFs, example files and materials xml files are included with your installation in a folder 
location based on the operating system. 
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In the table, <user> stands for the username and <version> for the version of Thermo-Calc, 
for example 2025a.

WINDOWS FILE PATHS

User Type Default Directory

Administrator

Software

Program Files\Thermo-Calc\<version>

 

Examples, Manuals, Materials, Property Models, Process Metallurgy Materials and SDK 
folders:

Users\Documents\Thermo- Calc\<version>

MACOS FILE PATHS

User Type Default Directory

Administrator (user name and 
password required)

Examples, Manuals, Materials, Property Models, Process Metallurgy 
Materials and SDK folders:

/Users/Shared/Thermo-Calc/<version>

To go to this folder, in Finder, from the Go main menu select Go to folder. 
Enter the above file path and click Go.

LINUX FILE PATHS

User Type Default Directory

Non root user home/<user>/Thermo-Calc/<version>

Root user usr/local/Thermo-Calc/<version>
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Website

Many resources are available from our website. On the Support → 
Documentation page you can download the current and archived PDF 
documentation and examples, or navigate to the TC-Python and TC-Toolbox for 
MATLAB® help and diagnostics tools. For current technical information and 
examples collections for the databases, you can access these by database 
starting on the Products → Databases page.

https://thermocalc.com/support/documentation/
https://thermocalc.com/support/documentation/
https://thermocalc.com/products/databases/
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About the Manuals (Documentation) Folder

There is documentation available in PDF format from the Help →  Manuals folder as part 
of your installation. Except for two of the SDKs, this is the same information as is contained 
in the Thermo-Calc online help, just in a different format. The contents of each folder are 
described below. 

It is recommended you search the help (press F1 in Thermo-Calc) if you cannot 
find what you are looking for in a particular folder or PDF.

A Documentation Set contains a variety of user guides packaged together in one 
PDF. For the Process Metallurgy Module and specialized material specific 
Property Models (i.e. Steel or Nickel), all the content is contained in the 
Thermo-Calc Documentation Set or online help.
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Additive Manufacturing (AM) Module 

The Additive Manufacturing Module User Guide is a summary PDF for the functionality of 
the Additive Manufacturing (AM) Module and its AM Calculator. This is a highly specialized 
product and it is interconnected to Thermo-Calc features such as the Scheil Calculator, 
Diffusion Calculator, and Precipitation Calculator. It requires additional licenses for some 
functionality. The user guide is not comprehensive. Use the Thermo-Calc Documentation Set 
or online help for all other content. 

All Thermo-Calc Documentation

The Thermo-Calc Documentation Set is one large PDF that includes the information needed 
to work with the Thermo-Calc software. By having all content in one PDF it enables you to 
search the content just like you would when in the online help (with some exceptions). For 
example, this PDF does not include specific database or other specialized content that can 
require additional licenses.

The Thermo-Calc Documentation Set includes the following.

Thermo-Calc Installation Guides

Includes all installation instructions for all platforms and license types.

Graphical Mode User Guide 

Includes details about all features and calculators included with Graphical Mode. For 
example, it includes details about calculators available with add-on products such as the 
AM Calculator, Diffusion Calculator, Precipitation Calculator, Process Metallurgy Calculator, 
and all the Add-on Material Specific Property Model Libraries (i.e. Steel, Nickel, etc.). For the 
Add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA), additional 
information is included in the separate documentation.

Console Mode User Guide

Includes details about the functionality and features available with the Console Mode 
version of Thermo-Calc. 

For example, the following is only in Console Mode and the associated documentation is 
included in the respective documentation.
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 l The PARROT module optimization content is described in the Data Optimization User 
Guide. 

 l If you develop your own custom databases, this is described in the Database 
Manager User Guide. There is some other generally related documentation that is 
found under General Reference.

 l If you use the old DATAPLOT functionality for plotting, this is included in the 
DATAPLOT User Guide.

 l The POURBAIX module is only in Console Mode and there is the Pourbaix Diagrams 
Educational Material guide included.

 l A separate Thermo-Calc Console Mode Example Macros PDF is available in the folder 
but NOT included in the Documentation Set due to its file size and page length.

Thermo-Calc General Reference

This is content that spans some of the general topics applicable to multiple applications 
within Thermo-Calc, i.e. it might be for both Console Mode and Graphical Mode, or needed 
for a specific database calculation in Thermo-Calc (i.e. model information, variables, and 
functions for thermophysical properties).

 l Parameters, Functions, and Variables: Information applicable to both Console Mode 
and Graphical Mode with respect to understanding the format these are to be 
written in for Thermo-Calc to use the parameter, function, or variable. However, 
many of the sections are specific to Console Mode where the explicit use of these 
terms is more often used.

 l Thermophysical Properties Data: This includes the model descriptions and  data 
parameters you would need in combination with a database that has the relevant 
thermophysical property.

 l Database Files and Database Checker: Information about the database initialization 
file, differences between Thermo-Calc encrypted and user-defined unencrypted 
databases, about cached database files, and more. Some content is more specific to 
those developing their own databases, other information is intended for advanced 
users, for example, the Database Checker information is a supplement to the 
Database Manager User Guide.

 l Global Settings: In the Options window you can globally set general settings for 
Graphical Mode as well as default settings for any new activities for both Graphical 
Mode and Console Mode. 
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Database Information Sheets (Technical Information)

The Technical Information content available as a PDF is also included in the online help 
system and contains details such as the elements, systems, phases, and properties available 
with a specific database. It includes the revision history for the database.

Starting with Thermo-Calc 2020b, databases are transitioning from the 
Extended Info PDF, which can include examples, to individual Validation and 
Calculation Examples Collection. The examples are only available on the website 
or in the help.

All Technical Information and  Validation and Calculation Examples Collection PDFs for the 
current version of the database are available for download from the Thermo-Calc website.

DATAPLOT Example EXP Files

The examples are available as supplementary information as described in the 
DATAPLOT User Guide, which you can find in either the online help, Thermo-Calc 
Documentation Set or Diffusion Module (DICTRA) Documentation Set.

Diffusion Module (DICTRA)

The Diffusion Module Documentation Set  is one large PDF that includes the information 
needed to work with the Add-on Diffusion Module (DICTRA) and Thermo-Calc software in 
Graphical Mode and Console Mode. By having all content in one PDF it enables you to 
search the content just like you would when in the online help (with some exceptions). For 
example, this PDF does not include specific database or other specialized content that can 
require additional licenses.

The Documentation Set includes:

 l All the content available in the Thermo-Calc Documentation Set and described above.
 l Diffusion Module (DICTRA) Quick Start Guide - Graphical Mode and Quick Start Guide 

-Console Mode.
 l Diffusion Module (DICTRA) Command Reference (for Console Mode only)

Also available separately in this folder:

https://thermocalc.com/products/databases/
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 l Diffusion Module Quick Guide - Console Mode
 l Diffusion Module Quick Guide - Graphical Mode
 l The Diffusion Module (DICTRA) Console Mode Example Macros PDF is available in the 

folder but NOT included in the Documentation Set due to its file size and page length.

Installation Guides

Includes the Quick Install guides for Standalone (SUNLL) Windows and macOS systems, 
instructions for TC-Python and TC-Toolbox for MATLAB®, with the full installation 
instructions for all platforms and license types. 

For convenience, the TC-Python Installation Guide is also included as a separate 
PDF in this folder. 

Precipitation Module (TC-PRISMA)

There is a User Guide in this folder, which includes examples, Precipitation Calculator 
settings, references, and details about the theoretical models and numerical methods. Use 
the Thermo-Calc Documentation Set or online help for all other content. 

Software Development Kits (SDKs)

Separate TC-Python and TC-Toolbox for MATLAB® documentation is stored in 
its own folder and each is available from our website. This folder has the 
PDF version of this content.

 l TC-Python API Programmer Guide: This guide is the PDF format of the HTML help 
described below. 

 l TQ-Interface Programmer Guide 
 l TC Toolbox for MATLAB® Programmer Guide:  This guide is the PDF format of the 

HTML help described below. 
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TC-Python

This folder contains the TC-Python HTML files. Double-click Index.html file to open it.  This 
help is also available on our website. TC-Python includes details about working with custom 
property models (the Property Model Framework).

TC Toolbox_MATLAB

This folder contains the TC Toolbox for MATLAB® HTML files. Double-click Index.html file to 
open it.  This help is also available via our website.

https://www2.thermocalc.com/docs/tc-python/latest-version/html/
https://www2.thermocalc.com/docs/tc-toolbox/latest-version/html/
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About the Examples

To learn more about how to use the software you can open and run the example projects 
(Graphical Mode) and macro files (Console Mode). 

Graphical Mode Examples

Graphical Mode examples are available for Thermo-Calc and the Add-on Modules. There are 
also examples for the Property Models, including the material specific model libraries (i.e. 
Steel, Nickel, etc.). These are in the format of project files (*.tcu).

Many of our Graphical Mode examples have video tutorials, which you can 
access in a variety of ways. When in Thermo-Calc, from the menu select Help → 
Video Tutorials, or from the main My Project window, click Video Tutorials. 
Alternately,  you can go to the website or our YouTube channel.

Console Mode Examples

Console Mode examples are available for Thermo-Calc and the Diffusion Module (DICTRA). 
The macro files are in the format of *.TCM and *.DCM, respectively. 

There are other file types when you are working in Console Mode.   Search the 
Help for  About the File Formats or About the DICTRA File Formats.

Examples by Product

Thermo-Calc Examples

A description of the Thermo-Calc examples, and how to access them, is based on whether 
you are using Graphical Mode or Console Mode. 

Thermo-Calc  Examples Collection

Console Mode Examples

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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Additive Manufacturing (AM) Module Examples

A description of examples using the AM Calculator, which is only available in Graphical 
Mode,  is included in the Thermo-Calc documentation.

Additive Manufacturing (AM) Module Examples Collection

Diffusion Module (DICTRA) Examples

A description of Diffusion Module (DICTRA) examples, which are available for both Graphical 
Mode and Console Mode, is included in both the Thermo-Calc and Diffusion Module 
(DICTRA) documentation. 

For Graphical Mode, see Diffusion Module (DICTRA) Examples Collection

For Console Mode, search the help or go to the Diffusion Module 
(DICTRA) documentation set.

All the macro files and the outputs are also combined into one file that you can 
search and read. This is included with your installation as a PDF (go to Help → 
Manuals folder → Diffusion Module (DICTRA) and open  Diffusion Module 
Console Mode Example Macros. 

Precipitation Module (TC-PRISMA)

A description of examples using the Precipitation Calculator, which is only available in 
Graphical Mode,  is included in both the Thermo-Calc and Precipitation Module (TC-PRISMA) 
documentation.

Precipitation Module (TC-PRISMA) Examples Collection 

Process Metallurgy Module Examples

A description of examples using the Process Metallurgy Calculator, which is only available in 
Graphical Mode,  is included in the Thermo-Calc documentation.

Process Metallurgy Module Examples Collection
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Property Models including Material Specific Model Library Examples

A description of examples using the Property Model Calculator, which is only available in 
Graphical Mode, is included in the Thermo-Calc documentation.  

Thermo-Calc General Property Models Examples Collection

Steel Model Library Examples Collection

Nickel Model Library Examples Collection

Titanium Model Library Examples Collection

Noble Metal Alloys Model Library Examples Collection

TC-Python Examples

There are examples for TC-Python available after installing the SDK. A brief description of 
the TC-Python SDK examples, and how to access these, is  available in the Help.

TQ-Interface  Examples

There are examples for the TQ-Interface  available. See  the TQ-Interface Guide for brief 
descriptions. 

TC-Toolbox for MATLAB® Examples

There are included examples with all TC-Toolbox installations. These are generally the same 
as the examples included with TC-Python although with a different suffix (matex) and prefix 
(*.m or *.mlx) in the file name. Not all examples included with TC-Python are available for 
this SDK. You can read summaries about the examples as described in the online help.

See  Installation Default Directory: TC-Toolbox and the Examples to learn where 
these are located. 
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Database Examples

Most of the databases have a Validation and Calculation Examples Collection 
available as a PDF you can download from the website. The information there is 
included in this help content.

https://thermocalc.com/products/databases/
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Help Resources

'Online' Help: No Internet Required

There are several ways to access online help in a browser. The content opens in a browser 
but uses local content so you do not need an Internet connection except for links to external 
websites.

First open Thermo-Calc, then choose one of these options:

 l Press <F1> on the keyboard.
 l Select Help →  Online Help.

 l On the My Project Configuration window, click  Online Help.
 l At the bottom of any Configuration window, click  Help.

There are several resources available on our website to help you learn how to 
use Thermo-Calc and other Add-on Modules. Go to the Getting Started Guides 
page and choose one of the guides that provides new users an introduction to 
setting up simple calculations in Graphical Mode. The information there is also 
in this help documentation.

Console Mode Help

Console Mode is for Thermo-Calc and the Diffusion Module (DICTRA).

In Console Mode at the command line prompt, you can access help in these ways:

 l For a list of all the available commands in the current module, at the prompt type a 
question mark (?) and press <Enter>.

 l For a description of a specific command, type Help followed by the name of the 
command. You can only get online help about a command related to the current 
module you are in.

 l For general system information type Information. Specify the subject or type ? and 
the available subjects are listed. This subject list is specific to the current module.

https://thermocalc.com/support/getting-started-guides/
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Typographical Conventions

The following typographical conventions are used throughout the documentation, both 
online and in the PDF documents.

Text

Convention Definition

Forward arrow symbol 
→

The forward arrow symbol → instructs you to select a series of menu items in a specific 
order. For example, Tools → Options is equivalent to: From the Tools menu, select 
Options.

Boldface font
A boldface font indicates that the given word(s) are shown that way on a toolbar button 
or as a menu selection. For example, if you are told to select a menu item in a particular 
order, such as File → Save Project, or to click Save.

Italic font An italic font in the body of the text indicates the introduction of important terminology. 
Expect to find an explanation in the same paragraph or elsewhere in the guide. 

COMMAND

For features in Thermo-Calc that use Console Mode (i.e. the command line), this font 
and all capital letters indicates that this is a Console Mode COMMAND. Examples of how 
you can use a command are written with code font. For example:

Use DEFINE_ELEMENTS followed by a list of the elements that you want in your system. 
(To list the elements that are available in your current database, use LIST_DATABASE and 
choose Elements).

HELP
Text in blue and underline and a page number is a link to another topic in the current or 
referenced guide. Command names are often also topics. Clicking the link takes you to 
more detail about a particular command or subject in the PDF or documentation set.

<Enter> Text with <angle brackets> indicates a keyboard entry. Usually to press <Enter> (or 
Return) or to use a series of keys such as <Ctrl + S>.

code and code bold

A code font shows a programming code or code example. The code bold font highlights 
the entry. It is also used for file names or paths to help distinguish it from other text. e.g. 

 l For Windows users, the documents, materials, examples and other folders that 
sometimes require additional licenses are installed in C:\Users\Public\Public 
Documents\Thermo-Calc\<version>."

click vs press In general, you click with the mouse to perform an action on the screen (e.g. click Save) 
and you press keys on a keyboard to enter a set of commands  (e.g. press Ctrl+S).
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Convention Definition

When working in Console Mode, you can use keyboard shortcuts. 
Sometimes a window opens where you have the option to Save, Cancel 
or Open a file, for example. In these cases the instructions might say 
click Save, whereas you would need to press the applicable keys to 
perform the action.

Icons

Convention Definition

Important Provides important information. It is recommended that you read the 
text or follow the link.

License Required This indicates that additional licenses are required for the feature, 
database, or example.

Note The information can be of use to you. It is recommended that you read 
the text or follow the link to more information.

Time Indicates that something you are going to do will take some time, 
usually related to running an example.

Tip This is general information that can be of use but is not required 
knowledge.

Read More Read more at the link, which may be to our website or another source 
of general information.
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Convention Definition

See More Go to the link or guide to see more general information about the 
topic being discussed.

Training Indicates there may be training opportunities available, usually related 
to a specific feature. 

Link to more information Click the link to more information in the content.

Examples Go to the example collection to learn more.

Console Mode This note relates specifically to something in  Console Mode.

Video 
Indicates there is a video tutorial on our website, usually in relation to 
an example.

Graphical Mode This note relates specifically to something in  Graphical Mode.

Diffusion Module 
(DICTRA)

This indicates that the information relates to the Add-on Diffusion 
Module (DICTRA).

Precipitation Module (TC-
PRISMA)

This indicates that the information relates to the Add-on Precipitation 
Module (TC-PRISMA).

Process Metallurgy 
Module

This indicates that the information relates to the Add-on Process 
Metallurgy Module.

Property Models
This indicates that the information relates to the Property Models. This 
includes the Steel Model Library and Nickel Model Library as well as the 
general Models included with all installations.

Additive Manufacturing 
(AM) Module

This indicates that the information relates to the Add-on Additive 
Manufacturing (AM) Module.
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Working in Graphical Mode
In this section:

The Graphical Mode Desktop Layout 4

Menu, Toolbar, and Keyboard Shortcuts 6

Organizing the Windows on the Desktop 10
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The Graphical Mode Desktop Layout

Open Thermo-Calc to view the default graphical user interface (GUI) layout for Graphical 
Mode. 

The windows are:

 1. Project: Create, make changes, and navigate between the activities that make up a 
project. Click the My Project node to access the Quick Start wizard and a variety of 
templates to create projects for all the calculator types. 

 2. Configuration: Shows the settings that can be configured for the currently selected 
activity.  

 3. Visualizations: Shows the results of a calculation, either plotted as a diagram or 
displayed in table format. For some types of calculations, there are also previews of 
settings shown in this window. In this example, there is only a Plot Renderer tab in 
the Visualizations window.

Previews in the Visualizations window are applicable to some of the 
Add-on Modules, i.e. for the Diffusion Calculator, Precipitation 
Calculator, and AM Calculator. The information is detailed in the 
relevant sections of the documentation. 

 4. Scheduler: Displays information about jobs, such as calculations, that are being 
performed or are scheduled to be performed. You can cancel scheduled jobs and if a 
job has failed, then you can view information about the error.

 5. Event Log: By default this window is closed but it displays during calculation 
processes. You can always open it to view progress of calculations and to 
troubleshoot.

In this example, the Visualizations window also has a Plot Renderer tab. You can also 
have a Table Renderer tab and when working with calculations that have specialized 
settings, these tabs are also included and match the names of the nodes in the 
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Project window. 
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Menu, Toolbar, and Keyboard Shortcuts

The File menu and toolbar are reserved for Graphical Mode but in Console Mode the Tools, 
Window, and Help menus have the same options. 

For Mac users, the Tools menu has only one item. The global Options window is 
opened by selecting Thermo-Calc <version> → Preferences or press <⌘> on 
the keyboard.

In Console Mode you use commands to access the other options, for example 
see Main Menu Commands.

Graphical Mode Menu and Toolbar Options

Button or 
Icon Action Description Action (s)

New Project Create a new project. Also see Creating 
a Project from a Template.

 l Click the New button  on 
the toolbar

 l Select File → New Project

 l Windows: Press <Ctrl+N>

 l Mac: Press < ⌘ + N>

Open Project Open an existing project. See Opening 
Project Files.

 l Click the Open button  on 
the toolbar

 l Select File → Open Project

 l Windows: Press <Ctrl+O>.

 l Mac: Press < ⌘ + O>
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Button or 
Icon Action Description Action (s)

-- Open Recent 
Project

Open a recent project. See Opening 
Project Files.

Select File → Open Recent Project and 
choose from the list of projects or click 
Clear Recent Projects to reset the list. 
Up to the last 10 projects are listed 
and numbered in the order at which 
last opened.

Save Save a project. See Saving Project Files.

 l Click the Save button  on 
the toolbar

 l Select File → Save Project

 l Windows: Press <Ctrl+S>.

 l Mac: Press < ⌘ + S>

Save Project 
As

Save an existing project with a new 
name. See Saving Project Files.

 l Select File → Save Project As 

 l Windows: Press 
<Ctrl+Shift+S>

 l Mac: Press < ⇧⌘ + S>

Switch to 
Console 
Mode

This button is available when working 
in Graphical Mode. Click to switch to 
Console Mode and the command 
prompt.

Click the button to exit Graphical 
Mode and open Console Mode.

Switch to 
Graphical 
Mode

This button is available when working 
in Console Mode. Click to switch to 
Graphical Mode and work with the GUI 
version.

Click the button to exit Console Mode 
and open Graphical Mode.

Append 
Project

Combine two projects into one project 
file. See Appending Project Files.

 l Select File → Append Project

 l Windows: Press 
<Ctrl+Shift+O>

 l Mac: < ⇧⌘+O>

Exit Exit the program.

 l In the upper right-corner of 
the program, click the X.

 l Windows: Select File → Exit 
or press <Ctrl+Q> on the 
keyboard.
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Button or 
Icon Action Description Action (s)

 l Mac: Thermo-Calc <version> 
→ Quit or press <⌘+Q> on 
the keyboard.

Options
Change the global defaults for a variety 
of settings. 

See Global Settings.

To open the Options window:

 l Windows: Select Tools →  
Options.

 l Mac: Select Thermo-Calc 
<version> → Preferences or 
Settings or press <⌘> on 
the keyboard.

Database 
Checker

Open the Database Checker, a 
program to check that the syntax of 
Thermo-Calc database files is correct. 
This is for advanced users who develop 
and manage databases. See About the 
Database Checker.

Select Tools → Database Checker

-- Window 
menu Highlight a specific window on the GUI 

From the Window menu, select an 
option to refocus on that specific 
window. 

Help

Open the help system where you can 
browse or search all the Thermo-Calc 
documentation.

This does not require 
an Internet 
connection. The 
content is stored 
locally.

First open Thermo-Calc, then choose 
one of these options:

 l Press <F1> on the keyboard.

 l Select Help →  Online 
Help.

 l On the My Project 
Configuration window, click 

 Online Help.
 l At the bottom of any 

Configuration window, click 
 Help.

Video 
Tutorials

Open a link to the Thermo-Calc 
website where a variety of video 
tutorials are available.

 l Select Help → Video 
Tutorials

 l On the My Project 
Configuration window, click 

 Video Tutorials.

Examples Open the examples folder based on  l Select File → Examples Files.
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Button or 
Icon Action Description Action (s)

Files
whether you are in Console Mode or 
Graphical Mode. Also see Opening 
Example Project Files in Thermo-Calc.

 l Select Help → Examples 
Files.

 l On the My Project 
Configuration window, click 

 Example Calculation.

Manuals 
Folder

Open the folder on your computer that 
has the PDF documentation and 
guides. Also see About the Manuals 
(Documentation) Folder.

Select Help → Manuals Folder

Show License 
Info

Open the License Information window. 
Also see Displaying Thermo-Calc 
License Information and the 
Thermo-Calc Installation Guide

Select Help → Show License Info

Check for 
update

Check for updates to the software. 
Also see Updating the Software for 
Interim Releases.

Select Help → Check for Updates

Request 
Support

Open a link to the Support on the 
Thermo-Calc website. There are 
instructions about how to submit your 
question.

Select Help → Request Support

About
Includes the version number of the 
installed software and information 
about third party software licenses.

Select Help → About

Notes Open a Notes - My Project window to 
add notes to your project file. 

At the bottom center of the 
Configuration window, click the Notes 

( ) button. Once a note is added, 
hover your mouse over the button and 
it is then called Read and edit notes.

https://thermocalc.com/support/request-support/
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Organizing the Windows on the Desktop

The windows on the Thermo-Calc desktop can be fixed or free floating. By default, most 
windows are fixed and open. 

Using a combination of menu (right-click the window bar) and buttons (top right corner of a 
window), you can organize the windows as needed for your workflow.

For example, right-click the top of a window to select from the options to float, auto hide, 
maximize, or dock it. You can also left-click on the top bar of a window to float (i.e. 
detach) and move a window or to dock it again using the guides on the screen.

Reset the Desktop Layout

At any time to return to the standard desktop layout, from the main menu, select Window 
→ Reset Windows.

Make a Window Dockable or "Permanently" Floating

By default windows are dockable, i.e. you can move the windows around using the outline 
guides and adjust the layout location for each window on one monitor. When a window is 
NOT dockable the window can be moved around it is just does not become part of the 
layout, it stays floating all the time (i.e. it is "permanently" floating).

When Dockable is turned off (i.e. not selected) the other options are not 
available and there are no buttons at the top right corner of the window. 
However, you can reset the desktop layout to return it to the default location. 

Right-click the top of a window to select Dockable to turn this option on and off.
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Auto Hide (Minimize) a Window

When a window is fixed it can also be set to auto hide. Auto-hiding means that the window 
is minimized and placed as a tab either along the top or bottom or side of Thermo-Calc. A 
free-floating window is shown on top of the other windows and can be moved outside the 
frame of Thermo-Calc. when you select another window. 

 l Right-click the top of a window to select Auto Hide to turn this on and off. 

 l Click the pin  and unpin  buttons  to Toggle auto-hide on and off. The buttons 
are on the top-right of a window.

 l Click the minimize  button to Hide active auto-hide window. The window 
automatically minimizes if another window is selected. This button is available on the 
top right of a window that is already set to auto-hide.  

The Event Log window is set by default to auto-hide.

Maximize or Restore a Window

 l Double-click the top bar of a window (i.e. Project, Configuration, Visualizations, etc.) 
to maximize the window pane across the whole monitor. This hides the other 
windows. To restore the configuration (and the hidden windows) double-click the top 
bar of the window a second time.
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This can be useful for small screens, or if you are working on a large 
screen and want to compare two configurations side-by-side. 

 l Right-click the top of a window to select Maximize. To restore the window to its 
previous state and location, right-click the bar of the window again and select 
Restore.

Float or Fix a Window

There are several ways to float and fix a window back to its most recent location in the 
layout.

 l Right-click the top of a window to select Floating and turn this on and off. 
 l Left-click on the top bar of a window to float (i.e. detach) and move a window or to 

dock it again using the guides on the screen.
 l Click the Toggle floating  button to float the window.
 l Click the Toggle floating  button to turn off floating and dock the window 

automatically to its last location.
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About the Activity Nodes

Graphical Mode Activities vs Console Mode Modules 

In a project, a set of linked activities is called a tree. A result calculated within a tree is fed as 
input into the next activity in the tree. Consequently, if you have an Equilibrium Calculator 
with another Equilibrium Calculator as its successor, the successor takes the calculation 
results of the predecessor as the starting values for its calculation. When working with 
activities in the Project window these are also referred to as nodes (or activity nodes) in the 
tree structure.

The example below  shows a  My Project node with two trees. In each tree, settings and 
calculation results are propagated downward until the calculation and the visualization of 
the results are completed in the Plot Renderer nodes. 

The system definitions, settings, and calculation results of the two trees are independent of 
each other in this example. 

There are several resources available on our website to help you learn how to 
use Thermo-Calc and other Add-on Modules. Go to the Getting Started Guides 
page and choose one of the guides that provides new users an introduction to 
setting up simple calculations in Graphical Mode. The information there is also 
in this help documentation.

https://thermocalc.com/support/getting-started-guides/
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Activity Successor and Predecessor Nodes

An activity node located below another activity node in a tree is referred to as that activity’s 
successor. An activity located above another activity is called that activity’s predecessor. A 
predecessor is performed before the predecessor’s successors and its result is fed forward 
to any successor activities.

For example, to calculate and display a phase diagram, create a branch with three linked 
activities: A System Definer activity linked to an Equilibrium Calculator activity, which in 
turn is connected to a Plot Renderer activity.

You can determine the available successors by right-clicking a node in the Project window to 
browse what is available from the menu and follow the arrows connecting the nodes. The 
example below shows that Scheil Calculator 1 is a predecessor to the successors, Plot 
Renderer 1 and Table Render 1.
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Creating Activities and Successors and Cloning Activities and Trees

Activity Node Descriptions

The table below is  a brief description of the activity types you work with in the Project 
window. When working with activities these are referred to as nodes in this documentation.

These are the project activity nodes available in Graphical Mode. Some of these require 
additional licenses for full feature availability. Listed in alphabetical order.

Activity Type Description

AM Calculator

Using the Additive Manufacturing (AM) Module this activity is used in conjunction with either 
the Scheil Calculator or a Material Library to define the necessary settings to  better understand 
the laser powder bed fusion (LPBF) process by predicting the temperature distribution and melt 
pool geometry as a function of process parameters. There is also connectivity with the Diffusion 
Calculator and Precipitation Calculator to include probe data with a Thermal Profile calculation. 
In DEMO mode you can view the settings and experiment with some things, but no calculations 
can be run. 

Binary Calculator

Use it for some calculations involving two components only. It is like a combination of System 
Definer and Equilibrium Calculator activities with adaptations to simplify the configuration of 
calculations on binary systems.

To perform this activity, you need a database designed for the Binary 
Calculator, such as the TCBIN database.

Diffusion 
Calculator

Using the Diffusion Module (DICTRA), this activity is where you set the geometry, add one or 
more regions, enter grids and phases in the regions, and then enter compositions of phases. You 
can also use this in DEMO mode with up to three components. There is also connectivity to the 
Scheil Calculator and to other Add-on Modules such as the Additive Manufacturing (AM) 
Module. 

Equilibrium 
Calculator

Set thermodynamic conditions and define axis variables when a series of equilibrium 
calculations are to be performed in one or more dimensions.

Experimental File 
Reader

Read experimental data files (*.EXP). This type of file contains information specifying a plotted 
diagram, written in the DATAPLOT graphical language.

Material to 
Material 
Calculator

This activity calculates materials transitioning from one into the other.
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Activity Type Description

Plot Renderer Determine the layout of non-text based output.

Precipitation 
Calculator

Set the conditions for, and perform, a precipitation calculation using the Precipitation Module 
(TC-PRISMA). You can also use this in DEMO mode with up to three components. There is also 
specialized connectivity to the Yield Strength Property Model and to other Add-on Modules 
such as the Additive Manufacturing (AM) Module. 

Process 
Metallurgy 
Calculator

This calculator allows for efficient setup of advanced calculations involving slag, metal and gas. 
Define the composition of a steel and slag system using material groups: one each for steel, slag 
and gas.

Property Model 
Calculator

Choose one or more General Models to predict and optimize material properties. You can 
evaluate models simultaneously over a range of compositions and cross plot the results. You can 
then conduct an uncertainty analysis and plot the results as either a histogram or as a 
probability plot. With additional licenses, there are Steel Models and Nickel Models available. 

Scheil Calculator

Perform Scheil-Gulliver calculations (also known as Scheil calculations). A default Scheil 
calculation is used to estimate the solidification range of an alloy assuming that i) the liquid 
phase is homogeneous at all times and ii) the diffusivity is zero in the solid. However, it is 
possible to disregard the second assumption for selected components. The Scheil Calculator is 
also used with other specialized Add-on Modules such as the Diffusion Module (DICTRA) and 
Additive Manufacturing (AM) Module. 

System Definer Define a certain thermodynamic system and read it from file into memory.

Table Renderer Use this activity for text-based output.

Ternary 
Calculator

Use it for some calculations involving three components. It is like a combination of System 
Definer and Equilibrium Calculator activities with adaptations to simplify the configuration of 
calculations on ternary systems.

To get a reliable result you need a database that fully assesses binary and 
ternary systems.
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Activity Node Workflow

You can set up a tree in the Project window (starting with the  My Project node) and then 
perform all the activities at once, or create and perform one activity at a time.

Additional licenses are required for some of the listed features.

You can also use the templates to add all the necessary activity nodes based on 
your simulation needs. See Creating a Project from a Template.

The typical workflow is to:

 1. Define a System: Add a System Definer activity (in the Project window) where you 
select a database and the elements to have as system components (in the 
Configuration window). 

 l To the  My Project node, you can alternatively add and define one of these 
activity nodes: AM Calculator, Binary Calculator, Ternary Calculator,  Process 
Metallurgy Calculator, or Experimental File Reader.

 2. Set up and run a calculation: Add an Equilibrium Calculator activity (a successor to 
the System Definer), where calculation conditions are set (temperature, pressure, 
etc.). This is where axis variables are set to create a property or phase diagram. 
These settings are also made in the Configuration window. You can also add a 
Property Model Calculator, Material to Material Calculator, Precipitation Calculator, 
Diffusion Calculator, or Scheil Calculator to the System Definer. The AM Calculator is 
also available and can either be added directly to the  My Project node or as a 
successor to the Scheil Calculator. It depends how you work with this Add-on 
Module.

 3. Preview some settings: For some specialized calculations (i.e. with the Add-on 
Modules), you can preview the settings in the Visualizations window. For example, 
for the Diffusion Calculator (Composition Profiles and Thermal Profiles), for the 
Precipitation Calculator (Thermal Profiles), and with the AM Calculator a variety of 
settings are previewed during the set up. 
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 4. Visualize the results: Add either a Plot Renderer or a Table Renderer activity in the 
Project window. When calculated, this creates a plot or table in the Visualizations 
window. The results are shown in a Plot Renderer or a Table Renderer tab. 

You need to Perform a Plot Renderer or a Table Renderer activity to 
visualize the calculation results from an Equilibrium Calculator.

Getting Started Links and Templates and About the Activity Nodes
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Creating Activities and Successors

You can create a new activity in these ways:

 l In the Project window, right-click an activity and choose Create New Activity (  My 
Project node only) or Create New Successor (all other nodes). 

 l Select the activity you want to create from the submenu.
 l At the bottom of the Configuration window, click Create New Activity or Create 

New Successor and select the activity to create.
 l Use the available templates or the Quick Start wizard: Click the  My Project node 

and select templates from the Configuration window to quickly add a set of activity 
nodes to the tree.

The activity nodes listed in the table are in alphabetical order not in order of 
selection from the various menus. Additional licenses are also required to 
access full functionality for any Add-on Modules.

Activity Possible Predecessors Possible Successors

 My Project

None; this is the first node of the tree 
structure. You can add activities using the 
Quick Start wizard or templates.

Getting Started Links and 
Templates

AM Calculator, System Definer,  Binary 
Calculator, Ternary Calculator, Process 
Metallurgy Calculator, or Experimental 
File Reader. Also choose templates from 
this level.

AM Calculator My Project, Scheil Calculator Plot Renderer, Diffusion Calculator, 
Precipitation Calculator
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Activity Possible Predecessors Possible Successors

When a Diffusion 
Calculator or  
Precipitation Calculator 
is added, a full set of 
nodes, including a 
System Definer and Plot 
Renderer, are added as 
a template to the top 
My Project node. The 
Diffusion Calculator or 
Precipitation Calculator 
is linked to the 
AM Calculator. 

Binary Calculator My Project Plot Renderer

Diffusion Calculator System Definer, AM Calculator Plot Renderer, Table Renderer

Equilibrium Calculator System Definer, Equilibrium Calculator Equilibrium Calculator, Plot Renderer, 
Table Renderer

Experimental File 
Reader My Project Plot Renderer

Material to Material 
Calculator System Definer Plot Renderer, Table Renderer

Plot Renderer

Equilibrium Calculator, Material to 
Material Calculator, Property Model 
Calculator, Binary Calculator, Ternary 
Calculator, Scheil Calculator, Process 
Metallurgy Calculator, Diffusion Calculator, 
Precipitation Calculator, AM Calculator, 
Experimental File Reader

None

Precipitation Calculator System Definer, AM Calculator Plot Renderer, Table Renderer

Process Metallurgy 
Calculator My Project Plot Renderer, Table Renderer

Property Model 
Calculator System Definer Plot Renderer, Table Renderer

Scheil Calculator System Definer Plot Renderer, Table Renderer, 
AM Calculator, Diffusion Calculator
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Activity Possible Predecessors Possible Successors

System Definer My Project, System Definer
Property Model Calculator, Equilibrium 
Calculator, Precipitation Calculator, Scheil 
Calculator

Table Renderer

Equilibrium Calculator, Material to 
Material Calculator, Property Model 
Calculator, Binary Calculator, Scheil 
Calculator, Process Metallurgy Calculator, 
Diffusion Calculator, Precipitation 
Calculator

None

Ternary Calculator My Project Plot Renderer
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Cloning Activities and Trees

As described in Creating Activities and Successors, you can clone a single activity or the 
selected activity and all the activities that come after it (successors). The predecessor of the 
selected activity also is the predecessor of the clone. 

Cloned activities are configured exactly like the activities that they were cloned from, and 
any results of calculations or plots are also cloned. To clone a selected activity, right-click the 
activity and select Clone.

For example, if you clone the Equilibrium Calculator in this project the result is an 
Equilibrium Calculator 2 created as a successor to System Definer 1.

The following applies to clones.

 l The new Equilibrium Calculator has the same settings for conditions, functions and 
options as its Equilibrium Calculator 1 clone. 

 l If the Equilibrium Calculator is already performed, then the calculation results are 
cloned.

 l If the activity is a Plot Renderer or a Table Renderer, then the plot or table is cloned. 
 l If you want to clone all the successor activities that follow a selected activity, then 

right-click and select Clone Tree instead.

Cloning an Equilibrium Calculator activity node.
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About Equilibrium Calculator Clones and Successors

If you create an Equilibrium Calculator as a successor to another Equilibrium Calculator, then 
the successor inherits all the settings for conditions, functions and options from its 
predecessor. In this respect, it is similar to a clone. 

The Equilibrium Calculator successor is different from a clone in that it does not 
inherit any calculated results and it is a successor to the Equilibrium Calculator 
instead of a successor to its predecessor. 

The calculated result from an Equilibrium Calculator that is the predecessor to another 
Equilibrium Calculator is the starting value for the latter’s calculation. The clone of an 
Equilibrium Calculator on the other hand, does not receive any data as input from the 
Equilibrium Calculator that it is cloned from.
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Moving or Grouping Nodes and Using the Grid

In the Project window, you can work with the activity nodes in these ways.

 l Select and move individual nodes
 l Select several nodes at a time
 l Select and then group activity nodes
 l Show the grid and "snap" to it
 l Apply Auto Layout

Select and Move Individual Nodes
 l Click an activity node to select it. 
 l To move activities, click and hold the activity node and move the cursor.

Select Several Nodes at a Time
 l To select several activity nodes, hold down <Ctrl> while clicking on each node you 

want to select. 
 l Click and hold the mouse button and draw a square around the activity nodes to 

select. Both the name and the icon that represents an activity must be within the 
square.
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Group Activity Nodes

You can group activity nodes together on the Project window. This also creates separate 
tabs on the Configuration window so you can more easily edit the settings for each one. It is 
important to have logical groupings of nodes because the calculation relies on this 
connectivity. 

In the Project window, control + click to select each node, then right-click and select Group. 
An Activity Group node is created (you can rename it) and on the Configuration window 
there are two tabs created, named for each of the group nodes. For example, Property 
Model Calculator 1 and Property Model Calculator 2. The order of the tabs is based on the 
order of when you select each node.
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Apply Auto Layout

In the Project window, right-click anywhere and choose Apply Auto Layout from the menu. 
The nodes and the tree default to the center of the Project window.

Show Grid and Snap to Grid

To show a grid of light grey cross-hairs overlaid on a project, click Show Grid in the toolbar. 
Click the button again to turn the grid off. Or right-click in the Project window and select 
Show Grid.

Click Snap to Grid in the toolbar or right-click in the Project window and select Snap to Grid 
to automatically position each activity in the Project window at a cross-hairs point in the 
grid.

The Project window with the grid turned on and activity nodes moved from the default 
location. These nodes are snapped to the grid.
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Node or Window Status Markers

Status markers indicate whether an activity is ready to be performed, is being performed, or 
has been performed. The markers are overlaid on the activity nodes in the Project window. 
The status markers are displayed on a System Definer node.

About the Activity Nodes

Project  Window Status Markers

Status Description

No status marker means the activity is ready to be performed (i.e. it has not been performed). 

A yellow circle with an exclamation mark means there is an error or the activity needs to be run again. 
For example, the necessary configurations for the activity may not be set or other prerequisites are 
not met.

A green circle with a right-facing arrow means the activity  is being performed.

A pink circle with a clock face means the activity is currently scheduled to be performed or in the 
process of being performed.

For the Diffusion Calculator and Precipitation Calculator, you can pause a calculation. A blue circle with 
a the pause symbol indicates this state. 

A green circle with a check mark means the activity has finished its calculation, i.e. it is performed.

Scheduler Window Status Markers

Status Description

No status marker means the activity (the job) is scheduled to be performed (the job has not started).



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 30 of 763

Status Description

A yellow circle with an exclamation mark means there an error happened during the activity job. 

A green circle with a right-facing arrow means the activity (the job) is being performed.

A green circle with a check mark means the activity (the job) performed successfully.

Visualizations Window Status Marker

If you have plotted a diagram and then modify something in the tree that the Plot Renderer 
is associated with, then a notification —an exclamation mark enclosed in a yellow triangle—
is shown in the Visualizations window for the applicable tab. The tab names match the node 
names in the Project window (i.e. if a node is renamed, the tab is renamed to match).
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My Project and Activity Menus

When working in the Project window you can right-click nodes to open menus with the 
available actions. For example, click the  My Project node to open the menus. Most nodes 
in the tree have a common menu with differences due to placement in the tree and the 
activity type.

About the Activity Nodes

Menus

MY PROJECT NODE

 ACTIVITY NODE GENERAL
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Menu Options for Activity Nodes

Option Description Action (s)

Create New Activity

Add AM Calculator, System Definer, 
Binary Calculator, Ternary Calculator, 
Process Metallurgy Calculator, and 
Experimental File Reader nodes. 

Right-click My Project and from 
the Create New Activity menu 
choose an option.

Creating 
Activities and 
Successors

Create New Activity → Use 
Template

Choose from the available templates to 
use the Wizard or add predefined nodes. 

Right-click My Project and from 
the Create New Activity → Use 
Templates menu choose an 
option.

The templates are also 
available on the Configuration 
window, which you can access 
by clicking the My Project 
node, or from the Window 
menu.
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Option Description Action (s)

Creating a 
Project with 
the Quick Start 
Wizard or 
Creating a 
Project from a 
Template

Create New Successor Add a successor to the selected node. 

Right-click the  System Definer, 
any  Calculator node or the 
Experimental File Reader. 
Then from the Create New 
Successor menu choose an 
option.

Creating 
Activities and 
Successors

Add a Predecessor Add a predecessor to the selected node. 
Right-click a node to add a 
predecessor to it (when 
available).

Perform Now or Perform Later
Perform a calculation or create a plot or 
table immediately, or schedule it for a 
time in the future. 

Right-click any node.

Using the 
Scheduler

Perform Tree Now or Perform Tree 
Later

Perform a calculation for the whole 
project immediately, or schedule it for a 
time in the future. 

Right-click the System Definer 
or any Calculator node.

Using the 
Scheduler

Rename Change the name of the node. Right-click any node.

Remove Delete the selected node from the tree. Right-click any node except My 
Project.

Clone Duplicate the selected node and add it to 
the same tree. 

Right-click any node except My 
Project.

Cloning 
Activities and 
Trees
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Option Description Action (s)

Clone Tree Duplicate a tree and add it to My Project. Right-click any node except My 
Project.

Apply Auto Layout Apply an automatic layout to the nodes 
in the tree. Right-click any node.

Snap to Grid Snap a node to align it with the grid. 

Right-click any node.

Moving or 
Grouping 
Nodes and 
Using the Grid

Show Grid Turn the grid on or off in the Project 
window. Right-click any node.

Zoom In, Zoom Out, Reset Zoom Zoom in and out of the Project window 
or reset the zoom to the default. Right-click any node.
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Saving Project Files

In Graphical Mode, Thermo-Calc uses a project file format with a .tcu suffix.

If you are working in Console Mode there are other file formats used for both 
Thermo-Calc and the Diffusion Module (DICTRA). See Working with the Console 
Mode File Types.

A project file always includes project activities and the configurations. You can also include 
calculated results, although there are factors and limitations that need to be considered as 
described below and also detailed in Opening Project Files and Converting Project Files to a 
Newer Version of Thermo-Calc.

In general, to save your project file, you can choose between the following methods:

 l On the toolbar click the Save  button.
 l Press CTRL + S (Windows) or  ⌘ + S (macOS).
 l From the menu, select File →  Save Project.
 l When you want to give an existing project a new name, OR when saving with results, 

select File →  Save Project As . See Including Calculated Results with Project Files 
and Saving a Project File with Results.

If you are working in a file that includes results, any method to save the project 
file continues to include the calculated results. However, if this is the first time 
results are being included, there are additional important factors to consider as 
described next.
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Including Calculated Results with Project Files

Starting with Thermo-Calc version 2022b, saved calculated results are only 
accessible in the same version of Thermo-Calc in which it is originally created. 
For example, if you have a project file with saved results from version 2020a, 
the results are only immediately available in 2020a. You can regenerate results 
in a different version of the software but that can require adjustments to the 
configuration if new functionality or changes impact the particular project set 
up, especially if there is a wide gap between release versions.

When including calculated results in the project file there are these factors to 
consider: Future compatibility, file size, and plot design and themes.

 l Future compatibility: If you want to use this project file over time, in future versions 
of Thermo-Calc, it will require recalculation after opening. It also depends on the 
difference in versions; the project can require reconfiguration of the settings and 
other fine tuning. However, if you are going to work in the same version of the 
software for a short term project, for example, saving the file with results eliminates 
the need for re-calculating results when the file is re-opened. This is particularly 
advantageous when a simulation takes several hours to complete such as when 
working with the Add-on Diffusion (DICTRA), Precipitation (TC-PRISMA), Process 
Metallurgy, and/or Additive Manufacturing Modules.

 l File size: When results are included, the size of the file  increases. This is especially 
true when working with the Add-on Diffusion (DICTRA), Precipitation (TC-PRISMA), 
Process Metallurgy, and/or Additive Manufacturing Modules.

 l Plot design and themes: When you save your results, the plot design may have local 
or global designs or themes applied, which are also saved as part of the calculated 
results. There are considerations related to this when you open the project file again, 
especially in future versions of the software. See Opening Project Files for more 
information.

Saving a Project File with Results

 1. First, determine if saving results is efficient for your particular project based on 
future compatibility, file size, and plot design and theme factors. To save calculated 
results with the project file, choose an option:
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 l From the menu, chose  File →  Save Project As  or,
 l Press CTRL + Shift + S (Windows) or ⇧+⌘ + S (macOS).

 2. On the Save window, select the Include calculated results in the project file 
checkbox.

The checkbox is not available (it is greyed out) if no results have yet 
been calculated. In this case, go back to your project, click Perform Tree 
(or any other action to generate results) and then save the project file as 
above.

 3. Click More information to learn about the activity nodes with calculated results that 
are included / saved in the project file.

 4. Enter a meaningful File Name. It can be useful to include the version of the software 
in the file name, especially if the file is converted in a future version of the software.

 5. Navigate to the location where you want to save your project file and then click Save.

Converting Project Files to a Newer Version of Thermo-Calc
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Opening Project Files

Opening a project file in the same software version in which it was saved, with or without 
results, is straight forward and there are several methods to open a file.

See the Saving Project Files topic for useful details about saving a project file to 
include calculated results.

 l For standard instructions to open a project file with or without results, see Opening 
Project Files in the Same Version of Thermo-Calc. There are checkbox controls for 
plot themes and opening with or without results that are also described.

 l To open a recent project file, see Opening Recent Project Files.

Starting with Thermo-Calc version 2022b, all older project files including results 
generated and saved in Thermo-Calc versions 2015a to 2022a, can only be 
opened with results in the original software version. You can still open a project 
file without results and then re-perform the calculation. However, this can 
require a review and update to the settings and configurations, especially if 
there is a wide gap between versions.

For old project files being opened in a different software version, see the topic 
Converting Project Files to a Newer Version of Thermo-Calc, where you can also 
learn about regenerating the results and the automatic creation of backup files 
in these instances.
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Opening Project Files in the Same Version of Thermo-Calc

To Open a Project File from Thermo-Calc

 1. To open a project file with or without results in the same version of the software in 
which it was created, choose a method below:

 l On the toolbar, click the Open  button.
 l From the main menu, select File →  Open Project.
 l Press <Ctrl+O> (Windows) or < ⌘ + O> (macOS).

 2. On the Open File window review the checkboxes that control global plot themes and 
results:

 l By default the Apply plot theme from Tools/Options checkbox is selected 
and depends on whether the global setting checkbox is also selected  on the 
Options window, which applies a predefined or custom theme globally to the 
project file. Click to deselect the checkbox to keep the original plot design in 
your project file. For more information about the settings, see About Project 
Files and Plot Themes for additional details.

 l For macOS users, Tools/Options refers to the Options window, which is 
accessed differently. Select Thermo-Calc <version> → Preferences or press 
<⌘> on the keyboard.

 l By default the Open project with results if present checkbox is selected. Click 
to deselect the checkbox if you want to exclude results for a file saved in the 
same version of the software.

 3. If you are opening an older project file with results (in which case the file is 
converted), you are prompted by a secondary window that includes related version 
information and options to continue or not. Even if the checkbox is selected, old 
project files still cannot be opened with results. See Converting Project Files to a 
Newer Version of Thermo-Calc.

 4. When you are ready, navigate to the file on your computer and click Open.

To Open a Project File from a File Location on the Computer

Navigate to the project file on your computer then choose between these methods:
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 l In an open instance of Thermo-Calc, drag and drop it into the Project window. This 
replaces any other project already open.

 l Double-click to open it. This launches a new instance of Thermo-Calc.

The checkbox controls Open project with results if present and Apply plot 
theme from Tools/Options are not available when dragging and dropping or 
double-clicking to open.

For macOS users, Tools/Options is the same as the Preferences menu that 
accesses the Options window.

For old projects with results, and if you are dragging and dropping or double-
clicking to open, you are also prompted to decide what to do next. See 
Converting Project Files to a Newer Version of Thermo-Calc.

Opening Recent Project Files

Select File → Open Recent Project and choose from the list of projects. Up to the last 10 
projects are listed and numbered in the order in which they were last opened. You can click 
Clear Recent Projects to reset the list.

About Project Files and Plot Themes

When opening project files, a predefined or custom plot theme can be automatically applied 
to all plots. There are two checkboxes that control this, one is a global setting and one is a 
local setting applied to a specific file as it is opened.

If you double-click or drag and drop to open a project file it automatically uses 
the global settings in Thermo-Calc (which may or may not be to apply a theme). 
This means you may inadvertently apply a theme to your plots without realizing 
it.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 41 of 763

On the Open File window, the Apply plot theme from Tools/Options checkbox is selected 
by default and applies a theme locally to the specific project file being opened. Click to clear 
the checkbox to allow the specific file to keep existing plot settings.

If this checkbox is selected or cleared it only applies to the specific project file being opened, 
i.e. the global settings Apply the selected theme to opened file [.tcu] checkbox on the Tools 
→ Options window does not change.

For macOS users, Tools/Options is the same as the Preferences menu that 
accesses the Options window.

See Working with Plot Themes for the details about how the checkbox interacts 
with its counterpart.

If you have a project file with calculated results and local settings applied to 
plots i.e. applied from the Visualizations window to a specific plot via the Plot 
Properties settings window, then click to clear the local setting as you open the 
file using Apply plot theme from Tools/Options checkbox. Otherwise the 
default global settings are applied to all plots and you would need to 
individually change these settings back to your original design. Alternatively, 
experiment with applying a predefined theme, e.g. Publication, as this could be 
sufficient for your final output.

Opening Project Files Including Results and with Different 
GES Versions

When projects with calculated results created with a different Gibbs Energy System (GES) 
version than selected from the Options window, the results are discarded as these are not 
100% compatible.

GES6 (Version 6 is the default, but some may be using GES5 (Version 5). See 
Global General Settings for more information.
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Opening Example Project Files in Thermo-Calc

Additional licenses may be required to run calculations with the examples. The 
individual example descriptions detail this information. 

To open an example project file:

 1. Open Thermo-Calc.

 2. Confirm you are in Graphical Mode. If not, click the Switch to Graphical Mode  
button.

 3. There are these ways to open the folders and files:
 l From the main menu select File →  Examples Files 
 l From the main menu select Help →  Examples Files. 
 l Click the My Project node and on the Configuration window, click the 

Example Calculation  button. 

 4. The examples are divided into folders. Navigate to the folder and project file you 
want and double-click to open. 

 

 5. The Graphical Mode examples are stored without calculated results so you will want 
to run the example calculation and generate a plot or table. To do this, click the first 
node in the tree at the top of the Project window. Then right-click and select 
Perform Now. Some examples require additional licenses in order for the calculation 
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to run. 
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Appending Project Files

You can only have one project file open at a time in any one instance of Thermo-Calc. 
However, you can append the nodes from additional project files to the topmost My Project 
node in the Project window. 

To append a project file into the Project tree:

 1. Chose an option: 
 l From the main menu, select File →  Append Project . 
 l Press <Ctrl+Shift+O> (Windows) or < ⇧⌘O> (macOS).

 2. Then in the Append file window, navigate to the project file and click Open. 

 3. The nodes are appended to the top node. Drag the nodes to separate and arrange 
within the Project window.

 4. 

Saving and Printing the Output in Graphical Mode and Saving Tabulated Data 
for the Table Renderer
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Converting Project Files to a Newer Version of Thermo-Calc

This topic discusses the various considerations related to opening old project files, with or 
without results, in a different version of Thermo-Calc, i.e. converting a project file. In both 
types of conversion (with or without results), a backup file is automatically created and can 
be useful during the review or regeneration of results for a converted file.

Saving Project Files and Opening Project Files

About Backup Files

When you first open a project file in a newer version of Thermo-Calc, a backup file is 
automatically created. The backup file has (backup) added to the end of the file name, e.g. 
My Alloy (backup).tcu. This is applicable whether the file has included results or not.

If a file including the name (backup) is also converted, then another (backup) is 
added to the file name, e.g. My Alloy (backup)(backup).tcu

As soon as the original project file containing results is converted, it overwrites any 
previously saved results. This is where the backup file can be useful.

Since the version of the software used for the original project file is not always 
known, you can use the information provided in the Old project file with 
results window to rename the backup file with key information once the file is 
converted. See Converting Old Project Files - Original with Saved Results for 
information about this window.
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An example of the backup file created (in the same folder) when an old project file is opened in a 
newer version of Thermo-Calc, i.e. converted. It is recommended that users rename the file in a 
meaningful way in order to include a software version number and to indicate if it contains saved 
results.

Converting Old Project Files - No Results Saved

When opening an old project file without results, the procedure is the same as described in 
Opening Project Files. The main difference is that a backup file is automatically created. 
There can also be potential differences in setup configuration that need to be addressed.

After opening the file in the new version of Thermo-Calc, also open the Event Log to see if 
there are any messages. Try also to perform the simulation and check the results against the 
original or expected output, then continue as normal.

Converting Old Project Files - Original with Saved Results

Starting with Thermo-Calc version 2022b, all older project files including results 
generated and saved in Thermo-Calc versions 2015a to 2022a, can only be 
opened with results in the original software version. You can still open a project 
file without results and then re-perform the calculation. However, this can 
require a review and update to the settings and configurations, especially if 
there is a wide gap between versions.

To Open and Convert a Project File with Results

 1. Follow the instructions as described in Opening Project Files.

 2. At the point of opening the old project file including results, the Old project file with 
results window displays. This also occurs when the Open project with results if 
present checkbox is selected because no results can be included.

The window provides information about the original Thermo-Calc version in which 
the results were calculated as well as the version of the software in which you are 
opening the project file.
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 3. Click Continue to open and convert the file to the version of the software indicated. 
A backup file is automatically created, which includes the old results. Click Cancel to 
exit without converting the file.

 a. If you click Continue, then it is recommended that you first review the setup 
and then regenerate the results. Review the Event Log to see if there are any 
messages.

 b. If you click Cancel, or want to use the backup file to compare results between 
versions, then open the old or backup file in the original version of the 
software.

Regenerating the Results for a Converted File

As part of the project file conversion, all previous results are overwritten and the file is 
opened without results. However, the project structure and settings are maintained.

When the versions of the software are not far apart, then re-performing a simulation is likely 
to have no or few errors recorded in the Event Log.

However, to regenerate and compare results in a newer version of Thermo-Calc also 
depends on the original project set up and whether new or improved functionality in 
Thermo-Calc impacts the recalculation. Another consideration includes the availability of a 
newer version of a database than was used in the original calculation. In other words, there 
are various factors that can change the new or regenerated results compared to the original.
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Opening Old Project Files in the Original Version of Thermo-Calc

There are various reasons for wanting to open an old project file in its original version of the 
software. For example, if you are:

 l Regenerating the results in a newer version of the software and there are errors in 
the Event Log or unexplained differences.

 l Reviewing or comparing the original configuration settings to update the settings.
 l Comparing results from the older version of the software to the converted version of 

the results.

Different versions of Thermo-Calc can be installed at the same time on your 
computer and have project files opened alongside each other to facilitate such 
comparisons.

If you are having problems with opening an old project file, or are unable to 
access an installed version of the software that you know your organization has 
a license for, complete this Request Support form on our website to get help. 
Be sure to include all relevant details such as your organization number.

https://thermocalc.com/support/request-support/
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Calculation Types in Graphical Mode

A variety of Plot Types are available based on the Calculator and, in most cases, 
Calculation Type selected. Also see Graphical Mode vs Console Mode: 
Calculation Types.

AM Calculator

The AM Calculator is available with the Additive Manufacturing (AM) Module. It is used to 
predict the temperature distribution and melt pool geometry as a function of process 
parameters. There are these simulation types: Steady-state, Transient, and Transient with 
heat source from Steady-state. 

For Steady-state simulations, you can also choose to run different Calculation Types:

 l Single point: The standard Gaussian heat source model. 
 l Heat Source Calibration:  To calibrate a heat source based on the imported or 

entered experimental data instead of performing a single point calculation. All types 
of heat sources can be used. 

 l Batch: To include power and scan speed data, which is read from a file such as a 
spreadsheet.  You can optionally include experimental melt pool width and depth (if 
there is data), and compare this to the calculated results using a Parity plot on the 
Plot Renderer. Other plots are also available.

 l Grid: To evaluate two axis variables of power and scanning speeds in the specified 
range and number of steps.

Binary Calculator

The following calculation types are available for a Binary Calculator activity node:

 l Phase diagram: To calculate in a defined multicomponent heterogeneous system, 
from one or more initial equilibria. A phase diagram is usually mapped within a 
specific space that is constructed by two (or more) defined independent mapping 
axis-variables.

 l Gibbs energy curves: To calculate at a constant temperature over the whole 
composition range.
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 l Activity curves: To calculate at a constant temperature over the whole composition 
range.

 l Phase fractions: To calculate as a function of temperature at a constant composition.

Diffusion Calculator

Diffusion calculations are done with the Diffusion Calculator to have detailed simulation of 
diffusion controlled reactions in multicomponent systems. There are no calculation types 
you need to choose when setting up your simulation.

Equilibrium Calculator

The following calculation types are available for an Equilibrium Calculator activity node:

 l Single equilibrium (no axes): To calculate a single point. The results from this 
calculation are displayed in the Event Log.

 l One Axis: To vary a quantity on the X-axis.
 l Grid: Computes the equilibrium of each grid point in a two-dimensional grid.
 l Phase diagram: To calculate in a defined multicomponent heterogeneous system, 

from one or more initial equilibria. A phase diagram is usually mapped within a 
specific space that is constructed by two (or more) defined independent mapping 
axis-variables.

Material to Material Calculator

The following calculation types are available for a Material to Material Calculator activity 
node:

 l Single equilibrium (no axes): To calculate a single point. The results from this 
calculation are displayed in the   Visualizations window if a Table Renderer is used.

 l One Axis: To vary a quantity on the X-axis; the fraction of one of the materials or 
temperature.

 l Phase diagram: To calculate  a section in a multicomponent system between two 
materials, transitioning from one into the other. The phase diagram is  mapped within 
a specific space that is constructed by the two mapping axis-variables; the fraction of 
one of the materials and temperature.
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See Plot Types for Plot Renderer choices related to the One Axis  Calculation 
Type.

Precipitation Calculator

The following calculation types are available for a Precipitation Calculator activity node:

 l Isothermal: Precipitation simulation at constant temperature.
 l Non-isothermal: Precipitation simulation with user-defined temperature profile.
 l TTT Diagram: Time-Temperature-Transformation diagram calculation.
 l CCT Diagram: Continuous Cooling Transformation diagram calculation.

Process Metallurgy Calculator

The following calculation types are available for a Process Metallurgy Calculator activity 
node when doing an Equilibrium simulation.

 l Single: To calculate a single point. The results from this calculation can be displayed 
in the Visualizations window using a Table Renderer. 

 l One Axis: To vary a quantity on the X-axis.
 l Grid: Evaluates two axis variables of the selected quantities in the specified range 

and number of steps.
 l Uncertainty: Evaluates calculations where the values of the quantities are sampled 

from Gaussian distributions.  The Mean field is as defined under Condition Definitions 
for the respective quantity. The result is visualized as a histogram or normal 
probability plot by adding a Plot Render activity.

Property Model Calculator

The following calculation types are available for a Property Model Calculator activity node:

 l Single to calculate a single point. Any model can use this calculation type and no 
additional settings are required. The results from this calculation are displayed in the 
Event Log or if a Table Renderer is used, in the Visualizations window. 

 l One Axis: To  vary a quantity on the X-axis.
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 l Grid: Evaluates two axis variables of the selected quantities in the specified range 
and number of steps.

 l Min/Max: Evaluates the Property Model(s) for all variations of the selected 
quantities at the given limits. The Mean field is as defined under Condition 
Definitions for the respective quantity. The total minimum and maximum of the 
model(s) results are shown in the Event log.

 l Uncertainty: Evaluates the Property Model(s) where the values of the quantities are 
sampled from Gaussian distributions. The Mean field is as defined under Condition 
Definitions for the respective quantity. The result is visualized as a histogram or 
normal probability plot by adding a Plot Renderer activity.

 l Batch: Use this to  allow for high throughput calculations and read data from a file, 
such as a spreadsheet, rather than, for example, having a fixed grid or random 
values.  Results from these batch calculations can then be compared to experimental 
values (as long as this data is included), using a Cross plot on the Plot Renderer. 

Scheil Calculator

When using a Scheil Calculator activity node there are no calculation types you need to 
choose when setting up your simulation.

Ternary Calculator

The following calculation types are available for a Ternary Calculator activity node:

 l Isothermal section: To calculate the ternary system for the whole composition 
range.

 l Monovariant lines: To calculate the variation of the liquid compositions with 
temperature.

 l Liquidus projection: The projection liquid surface and the monovariant lines are 
calculated over the given temperature range.
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About the Uncertainty Calculations

The Uncertainty calculation in Thermo-Calc uses the values (the mean) entered for 
quantities under the Condition Definitions section as the starting point to estimate, within a 
certain probability, the true variation of the quantity. Uncertainty calculations are available 
with the Property Model Calculator and the Process Metallurgy Calculator.

An example of a Gaussian distribution is shown next. The example uses the Phase Transition 
Property Model Settings and an Uncertainty Calculation Type to describe how the sampling 
of data is performed. The example PM_G_01: Phase Transition predicts the transition 
temperature to the unwanted brittle Sigma phase and shows how the temperature is 
influenced by changes to a steel alloy’s composition.

Gaussian Distribution, the 3-Sigma Rule
 l The mean is at the peak of the curve (labeled μ). 
 l The standard deviation (σ) is a plus and minus range, ±1σ, ±2σ or ±3σ, of the variance 

from the mean.

Image by Dan Kernler: https://en.wikipedia.org/wiki/Normal_
distribution#/media/File:Empirical_Rule.PNG. 
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As long as the number of events (the sample size) is very large, then the Gaussian 
distribution function can be used to describe physical events. A Gaussian distribution is 
assumed to describe how each quantity varies in an uncertainty calculation, as shown next. 

Condition Definitions and Sampling Settings

In Thermo-Calc, the mean of the quantity’s distribution is defined in the Condition 
Definitions section. The Mean is then used in the Sampling of Data from Gaussian 
Distributions section  as the starting point for how much you want to deviate from this value.

The mean defined under Condition Definitions is used during the sampling.

The values entered in the Δ  Min/Max fields are the resulting width of the distribution 
corresponding to the 95% confidence interval (approximately μ ± 2σ) shown in Gaussian 
distribution, the 3-sigma rule.This confidence interval means that approximately 95% of the 
sampled values fall within these limits, as shown next.

Sampling Parameter Settings

The default value for truncating the distribution is set at  3 standard deviations in the 
Sampling Parameters section. This is also where you set the Total number of samples. The 
default is 200. In order to maintain a Gaussian distribution for the varied quantities, this 
number should not be too low.
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You can experiment by varying the conditions and the number of samples to see the 
distribution results smooth out as is to be expected based on the Central Limit Theorem, as 
shown in the histogram plot. You can also plot the results as a normal probability. 

Histogram Plot 

This series of histogram plots shows the uncertainty calculations sampling data from 
Gaussian distributions. On the Plot Renderer the variable is set to measure the Composition 
of Ni. It compares the Ni composition where the total sample size is increased. In the 
example, the initial sample size uses the default, 200, and then the sample size is increased 
to 300, 400, 600, 800, and 1000, showing  how the plot follows the Gauss distribution.
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Normal Probability Plot 

You can also plot the results as a Normal probability. Continuing with this example, for the 
Property Model Calculator the X Axis variable is plotted as Composition and the Y Axis 
variable is plotted as the Normal probability. 
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This is a normal probability plot example of the uncertainty calculations sampling data from 
Gaussian distributions. It compares the relaxed condition where the total sample size is 200. 
The sampled data (blue line) closely follows the ideal normal distribution (red line). 
Deviations are naturally larger at the tails (≈1%Ni and ≈2%Ni) since the number of samples 
are fewer there compared to the center of the distribution.
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Working with Batch Calculations

When defining a Batch calculation for a Property Model Calculator, you choose to load 
(import) a configuration data file that contains predefined data. The columns that can be 
included in the data file are: 

 l Element compositions and the associated unit
 l Temperature and the temperature unit
 l Experimental data and a key word
 l Parameters (as long as these are both available and selected for a Property Model)
 l An identifier (ID) for each row of data

Only these types of data are read / used in calculations. It is important that the 
data file contents are correctly entered in order for the calculation to perform 
smoothly. The software runs a validation of the data file prior to allowing you to 
perform a calculation. Warnings related to this validation display on the 
Property Model Calculator. You can also skip this data file validation for 
composition or parameter inconsistencies. See below for details.

The Batch Control settings, which are further described in this section, are found on the 
Property Model Calculator Configuration window. See Configuration Window Settings.

Batch calculations are also available with the Additive Manufacturing (AM) 
Module and described separately. 

Batch Controls

For the settings in this section, it is recommended you read the Data File Rules, 
Data File Requirements, and Skip Validation of Data File sections prior to 
importing the data file.
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In the Data file field, either enter a file path or click the load data file button ( ) to navigate 
to a data file such as an Excel spreadsheet (with *.xls or *.xlsx extensions) or a *.csv file. 
You can also use other programs (e.g. Google Sheets) to enter data and export to a CSV 
format that can be read by the software.

Click Open to import the data. In the Data file field you can see the file path to the selected 
file. The next time you click the load data file button ( ) the program remembers the last 
location from where the file is opened.

Choose the delimiter—Comma (,), Colon (:), Equals sign (=), Semicolon (;), or Tab—that 
matches the delimiter in the data file and click the Reload ( ) button.

The data is imported and displays on the Property Model Calculator: 

 l The data are used for the applicable fields that must match what already exists as a 
Property Model parameter (e.g. critical radius, grain size, etc.) as well as the 
composition, temperature, and units that you want to run the calculation for.  Also, if 
the dependent element composition is not included in the data file, the batch 
calculation then sets the dependent element to be the same as defined in the user 
interface.

 l The calculation runs once for every row of data included in the file. 

When the data file is imported into Thermo-Calc, there is also a Row column 
autogenerated by Thermo-Calc. 

Select the Set zero amount to value (in mole-/mass-fraction) to enter a small value for the 
mole/mass-fraction in cases where a Property Model has problems calculating zero amounts 
of elements.

Select the Skip validation of data file checkbox to allow a calculation to perform using the 
data file even when certain criteria are not met. 

When selected, the validation of the data file is skipped: 

 l If the Composition (elements) do not match the system composition entered on the 
GUI in the System Definer or Property Model Calculator. 

 l If one or more Parameters are not correctly entered, not selected for the specific 
Property Model, or are unavailable with the selected Property Model, then these are 
ignored in the calculation.
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If there are any data file validation error(s), a tooltip on the Perform button lists 
and describes these. 

Data File Rules

GENERAL RULES

 l No abbreviations are allowed. 

 l All header text must be in English, i.e. no translations into other languages will be 
read correctly by the data file.

 l For the settings on the Property Model Calculator (Composition unit, Composition, 
Temperature, and Temperature unit) when there is nothing specified in the data file, 
the default is taken from the GUI and used in the calculation. Also, if the dependent 
element composition is not included in the data file, the batch calculation then sets 
the dependent element to be the same as defined in the user interface.

PARAMETER, PARAMETER NAME, AND PARAMETER VALUE RULES

Only numeric parameters available on the Configuration tab for the selected 
Property Model can be included in the calculation. 

The column entries for the Parameter + <parameter name> plus the row entries for the 
<parameter value> must adhere to these rules. The validation checks for inconsistencies, 
which could be the result of any of the following criteria not being met.
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 l When including Parameters in the data file, these must be existing Property Model 
parameters and the applicable Property Model must be selected on the GUI.

 l The <parameter name> is case sensitive and must be entered exactly as you see on 
the GUI, no abbreviations are allowed. 

 l The <parameter value> must be  numeric or  it is not included in the calculation.

Figure 1: An example of the Yield Strength Property Model numeric parameters available for the 
Batch calculations. These are available on the Property Model Calculator Configuration tab after 
selecting Yield Strength under General Models. The parameter name must be entered in the data 
file exactly as you see on the GUI. No parameters from other calculators are accepted.

Data File Requirements

Only the columns described here are read / used in the calculation. It is 
important to enter the information exactly as described. It is recommended 
that the data file is cleaned up before importing / loading it and performing 
calculations. All header text must also be written in English, i.e. no translations 
into other languages will be read correctly by the data file.

In the table below, code font indicates something entered  into the data file (or 
it is an example) and any <text in italic with angle brackets> is a generic name 
for an entry. 
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Column Heading 
Description

Column Heading Requirements and 
Options Row Cell Requirements  and Options

Composition

Each element of the 
composition is in a 
separate heading column 
using the <element short 
name> e.g.  Fe, C, Mn, Si, 
etc.

Enter an <element short name>. It is not 
case sensitive.

For example: Fe.

It is not case sensitive, so alternatives in 
this example are fe or FE.

Valid  format and entries of the 
<composition value>:

 l A number for the composition 
e.g. 0.1, 8.7,  1.00E-05, etc.

 l Text entry Bal to define the 
balanced element. 

 l Empty cells are read as zero (0) 
amounts. 

Composition unit

Enter the text Composition unit. No 
abbreviations allowed but it is not case 
sensitive.

For example, it is acceptable to enter 
composition unit or Composition 
Unit, or COMPOSITION UNIT, etc.

Valid  format and entries of the 
<composition unit>:

 l mass_pct

 l mass_frac

 l mole_pct

 l mole_frac

Temperature

Enter the text Temperature.  No 
abbreviations allowed but it is not case 
sensitive.

For example, it is acceptable to enter 
temperature or Temperature, or 
TEMPERATURE.

Valid format and entries –

 l Any number e.g. 273.15

Temperature unit

Enter the text Temperature unit.   No 
abbreviations allowed but it is not case 
sensitive.

For example, it is acceptable to enter 
temperature unit or Temperature 
Unit, or TEMPERATURE UNIT, etc.

Valid format and entries –

 l C

 l F

 l K

Parameters with 
numerical values only. 
The heading column is 
defined with Param in 
front of a Property Model 
<parameter name>

Param + <parameter name>

For example:
Param Critical radius

The <parameter name> has 
requirements–

 l It is case sensitive based on 
the available and selected 
Property Model parameter

 l It must be an existing Property 
Model parameter and be 
included with any selected 
Property Model

Valid format and entries –

The <parameter value> must be  numeric 
or  it is not included in the calculation.

An example of an accepted Property 
Model parameter is for the Yield Strength 
model where Grain size and Critical radius 
are accepted (these have fields for 
numerical entries) but you cannot use 
Matrix or Precipitate as these are text 
choices from a drop down list.
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Column Heading 
Description

Column Heading Requirements and 
Options Row Cell Requirements  and Options

 l No abbreviations

Experimental value. The 
heading column is 
defined with Exp followed 
by any <keyword>.

Exp + <keyword> where the <keyword> 
is defined by the user.

For example: Exp Ms.The keyword is not 
case sensitive so alternatives are MS or 
ms.

Valid format and entries –

 l Each <experimental value> must 
be numeric

Identifier (i.e. an alloy 
name). The heading 
column is defined as Id

Enter the text Id. 

It is not case sensitive so alternatives 
are id or ID.

Valid format and entries –

 l An <identifier> can be any text 
or number defined by the user.

DATA FILE EXAMPLE AND COLUMN DEFINITIONS

This is an example of data entered into an Excel spreadsheet. When this is imported into Thermo-
Calc, an additional "Row" column is automatically added and is a way for you to locate any errors 
in the data file that are identified as needing correction or adjustment to allow the program to 
read the file.

 l A1 to A4 is the Identifier column and rows. The heading text is Id and then in the 
entries in rows A2 to A4 can be text or numbers, for example it might be an alloy 
name or another user-defined <identifier>.

When the data file is imported into Thermo-Calc, there is also a Row 
column autogenerated by Thermo-Calc. 

 l B1 to B4 is the Composition column and rows for the element Fe. In this example, 
Bal indicates that the balance of the composition will be calculated for this column 
after the <composition values> for C and Cr are entered.
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 l C1 to C4 and D1 to D4 are the Composition columns each for C and Cr with the 
specific <composition values>, e.g. 0.000928 for C and 0.0149 for Cr in row 2.

 l E1 to E4 and F1 to F4 are the Experimental Value columns and rows.  The header 
starts with Exp and then user-defined <keywords> are added, e.g. Ms C and Ms. Then 
specific <experimental values> are entered, e.g. 529.85 for Ms C and 803 for Ms in 
row 2.

 l G1 and H1 are the headings for the Composition unit and Temperature unit 
columns. No abbreviations allowed but it is NOT case sensitive. Then the rows G2 to 
G4 and H2 to H4 include an accepted text value e.g.  mole_frac for the composition 
unit and K for the temperature unit.

 l I1  is the Parameter heading where you need to enter Param followed by the 
parameter name Critical radius, which has numeric values entered in rows I2 to 
I4. The <parameter name> matches that on the GUI and is an available and selected 
Property Model parameter.

Skip Validation of Data File

Select the Skip validation of data file checkbox to allow a calculation to perform using the 
data file even when certain criteria are not met. 

When selected, the validation of the data file is skipped: 

 l If the Composition (elements) do not match the system composition entered on the 
GUI in the System Definer or Property Model Calculator. 

 l If one or more Parameters are not correctly entered, not selected for the specific 
Property Model, or are unavailable with the selected Property Model, then these are 
ignored in the calculation.

If there are any data file validation error(s), a tooltip on the Perform button lists 
and describes these. 
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Skipping Composition Validation

If the Composition (elements) do not match the system composition entered on the GUI in 
the System Definer or Property Model Calculator then the default system composition is 
used for any missing elements  after you select the Skip validation of data file checkbox. 

This can occur when there are more elements included in the data file but not entered on 
the GUI, and then these are excluded from the calculation. For example, you might have too 
many or too few elements included in the data file compared to the composition entered on 
the System Definer, which is then further viewed under Condition Definitions on the 
Property Model Calculator Configuration window. 

When configuring the System Definer, it is recommended you select the 
composition to match the composition in the data file. However, if this is not 
possible you can use this checkbox to override any differences of the 
composition included in the data file and use the GUI default.

Skipping Parameter Validation

If one or more Parameters are not correctly entered, not selected for the specific Property 
Model, or are unavailable with the selected Property Model, then these are ignored in the 
calculation after you select the Skip validation of data file checkbox. 

For example, if a data file is uploaded and you are unable to perform the calculation, it 
means that one of the following criteria are not met for the Param columns and related to 
the <parameter name>. 

 l The parameter name is misspelled (does not match) the one on the GUI
 l The parameter is not available with the selected Property Model.
 l The parameter is not available with any Property Model.

It is best practice to use a data file that only includes available Property Model 
parameters. However, if this is not possible then use this checkbox to override 
the validation. Alternatives to skipping this validation, include removing the 
prefix Param from the data file (or delete this column), and confirming that the 
parameter you want to calculate is available and selected for the Property 
Model.
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Plotting Experimental Data Against Simulation Results

You can plot experimental values loaded to the Property Model Calculator using the Cross 
plot Plot type available on the Plot Renderer. There are also additional options for this 
Calculation Type. See Plot Types for a list and also Plot Type: Cross Plot and Statistical.
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Getting Started Links and Templates

When you first open Thermo-Calc, the My Project Configuration  window has a variety of 
links and templates available to get you started.  From here, click any template button to add 
the relevant nodes to a Project tree. You can also right-click the My Project node and select 
a template from the Create New Activity → Use Template list.

 1. In the Project window, click the  My Project node.

 2. The templates (plus additional links under Getting Started) are available to click in 
the  My Project Configuration window. 

Getting Started Links Including the Quick Start Wizard

Even before you understand how to work with Thermo-Calc projects or use the available 
templates, there are some links of interest available under Getting Started.
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 l Click Getting Started to go to the Getting Started Guides on the website.
 l Click Video Tutorials to go to the Video Tutorials on the website.
 l Click Online Help to open the help locally in a browser (or press F1).
 l Click Example Files to open the Graphical Mode folder containing the installed 

example files. 

In addition to the links above, click Quick Start to open the template wizard, which helps 
you set up a project and run calculations in Graphical Mode. You can set up, calculate and 
visualize any of the following:

 l Single point equilibrium
 l One axis equilibrium
 l Phase diagram
 l Scheil solidification simulation

Creating a Project with the Quick Start Wizard

Equilibrium Templates

Under Equilibrium, click a template to create a project and add the applicable nodes to the 
Project window. 

 l Single Point: To calculate a single point equilibrium. The project consists of a System 
Definer, Equilibrium Calculator, and a Table Renderer.

 l One Axis: To calculate a one axis diagram. The project consists of a System Definer, 
Equilibrium Calculator, and a Plot Renderer.

 l Material to Material: To examine how materials transition into one another. The 
project consists of a System Definer, Material to Material Calculator, and a Plot 
Renderer.

 l Phase Diagram: To calculate a phase diagram. The project consists of a System 
Definer, Equilibrium Calculator, and a Plot Renderer.

https://thermocalc.com/support/getting-started-guides/
https://thermocalc.com/support/video-tutorials/
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 l Binary: To perform a binary calculation. The project consists of a Binary Calculator 
and a Plot Renderer.

 l Ternary: To perform a ternary calculation. The project consists of a System Definer, 
Ternary Calculator, and a Plot Renderer.

Non-Equilibrum Templates

Under Non-Equilibrium, click a template to create a project and add the applicable nodes to 
the Project window.

 l Scheil Solidification: To perform a Scheil calculation. The project consists of a System 
Definer, Scheil Calculator, and a Plot Renderer.

 l Homogenization: To perform a Scheil solidification calculation followed by kinetic 
homogenization simulation of segregated composition profile. The project consists of 
a System Definer, a Scheil Calculator, a Diffusion Calculator, and two Plot Renderers.

 l Diffusion: To calculate general diffusion simulations. The project consists of a System 
Definer, Diffusion Calculator, and a Plot Renderer.

 l Precipitation: To simulate the evolution of particle size distributions. The project 
consists of a System Definer, Precipitation Calculator and a Plot Renderer.

To run full calculations with the Homogenization, Diffusion and Precipitation 
templates require additional licenses although you can run these in demo mode 
with up to three (3) components. See  Available Graphical Mode Features and 
Available Options.
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Property Models

Under Property Models, click a template to create a project and add the applicable nodes to 
the Project window.

 l Property Models: To choose from a variety of Property Models available on a 
Property Model Calculator. The project consists of a System Definer, Property Model 
Calculator, Plot Renderer, and a Table Renderer.

 l Steel TTT: To use the TTT Diagram Property Model as part of the Steel Model Library 
and add all the activities for a Time-Temperature-Transformation (TTT) diagram 
calculation. The project consists of a System Definer, Property Model Calculator, and 
a Plot Renderer.

 l Steel CCT: To use the CCT Diagram Property Model as part of the Steel Model Library 
and add all the activities for a Continuous-Cooling-Transformation (CCT) diagram 
calculation. The project consists of a System Definer, Property Model Calculator, and 
a Plot Renderer. Also see Steel Library TTT Diagram Template and Steel Library CCT 
Diagram Template.

To run full calculations with the Steel TTT and Steel CCT templates (as part of 
the Steel Model Library) requires a valid maintenance license plus licenses for 
both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) 
databases. 

Applications
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Under Applications, click a template  to create a project and add the applicable nodes to the 
Project window.

 l Process Metallurgy: To allow for calculation  and efficient setup of advanced 
calculations involving slag, metal, and gas. Also see Process Metallurgy Template.

To run full calculations with the Process Metallurgy template requires 
both a valid Maintenance and Support Subscription (M&SS) and a 
license for the TCS Metal Oxide Solutions Database (TCOX8 or newer).  

 l Additive Manufacturing and With Material Library: These templates are to work 
with additive manufacturing. The Additive Manufacturing (AM) Module is used  to 
better understand the laser powder bed fusion (LPBF) process by predicting the 
temperature distribution and melt pool geometry as a function of process 
parameters.Also see Additive Manufacturing Templates.

To run full calculations with the Additive Manufacturing and With 
Material Library templates require  a license for the Additive 
Manufacturing (AM) Module.  

When you also have licenses either for the Diffusion Module (DICTRA) 
and/or the Precipitation Module (TC-PRISMA), for transient simulations 
you can additionally  include probe data from the AM Calculator in the 
set up of the thermal profile for diffusion and precipitation calculations, 
respectively. 
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Creating a Project with the Quick Start Wizard

To set up, perform and visualize a calculation using the Quick Start wizard:

 1. In the Configuration window click Quick Start. If you cannot see the Quick Start 
button, first click  My Project in the Project window.

 2. In the Select Project Type window click to select the type of calculation to perform. 
Single point equilibrium, One axis equilibrium, Phase diagram, or Scheil 
solidification simulation (a Classic Scheil simulation). Click Next.
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 3. In the Define Systems window, choose an available Database.
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 4. Click to select Elements checkboxes to include as system components. To add 
elements from an existing material file, click the Material file button to enter the file 

path to a material file or then click the Select Material File button  (to the right of 
the field) to navigate to a file on the computer.

 5. Click Next. The Select Conditions window has different options depending on the 
project type and the elements selected. 

In this example figure, using a Single Point Equilibrium, choose the Composition unit 
from the list and under Condition Definitions specify the values of the state variables 
in the system. 

For One axis equilibrium or Phase diagram projects, specify the Axis Definitions of 
the stepping or mapping operation. Choose minimum and maximum values for the 
variable(s) (select Linear – min no. of steps, Linear – max step size, or Logarithmic –
scale factors) and whether it is Normal or Separate phases. 

For a Scheil solidification simulation project, and where applicable, select Fast 
diffuser.
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After using this Quick Start Wizard to do a Classic Scheil calculation (or 
with fast diffuser components), a Scheil Calculator is added to the 
Project window. At this point you can review Scheil-Gulliver 
Solidification Calculations for details about all the options using the 
Scheil Calculator, i.e. back diffusion and solute trapping.

 6. Click Finish. Click to expand the Event Log window to see information about the 
progress of the calculation.

The diagram is plotted in a Plot Renderer tab in the Visualizations window. If you 
have calculated a single-point equilibrium, then a Table Renderer tab shows 
information about the equilibrium.
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 7. To save the project, click Save  on the main toolbar. To save a diagram or table, 
right-click the diagram or table and select Save As.

                               

Creating a Project from a Template

Use a Template to create all the activities for a certain type of calculation. 

Getting Started Links and Templates

 1. In the Project window, click the  My Project node.

 2. The templates (plus additional links under Getting Started) are available to click in 
the  My Project Configuration window. 
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When you click a template, an activity tree is added to the Project window. You can then 
configure and perform the activities or the project. 

For example, if under Equilibrium you click One Axis, a tree is added to the  My Project 
node with System Definer, Equilibrium Calculator, and Plot Renderer nodes.

You can also add templates by right-clicking the  My Project node and choosing an option 
from the Create New Activity → Use Template   menu.
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Steel Library TTT Diagram Template

The use of this Steel Model Library template requires a valid maintenance 
license plus licenses for both the TCFE (version 9 and higher) and MOBFE 
(version 4 and higher) databases.

Use a Steel TTT template to add all the activities for a Time-Temperature-Transformation 
(TTT) diagram calculation. The TTT Diagram Property Model is automatically selected with 
all settings by default on the Property Model Configuration window. This makes it easy to 
add the project to the tree and examine the progress of transformation as a function of time 
at a fixed temperature.

How to Add a Steel Library TTT Template to a Project

 1. In the Project window click the  My Project node to display the templates in the 
Configuration window.

 2. Under Property Models, click the top icon Steel TTT.
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A System Definer, Property Model Calculator (renamed to Steel Models) and a Plot 
Renderer (renamed to TTT) are added to the Project window. Also see Property 
Model Calculator and Plot Type: TTT Mode.

You can also add templates by right-clicking the  My Project node and choosing an option 
from the Create New Activity → Use Template   menu.

Steel Library CCT Diagram Template

The use of this Steel Model Library template requires a valid maintenance 
license plus licenses for both the TCFE (version 9 and higher) and MOBFE 
(version 4 and higher) databases.

Use a Steel CCT template to add all the activities for a Continuous-Cooling-Transformation 
(CCT) diagram calculation. The CCT Diagram Property Model is automatically selected on the 
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Property Model Calculator with all settings by default. This makes it easy to add the project 
to the tree and examine the progress of transformation as a function of changing 
temperature.

How to Add a Steel Library CCT Template to a Project

 1. In the Project window click the  My Project node to display the templates in the 
Configuration window.

 2. Under Property Models, click the bottom icon Steel CCT.

A System Definer, Property Model Calculator (renamed to Steel Models) and a Plot 
Renderer (renamed to CCT) are added to the Project window. Also see Property 
Model Calculator and Plot Type: CCT Mode.

You can also add templates by right-clicking the  My Project node and choosing an option 
from the Create New Activity → Use Template   menu.
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Process Metallurgy Template

Use a Process Metallurgy template to add the Process Metallurgy Calculator and a Plot 
Renderer to the Project window. The Process Metallurgy Calculator has several 
preconfigured settings making is easier to setup the different groups and materials needed 
to define a system for slag, metal and gas used in steelmaking.

Process Metallurgy Calculator

How to Add a Process Metallurgy Template to a Project

 1. In the Project window click the  My Project node to display the templates in the 
Configuration window. 

 2. Under Applications, click Process Metallurgy. 

A System Definer, Process Metallurgy Calculator,  and a Plot Renderer are added to 
the Project window.

You can also add templates by right-clicking the  My Project node and choosing an option 
from the Create New Activity → Use Template   menu.
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Defining and Using the Activity Nodes

For information about the AM Calculator, see Additive Manufacturing (AM) 
Module

For information about the Process Metallurgy Calculator, see The Process 
Metallurgy Module.

In this section:

System Definer 85

Equilibrium Calculator 104

Material to Material Calculator 117

Binary Calculator 124

Ternary Calculator 127

Scheil-Gulliver Solidification Calculations 130

Property Model Calculator 159

Diffusion Calculator 176

Precipitation Calculator 214

Plot Renderer 254

Table Renderer 262

Experimental File Reader 270
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System Definer

In a System Definer activity, you select the database to use to retrieve thermodynamic data 
and define which elements the system has as components. You can also select the species to 
include as well as change the reference temperature and pressure for your components. 

You can add the System Definer directly (right-click  My Project and select it from the 
Create New Activity menu) or use a variety of the available templates to automatically add 
the node.

Many  examples use the System Definer (see Graphical Mode Examples Listed by 
Product). For details about the templates, see Getting Started Links and 
Templates  and Creating a Project from a Template.

Once you have added a System Definer, the Configuration window  has these settings tabs:

 l Elements
 l Species
 l Phases and Phase Constitution
 l Components
 l Data Sources
 l Description
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Define the System

This topic describes how to define a system, specifically how to select one or more 
databases and define the elements in the system with the System Definer activity node. 

 1. Right-click  My Project and from the menu select Create New Activity → System 
Definer. For many templates a System Definer is also added to the Project tree.

 2. In the Project window, click the System Definer activity node.

 3. In the Configuration window, choose Databases from the list or  a database Package. 

About the Database Files

OPTIONS:
 l From the Databases list, select <User database> to define your own. 
 l You can choose to add one or more databases by clicking the Add a database 

 button. 
 l From the Package list, choose a predefined database package to add multiple 

databases at a time. Depending on your license, there are predefined database 
packages available to select.

 4. Select the Elements tab to choose the elements in the Periodic Table or use the 
Alphabetic List to choose elements for the system.

 5. As required click the tabs to make edits: Species, Phases and Phase Constitution, 
and Components. The Data Sources and Description tabs provide information based 
on the database.

Configuration Window Settings

 6. Click Perform to start the System Definer activity immediately and retrieve data 
about the system. Click the Event Log window to watch the progress of the job. 

Configuration Window Settings

The System Definer Configuration window has many settings available, which are briefly 
described below.

This uses PM_G_02: Coarsening and Interfacial Energy to show these features.
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CHOOSE DATABASE(S) OR A DATABASE PACKAGE

At the top of the Configuration window you can choose to add one or more Databases by 
clicking the Add a database  button and choosing it from the list of available databases. 
You can also choose a predefined or custom database Package from the  list. Depending on 
your license, there are predefined databases and packages available to select. After adding a 
database, click Remove this database  button as required for your simulation. 
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If you have chosen a database package and then remove or change a database, 
a message displays Selected databases and selected package may differ. This 
means that the original package you selected, which added preset databases, 
does not match the databases you are using for the project. For information 
about how to clear the message, see Global Settings: System Definer.

Global Settings: System Definer

There are several settings tabs available for the System Definer activity.

The following example uses the FEDEMO and MFEDEMO databases and Graphical Mode 
example PM_G_02, which you can open from the Help →  Examples Files menu or from 
the top My Project Configuration window.

ELEMENTS

On the Elements tab, and based on the databases or database package selected, you can 
select and review elements using a Periodic Table or Alphabetic List format. Unavailable 
elements, which are based on the selected database, are greyed out.

ELEMENTS: ADVANCED DATABASE OPTIONS

Also on the Elements tab, there three special elements used in the databases.  

On the Periodic Table view, there are three buttons. For the Alphabetic List, the buttons are 
available each as a checkbox. In both cases you toggle ON  (click to select the button or 
checkbox) or toggle OFF (click to deselect the button or checkbox, in other words, you are 
rejecting the phase). 
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From this tab, you are choosing to include or reject the whole system of phases. 
Click the Phase and Phase Constituent tab if you want to select specific phases 
to reject. 

This is an advanced feature. The details of these options are described for  
Console Mode and generally in the Database Manager User Guide.  For 
example, see ELEMENT and POURBAIX_DIAGRAM Module. For the purposes of 
Graphical Mode, the use of the buttons or checkboxes either include or reject 
(exclude) the vacancies (VA) or charged species (I-). It is recommended to keep 
the default after selecting the database(s). In general, these three special 
elements should not be rejected from the System Definer (Graphical Mode) or 
GES (Console Mode).

There is a training module related to this feature available via the Thermo-Calc 
online Learning Hub. Subscriptions also include access to live monthly office 
hours, where you can ask our experts about any of the content on the Learning 
Hub or your own design simulation challenges.

 l VA. This allows a vacancy as a species. Toggled ON to include all vacancies or OFF to 
reject all vacancies in the phase constitution. VA itself is electrical neutral. It is usually 
a constituent of a phase. The element VA does not take any degree of freedom in an 
equilibrium calculation.

 l I-. This represents ELECTRON_GAS with -1 net charge. It is implemented in the 
database which includes ionic-modeled phases, i.e. with net-charged constituents. 
The charged species can be formed by combining /- (for negative charge) or /+ (for 
positive charge) with other ordinary elements, e.g. O-2 from O1/-2 or FE+2 from 
FE1/+2. The element /- does not take any degree of freedom in an equilibrium 
calculation. You can combine the elements VA and /- to model charged vacancies, 
e.g. VA-2 results from VA1/-2. To reject all charged species in the system, click to 
deselect (i.e. turn off). This is relevant to such databases as TCS Metal Oxide 
Solutions Database (TCOX), TCS Aqueous Solution Database (TCAQ), and the 

https://learn.thermocalc.com/courses/introduction-tothermo-calc/
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OXDEMO database.

For most databases, there is an extensive list of all the phase models 
included with the technical information.

 l The element ZE represents UNIT_CHARGE with +1 net charge. It is implemented and 
required only in the database that contains the AQUEOUS solution phase. ZE should 
never be rejected in GES. ZE itself is the only constituent of the phase REF_ELECTRODE, 
i.e. the reference electrode for ZE potential. This phase (REF_ELECTRODE) should 
always be suspended in the POLY module. Combining ZE with other ordinary 
elements forms aqueous species with net charge, e.g. the species H+1 results from 
H1ZE1 while OH-1 from H1O1ZE-1. The element ZE, like other ordinary elements, 
takes one degree of freedom in POLY in an equilibrium calculation. This is relevant to 
such databases as TCS Aqueous Solution Database (TCAQ) and when working with 
the Pourbaix module, which is only available with Console Mode and thus not 
available in Graphical Mode directly.

PERIODIC TABLE

In this example, using the demonstration databases FEDEMO and MFEDEMO, there are only 
a select number of elements to choose from when it is a DEMO database. These are selected 
for this example (Cr, Mn, Fe, Ni, C). The FEDEMO database is a subset of the main steel 
database TCS Steel and Fe-alloys Database (TCFE) and MFEDEMO is a subset of TCS 
Steels/Fe-Alloys Mobility Database (MOBFE).
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ALPHABETIC LIST

Click Alphabetic List to view a list of available and used elements. 

MATERIAL COMPOSITION

After selecting the elements and in the Periodic Table view, under Material, you can enter a 
Material name and define the material composition Amount in Mass percent, Mole 
percent, Mass fraction, or Mole fraction.
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How To Load or Save a Material

Click Load material to open a material file. The default folder opens to the Materials folder 
included with your installation.

About the Material Files and Examples, Manuals, and Materials Folders
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You can click Save material as to save the material you defined, for example Ferritic. Add 
your own folders as needed.

Global Settings: System Definer

For the System Definer, and if you load a material file and then change the 
composition, a message displays The composition has changed. This means that 
the original values/composition do not match the values you are using for the 
project. The message is cleared by either reloading the material file or editing 
the composition field to the original value.

SPECIES

On the Species tab for each database you can select and edit the Species and view the 
Stoichiometry for the selected database species. 
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At the bottom of the window, click Add new species and enter a New species name in the 
field.
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PHASES AND PHASE CONSTITUTION

At the top of the Phases and Phase Constitution tab for each database you can review and 
edit the Status (Entered or Dormant) for the selected Phases.

Select the Check/uncheck all checkbox to toggle between the options. 
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From this tab, you can also choose specific phases to include or exclude the VA 
and I- database species instead of doing it for the whole system as per 
Elements: Advanced Database Options. 

To review the Phase constitution for a specific phase, click it in the Phase list (for example 
BCC_A2) and its details are displayed at the bottom of the window for the database 
selected. Click the relevant database tab to see its constitution by phase. Click Edit then click 
an element to select or reject a constituent. The last remaining constituent on a sublattice 
cannot be rejected.

You can click the Show constitution or Hide constitution buttons found 
between the Phase table and Constitution details. Use this to toggle showing or 
hiding the  details as needed. This is particularly useful when there is a long list 
and you are working on smaller displays where it may be difficult to scroll 
easily. 
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COMPONENTS

The Components tab is where you can review and edit the Component, Reference phase, 
Reference temperature, and Reference pressure. Click to toggle the SER (Stable Element 
Reference) checkbox on and off. Then choose a Reference phase from the list and edit 
accordingly. Choose a unit for the Reference temperature  (Kelvin, Celsius, or Fahrenheit) 
and Reference pressure (Pascal, Atmospheres, or Bar).

DATA SOURCES

Data source references are shown after performing the activity. Click Perform or Perform 
Tree at the bottom of the window when your system is set up. 
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DESCRIPTION

The Description tab displays a description of the selected database(s). In this example, 
FEDEMO, or click MFDEMO to view that information. 

About the Material Files

When you are working with the System Definer or Material to Material Calculator in 
Graphical Mode you can open the default  Materials folder included with your installation. 
The files are in .xml format and the data contained are from some common alloys. You can 
also save and create your own materials files or copy the xml files to the Materials folder.

Examples, Manuals, and Materials Folders

My Materials

This is where you can add your own material files to be able to load it to the System Definer 
or Material to Material Calculator. When you are in the System Definer Configuration 
window, you define your material then click Save material as. You can save the profile to 
this folder or create a folder with a new name. 

Aluminum
 l UNS_A95005
 l UNS_A96053

Cast Iron
 l UNS_F10007
 l UNS_F33101



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 99 of 763

Nickel Alloys
 l UNS_N06600
 l UNS_N6600
 l UNS_N06625
 l UNS_N06690
 l UNS_N07001
 l UNS_N07718
 l UNS_N08800
 l UNS_N08825

Solder Alloys
 l ASTM_25A
 l ASTM_96TS
 l UNS_L50134
 l UNS_L54321

Steel

Austenitic Stainless Steel

 l ASTM_304_(UNS_S30400)
 l ASTM_304L_(UNS_S30403)
 l ASTM_304LN_(UNS_S30453)
 l ASTM_316_(UNS_S31600)
 l ASTM_316L_(UNS_S31603)
 l ASTM_316LN_(UNS_S31653)
 l ASTM_317L_(UNS_S31703)
 l UNS_J92710
 l UNS_S30908
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Duplex Stainless Steel

 l UNS_S31803_A
 l UNS_S32750_A
 l UNS_S32750_B

High Speed Steel

 l ASTM_M10_A5

High Temperature Steel

 l UNS_S31008

HSLA Steel

 l UNS_K12000

Low Carbon Steel

 l UNS_H61180

Maraging Steel

 l UNS_K92810

Martensitic Stainless Steel

 l ASTM_420
 l UNS_J82090
 l UNS_J91639
 l UNS_S44004

Tool Steel

 l UNS_T30106
 l UNS_T30109
 l UNS_T51620
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Training Steel

 l Ferritic
 l M7_Steel

Titanium Alloys
 l UNS_R54520
 l UNS_R56260
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Creating a Database Package

 1. From the main menu select Tools →  Options .

 2. Click the Activities tab and click System definition.

 3. Under Database Packages, click the Add a database package  button.

 4. Replace the default text <Package #1> with a name for the package, for example My 
database package.

 5. Select a database from the Choose database list, for example, FEDEMO Iron Demo 
Database.

 6. Click the Add a database  button and from the Choose database list, select 
another database.

 7. Click OK. The software needs to relaunch for the Database Package to be available to 
choose as the default for new System Definer activities.

The package is available for new System Definer nodes defined after 
adding the package.

Clearing a Database Package Message and Global Settings: System Definer
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Clearing a Database Package Message

Sometimes when working on the System Definer Configuration window, you may add or 
delete Databases. If you originally added a Database Package, the addition or removal of a 
database means that the original package you selected does not now match the databases 
you are using. To clear the message Selected databases and selected package may differ and 
reset the databases you need to either:

 l Change the newly added database back to the one that matches the database package, 
or

 l Choose another package from the Package list, then select the package you want.

For example, from the Package list you select Demo: Steels and Fe-alloys.

This adds the FEDEMO and MFEDEMO databases.

If you add or remove Databases, in this example MFEDEMO is removed, then this does not 
match the Package and the message displays:

To clear the message, click the Add a database  button and from the Choose database list, 
select the database that belongs with the package, in this example, MFEDEMO. The message 
is cleared.

You can also choose another package from the list, which changes the databases, and then 
re-select the original package to reset the message.

Creating a Database Package and Global Settings: System Definer
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Equilibrium Calculator

An Equilibrium Calculator allows you to set the conditions for, and perform, a calculation. 
You can add the calculator to the System Definer directly (right-click and select it from the 
Create New Successor menu) or use a variety of the available templates.

Once you have added an Equilibrium Calculator, the Configuration window  has these 
settings tabs. An Equilibrium Calculator that is the successor of another Equilibrium 
Calculator inherits all the settings of the predecessor.

 l Conditions: Set the conditions for your calculation that define the stepping or 
mapping axis variables. Click the Switch to Simplified Mode and Switch to Advanced 
Mode buttons to toggle between those settings.  

 l Functions: Define your own quantities and functions, which you then can calculate 
and plot. 

 l Options: Modify numerical settings that determine how equilibria are calculated, as 
well as how stepping and mapping calculations are performed. 

The Options tab is where you can locally define specific Equilibrium Calculator 
settings. These  settings can also be applied globally. To open the Options 
window: From the main menu select Tools →  Options and click the 
Activities tab. Then click Calculation. 

There are these templates available under Equilibrium that use an Equilibrium 
Calculator: Single Point, One Axis, and Phase Diagram. Choose one of these to 
quickly set up a simulation. The Quick Start wizard is also an option. See 
Getting Started Links and Templates.

Define the Equilibrium Calculator

 1. Add an Equilibrium Calculator node to the System Definer. If you used the Single 
Point, One Axis, or Phase Diagram templates (on the  My Projects Configuration 
window under Equilibrium), click the Equilibrium Calculator node to display the 
Configuration settings window. 
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 2. In the Configuration window, enter the settings described in Conditions Tab Settings. 
For the Options and Functions tab settings, see 

 l Options Tab Settings 
 l Calculating and Plotting Functions

 3. Once you have finished defining the Equilibrium Calculator, you also choose settings 
on the Plot Renderer. 

Calculating with a Fixed Phase 

Examples

There are several examples that use an Equilibrium Calculator. As a start, see T_01: 
Calculating a Single-Point Equilibrium.

For an example of how serially coupled Equilibrium Calculators can be used, see T_06: 
Serially Coupled Equilibrium Calculators.

Conditions Tab Settings

Conditions and axis variables for the Equilibrium Calculator are set in the Conditions tab on 
the Configuration window. The tab can be viewed in two modes: Simplified (the default) or 
Advanced (see About Advanced Mode). The conditions to set depend on the type of 
calculation. 
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Examples
 l T_01: Calculating a Single-Point Equilibrium 
 l T_02: Stepping in Temperature in the Fe-C System 
 l T_05: Stable and the Metastable Fe-C Phase Diagrams.

Options Tab Settings

Depending on the calculation type selected, there are also a variety of Plot 
Types to choose from.

The following outlines what you can set on the Conditions tab in simplified mode. 

Click Switch to Advanced Mode for more options.

COMPOSITION UNIT

Select the Composition unit: Mass percent, Mole percent, Mass fraction, or Mole fraction.

CONDITION DEFINITIONS

Specify the values (and units) of the state variables: Temperature, Pressure, and System size 
or any other available lists under Condition Definitions.

CALCULATION TYPE

Click to select a Calculation Type: 

 l Single equilibrium (no axes): To calculate a single point. The results from this 
calculation are displayed in the Event Log.

 l One Axis: To vary a quantity on the X-axis.
 l Grid: Computes the equilibrium of each grid point in a two-dimensional grid.
 l Phase diagram: To calculate in a defined multicomponent heterogeneous system, 

from one or more initial equilibria. A phase diagram is usually mapped within a 
specific space that is constructed by two (or more) defined independent mapping 
axis-variables.
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For Single equilibrium, no additional settings are required. Add a Table 
Renderer to perform the calculation and view the details in the Visualizations 
window.

When you use the Equilibrium Property Model Settings with the Property 
Model Calculator, it is the same calculation result as when you are using an 
Equilibrium Calculator with the Single equilibrium calculation type. 

AXIS DEFINITIONS

 l One Axis: Define the axis variable using these fields and menus: Quantity, Min, Max, 
Step division, Type, and Step Method. 

 l Grid: Define the two axis variables using these fields and menus: Quantity, Min, 
Max, and Number of steps. 

 l Phase diagram: Define the two axis variables using these fields and menus: Quantity, 
Min, Max, Step division, and Type.

If the  Calculator already has a Plot Renderer as a successor and you change the 
stepping/mapping quantities, then the quantities represented on the X- and Y-
axis are automatically updated in the Plot Renderer.

Depending on the calculation type selected, there are also a variety of Plot 
Types to choose from.

STEP DIVISION AND TYPE (ONE AXIS AND PHASE DIAGRAM)

Enter a Step division and select a Type: Linear - min no. of steps, Linear - max step size, or 
Logarithmic - scale factor.

 l For Linear - min no. of steps, the Step division value specifies a minimum number of 
steps that is calculated between the minimum and maximum value during the 
stepping/mapping operation. 
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 l For Linear - max step size, the Step division sets the maximum size of each step. For 
Logarithmic - scale factor, Step division specifies the scale factor of a logarithmic 
function that distributes the steps from the initial equilibrium to the minimum and 
maximum values defined.

STEP METHOD (ONE AXIS)

From the Step Method list, choose  Normal or Separate phases.

 l Normal allows a stepping calculation with the chosen independently-varying 
equilibrium condition (axis-variable). Only the step axis value is changed between 
each step.

 l Separate phases calculates how the Gibbs energy for a number of phases varies for 
different compositions. This is particularly useful to calculate Gibbs energies for 
complex phases with miscibility gaps and for an ordered phase that is never 
disordered (e.g. SIGMA-phase, G-phase, MU-phase, etc.). 

NUMBER OF STEPS (GRID)

Set a fixed Number of steps. The number of steps along with the minimum and maximum 
values for the axes define a grid. For each grid point an equilibrium is calculated.

About Advanced Mode

Click Switch to Advanced Mode to add and remove conditions as well as set additional axis 
definitions. However, the number and types of conditions set must still conform to the 
Gibbs’ phase rule. The Number of missing conditions is field, at the top of the tab shows 
how many conditions that you have left to set. If the number is negative, then that number 
of conditions need to be removed. 

List of Advanced Mode Condition Definitions
 l Activity of component
 l Activity referred to a phase
 l Amount of component
 l Amount of component in a phase
 l Amount of phase
 l Chemical potential of a component
 l Chemical potential referred to a phase
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 l Composition
 l Enthalpy
 l Entropy
 l Fix phase
 l Gibbs energy
 l Helmholtz energy
 l Internal energy
 l In(activity of component)
 l In(activity referred to a phase)
 l Pressure
 l Site fraction
 l System size
 l Temperature
 l User-defined
 l Volume
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Calculating and Plotting Functions

The Functions tab allows you to define your own functions that can be plotted in a Plot 
Renderer. 

For an example of how you can use functions that you define, see T_07: User-
Defined Functions.

 1. Add an Equilibrium Calculator node and click it in the Project window. 

 2. In the Configuration window click the Functions tab.

 3. Under Quantity Definitions, define Q1. Click the add  button to Add a new 
quantity. Then from the lists, choose the variable for each quantity to define. The 
quantities are called Q1, Q2, Q3 and so on. In this example, the quantity Q1 is 
defined as the Amount of phase, with No normalization, LIQUID in Mole units. 

 4. Under Function Definitions, click the add  button to add a new function. In the left 
field edit the default name of each function and enter the function itself in the right 
field after the equal sign. In this example, the quantity defined as Q1 is renamed to 
fraction_solid, which gives as its output the fraction of solid phase (1-Q1). 

You can also use Console Mode syntax when entering the function. For 
example, the function above can be entered as 1-NP(LIQUID). See 
Parameters, Functions, and Variables for details. 

 5. To plot the defined function, right-click Equilibrium Calculator and choose Create 
New Successor → Plot Renderer  . 

 6. Click the Plot Renderer node. In the tab for the Equilibrium Calculator that contains 
the function, set an Axis variable to Function, then from the menu select the defined 
function. In this example the Y-axis is set to plot the value of the function fraction_
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solid.

When run, the Plot Renderer plots the value of the function.

Options Tab Settings

These settings are for the Equilibrium Calculator and are located on the Configuration 
window  → Options tab. 
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You can change these settings locally for a specific Calculator or globally for 
some defaults in the Options window (a different location than the tab). 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode tab and the Calculation node in the tree.

Single Equilibrium and Grid

Under Single Equilibrium and Grid, there are these Calculation Type setting options.

GLOBAL MINIMIZATION

The Global minimization checkbox is selected by default to ensure that the most stable 
minimum under the specified conditions is computed.

MAX GRID POINTS

For the Max grid points, the default is Coarse (2000 grid points), or choose Medium (20,000 
grid points), Fine (200,000 grid points), or Custom to set your own number of grid points.

APPROXIMATE DRIVING FORCE FOR METASTABLE PHASES

The Approximate driving force for metastable phases checkbox is selected by default. Click 
to clear the checkbox to change the default as required and based on the options described 
below.

This setting involves the convergence of metastable phases and affects their driving forces. It 
can also have an effect on when an equilibrium is considered successful.

The default is to allow an equilibrium with metastable phases that have not converged, as 
long as the stable phases have converged. This is efficient but often causes approximate 
values of the driving forces for the metastable phases.
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If you change the default, it enforces metastable phases to converge. This gives accurate 
driving forces for metastable phases as well as stable phases. It can however take a slightly 
longer time, and if metastable phases do not converge it causes the equilibrium calculation 
to fail.

FORCE POSITIVE DEFINITE PHASE HESSIAN

The Force positive definite phase Hessian checkbox is selected by default and this setting 
determines how to reach the minimum of an equilibrium state.

ADVANCED_OPTIONS

CONTROL STEPSIZE

The Control stepsize checkbox is selected by default and this setting determines how to 
reach the minimum of an equilibrium state.

ADVANCED_OPTIONS

MAX NO OF ITERATIONS

Enter or choose a value for the Max no. of iterations. By default, the program tries 500 
iterations before it gives up. As some models give computation times of more than 1 CPU 
second/iteration, this number is also used to check the CPU time and the calculation stops if 
500 CPU seconds/iterations are used.

REQUIRED ACCURACY

The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program 
requires that the relative difference in each variable must be lower than this value before it 
has converged. A larger value normally means fewer iterations but less accurate solutions. 
The value should be at least one order of magnitude larger than the machine precision.

SMALLEST FRACTION

The default Smallest fraction (or Smallest fraction in a phase for Property Models) is 1.0E-
12. This is the value assigned to constituents that are unstable. It is normally only in the gas 
phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL 
phase with one sublattice site (such as the GAS mixture phase in many databases) for which 
the default value is always as 1E-30.
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In Console Mode, the default of 1E-30 for IDEAL phases is true unless you are 
using the  command SET_NUMERICAL_LIMITS to reset an even-lower value (e.g. 
1E-45, that is naturally enforced to all the phases in the system.

One Axis

Under One Axis, there are these Calculation Type setting options.

GLOBAL MINIMIZATION

The Global minimization checkbox is selected by default to ensure that the most stable 
minimum under the specified conditions is computed.

ADVANCED_OPTIONS

GLOBAL TEST INTERVAL

The default Every 10th eq is the recommended Global test interval i.e. every tenth step and 
at each phase change during calculations.  Or choose Always or Custom.

If you choose Custom, the integer number determines how often the global minimization 
should be used during step and mapping. Any other positive integer number, n, suggests it 
performs a global minimization test at every n-th step during calculations. 

Phase Diagram

Under Phase diagram, there are these Calculation Type setting options.

GLOBAL MINIMIZATION

The Global minimization checkbox is selected by default to ensure that the most stable 
minimum under the specified conditions is computed.

GLOBAL TEST INTERVAL

The default At node points  is the recommended Global test interval and is used only at 
node points during the calculations.
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 l If you choose Every 10th eq, this is every tenth step and at each phase change during 
calculations.

 l If you choose Custom, the integer number determines how often the global 
minimization should be used during step and mapping. Any other positive integer 
number, n, suggests it performs a global minimization test at every n-th step during 
calculations. 

GENERATE STARTING POINTS AUTOMATICALLY

The Generate starting points automatically checkbox is selected by default. 

USE INSIDE MESHING POINTS

Click the Use inside meshing points checkbox as required. The initial mesh consists of initial 
equilibrium points added only along the edge/border of the diagram defined by the axis-
variables. If you select the checkbox, then the initial equilibrium points added are also added 
to the inside edge.

NO OF MESHES ALONG AN AXIS

The default No of meshes along an axis is 3 , which represents how many intervals of initial 
equilibrium points are added along an edge in the diagram. For example, if set to 2 (two), 
initial equilibrium points are added at the beginning, center, and end of each axis-variable 
forming 2 intervals.

Calculating with a Fixed Phase 

This describes how to use the advanced mode to set a phase to be fixed at a certain amount. 
This allows you to, for example, find out at what temperature a material starts to melt. If 
you set the phase to be fixed to liquid phase at zero amount, and do not define the 
temperature state variable, then you can calculate at what temperature the material enters 
a state where the liquid phase is no longer zero (that is, when it starts to melt). 

For a fixed phase equilibrium calculation, it is recommended to serially couple 
the Equilibrium Calculators. This is where one Equilibrium Calculator activity is 
the successor to another Equilibrium Calculator activity that performs an 
ordinary equilibrium calculation, and then, for the condition you are interested 
in, you make a rough estimate of the value. This gives the fixed phase 
calculation better starting values.
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 1. Right-click a node that can add an Equilibrium Calculator to your project. 

 2. In the Project window, click the Equilibrium Calculator activity node.

 3. In the Configuration window, click Switch to Advanced Mode. 

If the Default calculation mode is globally set to Advanced then by 
default the Configuration window is already in advanced mode. 

Global Settings

 4. Under Condition Definitions, click the Add quantity  button.

 5. Select Fix phase from the first menu.

 6. Select the phase that you want to fix in the second menu, and set the amount of that 
phase you want to fix the phase to. For example, if you want to know when your 
material starts to melt, set the phase to LIQUID and the value to 0.0:

Above the Condition Definitions, the Number of missing conditions is field is 
probably -1. This means that you must remove one condition. 

 7. To remove a condition, either click the Remove  button, or click to clear the 
checkbox. For example, if you want to know at what temperature your material 
starts to melt, then you cannot have a fixed temperature, in which case the 
temperature condition is not selected:

The Number of missing conditions is field displays 0. When you have set all your 
conditions, you can perform the Equilibrium Calculator (now or later).
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Material to Material Calculator

A Material to Material Calculator allows you to set the conditions for, and perform, a 
calculation to examine how materials transition from one into the other. Typical applications 
are for graded materials, non-similar material joints (without requiring a diffusion 
calculation), or a reaction of two materials, e.g. influence of volcanic ash on a turbine 
component in an engine.

For example, you can look at the transitions of phase compositions (c1, c2, c3 in the diagram) 
for two materials, A and B and then calculate an equilibrium, one axis (similar to a property 
diagram), or phase diagram to examine, for example, what phases are forming at the 
interfaces or to see what kinds of reactions there are at specific points in the transition.

Composition of the elements is evolving versus the fraction of the second material.

You can add the calculator to the System Definer directly (right-click and select it from the 
Create New Successor menu).

There is also a Material to Material template available under Equilibrium that 
you can use to quickly set up a simulation. See Getting Started Links and 
Templates.

Once you have added a Material to Material Calculator, the Configuration window has these 
settings tabs. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 118 of 763

 l Conditions: Set the conditions for your calculation that define the stepping or 
mapping axis variables. 

 l Functions: Define your own quantities and functions, which you then can calculate 
and plot.

 l Options: Modify numerical settings that determine how equilibria are calculated, as 
well as how stepping and mapping calculations are performed.

Read more on our website about the Material to Material Calculator.  If you are 
in Thermo-Calc, press F1 to search the help.

Define the Material to Material Calculator

 1. Add a Material to Material Calculator node to the System Definer. If you used the 
Material to Material template (on the  My Projects Configuration window under 
Equilibrium), click the Material to Material Calculator node to display the 
Configuration settings window.

 2. In the Configuration window, enter the settings described in Material to Material 
Calculator Conditions Tab Settings.

For the Options and Functions tabs, the settings are the same as the 
Equilibrium Calculator. See Options Tab Settings and Calculating and 
Plotting Functions.

 3. Once you have finished defining the Material to Material Calculator, you also choose 
settings on the Plot Renderer.

Example

T_14: Fe-Cr-Ni Transition Comparison Using the Material to Material Calculator

Material to Material Calculator Conditions Tab Settings

Conditions and axis variables for the Material to Material Calculator are set in the 
Conditions tab on the Configuration window. The conditions to set depend on the type of 
calculation. 

https://thermocalc.com/products/thermo-calc/material-to-material-calculator
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Example

For an example, see T_14: Fe-Cr-Ni Transition Comparison Using the Material to Material 
Calculator.

The Material to Material template (on the  My Projects Configuration window under 
Equilibrium) creates a project to perform calculations to examine how materials transition 
from one into the other. The project consists of a System Definer, Material to Material 
Calculator, and a Plot Renderer.

Functions: This is the same as the Equilibrium Calculator. See Calculating and 
Plotting Functions

Options: This is the same as the Equilibrium Calculator. See Options Tab Settings

The following outlines what you can set on the Conditions tab. 

COMPOSITION UNIT

Select the Composition unit: Mass percent, Mole percent, Mass fraction, or Mole fraction.

CONDITION DEFINITIONS

Under Condition Definitions:

 l For both the First material and Second material, define the values (and units) of the 
state variables Temperature and Pressure.

 l Enter a Fraction of second material. 
 l For a Single equilibrium calculation this is used as condition for the 

calculation.
 l For a One Axis calculation this is used as the start value for the calculation. 
 l For a One Axis or Phase diagram calculation, and if the Fraction of second 

material is chosen as the Axis Definition>Quantity, then it is stepping 
between the Min and Max.

 l For both materials, select the Dependent component.
 l Select the Activity conditions checkbox to define the Activity of component for one 

or more components. By default this is not selected. Click the Add quantity   and 
Remove quantity   buttons to add and remove conditions.

 l The reference state is defined on the System Definer. 
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CONDITION DEFINITIONS > DEFINE THE FIRST AND SECOND MATERIALS

For each First material and Second material component there are individual settings to 
define as follows. 

Enter a unique Material name for each. This name is used on the plots and in the quantity 
definitions so it is good to use as concise a name as possible that clearly identifies each 
material. For example, Martensitic Steel for the First material and Alloy 800 for the 
Second material.

For each Composition field, enter numeric values for each material. 

 l Click Save material as after defining a composition to add it for reuse in other 
projects and calculations.

 l Click Load material to add the composition of a predefined material from an xml file. 
Also see How To Load or Save a Material

If  the user-defined material file includes one or more components not defined 
on the System Definer, then you are prompted to make a decision:

Click Open anyway to continue to load the material file even with the 
undefined component(s). However, this means the undefined component is 
excluded at first from calculations until it is further defined on the System 
Definer.  Once the material is defined then it is automatically included the next 
time calculations are run. Otherwise, click Cancel to stop the action and either 
edit the material file or manually define the component(s) in the System 
Definer. 
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How To Load or Save a Material

Click Load material to open a material file. The default folder opens to the Materials folder 
included with your installation.

About the Material Files and Examples, Manuals, and Materials Folders

You can click Save material as to save the material you defined, for example Ferritic. Add 
your own folders as needed.

Global Settings: System Definer

For the System Definer, and if you load a material file and then change the 
composition, a message displays The composition has changed. This means that 
the original values/composition do not match the values you are using for the 
project. The message is cleared by either reloading the material file or editing 
the composition field to the original value.

CALCULATION TYPE

Click to select a Calculation Type: 
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 l Single equilibrium (no axes): To calculate a single point. The results from this 
calculation are displayed in the   Visualizations window if a Table Renderer is used.

 l One Axis: To vary a quantity on the X-axis; the fraction of one of the materials or 
temperature.

 l Phase diagram: To calculate  a section in a multicomponent system between two 
materials, transitioning from one into the other. The phase diagram is  mapped within 
a specific space that is constructed by the two mapping axis-variables; the fraction of 
one of the materials and temperature.

AXIS DEFINITIONS

 l One Axis: Define the axis variable using these fields and menus: Quantity, Min, Max, 
Step division, Type, and Step Method. 

 l Phase diagram: Define the two axis variables using these fields and menus: Quantity, 
Min, Max, Step division, and Type. 

Also see additional setting details for Step division, Type, and Step Method.

If the  Calculator already has a Plot Renderer as a successor and you change the 
stepping/mapping quantities, then the quantities represented on the X- and Y-
axis are automatically updated in the Plot Renderer.

STEP DIVISION AND TYPE (ONE AXIS AND PHASE DIAGRAM)

Enter a Step division and select a Type: Linear - min no. of steps, Linear - max step size, or 
Logarithmic - scale factor.

 l For Linear - min no. of steps, the Step division value specifies a minimum number of 
steps that is calculated between the minimum and maximum value during the 
stepping/mapping operation. 

 l For Linear - max step size, the Step division sets the maximum size of each step. For 
Logarithmic - scale factor, Step division specifies the scale factor of a logarithmic 
function that distributes the steps from the initial equilibrium to the minimum and 
maximum values defined.

STEP METHOD (ONE AXIS)

From the Step Method list, choose  Normal or Separate phases.
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 l Normal allows a stepping calculation with the chosen independently-varying 
equilibrium condition (axis-variable).

 l Separate phases calculates how the Gibbs energy for a number of phases varies for 
different compositions. This is particularly useful to calculate Gibbs energies for 
complex phases with miscibility gaps and for an ordered phase that is never 
disordered (e.g. SIGMA-phase, G-phase, MU-phase, etc.). 
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Binary Calculator

A Binary Calculator can be used for some calculations involving two components. You can 
think of this activity as a combination of a System Definer and an Equilibrium Calculator, but 
designed to simplify setting up and performing calculations on binary systems.

The Binary Calculator relies on some specifications that are not supported by all databases. 
You need a specially designed database for the Binary Calculator such as the TCBIN 
database.

Template

There is a Binary template available on the  My Projects Configuration window under 
Equilibrium that you can use to quickly set up a simulation. See Getting Started Links and 
Templates.

Configuration Settings

See Configuration Window Settings.

Example

For an example see T_03: Fe-C Phase Diagrams. 

Configuration Window Settings

The Binary Calculator Configuration settings window and the associated tabs are similar to 
what you see on a System Definer. The database TCBIN is added by default when you use 
the Binary template (on the  My Projects Configuration window under Equilibrium), but 
you can choose an installed and licensed database from the list.  

The various versions of the TCFE (Thermo-Calc Steels and Fe-Alloys) databases 
are not compatible with the Binary Calculator. 
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ELEMENTS

On the Elements tab, and based on the database selected, select and review elements from 
the periodic table. Unavailable elements, which are based on the selected database, are 
greyed out.

PHASES AND PHASE CONSTITUTION

At the top of the  Phases and Phase Constitution tab, and based on the selected database, 
you can review the Status for the selected Phases. Select the Check/uncheck all checkbox to 
toggle between the options.

To review the Phase constitution for a specific phase, click it in the Phase list (for example 
BCC_A2) and its details are displayed below the Phases list. Click Edit then click an element 
to select or reject a constituent. The last remaining constituent on a sublattice cannot be 
rejected.
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DATA SOURCES

Data sources are not available until the activity is performed. Click Perform Tree at the 
bottom of the window to display available data sources.

DESCRIPTION

The Description tab displays a description of the selected database. 

CALCULATION TYPE

Click to choose a Calculation Type.

 l Phase diagram: To calculate in a defined multicomponent heterogeneous system, 
from one or more initial equilibria. A phase diagram is usually mapped within a 
specific space that is constructed by two (or more) defined independent mapping 
axis-variables.

 l Gibbs energy curves: To calculate at a constant temperature over the whole 
composition range.

 l Activity curves: To calculate at a constant temperature over the whole composition 
range.

 l Phase fractions: To calculate as a function of temperature at a constant composition.

Then:

 l For Gibbs energy curves and Activity curves, select a unit from the Temperature list: 
Kelvin, Celsius, or Fahrenheit and enter a value in the field.

 l For Phase fractions, select and enter the Mole fraction component and enter a value 
in the field.

For the Plot Renderer, there is an option to use the Table View  button to 
convert plots to table data for all calculation types and calculators. See Plot 
Renderer: Convert a Plot to a Table and Export the Data.
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Ternary Calculator

A Ternary Calculator is used for some calculations involving three components. You can 
think of this activity as a combination of a System Definer and an Equilibrium Calculator, but 
designed to simplify setting up and performing calculations on ternary systems. 

Template

There is a Ternary template available under Equilibrium that you can use to quickly set up a 
simulation. See Getting Started Links and Templates.

Configuration Settings

See Configuration Window Settings.

Example

For an example, see T_04: Fe-Cr-C Ternary Phase Diagram  at 1000 K.

Configuration Window Settings

Below lists the available settings that must be configured before performing the calculation 
and the image shows the Configuration window for a Ternary Calculator activity.
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DATABASES

Select a database that contains specifications dedicated to the Ternary Calculator. 

ELEMENTS

On the Elements tab, and based on the database selected, select and review elements from 
the periodic table. Unavailable elements, which are based on the selected database, are 
greyed out.

PHASES AND PHASE CONSTITUTION

At the top of the  Phases and Phase Constitution tab, and based on the selected database, 
you can review the Status for the selected Phases. Select the Check/uncheck all checkbox to 
toggle between the options.

To review the Phase constitution for a specific phase, click it in the Phase list (for example 
BCC_A2) and its details are displayed below the Phases list. Click Edit then click an element 
to select or reject a constituent. The last remaining constituent on a sublattice cannot be 
rejected.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 129 of 763

DATA SOURCES

Data sources are not available until the activity is performed. Click Perform Tree at the 
bottom of the window to display available data sources.

DESCRIPTION

The Description tab displays a description of the selected database. 

CALCULATION TYPE

Click to choose a Calculation Type.

 l Isothermal section: To calculate the ternary system for the whole composition 
range.

 l Monovariant lines: To calculate the variation of the liquid compositions with 
temperature.

 l Liquidus projection: The projection liquid surface and the monovariant lines are 
calculated over the given temperature range.

Then for Isothermal section and Liquidus projection, select a unit from the Temperature 
list: Kelvin, Celsius, or Fahrenheit and enter a value in the field.

For the Plot Renderer, there is an option to use the Table View  button to 
convert plots to table data for all calculation types and calculators. See Plot 
Renderer: Convert a Plot to a Table and Export the Data.
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Scheil-Gulliver Solidification Calculations

In Graphical Mode, you use the Scheil Calculator activity node to simulate the 
various models available in Thermo-Calc or with the Add-on Modules or 
additional databases.

Read more about Scheil Solidification Simulations on our website, including 
how to select the right model for your simulation. If you are in Thermo-Calc, 
press F1 to search the help to learn about using Scheil.

Thermo-Calc is often used to perform equilibrium calculations, but some non-equilibrium 
transformations or partial-equilibrium transformations can also be simulated.

A well-known example of a non-equilibrium calculation is the Scheil-Gulliver solidification 
simulation. In Thermo-Calc, the available Scheil-Gulliver solidification simulations are classic 
Scheil, Scheil with back diffusion in the primary phase, or Scheil with solute trapping. There 
are also configuration options available with fast diffusers for the classic and back diffusion 
models.

Classic Scheil Simulation

This is a Scheil simulation based on the well-known Scheil-Gulliver model. If this model is 
used without "fast diffusers" it is Classic Scheil simulation with the following assumptions:

 l Diffusion in the liquid phase is assumed to be very fast, that is, infinitely fast.
 l Diffusion in the solid phases is so slow that it can be ignored, that is, diffusion is 

assumed to be zero.
 l The liquid/solid interface is in thermodynamic equilibrium.

In this Classic Scheil simulation the temperature is decreased step-by-step. When the 
temperature drops below the liquidus temperature the equilibrium amount and 
composition of solid and liquid phase is calculated. The solid phase is removed from the 
system and only the amount and composition of the liquid phase is used for the next 
calculation step at a lower temperature. Again, the equilibrium amount and composition of 
solid and liquid phase is calculated and again the solid phase is removed from the system for 
the next step. This procedure is repeated until the last liquid disappears.

https://thermocalc.com/products/thermo-calc/scheil-solidification-simulations/
https://thermocalc.com/blog/tips-and-tricks-selecting-the-right-model-for-your-scheil-solidification-calculation/
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This calculation procedure is equivalent to assuming that there is no diffusion in the solid 
phase and infinitely fast diffusion of all elements in the liquid phase. It has been shown to be 
a good approximation of the solidification of most alloys such as Ni-superalloys, Cu alloys, Al 
alloys, Mg alloys, and others. However, in materials with interstitial elements, such as 
carbon, ignoring diffusion in the solid causes discrepancies with experimental results. 
Interstitial elements have much faster diffusion rates. The assumption of no diffusion in the 
solid phase during solidification is thus not correct at most industrial or lab-scale 
solidification rates.

For this reason, a variant of the Scheil simulation was developed and implemented in 
Thermo-Calc, where one or more elements can be defined as fast diffusers. See Other 
Options: Fast Diffusers and Scheil Simulations.

Scheil Simulation with Back Diffusion in Primary Phase

The Scheil simulation with back diffusion in primary phase kinetic model quantitatively takes 
into account the real back diffusion of all elements in the primary solid phase (typically the 
FCC or BCC phase). This model requires the use of both a thermodynamic and mobility 
database. The calculation also requires the cooling rate to be specified; a fast cooling rate 
allows for less time for back diffusion and the simulation result is similar to the classic Scheil-
Gulliver solidification simulation. A very slow cooling rate allows for almost complete back 
diffusion, the solidification simulation is then close to an equilibrium calculation. It also 
requires that the size of the solidification domain is specified. In most cases this domain size 
corresponds to the secondary arm spacing, as this is where typically the liquid is trapped 
during solidification.

The secondary arm spacing also depends on the cooling rate. For this reason, a 
simple empirical relation between cooling rate and secondary arm spacing is 
predefined in Thermo-Calc.

For the Scheil simulation with back diffusion in primary phase model the following 
assumptions are made.

 l Diffusion of all elements in the liquid phase is infinitely fast.
 l Diffusion of all elements in the primary solid phase are quantitatively calculated 

using mobility data, a cooling rate and a domain size (typically this is the secondary 
arm spacing).

 l The liquid/solid interface is in thermodynamic equilibrium.

Also see Other Options: Fast Diffusers and Scheil Simulations.
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Scheil with Solute Trapping

The Scheil with solute trapping model simulates deviation from local equilibrium for the 
primary phase. It is useful for high solidification speeds, such as those seen in additive 
manufacturing applications.

For equilibrium- and classical Scheil-type solidification simulations thermodynamic 
equilibrium is established at the solid-liquid interface. This means that solutes are 
partitioned between the solid and liquid phases according to solidus and liquidus lines of the 
phase diagram. The assumption of thermodynamic equilibrium at the solid-liquid interface 
however, is invalid for very fast solidification rates, as encountered for example during 
additive manufacturing. The faster the solidification rate, the less the partitioning at the 
interface, which can be perceived as that solutes in the liquid are trapped in the advancing 
solid phase, hence the term solute trapping.

The Scheil with solute trapping model calculates the solute partitioning between liquid and 
primary solid that deviates from thermodynamic equilibrium due to solidification speed. 

The following assumptions are made:

 l Only one primary solid phase forms dendrite, NOT necessarily the first solid phase.
 l Solute trapping in primary solid phase only. Other solid phases have equilibrium 

compositions following Scheil model.
 l Dynamic liquidus for primary solid phases is dependent on solute trapping and 

solidification speed.
 l Amounts of solid phases are dependent on solute trapping and solidification.

More theory details are in About Scheil with Solute Trapping.

Other Options: Fast Diffusers and Scheil Simulations

If a Classic Scheil or Scheil simulation with back diffusion in primary phase model is selected 
plus one or more Fast diffuser checkboxes selected, then Thermo-Calc takes into account 
the concept of the fast diffuser. Typically, C is defined as a fast diffuser, but also other 
elements such as N, O, or others can also be defined.
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Fast diffuser does not quite define this since diffusion is not actually simulated. 
It is simply assumed that the “fast diffusers” distribute throughout the solid and 
liquid phase according to thermodynamic equilibrium. This corresponds to 
infinitely fast diffusion for the selected elements.

For a Classic Scheil model with the compositions defined with Fast diffuser the following 
assumptions are made.

 l Diffusion of all elements in the liquid phase is infinitely fast.
 l Diffusion of all elements in the solid phases, except the ones defined as “fast 

diffusers”, is zero.
 l Diffusion of the elements defined as “fast diffusers” is infinitely fast in the solid 

phase.
 l The liquid/solid interface is in thermodynamic equilibrium.

For a Scheil simulation with back diffusion in primary phase model with the compositions 
defined with Fast diffuser the following assumptions are made.

 l Diffusion of all elements in the liquid phase is infinitely fast.
 l Diffusion of all elements in the primary solid phase are quantitatively calculated 

using mobility data, a cooling rate and a domain size (typically this is the secondary 
arm spacing).

 l Diffusion of the elements defined as “fast diffusers” is infinitely fast in the solid 
phase.

 l The liquid/solid interface is in thermodynamic equilibrium.

The Classic Scheil simulation and Classic Scheil simulation with fast diffuser models can be 
considered thermodynamic models. There are clear limitations as a certain amount of back 
diffusion always takes place in the solid phase at real solidification.

You can also use the more sophisticated Scheil simulation with back diffusion in primary 
phase kinetic model. Adding the fast diffuser option to this can be useful, for example for 
interstitials like C in steels where these then equilibrate in all phases and not just the 
primary phase.

Homogenization, Segregation Profiles, and the Diffusion Module

Scheil calculations can be used in diffusion simulations with the Diffusion 
Module (DICTRA). 
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Homogenization is a process were you want to get rid of the composition segregation from 
solidification with a homogenization heat treatment. This composition segregation can be 
simulated with Scheil. Then with the Diffusion Module (DICTRA), you input the secondary 
dendrite arm spacing to get the right diffusion distances.  With composition profile from file 
the idea is that you should be able to input for example a measured composition profile 
(from EDS/WDS, micro-probe etc). This could also be a segregation profile but also 
composition profiles over a weld, substrate/coating, diffusion couple, and so forth.

Summary

The available Scheil-Gulliver solidification simulations are classic Scheil, Scheil with back 
diffusion in the primary phase, or Scheil with solute trapping. There are also configuration 
options available with fast diffusers for the classic and back diffusion models. 

There is also connectivity to the Diffusion Module (DICTRA) and homogenization 
where you collect data from a Scheil solidification calculation, which is then 
used as part of the kinetic homogenization simulation of segregated 
composition profiles. 

Scheil in Graphical Mode vs Console Mode

The Scheil with back diffusion  feature is only available for systems with 
diffusion data, i.e. this model requires the use of a mobility database.

In Thermo-Calc, the Scheil calculation allows the calculation of:

 l The solidification range of an alloy.
 l Depression of the solidus temperature due to segregation.
 l Composition of the last liquid to disappear in segregation pockets.
 l Phases formed on final solidification in segregation pockets.
 l The composition gradient in the primary solid phase(s) (segregation profile).
 l Solute trapping to simulate deviation from local equilibrium for the primary phase
 l Kinetic homogenization simulation of segregated composition profile (diffusion 

calculations)
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Scheil in Graphical Mode vs Console Mode

Type of 
Calculation Console Mode Graphical Mode

Classic Scheil Use the START_WIZARD command to answer 
prompts

Scheil Calculator > click the Classic 
Scheil button on the Configuration 
window.

On the My Project Configuration 
window under Getting Started, click 
Quick Start and select Scheil 
solidification simulation.

Scheil with back 
diffusion in the 
primary phase

USE_BACK DIFFUSION command (turn on) then 
use the START_WIZARD command to answer 
prompts

Scheil Calculator > click the Scheil with 
back diffusion in the primary phase 
button on the Configuration window 
then enter the settings as needed. 
A mobility database is required.

Scheil with solute 
trapping

SOLUTE_TRAPPING command (turn on) then use 
the START_WIZARD command to answer prompts

Scheil Calculator > click the Scheil with 
solute trapping button on the 
Configuration window then enter the 
settings as needed.

Fast diffusers and 
Classic Scheil

Use the START_WIZARD command to answer the 
promptFast diffusing componentswhere you 
enter the elements that diffuse fast in solid 
phases and can assume to be in equilibrium in 
the whole phase. E.g. C in a steel.

Scheil Calculator > click the Classic 
Scheil button plus one or more of the 
Fast diffuser checkboxes next to the 
composition(s) on the Configuration 
window then enter the settings as 
needed.

Fast diffusers and 
Scheil with back 
diffusion in the 
primary phase

USE_BACK DIFFUSION command (turn on)  then 
use the START_WIZARD command to answer the 
prompt Fast diffusing componentswhere you 
enter the elements that diffuse fast in solid 
phases and can assume to be in equilibrium in 
the whole phase. E.g. C in a steel.

Scheil Calculator > click the Scheil with 
back diffusion in the primary phase 
button plus one or more of the Fast 
diffuser checkboxes next to the 
composition(s) on the Configuration 
window then enter the settings as 
needed. A mobility database is 
required.

Homogenization

Use the EVALUATE_SEGREGATION_PROFILE 
command before START_WIZARD to generate the 
segregation profile to file. In DICTRA_MONITOR 
use INPUT_SCHEIL_PROFILE for use of segregated 
profile in simulation. An additional license to the 
Diffusion Module (DICTRA) is needed to work 
with more than three components. 

Use the Homogenization template 
under Non-Equilibrium to 
automatically set up the project tree 
with the defaults needed to work with 
this. An additional license to the 
Diffusion Module (DICTRA) is needed 
to work with more than three 
components. 
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About Scheil with Solute Trapping

The Scheil with solute trapping model simulates deviation from local equilibrium for the 
primary phase. It is useful for high solidification speeds, such as those seen in additive 
manufacturing applications.

For equilibrium- and classical Scheil-type solidification simulations thermodynamic 
equilibrium is established at the solid-liquid interface. This means that solutes are 
partitioned between the solid and liquid phases according to solidus and liquidus lines of the 
phase diagram. The assumption of thermodynamic equilibrium at the solid-liquid interface 
however, is invalid for very fast solidification rates, as encountered for example during 
additive manufacturing. The faster the solidification rate, the less the partitioning at the 
interface, which can be perceived as that solutes in the liquid are trapped in the advancing 
solid phase, hence the term solute trapping.

The Scheil with solute trapping model calculates the solute partitioning between liquid and 
primary solid that deviates from thermodynamic equilibrium due to solidification speed. 

The following assumptions are made:

 l Only one primary solid phase forms dendrite, NOT necessarily the first solid phase.
 l Solute trapping in primary solid phase only. Other solid phases have equilibrium 

compositions following Scheil model.
 l Dynamic liquidus for primary solid phases is dependent on solute trapping and 

solidification speed.
 l Amounts of solid phases are dependent on solute trapping and solidification.

The model is based on Aziz [1982Azi; 1988Azi] and Hillert [1999Hil], and extends to 
multicomponent systems. The motion of liquid/solid interface is regarded as two concurrent 
processes, trans-interface diffusion (solute transport across the interface leading to solute 
partitioning) and migration (liquid to solid transformation without changing composition).

Aziz and Hillert used slightly different formulations to describe the trans-interface diffusion. 
Aziz [1982Azi; 1988Azi] formulated the expression in terms of chemical reaction theory, 
describing the diffusion of the   th solute element (the dependent element being labeled as 

  in a  -component system) with respect to chemical potential gradient and interface 
velocity   as:

[Eq. 1]         

Where  and  are compositions (mole fractions) of primary solid and liquid at the 
interface, respectively.  is the diffusion velocity defined as:
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[Eq. 2]         

Where  is the trans-interface diffusivity and  is the interface thickness. In the software,  
is treated as a constant of m. 

In Eq. 1  is an activation term for diffusion:

[Eq. 3]          

Where  is the diffusion potential difference:

[Eq. 4]         

Where 
§
 and  are chemical potentials of  th element in the primary solid and liquid at 

the interface. 

Hillert [1999Hil], on the other hand, formulated the expression based on diffusion theory as:

[Eq. 5]         

Where:

[Eq. 6]         

For migration process, the formulation relates the free energy change, or driving force that 
is opposite to free energy change, to the interface velocity. The overall free energy change 
(termed as driving energy), including both trans-interface diffusion and migration processes, 
is defined as:

[Eq. 7]         

The free energy change for migration process (termed as migration energy) is:

[Eq. 8]         

The interface velocity is then related to the free energy change as:

[Eq. 9]         

Where: 
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 l  can be either  or  defined in Eq. 7 and Eq. 8. 
 l  is the maximum velocity limit when the free energy change becomes infinitely 

negative. 

Additionally, the mass conservation within the interface is assumed:

[Eq. 10]         

Where  is the far-field liquid composition. 

Eq. 1 (for Aziz model) or Eq. 5 (for Hillert model), together with Eq. 9 and Eq. 10 are then 
used to calculate the solute partitioning at the interface between primary solid and liquid for 
multicomponent systems. Likewise, if replacing  with the initial alloying compositions, Eq. 
1 (Eq. 5) and Eq. 9 are used to calculate the dynamic liquidus of the primary solid phase.

Solute trapping also reduces the volume fraction of other solid precipitates. The reduction 
factor is estimated by employing the effect of the solute trapping on the heat of fusion, 
which can be manifested by the liquid + primary solid phase boundaries in the phase 
diagrams by [1998Hil]:

[Eq. 11]         

Where all values are determined at phase boundaries.  is the second partial derivative of 
Gibbs free energy of liquid phase with respect to mole fraction. The left side of Eq. 11 is the 
enthalpy change when one (1) mole of primary solid with composition  is melted into a 
reservoir of liquid. Since we are interested in a ratio, the term that needs to be considered 
is:

[Eq. 12]         

The reduction factor is then obtained by comparing solute trapping with equilibrium values:

[Eq. 13]         

Scheil Calculator Configuration Settings

The Graphical Mode settings are described in Configuration Window Settings.

T_13: Scheil Solidification with Solute Trapping
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On the Configuration window, these are the relevant settings related to solute trapping: 

 l Trans-interface diffusivity ( ): Smaller value leads to larger solute trapping effect. 

Be cautious that  may result in complete solute trapping and 
possibly numerical errors.

 l Maximum velocity for infinite driving force ( ): Smaller values lead to a larger 
solute trapping effect.

 l Choose the solute trapping Model (Aziz or Hillert): Hillert model usually leads to a 
larger solute trapping effect, though Aziz model is recommended for overall 
numerical performance including calculating the amount of non-primary solid 
phases.

 l Interface driving force: Driving energy  or  Migration energy . Using 
migration energy option leads to larger solute trapping effect, while using driving 
energy option is numerically more stable. It is recommended to using driving energy 
option and adjusting other parameters (e.g., trans-interface diffusivity) for desired 
solute trapping effect.
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Scheil Calculator

In Graphical Mode, you use the Scheil Calculator to set up the various Scheil solidification 
simulations outlined in more detail in Scheil-Gulliver Solidification Calculations. 

The Scheil Calculator is also used in combination with the specialized Add-on 
Modules such as the Diffusion Module (DICTRA) and Additive Manufacturing 
(AM) Module. 
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The available Scheil-Gulliver solidification simulations are classic Scheil, Scheil with back 
diffusion in the primary phase, or Scheil with solute trapping. There are also configuration 
options available with fast diffusers for the classic and back diffusion models. 

There is also connectivity to the Diffusion Module (DICTRA) and homogenization 
where you collect data from a Scheil solidification calculation, which is then 
used as part of the kinetic homogenization simulation of segregated 
composition profiles. 

Scheil in Graphical Mode vs Console Mode

The Scheil with back diffusion  feature is only available for systems with 
diffusion data, i.e. this model requires the use of a mobility database.

In Thermo-Calc, the Scheil calculation allows the calculation of:

 l The solidification range of an alloy.
 l Depression of the solidus temperature due to segregation.
 l Composition of the last liquid to disappear in segregation pockets.
 l Phases formed on final solidification in segregation pockets.
 l The composition gradient in the primary solid phase(s) (segregation profile).
 l Solute trapping to simulate deviation from local equilibrium for the primary phase
 l Kinetic homogenization simulation of segregated composition profile (diffusion 

calculations)

There are several options to get started with a Scheil simulation using the Scheil Calculator.

 l On the  My Project window under Getting Started, use the Quick Start → Scheil 
Solidification Simulation option to set up a Classic Scheil simulation. This adds a tree 
of nodes where you can then choose to simulate using the other options on the 
Scheil Calculator. See Creating a Project with the Quick Start Wizard. 

 l Use the Scheil Solidification template under Non-Equilibrium to add a project tree 
consisting of  System Definer, Scheil Calculator, and Plot Renderer nodes. See 
Getting Started Links and Templates.
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 l Use the Homogenization template under Non-Equilibrium to add a project tree 
consisting of  System Definer, Scheil Calculator, Diffusion Calculator, and two Plot 
Renderer nodes. See Getting Started Links and Templates.

When working with the Homogenization template, this also includes a 
Diffusion Calculator, which may require additional licenses to run with 
more than three components. Information, such as the Scheil 
segregation profiles available with the Diffusion Calculator, is described 
with that content.

 l Build your own tree by right-clicking and adding nodes from  My Project. Then go 
to Configuration Window Settings to enter settings directly.

 l Open an example and use this as a template.

 l When you are working with the Additive Manufacturing (AM) Module, a Scheil 
Calculator is also included with one of the Additive Manufacturing Templates or can 
be added as a predecessor to the AM Calculator, where it is used to generate the 
materials property data required for these simulations. 

By default, a Plot Renderer successor to a Scheil Calculator has the plot axes 
defined as Mole fraction of solid (X-axis) and Temperature Celsius (Y-axis). 
When these default axes are used and the setting Include one axis equilibrium 
calculation is enabled (see Advanced Options), the results of solidification 
under equilibrium conditions are automatically plotted in the same diagram as 
the Scheil calculations.

Define the Scheil Calculator

 1. Add a Scheil Calculator node to the System Definer. If you used the Scheil 
Solidification or Homogenization templates on the  My Projects Configuration 
window under Non-Equilibrium (or opened an example), click the node to display the 
Configuration settings window. 

 2. Enter the settings described in Configuration Window Settings. The Configuration tab 
as all the main settings and the permutations related to the types of Scheil 
simulations available such as back diffusion and solute trapping.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 142 of 763

When working with the Homogenization template, this also includes a 
Diffusion Calculator, which may require additional licenses to run with 
more than three components. Information, such as the Scheil 
segregation profiles available with the Diffusion Calculator, is described 
with that content.

 3. As needed you can also change default settings from the Advanced Options tab (see 
Advanced Options) 

 4. Once you have finished defining the Scheil Calculator, you also choose settings and 
variables on the Plot Renderer. For a list of available variables see Scheil Calculator 
Available Plot Variables. 

Examples

For examples using the Scheil Calculator, see:

 l T_08: Scheil and Equilibrium Solidification
 l T_10: Scheil Solidification with Back Diffusion
 l T_13: Scheil Solidification with Solute Trapping

There are also Console Mode, TC-Python, and Diffusion Module (DICTRA) examples 
described elsewhere in the content. 

Configuration Window Settings

An example of the main Configuration window of a  Scheil Calculator activity is shown 
below using the T_10: Scheil Solidification with Back Diffusion example.

Scheil-Gulliver Solidification Calculations is a general overview of the Scheil 
options. For more details about the solute trapping related settings, see the 
theory in About Scheil with Solute Trapping.
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An example of the Scheil Calculator Configuration window with the back diffusion option selected. 
There are different settings available and described below based on the calculation type selected.

There are additional settings found on the Advanced Options tab and based on 
the type of Scheil calculation. See Advanced Options.

CALCULATE FROM

Use the Calculate from setting to choose from where the calculation should start. With this 
setting it is possible to obtain properties of the gas and/or liquid phase before the 
solidification starts. 

Some of the temperature definitions related to these choices are:

 l Liquidus, the temperature where solidification starts.
 l Gas / Liquid, the temperature above which the liquid phase is no longer stable.
 l Liquid / Gas, the temperature below which the gas phase is no longer stable.

Click a button to choose Liquidus, Gas, or Start temperature. 
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Depending on the choice for this setting (Liquidus, Gas, or Start temperature), 
one or more of the following temperature values is calculated and collected in 
the Event Log at the end of the calculation: Liquidus, Gas / Liquid, or Liquid / 
Gas. 

By default, Liquidus is selected. The results are calculated from the start of the solidification.

Select Gas (after a gas phase is selected on the System Definer) to perform single 
equilibrium calculations from the Gas / Liquid temperature.

 l The equilibrium calculations are performed at 5 Kelvin (K) intervals in the two-phase 
region between the Gas/ Liquid temperature and the Liquid / Gas temperature. 

 l In the fully liquid region below the Liquid / Gas temperature single equilibrium 
calculations are performed at 50 K intervals until the Liquidus temperature is 
reached. After that the Scheil solidification calculation proceeds as usual.

Select Start temperature if you want to obtain properties of the liquid phase (and gas phase 
if selected) before the solidification starts. 

 l Ordinarily the start temperature is only used as a start point in the search of the 
liquidus temperature, as the Scheil calculation starts from the Liquidus temperature.

 l For this choice, single equilibrium calculations are performed at specific intervals 
from the temperature entered in the start temperature field, down to the Liquidus 
temperature, and after that the Scheil solidification calculation proceeds as usual. 

 l The equilibrium calculations are performed at 50 Kelvin (K) intervals in the fully liquid 
region and at 5 K intervals in a possible two-phase (Liquid / Gas) region.

CALCULATE TO

Use the Calculate to setting to choose from where the calculation should end, End of Scheil 
or Temperature below solidus, where a frozen structure is assumed below solidus. 

 l End of Scheil stops the calculation when the Scheil calculation is finished. 

 l Temperature below solidus calculates the properties in the solid state, for the  phase 
compositions and fractions at the end of the Scheil calculation. The default Final 
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temperature is room temperature. Click Show advanced options to adjust the 
Temperature below solidus settings: Change the Final temperature and/or define the 
No. of points. 

 l See  Advanced Options. 

START TEMPERATURE

Enter a Start temperature that is higher than the liquidus temperature of the alloy, in other 
words, the temperature at which the alloy is completely melted.

TEMPERATURE STEP DURING SCHEIL

Enter a Temperature step during Scheil. The temperature step is given in the same unit as 
Start temperature. Decreasing the temperature step increases the accuracy, but the default 
value is usually adequate. 

TEMPERATURE UNIT

Select the Temperature unit: Kelvin, Celsius or Fahrenheit.

COMPOSITION UNIT

Select the Composition unit: Mass percent, Mole percent, Mass fraction, or Mole fraction.

ALLOW DELTA FERRITE TO AUSTENITE TRANSITION IN STEEL

Select the Allow delta ferrite to austenite transition in steel checkbox to enable BCC to FCC 
transition. 
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This feature should only be used for such steels for which it is reasonable to 
assume infinitely fast diffusion (equilibrium conditions) when delta ferrite is 
present. When the Allow delta ferrite to austenite transition in steel checkbox 
is selected in Graphical Mode or the DELTA_FERRITE_AUSTENITE_TRANSITION 
command used in Console Mode, this essentially assumes that diffusion can be 
considered (infinitely) fast when delta ferrite is present as a solid phase, i.e 
assumes an equilibrium condition. After delta ferrite is no longer stable, the 
usual Scheil assumptions for the selected calculation type are in effect. This 
setting is therefore not suitable for steels where you DO NOT have a complete 
BCC to FCC transition during solidification. This setting is also NOT available in 
combination with solute trapping.

CALCULATION TYPE: CLASSIC, BACK DIFFUSION, SOLUTE TRAPPING

The available settings are based on the chosen model. See Scheil-Gulliver 
Solidification Calculations for descriptions.

Click to select a Calculation type: Classic Scheil, Scheil with back diffusion in primary phase, 
or Scheil with solute trapping.  Then based on this selection, additional settings are made 
available as indicated.

The back diffusion and solute trapping options are available to select after 
adding a mobility database and once components are defined on the System 
Definer.

COMPOSITION

The Composition settings display after you add components to the System Definer.

FAST DIFFUSER

The Fast diffuser checkboxes are available after you add components to the System Definer. 
Click the checkbox to allow redistribution of this component in both the solid and liquid 
parts of the alloy.
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COOLING RATE (BACK DIFFUSION)

This field is available when Scheil with back diffusion in primary phase is selected.

Specify the Cooling rate in Kelvin per second (K/s). An increased value moves the result from 
equilibrium toward a Scheil-Gulliver calculation.

SECONDARY DENDRITE ARM SPACING (BACK DIFFUSION)

This field is available when Scheil with back diffusion in primary phase is selected.

The Secondary dendrite arm spacing is the distance in meters between two secondary 
dendrite arms. It can be either a Constant or Calculated from the cooling rate as c*(cooling 
rate)-n where c and n are entered in these fields.

Select Calculated or Constant.

 l For Calculated, enter  values  for c and n.
 l For Constant, enter a value (unit = m) in the field.

PRIMARY PHASE (BACK DIFFUSION AND SOLUTE TRAPPING)

This field is available when Scheil with back diffusion in primary phase or Scheil with solute 
trapping is selected.

The primary solidified phase is the phase where the back diffusion or solute trapping takes 
place. 

If Automatic (Scheil Calculator) or Any phase (Property Models) is selected (or kept as the 
default), the program tries to find the phase which gives the most back diffusion or solute 
trapping.

To override this setting, choose a specific primary phase from the list:

 l For back diffusion, only phases with diffusion data can be used as primary phases.
 l For solute trapping, only phases that dissolve all elements in the system can be used 

as primary phases.

SCANNING SPEED, ALPHA, AND CALCULATED SOLIDIFICATION SPEED (SOLUTE TRAPPING)

These fields are available when Scheil with solute trapping is selected.

As needed, enter Scanning speed and α  to define the Calculated solidification speed.
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On the Scheil Calculator, the Calculated solidification speed is shown. For 
Property Models, below is how the values are calculated from the Scanning 
speed and α values entered.

The Calculated Solidification Speed is Vs = Vscanning * cos(α) m/s, where Vscanning is the user 
specified Scanning speed in m/s and α is the alpha angle, α, between the solid/liquid 
boundary and scanning direction.

TRANS-INTERFACE DIFFUSIVITY (SOLUTE TRAPPING)

These fields are available when Scheil with solute trapping is selected.

Select a Trans-inteface Diffusivity option: Same for all elements or Per element.  

Smaller value leads to larger solute trapping effect. Be cautious that 

 may result in complete solute trapping and possibly 
numerical errors.

 l For Same for all elements, enter one Pre-exponential factor  (default 5.0E-9 
m2/s) and Activation energy (default 0 J/mol) in the fields for the solute diffusivity 
across the interface between liquid and primary dendrite phase. 

 l For Per element, enter individual values for each one in the provided fields for Pre-
exponential factor  (default 5.0E-9 m2/s) and Activation energy (default 0 J/mol)  for 
the solute diffusivity across the interface between liquid and primary dendrite phase. 

MAXIMUM VELOCITY FOR INFINITE DRIVING FORCE (SOLUTE TRAPPING)

This field is available when Scheil with solute trapping is selected.

Enter a Maximum velocity for infinite driving force. The default is 2000 m/s. This is the 
maximum migration speed of the liquid/primary solid interface when the driving force is 
infinite. Smaller values lead to a larger solute trapping effect.

MODEL (SOLUTE TRAPPING)

This option is available when Scheil with solute trapping is selected.
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Choose a Model  to calculate the relation between migration speed and solute partitioning at 
the liquid/primary solid interface, developed by either Aziz or Hillert.

The Hillert model usually leads to a larger solute trapping effect, though Aziz 
model is recommended for overall numerical performance including calculating 
the amount of non-primary solid phases.

INTERFACE DRIVING FORCE (SOLUTE TRAPPING)

This option is available when Scheil with solute trapping is selected.

Choose the Interface driving force, where this driving force (free energy change at the 
liquid/primary solid interface) is used to evaluate the migration speed in comparison with 
the maximum velocity. 

 l Driving energy: Uses the overall free energy change. 
 l Migration energy: Uses free energy change due to migration, i.e. the overall free 

energy change excluding that contributes to diffusion.

Selecting Migration energy leads to a larger solute trapping effect. It is 
generally recommended to select Driving energy as this is numerically more 
stable, and then adjust the other settings (e.g., Trans-interface diffusivity) for 
the desired solute trapping effect.

 

Advanced Options

This topic has advanced settings information for the   Scheil Calculator Configuration 
window. The main settings are on the Configuration tab.

Configuration Window Settings

Click the Advanced Options tab to adjust the following default settings as needed.
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To make global default setting changes, see Global Settings: Scheil Calculator.

GLOBAL MINIMIZATION

Global minimization is enabled by default i.e. the Global minimization checkbox is selected.

It is recommended to keep global minimization on as it makes the calculation 
more accurate. However, turn it off if you find that the calculation is taking too 
long for any particular system, and accuracy is not the highest priority.

For this setting, a global equilibrium test is performed at selected intervals when an 
equilibrium is reached. By default it is at every 10 th Scheil step but this can be changed 
using the Global test interval setting. The global equilibrium test is also done every time the 
set of stable phases tries to change. This costs more computer time but the calculations are 
more robust.

GLOBAL TEST INTERVAL

Use the Global test interval setting to change the interval at which a global equilibrium test 
is done, which by default is every 10th step as long as there are no changes in the set of 
stable phases. Every time the set of stable phases tries to change, a global equilibrium test is 
also done regardless of the test interval value chosen. A global equilibrium test means that 
the calculated equilibrium state obtained by the ordinary minimization calculation is tested 
against the Global Minimization Technique, and if the result is found unstable then the full 
global minimization calculation is performed instead.
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MAX GRID POINTS

Use the Max grid points to set the maximum number of grid points per phase for global 
minimization. The default is 2000.

LIQUID PHASE

The default in the list is the LIQUID phase already defined in the chosen database.

GAS PHASE

The default in the list is the Gas phase already defined in the database

CALCULATE EVAPORATION PROPERTIES

Select the Calculate evaporation properties checkbox to calculate the Molar mass of gas, 
Driving force for evaporation, and Evaporation enthalpy properties.

A gas phase is required to calculate these properties.

This option sets the gas phase to dormant, meaning that the thermodynamic properties of 
the gas are evaluated, without the gas being allowed to form. This enables the calculation of 
the following properties: Molar mass of gas, Evaporation enthalpy, and Driving force for 
evaporation. Driving force for evaporation is positive when the gas is stable (temperature 
above evaporation temperature). A negative driving force means the gas is metastable.

TERMINATE SCHEIL ON

This setting controls when a Scheil calculation should terminate. From the Terminate Scheil 
on list, choose Fraction of liquid phase (unit = mole fraction) or Temperature and enter a 
value in the field.

MAX NO. OF ITERATIONS

Enter or choose a value for the Max no. of iterations. By default, the program tries 500 
iterations before it gives up. As some models give computation times of more than 1 CPU 
second/iteration, this number is also used to check the CPU time and the calculation stops if 
500 CPU seconds/iterations are used.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 152 of 763

REQUIRED ACCURACY

The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program 
requires that the relative difference in each variable must be lower than this value before it 
has converged. A larger value normally means fewer iterations but less accurate solutions. 
The value should be at least one order of magnitude larger than the machine precision.

SMALLEST FRACTION

The default Smallest fraction (or Smallest fraction in a phase for Property Models) is 1.0E-
12. This is the value assigned to constituents that are unstable. It is normally only in the gas 
phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL 
phase with one sublattice site (such as the GAS mixture phase in many databases) for which 
the default value is always as 1E-30.

In Console Mode, the default of 1E-30 for IDEAL phases is true unless you are 
using the  command SET_NUMERICAL_LIMITS to reset an even-lower value (e.g. 
1E-45, that is naturally enforced to all the phases in the system.

APPROXIMATE DRIVING FORCE FOR METASTABLE PHASES

The Approximate driving force for metastable phases checkbox is selected by default. Click 
to clear the checkbox to change the default as required and based on the options described 
below.

This setting involves the convergence of metastable phases and affects their driving forces. It 
can also have an effect on when an equilibrium is considered successful.

The default is to allow an equilibrium with metastable phases that have not converged, as 
long as the stable phases have converged. This is efficient but often causes approximate 
values of the driving forces for the metastable phases.

If you change the default, it enforces metastable phases to converge. This gives accurate 
driving forces for metastable phases as well as stable phases. It can however take a slightly 
longer time, and if metastable phases do not converge it causes the equilibrium calculation 
to fail.
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INCLUDE ONE AXIS EQUILIBRIUM CALCULATION

The Include one axis equilibrium calculation checkbox is selected by default and a One Axis 
(also called step) calculation is performed before the actual Scheil calculation. It produces 
the solidification curve under equilibrium conditions and it is shown on the plot if the default 
axis variables are used. This is sometimes referred to as the equilibrium line.

If a comparison to equilibrium is not necessary, change the default setting and then only a 
Scheil calculation is performed. This results in a much faster calculation, which for a complex 
system may be preferable.

TEMPERATURE BELOW SOLIDUS SETTINGS

The Temperature below solidus settings are available when Temperature below solidus is 
selected for Calculate to. This calculates the properties for the given number of 
temperatures, down to the final temperature for the phase compositions and fractions at 
the solid phases at the end of the Scheil calculation. 

 l Enter the No. of points. The default is 50.
 l Enter the Final temperature. The default is room temperature (298.15 K).

Scheil Calculator Available Plot Variables

When working with Scheil calculations in Graphical Mode, there are several plot variables 
available with the Plot Renderer that is a successor to the Scheil Calculator. 

For a comparable list in Console Mode, see State Variables for Scheil.

The following list is specific to a Plot Renderer that is a successor to a Scheil Calculator. The 
software includes relevant variables in the Axis variable list based on the set up of the Scheil 
Calculator. 

There may be some additional variables available if the calculation involves the 
Diffusion Module (DICTRA) and/or other specialized databases are used.

When certain variables are selected (i.e. electric or thermal conductivity, 
electric or thermal resistivity, or thermal diffusivity), there are additional 
settings related to these described in Configuration Settings.
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 l Apparent heat capacity per gram
 l Apparent heat capacity per mole
 l Apparent volumetric CTE
 l Average composition of solid phases
 l Composition of a phase
 l Density
 l Distribution of component in phase
 l Driving force for evaporation per mole
 l Dynamic viscosity
 l Electric conductivity
 l Electric resistivity
 l Evaporation enthalpy per mole
 l Heat per gram
 l Heat per mole
 l Kinematic viscosity
 l Latent heat per gram
 l Latent heat per mole
 l Mass fraction of liquid
 l Mass fraction of solid
 l Mass fraction of solid phase
 l Molar mass of gas
 l Molar volume
 l Molar volume of phase
 l Mole fraction of liquid
 l Mole fraction of solid
 l Mole fraction of solid phase
 l Site fraction
 l Surface tension
 l Temperature
 l Thermal conductivity
 l Thermal diffusivity
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 l Thermal resistivity
 l Volume fraction of liquid
 l Volume fraction of solid
 l Volume fraction of solid phase

Scheil Calculations Frequently Asked Questions

Below are some frequently asked questions (FAQs) related to Scheil calculations in Thermo-
Calc. It is not intended to cover all the scenarios that can occur with such complex 
calculations. A particular focus is on the use and definition of variables available for plotting 
latent heat, heat, and apparent heat capacity, and the differences between Graphical Mode 
and Console Mode. 

What is the latent heat evolution for a Scheil solidification simulation?

Theory usually defines the latent heat  as the isothermal enthalpy change of phase 
transformation at any chosen temperature. It is called latent because it is regarded as a 
potential heat release or uptake. Usually this is the transformation from liquid to solid.

However, most alloys, if not all, solidify non-isothermally. In the Scheil calculation the 
plotted quantity called latent heat might not follow the theoretical definition of latent heat. 
It is the cumulative enthalpy change of phase transformation. 

There is no contribution from heat capacity, only from phase transformation.

How can I plot the latent heat evolution after a Scheil simulation?

In Graphical Mode, on the Plot Renderer node, select one of the Axis variables—Latent heat 
per mole or Latent heat per gram—to plot the quantity.

In Console Mode, the corresponding quantities are NHR or BHR. If you plot NH in Console 
Mode, you get two curves. The bottom curve is NHR, or the latent heat. See State Variables 
for Scheil for a list of the other variables.

For more detail, see Why in Console Mode are there two curves when plotting 
heat evolution after a Scheil simulation?
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What is the difference between the Latent heat per mole or gram and 
just Heat per mole or gram?

In Graphical Mode, on the Plot Renderer node, in addition to Latent heat per mole and 
Latent heat per gram you can also select one of the Axis variables—Heat per mole or Heat 
per gram. What is the difference?

Heat per mole or Heat per gram is the total molar (or specific) enthalpy of the system. This 
includes both the enthalpy change from phase transformations, and from the temperature 
change, which comes from the heat capacity.
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Why in Console Mode are there two curves when plotting heat 
evolution after a Scheil simulation?

The following is applicable to Console Mode.

The top curve is the total heat evolution and it is plotted with the quantity NHV. This is the 
total molar or specific enthalpy, including the contribution from both phase transformations 
and form heat capacity of the phases. The contribution from the solid phases are averaged.

The bottom curve is the axis quantity and it is plotted with the quantity NHR. This means that 
this is only the contribution of enthalpy changes from phase transformation from liquid; 
therefore it starts at 0 at the onset of melting.

How do you plot the distribution of component in phase?

In Graphical Mode the axis quantity is called Distribution of component in phase. This gives 
the distribution of that element as a fraction of the total molar inventory of that element, 
from 0 to 1 (0 to 100 % of the overall composition). For example, the total amount of  Fe in 
all phases should then sum up to 1. 

Be aware that if using the fast diffuser option there may be issues summing up 
to 1.

In Console Mode, NN(Phase,Element) shows the fraction of this element relative to its total 
amount in the system, residing in that phase. Here a value of 0.3 means 30 % of all the Fe in 
the system is in that particular phase.

You can also use wildcards, e.g. NN(Phase,*), which shows all elements’ respective fractions 
of the total in that phase (this does not sum up to 1). This is useful to get an overview of 
preferential partitioning of elements during the solidification process.

Also useful is plotting NN(*,Element), where you see the distribution of the element over all 
phases in the system; these curves should all sum up to 1. Here, 0.3 of Fe in Liquid and 0.7 in 
FCC, would mean that 30 % of the total Fe-content in this alloy is still in the liquid, etc.

Due to calculation issues when working with fast diffusers, this command is not 
available in Console Mode.
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What is the apparent heat capacity?

The apparent heat capacity is what is going to be measured experimentally; heat capacity is 
theoretically the derivative of enthalpy with respect to temperature. This apparent heat 
capacity includes both contributions from phase transformation and from temperature 
change.

Scheil Resources: Installed Examples

For Graphical Mode examples, see T_08: Scheil and Equilibrium Solidification, T_
10: Scheil Solidification with Back Diffusion, and T_13: Scheil Solidification with 
Solute Trapping.

For Console Mode examples see Scheil-Gulliver Examples.

Scheil Resources: Website Video Tutorials and Application Example

Link to more information about Scheil Solidification Simulations on our website. 
There are also video tutorials related to some Scheil examples  as part of a 
playlist on our YouTube channel and an application example using the Diffusion 
Module (DICTRA). 

Scheil Resources: Self-paced Learning Hub

The Thermo-Calc Learning Hub has a module dedicated to Scheil Calculations. 

Learn about Thermo-Calc and the Add-on Modules at your own pace with our 
comprehensive online Learning Hub. The Learning Hub includes courses for Thermo-Calc, 
the Diffusion Module (DICTRA), the Precipitation Module (TC-PRISMA), and the TC-Python 
SDK. In addition to introductory lectures, instructors walk through and discuss real world 
examples that correlate calculations with microstructures and other metallurgical concepts, 
spanning a wide range of material types.

Subscriptions also include access to live monthly office hours, where you can ask our experts 
about any of the content on the Learning Hub or your own materials challenges.

https://thermocalc.com/products/thermo-calc/scheil-solidification-simulations/
https://thermocalc.com/support/video-tutorials/scheil-solidification-simulation-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGTa876IxGC8H2yuefiyIFaT
https://thermocalc.com/showcase/application-examples/microsegregation-during-solidification/
https://learn.thermocalc.com/courses/introduction-tothermo-calc/
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Property Model Calculator

A Property Model Calculator enables you to predict and optimize material properties based 
on their chemical composition and temperature. The available calculation types are Single, 
One Axis, Grid, Min/Max, Uncertainty, and Batch. 

Using these, you can evaluate models simultaneously over a range of compositions and 
temperature and cross plot the results, then conduct an uncertainty analysis and plot the 
results as either a histogram or  a probability plot. The Batch calculation further enables you 
to read input from a file, such as a spreadsheet. 

There are General Models plus material specific Model Libraries for Nickel 
Models, Noble Metal Alloys Models, Steel Models, and Titanium Models 
available. For more information start with the section About the Property 
Models.

Property Model Calculator Workflow

At the start when you are designing a project, it is recommended you first test it by 
performing a Single calculation type. This verifies that the configuration of the model is 
valid, otherwise you will get a Not a Number result in the Event Log Window, which indicates 
the calculation did not work correctly. 

Once the Single calculation performs successfully, you can experiment with other calculation 
types such as Grid, Min/Max, Uncertainty, or Batch. Best practice for both Grid and 
Uncertainty is to start with a small number of steps (Grid) or samples (Uncertainty) to 
confirm that it works before increasing the number of steps or samples. For Batch 
calculations, it is good practice to first review the data file requirements described in 
Working with Batch Calculations.

For a Grid calculation, you can additionally plot a Heat map, Contour, or 3D diagram. This 
setting is done on the  Plot Renderer, which has several Plot Types, Plotting Options, and Plot 
Types available. 

In general, the workflow for each model differs. A recommended start point is to do a One 
Axis calculation (using the Equilibrium Calculator) to determine what phases you get and 
where the transitions are before setting up the Property Model Calculator.
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Templates 

There are a variety of related templates both for the equilibrium One Axis calculations and 
to add a Property Model node structure. 

In addition there are Steel TTT and Steel CCT templates that you can use to quickly set up a 
simulation for the Steel Model Library. For details, see Getting Started Links and Templates. 

Configuration Settings

Each Property Model has its own set of configuration parameters. There are some standard 
ones entered starting with the Configuration Window Settings topic.

Custom Property Models

You can also create custom Property Models. Search the TC-Python help on the 
website for details about creating custom models. In general go to the Property 
Model Framework → Best Practices section.

https://www2.thermocalc.com/docs/tc-python/latest-version/html/
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About the Property Models

Property Models are used to predict and optimize properties of materials using models 
stored within the software where the calculations are set up in the Property Model 
Calculator.

General Models

The following General Property Models are available with the Property Model Calculator.

The General Models  are available to all users. 

To run calculations with  the Add-on Property Model Libraries all require a valid 
maintenance license plus a license for the specific database version: Nickel 
Models (TCNI11 and newer and MOBNI5 and newer; Noble Metal Alloys 
Models (TCNOBL3 and newer); Steel Models (TCFE9 and newer + MOBFE4 and 
newer); Titanium Models (TCTI6 and newer).

About the Steel Model Library Property Models, About the Nickel Model Library 
Property Models, and About the Titanium Model Library Property Models, and 
About the Noble Metal Alloys Model Library Property Models.

Coarsening

The Coarsening Property Model calculates the coarsening rate coefficient K (m3/s) of a 
spherical precipitate phase in a matrix phase. 

See About the Coarsening Property Model and Coarsening Property Model 
Settings for background theory and input parameter details.

Columnar to Equiaxed Transition (CET)

The Columnar to Equiaxed Transition Property Model calculates the fraction of equiaxed 
grains that correlates with a certain solidification condition, specifically thermal gradient  ( ) 
and solidification growth rate  ( ). 

See About the Columnar to Equiaxed Transition (CET) Property Model and 
Columnar to Equiaxed Transition (CET) Property Model Settings for background 
theory and input parameter details.
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Crack Susceptibility Coefficient

The Crack Susceptibility Coefficient Property Model calculates the hot tearing tendency 
during solidification. 

See About the Crack Susceptibility Coefficient Property Model and Crack 
Susceptibility Coefficient Property Model Settings for background theory and 
input parameter details.

Driving Force

The Driving Force Property Model calculates the thermodynamic driving force for a phase. 

See  Driving Force Property Model Settings for input parameter details.

Equilibrium

The Equilibrium Property Model calculates the equilibrium for the given conditions. 
Optionally define additional function definitions. 

See Equilibrium Property Model Settings for input parameter details.

Equilibrium with Freeze-in Temperature

The Equilibrium with Freeze-in Temperature Property Model calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature. The 
assumption is that diffusion and phase transformations are negligible when changing from 
the freeze-in-temperature and, therefore, that the phase amounts and compositions of 
phases are kept at all other temperatures. 

See About the Equilibrium with Freeze-in Temperature Property Model and 
Equilibrium with Freeze-in Temperature Property Model Settings for 
background information and input parameter details.

Interfacial Energy

The Interfacial Energy Property Model estimates the interfacial energy between a matrix 
phase and a precipitate phase using thermodynamic data from a CALPHAD database. 
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See About the Interfacial Energy Property Model and Interfacial Energy Property 
Model Settings for background information and input parameter details.

Liquid and Solidus Temperature

The Liquid and Solidus Temperature Property Model is for doing a common calculation. For 
example, you can easily use uncertainty calculations, vary one or more conditions, and see 
how that affects the liquidus and solidus temperatures. 

See Liquid and Solidus Temperature Property Model Settings for input 
parameter details.

Phase Transition

The Phase Transition Property Model can be used to vary which condition to relax, and then 
it calculates the point when a new phase may form. It is useful to determine melting 
temperature, boiling temperature or solubility limits. It returns the phase transformation 
temperature, or composition, depending on the relaxed condition.  

See Phase Transition Property Model Settings for input parameter details.

Scheil

The Scheil Property Model is used to calculate solidification under the Scheil assumption. 
The majority of the Model  input parameters are pulled from the Scheil Calculator to offer 
the outputs of the liquidus/solidus/solidification range so you can explore these in the 
calculation types of the Property Models.

See Scheil Property Model Settings, and Scheil Advanced Options: Property 
Models.

Spinodal

The Spinodal Property Model calculates the spinodal line. 

See About the Spinodal Property Model and Spinodal Property Model Settings 
for background information and input parameter details.

T-Zero Temperature

The T-Zero Temperature Property Model calculates the so-called T0 line. 
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See About the T0 Temperature Property Model and T0 Temperature Property 
Model Settings for background information and input parameter details.

Yield Strength

The Yield Strength Property Model calculates yield stress. It returns the calculated yield 
strength at room temperature for the specified material using the equilibrium values 
calculated at temperature  (i.e.  is the freeze-in temperature). Then you can further 
define the following contributions to the total yield stress: precipitation strengthening, solid 
solution, grain boundary strengthening, and constant addition of strength. 

See About the Yield Strength Property Model and Yield Strength Property 
Model: Simplified Mode Settings or Yield Strength Property Model: Advanced 
Mode Settings for background information and input parameter details.

Calculation Types

The Property Model Calculator includes these calculation types:

 l Single: Calculates a single point.
 l One Axis: Varies a quantity on the X-axis.
 l Grid: Evaluates two axis variables of the selected quantities in the specified range 

and number of steps. You can then select to create heat map, contour and 3D plots 
on the Plot Renderer.

 l Min/Max: Evaluates the Property Model(s) for all variations of the selected 
quantities at the given limits. The Mean field is as defined under Condition Definitions 
for the respective quantity. The total minimum and maximum of the Model(s) results 
are shown in the Event log.

 l Uncertainty: Evaluates the Property Model(s) where the values of the quantities are 
sampled from Gaussian distributions. The Mean field is as defined under Condition 
Definitions for the respective quantity. The result is visualized as a histogram or 
normal probability plot by adding a Plot Render activity.

 l Batch: Use this to  allow for high throughput calculations and read data from a file, 
such as a spreadsheet. You can include experimental results in the data file, which 
then can be used to compare to the batch calculation results.

About the Uncertainty Calculations and Plot Types

Examples and Video Tutorials

Thermo-Calc General Property Models Examples Collection
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For tutorials about this feature, go to our website or browse the Property Model 
Calculator playlist on our YouTube channel. 

https://thermocalc.com/support/video-tutorials/property-model-calculator-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGQLFHZ8SVl2TGlvqWUQOdJX
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Define the Property Model Calculator

 1. Add a Property Model Calculator node to the System Definer. If you used the 
Property Models template, click the node to display the Configuration settings 
window. 

 2. From the left side of the Configuration window, click to select one or more of the 
checkboxes under the General Models. If you have licenses for the material specific 
libraries, you can also select and run the Property Models from the   Nickel Models, 
Noble Metal Alloys Models, Steel Models, or Titanium Models folders. 

For the material specific libraries these are only available if you have the 
applicable licenses. If you are interested in learning more about the 
available models, go to our website.

A tab with the same name as the Property Model opens in the right side of the 
window under Condition Definitions. When you select more than one Model at a 
time, a matching tab is added in the same order that the checkbox is selected. 

 3. For each Model on the Configuration tab, select or enter settings described in 
Configuration Window Settings and based on the Calculation Type chosen.

When working in the Configuration window, click the Description tab for 

https://thermocalc.com/products/add-on-modules/steel-model-library/
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more information about the Model. 

 4. Once you have finished defining the Property Model Calculator, you also choose 
settings on the Plot Renderer. 

Examples and Video Tutorials

Thermo-Calc General Property Models Examples Collection

For tutorials about this feature, go to our website or browse the Property Model 
Calculator playlist on our YouTube channel. 

Configuration Window Settings

Click the Property Model Calculator node in the Project window to view the Configuration 
window.  The settings available vary based on such choices as the Property Model and 
calculation type selected. 

Depending on your license, there are many Property Models available and the available options 
on the Configuration window vary. The General Models are available to all users. 

https://thermocalc.com/support/video-tutorials/property-model-calculator-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGQLFHZ8SVl2TGlvqWUQOdJX
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General Configuration Settings

COMPOSITION UNIT

Select the Composition unit: Mass percent, Mole percent, Mass fraction, or Mole fraction.

CONDITION DEFINITIONS

Choose a unit (Kelvin, Celsius or Fahrenheit) and then enter a value for the Temperature 
and Composition for each component.

The values entered in Condition Definitions are used as the start values for the different 
calculation types. 

TIMEOUT IN MINUTES

Select the Timeout in minutes checkbox to enter a time when a calculation will stop trying 
to complete the evaluation. This is useful if it is a complex or unknown calculation outcome 
and you want to prevent it from taking too much computer time or resources. The number 
entered in the field means that this is the maximum amount of time that each line can take 
for an individual calculation. This is useful in particular for Batch or Uncertainty calculations.

PARALLEL CALCULATION

By default, the Parallel calculation (Property Model Calculator Configuration window) and 
Parallel calculation for Property Model Calculator (Options window for a Global setting) 
checkbox is selected. 

The number of parallel branches (the No. of worker processes) can only be changed globally 
via the Options window.  The default number of worker processes is based on the number of 
physical cores available on the computer. You can adjust the number of worker processes as 
needed, however it is still dependent on the available cores on the computer. 

This checkbox is used for all the calculation types available with the Property Model 
Calculator in Graphical Mode. When you click Perform, the grid points calculated are 
distributed among these worker processes, which enables parallel calculations and speeds 
up the calculation. Click to deselect the checkbox as needed to not use these worker 
processes.

DEFINE THE PROPERTY MODEL

For each Property Model chosen, select or enter Configuration settings as required. 
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For links to each Model with the settings details, see About the Property 
Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

CALCULATION TYPE

Click to select a Calculation Type:

 l Single to calculate a single point. Any model can use this calculation type and no 
additional settings are required. The results from this calculation are displayed in the 
Event Log or if a Table Renderer is used, in the Visualizations window. 

 l One Axis: To  vary a quantity on the X-axis.
 l Grid: Evaluates two axis variables of the selected quantities in the specified range 

and number of steps.
 l Min/Max: Evaluates the Property Model(s) for all variations of the selected 

quantities at the given limits. The Mean field is as defined under Condition 
Definitions for the respective quantity. The total minimum and maximum of the 
model(s) results are shown in the Event log.

 l Uncertainty: Evaluates the Property Model(s) where the values of the quantities are 
sampled from Gaussian distributions. The Mean field is as defined under Condition 
Definitions for the respective quantity. The result is visualized as a histogram or 
normal probability plot by adding a Plot Renderer activity.

 l Batch: Use this to  allow for high throughput calculations and read data from a file, 
such as a spreadsheet, rather than, for example, having a fixed grid or random 
values.  Results from these batch calculations can then be compared to experimental 
values (as long as this data is included), using a Cross plot on the Plot Renderer. 

AXIS DEFINITION

For One Axis, select a Quantity to vary along the X-axis, for example, Temperature then 
enter a Min, Max and Number of steps. 
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GRID DEFINITIONS

For the Grid calculation type, define the two axes variables using the fields and menus: 
Quantity, Min, Max, and Number of steps. The number of steps along with the minimum 
and maximum values for the axes define a grid. For each grid point the selected models are 
evaluated. 

For a Grid, on the Plot Renderer, you can choose to plot a Heat map, Contour, 
or 3D diagram.

Plot Type: Heat Map, Contour, and 3D

MIN/MAX DEFINITIONS

For the Min/Max calculation type, click to select the applicable checkboxes under Quantity 
to enable or disable an axis. The Mean field is as defined under Condition Definitions for the 
respective quantity. 

Enter numerical values in the ΔMin/Max fields to evaluate the change to the quantity. The 
highest and lowest value of each selected model results are shown in the Event Log.

SAMPLING OF DATA FROM GAUSSIAN DISTRIBUTIONS

For the Uncertainty calculation type, click to select the applicable checkboxes under 
Quantity to vary this quantity. The Mean field is for the distribution function as defined 
under Condition Definitions for the respective quantity. The default ΔMin/Max is a 95% 
confidence interval. 

About the Uncertainty Calculations

SAMPLING PARAMETERS

For the Uncertainty calculation type, choose a number of Standard deviations where you 
want to Truncate the distribution. Choose the Total number of samples. 

About the Uncertainty Calculations
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BATCH CONTROLS

For more details about the format of a data file used to define the compositions, 
parameters, experimental data, or skipping validation, see Working with Batch 
Calculations.

In the Data file field, either enter a file path or click the load data file button ( ) to navigate 
to a data file such as an Excel spreadsheet (with *.xls or *.xlsx extensions) or a *.csv file. 
You can also use other programs (e.g. Google Sheets) to enter data and export to a CSV 
format that can be read by the software.

Click Open to import the data. In the Data file field you can see the file path to the selected 
file. The next time you click the load data file button ( ) the program remembers the last 
location from where the file is opened.

Choose the delimiter—Comma (,), Colon (:), Equals sign (=), Semicolon (;), or Tab—that 
matches the delimiter in the data file and click the Reload ( ) button.

The data is imported and displays on the Property Model Calculator: 

 l The data are used for the applicable fields that must match what already exists as a 
Property Model parameter (e.g. critical radius, grain size, etc.) as well as the 
composition, temperature, and units that you want to run the calculation for.  Also, if 
the dependent element composition is not included in the data file, the batch 
calculation then sets the dependent element to be the same as defined in the user 
interface.

 l The calculation runs once for every row of data included in the file. 

When the data file is imported into Thermo-Calc, there is also a Row column 
autogenerated by Thermo-Calc. 

Select the Set zero amount to value (in mole-/mass-fraction) to enter a small value for the 
mole/mass-fraction in cases where a Property Model has problems calculating zero amounts 
of elements.

Select the Skip validation of data file checkbox to allow a calculation to perform using the 
data file even when certain criteria are not met. 

When selected, the validation of the data file is skipped: 
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 l If the Composition (elements) do not match the system composition entered on the 
GUI in the System Definer or Property Model Calculator. 

 l If one or more Parameters are not correctly entered, not selected for the specific 
Property Model, or are unavailable with the selected Property Model, then these are 
ignored in the calculation.

If there are any data file validation error(s), a tooltip on the Perform button lists 
and describes these. 

Entering Model Parameters as Functions

For many model parameters that are defined as a numeric value this can be entered in 
number format or as a user-defined function (an expression). 

An exception to this is the Yield Strength Model Advanced Mode setting for 
Solid solution strengthening and when entering the Solid solution 
strengthening temperature. This field must be entered in number format i.e. it 
does not accept a user-defined function. 

GUIDELINES FOR ENTERING FUNCTIONS

 l The user-defined function can contain the operators for  multiplication (*), division 
(/),  addition (+), subtraction (-), and exponentiation (** or (^). 

 l If an invalid function is entered, the Event Log warns you of the error. 
 l If an expression is entered as a parameter/function value, then that parameter is not 

available to select as a quantity on the Plot Renderer, i.e. as an axis quantity.

Only the thermodynamic quantities for composition (mole fraction and weight fraction) and 
temperature can be used in functions and these must be entered using a specific syntax 
(which uses Console Mode format). An example of a valid function for composition (mole 
fraction) and temperature is x(Fe)*2 - T^(1.0/3.0).
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Quantity Syntax

Mole fraction x(element)

Weight fraction w(element)

Temperature T

Result Quantities: Property Model Abbreviations

When selecting quantities on the Plot Renderer or Table Renderer, the quantity names 
include an abbreviated name for the Property Model it is associated to. This is useful in 
particular when you are calculating two or more Property Models that share names for the 
quantities. The short name identifying the specific Property Model is included in 
parentheses after the name of the quantity. Below are the full and abbreviated names for 
each Property Model.

This is not applicable to the Equilibrium Property Model.

An example of the short names included in parentheses for the Driving Force and Interfacial 
Energy Property Model quantities. This is from example PM_G_03.

Full Name Abbreviation Model Library

Columnar to Equiaxed Transition (CET) Col. Eq. Trans. General

Coarsening Coarsening General

Crack Susceptibility Coefficient Crack Susc. Coeff. General

Driving Force Driv. Force General
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Full Name Abbreviation Model Library

Equilibrium with Freeze-in Temperature Eq. Freeze-in Temp. General

Interfacial Energy Int. En. General

Liquid and Solidus Temperature Liq. & Sol. Temp General

Phase Transition Phase Trans. General

Scheil Scheil General

Spinodal Spinodal General

T-Zero Temperature T-Zero Temp. General

Yield Strength Yield Strength General

Antiphase Boundary Energy Ant. Bound En. - Ni Nickel

Coarsening Nickel Coars. -Ni Nickel

Equilibrium with Freeze-in Temperature Nickel Eq. Freeze-in Temp. - Ni Nickel

Solvus for Ordered Phase Solv. Ord. Phase - Ni Nickel

Strain-Age Cracking Strain-Age Crack. - Ni Nickel

Bainite Bainite Steel

CCT Diagram CCT Diagr. Steel

Critical Transformation Temperatures Crti. Transf. Temp. Steel

Ferrite Ferrite Steel

Martensite Fractions Mart. Fract. Steel

Martensite Temperatures Mart. Temp. Steel

Martensitic Steel Strength Mart. Steel Strength Steel

Pearlite Pearlite Steel



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 175 of 763

Full Name Abbreviation Model Library

TTT Diagram TTT Diagr. Steel

Alloy Strength - Ti All. Strength - Ti Titanium

Martensite Temperatures - Ti Mart. Temp. - Ti Titanium
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Diffusion Calculator

The Diffusion Calculator is available with three elements if you do not have the 
additional Diffusion Module (DICTRA) license. With the Add-on Module you can 
use all available elements as per the licensed database selected. See Available 
Graphical Mode Features for details about this and other options available with 
additional licenses.

A Diffusion Calculator allows you to set the conditions for, and perform, a diffusion 
calculation.  You can add the calculator to the System Definer directly (right-click and select it 
from the Create New Successor menu).

There are also templates available under Non-Equilibrium that you can use to 
quickly set up a simulation. See Getting Started Links and Templates.

Once you have added a Diffusion Calculator, the Configuration window  has Conditions and 
Options settings tabs where there are many available conditions to set and then continue 
the settings with the specialized Plot Renderer.

 l Conditions: Set the conditions for your calculation that define the geometry, regions, 
phases, grids, composition profiles, and thermal profile. 

The Composition Profiles and Thermal Profile are both set up on the 
Configuration window for a Diffusion Calculator. These are previewed in 
the Visualizations window. 

 l Options: Modify the simulation conditions such as the choosing the default solver 
(automatic or homogenization) and the time integration method. Also define the 
time step controls and if you choose homogenization as the solver, define further 
settings such as the interpolation scheme and whether to use global minimization or 
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not. 

 l Plot Renderer: There are also unique settings available for this calculator once you 
add a Diffusion Calculator Plot Renderer.

Working with these simulations is an advanced topic. It is recommended you 
review the  documentation and videos available or search for a specific topic. 

Available Graphical Mode Features

The Diffusion Module is an Add-on Module to the core Thermo-Calc software. 

A separate license is required to perform calculations for more than three 
elements. Without it you are able to use the module in Demo Mode. This is not 
available in Console Mode.

Diffusion Templates

Under Non-Equilibrium Calculations, the Homogenization and Diffusion templates are 
available to all Thermo-Calc users when in Graphical Mode. 

If you are using the Diffusion Module in Demo Mode, see Demonstration 
(Demo) Mode for what is available to you. Even if you have a license, you may 
find yourself in Demo Mode if you have a network license and all the licenses 
are checked out. 

USING THE TEMPLATES

After opening Thermo-Calc in Graphical Mode, in the templates section  under Non-
Equilibrium Calculations click: 
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 l Homogenization to add a System Definer, Scheil Calculator, Diffusion Calculator, and 
two Plot Renderer nodes to the Project tree.

 l Diffusion to add a System Definer, Diffusion Calculator, and Plot Renderer to the 
Project tree.

Creating a Project from a Template

Diffusion Calculator

A Diffusion Calculator allows you to  set the conditions for your calculation that define the 
geometry, regions, phases, grids, composition profiles, and the thermal profile, plus 
additional options. Many of the settings are automatically set as you define your system. 
Details about this activity are described in Diffusion Calculator.

Demo Database Packages for the Examples Collection

Both a thermodynamic and mobility database are required to run the Diffusion Module 
simulation.   If you have a Diffusion Module (DICTRA) license you can run all the examples 
because the demonstration database packages are included with your installation. 

Select the database packages from the System Definer Configuration window to run a 
simulation. 

Demonstration (Demo) Mode

The Diffusion Module and some examples are available to all Thermo-Calc users but only for 
simulations with three elements. If you do not have a license  then you are in Demo Mode 
when using the Diffusion Calculator, or either of the templates. 

DIFFUSION TEMPLATES

If you are in DEMO mode then  this is indicated by the addition of DEMO text under the 
button.
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DIFFUSION CALCULATOR

If you are experimenting with the Diffusion Calculator in Demo Mode then you may have 
access to a variety of databases based on your license. However, you can only define three 
elements for a demo simulation. 

If you define more than three elements on the System Definer, when you go to the Diffusion 
Calculator, the Perform button is unavailable and the tooltip explains why.

Even if you have more than three elements, the Plot Renderer Perform button 
is still available. However, if you click the button and try to run the simulation 
the Event Log displays an error message.

Additive Manufacturing (AM) Module

There is connectivity between the Diffusion Module (DICTRA) or the  Precipitation Module 
(TC-PRISMA) and the Additive Manufacturing (AM) Module when you have full licenses 
available for all relevant Add-on Modules and databases. 

You can add a Diffusion Calculator or Precipitation Calculator as a successor to the 
AM Calculator and then when probes are included with the AM Calculator this data can be 
further used with the thermal profile. 

Details are in the AM Module documentation. See AM Calculator: Working with Probe Data.

Define the Diffusion Calculator

Working with diffusion simulations is an advanced topic. It is recommended you review the 
Diffusion Module (DICTRA) documentation and videos available or search for a specific topic. 
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 1. Add a Diffusion Calculator node to the System Definer. If you used the Diffusion 
template (on the  My Projects Configuration window under Non-Equilibrium), 
click the node to display the Configuration settings window. 

 2. In the Diffusion Calculator Configuration window, enter the settings described in 
Conditions Tab Settings and  Options Tab Settings. 

The Composition Profiles and Thermal Profile are both set up on the 
Configuration window for a Diffusion Calculator. These are previewed in 
the Visualizations window. 

When you also have licenses either for the Diffusion Module (DICTRA) 
and/or the Precipitation Module (TC-PRISMA), for transient simulations 
you can additionally  include probe data from the AM Calculator in the 
set up of the thermal profile for diffusion and precipitation calculations, 
respectively. 

 3. Once you have finished defining the Diffusion Calculator, you also choose settings on 
the Plot Renderer. Some additional settings are specific to the Diffusion Calculator 
Plot Renderer.

Available Graphical Mode Features

Diffusion Module (DICTRA) Examples Collection

Conditions Tab Settings

The following Configuration window is from the Graphical Mode Quick Start Guide. It is using 
project example file D_07: Diffusion Carburization Multiphase.
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These are the settings available from the Conditions tab. To edit the global 
defaults for some settings, go to the Options window (different from the tab). 
See Global Settings: Diffusion Calculator.
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The Diffusion Module (DICTRA) in Console Mode has commands to perform 
some of the settings also available on the Diffusion Calculator. Where possible 
the name of the command is indicated and includes a link to the topic. 

General

COMPOSITION UNIT

Choose from Mass percent, Mole percent, Mass fraction, or Mole fraction.

LENGTH UNIT 

Choose m, μm, or nm.

GEOMETRY

Choose a Geometry: Planar, Spherical, or Cylindrical. For Cylindrical, also enter a value for 
the First interface position.

With a cylindrical or spherical geometry, the system’s zero coordinate (left boundary) is at 
the center of the cylinder or sphere. The highest coordinate (right boundary) is defined by 
the cylinder or sphere radius. 

Geometry Graphic

Planar

Spherical

Cylindrical

The Composition Profiles and Thermal Profile are both set up on the 
Configuration window for a Diffusion Calculator. These are previewed in the 
Visualizations window. 
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Region Settings

There should be one unique phase in each region.

LEFT AND RIGHT INTERFACE BOUNDARY

Toggle between hiding and showing the Left interface boundary or Right interface 
boundary.

Click the Add quantity  or Remove quantity  buttons as required to add a Phase and 
then enter a value for the Driving force as required. The default driving force is 1.0E-5.

NAME

Enter a Name for the region in the field. For example, enter Austenite. This name is 
automatically updated on the tab and above the grid points graphic.

WIDTH

Enter a numerical value in the Width field. The unit  is the one selected for the Length unit. 

POINTS

Enter a numerical value in the points field. The default is 50.

TYPE (OF GRID)

Select a type of grid, Linear, Geometric, or Double geometric.

Choose Geometric for a grid that yields a varying density of grid points in the region. Then 
enter a Ratio to determine the distribution. A geometrical factor larger than one yields a 
higher density of grid points at the lower end of the region and a factor smaller than one 
yields a higher density of grid points at the upper end of the region.

Choose Double geometric to have a high number of grid points in the middle or at both ends 
of a region. Then specify two geometrical factors, the Lower ratio for the distribution in the 
lower (left) part of a region, and Upper ratio for the distribution in the upper (right) part of a 
region.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 184 of 763

PHASE

Choose a Phase from the list. The available options are defined in the System Definer. At 
least one phase that dissolves all system elements must be selected.

Click the Add phase  or Remove phase  buttons as required. 

The Composition Profiles and Thermal Profile are both set up on the 
Configuration window for a Diffusion Calculator. These are previewed in the 
Visualizations window. 

Boundary Conditions

Boundary conditions are conditions that define how matter behaves at the boundaries of 
your system. By default, matter is not allowed to cross the system boundaries.

You can change the setting for both the lower boundary (left side/centre) and the upper 
boundary (right side/surface) of the system. 

Examples D_06 and D_07 use boundary conditions, as described in Diffusion 
Module (DICTRA) Examples Collection.

The boundary condition settings are done on the Diffusion Calculator. The following 
describes the options available for the Left boundary and Right boundary conditions.

CLOSED SYSTEM

By default it is a Closed system. Choose Mixed zero flux and activity or Composition if the 
system is not closed. Corresponds to a fix flux value, which is set to zero at all times. This is 
the default boundary condition.

COMPOSITION

Allows you to set a fix composition at the boundary. 

In Console Mode this is similar to the command STATE_VARIABLE_VALUE, but in 
Graphical Mode this condition is limited to setting a fixed composition.
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MIXED ZERO FLUX AND ACTIVITY

The flux of selected components is either set to zero or a prescribed activity value.

For Mixed zero flux and activity, and for each independent element selected in the 
Composition profile, choose either Zero flux or Activity from the lists and enter a value in 
the field when Activity is selected.  The reference state for the components are taken from 
the System Definer Components tab.

In the field for Activity, enter a formula that the software evaluates  during the calculation.

The formula can be:

 l A function of the variable TIME
 l A constant

The formula must be written  with these rules:

 l A number must begin with a number (not a dot)
 l A number must have a dot or an exponent (E)

The operators + , - , * , / , ** (exponentiation) can be used and with any level of parenthesis.

As shown, the following operators must be followed by  () i.e. open and closed parentheses:

 l SQRT(X) is the square root
 l EXP(X) is the exponential
 l LOG(X) is the natural logarithm
 l LOG10(X) is the base 10 logarithm
 l SIN(X), COS(X), TAN(X), ASIN(X), ACOS(X), ATAN(X) 
 l SINH(X), COSH(X), TANH(X), ASINH(X), ACOSH(X), ATANH(X)
 l SIGN(X)
 l ERF(X) is the error function

This image is from example D_07: Diffusion Carburization Multiphase.
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Composition Profiles

The Composition Profiles are set up on the Configuration window for a Diffusion Calculator. 
These are viewed in the Visualizations window. 

For most calculations, you can include data as follows.

 l Given by function (linear, step, or function). See Composition Profiles: Given by 
Function.

 l Table input that can be either directly entered or imported. See Composition Profiles: 
Table Input (i.e. Data File Import).

 l Solidification data. For a Diffusion Calculator that is a successor to the Scheil 
Calculator, you can perform a Scheil solidification calculation followed by kinetic 
homogenization simulation of segregated composition profile. In this case, there are 
different options on the Configuration window for this section. The profile then uses 
information from the Scheil Calculator. See Composition Profiles: Scheil Segregation 
Profiles.
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When using the Table input setting, you can directly enter data in the table or 
you can import a Data file. If you import a data file, even though it is a simple 
set of data, first prepare it based on the Guidelines for Importing Data Files to 
Composition Profiles.

Figure 2: This composition profile is from example D_08 Microsegregation During Solidification. 
Other examples using this feature are D_04_Diffusion_Fe-C_Moving_Boundary_Austenite_to_
Ferrite and D_09 Ni_Post_Weld_Heat_Treatment_From_File, which are all included with your 
installation.
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Composition Profiles: Given by Function

 1. On the Diffusion Calculator Configuration window, first enter the required settings 
described in Conditions Tab Settings including the Region Settings and Boundary 
Conditions.

 2. Click to select the Composition profiles → Given by function option. 

 3. Select a Dependent component for which the composition does not need to be 
given. The available options depend on the phase description. 

 4. For each Component choose one of these options:

 l Linear: Enter numerical values in the from and to fields. 

 l Step: Enter numerical values in the from, to, and  step at fields. The unit is the 
same as the Length unit selected at the top of the Configuration window.

 l Function: Enter a composition function in the field using SI units. The syntax 
to use for writing functions is a Python syntax (a programming language). Any 
valid Python expression that is a function of the distance variable x will work. 

You can use the standard Jython math library but you must 
prefix these functions with the text "math" For example: 10 + 
math.sin(x*2). The Jython math library is available here: 
https://www.jython.org/.

 l The error function erf(X) is also available in the Jython math library and can 
be called with math.erf(x). 

 l Another useful function is the Heaviside step-function hs(X). For example, 
3+2hs(x-1e-4) provides a concentration of 3 at the left side and 5 at the right 
side with a sharp step in the concentration profile at 1e-4m=100 mm.

 5. The Composition Profile is previewed in the Visualizations window as in Figure 2. 
Make adjustments to the settings as needed and watch it dynamically change in the 

https://www.jython.org/
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window.

 6. After completing this section, also continue with Boundary Conditions and the 
Diffusion Calculator Thermal Profile.

Composition Profiles: Table Input (i.e. Data File Import)

 1. On the Diffusion Calculator Configuration window, first enter the required settings 
described in Conditions Tab Settings including the Region Settings and Boundary 
Conditions.

 2. Click to select the Composition profiles → Table input option. 

 3. Select a Dependent component for which the composition does not need to be given 
(i.e. it is excluded from the table). The available options depend on the phase 
description. The Composition unit and Length unit are taken from the settings 
already entered.

 4. To enter data directly into the table: 

 a. Click in each cell under the applicable columns, e.g. Distance and then each 
individual component such as Fe, Al, etc. 

 b. Directly enter the values in the table. Press <Enter> to add rows and use the 
scroll bars to navigate the table.

 5. To import a data file:

 a. It is important to first prepare the data file as in Guidelines for Importing Data 
Files to Composition Profiles.  

 b. When the data file is ready, to the right of the Data file field, click the file  
button to load the file. 

 c. Navigate  to a data file such as an MS Excel spreadsheet (with *.xls or *.xlsx 
extensions) or a *.csv file. You can also use other programs (e.g. Google 
Sheets) to enter data and export to a CSV format that can be read by the 
software.  Click Open to import the data to the Configuration window table.
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 d. If there are issues with the above import, experiment with choosing the 
delimiter type that corresponds to the data in the file: Comma (,), Colon (:), 
Equals sign (=), Semicolon (;), or Tab—that matches the delimiter in the data 
file. Click the Reload button . The data is imported to the Configuration 
window table.

 6. The Composition Profile is previewed in the Visualizations window as in Figure 2. 
Make adjustments to the settings as needed and watch it dynamically change in the 
window.

 7. After completing this section, also continue with Boundary Conditions and the 
Diffusion Calculator Thermal Profile.

Composition Profiles: Scheil Segregation Profiles

This section is specific to when the Homogenization template is used, or generally when a 
Diffusion Calculator is a successor to the Scheil Calculator.

When this is the case, the Composition profiles take information from the Scheil calculation, 
and then you can choose to Average over all solidified phases (the default), where All 
solidified phases is further selected by default or you can define by Custom phases. 

Alternatively, choose Primary dendrite phase, where it is assumed that other phases formed 
during solidification will not dissolve during homogenization. The Primary dendrite phase 
can only be BCC, FCC, or HCP.

Also when Primary dendrite phase is selected, the Scheil segregation profiles 
for fast diffusers are not available. The alloy composition for fast diffusers that 
is defined on the Scheil Calculator Configuration window next to the Fast 
diffusers checkbox is used instead.
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The segregated composition profile can be assumed to be equal to a 
concentration profile for regular Scheil assumptions. i.e. the segregated 
composition profile as a function of solidified material can be directly mapped 
to a concentration profile given the secondary arm spacing. This direct relation 
between segregated and concentration profiles is no longer valid when fast 
diffusers are used. Then the fast diffusers equilibrate at all temperatures during 
the Scheil solidification and the concentration profiles for fast diffusers 
therefore change at every temperature. The average segregated profile for all 
elements (also fast diffusers) as a function of solidified material represent the 
composition profile at the final temperature at the end of solidification.

To learn about the Homogenization template, see Getting Started Links and 
Templates. 

Example D_10: Iron (Fe) Homogenization in Scheil uses the Homogenization 
template to demonstrate the use of the Scheil data with a diffusion calculation.

Guidelines for Importing Data Files to Composition Profiles

The Composition Profiles settings are done on the Configuration window for a Diffusion 
Calculator. The profile is then previewed in the Visualizations window. 

You can import data from a file.  There are specific guidelines needed to correctly prepare 
the data in the file to ensure it imports without errors. 

Data File Requirements

The following are instructions about setting up the data file when Table input is selected for 
the Composition Profiles.

The data in the spreadsheet or csv file can include the distance and the compositions, plus 
the parameters defining the dependent component, composition unit, and length unit. In 
order for the data to be included in the calculation, the column and row definitions in the 
file must adhere to certain rules of entry.

Only the columns described here are read / used in the calculation. It is 
important to enter the information exactly as described. It is recommended 
that the data file is cleaned up before importing / loading it and performing 
calculations. 
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Figure 3: This is an example of data entered into an Excel spreadsheet (which is then converted to 
csv format). Columns A to D show the data entered to create the Composition Profile itself. 
Columns E, F, and G are to define default settings although these can also be defined on the 
Configuration window. 

Figure 4: Three columns in the spreadsheet correspond to settings that can either be entered on 
the Configuration window, or defined in the data file. This is for the dependent component 
(column E), composition unit (column F), and length unit (column G). When this information is not 
specified in the data file, the default is taken from the settings defined on the Configuration 
window.

Distance and Composition/Components Plus Values

General Rules

 l No abbreviations are allowed. 

 l All header text must be in English, i.e. no translations into other languages will be 
read correctly by the data file.

 l The composition columns MUST match what is already entered on the System 
Definer or the file will not load. 
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In the table, code font indicates something entered  into the data file (or it is 
an example) and any <text in italic with angle brackets> is a generic name for 
an entry. 

Column Heading Requirements and Options Row Cell Requirements  and Options

Distance 

This is column A as in Figure 3

Enter the text Distance. No abbreviations allowed but it is 
not case sensitive.

Valid  format and entries for each row in this column:

 l Any numerical input for the distance e.g. 
500, 0.15, 8.7,  1.00E-05, etc.

 

<Components / Composition>

These are columns B to D as in Figure 3

Each element of the composition is in a separate heading 
column using the <element short name>

This is already included in the table header on the 
Configuration window and based on the entries selected 
on the System Definer. 

Enter an <element short name> into each column, row 1. 
e.g. in this example, Mn, Cr, and Ti are entered in columns 
B, C, and D, respectively. Entries are not case sensitive, so 
alternatives in this example for Mn can be mn or MN.

Valid  format and entries for each row in these 
columns:

 l A number for the composition e.g. 0.15, 
8.7,  1.00E-05, etc.

The elements in the file must match 
what is selected on the System 
Definer. (1) If it is in the file but not 
selected on the System Definer, then 
it is not added to the table, and (2) if 
the opposite is true, that an element 
is selected on the System Definer but 
not included in the file, then an 
empty column is added and manually 
you must enter the details.  

Composition Unit, Length Unit, and Dependent Component

General Rules

 l The defaults can be selected on the Configuration window, or can be entered in its 
own column in the data file.  When this is not specified in the data file, the default is 
taken from the settings defined on the Configuration window. See Figure 4.

 l No abbreviations allowed but it is not case sensitive. For example, it is acceptable to 
enter composition_unit or Composition_Unit, or COMPOSITION_UNIT, etc.
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 l All header text must be in English, i.e. no translations into other languages will be 
read correctly by the data file. For example, do not add the accents to the A and O in 
the word Angstrom, e.g. Ångström cannot be read correctly. 

 l Do not enter anything in the rows in each of these columns. 

In the table, code font indicates something entered  into the data file (or it is 
an example) and any <text in italic with angle brackets> is a generic name for 
an entry. 

Column Heading Description Column Heading Requirements and Options

The Dependent component in the data file is defined with the 
heading dependent_component=<element> 

In Figure 4, this is in column E.

i.e. dependent_component=fe. Add the heading to its own 
column to set the Dependent component to Fe.

Valid format and entries of the <dependent_
component> (the text is added after the = sign): 

 l Any of the components/elements 
selected already on the System Definer 
can be entered.

The Composition unit in the data file is defined with the heading 
composition_unit=<unit>. 

In Figure 4, this is in column F.

i.e. composition_unit=mass_pct. Add the heading to its own 
column to set the Composition unit to Mass percent. 

Valid  format and entries of the <composition_
unit> (the text is added after the = sign):

 l mass_pct

 l mass_frac

 l mole_pct

 l mole_frac

The Length unit for the distance in the data file is defined with 
the heading length_unit=<unit>. 

In Figure 4, this is in column G.

i.e. length_unit=micrometer. Add the heading to its own 
column to set the Length unit for the distance to Micrometer. 

Valid  format and entries of the <length_unit> 
(the text is added after the = sign):

 l Meter

 l Millimeter

 l Micrometer

 l Nanometer

 l Angstrom
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Column Heading Description Column Heading Requirements and Options

Enter Angstrom 
without the accents 
on A and O, e.g. 
Ångström will not be 
read correctly. 

Diffusion Calculator Thermal Profile

The Thermal Profile is set up on the Configuration window for a Diffusion Calculator. The 
isothermal or non-isothermal profile is viewed in the Visualizations window. Choose 
Isothermal to do a simulation at constant temperature. Choose Non-isothermal to enter or 
import data for a user-defined temperature profile.

When connected to an AM Calculator (see Including Probe Data from an 
AM Calculator) the Isothermal and Non-isothermal options are not visible as it 
is not relevant to that view.

Isothermal Calculations

Many of the Graphical Mode examples for this Add-on Module are isothermal 
calculations, e.g. D_03_Diffusion_Multiphase.

 1. On the Diffusion Calculator Configuration window, first enter the required settings 
described in Conditions Tab Settings including the Region Settings, Boundary 
Conditions, and Composition Profiles. 

 2. Under Thermal Profile click to choose Isothermal to do a simulation at constant 
temperature. 

 3. Enter a Temperature and choose a unit (Kelvin, Celsius, or Fahrenheit. 

 4. Enter a Simulation time and choose a unit: Seconds, Minutes, Hours, or Days.

The Thermal Profile is displayed in the Visualizations window showing the constant 
temperature entered. 
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 5. For this calculation type this completes the settings you need to enter for the 
Thermal Profile. 

Non-isothermal Calculations

 1. On the Diffusion Calculator Configuration window, first enter the required settings 
described in Conditions Tab Settings including the Region Settings, Boundary 
Conditions, and Composition Profiles. 

 2. Under Thermal Profile click to choose Non-isothermal to enter or import data for a 
user-defined temperature profile. 

 3. Select a Temperature unit: Kelvin, Celsius, or Fahrenheit.

 4. Enter an End time and choose a unit: Seconds, Minutes, Hours, or Days. The 
Simulation time is displayed as text.
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You can next either directly enter Time and Temperature coordinates into the table 
or import the information from a file. A minimum of two points is required. 

 5. To enter data directly into the table: 

 a. Click in each cell under the applicable columns, Time and Temperature then 
directly enter the values in the table.  

 b. Press <Enter> to add rows and use the scroll bars to navigate the table.

 6. To import from a file:

 a. Although it is a simple set of data, prepare the data file as in Guidelines for 
Importing Data Files to Thermal Profiles.

 b. When the data file is ready, to the right of the Import from file field, click the 
file  button. 

 c. Navigate  to a data file such as an MS Excel spreadsheet (with *.xls or *.xlsx 
extensions) or a *.csv file. You can also use other programs (e.g. Google 
Sheets) to enter data and export to a CSV format that can be read by the 
software. Click Open to import the data to the Configuration window table. 

 d. If there are issues with the above import, experiment with choosing the 
delimiter type that corresponds to the data in the file: Comma (,), Colon (:), 
Equals sign (=), Semicolon (;), or Tab. Click the Reload button . The data is 
imported to the Configuration window table.

 7. For this calculation type this completes the settings you need to enter for the 
Thermal Profile, which  is displayed in the Visualizations window. Make adjustments 
to the settings as needed and watch it dynamically change in the window.
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This is from example D_04: Diffusion Fe-C Moving Boundary Austenite to Ferrite. 

Including Probe Data from an AM Calculator

When you also have a license for the Additive Manufacturing (AM) Module you 
can  include probe data from the AM Calculator in the set up of the thermal 
profile. 

There is connectivity between the Diffusion Module (DICTRA) or the  Precipitation Module 
(TC-PRISMA) and the Additive Manufacturing (AM) Module when you have full licenses 
available for all relevant Add-on Modules and databases. 

You can add a Diffusion Calculator or Precipitation Calculator as a successor to the 
AM Calculator and then when probes are included with the AM Calculator this data can be 
further used with the thermal profile. 

Details are in the AM Module documentation. See AM Calculator: Working with Probe Data.
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Guidelines for Importing Data Files to Thermal Profiles

The Thermal Profile settings are done on the Configuration window for a Diffusion 
Calculator. The profile is then previewed in the Visualizations window. 

You can import data from a file.  There are specific guidelines needed to correctly prepare 
the data in this file to ensure it imports without errors. 

Data File Requirements

For a Thermal Profile you can either directly enter Time and Temperature coordinates into 
the table on the Configuration window, or import the data from a file. A minimum of two 
points is required. 

Although there are only two columns to define, it is still important to ensure the file is set up 
correctly.  In order for the data to be included in the calculation, the column and row 
definitions in the file must adhere to certain rules of entry. 

GENERAL RULES

 l No abbreviations are allowed in the header.

 l A header is not actually required in this file but in order to know which column is 
which, it is recommended to include it. 

 l All header text must be in English, i.e. no translations into other languages will be 
read correctly by the data file.

Only the columns described here are read / used in the calculation. It is 
important to enter the information exactly as described. It is recommended 
that the data file is cleaned up before importing / loading it and performing 
calculations. 
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Figure 5: This is an example of data entered into an Excel spreadsheet (which is then converted to 
csv format). Columns A and B show the data entered to create the Thermal Profile. 

Figure 6: The units shown on the Configuration window for the Time and Temperature correspond 
to settings that can ONLY be selected on the Configuration window. The data file does not contain 
any information about the units.

Column Heading Requirements and Options Row Cell Requirements  and Options

Time

This is column A as in Figure 5

Enter the text Time. No abbreviations allowed but it is not 
case sensitive. It is also not required but recommended to 
include so you know which column of data it applies to.

Valid  format and entries for each row in this column:

 l Any numerical input for the time that 
corresponds to the unit selected on the 
Configuration window e.g. 0.0, 773, 1000,  
1500, are times in seconds, which is the unit 
chosen in the example shown in Figure 6.

Temperature

This is column B as in Figure 5

Enter the text Temperature. No abbreviations allowed but it 
is not case sensitive. It is also not required but 
recommended to include so you know which column of 
data it applies to.

Valid  format and entries for each row in these 
columns:

 l Any numerical input for the temperature 
that corresponds to the unit selected on the 
Configuration window e.g. 1173, 1050, 1075,  
are temperatures in Kelvin, which is the unit 
chosen in the example shown in Figure 6

 Options Tab Settings

The following settings are available on the Options tab for a Diffusion Calculator.
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You can change these settings locally for a specific Calculator or globally for 
some defaults in the Options window (a different location than the tab). 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode tab and the Diffusion node in the tree.

Global Settings: Diffusion Calculator.

The Diffusion Module (DICTRA) in Console Mode has commands to perform 
some of the settings also available on the Diffusion Calculator. Where possible 
the name of the command is indicated and includes a link to the topic. 

Simulation Conditions 

DEFAULT SOLVER

Choose the Default solver: Automatic or Homogenization. Select Homogenization to define 
the Homogenization Model Specific sections.

Classic and Homogenization Model Settings

The homogenization solver (called the homogenization model in Console 
Mode) is useful when you want to simulate long-range diffusion through a 
multiphase mixture, under the assumption that local equilibrium holds at each 
node point. 

TIME INTEGRATION METHOD

Automatic , Trapezoidal, or Euler backwards. 
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The default is Automatic where the default degree of implicity corresponds to trapezoidal 
(0.5) for classic and Euler Backward (1.0) for the homogenization model. If large fluctuations 
occur in the profiles it may be necessary to use the more stable but less accurate Euler 
backwards.

SAVE RESULTS ON FILE

Yes, No, or Every nth.. Select Every nth to enter a value in the field. 

This setting determines if the results are to be saved on file during the course of the 
simulation. Select:

 l Yes to always save on file.
 l No to never save on file.
 l Every nth. to save every nth time to file. Then enter an  integer value ranging from 0 

to 99.

USE FORCED STARTING VALUES IN EQUILIBRIUM CALCULATIONS

The default, Automatic, allows the software program to automatically use forced starting 
values to perform the equilibrium calculations. When a phase with an ordering contribution 
is entered into the simulation, for example the gamma-prime/FCC_l12 phase in Ni-base 
superalloys, forced starting values are automatically turned on. Or choose Yes or No.

DEFAULT DRIVING FORCE FOR PHASES ALLOWED TO FORM AT INTERFACES

Enter a value in the field. The required driving force (evaluated as DGM (ph)) to be used for 
determining whether an inactive phase is stable. DGM is the variable for the driving force 
that is already divided by RT, and it is dimensionless. The default is 1E-5.

Suffixes

Timestep Control

MAX RELATIVE ERROR

Enter a value in the field.  The default is 0.05.

MAX ABSOLUTE ERROR

Enter a value in the field. The default is 1.0E-5.
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TIMESTEP

Enter values in the fields.

This value is always in seconds.

 l Initial: What is used as the initial time step. The default is 1.0E-7.
 l Smallest allowed: The smallest time step allowed during the simulation. This is 

required when using the automatic procedure to determine the time step. The 
default is 1.0E-7.

 l Max % of simulation time: The default is 10.

FACTOR SPECIFYING THE MAXIMUM INCREASE IN THE TIME STEP TAKEN FROM ONE TIME 
STEP TO ANOTHER

For example, if 2 is entered the maximum time step is twice as long as the previous time 
step taken.

Enter a value in the field. The default is 2.  

THE TIMESTEP IS TO BE CONTROLLED BY THE PHASE INTERFACE DISPLACEMENT DURING THE 
SIMULATION

The default is Automatic. When a liquid phase is entered in a simulation this option is 
automatically turned on. Optionally choose Yes or No to set whether the time step is to be 
controlled by the phase interface displacement during the simulation.

Classic and Homogenization Model Settings

Classic Model Specific

ACTIVITY OR POTENTIAL

Use the  [activity or potential] of a component in order to find the correct tieline at the 
phase interface.
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Determines whether the program should use the potential or the activity of a component in 
order to find the correct tie-line at the phase interface. The potential or the activity is varied 
by the program and is set in order to reduce the degrees of freedom at the local equilibrium.

FLUX BALANCE EQUATION ACCURACY

Required accuracy during the solution of the flux balance equations. The default is 1.0E-16.

Homogenization Model Specific 

This section is available when Homogenization is selected (or automatically selected) as the 
Default solver. These settings are available on the Options tab.

HOMOGENIZATION FUNCTION

Several functions are available. The default is Rule of mixtures (upper Wiener bound). See 
About the Homogenization Functions.

USE GLOBAL MINIMIZATION

Select the checkbox for global minimization used in equilibrium calculations. In general, 
using global minimization significantly increases the simulation time, but there is also a 
significantly reduced risk for non-converged equilibrium calculations.

INTERPOLATION SCHEME

When the homogenization model is used, simulations are run using an implicit finite volume 
method to increase numerical stability. Because of this, and other factors, homogenization 
model simulations generally run slower than other comparable  simulations. You can reduce 
simulation time with the Use Interpolation scheme checkbox. The checkbox is selected by 
default.

DISCRETIZATION

[Logarithmic or Linear] discretization with [number of] steps in each dimension.
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 l For the linear discretization the scheme is not used at node points where the content 
of one or more solutes fall below a certain critical value. For such cases, where 
composition span many orders of magnitude, the logarithmic discretization can be 
tried.

 l Enter  the number of steps in composition space. In the limit where an infinite 
number of steps are used, exactly the same solution is obtained as without the 
interpolation scheme. However, excellent results can be obtained with a reasonable 
discretization. The default is 10000 steps.

MEMORY TO USE

This is the fraction of free physical memory to be used by the interpolation scheme.

Select Megabyte or Fraction of free and then enter a value in the field. 

About the Homogenization Functions

The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical 
shells of each phase. For the general lower Hashin-Shtrikman bound the outermost shell 
consists of the phase with the most sluggish kinetics and vice versa for the general upper 
bound. The geometrical interpretation of the Hashin-Shtrikman bounds suggest further 
varieties of the bounds, viz. Hashin-Shtrikman bound with prescribed matrix phase and 
Hashin-Shtrikman bound with majority phase as matrix phase, where the outermost shell 
consist of a prescribed phase or the phase with highest local volume fraction, respectively. 

The geometrical interpretation of the Wiener bounds are continuous layers of each phase 
either parallel with (upper bound) or orthogonal to (lower bound) the direction of diffusion.

The labyrinth factor functions (described below) are available in Console Mode 
and when using TC-Python. 

The labyrinth factor functions implies that all diffusion takes place in a single continuous 
matrix phase. The impeding effect on diffusion by phases dispersed in the matrix phase is 
taken into account by multiplying the flux with either the volume fraction (Labyrinth factor f 
with prescribed matrix phase), or the volume fraction squared (Labyrinth factor f**2 with 
prescribed matrix phase), of the matrix phase.

The varieties with excluded phases (described below)  are available in Console 
Mode and when using TC-Python. 
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The varieties with excluded phases are useful in several respects. First, if a phase is modeled 
as having zero solubility for a component, the mobility of that component in that phase is 
undefined, which causes a (non-terminal) error. Setting a phase as excluded causes the 
mobility of all components in that phase to be set to zero. Second, often there are some 
major matrix solid solution phases and some minor precipitate phases. If the mobilities in 
the minor precipitate phases are zero the lower Hashin-Shtrikman bound is useless as it 
produces a kinetic coefficient of zero. However, using General lower Hashin-Shtrikman 
bound with excluded phase(s)  the excluded phases are not considered when evaluating what 
phase has the most sluggish kinetics.

Pause, Resume, and Cancel Diffusion Calculations

Diffusion calculations are often complex  simulations that take some time to complete. 
Sometimes you may want or need to pause or resume a calculation, or make adjustments to 
your compositions and start again. 

Graphical Mode

In Graphical Mode, you pause and resume when you are on the Diffusion Calculator 
Configuration window. When pausing a Diffusion Calculator calculation, you can make 
changes to the Simulation time, Left Boundary Condition, and Right Boundary Condition. 
This is useful, for example, when simulating carburization, where it is common to first have a 
step with high carbon activity in the furnace for the actual carburization, and then lower it 
and allow the carbon in the specimen to diffuse without further increased carbon content. 

This is also available for the Precipitation Calculator (but not any other 
calculators). See Pause, Resume, and Cancel Precipitation Calculations.

HOW TO PAUSE AND RESUME A JOB
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 1. Run the job (i.e. click Perform Tree). In the Scheduler you can see the job listed and 
in the Event Log you can follow the progress of the calculation. 

 2. In the Project window, click the Diffusion Calculator node. 

 3. In the Configuration window at the bottom, click Pause. Observe that the Diffusion 
Calculator in the Project window has a pause indicator. If there are intermediate 
results available these are listed in the Event Log. 
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 4. As required, make changes to the settings: Left Boundary Condition, Right Boundary 
Condition, Temperature, and/or Simulation time. The rest of the Configuration 
window settings are grayed out and no other editing can be done while paused.

 5. When ready, click  Continue to resume your calculations from the last time step or 
click  Discard to discard the calculation (then click Yes or No on the window that 
opens).

HOW TO CANCEL A JOB
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 l In the Scheduler window, right-click the job you want to cancel and select Cancel 
Job.

Console Mode

In response to a command or a lengthy calculation, Thermo-Calc may display a lot of text in 
the Console window. Use these keyboard shortcuts to pause, resume, or stop a process.

 l To pause the text on printing press <Ctrl+S>. 
 l To resume the printing on screen, press <Ctrl+Q>.
 l When Thermo-Calc is performing a stepping or mapping operation, the results are 

continuously printed in the Console window. To stop the calculation of the current 
region of the mapping and stop the output, press <Ctrl-A> (Windows) or <Ctrl-C> 
(Linux).

Diffusion Calculator Plot Renderer

The following is information about the settings available in both Simplified and Advanced 
Mode for a Plot Renderer when it is a successor to a Diffusion Calculator. 

Conditions Tab Settings and Configuration Settings

Simple Mode

When you open the Diffusion Calculator Plot Renderer, it defaults to Simple Mode. Use the 
Advanced Mode to have more flexibility.

Use Simple Mode to define the most common axis variables. The software automatically 
sets the correct  Plot condition and Independent variable. 
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When you select Advanced Mode as the Plot type, this expands the variable 
options available from both the X-axis and Y-axis lists. Otherwise the axis 
variables default to the most logical combination.

X-AXIS VARIABLE

Select the variable for the X-axis: Distance or Time.

 l For Distance also choose a unit (m, μm, or nm) and what region to include. The list 
contains the regions defined on the Diffusion Calculator or you can choose All 
regions. 

 l For Time choose a unit (Seconds, Minutes, Hours, or Days).

Y-AXIS VARIABLE

Select the variable to plot on the Y-axis. The available options are based on choices such as 
whether Distance or Time is chosen for the X-axis, whether isothermal or non-isothermal is 
selected, whether there is a homogenization solver, or if there is one or more regions.

DISTANCE ALONG THE X-AXIS

If Distance is plotted along the X-axis, then by default the Composition is plotted along the 
Y-axis. 

 l From the center list, choose the component to plot, or select All. 
 l From the next list, choose the unit to be Mass percent, Mole percent, Mass fraction, 

Mole fraction, or u-fraction.

TIME ALONG THE X-AXIS (ONE REGION)
If Time is plotted along the X-axis, then choose the Y-axis variable to plot plus the additional 
settings:

 l Total phase fraction: By volume or By mass. Then select a phase from the list.
 l Total fraction of element: By mole or By mass. Then select a component from the 

list.
 l Total fraction of element in phase: By mole or By mass. Then select a component 
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and a phase from the lists.
 l For a non-isothermal thermal profile Temperature is available: Kelvin, Celsius, or 

Fahrenheit. 

DISTANCE ALONG THE X-AXIS (HOMOGENIZATION)
If Distance is plotted along the X-axis and a homogenization solver is being used, then 
choose  Composition or Phase fraction to plot on the Y-axis. Then select the applicable 
settings. 

 l Choose the component to plot, or select All and the unit Mass percent, Mole 
percent, Mass fraction, Mole fraction, or u-fraction.

 l Choose By mole or By mass then select a component from the list.

TIME ALONG THE X-AXIS (TWO OR MORE REGIONS)
If Time is plotted along the X-axis, then choose the Y-axis variable to plot plus the additional 
settings:

 l Total phase fraction: By volume or By mass. Then select a phase from the list.
 l Total fraction of element: By mole or By mass. Then select a component from the 

list.
 l Total fraction of element in phase: By mole or By mass. Then select a component 

and a phase from the lists.
 l Composition at interface: Mass percent, Mole percent, Mass fraction, or Mole 

fraction. Then choose a Region and whether it is Upper or Lower and a component. 
 l Position of interface: Choose a unit (m, μm, or nm) and the interface.
 l Velocity of interface: Choose a unit (m, μm, or nm) and the interface.
 l Width of region: Choose a unit (m, μm, or nm) and the interface.
 l For a Non-isothermal profile, Temperature is available. Choose a unit Kelvin, Celsius, 

or Fahrenheit.

AXIS TYPE

Select the type of axis scale: Linear, Logarithmic, Logarithmic 10, or Inverse.
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LIMITS

Specify the range along the axis to show in the plot. In the fields, enter the minimum and 
maximum values of the axis variable. You can also determine the step size between the tick 
marks along each axis. 

Select the Automatic scaling checkbox to allow the program to set the limits.

TIME

An alternative Time setting is available in Advanced Mode.

When the X-axis variable is Distance, choose a Time unit (Seconds, Minutes, Hours, or 
Days). Enter a numerical value.

ADD AND REMOVE AXES 

Use the Add an axis   and Remove this axis   buttons to add additional X- and/or Y-axes 
to a plot or to merge plots (to overlay one plot with another in the same diagram).

Advanced Mode

Use Advanced Mode to select any combination of axis variables, and then access further 
settings such as the Plot condition, Region, and Independent variable. Examples of 
advanced plot options are activity of a component at an interface, diffusivities, and diffusion 
paths. Also user-defined functions can be used as plot variables where Console Mode syntax 
is used to define functions. In some cases, sensible default values are selected, but they can 
be changed according to your needs. 

Plot Axis Settings in Advanced Mode
 l If any plot axis variable of the type Integral is selected, then the plot condition is set 

to Integral and the Independent variable is set to Time.
 l If a plot axis variable is set to Time then the plot condition is set to Time and the 

Independent variable is also set to Time.
 l If a plot axis variable is set to Distance then the plot condition is set to Distance or 

Interface and the Independent variable is set to Distance.
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Plot condition Independent Variable settings based on the Plot condition

Time: Choose a unit (Seconds, 
Minutes, Hours, or Days). Enter 
a numerical value.

The default is Distance: Choose a Global or Local distance. A Global distance is 
counted from the rightmost interface of the system. A Local distance is counted 
from the lower interface of the Region selected.

You can also choose Time, which requires no further settings.

Distance: Choose a specific 
Region from the list or use the 
default All regions. 

The default is Time and there are no further settings.

You can also choose a Global or LocalDistance. A Global distance is counted from 
the rightmost interface of the system. A Local distance is counted from the lower 
interface of the Region selected.

Interface: From the lists choose 
a Region  and whether it is the 
Upper or Lower region.

The default is Distance: Choose a Global or Local distance. A Global distance is 
counted from the rightmost interface of the system. A Local distance is counted 
from the lower interface of the Region selected.

You can also choose Time, which requires no further settings.

Integral

The default is Time and there are no further settings.

You can also choose a Global or LocalDistance. A Global distance is counted from 
the rightmost interface of the system. A Local distance is counted from the lower 
interface of the Region selected.
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Precipitation Calculator

The Precipitation Calculator is available with three elements if you do not have 
the additional Precipitation Module (TC-PRISMA) license. With the Add-on 
Module you can use all available elements. See Available Options for details 
about this and other options available with additional licenses.

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation 
calculation. You can add the calculator to the System Definer directly (right-click and select it 
from the Create New Successor menu)

There is also a Precipitation template available under Non-Equilibrium that you 
can use to quickly set up a simulation. See Getting Started Links and Templates.

Once you have added a Precipitation Calculator, the Configuration window has Conditions 
and Options settings tabs where there are many available conditions to set and then 
continue the settings with the specialized Plot Renderer.

Conditions

Set the conditions for your calculation that define the Matrix phase and Precipitate phase. 
Choose the Calculation Type. 

Matrix Phase Settings

Precipitate Phase Settings

Calculation Type Settings

Options

Modify Numerical Parameters that determine how the conditions are calculated.  

Options Tab
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Plot Renderer

There are also unique settings available for this calculator once you add a Precipitation 
Calculator Plot Renderer.

Working with these simulations is an advanced topic. It is recommended you 
review the  documentation and videos available or search for a specific topic. 

Precipitation Module (TC-PRISMA) Examples Collection

Available Options

The Precipitation Module, previously referred to as TC-PRISMA, is an Add-on Module to the 
core Thermo-Calc software. 

A separate license is required to perform calculations for more than three 
elements. Without it you are able to use the module in Demo Mode. 

Precipitation Template

A Precipitation template under Non-Equilibrium Calculations is available to all Thermo-Calc 
users when in Graphical Mode. If you are in DEMO mode then  this is indicated by the 
addition of DEMO text.

USING THE TEMPLATE

After opening Thermo-Calc in Graphical Mode,  in the templates section under Non-
Equilibrium, click the Precipitation button to add a System Definer, Precipitation Calculator, 
and Plot Renderer to the Project tree.
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Creating a Project from a Template  

Precipitation Calculator

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation 
calculation. 

Demo Database Packages for the Examples Collection

Both a thermodynamic and mobility database are required to run the Precipitation Module 
simulation.   If you have a Precipitation Module (TC-PRISMA) license you can run all the 
examples as the demonstration database packages are included with your installation. Select 
the database packages from the System Definer → Configuration window to run a 
simulation. 

Demonstration (Demo) Mode

The Precipitation Module, and some examples, are available to all Thermo-Calc users but 
only for simulations of alloys with up to three elements. If you do not have a license for the 
Precipitation Module then you are in Demonstration Mode when using the Precipitation 
Calculator or Precipitation Simulation template. 
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A Precipitation template under Non-Equilibrium Calculations is available to all Thermo-Calc 
users when in Graphical Mode. If you are in DEMO mode then  this is indicated by the 
addition of DEMO text.

PRECIPITATION CALCULATOR

If you are experimenting with the Precipitation Calculator in Demo Mode, you may have 
access to a variety of databases based on your license. However, you can only define up to 
three elements for a demo simulation. 

If you define more than three elements on the System Definer, when you go to the 
Precipitation Calculator, the Perform button is unavailable and the tooltip explains why. In 
this case one of the chosen elements needs to be removed and then the Perform button is 
made available.

Even if you have more than three elements, the Plot Renderer or Table 
Renderer Perform button is still available. However, if you click the button and 
try to run the simulation the Event Log displays an error message.

Additive Manufacturing (AM) Module

There is connectivity between the Diffusion Module (DICTRA) or the  Precipitation Module 
(TC-PRISMA) and the Additive Manufacturing (AM) Module when you have full licenses 
available for all relevant Add-on Modules and databases. 

You can add a Diffusion Calculator or Precipitation Calculator as a successor to the 
AM Calculator and then when probes are included with the AM Calculator this data can be 
further used with the thermal profile. 

Details are in the AM Module documentation. See AM Calculator: Working with Probe Data.

Define the Precipitation Calculator

 1. Add a Precipitation Calculator node to the System Definer. If you used the 
Precipitation template (on the  My Projects Configuration window under Non-
Equilibrium), click the node to display the Configuration settings window. 
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 2. In the Precipitation Calculator Configuration window, enter the settings on the 
Conditions and Options tabs. These are described separately:

 l Matrix Phase
 l Precipitate Phase
 l Calculation Type and Precipitation Calculator Thermal Profile
 l Options Tab Advanced Settings

 3. Once you have finished defining the Precipitation Calculator, you also choose settings 
on the Plot Renderer. Some additional settings are specific to the Precipitation 
Calculator Plot Renderer.

Matrix Phase Settings

Below are details about the settings available for the Composition and Matrix Phase, which 
is selected from the Conditions tab on the calculator Configuration window.

There are additional Conditions tab settings described for the Precipitate Phase 
and Calculation Type.

This is the three distinct settings areas for the Configuration window for example P_04_
Precipitation_Fe-C_Cemetite.tcu. In this case, Show Details is expanded to show the Precipitate 
Phase settings.

You can change these settings locally for a specific Calculator or globally for 
some defaults in the Options window (a different location than the tab). 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.
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then click the Graphical Mode tab and the Precipitation node in the tree.

SHOW OR HIDE DETAILS

Click Show Details to view some of the additional settings listed below. You can also set the 
default to display in Phase view mode on the Options window then click the Graphical 
Mode tab and  the Precipitation node in the tree. Click Hide Details to hide the information.

Composition Settings

COMPOSITION UNIT

Select the Composition unit: Mass percent, Mole percent, Mass fraction, or Mole fraction.

Matrix Phase Settings

Selecting the Disordered Phase as a Matrix Phase 

PHASE

Only phases with kinetic data can be selected as the matrix phase. If the list is 
empty, go to the System Definer to confirm that both thermodynamic and 
kinetic databases are selected and defined.

Choose a Phase from the list. The list is based on the settings for the System Definer. When 
setting up a system, choose a matrix phase with kinetic data available in the database.

ELASTIC PROPERTIES

Choose Disregard to ignore the elastic properties.

Default elastic constants for Isotropic or Cubic are based on the major element of the alloy 
system. The elastic properties can affect nucleation rate, nuclei size, and particle shape.

 l For Isotropic, enter values for Shear modulus (in GPa) and Poisson's ratio as 
required.

 l For Cubic, enter values for c11, c12, and c44 as required.  are the elastic 
constants.
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MOLAR VOLUME

Use the Database value (if the molar volume for the phase is defined in the thermodynamic 
database) or select User-defined to enter another value in m3/mol.

If you select the Grain growth checkbox, see the separate Grain Growth 
Settings section for details.

GRAIN SIZE

If the Grain growth checkbox is NOT selected then this version of the Grain size 
section is available in order for the Average diameter of the grain size to be 
entered.

Grain size is the "diameter" of a grain. The Grain size value changes the available nucleation 
sites when Grain boundaries, Grain edges, or Grain corners is selected along with Calculate 
from matrix settings in the Precipitate Phase. Enter a numerical value and choose a unit 
from the list. The default is 1.0E-4 m.

GRAIN ASPECT RATIO

For an elongated grain with a minor axis and a major axis, one may use the minor axis as 
grain size and the major/minor ratio as the grain aspect ratio to characterize the grain. The 
Grain aspect ratio value also changes the available nucleation sites when Grain boundaries, 
Grain edges, or Grain corners is selected along with Calculate from matrix settings in the 
Precipitate Phase. Enter a numerical value. The default is 1.0.

If the Grain growth checkbox is selected, the aspect ratio is fixed at 1.0 and can 
not be changed. See Grain Growth Settings.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 221 of 763

DISLOCATION DENSITY

The Dislocation density value changes the available nucleation sites when Dislocations is 
selected along with Calculate from matrix settings in the Precipitate Phase. Enter a 
numerical value. The default is 5.0E12 m-2.

MOBILITY ADJUSTMENT

The Mobility adjustment parameters modify the atomic mobility data from a database. 

Choose  Same for all elements, which  applies the adjustment to all elements, or Per element 
to adjust to each individual element. Then for the following settings, enter one set of values 
for Same for all elements, or individually for Per element.

 l Prefactor (unitless) is a parameter that multiplies to the mobility data from a 
database. This value scales the mobility by a constant amount. This can be useful, for 
example, when the material has a higher than normal vacancy concentration at the 
start of the precipitation simulation. (e.g. from a prior solutionizing and quenching 
treatment).

 l The Activation energy (J/mol) is a value that adds to the activation energy of mobility 
data from a database. This value scales the mobility by a temperature-dependent 
amount. Similar usage as the Mobility adjustment >Prefactor setting.

Grain Growth Settings

GRAIN GROWTH

Select the Grain growth checkbox to use this to calculate the temporal evolution of grain 
size distribution (GSD). The grains are assumed of spherical morphology when modeling the 
growth rates. Nucleation is not considered, thus an initial GSD is necessary to start the 
simulation.

After selecting the checkbox, there are additional settings made available as described in 
this section.

This checkbox is not available when a TTT diagram or CCT diagram Calculation 
Type is selected. 
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GRAIN SIZE >> GRAIN SIZE DISTRIBUTION

When the Grain growth checkbox is selected, then this version of the Grain size settings 
section is available. This is where you access the grain Size distribution settings.

Click Edit grain size distribution to open the Size distribution settings window. In this 
window, you can edit the parameters and generate a graph comparing the radius and 
number density for initial grains.

Select a Length unit: Meter, Micrometer, Nanometer, or Ångström.

Select a Distribution: Normal, Log normal, or From file.

 l If Normal or Log normal is selected, enter values for Mean radius and Std (standard 
deviation). The default Std is different for each choice.

 l If Hillert is selected, enter a value for the Mean radius.
 l If From file is selected, click Import and navigate to the file containing the required 

information and click Open. This file can be in .xls, .xlsx, .csv or .txt formats. The file 
should consist of two columns with values where the first column contains radius 
data and the second contains number density data.

A similar setup can also be found in  the Particle Size Distribution (PSD).

Once the size distribution is defined, click Generate to view or update the graph comparing 
the radius and number density for initial grains.

GRAIN BOUNDARY ENERGY

This setting is available when the Grain growth checkbox is selected.

Enter a value for the Grain boundary energy. The default is 0.5 J/m2.

GRAIN BOUNDARY MOBILITY

This setting is available when the Grain growth checkbox is selected.

The Prefactor (m4/Js) is a parameter that represents the magnitude of the grain boundary 
motion.

The Activation energy (J/mol) is a parameter that describes the temperature dependence of 
the grain boundary mobility.
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ZENER PINNING

This setting is available when the Grain growth checkbox is selected. 

Select the Zenner pinning checkbox to consider the effect of precipitates on inhibiting 
normal grain growth. When this checkbox is selected, there are additional settings available 
in the Precipitate Phase section.

P_14: Grain Growth and the Zener Pinning Effect

Selecting the Disordered Phase as a Matrix Phase 

The following information is about using disordered FCC as a matrix phase with the following 
thermodynamic and mobility database packages:

 l TCCU and MOBCU (Cu-based alloys)
 l TCNI and MOBNI (Ni-based alloys)

In the TCNI/MOBNI and TCCU/MOBCU packages, the well-known order/disorder two-
sublattice model is used to describe the Gibbs energy of both FCC_A1 and FCC_L12. With 
this treatment, FCC_L12 is becoming FCC_A1 if the site fractions of each element on both 
sublattices are identical, which means that FCC_A1 is only a special case of FCC_L12. 
Therefore, FCC_A1 is not shown in the phase list on the Phases and Phase Constitution tab 
on the System Definer activity and in subsequent equilibrium calculation results. Instead it is 
shown only as FCC_L12. The real ordered FCC_L12 is shown as FCC_L12#2.

In precipitation simulations, the matrix phase is quite often the disordered FCC phase. You 
can directly select FCC_L12 as the matrix phase and run a simulation. However, the speed is 
not  optimal due to the sophisticated model used for both Gibbs energy and atomic 
mobilities. A better and more convenient way is to deselect FCC_L12 and FCC_L12#2 from 
the phase list on the Phases and Phase Constitution tab on the System Definer if the ordered 
phase is irrelevant in the alloy under investigation, such as in most  Cu alloys. Once these are 
unchecked (i.e. not selected), the FCC_A1 phase is available and can later be selected as the 
matrix phase.

For Ni-based superalloys using the TCNI/MOBNI package, the ordered FCC_L12#2 (gamma 
prime) has to be included as the precipitate phase in most of calculations. In this case, you 
can select DIS_FCC_A1 from the phase list on the Phases and Phase Constitution tab and 
then select it as the matrix phase in the Precipitation Calculator.
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Precipitate Phase Settings

Below are details about the settings for the Precipitate Phase, which is selected from the 
Conditions tab on the Precipitation Calculator Configuration window.

There are additional Conditions tab settings described for the Matrix Phase and 
Calculation Type.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode tab and the Precipitation node in the tree.

SHOW OR HIDE DETAILS

Click Show Details to view some of the additional settings listed below. You can also set the 
default to display in Phase view mode on the Options window then click the Graphical 
Mode tab and  the Precipitation node in the tree. Click Hide Details to hide the information.

PHASE

The phases available to choose have both thermodynamic and kinetic data. If 
the list is empty, go to the System Definer to confirm that both types of 
databases are selected and defined.

Choose a Phase from the list. The list is based on the System Definer settings.

NUCLEATION SITES

The number of different nucleation sites is dependent on the shape and size of grains in the 
matrix. Grain size is the "diameter" of a grain. Choose one of the following from the list.
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 l Bulk, Grain boundaries,  Grain edges, Grain corners, or Dislocations.
 l For Grain boundaries, Grain edges, and Grain corners, enter the Wetting angle (0-

90) in addition to the matrix settings. Wetting angle defines the deviation from 
spherical shape (or dihedral angle).

Click to select the Calculate from matrix settings checkbox to calculate the initial number 
density of sites from the matrix grain size or dislocation density.

To enter a specific value for the number of Nucleation sites, click to clear the checkbox.

INTERFACIAL ENERGY

Choose Calculated to use the estimated value. To adjust the estimate, enter a different 
prefactor or choose User-defined to enter a value in J/m2. For the User-defined option, you 
can also enter it as a function of radius (r) and temperature (T).

GROWTH RATE MODEL

Select Simplified, General, Advanced, Para-eq, NPLE, or PE Automatic (where Para-eq and 
PE are both abbreviations for paraequilibrium).

All models treat a particle (precipitate) of stoichiometric composition or with 
negligible atomic diffusivity. Except for the PE Automatic model, local 
equilibrium or paraequilibrium at the precipitate-matrix interface is assumed. 
The PE Automatic model enables smooth transition from paraequilibrium to 
local equilibrium.

In the documentation and on the GUI, the abbreviations Para-eq and PE are 
both used for paraequilibrium. There is also the use of OE as an abbreviation 
for ortho-equilibrium and LE for local equilibrium. 

MORPHOLOGY

Choose the particle shape: Sphere (default), Cuboid, Plate, or Needle. Options are based on 
the Elastic properties selected for the Matrix phase:
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 l For a Cubic elastic property,  Sphere, Plate, Needle, and Cuboid are available.
 l For an Isotropic  elastic property, Sphere, Plate and Needle are available.

For Plate or Needle, select the Calculate aspect ratio from elastic energy checkbox or enter 
a numerical value in the Aspect ratio field to provide a constant aspect ratio.

Figure 7: The cuboid shape is described by a supersphere. Cuboids have six faces, which form a 
convex polyhedron.

Figure 8: The plate is described as oblate spheroid. Oblate spheroids have rotational symmetry 
around an axis from pole to pole.

Figure 9: The needle shape is described as prolate spheroid. A prolate spheroid is a surface of 
revolution obtained by rotating an ellipse about its major axis.
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TRANSFORMATION STRAIN

Choose Disregard to ignore the transformation strain. When Isotropic or Cubic is chosen in 
Elastic properties in Matrix Phase, you can also choose Calculated from molar volume to 
obtain a purely dilatational strain. If Plate or Needle is selected as the Morphology, you can 
alternatively choose User-defined and enter the properties for ε11, ε12, ε13, ε22, ε23, and 
ε33.

MOLAR VOLUME

Use the Database value (if the phase molar volume is defined in the thermodynamic 
database) or select User-defined to enter another value.

ZENER PINNING PARAMETERS

These parameters are available when the Zener pinning checkbox is selected under the 
Matrix Phase settings.  These settings are to consider the effect of precipitates on inhibiting 
normal grain growth. 

 l Cutoff size: Precipitates with radius smaller than this value are neglected in pinning 
force calculation. Default value : 7 x 10-7 m.

 l Kinetic prefactor: Dimensionless kinetic coefficient in Zener equation. Default value: 
0.5.

 l Exponent: Exponent of precipitate volume fraction in Zener equation. Default value: 
0.93.

P_14: Grain Growth and the Zener Pinning Effect

PHASE BOUNDARY MOBILITY

A parameter that accounts for interface-controlled growth. Only effective if a very small, 
positive value is used. Use with caution due to a tentative treatment.

TRANS-INTERFACE MOBILITY ADJUSTMENT

This setting is available when PE Automatic Growth rate model is selected.
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The Trans-Interface mobility adjustment parameters modify the atomic mobility data from 
a database. 

Choose  Same for all elements, which  applies the adjustment to all elements, or Per element 
to adjust to each individual element. 

The transition kinetics from Para-Equilibrium (PE) to Ortho-Equilibrium (OE) is 
controlled by the ratio of atomic mobility of substitutional elements to that of 
interstitial elements. This implies that the option of Same for all elements—
while useful to the case that the atomic mobility data for all elements are 
needed to be scaled with the same factor to match experimental trans-
interface mobility data—does not change the PE-OE transition kinetics. 
Therefore, the change of transition kinetics separately requires adjustment of 
individual elements, which is when the Per element setting is useful.

Then for the following settings, enter one set of values for Same for all elements, or 
individually for Per element:

 l Prefactor (unitless) is a parameter that multiplies to the mobility data from a 
database. This value scales the mobility by a constant amount.  This results in the 
trans-interface mobility that controls the kinetics of Para-Equilibrium (PE) to Ortho-
Equilibrium (OE) transition.

 l The Activation energy (J/mol) is a value that adds to the activation energy of mobility 
data from a database. This value scales the mobility by a temperature-dependent 
amount. Similar usage as the Trans-Interface mobility adjustment >Prefactor 
setting.

PHASE ENERGY ADDITION

An energy value that adds to the Gibbs free energy of the precipitate phase from a database.

APPROXIMATE DRIVING FORCE

Select the checkbox to include this if simulations with several compositions sets of the same 
phase create problems.
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PREEXISTING SIZE DISTRIBUTION

Select the checkbox to include this. Click Edit particle size distribution to open the 
Preexisting Particle Size Distribution window where you can edit the parameters and view a 
graph comparing the radius and number density for the selected component.

Press F1 and search for "Particle Size Distribution (PSD)" for detailed 
instructions.

Precipitation Calculator Thermal Profile

The Thermal Profile is set up on the Configuration window for a Precipitation Calculator. 
The isothermal or non-isothermal profile is viewed in the Visualizations window. Choose 
Isothermal to do a simulation at constant temperature. Choose Non-isothermal to enter or 
import data for a user-defined temperature profile.

When connected to an AM Calculator (see Including Probe Data from an 
AM Calculator) the Isothermal and Non-isothermal options are not visible as it 
is not relevant to that view.

Isothermal Calculations

Many of the Graphical Mode examples for this Add-on Module are isothermal 
calculations, e.g. P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6.

 1. On the Precipitation Calculator Configuration window, first enter the required Matrix 
Phase and Precipitate Phase settings. 

 2. Under Calculation Type, click to choose Isothermal to do a simulation at constant 
temperature. 

 3. Enter a Temperature and choose a unit (Kelvin, Celsius, or Fahrenheit). 

 4. Enter an End time and choose a unit: Seconds, Minutes, Hours, or Days. The 
Simulation time is displayed as text.

The profile is displayed on the Precipitation Calculator tab in the Visualizations 
window showing the constant temperature entered. 
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 5. For this calculation type this completes the settings you need to enter for the 
Thermal Profile. 

Non-isothermal Calculations

 1. On the Precipitation Calculator Configuration window, first enter the required Matrix 
Phase and Precipitate Phase settings. 

 2. Under Calculation Type, click to choose Non-isothermal to enter or import data for a 
user-defined temperature profile. 

 3. Select a Temperature unit: Kelvin, Celsius, or Fahrenheit.

 4. Enter an End time and choose a unit: Seconds, Minutes, Hours, or Days. The 
Simulation time is displayed as text.
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You can next either directly enter Time and Temperature coordinates into the table 
or import the information from a file. A minimum of two points is required. 

 5. To enter directly into the table:

 a. Click in each cell under the applicable columns, Time and Temperature then 
directly enter the values in the table.  

 b. Press <Enter> to add rows and use the scroll bars to navigate the table.

 6. To import a data file:

 a. Although it is a simple set of data, prepare the data file as in Guidelines for 
Importing Data Files to Thermal Profiles.

 b. When the data file is ready, to the right of the Import from file field, click the 
file  button. 

 c. Navigate  to a data file such as an MS Excel spreadsheet (with *.xls or *.xlsx 
extensions) or a *.csv file. You can also use other programs (e.g. Google 
Sheets) to enter data and export to a CSV format that can be read by the 
software. Click Open to import the data to the Configuration window table. 

 d. If there are issues with the above import, experiment with choosing the 
delimiter type that corresponds to the data in the file: Comma (,), Colon (:), 
Equals sign (=), Semicolon (;), or Tab. Click the Reload button . The data is 
imported to the Configuration window table.

 7. For this calculation type this completes the settings you need to enter for the profile, 
which is displayed on the Precipitation Calculator tab in the Visualizations window. 
Make adjustments to the settings as needed and watch it dynamically change in the 
window.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 232 of 763

This is from the non-isothermal calculation example, P_06_Precipitation_
Ni-Al-Cr_Non-isothermal_Gamma-Gamma_prime.

Including Probe Data from an AM Calculator

When you also have a license for the Additive Manufacturing (AM) Module you 
can  include probe data from the AM Calculator in the set up of the thermal 
profile. 

There is connectivity between the Diffusion Module (DICTRA) or the  Precipitation Module 
(TC-PRISMA) and the Additive Manufacturing (AM) Module when you have full licenses 
available for all relevant Add-on Modules and databases. 

You can add a Diffusion Calculator or Precipitation Calculator as a successor to the 
AM Calculator and then when probes are included with the AM Calculator this data can be 
further used with the thermal profile. 
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Details are in the AM Module documentation. See AM Calculator: Working with Probe Data.

Guidelines for Importing Data Files to Thermal Profiles

The Thermal Profile settings are done on the Configuration window for a Precipitation 
Calculator. The profile is then previewed in the Visualizations window. 

You can import data from a file.  There are specific guidelines needed to correctly prepare 
the data in this file to ensure it imports without errors. 

Data File Requirements

For a Thermal Profile you can either directly enter Time and Temperature coordinates into 
the table on the Configuration window, or import the data from a file. A minimum of two 
points is required. 

Although there are only two columns to define, it is still important to ensure the file is set up 
correctly.  In order for the data to be included in the calculation, the column and row 
definitions in the file must adhere to certain rules of entry. 

GENERAL RULES

 l No abbreviations are allowed in the header.

 l A header is not actually required in this file but in order to know which column is 
which, it is recommended to include it. 

 l All header text must be in English, i.e. no translations into other languages will be 
read correctly by the data file.

Only the columns described here are read / used in the calculation. It is 
important to enter the information exactly as described. It is recommended 
that the data file is cleaned up before importing / loading it and performing 
calculations. 
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Figure 10: This is an example of data entered into an Excel spreadsheet (which is then converted 
to csv format). Columns A and B show the data entered to create the Thermal Profile. 

 

Figure 11: The units shown on the Configuration window for the Time and Temperature 
correspond to settings that can ONLY be selected on the Configuration window. The data file does 
not contain any information about the units.

Column Heading Requirements and Options Row Cell Requirements  and Options

Time

This is column A as in Figure 10

Enter the text Time. No abbreviations allowed but it is not 
case sensitive. It is also not required but recommended to 
include so you know which column of data it applies to.

Valid  format and entries for each row in this column:

 l Any numerical input for the time that 
corresponds to the unit selected on the 
Configuration window e.g. 0.0, 773, 1000,  
1500, are times in seconds, which is the unit 
chosen in the example shown in Figure 11.

Temperature

This is column B as in Figure 10

Enter the text Temperature. No abbreviations allowed but it 
is not case sensitive. It is also not required but 
recommended to include so you know which column of 
data it applies to.

Valid  format and entries for each row in these 
columns:

 l Any numerical input for the temperature 
that corresponds to the unit selected on the 
Configuration window e.g. 1173, 1050, 1075,  
are temperatures in Celsius, which is the 
unit chosen in the example shown in Figure 
11

Particle Size Distribution (PSD)

P_10: Initial Particle Size Distribution of Fe-Cr-C

On the Precipitation Calculator you can set the pre-exisiting particle size distribution 
(PSD) parameters in the Show Details section. The size distribution can be generated from a 
probability distribution function, by importing a file, calibrating a probability distribution 
function to experimental data, or by manually entering information into a table. Uni-modal 
distributions can be created within the Graphical Mode interface. Pre-existing multimodal 
distributions can be loaded from a file. 
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Accessing the 'Preexisting Size Distribution' Settings

 1. To the right of the Precipitate Phase settings fields, click Show Details.

 2. At the bottom of the Precipitate Phase section, click to select the Preexisting size 
distribution checkbox. Then click Edit Particle Size Distribution.

 3. The Preexisting Particle Size Distribution window opens as shown for example P_10 
CEMENTITE phase.
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Defining the Preexisting Size Distribution

Compositions

Choose a Dependent component from the list and enter the composition for the other 
component.

Size Distribution Settings

Length Unit

Choose a Length unit: Meter, Micrometer, Nanometer, or Ångström.

Amount of Phase

For all options, choose an Amount of phase: Volume percent or Volume fraction and then 
enter a number in the field.

Input Type

Choose an Input type: Generate 3D PSD from distribution function, From File, or 
Approximate the 3D PSD from experimental data. See the following sections for the details 
about each setting.

Generate 3D PSD from Distribution Function

This option allows the generation of the size distribution from a list of probability 
distribution functions. The Distribution types include LSW, Normal, Log normal, and 
Weibull. 

 l Mean radius The mean particle radius. 
 l Sigma The standard deviation for the chosen length unit. 
 l Alpha A dimensionless shape factor that should vary between 1.5 and 10. 
 l Fraction offset The fraction offset applied to the mean radius to shift the start of the 

distribution. This must be greater than or equal to zero, and less than 0.95.

Once the Distribution is defined, click Generate to create the size distribution.
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You can also click in the table to manually enter numbers into the cells rather than use one 
of the provided probability distribution functions. The radius values must monotonically 
increase in size.

From File

This option lets you load the initial size distribution from a file. Click Import and navigate to 
the file containing the required information and click Open. This file can be in .xls, .xlsx, .csv, 
or .txt formats. The file should consist of two columns with values where the first column 
contains radius data and the second contains number density data. 

The example P_10 (available from the Example files → Precipitation Module - 
TC-PRISMA  folder) shows this for the precipitate phase M23C6. There is also a 
file in this folder called P_10_Precipitation_Initial_PSD_FeCrC_psd_3D_
M23C6.csv that is an example of a correctly formatted text file. 

The imported size distribution is normalized into a probability distribution function by 
ensuring that the zeroth moment is unity. If you wish to import a histogram that has un-
even bin spacing, it is necessary to convert the Y-axis counts of the histogram to a count 
density first to avoid changes to the shape of the distribution. The count density is obtained 
simply by dividing the count of a bin by the bin's width. 

Approximate the 3D PSD from Experimental Data

The Approximate the 3D PSD from experimental dataInput type allows you to calibrate a 
continuous probability distribution function to an experimentally measured size distribution, 
and account for stereological considerations. There are additional settings related to this. 

DIMENSIONALITY OF EXP. DATA AND IMPORT EXP. DATA

The Dimensionality of exp. data setting must be defined. 
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 l For precipitate radius measurements that are a good approximation of the 3D size of 
the particles, select 3D. Measurements from quantitative image analysis of 
Transmission Electron Micrographs (TEM) provide 3D size data, however the 
precipitates can still be truncated within the TEM sample foil thickness. 

 l 2D data is obtained from a cross section taken through the microstructure. Examples 
include micrographs taken from Scanning Electron Microscopy (SEM), and Optical 
Microscopy (OM). The radius measurements are obtained from calculating the 
equivalent radius of a circle from the areas of identified objects from quantitative 
image analysis of the micrographs. It is possible that the samples of interest are over-
etched, revealing the full size of the precipitates. In this case the data may be more 
descriptive of the 3D size, however smaller particles are removed by the etching, 
distorting the obtained size distribution.

 l 1D data is obtained from applying the linear intercept method to micrographs 
descriptive of a cross section through the dispersion. A half-linear intercept is used in 
this calculation, which is analogous to the radius of the particle, opposed to the 
diameter. 

Click Import exp. data to import the experimental data. Navigate to the file containing the 
required information and click Open. This file can be in .xls, .xlsx, .csv, or .txt formats.  The 
file should consist of two columns with values where the first column contains radius data 
and the second contains number density data. 

The example P_10 (available from the Example files → Precipitation Module - 
TC-PRISMA  folder) shows this for the precipitate phase M7C3. There is also a 
file in this folder called P_10_Precipitation_Initial_PSD_FeCrC_psd_1D_
M7C3.csv that is an example of a correctly formatted text file. 

DISTRIBUTION

Choose a Distribution: LSW (Lifshitz-Slyozov-Wagner), Normal, Log normal, or Weibull. 

Click Generate to calibrate the chosen Distribution to capture the Import exp. data 
accounting for the chosen stereological Dimensionality of exp. data.

For 3D data, there are two datasets shown in the preview; the experimental data and the 3D 
model data. For 2D and 1D data, the sectioned model data is also shown and compared with 
the experimental data
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The Optimization error is output into the text-field highlighted below. This can be used to 
determine the best distribution type to use for a given dataset.

Calculation Type Settings

Below are details about the settings for the Calculation Type, which is selected from the 
Conditions tab on the Precipitation Calculator Configuration window.

There are additional Conditions tab settings described for the Matrix Phase and 
Precipitate Phase.
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ISOTHERMAL

Use an Isothermal calculation type to do a simulation at constant temperature. 

These settings are described in the section for the Precipitation Calculator 
Thermal Profile.

NON-ISOTHERMAL

Use a Non-isothermal calculation type to do a simulation with a user-defined temperature 
profile. You can enter information directly or import a data file.

These settings are described for the Precipitation Calculator Thermal Profile 
including information about importing data files.

When you also have a license for the Additive Manufacturing (AM) Module you 
can  include probe data from the AM Calculator in the set up of the thermal 
profile. 

TTT DIAGRAM

Use a TTT-diagram to calculate the time-temperature-transformation (TTT) curve for the 
formation of the precipitate phase.

 l Temperature: Enter Min, Max, and Step numerical values   and choose a temperature 
Unit.

 l Max annealing time: Enter a numerical value and choose a time Unit.
 l Stop criteria: Choose Volume fraction of phase or % of equilibrium fraction and 

then enter a numerical value. For each temperature, the simulation stops when the 
stop criteria is fulfilled or if the maximum annealing time is reached, whichever 
happens first.

See example P_03: Stable and Metastable Carbides - TTT Diagram
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CCT DIAGRAM

Use a CCT-diagram to calculate the continuous-cooling-transformation (CCT) curve for 
precipitation.

 l Temperature: Enter Min and Max numerical values and choose a temperature Unit.
 l Cooling rate(s): Enter a range of values in the field, e.g..01 .1 1 10 100. These 

values are equal to K/s, °C/s or °F/s per second based on the temperature Unit 
selected.

 l Stop criteria: Enter a numerical value for the Volume fraction of phase. For each 
temperature, the simulation stops when the stop criteria is fulfilled.

See example P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-
Cr γ-γ’.

Options Tab

The Precipitation Calculator  settings including the section Numerical Parameters are located 
on the Configuration window → Options tab.

You can change these settings locally for a specific Precipitation Calculator or 
globally for some defaults in the Options window settings. 

Preprocess Equilibrium  Data

Select the Preprocess equilibrium data checkbox to calculate the required phase 
equilibrium properties as a function of temperature for stable and metastable conditions. 
This speeds up the computation time of non-isothermal simulations or isothermal 
simulations where there is difficulty with losing precipitate phases during the calculation. 

When the  checkbox is selected, the stable and meta-stable property diagram data for all 
simulated precipitate phases is preprocessed. This preprocessing avoids repeating global 
equilibrium calculations, and speeds up computational time. It also allows for an improved 
description of precipitate kinetics under severe dissolution conditions. This can occur when 
temperatures are too high, where the phase is no longer detected in equilibrium 
calculations, or if the matrix is depleted of precipitate forming species, and the precipitate 
phase is lost when calculating the driving force.
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This feature is used primarily for non-isothermal simulations. For isothermal simulations it 
can be used when there is difficulty losing precipitate phases during the calculation. In this 
case, it alters the predicted dissolution kinetics in certain conditions where the precipitation 
phase is lost and then it also speeds up these calculations.

Include Incipient Melting

To use the Include incipient melting checkbox requires that the 
thermodynamic database (i.e. TCFE, TCNI, and so on) includes the liquid phase. 
If the liquid phase is not included, then the Perform button is not available (it is 
grayed out with a message explaining why) until either a liquid phase is 
included or this checkbox is deselected.

This is available when the Preprocess equilibrium data checkbox is selected.

Select the Include incipient melting checkbox to approximate the melting temperature of 
precipitate phases. The precipitates are removed upon exceeding this temperature.

Incipient melting is a phenomenon where, due to rapid heating rates, a solid-state 
precipitate is in solution at temperatures where it would normally dissolve. It liquidates 
rather than dissolves into the matrix. Being able to include (or exclude) the incipient melting 
is relevant to simulations involving welding and AM. Including incipient melting in AM 
calculations is useful to avoid excessive computation time modeling the dissolution of 
precipitates which would melt. The precipitates are assumed to melt instantaneously upon 
reaching their incipient melting temperature.

MAX TIME STEP FRACTION

The Max time step fraction is the maximum time step allowed for time integration as 
fraction of the simulation time. The default is 0.1.

NO. OF GRID POINTS OVER ONE ORDER OF MAGNITUDE IN RADIUS

The default number of grid points for every order of magnitude in size space. The default is 
150.0.

MAX NO. OF GRID POINTS OVER ONE ORDER OF MAGNITUDE IN RADIUS

The maximum allowed number of grid points in size space. The default is 200.0.
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MIN NO. OF GRID POINTS OVER ONE ORDER OF MAGNITUDE IN RADIUS

The minimum allowed number of grid points in size space. The default is 100.0.

MAX RELATIVE VOLUME FRACTION OF SUBCRITICAL PARTICLES ALLOWED TO DISSOLVE IN 
ONE TIME STEP

The portion of the volume fraction that can be ignored when determining the time step. The 
default is 0.01.

MAX RELATIVE RADIUS CHANGE

The maximum value allowed for relative radius change in one time step. The default is 0.01.

RELATIVE RADIUS CHANGE FOR AVOIDING CLASS COLLISION

Set a limit on the time step. The default is 0.5.

MAX OVERALL VOLUME CHANGE

This defines the maximum absolute (not ratio) change of the volume fraction allowed during 
one time step. The default is 0.001.

MAX RELATIVE CHANGE OF NUCLEATION RATE IN LOGARITHMIC SCALE

This parameter ensures accuracy for the evolution of effective nucleation rate. The default is 
0.5.

MAX RELATIVE CHANGE OF CRITICAL RADIUS

Used to place a constraint on how fast the critical radium can vary, and thus put a limit on 
time step. The default is 0.1.

MIN RADIUS FOR A NUCLEUS TO BE CONSIDERED AS A PARTICLE

The cut-off lower limit of precipitate radius. The default is 5.0E-10 m.
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MAX TIME STEP DURING HEATING STAGES

The upper limit of the time step that has been enforced in the heating stages. The default is 
1.0 s.

MAXIMUM RELATIVE SOLUTE COMPOSITION CHANGE AT EACH TIME STEP

Set a limit on the time step by controlling solute depletion or saturation, especially at the 
isothermal stage. The default is 0.01. 

Pause, Resume, and Cancel Precipitation Calculations

Precipitation calculations are often complex  simulations that take some time to complete. 
Sometimes you may want or need to pause or resume a calculation, or make adjustments to 
your compositions and start again. You pause and resume from the Precipitation Calculator 
Configuration window. 

This is also available for the Diffusion Calculator (but not any other calculators). 
See Pause, Resume, and Cancel Diffusion Calculations.

To Pause and Resume a Job

 1. Run the job (i.e. click Perform Tree). In the Scheduler, you can see the job listed and 
in the Event Log you can follow the progress of the calculation. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 245 of 763

 2. In the Project window, click the Precipitation Calculator node. 

 3. In the Configuration window at the bottom, click Pause. Observe that the 
Precipitation Calculator in the Project window has a pause indicator. If there are 
intermediate results available these will be listed in the Event Log. 

 4. When pausing the calculation, you can make changes to a variety of settings under 
the Matrix Phase or Precipitate Phase sections (click Show Details), plus the 
Interfacial energy, Temperature (for non-isothermal calculations), and Simulation 
time. The rest of the Configuration window settings are grayed out and no other 
editing can be done while paused.

 5. When ready, click  Continue to resume your calculations from the last time step or 
click  Discard to discard the calculation (then click Yes or No on the window that 
opens).
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To Cancel a Job

 l In the Scheduler window, right-click the job you want to cancel and select Cancel 
Job.

Precipitation Calculator Plot Renderer

The following is information about the settings available for a Plot Renderer when it is a 
successor to a Precipitation Calculator.

Plot Settings

LEGEND OPTION

Select whether the diagram’s legend displays On or Off.

AXIS VARIABLE

Set the state variable you want plotted along the X-axis and the Y-axis. The available 
variables in the list are based on how your system is set up.

Below are additional details related to the Axis variable chosen.

 l Separate Multimodal PSD: If you select Mean radius, Number density, Volume 
fraction, Size distribution, Number density distribution, or Normalized number 
density distribution then the Separate multimodal PSD checkbox is available. For 
variables with time for the X-axis, the number of Points used to sample the results 
can be modified. The Inflection neighbors and Smoothing iterations are used to 
identify individual particle populations. See Separate Multimodal PSD below for more 
detail.
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 l 3D → 2D: For a spherical morphology, and if you select Mean radius, Number 
density, Volume fraction, Size distribution, Number density distribution, or 
Normalized number density distribution as an axis variable, you can also select the 
3D → 2D checkbox to convert the 3D property to the corresponding 2D property 
considering the resulting 2D size distribution obtained from sectioning a 3D spherical 
dispersion. See 3D to 2D Conversion below for more detail.

 l Yield Strength: If you select this as an axis variable there are additional settings. See 
Yield Strength below for more detail.

Yield Strength

If you choose Yield strength as an Axis variable, you can further define the model. Click to 
expand the drop down list to the right of the Axis variable, then select any or all of the 
checkboxes listed below to plot the respective contributing elements to the yield strength. 

Click Configuration Panel toggle between the settings options and to further fine-tune the 
model. These options are described for the Yield Strength Property Model: Simplified Mode 
Settings and Yield Strength Property Model: Advanced Mode Settings. The greyed out 
sections (e.g. the Matrix,  Precipitate phases, and Grain size) are defined on the 
Precipitation Calculator and cannot be changed.

To see these settings after clicking Configuration Panel, you need to expand 
the Plot Renderer Configuration window to the right. Either detach the 
window to resize, or hover with the mouse until you see the double arrow, then 
click and drag to expand the window.

 l Total yield strength
 l Intrinsic strength
 l Solid solution strengthening
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 l Solid solution strengthening FCC
 l Solid solution strengthening BCC
 l Solid solution strengthening HCP
 l Grain boundary strengthening
 l Total precipitation strengthening
 l Precipitation strengthening per phase
 l Constant strength addition

The P_01: Isothermal Precipitation of Al3Sc example demonstrates the use of 
this Yield Strength Model.

Separate Multimodal PSD

This setting is available if you select Mean radius, Number density, Volume fraction, Size 
distribution, Number density distribution, or Normalized number density distribution as 
the Axis Variable.

When the Separate multimodal PSD checkbox is selected on a Plot Renderer activity for the 
Precipitation Calculator, the size distribution is evaluated at the given time steps and results 
for individual particle populations are identified and presented. These are separated and 
used to calculate the specified property.

P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal

It can be applied on the following plot properties:
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 l Mean radius
 l Size distribution
 l Number density
 l Volume fraction

POINTS

This field is available when Mean radius, Number density, or Volume fraction is selected as 
the Axis variable and the Separate multimodal PSD checkbox is selected. Since the 
evaluation of multimodality at each time step is costly, you can specify how many evaluation 
Points to use. The points are geometrically distributed over the time scale where nucleated 
particles are found. The default is 40 points.

INFLECTION NEIGHBORS

This setting is available when the Separate multimodal PSD checkbox is selected.

Enter the Inflection neighbors, which are the number of neighboring points with consistent 
gradient direction to identify inflection points. The default is 6. As a guide, too low a number 
is sensitive to noise and too high a number can fail to detect particle populations.

SMOOTHING ITERATIONS

This setting is available when the Separate multimodal PSD checkbox is selected.

Enter the number of Smoothing iterations performed to reveal significant particle 
populations. The default is 500. As a guide, too small a number can fail to remove noise, and 
too high a number can remove the particle populations of interest.

3D to 2D Conversion

When the Precipitate Phase Morphology is set to Sphere on the Precipitation Calculator, the 
following options are available when certain axis variables are also selected.

Select the 3D → 2D checkbox if you want to make a direct comparison between the 
predicted three-dimensional (3D) radius of the precipitates and the two-dimensional 
(2D) data obtained from a cross-section taken through the dispersion.

The stereological conversion is described in the theory for spherical particles.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 250 of 763

These variables can be converted to 2D:

 l Mean radius: The average circular radius of cross sections of particles obtained by 
taking a section through the dispersion, assuming spherical precipitates.

 l  Number density The number concentration of precipitates found on a 1 m2 cross-
section through the microstructure.

 l  Volume fraction The area fraction of precipitates found on a cross-section  taken 
through the microstructure.

 l Size distribution: The number density of particle cross sections that have a radius 
varying within a given size class in a unit area.

 l Number density distribution: The number of particle cross sections that have a 
radius varying within a given size class in a unit area.

 l Normalized number density distribution: The probability of finding particle cross 
sections with a cross sectional radius varying within the size class. The radius is 
normalized by the volumetric mean of the dispersion.

AXIS TYPE

Select the type of axis scale: Linear, Logarithmic, Logarithmic 10, or Inverse.

LIMITS

Specify the range along the axis to show in the plot. In the fields, enter the minimum and 
maximum values of the axis variable. You can also determine the step size between the tick 
marks along each axis.

Select the Automatic scaling checkbox to allow the program to set the limits.

UNIT (TIME X AXIS)

Choose a Unit: Seconds, Hours, or Days.

ADD AN AXIS AND REMOVE THIS AXIS BUTTON

Use the Add an axis  and Remove this axis  buttons to add additional X- and/or Y-axes 
to a plot or to merge plots (to overlay one plot with another in the same diagram). When 
merging plots, you define this variable as the Z-axis.
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AXIS VARIABLES

 l Mean radius: Spherical radius of average volume of all particles for a specific phase 
and nucleation type, regardless of their actual shapes. If the matrix phase is selected, 
it outputs the average grain radius.

 l Critical radius: Spherical radius of critical nuclei for a specific phase and nucleation 
type. If the matrix phase is selected, it outputs critical grain radius.

 l Yield strength: To use the Yield Strength Property Model to calculate yield stress. For 
more information  see About the Yield Strength Property Model.

 l Matrix composition: Instantaneous compositions of the matrix phase.
 l Precipitate composition: To track the instantaneous composition of precipitate 

particles. In particular, it is useful to distinguish different composition sets of the 
same phase (for example, FCC_A1#2 and FCC_A1#3). Further choose Solutes or All.

 l Number density: Instantaneous number of particles per unit volume for a specific 
phase and nucleation type. If the matrix phase is selected, it outputs instantaneous 
number of grains per unit volume.

 l Size distribution: Number of particles, or grains if the matrix phase is selected, 
varying with their sizes per unit volume per unit length, for a specific phase and 
nucleation type, at a specific time.

 l Number density distribution: Retrieve the number density (number of particles per 
unit volume) of precipitates, or grains if the matrix phase is selected, distributed in 
different particle sizes.

 l Normalized Number density distribution: Retrieve the number density (number of 
particles per unit volume) of precipitates, or grains if the matrix phase is selected, 
normalized by total number of particles or grains per unit volume, distributed in 
different particle sizes normalized by average size.

 l Volume fraction: Instantaneous volume fraction for a specific phase and nucleation 
type.

 l Nucleation rate: Instantaneous number of nuclei per unit volume per unit time for a 
specific phase and nucleation type.

 l Normalized driving force: Instantaneous nucleation driving force per unit mole of 
elements for a specific phase and nucleation type. It is normalized with RT and 
therefore, dimensionless.

 l Temperature
 l Mean cubic factor: Average cubic factor of cuboid particles. Available only when 

cuboid is selected as the Morphology.
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The following settings area available as indicated when Needle, Plate, or Cuboid are 
selected as the Morphology in the Precipitate Phase section on the Precipitation Calculator.

 l Cubic factor distribution: Variation of cubic factor with particle size at a specific 
time. Available with a cuboid morphology.

 l Mean aspect ratio: Average aspect ratio of non-spherical particles. Available with a 
needle or plate morphology. Note that this is always larger than 1, where 1 = a 
sphere.

 l Mean particle length: Diameter of non-spherical particles along the longer axis. 
Available with a needle or plate morphology.

 l Aspect ratio distribution: Variation of aspect ratio with particle size at a specific 
time. Available with a needle or plate morphology.

TIME

This field is available when Size distribution or Number density distribution is selected as 
the Axis variable. Enter one or a series of numbers in the field, separated by a space.

P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and Cuboid 
Morphologies

For example, if you enter 100.0 1000.0 1.0E7 in the field:

When you click Perform the times are plotted:
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Plot Renderer

The Plot Renderer is where you define the settings and output results in a diagram that 
displays in the Visualizations window. The available Plot Renderer  settings are based on the 
System Definer and/or calculator activity node predecessor (i.e. Equilibrium Calculator, 
Scheil Calculator, Property Model Calculator, and so forth). Settings availability is also 
determined by the Calculation Type as well as if you have an Add-on Module. If you used any 
of the templates, the Plot Renderer is automatically added to the Project tree.

Configuration Settings

For the standard plot settings, see Configuration Settings.

There are additional details for more advanced settings in Plotting Options. 

There are additional details for the Add-on Modules: 

 l Diffusion Calculator Plot Renderer
 l Precipitation Calculator Plot Renderer
 l AM Calculator: Plot Renderer Settings



Plot Toolbar

For any Plot Renderer, there is a toolbar available. 

Button Name Description

Save Diagram

Save the plot diagram. From the Save window, choose the file type–png (the default), jpg, ps, pdf, gif, svg, or emf. For PNG and JPG files 
you can also change the image quality. 

Saving and Printing the Output in Graphical Mode

Toggle 
Triangular/Regular 
Diagram

Display the diagram in triangular form, with the X-axis along the base and the Y-axis along the left side. Such a diagram is often useful if 
you want to plot the fractions of two components in a ternary diagram.

Show Grid Overlay a grid on the diagram.

Switch Axes Show the plotting X-axis variable on the diagram’s Y-axis, and the Y-axis variable on the diagram’s X-axis.

Retain Labels Toggle the default to keep labels displaying on the plot. By default labels are retained.

Table View 

Toggle to switch between displaying a Plot or the results of a Table in the Visualizations window. This is available for single equilibrium or 
stepping calculations. When you click to toggle ON, click Perform to regenerate as a Table. When you click to toggle OFF, click Perform to 
regenerate the Plot. 

For example, set up the Plot Renderer and click Perform to display the Plot. Then click Table View and Perform to see the results in a 
Table format in the Visualizations window. 

When toggled ON, click Save table to export the table data. Choose the Decimal digits and Number format (Auto, Decimal, or Scientific).

Saving and Printing the Output in Graphical Mode
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Configuration Settings

Click the Plot Renderer node in the Project window to view the Configuration window.  The 
settings available vary based on such choices as the specific calculator used and calculation 
type selected. 

 

Working with Plots and Tables

For the Add-on Modules with additional specialized functionality also see:

 l Diffusion Calculator Plot Renderer
 l Precipitation Calculator Plot Renderer
 l AM Calculator: Plot Renderer Settings

Settings

The options along the top of the window are available depending on the calculation type.

PLOT TYPE

There are a variety of combinations of Calculator and Calculation Type that offer different 
Plot Types. These are described in separate topics:

 l Plot Type: Cross Plot and Statistical 
 l Plot Type: Heat Map, Contour, and 3D
 l Plot Type: Parallel Coordinates
 l Plot Type: Flexible Mode and Grouped Mode
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 l Plot Type: CCT Mode
 l Plot Type: TTT Mode
 l Plot Type: Simple Mode and Advanced Mode

TIE-LINES

Select how many tie-lines to be plotted in the diagram. Every nth number of tie-line is 
plotted, where n is the number set here. Consequently, the higher the number, the fewer 
the number of plotted tie-lines in the diagram.

This setting is not available if the Plot Renderer is a successor to an Equilibrium 
Calculator where only one axis is defined and varied (that is, an Equilibrium 
Calculator that has performed a stepping calculation). 

LEGEND OPTION

Select whether the diagram’s legend displays the Stable phases, the Axis quantity, or 
choose Off for no legend. 

LEGEND STYLE

You can select a Legend style for the Stable phases or Axis quantity selected for Legend 
option. Choose None, All, Constitution description, or Ordering description. 

About Legend Styles

FILTER

This is available with the Property Model Calculator and Process Metallurgy Calculator.

Use the Filter checkbox to add various filters to the plot or table based on the set up of the 
calculation. When selected, click the Add quantity   and Remove quantity   buttons to 
add filters. For example, enter a Min and Max and choose an axis variable such as Ms 
Temperature and the unit Kelvin to adjust the output in the Visualizations window. Click 
Perform each time you add or remove a filter for the results to update.

SHOW LIMITS (BATCH)

This is available for the Batch calculation type, Cross plot. 
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Click the Show limits checkbox and then choose RMS (root mean squared), Absolute, or 
Relative in % limits. For Absolute or Relative in % enter a value in the field (the default is 
15.0).  A "perfect fit" line is added (solid line) to the plot and then the upper and lower limits 
shown on the plot are based on the type of limit selected.

 l When RMS is selected, a "perfect fit" line is added (solid line) plus the upper and 
lower limits (dashed lines), which are calculated for the experimental data points 
(read from the data file). The RMS error value is shown in the plot legend. The upper 
and lower limits are then this calculated value plus and minus from the perfect fit 
line. 

 l When Absolute is selected, the value entered (e.g. the default is 15), then this is the 
plus or minus value from the perfect fit line.

 l When Relative in % is selected, the value entered (e.g. the default is 15%), then this 
is the upper and lower limit that is plotted and this value is plus or minus percent 
from the perfect fit line as is calculated and shows in the plot legend. 

SHOW CALCULATION FAILURES AT VALUE (BATCH)

This is available for the Batch calculation type, Cross plot. 

Click the Show calculation failures at value checkbox and enter a value in the field. Use this 
checkbox to include any values that failed in the calculation and you want to see these on 
the plot. The value entered in the field replaces the non-existing calculated value(s) and can 
be cross plotted against experimental results from that data file. 

INTERPOLATE  (GRID)

From the Interpolate list, choose to interpolate data Never (the default), Once, Twice or 3 
times. This means points are put in between calculated points in the grid and interpolated 
instead of calculated in the calculation engine.

Choose how many points of data to interpolate  to improve curve smoothness – Never, 
20x20, 50x50, or 100x100. Try different settings for your own set of data.

LABEL DECIMAL DIGITS 

Choose the number of decimal digits to display in the plot label. The default is 2.

LABEL NUMBER FORMAT

Choose from Auto (the default), Decimal, or Scientific.
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AXIS VARIABLE

Set the state variable you want plotted along the X-axis and the Y-axis (and Z-axis for Grid 
calculations).

If the stepping/mapping variables are changed in the Equilibrium Calculator 
that precedes the Plot Renderer, then the variables to be plotted along the 
diagram’s X- and Y-axis are automatically updated to the appropriate 
quantities.

For a Grid Calculation Type, the X- and Y-axes always represent the quantities 
that define the calculation axes, but you need to set a variable for the Z-axis 
(the axis perpendicular to the plane defined by the X- and Y-axes).

For a Batch Calculation Type, the available options from the X- and Y- axes lists 
are based on the data file contents, i.e. if experimental data is included, then 
these are listed. See Working with Batch Calculations for details. Additional Plot 
Types are also available. 

AXIS TYPE

Select the type of axis scale: Linear, Logarithmic, Logarithmic 10, or Inverse.

AUTOMATIC SCALING

The Automatic scaling checkbox is selected by default to allow the program to set the limits.

LIMITS

This setting is available when the Automatic scaling checkbox is cleared (the scaling is 
turned off).

Enter the lower and upper Limits of the variables to display on the axis. You can also 
determine the step size between the tick marks along each axis. 
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If the Automatic scaling is turned off (i.e. the checkbox is not selected) then it is 
important to enter a large enough number in the step field for the numerical 
values to display correctly on the axis. That is, if the step size is too small, the 
program ignores this setting and the axis labels will not be as expected.

For logarithmic axes, the step size is related to the exponent. For example, if 
the step entered is 1.0, then the exponent increases by one each time (10-9, 10-
8, 10-7 and so forth).

CONTOUR VALUES AND USE CUSTOM CONTOUR VALUES (Z-AXIS, CONTOUR PLOTS)
The Use custom contour values checkbox is available when Contour is selected as the Plot 
type. Select this checkbox to enter one or a series of numbers in the Contour values field. 
Numbers can only be separated by a space.

ADD AN AXIS   AND REMOVE THIS AXIS BUTTONS

Use the Add an axis   and Remove this axis   buttons to add additional X- and/or Y-axes 
to a plot or to merge plots (to overlay one plot with another in the same diagram). When 
merging plots, you define this variable as the Z-axis.  

Plotting Options

SLAG PROPERTY OPTIONS (PROCESS METALLURGY)

For the Process Metallurgy Calculator when you are selecting axis variables on the Plot 
Renderer, there is the option to choose Slag property. The associated quantity that you 
select from the next drop-down list has these options to choose: All, B2, B3, B4, Bas2, Bells 
ratio, Ls, or Log10 (Sulphur capacity). 

Also choose In liquid slag only, In solid slag only, or In all slag.

References and equations for these properties are described in Process 
Metallurgy Slag Properties.
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UNIT (PROCESS METALLURGY)

For the Process Metallurgy Calculator select a Unit for the quantity to plot: Tonne, 
Kilogram, Gram, or Pound

ACCOUNT FOR INTERFACE SCATTERING (SCHEIL)

Scheil Calculator Available Plot Variables

The Account for interface scattering checkbox is available when any of the following Axis 
variables are selected for a Scheil Calculator:

 l Electric conductivity
 l Electric resistivity
 l Thermal conductivity
 l Thermal diffusivity
 l Thermal resistivity

The electrical resistivity due to phase interface scattering is evaluated as the scattering 
constant times sum of the interaction between the volume fraction of all the phases. The 
default value for the Phase interface scattering constant is found to be 4.0e-8 Ωm for 
aluminum alloys produced with conventional methods. A higher value could be required for 
the AM process where the rapid solidification results in a very fine microstructure with a 
large amount of phase interfaces.The contribution to thermal conductivity is assumed to be 
related to that to electrical resistivity, following the Wiedemann-Franz law.

Either keep the default Phase interface scattering constant, which is a constant for 
evaluating thermal conductivity due to scattering at phase interfaces, or enter another 
value.
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Table Renderer

A Table Renderer visualizes calculation results in a table. Several Table Renderer activities 
(as well as Plot Renderer activities) can be shown in the Visualizations window as different 
tabs.

You can add the Table Renderer directly (right-click a calculator node and select it from the 
Create New Successor menu) or use a variety of the available templates to automatically 
add the node. For example, on the  My Projects Configuration window under Equilibrium, 
choose the Single Point or One Axis templates.

For details about the templates, see Getting Started Links and Templates and 
Creating a Project from a Template.

You can only successfully tabulate the results of a single equilibrium calculation 
or a stepping (i.e. property diagram) operation. The tabulated data from an 
equilibrium calculation is different from the tabulated data from a stepping 
calculation.

The settings are described in the section Configuration Settings.

Table Button

Button Name Description

Save Table

Once a calculation is performed and 
there is data in the table, click to save it. 

Saving and Printing the 
Output in Graphical 
Mode

For the Plot Renderer, there is an option to use the Table View  button to convert plots to table 
data for all calculation types and calculators. See Plot Renderer: Convert a Plot to a Table and Export 
the Data.
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Results from an Equilibrium Calculation

The following tab shows the result of an equilibrium calculation (from example T_01: 
Calculating a Single-Point Equilibrium).

For each stable phase listed, from the Composition and constitution menu you can select 
the information to view. In this example, the maximum amount of information is shown and 
includes details about both composition and constitution for BCC_A2#1.

The default for the Phase description detail can be changed globally from 
Options window.
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Results from a Stepping Operation

The Table Render 1 tab in the example shows the results of a stepping calculation (where a 
Table Renderer is added to the example in T_02: Stepping in Temperature in the Fe-C 
System).

Process Metallurgy Module Single Equilibrium

When you use a Process Metallurgy Calculator with a Single equilibrium calculation, there is 
a variety of additional information you can display in the table such as the Slag properties 
(see Process Metallurgy Slag Properties for equations and references) and the Activities.

PMET_01: Basic Oxygen Furnace (BOF). Using version 01b, added a Table 
Renderer and did a Single calculation.

For the activities in the table, you can hover over the Component and the syntax of the 
activity displays.
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Yield Strength Property Model

The Yield Strength Property Model: Simplified Mode Settings is available with the Property 
Model Calculator. After defining the Model and adding a Table or Plot, all yield strength 
quantities are available to select from this list. These yield strength quantities are also 
accessible via a Table Renderer (or Plot Renderer) that is a successor to the Precipitation 
Calculator.

For details about the quantities, see About the Yield Strength Property Model.

This uses the PM_G_05: Yield Strength NiAlCr example and then a Table 
Renderer is added. Alternatively, you can click the Table View  button and 
reperform the Plot Renderer for the same results.

An example of the results when yield strength is chosen as the Axis variable for a Table Renderer 
that is a successor to the Property Model Calculator.

Precipitation Calculator Multimodal PSD and 3D --> 2D Settings

These settings are described in the Precipitation Calculator Plot Renderer.
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Configuration Settings

The Table Renderer settings are done on the Configuration window. Depending on what 
calculator node the table is a successor to, you can have different settings available. For 
most tables, this is where you set the level of detail for the columns as shown in the figure.

SAVE THE TABLE 

To save all the data in a table as a Character separated  (.csv), Hyper Text Markup (.html), 
or Excel (.xls), in the Configuration window click Save table  or in the Visualizations 
window right-click in the table and select Save As.

To copy the data from a single cell of a table to the clipboard, right-click the cell and select 
Copy. To copy the whole table to the clipboard, select Copy all.

The data saved is what is shown in the Table Renderer tab on the 
Visualizations window. If data is calculated (and not displayed) it is not saved.

NUMBER OF DECIMAL DIGITS AND NUMBER FORMAT

The table results can be presented in ordinary decimal number format or with normalized 
scientific notion. Choose Scientific or Decimal to increase or decrease the number of 
Decimal digits used in the table. The default is 5 digits. The Number format defaults to Auto 
to use the most appropriate format based on the tabulated data. 

The defaults for these settings can be changed globally. 

To open the Options window: 
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 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Tabulation node in the tree.

PROCESS METALLURGY SETTINGS

For the Process Metallurgy Calculator there are additional settings available.

PMET_01: Basic Oxygen Furnace (BOF). Using version 01b, added a Table 
Renderer and did a Single calculation.

Choose a Temperature unit: Kelvin, Celsius or Fahrenheit.

Choose a Mass unit: Tonne, Kilogram, Gram, or Pound.

Select the All stable phases checkbox and choose Composition or Condensed from the list.

Select the Slag properties checkbox and choose the associated quantity  from the next drop-
down list: All, B2, B3, B4, Bas2, Bells ratio, Ls, or Log10 (Sulphur capacity). 

Also choose In liquid slag only, In solid slag only, or In all slag.

Details, including references and equations, are described in Process Metallurgy 
Slag Properties.

Select the Activity checkbox then from the first list choose a component (or keep the default 
All). Then from the second drop-down list select Reference solid oxide or Reference liquid 
slag.
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The activity is always given relative to a phase. The liquid slag is always the IONIQ_LIQ 
phase. The composition set of ION_LIQ depends on the calculation and the  slag always 
contains a high amount of oxygen. The reference phase for the solid oxides depends on the 
components and it is always listed in the table. 

PRECIPITATION CALCULATOR WITH YIELD STRENGTH

When you use a Precipitation Calculator and choose Yield strength as an Axis variable, 
there are additional settings available.

If you choose Yield strength as an Axis variable, you can further define the model. Click to 
expand the drop down list to the right of the Axis variable, then select any or all of the 
checkboxes listed below to plot the respective contributing elements to the yield strength. 

Click Configuration Panel toggle between the settings options and to further fine-tune the 
model. These options are described for the Yield Strength Property Model: Simplified Mode 
Settings and Yield Strength Property Model: Advanced Mode Settings. The greyed out 
sections (e.g. the Matrix,  Precipitate phases, and Grain size) are defined on the 
Precipitation Calculator and cannot be changed.

To see these settings after clicking Configuration Panel, you need to expand 
the Plot Renderer Configuration window to the right. Either detach the 
window to resize, or hover with the mouse until you see the double arrow, then 
click and drag to expand the window.

 l Total yield strength
 l Intrinsic strength
 l Solid solution strengthening
 l Solid solution strengthening FCC
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 l Solid solution strengthening BCC
 l Solid solution strengthening HCP
 l Grain boundary strengthening
 l Total precipitation strengthening
 l Precipitation strengthening per phase
 l Constant strength addition

The P_01: Isothermal Precipitation of Al3Sc example demonstrates the use of 
this Yield Strength Model.

Yield Strength Property Model: Simplified Mode Settings

PRECIPITATION CALCULATOR SEPARATE MULTIMODAL PSD AND 3D > 2D 

When certain Axis variables are selected on the Plot Renderer or Table Renderer that is a 
successor to the Precipitation Calculator,  the Separate multimodal PSD and 3D > 2D 
checkboxes are available for the Precipitation Module (TC-PRISMA).

Another requirement is that the Precipitate Phase Morphology is set to Sphere 
on the Precipitation Calculator.

See the specialized section for the Plot Renderer for details.

Precipitation Calculator Plot Renderer
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Experimental File Reader

The Experimental File Reader activity node is added as a predecessor from the top  My 
Project node. This allows you to use  (or "read") the data contained in an experimental data 
file (with the file extension *.EXP) and then plot the data on one or more Plot Renderers.

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

If you are a Console Mode user, this is the same concept as using the 
Experimental Data Files (*.POP, *.DOP).

The EXP file is a type of data file with information specifying a plotted diagram and it is 
written in the DATAPLOT graphical language. From this activity node you can plot the 
EXP file or save a copy of the file to another location. 

Creating Activities and Successors and Plotting Experimental Data Files in the 
DATPLOT User Guide included with this documentation set.

How to Plot Using an Experimental Data File

 1. Right-click  My Project and from the Create New Activity submenu choose 
Experimental File Reader.

 2. In the Configuration window in the EXP file field, enter the name of the EXP file to 
plot. Or click the Select Exp file  button to navigate to a location on the computer 
to add the dataset.

 3. Once the .EXP file is added, under Dataset Selection you can choose to include or 
exclude specific datasets. Use the Select/Deslect all datasets checkbox as required.

 4. Right-click the Experimental File Reader node and from the Create New Successor 
submenu choose Plot Renderer.

If the source EXP file is changed, you can also click the Reload the selected EXP file 
from disk  button to refresh the data. If you want to save or export the loaded file, 
click the Save EXP file  button, then navigate to where you want to save it and 
give it a file name. 

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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 5. In the Configuration window click Perform or right-click the Plot Renderer node and 
select Perform.
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General Property Models
Property Model Calculator
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About the Property Models

Property Models are used to predict and optimize properties of materials using models 
stored within the software where the calculations are set up in the Property Model 
Calculator.

General Models

The following General Property Models are available with the Property Model Calculator.

The General Models  are available to all users. 

To run calculations with  the Add-on Property Model Libraries all require a valid 
maintenance license plus a license for the specific database version: Nickel 
Models (TCNI11 and newer and MOBNI5 and newer; Noble Metal Alloys 
Models (TCNOBL3 and newer); Steel Models (TCFE9 and newer + MOBFE4 and 
newer); Titanium Models (TCTI6 and newer).

About the Steel Model Library Property Models, About the Nickel Model Library 
Property Models, and About the Titanium Model Library Property Models, and 
About the Noble Metal Alloys Model Library Property Models.

Coarsening

The Coarsening Property Model calculates the coarsening rate coefficient K (m3/s) of a 
spherical precipitate phase in a matrix phase. 

See About the Coarsening Property Model and Coarsening Property Model 
Settings for background theory and input parameter details.

Columnar to Equiaxed Transition (CET)

The Columnar to Equiaxed Transition Property Model calculates the fraction of equiaxed 
grains that correlates with a certain solidification condition, specifically thermal gradient  ( ) 
and solidification growth rate  ( ). 
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See About the Columnar to Equiaxed Transition (CET) Property Model and 
Columnar to Equiaxed Transition (CET) Property Model Settings for background 
theory and input parameter details.

Crack Susceptibility Coefficient

The Crack Susceptibility Coefficient Property Model calculates the hot tearing tendency 
during solidification. 

See About the Crack Susceptibility Coefficient Property Model and Crack 
Susceptibility Coefficient Property Model Settings for background theory and 
input parameter details.

Driving Force

The Driving Force Property Model calculates the thermodynamic driving force for a phase. 

See  Driving Force Property Model Settings for input parameter details.

Equilibrium

The Equilibrium Property Model calculates the equilibrium for the given conditions. 
Optionally define additional function definitions. 

See Equilibrium Property Model Settings for input parameter details.

Equilibrium with Freeze-in Temperature

The Equilibrium with Freeze-in Temperature Property Model calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature. The 
assumption is that diffusion and phase transformations are negligible when changing from 
the freeze-in-temperature and, therefore, that the phase amounts and compositions of 
phases are kept at all other temperatures. 

See About the Equilibrium with Freeze-in Temperature Property Model and 
Equilibrium with Freeze-in Temperature Property Model Settings for 
background information and input parameter details.
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Interfacial Energy

The Interfacial Energy Property Model estimates the interfacial energy between a matrix 
phase and a precipitate phase using thermodynamic data from a CALPHAD database. 

See About the Interfacial Energy Property Model and Interfacial Energy Property 
Model Settings for background information and input parameter details.

Liquid and Solidus Temperature

The Liquid and Solidus Temperature Property Model is for doing a common calculation. For 
example, you can easily use uncertainty calculations, vary one or more conditions, and see 
how that affects the liquidus and solidus temperatures. 

See Liquid and Solidus Temperature Property Model Settings for input 
parameter details.

Phase Transition

The Phase Transition Property Model can be used to vary which condition to relax, and then 
it calculates the point when a new phase may form. It is useful to determine melting 
temperature, boiling temperature or solubility limits. It returns the phase transformation 
temperature, or composition, depending on the relaxed condition.  

See Phase Transition Property Model Settings for input parameter details.

Scheil

The Scheil Property Model is used to calculate solidification under the Scheil assumption. 
The majority of the Model  input parameters are pulled from the Scheil Calculator to offer 
the outputs of the liquidus/solidus/solidification range so you can explore these in the 
calculation types of the Property Models.

See Scheil Property Model Settings, and Scheil Advanced Options: Property 
Models.

Spinodal

The Spinodal Property Model calculates the spinodal line. 
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See About the Spinodal Property Model and Spinodal Property Model Settings 
for background information and input parameter details.

T-Zero Temperature

The T-Zero Temperature Property Model calculates the so-called T0 line. 

See About the T0 Temperature Property Model and T0 Temperature Property 
Model Settings for background information and input parameter details.

Yield Strength

The Yield Strength Property Model calculates yield stress. It returns the calculated yield 
strength at room temperature for the specified material using the equilibrium values 
calculated at temperature  (i.e.  is the freeze-in temperature). Then you can further 
define the following contributions to the total yield stress: precipitation strengthening, solid 
solution, grain boundary strengthening, and constant addition of strength. 

See About the Yield Strength Property Model and Yield Strength Property 
Model: Simplified Mode Settings or Yield Strength Property Model: Advanced 
Mode Settings for background information and input parameter details.

Calculation Types

The Property Model Calculator includes these calculation types:

 l Single: Calculates a single point.
 l One Axis: Varies a quantity on the X-axis.
 l Grid: Evaluates two axis variables of the selected quantities in the specified range 

and number of steps. You can then select to create heat map, contour and 3D plots 
on the Plot Renderer.

 l Min/Max: Evaluates the Property Model(s) for all variations of the selected 
quantities at the given limits. The Mean field is as defined under Condition Definitions 
for the respective quantity. The total minimum and maximum of the Model(s) results 
are shown in the Event log.

 l Uncertainty: Evaluates the Property Model(s) where the values of the quantities are 
sampled from Gaussian distributions. The Mean field is as defined under Condition 
Definitions for the respective quantity. The result is visualized as a histogram or 
normal probability plot by adding a Plot Render activity.
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 l Batch: Use this to  allow for high throughput calculations and read data from a file, 
such as a spreadsheet. You can include experimental results in the data file, which 
then can be used to compare to the batch calculation results.

About the Uncertainty Calculations and Plot Types

Examples and Video Tutorials

Thermo-Calc General Property Models Examples Collection

For tutorials about this feature, go to our website or browse the Property Model 
Calculator playlist on our YouTube channel. 

https://thermocalc.com/support/video-tutorials/property-model-calculator-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGQLFHZ8SVl2TGlvqWUQOdJX
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Scheil Advanced Options: Property Models

This topic has advanced settings information for the Show advanced Scheil options 
checkbox that is available for a Property Model Configuration windows. The main settings 
are on the Configuration tab. 

These settings are based on the Scheil Calculator settings with minor differences 
in wording or application. SeeAdvanced Options.

For theory or background details about Scheil, start by reviewing Scheil-Gulliver 
Solidification Calculations. 

To view all of these settings, click the Show advanced Scheil options checkbox. 

TEMPERATURE STEP DURING SCHEIL

Enter a Temperature step during Scheil for the Scheil simulation.  Temperature step is given 
in the same unit as the temperature in the Condition Definitions.

GLOBAL MINIMIZATION

Global minimization is enabled by default i.e. the Global minimization checkbox is selected.

It is recommended to keep global minimization on as it makes the calculation 
more accurate. However, turn it off if you find that the calculation is taking too 
long for any particular system, and accuracy is not the highest priority.

For this setting, a global equilibrium test is performed at selected intervals when an 
equilibrium is reached. By default it is at every 10 th Scheil step but this can be changed 
using the Global test interval setting. The global equilibrium test is also done every time the 
set of stable phases tries to change. This costs more computer time but the calculations are 
more robust.
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GLOBAL TEST INTERVAL

Use the Global test interval setting to change the interval at which a global equilibrium test 
is done, which by default is every 10th step as long as there are no changes in the set of 
stable phases. Every time the set of stable phases tries to change, a global equilibrium test is 
also done regardless of the test interval value chosen. A global equilibrium test means that 
the calculated equilibrium state obtained by the ordinary minimization calculation is tested 
against the Global Minimization Technique, and if the result is found unstable then the full 
global minimization calculation is performed instead.

LIQUID PHASE

The default in the list is the LIQUID phase already defined in the chosen database.

SOLID FRACTION FOR EVALUATING LIQUIDUS TEMPERATURE

Enter a value for the Solid fraction for evaluating liquidus temperature. A small fraction 
larger than zero can be used to avoid small amounts of high temperature stable phases for 
the evaluation of liquidus temperature.

TERMINATE AT FRACTION OF LIQUID PHASE AMOUNT

Enter a value in the field for Terminate at fraction of liquid phase amount. 

For Crack Susceptibility Coefficient model, the value should not be larger than 
the setting Liquid fraction: Smallest for vulnerability.

MAX NO. OF ITERATIONS

Enter or choose a value for the Max no. of iterations. By default, the program tries 500 
iterations before it gives up. As some models give computation times of more than 1 CPU 
second/iteration, this number is also used to check the CPU time and the calculation stops if 
500 CPU seconds/iterations are used.
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REQUIRED ACCURACY

The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program 
requires that the relative difference in each variable must be lower than this value before it 
has converged. A larger value normally means fewer iterations but less accurate solutions. 
The value should be at least one order of magnitude larger than the machine precision.

SMALLEST FRACTION IN A PHASE

The default Smallest fraction (or Smallest fraction in a phase for Property Models) is 1.0E-
12. This is the value assigned to constituents that are unstable. It is normally only in the gas 
phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL 
phase with one sublattice site (such as the GAS mixture phase in many databases) for which 
the default value is always as 1E-30.

This default setting is used as a start value in the Scheil Calculator. During simulation, and if 
there are convergence issues, the value can be decreased.

SMALLEST FRACTION FOR ALLOY COMPOSITION

The default Smallest fraction for alloy composition is 1.0E-7. A smallest value assigned to 
alloy mole/mass fraction in case a smaller input value for an element is entered.

APPROXIMATE DRIVING FORCE FOR METASTABLE PHASES

The Approximate driving force for metastable phases checkbox is selected by default. Click 
to clear the checkbox to change the default as required and based on the options described 
below.

This setting involves the convergence of metastable phases and affects their driving forces. It 
can also have an effect on when an equilibrium is considered successful.

The default is to allow an equilibrium with metastable phases that have not converged, as 
long as the stable phases have converged. This is efficient but often causes approximate 
values of the driving forces for the metastable phases.

If you change the default, it enforces metastable phases to converge. This gives accurate 
driving forces for metastable phases as well as stable phases. It can however take a slightly 
longer time, and if metastable phases do not converge it causes the equilibrium calculation 
to fail.
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About the Coarsening Property Model

Coarsening is a Property Model available when using the Property Model Calculator in 
Thermo-Calc. 

In the coarsening regime where the driving force is capillarity, the change of mean particle 
radius evolves according to the equation:

Following Morral and Purdy [1994Mor], the rate constant of precipitating β phase in a 
multicomponent α phase is

The mobility matrix M is not the same as the mobilites that can be obtained directly from 
the Diffusion Module (DICTRA). The M matrix instead corresponds to the L’’ matrix as 
defined by Andersson and Ågren [1992And].

Using the u-fractions that is defined as

where the summation only is performed over the substitutional elements give the final 
equation for the coarsening rate coefficient. 

The interfacial energy, σ,  is calculated using the extended Becker’s model (also available as 
the Interfacial Energy Property Model).

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Coarsening Property Model Settings.
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Coarsening Property Model Settings

Coarsening is a General Property Model available when using the Property Model Calculator 
in Thermo-Calc and it  calculates the coarsening rate coefficient K (m3/s) of a spherical 
precipitate phase in a matrix phase.

The output using this Model is the coarsening rate coefficient [m3/s] for the precipitate 
phase and the interfacial energy [J/m2] between matrix and the precipitate phase.

This Model requires that the thermodynamic database used includes 
descriptions of molar volume of the matrix and precipitates phases as well as a 
kinetic database with mobilities for the matrix phase.

Theory and Example

About the Coarsening Property Model

For an example, see PM_G_02: Coarsening and Interfacial Energy.

Configuration Settings

The settings  are found on the Property Model Calculator when Coarsening is selected under 
General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

MATRIX PHASE

Choose a Matrix phase.
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PRECIPITATE PHASE

Choose a Precipitate phase to calculate its coarsening rate. Click the Add phase  button to 
add another Precipitate phase. Click the Remove phase  button to remove a phase.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Temperature
 l Coarsening rate coefficient Ni [m3/s] for the precipitate phase.
 l Interfacial energy Ni [J/m2] for it to be between the matrix and precipitate phase.
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About the Columnar to Equiaxed Transition (CET) Property 
Model

The Columnar to Equiaxed Transition Property Model calculates the fraction of equiaxed 
grains that correlates with a certain solidification condition, specifically thermal gradient  ( ) 
and solidification growth rate  ( )  (defined as the migration rate of the interface between 
liquid and primary solid), so that valuable information on the solidification microstructure 
can be obtained. 

This General Model is available when using the Property Model Calculator in Thermo-Calc. 
The Model formulation consists of two essential steps (1)  to determine the dendrite tip 
radius and tip undercooling, and (2) to apply the calculated undercooling  to the CET Model. 
These are discussed below.

Use of this Property Model requires mobility data of liquid for the calculations. 
For all simulations both a thermodynamic and a mobility (kinetic) database 
must be selected on the System Definer. 

Determine the Dendrite Tip Radius and Tip Undercooling

The first step determines the dendrite tip radius and tip undercooling, which is strongly 
dependent on    while slightly on . For this Model, only primary solid is assumed to be 
stable while other secondary solid phases are ignored. Mullins and Sekerka instability 
analysis [1964Mul]  and marginal stability criterion [1978(a)Lan; 1978(b)Lan; 1978Mül] are 
used to determine the tip radius. Meanwhile, tip undercooling, , is also calculated due to 
constitutional, curvature, and solute trapping effects. The multicomponent extension of this 
framework is achieved based on the approach developed by Hunziker [2001Hun]. It 
integrates with both thermodynamic and mobility databases so that key thermodynamic and 
kinetic properties for multicomponent alloy systems, such as liquidus, liquidus slope, solute 
partitioning coefficients, and diffusivities of liquid, etc., can be obtained directly from the 
databases. Solute trapping effects on liquidus, liquidus slope, and solute partitioning are also 
considered based on the model developed by Aziz [1982Azi] and extended to 
multicomponent systems.

Apply the Undercooling to the CET Model

The second step is to apply the calculated undercooling, , to the CET Model. The model 
developed by Gäumann et al. [2001Gäu] is used, which extended Hunt’s model [1984Hun] to 
include high solidification rate. A slight modification [2018Hai]  enables elimination of an 
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adjustment parameter by directly using  . The model correlates ,   (mostly in terms of 
), and the fraction of equiaxed grains,  , as

Where three materials related parameters are introduced:

 l : number of nucleation sites per unit volume, in the unit of 1/m3

 l : nucleation undercooling, in the unit of K
 l : exponent

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Columnar to Equiaxed Transition (CET) Property Model Settings.

Examples
 l PM_G_15: Columnar to Equiaxed Transition (CET) of a NiAlCr Alloy
 l PM_G_16:  Columnar to Equiaxed Transition of a CMSX-4 Alloy
 l  PM_G_17: Columnar to Equiaxed Transition of an IN718 Alloy
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Columnar to Equiaxed Transition (CET) Property Model Settings

The Columnar to Equiaxed Transition Property Model calculates the fraction of equiaxed 
grains that correlates with a certain solidification condition, specifically thermal gradient  ( ) 
and solidification growth rate  ( ). 

This General Model is available when using the Property Model Calculator in Thermo-Calc.

Theory and Examples

For theory, see About the Columnar to Equiaxed Transition (CET) Property Model.

For examples see:

 l PM_G_15: Columnar to Equiaxed Transition (CET) of a NiAlCr Alloy
 l PM_G_16:  Columnar to Equiaxed Transition of a CMSX-4 Alloy, 
 l PM_G_17: Columnar to Equiaxed Transition of an IN718 Alloy

System Definer Configuration Settings

Use of this Property Model requires mobility data of liquid for the calculations. 
For all simulations both a thermodynamic and a mobility (kinetic) database 
must be selected on the System Definer. 

Property Model Calculator Configuration Settings

The settings are found on the Property Model Calculator when the Columnar to Equiaxed 
Transition Model is selected under General Models.
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When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

PRIMARY PHASE

Select the Primary phase from the list. This is the primary solid phase to form the dendrite. 

INTERFACIAL ENERGY

Enter a value for the Interfacial energy [J/m^2], which is between the liquid and primary 
phase. The default is 0.25 J/m2.

NUMBER OF NUCLEATION SITES

Enter a value for the Number of nucleation sites [/m^3] for equiaxed grains per cubic 
meter. The default is 2.0E15 / m3.

NUCLEATION UNDERCOOLING

Enter a value for the Nucleation undercooling [K], which is the critical undercooling for 
nucleation of equiaxed grains. The default is 2.5 K. 

EQUIAXED EXPONENT

Enter a value for the Equiaxed exponent. The Equiaxed exponent is used in the equation 
that calculates the fraction of equiaxed grains. This is usually a value between 3 and 5.

SOLVE FOR, TEMPERATURE GRADIENT, AND EQUIAXED FRACTIONS

Select an option from the Solve for list (Equiaxed fraction or Thermal gradient) and then 
enter the required secondary information as indicated.
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 l Equiaxed fraction: Solve for the equiaxed fraction given the thermal gradient. 

When Equiaxed fraction is selected, then enter a value for the Temperature 
gradient, which is the temperature gradient of the liquid ahead of the dendrite tip. 
The default is 1000 K/m.

 l Thermal gradient [K/m]: Solve for the thermal gradient given the equiaxed fraction
(s). 

When Thermal gradient is selected, then enter a value for the Equiaxed fractions. 
This finds the thermal gradient for the given equiaxed fractions.  The values entered 
should be between 0.001 and 0.99. If more than one fraction, separate the values 
with a space. The default is 0.0066 0.49 0.99. 

GROWTH RATE

Select a Growth rate from the list then enter a value in the field.

 l If v is selected, then enter a value for the solidification growth rate, v. The default is 
0.1 m/s. 

 l If log10(v) is selected, then enter a value for the logarithm of growth rate, log10(v). 
The default is -1.0 m/s.

 SOLUTE TRAPPING

Select the Solute trapping checkbox to enable solute trapping at the tip interface. By default 
this is not selected. 

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities: 

 l log10(v) [m/s]
 l Liquidus
 l Fraction of equiaxed grains
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 l Tip radius
 l Thermal gradient
 l v [m/s] 
 l Dendrite tip undercooling [K]
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About the Crack Susceptibility Coefficient Property Model

The Crack Susceptibility Coefficient is a Property Model available when using the Property 
Model Calculator in Thermo-Calc. It is used to calculate the hot tearing tendency during 
solidification. The model is based on the publication by Yan and Lin [2006Yan].

Hot tearing is one of the most common and serious defects encountered during the casting 
of, for example, aluminum alloys. In general, it is defined by the formation of a macroscopic 
fissure in a casting as a result of stress and the associated strain, generated during cooling, 
at a temperature above the non-equilibrium solidus.

Crack susceptibility is also referred to as solidification cracking, hot cracking, hot shortness, 
supersolidus cracking, and shrinkage brittleness [2006Yan]. 

The Crack Suscebility Coefficient (CSC) is calculated using Scheil results with three different 
models; Clyne and Davies [1981Cly; 2006Yan] , Kou [2015Kou], and Easton [2014Eas].

Input Parameters, Scheil Settings, and CSC Model Selection

There are these models to choose from as the Crack Susceptibility Coefficient (CSC) Model: 
Clyne and Davies, Kou, or Easton. 

There are also several Scheil settings, including advanced options to choose from. Some 
additional theory and background is included below to supplement the settings input 
choices.

Clyne and Davis CSC Model Theory and Background

The original model assumptions are from Clyne and Davis [1981 Clyne]. Later, 
the experimental hot cracking susceptibility was collected from several sources 
by Yan and Lin [2006 Yan] and given as a probability 0-100%. The CSC calculated 
with the current model cannot be compared by absolute values with the 
experimental number; instead it is best to compare the trends, to see if it is 
increasing or decreasing. The experimental values are therefore given with 
relative coordinates and do not map directly to the calculated plot axes.

The following information describes the background when Clyne and Davies is chosen as the 
CSC Model.

The Crack Susceptibility Coefficient (CSC) was originally proposed by Clyne and Davies 
[1981Cly] to describe the effects of alloy composition on hot tearing. 
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The current model is based on the publication by Yan and Lin [2006Yan]. In Thermo-Calc, the 
CSC is calculated using Scheil and uses assumptions of cooling rates under the thermal 

conditions that the heat flow is proportional to .

The CSC is defined as  where: 

 l  is the time during solidification where the casting is vulnerable to cracking, and 
 l  is the time available for the stress relief process. 

The values for and  are given by the thermal condition, the Scheil results, and the input 
parameters for the liquid fraction (defined on the Configuration window):

 l Start of relaxation
 l Transition to vulnerability 
 l Smallest for vulnerability

These liquid fraction parameters are elaborated on next using the results from a simulation 
using the TCS Al-based Alloy Database (TCAL) and the alloy Al-0.9Cu-10Mg-0.9Ni-12.2Si 
mass%.
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Figure 12: The results of the thermal condition in Mode 3, fraction of liquid, including the addition 
of lines and arrows to the plot for clarity. See the text for more detail.

Liquid Fraction Parameters 

The Crack Susceptibility Coefficient Model is based on the concept of the existence of 
critical time periods during the solidification process when the structure is most vulnerable 
to cracking.

Clyne and Davies concluded that the mass and liquid feeding readily occurs at liquid volume 
fractions between about 0.6 and 0.1, so the time spent in these ranges was defined as time-
relaxation ( ). At very low volume fractions of liquid, the material is too strong to crack. 
The authors chose a fraction of liquid between 0.1 and 0.01 as the vulnerable regime, and 
the time spent defined as . See Figure 12 for the results from a simulation using the TCS 
Al-based Alloy Database (TCAL)    and the alloy Al-0.9Cu-10Mg-0.9Ni-12.2Si mass%.
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The Scheil simulation takes temperature steps and does not regard time at all. See Figure 13 
for the typical Scheil results of amount of solid phases as function of temperature.  The 
simulation is made with the TCS Al-based Alloy Database (TCAL)   and the alloy Al-0.9Cu-
10Mg-0.9Ni-12.2Si mass%.

A thermal condition is assumed to connect the amount of liquid fraction to fraction of time.

Figure 13: A Scheil simulation result of the mole fraction solid phases vs temperature (°C).  See the 
text for more detail. 

Following Clyne and Davies’ approach, the cooling rates were then estimated under three 
different thermal conditions: 

 l Mode 1 with a constant cooling rate, dT/dt = constant
 l Mode 2 with a constant heat flow, , dQ/dt = constant, and 
 l Mode 3 with a heat flow proportional to 1/sqrt(time)

Then:
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 l Liquid fraction: Start of relaxation
 l Liquid fraction: Transition to vulnerability
 l Liquid fraction: Smallest for vulnerability

The crack index can then be obtained from the Scheil simulation results: fraction liquid vs T 
curve and the thermal condition.

1-fraction solid phases = fraction liquid phase. 

Figure 14 can be thought of as the 'master curve' for the connection between fraction of 
liquid and fraction of time. The limits of the amount of liquid 0.01, 0.1, and 0.6 and the 
corresponding fraction time are shown for each thermal condition. In Figure 12 , which is a 
less cluttered plot, the time spent in the relaxation and in the vulnerable regions are marked 
with lines and arrows for a single thermal mode.
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Figure 14: The results of the thermal condition in Modes 1-3,  the fraction of time vs the fraction of 
liquid. See the text for more detail. 

Kou CSC Model

When Kou is chosen as the CSC Model   [2015Kou], the cracking susceptibility coefficient is 
defined as the absolute value of the derivative of the  vs  curve at the end of the 
solidification, where 

 l  = Temperature 
 l  = fraction solid

Easton CSC Model

When Easton is chosen as the CSC Model [2014Eas], the cracking susceptibility coefficient is 
defined as the integral of  between  and  where 
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 l  = fraction solid
 l  = temperature for the solid fraction of a coherent dendrite structure. 
 l  = The temperature for the solid fraction of coalescence of dendrite structure. 

The user inputs are the solid fraction for coherency and coalescence.

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Crack Susceptibility Coefficient Property Model Settings.

Example

For an example, see PM_G_07: Hot Crack Susceptibility.
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Crack Susceptibility Coefficient Property Model Settings

The Crack Susceptibility Coefficient Property Model calculates the hot tearing tendency 
during solidification. 

This General Model is available when using the Property Model Calculator in Thermo-Calc.

When the default Clyne and Davies is selected as the CSC Model, the calculations use Scheil 
and assumptions of cooling rates under three different thermal conditions:      

 l Constant cooling rate, dT/dt = constant      
 l Constant heat flow, dQ/dt = constant
 l Heat flow proportional to 1/sqrt(time)

Theory and Example

For details about this more advanced model, see About the Crack Susceptibility Coefficient 
Property Model.

For an example, see PM_G_07: Hot Crack Susceptibility.

Configuration Settings

These settings  are found on the Property Model Calculator when Crack Susceptibility 
Coefficient is selected under General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

SCHEIL PARAMETERS

These parameters are the same as those used for the Scheil Calculator although 
some setting names are slightly different.
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The advanced Scheil settings are described with Scheil Advanced Options: Property Models.

SCHEIL START TEMPERATURE

Enter a Scheil start temperature for the Scheil simulation that is higher than the liquidus 
temperature of the alloy. Is given in the same unit as the temperature in the Condition 
Definitions.

SCHEIL CALCULATION TYPE

Click to select a Calculation type: Classic Scheil, Scheil with back diffusion in primary phase, 
or Scheil with solute trapping.  Then based on this selection, additional settings are made 
available as indicated.

See Additional Scheil Calculation Type Settings

The back diffusion and solute trapping options require the selection of a 
mobility database on the System Definer. 

FAST DIFFUSERS

Enter the element/component to make as Fast diffusers. Include a space between each 
entry, C N, for example, is the default entered for Carbon and Nitrogen to be fast diffusers.

ALLOW DELTA FERRITE TO AUSTENITE TRANSITION IN STEEL

This is available when Classic Scheil or Scheil with back diffusion in primary phase is 
selected.

Select the Allow delta ferrite to austenite transition in steel checkbox to enable BCC to FCC 
transition. 
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This feature should only be used for such steels for which it is reasonable to 
assume infinitely fast diffusion (equilibrium conditions) when delta ferrite is 
present. When the Allow delta ferrite to austenite transition in steel checkbox 
is selected in Graphical Mode or the DELTA_FERRITE_AUSTENITE_TRANSITION 
command used in Console Mode, this essentially assumes that diffusion can be 
considered (infinitely) fast when delta ferrite is present as a solid phase, i.e 
assumes an equilibrium condition. After delta ferrite is no longer stable, the 
usual Scheil assumptions for the selected calculation type are in effect. This 
setting is therefore not suitable for steels where you DO NOT have a complete 
BCC to FCC transition during solidification. This setting is also NOT available in 
combination with solute trapping.

SHOW ADVANCED SCHEIL OPTIONS

Click the Show advanced Scheil options checkbox to enter several settings related to Scheil 
calculations. See Scheil Advanced Options: Property Models.

CSC MODEL SELECTION

CSC MODEL

Choose a CSC Model: Clyne and Davies (the default), Kou, or Easton. 

Then continue with these additional settings: 

 l For Clyne and Davies go to Thermal Mode and Liquid Fraction Parameters (Clyne and 
Davies). 

 l For Easton, go to Solid Fraction for Coherency and Solid Fraction for Coalescence 
(Easton)

For details and references about these models, see About the Crack 
Susceptibility Coefficient Property Model.

ADDITIONAL SCHEIL CALCULATION TYPE SETTINGS
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COOLING RATE (BACK DIFFUSION)

This field is available when Scheil with back diffusion in primary phase is selected.

Specify the Cooling rate in Kelvin per second (K/s). An increased value moves the result from 
equilibrium toward a Scheil-Gulliver calculation.

SECONDARY DENDRITE ARM SPACING (BACK DIFFUSION)

This field is available when Scheil with back diffusion in primary phase is selected.

The Secondary dendrite arm spacing is the distance in meters between two secondary 
dendrite arms. It is calculated from the cooling rate as c*(cooling rate)-n where c and n are 
entered in these fields.

Enter  values  for Secondary dendrite arm spacing c and Secondary dendrite arm spacing n.

PRIMARY PHASE (BACK DIFFUSION AND SOLUTE TRAPPING)

This field is available when Scheil with back diffusion in primary phase or Scheil with solute 
trapping is selected.

The primary solidified phase is the phase where the back diffusion or solute trapping takes 
place. 

If Automatic (Scheil Calculator) or Any phase (Property Models) is selected (or kept as the 
default), the program tries to find the phase which gives the most back diffusion or solute 
trapping.

To override this setting, choose a specific primary phase from the list:

 l For back diffusion, only phases with diffusion data can be used as primary phases.
 l For solute trapping, only phases that dissolve all elements in the system can be used 

as primary phases.

SCANNING SPEED AND Α (SOLUTE TRAPPING)

These fields are available when Scheil with solute trapping is selected.

As needed, enter Scanning speed and α  to define the Calculated solidification speed.
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On the Scheil Calculator, the Calculated solidification speed is shown. For 
Property Models, below is how the values are calculated from the Scanning 
speed and α values entered.

The Calculated Solidification Speed is Vs = Vscanning * cos(α) m/s, where Vscanning is the user 
specified Scanning speed in m/s and α is the alpha angle, α, between the solid/liquid 
boundary and scanning direction.

THERMAL MODE AND LIQUID FRACTION PARAMETERS (CLYNE AND DAVIES)

These settings are available when Clyne and Davies is selected as the CSC Model.

THERMAL MODE

Select a Thermal mode for the solidification simulation:

 l Constant cooling rate,  dT/dt = constant
 l Constant heat flow, dQ/dt = constant

 l Heat flow proportional to 1/sqrt(time) (i.e. heat flow is proportional to  )

LIQUID FRACTION FOR START OF RELAXATION

Enter a value for the Liquid fraction for start of relaxation. 

LIQUID FRACTION TRANSITION TO VULNERABILITY

Enter a value for the Liquid fraction transition to vulnerability. 

LIQUID FRACTION SMALLEST TO VULNERABILITY

Enter a value for the Liquid fraction smallest to vulnerability.

SOLID FRACTION FOR COHERENCY AND SOLID FRACTION FOR COALESCENCE (EASTON)

These settings are available when Easton is selected as the CSC Model.
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SOLID FRACTION FOR COHERENCY

Enter a value in the Solid fraction for coherency field, which is the solid fraction for a 
coherent dendrite structure. The default is 0.7.

SOLID FRACTION FOR COALESCENCE

Enter a value in the Solid fraction for coalescence field, which is the solid fraction for 
coalescence of a dendrite structure. The default is 0.98.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Composition
 l Temperature
 l Crack Susceptibility coefficient. The tendency for the material to crack during 

solidification.
 l Liquidus temperature
 l Solidus temperature
 l Freezing range [K]. The solidification freezing range (Liquidus - Solidus) given in 

Kelvin.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 304 of 763

Driving Force Property Model Settings

Driving Force is a General Property Model available when using the Property Model 
Calculator in Thermo-Calc and it calculates the thermodynamic driving force for a phase 
divided by RT.

Example 

For an example, see PM_G_03: Driving Force and Interfacial Energy.

Configuration Settings

The settings  are found on the Property Model Calculator when Driving force is selected 
under General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

MATRIX PHASE

Choose a Matrix phase, the single phase region to start in. Select Any phase to use the 
phases that take part of the initial equilibrium or choose a specific phase.

PRECIPITATE PHASE

 Choose a Precipitate phase to calculate its driving force.

 Click the plus  and minus  buttons to add or remove Precipitate phases as needed.

Plot Renderer Settings

Plot Renderer and Configuration Settings
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When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Composition
 l Interfacial energy Ni [J/m2] 
 l Driving force per mole and then choose a unit: Joule, Calorie, Electron volt, 

Gigajoule, Watt hour, or Kilowatt hour.
 l Normalized driving force 
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About the Equilibrium with Freeze-in Temperature Property 
Model

The Equilibrium with Freeze-in Temperature Property Model calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature. 

The assumption is that diffusion and phase transformations are negligible when changing 
from the freeze-in-temperature and, therefore, that the phase amounts and compositions of 
phases are kept at the evaluation temperatures.

Typically, the freeze-in occurs during cooling where equilibrium can be assumed above the 
freeze-in temperature. This is the default setting and the Equilibrium above freeze-in 
temperature checkbox is automatically selected for this model. Change this default setting 
(i.e. click to clear the checkbox) when the frozen structure should be evaluated at a higher 
temperature than the freeze-in temperature.

The electrical resistivity due to phase interface scattering is evaluated as the scattering 
constant times sum of the interaction between the volume fraction of all the phases. The 
default value for the constant is 4.0e-8 Ωm. The contribution to thermal conductivity is 
assumed to be related to that of electrical resistivity, following the Wiedemann-Franz law.

A selection of homogenization functions is available for the evaluation of thermal- and 
electric-properties. Thermal and electric properties depend on the microstructure and the 
geometrical representation of phases in the microstructure can be linked to different 
homogenization functions. The homogenization function is applied on thermal- and 
electrical-resistivity. The electric conductivity, thermal conductivity, and thermal diffusivity 
are evaluated from the resistivities.

This Property Model uses thermophysical properties that are included with 
some Thermo-Calc databases such as the TCS Al-based Alloy Database (TCAL), 
which is used in the two examples included with your installation. For more 
information about the availability and the theory, see About Thermophysical 
Properties Data Parameters, Electrical Resistivity Model, and Thermal 
Conductivity Model.

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Equilibrium with Freeze-in Temperature Property Model Settings.
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Examples

For examples, see PM_G_10: Freeze-in Thermal Conductivity and PM_G_11: Freeze-in 
Electrical Resistivity.
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Equilibrium with Freeze-in Temperature Property Model Settings

The Equilibrium with Freeze-in Temperature Property Model calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature. The 
assumption is that diffusion and phase transformations are negligible when changing from 
the freeze-in-temperature and, therefore, that the phase amounts and compositions of 
phases are kept at all other temperatures.

Theory and Examples

For theory, see About the Equilibrium with Freeze-in Temperature Property Model.

For examples, see:

 l PM_G_10: Freeze-in Thermal Conductivity 
 l PM_G_11: Freeze-in Electrical Resistivity

Configuration Settings

The settings are found on the Property Model Calculator when the Equilibrium with Freeze-
in Temperature Model is selected under General Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

FREEZE-IN TEMPERATURE

Enter a Freeze-in temperature value in the field. The unit matches those selected under 
Condition Definitions. This is the temperature where the equilibrium is calculated.

The default is 623.15 K (350 °C).
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EQUILIBRIUM ABOVE FREEZE-IN TEMPERATURE

The Equilibrium above freeze-in temperature checkbox is selected by default and it 
calculates equilibrium above freeze-in temperature. Click to clear the checkbox when 
evaluating the frozen-in structure at higher temperatures than the freeze-in temperature.

EVALUATE FOR SINGLE PHASE ONLY

Select the Evaluate for a single phase only checkbox to evaluate the properties of a specific 
phase or deselect to evaluate the properties for the entire system.

PHASE FOR EVALUATION

This setting is available when the Evaluate for a single phase only checkbox is selected.

From the Phase for evaluation list, select any available phase or None.

EQUILIBRIUM MINIMIZATION STRATEGY

Select an Equilibrium minimization strategy. The default uses the Local minimization 
preferred option.

The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.

With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:

 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.
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HOMOGENIZATION FUNCTION

The Homogenization function is used for the evaluation of the systems thermal and electric 
properties. The function is applied on thermal- and electrical-resistivity. The electric 
conductivity, thermal conductivity, and thermal diffusivity are evaluated from the 
resistivities.

The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical 
shells of each phase.

 l Rule of mixtures (upper Wiener bound): the geometrical interpretation are 
continuous layers of each phase parallel with the direction of evaluation of the 
property.

 l Inverse rule of mixtures (lower Wiener bound): The geometrical interpretation are 
continuous layers of each phase orthogonal to the direction of evaluation of the 
property.

 l General lower Hashin-Shtrikman bound: The outermost shell consists of the phase 
with the most sluggish property.

 l General upper Hashin-Shtrikman bound: The innermost shell consists of the phase 
with the most sluggish property.

 l Hashin-Shtrikman bound with majority phase as matrix phase: The outermost shell 
consists of the phase with the highest local volume fraction.

ACCOUNT FOR PHASE INTERFACE SCATTERING

The Account for phase interface scattering checkbox is selected by default.

The electrical resistivity due to phase interface scattering is evaluated as the scattering 
constant times sum of the interaction between the volume fraction of all the phases. The 
default value for the constant is 4.0e-8 Ωm. The contribution to thermal conductivity is 
assumed to be related to that of electrical resistivity, following the Wiedemann-Franz law.

PHASE INTERFACE SCATTERING CONSTANT

This setting is available when the Account for phase interface scattering checkbox is 
selected.

The Phase interface scattering constant default value is 4.0e-8 Ωm.
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SET REFERENCE TEMPERATURE FOR TECHNICAL CTE

This setting is available when the Account for phase interface scattering checkbox is 
selected.

In the field, enter the Reference temperature for technical CTE, where CTE is the coefficient 
of thermal expansion. Typically room temperature is used as the default 293.15 K (20 °C).

DEFINE USER FUNCTIONS

Select the Define user functions checkbox to enter up to two User-defined functions using 
the Console Mode syntax.

For an example of user-defined functions, see T_07: User-Defined Functions.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Temperature
 l Electric resistivity (ohm m) (Ωm)
 l Electric conductivity (S/m)
 l Thermal conductivity (W/(mK))
 l Thermal resistivity (mK/W)
 l Thermal diffusivity (m2/s)
 l Heat capacity (J/mol K))
 l Volume (m3/mol)
 l Density (g/cm3)
 l Linear CTE (technical) (1/K): Fractional change of length per unit temperature 

change. Calculated as (L1-L0)/(T1-T0)/L0, where L0 is the length at a reference 
temperature T0. T0 is by default equal to room temperature. Assumed Isotropic 
material.
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 l Linear CTE (physical) (1/K): Fractional change of length per unit temperature change. 
Assumed Isotropic material.

 l Volumetric CTE (physical) (1/K): Fractional change of volume per unit temperature 
change.

 l User-defined function and 2nd user-defined function: Available when the Define 
user functions checkbox is selected and the functions are defined.
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Equilibrium Property Model Settings

Equilibrium is a General Property Model available when using the Property Model Calculator 
in Thermo-Calc and it calculates the equilibrium for the given conditions. 

When you use this Model with the Property Model Calculator, it is the same 
calculation result as when you are using an Equilibrium Calculator with the 
Single equilibrium calculation type. 

Configuration Settings

The settings  are found on the Property Model Calculator when Equilibrium is selected under 
General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

EQUILIBRIUM MINIMIZATION STRATEGY

Select an Equilibrium minimization strategy. The default uses the Global test preferred 
option. For this Property Model, and for either Global option, also enter the Max number of 
global gridpoints, where the default is 2000.

The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.

With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:
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 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.

QUANTITY DEFINITIONS

For Quantity Definitions define Q1. Click the Add  button to define additional items and 
the Remove  button to delete items. 

Then from the lists, choose the variable for each quantity to define. The quantities are called 
Q1, Q2, Q3 and so on. 

All quantities that normally can be obtained from an equilibrium calculation can also be 
obtained when plotting the results. 

FUNCTION DEFINITIONS

For Function Definitions, define Function 1. Click the Add  button to define additional 
items and the Remove  button to delete items. In the left field edit the default name of 
each function and enter the function itself in the right field after the equal sign. 

To learn about using variables and functions, in Graphical Mode, see T_07: User-
Defined Functions and in Console Mode, see example 44  .

You can also use Console Mode syntax when entering the function. See 
Parameters, Functions, and Variables for details.

Plot Renderer Settings

Plot Renderer and Configuration Settings
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When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

All quantities that normally can be obtained from an equilibrium calculation can also be 
obtained when plotting  the results as well as the defined functions.

Conditions Tab Settings
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About the Interfacial Energy Property Model

Interfacial Energy is a Property Model available when using the Property Model Calculator in 
Thermo-Calc. 

Interfacial energy is an important parameter used in precipitation simulations to calculate 
the rates of nucleation, growth/dissolution, and coarsening. The value of interfacial energy 
can vary dramatically (usually between 0.01 to 2.0 J/m2).

The extended Becker’s model functions to estimate coherent interfacial energy by using 
thermodynamic data from existing CALPHAD thermodynamic databases: 

where  is the coherent interfacial energy,  is the number of atoms per unit area at the 
interface,  is the number of cross bonds per atom at the interface,  is the coordination 
number of an atom within the bulk crystal lattice, and  is the energy of solution in a 
multicomponent system involving the two phases being considered [1938Bec].

Reference

[1938Bec] R. Becker, Die Keimbildung bei der Ausscheidung in metallischen Mischkristallen. 
Ann. Phys. 424, 128–140 (1938). 

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Interfacial Energy Property Model Settings.
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Interfacial Energy Property Model Settings

Interfacial Energy is a Property Model available when using the Property Model Calculator in 
Thermo-Calc and is used to estimate the interfacial energy between a matrix phase and a 
precipitate phase using thermodynamic data from a CALPHAD database. The approximation 
model is based on Becker's bond energy approach and is also available in Precipitation 
Module (TC-PRISMA). 

In the actual calculation, the coefficients taken distinguish between only bcc 
and fcc structure for the (110) and (111) lattice plane, respectively. 

For other planes and/or other phases, the estimate is approximate. In most situations, it is 
recommended to perform calibrations against some experimental data because the 
interfacial energy is dependent on so many factors that are ignored in the estimation, for 
example entropy, incoherency, orientation, and curvature, etc. Uncertainty factors must also 
be considered as thermodynamic data in CALPHAD databases are not always accurate. 

Theory and Example

For theory see About the Interfacial Energy Property Model.

For an example, see PM_G_02: Coarsening and Interfacial Energy.

Configuration Settings

The settings  are found  on the Property Model Calculator when Interfacial energy is selected 
under General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

MATRIX PHASE

Choose a Matrix phase to calculate the interfacial energy [J/m2].
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PRECIPITATE PHASE

 Choose a Precipitate phase to calculate the interfacial energy [J/m2].

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Temperature
 l Interfacial energy Ni [J/m2] for it to be between the matrix and precipitate phase.
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Liquid and Solidus Temperature Property Model Settings

Liquidus and solidus temperature is a Property Model available when using the Property 
Model Calculator in Thermo-Calc. It calculates the equilibrium solidification range in terms of 
temperature. If only the liquidus temperature is required, the calculation times are reduced.

Configuration Settings

The settings are found on the Property Model Calculator when Liquidus and solidus 
temperature is selected under General Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

ONLY CALCULATE LIQUIDUS TEMPERATURE

Select the Only calculate liquidus temperature checkbox as required. When selected, this 
improves the calculation speed but the solidus is not calculated.

LIQUID PHASE

Choose the Liquid phase of the system. This is a fallback choice. Normally this should be 
handled automatically, even if multiple liquid phases are present.

UPPER TEMPERATURE SEARCH LIMIT

Enter an Upper temperature search limit to calculate for a temperature above liquidus for 
any of the considered compositions. This needs to be in the fully liquid state.

MAX. NUMBER OF ITERATIONS

Enter a Max. number of iterations, which is the maximum number of phase transformation 
iterations performed. The default is 10.
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GLOBAL MINIMIZATION (LIQUIDUS AND SOLIDUS)

Select the Global minimization for liquidus and/or Global minimization for solidus 
checkboxes to find all phases present in the equilibria.

Selecting one or both checkboxes can significantly slow down the calculations 
but ultimately it produces more reliable results.

Global minimization recommendation: First try to calculate without global 
minimization, then if inaccuracies occur, switch global minimization on. 
Problems mostly occur if many phases are present at a given temperature.

SUSPEND GAS PHASE

Select the Suspend gas phase checkbox as required. The occurrence of a gas phase may 
mislead the liquidus temperature determination. If the presence of the gas phase is 
absolutely required, you can activate it and then choose a user-defined phase.

GAS PHASE

Choose a Gas phase from the list.

PRINT RESULTS IN EVENT LOG

Select the Print results in Event Log checkbox to display/include all results in the Event Log 
window. This includes the First solidified phase, Liquidus (K), Solidus (K), and Composition 
information. Choose the Output type: Single row or Full list for each iteration.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:
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 l Composition
 l Temperature
 l Liquidus temperature
 l Solidus temperature
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Phase Transition Property Model Settings

The Phase Transition Property Model is available when using the Property Model Calculator 
in Thermo-Calc. By varying which condition to relax, it calculates the point when a new 
phase may form. It is useful to determine melting temperature, boiling temperature or 
solubility limits. It returns the phase transformation temperature, or composition, 
depending on the relaxed condition.

For an example, see PM_G_01: Phase Transition.

Configuration Settings

The settings are found on the Property Model Calculator when Phase transition is selected 
under General Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

MATRIX PHASE

Choose a Matrix phase, the single phase region to start in. Select Any phase to use the 
phases that take part of the initial equilibrium or choose a specific phase.

PHASE TO FORM

For the new Phase to form, select Any phase or choose a specific phase.

CONDITION TO VARY

Choose a composition or temperature Condition to vary when calculating the phase 
transition.
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SUSPEND ALL OTHER PHASES

Select the Suspend all other phases checkbox to suspend the phases that are not of 
interest, which allows for a faster calculation. However, this could mean that metastable 
equilibria are in fact calculated.

It is best practice to suspend phases on the System Definer by selecting the 
applicable phases on the Phases and Phase Constitution tab.

SEARCH DIRECTION

For the composition or temperature condition being varied, choose the Search direction to 
be in a Positive, Negative, or Positive and Negative direction.

The start value is taken from Condition Definitions. The closer the start value is 
to the actual transition point, the more likely it is that the model will find the 
transition. Note that the phase transition for a given phase may actually occur 
in the opposite direction from the selected one.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Composition
 l Temperature
 l Relaxed condition: Composition
 l Relaxed condition: Temperature
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Since only one variable can serve as a Relaxed condition per calculation, the 
quantity that is not relaxed has a NaN result in its corresponding result 
quantity. The Temperature result quantity inherits the unit set in the conditions 
while the Composition result quantity inherits the normalization (mole or mass) 
but always returns a fraction.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 325 of 763

Scheil Property Model Settings

Scheil is a Property Model available when using the Property Model Calculator in 
Thermo-Calc. lt is used to calculate solidification under the Scheil assumption. The majority 
of the Model  input parameters are taken from the Scheil Calculator to offer the outputs of 
the liquidus/solidus/solidification range so you can explore these in the calculation types of 
the Property Models.

For theory or background details about Scheil, start by reviewing Scheil-Gulliver 
Solidification Calculations. 

Configuration Settings

The settings are found on the Property Model Calculator when Scheil is selected under 
General Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

The advanced Scheil settings are described with Scheil Advanced 
Options: Property Models.

These parameters are the same as those used for the Scheil Calculator although 
some setting names are slightly different.
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SCHEIL START TEMPERATURE

Enter a Scheil start temperature for the Scheil simulation that is higher than the liquidus 
temperature of the alloy. Is given in the same unit as the temperature in the Condition 
Definitions.

CALCULATION TYPE

Click to select a Calculation type: Classic Scheil, Scheil with back diffusion in primary phase, 
or Scheil with solute trapping.  Then based on this selection, additional settings are made 
available as indicated.

The back diffusion and solute trapping options require the selection of a 
mobility database on the System Definer. 

FAST DIFFUSERS

Enter the element/component to make as Fast diffusers. Include a space between each 
entry, C N, for example, is the default entered for Carbon and Nitrogen to be fast diffusers.

CALCULATE TO

Use the Calculate to setting to choose from where the calculation should end, End of Scheil 
or Temperature below solidus. 

 l End of Scheil stops the calculation when the Scheil calculation is finished. 

 l Temperature below solidus is where a frozen structure is assumed below solidus. 
When this is selected also enter a Temperature below solidus in the field. The 
default is 298.15.

ALLOW DELTA FERRITE TO AUSTENITE TRANSITION IN STEEL

This is available when Classic Scheil or Scheil with back diffusion in primary phase is 
selected.

Select the Allow delta ferrite to austenite transition in steel checkbox to enable BCC to FCC 
transition. 
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This feature should only be used for such steels for which it is reasonable to 
assume infinitely fast diffusion (equilibrium conditions) when delta ferrite is 
present. When the Allow delta ferrite to austenite transition in steel checkbox 
is selected in Graphical Mode or the DELTA_FERRITE_AUSTENITE_TRANSITION 
command used in Console Mode, this essentially assumes that diffusion can be 
considered (infinitely) fast when delta ferrite is present as a solid phase, i.e 
assumes an equilibrium condition. After delta ferrite is no longer stable, the 
usual Scheil assumptions for the selected calculation type are in effect. This 
setting is therefore not suitable for steels where you DO NOT have a complete 
BCC to FCC transition during solidification. This setting is also NOT available in 
combination with solute trapping.

SHOW ADVANCED SCHEIL OPTIONS

Click the Show advanced Scheil options checkbox to enter several settings related to Scheil 
calculations. See Scheil Advanced Options: Property Models.

COOLING RATE (BACK DIFFUSION)

This field is available when Scheil with back diffusion in primary phase is selected.

Specify the Cooling rate in Kelvin per second (K/s). An increased value moves the result from 
equilibrium toward a Scheil-Gulliver calculation.

SECONDARY DENDRITE ARM SPACING (BACK DIFFUSION)

This field is available when Scheil with back diffusion in primary phase is selected.

The Secondary dendrite arm spacing is the distance in meters between two secondary 
dendrite arms. It is calculated from the cooling rate as c*(cooling rate)-n where c and n are 
entered in these fields.

Enter  values  for Secondary dendrite arm spacing c and Secondary dendrite arm spacing n.

PRIMARY PHASE (BACK DIFFUSION AND SOLUTE TRAPPING)

This field is available when Scheil with back diffusion in primary phase or Scheil with solute 
trapping is selected.
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The primary solidified phase is the phase where the back diffusion or solute trapping takes 
place. 

If Automatic (Scheil Calculator) or Any phase (Property Models) is selected (or kept as the 
default), the program tries to find the phase which gives the most back diffusion or solute 
trapping.

To override this setting, choose a specific primary phase from the list:

 l For back diffusion, only phases with diffusion data can be used as primary phases.
 l For solute trapping, only phases that dissolve all elements in the system can be used 

as primary phases.

SCANNING SPEED AND Α (SOLUTE TRAPPING)

These fields are available when Scheil with solute trapping is selected.

As needed, enter Scanning speed and α  to define the Calculated solidification speed.

On the Scheil Calculator, the Calculated solidification speed is shown. For 
Property Models, below is how the values are calculated from the Scanning 
speed and α values entered.

The Calculated Solidification Speed is Vs = Vscanning * cos(α) m/s, where Vscanning is the user 
specified Scanning speed in m/s and α is the alpha angle, α, between the solid/liquid 
boundary and scanning direction.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Temperature
 l Liquidus temperature
 l Solidus temperature
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 l Freezing range, Scheil [K]. The solidification freezing range (Liquidus - Solidus) given 
in Kelvin.

 l Volume fraction of solid phases: The volume fraction of solid phases (evaluated at 
the lowest temperature from the simulation)

 l Mole fraction of solid phases: The mole fraction of solid phases (evaluated at the 
lowest temperature from the simulation)

 l Total fraction of solid phases: The total mole fraction of solid phases (evaluated at 
the lowest temperature from the simulation)

 l Eutectic fraction: Eutectic fraction at eutectic point (evaluated using Gibbs phase 
rule).

 l Electric resistivity (ohm m)
 l Electric conductivity (S/m)
 l Thermal conductivity (W/mK))
 l Thermal resistivity (MK/W)
 l Thermal diffusivity (m2/s)
 l Volumetric shrinkage (vol-%)
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About the Spinodal Property Model

Spinodal is a Property Model available when using the Property Model Calculator in 
Thermo-Calc and it calculates the spinodal line.

The spinodal is defined by the condition where the second derivative of Gibbs free energy is 
zero (d2G/dx2 = 0). The locus of these points is known as the spinodal curve. 

With this Model up to two spinodal solutions can be found. When searching for the spinodal 
you can vary the temperature or a composition in mass percent, mole percent, mass 
fraction, or mole fraction (e.g. mass percent Fe, mole percent Fe, and so forth). 

When within the miscibility gap, but above the spinodal curve, phase transformation occur 
by classical nucleation and growth of the spinodal phase. When within the miscibility gap, 
but below the spinodal curve, the phase transformation occur by spinodal decomposition of 
the spinodal phase.

The microstructure evolution of spinodal decomposition can be calculated with 
the phase field method. For some background information see [2018Bar]. 

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Spinodal Property Model Settings.

Example

For an example, see PM_G_08: Spinodal.

Reference

[2018Bar] T. Barkar, PhD thesis, Modelling phase separation in Fe-Cr alloys: A continuum 
approach, KTH Royal Institute of Technology, Sweden (2018).
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Spinodal Property Model Settings

Spinodal is a General Property Model available when using the Property Model Calculator in 
Thermo-Calc and it calculates the spinodal line. 

Theory and Example

For theory, see About the Spinodal Property Model.

For an example, see PM_G_08: Spinodal.

Configuration Settings

These settings  are found on the Property Model Calculator when Spinodal is selected under 
General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

SPINODAL PHASE

From the Spinodal phase list select the applicable phase you want to search for the 
spinodal. 

CONDITION TO VARY

From the Condition to vary list select an option  to vary when searching for the spinodal. Up 
to two spinodals can be found. These options are Temperature or those based on the 
Composition (e.g. Fe, Cr, and so forth) and Composition unit (i.e. Mass percent, Mole 
percent, Mass fraction, or Mole fraction). 
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MANUAL SEARCH LIMITS

The Manual search limits checkbox is not selected by default and this sets automatic search 
limits. 

Select the checkbox to enter user-defined search limits in the fields. Enter the Lower 
condition limit and Upper condition limit. Then enter the number of steps when estimating 
the position(s) of the spinodal(s)in the Steps when estimating spinodal field. 

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Composition
 l Spinodal temperature: The first spinodal when the search condition is temperature.
 l Spinodal temperature - 2nd solution: The second spinodal when the search 

condition is temperature.
 l Spinodal: The first spinodal regardless of search condition type.
 l Spinodal - 2nd solution: The second spinodal regardless of search condition type.
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About the T0 Temperature Property Model

T-Zero Temperature is a Property Model available when using the Property Model 
Calculator in Thermo-Calc and it calculates the so-called  line.  

The T0 temperature is defined as the temperature where two phases of identical chemical 
composition have the same molar Gibbs free energy. This temperature is an important 
quantity in the field of diffusionless phase transformations, e.g. martensitic transformation, 
since it is the upper limit where diffusionless phase transformations can occur.

Vary Temperature or Conditions

With this Model up to two  solutions can be found. When searching for  you can vary the 
condition of temperature or element composition in units of mass percent  (e.g. mass 
percent Fe). This is managed using the settings Condition to vary and in some cases, Manual 
search limits.

When Temperature is the varied condition,  is obtained as a solution. When 
a specific composition is selected as the condition to vary,  then the 
temperature(s) is calculated when the  condition is fulfilled. So the resulting 
temperature is equal to .

In most cases the curvature of the Gibbs energies of the two phases is different 
and results in multiple solutions for . If you keep the default settings 
(Condition to vary → Temperature and with no manual search limits) the 
Property Model Calculator can store up to two solutions. If the solution of 
interest is not calculated, including Manual search limits and/or changing the 
condition to vary to one of the listed compositions, allows you to find the  
solution of interest.

Gibbs Energy Addition

There is also an option to include a Gibbs energy addition to the second phase, which allows 
for inclusion of an energy barrier for martensitic phase transformations. This is done using 
the Energy addition second phase [J/mol] setting.
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The energy addition field in Graphical Mode corresponds to the Console Mode 
command ADVANCED_OPTIONS PHASE_ADDITION (see EQUILIBRIUM_CALCUL for 
information). However, the energy addition can also be composition- and/or 
temperature-dependent, which is not possible in Console Mode. In addition, 
Property Models are not available in Console Mode. However, You can access 
the functionality using methods available with an applicable API such as TC-
Python or TC-Toolbox for MATLAB®

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in T0 Temperature Property Model Settings.

Examples

For examples, see PM_G_09: T-Zero Temperature and PM_G_14: Ti-Fe T-Zero Martensite
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T0 Temperature Property Model Settings

T-Zero Temperature is a Property Model available when using the Property Model 
Calculator in Thermo-Calc and it calculates the so-called T0 line. 

Theory and Examples

For theory see About the T0 Temperature Property Model.

For examples, see:

 l PM_G_09: T-Zero Temperature 
 l PM_G_14: Ti-Fe T-Zero Martensite

Configuration Settings

These settings  are found on the Property Model Calculator when T-Zero Temperature is 
selected under General Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

FIRST PHASE

From the First phase list select the applicable phase you want to search for the evaluation of 
Gibbs energy. 

SECOND PHASE

From the Second phase list select the applicable phase you want to search for the 
evaluation of Gibbs energy. 
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ENERGY ADDITION SECOND PHASE

Use the Energy addition second phase [J/mol] field to include a Gibbs energy addition to 
the second phase. This allows for inclusion of an energy barrier for martensitic phase 
transformations. 

For an example of this see PM_G_14: Ti-Fe T-Zero Martensite.

CONDITION TO VARY

From the Condition to vary list select an option  to vary when searching for the solution (or 
root). Up to two solutions can be found. These options are Temperature or those based on 
the Composition + Composition unit for example Mass percent Fe, Mass percent Cr, Mass 
percent Ni, and so forth. 

When Temperature is the varied condition,  is obtained as a solution. When 
a specific composition is selected as the condition to vary,  then the 
temperature(s) is calculated when the  condition is fulfilled. So the resulting 
temperature is equal to .

In most cases the curvature of the Gibbs energies of the two phases is different 
and results in multiple solutions for . If you keep the default settings 
(Condition to vary → Temperature and with no manual search limits) the 
Property Model Calculator can store up to two solutions. If the solution of 
interest is not calculated, including Manual search limits and/or changing the 
condition to vary to one of the listed compositions, allows you to find the  
solution of interest.

MANUAL SEARCH LIMITS

The Manual search limits checkbox is not selected by default and this sets automatic search 
limits. 
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Select the checkbox to enter user-defined search limits in the fields. Enter the Lower 
condition limit and Upper condition limit. Then in the Steps when estimating root(s) field, 
enter the number of steps in a linear grid when estimating the position(s) of the conditions. 

Root means a solution of , so a composition and temperature where the 
Gibbs energies are the same. In other words, it finds the "root(s)" where the 
two selected phases have equal Gibbs energy. Think of the "root" as the 
conditions (temperature, composition) where the Gibbs energy of the two 
selected phases intersect, i.e. have equal Gibbs energies.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Composition, when the search condition is temperature
 l Temperature, when the search condition is composition (in this case temperature is 

equal to T-Zero.
 l T-Zero: The first root (solution) when the search condition is temperature.
 l T-Zero - 2nd solution: The second root (solution) when the search condition is 

temperature.
 l Varied condition: The first varied condition regardless of search condition type.
 l Varied condition - 2nd solution: The second varied condition regardless of search 

condition type.
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About the Yield Strength Property Model

The Yield Strength Model is a general model to estimate the yield stress of a material that 
considers these contributions to the overall yield stress of the material:

 l Intrinsic strength ( ) for the pure elements,
 l Grain boundary strengthening ( ),
 l Solid solution strengthening ( ),
 l Precipitation strengthening ( ), and
 l A user set, constant strength contribution ( ).

The temperature ( ) is used to evaluate the equilibrium state of the system, and the 
resulting compositions and phase fractions are subsequently used in the evaluation of 
mechanical properties.

It returns the calculated yield strength at room temperature for the specified material using 
the equilibrium values calculated at temperature  (i.e.  is the freeze-in temperature).

Below follows a short summary for each of the contributions.

Intrinsic Strength

The intrinsic strength model formulation for this Property Model corresponds to a surface of 
reference with end-members. For example, for FCC_A1 modeled as (Fe,Ti)(C,Va), the 
intrinsic strength is a linear combination (as given by the composition) of Fe:Va (i.e. pure FCC 
Fe), Ti:Va (i.e. pure FCC Ti), Fe:C (i.e., FCC FeC) and Ti:C (i.e., FCC TiC). With such an 
implementation, it is possible to calculate yield strength for materials with a significant 
fraction of hard phases, such as carbides, embedded in a soft matrix and the intrinsic 
strengthening effect of interstitial elements.

The general form of the intrinsic strength model follows in the spirit of the Compound 
Energy Formalism (CEF) surface of reference term, where the intrinsic strength for, e.g., a 
two-sublattice phase model would correspond to:

Such a formulation means that the intrinsic strength depends on the calculated site fractions 
from, e.g., an equilibrium calculation.
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Phases with Assessed Intrinsic Strength

Not all compound phases are yet assessed in terms of intrinsic strength.  The 
following phases are assessed: BCC_A2, CEMENTITE_D011, FCC_A1, FCC_L12, 
HCP_A3, M23C6_D84, M3C2_D510, M6C_E93, M7C3_D101, MC_SHP.

Temperature Dependence for Pure Elements

The following pure elements can be used to evaluate yield strength at non-room 
temperature conditions:

 l Ag, Al, Au, Be, Ce, Co, Cr, Cu, Dy, Er, Fe, Gd, Hf, Ho, Ir, La, Mg, Mo, Nb, Nd, Ni, Pd, Pt, 
Rh, Sm, Ta, Ti, U, V, W, Y, Zn, and Zr

The temperature dependence is of the form:

and is available for the listed pure elements where  and  are fitted to data from 
[1968Sam; 2017Wu]. This improves the results for evaluated yield strength at non-room 
temperature conditions.

The calculated solid solution strength can differ from versions of Thermo-Calc 
prior to 2022b where the pure element strength from Cordero et al. was used 
[2016Cor]. This is especially noticeable for pure element or dilute solution 
calculations. The pure element strength is only evaluated for FCC, BCC, and 
HCP.

Compound end-members of the intrinsic model are not modeled as 
temperature dependent, however, this should have only a small effect on most 
alloys.

Constant Addition of Strength

The constant strength contribution parameter, , is set by the user as a constant strength 
addition to the material.
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Grain Boundary Strengthening

The grain boundary strengthening, , is the contribution to the total strength stemming 
from the grain boundary's ability to hinder dislocation movement described by the Hall-
Petch relation [2004Han].

The parameters entered are the Hall-Petch constant, , in MPa μm1/2, and the average 
grain diameter in μm.

Solid Solution Strengthening

The solution strengthening, , is the contribution to total strength due to the elastic strains 
in the crystal lattice caused by alloying elements of a lattice parameter differing from the 
main constituent. For the solid solution strengthening the option of evaluating the strength 
at any temperature is available. The result is normalized with respect to the sum of all mole 
fractions for FCC, BCC, and HCP. This option uses the phase fractions and compositions 
calculated at the overall equilibrium temperature. The model by Walbrühl et al. [2017Wal] is 
implemented.

PM_G_06: Yield Strength HEA shows how this model is applied.

Precipitation Strengthening

The precipitation strengthening, , is the contribution to total strength due to precipitation 
of a secondary phase, e.g. gamma prime (γ') in Ni-base alloys or Al3Sc precipitates in Al-base 
alloys. This model is available for any number of precipitating phases. The total particle 
strength is calculated by the square mean of the individual particle strength contributions:

The Simplified model (general), Seidman model (Al-base), Reppich model (Ni-based), and 
Deschamps model (Al-base) are available as settings on the Configuration window to 
estimate the precipitation strengthening contribution. These are briefly described next.

Simplified Model (General)

The Simplified model (general) is based on the work by Zander et al. [2008Zan] and 
considers the general mechanisms of cutting and looping without regard to any detailed 
dislocation mechanisms. The default parameters are, however, optimized against 
experimental data for the Al-0.3wt%Sc alloy described by Seidman et al. [2002Sei]. Also see 
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Mean Precipitate Radius and Particle Size Distribution (PSD) below.

PM_G_04: Yield Strength compares the Simplified model (general), Seidman 
model (Al-base), and Deschamps model (Al-base) yield strength versus 
precipitate radius to experimental data for an Al-0.3wt%Sc alloy homogenized at 
648 °C for 24 hours and subsequently aged at 350 °C.

Seidman Model (Al-base)

The Seidman model (Al-base) by Seidman et al. [2002Sei] considers several contributions to 
the overall precipitation strengthening - ordering, coherency stresses, shear modulus 
mismatch, and Orowan looping. The Seidman model is suitable for Al-base alloys with a low 
volume fraction of spherical precipitates. Also see Mean Precipitate Radius and Particle Size 
Distribution (PSD) below.

PM_G_04: Yield Strength compares the Simplified model (general), Seidman 
model (Al-base), and Deschamps model (Al-base) yield strength versus 
precipitate radius to experimental data for an Al-0.3wt%Sc alloy homogenized at 
648 °C for 24 hours and subsequently aged at 350 °C.

Reppich Model (Ni-base)

The Reppich model (Ni-base) by Reppich et al. [1982aRep] considers both weak and strong 
coupling of dislocation as they propagate through an ordered secondary phase and is thus 
suitable for Ni-base alloys with relatively high volume fractions of gamma prime or gamma 
double prime. Also see Mean Precipitate Radius and Particle Size Distribution (PSD) below.

The Reppich model is not valid for very small values of volume fraction 
precipitate and precipitate radius.

PM_G_05: Yield Strength NiAlCr is an example of this model.
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Figure 15: Reppich model plotted with results and experimental data for PE16 [1982bRep], all 
data is normalized with the square root of the volume fraction of precipitate.
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Figure 16: Reppich model yield strength vs mean precipitate radius for Ni-10Cr-10Al.

Deschamps Model (Al-base)

The Deschamps model (Al-base) by Deschamps and Brechet [1998Des] considers 
contributions to the overall precipitation strengthening precipitate from particle cutting and 
Orowan looping. The Deschamps model is suitable for Al-base alloys with a low volume 
fraction of spherical precipitates. However, it has been successfully validated against other 
alloy types, such as Fe-based ferritic materials with TiC precipitates. Also see Mean 
Precipitate Radius and Particle Size Distribution (PSD) below.

The Deschamps model considers Friedel statistics as a default setting, with the option to 
instead apply Kock's statistics, as shown in the PM_G_04 example.
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PM_G_04: Yield Strength compares the Simplified model (general), Seidman 
model (Al-base), and Deschamps model (Al-base) yield strength versus 
precipitate radius to experimental data for an Al-0.3wt%Sc alloy homogenized at 
648 °C for 24 hours and subsequently aged at 350 °C.

Mean Precipitate Radius and Particle Size Distribution (PSD)

The mean precipitate radius entered on the Configuration window for all precipitation 
strengthening models is transformed to a Lifshitz-Slyozov-Wagner (LSW) particle size 
distribution [2010Tir]. The distribution is stepwise integrated and the mean radius for all 
sections are used to calculate a partial precipitate strengthening contribution. The partial 
contributions are added as

The use of a PSD smooths the transition between the cutting and Orowan regions. This 
change is implemented for the Simplified model (general) and Seidman model (Al-base).

When using the Yield Strength Model with the Precipitation Module (TC-PRISMA) the PSD as 
calculated by Precipitation Module (TC-PRISMA) is used for each time step. Also see 
Precipitation Calculator Plot Renderer for the settings input related to this.

Configuration Settings and References

Configuration Settings

The settings are entered on the Configuration window for the Property Model Calculator 
and described in Yield Strength Property Model: Simplified Mode Settings and Yield Strength 
Property Model: Advanced Mode Settings.

Yield strength is also available as a variable when working with Plots and Tables 
that are successors to the Precipitation Calculator.
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Yield Strength Property Model: Simplified Mode Settings

This section has information about the Simplified mode configuration settings available for 
the Yield Strength Property Model.

The Yield Strength Model is available with the Property Model Calculator and calculates 
yield stress.

Yield strength is also available as a quantity when working with Plots and Tables 
that are successors to the Precipitation Calculator.

The Yield Strength Model returns the calculated yield strength at room temperature (per 
default) for the specified material using the equilibrium values calculated at temperature  
(i.e.  is the freeze-in temperature). The Model is defined by further setting these 
contributions:

 l Intrinsic strength ( )
 l Solid solution strengthening ( )
 l Grain boundary strengthening ( )
 l Precipitation strengthening ( )
 l Constant strength addition ( )

These contributions are defined in About the Yield Strength Property Model.

For examples using the Property Model Calculator, see PM_G_04: Yield 
Strength, PM_G_05: Yield Strength NiAlCr, and PM_G_06: Yield Strength HEA.

For an example when it is available as an axis variable with the Precipitation 
Calculator, see P_01: Isothermal Precipitation of Al3Sc.

General Configuration Settings

The settings for these contributions are found on the Property Model Calculator when the 
Yield Strength Model is selected under General Models.

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.
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There are settings described elsewhere when Yield Strength is selected as an 
axis variable for a Plot Renderer or Table Renderer that are successors to the 
Precipitation Calculator.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

Simplified Mode Settings

Select Simplified as the Mode.

If the following set up is not sufficient for your simulation, see the Yield 
Strength Property Model: Advanced Mode Settings for more detailed options.

For all calculations in Simplified Mode, the automatically applied settings are as follows:

 l Equilibrium minimization strategy is Global test preferred.
 l The matrix phase is automatically identified.
 l Burgers vector is calculated.
 l Shear modulus for the matrix is calculated.

SOLID SOLUTION STRENGTHENING (SIMPLIFIED MODE)

Select the Solid solution strengthening checkbox to include solid solution strengthening in 
the calculation.

GRAIN BOUNDARY STRENGTHENING AND GRAIN SIZE (SIMPLIFIED MODE)

Click to select the Grain boundary strengthening checkbox to include calculated grain 
boundary strengthening ( ). Then enter the Grain size [um], which is the grain diameter in 
μm.
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PRECIPITATION STRENGTHENING (SIMPLIFIED MODE)

Click to select the Precipitation strengthening checkbox to include calculated precipitation 
strengthening ( ).

In Simplified Mode, the default Precipitation strength model is automatically 
the Deschamps model (Al-base). However, if the major element is Ni and 
gamma prime is present in the system, the Reppich model (Ni-base) is used 
instead.

Then enter the following settings.

 l Select a Precipitate from the list.
 l Enter a Mean precipitate radius. The unit is meter (m).
 l Enter a Critical radius ( ), which determines the mean precipitate radius where 

transition between cutting and looping occurs. The unit is meter (m).

CONSTANT STRENGTH ADDITION (SIMPLIFIED MODE)

Enter a value for the Constant strength addition, . The unit is MPa.

Additional Settings

 l Yield Strength Property Model: Calculation Type and Grid Definitions
 l Yield Strength Property Model: Calculation Type and Grid Definitions
 l Yield Strength Property Model: Plot and Table Settings

Yield Strength Property Model: Advanced Mode Settings

This section has information about the Advanced mode configuration settings available for 
the Yield Strength Property Model.

The Yield Strength Model is available with the Property Model Calculator and calculates 
yield stress.

Yield strength is also available as a quantity when working with Plots and Tables 
that are successors to the Precipitation Calculator.
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The Yield Strength Model returns the calculated yield strength at room temperature (per 
default) for the specified material using the equilibrium values calculated at temperature  
(i.e.  is the freeze-in temperature). The Model is defined by further setting these 
contributions:

 l Intrinsic strength ( )
 l Solid solution strengthening ( )
 l Grain boundary strengthening ( )
 l Precipitation strengthening ( )
 l Constant strength addition ( )

These contributions are defined in About the Yield Strength Property Model.

For examples using the Property Model Calculator, see PM_G_04: Yield 
Strength, PM_G_05: Yield Strength NiAlCr, and PM_G_06: Yield Strength HEA.

For an example when it is available as an axis variable with the Precipitation 
Calculator, see P_01: Isothermal Precipitation of Al3Sc.

General Configuration Settings

The settings for these contributions are found on the Property Model Calculator when the 
Yield Strength Model is selected under General Models.

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

There are settings described elsewhere when Yield Strength is selected as an 
axis variable for a Plot Renderer or Table Renderer that are successors to the 
Precipitation Calculator.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

Advanced Mode Settings

Select Advanced as the Mode. Available settings are displayed based on the choice.
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For the specific Simplified settings, go to Yield Strength Property 
Model: Simplified Mode Settings.

SET MATRIX PHASE EXPLICITLY

Select the Set matrix phase explicitly checkbox and choose a Matrix phase from the list. 
This allows forcing a specific phase to be considered as the matrix phase. 

This is an important parameter as it impacts the evaluation of the shear 
modulus and affects the result for the precipitation strengthening contribution.

The solid solution strengthening contribution is not affected by choice of matrix phase, since 
all stable FCC, BCC, and HCP phases always are evaluated for solid solution strength 
contributions. If this option is not selected, the matrix phase is automatically determined by 
the model.

SOLID SOLUTION STRENGTHENING (ADVANCED MODE)

Select the Solid solution strengthening checkbox to include solid solution strengthening in 
the calculation.

EVALUATE AT HIGHER TEMPERATURE

This checkbox is available when the Solid solution strengthening checkbox is selected. By 
default the checkbox is not and the simulation is evaluated at room temperature.

Select the Evaluate at higher temperature checkbox to evaluate the contribution at 
temperatures higher than room temperature.

When selected, enter a Solid solution strengthening temperature in the field in numeric 
format (no expressions/functions are accepted). The unit of temperature is the same as that 
selected above under Condition Definitions. 

If no temperature is entered, the default, room temperature, is used.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 351 of 763

GRAIN BOUNDARY STRENGTHENING AND GRAIN SIZE (ADVANCED MODE)

Click to select the Grain boundary strengthening checkbox to include calculated grain 
boundary strengthening ( ). Then enter the Grain size [um], which is the grain diameter in 
micrometers (μm).

USER-DEFINED HALL-PETCH COEFFICIENT

By default, a suitable default Hall-Petch coefficient is automatically calculated by the model. 
Select the User defined Hall-Petch coefficient checkbox to enter a different Hall-Petch 
coefficient:  in MPa μm1/2.

PRECIPITATION STRENGTHENING (ADVANCED MODE)

Click to select the Precipitation strengthening checkbox to include calculated precipitation 
strengthening ( ). Then enter the settings that follow under the Precipitation 
Strengthening Model section.

The Precipitate list defaults to Any phase. 

 l If Any phase is selected as a Precipitate phase, the non-matrix-like phase with the 
highest volume fraction is selected. If more than one precipitate is defined and set to 
Any phase, non-matrix-like phases are selected in order of descending volume 
fraction.

 l If more precipitates with Any phase are defined than there are stable non-matrix-like 
phases in the system, the redundant precipitates are ignored. 

 l Graphite is prohibited to be set as a precipitate phase.

Otherwise, select another phase from the list. Click the  and  buttons to add and remove 
additional Precipitates that can have different settings.

Precipitation Strengthening Model

The precipitation strengthening contribution ( ) is calculated by one of these models, which 
are further described below.

Select a Precipitation strengthening model from the list:
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 l Simplified model (general)
 l Seidman model (Al-base): Preferentially used for Al-based alloys.
 l Reppich model (Ni-base):   Preferentially used for Ni-based alloys.

The Reppich model is not valid for very small values of volume fraction 
precipitate and precipitate radius.

 l Deschamps model (Al-base): Preferentially used for Al-based alloys.

SIMPLIFIED MODEL (GENERAL) SETTINGS

For the Simplified model (general), enter values in the fields for the following. The default 
values of  and  are optimized against experiments for Al-Sc.

 l Mean radius Simplified model: The precipitate mean radius. The unit is meter (m). 
Also see Mean Precipitate Radius and Particle Size Distribution (PSD)

 l Critical radius ( ), which determines the mean precipitate radius where transition 
between cutting and looping occurs. The unit is meter (m).

 l kp: The prefactor for the Simplified model, which adjusts the overall height of the 
yield precipitation strength curve.

SEIDMAN MODEL (AL-BASE) SETTINGS

For the Seidman model (Al-base), enter values in the fields for the following. The default 
parameters are optimized against experiments.

 l Mean radius Seidman model: The precipitate mean radius. The unit is meter (m). 
Also see Mean Precipitate Radius and Particle Size Distribution (PSD)

 l Anti-phase boundary energy: , which is the average anti-phase boundary energy 
for the precipitate phase. The unit is Jm-2.

 l m: A Seidman exponent, it is a constant in the expression for strengthening by 
modulus mismatch. See [1985Ard] for details.

 l : A Seidman prefactor. It is a fitting constant in the expression for coherency 
strengthening. See [1985Ard] for details.
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REPPICH MODEL (NI-BASE) SETTINGS

For the Reppich model (Ni-base), enter values in the fields for the following. The default 
parameters are optimized against experiments.

 l Mean radius Reppich model: The precipitate mean radius. The unit is meter (m).
 l Anti-phase boundary energy: , which is the average anti-phase boundary energy 

for an L12 ordered precipitate phase. The unit is Jm-2.

 l Calculate anti-phase boundary energy: Select the checkbox to use calculated anti-
phase boundary energy in the yield strength calculation. The software uses the 
standalone APBE model in the Ni-library from within the Yield Strength Model for the 
calculation.

The APBE can only be calculated for gamma prime (γ'). If the selected 
precipitate phase is not γ', the user-defined value in the configuration 
window is used.

 l w: A parameter that accounts for elastic repulsion between strongly coupled 
dislocations.

 l A: Numerical factor reflecting particle morphology (0.72 for spherical). See [1982Rep] 
for details.

DECHAMPS MODEL (AL-BASE) SETTINGS

For the Dechamps model (Al-base) enter values in the fields for the following. The default 
parameters are optimized against experiments.

 l Mean radius Dechamps model: Precipitate mean radius. The unit is meter (m).
 l Critical radius ( ), which determines the mean precipitate radius where transition 

between cutting and looping occurs. The unit is meter (m).
 l : A parameter used to evaluate the dislocation line tension. Usually close to 1/2 but 

can deviate from this value.
 l Use Kock's statistics: By default, Friedel statistics are used. Select the checkbox to 

use Kock's statistics instead. See [1998Des].

ADDITIONAL PRECIPITATION PARAMETERS (ADVANCED MODE)
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The following are available for all models and when the Additional precipitation parameters 
checkbox is selected.

TAYLOR FACTOR

Enter a value for the Taylor factor.

The value of the Taylor factor accounts for texture in the material. Normally the value is 
between 2.24 and 3.06 for random orientations.

SHEAR MODULUS

Enter a value for the Shear modulus of the matrix phase in Pa.

BURGERS VECTOR

Enter a value for the Burgers vector. The unit is meter (m).

CONSTANT STRENGTH ADDITION (ADVANCED MODE)

Select the Constant strength addition checkbox and enter a value for the Constant strength 
addition, . The unit is MPa This accounts for any contributions not accounted for in the  
Yield Strength model, e.g. martensite strengthening.

EQUILIBRIUM MINIMIZATION STRATEGY

Select an Equilibrium minimization strategy. The default uses the Global test preferred 
option.

The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.

With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:

 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.
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If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.

Precipitation Calculator Setting - Density of Points

This setting is only available for a precipitation calculation using the 
Precipitation Module (TC-PRISMA).

Select the Density of points: Low (the default), Medium, or High. This is a measure of how 
many time steps yield strength is calculated.

References

[1982Rep] B. Reppich, Some new aspects concerning particle hardening mechanisms in γ’ 
precipitating Ni-base alloys—I. Theoretical concept. Acta Metall. 30, 87–94 (1982).

[1998Des] A. Deschamps, Y. Brechet, Influence of predeformation and ageing of an Al–Zn–
Mg alloy—II. Modeling of precipitation kinetics and yield stress. Acta Mater. 47, 293–305 
(1998).

Additional Settings

 l Yield Strength Property Model: Calculation Type and Grid Definitions
 l Yield Strength Property Model: Plot and Table Settings

Yield Strength Property Model: Calculation Type and Grid 
Definitions

This section has information about the Calculation Type and Grid Definitions Configuration 
settings available for the Yield Strength Property Model. It is a continuation from Simplified 
or Advanced Mode setting entries:

 l Yield Strength Property Model: Simplified Mode Settings
 l Yield Strength Property Model: Advanced Mode Settings
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Calculation Type Settings

CALCULATION TYPE

 l Single to calculate a single point. Any model can use this calculation type and no 
additional settings are required. The results from this calculation are displayed in the 
Event Log or if a Table Renderer is used, in the Visualizations window. 

 l One Axis: To  vary a quantity on the X-axis.
 l Grid: Evaluates two axis variables of the selected quantities in the specified range 

and number of steps.
 l Min/Max: Evaluates the Property Model(s) for all variations of the selected 

quantities at the given limits. The Mean field is as defined under Condition 
Definitions for the respective quantity. The total minimum and maximum of the 
model(s) results are shown in the Event log.

 l Uncertainty: Evaluates the Property Model(s) where the values of the quantities are 
sampled from Gaussian distributions. The Mean field is as defined under Condition 
Definitions for the respective quantity. The result is visualized as a histogram or 
normal probability plot by adding a Plot Renderer activity.

 l Batch: Use this to  allow for high throughput calculations and read data from a file, 
such as a spreadsheet, rather than, for example, having a fixed grid or random 
values.  Results from these batch calculations can then be compared to experimental 
values (as long as this data is included), using a Cross plot on the Plot Renderer. 

AXIS DEFINITION

For One Axis, select a Quantity to vary along the X-axis, for example, Temperature then 
enter a Min, Max and Number of steps. 

Grid Definition Settings

GRID DEFINITIONS

For the Grid calculation type, define the two axes variables using the fields and menus: 
Quantity, Min, Max, and Number of steps. The number of steps along with the minimum 
and maximum values for the axes define a grid. For each grid point the selected models are 
evaluated. 
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For a Grid, on the Plot Renderer, you can choose to plot a Heat map, Contour, 
or 3D diagram.

Plot Type: Heat Map, Contour, and 3D

MIN/MAX DEFINITIONS

For the Min/Max calculation type, click to select the applicable checkboxes under Quantity 
to enable or disable an axis. The Mean field is as defined under Condition Definitions for the 
respective quantity. 

Enter numerical values in the ΔMin/Max fields to evaluate the change to the quantity. The 
highest and lowest value of each selected model results are shown in the Event Log.

SAMPLING OF DATA FROM GAUSSIAN DISTRIBUTIONS

For the Uncertainty calculation type, click to select the applicable checkboxes under 
Quantity to vary this quantity. The Mean field is for the distribution function as defined 
under Condition Definitions for the respective quantity. The default ΔMin/Max is a 95% 
confidence interval. 

About the Uncertainty Calculations

SAMPLING PARAMETERS

For the Uncertainty calculation type, choose a number of Standard deviations where you 
want to Truncate the distribution. Choose the Total number of samples. 

About the Uncertainty Calculations

Additional Settings

 l Yield Strength Property Model: Plot and Table Settings

Yield Strength Property Model: Plot and Table Settings

This section has information about the Plot Renderer and Table Renderer Configuration 
settings available for the Yield Strength Property Model. It is a continuation from Simplified 
or Advanced Mode setting entries:
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 l Yield Strength Property Model: Simplified Mode Settings
 l Yield Strength Property Model: Advanced Mode Settings
 l Yield Strength Property Model: Calculation Type and Grid Definitions

For more information see:

Plot Renderer and Configuration Settings

Table Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Calculations can be performed over a range for the model parameters available 
in each sub-model. If, for example, the mean precipitate radius in a 
precipitation strengthening model is set as the variable to step over, it becomes 
available as a plot quantity in the Plot Renderer.

Plot Quantities

The various hardness or hardening quantities are treated separately from the 
various strength or strengthening quantities and each (hardness and strength) 
are plotted on the respective axes. When setting up the simulation, the 
Configuration window (when in Grouped Mode) shows either Vickers Hardness 
or Strength. This corresponds to the labeling of axes in the Visualizations 
window when plotting two or more quantities of the same type. The legend 
then lists the specific quantity names selected on the Configuration window. 

These plot quantities are available:

 l Total yield strength
 l Intrinsic strength
 l Solid solution strengthening
 l Solid solution strengthening FCC
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 l Solid solution strengthening BCC
 l Solid solution strengthening HCP
 l Grain boundary strengthening
 l Total precipitation strengthening
 l Precipitation strengthening per phase
 l Constant strength addition
 l Volume fraction of precipitate phase
 l Volume fraction of stable phase(s)

For all strength quantities, there is a corresponding hardness quantity:

 l Total hardness
 l Intrinsic hardness
 l Total solid solution hardening
 l Solid solution hardening FCC
 l Solid solution hardening BCC
 l Solid solution hardening HCP
 l Grain boundary hardening
 l Total precipitation hardening
 l Precipitation hardening per phase
 l Constant hardness addition
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Scheduler and Event Log Windows
In this section:

Using the Scheduler 361

Event Log Window 363
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Using the Scheduler

The Scheduler window has activity information about current or scheduled jobs. A job is any 
activity you have selected to be performed. The Scheduler also indicates if there is an error 
during a job and when a job has stopped. If you have set an activity, tree or project to be 
performed at a later time then this is also listed. 

About the Scheduler Jobs
 l Whenever you trigger the performance of a whole project, tree or individual activity, 

all the activities to be performed are shown under a job heading.
 l When all the activities belonging to a job are completed the job and its activities 

disappear from the Scheduler window. 
 l If there is an error during the performance of an activity, icons for that job and 

activity remain in the Scheduler window until removed. 

Node or Window Status Markers
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Managing the Schedule

In the Scheduler window, you can cancel scheduled jobs, remove errors and show 
information about errors.

 l To cancel all jobs: Right-click the Scheduled Jobs label or the cogwheel icon, and 
select Cancel All Jobs

 l To remove (clear) all failed activities and jobs: Right-click the Scheduled Jobs label or 
the cogwheel icon, and select Clear All Errors 

 l To cancel a specific job: Right-click the job label (for example, Job no 1) and select 
Cancel Job

 l To remove (clear) a specific failed job: Right-click the job label (for example, Job no 
1) and select Cancel Job 

 l To open a window with error details: Right-click the label for the failed job (for 
example, Job no 1), and select Show Error Log 
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Event Log Window

The Event Log window is closed by default. Information about what Thermo-Calc is 
processing or doing is in blue text, an error  message is in red text, and caution/warning 
information is in yellow text.

Global Settings

 l To open the Event Log window: Click the Event Log window once to expand it or 
select it from the Window → Event Log  menu. Double-clicking the window 
maximizes it.

 l To clear all messages in the window, right-click in the text area and select Clear.
 l To specify the level of detail in the Event Log, open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> 

on the keyboard.

 l then click the General tab and set the Log level slide bar to anything between Debug 
(most detailed) and Error (least detailed).
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Working with Plots and Tables
In this section:

Performing Projects, Trees and Activities 365

Saving and Printing the Output in Graphical Mode 366

Plotting Options 369

Common Quantities Available for Plots and Tables 374

Plot Types 378

Plot Type: Cross Plot and Statistical 385

Plot Type: Parallel Coordinates 390

Plot Type: Heat Map, Contour, and 3D 396

Plot Type: Flexible Mode and Grouped Mode 401

Plot Type: CCT Mode 403

Plot Type: TTT Mode 405

Plot Type: Simple Mode and Advanced Mode 407

Zooming In and Out 409

Plotting Several Calculations in One Diagram 410

Plot Renderer: Convert a Plot to a Table and Export the Data 412

Merging Plots into One Diagram 414

Adding Axes to a Diagram 416

Rotating 3D Plots 418
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Performing Projects, Trees and Activities

You can trigger the performance of an activity (also called a job) and all the activities below 
it in the same tree in either the Project or Configuration window. In the Project window you 
can also perform a single activity without performing its successors or perform the whole 
project (all the activity trees). 

In the Configuration window, click Perform Tree to perform the currently selected activity 
and all the activities below it. If there are no activities below the selected activity, then the 
button says Perform instead.

All activities that must be completed as prerequisites are automatically 
performed first. For example, if you Perform Tree for a Plot Renderer, then the 
predecessors, Equilibrium Calculator and System Definer, are automatically 
performed before the Plot Renderer.

In the Project window, you can do any of the following:

 l Perform an activity: Right-click the activity and select Perform Now, or Perform Later 
and schedule a time to perform the activity 

 l Perform an activity and all activities below it in the tree: Right-click any node in the 
tree and select Perform Tree Now. Or select Perform Tree Later and schedule a time 
for all activities in the tree to be performed

 l Perform a project: Right-click  My Project and select Perform Now or Perform 
Later and schedule a time to perform all project activities in the tree 

If there is an error during the performance of an activity, icons display status 
markers, which are described in Node or Window Status Markers.
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Saving and Printing the Output in Graphical Mode

Global Settings: Graphical and Console Mode Plotting

Output can refer to results in the form of tabulated data in a table or a diagram. 

The terms diagram and plot are interchangeable. The commands in Console 
Mode generally use the term diagram and in Graphical Mode it is also called a 
plot (e.g. the Plot Renderer). 

In Graphical Mode the output is displayed in the Visualizations window. The output can be 
in the form of a table  or a diagram (plot). In both cases you can save from the Configuration 
or Visualizations windows. You can print the table or diagram from the Visualizations 
window.

Saving a Parallel coordinates plot from the Visualizations window has less file 
type options. See Plot Type: Parallel Coordinates. 

Saving Diagrams 

You can save the output in a variety of file formats. For JPG and PNG images you can also 
adjust the image quality. 

In Console Mode, the diagram is output to the Console Results window after 
using the PLOT_DIAGRAM command.

In Graphical Mode, the diagram is output to the Visualizations window after 
performing a tree that includes a Plot Renderer.  
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 1. In the Visualizations window, right-click the diagram and select Save as. 

In the Graphical Mode Configuration window you can also click the Save 
Diagram  (or Save table ) buttons to open the Save window.

 2. In the Save window:
 a. Navigate to where you want to save the diagram.

 b. Enter a File name.

 c. From the Files of type list choose png (the default), jpg, ps, pdf, gif, svg, or 
emf. 

 d. For PNG and JPG files only, under the Image Quality section, choose to 
improve the resolution of the image. For JPG files you can also adjust the file 
size. 

 l To change the resolution of a PNG or JPG image, click to clear the Use 
screen resolution  checkbox. Then enter a numerical value in the Dots 
per inch (DPI) field. 

 l For JPEG files, you can also use the slider to choose a number between 
0 and 1 for the JPG quality. The default is 0.9. The lower the number, 
the smaller the file.

 e. When you are ready, click Save.

Saving (Exporting) Tables

You can save the table output in different file formats  from the Table Renderer and Plot 
Renderer Configuration and Visualizations windows.  

In Graphical Mode, a table is output to the Visualizations window after 
performing a tree that includes a Table Renderer. It is also output  using the 
Table View  button located on the  Plot Renderer Configuration window.
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 1. Generate a table. Then depending on which window you are in:

 l In the Visualizations window, right-click the table and select Save as, or 
 l In the Configuration window  click the Save table  button.

 2. In the Save As window:
 a. Navigate to where you want to save the table.

 b. Enter a File Name.

 c. From the Files of Type list choose Text [*.txt](the default), Hyper Text 
Markup [*.html],  or Excel [*.xls]. 

 d. When you are ready, click Save.

Printing Output

In the Visualizations window, right-click the table or diagram and choose Print. Select 
additional settings as required on the Print window.
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Plotting Options

The Plot Renderer is a dynamic activity node with options such as being able to:

 l add more than one Plot Renderer to its predecessor node (i.e. one of the calculator 
activities), 

 l add axes to the plots, 
 l merge results in one plot, 
 l filter quantities (only for a Parallel coordinates plot), and 
 l choose from a variety of plot types based on the selected combination of Calculator 

and Calculation Type.

Additional settings are also described in Configuration Settings.

The specialized Add-on Additive Manufacturing (AM) Module has additional 
functionality. The information is described separately and included with the 
Module's documentation.  

Plots Can Have More Than One Predecessor

A Plot Renderer can have several predecessors (if you want to plot several calculations in the 
same diagram), in which case there are several tabs in the Configuration window, one for 
each predecessor.

Plotting Several Calculations in One Diagram
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Several Plot Renderer activities (as well as Table Renderer activities) can be shown in the 
Visualizations window as different tabs. The figure is from Graphical Mode example T_04. 

Add Axes to Plots

You can add additional X- and/or Y-axes to a plot to compare two or more variables at the 
same time as in the figure. 

Adding Axes to a Diagram
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Two variables plotted on the Y-axis.

Merge Results in One Plot

You can merge (or overlay) calculated results for several variables into one plot. This is 
similar to adding an axis, but instead of displaying different variables along the X- and/or Y-
axes, the same X and Y variables are used to compare the third variable (defined in the Plot 
Renderer as the Z-axis).

As in the figure (from example PM_G_03 in Graphical Mode Examples), the driving force and 
interfacial energy results are combined into one diagram. The X- and Y-axis is the same for 
both (Mass percent Cr/Mass percent Mn). 

Merging Plots into One Diagram
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A contour plot showing both the driving force and interfacial energy calculation results comparing 
Mass percent Cr to Mass percent Mn.

Choose a Plot Type

When you set up most Calculators, there are calculation types to choose from on the 
Configuration window. The selection of the Calculation Type also provides options to choose 
from the Plot type menu for some of the associated Plot Renderer windows.

For a list of calculations for each Calculator, see Calculation Types in Graphical 
Mode. 

There are a variety of combinations of Calculator and Calculation Type that offer different 
Plot Types. These are described in separate topics:

 l Plot Type: Cross Plot and Statistical 
 l Plot Type: Heat Map, Contour, and 3D
 l Plot Type: Parallel Coordinates
 l Plot Type: Flexible Mode and Grouped Mode
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 l Plot Type: CCT Mode
 l Plot Type: TTT Mode
 l Plot Type: Simple Mode and Advanced Mode

If you also have a license for the Additive Manufacturing Module, there are 
additional plots available and described in the documentation, i.e. see About 
the AM Plot Types.

Filter Quantities on a Parallel Coordinates Plot

Use the Filter checkbox on a Plot Renderer to add various filters to the Parallel coordinates 
plot or table and based on the set up of the calculation.

When selected, click the Add quantity   and Remove quantity   buttons to add filters. 
For example, enter a Min and Max and choose an axis variable such as Composition Cr and 
the unit Mass percent to adjust the output in the Visualizations window. Click Perform each 
time you add or remove a filter for the results to update. 
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Common Quantities Available for Plots and Tables

The following table lists the common quantities available as axis variables or columns when 
working with plots and tables in Graphical Mode. All the quantities are listed alphabetically 
in Equilibrium Calculator conditions, quantity function definitions, and table and plot results 
(specifically for these types of calculations-one axis equilibrium, phase diagram, binary and 
ternary).

These quantities are also available in Console Mode but are entered manually.

Each quantity is selected on the Configuration window as required either as Axis variables 
for the Plot Renderer or when choosing the Columns for a Table Renderer. 

Quantity Available Units Comment or Link to More 
Information

Activity of component  dimensionless  

Activity referred to a phase  dimensionless  

Amount of component  Mole, Gram, Kilogram, Tonne, 
Pound  

Amount of component in phase Mole, Gram, Kilogram, Tonne, 
Pound  

Amount of phase Mole, Gram, Kilogram, Tonne, 
Pound  

Bohr magneton number  dimensionless  

Chemical diffusion coefficient  m2/s  

Chemical potential of 
component

Joule, Calorie, Electron volt, 
Gigajoule, Watt hour, Kilowatt hour  

Chemical potential referred to 
a phase 

Joule, Calorie, Electron volt, 
Gigajoule, Watt hour, Kilowatt hour  

Composition  Mass percent, Mole percent, Mass 
fraction, Mole fraction  
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Quantity Available Units Comment or Link to More 
Information

Composition of a phase Mass percent, Mole percent, Mass 
fraction, Mole fraction  

Curie temperature Kelvin, Celsius, Fahrenheit  

Density 
Gram per cubic meter, Kilogram per 
cubic meter, Gram per cubic 
centimeter, Pound per cubic inch

 

Dynamic viscosity Pascal-second, milliPascal-second, 
Poise, centiPoise

About Thermophysical 
Properties Data 
Parameters

Electric conductivity  dimensionless
About Thermophysical 
Properties Data 
Parameters

Electric resistivity  dimensionless
About Thermophysical 
Properties Data 
Parameters

Enthalpy  Joule, Calorie, Electron volt, 
Gigajoule, Watt hour, Kilowatt hour  

Entropy  Joule per Kelvin, Calorie per Kelvin, 
Electron volt per Kelvin  

Function  No units.

Select Function when you want to 
choose a user-defined function. For 
example, if fraction_solid is 
predefined defined on the Functions tab 
for an Equilibrium Calculator and you 
want to plot this, choose Function.

Gibbs energy Joule, Calorie, Electron volt, 
Gigajoule, Watt hour, Kilowatt hour  

Heat capacity
Joule per mole Kelvin, Calorie per 
mole Kelvin, Joule per kilogram 
Kelvin, BTU per pound Fahrenheit

 

Helmholtz energy Joule, Calorie, Electron volt, 
Gigajoule, Watt hour, Kilowatt hour  

Internal energy Joule, Calorie, Electron volt,  



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 376 of 763

Quantity Available Units Comment or Link to More 
Information

Gigajoule, Watt hour, Kilowatt hour

Intrinsic diffusion coefficient  dimensionless  

Isothermal compression  dimensionless  

Kinematic viscosity Square meter per second, Stokes, 
Centistokes

About Thermophysical 
Properties Data 
Parameters

L'' dimensionless  

Mobility  dimensionless  

Normalized driving force  dimensionless  

Phase stability function  dimensionless  

Pressure  Pascal, Atmospheres, Bar  

Site fraction dimensionless  

Surface tension Joule per m2, Millijoule per m2
About Thermophysical 
Properties Data 
Parameters

System size Mole, Gram, Kilogram, Tonne, 
Pound  

Temperature  Kelvin, Celsius, Fahrenheit  

Thermal conductivity  dimensionless
About Thermophysical 
Properties Data 
Parameters

Thermal diffusivity  dimensionless
About Thermophysical 
Properties Data 
Parameters

Thermal expansivity  per Kelvin, per Fahrenheit  
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Quantity Available Units Comment or Link to More 
Information

Thermal resistivity  dimensionless
About Thermophysical 
Properties Data 
Parameters

Thermodynamic factor  dimensionless  

Tracer diffusion coefficient  dimensionless  

User-defined   Enter another axis variable.

Volume  Cubic meter, Cubic decimeter, Cubic 
centimeter, Normal cubic meter  

Volume fraction of phase    

ln(activity of component)    

ln(activity referred to a phase)    

log10(Chemical diffusion 
coefficient)    

log10(Intrinsic diffusion 
coefficient)    

log10(Mobility)    

log10(Tracer diffusion 
coefficient)    

u-fraction   The u-Fraction Variable
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Plot Types

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and, in most cases, Calculation Type selected. 

The Mode plot types are related to groups of settings made available (or 
hidden) on the Plot Renderer, rather than a particular plot output type such as 
contour, cross plot, or heat map, for example. 

The tables below list the Plot types available with the various Calculator and  Calculation 
Type combinations, either By Calculator, By Plot Type, or By Calculation Type.

Calculation Types in Graphical Mode

There are a variety of combinations of Calculator and Calculation Type that offer different 
Plot Types. These are described in separate topics:

 l Plot Type: Cross Plot and Statistical 
 l Plot Type: Heat Map, Contour, and 3D
 l Plot Type: Parallel Coordinates
 l Plot Type: Flexible Mode and Grouped Mode
 l Plot Type: CCT Mode
 l Plot Type: TTT Mode
 l Plot Type: Simple Mode and Advanced Mode

If you also have a license for the Additive Manufacturing Module, there are 
additional plots available and described in the documentation, i.e. see About 
the AM Plot Types.

The following require additional licenses: Diffusion Calculator, Process 
Metallurgy Calculator, CCT Mode, and TTT Mode.
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By Calculator

Calculator Calculation 
Type Plot Types Notes

Diffusion Calculator n/a Simple Mode; 
Advanced Mode

There are no Calculation Types to choose when 
setting up a Diffusion Calculator.

Equilibrium 
Calculator 

One Axis

Phase diagram

Flexible Mode

Grouped Mode
 

Grid

Heat Map

Contour

3D

 

Material to Material 
Calculator

One Axis

Phase diagram

Flexible Mode

Grouped Mode
 

Process Metallurgy 
Calculator 
(Equilibrium 
calculations)

One Axis
Flexible Mode

Grouped Mode
 

Grid

Heat Map

Contour

3D

 

Process Metallurgy 
Calculator (Process 
simulation)

n/a
Flexible Mode

Grouped Mode

There are no Calculation Types to choose when 
setting up a Process Metallurgy Calculator as a 
Process simulation.

Property Model 
Calculator

One Axis

Flexible Mode

Grouped Mode
 

CCT Mode Also select Log10(cooling rate [K/s]) as the axis 
Quantity. 

TTT Mode Also select Temperature as the axis Quantity. 

Grid

Heat Map

Contour

3D
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Calculator Calculation 
Type Plot Types Notes

Parallel 
coordinates

At least three quantities under Grid Definitions 
must be selected on the Property Model 
Calculator; then this plot is available on the Plot 
Renderer.

Uncertainty

Cross Plot

Parallel 
coordinates

Statistical

 

Statistical - 
Histogram 

Choose Frequency as the Axis variable and 
Histogram as the Axis type

Statistical -
Probability 

Choose Normal probability as the Axis variable 
and Probability as the Axis type

Batch

Statistical

Cross Plot

Parallel 
coordinates

 

Ternary Calculator

Isothermal 
section

Monovariant 
lines

Liquidus 
projection

Flexible Mode

Grouped Mode
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By Plot Type

Plot Type Calculation Type Calculator(s) Notes

3D Grid

Equilibrium 
Calculator

Property Model 
Calculator

Process 
Metallurgy 
Calculator

3D Plots with additional 
functionality are also 
available with the Add-on 
Additive Manufacturing 
(AM) Module. The 
information is described 
separately and included 
with the Module's 
documentation.  

Advanced Mode n/a Diffusion 
Calculator 

There are no Calculation Types to choose 
when setting up a Diffusion Calculator.

CCT Mode One Axis Property Model 
Calculator

Also select Log10(cooling rate [K/s]) as the 
axis Quantity. 

Contour Grid

Equilibrium 
Calculator

Property Model 
Calculator

Process 
Metallurgy 
Calculator

 

Cross Plot
Batch

Uncertainty
Property Model 
Calculator  

Flexible Mode or 
Grouped Mode

One Axis

Equilibrium 
Calculator

Material to 
Material 
Calculator

Process 
Metallurgy 
Calculator 
(Equilibrium 
calculation)

Property Model 
Calculator

 

Isothermal section Ternary Calculator  
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Plot Type Calculation Type Calculator(s) Notes

Monovariant lines

Liquidus projection

n/a

Process 
Metallurgy 
(Process 
simulation)

There are no Calculation Types to choose 
when setting up a Process Metallurgy 
Calculator as a Process simulation.

Phase diagram

Equilibrium 
Calculator

Material to 
Material 
Calculator

 

Heat Map Grid

Equilibrium 
Calculator

Property Model 
Calculator

Process 
Metallurgy 
Calculator

 

Parallel 
coordinates

Batch

Grid

Uncertainty

Property Model 
Calculator

For the Grid calculation at least three 
quantities under Grid Definitions must be 
selected on the Property Model Calculator, 
then this plot type is available on the Plot 
Renderer.

Simple Mode n/a Diffusion 
Calculator 

There are no Calculation Types to choose 
when setting up a Diffusion Calculator.

Statistical
Batch 

Uncertainty
Property Model 
Calculator  

Statistical - 
Histogram 

Batch 

Uncertainty
Property Model 
Calculator

Choose Frequency as the Axis variable and 
Histogram as the Axis type

Batch is only available with the Property 
Model Calculator

Statistical -
Probability 

Batch 

Uncertainty
Property Model 
Calculator

Choose Normal probability as the Axis 
variable and Probability as the Axis type

Batch is only available with the Property 
Model Calculator
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Plot Type Calculation Type Calculator(s) Notes

TTT Mode One Axis Property Model 
Calculator

Also select Temperature as the axis 
Quantity. 

By Calculation Type

Calculation 
Type Plot Types Calculator (s) Notes

Batch
Statistical

Parallel 
coordinates

Property Model 
Calculator  

Grid

Heat Map

Contour

3D

Equilibrium 
Calculator

Property Model 
Calculator

Process 
Metallurgy 
Calculator

 

Parallel 
coordinates

Property Model 
Calculator

At least three quantities under Grid Definitions must 
be selected on the Property Model Calculator, then 
the plot is available on the Plot Renderer.

Isothermal 
section

Liquidus 
projection

Monovariant 
lines

Flexible Mode

Grouped Mode
Ternary 
Calculator  

Min/Max
Flexible Mode

Grouped Mode
Property Model 
Calculator  

One Axis
Flexible Mode

Grouped Mode

Equilibrium 
Calculator

Material to 
Material 
Calculator

Process 
Metallurgy 
Calculator
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Calculation 
Type Plot Types Calculator (s) Notes

Property Model 
Calculator

CCT Mode

TTT Mode
Property Model 
Calculator

CCT Mode: Also select Log10(cooling rate [K/s]) as the 
axis Quantity. 

TTT Mode: Also select Temperature as the axis 
Quantity. 

Phase diagram
Flexible Mode

Grouped Mode

Equilibrium 
Calculator

Material to 
Material 
Calculator

 

Uncertainty

Parallel 
coordinates

Property Model 
Calculator

 

Statistical  

Statistical - 
Histogram 

Choose Frequency as the Axis variable and Histogram 
as the Axis type

Statistical -
Probability 

Choose Normal probability as the Axis variable and 
Probability as the Axis type
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Plot Type: Cross Plot and Statistical

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

 Calculation Types in Graphical Mode 

See Plot Types detailing availability By Calculator, By Plot Type, or By Calculation 
Type.

Statistical (with a Histogram or Probability Axis Type)

Use a Statistical Plot type to  select Frequency or Normal probability as the Axis variable. The 
Axis type is then set to Histogram or Probability, respectively. 

The following uses a General Property Model example: PM_G_01: Phase 
Transition.

The two combination options, Frequency → Histogram or Normal probability → Probability, 
selected with Statistical on a Plot Renderer as a successor to a Property Model Calculator. 
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A Statistical Plot type, with the Frequency Axis variable and Histogram Axis type selected.

A Statistical Plot type, with the Normal probability Axis variable and Probability Axis type selected.

Cross Plot (Parity Plot)

Use Cross plot to plot the experimental data from a Batch calculation with the calculated 
result, e.g. you might be looking at liquidus temperature and now can plot both to compare 
the experimental data  against the Thermo-Calc calculated results.  You choose the 
experimental data value (which is read from the data file) as an X- or Y-axis variable and then 
the calculated result as the other X- or Y-axis variable. This is also known as a parity plot.

The following uses a General Property Model example: PM_G_12: Solidus and 
Liquidus Batch Calculation.
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For a Batch calculation, and when the data file contains experimental (Exp) data, you can use 
Cross plot on a Plot Renderer to compare it to the simulated results. 
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A comparison of experimental liquidus and solidus data using a Cross plot with a Batch 
calculation. A root mean square (RMS) setting shows the distribution of the data points. 

There is a blog post related to ICME Workflows that provides an additional 
example about the use of cross plots.

Another example showing the use of cross plots is PM_G_03: Driving Force and 
Interfacial Energy, which also has a video to accompany it. 

https://thermocalc.com/blog/icme-workflows-using-cross-plots-to-visualize-the-tradeoff-of-properties-in-alloy-design/
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Plot Type: Parallel Coordinates

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

Calculation Types in Graphical Mode

See Plot Types detailing availability By Calculator, By Plot Type, or By Calculation 
Type.

The Parallel coordinates plot type is available when using the Property Model Calculator 
with a Grid, Batch, or Uncertainty Calculation Type.

The Parallel coordinates plot is useful when interpreting multidimensional data and to 
compare how different parameters affect each other. This is especially useful in materials 
design after performing a batch or uncertainty set of evaluations when multiple inputs are 
varied at the same time and multiple model outputs are given as a result. 

For this plot type, there are some differences compared to other plots as to what can be 
done on the Visualizations window and the Plot Renderer Configuration window. 

 l Visualizations window: After a plot is generated, the options available when you 
right-click are slightly different. You can choose to Select/Deselect a line (to display 
additional information), and to Save As and Copy plot images. 

Other options such as Plot Themes and plot formatting options are not 
available. 

 l Plot Renderer Configuration window: You can select the Filter checkbox and then 
filter one or more quantities. 

To access this plot type on the Plot Renderer for a Grid calculation, at least 
three quantities under Grid Definitions must be selected on the Property Model 
Calculator. 
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Tips to Interpret the Plot Data

 l When most lines between two parallel axes are somewhat parallel to each other, 
there is a positive relationship between these two dimensions.

 l When lines cross in a kind of superposition of X-shapes, that's a negative 
relationship.

 l When lines cross randomly it means that there is no particular relationship.

Figure 17: Parallel coordinates plot showing multidimensional data.

Overlay Compositions on the Same Plot

For this plot, you can combine and overlay calculated results from two or more Property 
Model Calculators and show it on one plot in the Visualizations window, even if they have 
been set up for different grids. This is available for a Grid calculation and when you are 
including three or more axis quantities for two Property Model Calculators. Each 
composition has its own line and it is color coded so you can identify which Property Model 
Calculator a given result is from.
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Figure 18: Parallel coordinates plot with two sets of composition data overlaid and color coded for 
each Property Model Calculator.

Visualization Window Plot Options 

Once the plot is generated in the Visualizations window, you can right-click and choose one 
of these options:

 l Select/Deselect a line (or Ctrl + right-click). For this option, you must right-click 
directly on an axis line to view the details and highlight the relevant information. 

 l Save As to save the plot (in its current state) as a jpg, png, or gif file.
 l Copy to copy the plot (in its current state) to a clipboard. Then you can paste it into 

any supported application.  The pasted image defaults to a png format.

For both Save As and Copy actions, the image is saved in the current state that 
the both the plot and Visualizations window is in, i.e. if you have selected one 
or more lines to display information, then this is what is included in the saved 
file. It is also saved based on the current size of the Visualizations window, i.e. 
to ensure that the entire plot is saved, you may need to expand the window to 
the full view you want to capture. Sometimes it is also useful to detach the 
window and drag it to full size before saving the image.

There are examples using this plot type available: 

A Nickel Model Library example PM_Ni_04: Strain Age Cracking (SAC).

A Steel Model Library example PM_Fe_11: Steel Design Using the Parallel 
Coordinates Plot.
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Select and Deselect Lines

In the Visualizations window, you can highlight and display details about any plot axis, which 
is useful particularly with complex plots. 

You must directly right-click the axis line to turn it on (select) or off (deselect); it 
does not work to just right-click anywhere in the Visualizations window for this 
action.

To toggle the Select/Deselect a line option on (select a line) and off (deselect a line), hover 
over an axis line then: 

 l Ctrl + right-click or
 l Right-click and choose Select/Deselect a line. 

To deselect all lines, either do this one at a time or when several lines are selected, you can 
right-click to choose Deselect all selected lines.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 394 of 763

 

Figure 19: Choosing to display specific axes lines and the associated information on the 
Visualizations window for a Parallel coordinates plot type.

Save As 

 1. Once the plot is generated in the Visualizations window, right-click anywhere in the 
window and choose Save As.

 2. In the Save window:
 a. Navigate to where you want to save the plot.

 b. Enter a File Name.

 c. From the Files of Type list choose png (the default), jpg, or gif.

 d. When you are ready, click Save.

Copy

 1. Once the plot is generated in the Visualizations window, right-click anywhere in the 
window and choose Copy.

 2. Navigate to where you want to paste the image (i.e. Word, Slack, email, and so forth) 
and Ctrl + V to paste it. The pasted image defaults to a png format.
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Plot Renderer Configuration Window Options

Filter Quantities

Use the Filter checkbox on a Plot Renderer to add various filters to the Parallel coordinates 
plot or table and based on the set up of the calculation.

When selected, click the Add quantity   and Remove quantity   buttons to add filters. 
For example, enter a Min and Max and choose an axis variable such as Composition Cr and 
the unit Mass percent to adjust the output in the Visualizations window. Click Perform each 
time you add or remove a filter for the results to update. 
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Plot Type: Heat Map, Contour, and 3D

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

 Calculation Types in Graphical Mode 

See Plot Types detailing availability By Calculator, By Plot Type, or By Calculation 
Type.

Visit the website Application Examples → Process Metallurgy for examples of 
these Plot types using the Process Metallurgy Calculator. 

Heat Map

For a Heat map plot, each Z-axis variable value in the grid is represented by a color-coded 
area, where dark red represents the highest Z-axis variable value and dark blue represents 
the lowest Z-axis variable value.

https://thermocalc.com/showcase/application-examples/#pmm
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Thermo-Calc example T_09 uses an Equilibrium Calculator with a Grid Calculation Type to 
generate a Heat map plot. 

T_09: Carbide Driving Force Heat Map
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Thermo-Calc General Property Model example PM_G_02 uses a Property Model Calculator with a 
Grid Calculation type to plot the coarsening rate coefficient as a Heat map.

PM_G_02: Coarsening and Interfacial Energy

Contour 

For a Contour plot, Z-axis variable values are traced with curves in the same way that height 
values are traced with curves on a topographical map. The colors used originate from the 
different data series.
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Thermo-Calc General Property Model example PM_G_03 uses a Property Model Calculator with a 
Grid Calculation type to compare the driving force and interfacial energy on an overlaid contour 
plot. 

PM_G_03: Driving Force and Interfacial Energy

3D

For a 3D plot, the 3D surface is created by Delaunay tesselation of the calculated data. The 
surface uses a cold to warm color map where red represents the highest Z-axis variable 
value and blue represents the lowest Z-axis variable value. The color map color legend can 
be turned on or off with the legend option.
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3D Plots with additional functionality are also available with the Add-on Additive 
Manufacturing (AM) Module. The information is described separately and 
included with the Module's documentation.  

When in the Thermo-Calc help (press F1), go to Rotating 3D Plots to watch a 
short video showing you how to rotate this plot in the Visualizations window.

Thermo-Calc General Property Model example PM_G_02 uses a Property Model Calculator with a 
Grid Calculation type to plot the coarsening rate coefficient as a 3D plot.

PM_G_02: Coarsening and Interfacial Energy
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Plot Type: Flexible Mode and Grouped Mode

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

 Calculation Types in Graphical Mode 

See Plot Types detailing availability By Calculator, By Plot Type, or By Calculation 
Type.

Flexible Mode

Use Flexible Mode to individually add and configure axes quantities and change the units or 
other associated settings one at a time. 

Grouped Mode
Use Grouped Mode to add and configure groups of axis quantities at the same time and of 
the same type. For example, change units or settings in groups with similar settings like tem-
perature units or axis types. 

Switching Between Modes

If you have a license for the Steel Model Library, you can try yourself to switch between 
Flexible Mode and Group Mode and then change the settings to how you want it using the 
Steels example PM_Fe_02: Fe-Mn Martensite Morphologies.
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Comparing  Flexible Mode (left) to Grouped Mode (right) on a Plot Renderer as a successor to a 
Property Model Calculator. The advantage of Grouped Mode is that you can, for example, 
configure or edit settings in one place, making it easier to manage and work with the plot 
quantities.

To experiment using the Equilibrium Calculator, see Thermo-Calc example T_
02: Stepping in Temperature in the Fe-C System.

To experiment using the Material to Material Calculator, see Thermo-Calc 
example T_14: Fe-Cr-Ni Transition Comparison Using the Material to Material 
Calculator.
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Plot Type: CCT Mode

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

 Calculation Types in Graphical Mode 

See Plot Types detailing availability By Calculator, By Plot Type, or By Calculation 
Type.

Use CCT Mode to make a CCT diagram from a One Axis calculation with a Quantity of Log10
(cooling rate [K/s]) selected for the CCT Diagram Property Model. The X- and Y-axes are 
Time and Temperature, respectively. Result quantities defined as time-temperature pairs are 
identified and plotted. Cooling curves are also automatically added in the plot.

This plot type is available with the Steel Model Library, which requires specific 
maintenance and database licenses. See About the Steel Model Library 
Property Models.

In general, this plot type is available from the drop-down list in these situations: 

 l When you add the Steel - CCT template (on the  My Projects Configuration 
window under Property Models), it is the default type on the Plot Renderer 
(renamed CCT in the template).

 l If a user-defined Property Model has both Time and Temperature quantities defined 
in a coupled manner, for example if you create your own Property Model with TC-
Python. That is, if you select or create any model where the resulting combination of 
stepping-quantity and result-quantities has both time and temperature definitions.

Configuration Window Settings and Configuration Settings

Steel Library CCT Diagram Template

The settings example below uses Property Model example PM_Fe_08: CCT Diagram for Fe-C-
Mn-Si-Cr-V.
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CCT Mode on a Plot Renderer as a successor to a Property Model Calculator. 
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Plot Type: TTT Mode

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

 Calculation Types in Graphical Mode 

See Plot Types detailing availability By Calculator, By Plot Type, or By Calculation 
Type.

Use TTT Mode to make a TTT diagram from a One Axis calculation with temperature. The X- 
and Y-axes are Time and Temperature, respectively. Time quantities (such as Pearlite start, 
Bainite start) are plotted as functions of temperature. Temperature quantities (such as 
Martensite start, Martensite 50%) are independent of time and plotted as horizontal lines.

This plot type is available with the Steel Model Library, which requires specific 
maintenance and database licenses. See About the Steel Model Library 
Property Models.

In general, this plot type is available from the drop-down list in these situations:

 l When you add the Steel - TTT template (on the  My Projects Configuration 
window under Property Models), it is the default type on the Plot Renderer 
(renamed TTT in the template).

 l When you are using at least one of these Steel Property Models—Martensite 
Temperatures, Pearlite, or Bainite with a One Axis calculation and when both time 
and temperature quantities are selected on the Plot Renderer—the TTT Mode is 
available.

 l If a user-defined Property Model has both time and temperature quantities defined 
in a coupled manner, for example if you create your own Property Model with TC-
Python. That is, if you select or create any model where the resulting combination of 
stepping-quantity and result-quantities has both time and temperature definitions.

Configuration Window Settings and Configuration Settings

Steel Library TTT Diagram Template

The settings example below uses Property Model example PM_Fe_06: TTT Diagram for Fe-C-
Mn-Si-Cr-V.
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TTT Mode on a Plot Renderer as a successor to a Property Model Calculator. 
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Plot Type: Simple Mode and Advanced Mode

The Plot Renderer is a dynamic activity node with options such as being able to choose from 
a variety of Plot types based on the Calculator and Calculation Type selected.

Calculation Types in Graphical Mode and Plot Types

Simple Mode and Advanced Mode as a Plot type are only available for the 
Diffusion Module (DICTRA) in Graphical Mode. Unlike many other Calculators, 
the Diffusion Calculator does not require the selection of a Calculation Type 
before a Plot Type is available on the Diffusion Calculator Plot Renderer.

Simple Mode

Use Simple Mode to define the most common axis variables. The software automatically 
sets the correct  Plot condition and Independent variable. 

For one example using Simple Mode, see D_04: Fe-C Moving Boundary - 
Austenite to Ferrite.

Advanced Mode

Use Advanced Mode to select any combination of axis variables, and then access further 
settings such as the Plot condition, Region, and Independent variable. Examples of 
advanced plot options are activity of a component at an interface, diffusivities, and diffusion 
paths. Also user-defined functions can be used as plot variables where Console Mode syntax 
is used to define functions. In some cases, sensible default values are selected, but they can 
be changed according to your needs. 

For one example using Advanced Mode, see D_10: Iron (Fe) Homogenization in 
Scheil.

Switching Between Modes

You can try yourself to switch between Simple Mode and Advanced Mode and then change 
the settings to how you want it using  example D_04: Fe-C Moving Boundary - Austenite to 
Ferrite.
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Comparing  Simple Mode (left) to Advanced Mode (right) on a Plot Renderer as a successor to a 
Diffusion Calculator. For Advanced Mode, there are additional settings made available based on 
the combination of axis variables.
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Zooming In and Out

In the Visualizations window (where the plots are):

 l Use the mouse scroll wheel to zoom in and out. 
 l Click and drag the  mouse from left to right to highlight an area of the plot to zoom 

into a specific point. Use the scroll wheel to continue zooming in or out.

Resetting a Plot to the Default View

 l For 2D plots, click and drag the mouse from right to left.
 l For 2D and 3D plots,  click Perform Tree to regenerate the plot in the Visualizations 

window.

Rotating 3D Plots

In the Project window (where the activity nodes are):

 l Right-click and select Zoom In or Zoom Out. 
 l To go back to the default zoom, select Reset Zoom.
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Plotting Several Calculations in One Diagram

To plot several calculations in one diagram, you must have, in addition to the Plot 
Renderer’s original predecessor, at least one available Plot Renderer predecessor in your 
project, for example, the additional predecessor can be an Equilibrium Calculator, Binary 
Calculator, Ternary Calculator, Scheil Calculator, or Experimental File Reader.

 1. In the Project window click the Plot Renderer node. 

 2. In the Configuration window click Add Predecessor. Or right-click the Plot Renderer 
and choose Add Predecessor.

 3. Select a predecessor. When added, the extra predecessor is linked to the Plot 
Renderer. On the Plot Renderer Configuration window, the predecessors are shown 
as two tabs:
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 4. Configure how you want each calculation plotted on the tabs in the Configuration 
window, then click to Perform the Plot Renderer activity.

The calculations are plotted in the same diagram in a tab in the Visualizations 
window. If any of the axis variables of the plots differ, then the label and scale of all 
calculations are shown parallel to each other. The following shows two calculations 
where different axes variables are plotted.
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Plot Renderer: Convert a Plot to a Table and Export the 
Data

For all calculation types and calculators, the associated Plot Renderer has a Table View  
button you can use to  convert a plot to table data.  Once the plot data is converted, you can 
toggle between displaying the plot or table in the Visualizations window as well as save the 
table and export to file. 

For the Table Renderer only single equilibrium and property diagram (stepping) 
calculations are available.

Converting a Plot to a Table on the Plot Renderer

 1. Set up the Plot Renderer for your particular calculation and click Perform to display 
the plot in the Visualizations window. 

 2. On the Plot Renderer Configuration window, click the Table View   button (toggled 
ON).

 3. Choose the Decimal digits and Number format (Auto, Decimal, or Scientific) to 
display in the table. 

 4. Click Perform. This converts the plot data to display table data in the Visualizations 
window.

Switching Between a Plot and a Table in the Visualizations 
Window

Once the plot data is converted, you can toggle between displaying the plot or table in the 
Visualizations window. 

 l To display the Table: On the Plot Renderer Configuration window, click the Table 
View   button to toggle it ON and then click Perform to generate the table. 

 l To display the Plot: On the Plot Renderer Configuration window, click the Table View 
  button to toggle it OFF and then click Perform to generate the plot. 

Saving the Table (Exporting the Data)

Once the plot data is converted to a table, you can save/export this to file. 
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 1. Convert the plot to a table (the Table View  button is toggled ON).

 2. Click Save table to export the table data. 

 3. In the Save As window navigate to where you want to save the table.

 4. Enter a File Name.

 5. From the Files of Type list choose Text [*.txt](the default), Hyper Text Markup 
[*.html],  or Excel [*.xls]. 

 6. Click Save.

Saving and Printing the Output in Graphical Mode for more options.
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Merging Plots into One Diagram

You can merge (or overlay) calculated results for several variables into one diagram. The 
same X and Y variables are used to compare the third variable (defined in the Plot Renderer 
as the Z-axis).

You cannot overlay heat map or frequency plots.

The following uses example PM_G_03: Driving Force and Interfacial Energy to describe the 
steps to overlay two plots: the driving force and interfacial energy results are combined into 
one diagram. The X- and Y-axis is the same for both (Mass percent Cr/Mass percent Mn).

 1. In the Project window right-click the calculator node (e.g. Property Model Calculator) 
and add a Plot Renderer node from the Create New Successor menu.

 2. Click the Plot Renderer node.

 3. In the Configuration window, define the plot. Available settings are based on the 
calculation type. In this example the Property Model Calculator is set to a Grid 
calculation type. Choose On for the Legend option and Contour as the Plot type.

 4. Click the Add an axis    button. A new axes settings section is added underneath.

 5. From the Z Axis section choose the Axis variable. In this example, Interfacial energy.

 6. Click Perform to plot both on the same diagram. 

In this case, a contour plot showing both the driving force and interfacial energy 
calculation results comparing Mass percent Cr to Mass percent Mn.
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Adding Axes to a Diagram

You can add additional X- and/or Y-axes to a plot to compare two or more variables at the 
same time. 

The following uses example PM_G_03_Driving_force_and_Interfacial_
energy.tcu and its Equilibrium Calculator as the starting point to create the plot 
shown in the figure.

 1. In the Project window right-click the calculator node (e.g. an Equilibrium Calculator) 
and add a Plot Renderer node from the Create New Successor menu.

 2. Click the Plot Renderer node.

 3. In the Configuration window, define the plot. Available settings are based on the 
calculation type.

 4. Click the Add an axis    button. A new settings section is added underneath.

 5. From the X Axis and/or Y Axis sections define another Axis variable and choose an 
Axis type. 

 6. Click Perform to plot both variables on the selected axis, in this example, the Y-axis. 

In this example using Amount of phase and Volume are selected as the Y-axis 
variables and Temperature as the X-axis variable. 
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The final plot comparing the additional variables.
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Rotating 3D Plots

When you use a Grid calculation type you can plot the diagram in 3D.  

Plot Type: Heat Map, Contour, and 3D and Calculation Types in Graphical Mode

3D Plots with additional functionality are also available with the Add-on Additive 
Manufacturing (AM) Module. The information is described separately and 
included with the Module's documentation.  

In the Visualizations window after you create the 3D plot:

 l Rotate the diagram automatically. Double-click in the Visualizations window and the 
diagram rotates clockwise. Left-click once to stop the automatic rotation.

 l Rotate the diagram manually. Left-click and hold the mouse and move it around the 
Visualizations window.

 l Scroll the mouse wheel/use your fingers on a trackpad to zoom on the Z-axis values. 
 l Right-click and move the mouse to shift the surface up or down without zooming.
 l To reset the plot to its default view click Perform Tree to regenerate the plot.
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Plot and Table Formatting 
In this section:

Setting Background Colours 420

Changing the Plot Properties 421

Plot Labels 423

Plot Labels: Entering a Mixture of Plain Text and Equations 424

Plot Labels: Rotation Angle and Show Anchor 426

Moving Plot Labels 427

About Legend Styles 428

Legend and Label Styles 429



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 420 of 763

Setting Background Colours

To change the background colours of the table, in the Visualizations window right-click a 
Table Renderer tab, and select Properties. Modify as required.

The defaults for these settings can be changed globally from the Options 
window.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Tabulation node in the tree. 
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Changing the Plot Properties

To make local changes to the appearance of a specific plot, in the Visualizations window 
right-click a plot and select Properties. 

The available settings are the same as what you can globally set under the Tools →  
Options menus but are only applied to the specific plot. Below includes details about 
features that are unique to the local plot properties options. 

To make global plot setting default changes, see the details in Global Settings: 
Graphical and Console Mode Plotting. 

Edit Individual Plot Lines 

You can also edit some properties for individual plot lines (the color, the line width and type, 
and whether data points are included). 

In the Visualizations window, hover the mouse over a plot line. When it is over a line that 
can be clicked the crosshair cursor turns into a pointing finger. Click the line and then you 
can make changes for that specific line. 

To prevent unintended edits, hold down <Ctrl> while moving the cursor around 
the plot to only display it as a crosshair.

Color Switching Plots Between Light and Dark Mode

Depending on whether you are using a Light or Dark look and feel for the user interface (see 
Global General Settings), you can also switch the default colors (lines, background, and 
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more) of a plot using this local Plot Properties option. Alternatively, to set the global 
defaults for future project files (and plots), see Global Plot Settings: Design the Look and 
Feel.

Use the Color switching option to override the look and feel settings that may 
not be optimal. For example, when preparing a plot for publication, the Dark 
mode plot or line colors may not work well or do not follow a journal's 
guidelines. In other words, you can view and export the plot with Light mode 
color settings even though the interface is using Dark mode, and vice versa. 

How to Use the Color Switching for Local Plots

Perform your calculation. Right-click in the Visualizations window and select Plot Properties. 
Select a Color switching option:

 l Switch automatically between Light mode and Dark mode: The default, which 
matches the current look and feel for the GUI. 

 l Always use Light mode colors: If you are in Dark mode, this immediately switches 
the plot to Light default color settings.

 l Always use Dark mode colors: If you are in Light mode, this immediately switches 
the plot to Dark default color settings.

Tie lines and invariant lines are the same color for both Light and Dark modes, 
i.e. these colors do not change. 

Additional Plot Color Changes are Locked to the Original Mode 

When applying any of these settings, you can make further changes to the colors for the 
local plot but the change is locked to the mode. For example, you are in Dark mode and you 
change the plot background color to yellow. Then you switch to a Light look and feel mode. 
The background color for that plot is the default white background that is set for Light mode. 
Then if you change the background to blue, but now switch to a Dark look and feel, the 
background is yellow as this is the color applied in Dark mode to this particular plot. If you 
switch back to Light mode then the plot background is blue again. 
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Plot Labels 

To add a label text at a certain point in a plot, right-click the point, and select Add Label. For 
phase diagrams, the program suggests a label that you can keep or edit. The suggested label 
specifies the names of the stable phases at the coordinate where you clicked. For all other 
plot types, you enter your own text, which can either be Plain text or LaTeX formatted text.

You can enter the label as Plain text or in LaTeX-formatted text. For LaTeX-formatted text  
enter or edit the text as required. For example, underscores (_) are added before the 
numbers to make subscripts in the label. 

By default when using the LaTeX command, you are in math mode and 
Thermo-Calc automatically interprets the entered text as math. The above link 
uses the dollar sign ($) in all the examples but this is NOT required. For 
example, if you enter $E=mc^2$ this is displayed including the $ instead of the 
equation.
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Plot Labels: Entering a Mixture of Plain Text and Equations

When you enter text using LaTeX formatted text it displays  the text as an equation.

When using the Plain text format, the label does not display correctly because the label is a 
mixture of text (Mole-Fraction) and an equation needing subscripts (Al_2O_3). 

To add a mixture of plain text and equation formatted text, exit math mode by using the 
string \textsf followed by the text to display enclosed in curly brackets {}. 

For example \textsf{Mole-fraction }Al_2O_3 results in this label. In this example, you 
need to add a space at the end of fraction in order to separate the text from the equation 
part of the label. You can also choose a color to apply to the label text. 
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When working in Console Mode, you can also use the above windows on the 
Console Results window to add and edit labels. In addition, you can use the  
command.

It is possible to change the text style used in LaTeX labels, either for a section of the text or 
for the whole text (unless something else is specified).

Section of Text Within Curly Brackets All Text After the Command Resulting Text Style

\textsf{} \sf Sans serif (default)

\textrm{} \rm Roman

\textbf{} \bf Bold

\textit{} \it Italic

\textem{} \em Emphasis

\texttt{} \tt Monospace



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 426 of 763

Plot Labels: Rotation Angle and Show Anchor

By default the Show anchor checkbox is selected, which includes an arrow from the label 
point to the coordinates.

If you do not want the label oriented horizontally in the Plot Renderer tab, then specify the 
number of degrees of rotation in the Rotation angle field.

Click OK to add the label to the plot. You can also move a label by clicking and dragging it. 
The default anchor arrow is added to indicate the point that belongs to the label.
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Moving Plot Labels 

Drag and drop labels anywhere on the plot. The anchor arrow points to the point of origin.

Close up of a plot label before being moved (top) and after being moved (bottom). The arrow in 
the lower image points to the label's original location on the plot.
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About Legend Styles

There are a variety of legend styles you can use to display detail about the phases. The same 
legend styles are available for both Graphical Mode and Console Mode plots. 

For Console Mode, use the command  CHANGE_LEGEND. 

In Graphical Mode the label styles are defined when using the Plot Renderer. You can select 
a Legend style for the Stable phases or Axis quantity selected for Legend option.

When there is a legend in the diagram you can append constitution and/or ordering 
descriptions to the phase name.

If constituent description is included in the legend, then for each equilibria along a line in the 
diagram, the largest constituent fractions are summed until they are equal or greater than 
0.6. This is done separately for each sublattice. If the equilibria along the line gets different 
sets of constituents these are all appended to the list for that sublattice.

The ordering description is only printed for partitioned phases (phases that have a 
disordered contribution) that begins with at least two identical sublattices (sublattices 
where the set of constituents are identical).  DISORD (disordered) is shown if site fractions are 
identical between identical constituents on all identical sub lattices (with an error margin) 
otherwise ORD (ordered) is shown in the legend.

If ordering between equilibria in a line are different, then ORD + DISORD is shown in the 
legend.
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Legend and Label Styles

Legend Styles

To show the differences between labels, the following uses the same example file that 
creates Figure 6 in  TCNI database extended information document (found on the 
Thermo-Calc website).

When All is selected for this specific example the label includes the following:

Specifically:

 l There are two disordered FCC phases (matrix and carbide), one ordered FCC (gamma 
prime), plus a phase NI3TA_D0A (called Delta in Ni-alloys).

 l ORDERING shows the different FCC phases.
 l CONSTITUTION shows that FCC_L12#1 is NbC, FCC_L12#2 is matrix with Ni and Cr as 

major constituent, FCC_L12#3 is Ni3Al with Nb addition and NI3TA_D0A is Nb-rich 
(eg. Ni3Nb).

Label Styles

These examples are for each label style choice - None, All, Constitution, or Ordering. The 
instructions are for when you are setting the options using the Plot Renderer. In Console 
Mode, you choose the options (ALL, NONE, CONSTITUTION, or ORDERING) after the command 
CHANGE_LEGEND.

NONE

When None is selected the legend includes the standard information about the phases.

https://www.thermocalc.com/solutions/by-material/nickel-based-alloys/
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ALL

When you select All the Constitution description and the Ordering description (when there 
is ordering) are included.

CONSTITUTION DESCRIPTION

When you select Constitution description, this is added to the standard description.

Here is an example with a brief explanation of what you might see when choosing this 
option. 

Only major constituents are listed. 
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First there is the phase name then (NB, V : MO, Ti : VA) meaning the first sub-lattice contains 
mostly NB and V. The second sub-lattice contains mostly Mo and TI, the third sub-lattice 
contains mostly VA= Vacancy= No atom/molecule at all.

Mostly" means Thermo-Calc sums the largest site fractions in a sub-lattice until it reaches 
0.6. E.g. If sorted values are FE=0.5, AL=0.15, CR=0.15, NI=0.09 + smaller values then you will 
get "(Fe,AL,CR)" because FE+AL > 0.6 and then CR because it has same size as AL.

ORDERING DESCRIPTION

When you select Ordering description and when there is ordering, this is added to the 
standard description.
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Additive Manufacturing (AM) Module
In this section:

About the Additive Manufacturing (AM) Module 433

Available Options 437

Additive Manufacturing (AM) Module Help Resources 443

Network License Restrictions 444
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About the Additive Manufacturing (AM) Module

This guide is a supplement to the full Thermo-Calc documentation set. Access 
the help in Thermo-Calc by pressing F1, or choose Help →  Online help, or 
click  Online Help on the main My Project Configuration window. See Addit-
ive Manufacturing (AM) Module Help Resources to learn other ways to access 
information.

The Additive Manufacturing (AM) Module (also referred to as the AM Module) is an Add-on 
Module to Thermo-Calc and it is available in Graphical Mode as the AM Calculator. The aim 
of the Additive Manufacturing Module is to better understand the laser powder bed fusion 
(LPBF) process by predicting the temperature distribution and melt pool geometry as a 
function of process parameters and using material properties from the Thermo-Calc 
thermodynamic and properties databases. Special focus is to have a unified treatment of 
alloy-dependent material properties and process parameters when solving the multiphysics 
problem of a moving heat source that melts and solidifies metal powder. The multiphysics 
simulation involves thermal conduction, fluid flow, evaporation-, radiation-, and convective-
heat loss.

The Module can simulate the transition from conduction- to keyhole-mode.  With 
experimental melt pool data you can calibrate the heat source. The calibrated heat source 
can be used to predict additional process conditions and/or to construct printability (aka 
process) maps.

Furthermore, once you have the temperature distribution, for instance as a function of time 
and space, you can also use this information for other Thermo-Calc Add-on-Module 
simulations such as with the Diffusion Module (DICTRA) or the Precipitation Module (TC-
PRISMA), or for input to other external finite element programs.

Evaluation of the following is possible depending on the calculation type.

Steady-State
 l Size of melt pool
 l Peak temperature
 l Velocity of fluid flow
 l Property variations through the melt pool (temperature, viscosity, thermal 

conductivity, density) or any selected line
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 l 2D sectioning in any plane
 l Heat source calibration
 l Thermal gradient and solidification rate
 l Keyhole mode (with a Gaussian heat source) with or without fluid flow.

Transient and Transient with Heat Source from Steady-state
 l Temperature vs. time response at selected points of the build and how this changes 

with process parameters
 l Time-dependence of the properties listed above under steady-state
 l Thermal gradient and solidification rate
 l Connect the above temperature vs. time response with the Diffusion Module 

(DICTRA) and/or the Precipitation Module (TC-PRISMA)
 l Keyhole mode (with a Transient from Steady-state calculation using a Gaussian heat 

source) with or without fluid flow.

Overview of the Content 

In This Guide

There are Additive Manufacturing (AM) Module Help Resources and Network License 
Restrictions to consider and access.

Theory is included in a variety of feature topics. Some basic equations pertaining to the logic 
behind the simulation and settings are discussed in Additive Manufacturing Module Theory, 
as well as particular details about other features are discussed in About Heat Source 
Calibration, About the Keyhole Model, and About the Absorptivity Model, for example.

Feature overviews are covered in a summary of the Additive Manufacturing Simulation 
Types as well as the Steady-state Calculation Types and associated About the AM Plot Types, 
which links you to feature-based topics for each calculation or plot type.

The workflow for the AM Module is outlined in Setting Up the Additive Manufacturing 
Simulation and there are two default Additive Manufacturing Templates you can use to start 
defining your project. You can also add nodes individually to build your own tree. There are 
two workflows, and in either workflow, defining the AM Calculator involves choosing one of 
the available simulation types: Steady-state, Transient, or Transient with heat source from 
Steady-state.
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Then you can start building the simulation using the activity nodes and depending on which 
workflow you start with.

This involves the standard System Definer and Scheil Calculator settings, which are the 
same as what is used with a standard Thermo-Calc configuration. When you add an Additive 
Manufacturing Template (and need to generate some materials properties or do not have a 
material library to use), then some unique default settings for the Scheil Calculator and 
these particular types of simulations are already set by default. These are discussed in 
Setting Up the Additive Manufacturing Simulation.

This set of topics specifically includes details about the settings for the AM Calculator and 
the specialized AM Calculator: Plot Renderer Settings. There are many additional specialized 
sections related to working with, for example, probe data as well as experimental data files 
that are used in heat source calibrations and batch calculations. 

There are many details related to visualizing the plots discussed in several sections, starting 
with Working with AM Visualizations and then extended with specialized sections Visualizing 
Heat Source Calibrations and Visualizing Batch Calculations in the AM Module. The power of 
the AM Module is that there are many ways visualize both the set up (i.e. you can preview a 
variety of settings) and then finally examine and work with your results using the 
AM Visualizations Window Plot Toolbar and many other settings. 

There are also several examples included with the installation that are generally discussed 
and described in the examples section or as part of the Graphical Mode Examples Guide.

Databases

For compatibility with the Additive Manufacturing Module, a database needs the following 
properties added in addition to the thermodynamics: surface tension for liquid, viscosity for 
liquid, thermal conductivity, molar volume, and a complete gas description.

Available Databases

The Additive Manufacturing Module is currently available together with the following 
databases, starting with the version indicated:

 l Aluminum-based Alloys Database (TCAL9 and newer)
 l Copper-based Alloys Database (TCCU6)
 l High Entropy Alloys Database (TCHEA6 and newer)
 l Magnesium-based Alloys Database (TCMG6 and newer)
 l Molybdenum-based Alloys Database (TCMO1)
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 l Nickel-based Superalloys Database (TCNI12)
 l Niobium-based Alloys Database (TCNB1)
 l Noble Metal Alloys Database (TCNOBL3)
 l Solder Alloy Solutions Database (TCSLD5 and newer)
 l Steel and Fe-alloys Database (TCFE13 and newer)
 l Titanium and TiAl-based Alloys Database (TCTI5 and newer)

Read more about the Additive Manufacturing (AM) Module on our website 
including the details about database compatibility or to watch an introductory 
webinar. You can also use the Getting Started Guide to learn about the key 
features available. 

https://thermocalc.com/products/add-on-modules/additive-manufacturing-module/
https://resources.thermocalc.com/webinar-demonstration-of-the-new-additive-manufacturing-module
https://resources.thermocalc.com/webinar-demonstration-of-the-new-additive-manufacturing-module
https://thermocalc.com/support/getting-started-guides/additive-manufacturing-module-guide
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Available Options

The Additive Manufacturing (AM) Module is an Add-on Module to the core Thermo-Calc 
software.

A separate license is required to perform calculations with the Additive 
Manufacturing (AM) Module. Without a license you are in Demo Mode where 
you can, for example, open and view example set ups, run some examples, add 
templates and nodes to the Project window, adjust some Configuration 
settings, and preview some functionality on the Visualizations window. 

The Additive Manufacturing (AM) Module is not available with the free 
Educational version of Thermo-Calc. 

Additive Manufacturing Templates

Two types of Additive Manufacturing templates are under Applications and these are 
available to all Thermo-Calc users when in Graphical Mode. If you are in DEMO 
(demonstration) mode then this is indicated by the addition of DEMO text. See Figure 20.

Using the Templates

After opening Thermo-Calc in Graphical Mode, in the templates section under Applications, 
click the Additive Manufacturing button to add a System Definer, Scheil Calculator, AM 
Calculator, and Plot Renderer to the Project tree.

This template is used when you need to generate and use data from a Scheil calculation.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 438 of 763

An alternate template is available when you already have data or can directly use or import 
a Material Library.

After opening Thermo-Calc in Graphical Mode, in the templates section under Applications, 
and to the right of Additive Manufacturing, click the With Material Library button to add an 
AM Calculator and Plot Renderer to the Project tree.

Demonstration (Demo) Mode

The Additive Manufacturing (AM) Module is available in a demonstration (DEMO) mode 
without an additional AM license. It includes access to the templates, some examples, and 
some access to the embedded predefined material properties libraries. You also have access 
to the fluid flow settings and a steady-state calculation can be done. However, there are 
limitations such as the ability to change settings and to fully run calculations.

What is Included?
 l Some examples (i.e. AM_01, AM_02, AM_03, and AM_06b) use embedded and 

predefined Material Properties libraries that are included for all users. Although 
these examples can be run without a license, you cannot make any changes to the 
settings. If changes are made, the Perform button can still be clicked but the 
calculation will fail and a message displays above the Perform Tree button to inform 
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you of the need for a license. In addition, the Event Log displays an error message, 
ERROR AM Calculation: AM Calculation in Demo mode has limited 

functionality. See Figure 21.
 l Generally, when in DEMO mode and using the With Materials Library template, you 

can perform a calculation with default values. You cannot change any setting, 
including the calculation types (i.e. Steady-state, Transient, or Transient with heat 
source from Steady-state) as well as the Material Properties library i.e. meaning only 
Steady-state with the IN625 library is available with the default setup is possible.

 l All plot configurations are possible to perform in the above cases.
 l The following examples require a full license to the Additive Manufacturing (AM) 

Module to run, plus often additional licenses (i.e. for databases or other Add-on 
Modules): 

 l  AM_04, AM_05, AM_06a, and AM_07 to AM_12.
 l For those without the applicable licenses, you can still open the examples to 

review the settings and then refer to the documentation for discussions of 
what it is showing

You can also view the Getting Started Guide on the website, which uses AM_04 
in the example. 

Figure 20: The templates indicate that you are in DEMO mode and would need an AM license to 
fully use the templates or run certain examples as listed in the text.

https://thermocalc.com/support/getting-started-guides/additive-manufacturing-module-guide/
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Figure 21: When in DEMO mode and you click on the AM Calculator node, the above note is 
included at the bottom of the Configuration window to remind you that a license is needed for full 
functionality. The Perform Tree button is not always available and sometimes even if it is available 
to click, the calculation itself cannot complete due to lack of a license. There will also be an error 
message in the Event Log to indicate the need for a license.

Material Properties and Libraries

All predefined Material Properties libraries are available if you have a license 
for the Additive Manufacturing (AM) Module, even if you do not have the alloy 
database it is created with.

Create or Import Your Own Material Library

The use of the Scheil Calculator with an AM Calculator provides you with a way to generate 
the data you need to feed into any AM calculation. When this Scheil calculation is 
completed, and if you have a full license, you can save the results to the Material Properties 
Library for later use. From the AM Calculator there is an option to use either Scheil data 
(when it is connected to the Scheil Calculator) or predefined library data (as long as you have 
a license to the Additive Manufacturing (AM) Module the calculations can be run fully). With 
the applicable license, you can also import your own material library for a particular alloy of 
interest and then you can just use the AM Calculator (i.e. the With Material Library 
template setup) without needing the additional Scheil calculation step.

Users with a full Additive Manufacturing license can access all the predefined libraries for 
use in calculations (and also can create and import their own libraries and save these for 
reuse).
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Other Options

Using Data with other Add-on Modules

When you also have licenses either for the Diffusion Module (DICTRA) and/or 
the Precipitation Module (TC-PRISMA), for transient simulations you can 
additionally  include probe data from the AM Calculator in the set up of the 
thermal profile for diffusion and precipitation calculations, respectively. 

See AM Calculator: Working with Probe Data.
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Additive Manufacturing (AM) Module and TC-Python

When you also have a license for the TC-Python Software Development Kit, you 
can use the Additive Manufacturing (AM) Module functionality. Some examples 
are available with just a TC-Python license. Learn more about TC-Python on our 
website.

https://thermocalc.com/products/software-development-kits/tc-python/
https://thermocalc.com/products/software-development-kits/tc-python/
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Additive Manufacturing (AM) Module Help Resources

'Online' Help: No Internet Required

There are several ways to access online help in a browser. The content opens in a browser 
but uses local content so you do not need an Internet connection except for links to external 
websites.

First open Thermo-Calc, then choose one of these options:

 l Press <F1> on the keyboard.
 l Select Help →  Online Help.

 l On the My Project Configuration window, click  Online Help.
 l At the bottom of any Configuration window, click  Help.

There are several resources available on our website to help you learn how to 
use Thermo-Calc and other Add-on Modules. Go to the Getting Started Guides 
page and choose one of the guides that provides new users an introduction to 
setting up simple calculations in Graphical Mode. The information there is also 
in this help documentation.

Additive Manufacturing (AM) Module Specific Information

Read more about the Additive Manufacturing (AM) Module on our website 
including the details about database compatibility or to watch an introductory 
webinar. You can also use the Getting Started Guide to learn about the key 
features available. 

For more Additive Manufacturing (AM) Module learning resources, visit the 
video tutorials on our website or our YouTube playlist.

https://thermocalc.com/support/getting-started-guides/
https://thermocalc.com/products/add-on-modules/additive-manufacturing-module/
https://resources.thermocalc.com/webinar-demonstration-of-the-new-additive-manufacturing-module
https://resources.thermocalc.com/webinar-demonstration-of-the-new-additive-manufacturing-module
https://thermocalc.com/support/getting-started-guides/additive-manufacturing-module-guide
https://thermocalc.com/support/video-tutorials/additive-manufacturing-module-examples/
https://www.youtube.com/playlist?list=PLfv6McToaTGS-LW4xV4YFPLcAmIuDvKu0
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Network License Restrictions

The Additive Manufacturing (AM) Module requires a separate license. If you are using a 
network client installation of Thermo-Calc, then you may not be able to use it even if you 
have access to a license server with a valid network license file. The reason for this is 
because other clients who are part of your network installation may have checked out all 
instances of the network license allowed to run simultaneously.

For users with a network license, you must exit Thermo-Calc to release the 
license for other users. The license is checked out as soon as you add an AM 
Calculator and remains unavailable to other users until you exit the program.

With a network license, and if as per above you temporarily do not have access 
to a license, you are automatically put into Demo Mode. Then the AM Calculator 
is available.

Search the online help or see the Thermo-Calc Installation Guide for more 
about network licenses.
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Additive Manufacturing Module Theory

This section is an overview of the underlying fundamental theory used and applied to the 
calculations when you are setting up the AM Calculator using one of the Additive 
Manufacturing Simulation Types.

The settings related to the following are defined for the AM Calculator starting 
with the AM Calculator Conditions Settings section.

Energy Equation: The Enthalpy Formulation

The following formulation is based on a simple assumption that each volume element, which 
may contain several dendrites or a considerable part of a dendrite, is approximated as 
homogeneous, i.e., it is sufficient to characterize the whole volume with a single set of state 
variables. This assumption thus excludes the direct account of varying composition caused 
by microsegregation within the element.

The enthalpy formulation is based on the conservation of energy and is essentially 
equivalent with Fourier’s second law:

[Eq. 1]          

is the enthalpy density and is its time derivative.

The enthalpy density is related to the molar enthalpy  and molar volume  by:

[Eq. 2]         

 denotes the divergence operator and  is the heat flux given by Fourier’s law:

[Eq. 3]         

where  is the heat conductivity,  denotes the gradient operator and  is the 
temperature.  is a source term and represents the heat added from the outside at a certain 
point. In modeling of a process like welding or additive manufacturing this is a key term and 
requires a lot of modeling.

As state functions the enthalpy and the molar volume depend on temperature, state of 
phase, and composition of the individual phases. In a volume element approximated as 
homogeneous, one thus has:

[Eq. 4]         
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[Eq. 5]          

where is the mole fraction of the phase  and  is the mole fraction of  in . The time 
derivatives thus are:

[Eq. 6]          

[Eq. 7]          

Here  is the molar heat capacity of the  phase and its volumetric thermal expansion. 
For a given volume element the rates can be calculated from Thermo-Calc for the 

temperature, fraction of phases and their composition with the input of the rates and .

The rate of change of the enthalpy density, i.e., the left-hand side of Eq. 1 thus is obtained 
as:

[Eq. 8]         

The first term inside the brackets represents the change for a constant number of atoms due 
to a change in temperature or phase. The second term represents a change in volume for a 
constant number of atoms. However, the second term is balanced by a corresponding 
contribution in the heat flux, which we do not usually account for, and we should thus leave 
it out.

[Eq. 9]          

The fraction of phases sums up to unity and in the case of only one solid phase:

In most treatments the positive quantity

treated as constant and referred to as the latent heat. It is also common to neglect the 
difference in heat capacity between solid and liquid and the variation of  with 
composition. Eq. 6 then is simplified into

[Eq. 10]         

By the same token
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is often approximated as constant and so Eq. 7 is simplified into

[Eq. 11]         

where  is given by Eq. 5 and yields

Eq. 9 now becomes:

[Eq. 12]         

and Eq. 1 becomes:

[Eq. 13]          

The Equivalent Heat Capacity Method Using Thermo-Calc

If it is further assumed that the fraction liquid  is a unique function of temperature one 
has:

[Eq. 14]         

and Eq. 13 may be further simplified to:

[Eq. 15]          

where the effective heat capacity  is given by:

[Eq. 16]         

Eq. 15 is a normal heat-flow equation and the complication of the liquid/solid phase 
transformation is taken into account by means of an effective heat capacity. This method is 
referred to as the equivalent heat-capacity method by Rappaz [1989Rap].

It then remains to be discussed how to determine . It must be given by some extra 
information. Traditionally it was taken from experimental information but more recently it 
has been taken from the Scheil equation. The original equation was based on a number of 
approximations which are unnecessary today when thermodynamic and properties 
databases and efficient software such as Thermo-Calc are available. In fact, when using 

Scheil in Thermo-Calc one can directly calculate , referred to as apparent heat 
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capacity, for a given initial composition of the liquid. A possible approach thus is to calculate 
 for the alloy under consideration and then store the result as a table and use that in 

the solution of Eq. 15. The molar volume may be extracted from the same calculation. An 
example for a 316L type of stainless steel is shown in the plots below.

Figure 1: Results of a Scheil simulation of Fe-18Cr-10Ni alloy showing the mass fraction of the 
liquid (left) and the apparent heat capacity (right) both as a function of temperature.

Figure 2: Molar volume from a Scheil simulation of Fe-18Cr-10Ni alloy. The right plot shows all 
phases as a function of temperature.

The Enthalpy Method Using Thermo-Calc

In the enthalpy method we keep Eq. 1 and use Eq. 9 to write
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[Eq. 17]          

As pointed out by Rappaz [1989Rap] there is no mathematical difference between the 
enthalpy method and the equivalent heat capacity method because the former is simply the 
integral of the heat capacity over . For numerical reasons the cusps in the heat capacity 
may be disadvantageous and the enthalpy has a nicer behavior as shown in the plot below, 
where it gives temperature as a unique function of enthalpy.

Figure 3: Enthalpy from a Scheil simulation of Fe-18Cr-10Ni alloy.

In the Additive Manufacturing Module, we therefore use Eq. 17 to predict the evolution of 
temperature during the laser powder bed fusion (LPBF) process for the given material 
properties and process parameters.

Steady-state Formulation

An important approximation is when one can solve the stationary heat-flow equation for a 
volume element moving with the heating source. In that case, we neglect the left-hand side 
of Eq. 17 and add a translation term as follows:

[Eq. 18]         

Where  is the velocity of the heat source. In case of additive manufacturing,  is the 
scanning speed.

Fluid Flow

When there is also fluid flow involved, a fluid transport term has to be added to the heat-
flow equation and one obtains:
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[Eq. 19]         

where  is the velocity vector field and may be imposed or obtained from the solution of the 
Navier-Stokes equation:

[Eq. 20]         

where  is the density related to the molar volume by means of

[Eq. 21]         

is the molar weight in kg mol-1.  is the viscosity,  is a volume force, e.g., gravitational 
forces, and  is the internal pressure. The equation is often combined with approximating 
the liquid as incompressible.

[Eq. 22]         

LARGE EDDY SIMULATION USED FOR FLUID FLOW

The use of a subgrid model [1963Sma] relies on the eddy-viscosity assumption and this is 
applied to account for the unresolved turbulent motions that cannot be directly simulated 
due to computational limitations. The Smagorinsky model is the default for fluid flow, and it 
provides a simple way to estimate Subgrid-scale (SGS) viscosity in large eddy simulation as,

where:

 l  is the Smagorinsky constant (default value is 0.18).
 l  represents the filter width (length scale).

 l  is the magnitude of the resolved strain rate tensor.

Modeling Heat Source

It is crucially important to correctly model the heat source in AM simulations since the heat 
source not only affects the size of the melt pool but also determines the temperature 
gradients around the melt pool. In the Additive Manufacturing (AM) Module, there are three 
types of heat source models: Gaussian, Double-ellipsoidal, and Conical.
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Also see additional theory related to heat sources in About Heat Source 
Calibration.

GAUSSIAN HEAT SOURCE

The first model is a surface heat source model which was initially proposed by Pavelic et al.
[1969Pav]. By surface heat source model, it is meant that the power input from the heat 
source is only defined on the top surface of the workpiece, as a Neumann boundary 
condition on the computational domain, and the heat energy then diffuses into the 
workpiece depending on the thermal diffusivity of the selected material. As suggested by 
Pavelic et al., the heat flux (W/m2 ) is defined as Gaussian distribution around the center of 
the heat source, deposited on the top surface of the domain, as given in the equation below. 
A schematic representation of the heat flux, as defined by Gaussian heat source is shown in 
the figure below.

[Eq. 23]         

Where  is the power density deposited on the top surface (W/m2 ),  denotes absorptivity 
of the laser beam,  is the power of the heat source (W),  is the laser spot radius, and  and 
 denote coordinates of the computational domain while  and  represent the location of 

the heat source.

Figure 4: Schematic representation of energy distribution in Gaussian heat source model.

Also see additional theory related to using a Gaussian heat source with the 
keyhole option in About the Keyhole Model.

DOUBLE ELLIPSOIDAL (GOLDAK) HEAT SOURCE

The second heat source model in the AM Module is a volumetric heat source model which 
was first proposed by Goldak et al. [1984Gol], and is now commonly used in LBPF 
simulations. In contrast to the surface heat source model, in the volumetric heat source 
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model, the power input is defined not only on the surface of the workpiece but also inside 
the powder bed, along the depth of the powder bed. The heat distribution in the double-
ellipsoidal heat source model is given by a combination of two ellipsoids; one in the front 
quadrant of the heat source and the other in the rear quadrant, as shown in the figure 
below. The power density is thus given by two different expressions, one for each quadrant 
of the heat source.

[Eq. 24]         

Where  and  are the power densities (W/m3 ) in the front and rear quadrant of the heat 
source, while  and  are the semi-axes of the front and rear ellipsoids, respectively.  and 
 are the semi-axes along the width and depth of the melt pool.  and  are the 

proportional coefficients for the front and rear ellipsoid of the heat source, with the 
condition  is then given as follows:

[Eq. 25]         

Figure 5: Schematic representation of energy distribution in double ellipsoidal heat source model.

CONICAL HEAT SOURCE

The third heat source model in the AM Module is also a volumetric heat source model, 
which was first employed for welding simulations but due to inherent similarities between 
welding and LPBF processes, this model is also commonly used for AM simulations. The 
conical heat source model is defined by a Gaussian heat distribution on the top surface of 
the workpiece and a conical distribution along the depth of the powder bed. A schematic 
representation of the energy distribution for conical heat source model is shown below.
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Figure 6: Schematic representation of energy distribution in conical heat source model.

The power density for the conical heat source is given as follows [2019Zha]:

[Eq. 26]         

with

where  and  are the cone radius at the top and bottom, respectively, while  is the 
height of the cone.

Numerical Boundary Conditions

In order to obtain temperature distribution during the LPBF process in the Additive 
Manufacturing (AM) Module, incorporating fluid flow inside the melt pool, we couple energy 
equations with the Navier-Stokes equations, as explained earlier. In order to accurately 
reflect the physical process, both of these equations are subjected to a certain set of 
boundary conditions, which are given as follows.

BOUNDARY CONDITIONS FOR ENERGY EQUATION

The energy equation is subjected to four different boundary conditions. The first boundary 
condition is defined on the top surface (either the powder bed surface or the solid 
substrate) and represents the energy lost due to convection and radiation to the 
surrounding gas.

[Eq. 27]         

where  is the convective heat transfer coefficient,  is the surface radiation emissivity and

is the Stefan-Boltzmann constant.  is the ambient temperature or the temperature of 
the surrounding gas in the build chamber and can be set in the AM Calculator configuration.

conicalHeatSource.png
conicalHeatSource.png
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The second boundary condition represents the heat lost through the vertical walls of the 
domain and for simplicity we have chosen adiabatic boundary conditions for these surfaces. 
The boundary condition for the vertical walls of the computational domain is thus given as:

[Eq. 28]         

The third boundary condition reflects the temperature of the base plate and is therefore 
applied to the bottom of the computational domain. Here we have assumed that the base 
plate of the build part is kept at a constant temperature and the boundary condition is 
therefore given as:

[Eq. 29]         

 is the base plate temperature and can be set in the AM Calculator configuration.

The fourth and the most important boundary condition is the evaporation boundary 
condition that represents the heat lost due to evaporation of the material. Evaporation is 
implemented using a physics-based approach where the heat loss due to evaporation ( ) is 
given as:

[Eq. 30]         

where  is the evaporation flux and  is the evaporation enthalpy. For a 
multicomponent system, the evaporation flux is given as follows:

[Eq. 31]         

where  is the driving force for evaporation,  is the molar mass of the gas,  is the gas 
pressure inside the chamber,  is the atmospheric pressure, and  is the universal gas 
constant. The driving force for evaporation, the evaporation flux, and the molar mass of the 
gas are all temperature-dependent material properties which are obtained from Thermo-
Calc databases and are included in the material library whereas the gas pressure inside the 
chamber can be set from the AM Calculator configuration.

BOUNDARY CONDITIONS FOR NAVIER-STOKES EQUATIONS

For the velocity, a no-slip boundary condition is used for the bottom surface of the 
computational domain. A no-slip boundary assumes that at a solid boundary, the fluid will 
have zero velocity relative to the boundary. For the pressure, a pinned boundary condition is 
used.

For the melted liquid at the top, the symmetry (front - in a steady-state simulation), and the 
keyhole surfaces, the free-slip boundary is used.
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The most important boundary condition in Navier-Stokes setup is the Marangoni boundary 
condition that reflects the tangential force on the surface of the melt pool due to 
temperature variation of surface tension or the so-called Marangoni effect. In AM, large 
temperature gradients on the surface of the melt pool, leads to the Marangoni effect and is 
the primary cause of convective flow inside the melt pool. The Marangoni shear stress ( ) is 
modeled using the following equation:

[Eq. 32]         

where  is the surface tension and  represents the tangential component of the spatial 
derivative.

Surface tension is also a temperature-dependent material property which is obtained from 
Thermo-Calc databases and is included in the material library.

Thermophysical Properties of Powder Material

When the option “Use separate material properties for powder” is selected, a different 
thermal conductivity, density and molar volume is used for the powder material as 
compared to the solid substrate. The above mentioned properties depend on the porosity (
) of the powder. The density ( ) and molar volume ( ) of the powder are then 
simply given as follows:

For thermal conductivity of powder , an empirical expression is used which was 
suggested by Xue and Barlow [1991Xue]. The thermal conductivity of powder thus also 
depends on the conductivity of the surrounding gas. For simplicity, the surrounding gas is 
assumed to be air. The thermal conductivity of powder is given as follows:

[Eq. 33]         

where .
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Additive Manufacturing Simulation Types

Three simulation types are available on the AM Calculator – Steady-state, Transient, and 
Transient with heat source from Steady-state.

Additive Manufacturing Module Theory

The keyhole model is available when a Gaussian Heat Source is used for either 
the Steady-state or Transient with heat source from Steady-state types of 
simulation (see About the Keyhole Model. It is available with or without fluid 
flow.

Steady-state

For Steady-state simulations, you can also choose to run different Steady-state 
Calculation Types.

In the Steady-state mode it is assumed that the temperature distribution and the fluid flow 
around the heat source is in steady state and does not change with time. This is useful to get 
an estimation of the temperature distribution and size of the melt pool when you assume 
that the heat source is moving at a constant speed in a given path. In the single-track 
experiments, temperature distribution around the heat source and fluid flow inside the melt 
pool reach a steady state very quickly, and you should then perform steady-state 
simulations to predict melt pool geometry and cooling rates around the melt pool. In a 
sense, steady-state simulations give you an overall picture of the process but in order to get 
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more precise details and predict temperature distribution in a multi-layer build, as a function 
of time, you should perform transient simulations. The benefit of the steady-state option is 
that these simulations are quick, and you get a solution typically within 1-5 minutes, 
depending on the process parameters and your computational resources. For the steady-
state simulations, you can include or exclude fluid flow inside the melt pool due to the 
Marangoni effect. For the given processing conditions, if convection is the dominant mode 
of heat transfer, inclusion of fluid flow is crucial to enhance the accuracy of the model by 
correctly capturing the underlying physical behavior of melting and solidification of material. 
Furthermore, you can also perform simulations with a powder layer on the top of the 
substrate having different material properties than the bulk material. The steady-state 
simulations are performed on a symmetric domain where you specify only the height of the 
substrate and the thickness of the powder layer, if present. The length and width of the 
computational domain are determined automatically based on the process parameters. The 
temperature distribution is computed using the energy equation while the fluid flow is 
modeled using the Navier-Stokes equation.

Transient

In the Transient mode, you can perform full-scale transient simulations in a 3D rectangular 
build part and have the possibility to specify a scanning strategy comprising multiple tracks 
and multiple layers. Here you can enter the height, width, and length of the entire build part 
or a representative segment of the build part and configure a scanning strategy either for a 
single track or for multiple tracks (bidirectional or unidirectional). You can also add multiple 
layers of powder and rotate the scanning pattern between layers.

Similar to the Steady-state mode, here you can also choose to include fluid flow inside the 
melt pool to correctly capture the underlying physical phenomena of melting and 
solidification of the material and thereby increasing the accuracy of the model. The inclusion 
of fluid flow requires coupling the Navier-Stokes equations together with the energy 
equation which comes at the cost of increased numerical complexity resulting in longer 
simulation times.

Transient with Heat Source from Steady-state

In order to perform full scale 3D simulations in an efficient manner, with multitracks and 
multilayers, including fluid flow in the melt pool or with powder layer(s) having different 
properties than the solid material, you can use the Transient with heat source from Steady-
state mode. This mode develops a novel approach where the effect of fluid flow due to 
Marangoni convection in the melt pool is incorporated without solving for Navier-Stokes 
equations in the full-scale 3D domain.

The concept involves the assumption that the temperature distribution and fluid flow inside 
the melt pool instantly reach steady state. First you solve for temperature distribution, using 
the energy equation and fluid flow due to Marangoni convection, using the Navier-Stokes 
equations for the given process parameters in the Steady-state mode. Once you have the 
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steady state solution, use this solution inside the melt pool and map it as a “heat source” in 
the transient simulations. Using this approach, you do not have to solve for the complicated 
Navier-Stokes equations at each time step in the transient simulation, yet it still captures the 
effect of fluid flow on the shape of the melt pool. Furthermore, it also reduces the 
computational time by solving for the most non-linear region in the energy equation i.e., 
inside the melt pool, only once, and then reusing the solution as a boundary condition in the 
transient simulations. This approach considerably decreases the numerical complexity of the 
full-scale transient simulations, which consequently reduces the simulation time without 
making a significant compromise on the accuracy of the solution.

Steady-state Calculation Types

When setting up a  Steady-state simulation on the AM Calculator, you can also select 
different Calculation Types. These are briefly described here with links to the relevant 
details. 

Additive Manufacturing Simulation Types

Single Point

The standard Gaussian heat source model. See About Heat Source Calibration for 
background and Calculation Type (Steady-state) for settings information.

Heat Source Calibration

To calibrate a heat source based on the imported or entered experimental data instead of 
performing a single point calculation. All types of heat sources can be used. See About Heat 
Source Calibration for background and Calculation Type (Steady-state) for settings 
information. For information about previewing configuration settings (on the AM 
Calculator) as well as plot results (on the Plot Renderer), see Visualizing Heat Source 
Calibrations.

Batch

To include power and scan speed data, which is read from a file such as a spreadsheet.  You 
can optionally include experimental melt pool width and depth (if there is data), and 
compare this to the calculated results using a Parity plot on the Plot Renderer. 

For settings information on the AM Calculator, see Calculation Type (Steady-state). For 
information about previewing configuration settings (on the AM Calculator) as well as plot 
results (on the Plot Renderer), see Visualizing Batch Calculations in the AM Module.
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Grid

To evaluate two axis variables of power and scanning speeds in the specified range and 
number of steps. For settings information on the AM Calculator, see Calculation Type 
(Steady-state).  For Plot Renderer Configuration settings, see AM Calculator: Plot Renderer 
Settings.

About Heat Source Calibration

There are models available to define the heat source in the AM process: Gaussian, Double 
ellipsoidal, or Conical. All these heat sources rely on different sets of parameters to fully 
define the heat input to the powder and solid substrate. 

The standard Gaussian heat source model (a Single Point Calculation Type) requires defining 
the Absorptivity and the Beam radius on the AM Calculator Configuration window. The 
keyhole model takes into account the effect of evaporation recoil pressure that produces a 
keyhole, if present for the given processing conditions. Multiple reflections are also included 
in the keyhole model to improve the calculation of the keyhole shape. The absorptivity of 
the liquid can be calculated but often requires correction due to uncertainty in the model, 
surface oxides, and so forth. The beam radius of the heat source of the printer is, however, 
most often known but does not always match the definition of the beam size for the 
Gaussian heat source used in the simulation. Leveraging the experimental melt pool data 
and the relation between melt pool size and energy density can help to calibrate the 
absorptivity and beam radius for the Gaussian heat source model.

The keyhole model is available for Gaussian heat sources. See About the 
Keyhole Model for some additional information.

For information about using calculated or constant absorptivity with a Gaussian 
Heat Source Calibration, there is additional theory in About the Absorptivity 
Model. The associated settings for this type of calibration is in the subsection 
Heat Source Calibration. 

Similarly, for volume heat sources, i.e. Double ellipsoidal and Conical, it is necessary to 
enter four and three parameters, respectively, along with the absorptivity. Since volume 
heat sources are a numerical way to correctly capture the shape of the melt pool, it is not 
always possible to know the values of these parameters for the processing conditions.
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However, according to the literature [2021Gra] you can find a relationship between the size 
i.e., width and depth of the melt pool, and the energy density (defined as the ratio of power 
and scanning speed) and based on that, you can also find a relationship between the heat 
source parameters and the energy density.

See Additive Manufacturing Module Theory for a general overview including 
details about the heat sources.

This means that if a set of experimental data for an alloy can be provided in the form of 
power, scanning speed, width of the melt pool, and depth of the melt pool, then you can 
perform a heat source calibration to calibrate the heat source parameters for the given 
material. This is done by running an optimization algorithm for the selected experimental 
data and then choosing an appropriate function for each heat source parameter. As a result, 
the output includes expressions of the given parameters as a function of the energy density, 
which can be saved and is available later in heat source list as a Users heat source. This is for 
any given process parameter (i.e. the saved heat source can be used for any process 
parameter).

When a Users heat source option is available to choose in the heat source list, 
then only the Power of the heat source needs to be entered and the rest of the 
parameters, including the absorptivity, are automatically included in the 
simulation based on the selected expressions when originally saving the heat 
source calibration data.

In order to set up the calibration of the heat source, you select the Steady-state simulation 
type and then select Heat Source Calibration as the Calculation Type. The calibration is 
performed assuming steady-state conditions so most of the configurations are done in the 
same way as the Single Point Steady-state simulation. The difference is that you need to 
choose which heat source to use, i.e. Gaussian, Double ellipsoidal, or Conical.

For more details about including the Heat Source Calibration Calculation Type 
during the simulation set up, go to AM Calculator Conditions Settings. Then go 
to Visualizing Heat Source Calibrations for details about navigating the various 
previews and results.
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Heat Source Calibration with Experiment Data

When the Heat Source Calibration is selected in the Steady-state simulation type, there is 
an option to import a file with experimental data points that can be used in the simulation. 
Data can also be entered directly into the table on the AM Calculator Configuration window. 
However, if an Experiment file is imported it needs to be set up in a certain way so that the 
software can read the data.

AM Calculator Experiment File Requirements

Once the experiment data is entered, you can view the plot of melt pool dimensions vs. 
energy density (P/v) in the Visualizations window, and make a selection of the experiments 
to be used for calibration by checking the corresponding checkbox in the Use column. When 
this is done, click  Perform Tree to perform the calibration.

If you select Depth from the Calibrate for list, then the experimental values for 
only the melt pool depth is needed. 

Examples Related to Heat Source Calibration

There are two examples included with the installation to help you understand how to 
calibrate a heat source and then use the calibration in simulations.

AM_06a: Calibrating a Heat Source for a 316L Steel: This example demonstrates 
the calibration of the heat source using the Gaussian and Double ellipsoidal 
heat sources.

AM_06b: Using the Calibrated Heat Source for a 316L Steel: The purpose of this 
example is to use the saved heat sources from AM_06a and then validate the 
results by comparing the melt pool size from the simulations with the 
experimental melt pool dimensions. It also uses the keyhole model.

Reference

[2021Gra] D. Grange, A. Queva, G. Guillemot, M. Bellet, J.-D. Bartout, C. Colin, Effect of 
processing parameters during the laser beam melting of Inconel 738: Comparison 
between simulated and experimental melt pool shape. J. Mater. Process. Technol. 289, 
116897 (2021).
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About the Keyhole Model

In additive manufacturing a laser beam melts the powder, and at high energy density of the 
laser also evaporation of the liquid metal occurs. The evaporation causes transfer of 
momentum from the metal to the vapour, i.e. a recoil. The conservation of total momentum 
then leads to a recoil pressure that pushes down the liquid/gas interface to form a cavity, 
also known as a keyhole. However, this free surface is computationally expensive to 
calculate due to the very dynamic movements of the keyhole. To reduce the complexity,  the 
Additive Manufacturing (AM) Module has an analytic model [1994Kap] to pre-compute the 
keyhole shape and the corresponding mesh.

Example AM_06b: Using the Calibrated Heat Source for a 316L Steel includes 
the use of the keyhole model. The different processing conditions are selected 
to simulate both the conduction mode as well as the keyhole mode.

Also see examples AM_07, AM_08a, AM_08b, AM_09a, and AM_09b where the 
keyhole model is used with fluid flow.

The analytical keyhole model approximates the heat conduction by a moving line source 
where the keyhole shape is obtained by heat balance at the keyhole wall using average 
material properties. A point-by-point scheme compares absorbed power and conduction 
losses to obtain the local inclination angle of the keyhole walls.
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Figure 7: Side-view of a keyhole and melt pool for the material SS316L with Gaussian beam radius 
of 40 μm and the absorptivity set to 40%.

When a keyhole is formed, the energy is transmitted into the material through numerous 
reflections within the keyhole (see Figure 8). 

For metals with an absorption factor of around 30% the reflections can increase the 
effective absorption to values around 80% or higher of the total laser beam energy. In the 
Additive Manufacturing (AM) Module, multiple reflections are implemented in the analytical 
keyhole mode according to the Jahn publication [2020Jah]. This strategy allows for 
computation of a keyhole shape, including multi reflections, without implementing a 
numerically expensive ray tracing algorithm.
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Figure 8: Ray tracking of the laser beam reflected at the wall of the keyhole.

The keyhole model is limited to the Gaussian heat source without separate material 
properties for powder.  An additional input is the Rayleigh length of the laser beam where 
the default value is 2.5 mm. The Rayleigh length is related to the depth of focus of the heat 
source. The length is defined as the distance along the propagation direction of a beam from 
the waist to the place where the area of the cross section is doubled.

To include the keyhole feature, go to AM Calculator Conditions Settings and in 
the Heat Source section, you can enable this feature. 

See Additive Manufacturing Module Theory for a general overview including 
details about the heat sources.
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About the Absorptivity Model

The absorptivity of a flat metal surface is a function of the alloy composition, temperature, 
the wavelength of the heat source, and the angle of incidence.

The absorptivity of a metallic powder is more complex. Most metallic powders are oxidized 
at the surface where a thin layer of oxide often increases absorptivity. Multiple reflections of 
the laser rays also increases the effective absorptivity, e.g. at surface roughness or between 
the particles within the powder layer. The additional complications of the metallic powder 
are neglected in this model, which focuses on an ideal flat surface of the liquid phase after 
the powder has melted. This simplification can be justified at steady-state conditions when a 
melt pool is established and most laser rays hit the liquid surface in the melt pool.

Additive Manufacturing Module Theory and About the Keyhole Model.

Laser Beam Reflection

A fraction of the energy of a laser ray ( ) is absorbed when it strikes a surface, the rest of 
the energy is reflected ( ), i.e. the absorptivity is given by .

The Fresnel equation describes how the absorptivity depends on the angle of incidence .
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Figure 9: A laser ray strikes a surface at the incident angle .

For an unpolarized laser beam, the reflection coefficient  is the average of the parallel and 
perpendicular component, denoted by  and :

Both components of  are given by the Fresnel equations:

The refraction index  is a complex number  where  corresponds to the extinction 
coefficient.

The refractive index is directly related to the electric permittivity, :

About the Lorentz-Drude (LD) Model

The Lorentz-Drude model (LD) relates the electric permittivity with the electric resistivity 
[2021Yan]. 
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The electric resistivity thermophysical property is included in many Thermo-
Calc databases. For a list of databases that include it, see the Properties that 
Can Be Calculated brochure on the website or refer to the specific database 
documentation. 

The LD model only considers the intraband absorption and is neglecting the interband part. 
The interband part of absorption is, however, often less dominant for wavelengths larger 
than 1  μm; for smaller wavelengths the model shows larger deviations when compared to 
experimental data. 

For additive manufacturing lasers, the most common wavelength used is 1.06 
μm. 

The LD model is used as a first approximation of the dielectric constants of an alloy. The 
model is then further calibrated against the available experimental information of dielectric 
constants, refraction index, and absorptivity of liquid metal, i.e. the correction functions 
and  are modeled:

where 

 l  is the mole-fraction of element 
 l  the laser wavelength, and 
 l  the temperature. 

The correction improves the model accuracy for the entire wavelength spectrum.   

Following the work by Yang [2021Yan], the LD model obtains the real and imaginary parts of 
the electric permittivity:

where

https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf


Thermo-Calc Documentation Set

General Theory and Background ǀ 469 of 763

 l  is the plasma frequency,
 l  is the laser frequency, and 
 l  is the damping frequency. 

The plasma frequency is given by:

where 

 l  is the number density of free electrons, 

 l  the absolute value of elementary charge, ,

 l  is the electron mass, , and 

 l  is the vacuum permittivity,  .

The damping frequency can be expressed as:

where 

 l  is the temperature- and composition-dependent electrical resistivity.

The laser frequency can be expressed as:

where 

 l  is the speed of light in vacuum, and 
 l  is the wavelength of the laser. 

The free electron density  is assumed to be given directly by the atomic mass and mass 
density:

where 
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 l  is the Avagadros constant, 
 l  is the mass density of the alloy, 
 l  is the atomic weight of element , and 
 l  is the number of valence electrons per atom of element . 

Heat Sources

The LD model for liquid absorptivity describes a material property and is only applicable to 
the Gaussian Heat Source where the energy is added to the surface of the material. 

The LD model for absorptivity is not applicable to the volume heat sources 
Double ellipsoidal and Conical. Volume heat sources  assume an effective 
absorptivity that indirectly can include the effect of keyholing by increasing the 
absorptivity as a function of energy density. 

GAUSSIAN HEAT SOURCE

The angle of incidence for a laser ray is zero when no keyhole forms. The angle of incidence 
varies greatly within the keyhole and the full angle dependent absorptivity model is used.
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Figure 10: A schematic keyhole where three individual laser rays hit the surface at different 
incident angle . The keyhole model in the AM Module accounts for multiple reflections, but only 
the first reflection for each ray is shown for clarity.

The absorptivity model takes the wavelength of the heat source as input together with a 
prefactor that can scale the calculated absorptivity up or down. The scaling can be required 
to calibrate the simulations against experiments. 

The following absorptivity settings are described in the AM Calculator 
Conditions Settings topic.

Figure 11: Gaussian Heat Source using the Calculated Absorptivity. The calculated value is scaled 
with the value of “prefactor” where the default is 1.0, i.e. to use the calculated value as-is.  

Figure 12: Gaussian Heat Source with User-defined function of the absorptivity.  
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The resulting absorptivity (given the wavelength and prefactor) can be visualized from the 
Material Properties tab on the AM Calculator Configuration window. 

The following absorptivity options are described in AM Calculator Materials 
Properties Settings.

From the Plot list, select:

 l Absorptivity to visualize the temperature dependent absorptivity for the liquid phase 
of the selected material (Figure 13). 

 l Absorptivity vs angle to visualize the angle dependent absorptivity at liquidus and 
the evaporation temperature (Figure 14).   

 l Electric resistivity to visualize it as a function of temperature (Figure 15).

The electric resistivity is not directly used in the AM simulations, only 
indirectly through the absorptivity model that uses the electric 
resistivity when modeling the composition, temperature, and angle 
dependent absorptivity. 
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Figure 13: The calculated absorptivity as a function of temperature for the alloy IN738LC.

Figure 14: The calculated absorptivity as a function of angle of incidence for the alloy IN738LC. 
The red curve shows the absorptivity at the liquidus temperature and the blue curve the 
corresponding absorptivity at the evaporation temperature. 
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Figure 15: The electric resistivity of the liquid phase for the alloy IN738LC. The electric resistivity is 
used in the model for absorptivity for the liquid phase.

Heat Source Calibration

Additional settings are described in the AM Calculator Conditions Settings topic.

AM_06a: Calibrating a Heat Source for a 316L Steel

For Gaussian Heat Source Calibration calculations, you can use the temperature and angle 
dependent calculated absorptivity and calibrate the scaling prefactor to match the given 
experimental data. The settings are on the AM Calculator Configuration window. 

For Absorptivity select Calculated (prefactor calibrated) then enter the Wavelength of the 
heat source or use the default value.
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In order to use a constant Absorptivity, you can instead select Constant (calibrated), which 
uses a constant value of absorptivity i.e. it is not dependent on temperature or incidence 
angle. Then you can calibrate that value to match the given experimental data.

For both Absorptivity options (Calculated (prefactor calibrated) or Constant (calibrated)) 
you can also either calibrate the Beam radius along with the absorptivity or the prefactor 
(choose Calibrated), or use a fixed value of Beam radius and calibrate only the absorptivity 
(choose User-defined).

Another setting available with the Gaussian Heat Source Calibration, is to calibrate for both 
the Width and depth of the melt pool from the experimental data  or use only the Depth of 
the melt pool for the calibration. If you choose Width and depth, the Experiment Data 
values in the table require both the width and depth of the melt pool whereas if you only 
calibrate the depth then the data file needs to only include the information for the depth of 
the melt pool.

Reference

[2021Yan] Z. Yang, A. Bauereiß, M. Markl, C. Körner, Modeling Laser Beam Absorption of 
Metal Alloys at High Temperatures for Selective Laser Melting. Adv. Eng. Mater. 23, 
2100137 (2021).
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AM Plots and Tables

In this section:

About the AM Plot Types 477

AM Plot Type: 3D Plot 483
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AM Plot Type: Heat Source Calibration Parameters 491

AM Plot Type: Melt Pool Dimensions 492

AM Plot Type: Printability Map 493

AM Plot Type: Parity Plot 497

AM Plot Type: Melt Pool vs Energy Density 501

AM Plot Type: Thermal Gradient vs. Solidification Rate 502

AM Plots: Table View Options 505



About the AM Plot Types

When working with an AM Calculator with the Plot Renderer as a successor, the visualization is different from the other calculators available 
in Thermo-Calc. When setting up the AM Calculator, there are many options available that impact what plot types are going to be available. 
Further, when defining the Plot Renderer, there are additional ways and axis variables or other setting requirements that enable you to 
display certain plot types, as well as preview a variety of settings on the Visualizations window.

In addition, when a Plot Renderer is added as a successor to the AM Calculator, the default layout of the Configuration window, with 
respect to the different tabs, relates to how the AM Calculator is set up. This is then further related to the tabs located on the Visualizations 
window.

See Working with AM Visualizations for information about how these tabs are connected between the windows. Also see 
Overlaying Plots in the AM Module.

See Plot Types for more information for the Scheil Calculator and Diffusion Calculator, which are also used with the Additive 
Manufacturing (AM) Module.

AM Plot Types 

Simulation 
Type

Calculation 
Type* Plot Type

Export 
Result 
Files

Display 
Type Notes

Tab 
Name Configuration 
Window (Setting)

Tab Name 
Visualizations 
Window (Plot)

Link to More 
information

Steady-state, 
Transient, or 
Transient 
with heat 
source from 
Steady-state

Steady-state 
→ Single 
Point, Heat 
Source 
Calibration, 
Batch, and 
Grid

3D Plot Yes Surface 
colormap

From the 
Display list 
select Surface 
colormap. 
Available when 
Temperature, 
Surface tension, 

3D Plot

3D Plot 

When overlaying 
certain plots, 
there is also a 
suffix in brackets 
that matches the 

AM Plot Type: 
3D Plot
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Simulation 
Type

Calculation 
Type* Plot Type

Export 
Result 
Files

Display 
Type Notes

Tab 
Name Configuration 
Window (Setting)

Tab Name 
Visualizations 
Window (Plot)

Link to More 
information

Thermal 
conductivity, or 
Dynamic 
viscosity is 
selected as an 
Axis variable. 

name of the 
AM Calculator it 
is connected to.

e.g. 3D Plot 
(AM Calculator 
1)

Slice

From the 
Display list 
select Surface 
colormap or 
Contour and 
then click to 
select the Slice 
checkbox. 

Contour

From the 
Display list 
select Contour. 
Available when 
Temperature, 
Surface tension, 
Thermal 
conductivity, or 
Dynamic 
viscosity is 
selected as an 
Axis variable. 

Iso-surface

From the 
Display list 
select Iso-
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Simulation 
Type

Calculation 
Type* Plot Type

Export 
Result 
Files

Display 
Type Notes

Tab 
Name Configuration 
Window (Setting)

Tab Name 
Visualizations 
Window (Plot)

Link to More 
information

surface. 
Available when 
Temperature, 
Surface tension, 
Thermal 
conductivity, or 
Dynamic 
viscosity is 
selected as an 
Axis variable. 

Arrow, 2D 
glyph, Cone, 
or Line

Available when 
Flow velocity 
field is selected 
as an Axis 
variable. 
Requires that 
the Fluid flow 
including 
Marangoni 
effect checkbox 
is selected on 
the 
AM Calculator.

Steady-state, 
Transient, or 
Transient 
with heat 
source from 
Steady-state

Steady-state 
→ Single 
Point, Heat 
Source 
Calibration, 
Batch, and 
Grid

Plot Over Line 
(2D) No not 

applicable

Once the plot is 
performed, 
switch between 
a plot and a 
table by clicking 
the Table View 
button on the 
Visualizations 

Plot Over Line Plot Over Line

AM Plot Type: 
Plot Over Line 
(2D)

AM Plots: 
Table View 
Options
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Simulation 
Type

Calculation 
Type* Plot Type

Export 
Result 
Files

Display 
Type Notes

Tab 
Name Configuration 
Window (Setting)

Tab Name 
Visualizations 
Window (Plot)

Link to More 
information

window.

Steady-state Heat Source 
Calibration

Heat Source 
Calibration 
(2D)

Yes not 
applicable

This plot is 
available once 
the calibration is 
completed.

Heat Source 
Calibration

Heat Source 
Calibration 
Parameters

AM Plot Type: 
Heat Source 
Calibration 
Parameters

Steady-state Heat Source 
Calibration

Melt Pool 
Dimensions 
(2D)

Yes not 
applicable

This plot is 
available once 
the calibration is 
completed.

Heat Source 
Calibration

Melt Pool 
Dimensions

AM Plot Type: 
Melt Pool 
Dimensions

Steady-state Batch and 
Grid

Printability 
Map (2D) Yes not 

applicable

Also toggle 
between Show 
Table and Hide 
Table on the 
Configuration 
window.

Batch or Grid Printability Map

AM Plot Type: 
Printability 
Map

AM Plots: 
Table View 
Options

Steady-state Batch and 
Grid

Meltpool vs 
Energy Density 
(2D)

Yes not 
applicable

Also toggle 
between Show 
Table and Hide 
Table on the 
Configuration 
window.

Batch or Grid Meltpool vs 
Energy Density

AM Plot Type: 
Melt Pool vs 
Energy Density

AM Plots: 
Table View 
Options

Steady-state Batch Parity Plot 
(2D) Yes not 

applicable

Also toggle 
between Show 
Table and Hide 
Table on the 

Batch Parity Plot

AM Plot Type: 
Parity Plot

AM Plots: 
Table View 
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Simulation 
Type

Calculation 
Type* Plot Type

Export 
Result 
Files

Display 
Type Notes

Tab 
Name Configuration 
Window (Setting)

Tab Name 
Visualizations 
Window (Plot)

Link to More 
information

Configuration 
window. Options

Steady-state, 
Transient, or 
Transient 
with heat 
source from 
Steady-state

Single Point, 
Heat Source 
Calibration, 
Batch, or Grid

Thermal 
Gradient vs 
Solidification 
Rate (2D)

No not 
applicable

Once the plot is 
performed, 
switch between 
a plot and a 
table by clicking 
the Table View 
button on the 
Visualizations 
window.

It is also 
possible to 
visualize this via 
the 3D Plot tab 
when you 
define the Axis 
variables 
Solidification 
rate and 
Thermal 
gradient.

Thermal Gradient vs 
Solidification Rate

Thermal 
Gradient vs 
Solidification 
Rate

AM Plot Type: 
Thermal 
Gradient vs. 
Solidification 
Rate

Transient or 
Transient 
with heat 
source from 
Steady-state

not applicable Probe (2D) No not 
applicable

Probe positions 
and time steps 
available. 
Defined and 
available from a 
specific a tab on 
the Plot 
Configuration 
window. 

Probe Probe

AM Plot Type: 
Probe (2D)

AM Plots: 
Table View 
Options
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Simulation 
Type

Calculation 
Type* Plot Type

Export 
Result 
Files

Display 
Type Notes

Tab 
Name Configuration 
Window (Setting)

Tab Name 
Visualizations 
Window (Plot)

Link to More 
information

Once the plot is 
performed, 
switch between 
a plot and a 
table by clicking 
the Table View 
button on the 
Visualizations 
window.

* For Transient and Transient with heat source from Steady-state simulations there are no additional Calculation Types selected.  
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AM Plot Type: 3D Plot

The 3D Plot is available with all simulation types (Steady-state, Transient, and Transient with 
heat source from Steady-state). It is also available with Steady-state calculation types Heat 
Source Calibration, Batch, and Grid.

The 3D Plot type has its own tab on both the Plot Renderer Configuration window and the 
Visualizations window. This plot type is further visualized using additional Display options. 

Further, when connecting two AM Calculators to plot combinations of axis variables, 
separate tabs are added to the Visualizations window that have a suffix of the name of the 
AM Calculator added in brackets, e.g. 3D Plot (AM Calculator 1). It is recommended that the 
AM Calculator is renamed to help you identify which tab belongs to which calculation.

See Overlaying Plots in the AM Module for more details and AM Plot Type: 
Thermal Gradient vs. Solidification Rate for an example.

3D Plot Display Options

The Display options available are also based on the Axis variable selected. The Slice plot, 
which is a unique type of plot, is also available when either Surface colormap or Contour is 
selected.

Surface colormap, Contour, and Iso-surface are available when Temperature, Surface 
tension, Thermal conductivity, or Dynamic viscosity is selected as an Axis variable. 

Arrow, 2D Glyph, Cone, or Line are available when Flow velocity field is selected as an Axis 
variable. It also requires that the Fluid flow including Marangoni effect checkbox is also 
selected on the AM Calculator.
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Examples

Surface Colormap

This is an example from AM_01: Transient Simulation of a Single Track.

Figure 1: Surface plot of temperature distribution after the single track scan is completed. Probes 
P1 and P2 can also be seen on the top surface.

Slice Plot

This is an example from AM_01: Transient Simulation of a Single Track.
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Figure 2: Slices of the computational domain, orthogonal to the scanning direction, showing 
temperature distribution at different cross-sections. Red tubes show the contour of the melt pool 
(at liquidus temperature).

Contour

This is an example using AM_03: Steady-state Simulations to zoom into the AM Calculator, 
which in that example is renamed to Gaussian HS, with Fluid. On the Plot Renderer, the 
Display setting is changed from the default to Contour.
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Isosurface

This is an example using AM_03: Steady-state Simulations to zoom into the AM Calculator, 
which in that example is renamed to Gaussian HS, with Fluid. On the Plot Renderer, the 
Display setting is changed from the default to Iso-surface.

Arrow

This is an example using AM_04: Scheil Transient Steady-state  to zoom into one of the 
AM Calculators, which in this case is renamed to Steady-state. On the Plot Renderer, and 
when the Axis variable is set to Flow velocity field, the Display default setting is Arrow.
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2D Glyph

This is an example using AM_04: Scheil Transient Steady-state to zoom into one of the 
AM Calculators, which in this case is renamed to Steady-state. On the Plot Renderer, and 
when the Axis variable is set to Flow velocity field, the Display setting is changed from the 
default to 2D Glyph.
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Cone

This is an example using AM_04: Scheil Transient Steady-state to zoom into one of the 
AM Calculators, which in this case is renamed to Steady-state. On the Plot Renderer, and 
when the Axis variable is set to Flow velocity field, the Display setting is changed from the 
default to Cone.

Line

This is an example using AM_04: Scheil Transient Steady-state to zoom into one of the 
AM Calculators, which in this case is renamed to Steady-state. On the Plot Renderer, and 
when the Axis variable is set to Flow velocity field, the Display setting is changed from the 
default to Line.
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AM Plot Type: Plot Over Line (2D)

The Plot Over Line plot type is available with all simulation types (Steady-state, Transient, 
and Transient with heat source from Steady-state). For Steady-state simulations, it is also 
available with Heat Source Calibration, Batch, and Grid calculation types.

The Plot Over Line type is a 2D plot. On the Visualizations window it is available on the Plot 
Over Line tab and on the Configuration window on the tab of the same name.

Once the plot is performed, you can also switch between a plot and a Table View using the 
button available on the Visualizations window.

The coordinates for the Plot Over Line  Transient with heat source from 
Steady-state and its Steady-state model are synchronized. This means that if 
you switch between these computational models, the Plot Over Line 
coordinates  show the same result.

Example

This is an example from AM_01: Transient Simulation of a Single Track.
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Figure 3: 2D plot over line showing temperature in the tail of the melt pool as a function of 
distance plotted along the scanning track.

AM Plot Type: Probe (2D)

The Probe plot type is available with the Transient and Transient with heat source from 
Steady-state simulation types.

The Probe plot type is a 2D plot. On the Visualizations window it is available on the Probe 
tab and on the Configuration window on the tab of the same name.

To define a Probe plot requires that Probe Positions are selected on the AM Calculator. Then 
when a Plot Renderer is added as a successor, a Probe tab is available on the Configuration 
window where you can further define the plot.

Once the plot is performed, you can also switch between a plot and a Table View using the 
button available on the Visualizations window.
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Probe data can also be used with the Diffusion Calculator and Precipitation 
Calculator when these Calculators are added as successors to the 
AM Calculator.

Example

The example below is taken from AM_01: Transient Simulation of a Single Track.

Figure 4: 2D probe plot showing temperature evolution as a function of time at probes P1 and P2.

For use of probe data with the Diffusion Module (DICTRA) see AM_05: Using AM 
Calculator Probe Data with the Diffusion Module (DICTRA).

For use of probe data with the Precipitation Module (TC-PRISMA) see AM_12: 
Using AM Calculator Probe Data with the Precipitation Module (TC-PRISMA).

AM Plot Type: Heat Source Calibration Parameters

The Heat Source Calibration Parameters plot type is available with a Steady-state 
simulation and when Heat Source Calibration is selected as the Calculation Type.

During the set up, the Heat Source Calibration Parameters type also has its own tab called 
Heat Source Calibration on the Plot Renderer Configuration window. For more information 
see Visualizing Heat Source Calibrations.

About Heat Source Calibration
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Example

The following is from AM_06a: Calibrating a Heat Source for a 316L Steel. 

Also see the companion example, AM_06b: Using the Calibrated Heat Source for 
a 316L Steel.

A Heat Source Calibration Parameters plot shows the calibrated heat source parameters as 
a function of energy density (P/v) (unit J/mm). From the Plot Renderer Configuration 
window, you can also continue to select which experiments to be used to fit the calibration.

Figure 5: From example AM_06a, the Heat Source Calibration Parameters plot for the double 
ellipsoidal calibration.

For instance, you can deselect the points that seem to be outliers or where the error bar in 
experimental data is large. 

AM Plot Type: Melt Pool Dimensions

The Melt Pool Dimensions plot type is available with a Steady-state simulation and when 
Heat Source Calibration is selected as the Calculation Type. For more information see 
Visualizing Heat Source Calibrations.

About Heat Source Calibration 

Example

The following is from AM_06a: Calibrating a Heat Source for a 316L Steel. 
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Also see the companion example, AM_06b: Using the Calibrated Heat Source for 
a 316L Steel.

A Melt Pool Dimensions plot shows melt pool size, both from experiments and simulations, 
as a function of energy density (P/v). This plot can be used to compare the results from the 
experiments and optimization simulations.

Figure 6: From example AM_06a, the Melt Pool Dimensions plot for the double ellipsoidal 
calibration.

AM Plot Type: Printability Map

This topic describes  the plot type Printability Map, which is available with Batch or Grid 
calculations for a Steady-state simulation. A printability map is also known as a process map.

This plot is available with Batch and Grid calculations. However, using it with 
the Grid calculation is the preferred method as it provides full coverage of the 
plot area. Otherwise, if you are doing a Batch calculation and only base it on 
experimental conditions, it often leaves out the most extreme cases so you get 
areas in the Printability Map that are blank. 

Printability maps allow you to plot the likelihood of three possible defects that occur during 
additive manufacturing: Keyholing, lack of fusion, and balling.
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There is a video tutorial about the Printability Map on our website and on our 
YouTube channel. It is also included in the Additive Manufacturing Module 
YouTube playlist.

These examples highlight the use of the printability map: AM_08a: Grid 
Calculation for a Ti64 Alloy and AM_09a: Grid Calculation for an SS316L Alloy. 

These defects occur based on the speed and power used during the AM process. Printability 
maps allow you to reduce the risks of these defects by showing the speed and power 
settings that are optimal, which in turn allows you to calibrate your system to avoid these 
issues.

 l Keyholing occurs with low scanning speed and high power.
 l Lack of fusion occurs with high scanning speed and low power.
 l Balling occurs if you increase the scanning speed.

Figure 7: Printability map for 316L showing regions of keyholing and lack-of-fusion. Experimental 
information from Hu et. al. [2019Hu] overlaid as coloured labels showing  keyhole porosity (K), 
conduction mode with lack-of-fusion porosity (C). Green labels showing experiments without 
defects for conduction mode (C) and keyhole mode (K).

The defect regions in the printability maps are defined by functions of the keyhole 
dimension (Wk, Dk), melt pool dimensions (W, D, L), hatch distance (h), and powder 
thickness (t) [2019Joh].

https://thermocalc.com/support/video-tutorials/additive-manufacturing-module-examples/
https://youtu.be/Jact1ZmiyIE?si=bSJPm7EAUxDe-nsL
https://www.youtube.com/playlist?list=PLfv6McToaTGS-LW4xV4YFPLcAmIuDvKu0
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Figure 8: When defining the Printability map on the Plot Renderer for an AM Calculator, you can 
select from a variety of Functions.

Figure 9: Two single tracks with the melt pool width (W) and depth (D). The hatch distance (h), 
powder thickness (t), and the melt pool depth at half of the hatch distance (Dh).
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Keyholing Porosity

Keyholing is a critical feature in additive manufacturing that occurs at high energy densities 
(P/v). Keyholing is not only negative, the increased depth of the melt pool can increase 
productivity. However, deep and narrow keyholes are unstable and can collapse, and lead to 
keyholing porosity. Keyhole porosity appears close to spherical in shape.

Keyholing porosity can be defined to occur if the width/depth ratio of the keyhole is less 
than or equal to 1 (i.e. Wk/Dk ≤ 1). Similarly if a volume heat source is used (that lacks 
information of the keyhole geometry) the ratio of the melt pool (W/D) can be used instead, 
where W/D ≤ 1.

Lack of Fusion

Lack of fusion porosity occurs if the melt pool, due to low energy density (P/v), fails to 
penetrate the powder thickness. Lack of fusion gives porosity uneven in shape, compared to 
keyhole porosity that is close to spherical in shape.

Lack of fusion for a single track can be defined to occur if the melt pool depth is smaller than 
the powder thickness, i.e. D/t < 1.0. Additionally the lack of fusion between two tracks, at 
half of the hatch distance, can be defined to occur if  Dh/t < 1.0.

Balling

The scan tracks can break up and produce agglomerated particles in spherical shape instead 
of a single bead. Balling has been defined to occur if ratios W/L [2019Joh] or D/L [2023Kat] 
are small .

Additional user-defined defect criteria can be defined with the Custom function using any 
combination of the keyhole dimension (Wk, Dk), melt pool dimensions (W, D, L), hatch 
distance (h) and powder thickness (t).
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AM Plot Type: Parity Plot

This topic describes  the plot type Parity Plot which is available with Batch calculations for a 
Steady-state simulation. This plot type is only to select on the Plot Renderer when the 
simulation uses the Batch Calculation Type with an AM Calculator.

These examples highlight the use of this plot: AM_07: Batch Calculations for an 
IN718 Alloy, AM_08b: Batch Calculations for a Ti64 Alloy and AM_09b: Batch 
Calculations for an SS316L Alloy.

Parity plots are used when validating the Steady-state Batch calculation against 
experimentally measured melt pool width and depth. The plot shows the experimental 
width/depth on the X-axis and the calculated width/depth on the Y-axis. The data should 
follow the diagonal line for a perfect match between the calculated and experimental 
values. 

The following are from example AM_07.
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Figure 10: Parity plot comparing experimental versus calculated melt pool width and depth for all 
the experiments. The experiments are single tracks on bare plate IN718 with varied power and 
scan speed.  The Root Mean Square (RMS) error can also be shown as a dashed line.  

Figure 11: Alternatively, lines for user-defined Absolute or Relative in % error can be shown 
instead by selecting these options on the Configuration window.
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Figure 12: Parity plot comparing experimental versus calculated melt pool width and depth for all 
the experiments. The experiments are single tracks on bare plate IN718 with varied power and 
scan speed. In this plot, it is configured to show a Relative in % error of 5 instead of the RMS error. 

Keyhole Model with Fluid Flow 

This is an example application of using the parity plot when the keyhole model includes fluid 
flow, which can provide a better prediction of the melt pool size.

About the Keyhole Model

Keyholing can occur with low scanning speed and high power. Including fluid flow in the 
simulation makes the predictions of the entire melt pool size more accurate, which is 
especially important at higher energy densities when Marangoni forces are strong.
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Figure 13: Fluid flow can make the melt pool wider and longer. This example shows the effect 
when enabling fluid flow for 316L for power 50 W and scan speed 400 mm/s. Left images show 
without fluid flow and right images with fluid flow enabled. Top row shows the temperature color 
map. Bottom row shows the isosurfaces for liquidus and solidus, i.e. the size of the melt pool and 
mushy zone.
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Figure 14: Parity plot for 316L showing how the RMS is reduced for the melt pool width when 
excluding fluid flow (left) compared to when it is included (right). Experiments from Hu et. al 
[2019Hu].

Reference

[2019Hu] Z. Hu, B. Nagarajan, X. Song, R. Huang, W. Zhai, J. Wei, Formation of SS316L Single 
Tracks in Micro Selective Laser Melting: Surface, Geometry, and Defects. Adv. Mater. Sci. 
Eng. 2019, 1–9 (2019).

AM Plot Type: Melt Pool vs Energy Density

This topic describes  the plot type Melt Pool vs Energy Density which is available with Batch 
or Grid calculations for a Steady-state simulation.

These examples highlight the use of this plot: AM_08b: Batch Calculations for a 
Ti64 Alloy and AM_09b: Batch Calculations for an SS316L Alloy.

This plot type is used when validating the Steady state Batch calculation against 
experimentally measured melt pool width and depth. The plot shows the experimental and 
simulated melt pool dimensions as a function of the energy density (P/v). The plot type can 
also be used when experimental melt pool dimension are lacking, e.g. after the Grid 
calculation, but then naturally only shows the simulated melt pool dimensions as a function 
of the energy density (P/v).

This uses example AM_09b.
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Figure 15: Plot comparing experimental versus calculated melt pool dimensions for all the Batch 
calculations. The experiments are single tracks with SS316L with varied power and scan speed. 
The melt pool width and depth are shown on the Y-axis and the energy density (P/v) on the X-axis.

Figure 16: For the plot, you can choose what to include on the plot, to show width and/or depth 
by selecting the relevant checkboxes on the Configuration window. 

AM Plot Type: Thermal Gradient vs. Solidification Rate

This topic describes 2D and 3D versions of plots comparing thermal gradient to solidification 
rate along the liquid isotherm.  Both the 2D and 3D versions are available for steady-state 
and transient simulations. 
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 l The 2D version is accessed on the Plot Renderer Configuration window as a tab 
named Thermal Gradient vs Solidification Rate. It is visualized on a tab of the same 
name on the Visualizations window.

 l The 3D version is  available on the 3D Plot tab on the Configuration (settings) 
window. It is further visualized on two 3D Plot tabs on the Visualizations window.

AM_10: CET Transition in an IN718 Alloy includes an example of this plot in both 
2D and 3D.

2D Plot

The 2D version of this plot is available on the Thermal Gradient vs Solidification Rate tabs 
on both the Configuration (settings) and Visualizations window. 

You do not need to configure anything on the AM Calculator to access the 2D 
plot. 

On the Thermal Gradient vs Solidification Rate tab on Plot Renderer Configuration window 
you can adjust the settings for the Solidification rate (X-axis) and Thermal gradient (Y-axis). 

As you adjust settings, watch it dynamically change on the Visualizations window. The plot is 
on the tab of the same name (Thermal Gradient vs Solidification Rate). You can switch 
between the plot and a table format using the Table View   button.

AM Plots: Table View Options

This uses example AM_10.
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Figure 17: The solidification rate vs thermal gradient is shown on the AM Thermal Gradient 
& Solidification Rate Plot Renderer. 

3D Plot 

The 3D version of this plot is available on the 3D Plot tab on the Configuration (settings) 
window. You choose Solidification rate  and Thermal gradient as the Axis variable. Use the 

 and  buttons as usual to add and remove quantities.

On the Visualizations window the comparisons for the different calculation types and 
variable combinations are plotted on two 3D Plot tabs. 
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AM Plots: Table View Options

There are ways to view AM plot results as a table on either the Configuration or 
Visualization windows for various plots and calculation types. 

2D Plots

For 2D plots (Plot Over Line, Probe, and Thermal Gradient vs Solidification Rate), and once 
the plot is performed, you can switch between a plot and a table by clicking the Table View 
button on the Visualizations window. 

These plots are available with all calculation types (Steady-state, Transient, and Transient 
with heat source from Steady-state) simulations.

Batch and Grid Plots

For Steady-state Batch and Grid calculations, the available plots Printability map, Meltpool 
vs energy density, and Parity plot, can also be viewed as a table. 

Once the plot is performed, you can toggle to between Show Table and Hide Table on the 
Configuration window.
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Additive Manufacturing Workflow

In this section:

Setting Up the Additive Manufacturing Simulation 507

Additive Manufacturing Templates 511
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Setting Up the Additive Manufacturing Simulation

Setting up an Additive Manufacturing (AM) Module simulation can be done in one of two 
workflows.

General Overview

The general procedure of a simulation using the Additive Manufacturing Module is the 
following:

 1. Define the system (Workflow 1 only):
 a. Choose a database.

 b. Select elements and composition.

 2. Retrieve the materials data (Workflow 1 or 2):
 a. Either with a Scheil calculation (Workflow 1) or using the materials property 

data library (Workflow 2).

 b. Apply data smoothing.

 3. Set up the AM Calculator (Workflow 1 or 2):
 a. Choose a simulation mode Steady-state, Transient, or Transient with heat 

source from Steady-state.

 b. For Steady-state  you can also choose different  Calculation Type options such 
as a Heat Source Calibration to calibrate a heat source based on the provided 
experimental data instead of using just a Single point calculation. Batch and 
Grid types are also available.

 c. For Steady-state Gaussian heat source simulations, choose to include a 
keyhole model with or without fluid flow.

 d. Set the simulation conditions.

 4. Run the simulation and visualize the results (Workflow 1 or 2) based on the settings, 
for example:

 a. 3D Plot

 b. Plot Over Line or Thermal Gradient vs Solidification Rate (2D). Once the plot is 
performed you can also switch to view it in a table. 

 c. Probe 2D plot at a probe position (only available for transient calculations). 
You can also use and plot probe data with the Add-on Diffusion Module 
(DICTRA) and/or Precipitation Module (TC-PRISMA).  Once the plot is 
performed you can also switch to view it in a table. 

 d. Heat Source Calibration Parameters and Melt Pool Dimensions: These plots 
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are available for Heat Source Calibration calculations.

 e. Printability Map, Parity Plot, and Melt Pool vs Energy Density: These plots are 
available for Batch and Grid calculations. This can also be viewed as a table.

Workflow 1: When You Need to Obtain the Material Properties Data for the 
Calculation

Use a System Definer and Scheil Calculator to extract some Scheil data, then feed the data 
into the AM Calculator. Then add the Plot Renderer to define the specific AM Calculator Plot 
Renderer features and visualize the results. In this workflow, you can also save the results 
from the Scheil Calculator into the Material Library and reuse this data in the future.

When you also have licenses either for the Diffusion Module (DICTRA) and/or 
the Precipitation Module (TC-PRISMA), for transient simulations you can 
additionally  include probe data from the AM Calculator in the set up of the 
thermal profile for diffusion and precipitation calculations, respectively. 

Workflow 2: When You Already Have the Material Properties Data Available - 
Material Library

When you know you have the available material library data available, either by using the 
provided libraries, importing your own external data, or by saving your own material library 
after running a Scheil calculation, then you can directly start defining the AM Calculator and 
add and define one or more plots to visualize the results.

The Scheil Calculator and System Definer function the same as with a regular 
Thermo-Calc simulation. There are features available on the Scheil Calculator 
that are particularly useful to these types of calculations. The Plot Renderer is 
also unique to this calculator but is still based on the standard activity node.

The various activity nodes for each workflow are briefly described below.

System Definer (Workflow 1)

The first step of the set-up is to select which database to use and define the material for the 
simulation. This is done in the System Definer.
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In a System Definer activity, you select the database to use to retrieve thermodynamic data 
and define which elements the system has as components. You can also select the species to 
include as well as change the reference temperature and pressure for your components. 

A System Definer node can be added either directly to the  My Project node or by default 
when the Additive Manufacturing template is added.

See System Definer and then to learn more about the many settings go to 
Configuration Window Settings.

Scheil Calculator (Workflow 1)

Once you have defined your system, you need to retrieve the materials data necessary for 
the AM calculations. This is done using the Scheil Calculator when you are working in 
Workflow 1.

A Scheil Calculator node can be added either directly to the System Definer node or by 
default when the Additive Manufacturing template is added.

ABOUT THE SCHEIL CALCULATOR SETTINGS

The Scheil Calculator in the Additive Manufacturing Module template is configured to 
generate the data necessary for the AM calculation. It is configured to start the simulation at 
a temperature of 5000 degrees and capture the evaporation and calculate the material 
properties down to room temperature. If you add a Scheil Calculator manually from the 
System Definer, you need to change these settings yourself. If you are working with different 
materials, different settings might be more suitable to your material.

Materials Properties Library (Workflow 1 or 2)

A Scheil calculation using the Scheil Calculator (Workflow 1) can be saved for reuse in the 
Materials Libraries. Alternatively, if there is external data available to use, you can skip the 
Scheil Calculator and just use a library (Workflow 2). There are also some predefined 
materials libraries included with the installation that can be used, and are used, in the 
examples (e.g. AM_01, AM_02, and AM_03 and others) so that users without an AM license 
and necessary databases can see how this works.

Available Options
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AM Calculator (Workflow 1 or 2)

Add an AM Calculator node to the Scheil Calculator. If you used the Additive Manufacturing 
template (on the My Projects Configuration window under Applications), click the node to 
display the Configuration settings window.

Transient simulations currently support only cuboid geometries. Both Steady-
state and Transient models use adaptive mesh refinement to decrease 
computational cost. You have the option to either choose from the predefined 
mesh settings that defines the maximum and minimum element size based on 
the process parameters, or specify the maximum and minimum element size 
yourself.

You can use this either with or without the Scheil and System Definer if you already have the 
materials properties calculation you want.

AM Calculator and AM Calculator Conditions Settings

CHOOSE MATERIALS DATA SOURCE

Once the Scheil simulation is complete, click on the AM Calculator 1 node and then the 
Materials Properties tab to see the material property data obtained from the Scheil 
calculation. In the Material Properties tab, you can plot the properties required for the AM 
simulation. This is also where you select the data source that will be used in the simulation. 
In the Use data from: drop-down list you can choose either Scheil Calculator or Library. The 
Scheil Calculator option uses the Scheil results that you just calculated, while the Library 
option uses the data that was shipped with the software or previously calculated data that 
you have saved to the Library.

Visualizations Window

Working with AM Visualizations 
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Apply Data Smoothing

Before you run the AM Calculator, it is important that the data you will base the AM 
calculation on does not have any sharp peaks or curves to be able to solve the numerical 
problem. To avoid this, you can apply smoothing to your data. The default setting is Little 
smoothing but this can be changed depending on your simulation.

To determine how much smoothing to apply, you can plot the different properties. In the 
plot drop-down list you can select which property you want to plot to check the data and if 
there are any sharp peaks or curves in the plot. The plot appears immediately when you 
select a property. It is recommended to try running the simulations with only applying Little 
smoothing. If the calculation fails, you can increase the smoothing and try again. It is also 
possible to apply different levels of smoothing on different properties.

Additive Manufacturing Templates

There are two templates you can use to access the Additive Manufacturing Module settings 
and features in Thermo-Calc.

You can also add nodes individually to build your own tree.

When you also have licenses either for the Diffusion Module (DICTRA) and/or 
the Precipitation Module (TC-PRISMA), for transient simulations you can 
additionally  include probe data from the AM Calculator in the set up of the 
thermal profile for diffusion and precipitation calculations, respectively. 

Additive Manufacturing Template

On the main Project Configuration window, under Applications, click the Additive 
Manufacturing icon. This adds the following activity nodes as a tree in the Project window – 
System Definer, Scheil Calculator, AM Calculator, and Plot Renderer. When you add this 
Additive Manufacturing template (and need to generate some materials properties or do 
not have a material library to use), then some unique default settings for the Scheil 
Calculator and these particular types of simulations are already set by default. Then you 
continue defining the AM Calculator by choosing one of the available simulation types: 
Steady-state, Transient, or Transient with heat source from Steady-state.
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There is also an option on the AM Calculator to save the material properties in a material 
library, and use these later for a new AM Calculator where you want to make calculations 
related to the same alloy.

With Material Library Template

Click With Material Library to create an activity tree that only includes the AM Calculator 
and Plot Renderer nodes. The tree setup does not need the System Definer or Scheil 
Calculator. Instead you can select (or import) pre-saved Materials Properties data from a 
library and use these for your AM calculations. For example, if you have already run 
calculations for the Scheil Calculator for your alloy, and you want to perform a different AM 
calculation for the same alloy, this data can now be reused where you start the AM 
Calculator using the second option and use the material property data from the material 
library.
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Working with the Activity Nodes for an AM Simulation

In this section:

AM Calculator 514

AM Calculator Conditions Settings 516

AM Calculator Experiment File Requirements 529

AM Calculator Materials Properties Settings 533

AM Calculator Options Settings 537

AM Calculator: Working with Probe Data 538

AM Calculator: Plot Renderer Settings 540

Working with AM Visualizations 555

AM Visualizations Window Plot Toolbar 561

Menu or Keyboard Options: Geometry and 3D Plots 563

Rotate, Zoom, and Pan 3D Plots: AM Calculations 566

Overlaying Plots in the AM Module 567

Visualizing Heat Source Calibrations 567

Visualizing Batch Calculations in the AM Module 577
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AM Calculator

Depending how you set up your simulation, the AM Calculator can either be part of the 
workflow after a Scheil Calculator or directly at the root below the  My Project node.

There is an Additive Manufacturing template available under Applications that 
you can use to quickly set up either one of these workflow options for the 
AM simulation. See Additive Manufacturing Templates and Setting Up the 
Additive Manufacturing Simulation.

Configuration Window

Once you have added an AM Calculator, the Configuration window has these tabs where 
there are many available features to set on the Conditions, Materials Properties, and 
Options sections and with the specialized Plot Renderer and toolbar on the Visualizations 
window.

There are these simulation type pathways to choose: Steady-state, Transient, or Transient 
with heat source from Steady-state.

In cases where convection is the dominant mode of heat transfer, fluid flow 
inside the melt pool plays a significant role in determining the correct shape of 
the melt pool.

For more details about these see Additive Manufacturing Simulation Types. 
Also review the Additive Manufacturing Module Theory as needed.

 l Steady-state: Compute temperature distribution in a steady-state environment, 
either on a bare metal substrate or with a powder layer on the top, with the 
possibility to add fluid flow inside the melt pool. For this simulation type, you can 
also choose the following Calculation Types: 
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 l Single Point, which is the standard Gaussian heat source model.  
 l Heat Source Calibration to calibrate a heat source based on the imported or 

entered experimental data instead of performing a single point calculation. 
All types of heat sources can be used.

 l Batch  to include power and scan speed data, which is read from a file such as 
a spreadsheet.  You can optionally include experimental melt pool width and 
depth (if there is data), and compare this to the calculated results.

 l Grid to evaluate two axis variables of power and scanning speeds in the 
specified range and number of steps.

 l Transient: Compute temperature distribution in a transient case with the given 
scanning strategy including multiple paths and layers and the possibility to add fluid 
flow inside the melt pool.

 l Transient with heat source from Steady-state: Compute temperature distribution in 
a transient case with the given scanning strategy including multiple paths and layers.

 l A volume heat source is used in the transient simulations. This is based on the 
solution of a steady-state calculation.

 l For a Gaussian heat source (Steady-state or Transient with heat source from Steady-
state) you can also include a Keyhole model. This is available with or without fluid 
flow, or if you use separate material properties for powder.

There are several settings and these are described separately for each tab.

 l AM Calculator Conditions Settings
 l AM Calculator Materials Properties Settings
 l AM Calculator Options Settings

Plot Renderer as a Successor

Also as a successor to the AM Calculator, you can right-click the node to add one or more 
Plot Renderer nodes to visualize your results. Although the node works the same as with the 
other calculators in Thermo-Calc, there are additional features and settings unique to this 
Module. Useful information is included throughout the documentation. See About the 
AM Plot Types and AM Calculator: Plot Renderer Settings as starting points.
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When setting up an AM simulation, the Visualizations window shows both 
active configuration changes and other design states as set up on the AM 
Calculator as well as the results generated by the Plot Renderer calculations. 
There are several related topics to visualize results as well as when you are 
setting up the simulations. See Working with AM Visualizations as a starting 
point to learn more.

AM Calculator Conditions Settings

Once you have added an AM Calculator, the Configuration window has these settings tabs 
where there are many available conditions to set on the Conditions, Materials Properties, 
and Options tabs and with the specialized Plot Renderer.

This topic describes the available main settings on the Conditions tab.

AM Calculator Materials Properties Settings and AM Calculator Options Settings

Additive Manufacturing Module Theory

Global Settings

Gas Pressure

Pressure is used to calculate the heat loss due to evaporation from the top surface of the 
given material.

Gas pressure: The pressure of the gas inside the build chamber. The default is 100000 
Pascal. Select Atmospheres or Bar.

When you select a different unit the default value does not change.

Enter a different value in the field.

Temperature Unit

Temperature unit: Select a unit Kelvin, Celsius, or Fahrenheit.
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Base Plate Temperature

If you change the Temperature unit then double check that the value in this 
field is also updated or correct as expected if you are keeping the default. This 
field does not update automatically when the unit changes.

Base plate temperature: The base plate of the build part is assumed to have a constant 
temperature. This temperature is used as a boundary condition for the base of the 
computational domain.

The default is 303.15 K.

Ambient Temperature

The Ambient temperature is used to calculate the heat loss from the top surface due to 
radiation, convection, and evaporation.

This setting is the temperature of the air in the immediate surrounding environment.

If you change the Temperature unit then double check that the value in this 
field is also updated or correct as expected if you are keeping the default. This 
field does not update automatically when the unit changes.

Fluid Flow Including Marangoni Effect

Also see the theory section, Fluid Flow and if also using the keyhole model, see 
About the Keyhole Model.

Choose to use Fluid flow including Marangoni effect if you want to calculate and include for 
the effect of fluid flow due to gradient of surface tension in the melt pool. The checkbox is 
selected by default. This solves the Navier-Stokes equation to include fluid flow inside the 
melt pool due to the Marangoni effect. 

If you want to use separate properties for the powder layer, click to clear the checkbox to 
enable Use separate material properties for powder fields and then continue with the 
settings below.
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Use Separate Material Properties for Powder

This option is available when the Fluid flow including Marangoni effect checkbox is NOT 
selected.

If you want to use the keyhole model, then do not select this checkbox. 

Use separate material properties for powder: Select to use different density and thermal 
conductivity for the powder layer; otherwise by default the same properties as for the solid 
are used. Then enter a Powder density as a percentage (0-100%) of the solid material. The 
default is 80 % of the solid material.

Geometry

For a Steady-state simulation you only need to enter the height. For Transient or Transient 
with heat source from Steady-state these are volumetric and you also define the width and 
length. For all simulation types you define the coarseness of the mesh.

Height for Steady-state Simulation

Height: Enter the build height (mm). Length and width of the computational domain is 
automatically chosen as a function of the heat source parameters and the scanning speed.

Height, Width, and Length for Transient Simulations
 l Height: Enter the initial build height (mm). Powder layer(s) with the given layer 

thickness will be added on the top. In mm.
 l Width: Enter the build width (along y direction). In mm.
 l Length: Enter the build length (along x direction). In mm.

Mesh

Mesh: The initial mesh size —Coarse, Medium, Fine, or Custom. It is adaptive and refined as 
required.

If Custom is selected, enter the maximum and minimum element sizes:
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 l Maximum element size: The initial element size (in μm) in the mesh.
 l Minimum element size: The minimum element size (in μm) that the adaptive mesh 

can refine to.

Heat Source Models

Choose the heat source model: Gaussian, Double ellipsoidal, or Conical. When available you 
can also choose a predefined Users heat source from the list. 

Modeling Heat Source in the theory section. Also see About Heat Source 
Calibration for additional details.

When a Users heat source option is available to choose in the heat source list, 
then only the Power of the heat source needs to be entered and the rest of the 
parameters, including the absorptivity, are automatically included in the 
simulation based on the selected expressions when originally saving the heat 
source calibration data.

Gaussian Heat Source Settings

Gaussian is a surface heat source, and it is applied to the top surface of the domain. Then 
the heat is diffused based on the diffusivity of the material. This is most commonly used 
heat source in the industry.

However, in cases where the melt pool tends to form in a keyhole formation then you need 
to include more multiphysics phenomenon to get the correct shape of the meltpool. Then 
the volumetric heat sources give you better control of the shape of the meltpool and the 
temperature gradient around the heat source.

POWER

For a Single Point calculation  enter the Power. The default is 120 W.

ABSORPTIVITY

The Absorptivity settings are based on the Heat Source and Calculation Type selected.
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For a Single Point, Batch, or Grid Calculation Type:

 l Select Calculated (the default) to use the alloy's liquid resistivity to calculate the 
absorptivity as a function of temperature. To adjust this calculation, enter a different 
prefactor than the default (1.0) in the with prefactor field. 

 l Choose User-defined to enter absorptivity in % where you also can enter this as a 
function of temperature (T) i.e. -1.6e-7*T*T+2.5e-3*T+31.

For a Heat Source Calibration Calculation Type the absorptivity is calibrated separately for 
each row in the Experiment Data table. Select an option to calibrate absorptivity: 

 l Calculated (prefactor calibrated) (the default) to use the calculated absorptivity and 
calibrate the prefactor.

 l Constant (calibrated) to calibrate the absolute value of absorptivity.

About the Absorptivity Model and the section Heat Source Calibration for more.

WAVE LENGTH

This field is available:

 l For a Single Point, Batch or Grid Calculation Type and when Calculated is selected as 
the Absorptivity. 

 l For a Heat Source Calibration Calculation Type and when Calculated (prefactor 
calibrated is selected as the Absorptivity. 

About the Absorptivity Model and the section Heat Source Calibration for more.

Enter the Wave length in nm.

BEAM RADIUS

The beam radius is where the power reduces to 1 over a square as compared to its value at 
the axial point. This is only applied on the top surface and then heat is diffused into the 
material based on the diffusivity of the material.
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For a Single Point, Batch, or Grid Calculation Type enter the Beam radius size for the 
Gaussian heat source model. The default is 110 μm. Hover over the field in the GUI to view 
the example of it as below.

For a Heat Source Calibration Calculation Type and when Calculated (prefactor calibrated is 
selected as the Absorptivity.

 l Select Calibrated to calibrate the beam radius and the absorptivity or User-defined 
to enter a specific beam radius in the field (unit = μm) and only calibrate the 
absorptivity. 

 l Then choose what to Calibrate for. Select Width and depth of the melt pool, or 
Depth  to calibrate using only the depth of the melt pool. 

About the Absorptivity Model and the section Heat Source Calibration for more.

KEYHOLE MODEL AND RAYLEIGH LENGTH

About the Keyhole Model

The Use keyhole model checkbox is available for a Gaussian Heat Source and when the Use 
separate material properties for powder checkbox is NOT selected. 

Click to select the  Use keyhole model checkbox and enter a Rayleigh length of the laser 
beam in the field (unit = mm). The default is 2.5 mm.

Double Ellipsoidal Heat Source Settings

The Double ellipsoidal heat source, also referred to as Goldak, is a volume model where the 
heat intensity is in the front and the back of the heat source is defined with the help of two 
different ellipsoids. The axis of the each ellipsoid is needed.

POWER

For a Single Point calculation enter the Power. The default is 120 W.

ABSORPTIVITY

The Absorptivity settings are based on the Heat Source and Calculation Type selected.
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For this heat source and with a Single Point, Batch, or Grid Calculation Type enter the 
absorptivity % for the selected heat source model. The default is 60 %. For Heat Source 
Calibration calculations there are no further settings.

AR, AF, B, AND C

For Double ellipsoidal, also enter the following. For each field you can hover over it in the 
GUI to see these images that show you the location.

 l ar (default is 70 μm).

 l af (default is 70 μm).

 l b (default is 85 μm).

 l c (default is 200 μm).
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Conical Heat Source Settings

The Conical option is also a volumetric heat source where heat intensity is described as 
Gaussian distribution at the top surface, defined by a top radius, that varies linearly in the 
depth of the workpiece until it reaches a bottom radius within the prescribed depth.

POWER

For a Single Point calculation enter the Power. The default is 120 W.

ABSORPTIVITY

The Absorptivity settings are based on the Heat Source and Calculation Type selected.

For this heat source and with a Single Point, Batch, or Grid Calculation Type enter the 
absorptivity % for the selected heat source model. The default is 60 %. For Heat Source 
Calibration calculations there are no further settings.

RE, RI, H

For Conical, also enter the following. For each field you can hover over it in the GUI to see 
these images that show you the location.

 l re (default is 100 μm).
 l ri (default is 60 μm).
 l H (default is 100 μm).

Scanning Strategy

The scanning strategy determines the build geometry for one or multiple layers. Green layer 
on the top of the geometry is the powder and the grey part is the solid substrate.

For Steady-state simulations, you only need to define the Scanning speed and Layer 
thickness.
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Scanning Speed

Enter a Scanning speed, which is the velocity of the moving heat source. The default is 500 
mm/s.

Layer Thickness

Enter a Layer thickness, which is the thickness of the powder layer. The default is 40 mm. 
When you change the layer thickness, the meshing size changes too.

Pattern

Select the scanning Pattern—Single track, Bidirectional, or Unidirectional.

 l Select Unidirectional to use same scanning direction of the heat source for all tracks.
 l Select Bidirectional to flip scanning direction of the heat source between alternate 

tracks.

SINGLE TRACK

 l Margin: Offset of the laser scanning path from the sides of the computational 
domain. In case of Single track, offset is placed from the sides transverse to the 
scanning direction, whereas the scanning path is always in the middle of the domain 
going along the length of the workpiece.

 l Number of layers: Enter the number of layers or scroll using the arrows.
 l Powder fill time: Powder recoating time (unit = s) between two consecutive layers. 

This does not include lift time. This field is available when more than 1 is entered in 
the Number of layers field.

 l Cooling time:  Enter a cooling time (unit = s) This is the time for which the material is 
left to cool down after the scanning is completed. During cooling time, the heat 
source is completely turned off.

BIDIRECTIONAL AND UNIDIRECTIONAL

 l Margin: Offset of the laser scanning path from the sides of the computational 
domain.

 l Hatch spacing: Separation (unit = mm) between two consecutive tracks. 
 l Lift time: Time (unit = s) between two tracks where the heat source is inactive.
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 l Number of layers: Enter the number of layers or scroll using the arrows.
 l Powder fill time: Powder recoating time (unit = s) between two consecutive layers. 

This does not include lift time.
 l Rotation between layers: Rotation (unit = degrees) of the scanning direction 

between two consecutive layers. The scanning pattern of the first layer is always 
aligned to the X axis then the second layer will be rotated (if you choose this setting) 
with the specified angle then the next layer will be rotated at the same angle as 
compared to the previous layer and so on. This way you can change the rotation of 
the layers.

 l Cooling time: Enter a cooling time (unit = s) This is the time for which the material is 
left to cool down after the scanning is completed. During cooling time, the heat 
source is completely turned off.

Top Boundary Conditions

Numerical Boundary Conditions in the theory section.

Radiation Emissivity

Enter a Radiation emissivity to include the effect of radiation from the top surface to the 
surrounding gas. Enter a value between 0 and 1. If you want to neglect the heat loss, then 
enter 0 to disable radiation.

Convective Heat Transfer Coefficient

Enter a Convective heat transfer coefficient for the top surface to the surrounding gas. If 
you want to ignore this then enter 0 to disable convective heat transfer. The default is  20 
W/m2.

Evaporation

Select the Evaporation checkbox to include the effect of evaporation heat loss due to 
heating of the powder layer or the metallic surface close to the evaporation temperature.
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The Evaporation heat loss is calculated based on the settings on the Materials 
Properties tab, i.e. evaporation enthalpy per mole, the driving force for 
evaporation per mole quantity and the molar mass of gas. These are also 
calculated by the databases.

Calculation Type (Steady-state)

Single Point

By default for Steady-state calculations, Single point is selected, which uses the standard 
Gaussian Heat Source. Settings  are entered as described inHeat Source Models.

Heat Source Calibration

For some background, see About Heat Source Calibration. Also see Visualizing 
Heat Source Calibrations for various options related to visualizing the 
calibration settings.

Select Heat Source Calibration   to calibrate a heat source based on the imported or entered 
experimental data instead of performing a single point calculation. All types of heat sources 
can be used.  See below for additional information to enter the Experiment Data.
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Experiment Data (Heat Source Calibration)

It is important to prepare the experiment data file correctly so the simulation 
performs smoothly. See AM Calculator Experiment File Requirements.

This section is available when Heat Source Calibration is selected as the Calculation Type.

In the Experiment file field, either enter a file path or click the file button ( ) to navigate to 
a data file such as an Excel spreadsheet (with *.xls or *.xlsx extensions) or a *.csv file. You 
can also use other programs (e.g. Google Sheets) to enter data and export to a CSV format 
that can be read by the software.

Click Open to import the data. In the Experiment file field you can see the file path to the 
selected file. The next time you click the file button ( ) the program remembers the last 
location from where the file is opened.

Choose the delimiter—Comma (,), Colon (:), Equals sign (=), Semicolon (;), or Tab—that 
matches the delimiter in the experiment file and click the Reload ( ) button.

Batch

Select Batch to include power and scan speed data, which is read from a file such as a 
spreadsheet and entered or imported to the Batch Experiment Data table.  You can 
optionally include experimental melt pool width and depth (if there is data), and compare 
this to the calculated results using a Parity plot on the Plot Renderer. 

Visualizing Batch Calculations in the AM Module

Batch Experiment Data

It is important to prepare the experiment data file correctly so the simulation 
performs smoothly. See AM Calculator Experiment File Requirements.

This section is available when Batch is selected as the Calculation Type. 
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In the Experiment file field, either enter a file path or click the file button ( ) to navigate to 
a data file such as an Excel spreadsheet (with *.xls or *.xlsx extensions) or a *.csv file. You 
can also use other programs (e.g. Google Sheets) to enter data and export to a CSV format 
that can be read by the software.

Click Open to import the data. In the Experiment file field you can see the file path to the 
selected file. The next time you click the file button ( ) the program remembers the last 
location from where the file is opened.

Choose the delimiter—Comma (,), Colon (:), Equals sign (=), Semicolon (;), or Tab—that 
matches the delimiter in the experiment file and click the Reload ( ) button.

Grid

Select Grid to evaluate two axis variables of power and scanning speeds in the specified 
range and number of steps. Then continue with the Grid Definitions.

Grid Definitions

This section is available when Grid is selected as the Calculation Type.

For the Grid calculation type, define the two axes variables using the fields and menus: 
Quantity, Min, Max, and Number of steps. The number of steps along with the minimum 
and maximum values for the axes define a grid. For each grid point the selected models are 
evaluated. 

Enter a Min, Max, and Number of steps for:

 l Power (W) for the selected Heat Source model.
 l Scanning speed (mm/s) for the velocity of the moving heat source.

Probe Positions (Transient Simulations Only)

It is important to add the probes locations before the simulation is run or the 
action is not recorded.

You can add probes in the domain that record temperature and all other temperature 
related properties when the simulation is being run.

Click the Add  and Remove  buttons to add each probe and then you can either 
manually enter the probe coordinates (enter the x, y, and z coordinates in the fields) or click 
Pick coordinate to choose each of the points specifically on the Geometry tab in the 
Visualizations window.
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Some advance options can be selected from a popup menu; 

 l Double-click on the geometry to pick a coordinate
 l Hold Ctrl key to pick a probe in the middle of a layer
 l Hold Shift key to map the picking position with a scanning path, i.e. you can pick a 

probe that snaps to a nearest scanning path
 l Hold Shift+Alt keys to map the picking position to the middle of two scanning paths, 

i.e. pick a probe in the middle of the two nearest scanning paths.

AM Calculator: Working with Probe Data

Using Probe Data in Diffusion and Precipitation Calculations

When you also have licenses either for the Diffusion Module (DICTRA) and/or 
the Precipitation Module (TC-PRISMA), for transient simulations you can 
additionally  include probe data from the AM Calculator in the set up of the 
thermal profile for diffusion and precipitation calculations, respectively. 

AM Calculator Experiment File Requirements

The following describes the requirements for importing experimental file data to be used 
with an AM Calculator either for a Heat Source or Batch Calculation Type and when setting 
it up on the Configuration window.

AM Calculator Conditions Settings

It is important that the experiment data file contents are correctly entered in 
order for the calculation to perform smoothly.

Heat Source Calibration Calculations

When the Heat Source Calibration Calculation Type is selected in the Steady-state mode, 
there is an option to import a file with experimental data points that are used to calibrate 
the heat source.

Data can also be entered directly into the table on the AM Calculator Configuration 
window. However, if an Experiment file is imported it needs to be set up in a certain way so 
that the software can read the data.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 530 of 763

These examples use experiment data, key holing, and heat source calibration: 
AM_06a: Calibrating a Heat Source for a 316L Steel and AM_06b: Using the 
Calibrated Heat Source for a 316L Steel.

Figure 1: From example AM_06a, this shows the data imported from an experiment file into the 
table. The "Use" column allows you to choose the points to include or exclude for the simulation. 
Here row (experiment) #1 is selected to show the data point. Further down in this list, rows 9, 14, 
20, and 21 are also selected to be included.

Batch Calculations

When the Batch Calculation Type is selected in the Steady-state mode, there is an option to 
import a file with experimental data points.

Data can also be entered directly into the table on the AM Calculator Configuration 
window. However, if an Experiment file is imported it needs to be set up in a certain way so 
that the software can read the data.

These examples use Batch calculations AM_07: Batch Calculations for an IN718 
Alloy, AM_08b: Batch Calculations for a Ti64 Alloy, and AM_09b: Batch 
Calculations for an SS316L Alloy. 

Figure 2: From example AM_08b, this shows the data imported from an experiment file into the 
table. Here the "Use" checkbox for Experiment 1 is about to be deselected to exclude the data 
point after previewing it on the Visualizations window. 
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Experiment File Requirements

Only the columns described here are read / used in the calculation. It is 
important to enter the information exactly as described. All header text (the 
first line in the file) must also be written in English, i.e. no translations into 
other languages will be read correctly by the experiment file.

The experiment file is set up as follows.

 l The first row in the file is the header.
 l Include only four columns in the file and these must be in the following order and 

must use the indicated units.

Default Global units (i.e. set via the Tools → Options menu) are not 
applicable. The data must be in the indicated units.

 l Power (unit = W)
 l Scanning Speed (unit = mm/s)
 l Width of the melt pool (unit = μm)
 l Depth of the melt pool (unit = μm)

 l All of the values entered or imported to the table must be positive and greater than 
zero.

If you select Depth from the Calibrate for list, then the experimental values for 
only the melt pool depth is needed. 

Do not include the following in the file:

 l # this is the experiment number that is automatically associated to each imported or 
entered set of data. It is used to identify the applicable rows by a unique number so 
that you can easily identify these points (i.e. points are identified by labels on the 
plots), or when choosing to include or exclude the experiment point from the 
simulation or later from a plot. 
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 l P/v (J/mm). This is the energy density and is defined as the ratio of power and 
scanning speed. This is not included in any data file. This is automatically calculated 
based on the Power and Speed entered or included in the file (i.e it is defined as the 
ratio of power and scanning speed).

 l Use. This column is not part of the text file, it is available once the data is imported 
or entered in the table. Then you can choose to include or exclude specific data 
points as you examine this output in the Visualizations window. 

Figure 3: An example of the original experiment data file, with the four headings in the correct 
order and these do not need the units included here. When the file is imported, there is a standard 
header that is kept, plus the additional columns (i.e. #, P/V, and Use experiment), which are 
automatically available and updated as needed.

Once a set of data is imported to the table (or entered manually), expand the 
Configuration window to reveal the scroll bars. Then you can scroll up or down, 
left or right, within the table to select checkboxes for the relevant data points 
you want to include or exclude. This is applicable to the tables found on the 
AM Calculator as well as those on the Plot Renderer for the  data.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 533 of 763

You can edit the table after importing data, or manually enter information. To add a row, 
scroll to the bottom of the table and press <Enter>.

AM Calculator Materials Properties Settings

Once you have added an AM Calculator, the Configuration window has these settings tabs 
where there are many available conditions to set on the Conditions, Materials Properties, 
and Options tabs and with the specialized Plot Renderer.

This section describes the settings for the Materials Properties tab.

AM Calculator Conditions Settings and AM Calculator Options Settings

Use Data From

If there is a Scheil Calculator predecessor to the AM Calculator, you can import the material 
properties from a Library or Scheil Calculator. When the AM template is added, the default 
is to import material properties from Scheil calculations.

When the with Material Library template is used, then the AM Calculator > Materials 
properties are available to import from a Library only.
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In this case you also can Save, Save as, Export to Folder, Delete, and Rename the material 
data both from Scheil and from material library. With Save or Save as, original data is saved 
i.e. without any smoothing. With Export to Folder, the data is saved with Smoothing. the 
material data both from Scheil and from material library.

Export to folder is intended for using the data in an external simulation 
software, where using smoothed data is expected to result in fewer numerical 
issues. Save and Save as are intended for when the data is to be used in the AM 
Module. The data will be smoothed according to the smoothing setting before 
use in the FEM simulation.

Account for Interface Scattering

When  Use data from Scheil Calculator is selected, you can also select the Account for 
interface scattering checkbox. 

The electrical resistivity due to phase interface scattering is evaluated as the scattering 
constant times sum of the interaction between the volume fraction of all the phases. The 
default value for the Phase interface scattering constant is found to be 4.0e-8 Ωm for 
aluminum alloys produced with conventional methods. A higher value could be required for 
the AM process where the rapid solidification results in a very fine microstructure with a 
large amount of phase interfaces.The contribution to thermal conductivity is assumed to be 
related to that to electrical resistivity, following the Wiedemann-Franz law.

Either keep the default Phase interface scattering constant, which is a constant for 
evaluating thermal conductivity due to scattering at phase interfaces, or enter another 
value.

Import

You can import material properties contained in a folder.

Click the Import from folder and add to libraries button and navigate to the folder location 
where the material properties are located.
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Smoothing

From the Smoothing list, select Same for all quantities (where Little smoothing is the 
default) or Per quantity. Then either define the smoothing once (Same for all quantities) or 
individually for each quantity. Options are No smoothing, Little smoothing, Medium 
smoothing, Large smoothing, or Linear.

Available quantities to define smoothing:

 l Heat
 l Apparent heat capacity per kg
 l Density
 l Thermal conductivity
 l Dynamic viscosity
 l Surface tension
 l Molar volume
 l Molar mass of gas
 l Driving force for evaporation per mole
 l Evaporation enthalpy per mole
 l Electric resistivity
 l Absorptivity 
 l Absorptivity vs angle

Plot

From the Plot list, choose what quantity to plot:

 l Heat
 l Apparent heat capacity per kg
 l Density
 l Thermal conductivity
 l Dynamic viscosity
 l Surface tension
 l Molar volume
 l Molar mass of gas
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 l Driving force for evaporation per mole
 l Evaporation enthalpy per mole
 l Electric resistivity

Plot: Absorptivity Options

The following absorptivity options depend on what is  entered on the  Conditions tab. See 
Heat Source Models section for the settings.

If a Gaussian Heat Source is selected, plus one of the following Calculation Type 
combinations: 

 l Heat Source Calibration, when  User-defined is selected; 
 l Single Point, Batch, or Grid when Calculated or User-defined is selected 

Then the options are:

 l Absorptivity 
 l Absorptivity vs angle 

For a Gaussian Heat Source, Heat Source Calibration Calculation Type, and when Calculated  
is selected, then the options are:

 l Absorptivity (wavelength is <value from Heat Source settings >  with prefactor 1.0). 
 l Absorptivity vs angle (wavelength is <value from Heat Source settings > with 

prefactor 1.0).

The wavelength <value from Heat Source settings > for the Absorptivity and 
Absorptivity vs angle is the same as what is entered on the  Conditions tab. For 
example, if 1064 nm is entered, it displays on the Material Properties tab as 
Absorptivity (wavelength is 1064 nm with prefactor 1.0). 

Show Transition Temperatures

You can also choose to Show transition temperatures:
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 l Solidus, Liquidus, Evaporation
 l Solidus
 l Liquidus
 l Evaporation
 l Custom: If selected, also enter a value in the field. The default unit is the same as 

what is selected globally on the Tools → Options → Graphical Mode → Default 
Units tab.

 l None

AM Calculator Options Settings

Once you have added an AM Calculator, the Configuration window has these settings tabs 
where there are many available conditions to set on the Conditions, Materials Properties, 
and Options tabs, as well as with the specialized Plot Renderer.

This section describes the settings for the Options tab.

AM Calculator Conditions Settings and AM Calculator Materials Properties 
Settings

Streamline Upwind Petrov-Galerkin (SUPG)

Select the Streamline upwind Petrov-Galerkin (SUPG) checkbox to enable SUPG 
stabilization scheme for the energy and Navier-Stokes equations.

Damping Factor for the Damped Newton Iteration

Select the Damping factor for the damped Newton iteration checkbox to add a damping 
factor for the damped Newton iteration and enter a value between 0 and 1. The default is 
0.7.

It may improve stability but it slows down convergence of the simulation.

Smagorinsky Constant

Enter a Smagorinsky constant in the field. This is the value of the constant to use in the fluid 
flow model. The default is 0.18. 

For more information see Fluid Flow in the theory section.
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Save Interval for Transient Simulation

Select the interval to save results from transient simulations. If the number of files saved are 
specified, choose if the step size should increase linearly or exponentially.

From the Save interval for transient simulation list choose Automatic, Every Nth time step, 
or Time in seconds. Then for each also enter as indicated:

 l Automatic
 l Max number of files: The default is100Linear.
 l Then choose Linear or Exponentially increasing. Enter another number of 

files in the field as needed.

 l Every Nth time step: The default is 1 or enter or use the up and down arrows to 
choose another number.

 l Time in seconds: The default is 0.01 or enter another number in the field.

Number of Cores

Select or enter the Number of cores available for the simulations. The default value is the 
total number of physical cores available in the system.

AM Calculator: Working with Probe Data

When you also have licenses either for the Diffusion Module (DICTRA) and/or 
the Precipitation Module (TC-PRISMA), for transient simulations you can 
additionally  include probe data from the AM Calculator in the set up of the 
thermal profile for diffusion and precipitation calculations, respectively. 

Workflow to Include Probe Data from Diffusion or Precipitation Simulations

You can use installed examples to visualize how the probes are set up for a 
Diffusion Calculator (see AM_05: Using AM Calculator Probe Data with the 
Diffusion Module (DICTRA)) and for the Precipitation Calculator (see AM_12: 
Using AM Calculator Probe Data with the Precipitation Module (TC-PRISMA)).
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 1. Set up the probes on the AM Calculator. Probes are available for transient 
calculations only. See AM Calculator Conditions Settings. This must be done before 
you can use the probe data in the calculations connected to a Diffusion Calculator or 
Precipitation Calculator.

 2. If not already done, add a Diffusion Calculator or Precipitation Calculator as a 
successor to the AM Calculator.

 3. Set up your Diffusion or Precipitation Calculator as needed. Follow the basic settings 
details for the Thermal Profile section as described in Diffusion Calculator Thermal 
Profile and Precipitation Calculator Thermal Profile.

 4. Once the standard settings are completed, and as long as probes are set up, on the 
Configuration window, the section Probes is available. Until the AM Calculator is run, 
the list is empty. After the AM simulation is completed, the data is imported into the 
table you can choose how to Condense time-temperature data. These settings are 
described below.

Probes

The list of Probes is available as long as Probe Positions are set up on the AM Calculator and 
the AM Calculator is performed to generate the data, which is fed into the applicable 
Calculator (Diffusion or Precipitation). Select the probe you want to plot, for example as a 
Segregation Profile as shown in example AM_05.

Condense Time-Temperature Data

Use the Condense time-temperature data setting to adjust how many time-temperature 
points are included in the Thermal Profile displayed in the Visualizations window. For 
example, for a complex calculation you can choose a Medium or Large setting to save fewer 
time steps at this stage of design, which in turn can ensure that a complex diffusion or 
precipitation calculation is able to finish.

Choose None, Small, Medium, Large, or Custom.

 l None (the default) includes all points, i.e. no points are condensed together and all 
point data are included in the Thermal Profile preview. When using the Custom 
setting, this is equivalent to entering a value greater than 1 in the field.

 l Small condenses a minimum number of points, which means that a large number of 
time steps are used in the calculation and thus lots of time steps are shown.

 l Medium is when that a medium number of points are condensed together, which 
means that a medium number of time steps are used in the calculation.

 l Large is when a large number of points are condensed together, which means that 
there are few, or a small number of time steps used in the calculation.
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 l When Custom is selected you can fine-tune the number of points to include. Enter a 
value between 0 and 1, where 0 maximizes condensing the points (the same as 
choosing Large), 1 minimizes condensing the points (the same as choosing Small), 
and 0.5 is a medium number of points being condensed (the same as choosing 
Medium). If you enter a value greater than 1, it is the same as choosing None, i.e. all 
data points are included. The larger the value, the more points are condenses, until 
only two points are shown.

AM Calculator: Plot Renderer Settings

Once you have added an AM Calculator, you can add the specialized Plot Renderer. The 
following is information about the settings available for a Plot Renderer when it is a 
successor to an AM Calculator.

The settings listed below are made available based on a variety of 
combinations, e.g. the type of simulation (Steady-state, Transient, or Transient 
with heat source from Steady-state), whether fluid flow or the keyhole 
checkboxes are selected,  whether probes are used, and so on. There are also 
Calculation Types (Single Point, Heat Source Calibration, Batch, and Grid), that 
impact the settings shown, and these options are further included on separate 
tabs (i.e. Batch, Grid, Heat Source Calibration, 3D Plot, Plot Over Line, Thermal 
Gradient vs Solidification Rate, etc.), which are further fine-tuned based on the 
plot types or display types selected on the Plot Renderer. 

The software guides you by only providing the relevant settings to define. Due 
to the number of settings available, these are not in order as to what you see 
on the Configuration window. Where relevant or logical, settings are grouped 
together and some detail of when or how you would access the setting is 
included. Scroll or search for the setting or field name as there are many 
simulation, calculation, display options, and plot type combinations that are 
available on the relevant tab on the Plot Renderer Configuration window.  

About the AM Plot Types and Working with AM Visualizations
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General

Add a Quantity and Remove a Quantity or Function Buttons

Use the Add quantity or Add function  and Remove quantity or Remove function  
buttons to add additional setting groups that include all of the available settings. Click the 
checkbox next to these buttons to enable or disable any particular settings group. 

Show Table or Hide Table

These buttons are available on the Batch or Grid tabs after running either a Batch or Grid 
calculation, respectively. 

Use the Show Table or Hide Table buttons to view the simulation data and using the table 
you can fine tune the plot. Also see Visualizing Batch Calculations in the AM Module for 
more information about the columns in the table.

Export Result Files

This option is available on the Plot Renderer Configuration window for the following tabs 
(and the associated plots that are available for each): 3D Plot, Grid, Batch, or Heat Source 
Calibration. The button is available after the simulation is run. 

Click Export Result Files to export the files and visualize the results in external software. The 
result file(s) in Exodus format (*.e) and the json file info .json are copied to the folder 
selected. The json info file contains the settings and results from each data point. You can 
open the json info file in a text reader (i.e. Notepad) to review it before using the Exodus file 
in the external software.

When exporting from the Grid, Batch, and Heat Source Calibration tabs, the results are 
saved in separate subfolders, each containing the .e and .json files. The Exodus file format 
is used for finite element analysis. 

The folders containing the sets of results files are exported in random order. To 
match the folder to the original datapoint, open the json file in a text editor. In 
this file there is a number field that matches the row (experiment) number in 
the table found on the Plot Renderer Configuration window for the applicable 
tab (click Show Table). You can use this to match the folder contents back to 
the datapoint as needed.
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In the Export Result Files window, in the Folder Name field, navigate to the location or 
enter a file path to where you want to save the files. Create a new folder as needed. Click 
Save. The individual exported files in each folder are named info.json and result.e and 
can be used in external software. When there are multiple subfolders (i.e. for Grid, Batch 
and Heat Source Calibration) the number of folders exported is the same as the number of 
rows of data  selected to be used. If the Use checkbox is not selected, the result folder (and 
files) for that data point is not exported. Click the Show Table button to review the rows of 
data and choose to include or exclude data points from the Use column. 

Filter by Material Types

This option is available when Use separate material properties for powder is selected on 
the AM Calculator.

Select Filter by material types to visualize specific material types from the list.

Layer Thickness

Enter a Layer thickness in μm. The printed layer thickness is equal to the powder thickness 
first after multiple layers have been printed. For a single track, or a few layers, the printed 
layer is often much less than the powder thickness.

Table View

Click the Table View   button to toggle it ON and OFF between a plot and a table. 

AM Plots: Table View Options
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Transient-related Simulations

Time

Once a Transient simulation plot is calculated, the Time step results are listed in a drop-
down list. You can choose to look at a specific time point, or click the buttons to the right of 
the drop-down to navigate the time steps. Hover over the buttons to see the tooltips or see 
Time Step Navigation Buttons.

Time Step Navigation Buttons

Button Action

Move to the first time step

Move to the previous time step

Play from the current time step to the last one

Move to the next time step

Move to the last time step

Rescale Plotting Data Range Over All Time Steps

This is available for Transient simulations.

Select the Rescale plotting data range over all time steps checkbox to scale min and max 
values of legends and plots over all time steps.

Axis Variables and Display Options

Axis Variable
Set the state variable you want plotted along the X-axis and the Y-axis. The available 
variables in the list are based on how your system is set up and options vary.

Choose an Axis variable and an applicable unit (indicated in the brackets) from each of the 
drop-down lists.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 544 of 763

 l Temperature (Kelvin, Celsius, or Fahrenheit)
 l Surface tension (Joule per m2 or Millijoule per m2)
 l Thermal conductivity (unitless)
 l Available when the Fluid flow including Marangoni effect checkbox is selected:

 l Dynamic viscosity (Pascal-second, milliPascal-second, Poise, or centiPoise)
 l Flow velocity field (m/s, mm/s, μm/s, or nm/s)
 l Solidification rate  (m/s, mm/s, μm/s, or nm/s)

 l Thermal gradient (Kelvin per m)

Display

Based on the Axis variable selected, choose the way to Display it.

 l For Temperature, Surface tension, Thermal conductivity, or Dynamic viscosity, 
choose Surface colormap, Contour, or Iso-surface. For Surface colormap and 
Contour, you can also click to select the Slice checkbox. 

 l For Flow velocity field, choose the object shape to display velocity vectors: Arrow, 
2D glyph, Cone, or Line.

The settings are further described below.

Tubes

Available for display type Contour.

The Tubes checkbox is selected by default and this displays contour plots as 3D tubes. Click 
to clear the checkbox and instead display the contours as 2D lines.

Values

Available for display types Contour and Iso-surface. For Iso-surface you can also specify the 
opacity of surface plot in %.

Choose the Values: Automatic (the default), Custom values, Custom range, Solidus, 
Liquidus, or Solidus and Liquidus.
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 l For Automatic, enter the Number of steps.
 l For Custom values enter a number in the field.
 l For Custom range enter the Min and Max number of lines, then Number of steps.
 l Select Solidus to plot contour/iso-surface at solidus temperature.
 l Select Liquidus and Solidus and Liquidus to plot contour/iso-surface at both solidus 

and liquidus temperatures.

Some settings are further described in separate sections below.

Number of Steps

Available for Contour and Iso-surface Display types, and when Automatic or Custom range 
Values are selected.

Enter or choose the Number of steps.

In some cases for a Custom range selection, you need to expand the 
Configuration window to the right to access this setting.

Opacity

Available for Surface colormap and Iso-surface (available for all Values options).

Enter a value between 0-100 as the percent (%) of Opacity.

Slice

This is available for display types Surface colormap or Contour. 

Select the Slice checkbox to visualize the Axis variable on a cross-sectional plane. You can 
choose the normal of the cross-sectional plane and the distance of the plane from the center 
of the heat source.

Then choose X-direction, Y-direction, or Z-direction, for the Distance from center of heat 
source and for the beam radius.
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Coloring and Range

Choose Rainbow, Cool to warm, Purple Orange, Green Purple, Blue Brown, Green Red, 
Solid color.

For all but Solid color, choose a Range—Automatic or Custom. Then for Custom enter a Min 
and Max number.

Legend

Click the Legend checkbox to include or click to clear to exclude a legend.

Scale Glyph by Velocity Magnitude

This setting is for a Flow velocity field Axis variable. It is available for all Display types.

Select the Scale glyph by velocity magnitude checkbox to scale the velocity display object 
(glyph) according to the velocity magnitude. Otherwise the glyphs are scaled uniformly.

Glyph Scale Factor

This setting is for a Flow velocity field Axis variable.

Enter a numerical value for the Glyph scale factor.

Show Glyph in Every

This setting is for a Flow velocity field Axis variable.

For the Show glyph in every setting, enter or select the number of grid points where 
velocity glyphs are displayed.

2D Plot Types

You can plot the material properties (2D) so you can specify the quantities and add as many 
lines as you want directly to the plot in the Visualizations window. What you see is Distance 
vs Temperature, first is first layer, second is second layer, and so forth on the 2D plots. You 
can select the different times from the list at the top at different points and see it on the 
plot, for example it might be at 26 minutes where you can see it is as the peak of the melt 
pool max temperature.
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Show Transition Temperatures

Available with 2D plot types, such as Probe or Plot Over Line. It is a dynamic list that 
updates the plot in the Visualizations window after the 2D plot is performed.

Select the different options to better visualize the transition temperature results. From the 
Show transition temperatures list, choose Solidus, Liquidus, Evaporation, Solidus, Liquidus, 
Evaporation, Custom, or None. For Custom, also enter a specific temperature value in the 
field. Then observe the changes on the plot, where the legend updates and the lines for each 
option are added or removed based on the selection.

Grid Calculations (Grid, 3D Plot, and Plot Over Line Tabs)

These settings are specific to Grid calculations and are on the Grid tab. Also see plot related 
settings: Melt Pool vs Energy Density Plot Type (Batch and Grid Tabs) and Printability Map 
Plot Type (Batch and Grid Tabs).

Grid Data

This is available on the 3D Plot and Plot Over Line tabs after running a Grid Calculation Type.

The data in the Grid data list shows all the power and scan speed combinations and it is 
sorted in order of energy density. 

Grid Calculation Table

The following is on the Grid tab after a Grid calculation. 

Use the Show Table or Hide Table buttons to view the simulation data and using the table 
you can fine tune the plot. The table includes these columns:

 l The Power (W) and Speed (mm/s) columns are the from what was entered under 
Grid Definitions, on the AM Calculator i.e. the Min, Max, and Number of steps.

 l The P/v (J/mm) column is the automatically calculated energy density, defined as the 
ratio of power and scanning speed. 

 l The calculated width and depth points, with the prefix Sim., i.e. Sim.width (μm) and 
Sim.depth (μm), to indicate it is the result of the simulation.

 l The Use column has a checkbox available to include or exclude these points on the  
plots. When a Use checkbox is not selected, the results are also not included if you 
choose to export the result files. See Export Result Files.
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Batch Calculations

These settings are specific to Batch calculations. Also see plot related settings: Parity Plot 
(Batch Tab), Melt Pool vs Energy Density Plot Type (Batch and Grid Tabs), and Printability 
Map Plot Type (Batch and Grid Tabs).

After the Batch Experiment Data set up is completed on the AM Calculator and 
the simulation run, then on the Plot Renderer you can start to work with the 
data you want to plot. Also see Including or Excluding Data Points to 
understand the interaction between these two tables.

Batch Experiments

Plot Renderer →  3D Plot, Plot Over Line, and Thermal Gradient vs Solidification Rate tabs 
after running a Batch Calculation Type.

The data in the Batch Experiments list shows all the power and scan speed combinations 
and it is sorted in order of energy density. 

Batch Calculation Table

Plot Renderer → Batch tab.

You may have already included or excluded data points earlier when previewing the data. 
Use the Show Table or Hide Table buttons to view the included or excluded data and 
continue to fine tune the plot. 

On the Batch tab the table includes these columns:

 l The original experiment data for Power (W) and Speed (mm/s), plus the P/v (J/mm).
 l The original experiment data for Width and Depth, now with a prefix Exp. e.g. 

Exp.width (μm), to indicate this is the experimental data.
 l The calculated Width and Depth points, with the prefix Sim., e.g. Sim.width (μm), to 

indicate it is the result of the simulation.

Only the experiment data points selected for inclusion when setting up 
the AM Calculator have data in these two Sim. columns.
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 l The Use column has a checkbox available to continue to include or exclude those 
points on the  plots. When a checkbox is not selected, the results are also not 
included if you choose to export the result files. 

Only points that were originally included in the simulation can be 
selected or deselected from the Use column. If an experiment data 
point needs to be added, return to the AM Calculator, choose the point 
(s) to include there, and run the simulation again. Once the simulation is 
complete, the points are included in this table.

Parity Plot (Batch Tab)

The following settings are available on the Batch  tab when a Parity plot is selected as the 
plot type.

Plot Width and Plot Depth

Click the Plot width and Plot depth checkboxes to toggle between displaying these points on 
the associated tab on the Visualizations window for the plot. 

Show Limits

Select the Show limits checkbox to include additional visual cues on the plot. Choose RMS, 
Absolute, or Relative in %. For Absolute or Relative in % enter a number in the field.  The 
plot dynamically updates as you toggle between these options.

Melt Pool vs Energy Density Plot Type (Batch and Grid Tabs)

The following settings are available on the Batch or Grid tab when a Melt pool vs energy 
density is selected as the plot type.

Plot Width and Plot Depth

Click the Plot width and Plot depth checkboxes to toggle between displaying these points on 
the associated tab on the Visualizations window for the plot. 

Printability Map Plot Type (Batch and Grid Tabs)

The following settings are available on the Batch or Grid tab when a Printability map is 
selected as the plot type and after running a Batch or Grid calculation, respectively.
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Show Result Points

Select or deselect the Show result points checkbox to toggle these on and off on the 
Visualizations window. The plot updates dynamically. 

Hatch Distance

Enter a Hatch distance  in μm.  

Function

Printability maps with varied power and scanning speeds can be simulated showing regions 
where the defects keyholing porosity, lack of fusion, and balling occur. The defect regions 
are defined by functions of the keyhole dimension (Wk, Dk), melt pool dimensions (W, D, L), 
hatch distance (h), and powder thickness (t). Use the plus   and minus   buttons to add 
and remove sections to define each Function.
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Click to toggle the Function checkbox to show and hide the selected functions as needed on 
the Visualizations window.

From the list select one of the following for each section added then for each choose All, <= 
(less than or equal to), or >= (greater than or equal to) and enter a number in the field 
associated field. On the Visualizations window, there are numbered labels to indicate 
experiments with defects, in red , or without defects, in green.

 l Keyholing: W/D
 l Keyholing: Wk/Dk
 l Balling: W/L
 l Balling: D/L
 l Lack of fusion: D/t
 l Lack of fusion hatch: Dh/t
 l Meltpool width: W
 l Meltpool depth: D
 l Meltpool length: L
 l Keyhole width: Wk



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 552 of 763

 l Keyhole depth: Dk
 l Meltpool depth at hatch: Dh
 l Custom. Then enter a Name in the field.

Areaplot

Click the Areaplot checkbox to toggle between including the colored sections on the plot. 

Isolines

Click the Isolines checkbox to include or exclude isolines. 

Choose Automatic, Custom, or Custom values. 

 l For Automatic, enter the Number of steps. 
 l For Custom, enter the distance between lines i.e. 1.0 1.25 1.5.
 l For Custom values, enter a Min, Max, and Number of steps. 

Heat Source Calibration Calculations 

See AM Calculator Conditions Settings and Visualizing Heat Source Calibrations 
for more detailed information.

Heat Source Calibration Experiments

Plot Renderer →  3D Plot and Plot Over Line tabs after running a Heat Source Calibration 
Calculation Type.

The data in the Heat Source Calibration Experiments list shows all the power and scan 
speed combinations and it is sorted in order of energy density. 

Heat Source Calibration Table

Plot Renderer → Heat Source Calibration tab.

Click the Show Table or Hide Table buttons to view or hide the experimental and simulation 
data. To fine-tune the choice of data points, click the checkbox for the Use column for each 
row (experiment #) to observe the dynamic changes on the Heat Source Calibration 
Parameters and/or Melt Pool Dimensions tabs on the Visualizations window. 
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Experiment data and other settings must be configured for this to be available. 
The data points available in the table are selected on the AM Calculator under 
Experiment Data and then you can include or exclude points by selecting or 
deselecting the relevant checkboxes in the Use column.

On the Heat Source Calibration tab (Plot Renderer) the table includes these columns:

 l The original experiment data for Power (W) and Speed (mm/s), plus the energy 
density P/v (J/mm).

 l The original experiment data for Width and Depth, now with a prefix Exp. to indicate 
this is the experimental data, e.g. Exp. width (μm).

 l The calculated Width and Depth points, with the prefix Sim. to indicate it is the 
result of the simulation, , e.g. Sim. width (μm).

Only the experiment data points selected for inclusion when setting up 
the AM Calculator have data in these two Sim. columns.

 l The Use column has a checkbox available to include or exclude those points on the 
Heat Source Calibration Parameters and Melt Pool Dimensions tabs on the 
Visualizations window. Furthermore, if a simulation is not used in a fit, the results 
from that simulation are not included to generate functions for Heat Source 
Calibration parameters. 

Only points that were originally included in the simulation can be selected or 
deselected from the Use column. If an experiment data point needs to be 
added, return to the AM Calculator, choose the point (s) to include there, and 
run the simulation again. Once the simulation is complete, the points are 
included in this table.
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Figure 4: From example AM_06a, the Heat Source Calibration tab on the Plot Renderer for a 
double ellipsoidal heat source calibration for the double ellipsoidal heat source calculation. Here 
experiment from row #1 is included in the simulation as indicated by the white row and the check 
mark in the Use column. Rows 2-4 were not included in this simulation and are greyed out. When 
a  checkbox is not selected, the results are also not included if you choose to export the result files.

Heat Source Parameters

Plot Renderer → Heat Source Calibration tab.

These are the parameters you choose on the Plot Renderer Configuration window. There is 
also a Heat Source Calibration Parameters tab on the Visualizations window that is used in 
combination with the table to choose data points. 

The heat source parameters available to plot for each Heat Source type (i.e. Gaussian, 
Double ellipsoidal, or Conical) selected on the AM Calculator: 

 l Gaussian: Beam radius. Then based on the Absorptivity setting (Calculated 
(prefactor calibrated) or Constant (calibrated)), also Absorptivity prefactor plus 
additional options.

 l Double ellipsoidal: Absorptivity, ar, af, b, and c
 l Conical: Absorptivity, re, ri, and H.

There is more information about using these parameters in AM Calculator 
Conditions Settings → Heat Source Models section.

For all heat source parameters, you can also choose to select:

 l A Constant function value i.e. the average value from all experiments or a function of 
energy density, which could also be a Linear function, Cubic function, or a Sigmoid 
function.
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 l A 2d cubic function P and v of Power (P) and Scanning speed (v).
 l For extrapolating outside the range of energy density as given from the experimental 

data, select a Constant value, Extrapolate linear, or choose Extrapolate for 
extrapolation using the same function as chosen for interpolation.

 l Set the range of energy density to interpolate the heat source parameters by 
entering the appropriate values in the Below P/v and Above P/v fields. 

There are R2 values (the coefficient of determination) included that say how 
well the selected function fits the data.  R2 ranges from zero to one, where 1 is a 
perfect match. E.g. A linear function between two points. 

Once all the parameter adjustments are made, you can also retain this information for 
future reuse (click Save As or Save). You can also Rename or Delete these from the list as 
needed.

The name of the file defaults to using the Heat Source type + the material type. 
For example, Double ellipsoidal - 316L, or Gaussian - 316L.

Working with AM Visualizations

The AM Calculator visualization using the Plot Renderer is different from the 
other Calculators available in Thermo-Calc.

See Plot Types for more information for the Scheil Calculator and Diffusion 
Calculator, which are also used with the Additive Manufacturing (AM) Module.

About the AM Plot Types

How the Project Nodes are Connected to the Configuration and Visualizations 
Tabs

The following examples use a mix of adding an AM template and example AM_01 to provide 
an overview of how the nodes in the Project window are connected to the Configuration 
window settings tabs and to the different levels of tabs in the Visualizations window. Try 
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this yourself either by adding an AM template or open any of the examples and click around 
to understand how the geometry, heat source calibration (when applicable), and various 
plots are connected between all the windows.

Window Connectivity

In general:

 l In the Project window, the AM Calculator, Diffusion Calculator, and Precipitation 
Calculator nodes, plus all the associated successor Plot Renderer or Table Renderer 
nodes, are listed in the Visualizations window on the top level tabs using the same 
name as the node.

 l It is recommended you rename the nodes in the Project window to meaningful 
names that make it easier to navigate the visualizations.

 l In the Visualizations window, a Geometry tab is always associated to the AM 
Calculator node in the Project window. In addition, when a Heat Source Calibration 
calculation is chosen on the AM Calculator, there is also a Heat Source Calibration 
secondary level tab associated to this (at the same level as the Geometry tab). 

 l An AM Calculator and all its Plot Renderer successors are listed on the top level tab. 
The secondary level tab has visualizations related to geometry, heat source 
calibration, and the available plot types (3D Plot, Plot Over Line, Probe Plot, and the 
plots associated to heat source calibration).

 l The Diffusion Calculator and any Plot Renderer or Table Renderer successors are all 
listed in the Visualizations window on the top level tab. The secondary level tab has 
visualizations related to the Composition Profile and Thermal Profile.

 l The Precipitation Calculator and any Plot Renderer or Table Renderer successors are 
all listed in the Visualizations window on the top level tab. The secondary level tab 
has visualizations related to the Thermal Profile.

 l The Scheil Calculator is not listed on the top level tab in the Visualizations window, 
but any Plot Renderer or Table Renderer successor for this Calculator is listed on the 
top level tab.

 l Renaming any node in the Project window also renames the top level tabs in the 
Visualizations window.

 l The second level tabs on the Visualizations window cannot be renamed as these 
represent the visualization type named by the system e.g. a geometry, plot type 
(3D Plot, Plot Over Line, Probe Plot, etc.), or a Composition Profile (diffusion 
simulations) or Thermal Profile (diffusion or precipitation simulations).
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 l For 2D plots (Plot Over Line 2D Plot, Probe 2D Plot), click the Table View button on 
the applicable tab in the Visualizations window to convert the values into a table 
format.

Configuration Window

When a Plot Renderer is added to an AM Calculator in the Project window, there are default 
tabs added to the Configuration window where you can further set up the available plot 
types. In this example, two tabs, 3D Plot and Plot Over Line, are provided for you to set up 
these plot types.

Visualizations Window

In the Visualizations window, the upper tab level is connected to a second level of tabs that 
represent the available visualizations. A Geometry tab is always associated to the AM 
Calculator node. Then for any Plot Renderer node, all of the plotting types such as a 3D Plot, 
Plot Over Line, Probe, and Thermal Gradient vs Solidification Rate are listed in the 
secondary tab level.
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There is not always something to visualize at the second tab level. Keep an eye 
on the underlined tabs on both levels, i.e. click the upper level tab and look for 
the underlined second level tab associated to it and that is what is displayed. 
Also note that clicking the upper level tabs in the Visualizations window does 
not change the focus of the node clicked in the Project window, although the 
opposite is true.

Each node in the Project window is represented across the top set of tabs in the 
Visualizations window. Then the associated tab on the Visualizations window displays 
below as a secondary level. For example, in the Project window, if you click the 
AM Calculator node (in AM_01 it is renamed to Transient, DE HS), then on the Visualizations 
window the Transient, DE HS tab is highlighted and has a blue underline. On the second tab 
level, the Geometry tab is also underlined to indicate it is associated to the Transient, DE HS 
tab. What is actually displayed in the Visualizations window is based on the second tab.

Then for each Plot Renderer added and defined, the secondary tab level is connected to 
what is visualized. For example, a Plot Renderer is added to the AM Calculator in the Project 
window. In this case, the node is renamed to 3D plot. When this node is clicked in the 
Project window, the 3D plot tab is highlighted and underlined in the Visualizations window.

You can also click each of the top level tabs in the Visualizations window at any 
time to navigate the visualizations, but the node focus in the Project window 
does not change to match.
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Figure 5: When you click a node in the Project window, the associated tab is highlighted and 
underlined in the Visualizations window. Then the second level of tabs are further underlined to 
indicate what is associated to the selected top level tab, and this is what actually displays in the 
Visualizations window.

In the Visualizations window, the top level tab for Plot Renderer is further connected to the 
3D Plot and Plot Over Line tabs. You can determine what you are actually viewing in the 
Visualizations window based on the upper level highlighted and underlined tab and then 
further by the second level underlined tab.

Visualizing Heat Source Calibrations

The following is available for a Steady-state → Heat Source Calibration Calculation Type.
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About Heat Source Calibration

During the set up of the Heat Source Calibration, experiment data is either entered or 
imported to the AM Calculator. You can then view the Heat Source Calibration on a second 
level tab in the Visualizations window. This is associated to the AM Calculator.

Then once the experiment data is included and the heat source calibration is performed, you 
can further create plots on the Plot Renderer to examine the Heat Calibration Parameters 
and Melt Pool Dimensions.

More details about this are described in a separate topic. See Visualizing Heat 
Source Calibrations.

Visualizing Batch and Grid Calculations

The following is available for a Steady-state → Batch or Grid Calculation Type. 

Results from Steady-state simulations using Batch or Grid calculations contain multiple 
steady-state results, one for each power and scan speed.  The results can be visualized 
individually using a 3D Plot and Plot Over Line (described above). The combined result from 
all steady-state simulations can additionally be visualized from the Batch tab (available on 
the Plot Renderer Configuration window after the Batch calculation), and similarly from the 
Grid tab after a Grid calculation. On these tabs you choose additional plot types Printability 
map, Parity plot, and Melt pool vs energy density. 

A table of the experimental and calculated values can be viewed  when you click to toggle 
between the Show Table or Hide Table buttons. The table is displayed in the Plot Renderer 
Configuration window for the relevant Batch or Grid tab. 
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Figure 6: The simulated and experimental melt pool dimension can also be tabulated for all data 
using the toggle button to Show Table or Hide Table. This is from example AM_09b.

More details about this are described in separate topics. See Visualizing Batch 
Calculations in the AM Module and for the various plot settings for a Grid, these 
are included with the general topic, AM Calculator: Plot Renderer Settings.

There is a video tutorial about the Printability Map on our website and on our 
YouTube channel. It is also included in the Additive Manufacturing Module 
YouTube playlist.

AM Visualizations Window Plot Toolbar

The Visualizations window by default has tabs included to help you visualize both the set up 
using the available Calculators (e.g. AM Calculator, Diffusion Calculator, and Precipitation 
Calculator) and the results that are calculated via a Plot Renderer or Table Renderer. For 
2D plots, you can also view data by clicking the Table View button.

Rotate, Zoom, and Pan 3D Plots: AM Calculations

Working with AM Visualizations

Button Name Action

Zoom to heat 
source position Click to zoom to the heat source.

https://thermocalc.com/support/video-tutorials/additive-manufacturing-module-examples/
https://youtu.be/Jact1ZmiyIE?si=bSJPm7EAUxDe-nsL
https://www.youtube.com/playlist?list=PLfv6McToaTGS-LW4xV4YFPLcAmIuDvKu0
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Button Name Action

Set view to 3D Click to reset the view where you zoom out to see the whole geometry.

Set view 
direction to YZ, 
XZ, or XY 

Click to orient to a side view in the 

 l YZ-axes direction.

 l XZ-axes direction.

 l XY-axes direction.

Azimuth 
rotation, Ctrl+ 
for invert 
rotation

Click to rotate around the free axis. Press and hold CTRL + click the mouse to 
control the direction turned.

Elevation 
rotation, Ctrl+ 
for invert 
rotation

Click to rotate around the free axis. Press and hold CTRL + click the mouse to 
control the direction turned.

Roll rotation, 
Ctrl+ for invert 
rotation

Rotate around the free axis Click Ctl+button to control the direction turned

Save camera 
view angle and 
zoom level

There are two attributes that are saved when the Save camera view angle and 
zoom level button is clicked. The view angle of the camera and the zoom level.

Then when you click the Apply saved camera view and zoom level , it mirrors 
the view angle of the camera and the zoom level. This is available for any 3D 
plot tab on the Visualizations window.

Only one camera position can be saved/retained at any time for use.

Apply saved 
camera view 
angle and zoom 
level

First use the Save camera view angle and zoom level to save the desired view. 
Then click the Apply saved camera view and zoom level button to mirror the 
view angle of the camera and the zoom level. This is available for any 3D plot 
tab on the Visualizations window.

Only one camera position can be saved/retained at any time for use.

Show grid Click to turn on and off the mesh grid.

Show heat 
source Click to show and hide the heat source.
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Button Name Action

Mirror geometry When in steady state you only see half the geometry. Click to show the whole 
geometry, click again to show half the geometry.

— Hide layers Enter a number of layers to hide

Show Outer Box Click to turn on and off the outer box geometry.

Show line 
between powder 
and solid

Click to turn on and off a line and plane around the powder layer thickness.

Show Size of the 
Melt Pool

Click to show or hide the melt pool. This is the same thing as showing the size 
of the liquidus iso-surface plot. When clicked you also see the measurements 
in the Event Log window and shows on the Visualizations window.

Show Size of 
Melt Pool plus 
Mushy Zone

Click to show or hide the melt pool and mushy zone. This is the same thing as 
showing the size of the solidus iso-surface plot. When clicked you also see the 
measurements in the Event Log window and shows on the Visualizations 
window.

Show Manual 
Ruler

Click to use the manual ruler to measure the melt flow.

 l Double click each time to add the start and end points.

 l To align a ruler on the x-, y-, or z- axis: Hold CTRL when adding or 
moving the end point. The ruler snaps to the closest point on the 
same axis.

 l To move a ruler: Click and hold a point, then drag to reposition.

 l Right-click a point to delete it.

Menu or Keyboard Options: Geometry and 3D Plots

When working with the AM Calculator (probes) and its associated Plot Renderer (for 3D 
Plots), there are menu options or tooltip guidelines available to access certain actions for 
probes, markers, or to save a snapshot image from the Visualizations window. 

Plot- and Geometry-related Menus to Save  Images

When available, right-click in the Visualizations window and choose Save As from the menu 
to save the current view in png, gif, or jpg format. This saves an image snapshot of the 3D 
Plot or Geometry at the zoom level and angle you are currently viewing. 
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 l Geometry: When setting up probes, you can right-click on the Geometry to save the 
current view. 

 l 3D Plot: When working with a 3D Plot, you can right-click anywhere on the 3D Plot to 
save the current view. This option is only available with AM Calculator 3D plots. 

Probe-related Menus and Tooltips

AM Calculator: Working with Probe Data

When you are picking the coordinates for the probe location, there is a menu available when 
you right-click a point on the Geometry in the Visualizations window. There are also tooltips 
that can help guide you. 

 1. On the Configuration window for an AM Calculator, under Probe Positions, click Pick 
coordinate. Hover over the button to view the tooltips with options to:

 a. Double-click on the geometry to pick a coordinate.

 b. Hold the <Ctrl> key and double-click to pick the position at the middle of a 
layer.

 c. Hold the <Shift> key and double-click to map the picking position with a 
scanning path.

 d. Hold the <Shift+Alt> keys and double-click to map the picking position to the 
middle of the scanning path.

 2. In the Visualizations window on the Geometry tab, use one of the methods to add a 
probe point to the geometry, for example double-click to add a probe. 

 3. In the Visualizations window, right-click to choose an option from the menu 
associated to the new Pick coordinate probe point:

 a. Set probe to this position: Sets to the location where the probe is located at 
the time of selecting.

 b. Set probe to the nearest path line: Moves the probe to the path line, which 
can be where other probes are already set up.

 c. Set probe to the middle of the two nearest path lines: This only works if 
there are two path lines, otherwise the probe does not move.

 d. Save As...: Select this to save an image of the current view of the probes (a 
snapshot at the zoom level chosen). You can save in png, gif, or jpg formats. 

 e. Close : Closes this menu.
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Marker-related Menus and Tooltips for 3D Plots (AM Module Only)

Markers are added to 3D plots in the Visualizations window. For example, you are 
measuring the distance between two points on a heat source. 

 1. On the Visualizations window for an AM Calculator Plot Renderer (and after running 
a 3D Plot), click the Show Manual Ruler button on the toolbar. Hover over the 
button to view the tooltips with options to: 

 a. Double-click each time to add the start and end points.

 b. To align a ruler on the x-, y-, or z-axis: Hold <Ctrl> when adding or moving the 
end point. The ruler snaps to the closest point on the same axis.

 c. To move a ruler: Click and hold a point, then drag to reposition.

 d. Right-click a point to delete the ruler.

 2. Click in the plot area to add markers for the start and end points, for example. Once 
the marker is on the plot, you can delete it or save an image of the plot at the current 
view.

 l To delete a marker, zoom as close to it as possible and right-click the marker 
to bring up the menu. Select Delete marker from the list. You might have to 
move the mouse around the area of the marker or zoom further to access the 
menu options.

 l To save an image of the plot at the current view, click anywhere in the plot 
and select Save as. Select this to save an image in png. gif, or jpg format. 
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Rotate, Zoom, and Pan 3D Plots: AM Calculations

When working with the Additive Manufacturing (AM) Module and the results from an AM 
Calculator simulation, two general plot types are added to the Visualizations window: a 3D 
plot and a Plot over line 2D plot. The 2D plot has the same functionality as for other 
calculations but the 3D plot is specific to this Module.

In addition to the Visualizations window for an AM 3D plot having its own set of buttons 
(see AM Visualizations Window Plot Toolbar) there are also different ways to work with the 
3D plots with respect to rotating, zooming, and panning the geometry around the window.

 l In combination with the following actions use these buttons on the toolbar: 

Set View to 3D 

Set View Direction .

 l Rotate the geometry : Left-click and hold the mouse, then move it around the 
window to rotate in any direction. Hold CTRL + left mouse button to rotate on a 
specific axis.

 l Zoom in and out: Scroll the mouse wheel or right-click and move the mouse up and 
down in the window.

 l Pan the geometry: Hold Shift + left mouse button then move the mouse up or down, 
left or right, to move the geometry around the window without zooming.
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Go to the Help (press F1 in Thermo-Calc) to view a short video showing the use 
of these actions.

Overlaying Plots in the AM Module

In general, it is now possible to overlay plots from any Calculator with plots from any other 
Calculator. 

2D plots are overlaid pair-wise which means if you add two or more AM Calculators as a 
predecessor in one Plot Renderer, similar 2D plots (such as Probe with Probe and Plot Over 
Line with Plot Over Line, etc.) are grouped and overlaid in one tab on the Visualizations 
window.

The most important use case is that you can overlay Probe plots from different Transient 
and Transient with heat source from Steady-state Calculators and Plot Over Line plots from 
all AM Calculators. Similarly, you can also overlay Meltpool vs energy density and Parity plot 
from different Batch, Grid, and Heat Source Calibration calculators.

You need to click Perform to make plot overlaying work.

It is not possible to overlay two 3D plots. However, when you want to plot two 
or more variables in a comparable way to overlaying plots in 2D, you use one 
Plot Renderer connected to at least two AM Calculators. Then on the 3D Plot 
tab on the Configuration (settings) window you choose different quantities 
from the Axis variable list. Use the  and  buttons as usual to add and 
remove quantities. The plots are then viewed on separate 3D Plot tabs on the 
Visualizations window. After defining the axis variables, click Perform to 
update the plots on the respective Visualization 3D Plot tabs. It is also 
important to rename your AM Calculators in order to better work with these 
plots.

Visualizing Heat Source Calibrations

This topic describes both the AM Calculator and the Plot Renderer visualization outcomes 
related to the heat source calibration calculations for a Steady-state simulation.
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To import data for use in batch calculations, it is recommended you review 
AM Calculator Experiment File Requirements. Also review Working with 
AM Visualizations, which provides an overview of how most of the windows are 
connected. 

It is recommended to open and run one of the examples to best understand the 
wide variety of visualization outcomes: AM_06a: Calibrating a Heat Source for a 
316L Steel and AM_06b: Using the Calibrated Heat Source for a 316L Steel

Working with AM Calculator Heat Source Calibration Experiment Data

During the set up of the Heat Source Calibration, experiment data is either entered or 
imported to the AM Calculator table where it is visible on its associated Configuration 
window.

Click the relevant AM Calculator node in the Project window to preview the table data via a 
Heat Source Calibration tab on the Visualizations window.

Use the table's Use column on the AM Calculator Configuration window to select the 
relevant checkboxes for which Width and Depth points to include (i.e. use) or exclude (i.e. 
not use).

You can click or hover over any point on the Heat Source Calibration preview to display the 
label, which also includes the corresponding table row (i.e. Experiment) number for the 
point.
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On the Heat Source Calibration window :

 l For this calibration view, Width uses blue squares (solid color means used, hollow 
with same color outline means not used)

 l For this calibration view, Depth uses red circles (solid color means used, hollow with 
same color outline means not used)

 l The preview shows the energy density (P/v) on the X-axis and melt pool dimensions 
on the Y-axis.

Click to select or deselect checkboxes in the table to dynamically watch the selection change 
on the Visualizations window. The points that are selected in this table are used in the 
simulation results and are later labeled Exp.Width and Exp.Depth in the Plot Renderer 
Configuration table (see Figure 9). Then the calculated results are added to new columns 
labeled Sim.Width and Sim.Depth in the data table on the Plot Renderer Configuration 
window (see below).

Sometimes an experiment data point is selected in the table on the 
AM Calculator but after running the simulation it is not available in the 
corresponding Plot Renderer table (i.e. it is a greyed out row). This indicates 
that the calibration could not be calculated for that particular data point.
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Figure 7: From example AM_06a, this is the heat source calibration preview for the data imported 
to the AM Calculator node (renamed to AM Calibration Double Ellipsoidal). As per the legend, 
both "used" (solid color) and "not used" (hollow with outline color) points are included in this 
preview.

Once a set of data is imported to the table (or entered manually), expand the 
Configuration window to reveal the scroll bars. Then you can scroll up or down, 
left or right, within the table to select checkboxes for the relevant data points 
you want to include or exclude. This is applicable to the tables found on the 
AM Calculator as well as those on the Plot Renderer for the  data.
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Working with the Plot Renderer for Heat Source Calibrations

After the calibration is completed on the AM Calculator and the simulation run, then on the 
Plot Renderer Configuration window you can start to use the data.

For additional Plot Renderer settings (and other visualization options for 
plotting) go to AM Calculator: Plot Renderer Settings.

Adding the Heat Source Calibration Plots

 1. Add a Plot Renderer to the AM Calculator.

 2. Choose an experiment point from the Heat Source Calibration list. The points in this 
list match the points selected in the Use column on the AM Calculator.

 3. Click Perform.

 4. Click the Heat Source Calibration tab on the Plot Renderer Configuration window to 
(1) view the table of data and (2) view the Heat Source Calibration Parameters and 
Melt Pool Dimensions tabs in the Visualizations window on the secondary level of 
tabs. These tabs are where you fine-tune the choice of data points: Click the 
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checkbox for the Use column for each row (experiment #) to observe the dynamic 
changes on the Heat Source Calibration Parameters and Melt Pool Dimensions tabs 
on the Visualizations window.

Navigating the Heat Source Calibration Table

On the Heat Source Calibration tab (Plot Renderer) the table includes these columns:

 l The original experiment data for Power (W) and Speed (mm/s), plus the energy 
density P/v (J/mm).

 l The original experiment data for Width and Depth, now with a prefix Exp. to indicate 
this is the experimental data, e.g. Exp. width (μm).

 l The calculated Width and Depth points, with the prefix Sim. to indicate it is the 
result of the simulation, , e.g. Sim. width (μm).

Only the experiment data points selected for inclusion when setting up 
the AM Calculator have data in these two Sim. columns.

 l The Use column has a checkbox available to include or exclude those points on the 
Heat Source Calibration Parameters and Melt Pool Dimensions tabs on the 
Visualizations window. Furthermore, if a simulation is not used in a fit, the results 
from that simulation are not included to generate functions for Heat Source 
Calibration parameters. 
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Only points that were originally included in the simulation can be selected or 
deselected from the Use column. If an experiment data point needs to be 
added, return to the AM Calculator, choose the point (s) to include there, and 
run the simulation again. Once the simulation is complete, the points are 
included in this table.

Figure 8: From example AM_06a, the Heat Source Calibration tab on the Plot Renderer for a 
double ellipsoidal heat source calibration for the double ellipsoidal heat source calculation. Here 
experiment from row #1 is included in the simulation as indicated by the white row and the check 
mark in the Use column. Rows 2-4 were not included in this simulation and are greyed out. When 
a  checkbox is not selected, the results are also not included if you choose to export the result files.

Working with the Heat Source Calibration Parameters

Based on the type of heat source selected on the AM Calculator, below the Heat Source 
Calibration table there are additional parameters you can choose to include or exclude from 
the Heat Source Calibration Parameters and Melt Pool Dimensions plots.

Once the selection of experiments is made in the Configuration window for the Heat Source 
Calibration, you can choose appropriate functions for each heat source parameter including 
the absorptivity. See Figure 9 for an example of the available parameters for a Double 
ellipsoidal Heat Source.
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Figure 9: From example AM_06a, these are the available parameters for a double ellipsoidal heat 
source simulation. The available parameters are based on the heat source chosen on the 
AM Calculator during set up.

Click to select or deselect the Plot checkbox and watch the change on the 
Visualizations window for both the Heat Source Calibration Parameters and 
Melt Pool Dimensions plots. There are several options to choose from in this 
section that each change the plots dynamically.

The heat source parameters available to plot for each Heat Source type (i.e. Gaussian, 
Double ellipsoidal, or Conical) selected on the AM Calculator: 

 l Gaussian: Beam radius. Then based on the Absorptivity setting (Calculated 
(prefactor calibrated) or Constant (calibrated)), also Absorptivity prefactor plus 
additional options.

 l Double ellipsoidal: Absorptivity, ar, af, b, and c
 l Conical: Absorptivity, re, ri, and H.

There is more information about using these parameters in AM Calculator 
Conditions Settings → Heat Source Models section.

For all heat source parameters, you can also choose to select:

 l A Constant function value i.e. the average value from all experiments or a function of 
energy density, which could also be a Linear function, Cubic function, or a Sigmoid 
function.

 l A 2d cubic function P and v of Power (P) and Scanning speed (v).
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 l For extrapolating outside the range of energy density as given from the experimental 
data, select a Constant value, Extrapolate linear, or choose Extrapolate for 
extrapolation using the same function as chosen for interpolation.

 l Set the range of energy density to interpolate the heat source parameters by 
entering the appropriate values in the Below P/v and Above P/v fields. 

There are R2 values (the coefficient of determination) included that say how 
well the selected function fits the data.  R2 ranges from zero to one, where 1 is a 
perfect match. E.g. A linear function between two points. 

Once all the parameter adjustments are made, you can also retain this information for 
future reuse (click Save As or Save). You can also Rename or Delete these from the list as 
needed.

The name of the file defaults to using the Heat Source type + the material type. 
For example, Double ellipsoidal - 316L, or Gaussian - 316L.

Visualizations Window

Heat Source Calibration Parameters Plot

A Heat Source Calibration Parameters plot shows the calibrated heat source parameters as 
a function of energy density (P/v) (unit J/mm). From the Plot Renderer Configuration 
window, you can also continue to select which experiments to be used to fit the calibration.
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Figure 10: From example AM_06a, the Heat Source Calibration Parameters plot for the double 
ellipsoidal calibration.

For instance, you can deselect the points that seem to be outliers or where the error bar in 
experimental data is large. 

The selection is done via the checkboxes available in the Use column.

Melt Pool Dimensions Plot

A Melt Pool Dimensions plot shows melt pool size, both from experiments and simulations, 
as a function of energy density (P/v). This plot can be used to compare the results from the 
experiments and optimization simulations.
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Figure 11: From example AM_06a, the Melt Pool Dimensions plot for the double ellipsoidal 
calibration.

3D Plot and Plot Over Line

Use a 3D Plot to visualize all the experiments for which the calibration is performed. To 
show the 3D plot for a certain experiment, select the corresponding experiment from the 
Heat Source Calibration Experiments menu. The configuration in the 3D Plot works in the 
same way as for a single point steady-state calculation.

For Plot Over Line, plot the data along a line for the selected experiment. To show the plot 
over line for a specific experiment, select the corresponding experiment from the Heat 
Source Calibration Experiments menu. The configuration in the Plot Over Line works in the 
same way as for a single point steady-state calculation.

About the AM Plot Types

Visualizing Batch Calculations in the AM Module

This topic describes the AM Calculator visualizations related to the Batch calculations for a 
Steady-state simulation. There are further settings and visualization possibilities s that are 
available when you are working on the Plot Renderer. 
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To import data for use in batch calculations, it is recommended you review 
AM Calculator Experiment File Requirements. Also review Working with 
AM Visualizations, which provides an overview of how most of the windows are 
connected. 

It is recommended to open and run one of the examples to best understand the 
wide variety of visualization outcomes: AM_07: Batch Calculations for an IN718 
Alloy, AM_08b: Batch Calculations for a Ti64 Alloy, and AM_09b: Batch 
Calculations for an SS316L Alloy

Working with AM Calculator Batch Experiment Data

From example AM_08b, where the general behavior related to importing data to the table is 
the same as other places in Thermo-Calc. 

In the Project window, click the relevant AM Calculator node (in this example renamed to 
AM Ti64 Batch)  to work on the Configuration window and preview the table data via a 
Batch tab on the Visualizations window.
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During the set up of a calculation, the Batch Experiment Data is imported  into the 
AM Calculator Configuration window, where you can review the data and choose to include 
or exclude data points by selecting and deselecting the checkboxes as needed in the Use 
column  (see Figure 12). At the same time, you can observe the change as this is updated in 
the Visualizations window (see Figure 13). Data can also be entered directly into the table. 

Figure 12: The experimental data used for the Batch calculation for the single track experiments 
of Ti64 is imported to the AM Calculator table where you can review the data points and include 
or exclude as needed using the checkboxes. 

Figure 13: The visualization of the experimental melt pool dimensions are shown as a function of 
the energy density P/v. You can adjust the selected points in the Batch Experiment Data table and 
watch the updates dynamically in this window. 



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 580 of 763

Including or Excluding Data Points

The following discusses visualization options available on the Configuration windows for 
both the AM Calculator and Plot Renderer. 

You can click or hover over any point on the Batch preview to display the label, which also 
includes the corresponding table row (i.e. Experiment) number for the point.

Use the table's Use column on the AM Calculator Configuration window to select the 
relevant checkboxes for which Width and Depth points to include (i.e. use) or exclude (i.e. 
not use). 

Figure 14: From example AM_08b, on the AM Calculator, the checkbox for row (experiment) #1 
can be deselected to exclude the data point in the calculations. 

On the Batch tab on the Visualizations window, the preview shows the P/v on the X-axis 
and Melt pool dimensions on the Y-axis:

 l Width uses blue squares (solid color means used, hollow with same color outline 
means not used)

 l Depth uses red circles (solid color means used, hollow with same color outline means 
not used)

When you toggle the Use checkbox selection, the preview dynamically updates in the 
Visualizations window to indicate which data points are used (filled) or not used (hollow), 
both on the preview and in the legend.
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The points that are selected in the Batch Experiment Data table are used in the simulation 
results and are later labeled Exp.Width and Exp.Depth in the Plot Renderer Configuration 
table (see Figure 15). Then the calculated results are added to new columns labeled 
Sim.Width and Sim.Depth.

Figure 15: From example AM_08b, this is the Batch tab on the Plot Renderer Configuration 
window where row (experiment) #1 data point is excluded from the results after selecting it on 
the AM Calculator. When a checkbox is not selected here, the results are also not included if you 
choose to export the result files. The details about Plot Renderer settings are in the 
topicAM Calculator: Plot Renderer Settings.

Working with the Batch Table on the Plot Renderer 

After the Batch Experiment Data set up is completed on the AM Calculator and the 
simulation run, then on the Plot Renderer Configuration window you can start to work with 
the data you want to plot. Also see Including or Excluding Data Points to understand the 
interaction between these two tables.

For additional Plot Renderer settings (and other visualization options for 
plotting) go to Batch Calculations. 
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Navigating the Batch Table

You may have already included or excluded data points earlier when previewing the data. 
Use the Show Table or Hide Table buttons to view the included or excluded data and 
continue to fine tune the plot. 

On the Batch tab the table includes these columns:

 l The original experiment data for Power (W) and Speed (mm/s), plus the P/v (J/mm).
 l The original experiment data for Width and Depth, now with a prefix Exp. e.g. 

Exp.width (μm), to indicate this is the experimental data.
 l The calculated Width and Depth points, with the prefix Sim., e.g. Sim.width (μm), to 

indicate it is the result of the simulation.

Only the experiment data points selected for inclusion when setting up 
the AM Calculator have data in these two Sim. columns.

 l The Use column has a checkbox available to continue to include or exclude those 
points on the  plots. When a checkbox is not selected, the results are also not 
included if you choose to export the result files. 

Only points that were originally included in the simulation can be 
selected or deselected from the Use column. If an experiment data 
point needs to be added, return to the AM Calculator, choose the point 
(s) to include there, and run the simulation again. Once the simulation is 
complete, the points are included in this table.
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About the Process Metallurgy Module

The Process Metallurgy Module is an Add-on Module to Thermo-Calc and it is available in 
Graphical Mode as the Process Metallurgy Calculator. The Add-on Module is designed to 
model reactions that occur in metallurgical processes. Although primarily used in 
steelmaking and steel refining processes—such as basic oxygen furnaces, electric arc 
furnaces, ladle furnace metallurgy, and so forth—applications are not limited to 
steelmaking. 

There are two main branches of calculations possible: Equilibrium and Process simulation. 
Equilibrium calculations do not consider any kinetics, the process simulation includes 
reaction kinetics.

In general, for both types, the main difference compared to using a standard Equilibrium 
Calculator is that it is easy to handle the different materials present in a metallurgical 
process. The materials used in the process can be pre-defined, saved and used for the 
equilibrium calculations. Metallic materials can be defined in element weight percent, oxide 
materials in weight percent of oxide components, the gas phase in volume percent of gas 
components and its amount can be defined in normal cubic meters, and so forth. In principle 
this can be done in a standard Equilibrium Calculator. However, it is much easier when using 
the Process Metallurgy Calculator as this is designed for this specific purpose.

When using the Equilibrium branch of calculations, both isothermal and adiabatic 
calculations are possible. Adiabatic calculations assume no heat and mass exchange with the 
environment during the equilibrium reaction, meaning that the temperature changes as a 
result of exothermal or endothermal reactions taking place. 

For a Process simulation branch of calculation, the reaction kinetics of the process are 
considered. This is done by dividing the system into zones. Typically one would have one 
steel zone containing liquid metal and a slag zone containing liquid oxide (slag). The kinetic 
model assumes that only a fraction of the steel zone reacts with a fraction of the slag zone 
per time step. This reacting fraction of the whole system is termed the reaction zone (in 
literature it has become known as Effective Equilibrium Reaction Zone or EERZ).

You can use the Process Metallurgy Module to calculate the following:

 l The equilibrium between custom-defined steels, slags, and gasses.
 l The equilibrium between other metallic and non-metallic phases.
 l Desulfurization, dephosphorization, and decarburization.
 l Any partition coefficient, for example the partitioning of sulfur between the liquid 

steel and slag phase.
 l Slag characteristics, such as slag basicity or sulfur capacity.
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 l The fraction of liquid and solid in the slag.
 l The temperature change in an adiabatic process.
 l Kinetics of the reaction between phases. Typically this is the reaction between a 

liquid metal and slag phase, but it could also be the reaction between a solid oxide 
and slag (simulation of refractory wear) or between a solid metal and liquid metal 
(simulation of dissolution of alloy), etc.

The Process Metallurgy Module requires both a valid Maintenance and Support 
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database 
(TCOX8 or newer). 

All users can test the Process Metallurgy Module with the included OXDEMO 
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For 
more information about this and other products visit our website.

https://www.thermocalc.com/


Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 586 of 763

Available Options with the Process Metallurgy Module

The Process Metallurgy Module is an Add-on Module to the core Thermo-Calc software. 

A separate license is required to perform calculations for more than three 
elements. Without it you are able to use the module in Demo Mode. 

Process Metallurgy Template

A Process Metallurgy template under Applications is available to all Thermo-Calc users 
when in Graphical Mode. If you are in DEMO mode then  this is indicated by the addition of 
DEMO text.

Using the Template

After opening Thermo-Calc in Graphical Mode,  in the templates section under Applications 
click Process Metallurgy to add a System Definer, Process Metallurgy Calculator, and Plot 
Renderer to the Project tree.

Creating a Project from a Template  

Process Metallurgy Calculator

A Process Metallurgy Calculator allows you to set the conditions for, and perform, a process 
metallurgy calculation. 



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 587 of 763

Demonstration (Demo) Mode

The Process Metallurgy Module, and some examples, are available to all Thermo-Calc users 
but only for simulations of alloys with up to three elements. If you do not have a license for 
the Process Metallurgy Module then you are in Demonstration Mode when using the 
Process Metallurgy Calculator or its template. 

Process Metallurgy Template

A Process Metallurgy template under Applications is available to all Thermo-Calc users 
when in Graphical Mode. If you are in DEMO mode then  this is indicated by the addition of 
DEMO text.

Process Metallurgy Calculator

If you are experimenting with the Process Metallurgy Calculator in Demo Mode, you may 
have access to a variety of databases based on your license. However, you can only define 
up to three elements for a demo simulation. 

If you define more than three elements and try to run the simulation the Event Log displays 
an error message.
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Network License Restrictions

The Process Metallurgy Module requires a separate license. If you are using a network client 
installation of Thermo-Calc, then you may not be able to use it even if you have access to a 
license server with a valid network license file. The reason for this is because other clients 
who are part of your network installation may have checked out all instances of the network 
license allowed to run simultaneously. 

For users with a network license, you must exit Thermo-Calc to release the 
license for other users. The license is checked out as soon as you add a Process 
Metallurgy Calculator and remains unavailable to other users until you exit the 
program. 

With a network license, and if as per above you temporarily do not have access 
to a license, you are automatically put into Demo Mode. Then the Process 
Metallurgy Calculator is available with three elements. 

Search the online help or see the Thermo-Calc Installation Guide for more about 
network licenses.
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Setting Up a Process Metallurgy Simulation

The following basic steps need to be carried out to set up calculations in the Process 
Metallurgy Calculator. There are three branches of simulation to choose from on the 
Configuration window when setting up the simulation an isothermal equilibrium calculation,  
an adiabatic equilibrium calculation, and  a process simulation. 

Examples of using the Process Metallurgy Calculator for Basic Oxygen Furnace 
(BOF) (with and without kinetics), a Ladle Furnace (LF) simulation,  an Argon 
Oxygen Decarbarization (AOD), and a Vacuum Oxygen Decarborization 
(VOD) simulation are included with your installation. See the Process Metallurgy 
Module Examples Collection for links. 

You can find several learning resources on the Process Metallurgy page of our 
website (or in Thermo-Calc, go to Help → Thermo-Calc website). You can also 
subscribe to the Thermo-Calc newsletter to be kept up-to-date about upcoming 
releases, training, examples, videos and much more. 

https://www.thermocalc.com/products-services/process-metallurgy-module/
https://www.thermocalc.com/our-company/customer-newsletter-signup/
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Isothermal and Adiabatic Equilibrium Calculations and Process 
Simulation Options

The three branches of simulations available for the Process Metallurgy Calculator (1) an 
isothermal equilibrium calculation, (2) an adiabatic equilibrium calculation, and (3) a process 
simulation.  

Equilibrium Simulations

Two Equilibrium simulation types are available: Isothermal and Adiabatic. In general for the 
equilibrium  simulation, the three most common material groups—Steel, Slag, and Gas—are 
automatically included with the default composition input types that are relevant to each 
material group. You can add materials and save your material compositions directly from the 
Process Metallurgy Calculator and quickly access these for other simulations. For example, 
you might want to predefine compositions of steels, ferro-alloys, slags, and slag additions. 
The overall composition of the steel and slag is then obtained by adding amounts of these 
predefined materials.
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Each group of materials is automatically added to the similar group where it is defined. You 
can manage these groups using the Material Manager (see Working with the Material 
Manager). 

For adiabatic calculations, the selection of material type (steel, slag, gas) has an 
influence on the calculation. For isothermal calculations, the results are 
identical.

The reason the selection of materials for adiabatic calculations has an influence is because 
there are different strategies to calculate the enthalpy of the materials at the temperature 
at which these are added. Therefore, defining FeO as a steel containing 50 at% Fe and 50 
at% O or as a slag with 50 at% Fe and 50 at% O or as slag with 100% FeO, all result in 
different enthalpies assigned to the component FeO, which in turn results in different 
equilibrium temperatures. 

Defining the Equilibrium Simulation and Equilibrium Simulation: Conditions Tab

Adiabatic Calculations: Material Enthalpy

Process Simulations

When you choose to do a Process simulation it includes the reaction kinetics. Using the 
EERZ (Effective Equilibrium Reaction Zone) model, you can first define your materials as you 
do with an Equilibrium simulation. You also need to define the Process model where you 
define the kinetic parameters of the simulation by setting up reaction zones, reaction rates, 
heat transfer coefficients, and so forth. You also need to define the Process schedule where 
the sequence and amounts of added materials are defined.

Defining the Process Simulation and Process Simulation: Conditions Tab

Calculation Types

The calculations available for an Equilibrium simulation, for both isothermic and adiabatic 
calculations, are Single equilibrium, One Axis, Grid, and Uncertainty.  After adding a Plot 
Renderer or Table Renderer, you can choose a variety of quantities, including slag 
properties such as Bells ratio and B2, to output results that provide useful visual 
representations of the steelmaking systems being analyzed. 

Process Metallurgy Calculator and Defining the Equilibrium Simulation   
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Working with the Process Metallurgy Module

Working with the Process Metallurgy Calculator allows you to easily define complex 
metallurgical reactions. The calculator streamlines how you set up these steel and slag 
systems but there are details about various inputs and outputs that are different from other 
calculators. This topic is a general collection of information related to the Process Metallurgy 
Module and is intended to help you better understand how to interpret and make choices 
when you are setting up your steelmaking simulation.

Database Dependency

It is not possible to use custom user databases with the Process Metallurgy 
Module. This is because several internal calculations, such as determining the 
component compositions of ionic phases, are dependent on the database.  
Therefore, only TCS Metal Oxide Solutions Database (TCOX) versions 8 and 
newer, and to a limited extent, OXDEMO, can be used with this Module. 

Material Manager

For information about saving and deleting materials used with the Process Metallurgy 
Calculator, see Working with the Material Manager. Also see the next section.

Working with Material Groups (Steel, Slag, and Gas)

For more details about these fields, see Defining the Equilibrium Simulation. For 
information about saving and deleting materials, see Working with the Material 
Manager.

There are three groups to define: Steel (or another user-defined Metal group), Slag, and 
Gas.
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It is recommended you open the PMET_01: Basic Oxygen Furnace (BOF) 
example to follow along with the descriptions. Version b is used in the 
screenshots.

Open the example project  file(s) from Thermo-Calc Help  → Example Files  → 
Process Metallurgy  → PMET_01_Basic_Oxygen_Furnace.tcu. Choose a, b, or c 
versions of the example based on whether you have a license for the TCOX 
database.

In the image below, the red-highlighted area is where the Steel material group is defined. 
The drop-down menu that displays Steel_BOF shows a user-defined material. This can be 
defined and then saved to the material library. 
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The three material group areas on the Process Metallurgy Calculator where you can define 
components and save materials. You can create your own material groups using the Material 
Manager.

When you click Show composition next to any material group, additional fields display to 
give composition and input type  where you can further define each material group. You can  
remove materials and add and remove material groups using the Material Manager 
(available on the Configuration window → Options tab).

In the example, click Show composition next to the Slag and Gas groups to see how the 
Slag_BOF and Oxygen materials are defined. 

From this composition area you can click the Save material button to add the new material 
to the group's list. The newly named material composition is then available for use with that 
material group. In this example, the Steel_BOF material was defined first and then named at 
the end. It is now available in the lists wherever you select the Steel material or need to 
choose quantities to plot. 

After defining and saving a material composition, the named material is available for selection in 
a variety of places such as when choosing quantities on the calculator and defining axis variables 
on the Plot Renderer.

To add one or more material groups click the add  button. Click the minus  
button to remove a material group. The new material inherits the default 
settings of that group.  
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Understanding the Grid Definitions Quantities and How These Relate to 
the Composition 

When you choose a One Axis or Grid Calculation Type, you also choose a Quantity under the 
Grid Definitions. The relationship between these quantities and how the material group 
composition is defined as follows.

The following uses Composition of C in Steel_LF (STEEL) as an example quantity for a One 
Axis calculation. 

Under Grid Definitions, the availability of the Quantity in the list is based on the material 
(Steel_BOF) that is defined and saved for the Steel group (or any user-defined metal, slag, or 
gas group). 

Defining the Material Composition

Click Show composition so that when you choose the Input type for a steel the composition 
of the elements can be set up using a combination of settings starting with Mass- or Mole 
percent, Mass- or Mole fraction, or for Equilibrium calculations, Absolute amount. Then you 
further choose to define the composition using either the Major component  or Normalize 
to total of 100% options. 
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The Amount of X in Y quantities you can choose from the various drop-down 
lists (such as under Grid Definitions) are defined as Min-Max variation of the 
component X in Y. If a dependent element is present that is adapted as usual.

When you use Major component, as you add other components or adjust the composition, 
the major one is adjusted to be the rest of the composition. 

When you use Normalize to total of 100%, the sum is adapted to 100%. This is useful if you 
need to work with a given composition that does not sum up to 100%.
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Sometimes its preferable to use input of amount of each component Amount by weight 
(Tonne, Kilogram, Gram, or Pound), it can useful to choose Absolute amount as the Input 
type. In this case, the total amount of material automatically adjusts the total.

For the Gas component, if you choose Normal cubic meter as the Amount, then beside 
regular mass units, the amount of gas can also be provided in Nm3. 
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Phase Groups

The phases that are plotted after you run a simulation   are grouped together on the plot to 
make the interpretation of the results easier.

Phases of similar type are bundled together in the groups liquid metal, solid metal, solid 
oxides, liquid oxides, and gas. Except for the gas phase, all the groups can have more than 
one phase. This grouping is particularly useful for liquid metal and liquid oxide because they 
are both described by the same phase, IONIQ_LIQUID, and because there is typically two or 
more compositions sets of IONIQ_LIQUID. This is also useful for solid oxides, because a large 
number of phases can be stable, making the interpretation of results difficult without this 
grouping.

The term oxides in the Process Metallurgy Module can also mean carbides, 
sulfides, and fluorides.

Example of the plot labels with the phases grouped together. As you zoom in, only the phases that 
you can see are listed in the label, making it easier to examine the results.

Slag Property Quantities

The slag properties describe the capability of a slag to take up sulfur from the metal melt. 
The Process Metallurgy Module defines so-called phase groups. These contain all phases of a 
certain kind, for example all solid slag or all slag phases. The component composition of such 
a phase group is calculated by weighting the component composition of each phase with 
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their fraction in the group.

This allows to calculate slag properties for the phase groups, for example for the overall slag.

On the Plot Renderer (for axis quantities) and Table Renderer there is an option to choose or 
define the Slag property. The associated quantity that you select has these options: All, B2, 
B3, B4, Bas2, Bells ratio, Ls, or Log10 (Sulphur capacity). 

Details, including references and equations, are described in Process Metallurgy 
Slag Properties.

Adiabatic Calculations

When setting up the Process Metallurgy Calculator under the Equilibrium Kinetics branch, 
you choose the thermal control to be either Isothermal or Adiabatic.  Adiabatic calculations 
assume no heat and mass exchange with the environment during the equilibrium reaction. 
The adiabatic process is implemented  by an isenthalpic process with constant pressure (i.e. 
H=CONST), which is equivalent. 

Adiabatic Calculations: Material Enthalpy

Gas Volume Units

Beside regular mass units, the amount of gas can also be provided in Normal cubic meter 
(Nm3). The applied reference conditions are 1013.25 hPa and 15.0 °C (according to ISO 
2533). 

There are slightly deviating definitions present in the industry, which need to be 
converted for precise results. For most applications of the Process Metallurgy 
Module this difference has a minor influence.

Calculation of Component Compositions

The composition of all ionic phases is provided as elemental as well as component 
composition (i.e. Fe2O3, FeO, CaO, …). In order to provide a representation similar to that 
usually used in the industry, the content of S is provided as elemental content and the 
content of P is given as component content of P2O5. This is a simplification because P and S 
can also be present as sulphates and phosphates in the slag and can bind to different metal 
cations. This can cause deviations in the overall component composition if the content of S 
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and P is high in the phases. In doubt, the elemental composition can be used, it will always 
be exactly correct.

For non-ionic phases such as ALABANDITE, always the elemental composition will be shown 
only. This is also true if the IONIC_LIQ composition cannot be described by components only 
due to constraints of the overall composition (for example if the material has been oxidized 
completely and forces a certain composition of the ionic liquid slag).

Definition of Partial Pressure of Oxygen

The oxygen partial pressure in the gas phase is calculated with the following formula:

In the formula, p describes the total system pressure and AC the activity of oxygen in the gas 
phase.

Activities of Slag Components

The chemical activity of each component AC(COMPONENT, REFERENCE_PHASE) is available 
either with reference to the liquid or the solid slag phase. It can only be calculated for 
components being present in the thermodynamic database.

Process Schedule

When you are working with the Process simulation branch you set up a process schedule. 
There are some useful details about this described in Working with the Process Schedule.

Dynamic Time Stepping

The nature of a Process simulation requires a dynamic choice of the time step lengths. To 
understand this better, see About Dynamic Time Stepping. These settings are done on the 
Options Tab.

Pressure-Dependent Calculations

It is possible to apply variable pressure during process metallurgical calculations, which is 
relevant in various processes such as Vacuum Oxygen Decarburization (VOD) or Ruhrstahl-
Heraeus (RH). See About Pressure-Dependent Calculations.
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Working with the Process Schedule

Defining the Process Simulation

Process Simulation: Process Schedule Tab

About Dynamic Time Stepping

Materials and heat can be added at any time in any amount. They can be either added to a:

 l bulk zone (such as steel, slag, etc.), or 
 l reaction zone (interface between two bulk zones).

These types of materials are used in the process schedule set up:

 l Material addition (in tonne, kilogram, etc.)
 l Continuous material addition (in kilogram per minute, etc.)
 l Thermal / electrical power (i.e. a continuous heat addition in MW)

A material addition is typically used to model some event like emptying a bucket into the 
melt. A continuous material addition is instead used to model a continuous material feeding 
into the melt, such as wire feeding. Finally, heat can be added or removed during a time step 
and this is defined as  power.

A Process Schedule Additions Scheme

Generally the addition of materials and heat is modeled in the process simulations  for any 
time point tn as follows:
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 l Material additions happen immediately after the previous time point tn-1, i.e. at the 
beginning of the time step.

 l Continuous material and heat additions (power) are conceptually happening during 
the complete time step between tn-1 and tn.

The data presented in the results is always referring to the time point, i.e. to the end of the 
time step. This means that reactions and heat transfer have happened between adding 
materials and heat at the beginning of the time step and the end of the time step. If for 
example a strongly cooling material is added, a possibly quite large heating of the zone 
might have happened until the end of the time step.

The first two time points are different:

 l The first time point t0 at t=0 does not represent a time step, instead only a mixing 
and equilibrium reaction of the material additions in each bulk zone is taking place. 
There are no reaction zones existing at this time point.

 l The second time point t1 represents the first time step in the simulation where the 
different bulk zones react between each other via the reaction zones. Nevertheless it 
is conceptually identical to any other time point.
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About Dynamic Time Stepping

Defining the Process Simulation

Working with the Process Schedule

Options Tab

The nature of a process simulation requires a dynamic choice of the time step lengths. On 
the one hand the simulation needs to capture very fast changes of temperature and 
composition, for example after addition of cold material. On the other hand it should 
calculate processes that take several hours in reality within an appropriate calculation time.

The time step control algorithm is primarily controlling the change of the temperature in 
each zone (including the reaction zones) such that it stays below a specified limit but is 
always as large as possible.

The dynamic time stepping can be switched off by choosing a very large maximum allowed 
temperature change per step (such as 1.0e6 K). In this case the maximum time step is always 
used, however this is only recommended in special situations.

If a temperature change is too large, the algorithm reverts the time step and returns to the 
previous time point in order to try a smaller time step. Therefore you can see in the Event 
Log output that the time points can jump back. Except for larger additions this is a rare 
event.

The parameters of the time-step control algorithm are:

 l initial time step a t=0,
 l smallest allowed time step,
 l largest allowed time step, and 
 l maximum allowed temperature change of a zone within a time step.

The initial time step as well as the largest allowed time step are defined in percent of the 
total duration of the process while the smallest allowed time step is given in seconds. This 
allows that these parameters normally need no change even if switching between processes 
with very short and very long duration.

Making the largest allowed time step bigger can reduce the number of steps and 
consequently the calculation time, but only if the time step is not limited by the maximum 
temperature change per time step. This means that both parameters need to be considered 
together.
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Taking a too large smallest allowed time step can cause numerical difficulties, especially if 
large cold material additions are part of the process schedule.

The initial time step is usually of limited relevance for the overall calculation time, but 
should usually not be larger than the default value of 1.0%.

As different processes show very different temperature changes, it is probably most 
common to adapt the maximum temperature change per time step in order to have a good 
balance between accuracy of the results and calculation time. Usually it should be possible 
to change this parameter without adapting the other algorithm parameters.

The effects of the dynamic time step algorithm can be inspected by activating the data 
points in the plots. 

To show the data points, in the Visualizations window in Thermo-Calc, right-
click in the plot area and choose Properties, then click Show data points.
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About Pressure-Dependent Calculations

Defining the Process Simulation

It is possible to apply variable pressure during process metallurgical calculations, which is 
relevant in various processes such as Vacuum Oxygen Decarburization (VOD) or Ruhrstahl-
Heraeus (RH). 

The implementation includes all relevant features for a realistic modeling of the pressure-
dependency:

 l the set pressure at a time-step is valid for all bulk and reaction zones of the system
 l the exhaust gas zone has always atmospheric pressure
 l the added material (only relevant for gas) has initially always atmospheric pressure
 l the material transferred to and from the zones (i.e. the added material and the 

exhaust gas from the zones) is undergoing an adiabatic expansion / compression 
because it is moved between different pressures

Generally there is no effect of pressure change on anything else than gas (due to physics and 
the implementation of the database).

PMET_07: Vacuum Oxygen Decarburization Kinetics
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Working with the Material Manager

Use the Material Manager to create and delete groups of materials and delete materials you 
have saved directly from the Process Metallurgy Calculator.  It is useful for frequently used 
materials.

The Material Manager is only available for the Process Metallurgy Calculator. 

Material groups created in the Material Manager display in all of the Process Metallurgy 
Calculator drop down lists, and these are also globally removed. Deleted group data 
directories are moved to the computer’s trash bin.

A material saved in any of the material configuration panels is directly accessible globally in 
the Process Metallurgy Calculator Configuration window. When a material is removed in the 
Material Manager panel it is globally removed from the Process Metallurgy Calculator.

The settings are available on the Configuration window Options Tab.

Saving a Material

This is done directly from the Process Metallurgy Calculator → Configuration window.

 1. Add the Process Metallurgy Calculator to  My Project directly (right-click and select 
it from the Create New Activity menu) or use the available Process Metallurgy 
template on the  My Projects Configuration window under Applications.

 2. On the Configuration window, next to the Material group you want to define, for 
example Steel (or another user-defined metal group), Slag, or Gas. Click Show 
composition.

 3. Enter the composition and the Major component of the material you want to save 
for future use. You can alternatively select Normalize to total of 100% and enter the 
percentages for each element. 

 4. Click Save material.

 5. In the window that opens, enter a Material name. Click OK.

When you go to the Material Manager, you can select this saved material from the 
applicable list if you need to delete it. 
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It is not possible to rename a saved material—you need to 
recreate/redefine the material and save it again with the new name.

Deleting a Material

This is done with the Material Manager, located on the Configuration window, Options tab.

 1. After Saving a Material, go to the Material Manager.

 2. Select the Material group  associated to the material saved previously, for example, 
Steel (or another user-defined metal group), Slag, or Gas.

 3. From the Material list, select the material you want to delete and click Delete 
material.

 4. In the window that opens, click Yes to delete the material and No to cancel.

Creating a Material Group

This is done with the Material Manager, located on the Configuration window, Options tab.

 1. Go to the Material Manager.

 2. Click Create group.

 3. In the window that opens, select the Material group type (Metal, Slag, or Gas) you 
want to create.

 4. Enter a Material group name. The new group is now available to select from the 
Material group list.

Deleting a Material Group

This is done with the Material Manager, located on the Configuration window, Options tab.

 1. Go to the Material Manager.

 2. From the Material group list, select the group you want to delete and click Delete 
group.

 3. In the window that opens, click Yes or No.
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Process Metallurgy Slag Properties

The slag properties describe the capability of a slag to take up sulfur from the metal melt. 
The Process Metallurgy Module defines so-called phase groups. These contain all phases of a 
certain kind, for example all solid slag or all slag phases. The component composition of such 
a phase group is calculated by weighting the component composition of each phase with 
their fraction in the group.

This allows to calculate slag properties for the phase groups, for example for the overall slag.

Various predefined slag properties such as different definitions of slag basicity, sulfur 
capacity and so forth are available for plotting or tabulating. On the Process Metallurgy 
Calculator when selecting axis variables on the Plot Renderer or choosing the properties to 
list with the Table Renderer, there is an option to include these slag properties. 

The associated quantity  selected from the next drop-down list has these options: All, B2, B3, 
B4, Bas2, Bells ratio, Ls, or Log10(Sulphur capacity). Also choose In liquid slag only, In solid 
slag only, or In all slag. Depending on this setting, the composition averaged over liquid, 
solid, or all slag is applied as a basis for the slag property calculation.

Slag properties for a Table Renderer.
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Slag properties for a Plot Renderer.

Equations and References

The equations and references for the slag properties are defined below. Composition can be 
given in mass (% or fraction).

The formulas are given in Thermo-Calc console-like syntax (B: mass, W: weight fraction, AC: 
activity). A slag property is available if all of its components are present in the phase group. 
Steel and slag are the actual phase groups chosen depending on the user request, i.e. the 
slag property can be calculated for the liquid slag only or for the overall slag (liquid and 
solid).

Basicity is defined as:
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Sulfur capacity is defined as:

References

Basicity and MgO Saturation: For definitions of the basicity and MgO saturation properties 
B2, B3, B4, and Bells ratio see [2015Kes]. Also see  the Slag Atlas [1995Ver].

Sulfur Distribution and Capacity: For definitions of the sulfur distribution properties Ls see 
[1999And]. For the sulfur capacity, see Slag Atlas [1995Ver]. 

[1995Ver] Verein Deutscher Eisenhuttenleute (VDEh), ed. 1995. Slag Atlas 2nd Edition. 
Dusseldorf, Germany: Verlag Stahleisen GmbH. 

[1999And] Andersson, Margareta A. T., Par G. Jönsson, and Mselly M. Nzotta. 1999. 
“Application Ladle Slags of the Used Sulphide Capacity Concept on High-Basicity in 
Bearing-Steel Production.” ISIJ International 39 (11): 1140–49. 

[2015Kes] Keskitalo, Björn. 2015. “Model Studies on the Effects of Composition Differences 
of Direct Reduction Pellets and an Adaptive Addition of Slag Formers for the EAF 
Process.” Master's thesis, KTH Royal Institute of Technology, 
http://urn.kb.se/resolve?urn=urn:nbn:se:kth:diva-168296.
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Adiabatic Calculations: Material Enthalpy

An adiabatic calculation requires the enthalpy of the input materials as an initial condition. 
The Process Metallurgy Module uses different approaches for the different material types 
metal, gas, and slag. Any mechanical mixture is only applied for 1 bar / 1013 hPa.

Metal

Frozen-in global equilibrium calculation at T = 700 °C, taking the resulting enthalpy at the 
actual initial material temperature. This corresponds to a frozen-in microstructure. At initial 
material temperatures above 700 °C the equilibrium is instead calculated directly.

Gas

Mechanical mixture between the enthalpy of the gas components. This is no limitation 
because all gas components in the databases are assumed to be ideal gas.

Slag
 l Mechanical mixture: If the temperature is below T=1000 °C and every single material 

component (such as MgO, CaO, …) is fully solid at the requested material 
temperature, mechanical mixture is assumed. This means that the enthalpy of every 
component is calculated separately and summed up (weighted by mass fraction). 
This corresponds to the assumption that different separate components have been 
added to the slag (such as  burnt lime and magnesite). If any component forms gas or 
liquid at the initial material temperature, this mode is not used. Note that 
mechanical mixture is also applied if pure elements are added to the slag material, 
i.e. it is not the same in respect to the material enthalpy to define CaO and Ca + O.

 l Equilibrium: If no mechanical mixture of the material components is possible or if 
the temperature is above T=1000 °C. This corresponds to the assumption of a fully 
homogenized slag material.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 612 of 763

Process Metallurgy Calculator

For information about licenses and availability, see About the Process 
Metallurgy Module.

Use a Process Metallurgy Calculator  to set up calculations for steel and slag used in 
steelmaking. Define the composition of a steel (or other metal) and slag system using 
material groups: one each for steel, slag, and gas. You can save your material compositions 
directly from the calculator and quickly access and manage the materials and groups—it 
collects groups of saved materials according to type, thus making it easy to retrieve them.

You can add the calculator to  My Project directly (right-click and select it from the Create 
New Activity menu) or use the Process Metallurgy Template.

Examples of using the Process Metallurgy Calculator for Basic Oxygen Furnace 
(BOF) (with and without kinetics), a Ladle Furnace (LF) simulation,  an Argon 
Oxygen Decarbarization (AOD), and a Vacuum Oxygen Decarborization 
(VOD) simulation are included with your installation. See the Process Metallurgy 
Module Examples Collection for links. 

You can find several learning resources on the Process Metallurgy page of our 
website (or in Thermo-Calc, go to Help → Thermo-Calc website). You can also 
subscribe to the Thermo-Calc newsletter to be kept up-to-date about upcoming 
releases, training, examples, videos and much more. 

Kinetics - Equilibrium or Process Simulation

Once you have added a Process Metallurgy Calculator, the Configuration window  is further 
branched based on the Kinetics option you choose, Equilibrium, where kinetics are not 
considered, or Process simulation, where kinetics are considered using the Effective 
Equilibrium Reaction Zone (EERZ) model. 

All settings, no matter what kinetics branch, are defined on the Configuration window 
Conditions and Options tabs.

https://www.thermocalc.com/products-services/process-metallurgy-module/
https://www.thermocalc.com/our-company/customer-newsletter-signup/
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Conditions Tab

Equilibrium

For information about the individual settings on this tab, see Equilibrium 
Simulation: Conditions Tab. 

Set the conditions for your calculation that define the slag, metal, and gas. The topic, 
Defining the Equilibrium Simulation, has instructions that walk you through the steps that 
represent a simplified steelmaking process. 

Process Simulation

For information about the individual settings on this tab, see Process Simulation: 
Conditions Tab. 

Set the conditions for your calculation that best describes the process you want to simulate. 
The topic, Defining the Process Simulation, has instructions that walk you through the steps. 
Also the description of the kinetics examples are useful to help you better understand the 
settings.

Options Tab

For information about the individual settings, see Options Tab.

Use the Material Manager to create and delete groups of materials and delete materials you 
have saved directly from the Process Metallurgy Calculator.  It is useful for frequently used 
materials. Also see Working with the Material Manager.

The settings in Process Material Equilibrium and Grid define certain numerical settings used 
by the Thermo-Calc calculation engine for equilibrium calculations such as whether tests for 
global minimization should always be performed (this significantly slows down the 
calculations) or never be performed (this speeds up calculations but miscibility gaps might 
not be found), and so forth. 
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Calculations of oxide systems are numerically challenging, and they can often 
fail. The default values are chosen to give the best general performance and 
reliability and should only be changed by an expert user. Also, a large amount 
of logic is implemented in the Process Metallurgy Module to improve the 
convergence and calculation speed of equilibrium calculations. The timestep 
control is related to how finely the times defined in the Process schedule are 
resolved. See About Dynamic Time Stepping for more information.

Local versus Global Options Settings

The Options tab is where you can locally define specific Process Metallurgy Calculator 
settings. Settings can also be applied globally from the Options window.  

To open the Options window: From the main menu select Tools → Options → 
Graphical Mode and click the Activities tab. Then click Process Metallurgy. See 
Global Settings: Process Metallurgy. 

Plots and Tables

Right-click the node to add a Plot Renderer or Table Renderer to visualize your results. 
Although both nodes work the same as with the other calculators in Thermo-Calc, there are 
additional features and settings unique to the Process Metallurgy Module. Useful 
information is included throughout the documentation. You can also read more about the 
unique features in Working with the Process Metallurgy Module.
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Defining the Equilibrium Simulation

After adding a Process Metallurgy Calculator to your project, you can choose to conduct an 
Equilibrium simulation, where you define the steel, slag, and gas groups of materials, or a 
Process simulation, where you set up a process using the EERZ (Effective Equilibrium 
Reaction Zone) model. 

The following steps are for Equilibrium simulations. If you choose to do a 
Process simulation, see Defining the Process Simulation.

This is a general overview of the setup based on the PMET_01: Basic Oxygen Furnace (BOF) 
example, which walks you through the steps that represent a simplified steelmaking process. 

1: Add the Calculator and Choose the Simulation Type

 1. Add a Process Metallurgy Calculator node to  My Projects node. If you used the 
Process Metallurgy template on the  My Projects Configuration window under 
Applications), click the node to display the Configuration settings window. 

 2. Under Kinetics, choose the simulation type, Equilibrium or Process simulation. For 
the following steps, choose Equilibrium.

2: Select a Database and Enter a Temperature

 1. In the Configuration window, for the Database selection, the program automatically 
defaults to the highest available version of the TCOX database. 

The Process Metallurgy Module requires both a valid Maintenance and 
Support Subscription (M&SS) and a license for the TCS Metal Oxide 
Solutions Database (TCOX8 or newer). 
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It is not possible to use custom user databases with the Process 
Metallurgy Module. This is because several internal calculations, such as 
determining the component compositions of ionic phases, are 
dependent on the database.  Therefore, only TCS Metal Oxide Solutions 
Database (TCOX) versions 8 and newer, and to a limited extent, 
OXDEMO, can be used with this Module. 

All users can test the Process Metallurgy Module with the included 
OXDEMO database, which is limited to these elements: Al, C, Ca, Fe, O, 
S, and Si. For more information about this and other products visit our 
website.

 2. Set the Thermal Control as being Isothermal or Adiabatic. 

 3. Select a Temperature unit (Kelvin, Celsius, or Fahrenheit) and enter a numerical 
value in the field. 

 4. Select a Pressure unit (Pascal, Atmospheres, or Bar) and then enter a numerical 
value in the field.

3: Define the Conditions for the Steel, Slag, and Gas Material Groups

Next define each material group—Steel (or any user-defined Metal group), Slag, and Gas.  

See Equilibrium Simulation: Conditions Tab for an overview of the layout of this 
section. There is also an overview of these material groups in Working with the 
Process Metallurgy Module.

 1. Choose a Material to set up first, Steel (or any user-defined metal), Slag, or Gas. 

 2. Select an Amount from the list—Tonne, Kilogram, Gram, or Pound. Enter a 
numerical value in the field.

 3. If this is the first time you are defining a material, or at any time when User-defined 
is selected, click Show composition to set the composition for the material (steel, 
slag, or gas or another user-defined metal).

https://www.thermocalc.com/
https://www.thermocalc.com/
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The composition for each material is hidden by default because the 
Module allows you to easily save materials and access these from the 
material menu. Once you save a collection of materials, you will rarely 
have to click Show composition. See Working with the Material 
Manager for details about saving and deleting materials.

 4. To the right of the Material list (e.g. for the Steel group), choose the material 
composition you want to use for this simulation.  Predefined Example Steel and 
Example Slag compositions are included with the installation. 

 l If you chose Adiabatic as the Thermal Control, also enter a temperature in 
the field for each material. This is the initial temperature before the material 
is added to the process.

 5. From the first Input type list select Mass percent, Mass fraction, Mole percent, 
Mole fraction, or Absolute amount. For Absolute amount, you can directly enter 
values in the fields in the unit selected above for Amount (Tonne, Kilogram, Gram, 
or Pound).

 6. For the next list, the default is based on which group you are defining. For the Steel 
(Metal) group it is Element, for Slag it is Component, and for Gas it is Gas 
component. 

 7. Choose Major component so that as you add other components, the major one is 
adjusted to be the rest of the composition. Choose Normalize to total of 100% so 
that the sum is adapted to 100%. This is useful if you need to work with a given 
composition that does not sum up to 100% If you select Absolute amount, 
Normalize to total of 100% is not available.

 8. Based on which material group you are working with, add the Element, Component, 
or Gas component. 

To add one or more material groups click the add  button. Click the minus  
button to remove a material group. The new material inherits the default 
settings of that group.  

 9. After you have added and defined the element, component, or gas component it is 
recommended you save and name the material. This makes it easier to work with 
because the name of the material is automatically updated in the lists (and available 
as part of your library) instead of being named User-defined everywhere. 



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 618 of 763

The material is automatically saved in the relevant material group, so only steel 
materials are shown in the steel menu, only slag materials are shown in the slag  
menu, and only gas in the gas menu. You can also create additional material groups if 
there are groups you use regularly, such as scrap compositions, ferro-alloys or slag 
additions. See Working with the Material Manager for more details about creating 
and deleting material groups and deleting materials. 

 10. Continue adding and defining the material groups (e.g. Steel, Slag, and Gas). You 
could, for example, add another Steel group if you wanted to define a composition of 
a steel scrap to add to a basic oxygen furnace (BOF). 

4: Select the Calculation Type and Associated Definitions

These settings are described more in Equilibrium Simulation: Conditions Tab.

 1. Under Calculation Type, click to choose Single (no axes), One Axis, Grid, or 
Uncertainty. 

For more complex calculations, it is good practice to start with a Single 
equilibrium calculation to make sure the calculation converges. Also see 
the settings described in Options Tab. These can be useful if your 
calculation fails.

 2. Based on the calculation type, define either the Grid Definitions (for One Axis or Grid 
calculations) or the  Sampling of Data from Gaussian Distributions (for Uncertainty 
calculations). The Quantity displays all the stepping options set up with the material 
groups for Steel, Slag, and Gas. The example shows the steel group quantities.
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The Amount of X in Y quantities you can choose from the various drop-
down lists (such as under Grid Definitions) are defined as Min-Max 
variation of the component X in Y. If a dependent element is present 
that is adapted as usual.

How these quantities relate to the material definition is described in 
Working with the Process Metallurgy Module.

5: Add and Define a Plot or Table and Run the Simulation

Once you have finished defining the Process Metallurgy Calculator, you also define the plot 
or table settings. To add a Plot Renderer or Table Renderer, right-click the calculator node 
and select an option from the Create New Successor menu.

The settings are generally described for the individual nodes. See Plot Renderer 
and Table Renderer. Some useful information about the plots is also described 
in Working with the Process Metallurgy Module.
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Equilibrium Simulation: Conditions Tab

The following outlines what you can set on the Configuration window Conditions tab when 
working with the Process Metallurgy Calculator and an Equilibrium simulation. 

Also see Defining the Equilibrium Simulation for instructions that walk you 
through the steps that represent a simplified steelmaking process. A more 
complex process is described in Defining the Process Simulation.

An example of the different settings areas for a default Configuration window  for a Process 
Metallurgy Calculator when an Equilibrium simulation type is selected. There are many settings 
available depending on the parameters. 

DATABASE

The most recent available version of TCS Metal Oxide Solutions Database (TCOX) is selected 
by default. 

The Process Metallurgy Module requires both a valid Maintenance and Support 
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database 
(TCOX8 or newer). 
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It is not possible to use custom user databases with the Process Metallurgy 
Module. This is because several internal calculations, such as determining the 
component compositions of ionic phases, are dependent on the database.  
Therefore, only TCS Metal Oxide Solutions Database (TCOX) versions 8 and 
newer, and to a limited extent, OXDEMO, can be used with this Module. 

All users can test the Process Metallurgy Module with the included OXDEMO 
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For 
more information about this and other products visit our website.

THERMAL CONTROL

Choose Isothermal or Adiabatic. When Adiabatic is selected, no global temperature is 
defined (as this changes during the process). Instead the initial temperature has to be 
defined separately for each material. Adiabatic calculations assume no heat and mass 
exchange with the environment during the equilibrium reaction. Certain types of processes 
run at almost constant temperatures. For such processes isothermal conditions are 
acceptable. But in most metallurgical processes the temperature will change sometimes 
dramatically in function of time due to heating or cooling of the system and due to 
exothermal or endothermal reactions taking place. For such processes adiabatic conditions 
are a better choice.

TEMPERATURE

Choose a Temperature unit (Kelvin, Celsius, or Fahrenheit) and then enter a numerical value 
in the field.

PRESSURE

Choose a Pressure unit (Pascal, Atmospheres, or Bar) and then enter a numerical value in 
the field.

MATERIAL GROUPS (STEEL, SLAG, AND GAS)

For more details about these fields, see Defining the Equilibrium Simulation. See 
also Working with the Material Manager.

https://www.thermocalc.com/
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There are three groups to define: Steel (or another user-defined Metal group), Slag, and 
Gas.

In the image below, the red-highlighted area is where the Steel material group is defined. 
The drop-down menu that displays Steel_BOF is a user-defined material. This can be defined 
and then saved to the material library. 

The three material group areas on the Process Metallurgy Calculator where you can define 
components and save materials.

When you click Show composition next to any material group, additional fields display (e.g. 
Input type, Major components, and so forth) where you can further define each material 
group. You can add and remove materials using the Material Manager (available via the 
Configuration window → Options tab).
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You can open the example project PMET_01: Basic Oxygen Furnace (BOF) from 
Thermo-Calc (Help → Example Files → Process Metallurgy → PMET_01_Basic_
Oxygen_Furnace.tcu). Then click Show composition next to the Slag and Gas 
groups to see how the Slag_BOF and Oxygen materials are defined.

From this composition area you can click the Save material button to add the new material 
to the group's list. The newly named material composition is then available for use with that 
material group. In this example, the Steel_BOF material was defined first and then named at 
the end. It is now automatically available wherever you select the Steel material or need to 
choose quantities to plot.

The Amount of X in Y quantities you can choose from the various drop-down 
lists (such as under Grid Definitions) are defined as Min-Max variation of the 
component X in Y. If a dependent element is present that is adapted as usual.

To add one or more material groups click the add  button. Click the minus  
button to remove a material group. The new material inherits the default 
settings of that group.  

After defining and saving a material composition, the named material is available for selection in 
a variety of places such as when choosing quantities on the calculator and defining axis variables 
on the Plot Renderer.
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CALCULATION TYPE

Click to select a Calculation Type. 

 l Single: To calculate a single point. The results from this calculation can be displayed 
in the Visualizations window using a Table Renderer. 

 l One Axis: To vary a quantity on the X-axis.
 l Grid: Evaluates two axis variables of the selected quantities in the specified range 

and number of steps.
 l Uncertainty: Evaluates calculations where the values of the quantities are sampled 

from Gaussian distributions.  The Mean field is as defined under Condition Definitions 
for the respective quantity. The result is visualized as a histogram or normal 
probability plot by adding a Plot Render activity.

Plot Types

GRID DEFINITIONS (ONE AXIS OR GRID)

The Quantity menu displays all the stepping options set up with the material groups for 
Steel (or any user-defined metal group), Slag, and Gas.

For One Axis, select a Quantity to vary along the X-axis, for example, Temperature then 
enter a Min, Max, and Number of steps. 

For the Grid calculation type, define the two axes variables using the fields and menus: 
Quantity, Min, Max, and Number of steps. The number of steps along with the minimum 
and maximum values for the axes define a grid. For each grid point the selected equilibrium 
is evaluated. 

Depending on the calculation type selected, there are also a variety of Plot 
Types to choose from.

SAMPLING OF DATA FROM GAUSSIAN DISTRIBUTIONS (UNCERTAINTY)

For the Uncertainty calculation type, click to select the applicable checkboxes under 
Quantity. The Mean field is for the distribution function as defined under Condition 
Definitions for the respective quantity. The default ΔMin/Max is a 95% confidence interval. 

About the Uncertainty Calculations
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SAMPLING PARAMETERS (UNCERTAINTY)
For the Uncertainty calculation type, choose a number of Standard deviations where you 
want to Truncate the distribution. Choose the Total number of samples. 

About the Uncertainty Calculations
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Defining the Process Simulation

After adding a Process Metallurgy Calculator to your project, you can choose to conduct an 
Equilibrium simulation, where you define the steel, slag and gas groups of materials, or a 
Process simulation, where you set up a process using the EERZ (Effective Equilibrium 
Reaction Zone) model. 

Setting Up a Process Metallurgy Simulation

The following steps are for Process simulation. If you choose to do an 
Equilibrium, see Defining the Equilibrium Simulation.

1: Add the Calculator and Choose the Simulation Type

 1. Add a Process Metallurgy Calculator node to  My Projects node. If you used the 
Process Metallurgy template on the  My Projects Configuration window under 
Applications), click the node to display the Configuration settings window. 

 2. Under Kinetics, choose the simulation type, Equilibrium or Process simulation. For 
the following steps, choose Process simulation. 

Only adiabatic conditions are available for process simulations as this 
corresponds best to most practical processes.

2: Select a Database and Enter a Temperature

Process Simulation: Conditions Tab
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 1. In the Configuration window, for the Database selection, the program automatically 
defaults to the highest available version of the TCOX database. 

The Process Metallurgy Module requires both a valid Maintenance and 
Support Subscription (M&SS) and a license for the TCS Metal Oxide 
Solutions Database (TCOX8 or newer). 

It is not possible to use custom user databases with the Process 
Metallurgy Module. This is because several internal calculations, such as 
determining the component compositions of ionic phases, are 
dependent on the database.  Therefore, only TCS Metal Oxide Solutions 
Database (TCOX) versions 8 and newer, and to a limited extent, 
OXDEMO, can be used with this Module. 

All users can test the Process Metallurgy Module with the included 
OXDEMO database, which is limited to these elements: Al, C, Ca, Fe, O, 
S, and Si. For more information about this and other products visit our 
website.

 2. Select a Temperature unit (Kelvin, Celsius, or Fahrenheit). 

 3. Select a Time unit (Seconds, Minutes, Hours, or Days).

3: Define the Process Model

Process Simulation: Process Model Settings

 1. Enter a Name for the process and the total Duration of the process.

 2. Choose a Process model from the list or click Edit Process Model to define a new 
model or edit an existing one. 

 3. In the Process model the following is defined: 

https://www.thermocalc.com/
https://www.thermocalc.com/
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 a. Pressure. This is can be either Constant throughout the process (enter a 
constant via the Edit Process Model) or be changed during the process (select 
Table input via the Edit Process Model) and then enter pressure in the 
Process schedule table.

 b. Zones of the Effective Equilibrium Reaction Zone model. Only two zones can 
be defined. The densities need to be given manually. They are used to 
calculate the volume of the reaction zones, which is in turn used for the 
calculation of the reaction kinetics. Choose to allow degassing or not.

 c. Area of the Reaction zone and mass transfer coefficients. The area is 
typically the area of the interface between the two zones. The mass transfer 
coefficients state how fast material is moved into the reaction zone. Large 
values result in fast kinetics, small numbers in slower kinetics. These values 
strongly depend on the type of material (mass transfer in slags is slower than 
in liquid steel due to its higher viscosity) and type of process (the violent 
reactions in a basic oxygen furnace have higher mass transfer coefficients 
compared to the gentle stirring performed in a ladle furnace. These 
parameters are basically fitting parameters that need to be determined based 
on comparison with experimental data. Typical values can also be found in 
the literature. Choose to allow degassing or not.

 d. Transfer of phase group. This defines how fast “foreign” phases are moved 
from one zone to the other. Foreign phases could be solid or liquid oxide 
inclusions in the liquid steel, or metallic droplets in the slag phase. A typical 
application is the simulation of the flotation of oxide inclusions out of the 
liquid steel into the slag phase during refining in a ladle furnace.

 e. The Heat entering or leaving the system and being transferred between the 
zones. Constant cooling defines how much heat is lost from the system by 
radiation and convection. Separate values can be given to each zone if 
needed. Heat is used when the system is actively heated by an external heat 
source such as an electric arc or induction heater. Here only the heating 
efficiency is given, which is the percentage of for example electrical power 
that is transferred to the system as heat. The times and power are defined in 
the Process schedule. Different amounts of heat and material are added to 
the zones resulting in the zones having different temperatures. Heat transfer 
defines how heat flows from one zone to the other. A high value results in a 
quick equalization of temperature, a small value results in the zones keeping 
their different temperatures.

4: Define the Materials

Process Simulation: Materials Tab
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The materials can be defined, saved and retrieved in the same way as for an equilibrium 
simulation. For a process simulation, it must be defined to which zone the material is added. 
Typically, oxide materials are added to the slag zone and metallic materials are added to the 
steel zone. Gas or other injected materials (such as carbon or lime powder) are typically 
added to the reaction zone. But this choice depends on the process to be simulated and 
must be carefully chosen. By defining the same material twice or even three times, it can be 
split, so that part of the material is added to one zone and part of it to another zone.

5: Define the Process Schedule

Working with the Process Schedule

Process Simulation: Process Schedule Tab

On the Process schedule tab, the sequence and amounts of additions during the duration of 
the process are defined. All the materials defined in the Materials tab automatically are 
included in the table. If a heat addition is defined in the Process Model this is also included 
in the table. If the units Tonne, Kilogram, or Pound are selected, then the additions are 
defined as one-time additions at a certain time. If a rate is chosen as unit of the addition 
(such as Kilogram per minute or Kilogram per second, for gas also Normal cubic meter per 
minute or per second can be given) then the rate of addition is entered into the table. The 
additions are visualized in a plot for clarity.

6: Run the Simulation and Add and Define a Plot or Table

When the simulation is set up, click Perform Tree to run it. Plots and tables can be added in 
the same way as for equilibrium calculations.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 630 of 763

Process Simulation: Conditions Tab

See Defining the Equilibrium Simulation for instructions that walk you through 
the steps that represent a simplified steelmaking process. A more complex 
process is described in Defining the Process Simulation and where the settings 
in the following topics are described.

Examples of using the Process Metallurgy Calculator for Basic Oxygen Furnace 
(BOF) (with and without kinetics), a Ladle Furnace (LF) simulation,  an Argon 
Oxygen Decarbarization (AOD), and a Vacuum Oxygen Decarborization 
(VOD) simulation are included with your installation. See the Process Metallurgy 
Module Examples Collection for links. 

The following outlines what you can set on the Configuration window Conditions tab when 
working with the Process Metallurgy Calculator. 

Below is based on selecting a Process simulation under Kinetics. The settings to complete 
are for the Process Model, the Materials, and the Process Schedule.

An example of the different sections on the Configuration window  for a Process Metallurgy 
Calculator when a Process simulation type is selected. This screen shot is from the example PMET_
04c. There are many settings available depending on the parameters. 
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DATABASE

The most recent available version of TCS Metal Oxide Solutions Database (TCOX) is selected 
by default. 

The Process Metallurgy Module requires both a valid Maintenance and Support 
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database 
(TCOX8 or newer). 

It is not possible to use custom user databases with the Process Metallurgy 
Module. This is because several internal calculations, such as determining the 
component compositions of ionic phases, are dependent on the database.  
Therefore, only TCS Metal Oxide Solutions Database (TCOX) versions 8 and 
newer, and to a limited extent, OXDEMO, can be used with this Module. 

All users can test the Process Metallurgy Module with the included OXDEMO 
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For 
more information about this and other products visit our website.

TEMPERATURE

Select a Temperature unit (Kelvin, Celsius, or Fahrenheit).

TIME

Select a Time unit (Seconds, Minutes, Hours, or Days).

https://www.thermocalc.com/
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Process Simulation: Process Model Settings

The following outlines what you can set on the Configuration window under 
Process and when you click Edit Process Model. The overall steps to set this up 
are described in Defining the Process Simulation.

PROCESS

Under Process, enter a Name and Duration. 

For more complex processes, you could, for example, enter the process 
reference as its Name as is done for the EERZ example PMET_06_Ladle_
Furnace_Kinetics.tcu. 

PROCESS MODEL

Choose a Process model. Click Edit Process Model to enter details as below.

You can create your own Process model and name them so these are available 
to choose from the list in the future. This is done using the Edit Process Model 
window.

Edit Process Model

To open the Edit Process Model window, click Edit Process Model to access the following 
settings.

Pressure
For Pressure,  this is can be either Constant throughout the process  or be changed during the 
process (using Table input here and then entering values in the Process Schedule). Choose:
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 l Constant to choose a  unit (Pascal, Atmospheres, or Bar) and  then enter a numerical 
value in the field. 

Only constant pressure throughout the process can be used. Also, the 
pressure only influences reactions involving the gas phase.

 l Table input to add or use the values entered in the Process Schedule table.

Zones

In this section define the material zone(s), which are added to a Zone or Reaction zone on 
the Materials tab.

Enter a Name and density (in kg/m3) for the zones.

For example, enter Steel and Slag, which in the next section are available to define for 
Zone 1 or Zone 2 in the Reaction zone.

Select the Allow degassing checkbox to be able to simulate vacuum degassing, for example.

Click the Add  button to define additional items and the Remove  button to delete 
items. 

Reactions

In this section you are defining either a Reaction zone and/or Transfer of phase group.

Select the Allow degassing checkbox to be able to simulate vacuum degassing, for example.

Click the Add  button to define additional items and the Remove  button to delete 
items. 

REACTION ZONE

If you choose  Reaction zone from the list then enter an area (in m2).

Next choose from each Zone 1 and Zone 2 list the Zone as defined above, for example Steel 
or Slag. 
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For mass transfer coefficient choose:

 l Constant to enter a numeric value in the field in m/s for each.
 l Table input to add or use the values entered in the Process Schedule table.

Reaction zone area and mass transfer coefficient defines the kinetics of the reaction 
between the two zones. A large area and fast mass transfer results in fast kinetics.

TRANSFER OF PHASE GROUP

If you choose to define a Transfer of phase group, then choose the state  as Liquid metal, 
Solid metal, All metal, Solid oxides, Liquid oxides, All oxides, or Gas.

Then choose the two zones (e.g. Steel or Slag) to define from zone and to zone. Then enter a 
value and choose a time from the list, Percent per minute or Percent per second.

This parameter defines how fast “foreign” phases are transferred from one zone to another. 
A typical example is the flotation of oxide inclusions in liquid steel up into the slag phase.

Heat

Choose the type of heat to apply to the process: Constant cooling, Heat transfer, and/or 
Heat.

Click the Add  button to define additional items and the Remove  button to delete 
items. 

CONSTANT COOLING

If you choose Constant cooling, enter a Name, choose either Zone or Reaction Zone and 
enter a numerical value in the field in  MW (megawatts). 

If you choose Zone, you can further choose either Zone defined above (e.g. Steel or Slag). If 
you choose Reaction Zone, then heat is lost from the EERZ, the size of which is calculated at 
each timestep depending on the kinetic parameters defined in Reaction Zone.

This parameter defines how much heat is lost from a zone (or the reaction zone) by radiation 
or convection and results in an overall cooling of the system.
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HEAT TRANSFER

If you choose Heat transfer, select two zones between where heat should flow and enter a  
heat transfer coefficient in Wm2/K.

As different amounts of material and also different amounts of heat can be added to the 
different zones, these temperature are different. As the two zones are in contact heat flows 
from the hotter zone to the cooler zone thus equalizing the temperature. The amount of 
heat flowing from one zone to the other is defined by the Heat transfer. A high heat transfer 
coefficient leads to fast temperature equalization, a small heat transfer coefficient results in 
the zones keeping different temperatures.

HEAT

If you choose Heat, enter a Name, then select Zone or Reaction zone, choose a Zone (e.g. 
Steel or Slag) and enter a percentage of MW efficiency in the field. 

Select Heat if the system is actively heated by an external heat source such as an electric arc 
or induction coil. Here only the efficiency is defined, which is the percentage of power (for 
example electrical power) that is transformed into heat that enters the system and heats it 
up. The profile of power versus time is defined in the Process Schedule.

Click Save when the Process Model is defined and enter a Process model name. Each time 
you save a process model it adds it to the list on the main Configuration window, which you 
can use in future set ups.
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Process Simulation: Materials Tab

The following outlines what you can set on the Configuration window 
Materials tab. The overall steps to set this up are described in Defining the 
Process Simulation.

This section is similar  to how you define the materials for the Equilibrium 
branch. Some information is explained in more detail for Equilibrium 
Simulation: Conditions Tab and not repeated here.

MATERIAL

Materials are grouped into Steel (or another user-defined Metal group), Slag (or another 
user-defined non-metallic group), and Gas.

Some of what you choose from lists in this section depend on what you have entered as the 
Process Model above. For example, the Zone or Reaction zone options are based on those 
entries (e.g Steel or Slag).

To add one or more material groups click the add  button. Click the minus  
button to remove a material group. The new material inherits the default 
settings of that group.  

After choosing the Material for the section being defined, also enter a value of the 
temperature in the field. Choose what Zone or Reaction zone it is to be Added to.

The times and amounts of additions are defined in the Process schedule.

SHOW COMPOSITION

When you click Show composition next to any material group, additional fields display  
where you can further define each material group. 
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From this composition area you can click the Save material button to add the new material 
to the group's list. The newly named material composition is then available for use with that 
material group.

From the first Input type list select Mass percent, Mass fraction, Mole percent, or Mole 
fraction.

For the next list, the default is based on which group you are defining. For the Steel (Metal) 
group it is Element, for Slag it is Component, and for Gas it is Gas component. 

Choose Major component so that as you add other components, the major one is adjusted 
to be the rest of the composition. Choose Normalize to total of 100% so that the sum is 
adapted to 100%. This is useful if you need to work with a given composition that does not 
sum up to 100%. 



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 638 of 763

Process Simulation: Process Schedule Tab

The following outlines what you can set on the Configuration window Process 
Schedule tab. The overall steps to set this up are described in Defining the 
Process Simulation. Also see Working with the Process Schedule.

On the Process schedule tab, the sequence and amounts of additions during the duration of 
the process are defined. All the materials defined in the Materials tab automatically are 
included in the table. If a heat addition is defined in the Process Model this is also included in 
the table. 

PLOT

Select the Plot checkbox to include or exclude the components in the process schedule plot 
area, for example, to help you examine the changes in the plot window, after defining the 
Steel, Scrap, Slag, or Gas rows, see what happens when you remove one or more items from 
the plot.
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UNIT

Enter a value and choose a unit Tonne, Kilogram, Pound, Kilogram per second, or Kilogram 
per minute. For Gas you can also choose Normal m3 per minute as the unit.

If a unit Tonne, Kilogram, or Pound is selected, then the additions are defined as one-time 
additions at a certain time. If a rate is chosen as unit of the addition (such as Kilogram per 
minute or second, for gas Normal cubic meter per minute or second) then the rate of 
addition is entered into the table and it stays constant until a different value is entered.
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Options Tab

These settings are for the  Process Metallurgy Calculator and are located on the 
Configuration window  → Options tab. Only unique settings are described below. 

You can change these settings locally for a specific Calculator or globally for 
some defaults in the Options window (a different location than the tab). 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode tab and the Process Metallurgy node in the tree.

Equilibrium Simulation: Conditions Tab

Material Manager

Use the Material group and Material lists to create and delete material groups, as well as 
delete material compositions that are saved from the Process Metallurgy Calculator. It is 
useful for frequently used materials.

See Working with the Material Manager for details.

 l Material group: To create or delete a group, choose it from this list, e.g. Steel, Slag, 
or Gas. The Steel group is simply a generic Metal group. You can create other user-
defined metal groups and then these are listed. Click Create group or Delete group 
as required to manage the list.

 l Material: To delete a material, choose the group type then select the material 
composition to delete. For example, select the Slag material group, then choose the 
Example Slag material and click Delete material to remove it from all lists. 
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Process Material Equilibrium and Grid

MINIMIZATION STRATEGY

Under Process Material Equilibrium and Grid, the default  uses the Global test preferred 
option for Equilibrium simulations and the Local minimization preferred option for Process 
simulations.

The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.

With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:

 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.

MAX NO. OF ITERATIONS

Under Process Material Equilibrium and Grid, the default for the Max no. of iterations is 
that the program tries 2000 iterations before it gives up. 

REQUIRED ACCURACY

The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program 
requires that the relative difference in each variable must be lower than this value before it 
has converged. A larger value normally means fewer iterations but less accurate solutions. 
The value should be at least one order of magnitude larger than the machine precision.
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SMALLEST FRACTION

Under Process Material Equilibrium and Grid, the default Smallest fraction is 1.0E-16. If this 
value fails, the program tries other values. This is the value assigned to constituents that are 
unstable. 

The default value is for all phases except for the IDEAL phase with one 
sublattice site (such as the GAS mixture phase in many databases) where the 
default value is always as 1E-30.

MAX GRID POINTS (IN GLOBAL MINIMIZATION)
Under Process Material Equilibrium and Grid, from the Max grid points list choose:

 l Coarse for 2000 grid points, the default,
 l Medium for 20,000 grid points, 
 l Fine for 200,000 grid points, or
 l Custom to set your own number of grid points.

APPROXIMATE DRIVING FORCE FOR METASTABLE PHASES

Under Process Material Equilibrium and Grid, the Approximate driving force for metastable 
phases checkbox is selected by default, which means the metastable phases are included in 
all iterations. However, these may not have reached their most favorable composition and 
thus these driving forces may be only approximate. 

FORCE POSITIVE DEFINITE PHASE HESSIAN

Under Process Material Equilibrium and Grid, the Force positive definite phase Hessian 
checkbox is selected by default and this setting determines how to reach the minimum of an 
equilibrium state.

CONTROL STEP SIZE

Under Process Material Equilibrium and Grid, the Control step size checkbox is selected by 
default and this setting determines how to reach the minimum of an equilibrium state.
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Timestep Control

This section is used with the Process simulation calculations. Read About 
Dynamic Time Stepping to better understand these settings.

TIMESTEP

Under Timestep control, enter numerical values in the fields for the Timestep:

 l Initial %
 l Smallest allowed in seconds (s)
 l Max % of duration

MAX TEMPERATURE CHANGE PER TIME STEP

Under Timestep control, in the field enter the Max temperature change per time step in 
Kelvin (K).
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Nickel Model Library Property Models
Property Model Calculator

In this section:

About the Nickel Model Library Property Models 645

About the Antiphase Boundary Energy Property Model 647

About the Coarsening Nickel Property Model 653

About the Equilibrium with Freeze-in Temperature Nickel Property Model 657

About the Solvus for Ordered Phase Property Model 665

About the Strain-Age Cracking Property Model 669
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About the Nickel Model Library Property Models

These Nickel Models are available with the Property Model Calculator and as part of the 
Nickel Model Library.

To run calculations with the Nickel Models requires a valid maintenance license 
plus licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 
and newer) databases. For some Property Models, additional recommendations 
for the database version to use is indicated in its description. Also see our 
website to learn more about the Nickel Model Library.

Antiphase Boundary Energy - Ni

The Antiphase Boundary Energy - Ni Property Model, available with the Property Model 
Calculator and the Nickel Model Library, calculates the antiphase boundary energy for the 
gamma prime (γ') phase in Ni-base alloys. 

See About the Antiphase Boundary Energy Property Model and Antiphase Boundary Energy 
Property Model Settings for background theory and input parameter details.

Coarsening - Ni

The Coarsening - Ni Property Model, available with the Property Model Calculator and the 
Nickel Model Library, calculates the coarsening rate coefficient K of one or several 
precipitate phases in a matrix phase, assuming spherical geometry of the precipitating phase
(s).

See About the Coarsening Nickel Property Model and Coarsening Nickel Property Model 
Settings.

Equilibrium with Freeze-in Temperature - Ni

The Equilibrium with Freeze-in Temperature - Ni Property Model, available with the 
Property Model Calculator and the Nickel Model Library, calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature.

See About the Equilibrium with Freeze-in Temperature Nickel Property Model and 
Equilibrium with Freeze-in Temperature Nickel Property Model Settings.

https://thermocalc.com/products/add-on-modules/nickel-model-library/
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Solvus for Ordered Phase - Ni

The Solvus for Ordered Phase - Ni Property Model, available with the Property Model 
Calculator and the Nickel Model Library, calculates the solvus of ordered phases such as 
FCC_L12, BCC_B2, NI3TA_D0A, NI3TI_D024, TCP-phases (Sigma), and so forth.

See About the Solvus for Ordered Phase Property Model and Solvus for Ordered Phase 
Property Model Settings.

Strain-Age Cracking - Ni

The Strain-Age Cracking - Ni Property Model, available with the Property Model Calculator 
and the Nickel Model Library, is used in applications related to welding or additively 
manufactured components, where there are interface strains between γ' (gamma 
prime) and the matrix. 

See About the Strain-Age Cracking Property Model and Strain-Age Cracking Property Model 
Settings.
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About the Antiphase Boundary Energy Property Model

The Antiphase Boundary Energy - Ni Property Model, available with the Property Model 
Calculator and the Nickel Model Library, calculates the antiphase boundary energy for the 
gamma prime (γ') phase in Ni-base alloys. 

Alloy strength can be assumed [2014Cru] to be proportional to the product of the antiphase 
boundary energy and the square root of the fraction of the strengthening gamma-prime 
phase.

Equilibrium is calculated with the selected phases and conditions. The antiphase boundary 
energy is then evaluated for the gamma prime phase given the equilibrium composition.

To run calculations with the Nickel Models requires a valid maintenance license 
plus licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 
and newer) databases. For some Property Models, additional recommendations 
for the database version to use is indicated in its description. Also see our 
website to learn more about the Nickel Model Library.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Antiphase Boundary Energy Property Model Settings for details.

Example

For an example, see PM_Ni_02: Antiphase Boundary Energy of γ'.
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Antiphase Boundary Energy Property Model Settings

The Antiphase Boundary Energy - Ni Property Model, available with the Property Model 
Calculator and the Nickel Model Library, calculates the antiphase boundary energy for the 
gamma prime (γ') phase in Ni-base alloys. 

About the Antiphase Boundary Energy Property Model

For an example, see PM_Ni_02: Antiphase Boundary Energy of γ'

Configuration Settings

These settings are found on the Property Model Calculator when Antiphase Boundary 
Energy - Ni is selected under Nickel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

FREEZE-IN TEMPERATURE

Enter a Freeze-in temperature value in the field. The unit matches those selected under 
Condition Definitions. This is the temperature where the equilibrium is calculated.

The default is 623.15 K (350 °C).

SUBSET OF PHASES

The Subset of phases setting allows you to select a subset of phases relevant to the material 
type under investigation. The purpose is to consider only phases relevant to typical 
commercial Ni-base alloys, for example it excludes the eta and delta phases that are 
normally thermodynamically stable at heat treatment temperatures but rarely form in 
practice due to their slow formation. Select one of these options to include the specified 
phases in the calculation:
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 l All phases: To include all phases in the current system.

 l Gamma and gamma prime only (γ and γ' only): To include only disordered FCC (γ) 
and L12 ordered FCC (γ'). 

For the Coarsening - Ni Property Model, you select Gamma and 
selected precipitate(s) instead and it still includes only disordered FCC 
(γ) and L12 ordered FCC (γ'). 

For Solvus for Ordered Phases - Ni and Strain-Age Cracking - Ni, this 
option is Gamma + Gamma Prime.

 l Typical Ni-base superalloy: To include phases typically present in Ni-base 
superalloys, i.e. liquid, gamma (γ), gamma prime (γ'), gamma double prime (γ") and 
carbides (FCC_L12#3, HCP_A3#1, HCP_A3#2, M23C6, M6C, M7C3) along with some 
additional phases (BCC_A2, BCC_A2#2, BCC_B2, BCC_B2#2, BCT_D022, NI3B_D011, 
M2B_TETR, D5A_M3B2, M3B2, MB_B33, MB2_C32, G_PHASE, NI5ZR, NI7ZR2, 
CR3NI5SI2, CR3NI5SI2, SPINEL, ALPHA_SPINEL, CORUNDUM).

 l Typical Ni-base superalloy plus eta and delta: To include the phases listed above for 
a Typical Ni-base superalloy plus eta (η) (NI3TI_D024) and delta (δ) (NI3TA_D0A) 
phases.

 l Typical Ni-base superalloy plus TCP phases: To include the phases listed above for a 
Typical Ni-base superalloy plus topologically close packed (TCP) phases. TCP phases 
are laves (C14_LAVES), sigma (σ) (SIGMA), mu (μ) (MU_PHASE), R (R_PHASE), P (P_
PHASE), Z (Z_PHASE) and CR3SI (CR3SI_A15).

EQUILIBRIUM MINIMIZATION STRATEGY

This setting is not available if Gamma and gamma-prime only is selected as the Subset of 
phases.

Select an Equilibrium minimization strategy. The default uses the Global test preferred 
option. For this Property Model, and for either Global option, also enter the Max number of 
global gridpoints, where the default is 20000.
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The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.

With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:

 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities and then choose the unit Joule per m2 or Millijoule per m2:

 l Temperature
 l APBE for 111 plane (1/2): The antiphase boundary energy for the 111-plane for the 

first γ' phase.
 l APBE for 100 plane (1/2): The antiphase boundary energy for the 100-plane for the 

first γ' phase.
 l APBE average (1/2): The average of the antiphase boundary energy for the 100- and 

111-plane for the first γ' phase.
 l APBE for 111 plane (2/2): The antiphase boundary energy for the 111-plane for the 

second γ' phase in the case more than one FCC_L12 composition set is identified as 
γ'.
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 l APBE for 100 plane (2/2): The antiphase boundary energy for the 100-plane for the 
second γ' phase in the case more than one FCC_L12 composition set is identified as 
γ'.

 l APBE average (2/2): The average of the antiphase boundary energy for the 100- and 
111-plane for the first γ' phase in the case more than one FCC_L12 composition set is 
identified as γ'.

 l Delta APBE rel.pure Ni3Al: w.r.t. Ni3Al - The antiphase boundary energy of the 111-
plane for the current γ' relative to 'pure' Ni3Al γ'.
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About the Coarsening Nickel Property Model

The Coarsening - Ni Property Model, available with the Property Model Calculator and the 
Nickel Model Library, calculates the coarsening rate coefficient K of one or several 
precipitate phases in a matrix phase, assuming spherical geometry of the precipitating phase
(s).

This model is based on the General Models → Coarsening Property Model, the primary 
difference that with the Nickel Models version you are guided to the selection of phases 
during the set up.

See About the Coarsening Property Model for the background theory described 
for the General Models version.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Coarsening Nickel Property Model Settings for details.
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Coarsening Nickel Property Model Settings

The Coarsening - Ni Property Model, available with the Property Model Calculator and the 
Nickel Model Library, calculates the coarsening rate coefficient K of one or several 
precipitate phases in a matrix phase, assuming spherical geometry of the precipitating phase
(s).

About the Coarsening Nickel Property Model

This Property Model requires a kinetic database with mobilities for the matrix 
phase.

Configuration Settings

The settings are found on the Property Model Calculator when Coarsening - Ni is selected 
under Nickel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

SUBSET OF PHASES

The Subset of phases setting allows you to select a subset of phases relevant to the material 
type under investigation. The purpose is to consider only phases relevant to typical 
commercial Ni-base alloys, for example it excludes the eta and delta phases that are 
normally thermodynamically stable at heat treatment temperatures but rarely form in 
practice due to their slow formation. Select one of these options to include the specified 
phases in the calculation:
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 l All phases: To include all phases in the current system.

 l Gamma and gamma prime only (γ and γ' only): To include only disordered FCC (γ) 
and L12 ordered FCC (γ'). 

For the Coarsening - Ni Property Model, you select Gamma and 
selected precipitate(s) instead and it still includes only disordered FCC 
(γ) and L12 ordered FCC (γ'). 

For Solvus for Ordered Phases - Ni and Strain-Age Cracking - Ni, this 
option is Gamma + Gamma Prime.

 l Typical Ni-base superalloy: To include phases typically present in Ni-base 
superalloys, i.e. liquid, gamma (γ), gamma prime (γ'), gamma double prime (γ") and 
carbides (FCC_L12#3, HCP_A3#1, HCP_A3#2, M23C6, M6C, M7C3) along with some 
additional phases (BCC_A2, BCC_A2#2, BCC_B2, BCC_B2#2, BCT_D022, NI3B_D011, 
M2B_TETR, D5A_M3B2, M3B2, MB_B33, MB2_C32, G_PHASE, NI5ZR, NI7ZR2, 
CR3NI5SI2, CR3NI5SI2, SPINEL, ALPHA_SPINEL, CORUNDUM).

 l Typical Ni-base superalloy plus eta and delta: To include the phases listed above for 
a Typical Ni-base superalloy plus eta (η) (NI3TI_D024) and delta (δ) (NI3TA_D0A) 
phases.

 l Typical Ni-base superalloy plus TCP phases: To include the phases listed above for a 
Typical Ni-base superalloy plus topologically close packed (TCP) phases. TCP phases 
are laves (C14_LAVES), sigma (σ) (SIGMA), mu (μ) (MU_PHASE), R (R_PHASE), P (P_
PHASE), Z (Z_PHASE) and CR3SI (CR3SI_A15).

EQUILIBRIUM MINIMIZATION STRATEGY

This setting is NOT available if Gamma and selected precipitate(s) is selected.

Select an Equilibrium minimization strategy. The default uses the Global test preferred 
option. For this Property Model, and for either Global option, also enter the Max number of 
global gridpoints, where the default is 20000.

The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.
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With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:

 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.

MATRIX PHASE

Choose a Matrix phase. The default is Gamma (γ).

PRECIPITATE PHASE

Choose a Precipitate phase to calculate its coarsening rate. Click the Add phase  button to 
add another Precipitate phase. Click the Remove phase  button to remove a phase.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Temperature
 l Coarsening rate coefficient Ni [m3/s] for the precipitate phase.
 l Interfacial energy Ni [J/m2] for it to be between the matrix and precipitate phase.
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About the Equilibrium with Freeze-in Temperature Nickel 
Property Model

The Equilibrium with Freeze-in Temperature - Ni Property Model, available with the 
Property Model Calculator and the Nickel Model Library, calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature.

This Property Model is based on the General Models version but specifically implemented 
for use with nickel alloys.

The assumption is that diffusion and phase transformations are negligible when changing 
from the freeze-in-temperature and, therefore, that the phase amounts and compositions of 
phases are kept at the evaluation temperatures.

Typically, the freeze-in occurs during cooling where equilibrium can be assumed above the 
freeze-in temperature. This is the default setting and the Equilibrium above freeze-in 
temperature checkbox is automatically selected for this model. Change this default setting 
(i.e. click to clear the checkbox) when the frozen structure should be evaluated at a higher 
temperature than the freeze-in temperature.

The electrical resistivity due to phase interface scattering is evaluated as the scattering 
constant times sum of the interaction between the volume fraction of all the phases. The 
default value for the constant is 4.0e-8 Ωm. The contribution to thermal conductivity is 
assumed to be related to that of electrical resistivity, following the Wiedemann-Franz law.

A selection of homogenization functions is available for the evaluation of thermal- and 
electric-properties. Thermal and electric properties depend on the microstructure and the 
geometrical representation of phases in the microstructure can be linked to different 
homogenization functions. The homogenization function is applied on thermal- and 
electrical-resistivity. The electric conductivity, thermal conductivity, and thermal diffusivity 
are evaluated from the resistivities.

To run calculations with the Nickel Models requires a valid maintenance license 
plus licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 
and newer) databases. For some Property Models, additional recommendations 
for the database version to use is indicated in its description. Also see our 
website to learn more about the Nickel Model Library.

https://thermocalc.com/products/add-on-modules/nickel-model-library/
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Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Equilibrium with Freeze-in Temperature Nickel Property Model Settings.

Example

For an example see PM_Ni_01: Lattice Parameter of γ/γ'.

References

[1985Nat] M. V. Nathal, R. A. Mackay, R. G. Garlick, Temperature dependence of γ-γ’ lattice 
mismatch in Nickel-base superalloys. Mater. Sci. Eng. 75, 195–205 (1985).

[2019Goo] A. J. Goodfellow, L. R. Owen, K. A. Christofidou, J. Kelleher, M. C. Hardy, H. J. 
Stone, The Effect of Temperature and Mo Content on the Lattice Misfit of Model Ni-
Based Superalloys. Metals (Basel). 9, 700 (2019).
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Equilibrium with Freeze-in Temperature Nickel Property Model 
Settings

The Equilibrium with Freeze-in Temperature - Ni Property Model, available with the 
Property Model Calculator and the Nickel Model Library, calculates equilibrium at the 
freeze-in temperature and evaluates the properties at a different temperature.

About the Equilibrium with Freeze-in Temperature Nickel Property Model

For an example, see PM_Ni_01: Lattice Parameter of γ/γ'

Configuration Settings

The settings are found on the Property Model Calculator when the Equilibrium with Freeze-
in Temperature - Ni Model is selected under Nickel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

FREEZE-IN TEMPERATURE

Enter a Freeze-in temperature value in the field. The unit matches those selected under 
Condition Definitions. This is the temperature where the equilibrium is calculated.

The default is 1273.15 K (1000 °C).

EQUILIBRIUM ABOVE FREEZE-IN TEMPERATURE

The Equilibrium above freeze-in temperature checkbox is selected by default and it 
calculates equilibrium above freeze-in temperature. Click to clear the checkbox when 
evaluating the frozen-in structure at higher temperatures than the freeze-in temperature.
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SUBSET OF PHASES

The Subset of phases setting allows you to select a subset of phases relevant to the material 
type under investigation. The purpose is to consider only phases relevant to typical 
commercial Ni-base alloys, for example it excludes the eta and delta phases that are 
normally thermodynamically stable at heat treatment temperatures but rarely form in 
practice due to their slow formation. Select one of these options to include the specified 
phases in the calculation:

 l All phases: To include all phases in the current system.

 l Gamma and gamma prime only (γ and γ' only): To include only disordered FCC (γ) 
and L12 ordered FCC (γ'). 

For the Coarsening - Ni Property Model, you select Gamma and 
selected precipitate(s) instead and it still includes only disordered FCC 
(γ) and L12 ordered FCC (γ'). 

For Solvus for Ordered Phases - Ni and Strain-Age Cracking - Ni, this 
option is Gamma + Gamma Prime.

 l Typical Ni-base superalloy: To include phases typically present in Ni-base 
superalloys, i.e. liquid, gamma (γ), gamma prime (γ'), gamma double prime (γ") and 
carbides (FCC_L12#3, HCP_A3#1, HCP_A3#2, M23C6, M6C, M7C3) along with some 
additional phases (BCC_A2, BCC_A2#2, BCC_B2, BCC_B2#2, BCT_D022, NI3B_D011, 
M2B_TETR, D5A_M3B2, M3B2, MB_B33, MB2_C32, G_PHASE, NI5ZR, NI7ZR2, 
CR3NI5SI2, CR3NI5SI2, SPINEL, ALPHA_SPINEL, CORUNDUM).

 l Typical Ni-base superalloy plus eta and delta: To include the phases listed above for 
a Typical Ni-base superalloy plus eta (η) (NI3TI_D024) and delta (δ) (NI3TA_D0A) 
phases.

 l Typical Ni-base superalloy plus TCP phases: To include the phases listed above for a 
Typical Ni-base superalloy plus topologically close packed (TCP) phases. TCP phases 
are laves (C14_LAVES), sigma (σ) (SIGMA), mu (μ) (MU_PHASE), R (R_PHASE), P (P_
PHASE), Z (Z_PHASE) and CR3SI (CR3SI_A15).
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EVALUATE FOR A SINGLE PHASE ONLY

Select the Evaluate for a single phase only checkbox to evaluate the properties of a specific 
phase or deselect to evaluate the properties for the entire system.

PHASE FOR EVALUATION

This setting is available when the Evaluate for a single phase only checkbox is selected.

From the Phase for evaluation list, select any available phase or None.

EQUILIBRIUM MINIMIZATION STRATEGY

This setting is NOT available if Gamma and selected precipitate(s) is selected.

Select an Equilibrium minimization strategy. The default uses the Global test preferred 
option. For this Property Model, and for either Global option, also enter the Max number of 
global gridpoints, where the default is 20000.

The Minimization Strategy setting is used to ensure that the most stable minimum under 
the specified conditions is computed.

With either the Global test preferred or Local minimization preferred setting, the program 
cycles through options before it gives up:

 l For Global test preferred the minimization starts with a global test and if that fails it 
runs full global minimization.

 l For Local minimization preferred  the minimization starts with a local minimization, 
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries 
the one setting and gives up if it fails.

For general information about global minimization, see the topic related to the 
Console Mode command, GLOBAL_MINIMIZATION.
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HOMOGENIZATION FUNCTION

The Homogenization function is used for the evaluation of the systems thermal and electric 
properties. The function is applied on thermal- and electrical-resistivity. The electric 
conductivity, thermal conductivity, and thermal diffusivity are evaluated from the 
resistivities.

The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical 
shells of each phase.

 l Rule of mixtures (upper Wiener bound): the geometrical interpretation are 
continuous layers of each phase parallel with the direction of evaluation of the 
property.

 l Inverse rule of mixtures (lower Wiener bound): The geometrical interpretation are 
continuous layers of each phase orthogonal to the direction of evaluation of the 
property.

 l General lower Hashin-Shtrikman bound: The outermost shell consists of the phase 
with the most sluggish property.

 l General upper Hashin-Shtrikman bound: The innermost shell consists of the phase 
with the most sluggish property.

 l Hashin-Shtrikman bound with majority phase as matrix phase: The outermost shell 
consists of the phase with the highest local volume fraction.

ACCOUNT FOR PHASE INTERFACE SCATTERING

The Account for phase interface scattering checkbox is selected by default.

The electrical resistivity due to phase interface scattering is evaluated as the scattering 
constant times sum of the interaction between the volume fraction of all the phases. The 
default value for the constant is 4.0e-8 Ωm. The contribution to thermal conductivity is 
assumed to be related to that of electrical resistivity, following the Wiedemann-Franz law.

PHASE INTERFACE SCATTERING CONSTANT

This setting is available when the Account for phase interface scattering checkbox is 
selected.

The Phase interface scattering constant default value is 4.0e-8 Ωm.
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SET REFERENCE TEMPERATURE FOR TECHNICAL CTE

This setting is available when the Account for phase interface scattering checkbox is 
selected.

In the field, enter the Reference temperature for technical CTE, where CTE is the coefficient 
of thermal expansion. Typically room temperature is used as the default 293.15 K (20 °C).

DEFINE USER FUNCTIONS

Select the Define user functions checkbox to enter up to two User-defined functions using 
the Console Mode syntax.

For an example of user-defined functions, see T_07: User-Defined Functions.

Dot derivatives (e.g. Hm.T for heat capacity) should NOT be used since these 
are not consistent with freezing in the amount of phases.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Temperature
 l Lattice parameter Gamma (γ) ( ): Choose a unit Meter, Micrometer, Nanometer, or 

Ångström.
 l Lattice parameter Gamma-Prime (γ') ( ): Choose a unit Meter, Micrometer, 

Nanometer, or Ångström.
 l Lattice mismatch Gamma/Gamma-Prime (γ/γ'): This is an unconstrained misfit 

between Gamma/Gamma-prime lattice parameters:

 l Electric resistivity (ohm m) (Ωm)
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 l Electric conductivity (S/m)
 l Thermal conductivity (W/(mK))
 l Thermal resistivity (mK/W)
 l Thermal diffusivity (m2/s)
 l Heat capacity (J/mol K))
 l Volume (m3/mol)
 l Density (g/cm3)
 l Linear CTE (technical) (1/K): Fractional change of length per unit temperature 

change. Calculated as (L1-L0)/(T1-T0)/L0, where L0 is the length at a reference 
temperature T0. T0 is by default equal to room temperature. Assumed Isotropic 
material.

 l Linear CTE (physical) (1/K): Fractional change of length per unit temperature change. 
Assumed Isotropic material.

 l Volumetric CTE (physical) (1/K): Fractional change of volume per unit temperature 
change.

 l User-defined function and 2nd user-defined function: Available when the Define 
user functions checkbox is selected and the functions are defined.
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About the Solvus for Ordered Phase Property Model

The Solvus for Ordered Phase - Ni Property Model, available with the Property Model 
Calculator and the Nickel Model Library, calculates the solvus of ordered phases such as 
FCC_L12, BCC_B2, NI3TA_D0A, NI3TI_D024, TCP-phases (Sigma), and so forth.

The Model chooses the correct composition set by minimizing the Gibbs energy, which 
means that the correct composition set is automatically detected by the software for you.

The remarkable properties of Ni-base superalloys often rely on the formation of finely 
dispersed ordered phases. In order to obtain the correct microstructure, and therefore also 
the properties you want, it is necessary to heat treat the alloy accordingly. One important 
aspect of the heat treatment is the solvus temperature for the phase or phases that is 
expected and wanted in the microstructure. An appropriate heat treatment aims to dissolve 
the ordered phases in the as-cast or as-printed structure, which must be done above the 
respective phases' solvus temperature.

By combining the Solvus for Ordered Phase - Ni model with the latest TCS Ni-based 
Superalloys Database (TCNI) version, you can predict the solvus temperature for any ordered 
phase, provided that it is present in the database and that it is stable for the given alloy 
chemistry. As such, appropriate heat treatments may readily be designed with guidance 
from thermodynamic calculations, which efficiently cuts down on time spent using trial-and-
error approaches.

To run calculations with the Nickel Models requires a valid maintenance license 
plus licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 
and newer) databases. For some Property Models, additional recommendations 
for the database version to use is indicated in its description. Also see our 
website to learn more about the Nickel Model Library.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Solvus for Ordered Phase Property Model Settings for details.

Example

For an example, see PM_Ni_03: Critical Temperatures of Alloy 718.

https://thermocalc.com/products/add-on-modules/nickel-model-library/
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Solvus for Ordered Phase Property Model Settings

About the Solvus for Ordered Phase Property Model

Configuration Settings

The settings are found on the Property Model Calculator when Solvus for Ordered Phase- Ni 
is selected under Nickel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

NAMING CONVENTION

Select Conventional phase names (the default) or Explicit phase names.

Select Conventional phase names to limit the list to commonly occurring ordered phases, 
which are Gamma prime (FCC_L12), Gamma double prime (BCT_D022), Eta (NI3TI_D024), 
Delta (NI3TA_D0A), and Sigma (SIGMA). You can alternatively select a phase from the full 
list of Explicit phase names; phases available in the list are based on the selected database.

PHASE TO CALCULATE SOLVUS FOR

From the Phase to calculate solvus for list, choose a phase. When Conventional phase 
names is selected Gamma prime (FCC_L12) is the default.

Phases such as FCC_L12 and BCC_B2 normally exhibit ordering (when used with the TCS Ni-
based Superalloys Database (TCNI)).

SUBSET OF PHASES

The Subset of phases setting allows you to select a subset of phases relevant to the material 
type under investigation. The purpose is to consider only phases relevant to typical 
commercial Ni-base alloys, for example it excludes the eta and delta phases that are 
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normally thermodynamically stable at heat treatment temperatures but rarely form in 
practice due to their slow formation. Select one of these options to include the specified 
phases in the calculation:

 l All phases: To include all phases in the current system.

 l Gamma and gamma prime only (γ and γ' only): To include only disordered FCC (γ) 
and L12 ordered FCC (γ'). 

For the Coarsening - Ni Property Model, you select Gamma and 
selected precipitate(s) instead and it still includes only disordered FCC 
(γ) and L12 ordered FCC (γ'). 

For Solvus for Ordered Phases - Ni and Strain-Age Cracking - Ni, this 
option is Gamma + Gamma Prime.

 l Typical Ni-base superalloy: To include phases typically present in Ni-base 
superalloys, i.e. liquid, gamma (γ), gamma prime (γ'), gamma double prime (γ") and 
carbides (FCC_L12#3, HCP_A3#1, HCP_A3#2, M23C6, M6C, M7C3) along with some 
additional phases (BCC_A2, BCC_A2#2, BCC_B2, BCC_B2#2, BCT_D022, NI3B_D011, 
M2B_TETR, D5A_M3B2, M3B2, MB_B33, MB2_C32, G_PHASE, NI5ZR, NI7ZR2, 
CR3NI5SI2, CR3NI5SI2, SPINEL, ALPHA_SPINEL, CORUNDUM).

 l Typical Ni-base superalloy plus eta and delta: To include the phases listed above for 
a Typical Ni-base superalloy plus eta (η) (NI3TI_D024) and delta (δ) (NI3TA_D0A) 
phases.

 l Typical Ni-base superalloy plus TCP phases: To include the phases listed above for a 
Typical Ni-base superalloy plus topologically close packed (TCP) phases. TCP phases 
are laves (C14_LAVES), sigma (σ) (SIGMA), mu (μ) (MU_PHASE), R (R_PHASE), P (P_
PHASE), Z (Z_PHASE) and CR3SI (CR3SI_A15).

Advanced Settings

Click the Advanced settings checkbox to edit the following settings.
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UPPER AND LOWER TEMPERATURE SEARCH LIMITS (K)

The search for the solvus temperature is performed between the upper and lower limits. 
Enter values for the Upper temperature search limit (K) (default is 2000 K) and Lower 
temperature search limit (K) (default is 500 K).

FIRST AND SECOND SUBLATTICES FOR ORDERING

Depending on the phase model for the selected phase, different sets of sublattices can be 
used to model ordering. For example, the ordering of FCC_L12 in the TCS Ni-based 
Superalloys Database (TCNI) occurs on sublattice 1 and 2. Enter a number for the First 
sublattice for ordering (default is 1) and Second sublattice for ordering (default is 2).

NUMBER OF DECIMALS

Ordering reactions may be continuous and it is necessary to set a numerical precision. This is 
because the difference in site occupancy in ordered and disordered phases may be small. 
Enter a Number of decimals at which to truncate the site fractions (default is 7).

MAX NUMBER OF ITERATIONS

Limits the number of iterations. Enter any value in the Max. number of iterations field that 
is greater than 0. The default is 100.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Select from these plot quantities:

 l Composition
 l Solvus temperature
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About the Strain-Age Cracking Property Model

The Strain-Age Cracking - Ni Property Model, available with the Property Model Calculator 
and the Nickel Model Library, is used in applications related to welding or additively 
manufactured components, where there are interface strains between γ' (gamma 
prime) and the matrix. 

To run calculations with the Nickel Models requires a valid maintenance license 
plus licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 
and newer) databases. For some Property Models, additional recommendations 
for the database version to use is indicated in its description. Also see our 
website to learn more about the Nickel Model Library.

For best results with this Property Model and the features it uses, it is 
recommended to use TCNI version 12 and newer. 

Strain-age cracking (SAC) may occur in welded or additively manufactured components due 
to interface strains between γ' (gamma prime) and the matrix. The interface strain may be 
quantified as a misfit parameter, i.e.  

where  is the lattice parameter of each respective phase (γ matrix or γ') in conjunction with 
residual thermal stresses from welding or additive manufacturing. Strain-age cracking may 
occur at negative values of the misfit parameter in combination with thermal stresses and 
the risk for cracking is also related to the γ' volume fraction.

Misfit strain naturally varies with temperature (thermal expansion) and phase composition 
(molar volume depends on composition and temperature) and therefore an accurate 
assessment of the strain-age cracking risk must account for these variables. When defining 
this Model on the Configuration window, this is managed using either a Single temperature 
or Temperature interval mode.

https://thermocalc.com/products/add-on-modules/nickel-model-library/
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Single Temperature Mode

When using the Single temperature mode, the model evaluates the misfit parameter at the 
temperature and composition specified. By stepping in temperature or composition (or 
both), it is possible to get an idea of how the misfit varies. Misfit values calculated using this 
mode can be compared with experiment but it is necessary to remember that comparisons 
are only valid if experimental data are taken from fully equilibrated alloys.

Temperature Interval Mode

The Temperature interval mode circumvents the issue of having to compare with fully 
equilibrated alloys. It provides a single parameter to describe the tendency for strain-age 
cracking. When using this mode, the Model searches for a temperature interval, between 
the lower limit (this is the Temperature set under Condition Definitions) and the upper limit 
(by default the calculated  γ' solvus, which can also be changed by using the Set maximum 
temperature checkbox), where the misfit parameter becomes negative. 

The misfit value, and the γ' volume fraction is then integrated over the interval where the 
misfit is negative and the risk value for strain-age cracking is thereafter calculated.

Values of the SAC risk factor close to or below 0 indicate low or no risk for strain-age 
cracking. Positive values indicate risk for cracking and the more positive the value, the higher 
the risk. The risk factor, as defined here, also incorporates all thermodynamically related 
factors for strain-age cracking and makes it possible to differentiate the SAC risk for various 
alloys using a single number for any given temperature interval.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Strain-Age Cracking Property Model Settings for details.

Example

For an example, see PM_Ni_04: Strain Age Cracking (SAC).

Reference

[2024Kap] B. Kaplan, A comprehensive model for quantitatively predicting the comparative 
Strain-Age Cracking risk in welded or additively manufactured Ni-base superalloys. In 
press, Mater. Today Commun., 40, 109408 (2024). 
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Strain-Age Cracking Property Model Settings

The Strain-Age Cracking - Ni Property Model, available with the Property Model Calculator 
and the Nickel Model Library, is used in applications related to welding or additively 
manufactured components, where there are interface strains between γ' (gamma 
prime) and the matrix. 

Strain-Age Cracking Property Model Settings

For an example, see PM_Ni_04: Strain Age Cracking (SAC).

Configuration Settings

These settings are found on the Property Model Calculator when Strain-Age Cracking - Ni is 
selected under Nickel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

SUBSET OF PHASES

The Subset of phases setting allows you to select a subset of phases relevant to the material 
type under investigation. The purpose is to consider only phases relevant to typical 
commercial Ni-base alloys, for example it excludes the eta and delta phases that are 
normally thermodynamically stable at heat treatment temperatures but rarely form in 
practice due to their slow formation. Select one of these options to include the specified 
phases in the calculation:

 l All phases: To include all phases in the current system.

 l Gamma and gamma prime only (γ and γ' only): To include only disordered FCC (γ) 
and L12 ordered FCC (γ'). 
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For the Coarsening - Ni Property Model, you select Gamma and 
selected precipitate(s) instead and it still includes only disordered FCC 
(γ) and L12 ordered FCC (γ'). 

For Solvus for Ordered Phases - Ni and Strain-Age Cracking - Ni, this 
option is Gamma + Gamma Prime.

 l Typical Ni-base superalloy: To include phases typically present in Ni-base 
superalloys, i.e. liquid, gamma (γ), gamma prime (γ'), gamma double prime (γ") and 
carbides (FCC_L12#3, HCP_A3#1, HCP_A3#2, M23C6, M6C, M7C3) along with some 
additional phases (BCC_A2, BCC_A2#2, BCC_B2, BCC_B2#2, BCT_D022, NI3B_D011, 
M2B_TETR, D5A_M3B2, M3B2, MB_B33, MB2_C32, G_PHASE, NI5ZR, NI7ZR2, 
CR3NI5SI2, CR3NI5SI2, SPINEL, ALPHA_SPINEL, CORUNDUM).

 l Typical Ni-base superalloy plus eta and delta: To include the phases listed above for 
a Typical Ni-base superalloy plus eta (η) (NI3TI_D024) and delta (δ) (NI3TA_D0A) 
phases.

 l Typical Ni-base superalloy plus TCP phases: To include the phases listed above for a 
Typical Ni-base superalloy plus topologically close packed (TCP) phases. TCP phases 
are laves (C14_LAVES), sigma (σ) (SIGMA), mu (μ) (MU_PHASE), R (R_PHASE), P (P_
PHASE), Z (Z_PHASE) and CR3SI (CR3SI_A15).

CHOOSE MODE

The Strain-Age Cracking (SAC) risk can be evaluated for a single temperature or for a 
specified temperature interval.

For background information about these settings, see Strain-Age Cracking 
Property Model Settings.

From the Choose mode list, select Temperature interval or Single temperature. 

For Temperature interval the following limits are applied and defined with additional 
settings: 
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 l The lower limit Temperature is set under Condition Definitions. 
 l The upper limit is by default the γ' solvus temperature. You can also select the Set 

maximum temperature checkbox to enter a user defined maximum temperature.

SET MAXIMUM TEMPERATURE

Available when Temperature interval is selected as the mode. 

The Strain-Age Cracking (SAC) risk is evaluated between the temperature specified in 
conditions and the γ' solvus. 

Select the Set maximum temperature checkbox if a lower maximum temperature than the 
γ' solvus is required and thus to skip the γ' solvus calculation. 

MAXIMUM TEMPERATURE

Available when Temperature interval is selected as the mode and the Set maximum 
temperature checkbox is selected. 

Limit the search for a negative misfit to the Maximum temperature entered in the field. 

This should be below the γ' solvus temperature.

INITIAL STEP SIZE FOR SEARCH

Available when Temperature interval is selected as the mode. 

The search for a negative misfit parameter is initiated with the step size entered in the Initial 
step size for search field. 

If convergence issues arise, it can be useful to adjust this parameter and 
increase (or decrease) the lower temperature limit.

Plot Renderer Settings

Plot Renderer and Configuration Settings
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When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Depending on the set up, there are a variety of plot quantities available to choose from. For 
example, select from these plot quantities:

 l Temperature
 l Composition
 l SAC risk factor
 l Solvus of FCC_L12 (gamma prime)
 l Misfit value at current temperature
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Noble Metal Alloys Model Library Property 
Models

Property Model Calculator

In this section:

About the Noble Metal Alloys Model Library Property Models 676

About the Optical Properties - Noble Property Model 677
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About the Noble Metal Alloys Model Library Property 
Models

These Noble Metal Alloys Models are available with the Property Model Calculator and as 
part of the Noble Metal Alloys Model Library.

The General Models  are available to all users. To run calculations with the 
Noble Metal Alloys Models (as part of the Noble Metal Alloys 
Model Library) requires a valid maintenance license plus a license for the 
TCNOBL (version 3 and newer) database. 

Optical Properties - Noble

The Optical Properties - Noble Property Model, available with the Property Model 
Calculator and the Noble Metal Alloys Model Library, is used to simulate the color, 
reflection, and transmission of light, based on modeling the alloy microstructure and the 
resulting optical properties. 

See About the Optical Properties - Noble Property Model and Optical Properties - Noble 
Property Model Settings for background theory and input parameter details.
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About the Optical Properties - Noble Property Model

The Optical Properties - Noble Property Model, available with the Property Model 
Calculator and the Noble Metal Alloys Model Library, is used to simulate the color, 
reflection, and transmission of light, based on modeling the alloy microstructure and the 
resulting optical properties. 

For an example see PM_Noble_01: Color Prediction.

In the text CIE is the abbreviation for Commission internationale de l'éclairage 
(International Commission on Illumination), which is the international authority 
on light, illumination, color, and color spaces.

To run calculations with the Noble Metal Alloys Models (as part of the Noble 
Metal Alloys Model Library) requires a valid maintenance license plus a license 
for the TCNOBL (version 3 and newer) database. 

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Optical Properties - Noble Property Model Settings

Background

The Optical Properties - Noble model simulates the color and optical properties such as 
refractive index  and extinction coefficient  for a given condition. The process to simulate 
those properties has four steps.

The first step is to calculate the composition and phase fractions for phases using the 
Equilibrium Calculator. Once that is done, you calculate the dielectric function  of an 
alloy: 
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where  is the complex dielectric function of wavelength,  is the real part of the 
dielectric function, representing the material’s ability to polarize in response to an electric 
field, thus affecting refraction, and  is the imaginary part of the dielectric function, 
representing the energy loss or absorption in the material. 

Thermo-Calc calculates the dielectric functions of FCC_A1 and L12_FCC phases with different 
Al, Au, Ag, Cu, and Pt content. The TCS Noble Metal Alloys Database (TCNOBL) calculates 
dielectric functions that cover intermetallic phases AL2CU_C16, AL3NI2 (PT)_D513, ALPT_
B20, CUPT_L11, AL2AU_C1_CAF2, PTAL2, and CU9AL4. For alloys containing multiple phases, 
the Bruggeman model  [2001Mar] is adopted to get the effective dielectric functions based 
on the phase fraction and dielectric functions of each individual phase. For N different 
phases, the generalized Bruggeman model equation is:

[Eq. 1]         

Where:

 l  is the dielectric function of the i-th phase.

 l  is the volume fraction of the i-th phase, and 
 l  is the effective dielectric constant of the composite material.

The third step is obtaining refractive index  and  from dielectric functions using Eq. 2 and 
Eq. 3.

[Eq. 2]         

[Eq. 3]         

 and  are the real and imaginary parts of dielectric functions, respectively.

The fourth step is to calculate reflectivity of the material using Fresnel equations (Eq. 4 and 
Eq. 5) [2023Gri], which describes how much light is reflected and transmitted when it strikes 
from material 1 to the surface of material 2 at a specific angle. For light striking the surface 
at an oblique angle , the Fresnel equations differ for s-polarized and p-polarized light. For 
more complex situations such as thin films and multiple materials layers, the transfer matrix 
method (TMM) is used [2016Byr]:

[Eq. 4]         

[Eq. 5]         
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Where:

 l : The reflectance for s-polarized light.

 l : The reflectance for p-polarized light.
 l : The complex refractive index of material 1 (include real and imaginary part). In 

the current version material 1 is set to be air.
 l : The complex refractive index of material 2 (include real and imaginary part).
 l : The angle of incidence (angle between the incident light and the normal to the 

surface).
 l : The transmission angle (or angle of refraction), calculated using Snell’s law: 

.

The last step is to calculate the color coordinates by using the CIE XYZ color space and 
integrating over the visible spectrum  [2019Pra]:

[Eq. 6]         

[Eq. 7]         

[Eq. 8]         

Where:

 l  is the reflectance of the material as a function of wavelength , where it is 
calculated using the calculated materials  and  and Fresnel equations.

 l  is the spectral power distribution of the illuminant (for example, the CIE D65 
illuminant represents average daylight).

 l  , , and  are the CIE color-matching functions that model the human eye’s 
response to different wavelengths of light.

 l  is the differential element over the visible spectrum (400 nm to 700 nm).
 l  is a normalization constant chosen so that Y = 100 for a perfectly reflective 

material.

Finally,  the tristimulus values for the color of the material is found and based on its 
reflectance spectrum. 
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You can further convert these tristimulus values into other color spaces, such as 
CIE LAB or sRGB, depending on the display or application requirements. See 
About Color Space.

About DeltaE (ΔE)

Delta E (ΔE, dE) is a metric to understand how the human eye perceives color difference. On 
a typical scale, the ΔE value ranges from 0 to 100. The larger the ΔE value, the more 
perceptible the color difference.

If ΔE is:

 l Smaller than 2 (ΔE < 2), it is hard to find the color difference.
 l In the range of 2 – 10, you can find the difference at a glance.
 l Between 11 and 49, colors are more similar than opposite.
 l Between 50 to 99, colors are more opposite than similar.
 l 100, colors are the exact opposite.

This is a general guideline and it is possible to get a ΔE value below 1.0 for two colors that 
appear different. This is the case with CIE 1976 and CIE 1994 formulas, in which saturation is 
either not considered or not weighted properly. For the Optical Properties Model there are 
three methods for calculating ΔE. Because of inconsistencies between the three algorithms, 
the exact meaning of ΔE changes slightly depending on which formula is used.

ΔE Method

When you select the Calculate ΔE value checkbox, an additional setting, ΔE method is 
available. This section describes the options CIE 1976, CIE 1994, and CIE 2000 (default).

Over time, several versions of ΔE have been developed to improve how accurately they 
represent human color perception. The most common versions are ΔE 1976, ΔE 1994, and 
ΔE 2000. Each one has improvements in accuracy for different use cases.

 l ΔE 1976 formula (CIE 1976) was the first standardized method to calculate color 
differences and is based on the CIE 1976 Lab color space. It uses the Euclidean 
distance between two colors in this three-dimensional space. It is simple and easy to 
compute, however it has limitations. For example, it treats all changes in color as 
being equally perceptible, even though the human eye is more sensitive to changes 
in lightness and less sensitive to changes in chroma (color saturation).
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 l ΔE 1994 CIE 1994 was introduced to address the limitations of ΔE 1976 by 
considering the non-uniformity of human color perception. It adjusts for differences 
in lightness, chroma, and hue. It is widely used in industrial applications such as 
textiles, coatings, and plastics but it still does not perfectly match human visual 
perception.

 l ΔE 2000 CIE 2000 is the most recent and accurate method to calculate color 
differences. It is designed to improve on ΔE 1994 and provides a more perceptually 
uniform color difference metric, considering additional corrections for viewing 
conditions and color perception anomalies. It is the best choice for applications 
where precise color matching is crucial.

About the Standard Illuminant

There are several options to choose from in the Standard illuminant list. These options are 
related to how the color of alloys is simulated under different lighting conditions. Each 
option represents a specific type of light source with a defined spectral power distribution 
(SPD), which describes the intensity of light at different wavelengths. The choice of 
illuminant affects the perceived color of an object.

The following is an overview of the most common standard illuminants available to select. 

 l Single wavelength: Choose this when you want to know  and  value at certain 
wavelengths. When selected, color is not calculated.

 l A: Illuminant A represents typical tungsten incandescent lighting, with a color 
temperature ~2856 K. Use case: Indoor lighting conditions.

 l B: Illuminant B represents  noon sunlight, with a color temperature ~4874 K. Use 
case: Daylight conditions with direct sunlight. Often replaced by D series illuminants.

 l C: Illuminant C represents average daylight, with a color temperature ~6774 K. Use 
case: Color matching in daylight, superseded by the D-series illuminants. 

 l Illuminant D Series represents different types of daylight with varying color 
temperatures

 l D50: ~5003 K, warm daylight at sunrise or sunset.
 l D55: ~5503 K, mid-morning or mid-afternoon daylight.
 l D65: ~6504 K, the most common standard for noon daylight conditions. This 

is the default for the Property Model. 
 l D75: ~7500 K, used for north sky daylight, that has been largely replaced by 

D65.

 l  E: Illuminant E is theoretical, equal-energy illuminant, with no color temperature as 
it is theoretical. Use case: Represents uniform energy across all visible wavelengths, 
often used in colorimetric calculations as a reference.
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 l Illuminant F Series illuminants represent various types of fluorescent lighting, 
commonly found in offices, retail environments, and other indoor spaces. The 
number after "FL" corresponds to different types of fluorescent bulbs.

 l FL1: 6430, daylight fluorescent.
 l FL2: 4230, cool white fluorescent.
 l FL3: 3450, white fluorescent.
 l FL4: 2940, warm white fluorescent.
 l FL5: 6350, daylight fluorescent.
 l FL6: 4150, light white fluorescent.
 l FL7: 6500, D65 simulator, daylight simulator.
 l FL8: 5000, D50 simulator, Sylvania F40 Design 50.
 l FL9: 4150, cool white deluxe fluorescent.
 l FL10: 5000, Philips TL85, Ultralume 50.
 l FL11: 4000, Philips TL84, Ultralume 40.

 l LED Illuminants represent different LED lighting sources, which are becoming more 
common as replacements for traditional incandescent and fluorescent lighting. They 
often focus on different spectral distributions.

 l  LED-B1 to LED-B5: Represents different types of blue-enhanced LED lights.
 l LED-BH1 defines a blend of phosphor-converted blue and a red LE.
 l LED-V1 and LED-V2: Represents different types of violet-enhanced LED lights
 l LED-RGB1: Represents RGB LED lights, where colors are mixed from red, 

green, and blue LEDs.

In summary:

 l D65 is typically used to simulate daylight when designing digital displays or 
performing color matching in industrial settings.

 l Illuminant A is used to simulate indoor lighting conditions with tungsten bulbs.
 l Fluorescent (FL series) and LED illuminants are used when you need to simulate 

environments using these artificial light sources.

About the Viewing Angle

The Viewing angle options are CIE 1931 2 Degree Standard Observer or CIE 1964 10 Degree 
Standard Observer.   
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The CIE 2° and CIE 10° Standard Observers are models that describe how an average human 
eye perceives color. They are based on experiments that measured human color vision using 
color matching functions. These functions describe how different wavelengths of light are 
combined by the human eye to match a perceived color. The main difference between the 
two observers lies in the angle of view they represent, which corresponds to different parts 
of the eye's visual field.

 l CIE 1931 2° Standard Observer model is based on experiments where subjects 
matched colors within a 2° field of view. This small angle represents the central 
vision, which is the part of the eye responsible for seeing fine detail. It is most 
accurate to view small objects or when details are seen up close, such as tiny pixels 
on a screen or small color samples.

 l CIE 1964 10° Standard Observer model represents color perception over a 10° field of 
view, a much larger area than the 2° observer. This wider field involves more of the 
peripheral vision, provides a broader and more comprehensive representation of 
how the eye perceives color in general viewing situations. This is better for 
measuring color in typical situations where larger objects are viewed, such as printed 
materials, paints, textiles, or any larger surface.

About Color Space

A color space organizes colors to ensure consistent representation across devices. The Color 
space options are used in two sets of settings and in both you have the option to choose 
LAB (default), sRGB, or XYZ. 

 l CIE LAB (the default) includes all visible colors and is ideal for color matching, quality 
control, and any application where accurate perceptual color differences matter.

 l CIE XYZ covers all perceivable colors and is best for scientific and colorimetric 
studies, where precise color representation and transformations are needed.

 l sRGB has a smaller color gamut, but it is widely used for displaying on consumer 
electronics

CIE LAB Color Space (CIE LAB)

CIE LAB was introduced by the CIE in 1976, and was designed to overcome some of the 
limitations of CIE XYZ. It created a color space that is perceptually uniform, meaning that a 
given change in color value should correspond to a similar level of perceived difference to 
the human eye.
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How it Works

 l L: Lightness (ranging from 0 for black to 100 for white).

 l a: Green-red axis (with negative values being green and positive values being red).

 l b: Blue-yellow axis (with negative values being blue and positive values being 
yellow).

When to Use It
 l Color matching and quality control: CIELAB is used extensively in industries like, 

where precise control of color is required. Like CIE XYZ, LAB is device-independent, 
meaning it can represent colors regardless of the device displaying or printing them.

 l ΔE calculations: The LAB color space is the basis for computing ΔE values, which 
measure the perceptual difference between two colors. This is important for 
ensuring that two objects have colors that match closely.

 l Easy to interpret and understand by humans: The LAB color space is designed so that 
small changes in color values are perceived by humans as approximately the same 
amount of color difference, regardless of where they occur in the color space.

Limitations

 l Not well-suited for all applications: Because LAB is not tied to specific devices, it may 
not be as effective for applications where you're working within the constraints of a 
particular display or print color gamut (e.g., in digital photography).

CIE XYZ Color Space

Developed in 1931 by the CIE, which was based on tristimulus values—X, Y, and Z—that are 
hypothetical primaries derived from human vision experiments. It aims to represent all 
visible colors using a mathematical model grounded in human color perception.

How it Works 

The Y value is designed to represent luminance, which corresponds to the brightness or 
intensity of the color, while X and Z represent the chromaticity (colorfulness) without the 
influence of brightness.
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When to Use It

Scientific research: Since CIE XYZ can represent any perceivable color, it is used in color 
science and colorimetric applications where precise color measurements are required.

 l Device-independent color reproduction: It is used as a foundational color space for 
transforming colors between different device color profiles, such as between 
monitors, printers, or cameras.

 l Converting to other color space: It's a reference color space, which makes it useful as 
an intermediary when converting colors between different color spaces.

Limitations
 l Not perceptually uniform: While it can represent all colors, it does not account for 

how humans perceive color differences. A color change of the same magnitude in 
different areas of the XYZ space might not be perceived as equally different to the 
human eye.

 l Not intuitive for users: The X, Y, and Z coordinates do not correspond to human-
perceptible properties like red, green, or blue, making it harder for non-technical 
users to interpret.

sRGB Color Space

sRGB (Standard Red Green Blue) was created by HP and Microsoft in 1996 as a standard 
color space for digital displays and the internet webpage. It is based on the typical 
capabilities of a standard CRT monitor and has become the default color space for web 
images, digital photography, and many consumer-level devices like cameras and printers.

How It Works

sRGB defines colors in terms of Red, Green, Blue, where each component can range from 0 
to 255 or 0 to 1.

When to Use It
 l Web and digital content: sRGB is the default color space for the web, and almost all 

images and digital media you encounter online are in sRGB. This ensures that content 
looks consistent across different devices.

 l Consumer-level photography. Most consumer-grade cameras shoot in sRGB, and it is 
the standard color space used by default on screens, phones, and printers.
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Limitations

sRGB covers a smaller range of colors than spaces like Adobe RGB or LAB. Highly saturated 
or vivid colors may not be represented accurately in sRGB, which can limit its usefulness for 
professional printing or design.
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Optical Properties - Noble Property Model Settings

The Optical Properties - Noble Property Model, available with the Property Model 
Calculator and the Noble Metal Alloys Model Library, is used to simulate the color, 
reflection, and transmission of light, based on modeling the alloy microstructure and the 
resulting optical properties. 

About the Optical Properties - Noble Property Model

For an example see PM_Noble_01: Color Prediction.

Configuration Settings

The settings are found on the Property Model Calculator when Optical Properties - Noble is 
selected under Noble Metal Alloys Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

Intercritical Annealing

The Intercritical annealing checkbox is selected by default. It is where the Model can either 
accept the given composition as a homogeneous FCC solid solution or perform an 
equilibrium calculation at the temperature specified under Condition Definitions to get the 
phase fractions. 

This is an important setting as intermetallic phases have a very important effect 
on the actual color of the alloy.
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 l When selected, an equilibrium calculation is performed at the specified temperature 
and the composition and uses the calculated equilibrium phase and composition for 
optical property simulation.

 l Click to clear the checkbox if the specified composition is used directly and the alloy 
contains only FCC phases without phase separation. 

Calculate ΔE Value and ΔE Method Settings

Select the Calculate ΔE value checkbox  if there is a target color and you want to know the 
difference between the calculated alloy color and targeting color. Then choose a ΔE method:  
CIE 2000 (default), CIE 1976, or CIE 1994.

See About DeltaE (ΔE) in the theory section for more background detail about 
these settings. 

Based on the ΔE method selected, further define these settings.

See About Color Space in the theory section for more detail about the options. 

 l Color space of targeting color: Select LAB (default), sRGB, or XYZ. Then define the 
index to calculate ΔE, where the range of space for each setting is: LAB [0, 100], sRGB 
[0, 1], and XYZ [0, 1].

 l Enter values into the 1st, 2nd, and 3rd index fields based on the Color space of 
targeting color selection: 

 l First index of targeting color:  X for XYZ, L for LAB, R for sRGB.
 l Second index of targeting color: Y for XYZ, a for LAB, G for sRGB.
 l Third index of targeting color: Z for XYZ, b for LAB, B for sRGB.

Incident Angle

Enter a value for the Incident angle [degree] between 0°  and 90° for the incident light angle. 
The default is 0° (normal light). Incident angle is the angle at which light strikes a surface. 
This angle is measured between the incoming light ray and the normal (a perpendicular line) 
to the surface. The incident angle plays a crucial role in determining how light interacts with 
a material, which in turn affects the perceived color of the material.
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Standard Illuminant

Select an option from the Standard illuminant list. Choose the incident light wavelength 
distribution, such as standard daylight illuminant D65 (the default).

See About the Standard Illuminant in the theory section for more detail about 
the options. 

View Angle of Observer

Select the View angle of observer: CIE 1931 2 Degree Standard Observer or CIE 1964 10 
Degree Standard Observer (the default). 

In general:

 l CIE 1931 2 Degree Standard Observer is most accurate to view small objects or 
when details are seen up close, such as tiny pixels on a screen or small color samples.

 l CIE 1964 10 Degree Standard Observer is better for measuring color in typical 
situations where larger objects are viewed, such as printed materials, paints, textiles, 
or any larger surface.

See About the Viewing Angle in the theory section for more detail about the 
options. 

Material Thickness

Enter a value for the Material thickness [nm]. The default is 10000 nm. 

This is and important setting when dealing with thin films or coatings.

Material thickness plays a significant role  especially in the context of thin films, coatings, and 
transparent or semi-transparent materials. It affects how light interacts with the material, 
influencing reflection, transmission, absorption, and interference effects, all of which 
contribute to the final perceived color of the material. For example, a several nanometer 
thin gold film may display red or orange color, and it shows gold color when the film is thick 
enough. The default thickness is 10000 nm which displays bulk properties. The calculation 
assumes the two sides of materials are both air.
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Color Space

Choose the Color space for the resulting color space index 1-3: LAB (default), sRGB, or XYZ.

See About Color Space in the theory section for more detail about the options. 

 l LAB (the default) includes all visible colors and is ideal for color matching, quality 
control, and any application where accurate perceptual color differences matter.

 l XYZ covers all perceivable colors and is best for scientific and colorimetric studies, 
where precise color representation and transformations are needed.

 l sRGB has a smaller color gamut, but it is widely used for displaying on consumer 
electronics

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

PLOT QUANTITIES

 l 24-bit color: To visualize the color, the three color channels need to be merged into a 
single value. For sRGB, 24-bit color is one way to do this. 

Merging three channels (each channel representing an independent 
axis) into a single value creates a non-linear scale. Thus, the legend 
option for the Z-axis scale can be considered irrelevant for the actual 
plot.

 l Color space index 1, Color space index 2, and Color space index 3: For the LAB, 
sRGB, and XYZ color spaces, the color is described by three values (the color 
channels). The Color space index 1, 2, and 3 result quantities correspond to these 
values, e.g., for sRGB, 1=R, 2=G, 3=B.
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 l n for single wavelength or k for single wavelength: Provides the selected part of the 
refractive index when choosing a single wavelength as the illuminant. The values of n 
and k are material properties, but they do depend on the wavelength, wherefore if a 
multiwavelength illuminant is chosen, these result quantities will give NaN.

 l ΔE value: A metric for understanding how the human eye perceives color difference. 
On a typical scale, the ΔE value ranges from 0 to 100. The larger the ΔE value, the 
more perceptible the color difference.
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Steel Model Library Property Models
Property Model Calculator

In this section:

About the Steel Model Library Property Models 693
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About the CCT Diagram Property Model 703
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About the TTT Diagram Property Model 742
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About the Steel Model Library Property Models

These Steel Models are available with the Property Model Calculator. The following are 
available with the Steel Model Library.

Also see Steel Library CCT Diagram Template, Steel Library TTT Diagram 
Template, Plot Type: CCT Mode, and Plot Type: TTT Mode.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

For the Ferrite, Bainite, and Pearlite Property Models, it is also useful to review 
the Recommended Composition Ranges for Steel Models.

Bainite

The Bainite Property Model describes the thermodynamics and isothermal kinetics of 
bainite transformation from austenite. In this Model, bainite is modeled as ferrite or a 
ferrite-cementite mixture.

See About the Bainite Property Model and Bainite Property Model Settings for background 
theory and input parameter details.

CCT Diagram

The CCT Diagram Property Model calculates the concurrent transformations to ferrite, 
pearlite, bainite, and martensite under continuous cooling conditions and is used to 
construct a continuous-cooling-transformation (CCT) diagram.

See About the CCT Diagram Property Model and CCT Diagram Property Model Settings for 
background theory and input parameter details.

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Critical Transformation Temperatures

The Critical Transformation Temperatures Property Model calculates critical transformation 
temperatures for steels.

See About the Critical Transformation Temperatures Property Model and Critical 
Transformation Temperatures Property Model Settings for background theory and input 
parameter details.

Ferrite

The Ferrite Property Model calculates the thermodynamics and isothermal kinetics of 
proeutectoid ferrite forming from austenite in hypoeutectoid steels.

See About the Ferrite Property Model and Ferrite Property Model Settings for background 
theory and input parameter details.

Martensite Fractions

The Martensite Fractions Property Model calculates the fraction of athermal martensite 
based on available driving force.

See About the Martensite Fractions Property Model and Martensite Fractions Property 
Model Settings for background theory and input parameter details.

Martensite Temperatures

The Martensite Temperatures Property Model calculates the martensite start (Ms) 
temperature based on modeling of the transformation barrier. Martensite half and finish 
temperatures are also given according to the Martensite Fractions Property Model.

See About the Martensite Temperatures Property Model and Martensite Temperatures 
Property Model Settings for background theory and input parameter details.

Martensitic Steel Strength

The Martensitic Steel Strength Property Model calculates the strength and/or hardness of 
martensitic steels.

See About the Martensitic Steel Strength Property Model and Martensitic Steel Strength 
Property Model Settings for background theory and input parameter details.
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Pearlite

The Pearlite Property Model calculates the thermodynamics and kinetics of pearlite 
formation from austenite during isothermal heat treatment.

See About the Pearlite Property Model and Pearlite Property Model Settings for background 
theory and input parameter details.

TTT Diagram

The TTT Diagram Property Model calculates the concurrent transformations to ferrite, 
pearlite, bainite, and martensite under isothermal conditions and is used to construct a 
time-temperature-transformation (TTT) diagram.

See About the TTT Diagram Property Model and TTT Diagram Property Model Settings for 
background theory and input parameter details.
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Recommended Composition Ranges for Steel Models

The Steel Property Models (a.k.a. Steel Models or just Models) included with the Steel 
Model Library in Thermo-Calc calculate the process of austenite decomposition into ferrite, 
pearlite, bainite, and martensite. These Models are developed to satisfy the needs for a 
wide range of steels and are built on the thermodynamic and kinetic descriptions in the TCS 
Steel and Fe-alloys Database (TCFE) and TCS Steels/Fe-Alloys Mobility Database (MOBFE) 
databases, which are widely validated. However, the Steel Models also include their own 
modeling approach and parameters, which may limit the applicability to certain ranges of 
compositions and temperature, often due to some underlying assumptions of the modeling 
approaches and/or availability of calibration data.

In general, the Models for ferrite, bainite, and pearlite are for low-alloy, low-to-medium 
carbon steels involving austenite (Fe-rich disordered FCC_A1) transforming into ferrite (Fe-
rich disordered BCC_A2) and cementite. For steels with higher Cr contents, it is also possible 
to select M7C3 and M23C6 to be the carbide in pearlite, and M7C3 for bainite. Otherwise, 
the Models are not designed for other phase relations, for example:

 l Austenite transforming into a mixture of ferrite and another type of carbide (e.g. 
kappa carbide for high-Mn high-Al alloys).

 l Precipitation (e.g. FCC-Cu, FCC-carbides due to microalloying elements Ti, V, Nb) 
taking place concurrently while austenite is transforming into ferrite (and possibly 
cementite).

If some other phases coexist with austenite prior to its transformation, the Steel Models 
assume these do not participate in or affect the transformations by any means (e.g. by 
providing extra nucleation sites). The only effect of these phases is to determine the 
austenite composition (which is now different from the nominal composition). In this case, 
the setting Equilibrium composition at austenitizing temperature is selected from the 
Austenite composition from list on the Configuration window.

For an explanation of Austenite composition from see the individual 
configuration settings for the different Steel Models (Ferrite, Bainite, and 
Pearlite). Links to these are listed in About the Steel Model Library Property 
Models.

Ferrite and bainite calculations rely on carbon partitioning from ferrite to austenite. 
Therefore, the Models are not suitable for the ferrite transformed from austenite in a 
"massive" manner (composition invariant), in some "interstitial-free" ferrous alloys with very 
low carbon contents.
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Pearlite is assumed to be steady-state, i.e. growth rate and lamellar spacing are constant 
over time under isothermal conditions. This is reasonable if composition and transformation 
temperature lie in the ferrite-cementite two-phase region of a phase diagram. The Pearlite 
Model does not cover the so-called "divergent pearlite", or "partitioned pearlite", which 
usually forms in the austenite-ferrite-cementite three-phase region with growth rate and 
lamellar spacing changing over time. Also, pearlite nucleation is modeled to be on austenite 
grain boundaries only. In practice, however, pearlite nucleation at grain edges and corners 
may also be considerable if the undercooling is small.

Parameters within the Steel Models are calibrated against experimental data on 
nucleation, growth, and overall transformation kinetics. However, the 
composition space covered by the calibration data, on which the Steel Models 
calculations are checked, is limited. As a result, together with the limitations 
from modeling approach discussed above, some recommended composition 
ranges are listed below. The Models may not give reasonable results when the 
composition in question is far outside the recommended ranges. 

Element Ferrite

Bainite

Pearlite3Bainite Start 
Temperature 
[2018Lea]1

Bainite Growth, 
Nucleation, 
Transformation 
Kinetics2

C Max. 0.7 Max. 0.7 0.2-1.5 0.6-1

Mn Max. 3 Max. 5.5 Max. 0.6 Max. 1.8

Ni Max. 5 Max. 9 Max. 5.3 Max. 3

Si Max. 2 Max. 2 Max. 1 Max. 2

Al Max. 1.4 – –
(unknown, 
assuming similar to 
Si)

Co Max. 3.2 – – Max. 2.2

Cr Max. 3 Max. 5.7 Max. 5 Max. 13[4]

Mo Max. 2 Max. 4 (unknown) Max. 0.6
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Element Ferrite

Bainite

Pearlite3Bainite Start 
Temperature 
[2018Lea]1

Bainite Growth, 
Nucleation, 
Transformation 
Kinetics2

W – – – Max. 0.37

1 The model is from [2018Lea]. The supporting bainite start data is compiled and published in [2019Lea].

2 Parameters are not assessed to be composition dependent. The listed composition ranges come from the data of 
growth considered in a “universal” fitting.

3 References in [2020Yan].

[4] Requires calculation setting Custom for type of carbide. Estimated boundaries: CEMENTITE for <5 wt.% Cr, M7C3 
for 5~10 wt. % Cr, M23C6 for >10 wt.% Cr.

References

[2018Lea] L. Leach, P. Kolmskog, L. Höglund, M. Hillert, A. Borgenstam, Critical Driving Forces 
for Formation of Bainite. Metall. Mater. Trans. A. 49, 4509–4520 (2018).

[2019Lea] L. Leach, P. Kolmskog, L. Höglund, M. Hillert, A. Borgenstam, Use of Fe-C 
Information as Reference for Alloying Effects on BS. Metall. Mater. Trans. A. 50, 4531–
4540 (2019).

[2020Yan] J.-Y. Yan, J. Ågren, J. Jeppsson, Pearlite in Multicomponent Steels: 
Phenomenological Steady-State Modeling. Metall. Mater. Trans. A. 51, 1978–2001 
(2020).
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About the Bainite Property Model

The Bainite Property Model, available with the Property Model Calculator and the Steel 
Model Library,  describes the thermodynamics and isothermal kinetics of bainite 
transformation from austenite. In this Model, bainite is modeled as ferrite or a ferrite-
cementite mixture.

For a given austenite composition, the bainite start temperature, WBs, is calculated 
following Leach et al. [2018Lea] (see Eqs. 8 and 9 and Table 1 in the paper). At WBs, the 
driving force for ferrite to precipitate out of austenite under the “para” condition (i.e. no 
partitioning of substitutional elements, carbon in equilibrium) is balanced by a barrier, which 
is modeled as a function of composition.

At a temperature below WBs, there is a net driving force (over the barrier) for the growth of 
bainitic ferrite. The steady-state lengthening rate of ferrite plate is calculated based on the 
method from Leach et al. [2019Lea] with modifications. In the Bainite Model, unlike in 
[2019Lea], local equilibrium of carbon at the ferrite/austenite is sought, and a finite 
interfacial friction term is added to the dissipation terms. Otherwise the two methods are 
both based on a driving-force–dissipation balance and the Zener-Hillert equation, with a 
unique lengthening rate determined by maximizing it with respect to radius of curvature at 
the plate tip.

The Bainite Model also considers the case where cementite (under the “para” condition) can 
precipitate on the ferrite/austenite interface and grow into ferrite, forming a ferrite-
cementite mixture. The formation of para-cementite usually accelerates lengthening, by 
enlarging the driving force of transformation while reducing carbon partitioning from bainite 
to austenite. Carbon partitioning to austenite vanishes if para-cementite forms in bainite to 
its maximum fraction allowed by mass balance.

Thickening of bainitic plates is usually much slower than lengthening. In the Bainite Model, it 
is assumed that whenever there is a positive driving force of precipitating para-cementite on 
the ferrite/austenite interface, the final state of the bainite transformation should be a 
mixture of ferrite and cementite, with austenite being completely transformed. Otherwise, 
the final state is a ferrite-austenite mixture with no cementite but a finite fraction of 
retained austenite (incomplete transformation).

The overall kinetics of bainite transformation is calculated in the extended-volume approach 
devised by Cahn [1956Cah] and generalized for ellipsoids. Both grain boundary (GB) 
nucleation and volume nucleation are considered, the former being very temperature-
sensitive, the latter temperature-insensitive. This is used to model the kinks at about 350 °C 
in the TTT diagrams of some medium- and high-carbon steels—At higher temperatures GB 
nucleation is predominant, whereas at lower temperatures it is effectively suppressed, and 
volume nucleation becomes significant.
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To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Bainite Property Model Settings for details.

Example

For an example, see PM_Fe_05: Fe-C-Mn-Si-Ni-Cr-Mo Bainite.

References

[1956Cah] J. W. Cahn, “The kinetics of grain boundary nucleated reactions”, Acta 
Metallurgica 4, 449–459 (1956). 

[2018Lea] L. Leach, P. Kolmskog, L. Höglund, M. Hillert, and A. Borgenstam, “Critical driving 
forces for formation of bainite”, Metallurgical and Materials Transactions A 49, 4509–
4520 (2018).

[2019Lea] L. Leach, J. Ågren, L. Höglund, and A. Borgenstam, “Diffusion-controlled 
lengthening rates of bainitic ferrite a part of the Steel Genome”, Metallurgical and 
Materials Transactions A 50, 2613–2618 (2019)

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Bainite Property Model Settings

The Bainite Property Model, available with the Property Model Calculator and the Steel 
Model Library, describes the thermodynamics and isothermal kinetics of bainite 
transformation from austenite. In this Model, bainite is modeled as ferrite or a ferrite-
cementite mixture.

Considered elements: Fe, C, Mn, Si, Cr, Ni, Mo. Other elements in the system 
are neglected for bainite by mass percent.

For the Ferrite, Bainite, and Pearlite Property Models, it is also useful to review 
the Recommended Composition Ranges for Steel Models.

About the Bainite Property Model

For an example, see PM_Fe_05: Fe-C-Mn-Si-Ni-Cr-Mo Bainite.

Configuration Settings

These settings  are found on the Property Model Calculator when Bainite is selected under 
Steel Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

AUSTENITE COMPOSITION FROM

Select an option from the Austenite composition from list:
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 l Nominal composition uses the system composition as austenite composition.
 l Equilibrium composition at austenizing temperature. Select to enter an 

Austenitizing temperature. The austenite composition is determined from an 
equilibrium calculation at the austenitizing temperature (if austenite is stable). This 
option  is useful when austenite coexists with other phase(s), e.g. primary carbide, 
before the transformation(s) being calculated starts. But the Model only considers 
the effect of other phase(s) on austenite composition.

AUSTENTIZING TEMPERATURE

This setting is available when Equilibrium composition at austenitizing temperature is 
selected from the Austenite composition from list.

Enter an Austentizing temperature in the field. The unit is the same as that selected under 
Condition Definitions.

GRAIN SIZE

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.

Plot Renderer Settings

Plot Renderer, Configuration Settings, and Plot Type: TTT Mode

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

These plot quantities are available:

 l Temperature
 l Start time (2% bainite)
 l Half time (50% bainite)
 l Finish time (98% bainite)
 l Bainite start temperature
 l Lengthening rate [m/s]
 l Cementite fraction in bainite
 l Retained austenite fraction
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About the CCT Diagram Property Model

The CCT Diagram Property Model, available with the Property Model Calculator and the 
Steel Model Library, can be used to calculate a Continuous-Cooling-Transformation (CCT) 
diagram, with a One Axis calculation on Log10(cooling rate[K/s]). This Model calculates the 
kinetics of concurrent transformation of austenite into ferrite, pearlite, bainite, and 
martensite. The algorithms and parameters for ferrite, pearlite, bainite, and martensite are 
the same as in their individual Property Models (Ferrite, Pearlite, Bainite, Martensite 
Temperatures, and Martensite Fractions), but the competitive occupation of prior austenite 
grain boundaries and bulk volume is handled in the CCT Diagram Property Model.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See  CCT Diagram Property Model Settings for details.

Example

For an example, see PM_Fe_08: CCT Diagram for Fe-C-Mn-Si-Cr-V.

CCT Diagram Property Model Settings

The CCT Diagram Property Model, available with the Property Model Calculator and the 
Steel Model Library, calculates the concurrent transformations to ferrite, pearlite, bainite, 
and martensite under continuous cooling conditions and is used to construct a continuous-
cooling-transformation (CCT) diagram.

About the CCT Diagram Property Model and Steel Library CCT Diagram Template

For an example, see PM_Fe_08: CCT Diagram for Fe-C-Mn-Si-Cr-V

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Configuration Settings

These settings are found on the Property Model Calculator when CCT Diagram is selected 
under Steel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

AUSTENITE COMPOSITION FROM

Select an option from the Austenite composition from list:

 l Nominal composition uses the system composition as austenite composition.
 l Equilibrium composition at austenizing temperature. Select to enter an 

Austenitizing temperature. The austenite composition is determined from an 
equilibrium calculation at the austenitizing temperature (if austenite is stable). This 
option  is useful when austenite coexists with other phase(s), e.g. primary carbide, 
before the transformation(s) being calculated starts. But the Model only considers 
the effect of other phase(s) on austenite composition.

AUSTENTIZING TEMPERATURE

This setting is available when Equilibrium composition at austenitizing temperature is 
selected from the Austenite composition from list.

Enter an Austentizing temperature in the field. The unit is the same as that selected under 
Condition Definitions.

GRAIN SIZE

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.

START TEMPERATURE

Enter a Start temperature, which is the temperature at time zero where cooling starts.
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END TEMPERATURE

Enter an End temperature, which is the lowest possible temperature where cooling stops. 
Cooling may also stop before reaching this temperature if austenite has fully transformed 
(>98%).

LOG10(COOLING RATE [K/S])

Enter a Log10(cooling rate [K/s]) , which is the 10-base logarithm of cooling rate in K/s.

The unit must be Kelvin per second, and it does NOT follow the unit selection in 
the GUI. This is the Axis Quantity if a CCT diagram is to be constructed.

Calculation Setting

Select Quick (the default), Accurate, or Custom to balance accuracy and calculation time. 
Choose Custom to define the numerical settings yourself, which are otherwise set in the 
background when Quick or Accurate is selected. See the separate section below about the 
details for the Custom settings.

QUICK CALCULATION SETTING

Quick is used for a relatively quick and rough calculation to reveal the general feature of a 
CCT diagram. Interpolation is used when necessary, in order to avoid calculating the growth 
rates and nucleation rates of pearlite and bainite at every time step. For simplicity, Ferrite 
mode is PE (paraequilibrium), and Pearlite mode is Para-pearlite. 

Calculation times may vary between 30 minutes and several hours.

ACCURATE CALCULATION SETTING

Accurate evaluates the growth rates and nucleation rates at every time step accurately 
(without interpolation). The time step control is also tighter than when using the Quick 
setting. 
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 l Ferrite mode is PE if possible, otherwise OE so as to handle any ortho-para 
transition. 

 l Pearlite mode is Optimal pearlite, but its rate calculation becomes slower if 
austenite contains many alloying elements. 

Calculation times may vary between several hours and tens of hours.

DETAILS ABOUT THE QUICK AND ACCURATE CALCULATION SETTINGS

When you choose Quick or Accurate as the calculation setting, the following is what is 
automatically set in the background for each of the sections. These sections are visible to 
you and also can be edited when Custom is chosen:

Setting Quick Accurate

Ferrite selected checkbox selected 
(yes) checkbox selected (yes)

Pearlite selected checkbox selected 
(yes) checkbox selected (yes)

Bainite selected checkbox selected 
(yes) checkbox selected (yes)

Martensite selected checkbox selected 
(yes) checkbox selected (yes)

Ferrite mode PE only Faster start (TTT); PE if possible otherwise 
OE (CCT)

Pearlite criterion Maximize growth 
rate Maximize growth rate

Pearlite mode Para-pearlite Optimal pearlite

Use interpolation when necessary checkbox selected 
(yes) checkbox NOT selected (no)

Interpolation error tolerance 0.1 (does not apply)

Maximum phase fraction change (absolute) in 0.005 0.005
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Setting Quick Accurate

a time step

Maximum phase fraction change (relative) in a 
time step 0.05 0.05

Error tolerance for austenite fraction 1E-3 1E-4

Custom Calculation Setting

The following settings are available when Custom is selected as the Calculation Setting. 
Otherwise these settings are handled in the background as described above for when Quick 
or Accurate is selected.

FERRITE/PEARLITE/BAINITE/MARTENSITE SELECTED CHECKBOXES

By default the Ferrite selected, Pearlite selected, Bainite selected, and Martensite selected 
checkboxes are selected. For ferrite and pearlite, additional settings are then available.

Click to deselect as required to exclude one or more from the calculation.

FERRITE MODE

This setting is available when the Ferrite selected checkbox is selected.

From the Ferrite mode list choose an option.

 l OE only and PE only are the same as in the Ferrite Property Model.  i.e. 

 l Orthoequilibrium (OE): The ferrite and austenite compositions at the interface 
are fixed to the final equilibrium compositions    

 l Paraequilibrium (PE): Only carbon is allowed to partition, reaching PE at the 
interface

 l PE if possible, otherwise OE means ferrite grows in PE mode if this mode has a 
positive driving force, otherwise ferrite grows in OE mode. This is usually useful to 
handle an ortho-to-para transition as temperature decreases.

PEARLITE CRITERION

This setting is available when the Pearlite selected checkbox is selected. 
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Select an option from the Criterion list to determine the pearlite growth condition. This list 
is called Pearlite criterion for the CCT Diagram and TTT Diagram Property Models.

 l For Maximize growth rate, pearlite growth rate is maximized with respect to 
lamellar spacing (and for optimal pearlite, partition coefficients of substitutional 
alloying elements between ferrite and cementite). The calculation gives maximal 
growth rate and minimal lamellar spacing. This is the default criterion.

 l For Maximize Gibbs energy dissipation rate, Gibbs energy dissipation rate is 
maximized with respect to lamellar spacing (and for optimal pearlite, partition 
coefficients of substitutional alloying elements between ferrite and cementite). The 
calculation gives a smaller growth rate than the maximal, and a larger lamellar 
spacing than the minimal, which may better represent the average growth rate and 
lamellar spacing of all pearlite colonies in the material.

PEARLITE MODE

This setting is available when the Pearlite selected checkbox is selected. It is used to 
determine how substitutional alloying elements partition between ferrite and cementite in 
pearlite. Select an option from the Pearlite mode list.

 l For Optimal pearlite, the partitioning of substitutional alloying elements between 
ferrite and cementite is optimized according to the Criterion while keeping carbon 
equilibrium between the two phases. This is the default mode. This mode realizes a 
smooth transition between ortho-pearlite and para-pearlite.

 l For Para-pearlite, ferrite and cementite are in para-equilibrium where substitutional 
alloying elements do not partition and carbon reaches equilibrium.

 l For Ortho-pearlite, ferrite and cementite are in ortho-equilibrium.

CARBIDE IN PEARLITE

From the Carbide in pearlite list, select the carbide to be present in pearlite: CEMENTITE 
(default), M7C3, or M23C6. For M23C6, this usually depends on Cr content. 

When M23C6 is selected, parameters optimized for stainless steels are invoked.
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Recommended Composition Ranges for Steel Models

CARBIDE IN BAINITE

From the Carbide in bainite list, select the carbide to be present in pearlite: CEMENTITE 
(default) or M7C3. For M7C3, this usually depends on Cr content.

USE INTERPOLATION WHEN NECESSARY

If the Use interpolation when necessary checkbox is selected, and depending on alloy 
composition and temperature, if the code determines that an interpolation is necessary and 
possible to implement, then a composition grid (TTT diagram) or composition-temperature 
grid (CCT diagram) is generated and refined as needed. 

The growth rates and nucleation rates of pearlite and bainite, as functions of composition 
(TTT diagram) or composition and temperature (CCT diagram), are determined by 
interpolation (if sufficiently accurate). This is intended to avoid direct calculations of pearlite 
and bainite rates for every time step, which is usually time-consuming.

INTERPOLATION ERROR TOLERANCE

This setting is available when the Use interpolation when necessary checkbox is selected.

The growth and nucleation rates of pearlite and bainite, if determined from interpolation, 
are accepted only when the relative interpolation error estimated is below the value 
entered here. A large number implies few grid points necessary (shorter calculation 
time) and lower accuracy, and a small number implies the opposite.

MAXIMUM PHASE FRACTION CHANGE (ABSOLUTE/RELATIVE) IN A TIME STEP

The Maximum phase fraction change (absolute) in a time step and Maximum phase 
fraction change (relative) in a time step settings are used to control time step size during 
time integration.

The phase fraction (X) of ferrite, pearlite, and bainite cannot change more than 
 during a time step, where  and  are the absolute and relative maximum 

change, respectively. If the change is too large, the new time step is rejected, and time 
integration is retried with a smaller time step.
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ERROR TOLERANCE FOR AUSTENITE FRACTION

The Error tolerance for austenite fraction setting is used to control the accuracy for 
austenite fraction during time integration. Finite time steps cause an error in austenite 
volume fraction. When the error is larger than the tolerance, time integration is backed up 
and retried with a smaller time step.

Plot Renderer Settings

Plot Renderer, Configuration Settings, Plot Type: CCT Mode, and Plot Type: 
TTT Mode

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Each quantity is defined in both time (t) and temperature (T):

 l Ferrite start (2%), time (t), and temperature (T)
 l Pearlite start (2%), time (t), and temperature (T)
 l Bainite start (2%), time (t), and temperature (T)
 l Total ferrite start (2%), time (t), and temperature (T): The start of the sum of 

polygonal ferrite and bainitic ferrite.
 l Total ferrite+cementite start (2%), time (t), and temperature (T): The start of the 

sum of pearlite and cementite-containing bainite.
 l Total ferrite + cementite finish (98%), time (t), and temperature (T): 98% austenite 

transformed to ferrite, pearlite, and bainite.
 l Martensite start, time (t), and temperature (T)
 l Austenite transformed 2%, time (t), and temperature (T)
 l Austenite transformed 10%, time (t), and temperature (T)
 l Austenite transformed 50%, time (t), and temperature (T)
 l Austenite transformed 90%, time (t), and temperature (T)
 l Austenite transformed 98%, time (t), and temperature (T)

Fractions of transformation products at the last time step (unit-free) are also available:

 l Terminal fraction of ferrite
 l Terminal fraction of pearlite
 l Terminal fraction of bainite
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 l Terminal fraction of martensite
 l Terminal fraction of total ferrite
 l Terminal fraction of total ferrite+cementite

The CCT Mode on the Plot Renderer the time-temperature pairs are 
automatically identified and arranged in the plot to give a CCT diagram. 
Selected cooling curves are also given in the CCT Mode.
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About the Critical Transformation Temperatures Property 
Model

The Critical Transformation Temperatures Property Model, available with the Property 
Model Calculator and the Steel Model Library,  calculates critical transformation 
temperatures for steels under equilibrium conditions. 

This Property Model can output the transformation temperatures for the following:

 l Liquidus: First austenite or ferrite transformation from the liquid
 l Solidus: Liquid fully transformed to solid
 l A0: Magnetic transition temperature (Curie temperature) of cementite. The 

cementite is paramagnetic above A0 and ferromagnetic below
 l A1: Austenite (FCC_A1) transforms to ferrite (BCC_A2) + carbide (cementite or 

graphite or M23C6)
 l A2: Magnetic transition temperature (Curie temperature) of ferrite (BCC_A2). 

Paramagnetic above A2 and ferromagnetic below
 l A3: Austenite (FCC_A1) transforms to ferrite (BCC_A2)
 l A4: Delta-ferrite (BCC_A2) transforms to austenite (FCC_A1)
 l Acem: Austenite (FCC_A1) transforms to cementite. Requires that the Suspend 

graphite checkbox is selected on the Configuration window, which it is by default.
 l Agraph: Austenite (FCC_A1) transforms to graphite. Requires that the Suspend 

graphite checkbox is NOT selected on the Configuration window, i.e. graphite is not 
suspended.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator and described in Critical Transformation Temperatures Property Model Settings.

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Example

For an example, see PM_Fe_04: Critical Temperatures.
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Critical Transformation Temperatures Property Model Settings

The Critical Transformation Temperatures Property Model, available with the Property 
Model Calculator and the Steel Model Library, calculates critical transformation 
temperatures for steels under equilibrium conditions.

About the Critical Transformation Temperatures Property Model

For an example, see PM_Fe_04: Critical Temperatures.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

These settings  are found on the Property Model Calculator when Critical Transformation 
Temperatures is selected under Steel Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

CALCULATE SOLIDUS AND LIQUIDUS

Select the Calculate solidus and liquidus checkbox to calculate these temperatures.

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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CALCULATE AX TEMPERATURES 

Select the Calculate Ax temperatures checkbox to calculate A0, A1, A3, Acem, and Agraph 
temperatures. Typically, only one temperature of A3, Acem, and Agraph  exists. See below 
for additional details about these temperatures.

 l A0: Magnetic transition temperature (Curie temperature) of cementite. The 
cementite is paramagnetic above A0 and ferromagnetic below

 l A1: Austenite (FCC_A1) transforms to ferrite (BCC_A2) + carbide (cementite or 
graphite or M23C6)

 l A2: Magnetic transition temperature (Curie temperature) of ferrite (BCC_A2). 
Paramagnetic above A2 and ferromagnetic below

 l A3: Austenite (FCC_A1) transforms to ferrite (BCC_A2)
 l A4: Delta-ferrite (BCC_A2) transforms to austenite (FCC_A1)
 l Acem: Austenite (FCC_A1) transforms to cementite (requires that the Suspend 

graphite checkbox is selected, which it is by default)
 l Agraph: Austenite (FCC_A1) transforms to graphite (requires that the Suspend 

graphite checkbox is NOT selected, i.e. graphite is not suspended)

SUSPEND GRAPHITE

By default the Suspend graphite checkbox is selected and suspends the graphite phase. Click 
to clear the checkbox as needed to enable the graphite.

SUSPEND GAS

By default the Suspend gas checkbox is selected and suspends the gas phase. Click to clear 
the checkbox as needed.

 MANUAL TEMPERATURE SEARCH LIMITS

By default the temperature search limits are automatically defined. Select the Manual 
temperature search limits checkbox to manually change the limits for the Lower 
temperature search limit, Upper temperature search limit, and Max temperature step. Is 
given in the same unit as the temperature in the Condition Definitions.
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LOWER AND UPPER TEMPERATURE SEARCH LIMITS

These settings are available when the Manual temperature search limits checkbox is 
selected. 

In the Lower temperature search limit and Upper temperature search limit fields enter 
temperature values to search the lower and upper limits of transformation temperatures. 

MAX TEMPERATURE STEP

This setting is available when the Manual temperature search limits checkbox is selected.

In the Max temperature step field, enter the largest temperature step. This is most often 
reduced when changes in driving force or the amount of the phases indicate a phase 
transformation at a shorter temperature step.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Output the transformation temperatures:

 l Liquidus: First austenite or ferrite transformation from the liquid
 l Solidus: Liquid fully transformed to solid
 l A0: Magnetic transition temperature (Curie temperature) of cementite. The 

cementite is paramagnetic above A0 and ferromagnetic below
 l A1: Austenite (FCC_A1) transforms to ferrite (BCC_A2) + carbide (cementite or 

graphite or M23C6 or M7C3)
 l A2: Magnetic transition temperature (Curie temperature) of ferrite (BCC_A2). 

Paramagnetic above A2 and ferromagnetic below
 l A3: Austenite (FCC_A1) transforms to ferrite (BCC_A2)
 l A4: Delta-ferrite (BCC_A2) transforms to austenite (FCC_A1)
 l Acem: Austenite (FCC_A1) transforms to cementite (only possible if graphite is 

suspended)
 l Agraph: Austenite (FCC_A1) transforms to graphite (only possible if graphite is 

enabled)
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About the Ferrite Property Model

The Ferrite Property Model, available with the Property Model Calculator and the Steel 
Model Library, calculates the thermodynamics and isothermal kinetics of proeutectoid 
ferrite forming from austenite in hypoeutectoid steels.

This model is for the form of proeutectoid ferrite which forms without distinct 
crystallographic preferences at austenite grain boundaries. This type of ferrite is referred to 
as grain boundary allotriomorph, or polygonal ferrite. Another type, plate-shaped ferrite 
(Widmanstätten ferrite), is treated in the Bainite Property Model as a special case of bainite 
without cementite.

About the Bainite Property Model

Growth Models

Growth is modeled based on a simplified diffusion-control theory with the ferrite/austenite 
interfacial composition determined by:

 l Orthoequilibrium (OE): The ferrite and austenite compositions at the interface are 
fixed to the final equilibrium compositions    

 l Paraequilibrium (PE): Only carbon is allowed to partition, reaching PE at the interface
 l Negligible-partitioning local equilibrium (NPLE)
 l Orthoprecipitate (OP): Austenite interfacial composition being the bulk composition, 

ferrite interfacial composition from the maximum driving force condition (parallel 
tangent construction in Gibbs energy-composition diagram)

 l Paraprecipitate (PP): Only carbon is allowed to partition, otherwise the same as OP

The growth is parabolic if only diffusion-controlled. The parabolic rate constant can be 
modified by a phase addition because the driving force and interfacial compositions are 
changed. With a finite interfacial mobility and solute drag effects, the growth is then mixed-
controlled. The effect is handled in the overall transformation kinetics but not reflected in 
the parabolic rate constant.

Nucleation Rate and Interfacial Mobility

Nucleation rate of ferrite allotriomorph on austenite grain boundaries is calculated from 
classical nucleation theory assuming a pillbox shape of the ferrite nucleus [1988Lan].
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When you are setting up the model, parameters for nucleation rate (site density, edge 
energy, and epsilon, see [1988Lan] for definition) and interfacial mobility (pre-exponential 
factor and activation energy) can be customized. Otherwise, default values assessed by 
Thermo-Calc are used. The overall kinetics of isothermal transformation is calculated in the 
extended-volume framework by numerical integration over time. Austenite composition 
changes over time due to partitioning of elements, and its effects on growth and nucleation 
are handled.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Ferrite Property Model Settings for details.

Example

For an example, see PM_Fe_09: Fe-C-Ni Ferrite.

Reference

[1988Lan] W. F. Lange, M. Enomoto, H. I. Aaronson, The kinetics of ferrite nucleation at 
austenite grain boundaries in Fe-C alloys. Metall. Trans. A. 19, 427–440 (1988).

Ferrite Property Model Settings

The Ferrite Property Model, available with the Property Model Calculator and the Steel 
Model Library, calculates the thermodynamics and isothermal kinetics of proeutectoid 
ferrite forming from austenite in hypoeutectoid steels.

About the Ferrite Property Model

For an example, see PM_Fe_09: Fe-C-Ni Ferrite.

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Included Elements and Important Notes

 l Austenite must contain at least Fe and C for this model to function.
 l Elements that are quite soluble in both austenite and ferrite—Mn, Ni, Si, Al, Co, Cr, 

and Mo—have their effects on overall kinetics assessed.
 l Cu and strong carbide-formers—W, V, Nb, Ta, Ti, and Zr—can be included, but only 

to a certain extent not to cause phases other than austenite and ferrite to form at 
the calculation temperature. Otherwise, the model calculation may give unrealistic 
results or even fail. If carbide is expected to form at an austenitizing temperature, 
use the setting Equilibrium composition at austenitizing temperature for Austenite 
composition from, then enter an austenitizing temperature.

Elements not listed above are excluded in mass percent from the austenite 
composition used to calculate the transformation.

For the Ferrite, Bainite, and Pearlite Property Models, it is also useful to review 
the Recommended Composition Ranges for Steel Models.

Configuration Settings

These settings are found on the Property Model Calculator when Ferrite is selected under 
Steel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

AUSTENITE COMPOSITION FROM

Select an option from the Austenite composition from list:
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 l Nominal composition uses the system composition as austenite composition.
 l Equilibrium composition at austenizing temperature. Select to enter an 

Austenitizing temperature. The austenite composition is determined from an 
equilibrium calculation at the austenitizing temperature (if austenite is stable). This 
option  is useful when austenite coexists with other phase(s), e.g. primary carbide, 
before the transformation(s) being calculated starts. But the Model only considers 
the effect of other phase(s) on austenite composition.

As per above in Included Elements and Important Notes, use the Equilibrium 
composition at austenitizing temperature setting if carbide is expected to form 
at an austenitizing temperature.

AUSTENTIZING TEMPERATURE

This setting is available when Equilibrium composition at austenitizing temperature is 
selected from the Austenite composition from list.

Enter an Austentizing temperature in the field. The unit is the same as that selected under 
Condition Definitions.

GRAIN SIZE

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.

GROWTH MODE

Select a Growth mode: Orthoequilibrium (OE), Paraequilibrium (PE), Negligible-
partitioning local equilibrium (NPLE), Orthoprecipitate (OP), or Paraprecipitate (PP). This 
defines the compositions on the two sides of the ferrite-austenite interface and therefore 
affects growth rate.

For definitions of these modes, see About the Ferrite Property Model.

PHASE ADDITION

Enter a Phase addition in J/mol. This applies a Gibbs energy shift to ferrite.
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SKIP TIME INTEGRATION

Click to select the Skip time integration checkbox to skip this step in the calculations. Time 
integration is required for calculating ferrite start/half/finish times, but is usually time-
consuming. Skipping time integration allows you to get the other result quantities more 
quickly.

Custom Parameters

Select the Custom parameters checkbox to choose to set more advanced settings as listed 
below. 

 l Site density, Edge surface energy, and Epsilon are for calculating grain-boundary 
nucleation rate (see [1988Lan] for definition and details). 

 l M0 and Q are to define an interfacial mobility in the Arrhenius equation.

SITE DENSITY

This setting is available when Custom parameters is selected. Enter a Site density in 1/m2.

EDGE SURFACE ENERGY

This setting is available when Custom  parameters is selected. Enter an Edge surface energy 
in J/m2.

EPSILON

This setting is available when Custom parameters is selected. Enter a value for Epsilon in 
J/m2.

M0

This setting is available when Custom parameters is selected. Enter a value for M0 in m mol/
(Js). This is the pre-exponential factor for interfacial mobility.

Q

This setting is available when Custom parameters is selected. Enter a value for Q in J/mol. 
This is the activation energy for interfacial mobility. 



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 722 of 763

MAXIMUM PHASE FRACTION CHANGE (ABSOLUTE) IN A TIME STEP

This setting is available when Custom parameters is selected, and is used for time 
integration.

Enter the Maximum phase fraction change (absolute) in a time step.

MAXIMUM PHASE FRACTION CHANGE (RELATIVE) IN A TIME STEP

This setting is available when Custom parameters is selected, and is used for time 
integration.

Enter the Maximum phase fraction change (relative) in a time step

Plot Renderer Settings

Plot Renderer, Configuration Settings, and Plot Type: TTT Mode

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

 l Ferrite molar fraction (OE or PE): The ferrite molar fraction at the end of the 
transformation, determined from orthoequilibrium (for Ferrite mode “OE” or “OP”) 
or paraequilibrium (for Ferrite mode “PE”, “NPLE”, or “PP”). 

 l Growth Models
 l Parabolic growth rate constant [m/s(1/2)]: The ratio of half-thickness to square root 

of time. This is calculated from interfacial composition and diffusion coefficients in 
austenite.

 l Driving force [J/mol]
 l Nucleation rate [1/(m2 s)]: Steady-state nucleation rate of ferrite per unit austenite 

grain boundary area.
 l Ferrite start, Ferrite half, or Ferrite finish: The times at ferrite fraction being 0.02, 

0.50, and 0.98, respectively.
 l Ferrite start (relative), Ferrite half (relative), or Ferrite finish (relative): The times at 

2%, 50%, and 98% of the final ferrite fraction, respectively.

Reference

[1988Lan] W. F. Lange, M. Enomoto, H. I. Aaronson, The kinetics of ferrite nucleation at 
austenite grain boundaries in Fe-C alloys. Metall. Trans. A. 19, 427–440 (1988).
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About the Martensite Fractions Property Model

The Martensite Fractions Property Model, available with the Property Model Calculator and 
the Steel Model Library, calculates fraction of athermal martensite based on an analytical 
equation derived in Huyan et al. [2016Huy]. It is assumed that the first forming martensite 
morphology is the only forming one. The first morphology is determined based on the Ms-
temperatures of all morphologies. 

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Martensite Fractions Property Model Settings for details.

Example

For an example see PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing.

Reference

[2016Huy] F. Huyan, P. Hedström, L. Höglund, A. Borgenstam, A Thermodynamic-Based 
Model to Predict the Fraction of Martensite in Steels. Metall. Mater. Trans. A. 47, 4404–
4410 (2016).

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Martensite Fractions Property Model Settings

The Martensite Fractions Property Model, available with the Property Model Calculator and 
the Steel Model Library, calculates the fraction of athermal martensite based on available 
driving force. 

About the Martensite Fractions Property Model

For an example see PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing.

Configuration Settings

The settings  are found on the Property Model Calculator when Martensite Fractions is 
selected under Steel Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

INTERCRITICAL ANNEALING

Click to select the Intercritical annealing checkbox to assume intercritical annealing. Click to 
clear the checkbox if the specified composition is used directly. When selected, an 
equilibrium calculation is performed at the specified temperature and the composition of 
the austenite phase is used for the martensite temperature calculation.

ANNEALING TEMPERATURE

This setting is available when the Intercritical annealing checkbox is selected. 

Enter an Annealing temperature in the field. The unit is the same as that selected under 
Condition Definitions.

GRAIN SIZE [ΜM]

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.
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PARENT PHASE GIBBS ENERGY ADDITION

In the Parent phase Gibbs energy addition [J/mol] field enter a value in J/mol to add a 
Gibbs energy offset  to the parent austenite phase. This can be used, for example, to correct 
database offsets. The default is 0 J/mol.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

These plot quantities are available:

 l Total martensite percentage: The martensite percentage at these conditions.
 l Retained austenite percentage: The retained austenite percentage at these 

conditions.
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About the Martensite Temperatures Property Model

The Martensite Temperatures Property Model, available with the Property Model Calculator 
and the Steel Model Library, calculates the martensite start temperature (Ms) based on 
modeling the transformation barrier with fitted analytical equations. It is based on 
Stormvinter et al. [2012Sto] with subsequent update and extension by Gulapura 
Hanumantharaju [2017Gul] and Thermo-Calc internal assessment. The partitionless 
equilibrium temperature T0 is calculated using the thermodynamic database. The Model also 
gives temperatures corresponding to 50%, 90%, and 99% transformations. 

Martensite fractions are calculated with the same algorithm as in the Martensite Fractions 
Property Model. 

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Martensite Temperatures Property Model Settings.

Examples

For  examples see PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing and PM_Fe_02: 
Fe-Mn Martensite Morphologies.

References

[2012Sto] A. Stormvinter, A. Borgenstam, J. Ågren, Thermodynamically Based Prediction of 
the Martensite Start Temperature for Commercial Steels. Metall. Mater. Trans. A. 43, 
3870–3879 (2012).

[2017Gul] A. K. Gulapura Hanumantharaju, Master's thesis, KTH Royal Institute of 
Technology (2017).

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Martensite Temperatures Property Model Settings

The Martensite Temperatures Property Model, available with the Property Model Calculator 
and the Steel Model Library,  calculates the martensite start  (Ms) temperature based on 
modeling of the transformation barrier. Martensite half and finish temperatures are also 
given according to the Martensite Fractions Property Model.

About the Martensite Temperatures Property Model

For an example see PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing 
and PM_Fe_02: Fe-Mn Martensite Morphologies.

Configuration Settings

The settings  are found on the Property Model Calculator when Martensite Temperatures is 
selected under Steel Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

INTERCRITICAL ANNEALING

Click to select the Intercritical annealing checkbox to assume intercritical annealing. Click to 
clear the checkbox if the specified composition is used directly. When selected, an 
equilibrium calculation is performed at the specified temperature and the composition of 
the austenite phase is used for the martensite temperature calculation.

ANNEALING TEMPERATURE

This setting is available when the Intercritical annealing checkbox is selected. 

Enter an Annealing temperature in the field. The unit is the same as that selected under 
Condition Definitions.
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GRAIN SIZE [ΜM]

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.

PARENT PHASE GIBBS ENERGY ADDITION 

In the Parent phase Gibbs energy addition [J/mol] field enter a value in J/mol to add a 
Gibbs energy offset  to the parent austenite phase. This can be used, for example, to correct 
database offsets. The default is 0 J/mol.

Plot Renderer Settings

Plot Renderer, Configuration Settings, and Plot Type: TTT Mode

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

 l Ms temperature: Martensite start temperature
 l Lath Ms: Martensite start temperature of lath alpha or alpha-prime martensite
 l Plate Ms: Martensite start temperature of plate alpha or alpha-prime martensite
 l Epsilon Ms: Martensite start temperature of epsilon martensite
 l M50: 50% martensite temperature
 l M90: 90% martensite temperature
 l M99: 99% martensite temperature
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About the Martensitic Steel Strength Property Model

The Martensitic Steel Strength Property Model, available with the Property Model 
Calculator and the Steel Model Library, calculates the strength and/or hardness of 
martensitic steels.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Steels undergoing austenitization, or at least partial austenitization (i.e., intercritical 
annealing), may form martensite upon quenching. The mechanical properties of martensite 
depend heavily on the content of interstitial elements in the parent austenite but are of 
course also affected by other elements and secondary phases. In general, a martensitic steel 
exhibits the following contributions to strength (or hardness):

[Eq. 1]          

where  is the total intrinsic strength of the phases in the material,  is the contribution 
from solid solution strengthening from each phase, and  is the additional strength 
due to formation of martensite from the parent austenite.

The  and terms are modeled in the same way as in the Yield Strength 
Model. See About the Yield Strength Property Model.

The last term ( ) in Eq. 1 can further be decomposed into:

[Eq. 2]          

where  is the strength of the martensite and  is the fraction of parent austenite 
that has transformed to martensite. In the Martensitic Steel Strength Property Model, the 
fraction transformed is evaluated using the Martensite Fractions Model.

About the Martensite Fractions Property Model and Martensite Fractions 
Property Model Settings.

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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This means that the evaluation of the fraction of martensite is dependent on composition, 
austenitization temperature, quench temperature, and other parameters. These parameters 
are also available from within the Martensitic Steel Strength model.

Be aware of the absence of the contribution from grain size in Eq. 1. It has been 
shown that parent austenite grain boundaries contribute very little to the 
overall strength, due to the numerous other defects and interfaces that form 
during a martensitic transformation. The grain size may, however, affect the 
martensitic transformation itself in terms of the residual austenite content, 
which is modeled separately.

Eq. 1 is valid for the as-quenched condition, however, martensitic steels are most often 
tempered, which decomposes the martensite (and the residual austenite), to reduce 
brittleness. In the tempered condition, the martensite strength contribution is reduced by 
reduction of dislocation density and precipitation of carbides. The carbides may also 
contribute significantly to the overall strength (or hardness) and thus reduce the softening 
or even cause what is known as a secondary hardening peak. Eq. 2 thus becomes:

[Eq. 3]         

where  is a number between 0 and 1 and depends on tempering temperature and 
composition. In addition to this, the first two terms of Eq. 1 now also contain contributions 
from any tempering carbides that form. Tempering carbides are obtained from a 
constrained equilibrium calculation using the parent austenite composition and tempering 
temperature, where during set up you can select what phases are allowed on the System 
Definer Configuration window. This is justified by the abundant nucleation sites (due to very 
high dislocation density) and the fact that the carbides that form are very small, which 
implies very short diffusion distances. 

The tempering behavior as function of time is modeled using a neural network trained on a 
large dataset covering mainly carbon and low-alloy steels, which provides a correction term 
to the total calculated strength and/or hardness of the steel in the quench and tempered 
condition based on the physical model described above. For most of the steels considered, a 
very rapid decrease of hardness is expected with time, resulting in an asymptotic approach 
to an apparent stable value. Such a highly non-linear behavior, also exhibiting dependency 
on composition, lends itself well to machine learning (ML) based models.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 731 of 763

FCC_A1, BCC_A2, and Cementite must be selected on the System Definer 
Configuration window but can be suspended with settings available on the 
Property Model Configuration window. If these phases are excluded on the 
System Definer, the calculation does not work.

The Model only accepts phases that have had the intrinsic strength assessed. 
For a list of available phases see the section in the theory for Yield Strength 
Property Model regarding the Intrinsic Strength model.

Note about Hardness Data

Hardness data is the most abundant quantity available for martensitic steels as compared to 
tensile properties and especially so for studies of pure martensite. Therefore, this Model is 
developed based on hardness data. However, the hardness of materials with a significant 
proportion of hard phases, such as martensitic steels, often correlates better with tensile 
strength rather than yield strength (see e.g., [2008Pav]). For the Martensitic Steel Strength 
Model, the hardness to strength relationship follows Tabors relation, i.e., hardness (MPa) = 3 
* strength (MPa). This means that the strength corresponds to tensile strength for the most 
part. In case of ambiguity, it is recommended to rely on hardness as calculated by the model.

The various hardness or hardening quantities are treated separately from the 
various strength or strengthening quantities and each (hardness and strength) 
are plotted on the respective axes. When setting up the simulation, the 
Configuration window (when in Grouped Mode) shows either Vickers Hardness 
or Strength. This corresponds to the labeling of axes in the Visualizations 
window when plotting two or more quantities of the same type. The legend 
then lists the specific quantity names selected on the Configuration window. 

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Martensitic Steel Strength Property Model Settings.
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Example

For an example see PM_Fe_10: Martensitic Steel Strength.

Reference

[2008Pav] E. J. Pavlina, C. J. Van Tyne, Correlation of Yield Strength and Tensile Strength with 
Hardness for Steels. J. Mater. Eng. Perform. 17, 888–893 (2008).

Martensitic Steel Strength Property Model Settings

The Martensitic Steel Strength Property Model, available with the Property Model 
Calculator and the Steel Model Library, calculates the strength and/or hardness of 
martensitic steels.

About the Martensitic Steel Strength Property Model

For an example see PM_Fe_10: Martensitic Steel Strength.

System Definer Configuration Settings

The following details relate to choosing the phases on the System Definer. 

Then on the Property Model Calculator Configuration Settings window you can suspend as 
needed using the  Suspend FCC, BCC, or Cementite settings described below. 

FCC_A1, BCC_A2, and Cementite must be selected on the System Definer 
Configuration window but can be suspended with settings available on the 
Property Model Configuration window. If these phases are excluded on the 
System Definer, the calculation does not work.

The Model only accepts phases that have had the intrinsic strength assessed. 
For a list of available phases see the section in the theory for Yield Strength 
Property Model regarding the Intrinsic Strength model.
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Property Model Calculator Configuration Settings

The settings  are found on the Property Model Calculator when Martensitic Steel Strength is 
selected under Steel Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

EVALUATION TEMPERATURE

The default Evaluation temperature is room temperature. Otherwise, select the Evaluation 
temperature checkbox to evaluate the strength at a temperature other than room 
temperature. The value is taken from the Temperature defined under Condition Definitions.

Also:

 1. If the Evaluation temperature is lower than the tempering temperature, then the 
model evaluates the intrinsic and solid solution strengthening at the selected 
temperature. 

 2. Alternatively, if the Evaluation temperature is higher than the tempering 
temperature, then in addition to (1), the model treats the evaluation temperature as 
the tempering temperature.

ANNEALING TEMPERATURE

Enter an Annealing temperature, which is the temperature at which austenization or 
intercritical annealing is performed before the steel is quenched. The default is 1273.15.

QUENCH TEMPERATURE

Enter a Quench temperature, which is the end temperature for quench after austenization. 
The default is 298.15. 
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TEMPERING TEMPERATURE

The Tempering temperature is the temperature at which tempering is performed. This is 
used to estimate martensite hardness after tempering. The default is 673.15.

TEMPERING TIME

Add a Tempering time [s]. The default is 3600 seconds. The time dependency is predicted 
using a machine learning model. If tempering time is set to a negative value, no correction is 
applied to the total hardness and total strength results. 

SUSPEND FCC, BCC, OR CEMENTITE

Select the Suspend FCC, BCC, or cementite checkbox to choose to suspend one or more of 
these phases. All other phases can be deselected on the System Definer to exclude from the 
calculation as required. 

Austenite (FCC_A1), ferrite (BCC_A2), and Cementite phases all need to be 
selected on the System Definer. However, for some alloys it might be necessary 
to suspend one or more of these from the tempering calculation. 

Then from one or more of the FCC_A1, BCC_A2, or Cementite lists choose Entered or 
Suspended. 

MORE OPTIONS

Select the More options checkbox to adjust settings for Grain size, the Parent phase Gibbs 
energy addition, and Constant strength addition.

GRAIN SIZE

This setting is available when More options is selected.

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.

PARENT PHASE GIBBS ENERGY ADDITION

This setting is available when More options is selected.
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In the Parent phase Gibbs energy addition [J/mol] field enter a value in J/mol to add a 
Gibbs energy offset  to the parent austenite phase. This can be used, for example, to correct 
database offsets. The default is 0 J/mol.

CONSTANT STRENGTH ADDITION

This setting is available when More options is selected.

Enter a value for the Constant strength addition [MPa]. You can also enter expressions such 
as T*w(cr)+10 or similar. 

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Plot Quantities

These plot quantities are available:

 l Tempering temperature
 l Martensite strengthening as-quenched: The contribution of martensite to the 

overall strength after quenching.
 l Martensite strengthening quenched and tempered: The contribution of martensite 

to the overall strength after quenching and tempering.
 l Solid solution strengthening: Total intrinsic + solid solution strengthening 

contribution as-quenched.
 l Solid solution strengthening after temper: Total intrinsic + solid solution 

strengthening contribution after tempering.
 l Total martensite percentage: The percentage of martensite after quenching.
 l Retained austenite percentage: The percentage of retained austenite after 

quenching.
 l Total strength of the as-quenched steel: Total strength, including all modeled 

contributions to the strength, after quenching.
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 l Total strength of the tempered steel: Total strength, including all modeled 
contributions, after quenching and tempering.

 l Precipitate fraction (Annealing): The fraction of any given phase present at the 
annealing temperature before quenching.

 l Precipitate fraction (Tempering): The fraction of any given phase present after 
quenching and tempering (precipitates after temper are added to those at annealing, 
if any).

For all strength quantities, there is a corresponding hardness quantity:

The various hardness or hardening quantities are treated separately from the 
various strength or strengthening quantities and each (hardness and strength) 
are plotted on the respective axes. When setting up the simulation, the 
Configuration window (when in Grouped Mode) shows either Vickers Hardness 
or Strength. This corresponds to the labeling of axes in the Visualizations 
window when plotting two or more quantities of the same type. The legend 
then lists the specific quantity names selected on the Configuration window. 

 l Martensite hardening as-quenched
 l Martensite hardening quenched and tempered
 l Total solid solution hardening
 l Solid solution hardening after temper
 l Total hardness of the as-quenched steel
 l Total hardness of the tempered steel
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About the Pearlite Property Model

The Pearlite Property Model  [2020Yan], available with the Property Model Calculator and 
the Steel Model Library, calculates the thermodynamics and kinetics of pearlite formation 
from austenite during isothermal heat treatment.

The Pearlite Model describes the thermodynamics and kinetics of pearlite formation from 
austenite. It is assumed that the overall composition of pearlite is the same as the austenite 
composition, and growth rate is constant over time. Growth rate and lamellar spacing of 
pearlite are determined by a criterion where either growth rate or Gibbs energy dissipation 
rate is maximized. The Model considers Gibbs energy dissipation due to formation of ferrite-
cementite interface in pearlite, finite austenite-pearlite interfacial mobility, solute drag, and 
diffusion of elements within austenite and along austenite-pearlite interface.

Divergent pearlite, of which growth rate and lamellar spacing change with time, 
is not considered. This Model only considers the transformation from FCC_A1 
phase to pearlite consisting of BCC_A2 and CEMENTITE_D011 (for TCFE9  this is 
CEMENTITE). Pearlite with other phases is not implemented.

Pearlite is assumed to nucleate on austenite grain boundaries. Grain boundary nucleation 
rate is modeled as a function of composition and temperature. The isothermal 
transformation kinetics follows Cahn [1956Cah]. Start, half, and finish times are taken as 2%, 
50%, and 98% transformation, respectively.

Austenite composition can be taken either as the nominal composition or from an 
equilibrium calculation at an austenitization temperature. The latter option can be useful 
when austenite coexists with other phase(s), e.g. primary carbide or ferrite, before pearlite 
starts to form in austenite. But the Model only considers the effect of other phase(s) on 
austenite composition.

Model parameters have been determined from published data of maximal growth rate, 
minimal lamellar spacing, partition coefficients, and isothermal transformation kinetics in 
ternary and multicomponent systems.  

The included elements in the Pearlite Property Model are Fe (dependent 
element), C, Mn, Cr, Mo, W, Si, Al, Ni, Co. Other elements are neglected by 
weight percent.
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To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Pearlite Property Model Settings.

Example

For an example see PM_Fe_03: Fe-C-Mn Pearlite.

References

[1956Cah] J. W. Cahn, The kinetics of grain boundary nucleated reactions. Acta Metall. 4, 
449–459 (1956).

[2020Yan] J.-Y. Yan, J. Ågren, J. Jeppsson, Pearlite in Multicomponent Steels: 
Phenomenological Steady-State Modeling. Metall. Mater. Trans. A. 51, 1978–2001 
(2020).

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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Pearlite Property Model Settings

The Pearlite Property Model, available with the Property Model Calculator and the Steel 
Model Library, calculates the thermodynamics and kinetics of pearlite formation from 
austenite during isothermal heat treatment.

The included elements in the Pearlite Property Model are Fe (dependent 
element), C, Mn, Cr, Mo, W, Si, Al, Ni, Co. Other elements are neglected by 
weight percent.

For the Ferrite, Bainite, and Pearlite Property Models, it is also useful to review 
the Recommended Composition Ranges for Steel Models.

About the Pearlite Property Model

For an example see PM_Fe_03: Fe-C-Mn Pearlite.

Configuration Settings

The settings  are found on the Property Model Calculator when Pearlite is selected under 
Steel Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

AUSTENITE COMPOSITION FROM

Select an option from the Austenite composition from list:



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 740 of 763

 l Nominal composition uses the system composition as austenite composition.
 l Equilibrium composition at austenizing temperature. Select to enter an 

Austenitizing temperature. The austenite composition is determined from an 
equilibrium calculation at the austenitizing temperature (if austenite is stable). This 
option  is useful when austenite coexists with other phase(s), e.g. primary carbide, 
before the transformation(s) being calculated starts. But the Model only considers 
the effect of other phase(s) on austenite composition.

AUSTENTIZING TEMPERATURE

This setting is available when Equilibrium composition at austenitizing temperature is 
selected from the Austenite composition from list.

Enter an Austentizing temperature in the field. The unit is the same as that selected under 
Condition Definitions.

GRAIN SIZE [ΜM]

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.

CRITERION

This setting is available when the Pearlite selected checkbox is selected. 

Select an option from the Criterion list to determine the pearlite growth condition. This list 
is called Pearlite criterion for the CCT Diagram and TTT Diagram Property Models.

 l For Maximize growth rate, pearlite growth rate is maximized with respect to 
lamellar spacing (and for optimal pearlite, partition coefficients of substitutional 
alloying elements between ferrite and cementite). The calculation gives maximal 
growth rate and minimal lamellar spacing. This is the default criterion.

 l For Maximize Gibbs energy dissipation rate, Gibbs energy dissipation rate is 
maximized with respect to lamellar spacing (and for optimal pearlite, partition 
coefficients of substitutional alloying elements between ferrite and cementite). The 
calculation gives a smaller growth rate than the maximal, and a larger lamellar 
spacing than the minimal, which may better represent the average growth rate and 
lamellar spacing of all pearlite colonies in the material.
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PEARLITE MODE

This setting is available when the Pearlite selected checkbox is selected. It is used to 
determine how substitutional alloying elements partition between ferrite and cementite in 
pearlite. Select an option from the Pearlite mode list.

 l For Optimal pearlite, the partitioning of substitutional alloying elements between 
ferrite and cementite is optimized according to the Criterion while keeping carbon 
equilibrium between the two phases. This is the default mode. This mode realizes a 
smooth transition between ortho-pearlite and para-pearlite.

 l For Para-pearlite, ferrite and cementite are in para-equilibrium where substitutional 
alloying elements do not partition and carbon reaches equilibrium.

 l For Ortho-pearlite, ferrite and cementite are in ortho-equilibrium.

Plot Renderer Settings

Plot Renderer, Configuration Settings, and Plot Type: TTT Mode

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

 l Temperature
 l Start time (2% pearlite)
 l Half time (50% pearlite)
 l Finish time (98% pearlite)
 l Growth rate [m/s]
 l Lamellar spacing [m]
 l Cementite molar fraction in pearlite
 l Driving force of pearlite formation [J/mol]
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About the TTT Diagram Property Model

The TTT Diagram Property Model, available with the Property Model Calculator and the 
Steel Model Library, can be used to calculate a Time-Temperature-Transformation (TTT) 
diagram, with a One Axis calculation on temperature. The Model calculates the isothermal 
kinetics of concurrent transformation of austenite into ferrite, pearlite, bainite, and 
martensite. The algorithms and parameters for ferrite, pearlite, bainite, and martensite are 
the same as in the individual Property Models (Ferrite, Pearlite, Bainite, Martensite 
Temperatures, and Martensite Fractions), but the competitive occupation of prior austenite 
grain boundaries and bulk volume is handled in the TTT Diagram Property Model.

If the reaction temperature is below martensite-start temperature (Ms), it is assumed that a 
fraction of (athermal) martensite according to the calculation forms instantaneously at time 
zero, prior to the formation of ferrite, pearlite, and bainite. Otherwise austenite transforms 
to ferrite, pearlite, and/or bainite.

To run calculations with the Steel Models requires a valid maintenance license 
plus licenses for both the TCFE (version 9 and newer) and MOBFE (version 4 
and newer) databases. Also see our website to learn more about the Steel 
Model Library and other related examples.

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See TTT Diagram Property Model Settings.

Example

For an example see PM_Fe_06: TTT Diagram for Fe-C-Mn-Si-Cr-V.

TTT Diagram Property Model Settings

The TTT Diagram Property Model, available with the Property Model Calculator and the 
Steel Model Library, calculates the concurrent transformations to ferrite, pearlite, bainite, 
and martensite under isothermal conditions and is used to construct a time-temperature-
transformation (TTT) diagram.

About the TTT Diagram Property Model and Steel Library TTT Diagram Template

https://thermocalc.com/products/add-on-modules/steel-model-library/
https://thermocalc.com/products/add-on-modules/steel-model-library/
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For an example see PM_Fe_06: TTT Diagram for Fe-C-Mn-Si-Cr-V

Configuration Settings

These settings are found on the Property Model Calculator when TTT Diagram is selected 
under Steel Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

AUSTENITE COMPOSITION FROM

Select an option from the Austenite composition from list:

 l Nominal composition uses the system composition as austenite composition.
 l Equilibrium composition at austenizing temperature. Select to enter an 

Austenitizing temperature. The austenite composition is determined from an 
equilibrium calculation at the austenitizing temperature (if austenite is stable). This 
option  is useful when austenite coexists with other phase(s), e.g. primary carbide, 
before the transformation(s) being calculated starts. But the Model only considers 
the effect of other phase(s) on austenite composition.

AUSTENTIZING TEMPERATURE

This setting is available when Equilibrium composition at austenitizing temperature is 
selected from the Austenite composition from list.

Enter an Austentizing temperature in the field. The unit is the same as that selected under 
Condition Definitions.

GRAIN SIZE

Enter the Grain size of the austenite in micrometers (μm). The default is 100 μm.



Thermo-Calc Documentation Set

Working with the Activity Nodes for an AM Simulation ǀ 744 of 763

Calculation Setting

Select Quick (the default), Accurate, or Custom to balance accuracy and calculation time. 
Choose Custom to define the numerical settings yourself, which are otherwise set in the 
background when Quick or Accurate is selected. See the separate section below about the 
details for the Custom settings.

QUICK CALCULATION SETTING

Quick is used for a relatively quick and rough calculation to reveal the general feature of a 
TTT diagram. Interpolation is used when necessary in order to avoid calculating the growth 
rates and nucleation rates of pearlite and bainite at every time step. 

 l For simplicity, Ferrite mode is PE (paraequilibrium), and Pearlite mode is Para-
pearlite. 

 l Recommended temperature interval: 50-100 K. 

Each temperature can take several minutes.

ACCURATE CALCULATION SETTING

Accurate evaluates the growth rates and nucleation rates at every time step accurately 
(without interpolation). The time step control is also tighter than when using the Quick 
setting. 

 l Ferrite mode is faster start, meaning the mode between OE and PE which gives a 
faster initial transformation. 

 l Pearlite mode is Optimal pearlite, but its rate calculation becomes slower if 
austenite contains many alloying elements. 

 l Recommended temperature interval: 20-50 K or even lower. 

Calculating the whole TTT diagram may take several hours.
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DETAILS ABOUT THE QUICK AND ACCURATE CALCULATION SETTINGS

When you choose Quick or Accurate as the calculation setting, the following is what is 
automatically set in the background for each of the sections. These sections are visible to 
you and also can be edited when Custom is chosen:

Setting Quick Accurate

Ferrite selected checkbox selected 
(yes) checkbox selected (yes)

Pearlite selected checkbox selected 
(yes) checkbox selected (yes)

Bainite selected checkbox selected 
(yes) checkbox selected (yes)

Martensite selected checkbox selected 
(yes) checkbox selected (yes)

Ferrite mode PE only Faster start (TTT); PE if possible otherwise 
OE (CCT)

Pearlite criterion Maximize growth 
rate Maximize growth rate

Pearlite mode Para-pearlite Optimal pearlite

Use interpolation when necessary checkbox selected 
(yes) checkbox NOT selected (no)

Interpolation error tolerance 0.1 (does not apply)

Maximum phase fraction change (absolute) in 
a time step 0.005 0.005

Maximum phase fraction change (relative) in a 
time step 0.05 0.05

Error tolerance for austenite fraction 1E-3 1E-4
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Custom Calculation Setting

The following settings are available when Custom is selected as the Calculation Setting. 
Otherwise these settings are handled in the background as described above for when Quick 
or Accurate is selected.

FERRITE/PEARLITE/BAINITE/MARTENSITE SELECTED CHECKBOXES

By default the Ferrite selected, Pearlite selected, Bainite selected, and Martensite selected 
checkboxes are selected. For ferrite and pearlite, additional settings are then available.

Click to deselect as required to exclude one or more from the calculation.

PEARLITE CRITERION

This setting is available when the Pearlite selected checkbox is selected. 

Select an option from the Criterion list to determine the pearlite growth condition. This list 
is called Pearlite criterion for the CCT Diagram and TTT Diagram Property Models.

 l For Maximize growth rate, pearlite growth rate is maximized with respect to 
lamellar spacing (and for optimal pearlite, partition coefficients of substitutional 
alloying elements between ferrite and cementite). The calculation gives maximal 
growth rate and minimal lamellar spacing. This is the default criterion.

 l For Maximize Gibbs energy dissipation rate, Gibbs energy dissipation rate is 
maximized with respect to lamellar spacing (and for optimal pearlite, partition 
coefficients of substitutional alloying elements between ferrite and cementite). The 
calculation gives a smaller growth rate than the maximal, and a larger lamellar 
spacing than the minimal, which may better represent the average growth rate and 
lamellar spacing of all pearlite colonies in the material.

CARBIDE IN PEARLITE

From the Carbide in pearlite list, select the carbide to be present in pearlite: CEMENTITE 
(default), M7C3, or M23C6. For M23C6, this usually depends on Cr content. 

When M23C6 is selected, parameters optimized for stainless steels are invoked.
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Recommended Composition Ranges for Steel Models

CARBIDE IN BAINITE

From the Carbide in bainite list, select the carbide to be present in pearlite: CEMENTITE 
(default) or M7C3. For M7C3, this usually depends on Cr content.

PEARLITE MODE

This setting is available when the Pearlite selected checkbox is selected. It is used to 
determine how substitutional alloying elements partition between ferrite and cementite in 
pearlite. Select an option from the Pearlite mode list.

 l For Optimal pearlite, the partitioning of substitutional alloying elements between 
ferrite and cementite is optimized according to the Criterion while keeping carbon 
equilibrium between the two phases. This is the default mode. This mode realizes a 
smooth transition between ortho-pearlite and para-pearlite.

 l For Para-pearlite, ferrite and cementite are in para-equilibrium where substitutional 
alloying elements do not partition and carbon reaches equilibrium.

 l For Ortho-pearlite, ferrite and cementite are in ortho-equilibrium.

USE INTERPOLATION WHEN NECESSARY

If the Use interpolation when necessary checkbox is selected, and depending on alloy 
composition and temperature, if the code determines that an interpolation is necessary and 
possible to implement, then a composition grid (TTT diagram) or composition-temperature 
grid (CCT diagram) is generated and refined as needed. 

The growth rates and nucleation rates of pearlite and bainite, as functions of composition 
(TTT diagram) or composition and temperature (CCT diagram), are determined by 
interpolation (if sufficiently accurate). This is intended to avoid direct calculations of pearlite 
and bainite rates for every time step, which is usually time-consuming.

INTERPOLATION ERROR TOLERANCE

This setting is available when the Use interpolation when necessary checkbox is selected.
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The growth and nucleation rates of pearlite and bainite, if determined from interpolation, 
are accepted only when the relative interpolation error estimated is below the value 
entered here. A large number implies few grid points necessary (shorter calculation 
time) and lower accuracy, and a small number implies the opposite.

MAXIMUM PHASE FRACTION CHANGE (ABSOLUTE/RELATIVE) IN A TIME STEP

The Maximum phase fraction change (absolute) in a time step and Maximum phase 
fraction change (relative) in a time step settings are used to control time step size during 
time integration.

The phase fraction (X) of ferrite, pearlite, and bainite cannot change more than 
 during a time step, where  and  are the absolute and relative maximum 

change, respectively. If the change is too large, the new time step is rejected, and time 
integration is retried with a smaller time step.

ERROR TOLERANCE FOR AUSTENITE FRACTION

The Error tolerance for austenite fraction setting is used to control the accuracy for 
austenite fraction during time integration. Finite time steps cause an error in austenite 
volume fraction. When the error is larger than the tolerance, time integration is backed up 
and retried with a smaller time step.

Plot Renderer Settings

Plot Renderer, Configuration Settings, and Plot Type: TTT Mode

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

 l Ferrite start (2%)
 l Pearlite start (2%)
 l Bainite start (2%)
 l Total ferrite start (2%): The start of the sum of polygonal ferrite and bainitic ferrite.
 l Total ferrite + cementite start (2%): The start of the sum of pearlite and cementite-

containing bainite.
 l Total ferrite + cementite finish (98%): 98% austenite transformed to ferrite, pearlite, 

and bainite.
 l Austenite transformed 2%
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 l Austenite transformed 10%
 l Austenite transformed 50%
 l Austenite transformed 90%
 l Austenite transformed 98%
 l Martensite start
 l Martensite 50%
 l Martensite 98%

Fractions of transformation products at the last time step are also available:

 l Terminal fraction of ferrite
 l Terminal fraction of pearlite
 l Terminal fraction of bainite
 l Terminal fraction of martensite
 l Terminal fraction of total ferrite
 l Terminal fraction of total ferrite+cementite

Martensite start, Martensite 50%, and Martensite 98% are temperature 
quantities. Terminal fractions are unit-free quantities. The others are time 
quantities. 

In the TTT Mode of a Plot Renderer, the three temperature quantities for 
martensite are plotted as horizontal lines because these are independent of 
time. The other time quantities are plotted as functions of temperature.
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Titanium Model Library Property Models
Property Model Calculator

In this section:

About the Titanium Model Library Property Models 751

About the Alloy Strength - Ti Property Model 752

About the Martensite Temperatures - Ti Property Model 760
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About the Titanium Model Library Property Models

These Titanium Models are available with the Property Model Calculator and as part of the 
Titanium Model Library.

To run calculations with the Titanium Models requires a valid maintenance 
license plus a license for the TCTI (version 6 and newer) database. For some 
Property Models, additional recommendations for the database version to use 
is indicated in its description. Also see our website to learn more about the 
Titanium Model Library.

Alloy Strength - Ti

The Alloy Strength - Ti Property Model, available with the Property Model Calculator and 
the Titanium Model Library, calculates the strength and hardness for Ti-base alloys.

See About the Alloy Strength - Ti Property Model and  Alloy Strength - Ti Property Model 
Settings for background theory and input parameter details.

Martensite Temperatures - Ti

The Martensite Temperatures - Ti Property Model, available with the Property Model 
Calculator and the Titanium Model Library, calculates the martensite start temperature (Ms) 
and T-Zero temperatures for Ti-base alloys.

See About the Martensite Temperatures - Ti Property Model and  Martensite Temperatures - 
Ti Property Model Settings for background theory and input parameter details.

https://thermocalc.com/products/add-on-modules/titanium-model-library/
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About the Alloy Strength - Ti Property Model

The Alloy Strength - Ti Property Model, available with the Property Model Calculator and 
the Titanium Model Library, calculates the strength and hardness for Ti-base alloys.

To run calculations with the Titanium Models requires a valid maintenance 
license plus a license for the TCTI (version 6 and newer) database. For some 
Property Models, additional recommendations for the database version to use 
is indicated in its description. Also see our website to learn more about the 
Titanium Model Library.

The various forms of alpha martensite HCP ( , , or ) are not explicitly 
distinguished and are  collectively described by the phase HCP_A3 in terms of 
thermodynamic properties.

The Alloy Strength - Ti model is built from individual models for four strength contributions. 
The effect of impurities on the strength of Ti-base alloys is very strong [1981Con; 1998Ouc] 
and this model has therefore been equipped with a functionality to select base grades, 
according to the ASTM definitions of purity, for cases where the exact impurity content is 
not known.

Intrinsic Strength

The intrinsic strength is calculated as the combination of the strength for the pure elements 
in the system, weighted by the mole fraction of each element. In the Alloy Strength - Ti 
model you can choose the Titanium base grade, which are base grades of “commercially 
pure” titanium and represent the impurity elements allowed in each grade. The 
compositions defined for the available grades are as listed:

 l Iodide Titanium: Pure Ti with no impurity elements (the default)
 l Grade 1 (35A): Ti-0.2Fe-0.18O-0.08C-0.03N-0.015H (wt%)
 l Grade 2 (50A): Ti-0.3Fe-0.25O-0.08C-0.03N-0.015H (wt%)
 l Grade 3 (65A): Ti-0.3Fe-0.35O-0.08C-0.05N-0.015H (wt%)
 l Grade 4 (75A): Ti-0.5Fe-0.4O-0.08C-0.05N-0.015H (wt%)

https://thermocalc.com/products/add-on-modules/titanium-model-library/
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The intrinsic strength for the different grades is given as the linear combination of the 
strength for the elements in the system plus the calculated strengthening contribution from 
solid solution of the impurity elements.

Grain Boundary Strengthening

For the grain boundary strengthening, after selecting the Grain boundary strengthening 
checkbox you can include an effect of Grain size on the strength/hardness. This contribution 
is given by the Hall-Petch equation [2016Cor]. When setting up the model, you can either 
specify a User-defined Hall-Petch coefficient or otherwise it is calculated by default.

For additional background information, see About the Yield Strength Property 
Model.

Solid Solution Strengthening

The solid solution strengthening contribution is evaluated as per the model by Walbrühl et 
al. [2017Wal], where the parameters for each Ti binary system are optimized against a 
compiled collection of experimental studies on titanium. There is no specific input required 
for solid solution strengthening when setting up the model. This calculation uses the 
composition of the alpha and/or beta phase of the system, which is automatically calculated 
in the model.

For additional background information, see About the Yield Strength Property 
Model.

Precipitation Strengthening

After selecting the Precipitation strengthening checkbox on the Configuration window, 
there are several settings you can define. One phase can be chosen to contribute to the alloy 
strength by precipitation strengthening, which in this Property Model is given by the model 
by Deschamps et al. [1998Des].

On the Configuration window for this setting, the following input parameters can be 
defined:

 l Precipitate radius: The mean radius of the precipitates.
 l Critical radius: The mean precipitate radius where the mechanism that dislocations 

pass precipitates changes from shearing ( ) to looping ( ).
 l Taylor factor: The Taylor factor accounts for the texture of the material, normally the 
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value is between 2.24 and 3.06 for randomly oriented grains.
 l Shear modulus: The shear modulus of the matrix phase, given in Pascal (Pa).
 l Burgers vector: The burgers vector of the matrix phase, given in meters (m).

Starting with TCS Ti/TiAl-based Alloys Database (TCTI) version 6, it is possible to 
calculate the Shear modulus of individual phases. The option is enabled by 
default for the precipitation strengthening contribution. See the settings 
information or the tooltip.

Constant Strength Addition

The Constant strength addition contribution can be used to displace the calculated result in 
the y-direction.

Settings, Example, and References

Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Alloy Strength - Ti Property Model Settings.

Example

For an example see PM_Ti_02: Alloy Strength for Ti-O.
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Alloy Strength - Ti Property Model Settings

The Alloy Strength - Ti Property Model, available with the Property Model Calculator and 
the Titanium Model Library, calculates the strength and hardness for Ti-base alloys.

About the Alloy Strength - Ti Property Model

For an example see PM_Ti_02: Alloy Strength for Ti-O

About the Contributions

The model can be configured to include contributions from:

 l Intrinsic strength / hardness: The base line strength expressed as the weighted 
average of the strength for the pure elements in the system. If any of grade 1-4 is 
chosen as the base, a solid solution strengthening contribution stemming from 
impurities of Fe, C, N, H, and O is added to the weighted average of pure element 
strength.

 l Solid solution strengthening / hardening: The contribution to strength from solid 
solution calculated as the sum of contributions from binary interactions.

 l Grain boundary strengthening / hardening: The contribution to strength from grain 
boundaries described by the Hall-Petch relationshipis described by the Hall-Petch 
relation.
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 l Precipitation strengthening / hardening: The contribution to strength from 
precipitation, described by the model developed by Deschamps.

 l Constant strength / hardness: This contribution is a constant addition to the overall 
strength. It is a true constant in the sense that it is not converted between either 
strength or hardness, nor between Mpa or Vickers units.

For more details about these contributions, see About the Alloy Strength - Ti 
Property Model.

Configuration Settings

The settings are found on the Property Model Calculator when Alloy Strength - Ti is selected 
under Titanium Models.

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

TITANIUM BASE GRADE

Select a Titanium base grade from the list. Impurities have a strong solid solution hardening 
effect. When you select a Ti-grade as the base for the alloys system, this effect is taken into 
account. The default, Iodide Titanium, is pure Ti with no impurity elements, i.e. this excludes 
this contribution to the intrinsic hardness. Otherwise choose a Ti-base grade from the list, 
where the compositions for the available grades are also listed:

 l Grade 1 35A: Ti-0.2Fe-0.18O-0.08C-0.03N-0.015H (wt%)
 l Grade 2 50A: Ti-0.3Fe-0.25O-0.08C-0.03N-0.015H (wt%)
 l Grade 3 65A: Ti-0.3Fe-0.35O-0.08C-0.05N-0.015H (wt%)
 l Grade 4 75A: Ti-0.5Fe-0.4O-0.08C-0.05N-0.015H (wt%)
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EVALUATION TEMPERATURE

Enter an Evaluation temperature, which is the temperature at which the hardness is 
evaluated.

GRAIN BOUNDARY STRENGTHENING

Click to select the Grain boundary strengthening checkbox to include calculated grain 
boundary strengthening ( ).

GRAIN SIZE

This setting is available when the Grain boundary strengthening checkbox is selected.

Enter the Grain size [μm], which is the grain diameter in micrometers (μm). The default is 
100 μm.

USER-DEFINED HALL-PETCH COEFFICIENT

This setting is available when the Grain boundary strengthening checkbox is selected. By 
default, a suitable default Hall-Petch coefficient is automatically calculated by the model.

Alternatively, select the User defined Hall-Petch coefficient checkbox and enter a different 
Hall-Petch coefficient:  in MPa μm1/2.

PRECIPITATION STRENGTHENING

Click to select the Precipitation strengthening checkbox to include calculated precipitation 
strengthening ( ). Then continue to define the settings under Additional Precipitation 
Strengthening Settings.

CONSTANT STRENGTH ADDITION

Enter a Constant strength addition. This strength contribution can be used to displace the 
calculated result in the y-direction. Function input is allowed, e.g., 1000*w(Al).

ADDITIONAL PRECIPITATION STRENGTHENING SETTINGS

The following settings are available when the Precipitation strengthening checkbox is 
selected.
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PRECIPITATE PHASE

Select a Precipitate phase from the list. One phase can be chosen to contribute to the alloy 
strength.

The various forms of alpha martensite HCP ( , , or ) are not explicitly 
distinguished and are  collectively described by the phase HCP_A3 in terms of 
thermodynamic properties.

PRECIPITATE RADIUS

Enter a Precipitate radius, which is the mean radius of the precipitates. The default is 1.0E-
8.

CRITICAL RADIUS

Enter a Critical radius. This is the mean precipitate radius where the mechanism that 
dislocations pass precipitates changes from shearing ( ) to looping ( ). The 
default is 1.0E-8.

TAYLOR FACTOR

Enter a value for the Taylor factor. The default is 3.0.

The value of the Taylor factor accounts for texture in the material. Normally the value is 
between 2.24 and 3.06 for random orientations.

SHEAR MODULUS

Enter the word Calculated (not case sensitive) in this field to calculate the shear modulus of 
the matrix phase from the parameters in the thermodynamic TCS Ti/TiAl-based Alloys 
Database (TCTI) (version TCTI6 and higher), which contains the elastic properties. 

Additionally,  values or functions, expressed in Pa, are also accepted as input. If the shear 
modulus cannot be calculated or evaluated from the input, a default value of 4.5E10 Pa is 
used, which is close to the value for pure Ti at room temperature.
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BURGERS VECTOR

Enter a value for the Burgers vector, which is the burgers vector of the matrix phase. The 
unit is meter (m) and the default is 2.5E-10.

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

The various hardness or hardening quantities are treated separately from the 
various strength or strengthening quantities and each (hardness and strength) 
are plotted on the respective axes. When setting up the simulation, the 
Configuration window (when in Grouped Mode) shows either Vickers Hardness 
or Strength. This corresponds to the labeling of axes in the Visualizations 
window when plotting two or more quantities of the same type. The legend 
then lists the specific quantity names selected on the Configuration window. 

Plot Quantities
 l Temperature
 l Total Hardness
 l Total Yield Strength
 l Intrinsic Hardness
 l Total Solid Solution Hardening
 l Solid Solution Hardening for Beta Phase
 l Solid Solution Hardening for Alpha Phase
 l Constant strength addition [MPa]
 l Amount of Phases
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About the Martensite Temperatures - Ti Property Model

The Martensite Temperatures - Ti Property Model, available with the Property Model 
Calculator and the Titanium Model Library, calculates the martensite start temperature (Ms) 
and T-Zero temperatures for Ti-base alloys.

You can choose between HCP ( , , or ) and B19_PRIME or B19_ORTHO as the 
Martensite phase: 

 l The HCP ( , , or ) is the common choice for alloys such as Ti-6Al-4V and other 
structural alloys. 

 l The B19_PRIME and B19_ORTHO options are intended for TiNi-based shape-memory 
alloys. In particular, B19_ORTHO is useful for TiNiCu-based shape-memory alloys.

The various forms of alpha martensite HCP ( , , or ) are not explicitly 
distinguished and are  collectively described by the phase HCP_A3 in terms of 
thermodynamic properties.

An initial equilibrium is calculated to set the starting composition and internal constitution 
(in case of ordering) of the parent phase. This should be performed at a temperature that 
reflects the thermal history of the studied alloy. The starting composition and constitution is 
held fixed throughout the calculation as it is expected that the alloy cannot equilibrate 
during a martensitic transformation. 

The model then calculates the T0 temperature and the associated offset to the Ms 
temperature, which occurs due to the thermodynamic barrier for nucleation of martensite. 
The offset is parameterized using conventional Redlich-Kister polynomials.

To run calculations with the Titanium Models requires a valid maintenance 
license plus a license for the TCTI (version 6 and newer) database. For some 
Property Models, additional recommendations for the database version to use 
is indicated in its description. Also see our website to learn more about the 
Titanium Model Library.

https://thermocalc.com/products/add-on-modules/titanium-model-library/
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Configuration Settings

The input parameters are entered on the Configuration window for the Property Model 
Calculator. There are also additional axis variables available on the Plot Renderer.

See Martensite Temperatures - Ti Property Model Settings.

Example

For an example see PM_Ti_01: Martensite Temperatures for Ti-Zr

Martensite Temperatures - Ti Property Model Settings

The Martensite Temperatures - Ti Property Model, available with the Property Model 
Calculator and the Titanium Model Library, calculates the martensite start temperature (Ms) 
and T-Zero temperatures for Ti-base alloys.

About the Martensite Temperatures - Ti Property Model

For an example see PM_Ti_01: Martensite Temperatures for Ti-Zr

Configuration Settings

The settings  are found on the Property Model Calculator when Martensite Temperatures - 
Ti is selected under Titanium Models. 

When working in the Configuration window, click the Description tab for more 
information about the Model. 

For the details about the Condition Definitions, Calculation Type, Timeout in 
minutes, Parallel Calculation, and other calculation associated settings, see 
Configuration Window Settings.

Additionally note the following about the Temperature setting for this Property 
Model. You can also select the Annealing checkbox to treat this as the 
annealing temperature. See details below.
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TEMPERATURE (IN CONDITION DEFINITIONS)

The temperature at which an initial equilibrium is calculated to set the starting composition 
and internal constitution (in case of ordering) of the parent phase. Should reflect the initial 
microstructure of the studied alloy. The starting composition and constitution is held fixed 
throughout the calculation as it is expected that the alloy can not equilibrate during a 
martensitic transformation.

MARTENSITE PHASE

Select a Martensite phase from the list: HCP ( , , or ), B19_PRIME (shape-memory 
alloys), or B19_ORTHO  (shape-memory alloys). 

 l HCP  ( , , or ) is the common choice for alloys such as Ti-6Al-4V and other 
structural alloys.

 l B19_PRIME (shape-memory alloys) for TiNi-based shape-memory alloys.
 l B19_ORTHO  (shape-memory alloys) for TiNi-based shape-memory alloys. This 

setting is particularly useful for TiNiCu-based shape-memory alloys.

PARENT PHASE GIBBS ENERGY ADDITION 

In the Parent phase Gibbs energy addition [J/mol] field enter a value in J/mol to add a 
Gibbs energy shift for the parent phase. This should normally only be used for calculating T-
Zero since it might produce unpredictable results for Ms. 

The expression can be a function of temperature, T, and composition, w(el) or x(el), for 
example:

50*T/1000+10*x(Cr)+5*x(Cr)^2

The default is 0 J/mol.

ANNEALING

The model initially calculates a global equilibrium for the bulk composition in order to 
identify the correct parent phase. The temperature condition for this calculation is taken 
from the Condition Definitions setting. 

It is also possible to treat this temperature as the annealing temperature, i.e., that the 
composition of the parent phase is taken from the equilibrium calculation at this 
temperature and used as composition conditions. 
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If the parent phase is the only stable phase, the nominal composition is equal to the parent 
phase composition. However, for multiphase equilibria, the composition of the parent phase 
will differ from the build composition. 

Select the Annealing checkbox to use the annealing temperature instead of the 
Temperature set under Condition Definitions. 

Plot Renderer Settings

Plot Renderer and Configuration Settings

When setting up your calculation on the Plot Renderer and/or Table Renderer, the following 
axis variables are available for the conditions defined on the Property Model Calculator. Also 
see Result Quantities: Property Model Abbreviations for information.

Quantities
 l Temperature
 l Ms temperature: Martensite start temperature
 l T-Zero temperature
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Graphical Mode Examples Listed by Product

This guide includes descriptions of the following examples.

About the Examples

Category Example number

The Thermo-Calc collection includes binary and ternary system examples, Scheil, the Equilibrium 
Calculator, Material to Material Calculator, plus more.

Thermo-Calc  Examples Collection
T_01 to T_19

General Property Models Library

Thermo-Calc General Property Models Examples Collection 
General Models: PM_G_01 to 
PM_G_17

Add-on Modules and Material Specific Property Model Libraries (in Alphabetical Order)

Additive Manufacturing (AM) Module Examples Collection AM_01 to AM_12

Diffusion Module (DICTRA) Examples Collection
D_01, D_02, D_03 (the Quick 
Start Guide Examples)

D_04 to D_10

Nickel Model Library Examples Collection Nickel Property Models: PM_
NI_01 to PM_Ni_04

Noble Metal Alloys Model Library Examples Collection Noble Metals Property 
Models: PM_Noble_01

Precipitation Module (TC-PRISMA) Examples Collection P_01 to P_16

Process Metallurgy Module Examples Collection PMET_01 to PMET_08

Steel Model Library Examples Collection Steel Property Models: PM_Fe_
01 to PM_Fe_10

Titanium Model Library Examples Collection Titanium Property Models: PM_
Ti_01 to PM_Ti_02
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T_01: Calculating a Single-Point Equilibrium

This example shows the result from a single-point equilibrium calculation in the Fe-C system. It 
demonstrates the use of the Equilibrium Calculator and generates a Table Renderer in the Visualizations 
window. The number of equilibrium conditions is C+2 where C is the number of components, meaning 
that four conditions are needed in this example:

 l Temperature is 1000 K
 l Pressure is 100000 Pa
 l System size is 1 mole
 l Mass percent carbon is 0.1%

Project File Information
 l Folder: Thermo-Calc
 l File name: T_01_Single-point_equilibrium.tcu

Table Results

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 1: The displayed results of the calculation show that the BCC_A2 (ferrite) and GRAPHITE phases are 
stable for this set of equilibrium conditions.
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T_02: Stepping in Temperature in the Fe-C System

This example shows how the fractions of stable phases vary for an Fe-0.1 mass-% C alloy when the 
temperature is varied between 500 and 2000 K. It demonstrates the use of the Equilibrium Calculator. 
To allow temperature to vary, the corresponding Axis Definition checkbox is selected. 

Project File Information
 l Folder: Thermo-Calc
 l File name: T_02_Step_in_temperature_in_Fe-C.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 2: In this example, results are displayed graphically using a Plot Renderer activity.
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For the Plot Renderer, there is an option to use the Table View  button to convert plots 
to table data for all calculation types and calculators. See Plot Renderer: Convert a Plot to a 
Table and Export the Data.

If you want, you can also use a Table Renderer to generate text results instead, as shown in this example 
after adding a Table Renderer to the Equilibrium Calculator and clicking Perform.
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T_03: Fe-C Phase Diagrams

This example shows the stable Fe-C phase diagram (stable meaning that the graphite phase is entered in 
the calculation). The same diagram is calculated using the Binary Calculator activity and then using a 
System Definer and Equilibrium Calculator. 

In both cases, a Plot Renderer is used to display results. The purpose of the Binary Calculator is to 
simplify common calculations for binary systems. In the Equilibrium Calculator two axes are defined: 
Mass percent C and Temperature. An axis variable must also be an equilibrium condition.

Project File  Information
 l Folder: Thermo-Calc
 l File name: T_03_Fe-C_phase_diagram.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 3: The plot result of the System Definer and Equilibrium Calculator.

Figure 4: The plot result of the Binary Calculator simulation.
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T_04: Fe-Cr-C Ternary Phase Diagram  at 1000 K

This example shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. Similar to example T_03: 
Fe-C Phase Diagrams, the same diagram is calculated using a Ternary Calculator and then using a System 
Definer and Equilibrium Calculator. Two Plot Renderer activities are added to create two plots.

Project File Information
 l Folder: Thermo-Calc
 l File name: T_04_Fe-Cr-C_ternary_phase_diagram.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Try practicing with two features on the Plot Renderer Configuration window. To toggle between a 
triangular and a rectangular diagram, click the Show Triangular button then click Perform to see what 
happens. To toggle the X and Y axis variables, click the Switch Axes button and then click Perform.
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Figure 5: Ternary Calculator.

Figure 6: Equilibrium Calculator.
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T_05: Stable and the Metastable Fe-C Phase Diagrams

This example shows how to overlay results from two calculations in the same plot using the Equilibrium 
Calculator. 

Project File Information
 l Folder: Thermo-Calc
 l File name: T_05_Fe-C_stable_and_metastable_phase_diagram.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Plotting Several Calculations in One Diagram

 1. The Plot Renderer activity is first created as a successor to Equilibrium Calculator 1.

 2. Then right-click the Plot Renderer node and select Add predecessor and the results from both 
equilibrium calculators are in the same plot. In Equilibrium Calculator 1 the stable phase 
diagram is calculated and in Equilibrium Calculator 2 the metastable phase. 

 3. The metastable diagram is obtained by deselecting checkboxes for the GRAPHITE and 
DIAMOND_FCC_A4 phases on the Metastable Phases node (System Definer 2)  → Phases and 
phase constitution tab.
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To make it easier to work with your project, right-click any node and select Rename. 
In this example, System Definer 1 is renamed to Stable System and System Definer 
2 is renamed to Metastable System.

ǀ 12 of 420



T_06: Serially Coupled Equilibrium Calculators

Sometimes there are multiple solutions for a given set of equilibrium conditions. In other cases the 
equilibrium calculation does not converge. You can then aid the final calculation by, in effect, telling the 
software where it should start the search for the equilibrium. 

This example shows how to serially couple two Equilibrium Calculator nodes together for more complex 
equilibrium conditions. For each calculation, the output is to a Table Renderer. 

Project File Information
 l Folder: Thermo-Calc
 l File name: T_06_Serial_equilibrium_calculators.tcu

Table Renderer Results

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Equilibrium Calculator 1

In the first example, the objective is to calculate the equilibrium at 850° C where the mole fractions of 
the FCC A1 and BCC A2 phases are 0.5 each for an Fe-Cr-C steel with 10% chromium. In Equilibrium 
Calculator 1 a simple set of equilibrium conditions (temperature, pressure, system size and composition) 
are used to find a carbon content where only the FCC A1 and BCC A2 phases are stable. The results from 
this preliminary calculation are displayed in  Table Renderer 1.
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Equilibrium Calculator 2, 3, and 4

Click each tab along the top of the Visualizations window to view the results associated to Table 
Renderer 2, Table Renderer 2, and Table Renderer 2.

 l In Equilibrium Calculator 2 the carbon content equilibrium condition is replaced by the condition 
that the numbers of moles of the BCC A2 phase should be 0.5. The final result is displayed in 
Table Renderer 2. In this case, the final objective is to calculate the solidus temperature of an Fe-
Cr-C steel with 10% Cr and 0.01% C. 

 l In Equilibrium Calculator 3 the state at 2000 K is calculated and the result is displayed in Table 
Renderer 3. 

 l In Equilibrium Calculator 4 the temperature equilibrium condition is replaced by the condition 
Fix phase / liquid / 0.0, meaning that liquid should be stable in an amount of zero moles, i.e. the 
solidus temperature. The final result is displayed in Table Renderer 4.
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T_07: User-Defined Functions

This example shows how to implement user-defined functions. A series of equilibria for an Fe-Cr-C alloy 
are calculated by varying temperature between 500 and 3000 K. In the configuration window of the 
Equilibrium Calculator under the Functions tab, two identically meaning functions are defined, fraction 
solid and f solid, the values of which are plotted against temperature in two  Plot Renderer activities. 
Functions can be entered in terms of QuantitiesQ1, Q2, Q3 and so forth, or by using the Thermo-Calc 
syntax.

Project File Information
 l Folder: Thermo-Calc
 l File name: T_07_User_defined_functions.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 7: The result of the fraction_solid function.

Figure 8: The result of the f_solid function.
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T_08: Scheil and Equilibrium Solidification

This example shows a comparison for an Al-Si alloy solidified under full local equilibrium and under the 
Scheil assumptions, i.e. zero diffusion in the solidified material and infinitely fast diffusion in the liquid. 
The example uses the Scheil Calculator and adds a Plot and Table Renderer. 

Project File Information
 l Folder: Thermo-Calc
 l File name: T_08_Scheil_and_equilibrium_solidification.tcu

Visualizations

This example is included as a tutorial on  our website and as part of the Scheil Solidification 
Simulations playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 9: The plot compares the mole fraction of a solid vs temperature. 
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Figure 10: The table provides the data, which you can also export.

Saving the Table (via Table Renderer)

There are different ways to save the table from the Table Renderer Visualizations or Configuration 
windows. 

For the Plot Renderer, there is an option to use the Table View  button to convert plots 
to table data for all calculation types and calculators. See Plot Renderer: Convert a Plot to a 
Table and Export the Data.

Method 1

In the Visualizations window, right click the table and select  Save As...
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Method 2

 1. In the Project window, click the Table Renderer.

 2. In the Configuration window, click the Save table button .
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T_09: Carbide Driving Force Heat Map

This is an example of using Grid calculations to plot the driving force for a carbide as a function of two 
composition variables. With the Grid Calculation Type, a 2D grid is generated from the two calculation 
axes. After the calculation is done, an equilibrium is calculated in each grid point. A Plot Renderer 
connected to a grid calculation plots the Z-axis property for each equilibrium as a function of the two 
calculation axes. You can choose different Plot types such as Heat map and Contour to display the 
results. 

Project File Information
 l Folder: Thermo-Calc
 l File name: T_09_Heat_map_of_carbide_driving_force.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

ǀ 20 of 420

https://thermocalc.com/support/video-tutorials/
https://www.youtube.com/playlist?list=PLfv6McToaTGSzHrh3TfNF2EhoUUUqeEWd


Figure 11: The results are plotted as a Heat map. Alternatively, a Contour Plot type can be selected on the Plot 
Renderer.
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T_10: Scheil Solidification with Back Diffusion

This is an example of a Scheil solidification simulation of a Al-2.1Cu-1Si alloy including back diffusion in 
the primary phase.

The example uses two of the Scheil Calculator activity nodes with different cooling rates, 10 K/s and 
0.005 K/s. The lower cooling rate produces a solidification curve that is closer to the equilibrium curve 
as shown in the plot result. Both a thermodynamic ALDEMO (aluminum demo) and mobility MALDEMO 
(Al-alloys mobility) database are used for this calculation.

See Scheil Calculator for an overview of the different Scheil simulation models available. 

Project File and License Information
 l Folder: Thermo-Calc
 l File name: T_10_Scheil_with_back_diffusion.tcu

The Scheil with back diffusion  feature is only available for systems with diffusion data, i.e. 
this model requires the use of a mobility database.

Running the example itself does not require an additional license.

Visualizations

This example is included as a tutorial on  our website and as part of the Scheil Solidification 
Simulations playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 12: Scheil solidification. The lower cooling rate produces a solidification curve that is closer to the 
equilibrium curve .
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T_11: Surface Tension in Cu-Zr

This is an example of including surface tension in the calculations. 

Using the ALDEMO database, which is the free demonstration version of the TCS Al-based Alloy 
Database (TCAL), the surface tension of liquid metallic is plotted at 1373 K for Cu-Zr and compared to 
experimental data from [2005Kra].

Reference

[2005Kra] V. P. Krasovskyy, Y. V. Naidich, N. A. Krasovskaya, "Surface tension and density of copper–
Zirconium alloys in contact with fluoride refractories," J. Mater. Sci. 40, 2367–2369 (2005).

Project File Information
 l Folder: Thermo-Calc
 l File name: T_11_Surface_tension_in_Cu-Zr.tcu

The same example is also provided in Console Mode as tcex56.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 13: Surface tension of liquid metallic at 1373 K for Cu-Zr and compared to experimental data from 
[2005Kra].

More Information

The thermophysical properties are progressively being added to the Thermo-Calc databases starting 
with Thermo-Calc software version 2020a. 

You can learn more about the models by searching the help (press F1 when in 
Thermo-Calc). 

You can find information on our website about the properties that can be calculated with 
Thermo-Calc and the Add-on Modules. 
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T_12: Viscosity in Cr-Ni

This is an example of including viscosity in the calculations. 

Using the FEDEMO database, which is the free demonstration version of the TCS Steel and Fe-alloys 
Database (TCFE), the viscosity of metallic liquids is plotted at 1873 K for Cu-Ni and compared to 
experimental data from [2005Sat].

Reference

[2005Sat] Y. Sato, K. Sugisawa, D. Aoki, T. Yamamura, "Viscosities of Fe–Ni, Fe–Co and Ni–Co binary 
melts," Meas. Sci. Technol. 16, 363–371 (2005).

Project File Information
 l Folder: Thermo-Calc
 l File name: T_12_Viscosity_in_Cr-Ni.tcu

The same example is also provided in Console Mode as tcex55.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 14: The viscosity of metallic liquids  at 1873 K for Cu-Ni and compared to experimental data from 
[2005Sat].

More Information

The thermophysical properties are progressively being added to the Thermo-Calc databases starting 
with Thermo-Calc software version 2020a. 

You can learn more about the models by searching the help (press F1 when in 
Thermo-Calc). 

You can find information on our website about the properties that can be calculated with 
Thermo-Calc and the Add-on Modules. 
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T_13: Scheil Solidification with Solute Trapping

In Graphical Mode, you use the Scheil Calculator to set up the various Scheil solidification simulations 
outlined in more detail in Scheil-Gulliver Solidification Calculations.

For background theory see About Scheil with Solute Trapping.

This example shows the use of the Scheil with solute trapping option with an Al-7.5Si-0.2Cu alloy as 
compared to a Classic Scheil calculation. The thermodynamic ALDEMO (Aluminum demo) database, 
available to all users, is selected for this calculation to simulate the effect of solute trapping in the 
primary phase. This type of simulation is useful for additive manufacturing applications.

This example shows how the alloy starts to solidify at a lower temperature compared to a classic Scheil 
simulation, an effect which increases with increasing solidification speed. The solidification speed is 
calculated from user supplied scanning speed and angle between the solid/liquid interface and the 
scanning direction.

The example uses the Aziz model, with an Interface driving force of Migration energy and a Maximum 
velocity for infinite driving force of 2000 m/s.

Read more about Scheil Solidification Simulations on our website, including how to select 
the right model for your simulation. If you are in Thermo-Calc, press F1 to search the help 
to learn about using Scheil.

Project File  Information
 l Folder: Thermo-Calc
 l File name: T_13_Scheil_with_Solute_Trapping.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 15: The effect of Scheil solidification with solute trapping of a Al-7.5Si-0.2Cu alloy compared to 
equilibrium and a Classic Scheil calculation.
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T_14: Fe-Cr-Ni Transition Comparison Using the Material to 
Material Calculator

In Graphical Mode, you use the Material to Material Calculator to perform calculations and examine 
how two materials transition from one into the other. The calculations in this example search for 
potential deleterious phases during heat treatment of alloys joined together. In this example, the 
calculation steps between a model martensitic stainless steel (Fe-17Cr-2Ni) and a model Alloy 800 
composition (Fe-35Ni-19Cr). Neither alloy is predicted to form the deleterious sigma phase at 600 °C. 
However sigma is predicted to form at a wide range of mixtures of these two materials, which could 
have an impact on mechanical properties if it forms.

The example, as defined when you open it, uses a One Axis calculation (also known as a property 
diagram), a temperature of 650 °C, to compare the volume fraction of all phases to the mass fraction of 
Alloy 800. The Fraction of the second material (Alloy 800) is set to 50% (0.5), which for a One Axis 
calculation is used as the start value. 

As with all the examples, you can adjust the settings to plot a variety of combinations of 
output to see how the Material to Material Calculator works before defining your own 
project. 

The plot for this calculation compares the volume fraction of all phases of Material 1 (martensitic 
stainless steel) to the mass fraction of Material 2 (Alloy 800). In the plots you can see where each phase  
(FCC_A1, SIGMA_D8B, and BCC_A2) evolves. As you step from Material 1 to Material 2, the FCC_A1 
phase starts forming at about 5% (0.05), SIGMA-D8B phase starts to evolve at about 19% (0.19), and the 
BCC_A2 transitions from Material 1 to Material 2 where it stops forming at approximately 24% (0.24). 
The purpose of the calculation is to determine at what fraction of Alloy 800 the deleterious sigma phase 
forms and this is shown for these compositions.

Project File Information
 l Folder: Thermo-Calc
 l File name: T_14_Fe-Cr-Ni_Material_to_Material.tcu

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

The default plot shows the volume fraction of all phases as a function of the mass fraction of the second 
material, which in this case, is Alloy 800. You can see that the martensitic stainless composition is BCC at 
this temperature, and the highly alloyed stainless is FCC. Neither material is expected to form any 
deleterious phase on its own at 650 °C.

However, mixtures of these two materials, which could arise from a graded transition joint, weld, or 
potentially a diffusion couple, show some stability for the deleterious sigma phase at this temperature. 
You can try to make small adjustments to the initial chemistry to reduce the potential for sigma phase to 
form.

Figure 16: This plot shows the volume fraction of phases when changing composition from the Martensitic 
Steel (First material) to the Alloy 800 (Second material). This calculation uses the Material to Material 
Calculator to examine the transition of phases for two compositions of Fe-Cr-Ni. The purpose  is to determine 
at what fraction of Alloy 800 does the deleterious sigma phase start to form. See the text for details. 
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Figure 17: The composition varies linearly when the composition is changed from the Martensitic steel to the 
Alloy 800 using the Material to Material Calculator. See the text for details. 
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T_15: Molar Volume and Thermal Expansion Coefficients for L12-
type Al3Sc and Al3Zr Compounds

This example calculates volumetric thermal expansion coefficients of the L12-type Al3Sc and the L12-
type Al3Zr, respectively. Both Al3Zr and Al3Sc are modeled as the same phase (named as AL3SC, since 
Al3Sc is stable while Al3Zr is metastable).

The example set up uses two System Definers and Equilibrium Calculators to plot and compare the 
molar volume and thermal expansion coefficients of the Al3Sc and Al3Zr binary compounds. It uses the 
ALDEMO database, which is the free demonstration version of the TCS Al-based Alloy Database (TCAL) 
and an Experimental File Reader node to read the data from [2015Sah].

Project File Information
 l Folder: Thermo-Calc
 l File name: T_15_Molar_Volume_and_Thermal_Expansion_Coefficient.tcu

The example includes an experimental data (*.exp) file called Al3X.exp.

The same example is also provided in Console Mode as two separate examples: tcex58 and 
tcex59.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 18: Compares the molar volume of both Al3Zr and Al3Sc, which are modeled as the same phase (named 
as AL3SC, since Al3Sc is stable while Al3Zr is metastable).

Figure 19: Compares volumetric thermal expansion coefficients of the L12-type Al3Sc and the L12-type Al3Zr 
using theoretical data with quasiharmonic approximation from [2015Sah].
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Reference

[2015Sah] S. Saha, T. Z. Todorova, J. W. Zwanziger, Temperature dependent lattice misfit and coherency 
of Al3X (X=Sc, Zr, Ti and Nb) particles in an Al matrix. Acta Mater. 89, 109–115 (2015).

More Information

The thermophysical properties are progressively being added to the Thermo-Calc databases starting 
with Thermo-Calc software version 2020a. 

You can learn more about the models by searching the help (press F1 when in 
Thermo-Calc). 

You can find information on our website about the properties that can be calculated with 
Thermo-Calc and the Add-on Modules. 
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T_16: Electrical Resistivity and Thermal Conductivity for Pure 
Copper

This example calculates the electrical resistivity (ELRS) and thermal conductivity (THCD) of pure Cu. It 
makes a One Axis (step) calculation over a wide temperature range, covering both the FCC_A1 state and 
the liquid state. It plots thermal conductivity of the system (both FCC_A1 and liquid) and that of a single 
phase (taking FCC_A1 as an example), respectively. Also it plots electrical resistivity of the system and 
that of FCC_A1.

The example set up uses an Equilibrium Calculator combined with four Experimental File Reader nodes 
that take data from the included 1972Ho_cu_thcd.exp and 1981Ho_cu_elrs.exp files.

The example is available to all users as it uses the ALDEMO database, which is the free 
demonstration version of the TCS Al-based Alloy Database (TCAL).

Project File Information
 l Folder: Thermo-Calc
 l File name: T_16_Electrical_Resistivity_Thermal_Conductivity_Cu.tcu
 l Experimental data files included 1972Ho_cu_thcd.exp and 1981Ho_cu_elrs.exp

The same example is also provided in Console Mode as tcex60.

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 20: The electrical resistivity (ELRS) of pure Cu over a wide temperature range, covering both the FCC_A1 
state and the liquid state. The data was recommended by [1981Ho].

Figure 21: The electrical resistivity (ELRS) of a single phase (FCC_A1) vs. temperature. The data was 
recommended by [1981Ho].
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Figure 22: The thermal conductivity of pure Cu over a wide temperature range, covering both the FCC_A1 
state and the liquid state. The data was recommended by [1972Ho].

Figure 23: The thermal conductivity (THCD) of a single phase (FCC_A1) vs. temperature. The data was 
recommended by [1972Ho].
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References

[1972Ho] C. Y. Ho, R. W. Powell, P. E. Liley, Thermal Conductivity of the Elements. J. Phys. Chem. Ref. 
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More Information

For more advanced examples using the TCAL database, see PM_G_10: Freeze-in Thermal 
Conductivity and PM_G_11: Freeze-in Electrical Resistivity.

The thermophysical properties are progressively being added to the Thermo-Calc databases starting 
with Thermo-Calc software version 2020a. 

You can learn more about the models by searching the help (press F1 when in 
Thermo-Calc). 

You can find information on our website about the properties that can be calculated with 
Thermo-Calc and the Add-on Modules. 
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T_17: Al2O3-MgO Phase Diagram

Al2O3-MgO is one of the basic systems to understand metallurgical slags and refractories. This example  
uses an Equilibrium Calculator to calculate a phase diagram of the pseudo-binary system Al2O3-MgO. It 
also demonstrates how to change components  in the System Definer. In this case,  the components 
AL2O3 and MgO are defined instead of the elements Al, Mg, and O.

Project File and License Information
 l Folder: Thermo-Calc
 l File name: T_17_Al2O3-MgO_phase_diagram.tcu

The TCS Metal Oxide Solutions Database (TCOX)  is used in this example. A valid license for  
version 11 (TCOX11) or newer is required to run the example.  

Visualizations

This example is included as a tutorial on our website and as part of the Graphical Mode 
Examples playlist on our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 24: Phase diagram of the pseudo-binary system Al2O3-MgO.

More Information

This example is also included in the TCS Metal Oxide Solutions Database (TCOX) Validation 
and Calculation Examples Collection. 

There is a similar example provided in Console Mode that uses the OXDEMO database, 
which is available to all users. See tcex17.

Go to the Metal Slag and Oxides Database page  on our website where you can access a 
Validation and Calculation Examples Collection and the Technical Information plus learn 
about its many applications  with the Process Metallurgy Module. Also explore further 
applications of Thermo-Calc to Refractory Oxides and Slags including links to resources such 
as examples, publications, and more.
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T_18: Scheil with Delta Ferrite to Austenite Transition

This is a example of a Scheil solidification simulation using an Fe-0.23C-0.19Si-0.47Mn-0.92Cr-0.09Ni-
0.3Mo (wt%) alloy (Steel P) [2015Sch],  which is a steel that undergoes the peritectic transformation. 

The result of a Scheil Calculator with the default Classic Scheil calculation type is compared to a the 
result of a calculator where the setting Allow delta ferrite to austenite transition in steel is selected. 
Carbon ( C ) is set as a Fast diffuser in both. A comparison to experimental solidus temperature from 
Schaffnit et al. [2015Sch] shows that for this steel, using the Allow delta ferrite to austenite transition 
in steel option gives a much better agreement with experiment than the standard Classic Scheil.    

See Scheil Calculator for an overview of the different Scheil simulation models available. 

Project File and License Information
 l Folder: Thermo-Calc
 l File name: T_18_Scheil_with_Delta_Ferrite_to_Austenite_Transition.tcu

This uses the TCFE database. A license is required to run the example.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 25: Mole fraction of solid as a function of temperature comparing the liquidus and solidus from 
experimental data [2015Sch]. 

Reference
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T_19:  Young's Modulus for Ti-O with Elastic Properties

This is an example which shows the effect of oxygen concentration at three temperatures on  an elastic 
property, Young's modulus, for the HCP_A3 phase in a Ti-O system.

It is well established in the literature that mechanical properties of titanium and its related alloys are 
sensitive to the presence of even dilute concentrations of interstitial solutes such as carbon, hydrogen, 
nitrogen and oxygen. It is therefore important to adequately model the effects of impurities in the host 
lattice when calculating mechanical properties, such as the elastic constants and the corresponding 
moduli determined from these constants.   

Only the elastic constants are assessed, and then used to derive the elastic moduli, 
meaning the experimental data in the plot are completely standalone from the assessment 
process.  

In this example, three Equilibrium Calculators are used with One Axis calculations at different 
temperatures (298 K, 533 K, and 672 K) to show the Young's modulus of an HCP_A3 phase as a function 
of mole percent of O and compared to experimental data from [1957Gra; 1966Fed; 1971Hsu].

Project File and License Information
 l Folder: Thermo-Calc
 l File name: T_19_Elastic_Properties_YoungsModulus_Ti-O.tcu

The   TCS Ti/TiAl-based Alloys Database (TCTI) is used in this example. A valid license is 
required to run the example. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 26:  Effect of oxygen on Young’s modulus in HCP_A3 titanium compared to experimental data 
[1957Gra; 1966Fed; 1971Hsu].
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More Information

As of Thermo-Calc version 2024b, elastic properties are available with Thermo-Calc and the 
TCS Ti/TiAl-based Alloys Database (TCTI) starting with the most recent version (TCTI6). 
These elastic properties will be added to additional databases over time. Subscribe to our 
newsletter to be kept up-to-date on the latest product releases, webinars, user group 
meetings, applications examples, and more.

For more information about the theory about the elastic properties, which includes 
constants and moduli, see About the Elastic Properties.
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Thermo-Calc General Property Models Examples 
Collection
The General Models  are available to all users. 

To run calculations with  the Add-on Property Model Libraries all require a valid 
maintenance license plus a license for the specific database version: Nickel Models (TCNI11 
and newer and MOBNI5 and newer; Noble Metal Alloys Models (TCNOBL3 and newer); 
Steel Models (TCFE9 and newer + MOBFE4 and newer); Titanium Models (TCTI6 and 
newer).

These examples use the Property Model Calculator, an activity available with Thermo-Calc. 

About the Examples

In this section:

PM_G_01: Phase Transition 49

PM_G_02: Coarsening and Interfacial Energy 52

PM_G_03: Driving Force and Interfacial Energy 56

PM_G_04: Yield Strength 58

PM_G_05: Yield Strength NiAlCr 62

PM_G_06: Yield Strength HEA 64

PM_G_07: Hot Crack Susceptibility 66

PM_G_08: Spinodal 68

PM_G_09: T-Zero Temperature 70

PM_G_10: Freeze-in Thermal Conductivity 72

PM_G_11: Freeze-in Electrical Resistivity 74

PM_G_12: Solidus and Liquidus Batch Calculation 76

PM_G_13: Ti Alloy Design for Additive Manufacturing 78

PM_G_14: Ti-Fe T-Zero Martensite 80
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PM_G_15: Columnar to Equiaxed Transition (CET) of a NiAlCr Alloy 82

PM_G_16:  Columnar to Equiaxed Transition of a CMSX-4 Alloy 85

PM_G_17: Columnar to Equiaxed Transition of an IN718 Alloy 89

ǀ 48 of 420



PM_G_01: Phase Transition

The example uses the Property Model Calculator to predict the transition temperature to the unwanted 
brittle sigma phase. The example shows how the temperature is influenced by changes to a steel alloy’s 
composition using the Uncertainty Calculation Type and then you can choose to use either a Histogram 
(frequency diagram) or Probability plot after choosing the Statistical Plot type on the Plot Renderer.

Phase Transition Property Model Settings

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_01_Phase_Transition.tcu

Visualizations

This example is included as a Property Model tutorial on our website and as part of the 
Property Model Calculator playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 1: A property diagram as a result of using the Equilibrium Calculator with a One Axis calculation to 
determine a good starting temperature of the SIGMA phase.

Once you set up the Property Model Calculator, but before running a Grid calculation, it is 
recommended you run a Single calculation to make sure the calculation is valid. 

 l If the subprocess worked, it displays in the Event Log. The Event Log also has the result Relaxed 
condition, referring to the variable, which in this case is temperature. 

 l If the calculation did not work, NaN (not a number) displays instead. Check your configuration set 
up and run the calculation again before moving on to the more complicated calculation.

About the Uncertainty Calculations
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Figure 2: Using the Property Model Calculator with the Phase Transition Model to plot a histogram showing 
how the transition temperature of sigma varies when you vary the composition. The plot changes each time 
you run the calculation because it is taking a random sampling from the composition range set.

The X-axis is labeled the Relaxed Condition, which you can see on the Configuration 
window it is Temperature for the Condition to Vary setting. The Y-axis shows the 
Frequency, which is the number of samples out of 40 where the composition transitions at 
each temperature. You can see that the transitions occur more frequently near the 600 
degree starting point and less frequently at the edges.

Since only one variable can serve as a Relaxed condition per calculation, the quantity that 
is not relaxed has a NaN result in its corresponding result quantity. The Temperature result 
quantity inherits the unit set in the conditions while the Composition result quantity 
inherits the normalization (mole or mass) but always returns a fraction.
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PM_G_02: Coarsening and Interfacial Energy

The example uses the Property Model Calculator and both thermodynamic (FEDEMO) and kinetic 
(MFEDEMO) demonstration steel databases. Using a Grid Calculation Type it produces these plot types: 
a Heat map, a Contour plot and an overlaid plot combining a cross plot with a contour plot(where both 
the interfacial energy and coarsening rate is shown). It also creates a diagram to show the phase 
fractions vs time and a 3D Plot type comparing the coarsening rate coefficient.

Coarsening Property Model Settings and Interfacial Energy Property Model Settings

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_02_Coarsening_and_Interfacial_energy.tcu

Visualizations

This example is included as a Property Model tutorial on our website and as part of the 
Property Model Calculator playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 3: Uses a Property Model Calculator with a Grid Calculation type to plot the coarsening rate coefficient 
as a Heat map.

Figure 4: Uses a Property Model Calculator with a Grid Calculation type to plot the coarsening rate coefficient 
as a 3D plot.

When in the Thermo-Calc help (press F1), go to Rotating 3D Plots to watch a short video 
showing you how to rotate this plot in the Visualizations window.
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Figure 5: Uses a Property Model Calculator with a Grid Calculation type to plot the coarsening rate coefficient 
as a Contour plot. 

Figure 6: Comparing the coarsening rate coefficient and interfacial energy in overlaid plots. 
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Figure 7: A One Axis Equilibrium calculation showing the phase fractions vs T (with a Flexible Mode plot type).
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PM_G_03: Driving Force and Interfacial Energy

The example uses the Property Model Calculator and a thermodynamic demonstration steel database 
(FEDEMO). Using a Grid Calculation type it produces a Contour plot comparing the driving force and 
interfacial energy.

Driving Force Property Model Settings and Interfacial Energy Property Model Settings

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_03_Driving_force_and_Interfacial_energy.tcu

Visualizations

This example is included as a Property Model tutorial on our website and as part of the 
Property Model Calculator playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 8: An overlaid Contour plot comparing the driving force and interfacial energy.

Figure 9: A One Axis Equilibrium calculation showing the Phase fractions vs T.
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PM_G_04: Yield Strength

The example uses the Property Model Calculator and the Yield strength Property Model with a 
thermodynamic demonstration aluminum database (ALDEMO).

Using default options for the precipitation strengthening models, this example compares the Simplified 
model (general), Seidman model (Al-base) and Deschamps model (Al-base) yield strength versus 
precipitate radius to experimental data for an Al-0.3wt%Sc alloy homogenized at 648 °C for 24 hours 
and subsequently aged at 350 °C.

For more settings information, see Yield Strength Property Model: Simplified Mode Settings 
or Yield Strength Property Model: Advanced Mode Settings. For additional theoretical 
information about the models, see About the Yield Strength Property Model.

The Seidman model [2002Sei] considers a combination of a shearing mechanism and Orowan 
dislocation bypass mechanism. For the shearing mechanism, the increase in yield strength results from 
the contributions of ordering strengthening, coherency strengthening, and modulus mismatch 
strengthening.

When Seidman model (Al-base) is selected as the Precipitation strengthening model, the setting for  is 
a constant related to the coherency strengthening of precipitates, which usually varies from 2 to 3. In 
this example, the default  is 2.6 [1985Ard]. The m setting is the parameter that relates to the modulus 
mismatch strengthening and the default is set as 0.85 [1985Ard]. This model is applied in the study of 
precipitation hardening in dilute Al(Sc) alloys containing coherent Al3Sc precipitates. The model 
parameters described above can be adjusted to work for hardenable aluminum alloy calculations from 
the 2000 (Al–Cu and Al–Cu–Mg), 6000 (Al–Mg–Si), and 7000 (Al–Zn–Mg) series.

As a comparison, the Simplified model [2008Zan] only considers the general mechanisms of cutting and 
looping (Orowan mechanism) without regard to any detailed dislocation mechanisms.

When Simplified model (general) is selected as the Precipitation strengthening model, the default 
Critical radius (the critical size ) is optimized against experimental results for dilute Al-Sc. If the 
precipitates are smaller than a critical size (approximately 5–10 nm) the dislocations cut the 
precipitates. The strength of the obstacle is then proportional to the square root of the average radius. 
If the particles are larger than the critical size, , it is less costly for the dislocations to bow round the 
particles and the strengthening contribution is inversely proportional to . Since the Simplified model 
(general) only depends on generic material constants (  and ) it may be applied to any precipitation 
strengthened material.
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The Deschamps model (Al-base) model [1998Des], is for precipitation strengthening, mainly intended 
for use with Al-base alloys. The Deschamps model includes use of Friedel or Kock's statistics for particle 
size distribution. Default parameters are used to match a dilute Al-Sc alloy with Al3Sc precipitates. As is 
done for the other precipitation strengthening models, a critical radius, describing the transition from 
cutting to looping, must be specified when you are setting up the configuration.

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_04_Yield_Strength.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 10: Strength vs Radius - Simplified compared to experimental data from [2002Sei].

Figure 11: Strength vs Radius - Seidman compared to experimental data from [2002Sei].
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Figure 12: Strength vs Radius - Deschamps compared to experimental data from [2002Sei].
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PM_G_05: Yield Strength NiAlCr

The example uses the Property Model Calculator and the Yield strength Property Model with a 
thermodynamic demonstration nickel database (NIDEMO).

The Reppich model is developed for calculation of precipitation strengthening in Ni-based super alloys 
consisting mainly of gamma prime (γ') precipitates in a gamma matrix. The example shows a calculation 
of the precipitation strengthening vs precipitate radius in a Ni-10at%Al-10at%Cr alloy.

This example uses the Reppich model [1982Rep] which is developed and rests on existing hardening 
models estimating the increase of the yield stress due to pairwise particle cutting and antiphase domain 
boundary (APB) formation. The effect of the anisotropy on the dislocation line tension of two-phase 
material and on the Orowan stress is taken into account. Compared to conventional APB hardening 
theories, this model can be applied to large volume fraction of precipitates in the anisotropic systems.

For more settings information, see Yield Strength Property Model: Simplified Mode Settings 
and for additional theoretical information about the models, see About the Yield Strength 
Property Model.

For the settings input of the Reppich model (Ni-base):

 l A is a numerical factor depending on the morphology of the precipitates. For spherical particles, 
A equals to 0.72.

 l w represents the elastic repulsion between the strongly paired dislocations, which can be 
determined by the experimental data [1979Hüt].

In this example, A and w are set by default to 0.7639 and 0.2919, respectively.

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_05_Yield_Strength_NiAlCr.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 13: Reppich model plotted with results and experimental data for PE16, all data is normalized with the 
square root of the volume fraction of precipitate.
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PM_G_06: Yield Strength HEA

The example uses the Property Model Calculator and the Yield strength Property Model with the 
thermodynamic TCS High Entropy Alloys Database (TCHEA). It is an example of solid solution 
strengthening, which is the contribution to total strength due to the elastic strains in the crystal lattice 
caused by alloying elements of a lattice parameter differing from the main constituent. The example 
shows the solid solution strengthening at 300 K and 411 K over the full solubility range for the Mo-Ta 
system as compared to experimental data  [1972Ste].

For more settings information, see Yield Strength Property Model: Simplified Mode Settings 
and for additional theoretical information about the models, see About the Yield Strength 
Property Model.

Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_06_Yield_Strength_HEA.tcu

This example requires the use of the TCS High Entropy Alloys Database (TCHEA). A license is 
required to run the example.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 14: The solid solution strengthening over the full solubility range for the Mo-Ta system as compared to 
experimental data [1972Ste].
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PM_G_07: Hot Crack Susceptibility

The example uses the Property Model Calculator and the Crack Susceptibility Coefficient Property 
Model to calculate the hot tearing tendency during solidification for an Al-Si alloy. The ALDEMO: 
Aluminum Demo Database  is used and this example is available to all users. 

Hot tearing is one of the most common and serious defects encountered during the casting of, for 
example, aluminum alloys. In general, it is defined by the formation of a macroscopic fissure in a casting 
as a result of stress and the associated strain, generated during cooling, at a temperature above the 
non-equilibrium solidus.

The Model is based on the publication by Yan and Lin [2006Yan] and uses experimental data [1955Pum; 
1976Feu; 2004Bar] from this paper. 

The experimental hot cracking susceptibility of an alloy is defined as the ratio between the cracking 
length for that alloy and the maximum cracking length in the alloy system studied. Considering the 
uncertainties and difficulties in hot tearing measurements, the calculated hot tearing tendencies are in 
excellent agreement with the experimental data. The typical L-shaped curve is well reproduced in the 
current prediction. It rapidly increases at a low solute content and has a maximum at a composition of 
around 0.5 wt pct Si.

See About the Crack Susceptibility Coefficient Property Model for background information 
about this Property Model.

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_07_Hot_Crack_Susceptibility.tcu

Visualizations

This example is included as a Property Model tutorial on our website and as part of the 
Property Model Calculator playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 15: The plot compares the predicted cracking susceptibility/composition curve for the Al-Si system with 
the experimental hot tearing tendencies [1955Pum; 1976Feu; 2004Bar].
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PM_G_08: Spinodal

The example uses the Property Model Calculator and the Spinodal Property Model to  calculate the so-
called spinodal curve for the BCC_A2 miscibility gap in the system Fe-Cr. The FEDEMO: Iron Demo 
Database  is used and this example is available to all users. 

Two Property Model Calculators are used in this example. The spinodal curve (a One Axis calculation), is 
overlaid on top of a the Fe-Cr Phase diagram calculation. As can be seen in the plot, the spinodal curve 
for BCC goes through the one-phase region for Sigma. This is because the spinodal curve for a phase is 
calculated when all other phases are suspended.

 About the Spinodal Property Model

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_08_Spinodal.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

ǀ 68 of 420

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured


Figure 16: An Fe-Cr spinodal curve for BCC goes through the one-phase region for Sigma. 
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PM_G_09: T-Zero Temperature

The example uses the Property Model Calculator and the T-Zero Temperature Property Model to  
calculate the so-called T0 line for the two-phase field FCC_A1 and BCC_A2 in the Fe-Ni system.  The line 
is plotted together with the phase diagram for the same Fe-Ni system. The FEDEMO: Iron Demo 
Database  is used and this example is available to all users. 

The T0 temperature is defined as the temperature where two phases of identical chemical composition 
have the same molar Gibbs free energy. This temperature is an important quantity in the field of 
diffusionless phase transformations, e.g. martensitic transformation, since it is the upper limit where 
diffusionless phase transformations can occur.

Two Property Model Calculators are used in this example. The T0 line (a One Axis calculation) for the 
two-phase field FCC_A1 and BCC_A2 is overlaid on top of a the Fe-Ni Phase diagram calculation. 

About the T0 Temperature Property Model

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_09_T-Zero_temperature.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 17: In this plot for the Fe-Ni system, the T0 line for the FCC_A1 and BCC_A2 phases is located in the 
middle of the two-phase region. No solution for the T0 temperature exists above about 30 mass% Ni.
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PM_G_10: Freeze-in Thermal Conductivity

The example uses the Property Model Calculator and the Equilibrium with Freeze-in Temperature 
Property Model to compare the use of the model with thermal conductivity with and without grain 
boundary (GB) phase scattering being included in the calculation. 

The TCS Al-based Alloy Database (TCAL) is used to evaluate a 7075_T6 alloy (Al-1.6Cu-2.5Mg-5.6Zn-
0.25Fe-0.15Mn-0.23Cr-0.2Ti-0.2Si) mass%. The "T6" in the alloy name means that the alloy has been 
artificially peak-aged, i.e. the matrix is almost depleted. The heating is assumed to be at a typical 
artificial aging temperature of 150 °C. The temperature has then been increased for measuring of the 
reported values thermal conductivity at 400, 500, and 532 °C.

The thermal conductivity  due to grain boundary phase scattering is approximated as a scattering 
constant times the total volume fraction of the grain boundary phases. The contribution to thermal 
conductivity is assumed to be related to that to electrical resistivity, following the Wiedemann-Franz 
law.

The calculation set up assumes that the alloy reaches equilibrium at the peak-age temperature, i.e. that 
the amounts of phases and their composition freeze-in at 150 °C and that these do not change for the 
evaluation of thermal conductivity at the temperatures 400, 500, and 532 °C. Calculations are compared 
between accounting and ignoring contributions from grain boundary (GB) phase scattering. 

As can be seen in Figure 18, the calculation including the approximate effect of grain boundary phase 
scattering is close to the experimentally measured values. Excluding the effect of grain boundary phase 
scattering slightly overestimates the thermal conductivity. Experimental data is from [2008ASM].

About the Equilibrium with Freeze-in Temperature Property Model

Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_10_Freeze_In_Thermal_Conductivity.tcu

The  TCS Al-based Alloy Database (TCAL) is used in this example. A valid license for  version 7 
(TCAL7) or newer is required to run the example.  
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 18: Comparing the freeze-in temperature for the 7075_T6 alloy with and without grain boundary (GB) 
scattering included in the calculations.  

Reference

[2008ASM] ASM Handbook Committee, ASM Handbook Volume 15: Casting. ASM International, p. 468-
481, 2008, ISBN 978-0-87170-711-6.
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PM_G_11: Freeze-in Electrical Resistivity

The example uses the Property Model Calculator and the Equilibrium with Freeze-in Temperature 
Property Model to compare the use of the model for electrical resistivity with and without grain 
boundary (GB) scattering being included in the calculation. 

The TCS Al-based Alloy Database (TCAL) is used to evaluate a 4032-O alloy (Al-0.9Cu-1.0Mg-0.9Ni-12.2Si) 
mass%. The "O" in the alloy name means that the Al alloy has been heat-treated at a typical 
temperature of 350 °C. The measurement of electric resistivity is usually performed at room 
temperature.

The electrical resistivity due to grain boundary phase scattering is approximated as a scattering constant 
times the total volume fraction of the grain boundary phases.

The calculation set up assumes that the alloy reaches equilibrium at the "O" heat-treated temperature, 
i.e. that the amounts of phases and their composition freeze-in at 350 °C and that these do not change 
for the evaluation of electrical resistivity at the room temperature. Calculations are compared between 
accounting and ignoring contributions from grain boundary (GB) scattering. 

As can be seen from Figure 19, the calculated electrical resistivity at room  temperature, including grain 
boundary phase scattering, is very close to the experimentally measured value (4.3E-8) for the alloy. 
Excluding the grain boundary phase scattering somewhat underestimates the electrical resistivity for the 
alloy. Experimental data is from [1993Dav]. 

About the Equilibrium with Freeze-in Temperature Property Model

Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_11_Freeze_In_Electric_Conductivity.tcu

The  TCS Al-based Alloy Database (TCAL) is used in this example. A valid license for  version 7 
(TCAL7) or newer is required to run the example.  
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 19: Comparing the freeze-in temperature for the 4032-O alloy with and without grain boundary (GB) 
scattering included in the calculations.  

Reference

[1993Dav] J.R. Davis, ASM Specialty Handbook: Aluminum and Aluminum Alloys, 1993, ASM 
International. Pages: 784. ISBN: 978-0-87170-496-2.
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PM_G_12: Solidus and Liquidus Batch Calculation

The example uses the Property Model Calculator and the Liquidus and Solidus Temperature Property 
Model to demonstrate the use of the Batch Calculation Type. 

The   thermodynamic demonstration steel database (FEDEMO) is used along with a randomized set of 
experimental data points that are shown on the Configuration window in a table. The data showing in 
this example is imported from a data file prepared with specific data entry requirements. 

A variety of compositions for an Fe-Cr-Mn-Ni-C alloy is used for the calculations; these compositions are 
also taken from the same data file. When the heading includes Exp, then these columns are considered 
experimental data by Thermo-Calc, where in this example it is the columns titled Exp Liq temp C and 
Exp Sol temp C. This experimental data can then be plotted  as a function of the calculated 
solidus/liquidus temperature and compared on the plot using a Cross plot, which is selected on the Plot 
Renderer. The limits are shown using the setting RMS (root mean square). 

The experimental data entered into the batch data file is unitless even though the actual 
experimental data unit is Celsius (as written in the header text). In order for the plot and 
calculations to match, Celsius is chosen as the temperature unit when defining the 
Solidus/Liquidus Property Model and all the axes manually scaled to the same limits (1360 
→ 1520).  

Working with Batch Calculations

Project File  Information
 l Folder: Property Models → General
 l File name: PM_G_12_Solidus_and_Liquidus_Batch_Calculation.tcu

Visualizations

This example is included as a Property Model tutorial on our website and as part of the 
Property Model Calculator playlist on our YouTube channel. 
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 20: A comparison of experimental liquidus and solidus data using a Cross plot with a Batch calculation. 
A root mean square (RMS) setting shows the distribution of the data points. 
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PM_G_13: Ti Alloy Design for Additive Manufacturing

This in-depth example, which is showcased on our website, uses the Property Model Calculator to find 
the optimal composition for a titanium-based alloy to be used for additive manufacturing applications.

Additive manufacturing provides new opportunities to fabricate complex parts. However, traditional 
alloys may not be readily printable using techniques such as laser powder bed fusion. As such, the 
development of new alloys may be necessary to fully realize the benefits of additive manufacturing 
technologies.

In this example, inspired by the work of Ackers et al. [2021Ack], Batch calculations within the Property 
Model Calculator are used to identify candidate titanium alloy chemistries for biomedical implant 
applications using the thermodynamic TCS Ti/TiAl-based Alloys Database (TCTI). To optimize printability 
and material weight, the liquidus temperature, solidus temperature, and density of 2000 randomized 
titanium alloy chemistries from the Ti-Nb-Zr-Sn-Ta-Fe-Mo system are calculated. An estimate of alloy 
cost is also made for each alloy. Taken together, this methodology can be used to identify compositions 
of interest and accelerate material development activities.

Figure 21: Cost estimate histogram for 2000 randomized chemistries from the Ti-Nb-Zr-Sn-Ta-Fe-Mo system.  
The cost estimate was calculated using a user-defined function in the Property Model Calculator.
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Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_13_Ti_Alloy_Design_for_AM.tcu

The   TCS Ti/TiAl-based Alloys Database (TCTI) is used in this example. A valid license for  
version 4 (TCTI4) or newer is required to run the example.  

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 

Reference

[2021Ack] M. A. Ackers, O. M. D. M. Messé, U. Hecht, Novel approach of alloy design and selection for 
additive manufacturing towards targeted applications. J. Alloys Compd. 866, 158965 (2021). 
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PM_G_14: Ti-Fe T-Zero Martensite

The example uses the Property Model Calculator and the T-Zero Temperature Property Model to 
demonstrate the martensitic BCC → HCP transformation for a binary Ti-Fe system. A setting is used to 
include a Gibbs energy addition to the second phase, which allows for the inclusion of an energy barrier 
for martensitic phase transformations. 

About the T0 Temperature Property Model

Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_14_Ti_Fe_T-Zero_Martensite.tcu

The   TCS Ti/TiAl-based Alloys Database (TCTI) is used in this example. A valid license is 
required to run the example. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 22: The T-Zero (barrier = 0) line is the temperature without energy addition, the solid blue line is the T-
Zero temperature with an energy addition of 4000*w(Fe) [J/mol], that well reproduces the experimental data 
from Duwez (1952).

Reference

[1952Duw] P. Duwez, “The Martensite Transformation Temperature in Titanium Binary Alloys, Third 
Technical Report” (U.S. Atomic Energy Commission, 1952).
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PM_G_15: Columnar to Equiaxed Transition (CET) of a NiAlCr Alloy

This example uses the Property Model Calculator and the Columnar to Equiaxed Transition Property 
Model with nickel demo databases to  mimic the result of CMSX-4 alloy, which compares the tip radius 
and undercooling with growth velocity. 

A Ni-26Al-9Cr (at.%) alloy is used so that its calculated undercooling is close to that of a 10-component 
CMSX-4 alloy. A One Axis calculation for the FCC_L12 primary phase is done using the CET parameters 
entered on the Property Model Calculator Configuration window. 

The settings used are the same as those from the literature [2001Gäu], i.e.:

 l Number of nucleation sites: 2.0E15/m3

 l Equiaxed exponent: 3.4
 l Nucleation undercooling: 2.5 K
 l Solve for: Thermal gradient
 l Equiaxed fractions: 0.0066 0.1

About the Columnar to Equiaxed Transition (CET) Property Model

Project File Information
 l Folder: Property Models → General
 l File name: PM_G_15_Ni-Al-Cr_Columnar_Equiaxed_Transition.tcu

The NIDEMO and MNIDEMO databases are used in this example and it is available to all 
users.

Also see these examples that use the same Property Model. However, these examples 
require licenses as they use the TCS Ni-based Superalloys Database (TCNI) and TCS Ni-alloys 
Mobility Database (MOBNI): PM_G_16:  Columnar to Equiaxed Transition of a CMSX-4 Alloy 
and PM_G_17: Columnar to Equiaxed Transition of an IN718 Alloy.
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 23: Tip radius and undercooling vs growth velocity  for a Ni-26Al-9Cr alloy.
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Figure 24: CET curves for a Ni-26Al-9Cr alloy using experimental data from [2001Gäu]. Also see PM_G_16 to 
compare the results to the CMSX-4 alloy results.

Reference

[2001Gäu] M. Gäumann, C. Bezençon, P. Canalis, W. Kurz, Single-crystal laser deposition of superalloys: 
processing–microstructure maps. Acta Mater. 49, 1051–1062 (2001).
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PM_G_16:  Columnar to Equiaxed Transition of a CMSX-4 Alloy

This example uses the Property Model Calculator and the Columnar to Equiaxed Transition Property 
Model with a CMSX-4 alloy to compare calculated CET curves to experimental data. 

About the Columnar to Equiaxed Transition (CET) Property Model

A 10-component system, with a composition from Gäumann et al. [2001Gäu], is used for this simulation 
of a CMSX-4 alloy. 

 Co Cr Al Ti W Ta Re Hf Mo Ni

wt.% 9.0 6.5 5.6 1.0 6.0 6.5 3.0 0.1 0.6 Bal

at.% 9.262 7.581 12.587 1.267 1.979 2.178 0.977 0.034 0.379 Bal

Alloy composition of CMSX-4 [2001Gäu].

The results are compared with literature data (epitaxial laser metal forming) and the original model  
[1999Gäu; 2001Gäu]. 

A One Axis calculation for the FCC_L12 primary phase is done using the CET parameters entered on the 
Property Model Calculator Configuration window. 

The settings entered include:

 l Interfacial energy:    0.25 J/m2,  which gives a Gibbs-Thomson coefficient of 1.87 x 10-7 mK,  in 
agreement with the literature [2001Gäu]. 

 l Number of nucleation sites: 2.0E15/m3

 l Nucleation undercooling : 3.0 K 
 l Equiaxed exponent: 3.4
 l Solve for: Thermal gradient
 l Equiaxed fractions: 0.0066 0.1

In the calculation, the nucleation undercooling is slightly larger than originally used (2.5 K) [2001Gäu], 
since it has been found that at a low speed limit, the Property Model gives an undercooling close to 3 K. 

The original value is arbitrary and does not affect the results at a high speed range. 
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Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_16_CMSX-4_Columnar_Equiaxed_Transition.tcu

To run this example requires a license for the TCS Ni-based Superalloys Database (TCNI) 
version 12 (TCNI12) or newer and the TCS Ni-alloys Mobility Database (MOBNI) version 6 
(MOBNI6) or newer. 

Example PM_G_15: Columnar to Equiaxed Transition (CET) of a NiAlCr Alloy uses demo 
databases available to everyone and mimics this alloy in its results. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 25: Tip radius and undercooling vs growth velocity  for a CMSX-4 alloy.

Figure 26: Calculated CET curves (solid lines) in comparison to experimental data (data points) and 
calculations (dashed lines) from the literature [2001Gäu].

References

[1999Gäu] M. Gäumann, PhD thesis, Epitaxial laser metal forming of a single crystal superalloy, École 
polytechnique fédérale de Lausanne (EPFL) (1999).
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[2001Gäu] M. Gäumann, C. Bezençon, P. Canalis, W. Kurz, Single-crystal laser deposition of superalloys: 
processing–microstructure maps. Acta Mater. 49, 1051–1062 (2001).

More Information

Also see these examples that use the same Property Model: PM_G_15: Columnar to 
Equiaxed Transition (CET) of a NiAlCr Alloy and PM_G_17: Columnar to Equiaxed Transition 
of an IN718 Alloy.
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PM_G_17: Columnar to Equiaxed Transition of an IN718 Alloy

The example uses the Property Model Calculator and the Columnar to Equiaxed Transition Property 
Model to compare calculated CET curves for an IN718 alloy to experimental data. 

About the Columnar to Equiaxed Transition (CET) Property Model

A One Axis calculation for the FCC_L12 primary phase is done using the CET parameters entered on the 
Property Model Calculator Configuration window. 

The settings entered include:

 l Interfacial energy:    0.5 J/m2. 
 l Number of nucleation sites: 4.0E11/m3

 l Nucleation undercooling : 4.0 K 
 l Equiaxed exponent: 3.13
 l Solve for: Thermal gradient
 l Equiaxed fractions: 0.01 0.49 0.99

The literature data from Polonsky et al. [2020Pol] are not purely experimental data, but rather 
combined with experimental equiaxed evidence and model calculations with numerical values of 
thermal gradients, growth velocity as well as tip undercooling. Polonsky et al. estimated tip 
undercooling based on a Scheil calculation, which smeared out the composition inhomogeneity at the 
dendrite front, hence underestimating the undercooling. Since both tip undercooling and nucleation site 
density promotes the formation of equiaxed crystals, an increase in undercooling in this example 
calculation leads to a decrease in nucleation site density compared to the results in [2020Pol] if one 
were fitting the same set of data.

Project File and License Information
 l Folder: Property Models → General
 l File name: PM_G_17_IN718_Columnar_Equiaxed_Transition.tcu
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To run this example requires a license for the TCS Ni-based Superalloys Database (TCNI) 
version 12 (TCNI12) or newer and the TCS Ni-alloys Mobility Database (MOBNI) version 6 
(MOBNI6) or newer. 

Example PM_G_15: Columnar to Equiaxed Transition (CET) of a NiAlCr Alloy uses demo 
databases available to everyone. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 27: Tip radius and undercooling vs growth velocity  for an IN718  alloy.
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Figure 28: Calculated CET curves for IN718 in comparison with literature data [2020Pol].

Reference

[2020Pol] A. T. Polonsky, N. Raghavan, M. P. Echlin, M. M. Kirka, R. R. Dehoff, T. M. Pollock, 3D 
Characterization of the Columnar-to-Equiaxed Transition in Additively Manufactured Inconel 718, in 
Superalloys 2020 (2020), pp. 990–1002.

More Information

Also see these examples that use the same Property Model: PM_G_15: Columnar to 
Equiaxed Transition (CET) of a NiAlCr Alloy and PM_G_16:  Columnar to Equiaxed Transition 
of a CMSX-4 Alloy.

ǀ 91 of 420



Additive Manufacturing (AM) Module 
Examples Collection

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. Without a license you are in Demo Mode where you can, for example, open 
and view example set ups, run some examples, add templates and nodes to the Project 
window, adjust some Configuration settings, and preview some functionality on the 
Visualizations window. 

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

In this section:

AM_01: Transient Simulation of a Single Track 94

AM_02: Transient and Steady-state Simulations of a Single Track 101

AM_03: Steady-state Simulations 107

AM_04: Scheil Transient Steady-state 112

AM_05: Using AM Calculator Probe Data with the Diffusion Module (DICTRA) 119

AM_06a: Calibrating a Heat Source for a 316L Steel 128

AM_06b: Using the Calibrated Heat Source for a 316L Steel 134

AM_07: Batch Calculations for an IN718 Alloy 139

AM_08a: Grid Calculation for a Ti64 Alloy 146

AM_08b: Batch Calculations for a Ti64 Alloy 153

AM_09a: Grid Calculation for an SS316L Alloy 160

AM_09b: Batch Calculations for an SS316L Alloy 165

AM_10: CET Transition in an IN718 Alloy 171

AM_11: Comparing Single Tracks Printed on Casted and LPBF Substrates 176
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AM_12: Using AM Calculator Probe Data with the Precipitation Module (TC-PRISMA) 186
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AM_01: Transient Simulation of a Single Track

The following example is part of a series showing some of the features of the Additive Manufacturing 
(AM) Module and the AM Calculator. In this example, a single track simulation is performed using the 
Transient model of the AM Calculator.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_01_Transient_DE_No_Marangoni.tcu

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. Without a license you are in Demo Mode where you can, for example, open 
and view example set ups, run some examples, add templates and nodes to the Project 
window, adjust some Configuration settings, and preview some functionality on the 
Visualizations window. 

Some examples (AM_01, AM_02, AM_03,  and AM_06b) are available to all users.  These 
examples can be run without an additional Additive Manufacturing license when you are in 
DEMO (demonstration) mode. However, the AM Module is not available with the 
Educational version of Thermo-Calc. Search the help for Available Options with the Additive 
Manufacturing (AM) Module.  See Available Options for details.

Material Properties

These properties are the same for both AM_01 and AM_02.

 l Inconel 738LC: Ni-15.8 Cr-8.6 Co-2.7 W-3.3 Ti-3.6 Al-1.8 Ta-1.8 Mo-0.04 Fe-0.8 Nb-0.002 Mn-0.1 
C Mass percent.

 l Database: TCNI12
 l The material property was pre-calculated, and stored as a built-in material library of the Additive 

Manufacturing (AM) Module.
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Reference

[2021Gra] D. Grange, A. Queva, G. Guillemot, M. Bellet, J.-D. Bartout, C. Colin, Effect of processing 
parameters during the laser beam melting of Inconel 738: Comparison between simulated and 
experimental melt pool shape. J. Mater. Process. Technol. 289, 116897 (2021).

Model Configuration

The transient model solves for the heat equation in the entire 3D domain, including the melt pool, and is 
therefore, computationally expensive to solve. The fluid flow inside the melt pool due to the Marangoni 
effect is not included in this example. The double ellipsoidal, or the so-called Goldak heat source model, 
is used to predict melt pool size and temperature distribution during single track scanning. The 
parameters for the double ellipsoidal heat source are computed using optimization in a steady-state 
case for the given process parameters (power and scanning speed) and the melt pool size reported in 
the paper by Grange et al. [2021Gra]. The resulting parameters are shown in Figure 1.

Figure 1: Optimized heat source parameters entered on the AM Calculator for the experiment given in Grange 
et al. [2021Gra] with power = 230 W and scanning speed = 960 mm/s.

The geometry for a transient simulation, as given in the paper by Grange et al. [2021Gra], is shown in 
Figure 2. The base plate is 2 mm in length, 0.5 mm in width, and with a thickness of 0.95 mm. A layer of 
powder with a thickness of 55 μm is deposited on the solid substrate. The powder layer, however, has 
the same material properties as the solid substrate. The laser beam with a power of 230 W develops 
linear scanning with constant velocity 960 mm/s. The trajectory evolves from initial position (x, y) = 
(0.25, 0.25) mm to final position (1.75, 0.25) mm on the top surface.
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Figure 2: The geometry used for the Additive Manufacturing (AM) Module examples AM_01 and AM_02.

Two probes monitor the temporal evolution of temperature at positions shown in Figure 3. The results 
can be presented by tabulated data or as 2D graph plots.

Figure 3: Probe positions for Probes P1 and P2, where P1 is placed exactly on the scanning track while P2 is 
placed at a distance of 0.04 mm from the track, as shown in a close up of the probes on the Visualizations 
window.
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Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes at least 30 minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).

 l Geometry: View the geometry and adjust parameters visually by changing inputs on the 
Configuration window. Add probes needed.

 l Melt pool and other dynamically changing features can also be visualized and changed.
 l Plot results: After completing the set up and performing the calculation, to view the matching 

name of the node on tab(s) in the Visualizations window, click a Plot Renderer node in the 
Project window or click the tabs individually in the Visualizations window.

In the surface plot it shows the temperature distribution after the scanning process is completed. It is 
noted that the melt pool shape reaches a steady-state when the laser beam approaches the end of the 
scanning track. The melt pool dimensions at the end of scanning track is given in the table.

Melt Pool Dimension Size (mm)

Width 0.125

Depth 0.144

Length 1.12

If you are in the project file, click the Probe plot node in the Project window and the 3D 
Plot tab in the Visualizations window.
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Figure 4: Surface plot of temperature distribution after the single track scan is completed. Probes P1 and P2 
can also be seen on the top surface.

It is also possible to plot quantities at different cross-sections inside the domain by selecting the Slice 
checkbox on the Plot Renderer Configuration window under the 3D Plot tab. The next figure shows the 
temperature slices plotted at cross-sections orthogonal to the scanning direction.

Figure 5: Slices of the computational domain, orthogonal to the scanning direction, showing temperature 
distribution at different cross-sections. Red tubes show the contour of the melt pool (at liquidus temperature).
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Figure 6: 2D probe plot showing temperature evolution as a function of time at probes P1 and P2.

Figure 7: 2D plot over line showing temperature in the tail of the melt pool as a function of distance plotted 
along the scanning track.

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 
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Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_02: Transient and Steady-state Simulations of a Single Track

The following example is part of a series showing some of the features of the Additive Manufacturing 
(AM) Module and the AM Calculator. This example builds on the work done by Grange et al. [2021Gra] 
and is similar to example AM_01. The difference however is that in this example a single track 
simulation is performed using Transient with heat source from Steady-state model instead of the 
Transient model.

The Transient with heat source from Steady-state model exploits the assumption that the melt pool 
size and temperature distribution reaches a steady-state almost instantly and thus first solves for a 
Steady-state case with the given process parameters. The result from the Steady-state in the form of 
temperature distribution in the melt pool is then mapped as a heat source in the transient simulation. 
This novel approach is much faster and efficient than the approach used in example AM_01 where the 
heat equation is solved in the entire 3D domain.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_02_TransientSS_DE.tcu

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. Without a license you are in Demo Mode where you can, for example, open 
and view example set ups, run some examples, add templates and nodes to the Project 
window, adjust some Configuration settings, and preview some functionality on the 
Visualizations window. 

Some examples (AM_01, AM_02, AM_03,  and AM_06b) are available to all users.  These 
examples can be run without an additional Additive Manufacturing license when you are in 
DEMO (demonstration) mode. However, the AM Module is not available with the 
Educational version of Thermo-Calc. Search the help for Available Options with the Additive 
Manufacturing (AM) Module.  See Available Options for details.

Material Properties

These properties are the same for both AM_01 and AM_02.
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 l Inconel 738LC: Ni-15.8 Cr-8.6 Co-2.7 W-3.3 Ti-3.6 Al-1.8 Ta-1.8 Mo-0.04 Fe-0.8 Nb-0.002 Mn-0.1 
C Mass percent.

 l Database: TCNI12
 l The material property was pre-calculated, and stored as a built-in material library of the Additive 

Manufacturing (AM) Module.

Reference

[2021Gra] D. Grange, A. Queva, G. Guillemot, M. Bellet, J.-D. Bartout, C. Colin, Effect of processing 
parameters during the laser beam melting of Inconel 738: Comparison between simulated and 
experimental melt pool shape. J. Mater. Process. Technol. 289, 116897 (2021).

Model Configuration

The transient model solves for the heat equation in the entire 3D domain, including the melt pool, and is 
therefore, computationally expensive to solve. The fluid flow inside the melt pool due to the Marangoni 
effect is not included in this example. The double ellipsoidal, or the so-called Goldak heat source model, 
is used to predict melt pool size and temperature distribution during single track scanning. The 
parameters for the double ellipsoidal heat source are computed using optimization in a steady-state 
case for the given process parameters (power and scanning speed) and the melt pool size reported in 
the paper by Grange et al. [2021Gra]. The resulting parameters are shown in Figure 8.

Figure 8: Optimized heat source parameters entered on the AM Calculator for the experiment given in Grange 
et al. [2021Gra] with power = 230 W and scanning speed = 960 mm/s.

The geometry for a transient simulation, as given in the paper by Grange et al. [2021Gra], is shown in 
Figure 9. The base plate is 2 mm in length, 0.5 mm in width, and with a thickness of 0.95 mm. A layer of 
powder with a thickness of 55 μm is deposited on the solid substrate. The powder layer, however, has 
the same material properties as the solid substrate. The laser beam with a power of 230 W develops 
linear scanning with constant velocity 960 mm/s. The trajectory evolves from initial position (x, y) = 
(0.25, 0.25) mm to final position (1.75, 0.25) mm on the top surface.
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Figure 9: The geometry used for the Additive Manufacturing (AM) Module examples AM_01 and AM_02.

Two probes monitor the temporal evolution of temperature at positions shown in Figure 10. The results 
can be presented by tabulated data or as 2D graph plots.

Figure 10: Probe positions for Probes P1 and P2, where P1 is placed exactly on the scanning track while P2 is 
placed at a distance of 0.04 mm from the track, as shown in a close up of the probes on the Visualizations 
window.
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Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).

 l Geometry: View the geometry and adjust parameters visually by changing inputs on the 
Configuration window.

 l Melt pool and other dynamically changing features can also be visualized and changed.
 l Plot results: After completing the set up and performing the calculation, to view the matching 

name of the node on tab(s) in the Visualizations window, click a Plot Renderer node in the 
Project window or click the tabs individually in the Visualizations window.

With the example open and after it is run, the following is a summary of what is visible on the 
Visualizationswindow.

The figure below shows the surface plot of temperature distribution after the single track scanning is 
completed. The temperature profile is qualitatively similar to the one in example AM_01, however the 
maximum temperature is slightly lower in example AM_02. This could be due to selection of a coarse 
mesh in both examples which sometimes could affect the maximum temperature.

Figure 11: Surface plot of temperature distribution after the single track scan is completed. Probes P1 and P2 
can also be seen on the top surface.
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The melt pool dimensions for AM_02 are given in the following table, which are very similar to the melt 
pool dimensions obtained in example AM_01.

Melt Pool Dimension Size (mm)

Width 0.127

Depth 0.129

Length 1.12

A qualitative comparison between AM_01 and AM_02 can also be made by looking at probe plots. The 
probe plot for AM_02 is given in Figure 12.

Figure 12: 2D probe plot showing temperature evolution as a function of time at probes P1 and P2.

Despite the fact that maximum temperature is higher in AM_01, the temperature profile in the tail of 
the melt pool and close to the melt pool is very similar. This can also be concluded by comparing plot 
over lines for the two examples, where the plot over line for AM_02 is given in Figure 13.
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Figure 13: 2D plot over line showing temperature in the tail of the melt pool as a function of distance plotted 
along the scanning track.

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_03: Steady-state Simulations

The following example is part of a series showing some of the features of the Additive Manufacturing 
(AM) Module and the AM Calculator.

In this example steady-state simulations are performed for IN625 with different conditions i.e.

 i. without fluid flow in the melt pool,

 ii. with fluid flow in the melt pool due to Marangoni effect, and

 iii. using separate material properties for the powder.

and then the results are compared to demonstrate the effects of fluid flow and separate material 
properties for the powder on the temperature distribution as well as on the shape of the melt pool.

For the first two simulations, the same material properties are used for both powder and 
solid substrate while for the third simulation no fluid flow is included in the melt pool.

In steady-state simulations it is assumed that the heat source (laser beam) moves with a 
uniform speed relative to the base plate. In this case, the model is solved by modifying 
governing equations to a reference frame attached to a moving heat source. Furthermore, 
in steady-state mode you can make use of symmetry along the width of the geometry and 
solve for only half of the domain.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_03_Steady.tcu

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. Without a license you are in Demo Mode where you can, for example, open 
and view example set ups, run some examples, add templates and nodes to the Project 
window, adjust some Configuration settings, and preview some functionality on the 
Visualizations window. 
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Some examples (AM_01, AM_02, AM_03,  and AM_06b) are available to all users.  These 
examples can be run without an additional Additive Manufacturing license when you are in 
DEMO (demonstration) mode. However, the AM Module is not available with the 
Educational version of Thermo-Calc. Search the help for Available Options with the Additive 
Manufacturing (AM) Module.  See Available Options for details.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).

 l Geometry: View the geometry and adjust parameters visually by changing inputs on the 
Configuration window.

 l Melt pool and other dynamically changing features can also be visualized and changed.
 l Plot results: After completing the set up and performing the calculation, to view the matching 

name of the node on tab(s) in the Visualizations window, click a Plot Renderer node in the 
Project window or click the tabs individually in the Visualizations window.
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Results Discussion

Figure 14: A comparison of the melt pool depth for different simulation conditions; (top) without fluid flow, 
(middle) with fluid flow in the melt pool and (bottom) with different material properties for the powder layer. 
Isocontours show the boundaries of (inner) melt pool and (outer) mushy zone.

The table shows a comparison of the melt pool dimensions for different simulation conditions.
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Simulation set up
Melt Pool Dimensions (mm)

Width Depth Length

Without fluid flow 0.156 0.032 0.300

With fluid flow 0.188 0.040 0.619

Separate powder material properties 0.250 0.039 1.670

Figure 14 shows the effect of fluid flow on temperature distribution and size of the melt pool for the 
given process parameters. A quantitative comparison is also given in the table. It can be seen that with 
the addition of fluid flow due to gradient in surface tension (Marangoni effect), the melt pool tends to 
increase its dimensions in all three directions. This is because the negative gradient in surface tension 
with respect to the temperature creates an outward flow on the surface of the melt pool which 
consequently increases the width and length of the melt pool, as shown in Figure 15.

Figure 15: Vectors showing flow field in the melt pool due to gradient in surface tension. The colours of the 
vectors represent the magnitude of the velocity. Surface colormap shows the temperature distribution.
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Figure 16: (left) Surface colormap of temperature dependent thermal conductivity showing different values in 
powder and liquid/solid and (right) the corresponding temperature distribution.

Using separate material properties for powder has a significant effect on both the temperature 
distribution and the size of the melt pool. This is because a lower thermal diffusivity in the powder 
makes the temperature to diffuse more towards the length of the melt pool hence causing a significant 
increase in the length of the melt pool (shown in Figure 16) as compared to the first two cases. There is 
also an obvious increase in the width of the melt pool while the depth of the melt pool is almost the 
same as with the fluid flow. Furthermore, the maximum temperature is also highest in the case with 
separate material properties.

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_04: Scheil Transient Steady-state

In this example, three different simulations are performed: Steady-state, Transient Single track, and 
Transient Multilayer. Both Transient Single track and Transient Multilayer use Transient with heat 
source from Steady-state model to compute time-dependent temperature distribution in the given 
geometry. The primary difference between this example and the previous examples (AM_01 to AM_03) 
is that, in this case, the material properties data is retrieved from the Scheil Calculator whereas in the 
previous examples the material properties are taken from the preinstalled material library. 
Furthermore, this example simulates scanning of two layers of powder where the second layer is spread 
on the top of the first layer when scanning of the first layer is completed.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_04_Scheil_TransientSS.tcu

Material chosen for this example is Ti-6Al-4V. To run this example requires both version 
TCTI5.0 and newer of the TCS Ti/TiAl-based Alloys Database (TCTI) in addition to a license 
for the Additive Manufacturing (AM) Module. Some portions of this example are also 
covered in the Getting Started Guide on our website.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes at least 30 minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).
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 l Geometry: View the geometry and adjust parameters visually by changing inputs on the 
Configuration window.

 l Melt pool and other dynamically changing features can also be visualized and changed.

 l Plot results: After completing the set up and performing the calculation, to view the matching 
name of the node on tab(s) in the Visualizations window, click a Plot Renderer node in the 
Project window or click the tabs individually in the Visualizations window.

Steady-state

The Steady-state calculator of this example computes temperature distribution in a steady state for the 
power of 100 W and scanning speed of 600 mm/s. The beam radius in this example is taken as 100 μm. 
For the geometry, the steady-state model only needs the height of the solid substrate as the input, 
which is taken as 2.0 mm. The solid substrate is covered with a powder layer of thickness 55 μm. This 
example also takes into account the effect of fluid flow due to Marangoni forces inside the melt pool.

Figure 17: Geometry definition for Transient Multilayer. The scanning strategy shows the scanning pattern on 
the top most layer.
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Figure 18: Temperature distribution around the melt pool and mushy zone for the Steady-state case. Velocity 
vectors representing the fluid flow inside the melt pool can also be seen.

Transient Single Track

Figure 19: 3D Surface colormap showing temperature distribution at the end of single track transient 
simulation. The velocity vectors around the heat source show the direction of fluid flow in the melt pool.
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Figure 20: 2D Plot showing temperature as a function of time from Probe 1 (orange) and Probe 2 (blue) after 
the single track scan is completed.

Transient Multilayer

Figure 21: Temperature distribution on the top surface of the workpiece during scanning of the first layer.
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Figure 22: Temperature distribution on the top surface of the workpiece during scanning of the second layer.

Figure 23: 2D Plot showing temperature as a function of time from Probe 1 after scanning the first layer.
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Figure 24: 2D Plot showing temperature as a function of time from Probe 2 after scanning the second layer.

Figure 25: 2D Plot Over Line showing temperature profiles plotted along the lines, parallel to the width of the 
geometry placed on the top of the first layer (P1) and the second layer (P2).

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 
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Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_05: Using AM Calculator Probe Data with the Diffusion Module 
(DICTRA)

The microstructure of a hot-work tool steel additively manufactured using laser powder-bed fusion (L-
PBF) is studied in detail by microstructure characterization and computational thermodynamics and 
kinetics by C.-Y. Chou et al. [2021Cho].

This example demonstrates the application of adding probes to an AM Calculator and then using this 
data via the Thermal Profile that is set up on a connected Diffusion Calculator. The example also uses a 
Scheil Calculator to collect some materials data that is then further used with the AM Calculator prior to 
using the probe data generated by the AM Calculator.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_05_AM_Probe_to_Diffusion.tcu

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. This example also requires a license for the Diffusion Module (DICTRA), plus 
additional database licenses for the TCS Steel and Fe-alloys Database (TCFE) (TCFE13 and 
newer), and the TCS Steels/Fe-Alloys Mobility Database (MOBFE) (MOBFE8 and newer).

Background

According to the thermodynamics of this steel, δ-ferrite is the solid phase stable at the highest 
temperature and would be the first solid phase to form during solidification from a thermodynamic 
point of view, see Figure 26.
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Figure 26: Equilibrium property diagram calculated in Thermo-Calc of the tool steel showing δ-ferrite would be 
the first solid phase to form during solidification according to equilibrium.

However, the high solidification and cooling rates during the L-PBF process lead to suppression of δ-
ferrite and instead solidification of an austenite phase directly containing a cellular substructure where 
the alloying elements have segregated to the inter-cellular regions.

The microsegregation can be predicted by reducing the complex solidification behavior to a diffusion 
problem in one dimension enabling comparisons with the measured segregation profiles quantified at a 
nanometer scale.

Configuration and Calculation Set Up

For all calculations, the simplified composition Fe-0.35C-4.93Cr-0.45Mn-2.24Mo-0.25Si-0.54V (mass%) 
was used with δ-ferrite suspended on the System Definer.

The Additive Manufacturing template was used to first add the System Definer, Scheil Calculator, AM 
Calculator, and Plot Renderer to the Project window tree. Additionally, a Diffusion Calculator was 
added as a successor to the AM Calculator in order to automatically import the time-temperature 
profile from the AM simulation into the diffusion simulation. See Figure 27 (or refer to the example if 
you have it open) to see the layout.
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Figure 27: Project tree of the example containing activities from the default Additive Manufacturing template 
with additional Diffusion Calculator and Experimental File Reader nodes added, where the segregation profiles 
datasets are pulled from the Experimental File Reader.
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On the AM Calculator Configuration window, the calculation type Transient with heat source from 
Steady-state is selected with a single track scan pattern and a Geometry of 2 mm x 1 mm x 4 mm 
(height x width x length). The Base plate temperature is set to 200 °C.

Additional settings are then made on the Configuration window as follows.

The Double ellipsoidal volume heat source was previously assessed as a function of linear energy 
density for a similar material and directly applied to the experimental conditions of a volumetric energy 
density of 80 J/mm3. The laser Power is entered at 260 W, Scanning speed at 900 mm/s, and powder 
Layer thickness 30 μm. Below is a snapshot of the settings.
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A probe was then added in the center of the scan track at a distance of 1.3 mm from the edge. The 
Probe Positions can either be entered directly on the Configuration window or click the Pick coordinate 
button and then click on the geometry in the Visualizations window to directly choose the probe point 
(or points if there is more than one probe added).

Figure 28: Close up of the probe point added to the geometry for the single track AM simulation.
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Figure 29: The full geometry set up for the single track AM simulation with a probe point added to the middle 
of the scan. Open the example to better see the set up and to try working within the window.

Diffusion Calculations

For the Diffusion Module (DICTRA) solidification calculations using the Diffusion Calculator, only the 
liquid to austenite (FCC) transformation was simulated. On the Diffusion Calculator Configuration 
window, a Region of 140 nm with liquid and FCC allowed to form at the right boundary is set.
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In the Thermal Profile section, the time temperature from the probe was selected between a Start time 
of 5.0E-4 and Simulation time of 8.5.0E-4 s in order to only simulate the solidification, which can be 
viewed on the Visualizations window as in Figure 30. Note that the probes need to be added and then 
run in the AM Calculator to make this data available in for this part of the calculation.

Figure 30: Time temperature profile of the probe in the AM simulation. The green curve show the part of the 
profile used during the diffusion simulation with the Diffusion Calculator.

The calculated segregation profiles are finally compared with the STEM-EDS line scans as shown in 
Figure 31.
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Figure 31: The simulated segregation profile with overlaid experimental STEM-EDS line scans from C.-Y. Chou 
et al. [2021Cho].

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it can take over three hours to complete the 
calculations. 

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s). This example highlights some of these capabilities:

 l Probes: Probes are added to the AM Calculator during the set up either by entering coordinates 
or directly adding these to the geometry. See Figure 28 and Figure 29 for example.

 l Thermal Profile: The Diffusion Calculator Thermal Profile settings automatically include the 
probe data and you can visualize to help you continue the simulation. See Figure 30.
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 l Plot results: After completing the set up and performing the calculation, to view the matching 
name of the node on tab(s) in the Visualizations window, click a Plot Renderer node in the 
Project window or click the tabs individually in the Visualizations window. See Figure 31.

Reference

[2021Cho] C.-Y. Chou, N. H. Pettersson, A. Durga, F. Zhang, C. Oikonomou, A. Borgenstam, J. Odqvist, G. 
Lindwall, Influence of solidification structure on austenite to martensite transformation in additively 
manufactured hot-work tool steels. Acta Mater. 215, 117044 (2021).

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_06a: Calibrating a Heat Source for a 316L Steel

This example demonstrates the calibration of the heat source using the Gaussian as well as Double 
ellipsoidal heat sources. In this example, experimental data is taken from Hu. et al. [2019Hu] where the 
authors performed single-track experiments using the selective laser melting (SLM) process on 316L 
stainless steel for varying processing conditions. The power ranges from 50 W to 100 W while the 
scanning speed varies from 400 mm/s to 2800 mm/s. The data imported from [2019Hu], consisting of 21 
experimental points, is saved in the project file.

Also see the companion example, AM_06b: Using the Calibrated Heat Source for a 316L 
Steel.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_06a_Calibrate_Heat_Sources_316L.tcu

An Additive Manufacturing Module license is needed to run AM_06a.

Some examples (AM_01, AM_02, AM_03,  and AM_06b) are available to all users.  These 
examples can be run without an additional Additive Manufacturing license when you are in 
DEMO (demonstration) mode. However, the AM Module is not available with the 
Educational version of Thermo-Calc. Search the help for Available Options with the Additive 
Manufacturing (AM) Module.  See Available Options for details.

Material Properties

 l SS316L: Fe-17.0Cr-12.0Ni-2.5Mo-0.03C Mass percent
 l Database: TCFE13
 l The material properties are precalculated, and stored as a built-in material library with the 

Additive Manufacturing (AM) Module.

AM Calculator Configuration Settings

The AM_06a example contains two AM Calculators, which are renamed to AM Calibration Gaussian and 
AM Calibration Double Ellipsoidal.
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 l AM Calibration Gaussian uses a Gaussian Heat Source with the keyhole model.
 l AM Calibration Double Ellipsoidal uses a Double ellipsoidal Heat Source. 
 l The heat source parameters for both heat sources are calibrated for the given experimental 

data.
 l For both AM Calculators, the Base plate temperature and the Ambient temperature use a value 

of 353 K and the Layer thickness is 10 μm. The rest of the Configuration settings keep the 
original defaults.

For AM Calibration Gaussian, all of the 21 experimental points that are imported to the Experiment 
Data table are selected to be used in the calibration. This is because, for the Gaussian heat source with 
the keyhole model, one wants to obtain a single constant value for beam radius as well as absorptivity 
to correctly predict the melt pool size for a range of power and scanning speed. It is also in order to 
obtain the best possible value it is good to include as many experiments as you can to calibrate the heat 
source parameters.

For this AM Calculator, other settings include:

 l Constant (calibrated), which means the absorptivity is not a function of temperature or angle, 
and a constant value is calibrated for each experiment. 

 l The Beam radius is set to Calibrated, which means that both beam radius and absorptivity are 
calibrated.

 l Calibrate for is set to Width and depth, which means that the experimental values for both 
width and depth are used for calibration.

For AM Calibration Double Ellipsoidal, only five (5) experiment points are selected to perform the 
calibration. Two experiments are selected from the lower energy density, two from the higher energy 
density, and then one experiment is selected in the middle region of the two extremes.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it can take about an hour to complete the 
calculations. 
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There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).

See Visualizing Heat Source Calibrations for an extended overview of what is available and 
how to navigate the many options for visualizing the heat source calibration data.

Calibrated Functions

For AM Calibration Gaussian, a comparison of the melt pool dimensions from the experiments and 
calibration simulation is shown in Figure 32.

Figure 32: A comparison of melt pool dimension for Gaussian heat source calibration. The "Not used" points 
shown in the legend are because a checkbox is not selected in the 'Use' column for row 10 on the Plot 
Renderer Configuration window. 

The resulting calibrated heat source parameters for AM Calibration Gaussian, are shown in Figure 33.
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Figure 33: Calibrated heat source parameters for Gaussian heat source calibration.

In order to obtain the expressions for Absorptivity and Beam radius, one of the experiments 
(Experiment # 10) is not included. This is because Experiment # 10 is an outlier and you can see that the 
values for Exp width and Exp depth (hollow square) then the Sim width and Sim depth (hollow circle) are 
excluded in Figure 32. 

For both Absorptivity and Beam radius the Constant function of P/v is chosen to be saved as a 
calibrated heat source. Absorptivity of the material at the printing conditions is usually unknown in 
these experiments which is why it is regarded as a fitting parameter. Beam radius, on the other hand, is 
most often known, but does not match the definition of beam radius in the Gaussian heat source model 
used in the simulation, which is why a different value is obtained as compared to the one used in the 
experiment.
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Figure 34: A comparison of melt pool dimension for double ellipsoidal heat source calibration.

Figure 35: Calibrated heat source parameters for double ellipsoidal heat source calibration.

While selecting the functions for heat source parameters for double ellipsoidal, it was seen that ar, af, 
and b remained almost unchanged for all the experiments. Therefore the Constant function of P/v for 
ar, af, and b is used. For Absorptivity, a Linear function of P/v gave the best R2 value while for c a Cubic 
function of P/v gave the best R2 value. One of the experiments (experiment # 21) was excluded (i.e. the 
checkbox is deselected) to get a suitable curve for all functions.
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Reference

[2019Hu] Z. Hu, B. Nagarajan, X. Song, R. Huang, W. Zhai, J. Wei, Formation of SS316L Single Tracks in 
Micro Selective Laser Melting: Surface, Geometry, and Defects. Adv. Mater. Sci. Eng. 2019, Article ID 
9451406, 1–9 (2019).

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_06b: Using the Calibrated Heat Source for a 316L Steel

This example demonstrates the use of the two calibrated heat sources that are saved in the example 
AM_06a. One heat source is of the Gaussian type while the other heat source is Double ellipsoidal. For 
both heat sources, expressions are saved as a function of energy density (P/v) for all heat source 
parameters as well as the absorptivity. The example consists of four AM Calculators, two of which use a 
Gaussian heat source while the other two use a Double ellipsoidal heat source, and where the 
processing conditions for all four AM Calculators are taken from Hu et al [2019Hu].

AM_06a: Calibrating a Heat Source for a 316L Steel

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_06b_Use_Calibrated_Heat_Sources_316L.tcu

Other than an Additive Manufacturing (AM) Module license, this example does not require 
an additional license to run it, although its companion example, AM_06a, does.

Material Properties

 l SS316L: Fe-17.0Cr-12.0Ni-2.5Mo-0.03C Mass percent
 l Database: TCFE13
 l The material properties are precalculated, and stored as a built-in material library with the 

Additive Manufacturing (AM) Module.

Configuration and Calculation Set Up

There are four AM Calculators where all the calculators use the Steady-state simulation type and the 
Single point Calculation Type. The purpose of this example is to use the saved heat sources from AM_
06a and then validate the results by comparing the melt pool size from the simulations with the 
experimental melt pool dimensions as given in Hu et. al [2019Hu].

The saved heat sources are selected from the Heat Source list on the AM Calculator, where a subsection 
called Users heat sources includes all previously saved heat sources. In the example, two calculators use 
the Gaussian - 316L - beam d 15um user-defined heat source, and two use the Double ellipsoidal - 316L 
- beam d 15um user-defined heat source. The Base plate temperature and Ambient temperature is set 
to 353 K, while the Layer thickness is set to 10 μm.
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Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).

For this example, it is best to open and run this simulation to be able to view all the 
different plots and outputs to various tabs on both the various Configuration windows as 
well as the Visualizations window.

See Visualizing Heat Source Calibrations for an extended overview of what is available and 
how to navigate the many options for visualizing the heat source calibration data.

Gaussian Heat Source and Keyhole Model

The different processing conditions are selected to simulate both the conduction mode as well as the 
keyhole mode. For Gaussian - 316L - beam d 15 um heat source, with P = 100 W and scanning speed = 
2800 mm/s, the dominant mode of heat transfer is conduction, which is why a shallow melt pool is 
obtained. The results from the simulations are fairly close to the ones from the experiments, as can be 
seen in Table 1.

With P = 80 W and scanning speed = 400 mm/s, a keyhole mode is observed in the experiments. This is 
also predicted from the simulations as can be seen in Figure 36.

A comparison of the melt pool depth from the simulations and the experiments for the latter case 
shows that the calibrated Gaussian heat source with the keyhole model predicts the melt pool depth 
with reasonable accuracy. However, it underpredicts the melt pool width. This is because fluid flow due 
to Marangoni forces is not included in these simulations, which probably causes the melt pool to widen 
in the experiments.
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Calculator 
Name

Power 
[W]

Scanning 
Speed 
[mm/s]

Melt Pool Width Melt Pool Depth

Simulation 
[μm]

Experiment 
[μm]

Simulation 
[μm]

Experiment 
[μm]

AM use 
calibrated 
Gaussian P100 
u2800

100 2800 53.30 47.82 12.93 14.36

AM use 
calibrated 
Gaussian P80 
u400

80 400 93.25 105 102.71 106.57

Table 1: A comparison of the melt pool dimensions from the simulations and experiments using the calibrated 
Gaussian heat source.

Figure 36: Steady-state temperature distribution around the melt pool for SS316L with P = 80 W and scanning 
speed = 400 mm/s using the calibrated Gaussian heat source with the keyhole model. A keyhole can also be 
seen formed just below the location of the heat source.

Double Ellipsoidal Heat Source

For the Double ellipsoidal - 316L - beam d 15 um heat source, two different processing conditions are 
selected to simulate both the conduction mode as well as the keyhole mode. For both processing 
conditions, the prediction of the melt pool size from the simulations is in fairly good agreement with the 
results from the experiments as can be seen in Table 2.

The temperature distribution using the calibrated double ellipsoidal heat source with P = 80 W and 
scanning speed = 400 mm/s is shown in Figure 37.
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Calculator 
Name

Power 
[W]

Scanning 
Speed 
[mm/s]

Melt Pool Width Melt Pool Depth

Simulation 
[μm]

Experiment 
[μm]

Simulation 
[μm]

Experiment 
[μm]

AM use 
calibrated DE 
P80 u1200

100 1200 65.07 64.34 31.63 29.68

AM use 
calibrated DE 
P80 u400

80 400 103.65 105 112.29 106.57

Table 2: A comparison of the melt pool dimensions from the simulations and experiments using the calibrated 
double ellipsoidal heat source.

Figure 37: Steady-state temperature distribution around the melt pool for SS316L with P = 80 W and scanning 
speed = 400 mm/s using the calibrated double ellipsoidal heat source.

Reference

[2019Hu] Z. Hu, B. Nagarajan, X. Song, R. Huang, W. Zhai, J. Wei, Formation of SS316L Single Tracks in 
Micro Selective Laser Melting: Surface, Geometry, and Defects. Adv. Mater. Sci. Eng. 2019, Article ID 
9451406, 1–9 (2019).
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Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_07: Batch Calculations for an IN718 Alloy

This example shows the use of the AM Calculator with a Steady-state mode and Batch Calculation Type 
where it compares calculated and measured melt pool dimensions. The experimental data are from the 
2022 NIST AM-Bench Test Series [2022NIST] where single track experiments were performed on a IN718 
bare plate at different power and scan speeds.

The use of different Plot types in this example include a Parity plot, 3D plot showing the keyhole, and 
Printability map.

This example is part of a set using a Steady-state simulation with a Gaussian heat source, 
plus the Keyhole model including Fluid flow. These examples collectively show the use of 
Batch and Grid calculation types plus various plot types such as Printability maps, Parity 
plots, and Melt pool vs energy density. The examples are  numbered AM_07 to AM_09b.  

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_07_Batch_IN718.tcu

This example requires an Additive Manufacturing (AM) Module license.

Some examples (AM_01, AM_02, AM_03,  and AM_06b) are available to all users.  These 
examples can be run without an additional Additive Manufacturing license when you are in 
DEMO (demonstration) mode. However, the AM Module is not available with the 
Educational version of Thermo-Calc. Search the help for Available Options with the Additive 
Manufacturing (AM) Module.  See Available Options for details.

Configuration and Calculation Set Up

Below highlights the main settings for this example.

The Steady-state simulation is selected and the Fluid flow including Marangoni effect checkbox is 
selected. 
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The Heat Source is set to Gaussian and uses the Keyhole model. The printers in the experiments had a 
beam diameter of 67 μm so the Gaussian Beam radius is set to 33.5 μm. The Absorptivity is set to 30.0 
%.

The IN718 material is selected from the Material Properties library. The material properties are 
precalculated and stored as a built-in material Library.

The Batch Calculation Type is used to set up all the conditions from the multiple experiments in a single 
calculation. The experimental Power and scan Speed as well as the measured melt pool Width and 
Depth were collected in a CSV file and read into the software. This data is then saved in the project file. 

In the Batch Experiment Data table you can see that the power ranges between 245 W to 285 W and the 
scan speed ranges between 800 mm/s to 1200 mm/s.
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Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes at least 30 minutes for the calculations to 
complete.

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 
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Parity Plot

Figure 38: Parity plot comparing experimental versus calculated melt pool width and depth for all the 
experiments. The experiments are single tracks on bare plate IN718 with varied power and scan speed.  The 
Root Mean Square (RMS) error can also be shown as a dashed line.  
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Figure 39: Alternatively, lines for user-defined Absolute or Relative in % error can be shown instead by 
selecting these options on the Configuration window.

3D Plot with Surface Colormap

 

Figure 40: 3D plot showing a keyhole for the second simulation that uses power 285 W and scan speed 1200 
mm/s. 
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Figure 41: Selecting the Batch experiment number to display in the Visualizations window for the 3D plot 
shown in Figure 40.

Visualizing Batch Calculations in the AM Module

Reference

[2022NIST] National Institute of Standards and Technology (NIST), Additive Manufacturing Benchmark 
Test Series (AM-Bench) (2022), (available at https://www.nist.gov/ambench). 

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

ǀ 144 of 420

https://thermocalc.com/products/add-on-modules/additive-manufacturing-module/
https://resources.thermocalc.com/webinar-demonstration-of-the-new-additive-manufacturing-module
https://thermocalc.com/support/getting-started-guides/additive-manufacturing-module-guide


Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_08a: Grid Calculation for a Ti64 Alloy

This example shows the use of the AM Calculator with a Steady-state mode and Grid Calculation Type 
where it compares the calculated and measured printability map. Printability maps are also known as 
process maps. The experiments are from Dilip et. al [2017Dil] where they performed single track 
experiments with the alloy Ti64 at different power and scan speeds. They also printed cubes and 
performed measurements of the porosity amounts for each experimental condition.

The use of different Plot types in this example include a Printability map and a 3D plot with surface 
colormap.

This example is part of a set using a Steady-state simulation with a Gaussian heat source, 
plus the Keyhole model including Fluid flow. These examples collectively show the use of 
Batch and Grid calculation types plus various plot types such as Printability maps, Parity 
plots, and Melt pool vs energy density. The examples are  numbered AM_07 to AM_09b.  

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_08a_Printability_Map_Ti64.tcu

This example requires an Additive Manufacturing (AM) Module license.

Configuration and Calculation Set Up

Below highlights some of the settings for this example to compare with experimental data of Ti64.

This example builds on the previous one (AM_07) and it is recommended to review this and 
to open the example file to locate and follow along for the settings described here and 
found on the Configuration window. 

The Steady-state calculation  includes Fluid flow. 
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The Heat Source is set to Gaussian and uses the Keyhole model.  The printers in the experiments had a 
beam diameter of 100 μm so the Gaussian Beam radius is set to 50 μm. The Absorptivity is set to 27 %. 

The Ti6Al4V material is selected from the Material Properties library. The material properties are 
precalculated and stored as a built-in material Library.

The Grid Calculation Type is used to cover all the conditions from the experiments in a single calculation. 
The Power ranges between 50-200 W and the Scanning speed ranges between 500-1200 mm/s.
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Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it can take around two hours to complete the 
calculations. 

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 

Plot Renderer Configuration Window

The combined results from the Grid calculation can be viewed under the matching Grid tab on the Plot 
Renderer Configuration window where it is set to use the Printability map plot type. In this example, 
the Plot Renderer node is renamed to Printability map in the Project window.
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The experimental value of 30 μm powder thickness (Layer thickness) and  100 μm for the Hatch distance 
seems to be too big to produce dense builds according to this lack of fusion criteria. Full density can 
then in principle only be achieved by melting the regions between tracks by shifting the layers printed 
on top so the full depth of the melt pool covers unmelted regions.
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Next each Function is defined and limits were adjusted to match the experimental regions of keyholing 
and lack of fusion porosity. 

 l The keyholing limit (Keyholing: Wk/Dk) is slightly increased from 1.0 to 1.1. 
 l The Lack of fusion: D/t is kept at the default of 1.0. 
 l The lack of fusion at half of the hatch distance (Lack of fusion hatch: Dh/t) had to be reduced to 

from 1.0 to 0.45 in order to not extend the lack of fusion region to experimental regions where 
little porosity was found. 

Printability Map and 3D Plot

There is a video tutorial about the Printability Map on our website and on our YouTube 
channel. It is also included in the Additive Manufacturing Module YouTube playlist.
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Figure 42: The calculated printability map for Ti64 showing the regions for keyholing porosity (upper left) and 
lack of fusion porosity to the lower right. The labels show the measured amount of porosity. Labels in red 
show regions with severe amounts of porosity and labels in black/green show regions with little or no defects. 

Figure 43: 3D plot showing a keyhole for the simulation that uses power 200 W and scan speed 1200 mm/s.
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Reference

[2017Dil] J. J. S. Dilip, S. Zhang, C. Teng, K. Zeng, C. Robinson, D. Pal, B. Stucker, Influence of processing 
parameters on the evolution of melt pool, porosity, and microstructures in Ti-6Al-4V alloy parts 
fabricated by selective laser melting. Prog. Addit. Manuf. 2, 157–167 (2017). 

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

ǀ 152 of 420

https://thermocalc.com/products/add-on-modules/additive-manufacturing-module/
https://resources.thermocalc.com/webinar-demonstration-of-the-new-additive-manufacturing-module
https://thermocalc.com/support/getting-started-guides/additive-manufacturing-module-guide


AM_08b: Batch Calculations for a Ti64 Alloy

This example shows the use of the AM Calculator with a Steady-state mode and Batch Calculation Type 
where it compares the calculated and measured melt pool dimensions. The experiments are from Dilip 
et. al [2017Dil] where they performed single track experiments with the alloy Ti64 at different power 
and scan speeds. 

The use of different Plot types in this example include a Parity plot, Melt pool vs energy density, 
3D plot showing the keyhole, and Printability map.

This example is part of a set using a Steady-state simulation with a Gaussian heat source, 
plus the Keyhole model including Fluid flow. These examples collectively show the use of 
Batch and Grid calculation types plus various plot types such as Printability maps, Parity 
plots, and Melt pool vs energy density. The examples are  numbered AM_07 to AM_09b.  

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_08b_Batch_Ti64.tcu

This example requires an Additive Manufacturing (AM) Module license.

Configuration and Calculation Set Up

Below highlights some of the settings for this example. This example builds on the previous 
ones (AM_07 and AM_08a) and it is recommended to review these and to open the 
example file to locate and follow along for the settings described here and found on the 
Configuration window. 

The Steady-state calculation is configured with the Gaussian Heat Source with the Keyhole model and 
includes Fluid flow. The printers had a beam diameter of 100 μm so the Gaussian Beam radius is set to 
50 μm. The Absorptivity is set to 27 %.

The Ti6Al4V material is selected from the Material Properties library. The material properties are 
precalculated and stored as a built-in material Library.
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The Batch Calculation Type is used to set up all the conditions from the experiments in a single 
calculation. The experimental Power and scan Speed as well as the measured melt pool Width and 
Depth were collected in a CSV file and read into the software. This data is then saved in the project file. 

In the Batch Experiment Data table (see  Visualizing the Batch Calculation Experimental Data) you can 
see that the power ranges between 50-195 W and the scan speed ranges between 500-1200 mm/s.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes at least 30 minutes for the calculations to 
complete.

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 

 Visualizing the Batch Calculation Experimental Data

During the set up of a calculation, the Batch Experiment Data is imported  into the AM Calculator 
Configuration window, where you can review the data and choose to include or exclude data points by 
selecting and deselecting the checkboxes as needed in the Use column  (see Figure 44). At the same 
time, you can observe the change as this is updated in the Visualizations window (see Figure 45). Data 
can also be entered directly into the table. 
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Figure 44: The experimental data used for the Batch calculation for the single track experiments of Ti64 is 
imported to the AM Calculator table where you can review the data points and include or exclude as needed 
using the checkboxes. 

Figure 45: The visualization of the experimental melt pool dimensions are shown as a function of the energy 
density P/v. You can adjust the selected points in the Batch Experiment Data table and watch the updates 
dynamically in this window. 
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Parity, Melt Pool, and 3D Plot

Figure 46: Parity plot comparing experimental versus calculated melt pool width and depth for all the Batch 
calculations. The experiments are single tracks with Ti64 with varied power and scan speed.
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Figure 47: Plot comparing experimental versus calculated melt pool dimensions for all the Batch calculations. 
The experiments are single tracks with Ti64 with varied power and scan speed. The melt pool width and depth 
are shown on the Y-axis and the energy density (P/v) on the X-axis.
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Figure 48: 3D plot showing a keyhole for the 15th simulation that uses power 195 W and scan speed 1000 
mm/s. 

Visualizing Batch Calculations in the AM Module

Reference

[2017Dil] J. J. S. Dilip, S. Zhang, C. Teng, K. Zeng, C. Robinson, D. Pal, B. Stucker, Influence of processing 
parameters on the evolution of melt pool, porosity, and microstructures in Ti-6Al-4V alloy parts 
fabricated by selective laser melting. Prog. Addit. Manuf. 2, 157–167 (2017). 

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 
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Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_09a: Grid Calculation for an SS316L Alloy

This example shows the use of the AM Calculator with a Steady-state mode and Grid Calculation Type 
where it compares the calculated and measured printability map. Printability maps are also known as 
process maps.  The experiments are from Hu et. al [2019Hu] where they performed single track 
experiments with the alloy SS316L at different power and scan speeds.

The use of different Plot types in this example include a Printability map and a 3D plot with surface 
colormap.

This example is part of a set using a Steady-state simulation with a Gaussian heat source, 
plus the Keyhole model including Fluid flow. These examples collectively show the use of 
Batch and Grid calculation types plus various plot types such as Printability maps, Parity 
plots, and Melt pool vs energy density. The examples are  numbered AM_07 to AM_09b.  

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_09a_Printability_Map_316L.tcu

This example requires an Additive Manufacturing (AM) Module license.

Configuration and Calculation Set Up

Below highlights some of the settings for this example. This example builds on the previous 
ones (AM_07, AM_08a, and AM_08b) and it is recommended to review these and to open 
the example file to locate and follow along for the settings described here and found on 
the Configuration window. 

The Steady-state calculation is configured with the Gaussian Heat Source with the Keyhole model and 
includes Fluid flow. 

The Gaussian Beam radius is set to 22 μm. The Absorptivity is set to 30 % and in the Scanning Strategy 
section, the powder Layer thickness is set to 10 μm. 

The SS316L material is selected from the Material Properties library. The material properties are 
precalculated and stored as a built-in material Library.
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The Grid Calculation Type is used to cover all the conditions from the experiments in a single calculation. 
The Power ranges between 40-100 W and the Scanning speed ranges between 400-3000 mm/s.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it can take around two hours to complete the 
calculations. 

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 

Plot Renderer Configuration Window

The combined results from the Grid calculation can be viewed under the matching Grid tab on the Plot 
Renderer Configuration window where it is configured to use the Printability map plot type. In this 
example, the Plot Renderer node is renamed to Printability map in the Project window.
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Next each Function is defined and limits were adjusted to match the experimental regions of keyholing 
and lack of fusion porosity. 

 l The keyholing limit (Keyholing: Wk/Dk) is kept at default 1.0. 
 l The Lack of fusion: D/t is increased from default of 1.0 to 1.3. 
 l The experiments were only single-track and the lack of fusion at half of the hatch distance (Lack 

of fusion hatch: Dh/t) is kept at default 1.0 and only included together with the Hatch distance 
of 35 μm for demonstration purposes.

Figure 49: The settings for the printability map with the Function limits defined for keyholing, lack of fusion, 
and lack of fusion at half of the hatch distance (as described in the text).

Printability Map and 3D Plot

There is a video tutorial about the Printability Map on our website and on our YouTube 
channel. It is also included in the Additive Manufacturing Module YouTube playlist.
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Figure 50: Printability map for 316L showing regions of keyholing and lack-of-fusion. Experimental information 
from Hu et. al. [2019Hu] overlaid as coloured labels showing  keyhole porosity (K), conduction mode with lack-
of-fusion porosity (C). Green labels showing experiments without defects for conduction mode (C) and keyhole 
mode (K).

Figure 51: 3D plot showing a keyhole for the simulation that uses power 100 W and scan speed 400 mm/s.

Reference

[2019Hu] Z. Hu, B. Nagarajan, X. Song, R. Huang, W. Zhai, J. Wei, Formation of SS316L Single Tracks in 
Micro Selective Laser Melting: Surface, Geometry, and Defects. Adv. Mater. Sci. Eng. 2019, 1–9 
(2019).
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Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 
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AM_09b: Batch Calculations for an SS316L Alloy

This example shows the use of the AM Calculator with a Steady-state mode and Batch  Calculation Type 
where it compares the calculated and measured melt pool dimensions. The experiments are from Hu et. 
al 2019 where they performed single track experiments with the alloy SS316L at different power and 
scan speeds.

The use of different Plot types in this example include a Parity plot, Melt pool vs energy density, 
3D plot showing the keyhole, and Printability map.

This example is part of a set using a Steady-state simulation with a Gaussian heat source, 
plus the Keyhole model including Fluid flow. These examples collectively show the use of 
Batch and Grid calculation types plus various plot types such as Printability maps, Parity 
plots, and Melt pool vs energy density. The examples are  numbered AM_07 to AM_09b.  

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_09b_Batch_316L.tcu

This example requires an Additive Manufacturing (AM) Module license.

Configuration and Calculation Set Up

Below highlights some of the settings for this example. This example builds on the previous 
ones (AM_07, AM_08a, AM_08b, and AM_09a) and it is recommended to review these and 
to open the example file to locate and follow along for the settings described here and 
found on the Configuration window. 

The Steady-state calculation is configured with the Gaussian Heat Source with the Keyhole model and 
includes Fluid flow. 

The Gaussian Beam radius is set to 22 μm. The Absorptivity is set to 30 % and in the Scanning Strategy 
section, the powder Layer thickness is set to 10 μm. 

The SS316L material is selected from the Material Properties library.The material properties are 
precalculated and stored as a built-in material Library.
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The Batch Calculation Type is used to set up all the conditions from the experiments in a single 
calculation. The experimental Power and scan Speed as well as the measured melt pool Width and 
Depth were collected in a CSV file and read into the software. This data is then saved in the project file. 

In the Batch Experiment Data table the power ranges between 50-100 W and the scan speed ranges 
between 400-2800 mm/s.

Visualizations

There is a video tutorial about the Printability Map on our website and on our YouTube 
channel. It is also included in the Additive Manufacturing Module YouTube playlist.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it can take about an hour to complete the 
calculations. 

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 

 Visualizing the Batch Calculation Experimental Data

During the set up of this calculation, the Batch Experiment Data is imported into the AM Calculator 
Configuration window, where you can review the data and choose to include or exclude data points by 
selecting and deselecting the checkboxes as needed in the Use column. At the same time, you can 
observe the change as this is updated in the Visualizations window.
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Figure 52: The experimental data used for the Batch calculation for the single track experiments of SS316L is 
imported to the AM Calculator table where you can review the data points and include or exclude as needed 
using the checkboxes. 

Figure 53: The visualization of the experimental melt pool dimensions are shown as a function of the energy 
density P/v. You can adjust the selected points in the Batch Experiment Data table and watch the updates 
dynamically in this window. 
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Parity, Melt Pool, and 3D Plot

Figure 54: Parity plot comparing experimental versus calculated melt pool width and depth for all the Batch 
calculations. The experiments are single tracks with SS316L with varied power and scan speed.

Figure 55: 3D plot showing a keyhole for the 12th simulation that uses power 60 W and scan speed 800 mm/s. 
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Figure 56: Plot comparing experimental versus calculated melt pool dimensions for all the Batch calculations. 
The experiments are single tracks with SS316L with varied power and scan speed. The melt pool width and 
depth are shown on the Y-axis and the energy density (P/v) on the X-axis.

Figure 57: For the plot, you can choose what to include on the plot, to show width and/or depth by selecting 
the relevant checkboxes on the Configuration window. 

Visualizing Batch Calculations in the AM Module
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Reference

[2019Hu] Z. Hu, B. Nagarajan, X. Song, R. Huang, W. Zhai, J. Wei, Formation of SS316L Single Tracks in 
Micro Selective Laser Melting: Surface, Geometry, and Defects. Adv. Mater. Sci. Eng. 2019, 1–9 
(2019).

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 
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AM_10: CET Transition in an IN718 Alloy

The example uses a Scheil Calculator, AM Calculator, and the Property Model Calculator with the 
Columnar to Equiaxed Transition Property Model to compare calculated CET curves for an IN718 alloy 
(from example PM_G_17) with the solidification conditions of the melt pool in the AM simulation. 

For more background about this Property Model, search the Help or the main Thermo-Calc 
documentation set for About the Columnar to Equiaxed Transition (CET) model.

This example is similar to, and based on, example PM_G_17: Columnar to Equiaxed 
Transition of an IN718 Alloy. This is available from the Property Models → General folder.

A Scheil with solute trapping calculation is done first on the Scheil Calculator to generate 
thermophysical properties data to the AM Calculator. A steady-state AM simulation is done to predict 
the solidification conditions in the melt pool, the solidification rates, and thermal gradients.

Then using the Property Model Calculator with the Columnar to Equiaxed Transition (CET) model, the 
calculated CET curves for an IN718 alloy are fed into the AM + CET node (the renamed Plot Renderer), 
where together the data from the AM and Property Model calculations are combined and overlaid on 
one plot. 

The literature data from Polonsky et al. [2020Pol] are not purely experimental data, but rather 
combined with experimental equiaxed evidence and model calculations with numerical values of 
thermal gradients, growth velocity as well as tip undercooling. Polonsky et al. estimated tip 
undercooling based on a Scheil calculation, which smeared out the composition inhomogeneity at the 
dendrite front, hence underestimating the undercooling. Since both tip undercooling and nucleation site 
density promotes the formation of equiaxed crystals, an increase in undercooling in this example 
calculation leads to a decrease in nucleation site density compared to the results in [2020Pol] if one 
were fitting the same set of data.

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_10_Columnar_to_Equiaxed_Transition_IN718.tcu
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A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. This example also requires additional database licenses for the  TCS Ni-based 
Superalloys Database (TCNI) (TCNI12 and newer), and the  TCS Ni-alloys Mobility Database 
(MOBNI) (MOBNI6 and newer).

Configuration and Calculation Set Up

On the Scheil Calculator (renamed to Scheil with solute trapping) , the Scheil with solute trapping is 
used with these specific settings:

 l Trans-interface diffusivity: Same for all elements
 l Prefactor: 5.0E-9
 l Maximum velocity for infinite driving force: 2000 m/s
 l Model: Aziz 
 l Interface driving force: Driving energy 

For the AM Calculator (renamed to AM Steady-state), the Steady-state calculation is configured as a 
Gaussian Heat Source with the Keyhole model and includes Fluid flow. It also uses a Single Point 
calculation with the Calculated Absorptivity. 

On the Property Model Calculator (renamed to Columnar to Equiaxed Transition) a One Axis calculation 
for the FCC_L12 primary phase is done using the CET parameters entered on the Configuration window. 

The settings on the Property Model Calculator include:

 l Interfacial energy:    0.5 J/m2. 
 l Number of nucleation sites: 4.0E11/m3

 l Nucleation undercooling : 4.0 K 
 l Equiaxed exponent: 3.13
 l Solve for: Thermal gradient
 l Equiaxed fractions: 0.01 0.49 0.99
 l Solidification rate: log10(v)

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
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simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 

The thermal gradients and solidification rate can be visualized in 2D or 3D. Figure 58 shows the thermal 
gradient along the melt pool boundary in a 3D plot. Only the data corresponding to solidification 
conditions are shown. The thermal gradients corresponding to melting conditions are filtered out and 
only the tail part of the meltpool are shown.

Figure 58: The 3D Plot for the 3D Thermal Gradient Plot Renderer.

Both the thermal gradients and solidification rates from the melt pool can be visualized at the same 
time in a 2D scatter plot where the Plot Renderer tab Thermal Gradient vs Solidification Rate is 
selected.
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Figure 59: The solidification rate vs thermal gradient is shown on the AM Thermal Gradient & Solidification 
Rate Plot Renderer. 

Figure 60 is an example of a plot where the results from both the AM simulation and the CET model for 
the IN718 thermal gradient vs solidification rate are overlaid on the same plot. The blue, red, and green 
lines show the increasing equiaxed fraction from the CET Property Model and the points show the 
solidification conditions at the melt pool calculated with the Additive Manufacturing (AM) Module. 
When the results are overlaid like this, you can see that nearly all the points (those below the purple 
line) exist in a fully columnar region.
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Figure 60: The solidification rate vs the thermal gradient overlaying both plots from the AM Calculator and 
Property Model Calculator (via the AM + CET Plot Renderer). 

Reference

[2020Pol] A. T. Polonsky, N. Raghavan, M. P. Echlin, M. M. Kirka, R. R. Dehoff, T. M. Pollock, 3D 
Characterization of the Columnar-to-Equiaxed Transition in Additively Manufactured Inconel 718, in 
Superalloys 2020 (2020), pp. 990–1002.

Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_11: Comparing Single Tracks Printed on Casted and LPBF 
Substrates

Bogdonova et al. [2024Bog] performed single track experiments with the alloy Al10SiMg. The study 
compared the printing of single tracks on two types of substrates—one fabricated with traditional 
casting and the other with laser powder bed fusion (LPBF).

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_11_Batch_Al10SiMg.tcu

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. This example also requires an additional database license for the   TCS Al-
based Alloy Database (TCAL) (TCAL9 and newer).

Background

It is well known that the thermal conductivity of the alloy Al10SiMg is drastically reduced in the as-
printed condition when fabricated by LPBF compared to conventionally manufactured counterparts 
[2022Gha].

Thermal conductivity in Thermo-Calc is modeled as a temperature- and composition-dependent 
property per phase, and the conductivity of the alloy is taken as an average over the stable phases. The 
composition of the primary phase can change greatly depending on the fabrication method where the 
LPBF method results in rapid solidification and solute trapping of solute alloy elements.

Thermal conductivity can generally be reduced by different scattering phenomena (pores, defects, 
phase interfaces) within the microstructure and can therefore be lower than the calculated conductivity 
averaged over the phases. 

The electrical resistivity due to phase interface scattering is evaluated as the scattering constant times 
sum of the interaction between the volume fraction of all the phases. The default value for the phase 
interface scattering constant is found to be 4.0e-8 Ωm for aluminum alloys. The contribution to thermal 
conductivity is assumed to be related to that of electrical resistivity, following the Wiedemann-Franz 
law.

The rapid solidification during LPBF generally results in a much finer microstructure compared to 
traditional casting. LPBF fabricated Al10SiMg solidifies with a cellular primary FCC structure and a 
eutectic structure between the cells [2021Lef]. An increased interface scattering constant more than 
4.0E-8 can be argued given the much finer structure that has a large number of phase interfaces.
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In this example the effect on material properties and melt pool dimensions is compared when printing 
single tracks on the two types of substrates. The material properties for the traditionally cast alloy is 
calculated using regular Scheil and the default interface scattering constant of 4.0E-8. The material 
properties for the LBPF fabricated alloy is calculated using Scheil with solute trapping and the effect of 
increasing the interface scattering is shown.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a wide variety of information shown both in the Visualizations and Plot Renderer 
Configuration windows that can be viewed during configuration and after performing the 
calculation(s). Not all views, such as the Geometry or previews, nor all additional output 
(i.e. plots) are shown in this section and it is recommended that you open and run the 
example to review all available options and results. 

When you run (Perform) this example, it can take around two hours to complete the 
calculations. 

Material Properties for the As-cast Substrate Material

The TCS Al-based Alloy Database (TCAL) is selected on the System Definer (renamed to Scheil As-cast). 
The as-cast Al10SiMg alloy has the composition of Al-10.8Si-0.3Mg-0.1Cu-0.1Fe.

The Scheil Calculator (renamed to Scheil As-cast) is configured with default settings for AM with an 
evaluation of thermophysical properties from 5000 K down to room temperature. The Calculation type 
is set to Classic Scheil.

Material Properties for the LPBF Printed Substrate Material

The TCS Al-based Alloy Database (TCAL) is selected in the System Definer (renamed to Scheil printed). 
The LPBF Al10SiMg alloy has almost the same composition (Al-10.8Si-0.3Mg-0.1Cu-0.2Fe) with only a 
small difference in Fe content.
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The Scheil Calculator (renamed to Scheil Solute-Trapping) is configured with the default settings for AM 
with an evaluation of thermophysical properties from 5000 K down to room temperature. The 
Calculation type is set to Scheil with solute trapping.

Comparing Material Properties Between the Substrates

Two plots overlay results from the two Scheil Calculators in Figure 61. The Plot Renderer, renamed to Si 
in primary FCC, shows the Si content in the primary FCC phase. The classic Scheil calculation gives less 
than 1.5 at% Si. The solute trapping simulation results in twice the Si content with about 3 at% Si in the 
primary FCC phase. Atom probe experiments for a LPBF printed Al10SiMg alloy measured 3.08 at% Si in 
the FCC cell structure for the as-printed condition [2021Lef]. 

Figure 61: Silicon content in the primary FCC phase comparing regular (classic) Scheil with Scheil and solute 
trapping. The solute trapping almost doubles the Si content in the primary FCC phase.

Figure 62 is another overlaid plot that takes the results from two Scheil Calculator predecessors    to show 
how the thermal conductivity varies with temperature. The conductivity for the as-cast substrate (blue 
line), that uses classic Scheil and the default setting for the phase interface scattering constant (C = 
4.0E-8), naturally gives the highest thermal conductivity. The red line shows the reduction in 
conductivity due to solute trapping and the increased Si content in the primary phase. The green line 
shows further reduction in thermal conductivity due to the increased interface scattering when the 
scattering constant was increased  (C = 1.0E-7).
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Figure 62: Thermal conductivity for as-cast substrate and printed substrate. Blue line shows conductivity for 
as-cast structure using the default setting for the interface scattering constant (C = 4.0E-8). The red line shows 
the reduced conductivity due to the solute trapping. Finally, the green line shows further reduction in thermal 
conductivity due to increased interface scattering where C = 1.0E-7.

Batch AM Steady-State Simulations

Two AM Calculators are next set up. These are renamed to As-cast Batch and AM Batch. These AM 
batch steady-state simulations are configured with similar settings, except for the interface scattering 
and the measured experimental melt pool dimensions that are different for the as-cast and LPBF 
fabricated substrates. The interface scattering settings are found on the Material Properties tab for 
both AM Calculators: 

 l The as-cast substrate uses the default interface scattering (C = 4.0E-8).
 l The LPBF as-printed substrate uses the increased value for interface scattering (C = 1.0E-7). 

The shared settings in the AM Calculator configuration (on the Conditions tab) are: 

 l Uses Fluid flow including Marongoni effect and the keyhole model. 

 l Absorptivity is selected as Calculated and the with prefactor is set to 1.8 times the calculated 
value in order to match the experimental melt pool dimensions. 
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The need to use a large prefactor is probably related to surface oxides and that the 
calculated absorptivity is for an oxide free liquid surface. The stable oxide Al2O3 
often forms at the surfaces of Al-alloys where it remains in solid form to above 
2000 °C and evaporates well above 3000 °C.

Figure 63: The settings window for an AM steady-state simulation for the As-cast Batch calculator. Fluid flow 
and Gaussian heat source with keyhole model are enabled, plus it uses a calculated absorptivity with a 
prefactor set to 1.8.

To reduce total calculation time, for each AM Calculator only 5 of the 12 experiments are 
selected on the Plot Renderer (click Show Table to see the details). However, the example 
still takes about two hours to perform.
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Figure 64: The temperature- and incident angle-dependent absorptivity. Red curve shows the absorptivity as a 
function of incident angle at the liquidus temperature, the blue curve shows the corresponding absorptivity at 
the evaporation temperature.

Turbulent Flow - Large Eddy Simulations

Al-alloys have in general lower viscosity compared to other metallic alloys (e.g. Ti-, Fe- or Ni-based 
alloys). The low viscosity in combination with high fluid flow rates can result in turbulent flows. This 
happens in this example for the simulations at the higher energy densities. The turbulent flow model 
implemented in the AM simulation is based on Large Eddy Simulations (LES) where the large-scale 
motions are represented directly and smaller-scale motions are modeled. A larger Smagorinsky constant 
filters more small-scale motions to be modeled. The example increases the Smagorinsky constant to 
0.5. The simulations with the highest energy densities will otherwise fail to converge with the default 
value of 0.18.

Figure 65: On the Options tab for the AM Steady-State simulation (As-cast Batch) with an increased 
Smagorinsky constant to handle the high turbulent flows.
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The following parity plot examples compare the experimental versus calculated melt pool dimensions. 
In general a good trend can be seen for both the simulations with the as-cast and LPBF fabricated 
substrates. The experimental melt pools are in general deeper than the simulated with an increasing 
error with increasing depth of the melt pool.

Figure 66: 3D plot of melt pool for as-cast substrate  where P = 325 W and scanning speed = 600 mm/s.

Figure 67: Parity plot for as-cast substrate when 5/12 experiments are calculated.
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Figure 68: Parity plot for as-cast substrate when all 12 experiments are calculated.

Figure 69: Parity plot for LPBF printed substrate when 5/12 experiments are calculated.
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Figure 70: Parity plot for LPBF printed substrate when all 12 experiments are calculated.

Figure 71: 3D plot of melt pool for LPBF printed substrate where P = 325 W and scanning speed = 1200 mm/s.
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Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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AM_12: Using AM Calculator Probe Data with the Precipitation 
Module (TC-PRISMA)

This example demonstrates the coupling of the AM Calculator with the Precipitation Calculator via 
probe data from an AM simulation. Both a thermodynamic and mobility database is needed for the 
precipitation calculation, so the AM Material Library cannot be used. Instead, a Scheil Calculator is used 
to calculate the material properties used in the AM simulation.

The example simulates the incipient melting and re-precipitation of gamma prime in CMSX-4 during 
Selective Electron Beam Melting (SEBM) during a single pass of the beam. The SEBM process is 
simulated using a Gaussian heat source. A transient simulation of a single track is simulated, with a 
cooling time of 150 s. The bed and ambient temperature is elevated to 950 °C. The process parameters 
are taken from Ramsperger et al. [2016aRam].

Project File and License Information
 l Folder: Additive Manufacturing
 l File name: AM_12_AM_Probe_to_Precipitation.tcu

A separate license is required to perform calculations with the Additive Manufacturing 
(AM) Module. This example also requires a license for the Precipitation Module (TC-
PRISMA), plus additional database licenses for the TCS Ni-based Superalloys Database 
(TCNI) (TCNI12 and newer), and the TCS Ni-alloys Mobility Database (MOBNI) (MOBNI6 and 
newer).

Background

Ramsperger and Körner [2016bRam] demonstrated that it is possible to print single crystal CMSX-4 
components using SLBM with an elevated bed temperature. The main challenge encountered is fracture 
during printing. The formation of gamma prime may incur a drop in ductility that contributes to fracture. 
Understanding the precipitation kinetics of gamma prime during 3D printing is important with regards 
to identifying optimum process parameters, and determining how best to heat treat the final 
component.

Wahlmann et al. [2019Wah] studied gamma prime kinetics in emulated SLBM thermal conditions, 
indirectly measuring the size of the gamma prime using X-ray diffraction during repeated nucleation and 
dissolution thermal cycles imitating the thermal history of an SLBM build. Figure 72 shows the 
calibration of the Precipitation Calculator to capture the measured kinetics.
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Figure 72: A comparison of the indirectly measured gamma prime size evolution during thermal heat 
treatment emulated an SLBM process with predictions from the Precipitation Calculator using the Thermo-Calc 
Ni-based superalloys databases (TCNI12 and MOBNI6) [2019Wah].

This AM Calculator to Precipitation Calculator example uses the calibrated parameters for gamma prime 
kinetics shown in Figure 72. The Precipitation Calculator includes the possibility for incipient melting of 
the gamma prime, which is predicted to occur during the first pass of the electron beam. Incipient 
melting describes the phenomena where solid-state precipitates are heated rapidly to a high 
temperature beyond their solvus temperature. The precipitates reach a temperature where they melt 
before the parent matrix phase. The Precipitation Calculator removes the gamma prime dispersion upon 
melting.

Configuration and Calculation Set Up

The Additive Manufacturing template was used to first add the System Definer, Scheil Calculator, AM 
Calculator, and Plot Renderer to the Project window tree. Additionally, a Precipitation Calculator was 
added as a successor to the AM Calculator in order to automatically import the time-temperature 
profile from the AM simulation into the precipitation simulation.

Open the example to see the Project tree layout and review the settings for each activity. It 
is useful to click around in the interface to understand where the settings are located and 
configured. This section highlights the relevant settings for this example.
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System Definer

On the System Definer, the nickel-based superalloy CSMX-4 composition was approximated by Ni-
9.8Co-6.4Ta-6.5Cr-6.4W-5.7Al-2.8Re-0.97Ti-0.62Mo-0.086Hf, (mass%). The thermodynamic (TCNI) and 
mobility (MOBNI) nickel-based superalloy databases were selected, with the phase DIS_FCC_A1 
included.

You can include or exclude phases from the Phases and Phase Constitution tab on the 
System Definer.

AM Calculator

On the AM Calculator Configuration window, the calculation type Transient is selected with a single 
track scan pattern and Geometry of 5 mm x 5 mm x 5 mm (height x width x length). The Base plate 
temperature and Ambient temperature is set to 950 ℃ .

Additional settings are then made on the Configuration window as follows.

 l In the Heat Source section, Gaussian is selected with a Power of 180 W, and a User-defined 
Absorptivity of 85 %.

 l In the Scanning Strategy section, the Scanning speed is 300 mm/s and the Layer thickness is 50 
μm. A Cooling time of 150 s is included.

 l In the Top Boundary Conditions section, the Evaporation checkbox is selected to include this in 
the model.

 l In the Probe Positions section, a single probe is added to the center of the top surface of the 
component, below the powder layer. See the Geometry tab as shown in Figure 73.
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Figure 73: The full geometry set up for the single track AM simulation with a probe point added to the middle 
of the scan. Open the example to better see the set up and try working in the Visualizations window.

Precipitation Calculator

The following highlights the relevant settings to make on the Configuration window for this example.

On the Options tab:

 l Both the Preprocess equilibrium data and Include incipient melting checkboxes are selected.

On the Conditions tab, under Matrix Phase:

 l DIS_FCC_A1 is selected.

Also see "Selecting the Disordered Phase as a Matrix Phase" in the Precipitation 
Module User Guide, or search for this in the help.

 l Click Show Details, then for Mobility adjustment > Prefactor, keep Same for all elements and 
enter 6.0 for the Prefactor.

On the Conditions tab, under Precipitate Phase:

 l FCC_L12#2 is selected.
 l Nucleation sites = Bulk
 l Interfacial energy = 0.035 J/m2
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 l Click Show Details, then:
 l Phase energy addition = -55.0 J/mol
 l Select the Preexisting size distribution checkbox.
 l Click Edit Particle Size Distribution, and note the Compositions entered.

In the Preexisting Particle Size Distribution window you can also adjust other settings.  In 
this case, the size distribution is approximated by a Weibull distribution function with a 
mean radius of 200 nm, an Alpha of 2.0, and a fraction offset of 0.5 Search for "Particle Size 
Distribution (PSD)" in the Precipitation Module User Guide, or in the help.

On the Conditions tab, under Calculation Type: 

 l Temperature unit = Kelvin
 l Start time = 0.0
 l Simulation time = 150.01 Seconds
 l Probes: Probe1
 l Condense time-temperature data = None
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation(s).

Figure 74 and Figure 75 show the predicted evolution of the precipitate dispersion including the change 
in mean radius and volume fraction, respectively. The second Y axis in both figures shows the 
temperature. The initial gamma prime size distribution describes the gamma prime that has formed 
during the production of the AM powder. It is too large to dissolve during the rapid heating as the 
electron beam heats the component, and melts before the matrix. The gamma prime re-precipitates 
upon resolidification and cooling below the gamma prime solvus, and coarsens whilst held at elevated 
temperature. The incipient melting of the initial size distribution is clearly evident.

Figure 74: The mean radius and temperature as a function of temperature, with the mean radius on the left 
axis, and the temperature on the right axis.
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Figure 75: The volume fraction and temperature as a function of temperature, with the volume fraction on the 
left axis, and the temperature on the right axis. 

The gamma prime distribution just prior to incipient melting is observed at 0.004 s. It has not dissolved 
significantly during the rapid heating as the electron beam passes. At 1 s the material has solidified and 
cooled to a temperature where gamma prime has nucleated and grown. The size distribution at the end 
of the simulation is shown at 150.1 s. Figure 76 shows the size distributions at these times during the 
single track AM simulation.
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Figure 76: The size distributions of gamma prime at key points during the simulation. 
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Other Resources

Read more about the Additive Manufacturing (AM) Module on our website including the 
details about database compatibility or to watch an introductory webinar. You can also use 
the Getting Started Guide to learn about the key features available. 
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Diffusion Module (DICTRA) Examples Collection
These are the Graphical Mode examples. There are separate Console Mode examples also 
available. 

Examples using up to three elements are available to all users. The other examples require 
a Diffusion Module (DICTRA) license to calculate and plot results. 

The Role of Diffusion in Materials: A Tutorial is available for download on our website. It is 
intended for engineers interested in using the Diffusion Module (DICTRA), as well as 
students learning about the role of diffusion in materials. It is designed to be useful at 
many levels, from undergraduate studies to someone with a PhD and experience in a 
related field.

These examples use the Diffusion Calculator. All examples use demonstration database packages 
included with your installation no matter what licenses you have.

About the Examples

In this section:

D_01: Homogenization of a Binary Fe-Ni Alloy 195

D_02: Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy 198

D_03: Evolution of an Fe-Cr-Ni Diffusion Couple 201

D_04: Fe-C Moving Boundary - Austenite to Ferrite 204

D_05: γ/α/γ Diffusion Couple of Fe-Ni-Cr alloys 208

D_06: Diffusion Through a Tube Wall 215

D_07: Multiphase Carburization of an Alloy 219

D_08: Microsegregation During Solidification 223

D_09: Ni Post Weld Heat Treatment 226

D_10: Iron (Fe) Homogenization in Scheil 230
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D_01: Homogenization of a Binary Fe-Ni Alloy

The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in a planar 
domain. At this temperature the material is fully austenitic, i.e. the only phase present is the so-called 
fcc (face centered cubic) phase. Initially, there is a linear variation in Ni going from 10 mass-% on the 
left-hand side to 50 mass-% on the right-hand side. 

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_01_Diffusion_Single_Phase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available to all 
users. A version of the example is also available for Console Mode.

Visualizations

This example is included as a Diffusion Module (DICTRA) tutorial on our website and as part 
of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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Figure 1: During set up of the calculation, you can preview the Composition Profile (shown) or Thermal Profile. 
Click the tab(s) in the Visualizations window to switch between these previews and adjust settings on the 
Diffusion Calculator Configuration window. For an Isothermal Thermal Profile this shows the constant 
temperature as entered. 
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Figure 2: After performing the calculation, you can view the  result on the Composition of Ni vs Distance tab, 
which shows the initial and final Ni profile. In this example, the Plot Renderer is renamed and this matches the 
tab name in the Visualizations window.
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D_02: Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C 
Alloy 

The moving phase boundary example  simulates the growth of ferrite (bcc) into austenite (fcc). The 
austenite is assumed to be initially homogeneous with the composition Fe-0.15 mass-% C. The 
transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and an initially very 
thin ferrite (1 nm) is also present at the start of the simulation. 

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_02_Diffusion_Moving_Boundary.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available to all 
users. A version of the example is also available for Console Mode.

Visualizations

This example is included as a Diffusion Module (DICTRA) tutorial on our website and as part 
of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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Figure 3: During set up of the calculation, you can preview the Composition Profile (shown) or Thermal Profile. 
Click the tab(s) in the Visualizations window to switch between these previews and adjust settings on the 
Diffusion Calculator Configuration window. For an Isothermal Thermal Profile this shows the constant 
temperature as entered. 
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Figure 4: After performing the calculation, you can view the result on the Position of interface vs time tab. In 
this example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window. 

Figure 5: After performing the calculation, you can view the result on the Composition profile C tab. In this 
example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window.
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D_03: Evolution of an Fe-Cr-Ni Diffusion Couple

The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100 hour heat 
treatment at  1100° C (1373.15 K). Both end members of the diffusion couple are duplex ferrite plus 
austenite, but the majority phase is ferrite on the left-hand side and austenite on the right. 

With this type of simulation it is assumed that the material is fully equilibrated at each grid point, i.e. 
the local phase fractions, phase compositions and so forth are obtained from an equilibrium calculation 
with the local overall composition as a condition. 

More details about the homogenization model for multiphase simulations can be found in Larsson and 
Engström [2006Lar]   and Larsson and Höglund [2009Lar]. Experimental data is from Engström [1995Eng]. 

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_03_Diffusion_Multiphase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available to all 
users. A version of the example is also available for Console Mode.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 
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 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 6: During set up of the calculation, you can preview the Composition Profile (shown) or Thermal Profile. 
Click the tab(s) in the Visualizations window to switch between these previews and adjust settings on the 
Diffusion Calculator Configuration window. For an Isothermal Thermal Profile this shows the constant 
temperature as entered. 
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Figure 7: After performing the calculation, you can view the  result on the Phase fraction of FCC tab. In this 
example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window.
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D_04: Fe-C Moving Boundary - Austenite to Ferrite

This example simulates the austenite to ferrite transformation in a Fe-0.01 mass% C steel during 
continuous cooling. The simulation starts at a temperature where only austenite is stable, ferrite 
nucleates and grows into the austenite during cooling in the two phase region. Plots of thermal and 
carbon composition profiles are generated.

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_04_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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Figure 8: During set up of the calculation, you can preview the Composition Profile. Click the tab in the 
Visualizations window to switch between these previews and adjust settings on the Diffusion Calculator 
Configuration window. 
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Figure 9: During set up of the calculation, you can preview the non-isothermal Thermal Profile. Click the tab in 
the Visualizations window to switch between these previews and adjust settings on the Diffusion Calculator 
Configuration window. Also see the plot result comparing the thermal profile for the two regions.
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Figure 10: After performing the calculation, you can view the result on the Thermal profile tab. In this 
example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window. Note that 
this Thermal Profile is slightly different than what you can preview during set up.

Figure 11: After performing the calculation, you can view the  result on the Carbon composition profile tab. In 
this example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window.
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D_05: γ/α/γ Diffusion Couple of Fe-Ni-Cr alloys

This example demonstrates the evolution of a ternary Fe-Cr-Ni diffusion couple. A thin slice of ferrite (α 
phase) (38%Cr,0%Ni) is clamped between two thicker slices of austenite (γ phase) (27%Cr, 20%Ni). The 
assembly is subsequently heat treated at 1373 K. 

This set up corresponds to diffusion couple in Kajihara et al. [1993aKaj] and Kajihara and Kikuchi 
[1993bKaj].

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_05_Diffusion_Fe_Ni_Cr_Moving_Boundary_Diffusion_Couple.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 12: In this example, all Plot Renderer nodes are renamed and each match a tab name in the 
Visualizations window. Use the left and right arrows in the Visualizations window to move through the tabs 
and the down arrow to choose by name when a tab is not visible. 
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Figure 13: During set up of the calculation, you can preview the Composition Profile (shown) or Thermal 
Profile. Click the tab(s) in the Visualizations window to switch between these previews and adjust settings on 
the Diffusion Calculator Configuration window. For an Isothermal Thermal Profile this shows the constant 
temperature as entered. 
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Figure 14: After performing the calculation, you can view the  result on the  Interface position tab. 

Figure 15: After performing the calculation, you can view the result on the Concentration profiles at 3600 s 
tab.
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Figure 16: After performing the calculation, you can view the result on the Concentration profiles at 36 000 s 
tab. 

Figure 17: After performing the calculation, you can view the  on the Concentration profiles at 360 000 s tab. 
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Figure 18: After performing the calculation, you can view the  result on the Concentration profiles at 3 600 000 
s tab. 

Figure 19: After performing the calculation, you can view the  result on the Diffusion paths tab. 
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D_06: Diffusion Through a Tube Wall

This is a simple example of diffusion through a tube wall. The tube material is an Fe-0.06Mn-0.05C alloy. 
Two plots comparing distance to the U-fraction of manganese and composition of carbon are generated 
to visualize the austenite region. A cylindrical geometry is used with mixed zero flux and activity 
boundary conditions. 

On the inside wall a carbon activity of 0.9 is maintained whereas on the outside the carbon activity is 
very low. This example demonstrates the use of boundary conditions, advanced plotting and tables. 

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_06_Diffusion_Carburization_Tube.tcu

This example is based on Console Mode exab6. When in Console Mode, you can open the 
example from Thermo-Calc  (File → Examples Files → Diffusion Module). 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 
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 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 20: During set up of the calculation, you can preview the Composition Profile (shown) or Thermal 
Profile. Click the tab(s) in the Visualizations window to switch between these previews and adjust settings on 
the Diffusion Calculator Configuration window. For an Isothermal Thermal Profile this shows the constant 
temperature as entered. 
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Figure 21: After performing the calculation, you can view the  result on the Composition of C vs Distance tab. In 
this example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window.

Figure 22: After performing the calculation, you can view the result on the U-fraction of Mn vs Distance tab. In 
this example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window.
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Figure 23: After performing the calculation, you can view the result on the Table Composition C vs Distance 
tab. In this example, the Table Renderer is renamed and this matches the tab name in the Visualizations 
window.
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D_07: Multiphase Carburization of an Alloy

This example is based on Engström et al. [1994Eng] and is about carburization of a Ni-25Cr-0.0001C 
alloy. In this case the M7C3 and M3C2 carbides are entered as spheroid phases in an FCC_A1 matrix. It is 
similar to Graphical Mode example D_06 except the default simulation condition is automatically set to 
use the homogenization model. 

The isothermal calculation is run for 1000 hours at a temperature of 1123 K using the mixed zero flux 
and activity left boundary condition. Results are plotted using two Plot Renderers and a Table Renderer.

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_07_Diffusion_Carburization_Multiphase.tcu

This example is based on Console Mode exd1b. When in Console Mode, you can open the 
example from Thermo-Calc  (File → Examples Files → Diffusion Module). 

Visualizations

This example is included as a Diffusion Module (DICTRA) tutorial on our website and as part 
of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 
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 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 24: During set up of the calculation, you can preview the Composition Profile (shown) or Thermal 
Profile. Click the tab(s) in the Visualizations window to switch between these previews and adjust settings on 
the Diffusion Calculator Configuration window. For an Isothermal Thermal Profile this shows the constant 
temperature as entered. 
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Figure 25: After performing the calculation, you can view the  result on the Phase fraction vs distance tab. In 
this example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window. 

Figure 26: After performing the calculation, you can view the  result on the Table of Composition profiles tab. 
In this example, the Table Renderer is renamed and this matches the tab name in the Visualizations window.
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Figure 27: After performing the calculation, you can view the result on the Composition of C vs distance tab. In 
this example, the Plot Renderer is renamed and this matches the tab name in the Visualizations window.
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D_08: Microsegregation During Solidification

This application example, which is showcased on our website, shows how Thermo-Calc together with 
the Diffusion Module (DICTRA) can be used to investigate and predict microsegregation during 
solidification, also known as solute redistribution during solidification. The example uses a steel with 
composition Fe – 0.8% Mn – 0.7%Si – 0.03%P – 0.4%C.

The example is based on a real case where the elemental distribution of a continuously cast steel was 
measured revealing the concentration of the elements Si, Mn, and P. The profile results from the well-
known segregation across secondary dendrite arms. The interesting point is that the elements Si and Mn 
show the expected positive segregation (higher concentrations) in the interdendritic regions. The peak 
of the P content, on the other hand, is shifted compared to Si and Mn, and, in fact, shows negative 
segregation in the interdendritic region. This is unexpected and counter-intuitive.

The example also touches on some very basic concepts for metallurgy and using Thermo-Calc, such as 
stable and meta-stable phase diagrams, Scheil and para- or partial-equilibrium Scheil solidification 
simulations.

Project File and License Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_08_Diffusion_Microsegregation_During_Solidification.tcu

Running this calculation requires licenses for the Add-on Diffusion Module (DICTRA) plus 
the steels thermodynamic database (TCFE9 or newer) and mobility database (MOBFE4 or 
newer).

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

 

Figure 28: During set up of the calculation, you can preview the Composition Profile. Click the tab in the 
Visualizations window to switch between these previews and adjust settings on the Diffusion Calculator 
Configuration window. 
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Figure 29: During set up of the calculation, you can preview the Thermal Profile. Click the tab in the 
Visualizations window to switch between these previews and adjust settings on the Diffusion Calculator 
Configuration window. 

The other resulting plots and details related to setting up this example are available to 
download via the dedicated web page.  
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D_09: Ni Post Weld Heat Treatment

In this example, a Ni-based alloy (Ni-Al-Co-Cr-Mo-Ti) post weld heat treatment analysis is completed. It 
shows how to import an initial composition profile from a file into the Diffusion Calculator. Then the 
calculation is run and plotted to show the composition of Al vs distance compared to experimental data 
from [2017She]. Such simulations can be used to design the heat treatment such that the desired 
homogenization of the weld is achieved. The initial composition profile needs to be determined by 
suitable experimental techniques, for example microprobe.

This example highlights the dual purpose of the Visualizations window where you can enter or import 
Composition profiles via the Diffusion Calculator Configuration window as well as being able to view and 
analyze results via the Plot Renderer after a calculation runs. 

Project File Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_09 Ni_Post_Weld_Heat_Treatment_From_File.tcu

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

On the Diffusion Calculator, when defining its setup, the Composition profiles are imported using the 
Table input option. A prepared file, in this case a csv file, is set up with the correct data columns, which 
then are included on the Configuration window. After import the Composition Profiles are further able 
to be seen via the Visualizations window, at which point adjustments can be made as needed.  In this 
isothermal example, you can also see that the constant temperature of the Thermal Profile is  
previewed.
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Figure 30: The Diffusion Calculator Configuration window showing the composition profile data, which is then 
compiled and displayed on the Visualizations window.

Figure 31: The Visualizations window displays details from both the Diffusion Calculator node (renamed to 
Post-weld heat treatment) via the Composition Profile and Thermal Profile tabs as well as the Plot Renderer 
node (renamed to Composition of Al vs Distance).

ǀ 227 of 420



Figure 32: The Composition Profiles as shown in the Visualizations window after data is prepared and then 
imported into the Diffusion Calculator Configuration window.

An Experimental File Reader node is used to supply experimental data from [2017She] to the Plot 
Renderer to validate the composition of, for example, Al vs distance on the Plot Renderer. The plot 
shows the content of Al along the cross-section of the weld, both before and after the post weld heat 
treatment. There is good agreement between the diffusion simulation and the data measured in the 
literature.
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Figure 33: Plot results showing the mole fraction of Al before and after the heat treatment as a function of 
distance for a Ni-based alloy compared to experimental data [2017She].

Other plots could be added to investigate further details of the simulations, such as phase fractions or 
compositions.

Reference
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D_10: Iron (Fe) Homogenization in Scheil

This example models the homogenization of a cast Ni-Cr steel and compares predictions with the 
experimental data collated by Fuchs and Roósz [1975Fuc]. The conditions studied have a dendritic half 
spacing of 200 µm and are heat treated to temperatures of 1120 °C and 1235 °C. The data has been un-
normalized to allow comparison using wt.% composition values.

The composition of the steel is 0.4C, 0.65Mn, 0.35Si, 0.015S, 0.01P, 1.9Ni, 0.95Cr, and 0.3 Mo (wt.%). 
The diffusion of Cr and Ni are modeled using a simplified chemistry of 0.4C, 0.65Mn, 1.9Ni, and 0.95Cr.

Project File and License Information
 l Folder: Diffusion Module - DICTRA
 l File name: D_10_Fe _Homogenization_from_Scheil.tcu

The Diffusion Module (DICTRA) Console Mode example exa7 is available to show the use of 
Scheil segregation profiles in Console Mode.

The FEDEMO thermodynamic and MFEDEMO mobility databases are used with this 
example. Users with a Diffusion Module (DICTRA) license can run the example. Other users 
can read the documentation as a DEMO license only allows the use of up to three 
components.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.
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 l Composition Profiles and Thermal Profile: When setting up a calculator on a Configuration 
window you can preview the profile and adjust settings as needed. When you click a calculator 
node in the Project window, the matching name of the node is on the tab(s) displayed in the 
Visualizations window. 

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 34: The predicted chemical segregation using the Scheil calculation, with a dendritic half spacing of 200 
µm. This is the Composition Profile that is set up on the Diffusion Calculator and then previewed in the 
Visualizations window. 
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Figure 35: An example of the modeled isothermal heat treatments. The homogenization kinetics at 1235 °C 
and 1120 °C have been modeled for 72 hours. This is the Thermal Profile that is set up on the Diffusion 
Calculator and then previewed in the Visualizations window. 
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Figure 36: The solidification behavior predicted from the Scheil calculation compared with the equilibrium solid 
fraction.
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Figure 37: A comparison of the predicted and measured maximum Cr across the dendrites during 
homogenization at 1120 °C.
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Figure 38: A comparison of the predicted and measured maximum Ni across the dendrites during 
homogenization at 1120  °C.
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Figure 39: A comparison of the predicted and measured maximum Cr across the dendrites during 
homogenization at 1235 °C.

ǀ 236 of 420



Figure 40: A comparison of the predicted and measured maximum Ni across the dendrites during 
homogenization at 1235 °C.
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Precipitation Module (TC-PRISMA) Examples 
Collection

Examples that use up to three elements are available to all users. Other examples require a 
Precipitation Module (TC-PRISMA) license to calculate and plot results. 

When an example uses a demonstration (demo) database package, this is included with 
your installation. 

Unless specified in tables for each example, all the numerical parameters are assumed 
default values.

In this section:

P_01: Isothermal Precipitation of Al3Sc 240

P_02: Stable and Metastable Carbides - Isothermal 254

P_03: Stable and Metastable Carbides - TTT Diagram 258

P_04: Precipitation of Iron Carbon Cementite 262

P_05: Precipitation of γ’ in Ni Superalloys - Isothermal 265

P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal 270

P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-Cr γ-γ’ 278

P_08: Precipitation of Cu-Ti CU4TI with Assumptions of Sphere and Needle Morphologies 286

P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and Cuboid Morphologies 293

P_10: Initial Particle Size Distribution of Fe-Cr-C 308

P_11: Interfacial Energy Function 315

P_12: Comparing Growth Rate Models for an Al-Zr System 319

P_13: Paraequilibrium Precipitation of Cementite Fe-C-Cr 323
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P_14: Grain Growth and the Zener Pinning Effect 327

P_15: Smooth Transition from Paraequilibrium to Ortho-equilibrium 331

P_16 Isothermal Coarsening and  a 3D to 2D Stereological Conversion 336
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P_01: Isothermal Precipitation of Al3Sc

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase. The 
simulation results can be compared with experimental data collected from Marquis and Seidman 
[2001Mar] and Novotny and Ardell [2001Nov].

This example also includes a plot using the Yield strength Property Model. This demonstrates how you 
can use the results from a Precipitation Module (TC-PRISMA) simulation as input to the Yield Strength 
Model, i.e. the calculated precipitate radius/radii for each time step is used to calculate the precipitation 
strengthening, and similarly, the matrix composition for each time step is used to calculate the solid 
solution strengthening when this is selected in the Configuration on the Plot Renderer. The 
experimental data for the Yield Strength Model is from Seidman et al. [2002Sei]. In this example, the 
Precipitation strengthening model used is Seidman model (Al-base). This is selected on the Plot 
Renderer configuration panel that is connected to the Property Model.

Project File and Step-By Step Instructions
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_01_Precipitation_Al-Sc_AL3SC.tcu

You can also use the step-by-step instructions included in a PDF to follow the video or 
compare to the project file in Thermo-Calc.

Example Settings

System (System Definer)

Database package Demo: Aluminum-based alloys 
(ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

Precipitate phase AL3SC

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk
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Interfacial energy Calculated

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E7 seconds

Experimental File Reader 1 and 2  

There are two Experimental File Reader nodes used. One for the mean radius plot 
and one to demonstrate the Yield Strength Property Model.  

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our website and 
as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.
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 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 1: During set up of the calculation, you can preview the  Thermal Profile. Click the tab in the 
Visualizations window to  preview it and adjust settings on the Precipitation Calculator Configuration window. 
For an Isothermal Thermal Profile this shows the constant temperature as entered. 
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Figure 2: After performing the calculation, you can view the  result on the applicable tab. This plot shows the 
mean radius of the AL3SC precipitate as a function of time.
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Figure 3: After performing the calculation, you can view the  result on the applicable tab. This plot shows the 
total yield strength of the AL3SC precipitate as a function of time compared to experimental data from 
Siedmen et al. [2002Sei]. The model captures the over-tempering behavior from excessive coarsening of the 
strengthening precipitates.
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Isothermal Precipitation Calculation: Example P_01 – 
Precipitation Al-Sc AL3SC 

This example shows you how to set up an isothermal precipitation calculation for the formation of 
AL3SC in an aluminium-scandium alloy at 350° using the Precipitation Module (TC-PRISMA).  

The end of the example also shows how to use the results of the calculation to model Yield Strength.  

This is one of the most basic calculations using the Precipitation Module (TC-PRISMA), so it is a good 
place to start if you are new to this simulation type.  

HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
Module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here:  
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

This calculation is based on Precipitation Module example P_01 – Precipitation Al-Sc AL3SC, which is 
included in your installation.  

1. To run the example file, open Thermo-Calc and select Help > Examples Files or click Example 
Files on the My Project Configuration window.  

2. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example file to open it. 
3. In Thermo-Calc at the bottom center of the Configuration window click Perform Tree.  

 

 

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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ABOUT THE EXAMPLE  

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase. The 
results of the simulation are also used to model yield strength.  

SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. On the My Project Configuration window under Non-Equilibrium, click Precipitation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. In the Project window, click the System Definer 1 node.  
5. On the Configuration window from the Package list, select Demo: Aluminium-based alloys 

(ALDEMO, MALDEMO). This loads both thermodynamic and kinetic demonstration 
aluminium databases.  

6. In the Periodic Table, select the elements in the following order.  
Select Al first so that it is the dependant element: 

a. Al (aluminium)  
b. Sc (scandium).  

7. From the Amount list (to the right of the Periodic Table), select Mole percent. 
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.  
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The system is now defined. However, before starting the precipitation calculation, it is recommended 
to run a one axis calculation to find the phases present around 350° C.  

ONE AXIS CALCULATION 

Why We Do This 

In order to set up an isothermal precipitation calculation, you need to know which phases are 
present at 350 °C. A one axis calculation provides this information. Note that this step is not included 
with the P_01 example. This is an additional exercise. 

Setting up a One Axis Calculation 

1. In the Project window, right-click the System Definer 1 node, and select Create New 
Successor > Equilibrium Calculator.  

2. In the Configuration window, set Temperature to Celsius and enter 300. 
3. Under Calculation Type, click One axis.  

You now want to find the phases present around 350 °C. 
4. Under Axis Definitions, enter the Temperature range from Min 300 to Max 700.  

Keep the default values for everything else. The system is now defined. 
5. Right-click the Equilibrium Calculator node and select Create New Successor > Plot 

Renderer.  
6. In the Project window, click the Plot Renderer 2 node you just created. In the Configuration 

window, set the X-axis variable for Temperature to Celsius. Then right-click the Plot 
Renderer 2 node select Perform Now. Or click Perform at the bottom of the Configuration 
window. 
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Interpreting the Results of the One Axis Calculation 

Once the calculation is complete, a plot is displayed in the Results window. This plot shows you 
which phases are present at each temperature between 300° and 700° and the amount of that phase 
at each temperature. 

If you hover your cursor over any of the lines on the plot, a label gives you the name of the phase, 
the temperature and the amount of the phase at that temperature.   

We can see that there are two phases present at 350°. FCC_A1 is at the very top of the plot and 
makes up more than 99% of the system. The remainder of the system is made up of Al3SC, which is 
near the very bottom of the plot and is the precipitate phase in the alloy we are considering.  

Remember these two phases because these are used in the precipitation calculation.  
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PRECIPITATION CALCULATION 

Setting up the Precipitation Calculation 

1. In the Project window, click the Precipitation Calculator 1 node.  
2. Notice that the Composition set in the System Definer auto-populated here.  
3. Under Matrix Phase, the Phase defaults to FCC_A1, which is the primary phase present in the 

one axis calculation.  

NOTE: If you do not see any phases listed here it is probably because you do not have a kinetic 
database selected. If so, go back to the System Definer and add a kinetic (mobility) database. In this 
example it should be the MALDEMO database. 

4. Under Precipitate Phase, select AL3SC from the Phase list because that is the other phase 
present around 350 °C, as shown in the one axis calculation.  

5. Accept the rest of the default settings in the Precipitate Phase section. You could choose to 
define your own interfacial energy settings if you have them.  

6. Under Calculation Type, make sure Isothermal is selected.  
7. Enter: 

a. 350 as the Temperature and select Celsius.  
b. 1.0E7 as the Simulation time and select Seconds, which is ten million seconds.  

 

8. In the Project window, click the Plot Renderer 1 node. 
9. Under Y-axes, from the Axis type menu select Logarithmic 10 for a better view of the plot. 
10. Click Perform at the bottom, center of the Configuration window.  



Isothermal Precipitation Calculation 
Example P_01 – Precipitation Al-Sc AL3SC 

 

Page 6 of 9 
Version 4 (May 2022) 

 

 

Interpreting the Results of the Precipitation Calculation 

Once the calculation is complete, your plot is shown in the Results window. 

   

At the beginning, which is the left-most side of the plot, the mean radius is quite small and then 
grows rapidly over time, which is represented by moving rightward on the plot.  

Setting Other Variables in the Precipitation Module (TC-PRISMA) 

The Precipitation Module (TC-PRISMA) offers many variables that you can plot for the same 
calculation.  

1. Click the Plot Renderer 1 node. 
2.  Under Y-axes, click the Axis variable menu to see the other available options in the list.  

This plot shows the 
Mean radius of the 
AL3SC precipitate as a 
function of time.  
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3. Once you have made your selection, click Perform at the bottom, center of the Configuration 
window to create a new plot.   

 

Model Yield Strength 

Beginning with Thermo-Calc 2020b, results of a precipitation simulation can be used as input to 
model yield strength using the Yield Strength Property Model. The following simulation requires a 
license for Thermo-Calc 2020b or newer.  

1. Right click the Precipitation Calculator 1 node and select Create New Successor > Plot 
Renderer.  

2. Under Y-axes, from the Axis variable menu, select Yield strength (as in the figure above but 
for Plot Renderer 3). 

3. Click the Configuration panel button.  
4. If required, expand the Plot Renderer Configuration window. Then from the Precipitation 

strengthening model menu select Seidman model (Al-base).  
5. Under Y-axes, from the Axis type menu, select Logarithmic 10. 
6. Click Perform at the bottom, center of the program.  

The program uses the results from the precipitation simulation as the input for the Yield Strength 
model. 



Isothermal Precipitation Calculation 
Example P_01 – Precipitation Al-Sc AL3SC 

 

Page 8 of 9 
Version 4 (May 2022) 

 

  

 

Interpreting the Results of the Yield Strength Model 

Once the calculation is complete, your plot is shown in the Results window. 
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This plot shows the 
yield strength of the 
AL3SC precipitate as a 
function of time.  



P_02: Stable and Metastable Carbides - Isothermal

This example simulates the kinetics of precipitation of both stable and metastable carbides from ferrite 
phase. It demonstrates that metastable carbides (cementite, M7C3) may first emerge and then 
disappear and the stable phase (M23C6) prevails. 

This example uses the Equilibrium Calculator  and a one axis calculation to determine how the phases 
change with temperature. We are interested in the carbide precipitation at 1053 K where only the 
carbide M23C6 is stable according to the equilibrium calculation. The Precipitation Calculator is used to 
do an isothermal calculation of the three phases (cementite, M23C6, and M7C3) where cementite and 
M7C3 are metastable phases. 

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6.tcu

Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size (click Show Details to display this setting) 1.0E-4 m

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries
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Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.

Figure 4: After performing the calculation, you can view the  result on the applicable tab. This shows the 
equilibrium property diagram for the Fe-C-Cr alloy, highlighting what phases are predicted to be at equilibrium 
for a range of temperatures. The calculation shows that at 1053 K, M23C6 is the stable carbide.
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Figure 5: After performing the calculation, you can view the  result on the applicable tab. This shows the 
evolution of the volume fraction of cementite, M7C3, and M23C6 during an isothermal heat treatment of an 
Fe-C-Cr alloy at 1073 K. The cementite and M7C3 are metastable at this temperature, however their 
nucleation kinetics are faster than the stable phase, allowing them to form and then dissolve when the next 
more thermodynamically stable phase nucleates.
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P_03: Stable and Metastable Carbides - TTT Diagram

In this example, the kinetics of precipitation of both stable and metastable carbides is calculated from 
the ferrite phase. It demonstrates that metastable carbides may first emerge and then disappear and 
the stable phase prevails.

This example uses the Equilibrium Calculator  and a one axis calculation type to determine how the 
phases change with temperature. Using this result,  the Precipitation Calculator is used to do a TTT 
(Time-Temperature-Transformation) diagram calculation of the three phases (cementite, M23C6 and 
M7C3) at the grain boundaries.

For a TTT diagram calculation, select TTT diagram in Calculation Type, then enter Min, Max, and Step of 
Tempeature, as well as Max annealing time. In Stop criterion, choose Volume fraction of phase and 
enter the value. 

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_03_Precipitation_Fe-C-Cr_TTT_Cementite-M7C3-M23C6.tcu

Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size  (click Show Details to display this setting) 1.0E-4 m

Precipitate Phase Data Parameters

Nucleation sites Grain boundaries

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 
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J/m2

Calculation Type (Precipitation Calculator)

Calculation type TTT diagram

Temperature 500° to 800° C with 25° C steps

Max. annealing time 1.0E8 seconds

Stop criteria Volume fraction of phase is set to 0.0001

Options > Numerical Parameters

No. of grid points over one order of magnitude in radius 150

Max no. of grid points over one order of magnitude in 
radius 200

Min no. of grid points over one order of magnitude in 
radius 100

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 
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For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

Figure 6: After performing the calculation, you can view the result on the applicable tab. Here the results from 
the equilibrium calculator are shown, which assesses the stability of phases across the temperature range of 
interest.
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Figure 7: After performing the calculation, you can view the  result on the applicable tab.This shows results 
from a TTT (Temperature-Transformation) simulation using the Precipitation Calculator to examine the 
sequence of phase transitions considering the formation of cementite, M7C3, and M23C6 carbide phases. The 
previous Equilibrium Calculator reveals the temperatures where the cementite and M7C3 are metastable.
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P_04: Precipitation of Iron Carbon Cementite

This example is based on  [1949Wer] and simulates the kinetics of precipitation of carbides from a 
BCC Fe solution phase. This isothermal calculation example uses the Precipitation Calculator plus two 
Experimental File Reader activities to plot the volume fraction  of the  cementite phase.

Project File  Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_04_Precipitation_Fe-C_Cemetite.tcu

Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO) 

Elements Fe, C

Conditions (Precipitation Calculator)

Composition Fe-0.016C mass percent

Matrix phase BCC_A2

Precipitate phase Cementite

Matrix Phase Data Parameters (Precipitation Calculator)

Grain aspect ratio   (click Show Details to display this setting) 1.0

Dislocation density    (click Show Details to display this setting) 1.5e11m-3

Precipitate Phase Parameters (Precipitation Calculator)

Nucleation sites Dislocations

Interfacial energy 0.24 J/m2

Growth rate model (click Show Details) Advanced 

Calculation Type (Precipitation Calculator)

Calculation type Isothermal
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Temperature 102° C

Simulation time 600 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.

Figure 8: After performing the calculation, you can view the  result on the applicable tab. The result compares 
the predicted evolution of the volume fraction of cementite with the measurements of [1949Wer]. 

Reference

[1949Wer] C. A. Wert, Precipitation from Solid Solutions of C and N in α-Iron. J. Appl. Phys. 20, 943 
(1949).
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P_05: Precipitation of γ’ in Ni Superalloys - Isothermal

This example simulates the kinetics of precipitation of gamma prime (γ’) phase from gamma (γ) phase. 
The simulation results can be compared with experimental data collected from Sudbrack et al. 
[2008Sud]. 

This example uses three Experimental File Reader activities with the Precipitation Calculator. It does an 
isothermal calculation to plot the volume fraction, mean radius, and number density of the  cementite 
phase.

DIS_FCC_A1 needs to be selected on the System Definer. See Selecting the Disordered 
Phase as a Matrix Phase  for details.

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_05_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime.tcu

Example Settings

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al Cr

Conditions (Precipitation Calculator)

Composition Ni-9.8Al-8.3Cr Mole percent

Matrix phase DIS-FCC_A1 See Selecting the Disordered Phase as a Matrix Phase 

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk
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Interfacial energy 0.012 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 800° C

Simulation time 1 000 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.

Figure 9: After performing the calculation, you can view the result on the applicable tab. This plot compares 
the predicted evolution of the volume fraction of gamma prime with the measurements of [2008Sud]. 
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Figure 10: After performing the calculation, you can view the  result on the applicable tab. This plot compares 
the predicted evolution of the number density of gamma prime with the measurements of [2008Sud].

Figure 11: After performing the calculation, you can view the  result on the applicable tab. This plot compares 
the predicted evolution of the mean particle radius of gamma prime with the measurements of [2008Sud].
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Reference

[2008Sud] C. K. Sudbrack, T. D. Ziebell, R. D. Noebe, D. N. Seidman, Effects of a tungsten addition on the 
morphological evolution, spatial correlations and temporal evolution of a model Ni–Al–Cr superalloy. 
Acta Mater. 56, 448–463 (2008).
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P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal

This example simulates the kinetics of precipitation of gamma prime (γ’) phase from gamma (γ) phase in 
Ni-8Al-8Cr and Ni-10Al-10Cr at.% alloys during continuous cooling from a super-solvus temperature. The 
simulation results can be compared with experimental results from Rojhirunsakool et al. [2013Roj].

DIS_FCC_A1 needs to be selected on the System Definer for both the thermodynamic and 
mobility databases. See Selecting the Disordered Phase as a Matrix Phase  for details.

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_06_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_prime.tcu

Example Settings

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and 
MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition (Ni-8Al-8Cr) Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr) Ni-10Al-10Cr Mole percent

Matrix phase DIS_FCC_A1 See Selecting the Disordered Phase as a 
Matrix Phase 
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Precipitate phase FCC_L12#2

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility adjustment > Prefactor (click Show Details to 
display this setting)

Keep the default, Same for all elements, then enter 5.0 for 
the Prefactor.

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Non-isothermal

Temperature unit Celsius

Time unit Seconds

Temperature

1150 - 380 °C

Simulation time (Ni-8Al-8Cr) 3300 s

Simulation time (Ni-10Al-10Cr) 3300 s

Multimodal PSD (Plot Renderer)

Separate multimodal PSD checkbox is selected for 8Al-8Cr 
for both the Mean radius and PSD plots.

 l Mean Radius and PSD plots: The Inflection 
neighbors and Smoothing interactions defaults 
are kept.

 l Mean Radius plot: The Points are set to 15.

Separate multimodal PSD checkbox is selected for 10Al-
10Cr for both the Mean radius and PSD plots.

 l Mean Radius and PSD plots: The Inflection 
neighbors and Smoothing interactions defaults 
are kept.
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 l Mean Radius plot: The Points are set to 50.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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In this example, all nodes are renamed in the Project window, and this matches each of the 
tab names in the Visualizations window.

Figure 12: During set up of the calculation, you can preview the non-isothermal Thermal Profile(s). Click the 
tab in the Visualizations window to adjust settings on the Precipitation Calculator Configuration window. In 
this case the heat treatment is a continuous cooling curve, however any thermal profile can be modeled using 
the Non-isothermal Calculation Type.
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Figure 13: These results show the predicted evolution of the mean radius of gamma prime populations 
nucleating during the quench for the Ni-8Al-8Cr alloy. Note that the tertiary particles (second particle 
population) are very small, and this dispersion would appear monomodal without TEM characterization.
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Figure 14: These results show the predicted evolution of the mean radius of gamma prime populations 
nucleating during the quench for the Ni-10Al-10Cr alloy. In this case three distinct particle populations are 
simulated to form, agreeing with [2013Roj].
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Figure 15: These results show the predicted size distributions of precipitates at different times during the 
quench of the for the Ni-8Al-8Cr alloy. The individual particle populations are distinguished using the 
“Separate multimodal PSD” option showing a bimodal distribution with very small nano-meter sized tertiary 
particles.
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Figure 16: These results show the predicted size distributions of precipitates at different times during the 
quench for the Ni-10Al-10Cr alloy. The individual particle populations are distinguished using the “Separate 
multimodal PSD” option showing the formation of a tri-modal dispersion.

Reference
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(2013).
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P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-Cr 
γ-γ’

This example shows you how to simulate a CCT (Continuous Cooling Transformation) diagram for 
gamma prime (γ’) precipitation in a Ni-Cr-Al alloy using the Precipitation Calculator. A CCT calculation 
maintains the same cooling rate the entire time.

The system is a Ni-10Al-10Cr γ - γ’ alloy and it is calculated and plotted with superimposition of the 
cooling rate values.

Project File and Step-By Step Instructions
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_07_Precipitation_Ni-Al-Cr_CCT_Gamma-Gamma_prime.tcu

You can also use the step-by-step instructions included in a PDF to follow the video or 
compare to the project file in Thermo-Calc.

Example Settings

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition Ni-10Al-10Cr Mole percent 

Matrix phase DIS_FCC_A1

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type CCT Diagram
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Temperature Min to Max 500 to 1200 Kelvin

Cooling rate(s) .01 .1 1 10 100 K/s

Stop criteria Volume fraction of phase 1.0E-4

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our website and 
as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.
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Figure 17: In this plot, the blue horizontal line shows the time it takes for γ’ to transform at each of the cooling 
rates according to the stop criteria, which is set as 1e-4 volume fraction. The cooling rates are represented by 
the multicoloured curved lines.

If you hover your mouse over the intersection of the blue line and any of the vertical lines, a yellow box 
shows the approximate time it takes for γ’ to transform according to the stop criteria, which is a volume 
fraction of 1e-4, followed by the approximate temperature. 

Figure 18: An example of the table shown in the Visualizations window, which shows the same information as 
in the plot - for each cooling rate the temperature and the time it takes for γ’ to transform according to the 
stop criteria, which is a volume fraction of 1e-4.
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Continuous Cooling Transformation (CCT) Diagram of 
Ni-Al-Cr γ-γ’: Precipitation Example P_07 

HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
Module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here:  
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation Module example P_07 – Precipitation NI-Al-
Cr_CCT_Gamma-Gamma_prime, which is included in your installation.  

1. To run the example file, open Thermo-Calc and select Help > Examples Files or click Example 
Files on the My Project Configuration window.  

2. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example file to open it. 
3. In Thermo-Calc at the bottom center of the Configuration window click Perform Tree.  

 

 

ABOUT THE EXAMPLE  

This example shows you how to simulate a CCT diagram for gamma prime (γ’) precipitation in a Ni-Cr-
Al alloy using the Precipitation Module known as TC-PRISMA.  

CCT stands for Continuous Cooling Transformation and is a calculation that maintains the same 
cooling rate the entire time.  

The system is a Ni-10Al-10Cr γ - γ’ alloy and it is calculated and plotted with superimposition of the 
cooling rate values using the Precipitation Module (TC-PRISMA).  

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. On the My Project Configuration window under Non-Equilibrium, click Precipitation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. In the Project window, click the System Definer 1 node.  
5. On the Configuration window from the Package list, select Demo: Nickel-based alloys 

(NIDEMO, MNIDEMO). This loads both thermodynamic and kinetic demonstration nickel 
databases.  

6. From the Periodic Table, select the elements in the following order.  
Select Ni first so that it is the dependant element. 

a. Ni (nickel) 
b. Al (aluminium) then 
c. Cr (chromium).  

7. From the Amount list (to the right of the Periodic Table), select Mole percent. 
8. Enter 10 for Al and 10 for Cr, which automatically sets Ni to 80 mole percent. 
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9. Click the Phases and Phase Constitution tab.  
10. Under Phases click to select both check boxes next 

to the disordered FCC phase, DIS_FCC_A1. 

 

 

 

 

The system is now defined. The next step is to set up the precipitation calculations.  

SETTING UP THE PRECIPITATION CALCULATION 

1. In the Project window, click the Precipitation Calculator 1 node.  
2. Notice that the composition set in the System Definer auto-populated here.  
3. Under Matrix Phase, from the Phase list select Dis_FCC_A1, which is the disordered FCC 

phase.  
4. Under Precipitate Phase from the Phase list scroll to select FCC_L12#2.  
5. Change the Interfacial energy to User-defined then enter 0.023 in the field.  
6. Under Calculation Type, click CCT Diagram, which stands for Continuous-Cooling-

Transformation and means that the same cooling rate is maintained throughout the 
calculation.  

7. In the fields set: 
a. Min (minimum) Temperature to 500. 
b. Max (maximum) Temperature to 1200. 
c. Keep the default Kelvin as the temperature unit. 
d. Enter several cooling rates for the calculation. The rates are separated by a space. 

Enter these values as shown: .01 .1 1 10 100.  
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e. Keep the default Stop criteria of 1E-4 volume fraction of the γ’ phase. 
8. The calculation is now set. At the bottom, center of the Configuration window click Perform 

CCT Diagram Simulation.  

 

INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATION 

 

In this plot, the blue line shows the time it takes for γ’ to transform at each of the cooling rates 
according to the stop criteria, which is set as 1e-4 volume fraction. The cooling rates are represented 
by the multi-coloured curved lines. 

In this plot, the blue, 
horizontal line shows the 
time it takes for gamma 
prime (γ’) to transform at 
each of the cooling rates 
according to the stop 
criteria, which we set as 
1e-4 volume fraction.   
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If you hover your mouse over the intersection of the blue line and any of the vertical lines, a yellow 
box shows the approximate time it takes for γ’ to transform according to the stop criteria, which is a 
volume fraction of 1e-4, followed by the approximate temperature. In the image above, you can see 
a time of 0.531268 seconds and a temperature of 1147.49 Kelvin for the cooling rate of 100.0 K/s, 
which is represented by the yellow line.  

SHOWING THE RESULTS AS A TABLE 

You can also view these results in the form of a table, which gives you more precise results.  

1. In the Project window, right-click the Precipitation Calculator 1 node and select Create New 
Successor>Table Renderer.  

2. Right-click the Table Renderer 1 node and select Perform Now.  

The table is shown in the Results window and shows the same 
information as in the plot - for each cooling rate the temperature and 
the time it takes for γ’ to transform according to the stop criteria, 
which is a volume fraction of 1e-4.  

 

 

Tip! You can also convert the plot data into a table format that 
includes all the points.  

1. On the Project window, click Plot Renderer 1. 
2. On the Configuration window, click the Table View button  
3. After clicking the button, click Perform at the bottom of the window or right-click the Plot 

Renderer 1 node and select Perform Now. 
4. View the converted data on the Results window. 

 



P_08: Precipitation of Cu-Ti CU4TI with Assumptions of Sphere and 
Needle Morphologies

In this isothermal calculation example, the precipitation of Cu4Ti phase in a Cu-Ti binary alloy is 
calculated. To make a comparison, two separate simulations are performed, one assuming spherical 
morphology without elastic strain energy, and the other assuming needle morphology whose shape, 
determined by competition between interfacial energy and elastic strain energy, is changed during the 
simulation. The transformation strain is obtained from Borchers [1999Bor]. The results are compared 
with experiment results from Kampmann et al. [1987Kam]. 

For more details about the background theory, see Precipitation Morphology.

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_08_Precipitation_Cu-Ti_CU4TI1_Sphere_Needle.tcu

Example Settings

To ensure that the settings are done on the correct Precipitation Calculators, the Sphere 
and Needle nodes are renamed from Precipitation Calculator to match their morphology. 
The morphology is set in the Precipitate Phase section when you click Show Details.
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System (System Definer)

Database package Demo: Copper-based alloys (CUDEMO and MCUDEMO)

Elements Cu, Ti

Sphere and Needle Conditions (Precipitation Calculator)

Composition Cu-1.9Ti Mole percent

Matrix phase FCC_L12

Precipitate phase CU4TI1

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility adjustment > Prefactor 
(click Show Details to display this 
setting)

Keep the default, Same for all elements, then enter 100 for the Prefactor.

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default 

Morphology  (click Show Details to 
display this setting) For the Sphere node (renamed from Precipitation Calculator), keep the default. 
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For the Needle node (renamed from Precipitation Calculator), Needle is selected. 

Transformation strain (click Show 
Details to display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default. 

For the Needlenode (renamed from Precipitation Calculator), User defined is 
selected. In this example, the following settings are defined:

 l ε11 and ε22 are set to 0.022

 l ε33 is set to 0.003 

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 10,000 seconds

Datasets (Experimental File Reader)

Borchers Mean radius vs Time and 
Borchers Number density vs Time

Data sets included with this example and imported to two Experimental File 
Readers. These data sets are used for the Mean Radius and Number Density plots, 
respectively.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.
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 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

In this example, all nodes are renamed in the Project window, and this matches each of the 
tab names in the Visualizations window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.
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Figure 19: The predicted evolution of the morphology of needle shaped precipitates, showing how the mean 
aspect ratio changes during the isothermal heat treatment.

Figure 20: The results compare the predicted evolution of the mean size of precipitates with the experimental 
data from [1987Kam], comparing the spherical and needle shaped approximations of the precipitate 
morphology. Note how the needle shape approximation is closer to the experimental data.
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Figure 21: These results show both the predicted final particle size distribution from the needle shape 
simulation and the predicted relationship between the length of the precipitate and the needle aspect ratio.

Figure 22: This shows the approximates the size of the needle shaped precipitates as a sphere of equivalent 
volume, and compares the experimental results of [1987Kam] with those obtained from a spherical and needle 
shaped approximation.
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P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and 
Cuboid Morphologies

In this isothermal calculation example, the precipitation of Al3Sc phase from FCC_A1 matrix phase in an 
Al-Sc binary alloy is simulated. To make a comparison, two separate calculations are performed, one 
assuming spherical morphology without elastic strain energy, and the other assuming cuboid 
morphology whose shape is determined by competition between interfacial energy and elastic strain 
energy. The simulation results are compared with experimental data collected from Marquis and 
Seidman [2001Mar] and Novotny and Ardell  [2001Nov]. In addition, mean cubic factor and cubic factor 
distribution are also plotted for cuboid shape to illustrate the spherical-cuboidal transition during 
precipitation. 

For more details about the background theory, see Precipitation Morphology.

Project File and Step-By Step Instructions
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_09_Precipitation_Al-Sc_AL3SC_Sphere_Cuboid.tcu

You can also use the step-by-step instructions included in a PDF to follow the video or 
compare to the project file in Thermo-Calc.

Example Settings

To ensure that the settings are done on the correct Precipitation Calculators, the Sphere 
and Cuboid nodes are renamed from Precipitation Calculator to match their morphology. 
The morphology is set in the Precipitate Phase section when you click Show Details. See P_
08 for an example of this.

System (System Definer)

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)
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Elements Al, Sc

Sphere and Cuboid Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

Precipitate phase AL3SC

Matrix Phase Data Parameters (Precipitation Calculator)

Elastic properties   (click 
Show Details to display 
this setting)

For the Sphere node (renamed from Precipitation Calculator), the default, Disregard is kept.

For the Cuboid node (renamed from Precipitation Calculator), choose Cubic. Then enter the 
elastic constants accordingly. Default elastic constants are given based on the major 
element of the alloy system. In this example that is 

 l c11 is 108.2 GPa

 l c12 is 61.3 GPa

 l c44 is 28.5 GPa

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default 

Morphology  (click Show 
Details to display this 
setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default. 

For the Cuboid node (renamed from Precipitation Calculator), Cuboid is selected. 

Transformation strain 
(click Show Details to 
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default. 

For the Cuboid node (renamed from Precipitation Calculator), Calculate from molar volume 
is selected  to obtain a purely dilatational strain. 

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E9 seconds

Datasets (Experimental File Reader)

Dataset 1 and Dataset 2 Data sets included with this example and imported to one Experimental File Reader. It is 

ǀ 294 of 420



used for the Mean Radius plot.

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our website and 
as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

In this example, all nodes are renamed in the Project window, and this matches each of the 
tab names in the Visualizations window.
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For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.

Figure 23: This shows the predicted evolution of the mean size of precipitates with the experimental data from 
[2001Mar, 2001Nov], comparing the spherical and cuboidal shaped approximations of the precipitate 
morphology. Although there is not significant difference in the results, capturing the correct geometry of the 
precipitate is important in subsequent calculations of precipitate spacing used in property calculations.
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Figure 24: These results compare the predicted size distributions after heat treatment considering the 
spherical and cuboidal approximations of the precipitate morphology.

Figure 25: These results compare the predicted evolution of the mean particle radius and mean aspect ratio 
from using the cuboidal approximation of the precipitate morphology. In this case, the radius of a sphere of 
equivalent volume to the cuboidal precipitate is shown.
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Figure 26: These results show the predicted size distribution of the precipitates obtained from the cuboidal 
approximation of the precipitate morphology. Also shown is the calculated size dependent cubic factor of the 
cuboids associated with this dispersion.
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Precipitation of Al-Sc AL3SC with Assumption of 
Sphere and Cuboid Morphologies: Precipitation 
Example P_09 
HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
Module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here: 
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation Module example P_09 – Precipitation_Al-
Sc_AL3SC_Sphere_Cuboid, which is included in your installation. 

1. To run the example file, open Thermo-Calc and select Help > Examples Files or click Example 
Files on the My Project Configuration window.  

2. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example file to open it. 
3. In Thermo-Calc at the bottom center of the Configuration window click Perform Tree.  

 

ABOUT THE EXAMPLE  

This example shows you how to calculate the precipitation of Al3Sc phase from FCC_A1 matrix phase 
in an Al-Sc binary alloy using the Precipitation Module (TC-PRISMA).  

Two separate calculations are performed so you can make a comparison of the results, one assuming 
spherical morphology without elastic strain energy, and the other assuming cuboid morphology 
whose shape is determined by competition between interfacial energy and elastic strain energy.  

In addition, mean cubic factor and cubic factor distribution are plotted for cuboid shape to illustrate 
the spherical-cuboidal transition during precipitation.  

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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If you run the example file included in your software, the simulation results are compared with 
experimental data collected from Marquis and Seidman (2001) and Novotny and Ardell (2001). 

SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. On the My Project Configuration window under Non-Equilibrium, click Precipitation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. In the Project window, click the System Definer 1 node.  
5. Set the database Package to Demo: Aluminium-based alloys (ALDEMO, MALDEMO), which 

loads both thermodynamic and kinetic demonstration aluminium databases.  
6. From the Periodic Table, select the elements in the following order.  

Select Al first so that it is the dependant element: 
a. Al (aluminium)  
b.  Sc (scandium).  

7. From the Amount list (to the right of the Periodic Table), select Mole percent. 
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.  
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Our system is now defined. Now set up the precipitation calculations.  

SETTING UP THE PRECIPITATION CALCULATIONS 

There are two precipitation calculations in this example, one assuming spherical morphology without 
elastic strain energy, and the other assuming cuboid morphology whose shape is determined by 
competition between interfacial energy and elastic strain energy. The results are then compared for 
both calculations.  

Setting up the Precipitation Calculation with Spherical Morphology 

1. In the Project window, right-click the Precipitation Calculator 1 node and select Rename. 
Enter Sphere, then press enter or click OK.  

 
2. Notice that the composition set in the System Definer auto-populated on the Precipitation 

Calculator.  
3. Under Matrix Phase from the Phase list it defaults to FCC_A1.  
4. Under Precipitate Phase from the Phase list select AL3SC. 
5. Under Calculation Type, make sure Isothermal is selected, which means that the same 

temperature is maintained throughout the calculation.  
6. Enter  

a. 350 as the Temperature and select Celsius.  
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b. 1.0E9 as the Simulation time and select Seconds. 

 

Our first calculation is set, so next configure the plot.  

Configuring the Plot 

1. In the Project window, right-click Plot Renderer 1 and select Rename. Name the plot Mean 
radius then press enter or click OK. 

2. Under Y-axes change the units to Nanometer (nm). 
3. From the Axis type list select Logarithmic 10.  

 

The plot is now set, but before running the simulation you set up another calculation and link it to 
the same Plot Renderer.  

Setting up the Precipitation Calculation with Cuboid Morphology 

1. In the Project window, right-click the Sphere node and select Clone.  
a. Right-click the Sphere 1 node and select Rename.  
b. Name the node Cuboid and press enter or click OK.  

2. On the Configuration window to the right of Matrix Phase click Show Details.  
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3. From the Elastic Properties list select Cubic. Keep the suggested default values. Click Hide 
details. 

 

4. To the right of Precipitate Phase, click Show details.  
5. From the Morphology list select Cuboid.  
6. From the Transformation strain list select Calculate from molar volume. 

  

The second calculation is now set up, so now link it to the Plot Renderer node.  

Linking the Plot to the Calculation with Cuboid Morphology 

1. In the Project window, right-click the Mean radius node and select Add Predecessor 
>Cuboid.  

2. Notice that in the Configuration window there are two tabs associated with this plot, one for 
Sphere and one for Cuboid. The Sphere settings are already configured, so you just need to 
set up the Cuboid tab.  

 
3. Click the Cuboid tab. 
4. Under Y-axes change the units to Nanometer (nm). 
5. From the Axis type list select Logarithmic 10.  
6. The calculation is now ready to run. Right-click the Mean radius node and select Perform 

Now or click Perform on the Configuration window. 
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INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATIONS 

  

In this plot, the blue line represents the sphere calculation and the red line represents the cuboid 
calculation. You can see that, in this instance, these are almost identical.  

By ‘radius for non-spherical particles’ it means the radius of equivalent spheres with the same 
volume. 

If you run the example file that is included in your software, the plot also contains an experimental 
file, which you can see closely matches the calculations. 

PLOTTING ADDITIONAL VARIABLES 

Now you use the same calculation to set up additional plots using the many available variables. The 
examples below include two Y-axes each.  

Plotting Mean Radius and Cuboid Factor 

This plot has two Y-axes: Mean radius and Cuboid factor.  

1. Right-click the Cuboid node and add a Plot Renderer.  
2. Right-click the new node and rename it Mean radius and Cuboid factor.  
3. Under Y-axes click the plus sign to add another axis.  
4. Keep Mean radius as the first axis variable but change the units to Nanometer (nm) and set 

the axis type to Logarithmic 10.  
5. Set the second Axis variable to Mean cubic factor.  
6. Click to clear the Automatic scaling check box. In the fields, enter the Limits from 1 to 1.41 

and the step to 0.1.  
7. The plot is now set. Click Perform.  

In this plot, the blue 
line represents the 
sphere calculation 
and the red line 
represents the cuboid 
calculation. You can 
see that, in this 
instance, they are 
almost identical.  
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Interpreting the Results of Mean Radius and Cuboid Factor 

  

The blue line represents the evolution of the average radius of the cubic particles as a function of 
time. Again, for non-spherical precipitates this means the radius of equivalent spheres with the same 
volume.  

The red line shows the average cubic factor as a function of time. A value of one represents a 
spherical shape. A square root of two represents a cubic shape.  

In this plot, the blue line 
represents the evolution 
of the average radius of 
the cubic particles as a 
function of time. The red 
line shows the average 
cubic factor as a function 
of time. 
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The evolution of the shape when the particles grows is determined by competition between 
interfacial energy and elastic strain energy. In general, the shape is close to spherical at small particle 
sizes because the interfacial energy term dominates.  

At large sizes the elastic energy dominates and it is therefore more favourable with a non-spherical 
shape.  You can see that the particles get a more cubic form at later times when they grow to larger 
sizes.  

Plotting Particle Size and Cubic Factor Distribution 

This final plot shows the particle size distribution (PSD) and cubic factor distribution at the end of the 
simulation.  

This plot also has two Y-axes, so you can clone the previous plot. 
1. Right-click the Mean radius and Cuboid factor node and select Clone. 
2. Right-click the new node and rename it PSD and Cuboid factor.  
3. Under the Y-axes 

a. Select Size distribution as the first Axis variable.  
b. Change the Axis type to Linear.  

4. Set the second Y-axis to Cubic factor distribution and enter a Time of 1e9 Seconds.  
5. Keep the Automatic Scaling check box cleared. Enter the Limits from 1 to 1.45 and the step 

to 0.1.  
6. Under Size X-axis, change the unit to Nanometer (nm).  
7. Click Perform at the bottom center of the Configuration window. 
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Interpreting the Results of Particle Size Distribution and Cuboid Factor 

  

The blue curve, which shows the particle size distribution, is close to the regular LSW size distribution 
that is expected for spherical particles.  

The cubic factor distribution shows that the smallest particles are closer to spherical and that the 
larger ones get more and more cubic. 

References 

1. Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates 
in Al(Sc) Alloys.” Acta Materialia 49 (11): 1909–19. 

2. Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.” 
Materials Science & Engineering, A: Structural Materials: Properties, Microstructure and 
Processing 318 (1–2): 144–54. 

In this plot, the blue 
curve shows the 
particle size 
distribution and the 
red line shows the 
cubic factor 
distribution. 
 



P_10: Initial Particle Size Distribution of Fe-Cr-C

This example demonstrates the effect of initial particle size distribution (PSD) of the precipitate phases 
on the overall precipitation kinetics. It uses two Precipitation Calculators to simulate and compare 
carbide precipitations from a ferritic BCC_A2 matrix in a Fe-0.1C-12Cr alloy. Three carbides, CEMENTITE, 
M23C7, and M7C3 are included in the calculations simulating a complex precipitation sequence with 
stable and meta-stable precipitate phases. The results show a large difference in predicted behaviour, 
with meta-stable precipitates dissolving earlier as a result of the stable precipitates existing in the initial 
condition.

This example also shows the different ways to create the initial size distribution.

 l Generate 3D PSD from distribution function: CEMENTITE's PSD is approximated from an LSW 
distribution.

 l From File: M23C6's PSD is loaded from a file.
 l Approximate the 3D PSD from experimental data: M7C3's PSD is approximated from 1D 

experimental data descriptive of halved linear intercepts. 

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_10_Precipitation_Initial_PSD_FeCrC.tcu

There are also two *.csv files available for you to use as a template for when you are importing data 
from a file. 

 l Input data for M23C6: P_10_Precipitation_Initial_PSD_FeCrC_psd_3D_M23C6.csv
 l Input data for M7C3: P_10_Precipitation_Initial_PSD_FeCrC_psd_1D_M7C3.csv

Preexisting Particle Size Distribution

The Preexisting Particle Size Distribution window shown in Figure 27 is a graphical representation of 
the radius versus corresponding number densities, with fields available to enter the initial precipitate 
composition and volume fraction. An editable table is also provided for the particle size distribution.

Particle Size Distribution (PSD)
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Cementite

The amount of Fe and Cr must be defined for Cementite for this alloy. Fe is set to the dependent 
component, and 72 mass percent of Cr is set. The option Generate 3D PSD from distribution function is 
chosen to create the PSD for Cementite. The initial volume fraction of 0.001 % is assumed. An LSW 
distribution is selected with a mean radius of 1E-8m.

Figure 27: An LSW distribution with a mean radius of 1E-8m is used.

M23C6

The amount of Fe and Cr must be defined for M23C6 for this alloy. Fe is set to the dependent 
component, and 70 mass percent of Cr is set. The From File option is used to create the PSD. 

The file loaded for M23C6 is available from the Example files → Precipitation Module - TC-
PRISMA  folder and is named P_10_Precipitation_Initial_PSD_FeCrC_psd_3D_
M23C6.csv.
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You can import data from a spreadsheet or text file (.xls, .xlsx, .csv, or .txt formats are acceptable). The 
initial volume fraction of 0.15 % is assumed.

M7C3

The amount of Fe and Cr must be defined for M7C3 for this alloy. Fe is set to the dependent component, 
and 83 mass percent of Cr is set. The Approximate the 3D PSD from experimental data option is used to 
create the PSD.

In this example, the linear intercept method is used to measure the size distribution of M7C3 from 
micrographs descriptive of sectioning the dispersion. A size distribution of halved linear intercepts is 
created and is available as a file you can use as a template. 

The file loaded for M7C3 is available from the Example files → Precipitation Module - TC-
PRISMA  folder and is named  P_10_Precipitation_Initial_PSD_FeCrC_psd_1D_M7C3.csv.

The Dimensionality of the exp. data is set to 1D. The experimental data is loaded by importing the 
above named *.csv file. An LSW Distribution is used.  When you click Generate, it calibrates the chosen 
distribution and stereology description to the experimental data. The initial volume fraction of 0.15 % is 
assumed.
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Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase
BCC_A2

All other defaults are kept.
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Precipitate phases CEMENTITE, M23C6 and M7C3

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries (all calculations): Calculated from the matrix settings with a wetting 
angle of 90°

Interfacial energy

User-defined function f(r,T) (all calculations):

 l CEMENTITE: 0.167 J/m2

 l M23C6 0.252 J/m2

 l M7C3 0.282 J/m2

Preexisting size distribution 
(click Show Details to 
display this setting)

For the Precipitation Calculator including particle size distribution (PSD), and for all 
precipitate phases, this checkbox is selected.

For each precipitate phase (CEMENTITE, M23C6 and M7C3), click Edit Particle Size 
Distribution to make changes to the parameters. A window opens with a graphical 
representation of the radius vs number density.

Input type

 l Generate 3D PSD from distribution function - CEMENTITE uses this option in the 
example

 l From File - M23C6 uses this option in the example

 l Approximate the 3D PSD from experimental data - M7C3 uses this option in the 
example.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.
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Figure 28: These results show the predicted volume fraction of cementite, M23C6, and M7C3 during an 
isothermal aging with an initial particle size distribution of each precipitate phase. The predicted kinetics are 
sensitive to the initial size, volume fraction, and composition of these precipitates.

Figure 29: The predicted volume fraction of cementite, M23C6, and M7C3 during an isothermal aging with no 
precipitates in solution in the initial condition.
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P_11: Interfacial Energy Function

In some cases, interfacial energy may be a function of temperature and/or particle radius. This example 
uses four Precipitation Calculators at four temperature points in 30 K increments: 673 K, 703 K, 733 K, 
and 763 K. It is an isothermal calculation to examine the mean radius of an Al-0.12Sc system. It uses an 
FCC_A1 matrix phase and AL3SC precipitate phase with bulk nucleation sites and user-defined interfacial 
energy function. The user defined interfacial energy function uses an error function to set a smooth 
transition of the interfacial energy from 0.065  J/m2 to 0.085   J/m2 for particle radii below and above 1e-
8m and 5e-8m, respectively.

A dataset based on Iwamura and Miura [2004Iwa]  data is compared with the calculated results.

Interfacial Energy Anisotropy

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_11_Interfacial_energy_function.tcu

Example Settings

System (System Definer)

Database package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.12Sc Mole percent

Matrix phase
FCC_A1

All other defaults are kept.
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Precipitate phase

AL3SC

Nucleation sites (all calculations): Bulk (6.025E28 m-3)

Interfacial energy (all calculations): User-defined function f(r,T): 0.075+0.011*erf((r-3e-8)/1e-
8 J/m2)

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal (all calculations)

Temperature Four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K.

Simulation time 1 000 000 seconds (all calculations)

Datasets (Experimental File Reader)

Wamura 2004 (Dataset 
1) Data set included with this example and imported to one Experimental File Reader. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.
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 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.
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Figure 30: The results of an isothermal calculation to examine the mean radius of an Al-0.12Sc system with 
experimental data from [2004Iwa]. 

Reference

[2004Iwa] S. Iwamura, Y. Miura, Loss in coherency and coarsening behavior of Al3Sc precipitates. Acta 
Mater. 52, 591–600 (2004).
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P_12: Comparing Growth Rate Models for an Al-Zr System

This example compares the Simplified, General, and Advanced growth rate models for an Al-Zr system. 
The resulting plot compares the mean radius of the spheres for each AL3ZR_D023 precipitate phase 
calculated for each type of growth rate model. 

All models treat a spherical particle (precipitate) of stoichiometric composition or with negligible atomic 
diffusivity. Local equilibrium at the precipitate-matrix interface is assumed. 

When you use the Advanced model,  the velocity of a moving phase interface and the operating tie-line 
are solved together from flux-balance equations. This model can treat both high supersaturation and 
cross diffusion rigorously. It can also capture the transition between NPLE (non-partitioning local 
equilibrium) and PLE (partitioning local equilibrium) without any ad hoc treatment.

The Simplified model is based on the quasi-steady state diffusion approximation, and estimates solute 
partitioning  with matrix composition and nuclei composition instead of time-consuming stepwise tie-
line calculations. It also neglects cross diffusion for simplicity. 

The General model  can be considered the same theoretical approximation as, but an improvement over,  
the Simplified model, with cross-diffusion terms taken into account, as well as adjustment of Gibbs-
Thomson effect and effective diffusivity implemented. A dataset based on Knipling et al. [2008Kni]   data 
is compared with the calculated results.

For more background information,  see the theory described in Growth. 

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_12_Precipitation_Al-Zr_GrowthRateModel_comparison.tcu

Example Settings

System (System Definer)

Database package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements Al, Zr

Conditions (Precipitation Calculator)

Composition Al-0.2Zr Mole percent
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Matrix phase
FCC_A1

All other defaults are kept.

Precipitate phase
AL3ZR_D023

Click Show Details to select the Growth rate model (Simplified, Advanced and General). All other 
defaults are kept.

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 425 Celsius

Simulation time 400 hours

Datasets (Experimental File Reader)

2008 Knipling Data set included with this example and imported to one Experimental File Reader.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.
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 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.
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Figure 31: This shows the impact of the available growth rate settings options and compares the mean radius 
measurements of [2008Kni] with results obtained from the simplified, general, and advanced growth rate 
models. The experimental data includes measurements taken from different dendrites.

Reference

[2008Kni] K. E. Knipling, D. C. Dunand, D. N. Seidman, Precipitation evolution in Al–Zr and Al–Zr–Ti alloys 
during isothermal aging at 375–425 °C. Acta Mater. 56, 114–127 (2008).
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P_13: Paraequilibrium Precipitation of Cementite Fe-C-Cr

In this example, the precipitation of cementite during tempering of a Fe-Cr-C steel is simulated 
considering two interface conditions: one is the usual ortho-equilibrium condition; the other is the para-
equilibrium condition. The simulation results are compared with the experimental data from Sakuma et 
al. [1980Sak]. 

This example demonstrates that the early stage of the cementite precipitation can only be accounted 
for by a simulation applying the para-equilibrium condition, under which the precipitation kinetics are 
controlled by the diffusion of C. The comparison also shows a later stage gradual transition from the 
para-equilibrium condition to the ortho-equilibrium condition, and if the tempering time is long enough 
the diffusion of Cr has a dominating effect on the coarsening of cementite. 

For more background information,  see the theory described in Growth. 

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_13_Precipitation_Fe-C-Cr_Paraequilibrium_Precipitation_of_Cementite.tcu

Example Settings

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO, MFEDEMO)

Elements Fe, Cr, C

Conditions (Precipitation Calculator)

Composition Fe-0.95Cr-1.065C Mass percent

Matrix phase
BCC_A2

All other defaults are kept.
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Precipitate phase
CEMENTITE

Click Show Details to select the Growth rate model (Simplified and Para-eq). All other defaults 
are kept.

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 773 Kelvin

Simulation time 20 hours for the paraequilibrium model and 600 hours for the simplified model.

Datasets (Experimental File Reader)

1980 Sakuma Data set included with this example and imported to one Experimental File Reader.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it can take over two hours to complete the 
calculations. 

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 
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For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.

Figure 32: These results compare the predicted and measured evolution of the mean radius of cementite with 
the experimental data from [1980Sak] to simulation predictions obtained from the ortho-equilibrium (OE), and 
para-equilibrium (PE) approximations of the precipitate composition. The precipitate growth kinetics exhibited 
by cementite can be rationalized by the transition from PE to OE.
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Reference

[1980Sak] T. Sakuma, N. Watanabe, T. Nishizawa, The Effect of Alloying Element on the Coarsening 
Behavior of Cementite Particles in Ferrite. Trans. Japan Inst. Met. 21, 159–168 (1980).
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P_14: Grain Growth and the Zener Pinning Effect

This example demonstrates the simulation of normal grain growth and the pinning effect [1948Smi; 
1998Man] of precipitated second-phase particles on the grain boundary motion.

To investigate the grain growth and Zener pinning effect, an Fe-0.2C (wt.%) binary alloy, with a BCC_A2 
matrix phase and CEMENTITE precipitate phase, is simulated and uses the demonstration steel 
databases, FEDEMO and MFEDEMO. These databases are available to all users (i.e. you do not need a 
license for the Precipitation Module (TC-PRISMA)) and contain the necessary thermodynamic and kinetic 
data needed for the calculation.

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_14_Precipitation_Fe-C-Ferrite-Grain_Growth_with_Zener_Pinning.tcu

Example Settings

System (System Definer)

Database 
package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C

Conditions (Precipitation Calculator)

Composition Fe-0.2C Mass percent

Matrix phase

BCC_A2

 l Grain boundary energy (J/m2): 0.5
 l Grain boundary mobility: Prefactor(m4/Js): 2 x 10-15

 l Click to Edit grain size distribution. Then Initial grain size distribution: Hillert distribution 
with average radius of 3.2 x 10-6 m

 l Mobility adjustment: Same for all elements. Prefactor 0.08.
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Precipitate 
phase

CEMENTITE

 l Zener pinning parameters:  Cutoff size (m): 8.0 x 10-7

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 722 °C

Simulation time 35 hours

Datasets (Experimental File Reader)

[1975Hel] Data sets included with this example and imported to two Experimental File Readers.

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our website and 
as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.
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 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.

The calculated equilibrium volume fraction of CEMENTITE at 722 °C (0.02786), using FEDEMO, matches 
that (0.02787) of a Fe-0.2C-0.004S-0.0004O-0.001N-0.001Al (wt.%) multicomponent commercial alloy, 
calculated using the latest version of the TCS Steel and Fe-alloys Database (TCFE), an alloy that was 
studied by Hellman and Hillert [1975Hel]. The mobility adjustment assures the precipitation kinetics of 
CEMENTITE phase in Fe-C system matches that of experimental data [1975Hel] of the commercial 
counterpart (and shown in Figure 33)

Figure 33: The evolution of the mean radius of cementite comparing the experimental data from [1975Hel] 
with the Precipitation Calculator results.

The grain boundary energy was chosen to be a reasonable value of 0.5 J/m2. There is a large 
discrepancy, in several orders of magnitude, among experimental data regarding the grain boundary 
mobility. In the present calculation, a value of 2x10-15 m4/Js was chosen.
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Figure 34: The evolution of the mean grain radius of ferrite comparing the experimental data from [1975Hel] 
with predictions made with and without Zener pinning from an evolving dispersion of cementite precipitates.
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P_15: Smooth Transition from Paraequilibrium to Ortho-
equilibrium

In this example, the precipitation of cementite during tempering of an Fe-Mn-C steel is simulated 
considering three interface conditions:  the usual ortho-equilibrium (OE) condition; paraequilibrium (PE) 
condition; and  a smooth transition from paraequilibrium  to ortho-equilibrium condition (PE-OE). The 
simulation results are compared with the experimental data from Miyamoto et al. [2007Miy].

The Precipitation Calculator nodes are renamed in the example to match the abbreviations 
for the three interface conditions considered: OE, PE, and PE-OE. Also see the video to 
learn how to create this example.

This example demonstrates that the early stage of the cementite precipitation follows a PE condition, 
under which the precipitation kinetics is controlled by the diffusion of C. At a later stage, gradual 
transition from PE condition to OE condition occurs, and if the tempering time is long enough the 
diffusion of Mn has a dominating effect on the coarsening of cementite. While a Simplified model 
follows the OE condition and a Para-eq model follows PE condition, the PE Automatic model enables the 
smooth transition from PE condition at early stage to OE condition at a late stage.

The example uses the demonstration steel databases, FEDEMO and MFEDEMO. These databases are 
available to all users (i.e. you do not need a license for the Precipitation Module (TC-PRISMA)) and 
contain the necessary thermodynamic and kinetic data needed for the calculation.

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_15_Precipitation_Fe-C-Mn_PE-OE_Precipitation_of_Cementite.tcu

Example Settings

System (System Definer)

Database 
package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, Mn, C

Conditions (Precipitation Calculator)

Composition Fe-1.96Mn-0.61C mass percent
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Matrix phase

BCC_A2

Click Show Details:

 l Grain size: Average radius 1.0E-7m

 l Grain aspect ratio: 100.0

 l Mobility adjustment: Keep the default, Same for all elements, then enter 0.008 for the 
Prefactor, and -7e4 J/mol for the Activation energy.

All other defaults are kept.

Precipitate 
phase

CEMENTITE

Click Show Details to select the Growth rate model (Simplified, Para-eq, and PE Automatic). All 
other defaults are kept.

Calculation Type  (Precipitation Calculator)

Calculation type Isothermal

Temperature 923.15 Kelvin

Simulation time 1E6 seconds for Simplified and PE Automatic models, and 5 seconds for Para-eq model

Datasets (Experimental File Reader)

Mean Radius Exp Data set including experimental mean radius of cementite

Mn 
Concentration Data set including experimental Mn composition in cementite

Visualizations

This example is included as a Precipitation Module (TC-PRISMA) tutorial on our website and 
as part of the  playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.
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Figure 35: A comparison between the measurements of mean cementite radius from [2007Miy] with the 
simplified (OE), para-eq (PE), and PE Automatic (PE-OE) growth models. The PE-OE model is needed to capture 
the nucleation, growth, and coarsening behavior of cementite.

Figure 36: A comparison of the evolution of the cementite Mn composition during isothermal aging at 923.15 
K between the experimental data from [2007Miy] with model predictions obtained from the simplified (OE) 
growth model, the para-eq (PE) growth model, and the PE Automatic (PE-OE) growth model. The PE-OE model 
captures the behavior shown in the experimental data, where the Mn composition transitions from the initial 
ferrite composition towards the equilibrium cementite composition.
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P_16 Isothermal Coarsening and  a 3D to 2D Stereological 
Conversion  

This example demonstrates the use of the 3D → 2D stereological conversion functionality to compare 
Precipitation Module (TC-PRISMA) predictions with experimental data obtained from Scanning Electron 
Micrographs (SEM). 

The 3D → 2D setting is available on a Plot or Table Renderer that is a successor to the 
Precipitation Calculator, and when certain axis variables are selected for a spherical 
morphology.  

For more background information,  see the theory described in Stereology. 

The isothermal coarsening kinetics of γ' precipitates in a Ni-Al-Cr alloy is modeled. The experimental 
data is from [2008Sud], which investigates isothermal coarsening kinetics at a temperature of 873 K for 
up to 264 h. 

It is assumed that there are no precipitates in solution at the beginning of the isothermal heat 
treatment.

Project File Information
 l Folder: Precipitation Module - TC-PRISMA
 l File name: P_16_Precipitation_Ni-Al-Cr_Stereology.tcu

Example Settings

The example also includes an Equilibrium Calculator and Table Renderer to first  confirm the 
stability of the precipitate phase for this system (FCC_L12#2), then determine particle 
composition at 1073 K, and this information is used with the Precipitation Calculator set up.

System (System Definer)

Database 
package Demo: Nickel-based superalloys (NIDEMO and MNIDEMO)
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Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition Ni-10l-8.5Cr Mole percent

Matrix Phase

FCC_L12

 l Click Show Details and for the Mobility adjustment enter 0.5 for the 
Prefactor.

 l All other defaults are kept.

Precipitate 
Phase

FCC_L12#2

Click Show Details and adjust the default settings as indicated: 

 l Interfacial energy: Select User-defined and enter 0.01 J/m2. 

Calculation Type  (Precipitation Calculator)

Calculation 
Type Isothermal

Temperature 1073 Kelvin

Simulation time 300 h

Datasets (Experimental File Reader)

2008 Sudbrack 
et al

Data sets are included with this example and are imported using the Experimental 
File Reader activity. There are 2D size distributions comparing results after a total 
of 16 h aging, 64 h aging, and 264 h of aging, and a comparison of the  
experimental and predicted 2D mean radius versus time. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
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settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

There is a variety of information shown in the Visualizations window that can be viewed during 
configuration and after performing the calculation.

 l Thermal Profile: When setting up a calculator on a Configuration window for Isothermal or Non-
isothermal Calculation Types, you can preview the profile and adjust settings as needed. When 
you click a calculator node in the Project window, the matching name of the node is on the tab
(s) displayed in the Visualizations window. 

For TTT Diagram and CCT Diagram calculations there is nothing shown for the 
Precipitation Calculator tab in the Visualizations window as there is no Thermal 
Profile to be defined.

 l Plot or Table results: After completing the set up and performing the calculation, to view the 
matching name of the node on tab(s) in the Visualizations window, either click a Plot Renderer 
or Table Renderer node in the Project window or click the tabs individually in the Visualizations 
window.

For this Isothermal example, its Thermal Profile is also displayed in the Visualizations 
window showing the constant temperature entered for this calculation type. The tab 
names match the node names in the Project window.
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Figure 37: A comparison of the evolution of the mean 2D precipitate radius measurements of [2008Sud] with 
model predictions.

Figure 38: A comparison of the predicted and measured 2D size distribution after 4 h of aging.
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Figure 39: A comparison of the predicted and measured 2D size distribution after 16 h of aging.

Figure 40: A comparison of the predicted and measured 2D size distribution after 64 h of aging.
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Figure 41: A comparison of the predicted and measured 2D size distribution after 264 h of aging.
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Process Metallurgy Module Examples Collection

The Process Metallurgy Module requires both a valid Maintenance and Support 
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database (TCOX8 or 
newer). 

All users can test the Process Metallurgy Module with the included OXDEMO database, 
which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For more information about 
this and other products visit our website.

The Process Metallurgy Module

About the Examples

In this section:

PMET_01: Basic Oxygen Furnace (BOF) 343

PMET_02: Desulphurization in a Ladle Furnace (LF) 345

PMET_03: Argon Oxygen Decarburization (AOD) 347

PMET_04: Basic Oxygen Furnace (BOF) Kinetics 354

PMET_05: Lab Scale Ladle Furnace (LF) Kinetics 356

PMET_06: Ladle Furnace (LF) Kinetics 362

PMET_07: Vacuum Oxygen Decarburization Kinetics 365

PMET_08: Steel Deoxidation on Tapping 367
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PMET_01: Basic Oxygen Furnace (BOF)

The example uses the Process Metallurgy Calculator to demonstrate a simplified steelmaking process in 
a Basic Oxygen Furnace (BOF). 

This application example in its various forms is showcased on our website. There are two application 
examples (one equilibrium, one kinetic) showing how the Process Metallurgy Module can be used to 
calculate the BOF process. 

This basic example uses equilibrium calculations to gain a general understanding of your BOF process 
and help you determine optimal operation conditions and predict and optimize costs of raw materials 
and recycling. The other set of examples gives detailed instructions on how to simulate the kinetics of 
the BOF process using the kinetic process simulation (see PMET_04: Basic Oxygen Furnace 
(BOF) Kinetics).

Project File and License Information
 l Folder: Process Metallurgy 
 l File name: PMET_01_Basic_Oxygen_Furnace.tcu

Choose a, b, or c versions of the example based on your license.

 l PMET_01a_Basic_Oxygen_Furnace is included in a regular Thermo-Calc installation as well as 
the free Educational version of Thermo-Calc. This is a highly simplified example and uses the 
OXDEMO database, and only considers the elements Fe, C, and O.

 l PMET_01b_Basic_Oxygen_Furnace is also a simplified calculation but uses the OXDEMO 
database. It requires a full license of Thermo-Calc 2021b and newer.

 l PMET_01c_Basic_Oxygen_Furnace requires the TCOX11 database and newer and a full license 
of Thermo-Calc 2021b and newer. 

Visualizations

This example is included as a Process Metallurgy tutorial on our website and as part of the 
playlist our YouTube channel.
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One way to learn how to work with the Process Metallurgy Calculator is to use the project 
files as templates to help you set up your own simulation. For example, you can examine 
the settings available on the Configuration window and that are described in Process 
Simulation: Conditions Tab and the Options Tab. 

The resulting plots and details related to setting up this example are available to download 
via the dedicated web page. 
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PMET_02: Desulphurization in a Ladle Furnace (LF)

The example, which is also showcased on our website, uses the Process Metallurgy Calculator to 
demonstrate the use of a Ladle Furnace (LF) with the Process Metallurgy Module. 

The ladle furnace fulfils many purposes in the steelmaking process. Desulphurization, which we will 
focus on in this example, is merely one of them.

Desulphurization is usually performed by transferring S that is dissolved in the liquid metal to a CaO-rich 
slag phase. For this process to be successful, two conditions need to be fulfilled:

 1. The slag must be fully liquid (liquid fraction > 0.9). This is required for kinetic reasons. The slag 
phase must be fluid so that it can emulsify with the liquid steel and form a large surface area 
where the reaction between steel and slag can take place.

 2. The slag must take up a large amount of S from the liquid steel (have a “high sulphur capacity”) 
so that a significant amount of sulphur will move from the liquid steel to the slag phase.

It is difficult to decrease the S content in the liquid steel during steelmaking in a basic oxygen converter 
(BOF) or an electric arc furnace (EAF) because conditions are predominantly very oxidizing. 
Desulphurization is therefore usually performed in a subsequent step, during steel refining in a ladle 
furnace or a vacuum degasser after the steel has been fully killed by a suitable deoxidizing agent and the 
oxygen activity is low.

The following example explores these two conditions for an equilibrium between liquid steel and slag in 
a ladle furnace, trying to find good slag compositions.

Project File and License Information
 l Folder: Process Metallurgy  
 l File names: PMET_02a_Ladle_Furnace.tcu or PMET_02b_Desulphurization_in_Ladle_

Furnace.tcu. 

Choose a or b versions of the example  based on your license

 l PMET_02a_Ladle_Furnace.tcu can be run with OXDEMO database but requires the full license 
for Thermo-Calc 2021b and newer.

 l PMET_02b_Desulphurization_in_Ladle_Furnace.tcu requires the TCOX11 database and a full 
license for Thermo-Calc 2021b and newer.
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Visualizations

This example is included as a Process Metallurgy tutorial on our website and as part of the 
playlist our YouTube channel.

One way to learn how to work with the Process Metallurgy Calculator is to use the project 
files as templates to help you set up your own simulation. For example, you can examine 
the settings available on the Configuration window and that are described in Process 
Simulation: Conditions Tab and the Options Tab. 

The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 
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PMET_03: Argon Oxygen Decarburization (AOD)

The Argon Oxygen Decarburization (AOD) process is a converter process applied in stainless steel 
making. In this process the oxidation of chromium in the steel melt needs to be prevented while carbon 
is oxidized. This is achieved by reducing the oxygen partial pressure by having a high Ar-content in the 
blowing gas. It is a highly exothermic process that requires adiabatic modeling. In this example the 
conversion of carbon-rich steel scrap is modeled together with additions of Ferronickel and 
Ferrochrome to a stainless steel. The example uses the Process Metallurgy Calculator. 

Visit the website Application Examples → Process Metallurgy page for more background 
information as well as more in depth analyses of this and other examples. Also visit the 
Process Metallurgy Module page to access resources such as training videos, presentations, 
publications, webinars, and much more. 

Project File and License Information
 l Folder: Process Metallurgy  
 l File name: PMET_03_Argon_Oxygen_Decarburization.tcu

This example requires a license to run the simulation. It works with TCS Metal Oxide 
Solutions Database (TCOX) versions 8 and newer. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Background Description

The AOD-process is characterized by an initially high O2-content of the blowing gas, which is gradually 
replaced by Ar. The maximum temperature of the process is typically around 1720 °C. A grid plot of an 
adiabatic calculation is well suited to model the required simultaneous change of amount of gas and its 
composition during this process. The black line in the plot above indicates a possible process control 
path that finally leads to suitable alloy composition close to a X5CrNi 18-10 stainless steel.

In principle, this plot could be used to control the blowing gas flow in a plant process. However, note 
that the simulation only considers a global gas phase, i.e. additional gas is added but never removed. 
This means that the given gas phase composition is an average one and not identical to the composition 
of the gas flowing in at each point in time. Additionally there is a certain impact on the resulting 
equilibria from the fact that all gas remains in the system and is not removed. 
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Slag Basicity

Figure 1: The Slag Basicity plot shows the basicity of the slag (which is a measure for the sulphur capacity of 
the slag). The process achieves a final basicity of 1.74 which is typical for an AOD-process. The black line in the 
plot indicates a possible process control path that finally leads to suitable alloy composition close to a X5CrNi 
18-10 stainless steel.
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S Content in Steel

Figure 2: In the S Content in Steel plot, the sulphur content in the steel melt is slightly reduced during the 
process from 0.056% in the initial steel scrap to finally ca. 0.035%. The black line in the plot indicates a 
possible process control path that finally leads to suitable alloy composition close to a X5CrNi 18-10 stainless 
steel.
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Cr Content in Slag

Figure 3: In the Cr Content in Slag plot, the Cr2O3-content in the slag reaches at the end of the process ca. 26 
wt-%. This is typical for the AOD-process and requires an additional Cr-recovery step after the conversion to 
reduce the loss of chromium.  The black line in the plot indicates a possible process control path that finally 
leads to suitable alloy composition close to a X5CrNi 18-10 stainless steel.
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Amount of Slag

Figure 4: In the Amount of Slag plot, you can see that the process generates about 15 tons of slag in the total. 
The black line in the plot indicates a possible process control path that finally leads to suitable alloy 
composition close to a X5CrNi 18-10 stainless steel.

ǀ 352 of 420



Liquid Slag Fraction

Figure 5: In the Liquid Slag Fraction plot, you can see that towards the end of the process the slag is calculated 
to be mostly liquid. The black line in the plot indicates a possible process control path that finally leads to 
suitable alloy composition close to a X5CrNi 18-10 stainless steel.
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PMET_04: Basic Oxygen Furnace (BOF) Kinetics

The example uses the Process Metallurgy Calculator to demonstrate the steelmaking process in a Basic 
Oxygen Furnace (BOF). 

This application example in its various forms is showcased on our website. There are two application 
examples (one equilibrium, one kinetic) showing how the Process Metallurgy Module can be used to 
calculate the BOF process. 

This example simulates the kinetics of the BOF process, whereas the other only considers equilibrium. 
For information about the equilibrium examples, see PMET_01: Basic Oxygen Furnace (BOF).

Project File Information

 l Folder: Process Metallurgy

Choose a, b, or c versions of the example based on your license. 

 l PMET_04a_Basic_Oxygen_Furnace_Kinetics is included in a regular Thermo-Calc installation as 
well as the free Educational version of Thermo-Calc.  This  only considers the elements Fe, C, and 
O.

 l PMET_04b_Basic_Oxygen_Furnace_Kinetics needs a full license of Thermo-Calc 2021b or 
newer, but uses the free OXDEMO database. It considers the elements Fe, C, O, Ca, Al, Si, and S.

 l PMET_04c_Basic_Oxygen_Furnace_Kinetics requires both a full license of Thermo-Calc 2021b 
or newer and a license for the TCOX11 database and newer. This simulation corresponds pretty 
much to a real BOF process with the elements Fe, Mn, C, O, Ca, Al, Mg, Si, S, and P considered.  

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 
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PMET_05: Lab Scale Ladle Furnace (LF) Kinetics

Using the Process Metallurgy Calculator and the Process simulation branch, this example is based on 
the publication by Piva et al [2017Piv] where a lab scale sample of pure iron is first deoxidized with Si-
Mn and then a synthetic top slag is added to the steel. Generally, by using the project file and the 
information below, you can get an idea about how to set up a ladle furnace simulation using the Process 
Metallurgy Module.

Visit the website Application Examples → Process Metallurgy page for more background 
information as well as more in depth analyses of this and other examples. Also visit the 
Process Metallurgy Module page to access resources such as training videos, presentations, 
publications, webinars, and much more. 

Setting Up a Process Metallurgy Simulation

Defining the Process Simulation

Project File and License Information
 l Folder: Process Metallurgy  
 l File name: PMET_05_Lab_Scale_Ladle_Furnace_Kinetics.tcu 

This example is best run with the TCS Metal Oxide Solutions Database (TCOX) version 13 or 
newer and a full license of Thermo-Calc 2024a or newer. Running the example with earlier 
versions of the database is possible but the results are not consistent with the referenced 
paper.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

About the Plot Results

Many different aspects of the reactions taking place in the LF can be plotted and analyzed. After you run 
the project file and obtain the plots, you can experiment by adjusting the settings on each Plot Renderer 
to see what happens in each case. There is more analysis about this and other examples available at the 
links to our website.

For an example of a more realistic industry scale, see PMET_06: Ladle Furnace (LF) Kinetics.

Setting Up the LF Process Simulation

In the paper by Piva et al. [2017], it is experimentally investigated how the steel and inclusion 
composition changes in function of time as the Si-Mn killed steel reacts with the slag. This experiment 
can serve as a model for the production of SiMn killed steel with subsequent top-slag deoxidation.

Figure 6: Diagram of the experiment performed by Piva et al. [2017]. The sequence as described in the text is: 
(1) liquid Fe with dissolved oxygen; (2) FeMn and SiMn added to deoxidize Fe; (3) top slag added after 360s; 
and (4) gradual reaction between steel, slag and inclusions.

According to the publication the following reaction sequence is expected as shown in the diagram:

 1. In the initial state the steel contains 400 ppm of dissolved oxygen.

 2. The deoxidizing agents are added. They dissolve and react with the oxygen in the steel forming 
oxide inclusions, thereby reducing the amount of dissolved oxygen ("killing" the steel). The 
kinetics are fast, and it can be assumed that the reaction proceeds to thermodynamic 
equilibrium. 

 3. On adding the slag (360 s after step 2, killing the steel) the liquid steel starts reacting with the 
slag. 
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 4. According to the authors the most important reaction that takes place is the dissolution of Al out 
of the slag and its transferal into the liquid steel, where it reacts with the inclusions and changes 
their chemistry. Flotation of the inclusions is assumed to be negligible, due to the small size of 
the crucible and lack of stirring. 

In this example only the last reaction is simulated after adding the slag. The kinetic 
parameters, compositions of all materials and process schedule are all taken from the 
publication.

Results and Experimental Analysis

The plots below compare the Al content in the liquid steel with the experimentally determined amount. 
The bottom plot shows how the Al2O3 from the slag phase is gradually reduced to metallic Al that 
dissolves in the liquid steel. 

In this example, only part of the Al in the liquid steel is dissolved as metallic Al. With the 
Process Metallurgy Module, it is possible to plot both dissolved Al and also total Al.  

In the steel industry this fraction of Al in the liquid steel is often termed dissolved Al. The rest of the Al 
reacts with the oxygen in the liquid steel and forms oxide inclusions. The amount of dissolved Al plus the 
Al  bound up in oxide inclusions is often termed total Al. The difference between total Al minus dissolved 
Al is an important measure for the steel cleanness. 

Total Al is what was measured by Piva et al. [2017] and their experimental data are compared to the 
calculated values below.
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Figure 7: Total Al in the steel compared with experimental data (blue/top curve). Additionally the amount of 
dissolved Al is plotted (red/bottom curve), this is done by selecting “Composition of phase group” and “Liquid 
metal”. Note that the red/bottom curve is not available with the example. 

Immediately after killing the steel with SiMn and FeMn, the liquid steel contains liquid Si-Mn-oxide 
inclusions only. As the liquid steel picks up Al from the slag phase in function of time, the inclusions get 
richer and richer in Al. This experimentally verified change in inclusion chemistry is well reproduced by 
this simulation.

In the experiment, only the average composition of all inclusions could be measured; the 
type of inclusion (liquid / solid) was not determined.
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Figure 8: Calculated composition of non-metallic inclusions in function of processing time compared to 
experimental data [2017Piv].

With this simulation it is also possible to calculate the amount and type of inclusions present in the 
liquid steel. At the beginning of the process all the inclusions are liquid oxides, that gradually get richer 
in Al2O3 as the steel picks up Al from the slag.  After 20 minutes processing time, the first solid 
corundum (Al2O3) inclusions start appearing. After 25 minutes almost no liquid inclusions remain. 
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Figure 9: Amount of inclusions in the liquid steel in function of processing time. The total amount of inclusions 
(red line) and liquid oxide inclusions (blue line) are plotted. Up to about 20 min all inclusions are liquid oxide 
type, then they are replaced by solid corundum (Al2O3) inclusions. Experimental data from [2017Piv].

Reference

[2017Piv] Piva, S. P. T., Kumar, D. & Pistorius, P. C. "Modeling Manganese Silicate Inclusion Composition 
Changes during Ladle Treatment Using FactSage Macros," Metall. Mater. Trans. B 48, 37–45 (2017).
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PMET_06: Ladle Furnace (LF) Kinetics

This in-depth example, which is also showcased on our website, uses the Process Metallurgy Calculator 
to show how to set up a full kinetic simulation of steel refining in a ladle furnace using the Process 
Metallurgy Module in Thermo-Calc. The Process Metallurgy Module uses the Effective Equilibrium 
Reaction Zone model (EERZ) to simulate the kinetics of the process. In this example, a full kinetic 
simulation of the LF refining process  is set up using the Process Metallurgy Module. 

For a simpler process  that describes a lab-scale ladle furnace process, see PMET_05: Lab 
Scale Ladle Furnace (LF) Kinetics.

Background Overview

After steelmaking, which is mostly performed in a basic oxygen furnace (BOF) or electric arc furnace 
(EAF), the steel is usually tapped into a ladle where certain additions are made (deoxidation agents, slag 
formers, certain alloying elements) and then transferred to the ladle furnace (LF). The LF fulfils many 
purposes in the steel refining process, the most important being:

 l Temperature control / heating by an electrical arc.
 l Mixing by Ar or N2 bubbling through porous plugs in the bottom of the ladle to achieve 

homogeneous temperature and composition throughout the ladle.
 l Removal of unwanted non-metallic phases / inclusions such as corundum (Al2O3), liquid oxide 

inclusions, spinel, on so on, by flotation, aided by Ar or N2 bubbling.
 l Modification / engineering of non-metallic inclusions so that they are not detrimental for the 

downstream processing and/or the final product.
 l Removal of unwanted volatile elements such as Pb, Zn, Sn, and so on. Due to their high vapor 

pressure, these elements are enriched in the rising Ar or N2 bubbles. After the gas escapes out of 
the ladle and cools, they condense, forming copious amounts of dust.

 l Removal of unwanted elements such as sulphur by liquid steel / slag reactions.
 l Lowering of the dissolved gas content. In the LF this is mainly achieved through chemical 

reactions. For direct removal of dissolved gas, vacuum degassing (VD) is usually required.
 l Alloying and trimming of the steel to achieve the exact alloy composition required by the 

specification of the steel that is to be produced.

The reactions taking place in a LF are a complex interplay between equilibrium thermodynamics that 
define the direction of chemical reactions, and kinetics that define how fast the equilibrium state is 
approached.
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 Project File and License Information
 l Folder: Process Metallurgy  
 l File name: PMET_06_Ladle_Furnace_Kinetics.tcu

This example requires the database TCOX10 or newer, a full license of Thermo-Calc 2020b 
or newer, plus a license for the Process Metallurgy Module.

Visualizations

This example is included as a Process Metallurgy tutorial on our website and as part of the 
playlist our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 
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The nodes in the Project window for this example. The Process Metallurgy Calculator is renamed to EERZ 
model. If you click this node the Configuration window opens, which is where all the settings for the process 
simulation are located. This advanced example also uses three Experimental Data Reader nodes to read the 
experimental data that is included in the simulation results. After setting up the system and accessing the 
experimental data, you then add Plot Renderers to the calculator to generate the output in the Visualizations 
window. 
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PMET_07: Vacuum Oxygen Decarburization Kinetics

This application example, which is showcased on our website  and uses the Process Metallurgy 
Calculator, shows how the Process Metallurgy Module in Thermo-Calc can be used to simulate the 
Vacuum Oxygen Decarburization (VOD) process for a stainless steel.

This example, based on data of a real VOD process published by Ding et al. [2000Din], shows how to set 
up the VOD process in Thermo-Calc’s Process Metallurgy Module. Use of the following features in the 
Process Metallurgy Module are highlighted in this example:

 l Change of pressure as a function of time during the process
 l Change of reaction kinetics as a function of time during the process
 l Selection of zone where degassing is allowed

Project File and License Information
 l Folder: Process Metallurgy  
 l File name: PMET_07_Vacuum_Oxygen_Decarburization_Kinetics.tcu

This example requires a license for Thermo-Calc 2024a or newer, the database TCOX13 or 
newer, and a license for the Process Metallurgy Module.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 

Reference

[2000Din] R. Ding, B. Blanpain, P. T. Jones, P. Wollants, Modeling of the vacuum oxygen decarburization 
refining process. Metall. Mater. Trans. B. 31, 197–206 (2000).

ǀ 366 of 420

https://thermocalc.com/showcase/application-examples/vacuum_oxygen_decarburization_vod/


PMET_08: Steel Deoxidation on Tapping

This application example, which is showcased on our website and uses the Process Metallurgy 
Calculator, shows a few of the ways the Process Metallurgy Module in Thermo-Calc can be used to 
investigate steel deoxidation (killing) on tapping.

About Deoxidation or “Killing” of Steel

Deoxidation of steel, also known as killing of steel, occurs toward the end of the steelmaking process, 
but before desulphurization. After primary steelmaking, for example in a basic oxygen furnace (BOF) or 
electric arc furnace (EAF), the liquid steel contains a large amount of dissolved oxygen [O] (400 to over 
1000 ppm, see PMET_04: Basic Oxygen Furnace (BOF) Kinetics). This oxygen must be removed from the 
liquid steel for several reasons, including:

 l Desulphurization is not effective with high oxygen content in the steel (see example on 
desulphurization)

 l Continuous casting of un-killed steel is not possible and will result in “boiling” of the steel in the 
mould and massive porosity, as shown in the figure.

The two most widely applied methods of deoxidizing or killing the steel are adding Al (Al-killed steel) to 
the steel and adding Si (Si-killed steel) to the steel. These elements readily react with oxygen to form 
oxides that precipitate within the liquid steel. This does not reduce the total amount of oxygen in the 
liquid steel; it simply transforms the dissolved oxygen into an oxide precipitate. This oxide precipitate 
then needs to be removed from the steel by flotation during secondary metallurgy in the ladle furnace 
(LF).

In this example we look at how the Process Metallurgy Module can be used to investigate these two 
widely applied methods of deoxidizing or killing the steel: adding Al (Al-killed steel) or adding Si (Si-killed 
steel). This, however, can result in the formation of damaging inclusions that cause problems during 
further processing, so we go on to look at two simple and very common processes that are used to 
transform the solid SiO2 and Al2O3 inclusions into liquid oxides so that they are less damaging.

Project File and License Information
 l Folder: Process Metallurgy  
 l File name: PMET_08_Steel_Deoxidation_on_Tapping.tcu

Choose a or b versions of the example based  on your license.
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 l PMET_08a_Steel_Deoxidation_on_Tapping.tcu is included in a regular Thermo-Calc installation 
as well as the free Educational version of Thermo-Calc. It is a simplified version that uses the 
OXDEMO database.

 l PMET_08b_Steel_Deoxidation_on_Tapping.tcu requires a full license of Thermo-Calc version 
2021b or newer and database TCOX11 or newer.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 
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Nickel Model Library Examples Collection

The General Models  are available to all users. To run calculations with the Nickel Models 
(as part of the Nickel Model Library) requires a valid maintenance license plus licenses for 
both the TCNI (version 11 and newer) and MOBNI (version 5 and newer) databases. 

These examples use the Property Model Calculator, an activity available with Thermo-Calc plus the 
available Property Models in the Nickel Model Library. 

About the Examples

In this section:

PM_Ni_01: Lattice Parameter of γ/γ' 370

PM_Ni_02: Antiphase Boundary Energy of γ' 372

PM_Ni_03: Critical Temperatures of Alloy 718 374

PM_Ni_04: Strain Age Cracking (SAC) 376

ǀ 369 of 420



PM_Ni_01: Lattice Parameter of γ/γ'

The example uses the Property Model Calculator with the Equilibrium with Freeze-in Temperature - Ni 
Model.

Property Model Calculator and About the Equilibrium with Freeze-in Temperature Nickel 
Property Model

The lattice parameters are measured experimentally for γ/γ' in a 
Ni0.6Mo0.92Ta12.5Al1.83Ti10.5Cr3.3W alloy.

The thermodynamically stable equilibrium will not be reached for this alloy during the experimental 
heat treatment; only the phases γ and γ' are noticed in the experiment. The γ/γ' microstructure is in this 
calculation example assumed to freeze-in at 1000 °C where the phase compositions do not change 
during cooling to room temperature.

Some of the key settings to note in this example: 

 l The Subset of phases is selected as Gamma and gamma-prime only to match the experimental 
observations. 

 l The Freeze-in temperature is set to 1000 °C. 
 l A One Axis calculation is used where the evaluation temperatures are within a range of 20 °C to 

1000 °C.

Project File and License Information
 l Folder: Property Models → Nickel
 l File name: PM_Ni_01_Lattice_Parameter_of_Gamma_Gamma_Prime.tcu

To run calculations with the Nickel Models requires a valid maintenance license plus 
licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 and newer) 
databases. For some Property Models, additional recommendations for the database 
version to use is indicated in its description. Also see our website to learn more about the 
Nickel Model Library.
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 1: The lattice parameters for γ and γ' are plotted against experimental data from [1985Nat].

Reference

[1985Nat] M. V. Nathal, R. A. Mackay, R. G. Garlick, Temperature dependence of γ-γ’ lattice mismatch in 
Nickel-base superalloys. Mater. Sci. Eng. 75, 195–205 (1985).
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PM_Ni_02: Antiphase Boundary Energy of γ'

The example uses the Property Model Calculator with the Antiphase Boundary Energy - Ni Model.

Property Model Calculator and About the Antiphase Boundary Energy Property Model

This example shows a calculation of the antiphase boundary energy for an Al75Ni alloy at room 
temperature with increasing amounts of Ti. The plot shows the (111) APB energy in Ni3Al1−xTix over the 
whole compositional range together with first-principle calculations from Chandran and Sondhi 
[2011Cha] and Vamsi and Karthikeyani [2012Vam] evaluated at 0 K. The trend with increasing 111 APBE 
with an increasing amount of Ti is predicted by all calculations but the absolute values between the first 
principle calculations are quite different.

Some of the key settings to note in this example: 

 l γ' is the only stable phase for these compositions. FCC_L12 is therefore selected as the only 
phase  in the System Definer.

 l The Freeze-in temperature and evaluation temperature are both set at 20 °C with the Subset of 
phases for All phases. 

 l A One Axis calculation is used with Mole percent Ti between 0 and 25 in 20 steps.
 l The plotting quantity APBE for 111 plane (1/2) is then compared with the first principle 

calculations.

Project File and License Information
 l Folder: Property Models → Nickel
 l File name: PM_Ni_02_Antiphase_Boundary_Energy_of_Gamma_Prime.tcu

To run calculations with the Nickel Models requires a valid maintenance license plus 
licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 and newer) 
databases. For some Property Models, additional recommendations for the database 
version to use is indicated in its description. Also see our website to learn more about the 
Nickel Model Library.
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 2: Composition of Ti (mole %) compared to antiphase boundary surface energy for 111 plane and 
experimental data from [2011Cha; 2012Vam].

References

[2011Cha] M. Chandran, S. K. Sondhi, First-principle calculation of APB energy in Ni-based binary and 
ternary alloys. Model. Simul. Mater. Sci. Eng. 19, 025008 (2011).

[2012Vam] K. V. Vamsi, S. Karthikeyan, Effect of Off-Stoichiometry and Ternary Additions on Planar Fault 
Energies in Ni3Al, in Superalloys 2012 (John Wiley & Sons, Inc., Hoboken, NJ, USA, 2012; pp. 521–
530.

ǀ 373 of 420

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured


PM_Ni_03: Critical Temperatures of Alloy 718

The example uses the Property Model Calculator with the Solvus for Ordered Phase-Ni Model.

Property Model Calculator and About the Solvus for Ordered Phase Property Model

In this example, the respective solvus temperatures of the Delta and Gamma double-prime phases are 
calculated.

For the Delta phase, the Subset of phases is set to All phases but the result varies very little with the 
selected subset (provided that the Delta phase is included). For the Gamma double-prime phase, which 
is a metastable phase, it is necessary to use the Typical Ni-base superalloy phase subset.

The resulting solvus temperatures are compared with experimental data from [2010Fra].

Project File and License Information
 l Folder: Property Models → Nickel
 l File name: PM_Ni_03_Critical_Temperatures_Alloy_718.tcu

To run calculations with the Nickel Models requires a valid maintenance license plus 
licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 and newer) 
databases. For some Property Models, additional recommendations for the database 
version to use is indicated in its description. Also see our website to learn more about the 
Nickel Model Library.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 3: Solvus temperatures for NI3TA_D0A (Delta) and BCT_D022 (Gamma double-prime) compared to 
experimental data [2010Fra].

Reference

[2010Fra] R. B. Frank, C. G. Roberts, J. Zhang,  Effect of Nickel Content on Delta Solvus Temperature and 
Mechanical Properties of Alloy 718, in 7th International Symposium on Superalloy 718 and 
Derivatives (2010) (TMS (The Minerals, Metals & Materials Society), 2010, pp. 725–736.
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PM_Ni_04: Strain Age Cracking (SAC)

The example uses the Property Model Calculator with the Strain-Age Cracking - Ni Model.

For additional information, see About the Strain-Age Cracking Property Model.

Welding or additive manufacturing (AM) of Ni-base alloys has so far been strongly limited by various 
cracking issues during processing or post-processing. Strain-age cracking (SAC) occurs when the 
combination of thermal stresses and coherency stresses between the γ matrix and γ’ precipitates 
exceed the local strength of the alloy structure. Thermal residual stresses originate from the initial 
processing (welding or AM), while coherency stresses form during post-processing heat treatments, 
when γ’ re-precipitates in the matrix. Coherency stresses may be tensile or compressive depending on 
the sign of the lattice misfit. 

Furthermore, coherency stresses scale with the fraction of γ’, making conventional high-γ’ alloys 
virtually impossible to weld or shape via AM. At the same time, high-γ’ fraction alloys offer attractive 
properties, such as high strength at high service temperatures. In order for such alloys to be 
processable, it is necessary to reduce the cracking tendency.  

Thermal stresses are very difficult to alleviate, as this requires heating, which in turn triggers re-
precipitation of γ’. Therefore, an alternative strategy may be to target the coherency stresses, which are 
determined by the respective lattice parameters of the matrix and precipitate. Such a strategy was 
adopted by Zhou et al. [2020Zho], where they optimized the composition of the Ni-base alloy to fulfill 
the above criteria, i.e., high fraction of γ’ and no strain-age cracking tendency.  

In this example, the experimental alloys from [2020Zho] are analyzed based on the Strain-Age Cracking 
- Ni Property Model  to compare the tendency for cracking using an SAC risk factor. 

Project File and License Information
 l Folder: Property Models → Nickel
 l File name: PM_Ni_04_Strain_Age_Cracking.tcu
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To run calculations with the Nickel Models requires a valid maintenance license plus 
licenses for both the TCNI (version 11 and newer) and MOBNI (version 5 and newer) 
databases. For some Property Models, additional recommendations for the database 
version to use is indicated in its description. Also see our website to learn more about the 
Nickel Model Library.

This example uses the TCNI version 12 database. It can also be run with the TCNI version 11 
database.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Performing the calculation for the two experimental alloys, along with the CM247LC benchmark alloy 
and using the temperature interval setting produces a set of relevant output results as shown in a table 
(Figure 4) and Parallel coordinates plot (Figure 5). CM247LC is considered to be very difficult to weld, 
which is evidenced by the very high value of the SAC risk factor. Comparatively, the two experimental 
alloys, ExpAM and ExpAMmod, show values very close to zero. Low or negative values of the SAC risk 
factor can be interpreted as low or no risk for strain-age cracking.

Conventionally, the weldability of a given Ni-base alloy has been assessed based on the Ti and Al 
contents, which correlate with the fraction of γ’. However, such an approach neglects the fact that it is 
the coherency stresses that cause cracking, and these are also dependent on the lattice misfit. By 
tailoring an alloy to have low misfit, in relation to the γ’ fraction and in the relevant temperature range, 
it is possible to design a high-γ’ fraction alloy with very low risk for SAC, as shown in [2020Zho]. The SAC 
model used here captures all of these effects and can be used as a design tool for the purpose of 
eliminating this cracking tendency.
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Figure 4: There are a two ways to view the data in table format. In this example, there is a Table Renderer 
node added to the Project window that lists the data points in the Visualizations window. 

You can also access the same information via the Plot Renderer Configuration window by 
clicking the Table View button followed by clicking Perform. This converts the Parallel 
coordinates plot type to the same table of information.

Figure 5:  Parallel plot of the resulting SAC risk factor along with experimental and calculated solvus of γ’ for 
the three alloys compared in [2020Zho].

Plot Type: Parallel Coordinates

Reference

[2020Zho] N. Zhou, A. D. Dicus, S. A. J. Forsik, T. Wang, G. A. Colombo, M. E. Epler, Development of a 
New Alumina-Forming Crack-Resistant High-γ′ Fraction Ni-Base Superalloy for Additive 
Manufacturing, in Superalloys 2020, pp. 1046–1054.
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Noble Metal Alloys Model Library Examples 
Collection
These examples use the Property Model Calculator, an activity available with Thermo-Calc 
plus the available Property Models in the Noble Metal Alloys Model Library. 

The General Models  are available to all users. To run calculations with the 
Noble Metal Alloys Models (as part of the Noble Metal Alloys 
Model Library) requires a valid maintenance license plus a license for the 
TCNOBL (version 3 and newer) database. 

About the Examples

In this section:

PM_Noble_01: Color Prediction 380
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PM_Noble_01: Color Prediction

The Optical Properties - Noble Property Model, available with the Property Model 
Calculator and the Noble Metal Alloys Model Library, is used to simulate the color, 
reflection, and transmission of light, based on modeling the alloy microstructure and the 
resulting optical properties. 

For more information about the Property Model, see About the Optical 
Properties - Noble Property Model and Optical Properties - Noble Property 
Model Settings.

This example uses the Property Model Calculator with the Optical Properties - Noble 
Property Model. 

The example demonstrates three use cases for simulating color in the Ag-Au-Cu alloy system 
(1) screening the color of the alloy system (2) designing a green-gold alloy by adjusting Ag 
content, and (3) visualizing the impact of alloy thickness and light incident angle on color. 

Project File and License Information
 l Folder: Property Models → Noble Metals
 l File name: PM_Noble_01_Color_Prediction.tcu

To run calculations with the Noble Metal Alloys Models (as part of the Noble 
Metal Alloys Model Library) requires a valid maintenance license plus a license 
for the TCNOBL (version 3 and newer) database. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can 
access in a variety of ways. When in Thermo-Calc, from the menu select Help → 
Video Tutorials, or from the main My Project window, click Video Tutorials. 
Alternately,  you can go to the website or our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg/featured
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Open the example project file  to review the node setup on the Project window and the 
associated settings on the Configuration window for each node. For some types of projects, 
you can also adjust settings on the Plot Renderer Configuration window to preview results 
before performing the simulation. Click Perform Tree to generate plots and tables to see the 
results on the Visualizations window.

When you run (Perform) this example, it takes a few minutes for the 
calculations to complete.

Screening the Color of the Ag-Au-Cu Alloy System

 l The entire composition space was screened with a 2 wt.% step size.
 l Alloys were annealed at 873.15 K to reach equilibrium phases and compositions for 

accurate color prediction.
 l The standard illuminant is D65 noon daylight, with a 2 ̊standard observer. The 

material is assumed to be opaque with a thickness of 10,000 nm.
 l Some color predictions near the 20–40 wt.% Cu region require model accuracy 

improvements.
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Figure 1: Color prediction for Ag-Au-Cu alloy.

Designing a Green Gold Alloy by Adjusting Ag Content in Au-10Cu-xAg Alloys

 l ΔE calculation box was chosen to enable the measurement of color differences.
 l Target color in Lab color space is [95, -13, 25], representing a light green shade.

Figure 2: Change of color difference (ΔE) between the targeting light green gold and the simulated 
alloy when changing Ag content.
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Visualizing the Impact of Alloy Thickness and Light Incident Angle on Color

 l Intercritical annealing was not selected, as pure gold is in the FCC phase and does not 
require equilibrium calculations.

 l As material thickness increases, the color of gold tends to approach the bulk gold 
color observed in macroscopic samples.

Figure 3: Color of pure gold varies with different light incident angles and material thicknesses.



Steel Model Library Examples Collection

The General Models  are available to all users. To run calculations with  the Steel Models (as 
part of the Steel Model Library) requires a valid maintenance license plus licenses for both 
the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. 

These examples use the Property Model Calculator, an activity available with Thermo-Calc plus 
Property Models in the Steel Model Library. 

About the Examples

In this section:

PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing 385

PM_Fe_02: Fe-Mn Martensite Morphologies 388

PM_Fe_03: Fe-C-Mn Pearlite 390

PM_Fe_04: Critical Temperatures 393

PM_Fe_05: Fe-C-Mn-Si-Ni-Cr-Mo Bainite 396

PM_Fe_06: TTT Diagram for Fe-C-Mn-Si-Cr-V 398

PM_Fe_07: Hardenability Design of Steel 401

PM_Fe_08: CCT Diagram for Fe-C-Mn-Si-Cr-V 403

PM_Fe_09: Fe-C-Ni Ferrite 406

PM_Fe_10: Martensitic Steel Strength 410

PM_Fe_11: Steel Design Using the Parallel Coordinates Plot 413
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PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing

The example uses the Property Model Calculator with the Martensite Fractions and Martensite 
Temperatures Models to  calculate martensite fractions and martensite temperatures [martensite start 
(Ms) and 90% transformation temperature (M90)]. 

The alloy is first intercritically annealed and then quenched. Austenite composition is determined by an 
equilibrium calculation at the annealing temperature. Martensite fraction is calculated as a function of 
temperature which the alloy is quenched to. The example also shows how Cr content in the alloy 
influences Ms and M90 after intercritical annealing.

Property Model Calculator, About the Martensite Temperatures Property Model, and 
About the Martensite Fractions Property Model

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_01_Fe-Cr-C_martensite_intercritical_annealing.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

This example is included as a Property Model tutorial on our website and as part of the 
Property Model Calculator playlist on our YouTube channel. 

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 1: The transformation curves plot showing Fe-Cr-C martensite with intercritical annealing.

Figure 2: Comparing Martensite start (Ms) to Martensite finish (Mf).
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Reference

[1949Har] W. J. Harris, M. Cohen, Stabilization Of The Austenite-Martensite Transformation. Trans. 
AIME. 180, 447–470 (1949).
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PM_Fe_02: Fe-Mn Martensite Morphologies

The example uses the Property Model Calculator with the Martensite Temperatures Property Model to 
calculate the Ms temperatures of different types of martensites: lath, plate, and ε (HCP), compared with 
experimental ε Ms values taken from several sources.

Property Model Calculator and About the Martensite Temperatures Property Model

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_02_Fe-Mn_Martensite_Morphologies.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 3: A diagram showing all the Ms temperatures of different types of martensite morphologies (lath, 
plate and epsilon (HCP) compared with experimental epsilon Ms values.
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PM_Fe_03: Fe-C-Mn Pearlite

The example uses the Property Model Calculator and with the Pearlite Property Model and shows how 
to calculate pearlite growth rate, lamellar spacing, and times of start (2% transformation) and finish 
(98% transformation) as functions of isothermal heat treating temperature in an Fe-0.69C-1.80Mn alloy 
(mass %). With maximize growth rate set as the criterion, the model gives maximal growth rate and 
minimal lamellar spacing. With optimal pearlite as the pearlite mode, the model optimizes partitioning 
of substitutional alloying element(s) (Mn in this example) according to the criterion, which realizes a 
smooth transition between ortho-pearlite at high temperature and para-pearlite at low temperature.

Property Model Calculator and About the Pearlite Property Model

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_03_Fe-C-Mn_Pearlite.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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Figure 4: Growth rate as a function of temperature.

Figure 5: Lamellar spacing as a function of temperature.
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Figure 6: The TTT (time-temperature-transformation) diagram showing times of start (2% transformation) and 
finish (98% transformation) as functions of isothermal heat treating temperature in an Fe-0.69C-1.80Mn alloy 
(mass %).

Reference

[1974Raz] N. Razik, G. Lorimer, N. Ridlley, An investigation of manganese partitioning during the 
austenite-pearlite transformation using analytical electron microscopy. Acta Metall. 22, 1249–1258 
(1974).

ǀ 392 of 420



PM_Fe_04: Critical Temperatures

The example uses the Property Model Calculator and the Critical Transformation Temperatures Model 
to calculate the distribution of the typical phase transition temperatures for a low alloy steel (Fe-0.3Cr-
1.0Mn-0.3Mn-0.18C) when the composition is varied within the specification for the alloy. 

In the set up of the example, the Critical Transformation Temperatures model is used with a Property 
Model Calculator Uncertainty calculation to plot a histogram showing the distribution of A1- and A3-
temperatures (Figure 7). As a comparison,  an Equilibrium Calculator, One Axis calculation results in a 
property diagram showing the phase transitions for the nominal composition (Figure 8). 

The phase transition temperatures are defined as:

 l Liquidus: First austenite or ferrite transformation from the liquid
 l Solidus: Liquid fully transformed to solid
 l A0: Magnetic transition temperature (Curie temperature) of cementite. The cementite is 

paramagnetic above A0 and ferromagnetic below
 l A1: Austenite (FCC_A1) transforms to ferrite (BCC_A2) + carbide (cementite or graphite or 

M23C6)
 l A2: Magnetic transition temperature (Curie temperature) of ferrite (BCC_A2). Paramagnetic 

above A2 and ferromagnetic below
 l A3: Austenite (FCC_A1) transforms to ferrite (BCC_A2)

Property Model Calculator and About the Critical Transformation Temperatures Property 
Model

Project File  and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_04_Critical_Temperatures.tcu

The FEDEMO: Iron Demo Database  is used and this example is available to all 
users. However, in general a license is required to run the Steel Models.
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

Figure 7: The distribution of the A1 and A3 phase transition temperatures for a low alloyed steel (Fe-0.3Cr-
1.0Mn-0.3Mn-0.18C) when the composition is varied within the specification. This plot uses the Critical 
Transformation Temperatures model with the Property Model Calculator.
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Figure 8: This plot uses an Equilibrium Calculator to show an alternate visualization of the phase transitions in 
a property diagram for the nominal composition. 
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PM_Fe_05: Fe-C-Mn-Si-Ni-Cr-Mo Bainite

The example uses the Property Model Calculator and the Bainite Steel Model to calculate a Time-
Temperature-Transformation (TTT) diagram for an Fe-0.97C-0.72Mn-0.32Si-1.54Ni-0.8Cr-0.26Mo alloy. 
The result is compared to experimental results from [1948Jaf]. Other elements with low amount in the 
experimental alloy are omitted for the calculation.

Considered elements: Fe, C, Mn, Si, Cr, Ni, and Mo. Other elements in the system are 
neglected for bainite by mass percent.

A Property Model Calculator is used with a One Axis calculation and the TTT mode selected on the Plot 
Renderer to plot the TTT diagram.

For more information see About the Bainite Property Model, Plot Type: TTT Mode, and Plot 
Types.

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_05_Fe-C-Mn-Si-Ni-Cr-Mo_Bainite.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Figure 9: The bainite TTT diagram for an  Fe-0.97C-0.72Mn-0.32Si-1.54Ni-0.8Cr-0.26Mo alloy.

Reference

[1948Jaf]  L. D. Jaffe, Anisothermal formation of bainite and proeutectoid constituents in steels, Trans. 
AIME, vol. 176, pp. 343–383 (1948).
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PM_Fe_06: TTT Diagram for Fe-C-Mn-Si-Cr-V

The example uses the Property Model Calculator and the TTT Diagram Property Model to calculate a  
Time-Temperature-Transformation (TTT) diagram for an Fe-C-Mn-Si-Cr-V alloy (Steel 42CrV6). The 
calculation is compared to an experimental TTT diagram for the same steel (with some other impurities) 
from data in [1958Wev].  

A One Axis Calculation Type is selected on the Property Model Calculator and then the TTT Mode 
selected on the Plot Renderer as the Plot type in order to plot the final TTT diagram.

A second plot also shows the calculated terminal fractions of ferrite, pearlite, and bainite.

For more information see About the TTT Diagram Property Model, TTT Diagram Property 
Model Settings, and Plot Type: TTT Mode.

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_06_Fe-C-Mn-Si-Cr-V_TTT.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes several hours to complete the calculations. 

Figure 10: The TTT diagram for an  Fe-C-Mn-Si-Cr-V alloy comparing the calculation with experimental data 
from [1958Wev].

Figure 11: The terminal fractions quantities for bainite, ferrite, and pearlite are plotted against the cooling 
rate for the Fe-C-Mn-Si-Cr-V alloy.
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Düsseldorf, 1958), p. II-112.

ǀ 400 of 420



PM_Fe_07: Hardenability Design of Steel

This application example, which is showcased on our website, shows how the Steel Model Library in 
Thermo-Calc can be used to find the optimal compositions for an Fe–Mn–C steel to achieve high 
hardenability for the purpose of strength.

This example focuses on the hardenability design of steel using the Steel Model Library in Thermo-Calc. 
It shows how to find the optimal compositions for Fe-Mn-C steel to achieve high hardenability for the 
purpose of strength. Hardenability refers to the ability of steel to form martensite on quenching. It is a 
measure of the capacity of a steel to be hardened in depth when quenched from its austenitizing 
temperature. Among various factors, composition is one of the most important factors which has great 
influence on the hardenability of the steel. In this example, we use the Steel Model Library to 
investigate the possible composition ranges of Fe–C–Mn alloys to reach a fully martensitic 
microstructure.

To fulfil the requirement, room temperature martensite fraction should be large and the amount of 
retained austenite should be small. Meanwhile, other products of austenite decomposition should be 
avoided during continuous cooling. Such transformation products can be suppressed by fast quenching, 
yet the cooling rate is usually limited by the capacity of facilities or other problems such as cracking. 
Therefore, for hardenability purposes, it is desirable to achieve a fully martensitic structure with a 
relatively low cooling rate. This is done by promoting martensite formation while retarding other 
transformations through adjusting the steel composition.

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_07_Hardenability_Design_of_Steel.tcu

Although this example uses the FEDEMO and MFEDEMO databases, running the calculation 
requires a license for Thermo-Calc 2022b or newer and for the Steel Model Library.

Visualizations

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes several hours to complete the calculations. 

The resulting plots and details related to setting up this example are available  to download 
via the dedicated web page. 
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PM_Fe_08: CCT Diagram for Fe-C-Mn-Si-Cr-V

The example uses the Property Model Calculator and the CCT Diagram Property Model to calculate a 
Continuous-Cooling-Transformation (CCT) diagram for an Fe-C-Mn-Si-Cr-V alloy (Steel 42CrV6). The 
calculation is compared to an experimental CCT diagram for the same steel (with some other impurities) 
from data in [1958Wev]. 

A One Axis Calculation Type is selected on the Property Model Calculator and then the CCT Mode 
selected as the Plot type on the Plot Renderer in order to plot the final CCT diagram.

A second plot also shows the calculated terminal fractions of ferrite, pearlite, bainite, and martensite.

For more information  see About the CCT Diagram Property Model, CCT Diagram Property 
Model Settings, and Plot Type: CCT Mode.

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_08_Fe-C-Mn-Si-Cr-V_CCT.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes several hours to complete the calculations. 

Figure 12: The CCT diagram for an  Fe-C-Mn-Si-Cr-V alloy comparing the calculation with experimental data 
from [1958Wev].

 

Figure 13: The terminal fractions quantities for bainite, ferrite, martensite, and pearlite are plotted against the 
cooling rate for the Fe-C-Mn-Si-Cr-V alloy.
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PM_Fe_09: Fe-C-Ni Ferrite

The example uses the Property Model Calculator and the Ferrite Property Model to calculate the ferrite 
fraction parabolic rate constant and ferrite start time for an Fe-0.12C-3.28Ni alloy.

Two growth modes—Orthoequilibrum (OE) and Paraequilibrium (PE)—are used with a One Axis 
calculation type to compare the ferrite molar fraction and to determine the ferrite start time for each 
growth mode.

The experimental data for the ferrite start is taken from [1966Aar]. For the parabolic rate constant 
experimental data is from [1981Bra].

For more information about the Property Model, see About the Ferrite Property Model and 
Ferrite Property Model Settings.

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_09_Fe-C-Ni_Ferrite.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Figure 14: Ferrite fraction at the end of the transformation, under orthoequilibrium (OE) or paraequilibrium 
(PE).
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Figure 15: Parabolic rate constant. Experimental data is from [1981Bra].

Figure 16: Ferrite start time. This plot also uses the TTT mode. Experimental data from [1966Aar].
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PM_Fe_10: Martensitic Steel Strength

The Martensitic Steel Strength Property Model, available with the Property Model Calculator and the 
Steel Model Library, calculates the strength and/or hardness of martensitic steels.

In this example, data for AISI4068 from [1956Gra] are compared to calculations using the Martensitic 
Steel Strength model. In the set up, one System Definer and two Experimental File Reader activities are 
used along with four Property Model Calculators. The Martensitic Steel Strength Property Model is 
used in all cases with One Axis calculations to produce two plots that compare the tempering 
temperature and time to the total hardness of tempered steels. 

For more information about the Property Model, see About the Martensitic Steel Strength 
Property Model and Martensitic Steel Strength Property Model Settings.

Project File and License Information
 l Folder: Property Models → Steel
 l File name: PM_Fe_10_Martensitic_Steel_Strength.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

This example uses TCFE13. Earlier versions of this database can be used although there 
may be slight differences in the results. 

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

For some Windows-based systems, performing the full calculation from the top My Project 
node can result in out of memory issues due to the number of calculators. If this happens, 
perform individual calculations for each Property Model Calculator (e.g. right-click the node 
and select Perform Now). This produces the full plots that are output to the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Figure 17: Total hardness of the tempered steel versus tempering time, for two tempering temperatures, 
compared to data from [1956Gra].
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Figure 18: Total hardness of the tempered steel versus tempering temperature, for two tempering times, 
compared to handbook data from [1956Gra].
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PM_Fe_11: Steel Design Using the Parallel Coordinates Plot

The example uses the Property Model Calculator and three Property Models to plot a property diagram 
and a Parallel coordinates plot for chemistries centered around an Fe1.5Cr2.0Ni0.31C1.0Mn alloy. The 
Ni, Cr, and C chemistries are varied to understand their influence on some key properties. This can be 
used to optimize a material chemistry to meet specific design criteria.

A One Axis calculation using the Equilibrium Calculator produces a property diagram to show the 
equilibrium fractions of the alloy.

A second calculation uses a Grid calculation with the Property Model Calculator and the Driving Force, 
Martensite Temperatures, and Martensitic Steel Strength models to demonstrate the use of the 
Parallel coordinates plot type. The driving force model in this example calculates the driving force for 
Cementite to form at 500 °C (tempering temperature). The driving force gives a good idea of how fine a 
dispersion of carbides could form. Higher driving force means a finer distribution.

When using a parallel coordinates plot type, you can interpret multidimensional data to compare how 
different parameters affect each other. In this example this includes the composition of Ni, Cr, and C 
(each in mass percent), the Driving force per mole, the Total strength of the tempered steel, and the Ms 
temperature.

Plot Type: Parallel Coordinates

Project File and License Information
 l Folder: Property Models → Steels
 l File name: PM_Fe_11_Steel_Design_Using_Parallel_Plot.tcu

To run calculations with the Steel Models requires a valid maintenance license plus licenses 
for both the TCFE (version 9 and newer) and MOBFE (version 4 and newer) databases. Also 
see our website to learn more about the Steel Model Library and other related examples.

This example uses TCFE13. Earlier versions of this database can be used although there 
may be slight differences in the results. 
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Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Figure 19: A Property Diagram to observe the change in volume fraction of all phases as the temperature 
increases. 
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Figure 20: A parallel coordinates plot with multidimensional data comparing the Ni, Cr, and C compositions, 
the Driving force per mole, the Total strength of the tempered steel, and the Ms temperature. 

Tips to Interpret the Plot Data

 l When most lines between two parallel axes are somewhat parallel to each other, there is a 
positive relationship between these two dimensions.

 l When lines cross in a kind of superposition of X-shapes, that's a negative relationship.
 l When lines cross randomly it means that there is no particular relationship.
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Titanium Model Library Examples Collection

The General Models  are available to all users. To run calculations with the Titanium 
Models (as part of the Titanium Model Library) requires a valid maintenance license plus a 
license for the TCTI (version 6 and newer) database. 

These examples use the Property Model Calculator, an activity available with Thermo-Calc plus the 
available Property Models in the Titanium Model Library. 

About the Examples

In this section:

PM_Ti_01: Martensite Temperatures for Ti-Zr 417

PM_Ti_02: Alloy Strength for Ti-O 419
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PM_Ti_01: Martensite Temperatures for Ti-Zr

The Martensite Temperatures - Ti Property Model, available with the Property Model Calculator and 
the Titanium Model Library, calculates the martensite start temperature (Ms) and T-Zero temperatures 
for Ti-base alloys.

For more information about the Property Model, see About the Martensite Temperatures - 
Ti Property Model and Martensite Temperatures - Ti Property Model Settings.

This example uses the Martensite Temperatures - Ti Property Model with a simple Ti-Zr system to show 
the use of this model. A One Axis calculation is used to plot the Ms and T-Zero temperatures as a 
function of mole fraction of Zr with experimental data from [1952Du, 1965McM, and 1970Hua]. 

Project File and License Information
 l Folder: Property Models → Titanium
 l File name: PM_Ti_01_Martensite_Temperatures_Ti-Zr.tcu

To run calculations with the Titanium Models requires a valid maintenance license plus a 
license for the TCTI (version 6 and newer) database. For some Property Models, additional 
recommendations for the database version to use is indicated in its description. Also see 
our website to learn more about the Titanium Model Library.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.

Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.
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When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Figure 1: Ms and T-Zero temperatures as a function of mole fraction of Zr with experimental data from 
[1952Du, 1965McM, and 1970Hua]. 
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PM_Ti_02: Alloy Strength for Ti-O

The Alloy Strength - Ti Property Model, available with the Property Model Calculator and the Titanium 
Model Library, calculates the strength and hardness for Ti-base alloys.

For more information about the Property Model, see About the Alloy Strength - Ti Property 
Model and Alloy Strength - Ti Property Model Settings.

This example uses the Alloy Strength - Ti Property Model to determine the total hardness of a  Ti-
0.04Fe-0.03C-0.005N-0.01O alloy.

A One Axis calculation is done using the latest version of the TCTI database to compare the total 
hardness vs oxygen content (in mole %). Two Experimental File Readers provide the data from 
[1950Fin] and [1973Oka] for comparison with the calculated values.  

As is clearly illustrated in this example, the effect of typical impurity elements on the strength and 
hardness of Ti is very large. It is therefore important to keep in mind that the impurity elements and 
their respective contents should be included in the calculation, either explicitly, as is done in this 
example, or by selecting an appropriate base grade with a pre-defined impurity content for the 
calculation. 

Project File and License Information
 l Folder: Property Models → Titanium
 l File name: PM_Ti_02_Alloy_Strength_Ti-O.tcu

To run calculations with the Titanium Models requires a valid maintenance license plus a 
license for the TCTI (version 6 and newer) database. For some Property Models, additional 
recommendations for the database version to use is indicated in its description. Also see 
our website to learn more about the Titanium Model Library.

Visualizations

Many of our Graphical Mode examples have video tutorials, which you can access in a 
variety of ways. When in Thermo-Calc, from the menu select Help → Video Tutorials, or 
from the main My Project window, click Video Tutorials. Alternately,  you can go to the 
website or our YouTube channel.
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Open the example project file  to review the node setup on the Project window and the associated 
settings on the Configuration window for each node. For some types of projects, you can also adjust 
settings on the Plot Renderer Configuration window to preview results before performing the 
simulation. Click Perform Tree to generate plots and tables to see the results on the Visualizations 
window.

When you run (Perform) this example, it takes a few minutes for the calculations to 
complete.

Figure 2: The total hardness vs O (in mole %) is shown with data from [1950Fin] and [1973Oka].
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Console Mode Layout

By default the first time you launch Thermo-Calc it opens in Graphical Mode. After this, the 
mode defaults to the most recent one. You can switch back and forth between modes. To 
open the Console Mode interface, click Switch to Console Mode on the toolbar. 

Keyboard Shortcuts to Navigate Between Tabs

The Console Mode User Interface

The currently selected window is called the active window. This has a darker title bar than 
the other windows. The windows are:

 1. Console, with a Console 1 tab.

 2. Console Results, with a Results Console 1 tab as well as a sub-tab (Plot 1), which is 
what is displayed in the window in the figure.

 3. Event Log.

Console Tabs

By default, the tabs are side-by-side. You can toggle to view the tabs 
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 l Click the  button to display both windows side by side where you can see the 
information in all windows at the same time.

 l Click the  button to stack the windows  top to bottom where you can see the 
information in all windows at the same time.

 l Click the  button to return to the default layout with tabs side by side and the focus 
on one window at a time.

How to Open Console Windows

Open a specific window from the Window main menu, or select Reset Windows to return to 
the default window layout. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 5 of 622



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 6 of 622

Console Window and Tabs

By default the Console window is on the left-hand side of the console. This is where you 
enter commands and within the window there can be several Console tabs open at a time. 
When you right-click the tab, there are options available from the menu to edit the tab 
properties, open and close tabs, and view, copy, and save a command history.

Edit the Console Tab Properties

Right-click any tab and select Properties from the menu to edit the Console tab properties.

Global Settings: Console Mode Default Appearance 

 l Change the tab name in the Console name field to make it more descriptive for the 
work you are doing.

 l Increase or decrease the buffer size.
 l Edit fonts, sizes, and colors for various Console window text. Click Modify next to 

System output, Command prompt, and User input. 
 l Click Modify next to Background color to change the color for each Console window. 
 l To globally set the Default directory file path to where the various file types are 

saved, go to Tools > Options > Console Mode.

 Open and Close Console Tabs

There are options to add a New Console tab, Close one, or Close all tabs in the Console 
window.
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Open One or More Console Tabs
 l Click the  button.
 l Press <Ctrl+T> when the Console window is active.
 l Right-click a tab header and select New Console.

Close One or More Console Tabs
 l Click the X button.
 l Press <Ctrl+W> or <Ctrl+F4>.
 l Right-click the tab header and select Close.
 l To close all tabs except one, right-click the header of the tab you want to keep and 

select Close Other.
 l To close all tabs and open a new one, right-click the header of any tab and select 

Close All.

Copy all Text to Clipboard

 l Right-click any tab and select Copy All Text to Clipboard from the menu. Paste in a 
text editor as required. 

 l The shortcut for this command is to press <Ctrl+Alt+C> (Windows and Linux) or  
(macOS).

View, Copy, or Save a Command History

There are commands available to enter at the command line prompt as well as other ways 
to save or copy the full set of commands in any Console window tab.

Copy Commands to a Clipboard
 l Press CTRL + Shift + C in the window or tab where you want to copy the command 

history. Paste in a text editor as required. 
 l Right-click any tab and select Command History from the menu to open the 

Command History window. Then click the Copy button ( ) to copy all the 
commands to the clipboard. Paste in a text editor as required.
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 l Right-click any tab and select Copy Command History to Clipboard from the menu. 
Paste in a text editor as required. 

 l The shortcut for this command is to press <Ctrl+Shift+C> (Windows and Linux) 
or  (macOS).

View or Save Commands to a Macro File

Right-click any tab and select Command History from the menu to open the Command 
History window. Then click the Save button ( ), enter a file name and path to save all the 
commands in a .TCM file format.

Enter Commands to View the History
 l To scroll through the last twenty commands used, at the command line prompt enter 

two exclamation marks (!!) and press <Enter>. 
 l To repeat the last n commands, at the command line prompt enter ! followed by the 

number of previous commands to be repeated. 
 l !<text>      executes the most recent command starting with <text>. The < > is not 

entered at the prompt.
 l !*<n> or !*<text> makes the command available for editing before execution. The < 

> is not entered.
 l To scroll through previous performed commands, use the Up (↑) or Down arrow (↓) 

keys.
 l To read more information about the command history functionality in Thermo-Calc, 

enter ! ? at the command line prompt. 
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Results Window in Console Mode

By default, the Console Results window is on the right-hand side of the screen. This is where 
plotted diagrams display. Each Console has its own Results tab in the Console Results 
window. All the plots and tables generated are presented in the Results tab. 

 l To open new Plot tabs press <Ctrl+Shift+T> or click the add  button.
 l To open a new Plot tab for the currently active Console tab, press <Ctrl+Shift+T>. To 

close the Plot tab, press <Ctrl+Shift+W> or <Ctrl+Shift+F4>.
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Event Log Window

The Event Log window is closed by default. Information about what Thermo-Calc is 
processing or doing is in blue text, an error  message is in red text, and caution/warning 
information is in yellow text.

Global Settings

 l To open the Event Log window: Click the Event Log window once to expand it or 
select it from the Window → Event Log  menu. Double-clicking the window 
maximizes it.

 l To clear all messages in the window, right-click in the text area and select Clear.
 l To specify the level of detail in the Event Log, open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> 

on the keyboard.

 l then click the General tab and set the Log level slide bar to anything between Debug 
(most detailed) and Error (least detailed).
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Keyboard Shortcuts to Navigate Between Tabs

Use keyboard shortcuts to move between the tabs available in the Console and Results 
windows.

Windows
 l Press CTRL + TAB to move forward sequentially through each open tab. When you 

are focused on the Console window, you move forward simultaneously through the 
Console Results tabs, e.g. If you are on Console 1 and press CTRL + TAB, you move 
forward to Console 2 and Results Console 2 and so forth.

 l Press CTRL + SHIFT + TAB to move back through the open tabs. This is useful if you 
have multiple tabs open, otherwise you can use the CTRL + TAB to cycle through the 
windows.

 l Press CTRL + [tab number 1 to 9] to move directly to the numbered tab. For example, 
if you are focused on Console 1 and want to move to Console 3, press CTRL+3 and 
the focus jumps to that tab. 

The tab number corresponds to the order of the tabs, not necessarily the 
name. That is, if Console 4 is first, then it is what is highlighted when 
CTRL + 1 is used.

For EXAMPLE, press CTRL + 3 on the keyboard to move focus from Console 1 to 
Console 3.
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When you are focused on the Console Results window and use any of the 
shortcuts this only moves you through the open tabs on this window.

Linux and macOS

The same Windows keyboard shortcuts are used but must be pressed twice to move 
forward and backward.
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Console Mode Workflow

Working with Thermo-Calc involves moving between different modules. The workflow 
differs depending on the type of calculation: 

 l If you want to perform a calculation using the POLY module, you typically first 
retrieve thermodynamic data in the DATA module, perform the calculation in POLY, 
and visualize the results in the POST module. It is possible to define a system directly 
in POLY using the DEFINE_MATERIAL and DEFINE_DIAGRAM commands.

 l If you want to calculate and plot a diagram using a response-driven module, such as 
POTENTIAL or SCHEIL, then you can go directly to that module. Response-driven 
modules prompt you to go through the steps to do the calculation and the required 
post-processing. These modules include BIN, TERN, POTENTIAL, POURBAIX, and 
SCHEIL. You typically end up in the POST module after having used a response-driven 
module. In the POST module you can modify the plots and save the diagram.

 l If you want to tabulate a chemical substance, phase, or reaction, go directly to the 
TAB module. 

The basic workflow is:

 1. You are in the SYS module when you start Thermo-Calc in Console Mode.

 2. In the DATA module define the system. Before performing a calculation, you must 
define the system and retrieve thermodynamic data. The data is retrieved from a 
database file (*.TDB or *.TDC).

 3. The data needed to describe a system is then sent to the GIBBS module. This data is 
accessed by the POLY module when you instruct it to perform calculations. 

 4. In the POLY module, perform the calculations.
 l In POLY, the conditions are set for an equilibrium calculation (temperature, 

pressure, system composition, etc.), then an equilibrium calculation is done. 
 l If you want to make a property or phase diagram, you set the conditions for a 

stepping or mapping operation and perform that operation. 
 l This generates data that can be used to plot a property diagram (if a stepping 

operation is performed) or a phase diagram (if a mapping operation is 
performed).
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 5. In the POST module plot and visualize your data.
 l If a stepping or mapping operation is performed, then you can go to the POST 

module and plot a property or phase diagram. 
 l The diagram can be plotted quickly using default settings, but you can also 

modify which variables to plot of the diagram axes and change the 
appearance of the diagram. 

 l You can save the diagram either as a plain text file with data about all the 
coordinates or as an image file.
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Defining a System in Console Mode

Defining a system means to select the chemical components and to retrieve thermodynamic 
data about those components from an appropriate database in order to do the calculations. 
You use database(s) with thermodynamic data and then define what system elements as 
components. Once the system is defined, you retrieve the system’s thermodynamic data 
from the database(s). 

 l If you use a response-driven module to perform your calculation, such as BIN or 
POURBAIX, then the module prompts you to select database(s) and define the 
system. 

 l When doing calculations in the POLY module, you typically have to manually select 
databases and define the system in the DATA module. However, it is also possible to 
define the system directly in POLY using the DEFINE_MATERIAL and DEFINE_DIAGRAM 
commands. 

Database (TDB) Module Commands

How to Define a System in Console Mode

 1. Go to the DATA (TDB) module. At the SYS prompt, use GOTO_MODULE and enter Data.

 2. Change the default database unless you directly specify the name of the database as 
a parameter to the command. Type SWITCH_DATABASE and follow the prompts.

The second part of the command prompt indicates the current default database. For 
example, if the prompt is TDB_TCFE10, then the current database is TCFE10.

 3. Use DEFINE_ELEMENTS followed by a list of the elements that you want in your 
system. (To list the elements that are available in your current database, use LIST_
DATABASE and choose Elements). For example, if you want to have Fe and C in your 
system, type:

DEFINE_ELEMENTS Fe C

 4. Use REJECT and choose Phases if you want to avoid retrieving any phases from the 
database. (To list the phases that are available in your current database, use LIST_
DATABASE and choose Phases. To list the phases that can form in the defined system, 
use LIST_SYSTEM and choose Constituent.) For example, if you do not want the 
graphite phase to be retrieved, you type:

REJECT PHASES GRAPHITE
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If the number of phases to include is much lower than the total number of phases, 
then it can be convenient to first Reject Phases * and then restore the phases to 
include using Restore Phases.

 5. Use GET_DATA to search the database and send the thermodynamic data about your 
system to the GIBBS workspace. 

At this point you can proceed to the POLY module (with GOTO_MODULE POLY). 
However, you may want to add elements, phases and species to the GIBBS 
workspace from other databases. If so, then proceed to the next step.

 6. Use APPEND_DATABASE to select the (additional) database from which you want to 
retrieve data. This command works exactly in the same way as the SWITCH_DATABASE 
command, with the exception that it does not reinitialize the DATA module and the 
GIBBS workspace, but instead appends or replaces the data that has already been 
retrieved with new data from the additional database.

 7. Define your elements and specify whether to reject and restore any phases. Do this 
in exactly the same way when using the SWITCH_DATABASE command (see steps 2 
and 3).

 8. Use GET_DATA to search the database and add the thermodynamic data to the data 
that already exists in the GIBBS workspace. 

 9. Use APPEND_DATABASE again if you want to add data from yet another database. 
When you have retrieved all the data you need, you can proceed to the POLY 
module.
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Console Mode Modules

Graphical Mode Activities vs Console Mode Modules 

Below are each of the available modules you access in Console Mode. Most of the modules 
have commands, some are the same no matter what module you are in (e.g. general 
commands like BACK. GO TO MODULE, EXIT, HELP and so forth). Other commands have different 
prompts based on the module you are in how you define the system and so forth. 

Most modules have several commands available. The exceptions are the 
BINARY, TERNARY, SCHEIL, POURBAIX and POTENTIAL modules which do not 
have any additional commands once you access the modules. These are 
response-driven modules that prompt you with a series of questions and then 
build the diagram automatically based on your responses.

System Utilities (SYS)

This is the module where you start. It also has several commands. Throughout the other 
modules there are some general commands, both of which are listed together. 

System Utilities (SYS) Commands

Gibbs Energy System (GES)

The Gibbs Energy System (GES) module is an important Thermo-Calc Console Mode module 
and consists of a comprehensive subroutine package for various thermochemical 
calculations. The module is interactively connected with all basic and advanced modules in 
Thermo-Calc and the add-on Diffusion Module (DICTRA). Most users will not directly use the 
GES module and commands unless you perform assessments.
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The GES module is in essence the Thermo-Calc calculation engine, sometimes 
referred to as the calculation core. When working in Graphical Mode you are 
using the GES calculation engine behind the scenes, whereas in Console Mode, 
and if you are performing assessments, you are directly interacting with the 
module. This is also applicable if you are working with any of the software 
development kits (SDKs).

About the Gibbs Energy System (GES) Module

Gibbs Energy System (GES) Commands

POLY3 (POLY) (Equilibrium)

With the equilibrium calculation module, POLY3, it is possible to calculate many different 
kinds of equilibria and diagrams, in particular multicomponent phase diagrams. 

The Equilibrium Calculation Module (POLY3)

POLY Module Commands

Database (TDB)

The Database module (full name is Database Retrieval) is where you select and retrieve 
various types of thermodynamic and kinetic information from the selected databases you 
are going to use for your system. Once you enter the module the short name is TDB.

Database (TDB) Module Commands

Defining a System in Console Mode

Also see the Database Manager User Guide and the available information for 
the specific databases.

POST - A  POLY3 Submodule

The POST module (post-processor) is a submodule to the POLY module and has its own set 
of commands. The TAB, BIN, TERN, POT, SCHEIL and POURBAIX modules use the POST 
module features as part of the automatic generation of the plots.
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Using the POST Module

POST Module Commands

Scheil  (SCHEIL) Simulations

The available Scheil-Gulliver solidification simulations are classic Scheil, Scheil with back 
diffusion in the primary phase, or Scheil with solute trapping. There are also configuration 
options available with fast diffusers for the classic and back diffusion models. 

There is also connectivity to the Diffusion Module (DICTRA) and homogenization 
where you collect data from a Scheil solidification calculation, which is then 
used as part of the kinetic homogenization simulation of segregated 
composition profiles. 

Scheil in Graphical Mode vs Console Mode

The Scheil with back diffusion  feature is only available for systems with 
diffusion data, i.e. this model requires the use of a mobility database.

In Thermo-Calc, the Scheil calculation allows the calculation of:

 l The solidification range of an alloy.
 l Depression of the solidus temperature due to segregation.
 l Composition of the last liquid to disappear in segregation pockets.
 l Phases formed on final solidification in segregation pockets.
 l The composition gradient in the primary solid phase(s) (segregation profile).
 l Solute trapping to simulate deviation from local equilibrium for the primary phase
 l Kinetic homogenization simulation of segregated composition profile (diffusion 

calculations)

About the Scheil-Gulliver Solidification Simulations

SCHEIL Module Commands
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Pourbaix Diagram (POURBAIX)

The POURBAIX module lets you construct Pourbaix diagrams and other types of property 
diagrams for heterogeneous interaction systems with aqueous solution phases. Once you 
have calculated the Pourbaix diagram, you can also use the saved results of the calculation 
(the POLY3-file), and make a property diagram based on stepping calculation. You can also 
plot additional diagrams based on the results of the same calculation, but with different axis 
variables than Ph and Eh.

About Aqueous Solutions and the Pourbaix Diagram 

Potential Diagram (POT)

The POTENTIAL_DIAGRAM module (short name, the POTENTIAL module) is a potential phase 
diagram calculation module. A potential diagram uses the activities of two major species in 
the gaseous mixture phase as mapping variables. 

About Potential Diagrams

Binary Diagram (BIN)

The BINARY_DIAGRAM module (short name, the BIN module) enables you to quickly 
calculate a simple binary  phase diagram. Binary phase diagrams are by far the most common 
found in the literature and calculated by computers. However, most real systems have more 
than two components and thus binary diagrams are more a kind of exercise in order to 
calculate more realistic phase diagrams.  

About Binary Phase Diagrams

Ternary Diagram (TERN)

The TERNARY_DIAGRAM module (short name, the TERN module) enables you to quickly 
calculate a simple ternary phase diagram. There are many types of ternary phase diagrams 
but perhaps the most common is the isothermal section. In this case, the temperature is 
constant, which means that the tie-lines are in the plane of the calculation. 

About Ternary Phase Diagrams
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PARROT (Optimization)

The PARROT module makes use of the GES module to handle the models of the various 
phases that might form in a multicomponent system, as well as of the POLY module to store 
and calculate complex heterogeneous equilibria.

PARROT Module Commands

Also see the Data Optimization User Guide.

Tabulation Reaction (TAB)

The TABULATION_REACTION (TAB) module can be used to tabulate thermodynamic 
functions of any type of substance, stoichiometric phase or solution phase, or reaction. The 
module can tabulate thermodynamic functions of pure stoichiometric phases or solution 
phases at fixed composition, as well as various kinds of partial derivatives for a pure 
stoichiometric phase or solution phase at a given composition.

About the Tabulation Reaction Module

Tabulation Reaction (TAB) Commands

Reactor Simulator (REACTOR) 
Simulate chemical reaction processes in several feed-forward steady-state stages or in 
several dynamic stages.

REACTOR (REACTOR_SIMULATOR) Commands

DICTRA Monitor (DICTRA) 

DICTRA Monitor (DICTRA) and DIC Parrot (optimization for DICTRA): These are available with 
the add-on Diffusion Module.
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Moving Between Modules and Submodules

To go to a specific module, you typically use GOTO_MODULE (or just GOTO) followed by the 
name of the module. For example, to go to the DATA module, type GOTO DATA.

The exceptions are the submodules POST and ED-EXP:

 l To go to the POST module, you must enter the POST command from within the POLY 
module or DICTRA module (if you have the add-on license). 

 l To go to the Edit Experiments module you must enter the ED-EXP command from 
within the PARROT module.

To go back to the previous module type Back. For example, if you are in the DATA module 
and entered it from the SYS module, when you type Back, you return to the SYS prompt. This 
command is also available to exit from the submodules POST and ED-EXP. 

Without a valid Thermo-Calc license, you cannot leave the SYS module. To enter 
the DICTRA and DIC_PARROT modules, you also need a valid Diffusion Module 
(DICTRA) license key.
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Entering Command Names or Abbreviations

The name of a command typically consists of terms linked with underscores, for example, 
LIST_EQUILIBRIUM. Note the following:

 l UPPER or lower case letters are OK. 
 l Hyphens (-) instead of underscores (_) are OK, e.g. LIST-EQUILIBRIUM.
 l You can abbreviate commands as long as it is unambiguous, e.g. when more than 

one command begins with LIST_, you need to type the next letter or word to 
distinguish between the commands.

 l Each word can be abbreviated e.g., L_E for LIST_EQUILIBRIUM. 

Examples

Command Name Abbreviation

CALCULATE_EQUILIBRIUM C-E

CALCULATE_ALL_EQUILIBRIA C-A

LIST_EQUILIBRIUM L-E

LIST_INITIAL_EQUILBRIUM LI-I-E

LOAD_INITIAL_EQUILBRIUM LO-I-E

LIST_PHASE_DATA CBCC L-P-D CBC

LIST_PHASE_DATA CEMENTITE L-P-D CEM

SET_ALL_START_VALUES S-A-SS-AL

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025 S-A-V 1 X(F,FE) 0 .89 .025

SET_START_CONSTITUENT S-S-C

SET_START_VALUE S-S-V

SET_AXIS_PLOT_STATUS S-A-P

Examples of how to abbreviate commands at the 
command line prompt in Console Mode.
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Command Name Abbreviation

SET_AXIS_TEXT_STATUS S-A-T-SS-A-TE

SET_AXIS_TYPE S-A-TY

SET_OPTIMIZING_CONDITION S-O-C

SET_OPTIMIZING_VARIABLE S-O-V

SET_OUTPUT_LEVEL S-O-LS-OU
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Using the Command Line Prompt

The command line prompt in the Console window tells you which module you are currently 
in. When Thermo-Calc is first opened in Console Mode, you are in the SYS module, which is 
indicated with the command line prompt SYS.

To use Console Mode, you type in commands at the command line prompt. The available 
commands depend on which module you are in. You can list the commands by typing ? at 
the prompt and then press  <Enter>.

Console Window and Tabs also includes information about saving or copying 
the Command history.

 l Moving Between Modules and Submodules
 l Entering Command Names or Abbreviations
 l Specifying Parameters
 l Wild Card Characters
 l Keyboard Shortcuts to Navigate Between Tabs
 l Working with the Console Mode Output 
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Main Menu Commands

In Console Mode you use commands to access these menu options.  If there is an 
equivalent command, it is listed below. 

The File menu and toolbar are reserved for Graphical Mode. The Tools, Window 
and Help menus are described in Menu, Toolbar, and Keyboard Shortcuts.

How to Open Files
 l In the SYS module: MACRO_FILE_OPEN
 l In the SYS module: OPEN_FILE

Opening Console Mode Macro Files

Drag and drop files into the Console window to open or run a macro, for 
example. File types that can be opened this way are macro files (*.TCM and 
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR, 
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the 
Diffusion Module (DICTRA). 

Save (Workspace)
This command depends on the module you are in. Type ? at the prompt to look for a 
command such as SAVE_GES_WORKSPACE (GIBBS module).

Exit
In any module: EXIT

Close
In the SYS module: CLOSE_FILE

Display License Info
In the SYS module: DISPLAY_LICENSE_INFO



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 28 of 622

Wild Card Characters

You can sometimes use the asterisk (*) as a wild card character to, for example, refer to all 
components, phases, or species, when showing calculated properties in the POLY module, or 
when you set axis variables for plotting diagrams in the POST module. 

When showing calculated properties in the POLY module, you can also use the dollar sign ($) 
to refer to all stable phases. 

For activity and/or chemical potential properties, the *and $ normally do not 
work properly as wild card characters.

Examples

These are examples of the wild card characters you can use to search commands at the 
command line prompt.

Command Action

SHOW_VALUE B(*) Lists mass (gram) of all components in the system.

SET_AXIS_VAR Y B(*) * Sets mass (gram) of all components in the system as Y-axis variable.

SHOW_VALUE MUR(*) Lists chemical potentials of all components in the system.

SET_AXIS_VAR Y ACR(*) * Sets activities of all components in the system as Y-axis variable.

SHOW_VALUE HM(*).T Lists heat capacities of all phases.

SET_AXIS_VAR Y GM(*) * Sets molar Gibbs free energies of all phases as Y-axis variable.

SHOW_VALUE TC($) Lists curie temperature of all stable phases.

SHOW_VALUE W(*,*) Lists mass fractions of all components in all phases.

SHOW_VALUE W($,*) Lists mass fractions of all components in all stable phases.

SHOW_VALUE W(FCC,*) Lists mass fractions of all components in the FCC phase.
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Command Action

SHOW_VALUE W(*,FE) Lists mass fractions of the Fe component in all phases.

SHOW_VALUE W($,FE) Lists mass fractions of the Fe component in all stable phases.

SHOW_VALUE Y(*,*) Lists site fractions of all species in all sublattices of all phases.

SHOW_VALUE Y($,*) Lists site fractions of all species in all sublattices of all stable phases.

SHOW_VALUE Y(*,*) Lists site fractions of all species in all sublattices of all phases.
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Working with the Console Mode File Types

For DICTRA Console Mode see File Formats in the Diffusion Module 
(DICTRA) User Guide

In Console Mode, Thermo-Calc uses different types of files, including:

 l Macro Files and Log Files both with the file extension *.TCM. Log files are created 
using the SET_LOG_FILE command.

 l Workspace Files in POLY (*.POLY3), GIBBS module (*.GES5), and the PARROT module 
(*.PAR).  (For the GIBBS module, this cannot currently be done with GES6).

 l Experimental Data Files (*.POP, *.DOP) are a type of workspace file available with the 
PARROT module and have the file extension of *.POP. In the Diffusion Module 
(DICTRA), you work with .DOP files instead of .POP. These .POP and .DOP files are 
referred to as experimental data files.

Another type of experimental data file with the *.EXP file extension are also 
generated when working with DATAPLOT. See About the DATAPLOT Graphical 
Language.

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

Drag and drop files into the Console window to open or run a macro, for 
example. File types that can be opened this way are macro files (*.TCM and 
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR, 
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the 
Diffusion Module (DICTRA). 
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Opening Console Mode Macro Files

The macro files (with the extension *.TCM) include comments, which you can 
either run in Thermo-Calc or open and read in a text editor. 

You can open the macro files (*.TCM or *.DCM files) in different ways. 

 l From the main menu,
 l Using a command, 
 l By dragging and dropping the file into the  Console window, or 

 l Navigate to the file location on your computer and double-click to open it. If you 
already have Thermo-Calc open, the macro opens in a new tab. Otherwise a new 
instance of Thermo-Calc is launched. 

If you are using the advanced pipe or redirect option (Technical Note: 
Pipe or Redirect Output Data from Console Mode) then a new instance 
of Thermo-Calc is always started.

 l You can also read the commands listed in the macro file using a text editor. 

If you only open and read the macro file in a text editor, you do not see the 
output that Thermo-Calc gives in response to the commands stored in the 
macro file. 

Opening a Macro from the Main Menu

To open a Thermo-Calc example macro file:

 1. Open Thermo-Calc.

 2. Confirm you are in Console Mode. If not, click the Switch to Console Mode  button.

 3. From the main menu, select File →  or Help → Examples Files.  The Console Mode 
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folder opens. 

 4. Open the Thermo-Calc folder to see the available examples contained in separate 
folders. 

For the Diffusion Module (DICTRA) examples (*.DCM macro files), open the 
Diffusion Module - DICTRA folder.

 5. In the folder, double-click the *.TCM file or click Open. 

 6. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the 
macro and produce a plot in the Console Results window.

Opening a Macro Using a Command

At the SYS prompt, type MACRO_FILE_OPEN and press <Enter>. In the file dialogue window 
that opens, navigate to and select the macro file to open. 

Drag and Drop a Macro File into the Console Window

For example, on your computer, navigate to the  examples folder. Drag the file from its 
location into the Thermo-Calc Console window. When you release (drop) the file, the macro 
starts running. Follow the prompts in the Console window i.e. keep pressing <Enter> to run 
the macro and produce a plot in the Console Results window.
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Drag and drop files into the Console window to open or run a macro, for 
example. File types that can be opened this way are macro files (*.TCM and 
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR, 
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the 
Diffusion Module (DICTRA). 
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Log Files

Log files with the file extension *.TCM are plain text files used to save a sequence of 
commands. Log files can be edited in a text editor.

 l To start saving your input into such a file, use SET_LOG_FILE in the SYS module, 
followed by the name of the file that you want to save your command sequence to. 

 l If you want to save the output in the log file as well, use SET_ECHO before the SET_
LOG_FILE command. Doing this is useful if you want use the log file later as a macro 
file.
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Macro Files

Macro files (with the file extension of either *.TCM or *.LOG) are plain text files used to save a 
sequence of commands that can be loaded and executed. Macro files can be edited in a text 
editor. When creating a command sequence, you add comments to the file by starting a line 
with @@.

Macro files include comments, which you can either run in Thermo-Calc or open and read in 
a text editor. 

If you only open and read the macro file in a text editor, you do not see the 
output that Thermo-Calc gives in response to the commands stored in the 
macro file. It is recommended you run the macro to view all the details.

How to Open a Console Mode Example Macro File

To open a Thermo-Calc example macro file:

 1. Open Thermo-Calc.

 2. Confirm you are in Console Mode. If not, click the Switch to Console Mode  button.

 3. From the main menu, select File →  or Help → Examples Files.  The Console Mode 
folder opens. 

 4. Open the Thermo-Calc folder to see the available examples contained in separate 
folders. 

For the Diffusion Module (DICTRA) examples (*.DCM macro files), open the 
Diffusion Module - DICTRA folder.
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 5. In the folder, double-click the *.TCM file or click Open. 

 6. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the 
macro and produce a plot in the Console Results window.

Macro File Commands

Action Command Description and Comments

To load a macro file
In the SYS module, MACRO_
FILE_OPEN followed by the 
name of the macro file.

Thermo-Calc starts the command sequence that the file 
contains.

Regain control of the 
console SET_INTERACTIVE End a macro file with this command to have control of 

the Console returned to you.

Add comments to a 
macro file

Start a line with @@, or 
enclose it between an @ (-
line and a @)-line. 

When lines are enclosed the software ignores them 
when running the macro.

Open a macro file MACRO_FILE_OPEN When creating the log file, you can make a macro file 
load up to five other macro files.

Nest macro files inside 
of each other

MACRO_FILE_OPEN

SET_INTERACTIVE

If a nested macro file ends with SET_INTERACTIVE, then 
Thermo-Calc resumes with the higher-level macro file at 
the command immediately following the MACRO_FILE_
OPEN command that loaded and executed macro file 
that has just been terminated. If a nested macro file 
doesn’t end with SET_INTERACTIVE (but with an end-of-
file character), then the console shuts down and the 
macro is stopped.

Macro File Control Characters

The @? character allows you to make a macro interactive by allowing input. At the @? 
character, which is placed where a parameter value or argument is normally put, 
Thermo-Calc prompts to input the value of a parameter or argument. You can enter a string 
immediately following the @? character. This string is presented to the user when prompted 
to enter the parameter value or argument. The entered value is used by Thermo-Calc as 
input to the command in question. For example, you can request the user to specify the 
temperature range of a stepping calculation by entering the following in a macro file:

SET_AXIS_VARIABLE 1 T @?Low-temperature-limit: @?High-temperature-
limit:
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You can also use up to nine variables in your macro file and prompt the user to enter values 
that can be assigned to these variables. Use the @#n character when you want to prompt the 
user to provide a value to the variable, where the n is a digit between 1 and 9. You can then 
use this value by with the ##n character. For example, you can request the user to provide 
the first element of a system by entering the following in the macro file:

@#3First-element?

You can then use this variable with the entering the character ##3 later in the macro file. For 
example, you can write:

SET_AXIS_VARIABLE 1 x(##3) 0 1,,,

Finally, there is the @& pause character. Thermo-Calc pauses and waits for input from the 
user when this pause character is read from a macro file. Inserting pause characters is useful 
if you want to allow the user to monitor what is happening when Thermo-Calc is running the 
macro.

Response-Driven Modules and Macros

Macro files that are created while you use a response-driven module begin with the module-
entering command (for example, Goto_Module Scheil) followed by a number of lines with 
responses to the module’s questions and requests. The file terminates with the commands 
POST or SET_INTERACTIVE (this command gives you back control of the Console). An empty 
line cannot be edited with any input rather than the default answer (to a specific question). 
Comment lines, commands to open other macro files, pause characters or input-controlling 
characters cannot be inserted between these empty lines (otherwise the response-driven 
module cannot be executed properly).
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Workspace Files

For DICTRA Console Mode see File Formats in the Diffusion Module 
(DICTRA) User Guide

Workspaces files  allow you to save all the data in your current workspace.  A workspace 
contains all the data, specified settings and the result of any calculations performed. The 
saved data includes original and modified thermodynamic data, the last set of conditions 
and options, and the results of any simulations. You use the command SAVE_WORKSPACES to 
create this file type, which is available in the POLY, GIBBS and PARROT modules. 

When in Thermo-Calc Console Mode these are the workspace file extensions:

 l POLY module (*.POLY3) 
 l GIBBS (GES) module (*.GES5)
 l PARROT module (*.PAR and *.POP)

For DICTRA in Console Mode, the PARROT module file extension is *.DOP.

The workspace has all the settings specified and the result of any stepping or mapping 
operations performed after using SAVE_WORKSPACES. Consequently, the command opens a 
workspace in which all data is saved which is generated after the SAVE_WORKSPACE command 
is executed. The saved data includes original and modified thermodynamic data, the last set 
of conditions and options, and calculation results. 

To load the data and calculation results of a workspace file, use the READ_WORKSPACES 
command available in the POLY module. The file can be used for calculation in POLY, 
visualization in POST, or data manipulation in GES. You are also given the option in the 
POURBAIX and SCHEIL modules to open a previously saved workspace file. This allows you to 
make new POURBAIX or SCHEIL calculations on the same chemical system as before but with 
different temperature, pressure, and composition conditions, or to plot new property 
diagrams based on the previous calculations.

A reminder that Linux and macOS are case sensitive; when applicable ensure 
you enter file extensions with capital letters.
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Drag and drop files into the Console window to open or run a macro, for 
example. File types that can be opened this way are macro files (*.TCM and 
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR, 
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the 
Diffusion Module (DICTRA). 

Links to Workspace Commands

POLY module
 l READ_WORKSPACES
 l SAVE_WORKSPACES

Gibbs (GES) module
 l READ_GES_WORKSPACE
 l READ_WORKSPACES
 l SAVE_GES_WORKSPACE
 l SAVE_WORKSPACES

PARROT module
 l READ_PARROT_WORKSPACES
 l SAVE_PARROT_WORKSPACES

ED-EXP module (submodule to PARROT)
 l READ_WORKSPACES 
 l SAVE_WORKSPACES 

Reactor module
 l READ_WORKSPACE
 l SAVE_WORKSPACES
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Important Information About Map and Step Commands and the Save_
Workspaces Command

A STEP or MAP command automatically saves the workspace with the most 
recently specified name. Do not use the SAVE_WORKSPACES command after a 
MAP or STEP command.

The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE 
command. You can append several results obtained by sequential STEP or MAP calculations 
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping 
this in mind is important and useful particularly for calculating various isothermal (or 
isoplethal) sections and plotting them on the same diagram in a single Thermo-Calc run.

To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.
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Editing the Default Console Directory

You can add a startup parameter to a shortcut when launching Thermo-Calc on any of the 
platforms. When you launch the revised shortcut, the file path is set to a user-defined 
default directory. An example of why you might want to have a custom directory path is if 
you use batch projects or if you have macro files for batch jobs.  The custom directory file 
path can also be viewed from within Console Mode.

The shortcut is only valid throughout the existing session; it is not saved as a 
default. Each time you want to use this file path you must launch Thermo-Calc 
from the customized shortcut.

The following uses Windows for the example.

How to Set up the Default Console Directory

 1. Right-click a shortcut to Thermo-Calc and click Properties. 

 2. In the Thermo-Calc 2025a Properties dialog, Target field, add the following to the 
end of the string: –r plus the “path to the default directory”. Include a space between 
the –r and path, and use quotation marks around the full file path. A simple example: 

-r “C:\Thermo-Calc_Macro_Files”
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 3. Click Apply and OK.

 4. Launch Thermo-Calc from the shortcut where you added the parameter. You can 
confirm that it is set correctly from within Thermo-Calc.

How to View the File Path in Thermo-Calc

 1. Launch Thermo-Calc from the short cut where you added the parameter.

 2. In Console Mode, right click the Console window and choose Properties.
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 3. In the Console Properties window the Default directory section displays the custom 
file path. This default is set in the Options window, Console Mode section.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press 

<⌘> on the keyboard.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 46 of 622

Experimental Data Files (*.POP, *.DOP)

There is also another type of experimental data file (*.EXP) generated when 
working with DATAPLOT. See About the DATAPLOT Graphical Language.

If you are using Graphical Mode, the Experimental File Reader activity node is 
used to plot experimental data on one or more plots.

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

In order to conduct an assessment for a system, the experimental data is described with a 
syntax, which is similar to the way that one calculates an equilibrium in the POLY module or 
you edit an experimental point in the ED_EXP module. Similar to a Thermo-Calc macro file 
(*.TCM), an experimental data file (i.e. the *.POP or *.DOP file) is a basic text file and can be 
opened and edited by any text editor. For this reason, a *.POP or *.DOP file is not hardware 
dependent.

A POP or DOP file consists of various commands from the POLY and ED_EXP modules, as well 
some special commands which can only be used in such experimental data files. Various 
experimental information can be inputted in an *.POP or *.DOP file as different tables; the 
same type of experimental data are usually documented in the same table (see below).

A *.POP or *.DOP file is used in the PARROT module to provide experimental information for 
the optimization process, and is checked by a syntax checker when the PARROT command 
COMPILE_EXPERIMENTS is proceeded.

The special commenting identifier, i.e. a dollar sign $ which starts a line, is used to document 
comment lines at any position in a *.POP or *.DOP file. You may remember that this feature 
is universally the same as in almost all kinds of text files in Thermo-Calc software, e.g. in 
*.TDB, *.DAT, *.TCM, *.POP/*.DOP and *.EXP files. Such a sign and all information 
afterwards in the same comment line is skipped and ignored by the syntax checker. 

Many POLY and ED_EXP commands can be directly used in a POP or DOP file. But there are 
some differences with the set of POLY or ED_EXP commands, and some specially designed 
commands as described in this topic can only be used in the *.POP or *.DOP files.

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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Frequently Used POLY Commands 

Most of the commands in the experimental data file are the same as in the POLY module. 
The most frequently used are listed below:

The last command in an *.POP or *.DOP file must always be the SAVE 
command.

 l CREATE_NEW_EQUILIBRIUM
 l CHANGE_STATUS
 l SET_CONDITION
 l SET_REFERENCE_STATE
 l ENTER_SYMBOL
 l SAVE_WORKSPACES

Less Often Used POLY Commands

Other legal commands from the POLY module that are used less often are:

The DEFINE-COMPONENTS command must be always used as the first 
command in an *.POP or *.DOP file, as it automatically reinitiates the whole 
workspace.

 l DEFINE_COMPONENTS
 l EVALUATE_FUNCTIONS
 l SET_ALL_START_VALUES
 l SET_NUMERICAL_LIMITS
 l SET_START_VALUE
 l ADVANCED_OPTIONS
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Frequently Used Edit Experiments (ED_EXP) Commands

Most of the special commands for the ED_EXP module are also often used in an *.POP or 
*.DOP file. For example:

 l EXPERIMENT
 l EXPORT
 l IMPORT
 l LABEL_DATA
 l SET_ALTERNATE_CONDITION
 l SET_WEIGHT

Do not use these Edit Experiment (ED_EXP) Commands

The following special ED_EXP commands are illegal and should not be used in 
any *.POP or *.DOP file:

 l COMPUTE-ALL-EQUILIBRIA
 l MAKE-POP-FILE
 l READ (READ-BLOCK OR READ-WORKSPACE)
 l TRANSFER-START-VALUES
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About the Gibbs Energy System (GES) Module

The Gibbs Energy System (GES) module is an important Thermo-Calc Console Mode module 
and consists of a comprehensive subroutine package for various thermochemical 
calculations. The module is interactively connected with all basic and advanced modules in 
Thermo-Calc and the add-on Diffusion Module (DICTRA). Most users will not directly use the 
GES module and commands unless you perform assessments.

The GES module is in essence the Thermo-Calc calculation engine, sometimes referred to as 
the calculation core. When working in Graphical Mode you are using the GES calculation 
engine behind the scenes, whereas in Console Mode, and if you are performing 
assessments, you are directly interacting with the module. This is also applicable if you are 
working with any of the software development kits (SDKs).

The objective of the GES module is to provide a unified set of subroutines to be used in any 
application program that needs thermochemical data. All kinds of thermodynamic models 
for various types of substances are implemented. However, most model-dependent features 
are hidden inside the module, and the application programmer can use a standardized set of 
subroutines, i.e. using the Thermo-Calc SDKs such as TC-Python, TQ-Interface, and 
TC-Toolbox for MATLAB® to calculate the integral Gibbs energy or any partial derivative 
thereof for each phase at any composition, temperature and pressure.

There are subroutines to analytically calculate the first and second partial derivatives of 
integral Gibbs energy with respect to any variable. You can enter and modify phase 
descriptions, model connections, basic thermodynamic parameters, and so on. 

POLY and all other basic and special modules, as well as the add-on Diffusion Module 
(DICTRA), interactively call the subroutines within the GES module to calculate any 
thermodynamic quantities.

Calculation Engine: GES5 vs GES6 

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. However, not all GES5 functionality is implemented in GES6. In such 
cases (except for  the POURBAIX module), GES6 falls back silently and uses 
functionality from GES5 in the background. 
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To globally set the default from GES6 back to GES5, go to the Tools → Options 
→  Global General Settings tab and click Version 5 for the Preferred Gibbs 
Energy System setting. This is useful if you are using the POURBAIX module 
(aqueous solutions), or if you have a custom database that is not compatible 
with GES6. The SET_GES_VERSION Console Mode command can also be used to 
change GES versions for a single Thermo-Calc session.  

Contact Thermo-Calc Software AB at info@thermocalc.com for more 
information about the changes or if you encounter any issues you think are 
related to the new version of the calculation engine. 

mailto:info@thermocalc.com
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The Equilibrium Calculation Module (POLY3)

An equilibrium describes what the composition of the end state of a system is, given a full 
specification of state variables such as temperature, pressure, initial composition, system 
size, etc. An equilibrium calculation is normally done in POLY-3 according to the Global 
Minimization Technique, which ensures that the most stable minimum under the specified 
conditions is computed. 

For an equilibrium calculation to be performed, the state variables must all be set as 
conditions for the calculations. Such conditions include, for example, temperature, pressure, 
and system composition. When you calculate an equilibrium in the POLY module, you have 
to set these conditions manually. 

Knowledge of the thermodynamic equilibrium is an important factor for understanding 
properties of materials and processes. With a database of thermodynamic model 
parameters, it is possible to predict such properties and also to obtain driving forces for 
diffusion-controlled phase transformations and other dynamic processes.

With the equilibrium calculation module, POLY3, it is possible to calculate many different 
kinds of equilibria and diagrams, in particular multicomponent phase diagrams. 

Different types of databases can be used with the POLY module, and it can be used for alloys 
or ceramic systems, as well as gaseous equilibria, aqueous solution involved heterogeneous 
interaction systems. Up to 40 elements and 1000 species can be defined into a single system  
for equilibrium calculations.

All normal thermodynamic state variables can be used to set as conditions in calculating 
equilibria, and as axes in plotting diagrams. You can set the composition or any property of 
an individual phase as a condition. Any state variable can be varied along an axis in order to 
generate a diagram. During calculations of a diagram, complete descriptions of all calculated 
equilibria are stored, and in the diagram any state variable can be used as an axis.

The Global Minimization Technique is used to ensure that the present minimum in an 
equilibrium calculation is the most stable minima for the specified conditions. This  is based 
on the traditional GEM (Gibbs Energy Minimization) technique.  

A direct global minimization can be performed on conditions: N, n(comp), B, b(comp), w
(comp), x(comp), T, and P, but not when combined conditions as e.g. w(a)-3*w(b)=1 are 
used or when an activity or potential condition is used. For all other types of conditions 
where regular minimization converges, Indirect Global Minimization, i.e. global test and 
corrections, if necessary, are performed until the lowest minimum is found.

 l Direct Global Minimization: From the mesh of Gibbs energy, find the set of grid 
points that gives the lowest energy solution under the specified conditions. This set 
of grid points provides starting combination of phases and their constitutions for 
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regular minimization to find the exact equilibrium solution. This solution is then 
subject to a global test as described below.

 l Indirect Global Minimization: Under certain conditions, a direct approach is 
impossible. In this case, regular minimization is performed first and then a check is 
performed in order to see if the found local minimum is a global one by checking if all 
grid points are above the equilibrium Gibbs energy plane. If not, then recalculate by 
including these grid points until no grid point is above the equilibrium Gibbs energy 
plane from the previous step.

The full-scale and full-scope usage of the Global Minimization Technique has been extended 
from for only single-point calculations for all types of calculations (of single-points, property 
diagram stepping and phase diagram mapping)in Thermo-Calc.

The use of Global Minimization Technique may increase the computation time. The main 
cost in time comes from the calculation of Gibbs energy at each grid point generated by 
properly meshing the composition space for each entered phase. An additional (but much 
smaller) cost in time comes from finding the set of grid points in the above mesh that give 
the lowest energy solution. This solution is where POLY starts its ordinary minimization. 
When POLY has found an equilibrium, the equilibrium Gibbs energy surface is compared to 
the mesh to assure that no grid point is below the surface, i.e. a global minimization has 
been reached.

Global minimization is performed by default in single-point or stepping or mapping 
equilibrium calculations. 

Together with the PARROT module, the POLY module is also used for critical assessment of 
experimental data in order to develop thermodynamic databases. The POLY module uses the 
Gibbs Energy System (GES) for modeling and data manipulations of the thermodynamic 
properties of each phase.

Setting Conditions for Equilibrium Calculations

Setting a condition normally involves giving a single state variable a specific value. For 
example, you can set the temperature to 1273.5 Kelvin (T=1273.5). Alternatively, setting a 
condition can involve giving a linear expression with more than one state variable a specific 
value. For example, you can set the mole fraction of the S component to be the same in the 
liquid and the pyrrohotite phases (X(LIQ,S)-X(PYRR,S)=0).
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The number of state variables that need to set is determined by the Gibbs Phase Rule. 
Typically, the state variables to give values to are:

 l temperature (in K)
 l pressure (in Pascal)
 l system size in number of moles (in mole) or mass (in grams)
 l the fraction of each component (in number of moles or mass)

If you fix the phase of the equilibrium and all but one of the state variables, you can discover 
the value of the other state variable at equilibrium.

It is possible to specify a set of conditions that does not have any equilibrium and the 
program detects this by failing to reach equilibrium during the calculation. 

State VariableS

The following table lists some of the available state variables you can use to set conditions:

State Variable SET_CONDITION Parameter

temperature in the system (in K) T
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State Variable SET_CONDITION Parameter

pressure in the system (in Pascal) P

system size (mole number in moles) N

system size (mass in grams) B 

number of moles of a component in the system N(<component>)

mole fraction of a component in the system X(<component>) 

mass fraction of a component in the system W(<component>) 

activity of a component in the system ACR(<component>)

chemical potential of a component in the system MUR(<component>)

mole fraction of a component in a phase X(<phase>,<component>)

mass fraction of a component in a phase W(<phase>,<component>) 

activity of a species referred to a phase at ambient temperature and 
pressure ACR(<species>,<phase>)

chemical potential of a species referred to a phase at ambient 
temperature and pressure MUR(<species>,<phase>)

enthalpy in the system (in J) H

enthalpy of a phase (in J/mol) HM(<phase>)
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Calculating an Equilibrium

This topic explains how to calculate an equilibrium in POLY. To calculate an equilibrium 
means to calculate the equilibrium composition of your system, given a full specification of 
conditions that reduce the degrees of freedom of the calculation to zero.

If you are running a network client installation of Thermo-Calc and cannot enter 
the POLY module, this may be because all the license instances on that the 
license server makes available have been checked out. 

POLY Module Commands

 1. Define your system.

Defining a System in Console Mode

 2. Go to the POLY module. At the SYS prompt, type GOTO_MODULE and enter POLY.

 3. Use SET_CONDITION followed by conditions and value assignments to set the 
conditions of your calculation. For example, to set temperature, pressure, initial 
composition and system size for a Fe-Cr-C system, you might enter the following:

SET_CONDITION T=1200 P=1E5 W(CR)=0.18 W(C)=0.0013 N=1

This sets the temperature (T) to 1200 K, the pressure to 1 bar (100,000 Pascal), the 
mass fraction of Cr to 18 mole percent, the mass fraction of C to 0.13 weight percent, 
and the total amount of material to 1 mole. The fraction of Fe in the system is 
calculated from the fractions of Cr and C. You have to set the fraction of all the 
components in your system except one.

 4. Use COMPUTE_EQUILIBRIUM to run the calculation.

 5. Use LIST_EQUILIBRIUM to see the results of the calculation.
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Calculating an Equilibrium with a Fixed Phase

There are many ways to calculate equilibriums in Thermo-Calc. The following is one 
example. 

You can calculate an equilibrium that has a certain amount of a certain stable phase. Use 
CHANGE_STATUS and choose Phase to specify the phase and the amount of that phase (in 
normalized mole number) that you want to set as fixed. For example, if you want to find out 
at what temperature a system starts to melt, enter the following:

CHANGE_STATUS PHASE LIQUID=FIX 0

You must leave the state variable whose equilibrium value you are interested in unspecified. 
However, if you have already specified that state variable, you can make it unspecified again 
by using SET_CONDITION and set that state variable to NONE. For example, if you have given 
temperature a value, you can type: 

SET_CONDITION T=NONE

The calculated equilibrium includes the value of the unspecified variable at which the 
equilibrium enters the phase that is fixed.

For an example where an equilibrium is calculated with a fixed phase, see 
Console Mode example tcex07. 
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Calculating an Equilibrium with Suspended or Dormant Phases

You can calculate an equilibrium under the assumption that one or several phases are 
SUSPENDED or DORMANT using CHANGE_STATUS and choose Phase. For example, to specify that 
all phases except one should be suspended, you can first suspend all phases and then enter 
a single phase in the following way:

CHANGE_STATUS PHASE *=SUSPENDED
CHANGE_STATUS PHASE FE_LIQUID=ENTERED

For an example where this is done, as well as where the status of phases is set 
to be dormant, see the Single Equilibrium Calculation Examples.
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Property Diagrams
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Calculating Several Properties in the Same Diagram 65
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About Property Diagrams

When you calculate and plot a property diagram, there is only one independent state 
variable. Many different properties can be plotted as a function of this independent variable. 
For example, if the independent state variable is temperature, then the mole fractions of all 
phases can be plotted as a function of temperature. Or the composition of a specific phase 
may be plotted relative to temperature, or the activity of a component in the system as a 
whole or in a specific phase may be plotted relative to it.

A property diagram is plotted based on a series of equilibria that is computed while the 
value of one state variable is varied between a minimum and a maximum value. This 
variable is referred to as the stepping axis variable. In Thermo-Calc, first calculate one initial 
equilibrium, and then new equilibria are calculated at incremental steps in both directions 
on the stepping axis from the initial equilibrium. This continues until the stepping operation 
has covered the length of the axis between a minimum and a maximum value that is 
specified. 

For an example of the calculation of a property diagram,  see  tcex08.
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Calculating and Plotting a Property Diagram

This topic explains how to calculate a property diagram in POLY. To calculate a property 
diagram means to calculate a series of equilibria while the value of the stepping axis variable 
varies between a minimum and a maximum value. With the exception of the stepping axis 
variable, all the state variables that you set when you calculate the initial equilibrium retain 
the values when the new equilibria are calculated. 

POLY Module Commands

 1. Calculate an initial equilibrium in the POLY module.

 2. Use SET_AXIS_VARIABLE to set the axis variable, the minimum and the maximum 
stepping variable values and the step length. The first parameter of SET_AXIS_
VARIABLE is the axis number. Since a property diagram only has one axis variable, this 
is set to 1. For example, if you want to set the axis variable to temperature, and 
calculate an equilibrium at every 50 K between a minimum temperature of 100 K and 
a maximum temperature of 2000 K, enter

SET_AXIS_VARIABLE 1 T 100 2000 50

An axis variable must be a state variable that is set when you calculated 
the initial equilibrium. For example, if you set the fraction of a 
component in number of moles, then you cannot set the mass fraction 
of this component as an axis variable. Also, the minimum stepping 
variable value must be smaller than, and the maximum value larger 
than, the value that you set the state variable to when calculating the 
initial equilibrium.

 3. Use STEP_WITH_OPTIONS and choose Normal to perform the stepping operation. 

The phase regions are listed along the stepping axis, the phases contained in each 
region, and the number of equilibria calculated in that region. Each region is defined 
by the phases it contains. 
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The number of equilibria calculated is not just the number of steps that 
are performed according to the step length and the minimum and 
maximum values on the axis variable. This is because Thermo-Calc 
calculates extra equilibria when a new phase is discovered in order to 
determine the phase region boundary more precisely.

 4. To plot the diagram,  open the POST module and then use PLOT_DIAGRAM. By default, 
the X-axis represents the stepping axis variable and Y-axis represents the sum of the 
mole fractions of all phases (NP(*)). 
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Calculating a Property Diagram One Phase at a Time

There are many ways to calculate property diagrams in Thermo-Calc. One example is where 
you can calculate a property diagram with a separate stepping operation being performed 
for each phase at a time in its default most stable composition (the major constitution). This 
is useful if you want to create a property diagram for a heterogeneous system with both 
ordered phases and their disordered pairs.

To calculate a property diagram one phase at a time, use STEP_WITH_OPTIONS and when 
prompted choose One_phase_at_time to perform the stepping operation. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 65 of 622

Calculating Several Properties in the Same Diagram

There are many ways to calculate property diagrams in Thermo-Calc. The following is 
another example. If you perform several stepping calculations after each other, the results 
of these calculations are all saved in your workspace file. This allows you to the following:

 l Calculate (and then plot) missing parts of a specific property inside the first property 
diagram. These parts are calculated inside the range of the stepping variable with a 
different control condition.

 l Calculate (and then plot) two or more sets of a specific property on the same 
property diagram for the same system. These can be calculated under different 
control conditions with stepping operations being performed across the same 
stepping axis variable range.

 l Calculate phase boundary lines and then plot them in a corresponding phase diagram 
for the same system. This can be especially useful for some defined secondary phase-
transformations. For example, if you want to find the phase boundary between BCC_
A1 and BCC_B2, or the equal-Gm for two specific phases, or the equal-fraction or 
equal-activity for two specific phases of a certain species, then this can be useful.

Unless you have opened a new workspace file previously using SAVE_WORKSPACES , the 
results of the stepping calculations are saved in a RESULT.POLY3 file. To save the results of 
several stepping calculations in a file different from the workspace file that your results are 
currently saved to, then use SAVE_WORKSPACES before you perform the first stepping 
calculation.

SAVE_WORKSPACES overwrites and deletes the results of all previous stepping 
calculations.

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.
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Phase Diagrams

In this section:

About Phase Diagrams 67

About Binary Phase Diagrams 69

About Ternary Phase Diagrams 70

About Quasi-Binary and Quasi-Ternary Phase Diagrams 72
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About Phase Diagrams

Phase diagrams have two or more independent axis variables. Any state variable that has 
already been set can be used as the mapping variable for a mapping calculation and then as 
the axis variable for a phase diagram. From a mapping calculation, many types of phase 
diagrams can be plotted, with one of the mapped variables as one axis variable, and with 
other mapped variables or any varied property (state or derived variables) or entered 
symbol (variables, functions or table values) as the other axis variables.

All phase diagrams consist of zero phase fraction lines. There are two distinct types of phase 
diagrams: those with the tie-lines in the plane of the diagram and those where the tie-lines 
are not in the plane. The former includes binary phase diagrams and ternary isotherms. The 
latter includes more general isopleth diagrams with one or more fixed extensive variables 
(normally, this is a composition). 

 l The BIN and TERN modules calculate binary and ternary phase diagrams. 
 l The POTENTIAL and POURABIX modules calculate the more general isopleth 

diagrams and other related diagrams.

The following topics describe how to calculate the types of phase diagrams in the POLY_3 
module. In POLY, you can calculate phase diagram for systems with up to 40 components 
and with thousands of phases. You can combine activity conditions and fixed phase status 
and fraction conditions in any way. Thermo-Calc can calculate any arbitrary 2D section 
through composition space. 

There is no guarantee that the conditions set will result in a calculation that 
reaches an equilibrium. 

Binary Phase Diagram Examples

Ternary Phase Diagram Examples

Potential Diagram Example

Pourbaix Diagram Examples
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Calculating and Plotting a Phase Diagram

This topic describes how to calculate a phase diagram in the POLY module. 

POLY Module Commands and POST Module Commands

 1. Calculate an initial equilibrium in the POLY module. 

 2. Use SET_AXIS_VARIABLE to set the first axis variable, its minimum and maximum 
mapping value and the length of each incremental step on this axis. The first 
parameter of SET_AXIS_VARIABLE is the axis number and is set to 1. For example, 
suppose you want the mass fraction of C as your first axis variable. You want it to 
vary between 0 and 0.1, with the length of each incremental step being no more 
than 0.002. Then enter:

SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002

An axis variable must be a state variable that is set when you calculated 
the initial equilibrium. For example, if you set the fraction of a 
component in number of moles, then you cannot set the mass fraction 
of this component as an axis variable. 

 3. Use SET_AXIS_VARIABLE to set the second axis variable and specify its minimum, 
maximum, and step length values. The axis number is set to 2. For example, suppose 
you want temperature as your second axis variable and you want it to vary between 
900 K and 1900 K, with an incremental step of 25 K. Then enter:

SET_AXIS_VARIABLE 2 T 900 1900 25 

 4. If you want more than two axis variables, then use SET_AXIS_VARIABLE until you have 
set all the axis variables. You can set up to five axis variables. Axis variables 3, 4 and 5 
must be set temperature, pressure or to the chemical potentials of components.

You may want to save your workspace with SAVE_WORKSPACES  before you perform 
the mapping calculation. This saves the axis variables you have set. However, it 
overwrites the results of any previous stepping or mapping calculations done.

 5. Use MAP to perform the mapping calculation. The console lists the phase region 
boundaries and the phases contained on one side of each boundary.
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 6. To plot the diagram, use POST to open the POST module and then use PLOT_DIAGRAM. 
By default, the X-axis represents mapping axis variable 1 and the Y-axis represents 
mapping axis variable 2.

About Binary Phase Diagrams

Binary phase diagrams are by far the most common found in the literature and calculated by 
computers. However, most real systems have more than two components and thus binary 
diagrams are more a kind of exercise in order to calculate more realistic phase diagrams.

You can calculate many types of binary phase diagrams with POLY, but the traditional one 
has one composition axis and the temperature on the other axis. This is calculated by first 
specifying a single equilibrium by setting conditions such as

SET_CONDITION T=1200, P=1E5, W(C)=.02, N=1

This means that the temperature should be 1200 K, pressure 1 bar, mass fraction of C is 0.02 
(i.e., 2 weight percent) and the system contains one mole of atoms. Note that one does not 
set a condition on the amount of the second component. This is simply taken to be the rest 
of the system.

After setting these conditions one can calculate the equilibrium by giving the command:

CALCULATE_EQUILIBRIUM

When the calculation has converged, one continues by setting the axes for the diagram 
calculation. In most cases, one is interested in the complete composition range but the 
temperature range may vary.

SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002

SET_AXIS_VARIABLE 2 T 900 1900 25
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This means that the axis number 1 is taken to be the mass fraction of C which may vary 
between 0 and 0.1 with a maximum increment of 0.002. The axis number 2 is the 
temperature varied between a minimum 900 and maximum 1900 K with a maximum 
increment of 25.

Before starting the mapping, it is a good rule to SAVE the workspaces. If this is done just 
before the MAP command, and the MAP command fails for some reason, the user can 
restart from the situation just before mapping and try to find a better start point.

SAVE

MAP

The diagram is plotted in the post-processor. The post-processor will automatically set the 
same axes for plotting as used for mapping.

POST

PLOT

BINARY_DIAGRAM

The BINARY_DIAGRAM module (short name, the BIN module) enables you to quickly 
calculate a simple binary  phase diagram.  Access to specific databases designed for BIN, such 
as TCBIN, is required.

To enter the module, at the SYS prompt type GOTO_MODULE BINARY. There are no other 
commands for this module.  Follow the prompts to plot a diagram.

Syntax BINARY_DIAGRAM

Prompts Database: /TCBIN/

 
First element 

Second element

 Phase diagram, Phase fraction (FE), G- OR A-curves (G/A): /Phase_Diagram/

About Ternary Phase Diagrams

There are many types of ternary phase diagrams but perhaps the most common is the 
isothermal section. In this case, the temperature is constant, which means that the tie-lines 
are in the plane of the calculation. Isothermal sections and monovariant lines on the liquidus 
surface can be calculated in traditional way. They can also be calculated in the TERN module, 
but this requires a special database (such as PTERN).

In order to set up calculation of a ternary isothermal section in the system Al-Mg-Si, do the 
following (after retrieving the data from the database (TDB) module):

SET_CONDITION T=823,P=1E5,N=1,X(MG)=.01,X(SI)=.01
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C_E

Note that there is no condition on the amount of Al as that is the "rest". N=1 specifies that 
the system is closed. This calculation gives one point inside the system. Now define the axis:

S-A-V 1 X(MG) 0 1 0.01

S-A-V 2 X(SI) 0 1 0.01

Of course, you might not be interested in the whole section, and in such cases specify 
different lower and upper limits for the axes. Then give a SAVE command before the MAP 
command:

SAVE almgsi-823

MAP

The result can be plotted in the POST module. Ternary isopleths are equally simple to 
calculate. Use the same conditions as above if you are interested in a section of Al-Si at 1 
mole percent of Mg, just define a different set of axis:

S-A-V 1 X(SI) 0 1 .01

S-A-V 2 T 500 2000 25

SAVE almgsi-1mg

MAP

In the resulting diagrams, the tie-lines are not in the plane of the diagram, thus the lever rule 
etc. cannot be applied. But you can calculate more elaborate sections. An interesting 
diagram is the section from pure Al to Mg2Si, which is almost a quasi-binary section. In order 
to calculate this, set up the conditions differently:

SET-CONDITION T=823, P=1e5, N=1, X(MG)-2*X(SI)=0, W(MG)=.01

C-E

Note that there is no condition on the amount of Si as this is given by the relation X(MG)-2*X
(SI)=0. Also note that you can mix conditions in X and in W. Then set the axis, save the 
workspace and map.

S-A-V 1 W(MG) 0 .1 .01

S-A-V 2 T 500 1500 10

SAVE al-mg2si

MAP

A special type of ternary phase diagrams is liquidus surfaces. This is still not simple to 
calculate as a separate start point is needed for each separate line at each temperature.

However, you can easily calculate the monovariant lines where the liquid is stable together 
with two condensed phases:

SET-CONDITION T=800, P=1e5, N=1, X(MG)=0.01, X(SI)=.01
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C-E

C-S P LIQ=FIX 0.3

S-C T=NONE

C-E

Now there should be an equilibrium where liquid is just stable. Set the axis to be the 
compositions.

S-A-V 1 X(MG) 0 1 .01

S-A-V 2 X(SI) 0 1 .01

SAVE almgsi-luni

MAP

TERNARY_DIAGRAM

The TERNARY_DIAGRAM module (short name, the TERN module) enables you to quickly 
calculate a simple ternary phase diagram. 

To enter the module, at the SYS prompt type GOTO_MODULE TERNARY.  There are no other 
commands for this module.  Follow the prompts to plot a diagram.

Syntax TERNARY_DIAGRAM

Prompts Database: /FEDEMO/

 

First element:

Second element:

Third element:

 Phase diagram, Monovariants, or Liquidus Surface: /Phase_Diagram/

 Temperture (C) /1000/

 Global minimization on: /Y/

About Quasi-Binary and Quasi-Ternary Phase Diagrams

Quasi-binary diagrams, as well as quasi-ternary diagrams and so forth, have often been 
misunderstood and misused. A real quasi-binary phase diagram is for a ternary system 
where one component has a fixed activity or chemical potential, and a real quasi-ternary 
phase diagram is for a quaternary system where one component has a fixed activity or 
chemical potential.

A typical example of quasi-ternary system is a quaternary system Fe-Cr-Ni-C calculated at 
fixed carbon activity. The condition can be set as follows:

SET-REF-STATE C GRAPH ,,,,

SET-CONDITION T=1273, P=1e5, N=1, X(CR)=.1, X(NI)=.1, ACR(C)=.002
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In some cases, the activity may vary in a quasi-binary section if one has a phase fixed instead 
(and where the phase may vary in composition). The advantage with the quasi-binary 
section is that the tie-lines will be in the plane of the diagram and thus the lever rule etc is 
obeyed.

A quasi-binary section in Ca-Fe-O when the liquid oxide is in equilibrium with liquid Fe can 
be specified as follows:

DEFINE-COMPONENTS CAO FE FEO

SET-CONDITION T=1850, P=1e5, N=1, X(CAO)=.1

CHANGE-STATUS PHASE FE-LIQ=FIX 0

and the mapping can be done with the following axis

S-A-V 1 X(CAO) 0 1 .01

S-A-V 2 T 1500 2000 25

However, it is a problem as FE-LIQ is not the stable phase for pure iron below 1811. One will 
have to calculate separate sections depending on the stable modification of Fe.
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Calculating a Quasi-Binary Phase Diagram

There are many ways to calculate phase diagrams in Thermo-Calc. The following is an 
example where a quasi-binary phase diagram is used for calculations on a ternary system in 
which one component has an activity or chemical potential that is fixed (although if you 
have fixed a phase and the phase composition varies, then the activity or chemical potential 
may also vary). The tie-lines in a quasi-binary diagram are in the diagram’s plane of the 
diagram. This means that the calculation follows the lever rule as well as other rules. 

When calculating a quasi-binary phase diagram it is necessary to set a condition on either 
activity or chemical potential of the third component. To specify a meaningful value it is 
recommended that you first change the component’s reference state using SET_REFERENCE_
STATE. For example, to calculate a phase diagram for a quasi-binary Fe-Cr-O system with 
fixed oxygen activity, you can enter the following:

SET_REFERENCE_STATE O GAS ,,

You must also use SET_CONDITION to set the activity of the component whose activity or 
chemical potential you have fixed. Do this by assigning a value to the ACR state variable. For 
example, if the component is oxygen, you might enter

SET_CONDITION ACR(O)=0.2

Alternative Way to Set the Component Activity

As an alternative to set the activity of the component, you can Use CHANGE_STATUS to set a 
phase to fixed. For example, suppose you want to compute the iron-saturated section in 
"FeO"-SiO2. You then enter:

CHANGE-STATUS FCC=FIX 0
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Calculating a Quasi-Ternary Phase Diagram

There are many ways to calculate phase diagrams in Thermo-Calc. The following is an 
example of a quasi-ternary phase diagram used for calculations on a quaternary system 
where one component has a fixed activity or fixed chemical potential.

When calculating a quasi-ternary phase diagram it is necessary to set a condition on either 
activity or chemical potential of the fourth component. To specify a meaningful value it is 
recommended that you first change the component’s reference state using SET_REFERENCE_
STATE. For example, to calculate a phase diagram for a quasi-ternary Fe-Cr-Ni-C system with 
fixed carbon activity, you can enter the following:

SET_REFERENCE_STATE C GRAPH ,,

You must also use SET_CONDITION to set the activity of the component whose activity or 
chemical potential you have fixed. Do this by assigning a value to the ACR state variable. For 
example, if the component is carbon, you might enter

SET_CONDITION ACR(C)=0.002
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T0 Temperature Simulations

In this section:

About T0 Temperature Simulations 77

Making a T0 Temperature Simulation 78
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About T0 Temperature Simulations

The T0-temperature is the temperature at which two phases have the same Gibbs energy for 
a certain composition in a multicomponent system. The T0-temperature is located within the 
two-phase field between the phases and it is the theoretical limit for a transformation 
without diffusion. T0 temperatures are often of interest if you want to understand how 
diffusionless transformations work. The T0 temperature in a multicomponent system with a 
fixed composition is temperature at which the tangent lines of the Gibbs energies of the two 
target phases are the same. 

If the composition of one or two components varies, the common Gibbs energy for the two 
phases in partial equilibrium of a diffusionless transformation becomes a plane or surface, 
and the T0 temperature becomes a line or plane. 

See Console Mode examples tcex 23 and tcex41.
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Making a T0 Temperature Simulation

This  describes how to perform a T0 temperature simulation and apply a stepping calculation 
to its initial result.

Before you perform a T0 temperature calculation, you must have defined your initial system 
and be in POLY. The initial overall composition must have appropriate settings for the 
desired T0 temperature calculation for the two target phases. 

POLY Module Commands

 1. Use SET_CONDITION to set the conditions of your calculation in the same way as when 
you calculate an ordinary equilibrium.

 2. Use COMPUTE_EQUILIBRIUM to run the calculation. The calculation does not need to 
reach an equilibrium in which any of the target phases is stable.

 3. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS and 
choose  T-zero. 

 4. When prompted, specify the names of the two target phases for which the T0 
temperature (where the phases’ Gibbs energies are equal) is to be calculated.

 5. If the T0 temperature between the two target phases is calculated, this temperature 
(in Kelvin) is shown in the Console window.  

 6. If you want to do a stepping calculation based on this initial T0 temperature 
calculation, then use SET_AXIS_VARIABLE to specify which state variable to use as the 
stepping variable. This is done the same way as when you calculate a normal 
property diagram. 

When a T0 temperature simulation is run, you cannot set temperature as the 
stepping variable.

 7. Use STEP_WITH_OPTIONS and choose  T-zero to initiate the stepping calculation. You 
are prompted to specify the names of the target phases for which the T0 
temperature is calculated.

During the STEP T-ZERO calculation procedure, the calculated T0 values are presented 
next to the stepping variable. 

For example, part of the output might look like this:
Phase Region from   1.000000E-01 for:

BCC_A2
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FCC_A1

1.000000E-01         940.24

9.250000E-02         941.20

2.500000E-03         977.61

7.500000E-09         979.34

When the stepping calculation has finished, you can move to the POST module and 
plot the T0 line against the stepping composition variable or another varying axis 
value. Or you can impose the calculated T0 line onto a normal phase diagram. 
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Paraequilibrium

In this section:

About Paraequilibrium 81

Calculating a Paraequilibrium 82
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About Paraequilibrium

A paraequilibrium is a partial equilibrium where one interstitial component (such as carbon 
C and nitrogen N) in a multicomponent alloy can diffuse much faster than the other 
components (the substitutional elements, including the matrix element and alloying 
elements). The chemical potential for the interstitial component in two partially equilibrated 
phases is equal in such a case, but this is not true for the other components. In such a 
paraequilibrium state, it is possible to have a transformation that is partly without partitions, 
where a new phase of the mobile component can form with different content but where the 
slowly diffusing components retain their compositions. 

A paraequilibrium calculation is useful when, for example, you want to study phase 
transformations in systems with large differences in the diffusivities of different elements. 
Transformations occurring under paraequilibrium states can be much more rapid than if full 
local equilibrium holds at the phase interface. 

Calculating a Paraequilibrium
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Calculating a Paraequilibrium

This topic describes both how to calculate an initial paraequilibrium with two target phases, 
and how to base a stepping calculation on this initial calculation.

Before you do any paraequilibrium calculations, you must have defined your initial alloy 
system and be in POLY. The initial overall composition must have appropriate settings for 
the desired paraequilibrium calculation for the two target phases. 

 1. Use SET_CONDITION to set the conditions of your calculation just like when you 
calculate an ordinary equilibrium.

 2. Use CHANGE_STATUS to set the status of the chosen interstitial components to 
SPECIAL. For example, if C is an interstitial component, enter: 

CHANGE_STATUS COMPONENTS C=SPECIAL

This gives you a clear picture on u-fractions of the substitutional and interstitial 
components, which are different from the overall composition in the system. The 
SPECIAL status means that the specified components are not included in summations 
for mole or mass fractions. Therefore, all the composition variables plotted from 
paraequilibrium calculations are u-fraction related quantities.

 3. Use COMPUTE_EQUILIBRIUM to run the calculation.

 4. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS 
Paraequilibrium to perform the paraequilibrium calculation. 

 5. Specify the names of the target phases of the paraequilibrium state. For example, 
FCC#1 BCC and FCC#2 M23C6.

Both phases must have similar interstitial/vacancy sublattices that the 
fast-diffusion interstitial components occupy. Both target phases should 
have phase constitution definitions that cover all the defined 
substitutional and interstitial components of the current alloy system.

 6. Specify the names of one or more fast-diffusing components. These components 
must be located on the interstitial/vacancy sublattices in both of the chosen phases.
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Interstitial components (for instance C and N combined) may have 
significantly different behaviours depending on how they are 
partitioned in different structured phases. 

If the paraequilibrium between the two specified phases is successfully calculated, 
then a message is displayed, for example: 

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N = 
4.1548129E-03

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N = 
2.3781027E-04

All other compositions are the same in both phases

The first two lines show the phase amounts expressed in mole-percent [NP(phase)] 
and the contents of the interstitial components C and N in each phase. These 
contents are expressed in u-fractions. The third line states that the compositions of 
the matrix component and all the remaining compositions (regarding substitutional 
components) are equal in the two target phases at the paraequilibrium state.

 7. If you want to do a stepping calculation based on this initial paraequilibrium, then 
use SET_AXIS_VARIABLE to specify which state variable to use as the stepping 
variable. This is done exactly in the same way as when you calculate a normal 
property diagram.

 8. Use STEP_WITH_OPTIONS → Paraequilibrium to initiate the stepping calculation. 
You are prompted to specify the names of the target phases of the paraequilibrium 
states as well as the fast-diffusing components. 

The stepping calculation is performed, and the different phase regions are listed with 
columns for the value of the stepping variable, the amounts of the two target phases, 
the u-fractions of interstitial(s) in each of the two phases, and the LNACR value(s) of 
the interstitial component(s). 
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It is possible to now move to the POST module and plot some of the 
results of the calculation. For an example of a paraequilibrium 
calculation and how it can be plotted,  see Console Mode example 
tcex23. 
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Potential Diagrams

In this section:

About Potential Diagrams 86

POTENTIAL_DIAGRAM 86

Calculating a Potential Diagram 88

Calculating a Potential Diagram with Different Pressure 90
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About Potential Diagrams

If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a so-
called potential phase diagram given certain temperature and pressure. A potential diagram 
uses the activities of two major species in the gaseous mixture phase as mapping variables. 
The activities (that is, the fugacities at 1 bar) of these two species are typically set as the X- 
and Y-axis when the diagram is plotted. The phase relations between the gaseous mixture 
and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are 
represented by different fields controlled by these two potential quantities. 

This topic describes how to calculate such potential diagrams with the POTENTIAL module, 
and how to later modify the pressure of such a calculation in POLY. The calculation done by 
the POTENTIAL module always assumes a pressure of 1 bar.

POTENTIAL_DIAGRAM

The POTENTIAL_DIAGRAM (POT or POTENTIAL) module  is a potential phase diagram 
calculation module.

If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a so-
called potential phase diagram given certain temperature and pressure. A potential diagram 
uses the activities of two major species in the gaseous mixture phase as mapping variables. 
The activities (that is, the fugacities at 1 bar) of these two species are typically set as the X- 
and Y-axis when the diagram is plotted. The phase relations between the gaseous mixture 
and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are 
represented by different fields controlled by these two potential quantities.

To enter the module, at the SYS prompt type GOTO_MODULE POTENTIAL.

There are no commands for this module. Follow the prompts and see About 
Potential Diagrams for details about how to calculate using potential diagrams. 

Syntax POTENTIAL_DIAGRAM

Prompts

Database: /POT/

Press <Enter> and the program lists the available databases. Type one of the database names and 
press <Enter> to select. The following default elements are then based on the chosen database.

 Matrix element: /Fe/

 First potential species: /S1O2/

 Second potential species: /O2/
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Syntax POTENTIAL_DIAGRAM

 Temperature: /1000/
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Calculating a Potential Diagram

You need access to a substance or solution database that contains a gaseous mixture phase, 
metals (or alloys), and solids such as metal-oxides, sulphides, sulphates, carbonates, 
silicates, nitrides or nitrates (stoichiometric or solution phases). 

 1. Use GOTO_MODULE and enter POTENTIAL.

 2. Specify which substance or solution database to use. Any substance or solution 
database can be used that has a gaseous mixture phase, metals (or alloys), and solids 
such as metalxides, sulphides, sulphates, carbonates, silicates, nitrides, and nitrates 
(stoichiometric or solution phases). 

 3. Specify the matrix element (a metal) and the two gaseous species that define you 
metal-gas interaction system. The names of these components must be available in 
the database you are using.

 4. Set the temperature (in Kelvin). (The pressure is always 1 bar.)

A potential diagram with the activities of the two gaseous species as mapping 
variables is calculated. These mapping variables are also set as the axis variables in 
the plotted diagram. 

An example diagram (Console Mode example 35).
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A POLY3 file is also automatically saved in the current working directory with the 
default name POT.POLY3.

 5. When the diagram is plotted, it opens the POST module where you can modify the 
plotted diagram in any way you like. 
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Calculating a Potential Diagram with Different Pressure

It is possible to modify both the calculation and the plotted diagram that the POTENTIAL 
module generates in the POLY and POST modules. You can do this by opening a POLY3-file 
with the results from a POTENTIAL module calculation in either POLY or POST. You can 
modify the calculation in the same way that you can modify any ordinary mapping 
calculation or phase diagram. For example, this is useful for calculating a potential diagram 
at a pressure other than 1 bar.

POLY Module Commands

You must have calculated a potential diagram already, and have the saved POLY3-file 
available.

 1. Use GOTO_MODULE and enter POLY.

 2. Use READ  followed by the name of the POLY3 file that contains the results of the 
potential diagram calculation that you want to modify. 

A reminder that Linux and Mac are case sensitive; when applicable 
ensure you enter file extensions with capital letters.

 3. This opens the workspace file and loads the previous settings and results. The 
activities of the two gaseous species is now part of the conditions, and these 
conditions are set as the mapping variables.

 4. Use SET_CONDITION to specify the pressure under which you want the potential 
diagram to be calculated. For example, to set the pressure to 1000 bar, enter:

SET_CONDITION P=1e8

 5. Use COMPUTE_EQUILIBRIUM to compute the initial equilibrium.

You may also want to use ADD_INITIAL_EQUILIBRIUM to calculate some 
additional equilibria that the mapping calculations are based on. 

 6. Use MAP to perform the mapping calculations.

 7. Use GOTO_MODULE and enter POST to set conditions for visualization and to plot the 
diagram.
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Scheil Simulations

In this section:

About the Scheil-Gulliver Solidification Simulations 92

Scheil in Graphical Mode vs Console Mode 96

Scheil-Gulliver Examples 97

Simulating a Scheil Solidification Process 99

State Variables for Scheil 102
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About the Scheil-Gulliver Solidification Simulations

In Console Mode most of the set up for the Scheil module is via the START_
WIZARD command where you are prompted to answer a series of questions. 
You can also perform Scheil calculations in Graphical Mode using the Scheil 
Calculator, which is recommended for most users. See Scheil in Graphical Mode 
vs Console Mode to compare.

Thermo-Calc is often used to perform equilibrium calculations, but some non-equilibrium 
transformations or partial-equilibrium transformations can also be simulated.

A well-known example of a non-equilibrium calculation is the Scheil-Gulliver solidification 
simulation. In Thermo-Calc, the available Scheil-Gulliver solidification simulations are classic 
Scheil, Scheil with back diffusion in the primary phase, or Scheil with solute trapping. There 
are also configuration options available with fast diffusers for the classic and back diffusion 
models.

Classic Scheil Simulation

This is a Scheil simulation based on the well-known Scheil-Gulliver model. If this model is 
used without "fast diffusers" it is Classic Scheil simulation with the following assumptions:

 l Diffusion in the liquid phase is assumed to be very fast, that is, infinitely fast.
 l Diffusion in the solid phases is so slow that it can be ignored, that is, diffusion is 

assumed to be zero.
 l The liquid/solid interface is in thermodynamic equilibrium.

In this Classic Scheil simulation the temperature is decreased step-by-step. When the 
temperature drops below the liquidus temperature the equilibrium amount and 
composition of solid and liquid phase is calculated. The solid phase is removed from the 
system and only the amount and composition of the liquid phase is used for the next 
calculation step at a lower temperature. Again, the equilibrium amount and composition of 
solid and liquid phase is calculated and again the solid phase is removed from the system for 
the next step. This procedure is repeated until the last liquid disappears.

This calculation procedure is equivalent to assuming that there is no diffusion in the solid 
phase and infinitely fast diffusion of all elements in the liquid phase. It has been shown to be 
a good approximation of the solidification of most alloys such as Ni-superalloys, Cu alloys, Al 
alloys, Mg alloys, and others. However, in materials with interstitial elements, such as 
carbon, ignoring diffusion in the solid causes discrepancies with experimental results. 
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Interstitial elements have much faster diffusion rates. The assumption of no diffusion in the 
solid phase during solidification is thus not correct at most industrial or lab-scale 
solidification rates.

For this reason, a variant of the Scheil simulation was developed and implemented in 
Thermo-Calc, where one or more elements can be defined as fast diffusers. See Other 
Options: Fast Diffusers and Scheil Simulations.

Scheil Simulation with Back Diffusion in Primary Phase

The Scheil simulation with back diffusion in primary phase kinetic model quantitatively takes 
into account the real back diffusion of all elements in the primary solid phase (typically the 
FCC or BCC phase). This model requires the use of both a thermodynamic and mobility 
database. The calculation also requires the cooling rate to be specified; a fast cooling rate 
allows for less time for back diffusion and the simulation result is similar to the classic Scheil-
Gulliver solidification simulation. A very slow cooling rate allows for almost complete back 
diffusion, the solidification simulation is then close to an equilibrium calculation. It also 
requires that the size of the solidification domain is specified. In most cases this domain size 
corresponds to the secondary arm spacing, as this is where typically the liquid is trapped 
during solidification.

The secondary arm spacing also depends on the cooling rate. For this reason, a 
simple empirical relation between cooling rate and secondary arm spacing is 
predefined in Thermo-Calc.

For the Scheil simulation with back diffusion in primary phase model the following 
assumptions are made.

 l Diffusion of all elements in the liquid phase is infinitely fast.
 l Diffusion of all elements in the primary solid phase are quantitatively calculated 

using mobility data, a cooling rate and a domain size (typically this is the secondary 
arm spacing).

 l The liquid/solid interface is in thermodynamic equilibrium.

Also see Other Options: Fast Diffusers and Scheil Simulations.

Scheil with Solute Trapping

The Scheil with solute trapping model simulates deviation from local equilibrium for the 
primary phase. It is useful for high solidification speeds, such as those seen in additive 
manufacturing applications.
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For equilibrium- and classical Scheil-type solidification simulations thermodynamic 
equilibrium is established at the solid-liquid interface. This means that solutes are 
partitioned between the solid and liquid phases according to solidus and liquidus lines of the 
phase diagram. The assumption of thermodynamic equilibrium at the solid-liquid interface 
however, is invalid for very fast solidification rates, as encountered for example during 
additive manufacturing. The faster the solidification rate, the less the partitioning at the 
interface, which can be perceived as that solutes in the liquid are trapped in the advancing 
solid phase, hence the term solute trapping.

The Scheil with solute trapping model calculates the solute partitioning between liquid and 
primary solid that deviates from thermodynamic equilibrium due to solidification speed. 

The following assumptions are made:

 l Only one primary solid phase forms dendrite, NOT necessarily the first solid phase.
 l Solute trapping in primary solid phase only. Other solid phases have equilibrium 

compositions following Scheil model.
 l Dynamic liquidus for primary solid phases is dependent on solute trapping and 

solidification speed.
 l Amounts of solid phases are dependent on solute trapping and solidification.

More theory details are in About Scheil with Solute Trapping.

Other Options: Fast Diffusers and Scheil Simulations

If a Classic Scheil or Scheil simulation with back diffusion in primary phase model is selected 
plus one or more Fast diffuser checkboxes selected, then Thermo-Calc takes into account 
the concept of the fast diffuser. Typically, C is defined as a fast diffuser, but also other 
elements such as N, O, or others can also be defined.

Fast diffuser does not quite define this since diffusion is not actually simulated. 
It is simply assumed that the “fast diffusers” distribute throughout the solid and 
liquid phase according to thermodynamic equilibrium. This corresponds to 
infinitely fast diffusion for the selected elements.

For a Classic Scheil model with the compositions defined with Fast diffuser the following 
assumptions are made.
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 l Diffusion of all elements in the liquid phase is infinitely fast.
 l Diffusion of all elements in the solid phases, except the ones defined as “fast 

diffusers”, is zero.
 l Diffusion of the elements defined as “fast diffusers” is infinitely fast in the solid 

phase.
 l The liquid/solid interface is in thermodynamic equilibrium.

For a Scheil simulation with back diffusion in primary phase model with the compositions 
defined with Fast diffuser the following assumptions are made.

 l Diffusion of all elements in the liquid phase is infinitely fast.
 l Diffusion of all elements in the primary solid phase are quantitatively calculated 

using mobility data, a cooling rate and a domain size (typically this is the secondary 
arm spacing).

 l Diffusion of the elements defined as “fast diffusers” is infinitely fast in the solid 
phase.

 l The liquid/solid interface is in thermodynamic equilibrium.

The Classic Scheil simulation and Classic Scheil simulation with fast diffuser models can be 
considered thermodynamic models. There are clear limitations as a certain amount of back 
diffusion always takes place in the solid phase at real solidification.

You can also use the more sophisticated Scheil simulation with back diffusion in primary 
phase kinetic model. Adding the fast diffuser option to this can be useful, for example for 
interstitials like C in steels where these then equilibrate in all phases and not just the 
primary phase.

Homogenization, Segregation Profiles, and the Diffusion Module

Scheil calculations can be used in diffusion simulations with the Diffusion 
Module (DICTRA). 

Homogenization is a process were you want to get rid of the composition segregation from 
solidification with a homogenization heat treatment. This composition segregation can be 
simulated with Scheil. Then with the Diffusion Module (DICTRA), you input the secondary 
dendrite arm spacing to get the right diffusion distances.  With composition profile from file 
the idea is that you should be able to input for example a measured composition profile 
(from EDS/WDS, micro-probe etc). This could also be a segregation profile but also 
composition profiles over a weld, substrate/coating, diffusion couple, and so forth.
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Summary

The available Scheil-Gulliver solidification simulations are classic Scheil, Scheil with back 
diffusion in the primary phase, or Scheil with solute trapping. There are also configuration 
options available with fast diffusers for the classic and back diffusion models. 

There is also connectivity to the Diffusion Module (DICTRA) and homogenization 
where you collect data from a Scheil solidification calculation, which is then 
used as part of the kinetic homogenization simulation of segregated 
composition profiles. 

Scheil in Graphical Mode vs Console Mode

The Scheil with back diffusion  feature is only available for systems with 
diffusion data, i.e. this model requires the use of a mobility database.

In Thermo-Calc, the Scheil calculation allows the calculation of:

 l The solidification range of an alloy.
 l Depression of the solidus temperature due to segregation.
 l Composition of the last liquid to disappear in segregation pockets.
 l Phases formed on final solidification in segregation pockets.
 l The composition gradient in the primary solid phase(s) (segregation profile).
 l Solute trapping to simulate deviation from local equilibrium for the primary phase
 l Kinetic homogenization simulation of segregated composition profile (diffusion 

calculations)

Scheil in Graphical Mode vs Console Mode

Type of 
Calculation Console Mode Graphical Mode

Classic Scheil Use the START_WIZARD command to answer 
prompts

Scheil Calculator > click the Classic 
Scheil button on the Configuration 
window.

On the My Project Configuration 
window under Getting Started, click 
Quick Start and select Scheil 
solidification simulation.
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Type of 
Calculation Console Mode Graphical Mode

Scheil with back 
diffusion in the 
primary phase

USE_BACK DIFFUSION command (turn on) then 
use the START_WIZARD command to answer 
prompts

Scheil Calculator > click the Scheil with 
back diffusion in the primary phase 
button on the Configuration window 
then enter the settings as needed. 
A mobility database is required.

Scheil with solute 
trapping

SOLUTE_TRAPPING command (turn on) then use 
the START_WIZARD command to answer prompts

Scheil Calculator > click the Scheil with 
solute trapping button on the 
Configuration window then enter the 
settings as needed.

Fast diffusers and 
Classic Scheil

Use the START_WIZARD command to answer the 
promptFast diffusing componentswhere you 
enter the elements that diffuse fast in solid 
phases and can assume to be in equilibrium in 
the whole phase. E.g. C in a steel.

Scheil Calculator > click the Classic 
Scheil button plus one or more of the 
Fast diffuser checkboxes next to the 
composition(s) on the Configuration 
window then enter the settings as 
needed.

Fast diffusers and 
Scheil with back 
diffusion in the 
primary phase

USE_BACK DIFFUSION command (turn on)  then 
use the START_WIZARD command to answer the 
prompt Fast diffusing componentswhere you 
enter the elements that diffuse fast in solid 
phases and can assume to be in equilibrium in 
the whole phase. E.g. C in a steel.

Scheil Calculator > click the Scheil with 
back diffusion in the primary phase 
button plus one or more of the Fast 
diffuser checkboxes next to the 
composition(s) on the Configuration 
window then enter the settings as 
needed. A mobility database is 
required.

Homogenization

Use the EVALUATE_SEGREGATION_PROFILE 
command before START_WIZARD to generate the 
segregation profile to file. In DICTRA_MONITOR 
use INPUT_SCHEIL_PROFILE for use of segregated 
profile in simulation. An additional license to the 
Diffusion Module (DICTRA) is needed to work 
with more than three components. 

Use the Homogenization template 
under Non-Equilibrium to 
automatically set up the project tree 
with the defaults needed to work with 
this. An additional license to the 
Diffusion Module (DICTRA) is needed 
to work with more than three 
components. 

Scheil-Gulliver Examples

About the Scheil-Gulliver Solidification Simulations
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tcex15 - Simulating the Solidification of a Cr-Ni Alloy

This is an example of a solidification simulation of a Cr-Ni alloy. There is no back diffusion in 
the solid, i.e. this is a classic Scheil-Gulliver simulation. The FEDMO database is used and 
included with your installation. 

These commands are of note and used in this example:

 l START_WIZARD
 l COMPUTE_TRANSITION
 l ADD_INITIAL_EQUILIBRIUM
 l ENTER_SYMBOL
 l ADVANCED_OPTIONS
 l STEP_WITH_OPTIONS
 l MAKE_EXPERIMENTAL_DATAFILE
 l CHANGE_STATUS

tcex30a and 30b - Scheil Calculation for an Al-4Mg-2Si-2Cu Alloy

The Equilibrium Calculation Module (POLY3) and About the Scheil-Gulliver 
Solidification Simulations

These examples show two ways to do a Scheil calculation for an Al-4Mg-2Si-2Cu alloy. In part 
A, you use the POLY3 module and the STEP_WITH_OPTIONS command with an EVALUATE 
option. Then in part B you use the SCHEIL module commands to do the same thing. Data 
from the COST2 database is used and included with the example in the file named tcex30_
cost2.TDB.

tcex48 - Scheil Solidification with C Back Diffusion

The FEDEMO database is used and the example is available to all users. 

This is an example of Scheil solidification with simulated back diffusion of carbon in solid 
phases. The results are compared between a simple Scheil and equilibrium calculation. First 
perform a Partial Equilibrium Scheil by assigning carbon as a fast diffusing element. Plot 
solidification curve and a microsegregation diagram and save to file (so called .exp files). The 
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"back diffusion" of C in solid phases is not from any calculation involving kinetics, but comes 
from the equilibration of chemical potential of C at each step in temperature, thus allowing 
each already solidified  part of the system to change its C concentration.

See tcex54 for an example that calculates "real" back diffusion. This model 
requires a kinetic (mobility) database in addition to the thermodynamic one.  
Also see About the Scheil-Gulliver Solidification Simulations for details about 
the different Scheil options.

tcex54 - Scheil Solidification of an Al-2.1Cu-1Si Alloy including Back 
Diffusion

This is an example of a solidification simulation of a Al-2.1Cu-1Si alloy. The back diffusion 
option in the Scheil module is used, i.e. there is back diffusion in the primary phase. The 
example uses both the thermodynamic ALDEMO and mobility MALDEMO demo databases 
included with your installation. 

tcex57 - Scheil Solidification with Solute Trapping

This is an example of a solidification simulation of a Al-7.5Si-0.2Cu system. The solute 
trapping option in the Scheil module is used. The example uses the thermodynamic ALDEMO  
demo database included with your installation. 

See the Graphical Mode example T_13: Scheil Solidification with Solute Trapping 
for an additional comparison to Classic Scheil.

Simulating a Scheil Solidification Process

SCHEIL Module Commands

About the Scheil-Gulliver Solidification Simulations

Simulating a Scheil-Gulliver solidification process involves calculating the liquid composition 
of a higher-order multicomponent system at each step of a cooling process, and resetting 
the liquid composition as the composition of the entire system (after having removed all 
amount of solid phase). 
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The step-by-step instructions below are intended as a simple example of setting 
up a calculation using the wizard in Console Mode. You can also use the macros 
available and briefly described in Scheil-Gulliver Examples.

The following does not include any prompts related to using back diffusion or 
solute trapping. See START_WIZARD for additional details about when these 
options are enabled with the USE_BACK_DIFFUSION and SOLUTE_TRAPPING 
commands.

 1. At the prompt type  GOTO_MODULE SCHEIL.

 2. Type START-WIZARD and press <Enter>.

 3. Specify which Database to use. Type ? for a list of available databases based on your 
license. 

 l Type FEDEMO for this example. 

 4. Specify the Major element or alloy in your system. For example, enter Fe 
(steel/Fe-alloy),  Al (Al-based alloy), or Ni (Ni-based super alloy). 

 l Type Fe for this example.

 5. Set whether to specify the Composition input in mass (weight) percent (the 
default) or in Mole percent. Press <Enter> to keep the default for mass (weight) 
percent or type N to use mole percent.

 l Keep the default  for this example (press <Enter>).

 6. Specify the name of the 1st alloying element. You can directly specify mass or 
mole percent after the name. If this is not specified, then you are prompted to enter 
it separately. 

 l Type Cr 5 for this example.

 7. Specify the other alloying elements in the same way as you specify the first.
 l Type C 1 for this example. 
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 8. After you have specified your last alloying element, press <Enter>. This ends the 
process of defining the bulk composition of the alloy system. 

You can also specify all the alloying elements and their corresponding 
compositions on the same line when you are prompted to specify your 
first alloying element. As a general  example, you can enter Cr 5 Ni 1 
Mo 0.5 C 0.01 N 0.02.

 l Press <Enter> for this example.

 9. Specify the starting Temperature (C) in Celsius. The default is 2000.

This value should be sufficiently high so that the solidification simulation starts with 
the alloy system in the liquid single-phase region.

 l Keep the default  for this example (press <Enter>).

 10. At the Reject phase(s) prompt enter the name of the phases to reject or press 
<Enter> for the default NONE. 

 l Keep the default s for this example (press <Enter>).

 11. At the Restore phase(s) prompt you may want to restore a phase that you rejected 
when you ran the simulation earlier, or you may want to restore a phase that is 
rejected by default in your database. Enter the name of the phases to restore or 
press <Enter> for the default NONE.

 l Keep the default  for this example (press <Enter>).

 12. When prompted OK? type N to go back  to reconsider which phases to reject or 
restore. Type Y to continue. The thermodynamic data about the alloy system you 
defined is retrieved from the database.

 l Keep the default  for this example (press <Enter>).

 13. At the Should any phase have a miscibility gap check prompt, press <Enter> 
for the default N or type Y then specify the Phase with miscibility gap.  

 l For this example, type Y then enter FCC as the Phase with miscibility gap. 

 14. If you answer Y to the miscibility gap check, then next enter the following for Major 
constituent(s) for sublattice 1 and Major constituent(s) for sublattice 
2.

 l Enter Cr for sublattice 1 and C for sublattice 2 in this example. Then at the 
Phase with miscibility gap prompt press <Enter>. The system responds 
with LIQUID PHASE NAME: LIQUID.
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 15. Specify the names of any Fast-diffusing components. Press <Enter> for NONE or 
type all the names on the same line then press <Enter>. Keep the default  for this 
example (press <Enter>).

After the Scheil-Gulliver solidification simulation runs, the diagram Temperature versus 
Mole Fraction of Solid is plotted in the Console Results window. 

State Variables for Scheil

Post processing is done the same way as POLY-3: specific variables for plotting in the Scheil 
module are listed. 

POLY Module Commands

For a comparable list in Graphical Mode, see Scheil Calculator Available Plot 
Variables.
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The variables can be plotted along the X- and Y-axes. In the table, ph is an abbreviation of 
phase, and el is an abbreviation of element. An asterisk (*) can be used as a wild character 
for el and ph. Use the abbreviations of the variables when you specify what the X- and Y-
axes represent in a diagram.

Abbreviation State Variable

T Temperature in Celsius

NL/BL/VL Mole/mass fraction of liquid

NS/BS/VS Mole/mass fraction of all solid phases

NS(ph)/BS(ph) Mole/mass fraction of a solid phase

VS(ph) Volume fraction of a solid phase

W(ph,el) Weight fraction of an element in a phase

X(ph,el) Mole fraction of an element in a phase

Y(ph,el) Site fraction of an element in a phase

NN(ph,el) Distribution of an element in a phase

NH/BH Total heat per mole/gram (top curve) and Latent heat per mole/gram (bottom curve)

CP/BCP Apparent heat capacity per mole/gram

NV/NV(ph) Molar volume of the system or a phase

DS/DS(ph) Average density of the system or a phase

BT Apparent volumetric CTE of the system

DVIS(ph) Dynamic viscosity of a phase

KVIS(ph) Kinematic viscosity of a phase

SURF(ph) Surface tension of a liquid phase

ELRS/ELRS(ph) Electrical resistivity of the system or a phase

ELCD/ELCD(ph) Electrical conductivity of the system or a phase
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Abbreviation State Variable

THCD/THCD(ph) Thermal conductivity of the system or a phase

THRS/THRS(ph) Thermal resistivity of the system or a phase

THDF/THDF(ph) Thermal diffusivity of the system or a phase

DGV Driving force for evaporation

DHV Evaporation enthalpy

MMG Molar mass of gas

XAVG(el) Mole fraction of an element in solid phases

WAVG(el) Mass fraction of an element in solid phases
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Aqueous Solutions and Pourbaix Diagrams

In this section:

About Aqueous Solutions and the Pourbaix Diagram 106

Calculating a Pourbaix Diagram 109

Plotting More Pourbaix Diagrams 112

Stepping Calculations in an Aqueous Solution 114

POURBAIX_DIAGRAM Module 115
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About Aqueous Solutions and the Pourbaix Diagram

This command or module is not available with GES6. 

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. However, not all GES5 functionality is implemented in GES6. In such 
cases (except for  the POURBAIX module), GES6 falls back silently and uses 
functionality from GES5 in the background. 

Heterogeneous equilibrium calculations involving aqueous solutions are not different from 
other equilibrium calculations, but the setup of the equilibrium conditions and the reference 
states of the system is more complex. For example, the pH and Eh values of the aqueous 
solution phase are normally complex functions of bulk composition, temperature and 
pressure conditions. 

For some simple systems, thermodynamic approximations of pH-Eh calculations can be 
used. But Thermo-Calc also has comprehensive thermodynamic models and databases for 
various non-ideal solution phases. These let you accurately calculate pH and Eh property 
diagrams (and many other types of property diagrams) in complex aqueous solutions in a 
variety of conditions. 

A Pourbaix diagram is a kind of phase diagram that shows the stability boundaries for a 
metal-aqueous interaction system. The phase boundaries are shown as a function of pH 
(acidity) and Eh (standard hydrogen electronic potential). An aqueous solution phase is 
always present in such a system. At a given pH and Eh, a metal may lose its stability to a 
soluble or corrosive aqueous solution, or be in equilibrium with either the aqueous solution 
(insoluble/immune) or with a secondary-phase file that has formed (consisting of oxides, 
hydroxides, sulphides or other solids). In the latter case, further dissolution of the passive or 
protective metal is prevented. 

A Pourbaix diagram is a pH-Eh phase diagram where the tie-lines are not in the plane. The 
chemical potentials or activities of two system components (H+ and EA) are used as mapping 
variables and the pH and Eh quantities are normally plotted on the X- and Y-axes of the 
diagram. You can use many other properties as axis variables in various property diagrams 
for the interaction system at a specific temperature and pressure. The phase relations 
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between the aqueous solution and various metal forms, oxides, hydroxides, sulphides, 
sulphates, nitrates, silicates, carbonates and other solids, or gaseous mixtures, are 
represented as different fields defined by acidity and electric potential. 

The POURBAIX module lets you construct Pourbaix diagrams and other types of property 
diagrams for heterogeneous interaction systems with aqueous solution phases. The 
compositional definition and variations and the basic solvent and electron components H2O, 
H+1 and ZE are automatically determined by the aqueous solution phase in the Pourbaix 
module. 

See Console Mode examples tcex40 and tcex53.

Key Components

These key components are defined as follows: 

Component Component status Reference state Ref-T(K) Ref-P(Pa)

H2O ENTERED AQUEOUS * 100000 

H+1 ENTERED SER   

ZE  ENTERED REFERENCE_ELECTRODE * 100000

Besides the aqueous solution phase, your system may also contain a gaseous mixture phase. 
Other neutral and charged gaseous species may also be constituents. For multicomponent 
systems there are normally also some interacting solid phases (stoichiometric or solution) as 
the so-called secondary phases. These are typically the matrix and/or precipitate phases in 
the alloys of interest. 

Some databases have been specially developed for the Pourbaix module’s diagram 
calculations. Such a database contains all necessary phases, i.e., an aqueous solution phase, 
a gaseous mixture phase, some alloy solid solution phases and some secondary solid phases. 
Databases developed for the Pourbaix module include PAQ (TCS Public Aqueous Solution 
Database) or PAQS (TGG Public Aqueous Solution Database).

If such a dedicated Pourbaix module is not used, then an aqueous solution 
database such as TCAQ (TC Aqueous Solution Database), AQS (TGG Aqueous 
Solution Database), or any user-specified aqueous databases can be used. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 108 of 622

This database contains at least the AQUEOUS and REFERENCE_ELECTRODE phases. The 
aqueous solution database needs to be appended with additional required data and phases, 
such as interacting alloy (solid) solution phases and secondary (solid and liquid) phases. 
Additional data is from one or more databases, such as SSUB/SSOL/TCFE or other 
substances/solutions databases.
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Calculating a Pourbaix Diagram

The POURBAIX module lets you construct Pourbaix diagrams and other types of property 
diagrams for heterogeneous interaction systems with aqueous solution phases. 

When calculating a Pourbaix diagram, you need to have a database with an aqueous solution 
phase (that is, a phase with water as the dissolving solvent and with aqueous cation/anion 
and complex species as the dissolved solutes). Due to restrictions of aqueous solution 
models (SIT, HKF, Pitzer) used in the Thermo-Calc software, the aqueous solution database 
must be designed in the same Thermo-Calc database format as that used in the PAQ, PAQS, 
TCAQ and AQS databases for the aqueous solution phase. 

Pourbaix diagram calculations are done in the advanced Pourbaix module.

How to Calcuate a Pourbaix Diagram

 1. At the SYS prompt, enter GOTO_MODULE POURBAIX.

 2. At the Need any instruction on the POURBAIX module? prompt, press <Enter> to 
skip or enter Y to learn more.

 3. Press <Enter> at the prompt Enforce a PAUSE after plotting when running a 
MACRO?.

 4. Press <Enter> to accept the default 1 to Start a completely new POURBAIX 
diagram calculation or enter 3 to Open an old file and make another 
POURBAIX calculation.

To choose 3, you must have already done a Pourbaix calculation and have it saved in 
a POLY3 file. The new calculation uses the same system definition as the previous 
calculation, but the other conditions, such as the bulk composition, temperature and 
pressure, can be modified in the next step.

 5. Type Y or N to set whether to Consider the GAS phase (gaseous mixture phase) in 
the calculation.

The gaseous mixture phase should at least contain H2O, O2 and H2. If a GAS phase is 
not considered, then only the interactions between the aqueous solution phase and 
various solid phases (alloy phases and secondary phases) are calculated. Such a 
calculation may not accurately present all the heterogeneous interactions. Some 
secondary phases are therefore usually needed. Such phases exist in the PAQ or 
PAQS Public Aqueous Solution Databases. They can also be appended from the 
SSUB/SSOL/TCFE or other appropriate substances/solutions databases.
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 6. Type Y or N to set whether to Use single database (Y) or a multiple database (N). 

If you choose to use a single database, at the Combined Database: /PAQ2/ prompt 
specify a database that is specially developed for the Pourbaix module’s diagram 
calculations. 

If you choose to use a multiple database, then you are prompted to specify an 
aqueous solution database and to append any additional required data and select 
necessary phases, such as various interacting alloy (solid) solution phases, and 
secondary (solid and liquid) phases, for example.

 7. Specify all your solutes and the molality of each solute when prompted to do so. This 
can be done in terms of elements (such as Fe, Ni, Na, Cl, C or S) or arbitrary complex 
species (such as NaCl, CO2, CoCl3, Fe0.93S, NaSO4-1, or H2SO4). You can enter the 
element/species and the molarity on one line (for an example, NaCl 2.5).

The definition of your system and its initial bulk composition is now presented.

The first letter of the element abbreviation must always be upper case. 
Any second letters must be lower case. When you have finished your 
specification, press <Enter> when asked to specify Next solute. 

 8. Type Y to confirm the defined system and its bulk composition.

The thermodynamic data for your system is now retrieved from the database(s) 
chosen.

 9. Answer the questions that you are prompted regarding various parameters of your 
calculation. You are asked to do any of the following:

 l Rejectphase(s)or Restore phases(s)
 l Check for miscibility gaps on any phase (Should any phase have a 

miscibility gap check?)
 l Enforce the Global Minimization Technique in calculations?

 l Save all functions, variables and tables in POLY3 file?
 l Set numerical limits on the calculation
 l Confirm defined conditions?
 l Accept the default settings for two mapping variables
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 10. The Pourbaix calculation starts. Answer the question Any missing phase boundary 
you could possibly think of? Type Y or N to set whether you want to add starting 
points to the calculation. If you suspect that the calculation has missed some phase 
boundaries, this may help the program to detect them.

 11. Answer questions about how the diagram is plotted and how to save the results of 
your calculation. You are asked to do any of the following:

 l Change the pH/Eh steps for smoother curves?
 l Zoom in on a specific region of the diagram
 l Change the curve-label option for the diagram

 l Add label-texts onto the Pourbaix diagram

 l Change the subtitle of the diagram

 l Change the axis-texts

 l Further refine the diagram in the POST Module

 l Print the diagram (save a Hard copy of the diagram)
 l Save the X-Y coordinates of curve on a text file

 l Modify the diagram

 l Calculate and plot another Pourbaix diagram (Any more diagram?)
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Plotting More Pourbaix Diagrams

When you have calculated a Pourbaix diagram, you can plot additional diagrams based on 
the results of the same calculation, but with different axis variables than Ph and Eh.

The variables can be plotted along the X- and Y-axes. Use the abbreviations of the variables 
when you specify what the X- and Y-axes represent in a diagram. In the table, AQsp refers to 
the name of a specific aqueous species. The asterisk (*) can be used as a wild card character 
for all such species. If neither AQsp nor * is entered in parenthesis, then all species are 
searched.

You must have plotted a Pourbaix diagram to plot a diagram with other variables than Ph 
and Eh on the Y-axis and the X-axis. You can either plot such additional diagrams directly 
after having finished the plotting and saving/printing of a Poubaix Ph-Eh diagram or by 
choosing option 2 (Open an old file and plot other property diagrams) when you enter the 
POURBAIX module and opening a POLY3 workspace file.

Abbreviations for Aqueous Solution Variables 

Abbreviation Variable

pH Acidity

Eh Electronic Potential (V)

Ah Electronic Affinity  (kJ)

Pe Electronic Activity (log10ACRe)

IS Ionic Strength

TM Total Concentration

Aw Activity of Water

Oc Osmotic Coefficient

MF(AQsp) Mole Fractions of Aqueous Species

ML(AQsp) Molalities of Aqueous Species

AI(AQsp) Activities of Aqueous Species
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Abbreviation Variable

RC(AQsp) Activity Coefficients of Aqueous Species

How to Plot an Aqueous Solution Diagram

 1. Type Y when prompted whether to plot any more diagrams, or select option 2 when 
you enter the POURBAIX module.

 2. Specify which variable you want the X-axis to represent. Use the abbreviation 
specified in the preceding table. When you specify the name of an aqueous species, 
you can use the asterisk (*) to select all species.

 3. Specify which variable you want the Y-axis to represent. The diagram is then 
automatically plotted.

 4. Answer questions about how the diagram is plotted and how to save it. You are 
asked to do any of the following:

 a. change the axis-type (linear, logarithmic or inverse) on the X-axis or Y-axis

 b. zoom in on a specific region of the diagram

 c. change the curve-label option for the diagram  

 d. add label-texts onto the Pourbaix diagram

 e. change the subtitle of the diagram

 f. change the axis-texts 

 g. refine the diagram in the POST Module

 h. print the diagram (save a hard copy)

 i. save the X-Y coordinates of curve on a text file

 j. modify the plotted diagram

 k. calculate and plot another aqueous solution diagram
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Stepping Calculations in an Aqueous Solution

Performing the stepping calculation overwrites all the previous settings and 
stepping results on the POLY3-file. To avoid this, use SAVE_WORKSPACES to 
create a new workspace.

When you have calculated a Pourbaix diagram, you can use the saved results of the 
calculation (the POLY3 file), and make a property diagram based on stepping calculation.

Since the program normally sets the calculated initial equilibrium point as the starting point, 
the minimum value for the stepping variable must be specified as smaller or equal to the 
specific initial condition, and the maximum value as larger or equal to that condition. If pH is 
set as the stepping variable, the program automatically calculates the equilibrium constant 
in logarithmic (log10Ka) of the electrolysis reaction H2O (water) = H+ + OH- for the real 
aqueous solution under the current temperature-pressure-composition conditions, and thus 
this constant log10Ka value is considered as the highest pH in specifying the maximum value 
along stepping. Subsequently, confirm or modify an increment factor with a default value; 
for pressure and mole of a component, specify the step in logarithmic (log10P or log10N).  

State Variable Abbreviations

You can use any of these state variables as a stepping variable.

State Variable Abbreviation

Temperature (K) T

Pressure (bar) P

Acidity pH

Electronic potential (V) Eh

Mole number of a dissolving component (such as Fe, 
Na, Cl, or NaCl) in 1 kg of water.

N(Comp)

(for example, N(Fe))
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How to Do a Stepping Calculation

You must have plotted a Pourbaix diagram before making a stepping calculation on an 
aqueous solution.

 1. Use GOTO_MODULE POURBAIX to enter the POURBAIX module.

 2. Type 4 to open an old file and make another STEPPING calculation.

 3. Choose which POLY3 file to load.

 4. Specify the conditions of the calculation by answering the questions that follows. 

The system definition is the same as in the previous Pourbaix calculation, but you can 
modify conditions such as bulk composition, temperature and pressure, and change 
some component definitions if necessary.

 5. Specify which variable to use as the stepping variable (see the preceding table), its 
minimum and maximum value, and the length of each incremental step.

The settings and stepping results are written to the opened POLY3 file, and a first 
default property diagram is plotted.

POURBAIX_DIAGRAM Module

This command or module is not available with GES6. 

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. However, not all GES5 functionality is implemented in GES6. In such 
cases (except for  the POURBAIX module), GES6 falls back silently and uses 
functionality from GES5 in the background. 

Getting started with the Pourbaix module

After you enter the POURBAIX_DIAGRAM module, you are asked if you want to have step-
by-step instuctions to help walk you through the module. 

Need any instruction on the Pourbaix module? /N/: Y
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If you answer Y a series of notes are displayed. The following is a more comprehensive 
summary of these same notes.  

WHAT IS A POURBAIX DIAGRAM?

The Pourbaix diagram is a calculated equilibrium phase diagram mapped and plotted with 
the independently-varied electropotential (Eh, as defined with regard to the standard 
hydrogen electrode as its reference) and acidity (pH), that represents all the equilibrated 
phase boundaries among aqueous solution, gaseous mixture, and various primary and 
secondary solids (modeled as either complex solution or simple stoichiometric phases) in a 
certain multicomponent heterogeneous interaction system, under a defined T-P condition 
and a specific initial bulk composition (which is, by default, always set as 1 kg of water 
dissolving a specified amount of metals/alloys and other acids/alkalines/salts).

WHAT DATABASE SHOULD I USE?

At least one database is required that contains an aqueous solution phase (with 
thermodynamic data for water and various aqueous solutes), that shall be selected from 
TCAQ (PAQ) or AQS (PAQS) [which use the SIT Model or the Complete Revised HKF Model, 
respectively] within the Thermo-Calc databases. 

CHOOSING A CUSTOM AQUEOUS SOLUTION DATABASE

You can also use a custom database but it must be in the Thermo-Calc TDB format. Due to 
the restrictions of aqueous solution models used within Thermo-Calc, such a database must 
be designed in the same format as in the default TCAQ (PAQ2)  for aqueous solution phases. 
Among other things, keep the following requirements in mind: 

The ELECTRON is defined as an special element (ZE) and as the only constituent in its 
reference phase REFERENCE_ELECTRODE (for determining the electro-potential that is 
defined as Eh with the standard hydrogen electrode as the reference), but it is not defined 
as an aqueous species;

The vacancy (VA) is unnecessary for AQUEOUS solution phase and it should be avoided in 
the definition of phase-constituents in the AQUEOUS phase;

The AQUEOUS solution phase should always be defined as a constitutional solution phase, 
implying that all the aqueous solution species must be included in a single site, rather than 
in two or multiple sublattices. 

Beside the AQUEOUS solution phase, there shall exist a GAS mixture phase containing at 
least H2O1, O2 and H2; and for multicomponent systems, normally there shall also contain 
some solid (stoichiometric or solution) phases. Of course, if desired, you could also choose 
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to calculate and generate a Pourbaix diagram without considering the GAS mixture phase 
entirely; however, such a plot is not really a complete Pourbaix diagram, due to the fact that 
thermodynamically-stable phase boundaries between the AQUEOUS solution phase and GAS 
mixture phase will then not be calculated at all!

All the required thermodynamic data for calculations of Pourbaix diagrams or other 
diagrams must be retrieved either from one (Single) database which consists of an 
AQUEOUS solution phase, a GASeous mixture phase, a REF_ELECTRODE phase, and some 
SOLID phases (being solutions and/or stoichiometric compounds; for primary metals/alloys 
and for secondary products formed from heterogeneous chemical/electrochemical 
interactions, or from several (Multiple) databases that respectively contain various 
solutions/compounds (as listed above).

Such databases suitable for calculations of aqueous-bearing heterogeneous interaction 
systems can be those default-prompted ones [i.e., in the Single-Database case, the PAQ or 
PAQS; and in the Multiple-Database case, the PAQ2 or as primarily-switched database, plus 
the SSUBx as firstly-appended one and the SSOLx as secondly-appended one if it is 
necessary; even more databases can be appended). Of course, you could also choose to 
append required data from other appropriate databases (such as TCFE, TCSLD, TCNI/TTNi, 
TCAL/TTAl, TCMG/TTMg, TTZr, TCMP, SLAG, etc.) for GASeous mixture phase and for varous 
solid solution and stoichiometric compound phases. Furthermore, an experienced user can 
also utilize his/her own USER-specified databases in various cases. 

The advanced POURBAIX module is designed so that it requires you to just answer some 
necessary questions, rather than to go through the other Console Mode modules (i.e., TDB, 
GES5, POLY3 and POST) although you still enter commands at the prompts. Beside the 
default plotted Pourbaix diagram, it also allows the user to easily and quickly plot many 
different properties of the system, stable phases and aqueous species, varied along the 
calculated phase boundaries for the same defined heterogeneous interaction system. 
Moreover, it permits the user to directly change some plotting settings and manipulate all 
kinds of plotted diagrams.

The current advanced POURBAIX-Module has been extended so that it is additionally able to 
directly perform a normal STEPPING calculation (varied with a specified independent 
variable) and to easily generate various types of property diagrams, for the same 
heterogeneous interaction system that has been defined in a previous POURBAIX or TDB-
GES5-POLY3-POST calculation. 

COPY AND RENAME THE POLY3 FILE

At the end of a Pourbaix module calculation, a new POLY3 file  is automatically saved.  
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A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended 
examples), it is recommended that you copy and rename the previously-
generated POLY3 file. This is so that the required POLY3 file structure and 
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save 
from within Thermo-Calc.

The reason you do not save from within Thermo-Calc is because of how the file 
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is 
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3 
module monitor and all the initial equilibrium points and the mapping/stepping 
calculation results are lost as well as parts of the POLY3 file structure (e.g., some 
definitions of the previously defined POURBAIX-type calculation system). 

ENFORCE A PAUSE

After the initial set of information is displayed, you are asked:

Enforce a PAUSE after plotting when running a MACRO? /N/

 l If you choose Y a pause is always enforced after each diagram is plotted;
 l If you choose N, all the command-lines (answers) for the session continue without 

stopping or until the SET_INTERACTIVE_MODE line in the macro file is reached.

Whenever running a Thermo-Calc macro (TCM) file, you may want to pause after a specific 
diagram is plotted on screen. This gives you the flexibility to:

 l Print it (of EMF/PS format) to a printer
 l Convert it (of EMF format) to (PDF) graphical files;
 l Save it as an EMF graphical file;
 l Dump it as a PNG or BMP graphical file;
 l Set background colour for the current diagram
 l You can also set the default font/size and change plot layers for sequential plots.
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Pourbaix Main Options

If you answer Y to the Pause prompt above, these options are displayed:

 1. Start a completely new Pourbaix diagram calculation.

 2. Open an old file and plot other property diagrams.

 3. Open an old file and make another Pourbaix calculation.

 4. Open an old file and make another stepping calculation.

POURBAIX_DIAGRAM Commands for Options 1 to 4
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Tabulation Reactions

In this section:

About the Tabulation Reaction Module 121

Tabulating a Reaction 123

Tabulating a Substance or Solution Phase at Fixed Composition 124
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About the Tabulation Reaction Module

The TABULATION_REACTION (TAB) module can be used to tabulate thermodynamic 
functions of any type of substance, stoichiometric phase or solution phase, or reaction. The 
module can tabulate thermodynamic functions of pure stoichiometric phases or solution 
phases at fixed composition, as well as various kinds of partial derivatives for a pure 
stoichiometric phase or solution phase at a given composition. 

The TAB module begins by evaluating the most stable species of a substance in either a 
homogeneous state or in a reaction. Results are presented in a table or plotted as a graph.

Tabulating a Reaction

A reaction tabulation presents you with the following properties, on rows representing 
different temperature levels:

 l Heat capacity change / Delta-Cp (Joule/K) in column 2.
 l Enthalpy change / Delta-H (Joule) in column 3.
 l Entropy change / Delta-S (Joule/K) in column 4.
 l Gibbs energy change / Delta-G (Joule) in column 5.

In the case of a tabulation of a substance or solution phase at a fixed composition, the 
properties presented are the heat capacity, enthalpy, entropy and Gibbs energy, rather than 
the degree of change in those properties. 

Tabulating a Substance or Solution Phase at Fixed Composition

You can add a 6th column to the table that shows the values of a property or user-defined 
function of your choice. 
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Tabulating a Reaction

A tabulation of a given chemical reaction provides you with data about the rate of change of 
the standard tabulation properties at various levels of temperature. You can also add a 
column for a property of your choice to the table.

 1. Use GOTO_MODULE TAB to enter the TAB module.

 2. If you want to add one thermodynamic functions to the tabulation calculation, which 
is present in a sixth column in the table, use ENTER_FUNCTION. 

You are prompted to enter the name of the column that is given at its head, and the 
function itself. The following state variables can be used to define the function: G, H, 
S, T, P, V and H298.

 3. Use TABULATE_REACTION followed by a formula that specifies of the reacting species 
and products to perform the tabulation calculation. The name of the elements must 
be entered in upper case letters only. Terminate the chemical reaction with a semi-
colon. For example, you can enter:

TABULATE_REACTION 3H2+N2=2N1H3;

Elements that are designated with a single letter must be followed by a 
stoichiometry factor, even if this factor is 1. CO hence be interpreted as Cobalt rather 
than as carbon monoxide. Carbon monoxide is entered as C1O1 or O1C1.

 4. Set the pressure, the range of temperature that you want the tabulation to cover, 
and change in temperature between each row in the table. You can also specify if 
you want to output the calculation results to an EXP-file and whether you want any 
graphical output, and if so, which column you want to be plotted against 
temperature.

The tabulation calculation is performed and you are given a table that shows the 
various properties at each temperature level within the range defined. 

If you have chosen to receive graphical output, then the Console Results window 
presents a graph that plots the column of you chose (on the Y-axis) against 
temperature (on the X-axis). When this graph is plotted, you are now in the POST 
module, where you can modify the graph in various ways. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 124 of 622

Tabulating a Substance or Solution Phase at Fixed Composition

A tabulation of a substance or solution phase at fixed composition provides you with data 
about the standard tabulation properties at various levels of temperature for a given 
chemical reaction. You can also add one extra property column of your choice to the table.

It is important to have already defined the system and retrieved 
thermodynamic data from a database before using the TAB command. 

 1. Use GOTO_MODULE TAB to enter the TAB module.

 2. Use SWITCH_DATABASE to switch to a database that contains solution-based data, 
such as TCFE for example. 

You cannot use the default SSUB database when tabulating solution 
phases at a fixed composition.

 3. If you want to add one thermodynamic function to the tabulation calculation, which 
is present in a sixth column in the table, use ENTER_FUNCTION. 

You are prompted to specify the column header and the function itself. The following 
state variables can be used to define the function: G, H, S, T, P, V and H298.

 4. Use TABULATE_SUBSTANCE followed by the name of the substance or solution phase to 
perform the tabulation calculation.

 5. Set the pressure, the range of temperature that you want the tabulation to cover, 
and change in temperature between each row in the table. You can also specify if 
you want to output the calculation results to an EXP-file and whether you want any 
graphical output, and if so, which column you want to be plotted against 
temperature.

The tabulation calculation is performed and a table shows the various properties at each 
temperature level within the defined range.

If you have chosen to receive graphical output, then the Console Results window presents a 
graph that plots the column you chose (on the Y-axis) against temperature (on the X-axis). ). 
When this graph is plotted, you end up in the POST module, where you can modify the graph 
in other ways. 
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Results
In this section:

Console Mode Results 126

Using the POST Module 128

Plotting Diagrams 129

Saving and Printing the Output in Console Mode 130

Modifying Diagrams 133

Loading Saved Diagrams 135

Working with the Console Mode Output 136
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Console Mode Results 

The results of a calculation in Thermo-Calc can be plotted by the post-processor module, 
also called the POST module. The diagram is displayed in the Console Results window.

In the POST module, you can define and plot various kinds of diagrams based on a 
calculation. You can modify diagram type, which variables to plot on each axis and between 
which minimum and maximum values, append experimental data from an EXP-file, change 
labels and symbols in the diagram, zoom in on (and out from) a certain region in a diagram, 
etc.

If you calculate a property or phase diagram in POLY, then you have to open the POST 
module yourself. If your calculation was performed by a response-driven module such as 
SCHEIL or POURBAIX, then the plotting of a diagram based your calculation is part of the 
dialogue of questions and answers you have in that module (but under the hood, the 
response-driven module is actually utilizing the POST module to get the plotting done). 
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Example of output to the Console Results window.
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Using the POST Module

Use the POST module after a STEP_WITH_OPTIONS or MAP calculation to generate graphical 
or tabulated presentations on screen or into files.

The graphical files are available in different formats (e.g. PS, EMF, PNG, BMP, PDF, JPG, TIF) 
or data forms (e.g. EXP, TAB and WRL). The graphical output can be phase diagrams, 
property diagrams, diffusion profiles and other types of plots. The tabulated presentation is 
into a basic text file (TXT) or a spreadsheet (e.g. an MS Excel file with an extension of .XLS). 

The POST module (post-processor) is a submodule to the POLY module and has 
its own set of commands. The TAB, BIN, TERN, POT, SCHEIL and POURBAIX 
modules use the POST module features as part of the automatic generation of 
the plots.

Within the POST module, you can choose any state variable, any derived variable, or any 
entered symbol (functions or variable) as the X/Y-axis. 

Thermophysical Properties Data and Variables

When a diagram is plotted, appearance parameters for defining a high-standard graph can 
be further specified, e.g. curve labelling options, diagram titles and subtitles, plot size, axis 
length, axis types, axis-tic type, tie-line status, automatic or manual scaling and zooming, 
semi-automatic or manual labeling on phase boundaries and phase regions, graphic formats, 
text fonts, colors, raster plot, etc. 

You can append experimental data onto a plotted diagram. You can also save the 
coordinates onto a textual file, which can be edited and used as an experimental data file to 
be merged onto another diagram or as a part of a setup file for PARROT-module assessment. 

Phases can be suspended or restored in a plotted diagram. The reference states for 
components can also be modified for the resulted diagrams. Moreover, you can translate a 
plotted property diagram (after a stepping calculation) into a tabulated form, such as a 
simple list on screen or a textual file, and a spreadsheet .
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Plotting Diagrams

Plotting a diagram is to graphically represent how several variables (typically two variables) 
co-vary. Each axis in a property diagram or a phase diagram represents the value of one 
variable. The default variables represented by the X- and Y-axes are the following:

 l If you plot a diagram based on the results of a mapping operation (a phase diagram), 
then by default the X- and Y-axes represent the mapping axis variables 1 and 2 (set 
using SET_AXIS_VARIABLE in POLY). 

 l If you plot a diagram based on the results of a stepping operation (a property 
diagram), then by default, the X-axis represents the stepping variable (set using SET_
AXIS_VARIABLE) and the Y-axis represents the sum of the mole fractions of all phases 
(that is, NP(*)).

POLY Module Commands

How to Plot a Diagram

To plot a diagram, you must have already made a stepping or mapping operation in POLY (or 
in some cases, made a calculation as part of some opening a response-driven module), and 
you must have entered the POST module. 

The POST command is available inside POLY. Use POST to enter the POST module 

 1. If you want to directly plot your diagram with the default variables represented by 
the X- and Y-axes, type Plot and press <Enter>. This plots a property or phase 
diagram with the default variables represented at each axis. If you do not want to 
plot your diagram with these default variables, go to the next step.  

 2. Use SET_DIAGRAM_AXIS to set which variables to plot on the X-axis and the Y-axis. For 
example, if you want to plot a phase diagram with pressure on the Y-axis and 
temperature on the X-axis, type:

SET_DIAGRAM_AXIS X T

SET_DIAGRAM_AXIS Y P

 3. Use PLOT_DIAGRAM to plot your diagram.
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Saving and Printing the Output in Console Mode

Global Settings: Graphical and Console Mode Plotting

Output can refer to results in the form of tabulated data in a table or a diagram. 

The terms diagram and plot are interchangeable. The commands in Console 
Mode generally use the term diagram and in Graphical Mode it is also called a 
plot (e.g. the Plot Renderer). 

Commands to Save and Print Diagrams

Use the following commands to create diagrams, which then display in the Console Results 
window. From this window, you can right-click the diagram and choose Save as or Print. You 
can also use the following commands for these actions.

PLOT_DIAGRAM

After you use the SET_PLOT_FORMAT command to define the default graphic device (the 
printer) you can use a PLOT_DIAGRAM command to either save the calculation output to a 
file or display the output in the Console Results window. 

DUMP_DIAGRAM

DUMP_DIAGRAM is an alternative command used to create output. After a diagram is 
displayed to the Console Results window with the PLOT_DIAGRAM command, you can save 
(dump) it to a file using this command. 

MAKE_EXPERIMENTAL_DATAFILE

Use  MAKE_EXPERIMENTAL_DATAFILE to save all the data about the plotted diagram in an 
EXP-file. An EXP-file is a plain text file that describes the diagram in the DATAPLOT graphical 
language. Note that information about the underlying calculations that the diagram is based 
on is not saved in an EXP-file. 
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DATAPLOT User Guide included with this documentation set.

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

PRINT_DIAGRAM

First use PLOT_DIAGRAM to create output that displays in the Console Results window. 
Then after entering the PRINT_DIAGRAM command, the Print window opens where you can 
choose additional settings for a hard copy of the diagram.

Commands to Save  Tables

Tables or tabulated data can be listed in the Console window. You then use commands to 
save  the text to different file formats (txt, html, or xls) where you can then print the 
information.

 l LIST_DATA_TABLE: Use this command to output to the screen or to file.
 l TABULATE 

Saving Diagrams

You can save the output in a variety of file formats. For JPG and PNG images you can also 
adjust the image quality. 

In Console Mode, the diagram is output to the Console Results window after 
using the PLOT_DIAGRAM command.

In Graphical Mode, the diagram is output to the Visualizations window after 
performing a tree that includes a Plot Renderer.  

 1. In the Visualizations window, right-click the diagram and select Save as. 

In the Graphical Mode Configuration window you can also click the Save 
Diagram  (or Save table ) buttons to open the Save window.

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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 2. In the Save window:
 a. Navigate to where you want to save the diagram.

 b. Enter a File name.

 c. From the Files of type list choose png (the default), jpg, ps, pdf, gif, svg, or 
emf. 

 d. For PNG and JPG files only, under the Image Quality section, choose to 
improve the resolution of the image. For JPG files you can also adjust the file 
size. 

 l To change the resolution of a PNG or JPG image, click to clear the Use 
screen resolution  checkbox. Then enter a numerical value in the Dots 
per inch (DPI) field. 

 l For JPEG files, you can also use the slider to choose a number between 
0 and 1 for the JPG quality. The default is 0.9. The lower the number, 
the smaller the file.

 e. When you are ready, click Save.

Printing Diagrams

In the Console Results window, right-click the diagram and choose Print. Select additional 
settings as required on the Print window.

Use the LIST_DATA_TABLE command to save to file and then print the file. 
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Modifying Diagrams

Modifying a diagram amounts to changing the settings that determine how the POST 
module presents the calculated results and plots a new diagram. Suppose that you have 
already plotted a binary phase diagram with the mapping axis variables temperature and 
mole fraction of one of your components (the Fe component, say) on the X- and Y-axes. If 
you then want to modify your diagram so that the Y-axis instead represents, say, the mass 
fraction of Fe rather than the mole fraction, then you use SET_DIAGRAM_AXIS to set 
diagram axis Y to w(Fe), and then use PLOT_DIAGRAM.

There are many ways in which you can modify your diagram and how it is presented. Any 
modification made in the plot settings is taken into account the next time you use PLOT. 

Example Commands

The following are some of the modifications you can make. Use:

 l SET_TITLE to set add a title or to change an already existing title. The title is displayed 
above the plotted diagram in the Console Results window.

 l ADD_LABEL_TEXT to add a label text that starts at a certain X- and Y-coordinate. If 
you have plotted a phase diagram, then you can let Thermo-Calc set the label text 
that specifies the names of the stable phases at that coordinate.

 l SET_AXIS_TYPE to set whether the scale of an axis is linear, logarithmic or inverse.
 l SET_DIAGRAM_TYPE to plot a triangular diagram with the X-axis on the triangle’s 

base and the Y-axis on the triangle’s left side. Such a diagram is often useful if you 
want to plot the fractions of two components in a ternary diagram.

 l SET_SCALING_STATUS to modify the range of values that are displayed on an axis. In 
effect, you can use it to zoom in or out of the diagram. For example, to set the scale 
of the X-axis to range from 0 to 0 .3, type:

SET_SCALING_STATUS X N 0 0.3

The X specifies which axis to change the scaling on, the N turns off Thermo-Calc’s 
automatic scaling, and 0 and 0.3 specifies the minimum and maximum values on the 
scale. You can turn on automatic scaling again by setting the second parameter to Y.

 l SET_LABEL_CURVE_OPTION to label each set of curves that have the same stable 
phases with a certain digit. A legend is also added, where you specify which phases 
each digit designates. 
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Loading Saved Diagrams

If you have previously saved a diagram in an EXP-file, then you can load and superimpose 
the diagram on another diagram. Both the following command requires you to specify which 
prologue and dataset(s) that are loaded from an experimental data file. 

Use APPEND_EXPERIMENTAL_DATA to plot selected data from an experimental data file 
(EXP-file). If you have set the axes of the diagram already, the labels on the diagram are not 
changed when you plot the additional data from the EXP-file, irrespectively of the data in 
that file.

Use QUICK_EXPERIMENTAL_PLOT to plot selected data from an experimental data file (EXP-
file). If you have set the axes of the diagram already, these settings are overwritten with the 
axes settings from the EXP-file. 
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Working with the Console Mode Output 

Pause, Resume or Stop Output to the Console Window

In response to a command or a lengthy calculation, Thermo-Calc may display a lot of text in 
the Console window. Use these keyboard shortcuts to pause, resume, or stop a process.

 l To pause the text on printing press <Ctrl+S>. 
 l To resume the printing on screen, press <Ctrl+Q>.
 l When Thermo-Calc is performing a stepping or mapping operation, the results are 

continuously printed in the Console window. To stop the calculation of the current 
region of the mapping and stop the output, press <Ctrl-A> (Windows) or <Ctrl-C> 
(Linux).

Controlling Console Output

In response to a command or a lengthy calculation, Thermo-Calc may display a lot of text in 
the Console window. Use these keyboard shortcuts to pause, resume or stop a process.

 l To pause the text on printing press <Ctrl+S>. 
 l To resume the printing on screen, press <Ctrl+Q>.
 l When Thermo-Calc is performing a stepping or mapping operation, the results are 

continuously printed in the Console window. To terminate the calculation of the 
current region of the mapping and stop the output, press <Ctrl-A> (Windows) or 
<Ctrl-C> (Linux).

In Console Mode, sometimes the output overflows the window text buffer. This is how to 
increase the buffer size.

 1. In the Console window right-click the tab to edit. For example, if this is the first tab, it 
is labeled Console 1.

 2. Select Properties and either enter a number in the field or use the arrows to increase 
or decrease the Buffer size. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 137 of 622

Commands by Module
In this section:

System Utilities (SYS) Commands 138

Database (TDB) Module Commands 162

POLY Module Commands 177

Gibbs Energy System (GES) Commands 280

SCHEIL Module Commands 338

PARROT Module Commands 362

EDIT_EXPERIMENTS (ED_EXP) Submodule Commands 409

Tabulation Reaction (TAB) Commands 466

REACTOR (REACTOR_SIMULATOR) Commands 492

POST Module Commands 503
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System Utilities (SYS) Commands

In this section:

ABOUT 139

BACK 140

CLOSE_FILE 141

DISPLAY_LICENSE_INFO 142

EXIT 143

GOTO_MODULE 144

HELP (? and ??) 145

HELP 146

HP_CALCULATOR 147

INFORMATION 148

MACRO_FILE_OPEN 149

OPEN_FILE 152

SET_COMMAND_UNITS 153

SET_ECHO 154

SET_GES_VERSION 155

SET_INTERACTIVE 156

SET_INTERACTIVE_MODE 157

SET_LOG_FILE 158

SET_PLOT_ENVIRONMENT 159

SET_TC_OPTIONS 160

STOP_ON_ERROR 161
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ABOUT

The ABOUT command lists basic information about the development history and ownership 
of the Thermo-Calc software as well as version information.
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BACK

GOTO_MODULE. 

Use the BACK command to switch control back to the most recent module. Going from the 
POST module, BACK goes only to the TAB or POLY module (from where the POST module is 
entered).
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CLOSE_FILE

Close an opened text file.

Syntax CLOSE_FILE

Prompt
Unit number: <Unit number>

A unit number given in an OPEN_FILE command must be specified.
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DISPLAY_LICENSE_INFO

You can also access this same information from the top menu. Choose Help → 
Show License Info.

Use this command to launch a license diagnostics program implemented in the SYS module. 
It detects the license information for the Thermo-Calc installations on the current client 
computer (and on the connected license server), and lists the details, including the current 
status of available license file and all its included license features for the current installation
(s), as well as the Safenet Environment Variables and detailed Local (Client) Information, on 
screen or into a textual file (*.TXT).

This is useful for a list of license details, and to obtain basic technical support by sending the 
*.TXT file to support@thermocalc.com. If you are running a network client installation of 
Thermo-Calc, you can see how many of the client example licenses that are currently 
checked out and how many of them are left. You can also see which clients computers it is 
that have checked these client example licenses out. 

Syntax DISPLAY_LICENSE_INFO

Prompt

Output to screen or file /Screen/: <Mylicenseinfo.txt>

Press <Enter> to display a list of license information or into a *.TXT file under a specific file name 
which can later on be opened and edited by any basic text editor.

mailto:support@thermocalc.se?subject=License Inforrmation from <Name>
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EXIT

Use the EXIT command to leave the program and return to the operating system. Use a SAVE 
command before exiting otherwise all data and results are lost (in either the GIBBS, POLY, 
PARROT or REACTOR module).
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GOTO_MODULE

Switch between modules. The name of the module must be typed. To get a list of available 
modules, press the <Enter> key.

Syntax GOTO_MODULE 

Prompt Module name: <Module name>

 If the <Enter> key is pressed without typing a unique module name (or typing a ? mark) it prompts 
for the MODULE NAME and lists the available modules.
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HELP (? and ??)

Enter ? or ?? to get text help about the current prompt (whether this is the prompt of a 
module, or a prompt that requests you to specify the value of some parameter). 

For some commands and prompts, more detailed help is given when two ?? are 
entered.
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HELP

Lists the available commands or explains a specified command. Specifying a unique 
command displays an explanation on screen. Typing a command abbreviation that is not 
unique lists all matching commands. Get the command information by typing a unique 
abbreviation or the complete command name.

Syntax HELP

Prompt

Command: <Command name>

Command name is the name of the command (one of the-module commands) to get help.

If the <Enter> key is pressed without typing a command name, then all the available commands are 
listed.
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HP_CALCULATOR

The HP-CALCULATOR commend is the QBA simple interactive calculator using reverse Polish 
notations.

Available OPCODEs (HPC codes) are  listed by entering the command HELP. 

Use the BACK command to quit  and go back to the SYS module.

Input are numbers, + - * / and ^ and OPCODEs. Several numbers an operations can be given 
on one line. The content of the X register is displayed after each operation.

For example, to compute 2*EXP(1.5**3-30000/(8*1273)), you should input the following: 
30000 8/1273/chs 1.5 3 ^ + exp 2 *
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INFORMATION

Get basic information about topics related to the module you are in.

Syntax INFORMATION

Prompt

Which subject /Purpose/: <Topic name>

Specify a subject (or its abbreviation as long as it is unique). Enter a question mark ? for a list of 
topics.
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MACRO_FILE_OPEN

Some of the information in this topic is related to the add-on Diffusion Module 
(DICTRA).

The macro file functionality is a way to predefine sequences of Thermo-Calc  commands 
stored in a macro file (a basic text file usually with the default extension *.TCM or*.DCM for 
DICTRA) and then executing all of the sequences using this command (preceded by the 
macro file name). This command can be used within various modules (i.e. SYS, POLY, 
PARROT, TAB and DICTRA_Monitor).

Syntax MACRO_FILE_OPEN 

 

<Name of a macro file *.tcm>

An Open window displays to specify the filename of the macro file (*.TCM) with the macro command, 
so that the path (in the Look in field) and File name can be specified.

The Files of type *.TCM for Thermo-Calc (Console Mode) calculations and *.DCM for DICTRA 
simulations, cannot be changed. Click Open or Cancel to continue.

A window such as Save, Open, or Print opens if the macro file contains commands to:

 l set log files (these have a file extension .TCM)

 l save or read GIBBS, POLY or PARROT workspaces

 l switch user databases

 l compile experiments (from existing *.POP files)

 l create new *.PAR files

 l append *.EXP files

 l plot diagrams, etc.

If required, opening these windows can be avoided by issuing the file names (preferably with file-type 
extensions; if the files are not in the current working area where the macro is located, the 
appropriate and complete paths of the files should also be specified) and sometimes with the 
required options after the corresponding commands or parameters/options. 

For details, see the related commands and modules.

When using a macro file that intended to plot graphs on screen, but the command SET_PLOT_FORMAT 
is used to alter the plotting environment from the default value, it is important to first use the 
command SET_PLOT_FORMAT again to change back to the default value. 

This is useful when the same or similar calculations are made frequently with small changes 
[in terms of system definitions, data manipulations, conditions (for single points, stepping or 
mapping calculations), plotting settings, etc.). For example, use this feature when calculating 
phase/property diagrams during an assessment of thermodynamic data.
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A macro file can be automatically generated in Console Mode if in the SYS module the SET_
LOG_FILE command is used and a log file name (with a file extension *.TCM) is given before 
any other SYS, DATA, TAB, GIBBS, POLY, POST, PARROT, or ED-EXP command or any special-
module command (e.g. BIN, TERN, POTENTIAL, SCHEIL, POURBAIX, or REACTION). Such a log 
file generated in Console Mode is a text file. You can use a text editor (such as Notepad++) 
to remove unnecessary command lines, modify some commands, settings and definitions, 
add some pause points, add comment lines that start with @@, and so forth. Then save it as a 
macro file with the standard file extension TCM.

Experienced users can also write/edit an appropriate macro file for calculations/simulations, 
using any basic textual editor outside the Thermo-Calc  program.

All  commands can be used in a macro file. 

The file can be terminated with EXIT or interrupted with SET_INTERACTIVE.

Within a macro file you can use comment-lines (for describing the problems and for 
explaining commands and inputs/outputs), which should always start with the @@ signs in 
the beginning of each comment-line. Such comment-lines help to document the macro file, 
while these are not considered as command lines and thus do not affect the proceeding of 
all the normal commands in modules when the file is called by Thermo-Calc.

You can put multiple-line comment-blocks in a macro file between the @ (” and “@)” signs. 
The former sign indicates where the comment begins and the latter sign indicates where the 
comment ends. A comment-block begins from a line started with the begin comment sign @ 
(and ends with the finish comment sign @); all the lines written in between are ignored, and 
the line started with @) is also ignored.

Another use for a macro file is to allow you to interact at some specific points, using the 
“@?” sign starting a text line (note that the text describing the expected user-
specification/input should be written as a continuous string without any empty space), for 
user’s on-time specifications of arguments/parameters or inputs of parameter-values that 
are requested by a certain command. The macro temporally stops at the “@?” sign, prompt 
on screen the text given after “@?”, and waits for the specified argument/parameter/value. 
Thermo-Calc  then uses specified argument/parameter/value as the input(s) for the 
associated command. For example, you can input the values of lower and higher 
temperature limits for the second axis-variable as follows:

GO POLY-3

SET-AXIS-VAR 2 T  @?Low-temperature-limit:

@?High-temperature-limit:
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You can have macro-variables denoted by the signs of @#n (for definition) and ##n (for 
usage); and up to nine variables inside a single macro file. Such a macro-variable can be 
assigned with its desired value, as for example:

@#3First-element?

This writes the text (note that the text describing the expected user specification/input is 
written as a continuous string without any empty spaces) after the “@#3” sign as prompted 
on screen and then wait for a specification. The input is assigned to the macro-variable ##3, 
which is directly called in different parts within the current macro file.

For example, the content of the macro-variable ##3 is inserted in the command:

DEFINE-SYSTEM ##3

It is also useful in more complicated commands, such as:

SET AXIS VAR 1 x(##3) 0 1,,,

This command sets the mole fraction of macro variable 3 as axis 1.

A macro file can have any number of pauses at the @& signs, for the purpose of checking the 
details/results of executing certain commands when running the macro file. However, you 
can also prevent the  software from temporarily stopping at any pause by typing any 
character (except for the Y character for confirming a Yes answer to a command prompt) 
after specifying the name of a macro file.

A macro file can have a maximum of five nested levels, i.e. a macro file can call another 
macro file, and if one sub-level macro is terminated by the  command it resumes at the next 
command in the previous macro. If it is terminated by end-of-file, the Thermo-Calc 
(Console Mode) software stops.

This feature is especially useful for alloy design that requires many (hundreds) of 
calculations/simulations on similar material system/processes (specified in many different 
but appropriately-documented macro files that are organized in up to five levels) during a 
certain period of time (e.g. in an evening), you can run the main macro (on the top level) at a 
certain time (e.g. before leaving  the office) and afterwards (e.g. next morning) you can 
systematically and efficiently check/compare/analyse the results (saved as graphical files, 
and/or EXP, TXT, XLS… files).

By adding the SYS command SET_ECHO at the beginning of a macro file (or in the primary 
macro file on the top level if any sub-level(s) of macro files are used), it is useful to 
automatically display the complete/detailed meaning of various commands in all the 
sequential operations in the  software, all enforced according to the macro file(s).
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OPEN_FILE

A text file is opened for use in other commands where a unit number is necessary. The 
program automatically assigns a unit number.

Syntax OPEN_FILE

Prompt
File name: <File name>

A legal file name must be specified.
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SET_COMMAND_UNITS

This command is useful for reading inputs already prepared by a textual editor on a file. Such 
inputs can be a table of values or a large number of parameters. The file must be opened 
with OPEN_FILE.

The first two lines of an input file are skipped before any input is read.

Syntax SET_COMMAND_UNIT

Prompt

Input unit number /5/: <Input unit number>

Specify the input unit number returned from an OPEN_FILE command. The next command is taken 
from the file connected to this unit number. The last command on such a file must be EXIT or SET_
INTERACTIVE when you are in POLY, POST or SYS module, in order to go back to read input from the 
keyboard. The default value is the current input unit.

 
Output unit number /6/: <Output unit name>

Specify the output unit number returned from an OPEN_FILE command. 
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SET_ECHO

This command is only applicable to use with macro files, i.e. it does not work to 
enter this command directly into the Console.

Add the SET_ECHO command at the beginning of a  macro *.TCM file (or to the primary macro 
file on the top level if any sub-level(s) of macro files are used). 

Automatically displays on screen the complete details of various commands in all the 
sequential operations in the  software, that are enforced according to the macro file(s). 
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SET_GES_VERSION

This command enables switching between the two versions of the Gibbs Energy System 
(GES) calculation engine. As of Thermo-Calc version 2019b, GES6 is the default.  Also see 
About the Gibbs Energy System (GES) Module. 

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. However, not all GES5 functionality is implemented in GES6. In such 
cases (except for  the POURBAIX module), GES6 falls back silently and uses 
functionality from GES5 in the background. 

Syntax SET_GES_VERSION

Prompt

USE GES VERSION 5 OR 6 /6/:

The default is version 6. If you change the version to GES5, it is set for the current session of 
Thermo-Calc only. If you launch a new Console window, the version resets to GES6.

 

To globally set the default from GES6 back to GES5, go to the Tools → Options →  
Global General Settings tab and click Version 5 for the Preferred Gibbs Energy 
System setting. This is useful if you are using the PARROT module (optimization) or if 
you have a custom database that is not compatible with GES6.

Contact Thermo-Calc Software AB at info@thermocalc.com for more 
information about the changes or if you encounter any issues you think are 
related to the new version of the calculation engine. 

mailto:info@thermocalc.com
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SET_INTERACTIVE

Use the SET_INTERACTIVE command to reset the input and output units to the initial values, 
i.e. keyboard and screen. Add this as the last command to the macro files.
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SET_INTERACTIVE_MODE

Use the SET_INTERACTIVE_MODE command to reset the input and output units to the initial 
values, i.e. keyboard and screen. 

Remember to add this as the last command to your macro files, in order to stop 
execution of the command file in the POST module. It has no meaning in 
interactive mode.
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SET_LOG_FILE

Use it to save, in a basic text file, everything typed into Thermo-Calc. When having problems 
executing a command sequence, this command can be used to save the command typed 
onto a log file with the file extension *.TCM.

This command also makes the system echo the full command for all commands typed. This 
feature is useful when demonstrating the system since the abbreviated commands are often 
difficult.

The saved log file can then be edited as a macro file by using a basic text editor. This is useful 
to run the macro file(s) for similar calculations (the same system but slightly varied 
temperature-pressure-composition conditions), or run the example macro files.

Macro Files

Syntax SET_LOG_FILE

Prompt

A Save window opens to specify a file name for the *.TCM file, so that the path (in the Save in field) 
and File name can be specified. If a log file with the same name exists in the current working 
directory, it is overwritten. The Files of type (i.e. TCM) cannot be changed. Click Save or Cancel as 
applicable.
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SET_PLOT_ENVIRONMENT

Use this command to set the plot devices to save or print plots to, which varies for by 
installation type. 

This command must be terminated with an empty line or two commas.

Syntax SET_PLOT_ENVIRONMENT

Prompts

Default plot device number /Default number/: <Device number>

The number given is unique for each type of graphical device. The default graphical device number 
should normally be selected. A question mark ? gives you a list of all available graphical devices 
used.

 

Pseudo file name: <Pseudo-file name>

The name given here is a symbol which can be used to refer to a physical graphics device when 
asked for graphical output file.

 
Plot device number /1/: <Device number>

The number that specifies the type of graphical device.

 

Plot file name: <File name or printer name>

The name of the graphical device on system level (name of file or printer).

Example
SET_PLOT_ENVIRONMENT 1 lasp 5 a0tr,,

This example sets the default plot device number to 1, and defines an alias named lasp with plot 
device 5 and connected to a printer named a0tr.
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SET_TC_OPTIONS

Predefine the default values of three general  options for performing all the sequential 
single-points, stepping and mapping calculations.

Syntax SET_TC_OPTIONS

Prompts

Use_global_minimization /Y/: 

By default it global minimization is used where possible (depending on the conditions setting). A 
global minimization test is performed when an equilibrium is reached. This costs more computer 
time but the calculations are more robust. Enter N to prevent global minimization being used to 
reach the equilibrium.

 

Global_test_interval /0/: <An integer value>

The integer number determines how often the global minimization should be used during 
calculations with STEP_WITH_OPTIONS and MAP. If it is set to 0 (zero), the recommended global test 
interval is used: i.e. every tenth step and at each phase change during step calculations, and only at 
node points during map calculations. Any other positive integer number, n, suggests it performs 
global minimization tests at every nth step during step and map calculations. Of course, the Global 
Minimization test is always carried out at a phase change or a node point. The software is initially 
configured with 0 (zero) as the default value, but such a configuration for the default value can be 
changed by this option.

 

Automatically_add_initial_equilibria /Y/: 

When ADD_INITIAL_EQUILIBRIUM is not used before a map calculation, a mesh of INITIAL_EQUILIBRIUM 
is automatically added before the mapping procedure itself takes place. This mesh is only available 
when the two independent axis-variables have already been defined by the POLY command.

 

Set_axis_variable

If Y is entered, the POLY module always enforces the automatic procedures for adding initial 
equilibrium points during mapping. For N, no initial equilibrium points are then added during 
mapping.
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STOP_ON_ERROR

Useful for batch jobs in order to prevent that an erroneous sequence of commands to the 
program causes waste of computer activity.

Syntax STOP_ON_ERROR 

 
Give the preferred argument (ON or OFF) after the STOP command. If the default argument ON is 
given, the program terminates after an illegal or ambiguous command. It is possible to reset the 
effect of this command by giving the argument OFF. 
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Database (TDB) Module Commands

These commands are related to the DATABASE_RETRIEVAL module, which is 
also known as the TDB module.

Search the online help  for step-by-step instructions to define a system.

In this section:

AMEND_SELECTION 163

APPEND_DATABASE 164

DATABASE_INFORMATION 165

DEFINE_ELEMENTS 166

DEFINE_SPECIES 167

DEFINE_SYSTEM 168

GET_DATA 169

LIST_DATABASE 170

LIST_REFERENCES 171

LIST_SYSTEM 172

REJECT 173

RESTORE 174

SET_AUTO_APPEND_DATABASE 175

SWITCH_DATABASE 176
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AMEND_SELECTION

This command is for the DATABASE_RETRIEVAL (TDB) module.

Use this command after defining the elements, species or the system (with the commands 
DEFINE_ELEMENTS, DEFINE_SPECIES, or DEFINE_SYSTEM). The prompts allow changes to the 
predefined system. By answering Y or N, each of the selected elements, species or phases 
can be accepted or rejected (although this is not the case for the constituents or the entire 
system).

Syntax AMEND_SELECTION 

Prompt
Keep <Name1> No/Quit/Yes/

Keep <Name2> No/Quit/Yes/

Options
Keyword-- Elements/Species/Phases name&

Names of the pre-defined or pre-selected elements/species/phases
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APPEND_DATABASE

This command is for the DATABASE_RETRIEVAL (TDB) module.

Appends data to the current set of data already read from another database. The syntax is 
the same as for the SWITCH_DATABASE command.

This command enters all additional functions and parameters to already existing phases, e.g 
atomic mobilities, phase constituents, excess models, G0 and interaction parameters.

This command is most commonly used to read mobility data from stand-alone mobility 
databases.

This command should be used with some caution if thermodynamic data is appended and 
the application is run with Gibbs Energy System version 5 (see SET_GES_VERSION in the SYS 
module). It can change calculated values in an unexpected way. This can happen e.g. if the 
appended database has the same function name as a function in the data retrieved from a 
database opened with SWITCH_DATABASE.

Syntax APPEND_DATABASE 

Prompt
New database name /XYZ/: 

The name of either an existing database (e.g. FEDEMO) or USER.
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DATABASE_INFORMATION

This command is for the DATABASE_RETRIEVAL (TDB) module.

Use the DATABASE_INFORMATION command to obtain a short description of the current 
database. This can include information on covered systems, used models, valid ranges for 
parameters in temperature and composition, major applications, and so on.
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DEFINE_ELEMENTS

This command is for the DATABASE_RETRIEVAL (TDB) module.

Define the system in terms of elements. All possible species that can be formed by the given 
elements are retrieved from the database. The names of elements must be separated with a 
space or comma. It is possible to use a wildcard * after a common part of element names so 
that all the elements, which start with that common part and are available in the currently 
switched or appending database, are defined in the system. Up to 40 elements can be 
defined into a single system. 

Also see Defining a System in Console Mode for step-by-step instructions to 
define a system with this command.

Syntax DEFINE_ELEMENTS

Prompt
Element&  <Element1, Element2, …>

A list of elements to be defined into the system.

 
When appending database(s), this command, or DEFINE_SPECIES or DEFINE_SYSTEM 
must be repeated with the same or similar elements as defined in the first switched 
database. 
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DEFINE_SPECIES

This command is for the DATABASE_RETRIEVAL (TDB) module.

Define the system in terms of species. Only those species given are retrieved. The different 
names of species must be separated with a space or comma. It is possible to use a wildcard * 
after a common part of species names so that all the species, which start with that common 
part and are available in the currently switched or appending database, are defined in the 
system. Up to 1000 species can be defined in a single system.

 Defining a System in Console Mode

Syntax DEFINE_SPECIES 

Prompt
Species& <Species1, Species2, …>

A list of species to be defined in the system.

 
When appending database(s), this command, DEFINE_ELEMENTS or DEFINE_SYSTEM 
must be repeated with the same or similar elements as defined in the first switched 
database.  
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DEFINE_SYSTEM

This command is for the DATABASE_RETRIEVAL (TDB) module.

Define the system in terms of either elements (equivalent to DEFINE_ELEMENTS) or species 
(equivalent to DEFINE_SPECIES). Certain databases have a default value of the keyword (as 
either ELEMENTS or SPECIES) reflecting what is most appropriate when defining a system.

The different names of elements or species must be separated with a space or comma. It is 
possible to use a wildcard * after a common part of elements or species names so that all 
the elements or species, which start with that common part and are available in the 
currently switched or appending database, are defined in the system.

When appending database(s), this command (or DEFINE_ELEMENTS or DEFINE_SPECIES) must 
be repeated with the same or similar elements as defined in the first switched database. 
Different databases might contain different elements and have different species definitions: 
avoid defining elements/species that are missing in the appending database(s). Otherwise, 
the program indicates these missing elements/species, and ignores them in subsequent 
steps. But additional elements/species, and additional phases not available in the first 
switched database can be defined and retrieved from the appending database(s). Up to 40 
elements and 1000 species can be defined in a single system.

Also see Defining a System in Console Mode for step-by-step instructions to 
define a system with this command.

Syntax DEFINE_SYSTEM 

Prompt
Elements: <Element1, Element2, …>, or 

Species: <Species1, Species2, …>

Options Description

Species or Elements Default keyword.

Element& Specify a list of elements for the defining system.

Species& Specify a list of species for the defining system.
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GET_DATA

This command is for the DATABASE_RETRIEVAL (TDB) module.

Enter the defined system’s elements, species, phases, and the connected parameters 
obtained from either the primary switched or additionally appending database(s) to the 
GIBBS and/or DICTRA workspace. Then use the GET_DATA command to get all information 
concerning a defined system from the databank.

Only after executing this command can you go to any of the application 
programs such as GES, POLY or DICTRA and use the retrieved data. When 
appending database(s), this command must be repeated in order to obtain the 
additional system definitions, parameters and functions.
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LIST_DATABASE

This command is for the DATABASE_RETRIEVAL (TDB) module.

List all elements, species, phases or phase constituents in the database.

Syntax LIST_DATABASE 

Options Description

Keyword
One of the keywords Elements, Species, Phases or Constituent must be used to indicate what 
to list 

Elements
All available elements, the reference state, atomic mass, H298-H0 and S298. Some elements 
have spaces in the column for the reference state. This implies that there are no parameters 
stored for this element.

Species All available species together with the stoichiometric factors. 

Phases
All available phases together with the number of sublattices and the number of sites in each 
sublattice.

Constituent

All available phases, the number of sublattices, the number of sites in each sublattice and the 
species dissolved in each phase. Species in different sublattices are separated with a colon (:). It 
is important to realize, for example, a phase can consist of Fe, Mo, V, and Cr, and its 
thermodynamic parameters can come from the binary systems Fe-Mo, Fe-V, Fe-Cr, and Mo-Cr. 
These data can give a relatively good description of the corners of the Fe-Cr-Mo system, but 
would most certainly give a bad one for the system Mo-Cr-V, due to the fact that the 
interaction parameters are, by default, set to zero, which originates from binary systems not 
included in the database.



Thermo-Calc User Guide: Console Mode ǀ 171 of 622

LIST_REFERENCES

This command is for the DATABASE_RETRIEVAL (TDB) module.

Use the LIST_REFERENCES command to list the relevant literature references for the 
assessed data for the present system. The command is used after the GET_DATA command.

Syntax LIST_REFERNCES 

Prompt
There is no prompt after entering the command. The list of references is shown in the Console 
Window. 

You can highlight the list of references to copy to another program. Or if the 
reference list is very long, right-click the Console tab and select Copy Command 
History to Clipboard or Copy All Text to Clipboard (or use the keyboard 
shortcuts).
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LIST_SYSTEM

This command is for the DATABASE_RETRIEVAL (TDB) module.

List all elements, species, phases or phase constituents in the defined system. It works only 
after a system is defined.

Syntax LIST_SYSTEM 

Keyword

One of the keywords Elements, Species, Phases or Constituent must be used to indicate what to 
list.

LIST_DATABASE 
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REJECT

This command is for the DATABASE_RETRIEVAL (TDB) module.

Reject elements, species, phases or phase constituents that can form from the defined 
elements and species. Phases/species/constituents that are possible to form in the defined 
system are removed from the list of system phases/species/constituents (shown by the 
command LIST_SYSTEM). Phases/species/constituents that are not included in the list cannot 
be entered without first being restored. The different names must be separated with a space 
or comma. You can use a wildcard * after a common part of names so that all the 
elements/species/phases/constituents that start with that common part and are available in 
the currently switched or appending database, are rejected from the defined system.

This command can also reject a defined system, and thus reinitiate the entire DATA module 
memory and GES workspace.

Syntax REJECT

Prompt 1
(Keyword = Elements or Species or Phases)

If keyword: <Name1, Name2, …>

Prompt 2

(if keyword = Constituent)

Phase: <Phase name>

Sublattice number: <Sublattice number in the phase> 

Constituent: <Constituent(s) in the sublattice of the phase>

Prompt 3 If keyword = SYSTEM the DATA module is reset to its initial state; GIBBS is reinitiated and data 
already entered to GES is lost.

Options Description and additional information

Keyword
One of the keywords Elements, Species, Phases, Constituent or System must be used to 
indicate what is rejected.

Name& Names of the pre-defined elements/species/phases/constituents/system

Elements The given elements are rejected. 

Species The given species are rejected, making it impossible to form them from the defined elements. 

Phases
The given phases are rejected, making it impossible to form them from the defined elements or 
species.

Constituent

The given constituent in one phase are rejected. Add the following when prompted:

Phase: The name of the phase containing the constituent to be rejected. 

Sublattice number: The sublattice where the constituent enters (the first sublattice is 1). The 
question is omitted if there exists only one possible sublattice. 

Constituent: The name(s) of the constituent(s) to be rejected.
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RESTORE

This command is for the DATABASE_RETRIEVAL (TDB) module.

Restore already explicitly rejected elements, species, phases or constituents; it is the 
opposite of the command REJECT although it does not restore a completely rejected system. 

Phases/species/constituents that are possible to form from the defined elements or species 
are entered to the list of system phases/species/constituents (shown by the command LIST_
SYSTEM). Phases/species/constituents that are not included on the list can now be added to 
the list. The different names must be separated with a space or comma. It is possible to use 
a wildcard * after a common part of names so that all the 
elements/species/phases/constituents, which start with that common part and are available 
in the currently switched or appending database, are restored in the defined system.

Syntax RESTORE 

Prompt1
(if keyword = ELEMENTS or SPECIES or PHASES)

Keyword: <Name1, Name2, …>

Prompt2

(if keyword = CONSTITUENT)

Phase: <Phase name>

Sublattice number: <Sublattice number in the phase>

Constituent: <Constituent(s) in the sublattice of the phase>

Options Description and Information

Keyword
One of the keywords Elements, Species, Phases or Constituent must be used to indicate 
what is rejected.

Name& Names of the pre-defined elements, species, phases, and constituents

Elements The given elements are restored.

Species The given species are restored and thus possible to form from the defined elements.

Phases The given phases are restored and thus possible to form from the defined elements or species. 

Constituent

The given constituent in one phase are restored.

Add the following when prompted:

Phase: The name of the phase containing the constituent to be restored. 

Sublattice number: The sublattice where the constituent enters (the first sublattice is 1). 

Constituent: The name(s) of the constituent(s) to be restored.
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SET_AUTO_APPEND_DATABASE

This command is for the DATABASE_RETRIEVAL (TDB) module.

Enforce an automatic action that appends thermodynamic data from a chosen database 
regarding the system to the data you already have about the system from the current 
database (that is, the default database or the database last chosen with SWITCH_DATABASE or 
APPEND_DATABASE). 

This is useful to simultaneously retrieve both thermodynamic and mobility data 
for a defined system when performing a DICTRA module simulation.

This command should be used before defining a system (with the commands DEFINE_
ELEMENTS, DEFINE_SPECIES, or DEFINE_SYSTEM) and retrieving the data with the GET_DATA 
command from the primary switched database. 

Syntax SET_AUTO_APPEND_DATABASE 

Prompt Database name /XYZ/: <Additional database name>

Option

Additional database name

The name of an existing database or a User database that corresponds to the 
automatically-appending database.

It works in a way that is similar to the APPEND_DATABASE<DATABASE-NAME> command 
sequence, but only the phases that are also available in the primary switched database are 
appended. There is no possibility to manually list, reject and/or restore any phase that is 
available in the appending database. When retrieving data with GET_DATA afterwards, all the 
phases that exist in the appending database but not in the primary switched database are 
automatically rejected. The prompt is kept as for the primary switched database, TDB_XYZ: 
(where XYZ stands for the name of the primary switched database) until the execution of 
GET_DATA.

Therefore, to selectively append more phases from a secondary database to a system that is 
defined and retrieved from a primary switched database, then APPEND_DATABASE and 
sequential commands (such as DATABASE_INFORMATION, DEFINE_SYSTEM, DEFINE_ELEMENT, 
DEFINE_SPECIES, LIST_SYSTEM, REJECT, RESTORE and GET_DATA) should be used instead, before 
this command.

Although it is impossible to manually list, reject and restore any phase from the appending 
database, the DATA module automatically ignores all the phases that do not exist in both the 
primary switched database and the appending database, and append the data for the 
phases (that are also available in the primary switched database) from the appending 
database, as informed on screen when executing GET_DATA afterwards.
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SWITCH_DATABASE

This command is for the DATABASE_RETRIEVAL (TDB) module.

Switch (or change) from the current database to a new one. It also reinitializes the entire 
module.

The database can be either a standard database (the ones in tc_initd.tdb) or a so-called 
user database. To open your own (user) database, type USER followed by the path to the 
user .TDB file or press <Enter> and select it in the window that opens.

Syntax SWITCH_DATABASE 

Prompt
New database name /XYZ/: 

The name of either an existing database (e.g. FEDEMO) or USER. 
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POLY Module Commands

In this section:

ADD_INITIAL_EQUILIBRIUM 181

ADVANCED_OPTIONS 184

AMEND_STORED_EQUILIBRIA 185

CHANGE_STATUS 187

COMPUTE_EQUILIBRIUM 192

COMPUTE_TRANSITION 194

CREATE_NEW_EQUILIBRIUM 196

DEFINE_COMPONENTS 197

DEFINE_DIAGRAM 198

DEFINE_MATERIAL 201

DELETE_INITIAL_EQUILIBRIUM 205

DELETE_SYMBOL 206

ENTER_SYMBOL 207

EQUILIBRIUM_CALCUL 210

EVALUATE_FUNCTIONS 212

GLOBAL_MINIMIZATION 213

KEEP_COMP_SET_NUMBERS 215

LIST_AXIS_VARIABLE 216

LIST_CONDITIONS 217

LIST_EQUILIBRIUM 218

LIST_INITIAL_EQUILIBRIA 219

LIST_PHASE_ADDITION 220

LIST_STATUS 221
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LIST_SYMBOLS 222

LOAD_INITIAL_EQUILIBRIUM 223

MAKE_COMPONENT_ENTERED 224

MAKE_COMPONENT_SUSPENDED 225

MAJOR_CONSTITUENTS 226

MAP 227

NEW_COMPOSITION_SET 229

OUTPUT_FILE_FOR_SHOW 231

PARAEQUILIBRIUM 232

PHASE_ADDITION 235

POST 236

PRESENT_PHASE 237

READ_WORKSPACES 238

REINITIATE_MODULE 239

SAVE_WORKSPACES 240

SELECT_EQUILIBRIUM 242

SET_ALL_START_VALUES 243

SET_AXIS_VARIABLE 245

SET_CONDITION 247

SET_INPUT_AMOUNTS 250

SET_INTERACTIVE 251

SET_NUMERICAL_LIMITS 252

SET_REFERENCE_STATE 254

SET_START_CONSTITUTION 256

SET_START_VALUE 257

SHOW_FOR_T= 258
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SHOW_VALUE 260

STABILITY_CHECK 261

STEP_AND_MAP 262

STEP_WITH_OPTIONS 264

TABULATE 277

TOGGLE_ALTERNATE_MODE 278

T-ZERO_TEMPERATURE 279
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ADD_INITIAL_EQUILIBRIUM

This command is for the  POLY module.

Add initial equilibrium points from which a phase diagram is calculated (through the MAP 
command). 

For each initial equilibrium the first stage of the mapping varies the value of the given axis 
variable condition, changing it in the given direction. When a phase change is found it is 
saved as a start equilibrium, and if the symbol ">" was used, it continues the search until the 
end of the axis variable. 

If no axis variable conditions differ between   initial equilibria then the map 
results in several overlaid diagrams, in accordance with the selected conditions 
and the values.

The ADD_INITIAL_EQUILIBRIUM default command implicitly makes the MAP command search 
for phase changes according to settings set by ADVANCED_OPTIONS STEP_AND_MAP 
command. Default for STEP_AND_MAP are three initial equilibrium equidistantly along each 
axis variable, along the edge of the axis variable rectangle.

By default these default start points are used in MAP. If any ADD_INITIAL_EQUILIBRIUM is used 
these default start points are not used. They are again used if the command ADD default is 
used together with another ADD_INITIAL_EQUILIBRIUM command.

The ADD command with the default direction scans along the axis variables and generates 
start points each time the scan procedure crosses a phase boundary. In addition, it 
generates four start points, scanning cross the middle of each axis, if there is any solubility 
line that does not reach the axes. At the MAP command, a search for lines in the diagram is 
made along each direction of the axis variables in the diagram.

In this way, it should guarantee that all possible phase boundary lines in a phase diagram are 
found. It may take a little longer to execute than using the minimum number of start points, 
as some lines may be calculated more than once. But the POLY module remembers all node 
points and subsequently stops calculations along a line when it finds a known node point.

It is also possible to create a sequence of start points from one initial equilibria by appending 
a > after the direction at the ADD command. For example:

Direction /Default/: 2>

Direction /Default/: -2>
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This generates one start point for each set of phase change in the positive direction of the 
axis 2 (or negative direction of the axis 2); this ensures finding all possible phase boundary 
lines (not just the first one) along such an axis direction.

This is particularly useful when you have a phase diagram with several lines with no 
intersection. It is thus possible to calculate e.g. an isopleth for a much more limited 
composition range. It is also useful for calculating CVD diagrams and Pourbaix diagrams.

Syntax ADD_INITIAL_EQUILIBRIUM 

Prompt

Direction /Default/: <Direction code>

Direction code(s):

 l 1 or 2   for positive direction of axis 1 or 2, respectively.

 l -1 or -2  for negative direction of axis 1 or 2, respectively.

 l Default  for MAP to start looking for phase changes from each corner of the axis variable 
rectangle. 

The direction is important when the initial equilibrium point is in a single-phase region or when the 
diagram is an isopleth (tie-lines not in the plane of calculation). In such cases, the program will 
search for a line in the diagram (i.e., a line where the amount of a phase is zero) in the given 
direction.

Normally, this command is not needed to calculate a property diagram (with the STEP_WITH_
OPTIONS → NORMAL command-sequence), as the STEP procedure starts from the current 
equilibrium state already calculated. In many cases, the ADD_INITIAL_EQUILIBRIUM command 
is not required for MAP commands either.

In order to calculate a simple property diagram, set the equilibrium conditions and the 
stepping axis variable, and then give a STEP command. But if a phase diagram has 
disconnected lines, ADD_INITIAL_EQUILIBRIUM may still be needed to add two or more initial 
equilibria so that the MAP calculation starts from such initial equilibria at the specified 
directions to find all phase boundary lines.

This command becomes unnecessary in most cases, as the MAP routines that by default use 
the Global Minimization Technique handles all the initial equilibrium points in a robust and 
automatic way. Therefore, you do not need to have a good guess of the starting point and to 
add any initial equilibrium point prior to the calculations of various types of phase diagrams. 
However, if preferred, use this command to add any initial equilibrium points in certain 
directions, the POLY module uses the specified starting point(s) and corresponding user-
added initial equilibrium point(s) for a mapping calculation; in such a case, the automatic 
procedure in the rewritten MAP routines are not enforced while the Global Minimization 
Technique can still be applied. Similar situations occur when a specific database, in which 
there are some definitions of initial-equilibrium adding direction(s) for accessed binary 
and/or ternary subsystems in its ACCESSED_SYSTEM section, is used in the BINARY or 
TERNARY module for calculating a binary or ternary phase diagram.
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All the initial equilibrium points generated by ADD_INITIAL_EQUILIBRIUM (previously and 
presently; saved in the current POLY workspace) can be easily listed on screen with LIST_
INITIAL_EQUILIBRIA. A certain initial equilibrium point (including its conditions and 
equilibrium results) can be loaded into the current equilibrium, if needed, with LOAD_
INITIAL_EQUILIBRIUM. Any specific or all of the initial equilibrium points can be deleted from 
current POLY workspace, if desired, with DELETE_INITIAL_EQUILIBRIUM.
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ADVANCED_OPTIONS

This command is available with the POLY and ED-EXP modules.

Syntax ADVANCED_OPTIONS

Prompt Which option? /Step_and_Map/:  <Option>

Several options are available after you enter this command at the prompt. The default is 
STEP_AND_MAP.

 l EQUILIBRIUM_CALCUL
 l GLOBAL_MINIMIZATION
 l KEEP_COMP_SET_NUMBERS
 l LIST_PHASE_ADDITION
 l MAJOR_CONSTITUENTS
 l NEW_COMPOSITION_SET
 l OUTPUT_FILE_FOR_SHOW
 l PARAEQUILIBRIUM
 l PHASE_ADDITION
 l PRESENT_PHASE
 l SHOW_FOR_T=
 l STABILITY_CHECK
 l STEP_AND_MAP
 l TOGGLE_ALTERNATE_MODE
 l T-ZERO_TEMPERATURE
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AMEND_STORED_EQUILIBRIA

This command is for the  POLY module.

This command gives information about the calculated blocks (and phase regions included in 
blocks) after the STEP or MAP calculation(s). It allows you to list all or part of the calculation 
results, to suspend all or parts of the calculation results that are redundant or where 
metastable equilibria are calculated, and to restore all or parts of the calculation results (if 
having been suspended by another AMEND_STORED_EQUILIBRIA command).

The workspace for storing equilibria may overflow during stepping or mapping, and is then 
written to a file as blocks. Each block usually contains one or more ranges of equilibrium 
regions.

Use one these options:

 l L to list the calculated equilibria (all or a specified block)
 l S to suspend everything (all blocks and their regions)
 l Q to suspend each set of equilibria individually (specified blocks and/or regions)
 l R to restore everything (all blocks and their regions)

Syntax AMEND_STORED_EQUILIBRIA

Prompts

Name: <Name of a defined table>

List (L) the calculated equilibria, suspend everything (S) or suspend each set of equilibria 
individually (Q), or restore everything (R).

 

Block /*/: <Block number>

Specify a block number in the option L, S, Q or R. Or include all the blocks in the amending option, 
by accepting the wildcard * (press  <Enter>).

For L, a block (if a block number is specified) or all the blocks (if the wildcard * is accepted/used), 
with the regions and the equilibrium details, that are calculated during stepping or mapping is listed 
on screen or in a textual file.

For Q, each ranger in a block (if a block number is specified) or in all blocks (if the wildcard * is 
accepted/used) then choose:

 

S(uspend) K(eep) /K/: <S or K>

For S or R, if a block is specified, you are asked what region in the block should be suspended or 
restored. However, if the wildcard * is accepted/used, you are asked the following:

Really suspend all /N/: 

Really restore all /N/: 

In both cases the default is N and you are prompted for which block(s) and which region(s) in a 
certain block to execute the S or R action.

Really suspend all /N/: 
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Syntax AMEND_STORED_EQUILIBRIA

Y suspends everything.

Really restore all /N/: 

Y restores everything.

 

Range: <Range(s) of region>

Specify one or more ranges to be suspended (the S option) or restored (the R option). The wildcard 
* suspends or restores all ranges in the specified block.

In order to know the ranges the LIST command must first be used.

 

S(uspend) K(eep) /K/: <S or K>

The Query suspend option (Q) asks for each region in a certain block if it should be suspended or 
kept. Suspended regions are not included on sequentially generated plots.

 

Output file: /Screen/: <File name>

This prompt is only for listing (the L option), and after it the command is terminated. The file name 
must be given here; or accept the default Screen (terminal) by pressing <Enter>. A list of stored 
equilibria as various blocks (with all their ranges) are shown out on screen or the file.
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CHANGE_STATUS

This command is available with the POLY and ED-EXP modules.

In the POLY module, set the status for components, species and phases in the defined 
system for all the sequential calculations (single-point, stepping, and mapping) in 
equilibrium or local/partial equilibrium state. Each component, species and phase has a 
status. The default status is ENTERED.

The most important use is to calculate metastable equilibria and metastable phase diagrams 
by setting some phases (that would otherwise be stable) to the SUSPENDED or DORMANT 
phase-status. Another important applications is to calculate paraequilibria by setting some 
components to the SPECIAL component-status.

For a component and for a species, the status can be one of the following:

 l ENTERED: the component(s) or species are included in the calculation. This is the 
default status.

 l SUSPENDED: the component(s) or species are not considered in the calculation.
 l SPECIAL: the specified component(s) are not included in summations for mole or 

mass fractions. It only works for component(s).

Only component(s) can have the status SPECIAL, which implies that these are 
not included in summations for mole or mass fractions. 

For example, for the u-fractions or other normalized fractions, when one or more of the 
components are excluded from the summation, you must specify which component(s) 
should be excluded from the calculation of mole or mass fraction. This component status is 
particularly useful when calculating paraequilibrium states. Such component(s) are normally 
interstitial component, and must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command.

Syntax CHANGE_STATUS 

Prompts
For phases, species or components? /Phases/: <Keyword>

Keyword = phase or species or components

 

Phase name(s): <Name(s) of the phase(s)>

For phase as the keyword, the names of the phases that have their status changed must be given 
(all on one line). A comma or space must be used as separator. The status to be assigned to the 
phases can also be given on the same line if preceded with an equal sign (=). 
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Syntax CHANGE_STATUS 

An asterisk, *, can be used to denote all phases. The special notations *S, i.e. a 
wildcard * directly followed by an S, sign, means all suspended phases. In the same 
way, *D means all dormant phases, and *E means all entered phases.

 

Name(s): <Name(s) of the Species or Component(s)>

For species or components as the keyword, the names of the species or components that have their 
status changed must be given (all on one line). A comma or space must be used as separator. 
Similarly to the case of phase as the keyword, the status to be assigned to the species or 
components can also be given on the same line if preceded with an equal sign =. 

An asterisk, *, can be used to denote all species or components. The special 
notations *S, i.e. a wildcard * directly followed by an S, sign, means all suspended 
species or components. In the same way, *E means all entered species or 
components.

 

Status /Entered/: <New status>

The new status to be assigned must be given.

For species, the values ENTERED or SUSPENDED can be used.

For the POLY module, using the Entered or Suspended status here has the same 
result as using the commands MAKE_COMPONENT_ENTERED and MAKE_
COMPONENT_SUSPENDED. The  exception is that any existing conditions that 
depend on a suspended component are removed when using the MAKE_
COMPONENT_SUSPENDED command.

For components, the status ENTERED, SUSPENDED or SPECIAL can be given. SPECIAL means that this 
component is excluded from sums for mole fractions and mass fractions, which is useful when 
calculating the ufractions or other normalized fractions of system components.

For phases, the status ENTERED, SUSPENDED, DORMANT or FIXED can be given. DORMANT means the 
same as suspended but the driving force is calculated. FIXED means that it is a condition that the 
phase is stable at a certain amount.

For example, for the ufractions, when one or more of the components are excluded from the 
summation, you must specify which component should be excluded from the calculation of the 
mole fraction. This component must have the status SPECIAL. This is assigned by the CHANGE_STATUS 
command: Change_Status comp C=special.

 

Start value, number of mole formula units /0/: <Initial amount>

For ENTERED phases, an initial amount of the phase can be given. Normally, 0 is given if the 
phase is not likely to be stable, and 0.5 or 1 or any positive number if the phase could be stable, but 
such an initial amount is only used as the rough starting estimation in the equilibrium calculations.

 Number of mole formula units /0/: <Equilibrium amount>
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Syntax CHANGE_STATUS 

For FIXED phases, the equilibrium amount of the phase [always using an initial estimation being 
the NPF(phase) value which it is the normalized mole number of components (per mole formula 
unit) of the specific status-fixed phase] must be given. If the equilibrium amount is zero, then the 
phase is at its stability limit.

NOTE WHEN SPECIFYING A FIXED PHASE STATUS

Special attention should be paid when specifying a FIXED phase status in equilibrium calculations 
(for single points, stepping or mapping calculations), as described below.

The phase amount variables, NP(phase), BP(phase) and VP(phase), as well as all their M/W/V-
suffixed quantities, should not be used as conditions. Instead, use the CHANGE_STATUS command 
to set a relevant condition, e.g. CHANGE_STATUS phase <phase>=fix <amount> where the fixed 
<amount> is roughly the same as the F-suffixed quantity NPF(phase).

The NPF(phase) quantity is the normalized mole number of components (per mole formula unit) of 
the specific phase in the defined system, which unlike other F-suffixed state variables [e.g. GF
(phase), HF(phase) and DGF(phase)] cannot be directly applied in any POLY command, implying that 
it cannot be directly evaluated or listed/shown. If intended to shown such a normalized phase 
amount value in an equilibrium state, you should use a properly-entered symbol (function or 
variable), for example: NPFabc = NP(abc)/NA or NPFabc = NPM(abc)/NA*N. N is the total system 
size (in mole). The NA value is a quantity that is phase-dependent (and sometimes also equilibrium-
dependent for ionic solution phases), and is the total atomic number in a mole-formula-unit of the 
specific phase abc (excluding interstitial component and, of course, vacancy).  For example, the 
SIGMA, FCC, BCC and LIQUID phases (among others) in a defined Fe-Cr-Ni-C-N-O system (retrieved 
from a specific database) may be modeled by certain models, and their NA values must be 
evaluated in different ways, as described below:

LIQUID (C,Cr,CrO3/2,Fe,FeO,FEO3/2,N,Ni,NiO)1  NA = 1

FCC_A1 (Cr,Fe,Ni)1(Va,C,N,O)1 NA = 1

BCC_A2 (Cr,Fe,Ni)1(Va,C,N,O)3 NA = 1

SIGMA (Fe,Ni)8(Cr)4(Cr,Fe,Ni)18 NA = 30

If in the same Fe-Cr-Ni-C-N-O system the liquid solution phase is modeled by the Two-Sublattice 
Ionic Liquid Model, i.e.:

IONIC_LIQ  (Cr+3,Fe+2,Ni+2)p(VA,C,N,O-2,FEO3/2)q,7

then the evaluation of its NA value becomes even more complicated:

NA = p + q*yC2 + q*yN2 + q*yO2-2 + q*yFeO2 3/ 2

where the stoichiometric coefficients p and q are also dependent upon the real equilibrium state 
(rather than having fixed values in the system). Similar situations occur for other (solid) phases 
which are described by a multiple sublattice model with ionic constituents, such as SPINEL and 
HALITE phases in some databases.

There is no strange thing when using a zero value [i.e. 0] in a FIXED phase-status, since it means the 
specified phase is stable in equilibrium state but has a zero-amount of mass in the equilibrium 
calculations; in other words, on a phase diagram, the specific phase is on a zero-fraction line (ZFL), 
i.e. it starts becoming stable on one side of a corresponding phase-boundary line or unstable on the 
other side of the same boundary. It is often and efficient to do so when calculating e.g. solidus 
equilibrium states.

However, when a non-zero value [it must always be positive; e.g. 1 or 0.5 or 0.3 or 1.5] is to be 
specified in a FIXED phase-status, it is unnecessarily the exactly same stable amount of the specific 
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Syntax CHANGE_STATUS 

FIXED-status phase in a calculated equilibrium state any longer; instead, the <equilibrium amount> 
value is the NPF(phase) value that is only roughly used as the estimated starting-value of the FIXED-
status phase in the equilibrium calculations.

Therefore, a FIXED-status for a liquid phase being unity does not necessarily imply that it is a 
liquidus equilibrium state (where the liquid phase is in equilibrium with some solid phases but the 
liquid phase takes all the mass in the defined system). A unity value for setting the liquid phase 
status in calculating liquidus equilibrium state can only be used when the liquid mixture phase is 
predefined as a single-sublattice solution phase (such as metallic liquid phase in multicomponent 
alloy systems) and the total system size as one mole (i.e. N=1).

When a phase is described by a solution model in which two or more sublattices are considered and 
these sublattice sites may also have different stoichiometric coefficients [meaning that the mixture 
phase could have more than one atom in formula [NA>1; see some examples above], the unity 
value should not be used when setting the FIXED status for the phase; instead, you should use an 
appropriate value that ranges from 0 to a NPF(phase) value that equals to or is smaller than 1/NA (if 
the total system size N=1) or 1/NA*N (if N differs from unity). For this reason, if a multicomponent 
system bears an IONIC_LIQUID phase that is described by the Two-Sublattice Ionic Liquid Model (or 
any other multiple-sublattice ionic solution phases), it is difficult to use a proper NPF(ION_LIQ) 
value in setting its FIXED phase-status, because that should be less than (or equal to) the complex 
value of

N/[p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2 ].

Examples

For example, to obtain the metallic fraction in a system with carbon as an interstitial 
component, you can set the component status for carbon as SPECIAL:

Change_Status comp C=special

The SUSPENDED status for components and species does not always work as 
expected.

For a phase, it may have one of these statues:

 l ENTERED: the phase(s) are included in the equilibrium calculations and these are 
stable if that minimizes the total Gibbs energy in the defined system. This is the 
default status for all phases already retrieved from the chosen database(s). An 
ENTERED phase-status is always associated with an initially-estimated amount [in 
mole number; normally, as 0 if the phase is not likely to be stable, and as 0.5 or 1 or 
any positive number if the phase could be stable] but it is only used as the rough 
starting value in the equilibrium calculations.
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 l SUSPENDED: the phase(s) are not considered in the equilibrium calculations.
 l DORMANT: the phase(s) are not considered in the equilibrium calculations but their 

driving forces for precipitation are calculated.
 l FIXED: it is an equilibrium condition that the status-fixed phase must be stable, and 

be in equilibrium at a specified amount [always using an initial estimation being the 
NPF(phase) value which it is the normalized mole number of components (per mole 
formula unit) of the specific status-fixed phase]. See more descriptions at the end of 
this command.
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COMPUTE_EQUILIBRIUM

This command is for the  POLY module.

The full equilibrium state is calculated for the given set of conditions. The Global 
Minimization Technique is by default enforced in this command (C_E), while it can be 
disabled temporarily (for the current single-point equilibrium calculation) if using C_E – or C_
E * command-combination, or permanently (for all the sub sequential single-point 
calculations or stepping/mapping calculations within the current TCC run) if having decisively 
switched it off by a user (or possibly in some special modules) through changing the 
minimization option using the ADVANCED_OPTIONS → MINIMIZATION_OPTION command-
sequence.

Syntax COMPUTE_EQUILIBRIUM

Prompt

The C_E command can be used, in order to enforce the ordinary POLY minimization routines in an 
equilibrium calculation; this is because of that the ordinary C_E command is now associated with the 
Global Minimization Technique, and only after the Global Minimization

If technique is permanently switched off the C_E command makes no difference from the C_E – 
command-combination.

Only certain types of equilibrium conditions [e.g. T, P, N, N(<component>), X(<component>), B, B
(<component>), and W(<component>)] are fully supported in the Global Minimization mode (called 
Direct Global Minimization); and when other types of equilibrium conditions are used, after the 
initial POLY, a Global Minimization test and corrections are performed until the lowest minimum is 
found (called Indirect Global Minimization).

If there is any problem with convergence, you may try the C_E * command-combination. The 
character * enforces the command to use an advanced technique to obtain a complex equilibrium. 
However, after a successful C_E *calculation, you may repeat the C_E command and can check the 
status of phases, species or components (with LIST_STATUS → CPS command-sequence) and 
equilibrium conditions (with LIST_CONDITIONS) and list out the calculation results (with LIST_
EQUILIBRIUM), because such actions may tell you how to further modify various settings for your 
current calculation. This command-combination is not that useful anymore, because the Global 
Minimization Technique that is always associated with the C_E command is even more powerful and 
more precise in finding the most-stable equilibrium state in a complex heterogeneous interaction 
system; therefore, the C_E * command-combination is functional and can be used only after the 
Global Minimization mode has already been disabled temporarily or permanently.

Some phases that are not stable in the current equilibrium state may not have their most favorable 
composition after this command, and thus their driving forces may not be correct. You can force the 
program to correctly calculate the driving forces of metastable phases, by giving repeated C_E 
commands until the number of iterations (that is shown on screen after this command) is reduced to 
2.

Also see the POLY command SET_NUMERICAL_LIMITS which can set the approximate 
driving force for metastable phases option on or off in all the subsequent POLY 
calculations within the current TCC run.
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Syntax COMPUTE_EQUILIBRIUM

If an equilibrium state for the defined system is not found, an error message is given. 

You can try repeating this command a few times, or change some of settings for the numerical limits, 
for starting variables and starting values, for starting constitutions of certain phases and for 
reference states of certain components, or to verify some of the defined conditions.
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COMPUTE_TRANSITION

This command is for the  POLY module.

This command is a combination of the CHANGE_STATUS, SET_CONDITION and COMPUTE_
EQUILIBRIUM commands. It allows a direct calculation when a new phase may form by 
varying one of the already-set conditions. It can be used only after at least one equilibrium is 
calculated successfully; otherwise, you are informed on the necessity of first making an 
equilibrium calculation to find out the stable phases under the current conditions.

When this command is used, the program calls the command CHANGE_STATUS to temporarily 
change the phase status of a specified phase as FIXED at the zero amount, and at the same 
time to temporarily release one of the existing equilibrium conditions (which is chosen by 
you). The program calculates a new equilibrium in which that specific phase is stable but its 
equilibrium amount in the system is zero. The released condition is then assigned with a 
calculated value that ensures the calculated equilibrium. After wards, the program 
automatically changes the phase status of that specific phase back to ENTERED, and resets 
the temporarily released condition as one of the conditions and assigns it with the value that 
is calculated to ensure the zero-amount formation of that specific phase.

This command is useful to find melting temperature, boiling temperature, or solubility limits, 
and generally when you want to set the most optimal conditions for calculating an 
equilibrium where a specific phase becomes stable. It can also be used when you want to 
know exactly how far away the defined conditions are from the value that can ensure a zero-
amount of a specific phase in the system when other conditions remain the same.

After a successful calculation, you can issue a COMPUTE_EQUILIBRIUM calculation to assure the 
calculated transitional equilibrium is a really stable one, and can also use LIST_EQUILIBRIUM 
to see the details of transitional equilibrium state.

Syntax COMPUTE_TRANSITION

Prompts

Phase to form: <Phase name>

A new phase name, e.g. BCC that is expected to form, is specified here. This changes the status of 
this new phase to be FIXED as 0 amount, and the program shows the information such as:

You must remove one of the these conditions

P=100000, T=800, N=1, X(FE)=.5    DEGREE OF FREEDOM 0

If the key word ANY is used when prompted for Phase to form (instead of a specific phase name), it 
is possible to find out any new phase to be formed, in a given varying direction sign and at an 
estimated change of the released condition: a negative sign means at a lower value of the released 
condition any new phase is to be found, and a positive sign at a higher value; an estimated change 
of the released condition implies where any new phase is expected (but it is only estimated value, 
so any value within its reasonable scale would be enough). Such calculations can be repeated if 
required. This feature is useful to find out all possible phase transformations along a certain 
released condition.
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Give the state variable to be removed /T/: <One condition>

One condition must be removed, in order to calculate the transition equilibrium where the 
specified (or any) new phase to be formed at a calculated value of this released variable.

 

Therefore, the message may display (after a successful calculation) if, for example, X(Fe)is entered:

To form BCC the condition is set to X(FE)=.48605791769

This calculated value is assigned as the parameter of that removed condition, in this case, the X(FE) 
variable. If the LIST_CONDITIONS command is typed this message displays:

P=100000, T=800, N=1, X(FE)=4.86057918E-1

DEGREES OF FREEDOM 0

If the key word ANY (instead of a specific phase) is given as the phase name when it is prompted for 
Phase to form, the line is prompted for a given varying direction sign and an estimated change of 
the released condition before the calculation of transition equilibrium:

 

Estimated change (with sign) /1/: <+/-#>

A given varying direction sign and an estimated change of the released condition, in this case as X
(FE), must be given here: a negative sign means at a lower value of the released condition any new 
phase is to be found, and a positive sign at a higher value; an estimated change of the released 
condition implies where any new phase is expected (but it is only estimated value, so any value 
within its reasonable scale would be enough). For example, if a combination of -0.02 is input, this 
message may display (after a successful calculation):

To form BCC_A2#1 the condition is set to X(FE)=.493708756187

This calculated value is then assigned as the parameter of that removed condition, in this case, the 
X(FE) variable. The message is shown if the LIST_CONDITIONS command is typed:

P=100000, T=800, N=1, X(FE)=4.93708756E-1

DEGREES OF FREEDOM 0
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CREATE_NEW_EQUILIBRIUM

This command is available with the POLY and ED-EXP modules.

During data-assessments using the ED_EXP module (a submodule of PARROT), you can, in 
the POLY module, create several equilibria with different sets of conditions and phases (but 
normally with the same set of components). By default, there is one equilibrium. To keep 
the set of conditions and phase for this equilibrium, create another one using this command, 
and use another set of conditions for that. Two equilibria may be useful to calculate easily 
the enthalpy difference between two states. In the PARROT module, the experimental 
information is stored as a sequence of equilibria.

Syntax CREATE_NEW_EQUILIBRIUM

Prompts

Equilibrium number /2/: <A new equilibrium number>

Each equilibrium in the POLY workspace is identified by a unique integer number. Such an 
equilibrium number can be recalled with SELECT_EQUILIBRIUM.

 

Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all components and phases (initiation 
code 2), ENTER the components only (initiation code 1) or SUSPEND everything (initiation code 0). No 
other values are legal. 

The entered components and phases can later be changed with CHANGE_STATUS.
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DEFINE_COMPONENTS

This command is available with the POLY and ED-EXP modules.

Change the set of components. By default, the elements are used as components. The set of 
components can be important because some conditions are set using components, for 
example, the amounts, activities or chemical potentials.

For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components, 
thus replacing the default FE, SI and O.

This implies a command REINITIATE_MODULE and it should be given as the first 
command in the POLY module.

Syntax DEFINE_COMPONENTS 

Prompt

Give all new components / existing components/: <New components>

The new components must be specified all on one line. These replace the existing component 
definitions. 

The number of components cannot be changed with this command. Use CHANGE_
STATUS instead.

 

To keep some existing components, it is recommended that you also enter these on the line. 
Otherwise, the added new components may not be defined correctly. This is especially important if 
some components are built out of several elements.

The new components do not have to be present as species. 
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DEFINE_DIAGRAM

This allows automatic calculation and plotting of a diagram with a single command. It is the 
same as the DEFINE_MATERIAL command up to when the first equilibrium is calculated. The 
alloy OPTION feature is also available in this command to specify alloying compositions for a 
special alloy predefined by the OPTION keyword in a selected database (e.g. the TCNI Ni-
based Superalloys Database).

Use this command to calculate all types of phase diagrams after specifying all composition 
value and an initial temperature (if temperature is used as an axis). However, for binary and 
ternary diagrams, the special BIN and TERN modules may be preferred.

It then lists all the independent variables for the defined system (i.e. temperature and the 
components) and asks for a variable as the X-axis. You must also specify a maximum and 
minimum for the X-axis. The second axis (Y-axis) can be another composition (or the 
temperature if that is not on the X-axis) from the independent variable list. The program 
then calculates and plots a phase diagram, as there are two independent quantities on the 
axes.

Alternatively, select a dependent quantity as the Y-axis variable from the second list on 
screen (e.g. the amount of all phases, composition of a specific phase, or fractions of a 
component in all phases), and the program calculates and plots how this quantity depends 
on the condition on the X-axis. This is a property diagram.

This command ends up within the POST module monitor. You can refine the calculated 
phase diagram or property diagram.

Moreover, many more property diagrams with axes other than compositions can also be 
plotted (after the calculation), using SET_AXIS_VARIABLE in the sequent POST monitor.

Syntax DEFINE_DIAGRAM

Prompts

These prompts are given:

Same elements as before /Y/?  

Mole percent of <Element> /##/: <Value> 

or

Mass percent of <Element> /##/: <Value>

Database /ABCDE/: <Database name>

Major element or alloy: <Element name>

Composition in mass (weight) percent? /Y/: 

1st alloying element:  <Element name>

Mass (weight) percent: <Amount of the above specified element>

2nd alloying element: <Element name>

Next alloying element: <Element name>

Mass (weight) percent: <Amount of the above specified element>
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Temperature (c) /1000/: <Temperature of interest in oc>

Reject phase(s) /none/: <List of phase(s) to be rejected>

Restore phase(s) /none/: <List of phase(s) to be restored>

OK? /Y/: <Y or N>

Should any phase have a miscibility gap check? /N/: 

Phase with miscibility gap: <phase name>

Major constituent(s) for sublattice #: /aa/: <Constituent(s)>

Phase with miscibility gap: <Phase name>

The first equilibrium is calculated, as with DEFINE_MATERIAL. Then a list of all independent conditions 
suitable to be chosen as X/Y-axis variables is given by the program.

 

Quit? /Y/: <Y or N>

This question is asked only when the axis variables are already defined, or if DEFINE_DIAGRAM is 
used. It then offers an opportunity to quit (Y) the calculation or to continue (N) the calculation but 
by defining other axes.

 

Give the number of the condition to vary /1/: <A condition index>

Select one of the independent conditions by giving its index on the condition list as the X-axis 
variable.

 

Minimum value /XXX/: <minimum value for X-axis>

Specify the minimum value of the chosen X-axis variable. A default value is shown automatically by 
the program; press <Enter> to accept it or input another value.

 

Maximum value /YYY/: <maximum value for X-axis>

Specify the maximum value of the chosen X-axis variable. A default value is shown automatically by 
the program; press <Enter> to accept it or input another value. Then another list with some 
dependent quantities is given by the program, which can be selected as the Y-axis variable.

 

Give the number of the quantity on the second axis /#/: <##>

Select one of the independent conditions or dependent quantities as the Y-axis variable, by giving 
its corresponding index given on the condition lists. 

It must be different from the X-axis variable already selected.

If selecting one of dependent quantities (by giving the corresponding number from the second list) 
as the Y-axis, then a property diagram is to be automatically calculated (through a normal stepping 
procedure) and generated. For composition of a phase the phase name is asked for further 
specification subsequently.

If selecting any of the other independent variables (conditions) on the first list as the Y-axis, then a 
phase diagram is automatically calculated (through a mapping procedure) and plotted.

 

Name of phase: /ABC/: <phase name>

This is prompted only in case of that the composition of a phase is selected as the Y-axis variable. 
The phase name for which the composition varied along with X-axis variable should be specified.
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Multiple start points? /Y/: 

By default, the program automatically generates and uses multiple start points for mapping the 
defined phase diagram. 

 

Save file /Result/: <File name>

The file name where the calculations are stored (saved as a *.POLY3 file) should be specified; the 
default file name is RESULT.POLY3.

Linux and Mac are case sensitive so ensure you enter .POLY3.
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DEFINE_MATERIAL

This command is for the  POLY module.

Read data for a system from a database in the POLY module. It is convenient to use for alloys 
when there is a major component and the amount of the other elements is known in mass 
(weight) fraction. The command reads the system from the specified database, sets the 
composition and temperature (and pressure equal to 1 bar) and calculates the equilibrium 
state before the prompting for a new command. You can list the results with LIST_
EQUILIBRIUM or set a new composition or set axis for a STEP or MAP command.

You cannot append data from different databases in this way. Use this 
command with data from a USER database.

Syntax DEFINE_MATERIAL

Prompts

Same elements as before /Y/?  

This question is asked only if some data is already read from the database, or if the command 
DEFINE_MATERIAL or DEFINE_DIAGRAM is used. It then offers a convenient way to change the 
composition and temperature with one command.

This command only works properly in cases where the composition of the material 
system is already defined as in the mole-percent or mass-percent unit.

 

Mole percent of <Element> /##/: <Value>

or

Mass percent of <Element> /##/: <Value>

If you have decided to use the same materials system (available in the current POLY3 workspace) by 
accepting the default (Y) to the previous prompt Same elements as before /Y/?, one of the 
alternative prompts display for each of the components in the defined system, depending on how 
the composition is defined (either in mole-percent, or in mass-percent).

Prompts are repeated until all the defined components are completed. Then, the program prompts 
to specify the temperature condition.

 

Database /ABCDE/: <Database name>

The database with the description for the material must be given, or press <Enter> if using the 
current database. It is possible to give a USER database.

 

Major element or alloy: <Element name>

The material must have a major element, usually the element which is present in the largest 
amount. The fraction of this element is not set but is the rest.
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In some databases there are the alloys predefined. An alloy has a default major element and have 
limits of the amounts of the alloying elements. If you stay within these limits the calculation gives 
reasonable results.

 

Composition in mass (weight) percent? /Y/:

By default the input is taken as mass percent. Choose N to change to mole percent.

Composition should be given in PERCENT not FRACTION, as it is required for the W 
and X state variables in the SET_CONDITION command.

 

1st alloying element: <Element name>

The first alloying element must be given.

All alloying elements are asked for in a sequence. These can be given in any order. You must know if 
you are present as assessed systems in the database. There is no error or warning messages if data 
are missing. Check the documentation of the database selected.

If an alloy is selected, a list of legal alloying elements and their maximum percent is listed on-line.

 

Mass (weight) percent: <Amount of the above specified element>

The amount of the alloying element in mass (weight) percent. Using DEFINE_MATERIAL you cannot 
use the normal flexibility  for conditions, but all must be given in mass percent. However, you can 
after wards change the conditions using SET_CONDITION.

 

2nd alloying element: <Element name>

The second alloying element must be given. If only one, press <Enter>. If an element name is given 
then the program asks for its mass fraction.

 
Mass (weight) percent: <Amount of the above specified element>

The amount of the above specified alloying element in mass (weight) percent.

 

Next alloying element: <Element name>

Continue giving elements and mass (weight) fractions until all elements specified. When all alloying 
elements and their compositions (as in the above prompt) are specified, press <Enter> as answer to 
this question to finish the materials definition.

 

Temperature (C) /1000/: <Temperature of interest in oC>

POLY makes the first calculation after retrieving the data for this temperature. By pressing <Enter> 
to accept the default temperature. The value should be given in Celsius (°C).

The pressure is set to 1 bar.

 

Reject phase(s) /None/: <List of phase(s) to be rejected>

This is a question generated by the database allowing you to select the phases. Normally, all phases 
should be included when you press <Enter>. If a phase is to be rejected, the name of the phase 
must be supplied. Several phase names can be specified in one line. It is possible to reject all phase 
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by giving an asterisk *. If the number of phases to be included is much smaller than the total 
number of phases, it may be convenient to first reject all phases and then restore those that should 
be included. The question is repeated until you press <Enter> after rejecting all unwanted phases or 
an asterisk *.

 

Restore phase(s) /None/: <List of phase(s) to be restored>

You can restore phases that are accidentally or deliberately rejected. It may also be possible to 
restore some hidden phases.

If phases are to be restored the name of the phases must be supplied. Several phase names can be 
specified in one line. It is possible to restore all phase by giving an asterisk *. The question is 
repeated until you press <Enter> after restoring all desired phases.

 

OK? /Y/: 

By default, all phases to be selected from the database have the thermodynamic data retrieved and 
the references from the chosen database are listed. Enter N if there are any errors or you want to 
amend the selection then you are returned to the prompt about rejecting phase(s).

 

Should any phase have a miscibility gap check? /N/: 

The database usually creates two or more composition sets for phases that can have miscibility 
gaps. However, for some phases this is not done automatically, for example the miscibility gap in 
the bcc phase in Fe-Cr is usually ignored. But if it is important to include a Cr-rich bcc phase, specify 
this here. It costs some computation time and may make the subsequent MAP or STEP more 
difficult to converge.

If you do not want to have any phase with a miscibility gap in the calculation, press <Enter>. Then, 
DEFINE_MATERIAL starts calculating the equilibrium, and is terminated.

 

To set such a phase with miscibility gaps in the calculation, answer Y. Then the software asks 
questions about the phase names and their constitutions, such as:

Phase with miscibility gap: <Phase name>

You must supply the phase name, which has a miscibility gap under the specified system and 
conditions.

 

Major constituent(s) for sublattice #: /AA/: <Constituent(s)>

The software shows a default constituent in the sublattice #(1,2,3,…), according to the existing 
phase definition in the chosen database. You can specify one or more major constituents for the 
sublattice # in the phase.

This question is repeated until all sublattices are specified.

 

Phase with miscibility gap: <Phase name>

You can supply another phase name with a miscibility gap under the specified system and 
conditions, and answer the questions concerning the major constituent(s) in associated sublattice
(s).

By pressing <Enter>, the command starts calculating the equilibrium, and then terminates.
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It is also possible to use this command to select an alloy from a specific database 
(e.g. the TCNI Ni-based superalloys database). Such alloys are predefined by the 
OPTION keyword inside the database, and have their default major elements and 
composition limits of their alloy elements.

Such alloys available in the selected database (at the prompt Database /ABCDE/ can be listed on 
the screen if typing a ? mark on the prompt Major element or alloy. When a specific predefined 
alloy (instead of a major element) is selected, the major element is staked from the alloy definition 
and shown on the screen (with a message like Alloy found with major element NI).

You can only specify alloying elements and the compositions (weight percent or mole percent). 
Typing a ? at any of the prompts for the alloying element names, e.g. 1st alloying element, 2nd 
alloying element, lists all the alloying elements and the composition limits in the alloy. If the 
composition of an alloying element is outside of its limit, there is a message (such as Amount above 
limit: 30.0000) and a prompt Override limit ? /N/. If you decide to enforce the override by 
answering Y on this prompt (i.e. accepting the over-limit alloying composition), another warning 
message (such as Amount of major element below limit: 70.0000) and prompt Override limit 
? /N/. Then further decide if enforcing the overriding: if Y then accepting the major element’s 
composition below the limit; if N then using the predefined major element composition limit.
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DELETE_INITIAL_EQUILIBRIUM

This command is for the  POLY module.

Delete ONE specific initial equilibrium point or ALL of the initial equilibria. The initial 
equilibria are used as starting points for all the sub-sequential MAP and STEP calculations.

ADD_INITIAL_EQUILIBRIUM.

Syntax DELETE_INITIAL_EQUILIBRIUM 

Prompt Number /All/: <Number of an initial equilibrium>

 

Specify the number of an initial equilibrium (as a specific numerical value e.g. 3, or ALL) to be deleted 
from the POLY3 workspaces. It is recommended to use LIST_INITIAL_EQUILIBRIA to figure out the 
numbers for all the existing initial equilibrium points that have already been added (manually 
through ADD_INITIAL_EQUILIBRIUM, or automatically by some other POLY commands) and stored in 
the current POLY3 workspace. By default, ALL the initial equilibrium points are deleted.
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DELETE_SYMBOL

This command is available with the POLY and ED-EXP modules.

Use the DELETE_SYMBOL command to remove symbols i.e. constants, variables, functions or 
tables. 

Syntax DELETE_SYMBOL 

Prompt
Name: <Name of a symbol>

Specify the name of the symbol to be deleted. Only one symbol can be deleted each time.
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ENTER_SYMBOL

This command is for the  POLY module.

There are also GES and POST module commands with the same name.

Symbols are a useful feature of the POLY and POST modules to define quantities that are 
convenient. Symbols can be constants, variables, functions or tables.

Functions or tables (with defined functions as values) can be entered in the POST module 
after a stepping or mapping calculation, for purposes of plotting such entered functions or 
tables as axis variables.

Within the POLY module, symbols are normally defined prior to an equilibrium calculation 
(enforced by a C_E command), stepping calculation (enforced by the command STEP_WITH_
OPTIONS) or mapping calculation (enforced by MAP). These can be entered after an 
equilibrium calculation; however, for defined functions, variable or tables, it requires using 
EVALUATE_FUNCTIONS before showing the corresponding values in the calculated equilibrium 
state. 

The symbols entered in the POST module are not saved in the currently-loaded POLY3 
workspaces. Therefore, if you want to apply such symbols in other similar calculations for 
the same defined system, you must use the ENTER_SYMBOL command prior to the 
STEPPING or MAPPING calculation in the POLY module.

See example 44  for an example of using variables and functions.

Symbols are a useful feature modules to define quantities that are convenient. Symbols can 
be constants, variables, functions, or tables.

Syntax ENTER_SYMBOL

Prompt

Constant, Variable, Function or Table? /Function/: <Keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION, or TABLE.

 l CONSTANTS can only be entered once and is a means of using a name for a numeric value. 
For example, the value of 1 atmosphere in Pascal can be denoted by P0 after the command 
ENTER_CONSTANT P0=101325. Defined constants can be used as values in condition 
assignments, for example, SET-COND P=P0.

 l FUNCTIONS are expressions of state variables or other functions. These expressions are 
saved, and whenever a function value is requested all functions are evaluated. The reason 
for this is that they may depend on each other.

 l VARIABLES are similar to functions because they can also be expressions of state variables. 
However, contrary to functions, they are only evaluated when they are entered or if they 
are explicitly named in an EVALUATE_FUNCTIONS command. It is possible to enter a variable 
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Syntax ENTER_SYMBOL

with a new expression any time. This expression is evaluated directly and its value stored as 
the value of the variable. Defined variables can be used as values in the SET_CONDITION 
command.

 l TABLES are used for listing results from the STEP or MAP commands. A table consists of a 
list of any number of state variables, functions, or variables. Defined tables can also be used 
in the POST (post-processor) module.

There is a special connection between tables and variables. If a variable is used in a 
table, it is evaluated for each line of the table in the TABULATE command or when the 
table is used in a plot.

 

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 
8 characters.  Legal characters include letters (either UPPER or lower case), digits and 
underscore _. Any other special character, such as parentheses ( and ), plus +, minus 
-, slash / or \, full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line; these must be separated 
with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a definition of 
temperature in Celsius. Otherwise, these questions are asked.

For different types of symbols (constant, function, variable, or table), the questions 
have different prompts.

 

Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or other functions, 
constants, or variables. The expression is a FORTRAN-like expression and operators +,  -, *, = and ** 
can be used (** only with integer powers). 

Unary functions like LOG, LOG10, EXP, SIN, COS, and ERF can also be used. An expression can be 
continued on more than one line. An expression should be terminated by a semicolon (;) or an 
empty line (press <Enter> at the next prompt). 

Examples of function expressions:

 l GM(LIQUID): The Gibbs energy of liquid per mole component

 l H.T/4.184: The heat capacity of the system in calories

 l ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

 l T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is 
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Syntax ENTER_SYMBOL

not enough for the function. If you finish the function press <Enter> again.

 
Value: <Value for a constant>

A constant can only be assigned a numeric value once.

 

Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is evaluated immediately 
and discarded. Only the numeric value is kept. This gives a possibility to save a value between 
calculations with different conditions because all state variables and functions are evaluated for the 
new conditions.

 

Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP 
command is through a table.  

Example:

ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole fractions 
of C and Cr in the LIQUID phase, and the activity of C.

To show the temperature in Celsius in a table, give the command ENTER_FUNCTION TC=T-273; and 
then use the symbol TC in the table.

& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new line if one line is not 
enough for the table. If you finish the table press <Enter> again.
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EQUILIBRIUM_CALCUL

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Use this command to decide how to perform the POLY minimization (i.e. the traditional 
Gibbs energy minimization). The Global Minimization Technique is used by default for 
various single point equilibrium calculations and for stepping or mapping calculations. 

To permanently turn off the Global Minimization Technique (for all sequential calculations 
throughout the current run), use the GLOBAL_MINIMIZATION  command and set the options to 
use only the local POLY minimization. You can also make other adjustments to control the 
steps in reaching Gibbs energy minima in an equilibrium state, for example. 

When enforcing the Global Minimization Technique in the equilibrium calculations, you can 
further adjust how to assign grid points and to handle compositional set(s) for solution 
phases during stepping/mapping. In order to improve convergence, and because the Global 
Minimization Technique uses the normal POLY optimization routine for some calculations, 
you can also change how to control the steps in reaching Gibbs energy minima in an 
equilibrium state.

Settings for the Minimization of an Equilibria

The following prompts show how the POLY optimization does the local POLY minimization to 
reach the minimum of an equilibrium state.

Force positive definite phase Hessian /Y/: 

Choose Y or N to determine how to reach the minimum of an equilibrium state in a normal 
POLY optimization procedure. This is related to the special quantity, the phase stability 
function QF (phase), for all kinds of phases in an equilibrium state [a phase stability 
function for a phase is negative when the phase composition is inside a spinodal, and 
positive everywhere else].

If the composition of a solution phase is inside its spinodal, the enforcement of positive 
definite eigenvalues of a Hessian matrix (i.e. when Y is selected) makes the step be taken 
towards the minima rather than the local maxima. Furthermore, if an eigenvalue (for a 
phase) of the Hessian matrix is near 0.0, the step size is large this sets a lower limit to this 
eigenvalue, reducing the step-size and improving the convergence. 
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The POLY command sequence SHOW_VALUE QF(phase) shows the size of the 
lowest eigenvalue of a phase in an equilibrium state.

If you answer:

 l Y , it helps the local POLY minimization to converge (if there is a problem), especially 
if QF(phase)=0 for phases.

 l N the local POLY minimization routine is applied.

For each phase in a defined system, the molar Gibbs energy of the phase is a function of the 
temperature-pressure condition and its composition: 

Compute a Hessian matrix, which describes the curvature of the Gibbs energy curve of this 
phase at the defined composition X:

Diagonalize this matrix and call the Eigenvalues as e1,e2,...,en . The QF(phase) quantity 
for this phase is the lowest of these eigenvalues divided by the same values for a 
corresponding ideal phase: 

Here, se1,se2,...,sen are the Eigenvalues for the ideal phase. Therefore, for an ideal 
phase, the QF(phase) should always be 1.0.

Control stepsize during minimization /Y/: 

Choose Y or N  to determine whether to introduce a control of step size while reaching the 
minimum of an equilibrium state in a normal POLY optimization procedure. If you choose Y it 
might help the POLY optimization to converge, especially if some site fractions are less than 
1E-4.
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EVALUATE_FUNCTIONS

This command is available with the POLY and ED-EXP modules.

The value of one or more or all entered functions or variables are evaluated and listed. 

Syntax EVALUATE_FUNCTIONS 

Prompt

Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By typing a wildcard *, 
all functions and variables are evaluated.

Variables are evaluated only if these are explicitly named.
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GLOBAL_MINIMIZATION

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Designed to decide how to perform the so-called Global Minimization in the POLY module. 
By default, the POLY module uses the Global Minimization technique for various single-point 
equilibrium calculations and for stepping or mapping calculations. You can use this to 
permanently (for all sequential calculations throughout the current software run) turn off 
the Global Minimization technique and consequently use only the Ordinary POLY 
Minimization, and additionally adjust the ways to proceed the normal minimization (mainly 
in terms of how to control the steps in reaching Gibbs energy minima in an equilibrium 
state). When enforcing the Global Minimization technique in the equilibrium calculations, 
you can adjust the manners for assigning grid-points and for handling new possible 
compositional set(s) for solution phases during stepping/mapping; since the Global 
Minimization technique also uses the normal POLY optimization routine for some 
calculations, it is also possible to change the ways on how to control the steps in reach Gibbs 
energy minima in an equilibrium state, in order to improve convergence.

The following prompts affect how the Global Minimization is done. Settings for global 
minimization:

Use global minimization as much as possible /Y/:

Use global minimization for test only? /N/:

Maximum number of gridpoints per phase /2000/: <Integer number>

Use global minimization as much as possible /Y/:

Choose Y or N to decide if using the Global Minimization Technique from start of calculation 
or not. The default value on start-up may be changed by SET_TC_OPTIONS in the SYS module.

If Y the calculation is done when possible (depending on the condition settings), and a Global 
Minimization test is always performed when an equilibrium is reached. This costs more 
computer time but the calculations are more accurate.

If N the calculation is not used to reach the equilibrium state. Use global minimization for 
test only? determines if the Global Minimization test is made against the calculated 
equilibrium states obtained by the Ordinary POLY Minimization calculation.

Use global minimization for test only? /N/:
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If Y a calculated equilibrium state obtained by the Ordinary POLY Minimization calculation is 
tested against the Global Minimization Technique after it is reached; and if found it as 
unstable, there is an error message.

If N the Global Minimization Technique is never tested for or done for all sequential 
calculations throughout the current TCC run. This implies that Global Minimization 
Technique is permanently turned off, and that consequently only the Ordinary POLY 
Minimization routine is used.

Maximum number of gridpoints per phase /2000/: <Integer number>

Specify the maximum number of grid points that are computed for each of the phases in the 
currently defined system, during the calculations enforced by the global minimization. More 
grid points give a higher robustness and take more computation time. The total number of 
computed grid points in all phases is limited to 2E6.
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KEEP_COMP_SET_NUMBERS

This is available with the ADVANCED_OPTIONS command in the POLY module.

ADVANCED_OPTIONS

COMPUTE_EQUILIBRIUM

This setting affects the COMPUTE_EQUILIBRIUM command and turns on/off the functionality to 
keep the composition set numbers from the previous equilibrium calculation. The setting is 
on by default. 

To turn the setting on or off enter the ADVANCED_OPTIONS command in POLY, then enter this 
option and either press <Enter> to keep the default Y or enter N at the prompt:

Keep composition set numbers /Y/:

If this setting is on, performing the COMPUTE_EQUILIBRIUM command keeps the composition 
set number for any phases that were also present in the last result from COMPUTE_
EQUILIBRIUM. 

The composition set numbers are kept when the constitution of a phase in the 
new equilibrium result  is similar to the constitution of one of the composition 
sets of that phase in the previous result. Making major changes to the 
conditions between calculations makes it therefore less likely that the 
composition set numbers are kept. The major constituents, given in the 
thermodynamic database, are used if no previous result exists.
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LIST_AXIS_VARIABLE

This command is for the  POLY module.

Syntax LIST_AXIS_VARIABLE

 Lists all the axis variables for a stepping or mapping calculation that have already been set by SET_
AXIS_VARIABLE.
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LIST_CONDITIONS

This command is available with the POLY and ED-EXP modules.

All the conditions that are set by the SET_CONDITION command and the command-sequence 
CHANGE_STATUS PHASE =FIXED <0 or 1 or alike>, are listed.  The current conditions are 
also listed by the LIST_EQUILIBRIUM command. The degree of freedom in the defined system 
is also shown. 

 l If this is zero, you can perform a COMPUTE_EQUILIBRIUM command. 
 l If it is larger than zero, some more conditions are required, and you must further set 

additional ones, using SET_CONDITION or CHANGE_STATUS. 
 l If it is negative, then too many conditions are defined and the unnecessary ones 

conditions need to be removed using the SET_CONDITION command (with a value of 
NONE for the to-be-deleted condition) or the CHANGE_STATUS command (i.e. 
changing a FIXED status of a phase to another type of phase status, ENTERED or 
DORMANT or SUSPENDED).

Syntax LIST_CONDITIONS

Example

P=100000, T=800, N(NI)=1E-1, N=1

FIXED PHASES

FCC_A1=1 LIQUID=0   DEGREE OF 
FREEDO 0



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 218 of 622

LIST_EQUILIBRIUM

This command is available with the POLY and ED-EXP modules.

The result (always in SI units) from the last calculated equilibrium is listed on screen or in a 
text file. 

You can also execute this command if no calculation is made or if the 
calculation fails. Make sure to interpret the results accordingly.

Syntax LIST_EQUILIBRIUM 

Prompt
Output to screen or file /Screen/: <File name>

The name of the text file where the list of the calculation results shall be written. 

 

Options /VWCS/: <Option(s)>

Select the output units and formats by optionally specifying a combination of these letters.

 l Fraction order:V means VALUE ORDER; A means ALPHABETICAL ORDER.

 l Fraction type: W means MASS FRACTION; X means MOLE FRACTION.

 l Composition: C means only COMPOSITION; N means CONSTITUTION and COMPOSITION.

 l Phase: S means including only STABLE PHASES; P means including ALL NON-SUSPENDED 
PHASES.

 

Default options are VWCS. If the output fraction type should be in mole fraction (rather than mass 
fraction), then give VXCS or type X (implying that in this case the options V, C and S are accepted as 
the listing manners for fraction order, composition and phase).

If accepting all the default options, or if accepting all the altered options that had already changed 
when using this command previously, you can type L_E,,, or LIST_EQUILIBRIUM ,,,

LIST_EQUILIBRIUM displays ORD (ordered) or DISORD (disordered) (when available). 
See CHANGE_LEGEND for details.
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LIST_INITIAL_EQUILIBRIA

This command is for the  POLY module.

List all the equilibria added with ADD_INITIAL_EQUILIBRIUM. 

Syntax LIST_INITIAL EQUILIBRIA

 All the initial equilibria are used for the MAP (and STEP) calculations.
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LIST_PHASE_ADDITION

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

The values set as additional contributions (given by  PHASE_ADDITION) to Gibbs energy Gm 
(J/mol formula unit) to all the phases (stoichiometric or solution) are listed at the current 
calculated equilibrium.

LIST_PHASE_ADDITION has no additional prompt.
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LIST_STATUS

This command is for the  POLY module.

There is also an ED-EXP module command with the same name.

List the status of components, species or phases.

Syntax LIST_STATUS 

Prompt

Specify what to list:

Option /CPS/:<keyword(s)>

keyword = C or P or S, or any combination

 l C: list component status

 l P: list phase status

 l S: list species status

 l CS: list both components and species

Default is CPS. 

 

The results depend on the key word specified in the options for CHANGE_STATUS, a table with the 
current status of phases or species or components, or the combinations, is shown:

 l For components, the statuses and reference states are listed.

 l For species, only the status is listed.

 l For ENTERED and FIXED phases, the status, driving forces and equilibrium amounts are 
listed. 

 

The metastable phases are listed in descending order of stability. To avoid long 
outputs only 10 metastable phases (in ENTERED status) are listed by lines, while all 
other less stable phases are merged onto one line. For DORMANT phases, their 
phase names and driving forces are listed. For SUSPENDED phases, only the phase 
names are listed.
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LIST_SYMBOLS

This command is for the  POLY module.

There are also POST and ED-EXP module commands with the same name. 

Use this command to list the definitions for all constants, functions, variables and tables.  In 
order to find the value of a function or variable, use SHOW_VALUE or EVALUATE_FUNCTIONS. A 
table is tabulated with the TABULATE command.

Syntax LIST_SYMBOLS

 The defined variables are listed up together with the defined functions, but variable names are 
followed by a percentage sign %.
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LOAD_INITIAL_EQUILIBRIUM

This command is for the  POLY module.

Copies all conditions and calculated results from a specific added initial equilibrium to the 
current equilibrium. The current conditions and calculation results are lost, and the newly 
loaded initial equilibrium point gets into the POLY workspace.

Syntax LOAD_INITIAL_EQUILIBRIUM 

Prompt

Number: <Number of an initial equilibrium>

Specify the number of an initial equilibrium to be loaded as current. The number can be found with 
LIST_INITIAL_EQUILIBRIA.
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MAKE_COMPONENT_ENTERED

This command is for the  POLY module.

The MAKE_COMPONENT_ENTERED command sets the status for the components to be ENTERED 
in the defined system for all the sequential calculations (single-point, stepping, and 
mapping) in equilibrium or local/partial equilibrium states. ENTERED means that the 
component(s) are included in the calculation and these are stable if that minimizes the total 
energy.

This command has the same results as when using CHANGE_STATUS  Entered 
option.

Syntax MAKE_COMPONENT_ENTERED

Prompts

Name(s) <Name(s) of the components>

The names of the components to set to ENTERED (all on one line). A comma or space must be used 
as separator. An asterisk, "*", can be used to denote all components.
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MAKE_COMPONENT_SUSPENDED

This command is for the  POLY module.

The MAKE_COMPONENT_SUSPENDED command sets the status for the components to be 
SUSPENDED in the defined system for all the sequential calculations (single-point, stepping, 
and mapping) in equilibrium or local/partial equilibrium states. SUSPENDED means that the 
component(s) are not considered in the calculation. Any conditions that depend on the 
suspended components are automatically removed.

Removing relevant conditions is unique to this command and does not occur 
when suspending components with the CHANGE_STATUS command and 
Suspended option. 

Syntax MAKE_COMPONENT_SUSPENDED

Prompts

Name(s) <Name(s) of the components>

The names of the components to set to SUSPENDED (all on one line). A comma or space must be 
used as separator. An asterisk, "*", can be used to denote all components.

This command is useful when an element has a very low amount because you can now 
ignore it in the calculation instead of reading the entire system from the database.  The 
command is also of use when working in an API with many calculations.
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MAJOR_CONSTITUENTS

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Use this to set the major constituent(s) of a composition sets in a miscibility gap of a solution 
phase. Normally, the major constituents are specified when a new composition set is 
created by the NEW_COMPOSITION_SET option; but for the first composition set, this option 
may be needed before using NEW_COMPOSITION_SET.

The following prompts are to specify the major constituent(s) on each of the sublattice sites 
for a composition set of a certain solution phase:

Phase name: <name of a phase>

Specify the name of the solution phase with a new set of major constituents.

Composition set number /1/: <#>

The default value for the composition set number (#) is usually /1/ as the other composition 
sets are given major constituents when creating them. Each phase has initially one 
composition set.

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) on each sublattice of a solution phase can be given. This may 
simplify giving start values when calculating the equilibrium as phases with miscibility gaps 
should have different major constituents for each composition set.

This question is repeated for each sublattice in the phase.
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MAP

This command is for the  POLY module.

This command starts the mapping procedure for making a calculation of phase diagrams in a 
defined multicomponent heterogeneous system, from one or more initial equilibria. A phase 
diagram is usually mapped within a specific space that is constructed by two (or more) 
defined independent mapping axis-variables. 

Syntax MAP

 

A phase diagram consists of mapped phase boundary lines/curves; on one side of each such phase-
boundary line/curve, the amount of one specific stable phase is zero (i.e. the zero-fraction lines). 
From a single MAP calculation, many different types of phase diagrams in the defined 
multicomponent heterogeneous system can be plotted, with some desired properties (that vary along 
the calculated phase-region boundaries) plotted as X/Y-axis variables. All different types of phase 
diagrams are generated by the mapping calculations through this command.

Normally, you need to have calculated at least one initial equilibrium point and have also 
defined at least two independent varying variables (i.e. the controlling conditions in the 
system) that are set with SET_AXIS_VARIABLE. You can also have three, or four or maximum 
five independent varying variables that are defined by the SET_AXIS_VARIABLE command).

This lists the current values of each of the independent axis variables for each of the 
calculated equilibrium points along each of the mapped phase boundaries, and also lists the 
corresponding information when the set of stable phases changes.

The Global Minimization Technique is by default enforced in this command while it can be 
disabled if having decisively switched it off (or possibly in some special modules) through 
changing the minimization option using the ADVANCED_OPTIONS → MINIMIZATION_OPTION 
command-sequence. You can choose how often to do a Global Minimization test (via the 
Global Test Interval option) in the ADVANCED_OPTIONS STEP_AND_MAP command-
sequence.

During a MAP calculation, the values of mapped axis-variables for presenting each phase 
boundary (lines/points) of the calculated phase-regions are listed, and the corresponding 
stable-phase sets are shown up. 

You can terminate the mapping of a line by pressing a single <Ctrl-A> 
(Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish 
calculation without losing what is already calculated.
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If there is any convergence problem in finding a stable solution at a certain stage during a 
calculation procedure enforced by this command, these messages display on screen:

Convergence problems, increasing smallest site-fraction from 1.00E-30 
to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-
LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically 
increased from the default value 1.00E-30 to the hardware-dependent precision (under 
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run, 
you can use SET_NUMERICAL_LIMITS to restore or reset the smallest site fraction to the 
previous or another preferred value, as well as to reset other numerical limits.

In particular, for phase diagrams with tie-lines in the plane (i.e. most binary systems and 
ternary isotherms), there is a MAP procedure which checks for the best phase to use as axis 
variables in order to ensure reasonable increments between the tie-lines. This produces 
smoother curves and also gives a better stability in finding adjacent phase-regions.

Complex miscibility gaps of various solution phases are automatically detected during a 
mapping calculation, and two or more composition sets for each of such solution phases are 
automatically generated as well, through an automatic Global Minimization Test procedure 
(by specifying a Global Test Interval value and confirming the Automatically add initial 
equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a 
particular case, such an automatic Global Minimization Test ensures that you can start 
calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase) 
where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1 
miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.) are 
not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may first 
become metastable with a composition different from the metallic FCC_A1 phase and later 
also stable. The advanced mapping procedure (enforced by the Global Minimization 
Technique) inside the Thermo-Calc software (both the Console Mode and Graphical Mode) 
can efficiently and effectively handle complex miscibility gaps in multicomponent 
heterogeneous systems.

To get a complete phase diagram, sometimes it may be necessary to have multiple starting 
equilibrium-points, and/or to have added multiple initial-equilibrium points (through ADD_
INITIAL_EQUILIBRIUM) inside various phase-region boundaries under certain direction(s).
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NEW_COMPOSITION_SET

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

A solution phase that can exist with two (or more) different compositions simultaneously 
must have two (or more) composition sets in its phase descriptions. Normally the database 
creates as many composition sets as is necessary but use this command to add or delete 
more composition sets. A complex solution phase in a defined multicomponent system can 
have up to 9 different composition sets for the purpose of appropriately handling its 
possible miscibility gap(s) under various temperature-pressure-composition conditions.

This option is unnecessary if the Global Minimization Technique is in use, as it can 
automatically detect all possible miscibility gap(s) for complex solution phases (normal or 
disordered/ordered phases) and then automatically add required composition sets for such 
phases in the defined system.

This option can automatically create composition sets also for disordered phase when it is 
executed for the ordered phase.

If you have your own data file, this option must be used to indicate that a solution phase can 
have a miscibility gap (or may exhibit some complex phase separations as to more than two 
composition sets), unless that the possibly-additional composition set(s) for the solution 
phase must have already been added inside the TDB file (through a TYPE_DEFINITION 
command to amend composition-set) or been manipulated through the GIBBS module 
(using the AMEND_PHASE_DESCRIPTION COMPOSITION_SET command-sequence). This option 
asks for default major constituents for the new sets and it is important that this is set 
correctly, otherwise the test for miscibility gaps may fail.

The following prompts are to specify the additional composition set(s) to handle possible 
miscibility gap(s) of a certain solution phase:

Phase with miscibility gap: <Name of a phase>

Specify the name of the phase with miscibility gap.

New highest composition set number /2/: <#>

The default value is usually one higher than the current value. Each phase has initially one 
composition set. If a lower value is given, composition sets are deleted. You cannot take 
away the first composition set.
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A message displays to show that you need to specify the composition for the composition 
set # (2,3,…).

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) in each sublattice can be given. This may simplify giving start 
values when calculating the equilibrium as phases with miscibility gaps should have different 
major constituents for each composition set.

This prompt is repeated for each sublattice in the phase, sometimes even for all sublattices 
in the first composition set if such major constituents have not been specified.
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OUTPUT_FILE_FOR_SHOW

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

The name of a text file is asked for and all the results output from the command SHOW_
VALUE is written to this file.

When you use this command, a window opens with a default name for the file tc_show.dat. 
Choose a location to save the file and click Open.
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PARAEQUILIBRIUM

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

This calculates a paraequilibrium between two specific phases in an alloy system with one or 
more interstitial component(s) as fast diffusion species. Under the paraequilibrium state, 
two partially-equilibrated phases have the same chemical potential (but different contents) 
for one or more interstitial components (such as C, N, O, S, etc., as individual or combined)], 
along varied temperature or along a composition variable (of the matrix or one 
substitutional component) which has already set as the stepping variable with SET_AXIS_
VARIABLE.

To ensure a successful point calculation of paraequilibrium state between two specific 
phases in a defined alloy system, it is important that you first have made a single-point 
equilibrium calculation with an initial overall composition in the current system before 
performing this advanced-option calculation; however, it is unnecessary to obtain an 
equilibrium in which either one or both of the target phases is stable. The initial overall 
composition must have a reasonable setting for the desired paraequilibrium calculation for 
the two target phases. This is especially true for cases where there are more than one 
interstitial components to be considered in the paraequilibrium state, because different 
interstitial components (for example C and N combined) may have significant different 
behaviors as partitioning into different structured phases; otherwise, for one chosen 
interstitial component the initial overall composition is OK for the paraequilibrium 
calculation between the specified two phases, but for other chosen interstitial component(s) 
it might be impossible to calculate the paraequilibrium state.

Note the following:

 l Always check if the chosen phases A and B have the exactly same definition of 
elements and if the chosen interstitial components are all in the vacancy sublattice 
sites of the two phases; otherwise the program cannot find the paraequilibrium state 
(as it is impossible to correctly calculate u-fractions).

 l Always have a comprehensive understanding of the normal phase diagram for the 
currently investigated system, so that you make the appropriate choice of the phase 
pair and staring bulk composition for the system.

 l Always set the status of the chosen interstitial components as SPECIAL using the 
POLY command: CHANGE_STATUSComponent <interstitial component> = SPECIAL. 
By doing this, you get a clear picture of u-fractions of various substitutional and 
interstitial components, which are different from the overall composition in the 
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system. The SPECIAL status means that specified component(s) are not included in 
summations for mole or mass fractions. Therefore, all the composition variables 
plotted from paraequilibrium calculations are u-fraction related quantities.

Settings
Name of first phase:  <Phase A>

Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium state is to 
be calculated, must be entered subsequently or on the same (first) line at once then 
separated by an empty space, e.g. FCC#1 BCC or FCC#2 M23C6.

You need to understand what you are dealing with in terms of calculating a 
paraequilibrium state between the two specified phases. 

Specifically, there are four distinguished cases to understand: (1) both chosen phases must 
have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component
(s) occupy; (2) the choice on the target phase pair must be reasonable for the defined 
system and specified initial overall composition; (3) both target phases should have phase 
constitution definitions that cover all the defined substitutional and interstitial components 
of the current alloy system; or (4) it is impossible to calculate the paraequilibrium state 
between the target phase pairs with given interstitial component(s) in the currently defined 
system.

Fast diffusing component: /c/: <interstitial component(s)>

Fast diffusing component: /none/: <interstitial component(s)>

The name(s) of the fast-diffusing component(s) (C as the default single component) must be 
given at the above prompts subsequently or at the same (first) prompt. It is possible to 
specify more than one interstitial component as fast diffusion species.

Note the following:

Such specified interstitial component(s) must be appropriately defined according to the 
phase constitution definitions of the two selected phases: these must be located on the 
interstitial/vacancy sublattices in both chosen phases;

If there is only one fast-diffusing component which is carbon, press the <Enter> key to 
accept the default input at the first prompt; if the single fast-diffusing component is another 
element (e.g. N), type its name at the first prompt;
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If there are two or more fast-diffusing components (e.g. C and N), type their names at the 
above prompts subsequently or at the same (first) prompt (separated by an empty space, 
such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt, i.e. by 
pressing <Enter> key to start the paraequilibrium point calculation;

If NONE or a non-existing component name is typed at the first prompt, it means no back 
diffusion is to be considered, and the para-equilibrium calculation is thus canceled entirely.

If the paraequilibrium state between the two specified phases is successfully calculated, the 
messages displays e.g.

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02  N = 4.1548129E-03

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04  N = 2.3781027E-04

All other compositions the same in both phases

Note: LIST-EQUILIBRIUM is not relevant

The first and second lines list the phase amounts expressed in mole-percent [NP(phase)] and 
the contents of the interstitial components C and N in a specific phase expressed in the so-
called u-fractions [u-f(phase,C) and u-f(phase,N)], for the phase A (in this case as FCC) and 
phase B (in this case as BCC), respectively. The third line states that the compositions of the 
matrix component and all the remaining compositions (regarding substitutional 
components) in both the target phase A and target phase B are the same at the current 
paraequilibrium state, while these are not shown on screen. The last line indicates that after 
this advanced-option calculation the LIST_EQUILIBRIUM command is irrelevant and does not 
list the paraequilibrium state for the system at the current condition.

However, if the single-point calculation of the paraequilibrium state between the two 
specified phases has failed, these messages display:

*** Error 4 in ns01ad

*** Numerical error

This implies that the chosen target phase pair may be unreasonable for the defined alloy 
system or for the defined initial overall composition, or one or both phases may have 
inappropriate phase constitution definitions regarding the specified interstitial component
(s). Then, you must either modify the settings of initial overall composition or specify the 
reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in 
the defined alloy system.
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PHASE_ADDITION

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Sometimes it is interesting to add a constant contribution to the Gibbs energy of a phase 
(stoichiometric or solution). This can be done in the Database module (DATA) or Gibbs 
Energy module (GIBBS), for a stoichiometric phase, or for a pure end-member in a solution 
phase. However, if the addition is related to the equilibrium state, for example, strain 
energies or surface energies, interfacial energies, or deformation energies, it may be more 
convenient to have this quantity related to the equilibrium state rather than the 
thermodynamic data. 

Give a value of an addition to the Gibbs energy of a phase. The value should always be 
constant (implying that the addition is not a function of phase composition or temperature-
pressure conditions in the equilibrium state) and always be given in the unit of J/mol 
formula unit of the phase.

The following prompts are to specify the additional energy term (always being a constant) of 
a given phase.

Phase name: <Name of a phase>

Specify the name of the (stoichiometric or solution) phase with the addition.

Addition to G per mole formula unit: <xxxxx>

The value (xxxxx) given is added to the Gibbs energy of the (stoichiometric or solution) 
phase. It can represent a nucleation barrier, surface tension, elastic energy, etc. 

It is not composition-, temperature-, or pressure-dependent.
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POST

The POST module (post-processor) is a submodule to the POLY module and has 
its own set of commands. The TAB, BIN, TERN, POT, SCHEIL and POURBAIX 
modules use the POST module features as part of the automatic generation of 
the plots.

POST Module Commands

Using the POST Module

Syntax POST

 Switches to the POST module, which has its own command set.
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PRESENT_PHASE

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Specify the name of the present phase a the name of the phase that should be present at all 
calculated equilibria:

Present phase:

Phase name: <Name of a phase>
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READ_WORKSPACES

This command is used in both the POLY and GES (GIBBS) modules.

Workspace Files

The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP 
commands can be READ from a file where they are saved with  SAVE_WORKSPACES. Such a 
*.POLY3 file is not printable.

Syntax READ_WORKSPACES 

Options

File name is the name of a saved POLY3-file where the POLY3 and GIBBS workspaces shall be read 
from must be specified. You do not need to type the extension if it is the default *.POLY3, otherwise 
type the whole POLY-file name.

A reminder that Linux and Mac are case sensitive; when applicable ensure you enter 
file extensions with capital letters.

A window opens so that the path (in the Look in field) and File name can be specified. The Files of 
type (i.e. POLY3) cannot be changed. Click Open to open the POLY3 and GIBBS workspaces from the 
saved *.POLY3 file.

 

When reading back an original POLY3 workspace that has already been saved as an *.POLY3 file in 
the current Thermo-Calc (Console Mode) run or had been read from an existing POLY3 file under the 
current work area, while some additional changes in the settings may be made but do not need to 
be kept in further steps in the current Thermo-Calc (Console Mode) run or any diagram is plotted in 
the POST module, you can type READ,, or READ_WORKSPACE ,,
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REINITIATE_MODULE

This command is for the  POLY module.

This command makes sure that the whole POLY module (and thus the entire POLY 
workspace) is reinitiated to the state as it was when first entered. 

Syntax REINITIATE_MODULE

 

All the defined components, defined conditions, changed status, entered symbols, defined 
independent axis-variables, calculated starting equilibrium-points, added initial equilibrium points, 
stepped/mapped equilibrium data, and so forth, are removed completely. The saved file name is 
restored to the default.
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SAVE_WORKSPACES

This command is available for both the POLY and GES (GIBBS) modules.

Workspace Files

You can save the current status and workspaces, including thermodynamic data, conditions, 
options and results from a single, stepping or mapping calculation on a *.POLY3 file. The  
workspaces are saved to a file with this command. This is useful so you have access to the 
workspace for later use or when you need to terminate the current Console Mode session. 

 l In the Gibbs (GES) module  workspace, all thermochemical data are stored. 
 l In the POLY module workspace, all the last set of conditions and equilibrium state, 

changed status, entered symbols, advanced options, defined stepping/mapping 
variables, added initial equilibria, stepped/mapped results, etc., are stored, so it also 
contain the GES workspace. 

 l When you are in a response-driven module such as POTENTIAL or SCHEIL for 
example, a workspace file is automatically opened. In the workspace file, system 
definitions, conditions for the calculation, calculation results, and plot settings are 
saved. The file is saved in the current working directory, and is named after the name 
of the module that created it. For example, the POTENTIAL module saves a 
workspace file called POT.POLY3 ; the POURBAIX module saves a file called 
POURBAIX.POLY3 and so forth.

After a SAVE_WORKSPACES command, you can always come back to exactly the 
state you had when you issued the command by giving a READ_WORKSPACE 
command. For example, after saving the POLY and GIBBS workspaces to a file, 
you can leave the program and at a later time READ the file and continue from 
the saved state. 

Important Information About Map and Step Commands

A STEP or MAP command automatically saves the workspace with the most 
recently specified name. Do not use the SAVE_WORKSPACES command after a 
MAP or STEP command.
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The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE 
command. You can append several results obtained by sequential STEP or MAP calculations 
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping 
this in mind is important and useful particularly for calculating various isothermal (or 
isoplethal) sections and plotting them on the same diagram in a single Thermo-Calc run.

To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.

Syntax SAVE_WORKSPACES 

Options

A file name must be specified. The default extension of the POLY workspace file is *.POLY3 but you 
can have any other file extension.

Linux and Mac are case sensitive so ensure you enter .POLY3.

A Save window displays if a file name is not given after the command, so that the path (in the Save 
in field) and File name can be specified. The Files of type cannot be changed. 

If there is already a file with the same file name under the directory a warning message displays. 
Click OK to overwrite the current  POLY or GIBBS workspace onto the existing file. Click Cancel to 
return to the module. You can use the SAVE command with an unspecified name (i.e. through SAVE 
,,, command-sequence) to save the POLY or GIBBS workspace.

When saving a POLY3 workspace under a name that already exists under the current 
work area, which is saved by default (after running a special module, e.g. BIN, TERN, 
POT, SCHEIL and POURBAIX) or in an earlier stage of the current Console Mode 
session or in a previous run (which is READ into the current POLY3 workspace), you 
can type SAVE,,Y or SAVE_WORKSPACE ,,y. However, this must also be avoided if 
some results from previous MAP or STEP calculations shall not be destroyed.
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SELECT_EQUILIBRIUM

This command is available with the POLY and ED-EXP modules.

If you create more than one initial equilibrium (during data-assessments using the 
PARROT/ED_EXP modules), you can switch between them using this command.

Syntax SELECT_EQUILIBRIUM 

Prompt

Number /Next/: <Choice on equilibrium>

Options: FIRST, LAST, NEXT, PREVIOUS or PRESENT.

Most commands affect only the PRESENT equilibrium. However, the REINITIATE_MODULE and DEFINE_
COMPONENTS commands remove all the stored equilibria.
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SET_ALL_START_VALUES

This command is available for the  POLY and ED-EXP modules.

Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If 
temperature and pressure are not conditions, you are asked for values of them. Then for 
each phase prompt on if it should be stable and on its constitution.

Syntax SET_ALL_START_VALUES

 
T /XXXX/: <Temperature in K>

If the temperature is not a condition, supply a guess of its final value (in K).

 
P /100000/: <Pressure in Pa>

If the pressure is not a condition supply a guess of its final value (in Pa).

Prompts

Automatic start values for phase constitutions? /N/: <Y, N or F>

 l For N, enter an initial amount of each entered phase and the major constituents or site 
fraction of each constituent.

 l For Y, the program automatically sets the start values for phase constitutions in all 
possible phases.

 l F is for force. In some cases the calculation fails because impossible conditions are set, e.g. 
W(C)=1.5 [W(C) is mass fraction and must thus be less than unity. The program tries to 
fulfill this condition by putting maximum amount of carbon in all phases, but can fail 
anyway. When you detect the error and set W(C) to 0.015, the calculation may still fail 
because it could start from the previous values. To get back to ‘fresh’ start values, choose 
F.

 

Should <phase> be stable /N/: <Y/1 or N/2>

A guess if this phase should be stable or not is requested. All entered phases are prompted for this 
question and next two. 

You cannot have more phases stable than you have components, but at least one 
(which dissolves all constituents) must be set as stable. For backward compatibility, 
this question can be answered by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2. For phases with 
miscibility gaps, there should be two phases with the same name but with different numbers after 
the hash sign.

 

Major constituent(s): <Name of major constituent(s) in the phase>

The constituent with the largest fraction in the phase should be specified. If there are more than 
one constituent with a large fraction, give them all on the same line. If the default major 
constituents should be used answer with an asterisk (*). By giving $ the constitution is not changed. 
If there should be no major constituent give NONE and or if the major constituent(s) are improperly 
specified, you are asked for individual fractions in the phase.
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Syntax SET_ALL_START_VALUES

 

Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by pressing <Enter> or give a 
new value (.YYYYY).

The phase name or constituent name may have a hash sign # followed by a digit, e.g. Y(BCC_
A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility gaps, there should be two phases with the 
same name but with different numbers after the hash sign. For phases with sublattices, the 
constituents in sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.
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SET_AXIS_VARIABLE

In order to calculate a diagram, set at least one axis variable in a stepping calculation, or at 
least two axis variables in a mapping calculation. For property diagrams, one axis is enough; 
for phase diagrams two or more are necessary. Any condition that can be set to calculate an 
equilibrium can be used as an axis variable (with its lower and upper limits and step length) 
by using SET_AXIS_VARIABLE, and the POLY program does, after a STEP or MAP command, 
vary the value of the condition between the limits set on its related axis variable.  As an 
extraordinarily unique and powerful feature of the Thermo-Calc software, up to five 
independent axis variables can possibly be used in a mapping calculation of a 
multicomponent heterogeneous system; however, the axis numbers 3, 4 and 5 must have 
chemical potentials of components (or temperature or pressure) as conditions.

Syntax SET_AXIS_VARIABLE 

 

Axis number /#/: <An axis number>

Specify a number between 1 and 5. The axis numbers 3, 4 and 5 must have chemical potentials of 
components (or temperature or pressure) as conditions.

Prompts

Condition /None/: <One condition>

Here the condition that should be varied along the axis must be given. The condition is specified as 
in SET_CONDITION, for example W(C) for mass fraction of carbon. By accepting NONE, the axis is 
removed.

 
Min value /0/: <Min value>

Specify the minimum value of the axis condition.

 
Max value /1/: <Max value>

Specify the maximum value of the axis condition.

 
Increment /.025/: <Step length>

Specify the maximum step length. By default, this is 1/40 of the total axis length.

You can give SET_AXIS_VARIABLE without having set a condition on the axis variable. Under 
such circumstances, the relevant condition is automatically created and the value set 
between the minimum and maximum axis limits; however, as a side effect, the POLY module 
creates two conditions, P=1e5 and N=1 (these have not been defined as a condition yet), in 
case you set an axis variable which is not already a condition.

You can use a logarithmic axis during calculations. This is useful for low fractions like in a gas 
phase where 1e-7 to 1e-2 might be an interesting range. The pressure is also suitable for 
logarithmic step. You specify the logarithmic axis by giving an asterisk * after the increment 
value. 
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The increment in this case is treated as a factor. 

For example, 

S-A-V 1 P 1E5 1E25 5*

This makes axis 1 a logarithmic axis where the difference between two calculated values 
makes a factor 5. 

The factor must be larger than 1.0.

In some cases, such as when the DEFINE_DIAGRAM command is used or a special advanced 
module (e.g. BIN, TERN, POT, SCHEIL or POURBAIX) is called, some axis variables are 
automatically set by the program, not necessarily by this command.
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SET_CONDITION

This command is available with the POLY and ED-EXP modules.

Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as 
most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state 
variables (with respect to chosen reference states), can be used as conditions. In addition to 
temperature and pressure conditions, a multicomponent system can have mixed types of 
conditions. You should repeat this command for a multicomponent system until the degree 
of freedom in the defined system becomes zero. When a FIXED phase status is used on a 
specific phase (use CHANGE_STATUS), it is equivalent to one condition (implying that 
particular phase is stable in the defined system).

Syntax SET_CONDITION 

 

Each condition must be given explicitly, but can be given on the same line (separated by a comma (,) 
or an empty space) or on separate lines with each one started with the command.

Example
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2

or

SET_COND T=1273, P=1E5

SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5 Pascal), the mass 
(weight) fraction of C to 0.0015 and the mole fraction of Cr to 0.22 and the activity of N to 0.2.

Prompt

State variable expression: <State variable name or linear expression> or a linear 
expression of state variables.

Some of the state variables that can be used in conditions are:

 l T: temperature in the system (in K)

 l P: pressure in the system (in Pascal)

 l N: system size (mole number in moles)

 l B: system size (mass in grams)

 l N(<component>): mole number of a component in the system

 l X(<component>): mole fraction of a component in the system

 l W(<component>): weight fraction of a component in the system

 l For the SET_CONDITION command this is ACR(<component>): activity of a component in the 
system. For the SET-ALTERNATIVE_CONDITION command, this is ACR(<phase>,<component>) 
(activity of a component in a phase)

 l For the SET_CONDITION command this is MUR(<component>): chemical potential of a 
component in the system. For the SET-ALTERNATIVE_CONDITION command, this is MUR
(<phase>,<component>) (chemical potential of a component in a phase)
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Syntax SET_CONDITION 

 l X(<phase>,<component>): mole fraction of a component in a phase

 l W(<phase>,<component>): weight fraction of a component in a phase

 l ACR(<species>,<phase>): activity of a species referred to a phase

 l MUR(<species>,<phase>): chemical potential of a species referred to a phase

 l H: enthalpy in the system (in J)

 l HM(<phase>): enthalpy of a phase (in J/mol)

There are many state variables that can be used in conditions. For more information, enter an INFO 
STATE_VARIABLES command. A condition is normally a value of a single state variable with its value. 

Example
T=1273.15  P=1E5

X(C)=.002

W(CR)=0.5

ACR(CR)=0.85

X(FCC,C)=.001

H=-250000

HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one state variable. For 
example,

X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S component should be the same in the 
LIQUID and PYRRHOTITE phases. In practice, that should be the congruent melting point. 

After the equal sign only a numeric value is allowed in the expression.

 

Factor: <A factor for the state variable, or a continuation>

This question means you did not answer the previous question. The program is then expecting a 
single state variable or a complete state variable expression, or the numeric factor in an expression 
with only one state variable. In a state variable expression a state variable may be preceded by a 
constant factor. An example of this is:

2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential of FE plus three times 
the chemical potential of O should be -35000 J/mol.

 

State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt State 
variable expression or Factor, or a state variable expression is given but the expression is 
incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a continuation 
of the unfinished expression. You need to specify a state variable or a complete state variable 
expression, or complete the unfinished state variable expression. If a numeric factor is given before 
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Syntax SET_CONDITION 

this prompt, only one state variable can be specified; otherwise, the program only takes the first 
state variable to complete the expression (i.e. the factor times the state variable).

 

Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is 
given as the default value. The special value NONE means that the condition is removed; for example 
T=NONE takes away the temperature condition.
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SET_INPUT_AMOUNTS

Specify how a system is made up from mixing of various substances. It is useful with a 
substance database. In the C-H-O-N system, you can, for example, give:

S-I-A N(H2)=10, N(H2O)=25, N(C1O2)=5, N(N2)=100

The POLY module automatically converts this into conditions for the current set of 
components. In the case when the elements are defined as the components, the command 
above is equivalent to

SET-CONDITION N(H)=70, N(O)=35, N(C)=5, N(N)=200

Syntax SET_INPUT_AMOUNTS 

Prompts

Quantity: <N(<specie>) or B(<specie>)>

You can give the amount also preceded with an equal sign = [e.g. N(H2)=10 or B(H2O)=1000], or 
press  <Enter> for the next prompt on the amount of the quantity.

 

Amount: <Value of the quantity>

Specify the numerical value of the quantity.

You can give negative amounts in the SET-INPUT-AMOUNTS command.
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SET_INTERACTIVE

In the  POST module this is called SET_INTERACTIVE_MODE.

Use the SET_INTERACTIVE command to use it in demonstration or macro files  to stop the 
execution of the command file and pass over input focus to the keyboard. 
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SET_NUMERICAL_LIMITS

This command is available for the POLY, Scheil, and ED-EXP modules.

Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a 
calculation procedure enforced by COMPUTE_EQUILIBRIUM, STEP_WITH_OPTIONS, MAP or 
ADVANCED_OPTIONS), this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 
to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-
LIMITS

This implies that smallest site fraction in the current POLY workspace is automatically 
increased from the default value 1.00E-30 to the hardware-dependent precision (under 
Linux, as 2.00E-14). For other subsequent POLY module calculations, you can use this 
command to restore or reset the smallest site fraction to the previous or another preferred 
value, as well as to reset other numerical limits.

Syntax SET_NUMERICAL_LIMITS

Prompt

Maximum number of iterations /500/:

By default, the program tries 500 iterations before it gives up. As some models give computation 
times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the 
calculation stops if 500 CPU seconds/iterations are used.

 

Required accuracy /1E-6/:

This is a relative accuracy, and the program requires that the relative difference in each variable 
must be lower than this value before it has converged. A larger value normally means fewer 
iterations but less accurate solutions. The value should be at least one order of magnitude larger 
than the machine precision.

 

Smallest fraction /1E-12/:

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you 
can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with 
one sublattice site (such as the GAS mixture phase in many databases) for which the default value is 
always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an even-
lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).

 

Approximate driving force for metastable phases /Y/:

Y is the default. Enter N to change the default as required and based on the options described below.

This setting involves the convergence of metastable phases and affects their driving forces. It can 
also have an effect on when an equilibrium is considered successful.

The default is to allow an equilibrium with metastable phases that have not converged, as long as 
the stable phases have converged. This is efficient but often causes approximate values of the 
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Syntax SET_NUMERICAL_LIMITS

driving forces for the metastable phases.

If you change the default, it enforces metastable phases to converge. This gives accurate driving 
forces for metastable phases as well as stable phases. It can however take a slightly longer time, and 
if metastable phases do not converge it causes the equilibrium calculation to fail.
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SET_REFERENCE_STATE

This command is available for the POLY, ED-EXP and POST modules.

The reference state for a component is important when calculating activities, chemical 
potentials, and enthalpies and is determined by the database being used. For each 
component the data must be referred to a selected phase, temperature, and pressure, i.e. 
the reference state. 

All data in all phases where this component dissolves must use the same 
reference state. However, different databases can use different reference 
states for the same element/component. It is important to be careful when 
combining data obtained from different databases.

By default, activities, chemical potentials, and so forth are computed relative to the 
reference state used by the database.  If the reference state in the database is not suitable 
for your purposes, use this command to set the reference state for a component using SER, 
i.e. the Stable Element Reference (which is usually set as default for a major component in 
alloys dominated by the component). In such cases, the temperature and pressure for the 
reference state is not needed.

In order to specify conditions in the specific reference state, you can append an R to the 
state variables. Thus, AC is the activity (of a system component or of a species in a phase) 
with respect to the default reference state, and ACR is the activity with respect to the 
selected reference state; MU is the chemical potential of a system component with respect 
to the default reference state, and MUR stands for the chemical potential with respect to the 
selected reference state. The AC and ACR variables, for both components in a system and 
species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).

For the POST module, and after calculating with the STEP_WITH_OPTIONS or MAP commands, 
the reference state for a component can also be changed to plot various properties of the 
component in the entire system or in a specific phase. Then you can set the diagram axes as 
the chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR
(comp,ph), ACR(comp),  ACR(comp,ph) or the common logarithms [e.g. LNACR(comp,ph)].

Syntax SET_REFERENCE_STATE 

Prompts
Component: <Name of the component>

The name of the component must be given.

 Reference phase: <Name of a phase used as the new reference state>
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Syntax SET_REFERENCE_STATE 

Enter the Name of a phase for the system. 

For a phase to be usable as a reference for a component, the component needs to 
have the same composition as an end member of the phase. The reference state is 
an end member of a phase. The selection of the end member associated with the 
reference state is only performed once this command is executed. 

If a component has the same composition as several end members of the chosen reference phase, 
then the end member that is selected at the specified temperature and pressure will have the 
lowest Gibbs energy. 

The following are example using temperature. Pressure is used in the same way:

 l In the Fe-C system, BCC can be a reference state for Fe but not for C since BCC can exist as 
pure Fe but cannot exist as pure C. 

 l If GAS is chosen as the reference phase of component O at such a high temperature that 
O1 has the lowest energy, then O1 remains the reference state even at calculations 
performed at lower temperatures where O2 has a lower energy than O1.

 l Setting the reference state for component O as gas (one sublattice) with constituents O1, 
O2 and O3 results in O2 being the reference state if, at the present temperature, pure O2 
has the lowest energy of O1, O2 and O3. If the reference state is set above a critical higher 
temperature, then O1 has the lowest energy and consequently becomes the reference 
state. 

 

Temperature /*/: <Temperature for the reference state>

Select the Temperature (in K) for the reference state. The wildcard value * means the current 
temperature is used at the time of evaluation of the reference energy for the calculation. 

The temperature set with this command does not affect the temperature used 
when evaluating the energy of the reference state during the end member 
selection process.

 

Pressure /1E5/: <Pressure for the reference state>

Select the Pressure (in Pa) for the reference state. The wildcard value * means the current pressure 
is used for evaluating the reference energy at the time of calculation.

 

Examples
S-R-S Fe SER

S-R-S Cr FCC * 100000

S-R-S H2O AQUEOUS * 100000

S-R-S ZE REF_ELECTRODE * 100000
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SET_START_CONSTITUTION

This command is available with the POLY and ED-EXP modules.

This command is similar to SET_ALL_START_VALUES, but is used for an individual phase that 
may have a wrong constitution.

Syntax SET_START_CONSTITUTION

Prompts

Phase name: <Name of a phase, and possible major constituent(s)>

Specify the name of a phase for which the constitution shall be set.

If there is a major constituent of the phase, you must specify this on the same line as 
the phase name. By giving an*, select the default major constituents. A $ means 
keeping the same constitution, and NONE means to give individual site-fractions.

 

Y(<Phase>#<Composition_set>,<Constituent>#<Sublattice>) /xxx/: <SF>

The site fraction (SF) of the constituent shall be given. The default value xxx is the last 
calculated one.
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SET_START_VALUE

This command is available with the POLY and ED-EXP modules.

This command is not often required as the automatic start values can be 
handled for most problems.

Set a start value of an individual variable.

Syntax SET_START_VALUE

Prompts
State variable: <Name of a state variable>

The state variable must be given.

 
Value

Specify the value to be assigned the state variable as start value.
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SHOW_FOR_T=

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Display various thermodynamic properties (state variables, derived/partial variables or 
entered symbols) of the currently calculated (stable/meta-stable) equilibrium state but 
under a different temperature condition. This is useful for knowing, for example, a volume-
related property of a frozen (stable/meta-stable) equilibrium state at a certain temperature, 
where the equilibrated phase assemblage and all the phase compositions are not adjusted 
while only the temperature condition is changed.

Use this option carefully. You must have successfully calculated a real equilibrium state 
under one temperature condition (normally the temperature for the last heat treatment). 
This can then be used to obtain the value(s) of any specified state variable(s) or 
derived/partial variable(s) or defined symbol(s) for thermodynamic properties of the entire 
system, of components, or of phases for the currently-defined system (being in a frozen 
state) under another temperature (normally at room temperature). No real equilibrium is re-
calculated through this option, and thus the phase amounts and compositions in the system 
are the same as at the last real equilibrium calculation.

Settings
Temperature (K) /298.15/: <temperature_in_K>

Specify the new temperature condition (in K) under which the values of some specific state 
variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic 
properties of the entire system, of components, or of phases) in the currently-defined 
system (being in a frozen state) is shown on screen.

State Variable or symbol /VM/: <State variable or symbol name(s)>

Specify the name(s) of the desired state variable(s) or derived/partial variable(s) or defined 
symbol(s) for various thermodynamic properties of the entire system, of components, or of 
phases) in the currently-defined system. More than one state variable or symbol of interest 
can be simultaneously specified on the same line. For example, you can choose to show the 
values of VM or GM (i.e. molar volume or molar Gibbs energy of the entire system), or of 
VM(*) or HM(*).T (i.e. molar volumes or isobaric heat capacity of all phases), or of ACR(*), 
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DGM(*) and LNACR(*,FCC) [i.e. activities of all system components, driving forces for all 
phases, and activities (in logarithm) of all system components in the FCC solution phase], 
under the new temperature condition (being in a frozen state).
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SHOW_VALUE

This command is available for the  POLY and ED-EXP modules.

Show the current value of any state variable, function or variable.

Syntax SHOW_VALUE 

Prompt
State variable or symbol: <Name(s) of state variable(s) or symbol(s)>

A single or several state variables or symbols (entered functions or variables) can be specified. 

 

The wildcard * can be used to denote all phases or all components. 

You can use the dollar-sign $ to denote all stable phases. Thus, the command SHOW W(*,*)lists the 
mass fraction of all phases, whereas SHOW W($,*)lists the mass fraction of all stable phases.

If you SHOW a function, all functions are evaluated using the current values of the 
state variables. But if you SHOW a variable, it retains its value from the time it was 
ENTERED or last EVALUATED. 

Therefore to save a value from one calculation to another, ENTER it to a variable. This is frequently 
done in the PARROT module to transfer values between equilibria.
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STABILITY_CHECK

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

In some composition ranges of a multicomponent system, it often happens that an unstable 
solution phase region locates inside a miscibility gap, and the stability limit (the spinodal 
curve or spinodal) may be not easy to find. A system inside a spinodal is thermodynamically 
unstable with respect to compositional fluctuations, and the system may experience the 
spinodal decomposition (i.e. decomposing to a mixture of regions with the two stable 
compositions, one on each side of the miscibility gap).

This option makes it possible to automatically check internal stability of both stable and 
unstable phases in all subsequent single-point equilibrium and MAP/STEP calculations. It can 
find out if any phase is subject to spinodal decomposition during the subsequent 
calculations. If there is an unstable phase located inside a miscibility gap in a calculation, it 
gives a warning so that you suspend the unstable phase, or use FORCED automatic start 
values for phase constituents (i.e. SET_ALL_START_VALUES → FORCE command-sequence), or 
create other composition sets; you can also ignore the warning message if you know that 
the unstable phase is not formed in the current calculations.

Settings
Stability check on? /Y/: 

Check also for unstable phases? /Y/: 

If the automatic stability-check option is switched on choose to also check the stability for 
unstable phases. The default is Y and if an unstable phase is found to be located in a 
miscibility gas during a subsequent single-point equilibrium or MAP/STEP calculation, a 
warning message informs you to selectively make adjustments in the calculation settings 
[e.g. suspending the unstable phase, or using FORCED automatic start values for phase 
constituents by the S_A_S_V F command-sequence, or creating other composition sets, etc.]. 
By answering N the stability check is enforced only to stable phases in the system.
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STEP_AND_MAP

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

STEP_AND_MAP is the default ADVANCED_OPTIONS choice and is used to determine how to 
perform Global Minimization test and how to handle initial equilibrium points.

Settings for MAP and STEP:

Global test interval /0/: <Integer number>

Settings for MAP:

Automatically add initial equilibria /Y/: 

Number of mesh along an axis /3/: <Integer number>

Use inside meshing points /N/: 

Global test interval /0/: <Integer number>

The integer number determines how often the Global Minimization should be used during 
STEP_WITH_OPTIONS and MAP calculations. If it is set to 0 (zero), the recommended global 
test interval is used: i.e. every tenth step and at each phase change during STEP calculations, 
and only at node points during MAP calculations. Any other positive integer number, n, 
suggests it performs a Global Minimization test at every -th step during STEP and MAP 
calculations. Of course, the Global Minimization test is always carried out at a phase change 
or a node point. The Thermo-Calc software is installed with 0 (zero) as the default value, but 
such a configuration for the default value can be changed by using SET_TC_OPTIONS in the 
SYS module.

Automatically add initial equilibria /Y/: 

When ADD_INITIAL_EQUILIBRIUM is not used before MAP, a mesh of initial equilibrium 
points are added before the mapping itself takes place. This mesh is only available when two 
(2) axes are already defined. The default on start-up may be changed by SET_TC_OPTIONS in 
the SYS monitor.

Number of mesh along an axis /3/: <Integer number>

An integer for how many intervals of initial equilibrium points to be added along an edge in 
the diagram. For example, if set to 2 (two), initial equilibrium points are added at the 
beginning, center, and end of each axis-variable forming 2 intervals.

Use inside meshing points /N/: 
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If N the INITIAL_EQUILIBRIUM mesh consists of initial equilibrium points added only along 
the edge/border of the diagram defined by the axis-variables. If Y, the initial equilibrium 
points added are also added to the inside edge.
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STEP_WITH_OPTIONS

This command is for the  POLY module.

The STEP_WITH_OPTIONS (short name, STEP) command initiates the stepping procedure to 
make a calculation of property diagrams in a multicomponent heterogeneous system. A 
property diagram is usually stepped under one defined independent stepping axis-variable, 
and is often constructed by the defined independent mapping axis-variable against a chosen 
property (for the system, or for a specific phase, or for a certain species). 

In the POLY module, it is possible to compute a series of equilibria with one condition as the 
stepping axis variable. This is achieved by first calculating a single equilibrium, and then 
selecting one of the conditions as the axis variable. The minimum and maximum value and 
the incremental step along the axis must also be given. By default, the global minimization 
technique is used .

A property diagram consists of property lines that change (normally) along with 
the stepping axis-variable. From a single STEP calculation, many different types 
of property diagrams in the defined multicomponent heterogeneous systems 
can be plotted. Various types of property diagrams are generated by the 
stepping calculations. 

About Property Diagrams

Normally, before the command can be invoked, you need to have already calculated an 
initial equilibrium point and set one independent variable (i.e. the controlling condition in 
the system) . This is done using SET_AXIS_VARIABLE. You then list the current values of the 
axis variable for each calculated equilibrium, as well as the corresponding information when 
the set of stable phases changes.

By default, the global minimization technique is enabled, You can turn this off by using the 
command-sequence ADVANCED_OPTIONS → GLOBAL_MINIMIZATION. 

You can choose how often to do a global minimization test using the command-
sequence ADVANCED_OPTIONS → STEP_AND_MAP → GLOBAL TEST INTERVAL.

Syntax STEP_WITH_OPTIONS                   

Prompt Option? /Normal/: <A chosen option, N, I, S, O, E, M, T, or P>
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Syntax STEP_WITH_OPTIONS                   

N = Normal, I = Initial equilibria, S = Separate phases, O = One phase at a time, E = Evaluate, M = 
Mixed Scheil, T= T0, and P  Paraequilibrium 

Normal (N)

When you accept the default, Normal (N), it allows a stepping calculation with the chosen 
independently-varying equilibrium condition (axis-variable). Only the step axis value is 
changed between each step.

When you repeat the STEP → NORMAL command-sequence, you can make several stepping 
calculations while still keep all the stepping-calculation results in the current POLY3 
workspaces. 

The calculation results are saved in the default RESULT.POLY3 file or you can 
specify to save it in the <MyName>.POLY3 file. This is as long as there is no SAVE_
WORKSPACES command before the second set of command sequences (STEP → 
NORMAL). Repeated stepped results can be restored into the same current 
POLY3 workspaces/file.

Linux and Mac are case sensitive so ensure you enter .POLY3.

The addition of several steps enables you to generate special types of property diagrams and 
to calculate and plot special phase boundary lines on phase diagrams, such as: 

 l The missing part(s) of a specific property [that are calculated under another 
controlling condition inside the range of the stepping-variable] on the same property 
diagram.

 l Two or more sets of a specific property [that are calculated under different 
controlling conditions and stepped over the same stepping-variable range] on the 
same property diagram for the same system.

 l Calculate some special phase-boundary lines [especially for some defined secondary 
phase transformations or alike, e.g. the BCC_A1 <--> BCC_B2 phase-boundary, or 
equal-Gm for two specific phases, or equal-fraction or equal-activity for a certain 
species in two specific phases, that shall be calculated under different controlling-
conditions and also be stepped over different stepping variable(s)], and then plot (or 
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impose) them onto a corresponding phase diagram (which can be resulted from 
several such STEP → NORMAL calculations or  even from a separate MAP calculation) 
for the same system.

Initial_Equilibria (I)

An initial equilibria is added at each calculated point. This can be useful, for instance, to 
generate a set of isothermal calculations.

When you choose I, an initial equilibrium is stored at each calculated equilibria. It is 
intended to generate a matrix of calculated initial equilibria, first stepped under a STEP 
INITIAL_EQUILIBRIA command-sequence and then repeated by another STEP NORMAL 
command-sequence (or even continued by a MAP command). 

For example, you can first use the temperature condition as the stepping axis-variable with 
this option, which calculates a number of initial equilibrium points and automatically adds 
each one as an initial equilibria for another STEP → NORMAL command-sequence (or even 
for a MAP command). Before the second STEP command (i.e. the STEP → NORMAL 
command-sequence), you can chose a compositional condition as the new stepping axis-
variable; then the STEP → NORMAL command-sequence uses those created starting 
equilibrium points (at different temperatures) and steps in such a new compositional 
variable. As a result, these two STEP commands together give a matrix of values. 

Separate_Phases (S)

In this way, you can calculate how the Gibbs energy for a number of phases varies for 
different compositions. This is particularly useful to calculate Gibbs energies for complex 
phases with miscibility gaps and for an ordered phase that is never disordered (e.g. 
SIMGMA-phase, G-phase, MU-phase, etc.). 

One_Phase_at_Time (O)

This option is recommended for STEPPING heterogeneous systems with both ordered 
phases and the disordered pairs.

When you choose O, the stepping calculation is conducted individually for one phase at a 
time. That is, it is stepped over the whole stepping variable range, but the stepping is 
repeated for all the entered phases in the defined system. This is particularly useful to 
properly step in composition for an equilibrium heterogeneous system with both ordered 
phases and the disordered pairs. Thus, instead of calculating for the same composition for 
each of the phases at each composition step, it  starts the stepping in each of the phases in 
the default most-stable compositions (the major constitutions). 
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Evaluate (E)

For Scheil-Gulliver simulations it is recommended you use the SCHEIL module.

Evaluate E is an advanced option and is useful when additional conditions (instead of the 
stepping variable) require changing during a stepping calculation. It allows a stepping 
calculation in a single axis with simultaneous evaluation of one or more variables after each 
step. As variables can be used as conditions, it means that you can change the conditions 
during the stepping. After a successful EVALUATE calculation, you can go to the POST 
module to manually define and plot property diagrams.

The variables given are evaluated after each step, which may change other 
conditions. This can be useful to perform the Ordinary ScheilGulliver Approach 
(non-equilibrium transformations) for simulating alloy solidification without 
back diffusion of fast-diffusing interstitial components in solid phases. 
However, it is recommended you use the SCHEIL module.

Specify the prompt:

Variable name(s): <Variable name>

The names of the variables that shall be evaluated after each step must be typed here.

The miscibility gap test is automatically used during stepping (see ADVANCED_
OPTIONS) if a phase has two or more composition sets.

The miscibility gap test means that you can start calculating from high temperatures in a 
steel where the MC carbide is not stable. During the calculation, the MC carbide first 
becomes metastable with a composition different from the metallic FCC phase and later also 
becomes stable.

See Console Mode example tcex30A.
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Mixed_Scheil (M)

For Scheil-Gulliver simulations it is recommended you use the SCHEIL module.

This is an advanced stepping calculation designed for the Extended Scheil-Gulliver Approach 
(partial-equilibrium transformations) to simulate alloy solidifications with back diffusion of 
one or more fast-diffusing interstitial components (such as C, N, O, S, etc.) in solid phases is 
performed. It also will consider BCC-->FCC phase transformation (practically for steels) along 
the alloy solidification process. 

To ensure a successful stepping calculation of mixed Scheil-Gulliver simulation of 
solidification process of a defined alloy system with a certain initial overall composition, it is 
important to note the following:

 l For solution phases with possibility of miscibility gap existence, you have 
appropriately added the necessary composition set(s);

 l You have already set the temperature condition as the stepping SET_AXIS_VARIABLE 
command, with minimum and maximum temperature points as well as an 
appropriate s temperature step for the cooling process). 

 l There must be a composition condition for each of the back diffusion components 
(i.e. fast-diffusing interstitial components, such as C, N and/or other elements) that 
are already defined in terms of mole-fraction or mass-fraction, e.g. X(C) and W(N). 
Otherwise, a stepping calculation with this option can fail.

 l An initial equilibrium in which the LIQUID mixture phase is the only stable must be 
calculated. This is why it is good to start with a relatively high temperature condition 
for the initial equilibrium calculation. It is always necessary to reject or suspend the 
GAS mixture phase (if it exists) before the C-E and STEP commands, to avoid its 
formation along with LIQUID.

 l In cases where fast-diffusing interstitial components are specified as back diffusion 
components, you can choose to allow BCC>FCC phase transformation (practically for 
steels) during the alloy solidification process.

These are the prompts for this option:

Fast diffusing components: <Fast diffusion interstitial(s)>

Specify one or more interstitial component(s) as the back diffusion component(s).
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 l If there is only one fast-diffusing interstitial component (e.g. C or N), type its name;
 l If there are two or more fast-diffusing interstitial components (e.g. C, N and S), 

always type the names on the same line at once (separated by an empty space in 
between, e.g. C N S);

 l If there is no fast-diffusing interstitial component to be considered, type NONE to 
ignore back diffusion entirely, meaning a normal Scheil-Gulliver simulation is 
performed.

Such specified back diffusion interstitial component(s) must be appropriately 
defined according to the phase constitution definitions of some major alloy 
solution phases (e.g. FCC, BCC, HCP, etc.). These are located on the 
interstitial/vacancy sublattices in such alloy solution phases; otherwise, such a 
Scheil-Gulliver simulation may not make sense at all.

Allow BCC -> FCC ? /Y/: 

By default the BCC-->FCC phase transformation is allowed. This is usually a typical 
phenomenon along the cooling processes of steels/Fe-alloys.

During the  calculation  the simulated solidification path, including the locally-equilibrated 
phase assemblage (region), captured temperature condition (T in K), remaining liquid phase 
(NL, mole fraction), overall formed solid phases (NS, mole fraction) and latent heat formation 
(NH, J/mol) along the cooling process are shown after the information on starting 
temperature point of the alloy solidification process, e.g.

Solidification starts at  1743.15 K

Phase Region from   1.744150E+03 for:      LIQUID

Phase Region from   1.742525E+03 for:

     LIQUID

     FCC_A1#1

       1742.5250          0.9960          0.0040         -1.1824

       1742.4000          0.9795          0.0205       -202.1585    . . . . . .

Phase Region from   1.733150E+03 for:

     LIQUID

     BCC_A2

     FCC_A1#1

       1733.1500          0.3294          0.6707      -8032.6240

       1733.0250          0.3237          0.6763      -8095.1490    . . . . . .
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After a successful calculation, you can go to the POST module to manually define and plot 
property diagrams for the alloy solidification process according to the chosen Scheil-Gulliver 
model, or to impose existing relevant experimental information or other types of calculated 
solidification results [e.g. Scheil-Gulliver simulation with or without considering fast-diffusing 
interstitial component(s), full-equilibrium approach, or Diffusion Module (DICTRA)-type 
simulation with moving-boundary conditions] onto the same plotted property diagrams.  
Normally, the solidus temperature (T in Celsius) is set as one of the axis variables (usually as 
Y-axis in most cases), while the other plotted quantity on the other axis can be the amount 
of overall formed solid alloy phases (NS in mole-fraction or BS in mass-fraction), the amount 
of remaining liquid phase (NL in mole-fraction or BL in mass fraction), the heat of latent 
along the solidification process (NH in J/mol or BH in J/gram), among many other properties 
in the solidified alloy phases or in the whole alloy system.

T-zero (T)

See Console Mode example 41.

This advanced option allows a stepping calculation of the so-called T0 (T-zero) line in a 
diffusionless transformation (where two specific partially-equilibrated phases have the same 
Gibbs energy) along a composition variable which has already set as the stepping variable 
with SET_AXIS_VARIABLE. 

The temperature condition cannot be set as the stepping variable if you want to 
make a STEP T-ZERO calculation.

Prior to performing the step T0 command sequence, and to ensure a successful 
calculation of T0 line between two specific phases after an initial equilibrium 
calculation in the current system, it is sometimes recommended to make a 
single T0 point calculation using ADVANCED_OPTIONS → T-ZERO.

Specify these prompts:

Name of first phase:  <Phase A>

Name of second phase: <Phase B>
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The names of the target phases, for which the Gibbs energies equal to each other at each  
point on the T0 line, must be entered.

During the calculation, the T0 values are shown after the corresponding scanned conditions 
(of the stepping composition variable), e.g.

Phase Region from   1.000000E-01 for:

     BCC_A2

     FCC_A1

   1.000000E-01         940.24

   9.250000E-02         941.20

   . . . . . .

   2.500000E-03         977.61

   7.500000E-09         979.34

Phase Region from   1.000000E-01 for:

     BCC_A2

     FCC_A1

   1.000000E-01         940.24

   1.075000E-01         939.62

   . . . . . .

   2.950000E-01        1084.87

3.000000E-01        1080.99

After a successful calculation, you can go to the POST module to plot the T0 line against the 
stepping composition variable or another varying axis, or to impose the calculated T0 line 
onto a normal phase diagram [normally plotted as a T-X isopleth]. 

Paraequilibrium (P)

See Console Mode examples 42 and 43.

This is an advanced option. Select P to calculate the paraequilibrium state between two 
specific phases (the  paraequilibrium lines). It allows a stepping calculation of  
paraequilibrium lines where the chemical potential for one or more interstitial components 
(that are considered as back diffusion elements, such as C and N) but not for the other (s) in 
two partially equilibrated phases are equal.

More than one interstitial component can be treated as fast-diffusion species (such as C, N, 
O, S, etc., as individual or combined) in a paraequilibrium stepping calculation.
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The composition condition for the interstitial components cannot be set as the 
stepping variable if you want to make this calculation.

To ensure a successful stepping calculation of paraequilibrium states between two specific 
phases in a defined alloy system, it is important to first make a starting-point equilibrium 
calculation with an initial overall composition in the current system. However, it is 
unnecessary to obtain an equilibrium in which either one or both of the target phases is 
stable. 

The initial overall composition must have a reasonable setting for the desired 
paraequilibrium calculation for the two target phases. This is especially true  where there is 
more than one interstitial component to be considered in the paraequilibrium state, 
because different interstitial components (for example C and N combined) may have 
significant different behaviours as partitioning into different structured phases; otherwise, 
for one chosen interstitial component the initial overall composition is OK for the 
paraequilibrium calculation between the specified two phases, but for other chosen 
interstitial component(s) it might be impossible to calculate the paraequilibrium state.

Always check if the chosen phaseA and phaseB have the exact same definition of elements 
and if the chosen interstitial components are all in the vacancy sublattice sites of the two 
phases; otherwise the program cannot find the paraequilibrium state (as it is impossible to 
correctly calculate u-fractions).

Always have a comprehensive understanding of the normal phase diagram for the currently 
investigated system, so that you make the appropriate choice of the phase pair and staring 
bulk composition for the system.

Always set the status of the chosen interstitial components as SPECIAL using the command:

CHANGE_STATUS COMPONENT <interstitial component> = SPECIAL

By doing this, you get a clear picture on u-fractions of various substitutional and interstitial 
components, which are different from the overall composition in the system. The SPECIAL 
status means that specified component(s) are not included in summations for mole or mass 
fractions. Therefore, all the composition variables plotted from the paraequilibrium 
calculations are u-fraction related quantities.

Always make a single-point paraequilibrium calculation by the command-sequence of 
ADVANCED_OPTIONS → PARAEQUILIBRIUM, prior to performing this STEP → 
PARAEQUILIBRIUM command-sequence, although this might not be always necessary for 
some systems.

With this stepping calculation specify the following:

Name of first phase:  <Phase A>
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Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium states 
establish, must be typed at the above two prompts subsequently or on the same (first) line 
at once (separated by an empty space, e.g. FCC BCC, FCC#2 M23C6).

It is important to understand that this is the calculation of a paraequilibrium 
state between the two specified phases. 

Particularly, there are these issues to consider: 

 1. Both chosen phases must have similar interstitial/vacancy sublattices where the fast-
diffusion interstitial component(s) occupy.

 2. The choice on the target phase pair must be reasonable for the defined system and 
specified initial overall composition.

 3. Both target phases should have phase constitution definitions that cover all the 
defined substitutional and interstitial components of the current alloy system; or 

 4. It is impossible to calculate the paraequilibrium state between the target phase pairs 
with given interstitial component(s) in the currently defined system.

Fast diffusing component: /C/: <Interstitial component(s)>

Fast diffusing component: /None/: <Interstitial component(s)>

The name(s) of the fast-diffusing interstitial component(s) (C as the default single 
component) must be given either one by one at each of the above prompts subsequently or 
in a combination (separated by an empty space in between, e.g. C N S) at the same (first) 
prompt; otherwise, press <Enter> key to start the paraequilibrium line stepping-calculation.

Note the following:

Such specified fast-diffusing interstitial component(s) must be appropriately defined 
according to the phase constitution definitions of the two selected phases: These must be 
located on the interstitial/vacancy sublattices in both chosen phases.

If there is only one fast-diffusing component which is carbon, press <Enter> to accept the 
default value (C) at the first prompt; if the single fast-diffusing interstitial component is 
another element (e.g. N), appropriately type interstitial component the name at the first 
prompt;
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If there are two or more fast-diffusing components (e.g. C and N), type their names at the 
above prompts subsequently or at the same (first) prompt (separated by an empty space, 
such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt;

If NONE or a non-existing component name is typed at the first prompt, it means no back 
diffusion is to be considered, and the para-equilibrium calculation is thus cancelled entirely.

During the STEP → PARAEQUILIBRIUM calculation procedure, the calculated paraequilibrium 
states include the:

 l corresponding stepping conditions (e.g. temperature in K, or the stepping 
composition variable of the matrix component or of one of substitutional 
components) which has already set as the stepping variable by the SET_AXIS_VAR 
command);

 l amounts of the phase A in mole number [i.e. NP(phaseA)];
 l amounts of the phase B in mole number [i.e. NP(phaseB)];
 l contents of the interstitial component(s) in the phase A expressed in u-fractions [i.e. 

u-f(phaseA,component(s))];
 l contents of the interstitial component(s) in the phase B expressed in u-fractions [i.e. 

u-f(phaseB,component(s))];
 l LNACR(component) value(s) for the interstitial(s).

After a successful STEP → PARAEQUILIBRIUM calculation, you can go to the POST module to 
plot a paraequilibrium phase diagram, or to impose the calculated paraequilibrium states 
onto a normal phase diagram [normally plotted as a T-X isopleth with one of the considered 
interstitial component(s) as the x-axis variable]. 

However, the stepping calculation procedure for the currently specified paraequilibrium 
states between the two specified phases may find difficulties at some steps due to some 
possible numerical problems (normally regarding to the u-fractions of the interstitial 
components under some composition ranges), or it may completely fails. In the latter case, it 
implies that the chosen target phase pair may be unreasonable for the defined alloy system 
or for the defined initial overall composition, or one or both phases may have inappropriate 
phase constitution definitions regarding the specified interstitial component(s) and 
substitutional components. Then, you must either modify the settings of initial overall 
composition or specify the reasonable target phase pair with an appropriate choice of the 
fast diffusion interstitials in the defined alloy system.
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The figure shows the plot of a paraequilibrium calculation of isopleths: Formation of para-pearlite 
in two Fe-based alloys, with equilibrium results appended.

The calculated paraequilibrium phase boundaries (black lines) are shown with 
tie-lines (in green-colour). In the Fe-2.5Mn-C alloy system, C is considered as 
fast diffusing interstitial component in the BCC+FCC and FCC+Cementite 
paraequilibrium stepping calculations; while in the Fe-3Cr-N alloy system, N is 
treated as fast diffusing interstitial components in the BCC+FCC and FCC+FCC_
M1N (i.e. FCC#1+FCC#2) paraequilibrium stepping calculations.

During a STEP calculation, the value of the stepping axis variable for each 
calculated equilibrium is listed and also the set of stable phases.

You can terminate the mapping of a line by pressing a single <Ctrl-A> 
(Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish 
calculation without losing what is already calculated.

If there is any convergence problem in finding a stable solution at any stage during a 
calculation procedure enforced by a STEP_WITH_OPTIONS command-sequence, this message 
displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30   to 
hardware precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS
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This implies that smallest site fraction in the current POLY3 workspace is automatically 
increased from the default value 1.00E-30 to the hardware-dependent precision (under 
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run, 
you can use the POLY command SET_NUMERICAL_LIMITS to restore or reset the smallest site 
fraction to the previous or another preferred value, as well as to reset other numerical 
limits.

Complex miscibility gaps of various solution phases are automatically detected during a 
stepping calculation, and two or more composition sets for each of such solution phases are 
automatically generated as well, through an automatic Global Minimization Test procedure 
(by specifying a Global Test Interval value and confirming the Automatically add 
initial equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a 
particular case, such an automatic Global Minimization Test ensures that you can now start 
calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase) 
where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1 
miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.) are 
not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may first 
become metastable with a composition different from the metallic FCC_A1 phase and later 
also stable.

Occasionally, it may be necessary to have a specified increment other than the default value 
for the defined stepping axis-variable, in order to calculate/plot a smoother property 
diagram.

To get a complete property diagram, sometimes (especially in some earlier Thermo-Calc 
versions) it may also be required to have more than one starting equilibrium-points (under 
another starting equilibrium condition), and repeat the stepping calculation over the same 
stepping axis-variable range (while without over-writing the same POLY3 workspaces via a 
SAVE_WORKSPACE command). However, using the current STEP procedure such a 
requirement become less necessary.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 277 of 622

TABULATE

This command is available for a table entered in either the POLY or POST 
module.

For any entered table, this command gives a table of values from equilibria calculated with a 
STEP command. 

Unlike the TAB module's command (also called TABULATE) it is not possible to 
plot columns from the tabulated tables. For this use normal POST commands.

Syntax TABULATE

Prompts
Name: <Name of a table entered in either POLY or POST>

Specify a table name that is entered in either the POLY or POST module.

 

Output on screen or file /Screen/: 

Specify a file name if you want to save on a file the table values along the defined STEP calculation, 
or press <Enter> if want to see the table values displayed.
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TOGGLE_ALTERNATE_MODE

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

Toggle the ALTERNATE mode for experimental equilibrium calculation between DEFAULT, 
ALWAYS and NEVER, during data-assessments using the PARROT optimization. 

Set alternate toggle to DEFAULT, ALWAYS, or NEVER?

Set global toggle to DEFAULT, ALWAYS, or NEVER?

 l DEFAULT: the experiment points are calculated according to the Alternate Technique 
depending on the SET_ALTERNATE command. 

 l ALWAYS: the experiment points are always calculated according to the Alternate 
Technique even if the Alternate Mode is switched off in the PARROT module. 

 l NEVER: the experiment points are calculated as normal equilibria even if you SET_
ALTERNATE in the PARROT module.
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T-ZERO_TEMPERATURE

This is an option that is available with the ADVANCED_OPTIONS command with 
the POLY and ED-EXP modules.

ADVANCED_OPTIONS

This calculates the temperature when two specific phases have the same Gibbs energy, i.e. 
the so-called T0 temperature. You must calculate an equilibrium state at an estimated 
temperature before performing this advanced-option calculation; however, it is unnecessary 
to obtain an equilibrium state in which either one or both of the target phases is stable.

The following prompts are shown.

Name of first phase:  <Phase A>

Name of second phase: <Phase B>

The names of phases A and B must be given, for which the T0 temperature (where the Gibbs 
energies are equal) is to be calculated.

If the T0 temperature between the two specified phases is successfully calculated, a 
message displays, e.g. 

The T0 temperature is 840.82 K. Note: LIST-EQUILIBRIUM is not relevant

The first message shows the calculated T0 temperature between the two specified phases.

The second message indicates that after this option calculation with LIST_EQUILIBRIUM is 
irrelevant and does not list the equilibrium for the system at the T0-temperature.
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Gibbs Energy System (GES) Commands

In this section:

Solution Models in the GIBBS (GES) Module 283

About the ENTER_PHASE Command 291

ADD_COMMENT 295

AMEND_ELEMENT_DATA 296

AMEND_PARAMETER 298
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AMEND_SYMBOL 305

CHANGE_STATUS 308
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ENTER_PHASE 314

ENTER_SPECIES 316

ENTER_SYMBOL 317

LIST_CONSTITUTION 321

LIST_DATA 322

LIST_PARAMETER 325

LIST_PHASE_DATA 327
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REINITIATE 334
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SAVE_GES_WORKSPACE 335

SAVE_WORKSPACES 336
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Solution Models in the GIBBS (GES) Module

AMEND_PHASE_DESCRIPTION

The AMEND_PHASE_DESCRIPTION command  is used to specify/amend phase descriptions if a 
phase has a miscibility gap, uses a special excess energy model, or has a specific additional 
contribution to its Gibbs energy, for example. 

This topic outlines the application of each option and includes important information about 
each command. 

There are many solution models implemented in the GIBBS module (type INFO MODELS to 
see details about various thermodynamic models). However, these are switched on and 
handled differently via various GIBBS routines/commands:

 l The first models the non-ideality as excess parts, i.e. by amending the phase’s 
EXCESS_MODEL and/or TERNARY_EXTRAPOLAT models.

 l The second models the non-ideality as ADDITIONAL parts, i.e. by amending the 
phase’s other subjects in this command, e.g. MAGNETIC_ORDERING for the Magnetic 
Ordering Model, DISORDERED_PART for the CVM Approach in modeling chemical 
ordering/disordering phenomenon, QUASICHEM_IONIC for using a quasi-chemical 
entropy term for an ionic two-sublattice liquid solution phase, QUASICHEM_FACT00 
or QUASICHEM_IRSID for describing a substitutional liquid solution phase, DEBYE_
HUCKEL for the DHLL/SIT Model in describing a dilute aqueous solution phase, etc.

 l The third implements the model entirely or partially into the GIBBS module and 
related database(s), such as for the electrostatic contribution in an AQUEOUS 
solution phase by the Complete Revised_HKF Model, the Murngham Model, Birch-
Murngham Model or Generalized PVT Model for high-pressure/temperature volume 
contribution in a solid or liquid phase, the SUPERFLUID Model for the non-ideal EOS 
and non-ideal mixing in a gaseous mixture.

NEW_CONSTITUENT

Use this if you want to add a new constituent to a phase. It is illegal to add new constituents 
to an ionic two-sublattice liquid phase.

RENAME_PHASE

Use this to change the names of some specific phases. For example, a phase called FE3O4_S 
may be better named Magnetite to help identify it during the calculations and 
postprocessing. This is also a way to delete a phase by hiding it under a new name.
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SITE_RATIOS

Use this to change the number of sites (i.e. the stoichiometric coefficients of various 
sublattices) in a sublattice phase.

COMPOSITION_SETS

Use this for solution phases that may have miscibility gap(s). However, this is less important 
today and often unnecessary to define additional composition set(s), since the implemented 
Global Minimization Technique can usually detect and add such composition set(s) in an 
automatic manner where it is really necessary during equilibrium calculations (of single-
points, stepping or mapping).

MAJOR_CONSTITUENT

Use this to set major constituent(s) on each sublattice in each composition set for a solution 
phase. This is useful to make calculations converge faster because it may simplify giving start 
values when calculating the equilibrium as those phases with miscibility gaps should have 
different major constituents for each composition set. The databases often set major 
constituents for several phases automatically when data are retrieved.

FRACTION_LIMITS

Use this to limit the application range (in terms of mole-fractions of all the involved 
elements) of a particular solution phase. This is useful to avoid automatic creations 
(enforced by the Global Minimization Technique) of additional composition sets for some 
solution phases (such as AQUEOUS solutions or dilute Fe-based liquid mixtures) of which the 
used models [e.g. the SIT Model or the Complete Revised_HKF Model for AQUEOUS 
solution, or the modified dilute solution parameters (plus a quadratic term, according to 
Hillert (1986) based on the SigworthElliot Model [1974Sig] for Fe-rich liquid mixture] cannot 
be appropriately applied on a full scale.

Globally set the composition limits (in terms of mole fractions of various elements) in a 
specific solution phase, so that whenever the program finds a potential phase composition 
or a new composition set of possible miscibility gap(s) but that is out of this globally-set 
composition range, the program automatically ignores such a phase composition in an 
equilibrium calculation. This can be done either permanently inside a database (by enforcing 
this option for amending the phase-description of the solution phase) or temporarily within 
the GIBBS module (by using this phase-description amendment option).
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This is important for solution phases for which the thermodynamic models and assessed 
data for the phases are for specific composition ranges, for example, the FE_LIQUID phase in 
the SLAG database is only applicable for Fe-rich liquid mixture, and the AQUEOUS phase in 
the TCAQ/PAQ and AQS/PAQS databases is only applicable for H2O-dominant aqueous 
solution phase.

Specify the low and high mole-fraction limits for each of the elements possibly available 
within the considered phase (in the currently defined system, or in a certain database). Do 
this for all the possible elements (defined in the phase) in a single AMEND_PHASE_
DESCRIPTION FRACTION_LIMITS command-sequence, for example:

TYPE_DEFINITION R GES AM_PH_DES FE_LIQUID FRACTION_LIMITS Fe 0 0.6

      Ag 0 0.01  Al 0 0.05  Ca 0 0.05  Co 0 0.01  Cr 0 0.01

      Cu 0 0.02  Mg 0 0.05  Mn 0 0.05  Mo 0 0.05  Nb 0 0.05

      Ni 0 0.05  Pb 0 0.05  Si 0 0.10  Sn 0 0.02  Ti 0 0.05

U  0 0.01  V  0 0.02  W  0 0.02  Zr 0 0.03

      B  0 0.01  C  0 0.01  H  0 0.01  N  0 0.01  O  0 0.01

P  0 0.01  S  0 0.01  !

NEVER_DISORDER

The contribution from the disordered phase are added to the ordered phase. Use this to 
avoid entering several parameters to the ordered phase in the database. Instead it can be 
expressed as one parameter in the disordered phase.

The reference [2018Sun] section 2.3.4 has extensive details about this model. 
Original references from [1994Dup] and [2000Ans]. 

DISORDERED_PART

This command is needed for the special treatment of chemically-ordered phases where the 
contributions from the disordered state are described by a phase without ordering 
sublattices (the disordered phase name must be specified).

Several checks are made that the ordered and disordered phases are compatible 
(sublattices, sites and constituents). A link is then created between the phases, and the 
disordered phase is hidden from application programs. The Gibbs energy for the ordered 
phase also includes the Gibbs energy for the disordered phase.
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Phases which can have an order/disorder transformation have parameters split on two 
phases and are referred to as the two phase description in the GIBBS module. One of them 
has sublattices for chemical ordering, the other one represents the disordered state. 
Normally, the ordered BCC and FCC or HCP phases may have either 2 or 4 substitutional 
sublattice (plus one additional interstitial site), that are handled by the Two Substitutional-
Sublattice Ordering Model or Four Substitutional-Sublattice Ordering Model, respectively.

Two phase means that the ordered phase has parameters that describe the ordering. The 
disordered phase has all parameters for the reference state and those for describing the 
disordered phase. The ordered phase may occur only is some systems whereas the 
disordered phase may occur frequently, typical examples are the disordered FCC and BCC 
which may become ordered as L12 or B2 in certain systems. In order to treat 
multicomponent systems where some subsystems have ordering it would be necessary to 
transform all parameters of BCC into a B2 model.

The parameters describing the disordered phase are not changed but the Gibbs Energy 
system is informed that the Gibbs Energy for the two phases should be added.

The method used calculates the Gibbs Energy of a two phase model with two or four 
substitutional sublattices for ordering.

The mole fractions xi are calculated from the site fractions yi. The last term 
means that the contribution from Gmord in a disordered state (same site 
fraction, equal to the mole fraction, on both sublattices) is subtracted. The 
effect of this is that the parameters in the ordered phase have no contribution 
to the disordered state.

MAGNETIC_ORDERING

Change the magnetic ordering parameter for a certain phase with magnetic ordering 
contribution, in terms of its anti-ferromagnetic factor. By default this is –1 for BCC phase and 
–3 for all other phases (FCC, HCP, etc.). The fraction value of the total enthalpy (due to 
short-range ordering above the magnetic transition temperature) is by default 0.40 for BCC 
phase and 0.28 for all other phases (FCC, HCP, etc.).

EXCESS_MODEL

See example tcex52.
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Use this to change the default Excess Model (for interaction energies) from the default 
(REDLICH-KISTER_MUGGIANU). The model handles the excess interaction energies in a 
solution phase is chosen from:

 l REDLICH-KISTER_MUGGIANU: for binary (R-K) & ternary (R-K-M) interactions
 l REDLICH-KISTER_KOHLER: for binary (R-K) & ternary (R-K-K) interactions
 l FLORY-HUGGINS POLYMER MODEL: for interactions in a polymer mixture phase (F-H)
 l MIXED-EXCESS-MODELS: (R-K default) for mixed binary excess model (R-K, Legendre 

& Polynom) of a substitutional solution phase
 l HKF: for interaction in an AQUEOUS solution phase (HKF)
 l PITZER: for interaction in an AQUEOUS solution phase (PIT) 
 l CENTRAL_ATOM_MODEL: for interaction in a liquid slag solution phase (C-A-M)

For extrapolations of excess energies from related binary systems to ternary or higher-order 
systems, the Redlich-Kister binary excess interaction parameters may be extrapolated with 
either a Muggianu extension (i.e. the default REDLICH-KISTER_MUGGIANU model) and a 
Kohler extension (i.e. the alternative REDLICH-KISTER_KOHLER model), where there is no 
ternary, quaternary or higher-order interaction parameter. 

The REDLICHKISTER_KOHLER model is implemented only for ternary systems.

The MIXED-EXCESS-MODELS option works only for a substitutional phase with no sublattice 
(such as the metallic LIQUID phase) and it can be used to invoke asymmetrical simple or 
Legendre polynomial as binary excess energy models in addition to the default symmetrical 
Redlich-Kister model for the chosen pair of constituents in a substitutional phase with no 
sublattice. Asymmetrical here means that the power series depend only on one of the 
constituents, for example with expansions based on the [1-2*X(B)] term rather than [X(A)X
(B)]. 

Binary interaction parameters for such a pair of constituents must be entered 
prior to turning on the non-default Legendre or Polynom models. 

TERNARY_EXTRAPOLAT

See example tcex52.
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Use this to change the extrapolation method from the default REDLICH-KISTER_MUGGIANU to 
another extrapolation model. This method extrapolates from binary to ternary (and higher-
order) excess interaction parameters in a solution phase and is chosen from:

 l MUGGIANU for Muggianu Extrapolation from R-K parameters
 l TOOP-KOHLER for Toop-Kohler Extrapolation Model
 l KOHLER-ALL for Kohler Extrapolation Model
 l MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model

Only when all the relevant binary excess energies in the current solution phase 
are treated by the default Redlich-Kister Model (i.e. the Mixed-Excess-Model 
should have not been used), the MUGGIANU_RESTOR method for ternary 
extrapolations is equivalent to the Redlich-Kister_Muggianu Model, or the 
KOHLER-ALL method to the RedlichKister_Kohler Model.

The default ternary extrapolation method MUGGIANU_RESTOR applies to a solution phase as a 
whole, whatever the binary excess model(s) enforced to each of individual binary pairs in 
the phase. In case that all the binary pairs in the phase use the default binary excess model 
REDLICH-KISTER, then the ternary extrapolation method becomes the so-called Redlich-
Kister_Muggianu Model (in short as R-K-M), for extrapolations from binary parameters to 
ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for 
that, such a default R-K-M Model is always used.

The KOHLER-ALL ternary extrapolation method can be turned on also for a solution phase as 
a whole, whatever the binary excess model(s) enforced to each of individual binary pairs in 
the phase. In case that all the binary pairs in the phase use the default binary excess model.

REDLICH-KISTER, then the ternary extrapolation method becomes the so-called Redlich-
Kister_Kohler Model (in short as R-K-K), for extrapolations from binary parameters to 
ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for 
that, such an R-K-K Model is used.

The TOOP-KOHLER ternary extrapolation method is applied in a special way: for a specific 
ternary system (e.g. A-B-C) in a solution phase, specify which two constituents as the so-
called Kohler constituents and the remaining constituent as the so-called Toop constituent 
on a given sublattice. If for the A-B-C ternary system you have specified A and B, or B and A, 
as the Kohler constituents (entered as the basis constituent and first interacting constituent) 
and C as the Toop constituent, only the A-B binary interaction parameters are used in 
accordance with the Kohler ternary extrapolation formula for A-B-C ternary interaction, 
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while any other binary interaction parameters involving the Toop species C (i.e. of A-C and B-
C binaries) are used in line with the Toop-Kohler ternary extrapolation formula (for the A-C-B 
and B-C-A ternary interactions). 

DEBYE_HUCKEL

To use the DHLL (Debye-Hückel Limiting Law) model and SIT (Specific Ionic Interaction 
Theory) model for a dilute AQUEOUS solution phase, switch the DEBYE_HUCKEL part on, and 
it removes previously set (if any) ADDITIONAL part on the non-ideality for the chosen 
AQUEOUS phase.

HKF_ELECTROSTATIC

To use the hypothetical electrostatic contribution for the chosen phase (it must be an 
aqueous solution phase using the Complete Revised_HKF Model). It removes previously set 
(if any) ADDITIONAL part on the non-ideality for the chosen AQUEOUS solution phase.

QUASICHEM_IONIC

To use the Quasichemical-Ionic model for the chosen liquid phase, you must have already 
entered/retrieved a liquid phase as an ionic two-sublattice liquid solution phase (normally, 
that is the IONIC_LIQ phase), and then use this amending option to switch QUASICHEM_
IONIC on. It creates a completely new liquid solution phase [namely the QUAS_IONIC phase 
which uses the Quasichemical Model for the entropy, according to Mats Hillert [2001Hil], 
while the original IONIC_LIQ phase remains in the system and is not changed by this option. 

QUASICHEM_FACT00

See example tcex49.

To use the Quasichemical Model developed by Kongoli et al. [1998Kon], you must have 
entered/retrieved a liquid phase using a normal substitutional liquid model with specified 
associates or species (on a single lattice site), and then turn on the option QUASICHEM_
FACT00. This removes the previously-set (if any) ADDITIONAL part on the non-ideality for the 
chosen liquid phase. 
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QUASICHEM_IRSID

To use the Kapoor-Frohberg-Gaye Quasichemical Cell Model (i.e. the Quasichemical Model 
developed by ISRID, France) for a liquid SLAG solution phase, you can use a normal liquid 
model with specified associates or species.

GLASS_TRANSITION

To use the special model for glass transition of a liquid phase. It removes previously set (if 
any) ADDITIONAL part on the non-ideality for the chosen liquid phase.

REMOVE_ADDITION

To remove all the selected ADDITIONAL part from the Gibbs energy description for the 
chosen phase. If preferred, set a specific phase-status bit for a phase, use the PHASE_BITS 
option as long you know the restrict meaning of each part of a phase- status bits. 

DEFAULT_STABLE

Set phases as default-stable, which helps you to have a better guess of which phases that 
should be stable at the first calculation.
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About the ENTER_PHASE Command

ENTER_PHASE

With the command ENTER_PHASE, the phase name, phase-type, sublattice number, and 
constituents or constituent array(s) for the phase are entered into the GIBBS workspaces. 

About Phase Names

A thermochemical system must have at least one phase (which is a homogeneous part of the 
system with a uniform composition and structure). In the GIBBS module, any number of 
phases can be entered for a system and for each phase there must be a description of how 
its Gibbs energy varies with temperature, pressure and composition. A phase has a large 
amount of data connected to it, e.g. it starts with a phase name:

 l It may be treated as a special phase-type;
 l It may have structural information about sublattice(s), etc.,
 l There must be a list of constituents (for a substitutional phase with no sublattice) or 

of constituent arrays (for a sublattice phase);
 l There may be basic information on what kind of EXCESS_MODEL (polynomial 

expression) is used to describe the binary, ternary and/or higher-order interactions 
between constituents;

 l There may be so-called Additional contributions to the Gibbs energy of the phase 
from special physical phenomena, e.g. magnetic ordering, hypothetical electrostatic 
interaction, and so forth;

 l There must exist all the parameters required for the descriptions of thermochemical 
properties (i.e. G terms for standard Gibbs energies, and L terms for binary, ternary 
or higher-order interaction excess energies) and of some special physical properties 
(e.g. the Curie temperature TC and Bohr magneton number BMAGN (or BM) for 
magnetic ordering, V0-VA-VC-VK parameters for volume contributions, Born functions 
for hypothetical electrostatic interaction in an aqueous solution phase) stored in 
connection with the phase.

About Phase Type Code

A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a 
substitutional phase without sublattice, and that an L phase (ordinary liquid solution) is 
normally (but not always) modeled as a substitutional phase without sublattice, too.
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The F and B phase-types are useful for ordered FCC (or HCP) and BCC solution phases 
handled by the so-called Four Substitutional-Sublattice Ordering Model, which always 
requires that the solution phase must have four sublattices for substitutional ordering and 
can additionally have an interstitial sublattice.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners 
of the regular tetrahedron on these lattices all of which are the nearest neighbours. A 
Normal 4-Sublattice Model requires that all the G parameters for each of end-members with 
the same elements but distributed on different sites be given separately. However, as these 
corners are identical lattice points, the phase-type option F means that the G parameters 
need be given only once. The possible permutations are handled automatically. To be more 
clarified: An A-B binary solution phase (with the element A locates on one sublattice site and 
B on three sublattice sites) treated by the Normal 4-Sublattice Model has to have 4 G 
parameters for 4 end-members, i.e. G(phase,A:B:B:B), G(phase,B:A:B:B), G(phase,B:B:A:B) 
and G(phase,B:B:B:A), because of that in the general case these G parameters can be 
different from each other. But for the FCC and HCP orderings, these are identical and thus all 
G parameters of such end-members need be given only once, and the possible permutations 
are then automatically handled by the GIBBS module. This significantly simplifies the usage 
of this model (Four Substitutional-Sublattice Ordering Model) in multicomponent alloys.

There are restrictions on the excess parameters allowed with the phase-type option F. You 
can only have excess parameters of these types:

L(phase,A,B:*:*:*;0…9)

L(phase,A,B:C,D:*:*;0…9)

The asterisk * means that the interaction parameter is independent on the constituents on 
its corresponding sublattice. No ternary interaction parameters (i.e. with three elements on 
one sublattice site) are allowed. The reason for this restriction is that it would be too 
complicated to handle all possible permutations. In the current Four Substitutional 
Sublattice Ordering Model, the binary interaction between A and B atoms is thus 
independent of the constituents on the other sublattices, where there are many other 
parameters to model the composition-dependence of the Gibbs energy (both in the ordered 
and disordered parts of the phase). The model for these ordered phases are always 
partitioned in a disordered part (with a single substitutional sublattice) and an ordered part 
(with four substitutional sublattices for ordering).

For ordered BCC phases, the phase-type option B means the same thing but the situation is 
more complicated, as the 4-sublattice ordering phase represents an irregular tetrahedron 
with two pairs of sites that are next nearest neighbours. Thus, for an A-B binary solution 
phase (with the element A locates on two sublattice site and B on other two sublattice sites) 
treated by the Normal 4-Sublattice Model, the end-member described by the G
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(phase,A:A:B:B) term has four nearest neighbour bonds between A and B atoms, whereas 
the end-member described by the G(phase,A:B:A:B) term has two nearest neighbour bonds 
between A and B atoms and two next nearest neighbour bonds 

For detailed reference visit the Crystal Lattice Structure web page 
https://www.nrl.navy.mil/mstd/6390.

The first end-member (described by the G(phase,A:A:B:B) term) represents B2- ordering and 
the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There are two 
permutations of the G(phase,A:A:B:B) term and four permutations of the G(phase,A:B:A:B) 
term, automatically conducted in the Four Substitutional-Sublattice Ordering Model. And 
there are also two kinds of reciprocal interaction parameters, i.e.

L(phase,A,B:C,D:*:*;0…9) L(phase,A,B:*:C,D:*;0…9)

An advanced feature with the phase-type options F and B is that a composition set that 
represents the solution phase has a suffix (indicating that it is really as an ordered or 
disordered phase) that is automatically added to its phase name in some listings of 
equilibrium calculations (when performing either single-point or stepping or mapping 
calculations, and when plotting the calculated property diagrams or phase diagrams). Such 
suffix indications can be:

 l _L12 or _L10 for ordered FCC
 l _A1 for disordered FCC
 l _B2, _B32, _D03 or _L21 for ordered BCC
 l _A2 for disordered BCC
 l _D019 and _B19 for ordered HCP
 l _A3 for disordered HCP

Solution Phase Suffix for Disordered Phase Suffix for Ordered Phase 

FCC PHASE PHASE_A1 
PHASE_L12 

PHASE_L10 

BCC PHASE PHASE_A2 

PHASE_B2 

PHASE_B32 

PHASE_D03 

PHASE_L21 

https://www.nrl.navy.mil/mstd/6390
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Solution Phase Suffix for Disordered Phase Suffix for Ordered Phase 

HCP PHASE PHASE_A3 
PHASE_D019 

PHASE_B19 
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ADD_COMMENT

This command is for the Gibbs Energy System (GES) module.

Use the ADD_COMMENT command to add a comment or make notes about parameters.
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AMEND_ELEMENT_DATA

This command is for the Gibbs Energy System (GES) module.

The data for an element (in the SER, the Stable Element Reference, state) can be changed by 
this command. It should only be used for the elements that do not have any data in the 
database because the element data available in the database is set by the database-
developer for the purpose of internal consistency. Except for the mass, the other values 
have no influence on the calculations.

Syntax AMEND_ELEMENT_DATA

Prompts
Element name: <Element name>

Specify the name of the element for which you want to change the data.

 

New stable element reference /ABCD/: <Name of ser>

Press <Enter> to accept the default SER or specify a new SER for the element. Important: The 
default name should not be changed if this data is retrieved from a database. This name is used 
when parameters for a phase are listed and the database assumes that the stable element 
reference is the same as in the database. Only if the element's data have not been fetched from a 
database, e.g. entered manually, can you enter a new SER.

 

New atomic mass /xx.xxxx/: <yyyyyy>

Press <Enter> to accept the default atomic mass or specify a new value for the element. The atomic 
mass of the element is given in g/mol.

 

New h(298.15)-h(0) /xxx.xxx/: <yyyyy>

Press <Enter> to accept the default H(298.15)-H(0) or specify a new value for the element. H
(298.15)-H(0) is the enthalpy difference between 298.15 K and 0 K for the element in its SER state.

 

New s(298.15) /xx.xxxx/: <yyyyy>

Press <Enter> to accept the default S(298.15) or specify a new value for the element. S(298.15) is 
the absolute value of the entropy at 298.15 K for the element in its SER state.

 

Default element reference state symbol index /#/: <index>

The index only changes the symbol, not any value. Normally the index is set 
correctly by the database. Only when manually entering data, you must set the 
index to get the correct symbol.

Specify an index for the default listing parameters (symbol), or press <Enter> to accept the pre-set 
index. 0 is for G, 1 is for H298 and 2 is for H0.

The index is to define the symbol printed in parameter listings. The symbol can be:

 l G the data are referred to Gibbs energy at a variable temperature (also called lattice 
stability).
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Syntax AMEND_ELEMENT_DATA

 l H298 the data are referred to the enthalpy of the element at 298.15 K and 1 bar.

 l H0 is the same as H298 but at the temperature 0 K.
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AMEND_PARAMETER

This command is for the Gibbs Energy System (GES) module.

There is also a PARROT module command with the same name.

Use this command to interactively change/amend the temperature-pressure function of a 
parameter. This is useful to correct typing errors because the old function is made available 
on the terminal for interactive editing. 

About the ENTER_PARAMETER Command

Syntax AMEND_PARAMETER

Prompts

Parameter: <Parameter name>

Specify a correct parameter name. If a parameter name is not acceptable or you only press <Enter>, 
the error message displays: 

Error, please re-enter each part separately

The program prompts for separate input for each part for a parameter name.

 
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these legal identifiers as described for ENTER_PARAMETER. 

 
Phase name (/ABCD/): <Phase name>

Specify the phase name. 

 
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name. 

 
Interacting constituent (in sublattice # /xyz/): <Species name>

Specify the interacting constituent name: If there is no interacting constituent, press <Enter>. 

 
Interacting constituent (in sublattice # /xyz/): <Species name>

If there are more than one interacting constituents, specify them; otherwise press <Enter>.

 
Degree /#/: <Degree>

Specify a numerical number as the degree of the phase parameter. 

 

After the parameter name is specified correctly, the program lists its current definition (either 
present in the database or defined by the ENTER_PARAMETER command), such as:

L(PHASE2,AL,MG;1)=

298.15<T<2000.00: +5000

2000.00<T<4500.00: +4500

4500.00<T<6000.00: +4000

Then you are prompted to change the parameter definition, as shown below:
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Syntax AMEND_PARAMETER

Do you want to change the number of ranges /No/: 

Enter Y if you want to change the number of ranges for the chosen function, or change some of the 
temperature limits in the definition. Then retype both the low/high temperature limits and 
functions. 

If you do not want to change the number of ranges but want to change the function(s) in one or 
more ranges, press <Enter> to accept the default N, then the whole definition of the chosen 
parameter in all ranges (if any) is listed on screen, such as:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00 

The prompt is given:

Do you want to change range limits /No/: 

If there is more than one range, this question is prompted press <Enter>.

 

Range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges, you must specify the 
range of the function of which you want to amend. Or press <Enter> or type 0 to exit this command 
without making any changes.

 

Function:

The previous function is available for editing. The editing is performed within the general 
subroutine FOOLED, as described in AMEND_SYMBOL. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at that position between 
colons, (::).

Commands
These commands can be given:

 l Help: ?

 l Move CP to last or first character: <+/-> A

 l Delete characters from CP: <+-#characters> D

 l Exit: E

 l Find: <#occurrences> F<string>@

 l Insert: I<string>@

 l Move: <+-#positions> M

 l Restore string: R

 l Substitute: S<OLD>@<NEW>@

 l Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an 
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input or search string.

When the string is typed the character at the current position is replaced by an 
underscore _. 

To finish the editing of the current function, type E at the prompt.
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AMEND_PHASE_DESCRIPTION

This command is for the Gibbs Energy System (GES) module.

Also see Solution Models in the GIBBS (GES) Module for detailed information 
about this command and its options.

Specify/amend phase descriptions if a phase has a miscibility gap, uses a special excess 
energy model, or has a specific additional contribution to its Gibbs energy, for example. 

Syntax AMEND_PHASE_DESCRIPTION

Prompts

Phase name: <Phase name>

Specify the name of the phase.

Amend what /Composition_Set/: <Subject>

Several subjects for the phase can be amended but most often this command is used to enter 
two or more composition sets for a phase. If a phase has a miscibility gap it is necessary to 
have two composition sets, one for each possible composition that can be stable 
simultaneously.

Enter a question mark at the prompt to get a list of all possibly amended subjects for a phase.

There are no additional prompts for DEBYE_HUCKEL, HKF_ELECTROSTATIC, GLASS_TRANSITION, 
QUASICHEM_FACT00, QUASICHEM_ISRID, REMOVE_ADDITION, and DEFAULT_STABLE.

RENAME_PHASE
New phase name /ABCD/: <Phase name>

Give a new phase name for the chosen phase, or press <Enter> to keep the default shown.

Site_ratios

Sites in first sublattice /XX/ : <YY> Sites in second sublattice /XX/ : <YY> 

Specify the site numbers for each of the prompted sublattices for the current phase. Press 
<Enter> to accept the previous definitions.

New_
constituent

Sublattice /#/: <Sublattice number>

Specify the sublattice where the new constituents are located.

Species: <Species name>

Give a valid species name.

Composition_
sets

New highest set number /#/: <Set number n>

The default value (#) is usually one higher than the current value. All phases have initially one 
composition set. If a lower value (i.e. lower than the default one) is given, that specific 
composition sets are deleted. 
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Syntax AMEND_PHASE_DESCRIPTION

You cannot take away the first composition set.

Major constituent(s) for sublattice #: /AB/: <Major constituent(s)>

Specify the new major constituent(s) for the sublattice #, or press <Enter> to accept the 
default which was automatically set according to the specified composition set of the phase.

This prompt is repeated for all available sublattices in the chosen phase. The major 
constituents in each sublattice can be given. This may simplify giving start values when 
calculating the equilibrium as phases with miscibility gaps should have different major 
constituents for each composition set.

Major_
constituent

Composition set /1/: <Composition set number>

Give the composition set (digit number) for the chosen phase, or press <Enter> if you want to 
set major constituents for the specified composition set.

Major constituent(s) for sublattice #: /AB/: <Major constituent(s)>

Specify the new major constituent(s) for the sublattice #, or press <Enter> to accept the 
default which is automatically set according to the specified composition set of the phase.

This prompt is repeated for all available sublattices in the chosen phase for the specified 
composition set.

The major constituents in each sublattice can be specified. This is useful in order to make 
calculations converge faster and more easily (because it may simplify giving start values when 
calculating the equilibrium as those phases with miscibility gaps should have different major 
constituents for each composition set). The databases often set major constituents for several 
phases automatically when data are retrieved.

Fraction_
limits

Element : <el1>

Low fraction limit /0/ :  <Appropriate low limit> 

High fraction limit /1/ : <Appropriate high limit >

Element : <el2>

Low fraction limit /0/ :  <Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit>

Element : <eln>

Low fraction limit /0/ :  <Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit >

Magnetic_
ordering

The antiferromagnetic factor /XX/: <YY>

Specify the anti-ferromagnetic factor for the chosen phase. This should be –1 for BCC phase 
and –3 for all other phases (FCC, HCP, etc.).

Short range order fraction of the enthalpy /XX/: <YY>

The magnetic ordering is a second-order transformation and part of the enthalpy due to this 
transformation is due to short-range order. This value is the fraction of the total enthalpy that 
is due to short-range ordering above the magnetic transition temperature.

The default value (xx) is 0.40 for BCC phase, and 0.28 for all other phases (FCC, HCP, etc.).

Never_disorder Never disorder: <Phase name>
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Give the phase name to never disorder. 

The contribution from the disordered phase are added to the ordered phase. 
Use this to avoid entering several parameters to the ordered phase in the 
database. Instead it can be expressed as one parameter in the disordered 
phase.

Disordered_
part

Disordered phase name: <Phase name>

Give the disordered phase name for which there is no ordering sublattice.

Excess_model

Model name /ABCDEFG/: <Model name>

The default model is the pre-set model for the solution phase, normally the REDLICH-KISTER_
MUGGIANU model, or choose another model for the phase to be amended:

 l REDLICH-KISTER_MUGGIANU

 l REDLICH-KISTER_KOHLER

 l FLORY-HUGGINS POLYMER MODEL

 l MIXED-EXCESS-MODELS (R-K default)

 l HKF

 l PITZER

 l CENTRAL_ATOM_MODEL

The MIXED-EXCESS-MODELS option has sub-options:

First (the independent) constituent: <Constituent name>

Second (the dependent) constituent: <Constituent name>

Specify the binary pair of constituents in the current substitutional solution phase (the first 
one as the so-called independent constituent, and the second one as the dependent 
constituent), for which you wish to change the binary excess model from the default 
REDLICH-KISTER model to another model (LEGENDRE or POLYNOM). 

You are prompted with the first sub-option (i.e. First (the independent) constituent 
after you have specified the desired binary Excess model type. To make further changes of 
binary excess model for other specific binary pairs in the current substitutional solution 
phase, press <Enter> (implying that there are no more changes of binary excess model for all 
other possibly-remaining binary pairs that shall still use the default REDLICH-KISTER model).

Excess model type: /Legendre/: <Desired binary excess model type>

For the currently-specified binary pair, choose one the legal binary excess models: LEGENDRE, 
POLYNOM or REDLICH-KISTER. If the default binary excess model REDLICH-KISTER is used for a 
certain binary pair, you can either specify the model name (or in short as R-K) or press 
<Enter>. After this sub-option, it returns to the first sub-option First (the independent) 
constituent: either for further change(s) of binary excess model of any other binary pair(s) or 
for termination (by pressing <Enter>) in the MIXED-EXCESS-MODELS option.

Ternary_
extrapolat

Extrapolation method: /Toop-Kohler/: <Ternary model>

Choose a ternary extrapolation model for the current solution phase:
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 l TOOP-KOHLER for Toop-Kohler Extrapolation Model

 l KOHLER-ALL for Kohler Extrapolation Model

 l MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model

The TOOP-KOHLER option further prompts:

Constituent in sublattice #: <Basis constituent name>

First interaction constituent: <Interacting constituent name>

Toop constituent: <Toop constituent name>

Specify the so-called Kohler constituents (entered as the basis constituent and first interacting 
constituent) and Toop constituent on a given sublattice in the current solution phase.

Quasichem_
ionic

To use the Quasichemical Model for the chosen liquid phase, you must first enter it as an 
ionic liquid phase, and then use this amending option. It creates a completely new phase, the 
original IONIC_LIQUID phase remains in the system and is not changed. 

Number of bonds/atom /2/: <Number of bonds per atom>

Specify the Z value (number of bonds per atom).

Status_bits

Correct the phase status bits. It is important to fully understand this command before using it:

New status word (in hexadecimal) /04204000/: <New status bits>

LIST_STATUS 

Normally, these should never be changed in this way, because such phase status bits are 
automatically set on when all the phase descriptions (predefined in databases and amended 
in the GIBBS module) are defined properly. The only exceptions are for the Kapoor-Frohberg-
Gaye cell model for liquid SLAG solution phase, which can be set only as 04208000; and for 
the complete Revised HKF AQUEOUS solution model, which can be set as 02084000.
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AMEND_SYMBOL

This command is for the Gibbs Energy System (GES) module.

The same command is also available for the PARROT module.

Interactively calculate the current values of a function or table (predefined by the switched 
database or previously entered with ENTER_SYMBOL) at the current temperature and 
pressure condition, and also possible to modify the definitions of variables or functions.

The current values of the temperature and pressure used to calculate the 
functions or tables are the ones listed with LIST_STATUS. There is no way to 
change the current temperature and pressure values interactively.

To modify the definitions of entered symbols (variable, functions or parameters), the 
performance of this command is slightly different one from another, as described below:

 l For variables, the values can be changed.
 l For functions the low and high temperature limits in various ranges (if any), as well 

the expressions, can be changed.
 l For parameters the low and high temperature limits in various ranges (if any), as well 

the expressions, can be changed.

Syntax AMEND_SYMBOL

Prompts

Name: <Symbol name>

Specify the name of an entered symbol.

For tables and functions (or parameters which are treated as functions after these are entered by 
the ENTER_SYMBOL command with the Parameter keyword, but not by the ENTER_PARAMETER 
command), after the symbol name is specified here, the program automatically calculates the 
values under the current temperature and pressure conditions, and lists the current values, such as:

FUNCTION VALUE  2.52500000E+01

TABLE VALUE  1.56000000E+02

For variables and functions (or parameters), there are additional prompts and depend on the 
symbol type.

 

For a variable, its current value is displayed, and you can change it to a new value: 

Value /Current value/: <New value>

For a function (or a parameter entered as a symbol):

Do you want to change the number of ranges /No/: 
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Enter Y to change the number of ranges for the function, or change some of the temperature limits 
in the definition, then retype both the low/high temperature limits and functions (see all the 
remaining details in the ENTER_SYMBOL  command. 

If you do not want to change it, press <Enter>. The definition of the chosen function in all ranges (if 
any) is listed, for example:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00

and this message displays:

Do you want to change range limits /No/: 

If a function is different in two or more temperature ranges, you must specify the range of the 
function of which you want to amend. Or press <Enter> or type 0 to exit this command without 
making any change.

 

Range number (0 to exit) /0/: <Range number>

Function:

The previous function is available for editing. The editing is performed within the general 
subroutine FOOLED. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at that position between 
colons (::).

Commands
These commands can be given:

 l Help: ?

 l Move CP to last or first character: <+/-> A

 l Delete characters from CP: <+-#characters> D

 l Exit: E

 l Find: <#occurrences> F<string>@

 l Insert: I<string>@

 l Move: <+-#positions> M

 l Restore string: R

 l Substitute: S<OLD>@<NEW>@

 l Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an 
input or search string.
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When the string is typed the character at the current position is replaced by an 
underscore _. 

To finish the editing of the current function, type E at the prompt.
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CHANGE_STATUS

This command is for the Gibbs Energy System (GES) module.

The status of an element or species or phase can be either ENTERED or SUSPENDED. The 
suspended status can be either implicit or explicit. The implicitly suspended status can be set 
e.g. for a species if any of the elements in its chemical formula is explicitly suspended. A 
species that is implicitly suspended becomes entered automatically if all its elements are set 
entered. After this command, a message shows which elements/species/phases are 
suspended or restored (entered). Consequently, the status bits for the specified elements or 
species or phases are changed, as listed with LIST_STATUS.

Syntax CHANGE_STATUS 

Prompts
For Element, Species or Phase /Species/: <Keyword>

Specify the keyword (element, species or phase).

 

Suspend /Y/: 

By default the status is changed from ENTERED to SUSPENDED. 

If an element is suspended all species with this element become implicitly SUSPENDED too. A phase 
may become implicitly suspended if all its constituents or all constituents in a sublattice are 
suspended.

 

List of elements/species/phases: <Name of elements or species or phases>

Specify the names or indices of those elements or species or phases that shall become suspended 
or active. For names, these should be separated by a space and terminated with a semicolon (;) or 
an empty line. For indices it is possible to give a range by separating two numbers by a hyphen (-). 
The list should be terminated by a semicolon (;). Example: 5 1 7-12 FE;
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ENTER_ELEMENT

Specify a system interactively. The program searches the currently switched or preset 
database for data for the given elements. The data for the elements in the database are the: 

 l mass in g/mol
 l name of the Selected Element Reference State (SER) which normally is the stable 

phase for the element at 298.15 K
 l enthalpy difference for the element in the SER state at 298.15 K and zero K
 l absolute entropy for the element in the SER state at 298.15 K.

The two predefined elements, i.e. electrons and vacancies, have the chemical symbols /- 
and VA, respectively. Initially, these are suspended but can be entered either by this 
command or CHANGE_STATUS.

If an aqueous solution phase is involved, in the GIBBS module you enter a special aqueous 
electron called, ZE. This is specially designed for appropriately calculating the standard 
electric potential in the aqueous solution system.

Syntax ENTER_ELEMENT

Prompt

Element name: <Element name>

Specify several elements on one line. The name of an element is its chemical symbol. The chemical 
symbols must be separated by spaces. Fictitious element names are legal but naturally no data are 
found in the database for them.

 

An element name (maximum 2 characters) can either have its first letter in upper 
and the second (if any) in lower case (i.e. Lower Case Mode) or both letters can be in 
upper or lower case (i.e. Upper Case Mode). The Upper or Lower Case Mode is 
selected by the command REINITIATE, which removes all data, and should be 
executed before any other command.
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ENTER_FUNCTION

This command is available with the GES and TAB modules.

Used to define a new thermodynamic function to be included in the sixth column of tabular 
output. The last entered function is listed in the 6th column of all tables, and can be plotted 
(if choosing the Plot Column value 6) in all graphs, for all subsequently tabulated substances 
or reactions.

Syntax ENTER_FUNCTION

Prompt
Name: <Name>

Function: <Definition>

 

A limited number of state variables, G, H, S, T, P, V and H298 can be used in the function definition. 
For example, -(G-H)/T can be defined as a function which is identical to S for a substance or ΔS for a 
reaction, G+T*S-P*V can be defined as a function which is U (internal energy) for a substance or ΔU 
(internal energy change) for a reaction.

Options Nameof the function (maximum 8 characters) and Definition of the function. A long function can be 
typed over several lines. A function should be terminated by a semicolon (;) or an empty line.

Example

For the pure substance Fe (using the SSUB database), by entering a function as G+T*S-P*V, 
the following table is obtained by typing <Enter> in the prompt Output file /Screen/:, 
and the figure by typing 6 in the prompt Plot column /2/:

TAB: ENTER-FUNCTION

Name: InEnergy

Function: G+T*S-P*V;

TAB: TABULATE_SUBSTANCE

Substance (phase): Fe

Pressure /100000/: <Enter>

Low temperature limit /298.15/: <Enter>

High temperature limit /2000/: <Enter>

Step in temperature /100/: <Enter>

Output file /try1/: try2

Graphical output? /Y/: <Enter>

Plot column? /2/: 6

This gives the following output:
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O U T P U T  F R O M  T H E R M O - C A L C

Column 6: InEnergy G+T*S-P*V

Phase : FE_S                       Pressure :      100000.00

Specie: FE

***************************************************************

    T      Cp            H             S             G             InEnergy

   (K)    (Joule/K)      (Joule)      (Joule/K)      (Joule)

***************************************************************

  298.15   2.48446E+01   2.17972E-06   2.72800E+01  -8.13353E+03   2.17972E-06

  300.00   2.48905E+01   4.60049E+01   2.74338E+01  -8.18414E+03   4.60049E+01

  400.00   2.71299E+01   2.64957E+03   3.49085E+01  -1.13138E+04   2.64957E+03

  500.00   2.93561E+01   5.47211E+03   4.11976E+01  -1.51267E+04   5.47211E+03

  600.00   3.19293E+01   8.53245E+03   4.67701E+01  -1.95296E+04   8.53245E+03

  700.00   3.50985E+01   1.18777E+04   5.19207E+01  -2.44667E+04   1.18777E+04

  800.00   3.92042E+01   1.55830E+04   5.68623E+01  -2.99068E+04   1.55830E+04

  900.00   4.49645E+01   1.97726E+04   6.17903E+01  -3.58387E+04   1.97726E+04

1000.00   5.42147E+01   2.46891E+04   6.69619E+01  -4.22728E+04   2.46891E+04

1100.00   4.55851E+01   2.99025E+04   7.19412E+01  -4.92328E+04   2.99025E+04 $ 
Stable phase is FE_S2

1200.00   3.40840E+01   3.51037E+04   7.64466E+01  -5.66322E+04   3.51037E+04

1300.00   3.49398E+01   3.85549E+04   7.92086E+01  -6.44162E+04   3.85549E+04  
1400.00   3.57994E+01   4.20918E+04   8.18293E+01  -7.24692E+04   4.20918E+04

1500.00   3.66636E+01   4.57149E+04   8.43287E+01  -8.07780E+04   4.57149E+04

1600.00   3.75330E+01   4.94247E+04   8.67226E+01  -8.93314E+04   4.94247E+04 $ 
Stable phase is FE_S3

1700.00   4.05217E+01   5.41173E+04   8.95609E+01  -9.81363E+04   5.41173E+04

1800.00   4.12595E+01   5.82055E+04   9.18975E+01  -1.07210E+05   5.82055E+04 $ 
Stable phase is FE_L

1900.00   4.60000E+01   7.74165E+04   1.02377E+02  -1.17099E+05   7.74165E+04  
2000.00   4.60000E+01   8.20165E+04   1.04736E+02  -1.27456E+05   8.20165E+04
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ENTER_PARAMETER

This command is for the Gibbs Energy System (GES) module.

There is also a PARROT module command with the same name.

About the ENTER_PARAMETER Command

Use this command to enter TP-function(s) for a specific parameter for a phase interactively 
with this command. If there is already a parameter expression defined (for this parameter), 
that is deleted and replaced with newly entered one.

The entered TP-Function(s) for the parameter can be changed later with the command 
AMEND_PARAMETER.

Syntax ENTER_PARAMETER

Prompts

Parameter: <Parameter name>

As explained in About the ENTER_PARAMETER Command, specify a correct and complete 
Parameter Name, which should contain all the necessary parts of the general form:

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter>, is pressed, a message displays:

*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter name.

Options Description or Information

Identifier

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA  or VC or VK>

If this command is used one or more times, the previous value on this prompt is set as default. 
Press <Enter> for the same type identifier or specify a new type.

Phase name

Phase name (/ABCD/): <Phase name>

Each parameter is valid for a specific phase only. The name of that phase must be supplied 
(maximum 24 characters). The name can be abbreviated.

Constituent

Constituent (in sublattice # /ABC/): <Species name>

A parameter is identified by the constituents on a specified sublattice site of the given phase, 
the stoichiometric coefficients of which are multiplied with the parameter. The name of the 
constituent can be abbreviated.

It is the species name, not the stoichiometric formula required here.

If this command is used one or more times, the previous value on this prompt is set as default. 
Accept it by pressing <Enter> if the constituent is the same, or specify a new species name.
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Interacting 
constituent

For phases with several sublattices, the program asks for one constituent in each sublattice.

Interacting constituent (in sublattice # /XYZ/): <Species name>

If this command is used one or more times, the previous value on this prompt is set as default. 
Press <Enter> to accept it if the constituent is the same, or specify a new species name.

To cancel the default value of the interacting constituent type NONE or the 
name of another constituent.

This question is repeated until all the interested interacting constituent(s) on a specific 
sublattice in the phase are specified, and finally an <Enter> is enforced.

Degree

Degree /#/: <Degree>

Degree is model-dependent. Specify an integer number (a value from 0 through 9) as the 
degree of composition-dependent interaction contribution for the phase parameter. This is 
valid for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), as well 
as for volume-related parameters (V0, VA, VC or VK).

For binary interaction parameters, the degree is usually the power in the Redlich-Kister 
expression. For ternary interaction parameters, it is usually the Hillert ternary index.

For a standard G parameter for a pure component (end-member) its degree should be always 0 
and this prompt should not display.

Phase 
parameter

After this prompt, the program echoes on the screen the full TP-Function of the phase 
parameter.

Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but 
entered as a negative number), for the current TP-Function. 

Function: <Definition for a function>

A TP-Function consists of terms in T and P.

& <Continuation of the definition for the current function>

Continuation of a TP-Function definition. 

High temperature limit /6000/: <High temperature limit in K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the 
lowest limit is entered as a negative number) for the current TP-Function.

Any more ranges? /N/: 

Enter Y for more function(s) or N to end this command.
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ENTER_PHASE

See About the ENTER_PHASE Command for details about the phase-type and 
other prompts.

With this command, the phase name, phase-type, sublattice number, and constituents or 
constituent array(s) for the phase are entered into the GIBBS workspaces. However, for the 
remaining parts of thermodynamic descriptions (i.e. thermochemical and physical 
parameters, excess model, and possibly additional contribution term) for the phase, the 
GIBBS commands ENTER_PARAMETER and AMEND_PHASE_DESCRIPTION, should be used 
sequentially.

Normally, data for a system are retrieved from the preset database after the elements and 
species are specified. This is automatically done through GET_DATA. In some cases, specify a 
phase interactively.

Syntax ENTER_PHASE

Options Description and Information

Phase name

Name of phase: <Phase name>

The phase name is any string starting with a letter and containing only letters, digits or the 
underscore character. The phase name must be unique.

Type code: <Phase-type code>

The Phase-type code must be specified for the phase if it is not an ordinary solution phase. 
Press <Enter> if the phase is ordinary.

Phase-type

G

Gaseous mixture phase.

There may only exist one gas phase in a system.

A Aqueous solution phase.

L Liquid solution phase but not A (aqueous) or Y (ionic liquid)

Y Ionic liquid solution phase (that is specially treated by the Ionic Two Sublattice Liquid Model).

I A phase with charged species but not G (gaseous), A (aqueous) or Y (ionic liquid).

F
An ordered FCC or HCP solution phase with four substitutional sublattices (additionally, such a 
phase can also have an interstitial sublattice).

B An ordered BCC solution phase with four substitutional sublattices (additionally, such a phase 
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can also have an interstitial sublattice).

Sublattice 
number

Number of sublattices /1/: <Sublattice number>

Phases with stoichiometric constraints usually have two or more sublattices. On each 
sublattice one or more species can be entered as constituents. The number of sublattices 
must not exceed 10. Substitutional phases with no sublattices are treated as phases with one 
sublattice.

Number of sites on sublattice  # /1/: <Site number>

For phases with sublattices, the ratio of the sites on each sublattice (donated with #) must be 
given. The program asks for values for all sublattices (by repeating this question for each 
sublattice), but these may have a common factor extracted. It is recommended to use integer 
numbers as sites if possible. For substitutional phases with no sublattices, this question does 
not show up.

Constituents

Name of constituent: <Constituent name(s)>

For each sublattice specify at least one species as constituent. Several constituents can be 
given consequently (on the repeated prompt) or on the same line separated by a space. This 
question is repeated till pressing <Enter> or giving a semi-colon (;), meaning that the list of 
constituents is terminated by (;) or an empty line.

Will you add constituents later /N/: 

For Y add other constituents to the phase by specifying new components in e.g. an ENTER_
PARAMETER command.

If illegal constituents are used, you get a message e.g. when parameters are entered.

Do you want a list of possible parameters /N/: 

Enter Y for a list of all possible parameters up to the fifth interaction order for the entered 
phase. 
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ENTER_SPECIES

Specify a species from the already entered elements. The stoichiometry of the species is the 
chemical formula of the species. For each species, its name and chemical formula must be 
given.

All elements are automatically entered simultaneously as species. The 
constituents of a phase must be species, but there is no thermochemical data 
associated with the species except as constituents of a phase.

Syntax ENTER_SPECIES 

Prompt

Species name: <Species name>

Enter a unique species name. This is usually its chemical formula but it can be any string which starts 
with a letter and contains only letters or digits. Parenthesis () and an underscore _ are permitted. 
The combination /- or /+ used to denote charge. 

Species Names Examples
NACL2, FE2O3, FEO3/2, FE1O1.5, CA.5MG.5SI1O3,

AL1H1O1_Al(OH) , AL1H1O1_HAlO, C2H4O3_124TRIOXOLANE, NA+, SIO4-4, H1/+1, H1O1/-1, 
AGC2N2-1.

The species name can be used to separate isomers with the same stoichiometry, e.g. C2H2Cl2, 
(CHCl)2_cis, (CHCl)2_trans, CH2_CCl2.

 

Stoichiometry /Species name/: <Chemical formula>

The elements in the chemical formula are normally separated by stoichiometric numbers. Neither 
parenthesis () nor an underscore _ is allowed in the chemical formula, while the special combination 
/- or /+ can be used.

In upper case mode (see REINITIATE), the stoichiometric number unity can be excluded only if the 
element symbol consists of two letters. In lower case mode, the element must be typed with the first 
letter in UPPER case and the second in lower, and it is thus possible to distinguish CO (carbon 
monoxide) from Co (cobalt) without any stoichiometry number.

All elements in a species must be entered prior to entering the species.
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ENTER_SYMBOL

This command is for the Gibbs Energy System (GES) module.

There are also a POLY and POST module commands with the same name. 
However, symbols entered in the GIBBS module are not the same symbols as 
defined in the POLY and POST modules. 

In the GIBBS module, a symbol can be used to represent a numeric quantity (e.g. a variable), 
a function, or a table. The entered symbol (with a symbol name of maximum eight 
characters) can be used later when parameters are entered, and this is a flexible way to 
manipulate thermodynamic functions. Symbols are especially useful if the same function or 
table is used in several thermochemical parameters. A parameter symbol is used to assign 
the values of phase parameters (which are defined with the command ENTER_PARAMETER) to 
specific characterized symbols. If you want to define a constant quantity, enter it as a simple 
function with a constant value in all (temperature) ranges.

The symbols entered in the GIBBS module can also be listed and used in the PARROT module 
(for data optimization) where you can use the GIBBS-entered symbols (variables, functions 
or parameters) to define parameters that shall be optimized. 

See example 44 for an example of using variables and functions.

Syntax ENTER_SYMBOL

Prompt

Variable, function, table or parameter? /Function/: <Keyword>

The keyword can be a variable, function, table or parameter.

 l Variables are similar to functions because these can also be expressions of state 
variables. It is possible to enter a variable with a new expression anytime.

 l Functions are expressions of state variables or other functions.

 l Tables are used for listing results. A table consists of a list of any number of state 
variables, functions or variables. 

 l Parameter symbols are used to assign the values of phase parameters (which are 
defined by the command ENTER_PARAMETER) to specific characterized symbols. If the 
phase parameter is not defined yet, the parameter symbol is assigned zero or a symbol 
which is valued as zero. In this way it is easy to refer to entered phase parameters in 
further defining other phase parameters.

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 8 
characters.
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The following prompts are based on the type of symbol.

Variable 
symbol

Value: <Numeric value of a variable>

Only a constant numeric value, not an expression, is accepted.

Function 
symbol

Enter the lower-temperature limit, the expression, an upper-temperature limit and if there is 
another expression above this upper limit:

Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest-temperature limit, below which its (first) expression is not applicable. The 
default lowest limit of all kinds of data is 298.15 K.

If a negative number is given as the lowest-temperature limit, it is assumed that there are 
breakpoints in pressure for this function; in such a case, it is interpreted as the lowest-pressure 
limit (in Pascal), and the other limits in the current function are also taken as pressure limit values 
(in Pascal).

The temperature/pressure limits for the functions are checked during calculations. An indicator is 
set if the actual temperature/pressure condition is below the lowest temperature/pressure limit 
or above the highest temperature/pressure limit; and in such a case, an extrapolation is 
conducted using the TP-FUNCTIONS valid in the nearest temperature/pressure range.

Function: <Definition for a TP-function>

A TP-Function consists of terms in T and P. The expression is a FORTRAN-like expression and 
operators +,  -, *, = and ** can be used (** only with integer powers). Unary-functions LN or LOG 
(both for natural logarithm) and EXP (for exponential) can also be used. An expression can be 
continued on more than one line. A PT-function must be terminated by a semicolon (;) or an 
empty line. No more than 78 characters can be written on a line. If this is not sufficient space on 
one line, press <Enter> and continue on the next line. The program prompts with an ampersand & 
when a continuation is expected.

A function can have several temperature ranges, and a different expression (i.e. a 
TP-Function) for each region; if required, a single function can have up to ten 
different temperature ranges (and thus have up to ten different TP-Functions).

This question is repeated if the current function has more than one expression (TPFunction) in 
various temperature ranges [or pressure ranges; only if the lowest limit is entered as a negative 
number)].

& <Continuation of the definition for the current TP-Function>

This is for a continuation of the definition for the current TP-Function. The ampersand & means 
that you can continue to write the function on the new line if one line is not enough for the 
current TP-Function. If you are finished the current TP-Function, press <Enter> again.

High temperature limit /6000/: <High temperature limit in K>

For a TP-Function, specify the high-temperature limit, above which its current expression is not 
applicable. The default high-temperature limit for all kinds of data is always 6000 K.

This question is repeated if the function has more than one expression (TPFunction) in various 
temperature ranges. 
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All the temperature limits for the presently-be-entered TP-Function MUST be in 
an increasing order; otherwise the whole function is given a single value of zero.

If a negative number is given as the lowest-temperature limit, it is interpreted as the low-pressure 
limit (in Pascal), and the high-temperature limit is also taken as the high-pressure limit (in Pascal) 
for the current TP-Function.

The high-temperature/pressure limit for the current applicable expression (TPFunction) is the low 
temperature/pressure limit for the next range if several ranges are needed to describe the 
temperature/pressure-dependence of this function.

The temperature/pressure limits for the functions are checked during calculations. An indicator is 
set if the actual temperature/pressure condition is below the lowest temperature/pressure limit 
or above the highest temperature/pressure limit; and in such a case, an extrapolation is 
conducted using the TP-Function valid in the nearest temperature/pressure range.

Any more ranges /N/: <Y or N>

Answer N to finish the definition of the current function. If Y the program asks for a new function 
valid above the last high temperature limit and below a new high temperature limit. The 
maximum number of temperature ranges is 10.

Important note: Make sure that the function and its first derivatives are continuous across break 
points.

Table 
symbol

Specify the low and high temperature limits, temperature step and tabled value at each specified 
temperature:

Low temperature limit /298.15/: <Low temperature limit in K>

The lowest temperature where the table has a value.

High temperature limit /6000/: <High temperature limit in K>

The highest temperature where the table has a value.

Step in temperature /100/: <Temperature step>

The step in temperature between each value in the table. This step must be constant for the 
whole table. If a table cannot be described with a single step it must be divided into several tables 
for different temperature ranges. The upper and lower limits are truncated to give reasonable 
values where the table values must be specified.

Table value at  XX /YY/: <Table value>

The value of the table at the specified temperature (xx) must be given. The default value (yy) is 
the last value.

Parameter 
symbol

Input the correct name of a phase parameter (including its identifier, phase name, constituent 
and interacting constituent(s) in various sublattices (if exist), and degree of the parameter. Most 
of the settings are the same as in the ENTER_PARAMETER command or the Function symbol 
prompts above.

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of 
the general form:
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<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter> is pressed, this error message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these types of legal identifiers. 

Phase name (/abcd/): <Phase name>

Specify the phase name. 

Constituent (in sublattice  # /abc/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.

Interacting constituent (in sublattice  # /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the given phase; if 
there is no interacting constituent, press <Enter>. 

Interacting constituent (in sublattice  # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice site of the given 
phase, specify them; otherwise press <Enter>. 

Degree /#/: <Degree>

Specify an integer number (a value from 0 through 9) as the degree for the phase parameter. 

Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest-temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but 
entered as a negative number), for the current TP-Function. 

Function: <Definition for a function>

Specify the desired TP-Function for the current temperature range (or current pressure range; 
only if the lowest limit is entered as a negative number). 

& <Continuation of the definition for the current TP-function>

Specify the desired TP-Function continuation for the current temperature range (or current 
pressure range; only if the lowest limit is entered as a negative number). 

High temperature limit /6000/: <High temperature limit in K>

Specify the high-temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the 
lowest limit is entered as a negative number) for the current TP Function.

Any more ranges /N/: 
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LIST_CONSTITUTION

This command is for the Gibbs Energy System (GES) module.

Syntax LIST_CONSTITUTION

 List all the constitutions (as site-fractions) for all the phases in the defined system.

 This is mainly for software managers. There are no commands in the GIBBS monitor 
to set the constitution.
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LIST_DATA

This command is for the Gibbs Energy System (GES) module.

Use the LIST_DATA command to retrieve and then list the data included with a database in 
the DATA module or directly entered in the GIBBS module. All data for the current system 
that is defined  within the current GIBBS workspace is written in a readable manner in the 
output file. If no output file is specified, by default the data displays on screen. The behavior 
of this command differs slightly based on whether you are using GES6 (the default) or GES5. 

For encrypted commercial databases you may not be able to use this command 
to list any retrieved data. However, it can be used to list some basic definitions 
(such as phase models and phase-constituents) retrieved from an encrypted 
database, as well as all the references related to original assessments (but not 
thermodynamic parameters) for the currently-defined system.

Command Prompts

After entering the command  in the console, the following prompt options are available.

Syntax LIST_DATA

Prompts

Output to screen or file /Screen/: <File name>

Specify the name of a file in which the data shall be written in a readable manner. The default value 
is the screen (by pressing <Enter>).

 

Options?: <Option(s)>

Choose one or several of the following options for output. 

See the section about the differences between GES5 and GES6 output for these 
options.

 l N the output is written as a user database format. For GES6, and only for an unencrypted 
database, this option has a subcommand that allows filtering of phase parameters with 
respect to the property type e.g., to include only volume parameters and/or viscosity 
parameters in the output.

 l The subprompt is Property type /All/. Choose All or enter the property type. 
The valid alternatives (when available) are: V0, VA, VB, VC, VK, TC, TN, BM, MQ, 
MF, DQ, DF, OQ, VS, G, L, THCD, ELRS, ESPD, VISC, GD, SIGM or XI

 l P the output is written as a macro file for future input. This is useful for creating *SETUP 
files for data assessments.
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Syntax LIST_DATA

 l S the symbols are suppressed.

 l R the references for the parameters are listed (only for some databases in which 
references are available)

 l L the output is written suitable for a LaTeX preprocessor.

Output Differences: GES5 vs GES6

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. 

As required you can set Thermo-Calc to use GES5 instead of the default with 
the SET_GES_VERSION command. The application may also automatically and 
temporarily switch to GES5 when a database is being used that is not 
compatible with GES6.

For both GES5 and GES6 and when you enter P, S, R, or L, the output data consists of a list of 
all elements and the data followed by a list of all phases and the data associated with each 
phase. The thermochemical parameters listed for each phase are always in SI units.

For GES6, and only when option N, P, or nothing is entered, the output data consists of a list 
of all elements and the data followed by a list of all phase definitions and the data 
associated with the phases, sorted by system. In these modes, and only for unencrypted 
databases, there is a subcommand that allows filtering of phase parameters with respect to 
the property type e.g., to include only volume parameters and/or viscosity parameters in the 
output. 

Other differences between the GES5 and GES6 output are related to the output as shown 
below.

Output GES5 GES6

Parameters Includes implicitly defined zero-valued 
thermodynamic parameters

Only contains parameters that are 
actually defined in the database

Automatically Does not include Includes
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Output GES5 GES6

suspended phases

References Contains references of functions and parameters 
with generic names, such as "REF123" 

 Retains the original reference names 
that are used in the database
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LIST_PARAMETER

This command is for the Gibbs Energy System (GES) module.

There is also a PARROT module command with the same name.

List the TP-function(s) of a specific parameter for a phase. You must supply the name of the 
phase parameter:

The parameter name: <Identifier>(<Phase>,<Constituent array>;<Digit>)

For encrypted commercial databases, you may not be able to use this 
command to list any retrieved parameter.

Syntax LIST_PARAMETER 

Prompts

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of the 
general form: <identifier>(<phase>,<constituent array>;<digit>)

See About the ENTER_PARAMETER Command to learn how to define the parameter 
name.

If a parameter name is not acceptable or <Enter> is pressed, an error message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.

 
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA  or VC or VK>

Specify one of these types of legal identifiers. 

 
Phase name (/ABCD/): <Phase name>

Specify the phase name. 

 
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.

 

Interacting constituent (in sublattice  # /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the given phase; if there 
is no interacting constituent, press <Enter>. 

 

Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice site of the given phase, 
specify them; otherwise press <Enter>. 

 Degree /#/: <Degree>
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Syntax LIST_PARAMETER 

Specify a numerical number as the degree for the phase parameter.
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LIST_PHASE_DATA

This command is for the Gibbs Energy System (GES) module.

All data for a specific phase are written in a readable manner on screen. The 
thermochemical parameters listed for the phase are always in SI units.

For encrypted commercial databases you may not be able to use this command 
to list any phase data. However, this command can be used for listing some 
basic definitions (such as phase model and phase-constituents) for the specified 
phase, as well as all the references related to original assessments (but not 
thermodynamic parameters) for the currently-defined system.

Syntax LIST_PHASE_DATA 

Prompt
Phase name: <Phase name>

Specify a phase name (if abbreviated, it should be unique).

Output Differences: GES5 vs GES6

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. 

As required you can set Thermo-Calc to use GES5 instead of the default with 
the SET_GES_VERSION command. The application may also automatically and 
temporarily switch to GES5 when a database is being used that is not 
compatible with GES6.

For GES6 the output data consists of the phase definition and the data associated with the 
phase, sorted by system. In GES6, there is a subcommand that allows filtering of phase 
parameters with respect to the property type e.g., to include only volume parameters 
and/or viscosity parameters in the output. 
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LIST_STATUS

This command is for the Gibbs Energy System (GES) module.

Syntax LIST_STATUS

 

List the entered elements, phases and species with the status word. The command is included for 
system managers.

Each element, species, phase and symbol has a set of status bits. The values of these 
bits are listed with this command.

The bits are listed as hexadecimal, i.e. four bits are written as a hexadecimal number. Two 
hexadecimal numbers make a byte. In hexadecimal, 0 to 9 mean normal digits. A to F means values 10 
to 15. The number E4000000 has thus bit 1, 2, 3 and 6 equal to one. The bits are numbered starting 
with 1 for the most significant (leftmost) bit.

Element Status Word

Set the element status word (Bit. Meaning) if:

 1. Element cannot be deleted (only vacancy and electron)

 2. Suspended (inclusive OR of bit 3 and 4)

 3. Explicitly suspended

 4. Implicitly suspended (cannot occur for an element)

Species Status Word

Set species status word (Bit. Meaning) if:

 1. Species record for an element (each element has a species record)

 2. Suspended (inclusive OR of bit 3 and 4)

 3. Explicitly suspended

 4. Implicitly suspended (e.g. if a species element is suspended)

 5. Charged (inclusive OR of bit 6 and 7)

 6. Negative charge
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 7. Positive charge

 8. Vacancy

 9. Component (by default the elements are the components)

Phase Status Word

Set phase status word (Bit. Meaning) if:

 1. Ideal (no sublattices and no excess parameters)

 2. Suspended (inclusive OR of bit 3 and 4)

 3. Explicitly suspended

 4. Implicitly suspended (e.g. if all constituents suspended)

 5. Gas phase

 6. Liquid phase

 7. Solution phase

 8. Only one constituent (in each sublattice)

 9. Ions (inclusive OR of bit 10 and 12)

 10. New ionic liquid model (charge balance handled internally)

 11. Constituents cannot be added

 12. External charge balance needed

 13. Aqueous model

 14. Charged species (ions)

 15. Dilute entropy

 16. Last calculation exceeded temperature range for any parameter

 17. Kapoor-Frohberg-Gaye cell model

 18. Turbo calculation used

 19. Turbo calculation impossible

 20. Turbo calculation illegal

 21. Phase is not ideal

 22. Current site fractions saved

 23. This phase is the ordered part

 24. This phase is the disordered part (bit 2 and 3 also set)
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 25. Shadow phase with diffusion data

 26. Error in ionic model

 27. Sometimes

 28. CVM-SRO (short-range ordering) entropy expression

 29. CVM initialization is made

 30. Used to test quasi-chemical ordering model

 31. Major constituents check even if no miscibility gap (ordering)

 32. Hoch-Arpshofen model

Symbol Status Word

Set symbol status word (Bit meaning) if:

 1. Constant

 2. Variable

 3. Function

 4. Table

 5. Value must not be amended

 6. Undefined
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LIST_SYMBOL

This command is for the Gibbs Energy System (GES) module.

List the symbols available in the current GIBBS workspace, which are defined (retrieved from 
database in the DATA module, or directly entered in the GIBBS module) and used in TP-
functions for the entered model parameters for various phases in the defined system.

For encrypted commercial databases you may not be able to use this command 
to list any retrieved symbol.

Syntax LIST_SYMBOL

Prompts

Name: <Symbol name>

Specify a symbol name (either as the full name of a defined symbol, or as the first few 
common characters of several symbols which have names starting with such common 
characters). 

Only those symbols that match this name are listed.

Or press <Enter> for a list of all the symbols defined (retrieved from database in the 
DATA module, or directly entered in the GIBBS module) for the current system, which 
are available in the current GIBBS workspace.

 

Output to screen or file /Screen/: <File name>

Specify the name of a simple-textual file in which the entered symbols shall be written 
in a readable manner (such a basic textual file can later on be opened and edited by 
any text editor). The default value is the screen (by pressing <Enter>).
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READ_GES_WORKSPACE

This command is for the Gibbs Energy System (GES) module.

Workspace Files

The data saved into a *.GES5 with SAVE_GES_WORKSPACE can be read back into the GIBBS 
workspace. 

Syntax READ_GES_WORKSPACE 

 

Enter a File name and specify the working directory where to save the file in the Look in field. 
Normally the default file-type in the Files of type field is the correct one for the GES workspace 
format.

The saved *.GES5  files are unique for each CPU type, and therefore a  file saved on 
one CPU type cannot be read and used on another CPU type.
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READ_WORKSPACES

This command is used in both the POLY and GES (GIBBS) modules.

Workspace Files

The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP 
commands can be READ from a file where they are saved with  SAVE_WORKSPACES. Such a 
*.POLY3 file is not printable.

Syntax READ_WORKSPACES 

Options

File name is the name of a saved POLY3-file where the POLY3 and GIBBS workspaces shall be read 
from must be specified. You do not need to type the extension if it is the default *.POLY3, otherwise 
type the whole POLY-file name.

A reminder that Linux and Mac are case sensitive; when applicable ensure you enter 
file extensions with capital letters.

A window opens so that the path (in the Look in field) and File name can be specified. The Files of 
type (i.e. POLY3) cannot be changed. Click Open to open the POLY3 and GIBBS workspaces from the 
saved *.POLY3 file.

 

When reading back an original POLY3 workspace that has already been saved as an *.POLY3 file in 
the current Thermo-Calc (Console Mode) run or had been read from an existing POLY3 file under the 
current work area, while some additional changes in the settings may be made but do not need to 
be kept in further steps in the current Thermo-Calc (Console Mode) run or any diagram is plotted in 
the POST module, you can type READ,, or READ_WORKSPACE ,,
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REINITIATE

This command is for the Gibbs Energy System (GES) module.

All data in the stored GIBBS workspace are erased, and all variables are initiated to their 
default values.

Syntax REINITIATE

Prompts

Upper case only /Y/: 

Press <Enter> to keep the default where the name of elements and species is in only UPPER case. 
Or choose N to have the elements with two letter names with the first letter in Upper case and the 
second in lower case. 

In upper case mode all input in lower case is automatically converted to upper case.

 
Lower temperature limit /298.15/: <Lowest T in K>

This value is used as the lower temperature limit when data are entered interactively.

 
Upper temperature limit /6000/: <Highest T in K>

This value is used as the upper temperature limit when data are entered interactively.

 

Default element reference state symbol index /1/: <1 or 2 or 3>

Specify a proper index for the default listing parameters (symbol), or press <Enter> to accept the 
preset index 1.

The index is for defining the symbol printed in listings of parameters. The symbol can be:

 l G: the data are referred to Gibbs energy at a variable temperature (also called Lattice 
Stability).

 l H298: the data are referred to the enthalpy of the element at 298.15 K and 1 bar.

 l H0 is the same as H298 but at the temperature 0 K.

The index only changes the symbol, not any value. Normally the index is set 
correctly by the database. Only when manually entering data must you set the 
index to get the correct symbol. Set the index value to 0 to get the symbol G, to 1 to 
get the symbol H298 and to 2 to get H0.
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SAVE_GES_WORKSPACE

This command is for the Gibbs Energy System (GES) module.

Workspace Files

The data used by the GES workspace can be saved in a file with a default extension *.GES5. 
The default file name is RESULT.GES5 or equal to the one used in a previous READ_GES_
WORKSPACE command.

Syntax SAVE_GES_WORKSPACE 

 

Enter a File name and specify the working directory where to save the file in the Save in field. 
Normally the default file-type in the Files of type field is the correct one for the GIBBS workspace 
format.

The output is not formatted and cannot be printed.
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SAVE_WORKSPACES

This command is available for both the POLY and GES (GIBBS) modules.

Workspace Files

You can save the current status and workspaces, including thermodynamic data, conditions, 
options and results from a single, stepping or mapping calculation on a *.POLY3 file. The  
workspaces are saved to a file with this command. This is useful so you have access to the 
workspace for later use or when you need to terminate the current Console Mode session. 

 l In the Gibbs (GES) module  workspace, all thermochemical data are stored. 
 l In the POLY module workspace, all the last set of conditions and equilibrium state, 

changed status, entered symbols, advanced options, defined stepping/mapping 
variables, added initial equilibria, stepped/mapped results, etc., are stored, so it also 
contain the GES workspace. 

 l When you are in a response-driven module such as POTENTIAL or SCHEIL for 
example, a workspace file is automatically opened. In the workspace file, system 
definitions, conditions for the calculation, calculation results, and plot settings are 
saved. The file is saved in the current working directory, and is named after the name 
of the module that created it. For example, the POTENTIAL module saves a 
workspace file called POT.POLY3 ; the POURBAIX module saves a file called 
POURBAIX.POLY3 and so forth.

After a SAVE_WORKSPACES command, you can always come back to exactly the 
state you had when you issued the command by giving a READ_WORKSPACE 
command. For example, after saving the POLY and GIBBS workspaces to a file, 
you can leave the program and at a later time READ the file and continue from 
the saved state. 

Important Information About Map and Step Commands

A STEP or MAP command automatically saves the workspace with the most 
recently specified name. Do not use the SAVE_WORKSPACES command after a 
MAP or STEP command.
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The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE 
command. You can append several results obtained by sequential STEP or MAP calculations 
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping 
this in mind is important and useful particularly for calculating various isothermal (or 
isoplethal) sections and plotting them on the same diagram in a single Thermo-Calc run.

To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.

Syntax SAVE_WORKSPACES 

Options

A file name must be specified. The default extension of the POLY workspace file is *.POLY3 but you 
can have any other file extension.

Linux and Mac are case sensitive so ensure you enter .POLY3.

A Save window displays if a file name is not given after the command, so that the path (in the Save 
in field) and File name can be specified. The Files of type cannot be changed. 

If there is already a file with the same file name under the directory a warning message displays. 
Click OK to overwrite the current  POLY or GIBBS workspace onto the existing file. Click Cancel to 
return to the module. You can use the SAVE command with an unspecified name (i.e. through SAVE 
,,, command-sequence) to save the POLY or GIBBS workspace.

When saving a POLY3 workspace under a name that already exists under the current 
work area, which is saved by default (after running a special module, e.g. BIN, TERN, 
POT, SCHEIL and POURBAIX) or in an earlier stage of the current Console Mode 
session or in a previous run (which is READ into the current POLY3 workspace), you 
can type SAVE,,Y or SAVE_WORKSPACE ,,y. However, this must also be avoided if 
some results from previous MAP or STEP calculations shall not be destroyed.
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SCHEIL Module Commands

In this section:

CALCULATE_BELOW_SOLIDUS 339

CALCULATE_EVAPORATION_PROPERTIES 340

CALCULATE_FROM_START_TEMPERATURE 341

CALCULATE_FROM_GAS 342

DELTA_FERRITE_AUSTENITE_TRANSITION 343

EVALUATE_SEGREGATION_PROFILE 344

GLOBAL_MINIMIZATION 346

LIQUID_PHASE_NAME 347

SAVE_FILE_NAME 348

SET_MAX_GRID_POINTS_FOR_GLOBAL 349

SET_NUMERICAL_LIMITS 350

SKIP_STEP_CALCULATION 352

SOLUTE_TRAPPING 353

START_WIZARD 354

TEMPERATURE_STEP 358

TERMINATION_CRITERIA 359

TEST_INTERVAL_FOR_GLOBAL 360

USE_BACK_DIFFUSION 361
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CALCULATE_BELOW_SOLIDUS

This command is for the SCHEIL module.

The CALCULATE_BELOW_SOLIDUS command enables or disables the calculation of solid 
state properties at temperatures below the solidus temperature, using the phase 
compositions and fractions from the Scheil calculation. By default this is disabled.  

The calculation is performed at a set number of temperatures between the solidus 
temperature and a lower temperature, which is by default set to room temperature. The 
end temperature and the number of points can be changed. 

Syntax CALCULATE_BELOW_SOLIDUS 

Prompts

Calculate properties below solidus?  /N/:

The default is N. Enter Y to calculate solid state properties below 
solidus .

If Y is entered, then you are prompted:
Final temperature (C) /25/:?

Enter the final temperature in degrees Celsius. Must be 25 C or higher. 

Number of points /50/:?

Enter the number of points where solid state properties are calculated.
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CALCULATE_EVAPORATION_PROPERTIES

This command is for the SCHEIL module.

The CALCULATE_EVAPORATION_PROPERTIES command enables or disables the calculation 
of evaporation properties. By default this is disabled. The evaporation properties include 
driving force for evaporation, evaporation enthalpy, and molar mass of gas.

To be able to calculate these properties the gas phase needs to be selected (in 
the START_WIZARD). 

Syntax CALCULATE_EVAPORATION_PROPERTIES

Prompts
Calculate evaporation properties?  /N/:

The default is N. Enter Y to calculate evaporation properties.
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CALCULATE_FROM_START_TEMPERATURE

This command is for the SCHEIL module.

The CALCULATE_FROM_START_TEMPERATE command enables or disables the calculation of 
equilibria directly from the start temperature chosen in the START_WIZARD. By default this 
is disabled (set to N). Enable this (set to Y) if you want to obtain properties of the liquid 
phase (and gas phase if selected) before the solidification starts. Ordinarily the start 
temperature is only used as a start point in the search of the liquidus temperature, as the 
Scheil calculation starts from the liquidus temperature.

With this setting enabled single equilibrium calculations are performed at specific intervals 
above the liquidus temperature, and after that the Scheil solidification calculation proceeds 
as usual. The equilibrium calculations are performed at 50 Kelvin (K) intervals in the fully 
liquid region and at 5 K intervals in a possible two-phase (liquid/gas) region.

Syntax CALCULATE_FROM_START_TEMPERATURE

Prompt

Perform equilibrium calculations between start and liquidus temperatures? /N/:

The default is N. Enter Y to perform equilibrium calculations from the start temperature until liquidus 
temperature is reached (i.e. solidification starts). The calculations are performed at 5 Kelvin intervals 
in the two-phase gas/liquid region and at 50 Kelvin intervals in liquid.
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CALCULATE_FROM_GAS

This command is for the SCHEIL module.

The CALCULATE_FROM_GAS command enables or disables the calculation of equilibria 
starting from the gas/liquid temperature, i.e. from the temperature above which the liquid 
phase is no longer stable. By default this is disabled (set to N). Enable this (set to Y) to 
perform single equilibrium calculations at 5 Kelvin (K) intervals in the two-phase region 
between the gas/liquid temperature and the liquid/gas temperature, which is the 
temperature below which the gas phase is no longer stable.

In the fully liquid region below the liquid/gas temperature single equilibrium calculations are 
performed at 50 K intervals until the liquidus temperature is reached. After that the Scheil 
solidification calculation proceeds as usual.

Syntax CALCULATE_FROM_GAS

Prompts

Calculate from gas/liquid temperature? /N/:

The default is N. Enter Y to perform equilibrium calculations from the gas/liquid temperature.
Gas phase name /GAS/:

Enter the name of the gas phase (default GAS).

If you choose a phase that is not available in the system, Thermo-Calc checks if 
there is any phase present  with the phase type code G.
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DELTA_FERRITE_AUSTENITE_TRANSITION

This command is for the SCHEIL module.

The DELTA_FERRITE_AUSTENITE_TRANSITION command enables or disables BCC to FCC 
transition.

This feature should only be used for such steels for which it is reasonable to 
assume infinitely fast diffusion (equilibrium conditions) when delta ferrite is 
present. When the Allow delta ferrite to austenite transition in steel checkbox 
is selected in Graphical Mode or the DELTA_FERRITE_AUSTENITE_TRANSITION 
command used in Console Mode, this essentially assumes that diffusion can be 
considered (infinitely) fast when delta ferrite is present as a solid phase, i.e 
assumes an equilibrium condition. After delta ferrite is no longer stable, the 
usual Scheil assumptions for the selected calculation type are in effect. This 
setting is therefore not suitable for steels where you DO NOT have a complete 
BCC to FCC transition during solidification. This setting is also NOT available in 
combination with solute trapping.

Syntax DELTA_FERRITE_AUSTENITE_TRANSITION

Prompt

Allow delta-ferrite -> austenite ? /N/:

The default is N. Enter Y  to enable BCC to FCC transition. 

This feature should only be used for such steels for which it is reasonable to assume infinitely fast 
diffusion (equilibrium conditions) when delta ferrite is present. See the above for details.



Thermo-Calc User Guide: Console Mode ǀ 344 of 622

EVALUATE_SEGREGATION_PROFILE

This command is for the SCHEIL module.

This feature is not supported with fast diffusers. 

Enable this feature before executing the START_WIZARD command.

Use this command in order to evaluate a segregation profile while performing the Scheil 
calculation. The Scheil calculation itself does not contain a spatial dimension. However, if it 
is assumed that the molar volume is constant and equal for all elements, and if a length is 
provided over which solidification occurs (for example the secondary dendrite arm spacing) 
then the generated profile corresponds to the segregation that would be obtained under the 
assumptions of a Scheil calculation. The grid is then equidistant and can be used as input for 
a DICTRA simulation. 

The generated text file contains, on each line, the mole fractions of all elements in 
alphabetical order at a certain grid point. If the composition is the same on several 
consecutive lines it means that the composition of the then remaining liquid has reached a 
state in which there are no degrees of freedom.

Syntax EVALUATE_SEGRATION_PROFILE

Prompt

Evaluate segregation profile? /N/

If the answer is Y, a segregation profile will be evaluated and saved to disc. This 
feature is not supported with fast diffusers. You cannot select fast diffusers if 
evaluation of the segregation profile is enabled.

 

Number of grid points /100/

Enter the number of grid points for the segregation profile. An xf.txt file dialogue window opens and 
allows you to specify the name of the file in which the segregation profile is written. 

About the xf.txt File
The file is started with this command, and available after the Scheil simulation is finished. The XF.txt 
file contains one line per grid point entered here. 

In a macro file it is possible to enter all arguments on a single line, e.g. EVALUATE_SEGREGATION_
PROFILE Y 100 XF.TXT, meaning that the segregation profile is evaluated over 100 grid points and 
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Syntax EVALUATE_SEGRATION_PROFILE

saved to a file (XF.TXT) in the current working directory. The grid coordinate (actually fraction solid, 
but used later as distance) is not recorded in the XF.txt file.

The file contains one column per element, listing the mole-fraction of each in alphabetical order, 
including the dependent element. As I understand it, it is the total concentration of each element in 
each point at the end point of the Scheil simulation.

The XF.txt is then used with INPUT_SCHEIL_PROFILE command in the 
DICTRA module. Remember to use the same number of grid points in the DICTRA 
region as in this file.

 

../../../../../../Content/DICTRA_Commands/INPUT_SCHEIL_PROFILE.htm
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GLOBAL_MINIMIZATION

This command is for the SCHEIL module.

Global minimization is enabled by default (i.e. set to Y) and global minimization is used 
throughout the simulation. 

It is recommended to keep global minimization on as it makes the calculation 
more accurate. However, turn it off if you find that the calculation is taking too 
long for any particular system, and accuracy is not the highest priority.

For the GLOBAL_MINIMIZATION command, a global equilibrium test is performed when an 
equilibrium is reached, at selected intervals. By default it is at every 10th Scheil step but this 
can be changed using the command TEST_INTERVAL_FOR_GLOBAL. The global equilibrium 
test is also done every time the set of stable phases tries to change. This costs more 
computer time but the calculations are more robust.

Syntax GLOBAL_MINIMIZATION

Prompt
Use global minimization? /Y/

By default this is set to Y. This costs more computer time but the calculations are more robust.
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LIQUID_PHASE_NAME

This command is for the SCHEIL module.

Use this command  to use the liquid phase name from the database definitions or enter 
another phase name.

Syntax LIQUID_PHASE_NAME

Prompt
Liquid phase name /Default/

Default selects the liquid phase from the database definitions, otherwise enter a phase name.
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SAVE_FILE_NAME

This command is for the SCHEIL module.

Use this command  to save the file. The files get the console number added to this name, e.g. 
005.->Scheil_006.POLY3 and Scheil_segregation_profile.txt).

Syntax SAVE_FILE_NAME

Prompt
Name of files to be saved, POLY and segregation profiles.

Linux and Mac are case sensitive so ensure you enter .POLY3. 



Thermo-Calc User Guide: Console Mode ǀ 349 of 622

SET_MAX_GRID_POINTS_FOR_GLOBAL

This command is for the SCHEIL module.

Use the SET_MAX_GRID_POINTS_FOR_GLOBAL command to set the maximum number of 
gridpoints per phase for global minimization. The default is 2000.

Syntax SET_MAX_GRID_POINTS_FOR_GLOBAL

Prompt
Maximum number of gridpoints per phase /2000/:

Enter the maximum number of gridpoints per phase for global minimization
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SET_NUMERICAL_LIMITS

This command is available for the POLY, Scheil, and ED-EXP modules.

Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a 
calculation procedure enforced by COMPUTE_EQUILIBRIUM, STEP_WITH_OPTIONS, MAP or 
ADVANCED_OPTIONS), this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 
to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-
LIMITS

This implies that smallest site fraction in the current POLY workspace is automatically 
increased from the default value 1.00E-30 to the hardware-dependent precision (under 
Linux, as 2.00E-14). For other subsequent POLY module calculations, you can use this 
command to restore or reset the smallest site fraction to the previous or another preferred 
value, as well as to reset other numerical limits.

Syntax SET_NUMERICAL_LIMITS

Prompt

Maximum number of iterations /500/:

By default, the program tries 500 iterations before it gives up. As some models give computation 
times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the 
calculation stops if 500 CPU seconds/iterations are used.

 

Required accuracy /1E-6/:

This is a relative accuracy, and the program requires that the relative difference in each variable 
must be lower than this value before it has converged. A larger value normally means fewer 
iterations but less accurate solutions. The value should be at least one order of magnitude larger 
than the machine precision.

 

Smallest fraction /1E-12/:

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you 
can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with 
one sublattice site (such as the GAS mixture phase in many databases) for which the default value is 
always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an even-
lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).

 

Approximate driving force for metastable phases /Y/:

Y is the default. Enter N to change the default as required and based on the options described below.

This setting involves the convergence of metastable phases and affects their driving forces. It can 
also have an effect on when an equilibrium is considered successful.

The default is to allow an equilibrium with metastable phases that have not converged, as long as 
the stable phases have converged. This is efficient but often causes approximate values of the 



Thermo-Calc User Guide: Console Mode ǀ 351 of 622

Syntax SET_NUMERICAL_LIMITS

driving forces for the metastable phases.

If you change the default, it enforces metastable phases to converge. This gives accurate driving 
forces for metastable phases as well as stable phases. It can however take a slightly longer time, and 
if metastable phases do not converge it causes the equilibrium calculation to fail.
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SKIP_STEP_CALCULATION

This command is for the SCHEIL module.

Use the SKIP_STEP_CALCULATION command to skip the step (also called one axis) 
calculation that is by default performed before the Scheil calculation in Thermo-Calc. The 
step calculation is used to plot the equilibrium solidification curve, which is shown for 
comparison if the default axis variables are used. This is sometimes referred to as the 
equilibrium line. 

If a comparison to equilibrium is not necessary, change the default setting and then only a 
Scheil calculation is performed. This results in a much faster calculation, which for a complex 
system may be preferable.

Syntax SKIP_STEP_CALCULATION

Prompt
Skip the step calculation before Scheil (equilibrium curve)? /N/:

By default this is set to N. If a comparison to equilibrium is not necessary, enter Y and only a Scheil 
calculation is performed. 
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SOLUTE_TRAPPING

This command is for the SCHEIL module.

Details about the solute trapping model theory are in About Scheil with Solute 
Trapping.

The SOLUTE_TRAPPING command enables solute trapping. Once enabled, there are additional 
prompts and settings that are included and described with the START_WIZARD command.

Syntax SOLUTE_TRAPPING

Prompt

Consider solute trapping in primary phase? /N/

The default (N) does not use solute trapping. If you choose Y, then solute trapping is used.

When the  USE_BACK_DIFFUSION command is enabled, the  SOLUTE TRAPPING command 
is automatically disabled (set to N). 
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START_WIZARD

This command is for the SCHEIL module.

About the Scheil-Gulliver Solidification Simulations

Use this command to use the START_WIZARD with step-by-step prompts to create a Scheil 
simulation.

You are prompted for settings including the major element or alloy, composition input in 
mass (weight) percent, the alloying elements, the temperature, fast diffusing components, 
and whether any phase should have a miscibility gap check. There are additional prompts 
included in the Start Wizard if USE BACK DIFFUSION or SOLUTE TRAPPING commands are set to 
Yes to enable back diffusion and solute trapping, respectively.

The Scheil with back diffusion  feature is only available for systems with 
diffusion data, i.e. this model requires the use of a mobility database.

Use the other commands to make changes to settings that are not included in this wizard.

 l EVALUATE_SEGREGATION_PROFILE

 l GLOBAL_MINIMIZATION

 l LIQUID_PHASE_NAME

 l SAVE_FILE_NAME

 l STORED_COMPOSITION_TYPE

 l TEMPERATURE_STEP

 l TERMINATION_CRITERIA

If you also have a license for the Diffusion Module (DICTRA), you can import a 
previously calculated Scheil segregation profile into the software using the 
command INPUT_SCHEIL_PROFILE. Press F1 to search the online help. 

Syntax START_WIZARD

Prompt

The following is a list of the prompts. Press <Enter> to accept the defaults that are shown between 
the forward slashes (/default/). 

Database /<Default>/:

The available thermodynamic database and its version are available to enter (based on license). 
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Enter ? for a list. 

Major element or alloy:

The major element in the system, e.g. Fe for a steel.

Composition input in mass (weight) percent? /Y/:

Set whether to specify the Composition input in mass (weight) percent (the default) or in Mole 
percent. Enter Y for mass percent and N for mole percent.

1st alloying element: 

You can specify all the alloying elements and their corresponding compositions on 
the same line when you are prompted to specify your first alloying element. For 
example, you can enter Cr 5 Ni 1 Mo 0.5 C 0.01 N 0.02.

You can directly specify mass or mole percent after the name (for example, enter Cr 5). If this is not 
specified, then you are prompted to enter it separately.  

Mass (weight) percent /1/

2nd alloying element:

Specify the other alloying elements in the same way as you specify the first (for example, c 1). 

Mass (weight) percent /1/

Next alloying element:

After you have specified your last alloying element, press <Enter> when requested to specify the 
next element. This ends the process of defining the bulk composition of the alloy system. 

Temperature (C) /2000/:

Enter a value for the temperature in degrees C (Celsius) . This value should be sufficiently high so 
that the solidification simulation starts with the alloy system in the liquid single-phase region.

Decide which phases (if any) to reject at the Reject phase(s) prompt. Enter the name of the phases 
to reject or press <Enter> for NONE. 

Decide whether to Restore phase(s). You may want to restore a phase that you rejected when you 
ran the simulation earlier, or you may want to restore a phase that is rejected by default in your 
database. Enter the name of the phases to restore or press <Enter> for NONE.

Then you are asked to confirm whether these phases should be retained in this system:

OK? /Y/:

Press <Enter> to accept the default Y or type N and press <Enter>. Thermodynamic data about the 
alloy system you defined is retrieved from the database.

Should any phase have a miscibility gap check? /N/:

If you answer Y, you are prompted to specify the Phase with miscibility gap. Answer with a 
solution phase name(s) (e.g.  FCC) as well as the Major constituents for sublattice   (for each 
sublattice site) (for this example, Cr is entered for sublattice 1 and C for sublattice 2). 

Press Enter to specify another phase. 

Fast diffusing components: /None/: 
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Enter the elements that diffuse fast in solid phases and can assume to be in equilibrium in the whole 
phase. E.g. C in a steel.

Back Diffusion and Solute Trapping Settings

The following prompts are included with the Start Wizard at various points in the set up if 
the:

 l  USE_BACK_DIFFUSION command is set to Y to enable back diffusion
 l  SOLUTE_TRAPPING command is set to Y to enable solute trapping

Syntax START_WIZARD

Back 
Diffusion 
settings

Mobility Database /<Default>/:

The available mobility database and its version are available to enter (based on license). Enter ? for 
a list. 

You then are shown a list of what phases are available for the database and the defined system and 
have the opportunity to reject or restore phases at the next prompts. 

Reject phase(s) /NONE/:

Restore phase(s): /NONE/:

Then you are asked to confirm whether these phases should be retained in this system:

OK? /Y/:

Press <Enter> to accept the default Y or type N and press <Enter>.

Temperature time dependence /LINEAR/:

Specify the type of temperature time dependence. Press <Enter> to accept this default. 

An increased value moves the result from equilibrium toward a Scheil-Gulliver calculation.

LINEAR is the only option and it corresponds to a constant cooling rate.

Cooling rate (K/s) /.1/:

Specify the cooling rate in Kelvin per second (K/s). An increased value moves the result from 
equilibrium toward a Scheil-Gulliver calculation.

Expression for secondary dendrite arm spacing /CONSTANT/:

Secondary dendrite arm spacing is the distance in meters (m) between two secondary dendrite 
arms. Specify the type of secondary dendrite arm spacing by entering CONSTANT (the default) or 
POWER_LAW. 

An increased value moves the result from equilibrium toward a Scheil-Gulliver calculation. Use

 l CONSTANT for a constant dendrite arm spacing. If you choose this, then enter a value for 
the Secondary dendrite arm spacing (m) /5E-05/: prompt. 

 l POWER_LAW in the form c*(cooling rate)^-n where c and n are entered in the next 
prompts.  If you choose this, then enter a value for the Exponent n /.33/: and Scaling 
factor c /5E-05/:



Thermo-Calc User Guide: Console Mode ǀ 357 of 622

Syntax START_WIZARD

Primary phase /AUTOMATIC/:

The primary phase is the phase where the back diffusion takes place. 

If Automatic is selected (or kept as the default), the program tries to find the phase which gives 
the most back diffusion. To override this setting, choose a specific primary phase from the list.  For 
back diffusion, only phases with diffusion data can be used as primary phases.

Solute 
Trapping 
settings

 

Expression for solidification speed /SCANNING_SPEED_AND_ANGLE/:

SCANNING_SPEED_AND_ANGLE is currently the only available option. It is calculated as scanning 
speed * cos(alpha) where scanning speed and the angle alpha are given by the user.

Decreasing the value moves the result toward a Scheil-Gulliver calculation.

Scanning speed (m/s) /1/:

Enter the Scanning speed to calculate the solidification speed, Vs = Vscanning * cos(α) m/s, where 
Vscanning is the user specified scanning speed. 

Alpha (degrees) /45/:

Enter an Alpha value in degrees, which is the alpha angle, α, between the solid/liquid boundary and 
scanning direction. 

Primary phase /AUTOMATIC/:

If Automatic is selected (or kept as the default), the program tries to find the phase which gives 
the most  solute trapping. To override this setting, choose a specific primary phase from the list. For 
solute trapping, only phases that dissolve all elements in the system can be used as primary phases. 
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TEMPERATURE_STEP

This command is for the SCHEIL module.

Use this command  to define a temperature step.

Syntax TEMPERATURE_STEP

Prompt Set temperature step (C) /1/
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TERMINATION_CRITERIA

This command is for the SCHEIL module.

Use this command to define the termination criteria for the fraction of liquid (unit = mole 
fraction) or temperature.

Syntax TERMINATION_CRITERIA

Prompts Fraction of liquid or Temperature (F or T)? /F/

 Fraction of liquid /.01/



Thermo-Calc User Guide: Console Mode ǀ 360 of 622

TEST_INTERVAL_FOR_GLOBAL

This command is for the SCHEIL module.

By default, global minimization is enabled (i.e. set to Y with the command GLOBAL_
MINIMIZATION). 

Use the TEST_INTERVAL_FOR_GLOBAL command to change the interval at which a global 
equilibrium test is done, which by default is every 10th step as long as there are no changes 
in the set of stable phases. Every time the set of stable phases tries to change, a global 
equilibrium test is also done regardless of the test interval value chosen. A global 
equilibrium test means that the calculated equilibrium state obtained by the ordinary 
minimization calculation is tested against the Global Minimization Technique, and if the 
result is found unstable then the full global minimization calculation is performed instead.

Syntax TEST_INTERVAL_FOR_GLOBAL

Prompt
Global test interval /10/:

Global equilibrium test is done every Nth step,  unless the set of stable phases changes. By default a 
test is done every 10th step. Enter a different number to change the interval.
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USE_BACK_DIFFUSION

This command is for the SCHEIL module.

The Scheil with back diffusion  feature is only available for systems with 
diffusion data, i.e. this model requires the use of a mobility database.

About the Scheil-Gulliver Solidification Simulations

The USE_BACK_DIFFUSION command enables back diffusion in the solid primary phase. Once 
enabled, there are additional prompts and settings that are included and described with the 
START_WIZARD command.

Syntax USE_BACK_DIFFUSION

Prompt

Use back diffusion? /N/

The default (N) does not use back diffusion. If you choose Y, then back diffusion is used. 

When the SOLUTE TRAPPING command is enabled, the USE_BACK_DIFFUSIONcommand 
is automatically disabled (set to N).
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PARROT Module Commands

The PARROT Module in the Data Optimization User Guide.

In this section:

About the ENTER_PARAMETER Command 365

AMEND_PARAMETER 370

AMEND_SYMBOL 373

COMPILE_EXPERIMENTS 376

CONTINUE_OPTIMIZATION 377

CREATE_NEW_STORE_FILE 378

EDIT_EXPERIMENTS 379

ENTER_PARAMETER 380

LIST_ALL_VARIABLES 382

LIST_CONDITIONS 383

LIST_PARAMETER 384

LIST_PHASE_DATA 386

LIST_RESULT 387

LIST_STORE_FILE 392

LIST_SYMBOL_IN_GES 393

OPTIMIZE_VARIABLES 394

READ_PARROT_WORKSPACES 395

RECOVER_VARIABLES 396

REINITIATE 397

RESCALE_VARIABLES 398

SAVE_PARROT_WORKSPACES 399

SET_ALTERNATE_MODE 400
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SET_EXTERNAL_PARAMETER 401

SET_FIX_VARIABLE 402

SET_OPTIMIZING_CONDITION 403

SET_OPTIMIZING_VARIABLE 405

SET_OUTPUT_LEVELS 406

SET_SCALED_VARIABLE 407

SET_STORE_FILE 408
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About the ENTER_PARAMETER Command

For the PARROT Module, this command is the same and is described here. See 
ENTER_PARAMETER for the command details.

In the descriptions of the standard thermochemical properties and special physical 
properties for a phase, there are a number of parameters which may depend on the 
temperature and pressure. The expressions for these parameters can be given in a free form 
as a sum of terms with powers of T and P and may also include the natural logarithm and 
exponential function. This type of expression is called TP-functions. Identical parameters (in 
terms of parameter-names) are stored only once in the GIBBS workspaces.

The composition-dependence of the Gibbs energy is described in the GIBBS module by the 
internal data structure, which is created when the phase is entered. The Gibbs energy of a 
phase is always referred to one formula unit of the phase, i.e. the amount derived from the 
number of sites (i.e. the stoichiometric coefficient) for each sublattice. If vacancy is a 
constituent of a sublattice, the amount of matter per formula unit of the phase may vary 
with composition.

Gibbs Energy System (GES) Commands

How to Define a Parameter

A valid parameter should have the general form of: 

<identifier>(<phase>, <constituent array>; <digit>) <xxx> <expression> <yyy> 
<keyword Y or N> <zzz> ! 

The identifier must be followed by an opening parenthesis, a phase name, a comma and a 
constituent array. Optionally, the constituent array can be followed by a semicolon and a 
digit. The parameter name is terminated by a closing parenthesis. The parameter form is 
defined as:

 l <identifier> is the parameter type;
 l <phase> is the phase name (maximum 24 characters);
 l <constituent array> is the specific constituent array in the phase; 
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 l <digit> is the degree of composition-dependent interaction contribution (an integer 
number from 0 through 9), that is only for excess energy (L), Curie temperature (TC) 
and Bohr magneton number (BMAGN), as well as for volume-related parameters (V0 
or VA or VC or VK); if it is valued as zero, or if it is for the standard Gibbs energy (G) 
for which the degree is always zero, it can be omitted;

 l <expression> is the mathematical relation to describe the parameter;
 l <xxx> and <yyy> are the low and high temperature limits respectively for the 

applicable temperature range of the parameter expression;
 l <keyword Y or N> is the indicator on if there is continuation for the parameter 

expression or not;
 l <zzz> is the reference index/number for the assessment of this parameter;
 l The exclamation point ! is used to indicate that the current parameter definition is 

ended.

Parameter Name

The GES parameter name has a general form of:

<identifier>(<phase>,<constituent array>;<digit>)

Examples of parameter names:

 l G(GAS,C1O2): The Gibbs energy of formation of a CO2 molecule in gas.
 l G(FCC,FE:VA): The Gibbs energy of formation of fcc Fe with interstitials.
 l L(LIQ,Fe,Cr;0: The regular solution parameter for Fe and Cr in liquid.
 l L(LIQ,Fe,Cr;1): The sub-regular solution parameter.
 l TC(BCC,Fe:Va): The Curie temperature of bcc Fe.
 l BMAGN(BCC,Fe:Va): The Bohr magneton number parameter of bcc Fe.

The parameter name consists of several parts. The first is a type-identifier and these can be 
used:

 l G: Standard energy parameter (Gibbs energy of formation) or for interaction 
parameters;

 l L: Excess energy parameter (Gibbs energy of interaction) always used for interaction 
parameters;

 l TC: Curie temperature for magnetic ordering;
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 l BMAGN or BM: Bohr magneton number for magnetic ordering (or Born function ωPr,Tr 
for aqueous solute species).

 l VO: Molar volume at 298.15 K and 1 bar (a numeric value only);

 l VA: Integrated thermal expansivity; 

 l VC: High-pressure fitting parameter;
 l VK: Isothermal compressibility.

For more information about the high pressure volume, see X.-G. Lu, M. Selleby, 
B. Sundman, "Implementation of a new model for pressure dependence of 
condensed phases in Thermo-Calc", Calphad. 29, 49–55 (2005).

When necessary quantities as H (enthalpy), S (entropy), V (Volume), F 
(Helmholtz energy), etc., can be calculated from the Gibbs energy.

Phase Name

Specifying the PHASE NAME in uppercase is recommended; however, if you prefer to write it 
as a mixture of uppercase and lowercase, it automatically converts all lowercase to 
uppercase, as the GIBBS module only recognizes uppercase phase names. It is important 
that if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition 
(already by the PHASE keyword; such as GAS:G, LIQUID:L,SLAG:L, IONIC-LIQ:Y, SPINEL:I, FCC_
L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code should not be 
attached to the phase name when ENTER_PARAMETER is executed.

Constituent Array

The constituent array consists of a list of constituent names. Interaction parameters have 
two or more constituents from the same sublattice separated by a comma. If the phase has 
sublattices, at least one constituent in each sublattice must be specified. The constituents in 
different sublattices must be given in sublattice order and are separated by a colon.
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After the component array, a sub-index digit can be specified after a semicolon. This digit 
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess 
energy model used for the phase. If no semicolon and digit are given, the sub-index value is 
assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary 
parameters, are multiplied with two or more fractions of the constituents from the same 
sublattice of the solution phase. These additional constituents must be given as interacting 
constituents (as the following prompt). 

Solution phases with sublattices can have interacting constituents in each 
sublattice.

Interaction Parameter

An interaction parameter, which is used to describe the excess term of a quantity, must 
have two or more constituents that interact with each other on a specified sublattice site of 
the given phase. It is arbitrary which of these constituents is given as the first constituent 
and what is given as the interacting constituents. The software always sorts the constituents 
(in each sublattice) in alphabetical order when the parameter name is written as a prompt 
(for entering its parameter value) and when the parameter is listed (using the GIBBS 
commands LIST_PARAMETER or LIST_PHASE_DATA). This is important for all asymmetric 
interaction parameters where the sign of the interaction parameter must depend on the 
appearance order.

Use an asterisk* to denote that the excess interaction parameter is independent of the 
constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that the 
interaction parameter is for the binary interaction between constituents AL and NI on the 
first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on 
the second sublattice. An interaction parameter in the list of constituents is always added to 
the Gibbs energy and the asterisk * is calculated with the term of [1∑y(specified 
constituents)], which implies that in an A-B binary system these L parameters are identical 
(but in higher-order systems, these are different):

 l L(phase,A,B) is multiplied with X(A)*X(B)
 l L(phase,A,*) is multiplied with X(A)*(1-X(A))
 l L(phase,B,*) is multiplied with X(B)*(1-X(B))
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If you press <Enter> when you are asked for a parameter name or if you have improperly 
input the entire parameter name, you are asked for each of these items in the name.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 370 of 622

AMEND_PARAMETER

This command is for the  PARROT module.

There is also a Gibbs (GES) module command with the same name.

Interactively modify the TP-function(s) for a specific parameter for a phase with this 
command. This is useful in order to correct typing errors because the old function is made 
available for interactive editing on the terminal.

Syntax AMEND_PARAMETER

Prompts

Parameter: <Parameter name>

Specify a correct parameter name. If a parameter name is not acceptable or <Enter> is pressed, the 
error message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each part for a parameter name.

 

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these types of legal identifiers 

ENTER_PARAMETER

 
Phase name (ABCD/): <Phase name>

Specify the phase name. 

 
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name. 

 
Interacting constituent (In sublattice # /XYZ/): <Species name>

Specify the interacting constituent name; if there is no interacting constituent, press <Enter>. 

 
Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent, specify these; otherwise press <Enter>. 

 
Degree /#/: <Degree>

Specify a numerical number as the degree of the phase parameter. 

 

After the parameter name is specified correctly, the program lists its current definition (either 
preset in database or defined by the ENTER_PARAMETER command), such as:

L(PHASE2,AL,MG;1)=

298.15<T<2000.00: +5000

2000.00<T<4500.00: +4500

4500.00<T<6000.00: +4000

You are prompted to change the parameter definition:
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Do you want to change the number of ranges /No/: 

Enter Y to change the number of ranges for the chosen function, or change some of the 
temperature limits in the definition, then retype both the low/high temperature limits and 
functions 

If you do not want to change the number of ranges but want to change the function(s) in one or 
more ranges, press <Enter> and the whole definition of the chosen parameter in all ranges (if any) is 
listed such as:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00 

This message prompts:

Do you want to change range limits /No/: 

If there is more than one range, this question is prompted. Press <Enter>.

 

Range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges, you must specify the 
range of the function of which you want to amend. Or press <Enter> or type 0 to exit this command 
without making any change.

 

Function

The previous function is available for editing. The editing is performed within the general 
subroutine FOOLED, as described in AMEND_SYMBOL. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at that position between 
colons, (::).

Commands
These commands can be given:

 l Help: ?

 l Move CP to last or first character: <+/-> A

 l Delete characters from CP: <+-#characters> D

 l Exit: E

 l Find: <#occurrences> F<string>@

 l Insert: I<string>@

 l Move: <+-#positions> M

 l Restore string: R

 l Substitute: S<OLD>@<NEW>@

 l Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an 
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Syntax AMEND_PARAMETER

input or search string.

When the string is typed the character at the current position is replaced by an 
underscore _. 

To finish the editing of the current function, type E at the prompt.

 
Range number (0 to exit) /0/: <Range number>

Give a range number to edit that function, or press <Enter> or type 0 to exit this command.
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AMEND_SYMBOL

This command is for the  PARROT module.

The same command is also available for the Gibbs (GES) module.

Interactively calculate the current values of a function or table (predefined by the switched 
database or previously entered with ENTER_SYMBOL) at the current temperature and 
pressure condition, and also possible to modify the definitions of variables or functions.

The current values of the temperature and pressure used to calculate the 
functions or tables are the ones listed with LIST_STATUS. There is no way to 
change the current temperature and pressure values interactively.

To modify the definitions of entered symbols (variable, functions or parameters), the 
performance of this command is slightly different one from another, as described below:

 l For variables, the values can be changed.
 l For functions the low and high temperature limits in various ranges (if any), as well 

the expressions, can be changed.
 l For parameters the low and high temperature limits in various ranges (if any), as well 

the expressions, can be changed.

Syntax AMEND_SYMBOL

Prompts

Name: <Symbol name>

Specify the name of an entered symbol.

For tables and functions (or parameters which are treated as functions after these are entered by 
the ENTER_SYMBOL command with the Parameter keyword, but not by the ENTER_PARAMETER 
command), after the symbol name is specified here, the program automatically calculates the 
values under the current temperature and pressure conditions, and lists the current values, such as:

FUNCTION VALUE  2.52500000E+01

TABLE VALUE  1.56000000E+02

For variables and functions (or parameters), there are additional prompts and depend on the 
symbol type.

 

For a variable, its current value is displayed, and you can change it to a new value: 

Value /Current value/: <New value>

For a function (or a parameter entered as a symbol):

Do you want to change the number of ranges /No/: 
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Syntax AMEND_SYMBOL

Enter Y to change the number of ranges for the function, or change some of the temperature limits 
in the definition, then retype both the low/high temperature limits and functions (see all the 
remaining details in the ENTER_SYMBOL  command. 

If you do not want to change it, press <Enter>. The definition of the chosen function in all ranges (if 
any) is listed, for example:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00

and this message displays:

Do you want to change range limits /No/: 

If a function is different in two or more temperature ranges, you must specify the range of the 
function of which you want to amend. Or press <Enter> or type 0 to exit this command without 
making any change.

 

Range number (0 to exit) /0/: <Range number>

Function:

The previous function is available for editing. The editing is performed within the general 
subroutine FOOLED. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at that position between 
colons (::).

Commands
These commands can be given:

 l Help: ?

 l Move CP to last or first character: <+/-> A

 l Delete characters from CP: <+-#characters> D

 l Exit: E

 l Find: <#occurrences> F<string>@

 l Insert: I<string>@

 l Move: <+-#positions> M

 l Restore string: R

 l Substitute: S<OLD>@<NEW>@

 l Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an 
input or search string.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 375 of 622

Syntax AMEND_SYMBOL

When the string is typed the character at the current position is replaced by an 
underscore _. 

To finish the editing of the current function, type E at the prompt.
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COMPILE_EXPERIMENTS

The descriptions of the experimental equilibria saved on a textual *.POP file, given as 
commands in the POLY and ED_EXP syntax, is compiled by this command into the PARROT 
structured data, i.e. stored into the current work *.PAR file which is created with CREATE_
NEW_STORE_FILE, set by SET_STORE_FILE , or opened with READ_PARROT_WORKSPACES, 
all done before COMPILE_EXPERIMENTS.

This command also lists the compilation details on screen or onto a listing file (*.TXT). 

If a syntax error in the commands is detected, the compilation is terminated. 
You need to correct the error in the *.POP file (using a textual editor) and 
recompile it with the *.PAR work (store) file.

After a successful compilation, the program translates all the experimental data points in the 
*.POP file into a graphical experimental data file (*.EXP) in the DATAPLOT syntax, which can 
be further edited and used as a graphical experimental data file (*.EXP) for the purposes of 
imposing onto calculated/plotted phase diagrams and/or property diagrams for comparisons 
during the assessment process.

DATAPLOT User Guide included with this documentation set.

Syntax COMPILE_EXPERIMENTS 

 

A window displays to open the original experimental data file (*.POP). Enter a *.POP File name box, 
and specify the working directory in the Look in box. Normally the default file-type in the Files of 
type field is the correct one for the experimental data format (i.e. *.POP file). Click Open or Cancel 
button as applicable.

Prompts

Output to screen or file /Screen/: <*.pop file name>

A list of the source code in the *.POP file and error messages during compilation is written on 
screen (by pressing <Enter>) or on a list *.TXT file under a specific file name which can later on be 
opened and edited by any basic textual editor.

 

Initiate store file /Y/: 

After a successful compilation, the data in the POLY workspace is stored as a new block of equilibria 
on the current work (store) file. By default the store file is initiated before compilation and only the 
compiled block is stored on the current work file (consequently, the *.PAR file is updated). 

A window displays to generate/store the graphical experimental data file (*.EXP) in the DATAPLOT 
syntax. Enter a *.EXP file name in the File name field and specify the working directory when 
opening the *.EXP file in the Look in field. Normally the default file type in the Files of type field is 
the correct one for the graphical experimental data format (i.e. *.EXP file). Click Open or Cancel as 
applicable.

To keep the current work file, enter N. 
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CONTINUE_OPTIMIZATION

This command is for the  PARROT module.

This command continues the optimization using the same Hessian matrix.

In some cases it is not possible to attempt continuation. For example, if the 
optimization has already converged or if the optimizing parameters or the set 
of experimental equilibria used in the current optimization runs are changed. 
The program gives a warning message if you try to continue when you make 
these changes.

Syntax CONTINUE_OPTIMIZATION

Prompts

Are you sure? /N/: <N or Y>

Prior to this question, a message displays to confirm if it is OK to continue:

It is safe to CONTINUE only after TOO MANY ITERATIONS  and no change in variables and 
experiments ...

You can accept the default (N) in order to cancel this special attempt.

 

Number of iterations /N/: <Integral number of iteration>

Specify an integral number for the optimization iteration. The specified iteration number is shown 
as the default number. The PARROT program tries this exact number of different sets of values of 
the optimizing variables without stopping the optimization even it would have converged earlier or 
should give up earlier.
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CREATE_NEW_STORE_FILE

This file is hardware dependent and cannot be read by any text editor.

Create a binary file to be used as a work file (also called store file) before any optimization 
can be done. The workspace used by the GIBBS, POLY and PARROT modules is stored 
automatically on the work file but not any experimental information. The binary work file 
has a default extension of PAR under MS-Windows or par under Linux/UNIX. 

A work file that is created at a previous run can be used in the PARROT module with the 
other command SET-STORE-FILE.

Syntax CREATE_NEW_STORE_FILE 

Prompt

<*.par file name>

A Save window displays. Enter a File name and specify the working directory in the Save in field. 
Normally the default file-type in the Files of type field is the correct one for the PARROT workspace 
format (i.e. PAR file). Click Save or Cancel as applicable.
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EDIT_EXPERIMENTS

Initialize and make available the sub-module for editing experimental equilibria, i.e. the ED_
EXP module. All experimental equilibria compiled from the *.POP file can be accessed in the 
ED_EXP module.

The ED_EXP module is similar to the normal POLY module, but some commands are special 
and some POLY commands are not available. In the ED_EXP module, you can calculate each 
equilibrium separately or together, provide start values for equilibria which failed to 
converge, set weights, and modify the values of experiments or conditions.

Syntax EDIT_EXPERIMENTS

 You are now in this submodule and can start using the commands.

 l The first required command after entering the ED_EXP module for the first time 
(from the PARROT module GOTO MODULE ED-EXP)  should always be READ_BLOCK in 
order to load the experimental data block from the current work *PAR-file for 
editing. 

 l The READ_BLOCK command must also be used prior to any other ED_EXP command if 
the module is reinitiated, or if no experimental data block is not previously read from 
a work file compiled with a proper experimental data .POP file, or if you want to 
change to another data block for editing.

 l If any change is made in the ED_EXP module remember to use the command SAVE_
WORKSPACE before going BACK to the PARROT module.

Although the TABLE_HEAD, COMMENT and FLUSH_BUFFER commands are visible in 
the ED_EXP module, these cannot be used here as these only work in a *.POP 
file (or *.DOP file for DICTRA).
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ENTER_PARAMETER

This command is for the  PARROT module.

There is also a Gibbs (GES) module  command with the same name.

About the ENTER_PARAMETER Command

Use this command to enter TP-function(s) for a specific parameter for a phase interactively 
with this command. If there is already a parameter expression defined (for this parameter), 
that is deleted and replaced with newly entered one.

The entered TP-Function(s) for the parameter can be changed later with the command 
AMEND_PARAMETER.

Syntax ENTER_PARAMETER

Prompts

Parameter: <Parameter name>

As explained in About the ENTER_PARAMETER Command, specify a correct and complete 
Parameter Name, which should contain all the necessary parts of the general form:

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter>, is pressed, a message displays:

*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter name.

Options Description or Information

Identifier

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA  or VC or VK>

If this command is used one or more times, the previous value on this prompt is set as default. 
Press <Enter> for the same type identifier or specify a new type.

Phase name

Phase name (/ABCD/): <Phase name>

Each parameter is valid for a specific phase only. The name of that phase must be supplied 
(maximum 24 characters). The name can be abbreviated.

Constituent

Constituent (in sublattice # /ABC/): <Species name>

A parameter is identified by the constituents on a specified sublattice site of the given phase, 
the stoichiometric coefficients of which are multiplied with the parameter. The name of the 
constituent can be abbreviated.

It is the species name, not the stoichiometric formula required here.

If this command is used one or more times, the previous value on this prompt is set as default. 
Accept it by pressing <Enter> if the constituent is the same, or specify a new species name.
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Syntax ENTER_PARAMETER

Interacting 
constituent

For phases with several sublattices, the program asks for one constituent in each sublattice.

Interacting constituent (in sublattice # /XYZ/): <Species name>

If this command is used one or more times, the previous value on this prompt is set as default. 
Press <Enter> to accept it if the constituent is the same, or specify a new species name.

To cancel the default value of the interacting constituent type NONE or the 
name of another constituent.

This question is repeated until all the interested interacting constituent(s) on a specific 
sublattice in the phase are specified, and finally an <Enter> is enforced.

Degree

Degree /#/: <Degree>

Degree is model-dependent. Specify an integer number (a value from 0 through 9) as the 
degree of composition-dependent interaction contribution for the phase parameter. This is 
valid for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), as well 
as for volume-related parameters (V0, VA, VC or VK).

For binary interaction parameters, the degree is usually the power in the Redlich-Kister 
expression. For ternary interaction parameters, it is usually the Hillert ternary index.

For a standard G parameter for a pure component (end-member) its degree should be always 0 
and this prompt should not display.

Phase 
parameter

After this prompt, the program echoes on the screen the full TP-Function of the phase 
parameter.

Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but 
entered as a negative number), for the current TP-Function. 

Function: <Definition for a function>

A TP-Function consists of terms in T and P.

& <Continuation of the definition for the current function>

Continuation of a TP-Function definition. 

High temperature limit /6000/: <High temperature limit in K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the 
lowest limit is entered as a negative number) for the current TP-Function.

Any more ranges? /N/: 

Enter Y for more function(s) or N to end this command.
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LIST_ALL_VARIABLES

This command is for the  PARROT module.

Create a list of the values and status of all variables in the PARROT workspace on screen or 
in a text file. After an optimization some statistical information is also written. The 
correlation matrix is written if that option is chosen. 

SET_OUTPUT_LEVELS.

Syntax LIST_ALL_VARIABLES

Prompt

Output to screen or file /Screen/: <File name>

A list of the current values and status, as well statistical information (if after optimization) and the 
correlation matrix (optionally), for all variables is written on screen (by pressing <Enter>) or on the 
list file under a specific file name which can later on be opened and edited by basic text editor.

 

Example
The following is the listed variables for the example TCEX36, after the first optimization when having 
set all variables available for optimization.

== OPTIMIZING VARIABLES ==

AVAILABLE VARIABLES ARE V1  TO V00

VAR.   VALUE             START VALUE       SCALING FACTOR    REL.STAND.DEV

V1      2.03729090E+04    2.03688352E+04    2.03688352E+04    3.41524152E+00

V2     -2.94286372E+01   -2.94286372E+01   -2.94286372E+01    2.37944771E+00

V11    -2.17373936E+04   -2.18095983E+04   -2.18095983E+04    3.97086303E-02

V12     1.52107184E+01    1.51660547E+01    1.51660547E+01    5.84552327E-02

V15     2.42082351E+04    2.45139169E+04    2.45139169E+04    5.00914471E+00

V16    -8.38723972E+00   -8.83460472E+00   -8.83460472E+00    1.60961318E+01

V17     3.08916533E+03    3.15802558E+03    3.15802558E+03    9.63738108E+00

V19     2.20292586E+04    2.21385673E+04    2.21385673E+04    4.14274011E+01  V20    -
7.04217974E+00   -7.22424882E+00   -7.22424882E+00    1.00561540E+02

NUMBER OF OPTIMIZING VARIABLES :   9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO

THE SUM OF SQUARES HAS CHANGED FROM   8.00002729E+04 TO   8.00002719E+04

DEGREES OF FREEDOM   45.  REDUCED SUM OF SQUARES   1.77778382E+03
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LIST_CONDITIONS

This command is for the  PARROT module.

Use this command to generate a list of the current values of optimization conditions, as well 
the current status of listing, either on screen or in a basic text file which can be opened and 
edited by a text editor.

Syntax LIST_CONDITIONS

Prompt
Output to screen or file /Screen/: <File name>

Press <Enter> to output to screen or on the list file under a specific file name. 
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LIST_PARAMETER

This command is for the  PARROT module.

There is also a Gibbs (GES) module  command with the same name.

List the TP-function(s) of a specific parameter for a phase. You must supply the name of the 
phase parameter:

The parameter name: <Identifier>(<Phase>,<Constituent array>;<Digit>)

For encrypted commercial databases, you may not be able to use this 
command to list any retrieved parameter.

Syntax LIST_PARAMETER 

Prompts

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of the 
general form: <identifier>(<phase>,<constituent array>;<digit>)

See About the ENTER_PARAMETER Command to learn how to define the parameter 
name.

If a parameter name is not acceptable or <Enter> is pressed, an error message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.

 
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA  or VC or VK>

Specify one of these types of legal identifiers. 

 
Phase name (/ABCD/): <Phase name>

Specify the phase name. 

 
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.

 

Interacting constituent (in sublattice  # /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the given phase; if there 
is no interacting constituent, press <Enter>. 

 

Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice site of the given phase, 
specify them; otherwise press <Enter>. 

 Degree /#/: <Degree>
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Syntax LIST_PARAMETER 

Specify a numerical number as the degree for the phase parameter.
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LIST_PHASE_DATA

This command is for the  PARROT module.

List all the phase from the Gibbs (GES) module for a specific phase. These are displayed on 
screen. The thermochemical parameters listed for each phase are always in SI units.

Syntax LIST_PHASE_DATA

Prompt
Phase name: <Phase name> 

Specify a phase name.
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LIST_RESULT

This command is for the  PARROT module.

List the result of the current optimization run on screen or in a specified file. The level of 
detail listed can be prescribed by the command SET_OUTPUT_LEVELS.

The LIST_RESULT command has an option G for creation of an experimental data file with 
two columns, one for the experimental value and the other for the calculated value. It allows 
plotting a diagram and visualizing the fitting results. The plot is automatically plotted and 
you can scale it giving commands in the POST module. The option D lists all experiments, 
including those with fulfilled inequalities which are suppressed with the default option C.

Syntax LIST_RESULT

Prompt Full, Condensed, Detailed or Graphic format: /C/: <C or D or F or G>

 

Choose a format. 

 l The F (full) format is obsolete but retained for backward compatibility.

 l C (condensed) is the default.

 l D (detailed) lists all experiments, including those with fulfilled inequalities (not included 
with the default condensed file).

 l The G (graphical) format creates an experimental data file containing two columns, one 
with the experimental value and the other with the calculated value. This allows plotting of 
a diagram where all symbols should be on the diagonal if the fit is perfect. The plot is 
automatically plotted and you can scale it giving commands in the POST module.

Output to screen or file /Screen/: <File name>

A list of the current optimization results are written on screen (by pressing <Enter>) or on the list file 
under a specific file name which can later on be opened and edited by basic text editor.

 

The output normally consists of these parts:

 l A title showing the data of the action;

 l A message on successful optimization with the iteration number in the last optimization;

 l A paragraph describing the optimization condition;

 l A list of the latest set of optimized and fixed variables;

 l A paragraph describing the optimization quality (some statistical information);

 l A correlation matrix for all optimizing variables (optionally shown, pre-set by the SET_
OUTPUT_LEVELS command);

 l A list of all parameters (including their symbol names, status and current values or function 
expressions), and all phase descriptions (including phase name, model names, constituents, 
and phase’s G/L/TC/BM expressions) predefined for each phase in the system (optionally 
shown, pre-set by the SET_OUTPUT_LEVELS command);

 l A paragraph describing the alternate equilibria (and possible error during optimization);
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Syntax LIST_RESULT

 l A detailed list on all the equilibrium points used in the current optimization. If the 
alternate-mode is used in the optimization, only an error value is shown. For normal-mode 
calculations, a list is shown for the experimental equilibrium numbers (first column) and 
corresponding original experimental data (second column, in the form quantity = value) 
which are used in optimization (i.e. non-zero weighted points). Such experimental data are 
by each point compared by the calculated value (third column) after the last optimization. 
Also listed are the experimental error (column 4), the difference between the calculated 
value and original experimental data (column 5), and the contribution to the sum of least 
square (column 6).

Example

The following is the listed result after the first optimization based on the prescribed 
definitions in the TCEX36a.TCM and TCEX36b.TCM, but having set all variables available for 
optimization.

=====================================================

           OUTPUT FROM P A R R O T.            

*** SUCCESSFUL OPTIMIZATION. ***      NUMBER OF ITERATIONS:  10

== OPTIMIZING CONDITIONS ==

   RELATIVE STANDARD DEVIATIONS FOR EXPERIMENTS: N

   MINIMUM SAVE ON FILE: Y

   ERROR FOR INEQUALITIES =  1.00000000E+00

   RELATIVE STEP FOR CALCULATION OF DERIVATIVES =  1.00000000E-04

ARGUMENTS FOR SUBROUTINE VA05AD (HSL)

   MAXFUN =   1   DMAX =  1.00000000E+02   H =  1.00000000E-04    ACC = (INITIAL 
SUM OF SQUARES) *  1.00000000E-03

== OPTIMIZING VARIABLES ==

AVAILABLE VARIABLES ARE V1  TO V00

VAR.   VALUE             START VALUE       SCALING FACTOR    REL.STAND.DEV

V1      2.03749463E+04    2.03729090E+04    2.03729090E+04    3.41455863E+00

V2     -2.94286372E+01   -2.94286372E+01   -2.94286372E+01    2.37944774E+00

V11    -2.17395673E+04   -2.17373936E+04   -2.17373936E+04    3.98405298E-02

V12     1.52107184E+01    1.52107184E+01    1.52107184E+01    5.82861832E-02

V15     2.42106560E+04    2.42082351E+04    2.42082351E+04    5.07239609E+00

V16    -8.38723972E+00   -8.38723972E+00   -8.38723972E+00    1.69546796E+01

V17     3.08947424E+03    3.08916533E+03    3.08916533E+03    9.85220694E+00
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V19     2.20314615E+04    2.20292586E+04    2.20292586E+04    4.16329629E+01  V20    
-7.04217974E+00   -7.04217974E+00   -7.04217974E+00    1.03161466E+02

NUMBER OF OPTIMIZING VARIABLES :   9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO

THE SUM OF SQUARES HAS CHANGED FROM   8.00002719E+04 TO   8.00002709E+04

DEGREES OF FREEDOM   45.  REDUCED SUM OF SQUARES   1.77778380E+03

Number of alternate equilibria           14

SYMBOL        STATUS   VALUE/FUNCTION

R         80000000  8.3145100E+00

RTLNP     20000000 +R*T*LN(1E-05*P)

V1        48000000  2.0374946E+04

V2        48000000 -2.9428637E+01

V11       48000000 -2.1739567E+04

V12       48000000  1.5210718E+01

V15       48000000  2.4210656E+04

V16       48000000 -8.3872397E+00

V17       48000000  3.0894742E+03

  21 V19       48000000  2.2031462E+04   22 V20       48000000 -7.0421797E+00

LIQUID

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU                              
CONSTITUENTS: A,B

      G(LIQUID,A;0)-G(BCC,A;0) =    500.00<T< 2000.00: +14000-10*T

      G(LIQUID,B;0)-G(BCC,B;0) =    500.00<T< 2000.00: +18000-12*T

      L(LIQUID,A,B;0) =    500.00<T< 2000.00: +V11+V12*T       L(LIQUID,A,B;1) =    
500.00<T< 2000.00: +V13+V14*T

A2B

  2 SUBLATTICES, SITES  2:  1     CONSTITUENTS: A : B

      G(A2B,A:B;0)- 2 G(BCC,A;0)-G(BCC,B;0) =

             500.00<T< 2000.00: +V1+V2*T+V3*T*LN(T)

BCC

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU                              
CONSTITUENTS: A,B

      G(BCC,A;0)-G(BCC,A;0) =    500.00<T< 2000.00: 0.0

      G(BCC,B;0)-G(BCC,B;0) =    500.00<T< 2000.00: 0.0

      L(BCC,A,B;0) =    500.00<T< 2000.00: +V15+V16*T

      L(BCC,A,B;1) =    500.00<T< 2000.00: +V17+V18*T

FCC
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EXCESS MODEL IS REDLICH-KISTER_MUGGIANU                              
CONSTITUENTS: A,B

      G(FCC,A;0)-G(BCC,A;0) =    500.00<T< 2000.00: 408

      G(FCC,B;0)-G(BCC,B;0) =    500.00<T< 2000.00: +3300-3*T

      L(FCC,A,B;0) =    500.00<T< 2000.00: +V19+V20*T

      L(FCC,A,B;1) =    500.00<T< 2000.00: +V21+V22*T

======  BLOCK NUMBER  1

DEFINED CONSTANTS

    DX=2E-2, P0=101325, DH=500, DT=10

DEFINED FUNCTIONS AND VARIABLES%

    HTR=HM(LIQUID)-HM(A2B)

Alternate equilibrium calculation                  0.4183

Alternate equilibrium calculation                  0.1932

Alternate equilibrium calculation                  0.1016

Alternate equilibrium calculation                  1.4354E-03

Alternate equilibrium calculation                  2.5063E-02

Alternate equilibrium calculation                  8.3929E-03

Alternate equilibrium calculation                   141.4

Alternate equilibrium calculation                   141.4

Alternate equilibrium calculation                   141.4

Alternate equilibrium calculation                   141.4

Alternate equilibrium calculation                  1.2532E-03

Alternate equilibrium calculation                  5.4781E-04

Alternate equilibrium calculation                  1.5404E-03

Alternate equilibrium calculation                  1.2702E-03

ACR(B)=9.4E-1                0.9397      2.85E-02 -2.7745E-04 -9.7472E-03

ACR(B)=8.4E-1                0.8395      2.82E-02 -4.9038E-04 -1.7396E-02

ACR(B)=7.4E-1                0.7407      2.81E-02  7.3804E-04  2.6305E-02

ACR(B)=6.4E-1                0.6424      2.81E-02  2.3935E-03  8.5272E-02

ACR(B)=5.4E-1                0.5434      2.82E-02  3.4449E-03  0.1220

ACR(B)=4.4E-1                0.4428      2.85E-02  2.8265E-03  9.9024E-02

ACR(B)=3.4E-1                0.3394      2.90E-02 -5.8174E-04 -2.0040E-02

ACR(B)=2.3E-1                0.2320      2.97E-02  2.0260E-03  6.8208E-02

ACR(B)=1.2E-1                0.1194      3.06E-02 -6.4192E-04 -2.0981E-02

HMR(LIQUID)=-1964            -1957.      5.00E+02   7.439      1.4878E-02

HMR(LIQUID)=-3500            -3478.      5.00E+02   21.67      4.3338E-02
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HMR(LIQUID)=-4588            -4565.      5.00E+02   22.69      4.5382E-02

HMR(LIQUID)=-5239            -5217.      5.00E+02   21.50      4.3008E-02

HMR(LIQUID)=-5454            -5435.      5.00E+02   19.11      3.8216E-02

HMR(LIQUID)=-5233            -5217.      5.00E+02   15.50      3.1008E-02

HMR(LIQUID)=-4575            -4565.      5.00E+02   9.691      1.9382E-02

HMR(LIQUID)=-3481            -3478.      5.00E+02   2.669      5.3385E-03   118 
HMR(LIQUID)=-1950            -1957.      5.00E+02  -6.561     -1.3122E-02
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LIST_STORE_FILE

This command is for the  PARROT module.

Use the LIST_STORE_FILE command to display the name of the store file and its full path.
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LIST_SYMBOL_IN_GES

This command is for the  PARROT module.

Lists TP-function(s) for the entered model parameters for phases in the system on screen. In 
many cases, the optimizing variables are parts of the TP-functions which in turn are entered 
in model parameters for various phases in the GIBBS workspace.

This command is a way to find out how the functions depend on the optimizing variables. In 
the PARROT module the list is only shown on screen, not written to any file (which the LIST_
SYMBOL command in the GIBBS module does). 

Syntax LIST_SYMBOL_IN_GES

Prompt

Name: <Symbol name>

Specify a symbol name. 

Only those symbols that match this name are listed. Or press <Enter> for a list of all 
available symbols entered in the system.
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OPTIMIZE_VARIABLES

This command is for the  PARROT module.

Perform variable optimization. All system-definition data needed for the optimization is read 
from the current work file (*.PAR). The result of the optimization is automatically stored in 
the current work file.

Syntax OPTIMIZE_VARIABLES

Prompt

Number of iteration /N/: <Integral number of iteration>

Specify an integral number for the optimization iteration. The specified iteration number is shown as 
the default number. The PARROT module tries this number of different sets of values of the 
optimizing variables unless it has converged earlier, or has given up earlier. 

 
It initially takes a small step in each variable to find the steepest slope. You can give 
zero iteration to calculate the error in all selected experiments, and then use LIST_
RESULT to check how good (bad) the current fit is.
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READ_PARROT_WORKSPACES

This command is for the  PARROT module.

Workspace Files

Read the previous PARROT/GIBBS/POLY workspaces back to replace the current 
PARROT/GIBBS/POLY workspaces. It is useful if late changes made through various 
PARROT/GIBBS/POLY commands are not satisfactory.

Syntax READ_PARROT_WORKSPACES

 

The previous PARROT/GIBBS/POLY workspaces are always associated with the latest action to either 
open a work file by SET_STORE_FILE, or to create a work file by CREATE_NEW_STORE_FILE (either 
interactively in the PARROT module or through a MACRO_FILE_OPEN of an *SETUP.TCM file), or to 
update the work file by SAVE_PARROT_WORKSPACES.

 
Unlike the READ commands in other modules (e.g. GIBBS or PLOY), this command in the PARROT 
module does not ask for the file name where to read a previously opened/created/updated 
PARROT/GIBBS/POLY workspaces, for the reason described above. 

 You cannot use this command if there is no work file opened or created already.
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RECOVER_VARIABLES

The RECOVER_VARIABLES command is used to set back the values of all variable to the start 
values.
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REINITIATE

This command should not be used unless you want to destroy the current 
PARROT workspace. However, this PARROT command does not reinitiate the 
GIBBS/POLY3 workspaces.

This command is for the  PARROT module.

The REINITIATE command is used to reinitiate the workspace used by PARROT. All output and 
optimizing conditions are given their default values. All variables are set fixed with their 
value equal to zero. 
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RESCALE_VARIABLES

When using the RESCALE_VARIABLES command, the current values of all the parameters are 
copied to their start values and the scaling factors for further optimization. Thus it should be 
done now and again, in particular if you think the optimization results are improved after 
the previous run(s), or if any variable changes more than a factor of 10.
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SAVE_PARROT_WORKSPACES

This command is for the  PARROT module.

If the latest changes made through various PARROT/GIBBS/POLY commands are as required, 
use this command to save the current workspace (i.e. data area) used by the PARROT 
program (also including the current GIBBS and POLY workspaces), onto the present work 
*.PAR file which has already been opened by SET_STORE_FILE or been created by CREATE_
NEW_STORE_FILE (either interactively in the PARROT module or through a MACRO_FILE_OPEN 
of an *SETUP.TCM file).

The PARROT/GIBBS/POLY workspaces are updated after each 
PARROT/GIBBS/POLY command. This means the current PARROT/GIBBS/POLY 
workspaces are always updated onto the latest work *.PAR file that is 
associated with the latest SET_STORE_FILE or CREATE_NEW_STORE_FILE 
command.

Workspace Files

Syntax SAVE_PARROT_WORKSPACE

 

Unlike the SAVE commands in other modules (e.g. GIBBS or PLOY), this command in 
the PARROT module does not ask for the file name where to save the current 
PARROT/GIBBS/POLY workspaces, for the reason described above. You cannot use 
this command if there is no work *.PAR file opened or created already.
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SET_ALTERNATE_MODE

Turn the alternate mode on or off. 

With the ALTERNATE mode is possible to include functions to be evaluated together with an 
alternate calculation and to select ALTERNATE mode for each experimental equilibrium.

The alternate mode is described in About Alternate Mode. It should be used 
only to optimize start values of the model parameters in the beginning of the 
assessment. 

Syntax SET_ALTERNATE_MODE

Prompt
On /Y/: 

By default alternate mode is ON. 
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SET_EXTERNAL_PARAMETER

This command is for the  PARROT module.

Optimize model parameters of the so-called external models, which may not be as fully-
implemented/integrated parts inside the GIBBS system and thus are independently defined 
within user-specified/written source codes. This command makes links between the PARROT 
optimizing variables and external model parameters.

In order to be able to build the specified external model and to use this SET_
EXTERNAL_PARAMETER command, it requires you to first write codes for a 
preferred external model (as it is not within the standard GIBBS system of the 
Thermo-Calc software) and then provide it to a consultant at Thermo-Calc 
Software AB for the purpose of including the external model in a separate DLL 
that is interactively connected to the software. For more information, see 
theConsultancy page on our website.

Syntax SET_EXTERNAL_PARAMETER

Prompt
External name: <Parameter name in the external model>

Correctly specify the parameter name defined within a specified/written external model.

 

As optimizing variable number: <n>

Give the number of the PARROT optimizing variable, which should have a unique link to the specified 
parameter name of the external model.

For example, @@ Link PARROT variables to CAM parameters:

SET-EXTER-PAR GT(SLAG_A,O-2,SI+4,CA+2) 1

SET-EXTER-PAR ET(SLAG_A,O-2,SI+4,CA+2) 2

SET-EXTER-PAR EXT(SLAG_A,O-2,SI+4,CA+2) 3

https://thermocalc.com/consultancy/
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SET_FIX_VARIABLE

Prescribe a fixed value to a variable. The variable is considered as a constant at the 
optimization, usually after successful optimization runs for some specific variables (for some 
of the phases in the system). Such fixed variables can also be set back for further 
optimization run by using SET_OPTIMIZING_VARIABLE.

Syntax SET_FIX_VARIABLE

Prompts

Variable number: <Variable number(s)>

Specify the number of the variable. It is possible to give a range by giving two numbers with a 
hyphen in between (no spaces allowed), e.g. l. The parameters within the limits are set fixed to 
their current values (no question of values).

 

Start value /xxxx.xxxxx/: <A value to be fixed>

Specify a numerical value to be fixed for the selected variable (only when one variable number is 
specified at the previous prompt). The current value for the selected variable is shown as default.

If a range of variable numbers is specified at the previous prompt, this question is not prompted, 
and the current values are used as fixed values.
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SET_OPTIMIZING_CONDITION

This command is for the  PARROT module.

Specify the conditions for the optimization. The default values are chosen automatically by 
the PARROT program, and in most cases these should not be changed.

The optimization stops when the sum of errors decreases by this value, even 
though it might be possible to increase it further with a new OPTIMIZE 
command.

Syntax SET_OPTIMIZING_CONDITION

 

Relative standard deviation for experiments? /N/: 

By default the standard deviation of the experimental determinations are absolute values. Enter Y if 
these are used as relative weighting factors. 

The estimated standard deviations of the optimized variables might be different for 
the two cases.

Prompt

Min save on file? /Y/: 

Specify whether the program should minimize the transfer of data to and from the current work file 
during the optimization:

 l If the default (N) is kept, the workspaces are stored on the current work file after every 
iteration in the optimization procedure.

 l Enter Y to speed up the optimization. After optimization use the SAVE_PARROT_WORKSPACES 
command to update the progress onto the current work file.

 

Relative step for calculation of derivatives: /1e-04/: <xxx>

In the calculation of the correlation matrix for equilibria with inaccuracy in the independent state 
variables, some numerical derivatives might have to be calculated.

Specify the relative step (xxx) for the calculation of these derivatives.

 

Maxfun (va05ad): /100/: <n>

The maximum number of iterations in the optimization. The same value set by the OPTIMIZE 
command.

 

Dmax (va05ad): /100/: <n>

An estimate of the maximum distance between the start and the final values of the variables. A 
smaller value makes the program vary the parameters with smaller factors.
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Syntax SET_OPTIMIZING_CONDITION

 
H (va05ad): /1e-04/: <xxx>

The step used in the scaled variables for calculating numerical derivatives during the optimization.

 

Acc/(initial sum of squares) (va05ad): /.001/: <xxx>

The break condition for the optimization. The accepted value is the difference between the true 
minimum and the calculated one. 
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SET_OPTIMIZING_VARIABLE

This command is for the  PARROT module.

Specify which variable value should be estimated at the optimization. Such a variable can 
have a value of zero or another start value, or is fixed by SET_FIX_VARIABLE prior to the 
previous optimization run. 

For a good reference prior to this command, a list of all variables (which are used to define 
various parameters for phases in the optimizing system, as pre-entered in the *SETUP.TCM 
file or interactively entered in the GIBBS module) are obtained by using LIST_ALL_VARIABLES.

Syntax SET_OPTIMIZING_VARIABLE

Prompts

Variable number: <Variable number(s)>

Specify the number(s) for the variable(s) to be set. Any non-zero parameter within the range is 
allowed to be optimized. A parameter with a current value equal to zero must be specified explicitly 
here in order to be optimized.

Specify a range by giving two numbers connected by a hyphen (no space allowed!), e.g. 2-8. Under 
this circumstance, no question of start values are asked.

 

Start value /xxxx.xxxxx/: <A guess value>

Specify a start guess of the optimum value (only when one variable number is specified at the 
previous prompt). The current numerical value for the selected variable is shown as default.

This guess is critical as the initial guess of all parameters must make it possible to 
calculate the selected equilibria. If a range of variable numbers is specified at the 
previous prompt, this question is not prompted, and the current values (as start 
values) are not changed.
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SET_OUTPUT_LEVELS

This command is for the  PARROT module.

Choose the type of information the PARROT module gives during the optimization procedure 
and when listing results.

Syntax SET_OUTPUT_LEVELS

Prompts

List increment /1/: <Increment in iteration number>

Specify the increment in iteration number for which information is listed on screen during the 
optimization. By giving a larger number it shortens the list.

 
List sum of squares: /Y/:

Choose whether the sum of squares is listed on screen during the optimization procedure.

 

List scaled variables: /Y/: 

Choose whether the scaled variable values are listed on the terminal during the optimization 
procedure.

 

List weighted residuals: /N/: 

Choose whether the weighted residuals are listed on the terminal during the optimization 
procedure.

 
List all parameters: /N/: 

Choose whether all parameters in the models are listed in LIST_RESULT.

 

List correlation matrix: /N/: 

Choose whether the correlation matrix of the variables are listed with the commands LIST_RESULT 
and LIST_ALL_VARIABLES.
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SET_SCALED_VARIABLE

This command is similar to SET_OPTIMIZING_VARIABLE in that it specifies start values for 
optimizing variables. The difference being it is functional for only one optimizing variable at 
one time. It also prescribes a minimum and maximum value for the variable. During the 
optimization runs, the variable value is limited within this min-max range.

Such a variable may have a value of zero or another start value, or may be fixed by SET_FIX_
VARIABLE prior to the previous optimization run. For a good reference prior to using this 
command, a list of all variables (which are used to define various parameters for phases in 
the optimizing system, as entered in the *SETUP.TCM file or interactively entered in the 
GIBBS module) is obtained by using LIST_ALL_VARIABLES.

Syntax SET_SCALED_VARIABLE

Prompts

Variable number: <Variable number(s)>

Specify the number for an optimizing variable to be set. Any non-zero parameter is allowed to be 
optimized, and a parameter with a current value equal to zero must be specified explicitly here in 
order to be optimized.

 

Start value /xxxx.xxxxx/: <A guess value>

Specify a start guess of the optimum value. The current numerical value for the selected variable is 
shown as default.

This guess is critical as the initial guess of all parameters must make it possible to 
calculate the selected equilibria.

 

Min value /xxxx.xxxxx/: <A guess value>

Specify a minimum guess of the optimum value. It should be smaller than, at least equal to, the 
current start value for the selected variable.

 

Max value /xxxx.xxxxx/: <A guess value>

Specify a maximum guess of the optimum value. It should be larger than, at least equal to, the 
current start value for the selected variable.
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SET_STORE_FILE

This command is for the  PARROT module.

Specify a store file (work file) to be used for compilation and optimization. The *.PAR work 
file must be created (CREATE_NEW_STORE_FILE) as a store file. The GIBBS, POLY and PARROT 
workspaces are read from the specified store file (with a default extension of PAR).

Syntax SET_STORE_FILE 

Prompt
Enter a *.PAR file name in the File name field and specify the working directory in the Look in field. 
Normally the default file-type in the Files of type field is the correct one for the PARROT workspace 
format (i.e. *.PAR file). Click Open or Cancel as applicable.
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EDIT_EXPERIMENTS (ED_EXP) Submodule Commands

EDIT_EXPERIMENTS (ED-EXP) is a submodule of PARROT. 

In this section:

ADVANCED_OPTIONS 412

CHANGE_STATUS 413

COMMENT 418

COMPUTE_ALL_EQUILIBRIA 419

CREATE_NEW_EQUILIBRIUM 420

DEFINE_COMPONENTS 421

DELETE_SYMBOL 422

ENTER_SYMBOL 423

EVALUATE_FUNCTIONS 426

EXPERIMENT 427

EXPORT 429

FLUSH_BUFFER 430

GRAPHICS_PLOT 431

IMPORT 432

LABEL_DATA 433

LIST_ALL_EQUILIBRIA 434

LIST_CONDITIONS 435

LIST_EQUILIBRIUM 436

LIST_STATUS 437

LIST_SYMBOLS 438

MAKE_POP_FILE 439
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READ_WORKSPACES 440

REINITIATE_MODULE 441

RESTORE_ALL_WEIGHTS 442

SAVE_WORKSPACES 443

SELECT_EQUILIBRIUM 444

SET_ALL_START_VALUES 445

SET_ALTERNATE_CONDITION 447

SET_CONDITION 450

SET_NUMERICAL_LIMITS 453

SET_REFERENCE_STATE 455

SET_START_CONSTITUTION 457

SET_START_VALUE 458

SET_WEIGHT 459

SHOW_VALUE 461

STORE_ALL_WEIGHTS 462

TABLE_HEAD, TABLE_VALUES and TABLE_END 463

TRANSFER_START_VALUES 465
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ADVANCED_OPTIONS

This command is available with the POLY and ED-EXP modules.

ADVANCED_OPTIONS described for the POLY module.

Syntax ADVANCED_OPTIONS

Prompt Which option? /Step_and_Map/:  <Option>
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CHANGE_STATUS

This command is available with the POLY and ED-EXP modules.

In the POLY module, set the status for components, species and phases in the defined 
system for all the sequential calculations (single-point, stepping, and mapping) in 
equilibrium or local/partial equilibrium state. Each component, species and phase has a 
status. The default status is ENTERED.

The most important use is to calculate metastable equilibria and metastable phase diagrams 
by setting some phases (that would otherwise be stable) to the SUSPENDED or DORMANT 
phase-status. Another important applications is to calculate paraequilibria by setting some 
components to the SPECIAL component-status.

For a component and for a species, the status can be one of the following:

 l ENTERED: the component(s) or species are included in the calculation. This is the 
default status.

 l SUSPENDED: the component(s) or species are not considered in the calculation.
 l SPECIAL: the specified component(s) are not included in summations for mole or 

mass fractions. It only works for component(s).

Only component(s) can have the status SPECIAL, which implies that these are 
not included in summations for mole or mass fractions. 

For example, for the u-fractions or other normalized fractions, when one or more of the 
components are excluded from the summation, you must specify which component(s) 
should be excluded from the calculation of mole or mass fraction. This component status is 
particularly useful when calculating paraequilibrium states. Such component(s) are normally 
interstitial component, and must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command.

Syntax CHANGE_STATUS 

Prompts
For phases, species or components? /Phases/: <Keyword>

Keyword = phase or species or components

 

Phase name(s): <Name(s) of the phase(s)>

For phase as the keyword, the names of the phases that have their status changed must be given 
(all on one line). A comma or space must be used as separator. The status to be assigned to the 
phases can also be given on the same line if preceded with an equal sign (=). 
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Syntax CHANGE_STATUS 

An asterisk, *, can be used to denote all phases. The special notations *S, i.e. a 
wildcard * directly followed by an S, sign, means all suspended phases. In the same 
way, *D means all dormant phases, and *E means all entered phases.

 

Name(s): <Name(s) of the Species or Component(s)>

For species or components as the keyword, the names of the species or components that have their 
status changed must be given (all on one line). A comma or space must be used as separator. 
Similarly to the case of phase as the keyword, the status to be assigned to the species or 
components can also be given on the same line if preceded with an equal sign =. 

An asterisk, *, can be used to denote all species or components. The special 
notations *S, i.e. a wildcard * directly followed by an S, sign, means all suspended 
species or components. In the same way, *E means all entered species or 
components.

 

Status /Entered/: <New status>

The new status to be assigned must be given.

For species, the values ENTERED or SUSPENDED can be used.

For the POLY module, using the Entered or Suspended status here has the same 
result as using the commands MAKE_COMPONENT_ENTERED and MAKE_
COMPONENT_SUSPENDED. The  exception is that any existing conditions that 
depend on a suspended component are removed when using the MAKE_
COMPONENT_SUSPENDED command.

For components, the status ENTERED, SUSPENDED or SPECIAL can be given. SPECIAL means that this 
component is excluded from sums for mole fractions and mass fractions, which is useful when 
calculating the ufractions or other normalized fractions of system components.

For phases, the status ENTERED, SUSPENDED, DORMANT or FIXED can be given. DORMANT means the 
same as suspended but the driving force is calculated. FIXED means that it is a condition that the 
phase is stable at a certain amount.

For example, for the ufractions, when one or more of the components are excluded from the 
summation, you must specify which component should be excluded from the calculation of the 
mole fraction. This component must have the status SPECIAL. This is assigned by the CHANGE_STATUS 
command: Change_Status comp C=special.

 

Start value, number of mole formula units /0/: <Initial amount>

For ENTERED phases, an initial amount of the phase can be given. Normally, 0 is given if the 
phase is not likely to be stable, and 0.5 or 1 or any positive number if the phase could be stable, but 
such an initial amount is only used as the rough starting estimation in the equilibrium calculations.

 Number of mole formula units /0/: <Equilibrium amount>
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Syntax CHANGE_STATUS 

For FIXED phases, the equilibrium amount of the phase [always using an initial estimation being 
the NPF(phase) value which it is the normalized mole number of components (per mole formula 
unit) of the specific status-fixed phase] must be given. If the equilibrium amount is zero, then the 
phase is at its stability limit.

NOTE WHEN SPECIFYING A FIXED PHASE STATUS

Special attention should be paid when specifying a FIXED phase status in equilibrium calculations 
(for single points, stepping or mapping calculations), as described below.

The phase amount variables, NP(phase), BP(phase) and VP(phase), as well as all their M/W/V-
suffixed quantities, should not be used as conditions. Instead, use the CHANGE_STATUS command 
to set a relevant condition, e.g. CHANGE_STATUS phase <phase>=fix <amount> where the fixed 
<amount> is roughly the same as the F-suffixed quantity NPF(phase).

The NPF(phase) quantity is the normalized mole number of components (per mole formula unit) of 
the specific phase in the defined system, which unlike other F-suffixed state variables [e.g. GF
(phase), HF(phase) and DGF(phase)] cannot be directly applied in any POLY command, implying that 
it cannot be directly evaluated or listed/shown. If intended to shown such a normalized phase 
amount value in an equilibrium state, you should use a properly-entered symbol (function or 
variable), for example: NPFabc = NP(abc)/NA or NPFabc = NPM(abc)/NA*N. N is the total system 
size (in mole). The NA value is a quantity that is phase-dependent (and sometimes also equilibrium-
dependent for ionic solution phases), and is the total atomic number in a mole-formula-unit of the 
specific phase abc (excluding interstitial component and, of course, vacancy).  For example, the 
SIGMA, FCC, BCC and LIQUID phases (among others) in a defined Fe-Cr-Ni-C-N-O system (retrieved 
from a specific database) may be modeled by certain models, and their NA values must be 
evaluated in different ways, as described below:

LIQUID (C,Cr,CrO3/2,Fe,FeO,FEO3/2,N,Ni,NiO)1  NA = 1

FCC_A1 (Cr,Fe,Ni)1(Va,C,N,O)1 NA = 1

BCC_A2 (Cr,Fe,Ni)1(Va,C,N,O)3 NA = 1

SIGMA (Fe,Ni)8(Cr)4(Cr,Fe,Ni)18 NA = 30

If in the same Fe-Cr-Ni-C-N-O system the liquid solution phase is modeled by the Two-Sublattice 
Ionic Liquid Model, i.e.:

IONIC_LIQ  (Cr+3,Fe+2,Ni+2)p(VA,C,N,O-2,FEO3/2)q,7

then the evaluation of its NA value becomes even more complicated:

NA = p + q*yC2 + q*yN2 + q*yO2-2 + q*yFeO2 3/ 2

where the stoichiometric coefficients p and q are also dependent upon the real equilibrium state 
(rather than having fixed values in the system). Similar situations occur for other (solid) phases 
which are described by a multiple sublattice model with ionic constituents, such as SPINEL and 
HALITE phases in some databases.

There is no strange thing when using a zero value [i.e. 0] in a FIXED phase-status, since it means the 
specified phase is stable in equilibrium state but has a zero-amount of mass in the equilibrium 
calculations; in other words, on a phase diagram, the specific phase is on a zero-fraction line (ZFL), 
i.e. it starts becoming stable on one side of a corresponding phase-boundary line or unstable on the 
other side of the same boundary. It is often and efficient to do so when calculating e.g. solidus 
equilibrium states.

However, when a non-zero value [it must always be positive; e.g. 1 or 0.5 or 0.3 or 1.5] is to be 
specified in a FIXED phase-status, it is unnecessarily the exactly same stable amount of the specific 
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Syntax CHANGE_STATUS 

FIXED-status phase in a calculated equilibrium state any longer; instead, the <equilibrium amount> 
value is the NPF(phase) value that is only roughly used as the estimated starting-value of the FIXED-
status phase in the equilibrium calculations.

Therefore, a FIXED-status for a liquid phase being unity does not necessarily imply that it is a 
liquidus equilibrium state (where the liquid phase is in equilibrium with some solid phases but the 
liquid phase takes all the mass in the defined system). A unity value for setting the liquid phase 
status in calculating liquidus equilibrium state can only be used when the liquid mixture phase is 
predefined as a single-sublattice solution phase (such as metallic liquid phase in multicomponent 
alloy systems) and the total system size as one mole (i.e. N=1).

When a phase is described by a solution model in which two or more sublattices are considered and 
these sublattice sites may also have different stoichiometric coefficients [meaning that the mixture 
phase could have more than one atom in formula [NA>1; see some examples above], the unity 
value should not be used when setting the FIXED status for the phase; instead, you should use an 
appropriate value that ranges from 0 to a NPF(phase) value that equals to or is smaller than 1/NA (if 
the total system size N=1) or 1/NA*N (if N differs from unity). For this reason, if a multicomponent 
system bears an IONIC_LIQUID phase that is described by the Two-Sublattice Ionic Liquid Model (or 
any other multiple-sublattice ionic solution phases), it is difficult to use a proper NPF(ION_LIQ) 
value in setting its FIXED phase-status, because that should be less than (or equal to) the complex 
value of

N/[p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2 ].

Examples

For example, to obtain the metallic fraction in a system with carbon as an interstitial 
component, you can set the component status for carbon as SPECIAL:

Change_Status comp C=special

The SUSPENDED status for components and species does not always work as 
expected.

For a phase, it may have one of these statues:

 l ENTERED: the phase(s) are included in the equilibrium calculations and these are 
stable if that minimizes the total Gibbs energy in the defined system. This is the 
default status for all phases already retrieved from the chosen database(s). An 
ENTERED phase-status is always associated with an initially-estimated amount [in 
mole number; normally, as 0 if the phase is not likely to be stable, and as 0.5 or 1 or 
any positive number if the phase could be stable] but it is only used as the rough 
starting value in the equilibrium calculations.
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 l SUSPENDED: the phase(s) are not considered in the equilibrium calculations.
 l DORMANT: the phase(s) are not considered in the equilibrium calculations but their 

driving forces for precipitation are calculated.
 l FIXED: it is an equilibrium condition that the status-fixed phase must be stable, and 

be in equilibrium at a specified amount [always using an initial estimation being the 
NPF(phase) value which it is the normalized mole number of components (per mole 
formula unit) of the specific status-fixed phase]. See more descriptions at the end of 
this command.
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COMMENT

This command is for the ED-EXP module.

The COMMENT command is only used in the *.POP/*.DOP files (so can be included with 
experimental data files) to write brief comments or descriptive information on a newly 
created equilibrium (experimental) data point or a set of points given in a table. 

A comment can have a maximum of about 60 characters written on the same line.
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COMPUTE_ALL_EQUILIBRIA

This command is for the ED-EXP module.

In ED_EXP and PARROT modules, each experiment is treated as an individual equilibrium 
with some measured values. These are created with CREATE_NEW_EQUILIBRIUM, and stored in 
an experimental data *.POP file and then compiled and saved in the POLY workspace of a 
PARROT work *.PAR file.

In the DICTRA module, you work with a .DOP file instead of a .POP file.

With COMPUTE-ALL-EQUILIBRIA, all equilibria from the current to the last experimental 
points are calculated. If an equilibrium calculation fails, the calculation is stopped at that 
equilibrium. Equilibria with weight zero is skipped.

A current or present experimental point means the latest selected or calculated 
one. Once used the current point turns to the last point in the data block; in 
such a case you first use SELECT_EQUILIBRIUM so that the current point is 
switched to a desired one.

For this command there is always a list output on screen, which consists of six columns for 
all experimental points available in the current data block:

 l The first column is the equilibrium identifier (a number) assigned by this command, 
 l the second the data label assigned with LABEL_DATA, 
 l the third the number of iterations, 
 l the fourth the current weight, and 
 l the fifth the current temperature. 
 l In the sixth column the fixed stable phases are listed together with any comment text 

given after a COMMENT in the *.POP or *.DOP file.

If the weight is zero for an equilibrium columns 3-5 are replaced by the text <unused>. If the 
alternate mode is used for some experimental points, the listing is slightly different for such 
points. The 3-4 columns are displayed with *alt*, instead. If an alternate calculation is failed 
at one experimental point, the point is automatically assigned with a zero weight, and a 
warning message is shown above the data line (with all six columns).
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CREATE_NEW_EQUILIBRIUM

This command is available with the POLY and ED-EXP modules.

During data-assessments using the ED_EXP module (a submodule of PARROT), you can, in 
the POLY module, create several equilibria with different sets of conditions and phases (but 
normally with the same set of components). By default, there is one equilibrium. To keep 
the set of conditions and phase for this equilibrium, create another one using this command, 
and use another set of conditions for that. Two equilibria may be useful to calculate easily 
the enthalpy difference between two states. In the PARROT module, the experimental 
information is stored as a sequence of equilibria.

Syntax CREATE_NEW_EQUILIBRIUM

Prompts

Equilibrium number /2/: <A new equilibrium number>

Each equilibrium in the POLY workspace is identified by a unique integer number. Such an 
equilibrium number can be recalled with SELECT_EQUILIBRIUM.

 

Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all components and phases (initiation 
code 2), ENTER the components only (initiation code 1) or SUSPEND everything (initiation code 0). No 
other values are legal. 

The entered components and phases can later be changed with CHANGE_STATUS.
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DEFINE_COMPONENTS

This command is available with the POLY and ED-EXP modules.

Change the set of components. By default, the elements are used as components. The set of 
components can be important because some conditions are set using components, for 
example, the amounts, activities or chemical potentials.

For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components, 
thus replacing the default FE, SI and O.

This implies a command REINITIATE_MODULE and it should be given as the first 
command in the POLY module.

Syntax DEFINE_COMPONENTS 

Prompt

Give all new components / existing components/: <New components>

The new components must be specified all on one line. These replace the existing component 
definitions. 

The number of components cannot be changed with this command. Use CHANGE_
STATUS instead.

 

To keep some existing components, it is recommended that you also enter these on the line. 
Otherwise, the added new components may not be defined correctly. This is especially important if 
some components are built out of several elements.

The new components do not have to be present as species. 
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DELETE_SYMBOL

This command is available with the POLY and ED-EXP modules.

Use the DELETE_SYMBOL command to remove symbols i.e. constants, variables, functions or 
tables. 

Syntax DELETE_SYMBOL 

Prompt
Name: <Name of a symbol>

Specify the name of the symbol to be deleted. Only one symbol can be deleted each time.
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ENTER_SYMBOL

This command is for the ED-EXP module.

The GES, POLY and POST modules also have a command with the same name.

Symbols are a useful feature modules to define quantities that are convenient. Symbols can 
be constants, variables, functions, or tables.

Syntax ENTER_SYMBOL

Prompt

Constant, Variable, Function or Table? /Function/: <Keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION, or TABLE.

 l CONSTANTS can only be entered once and is a means of using a name for a numeric value. 
For example, the value of 1 atmosphere in Pascal can be denoted by P0 after the command 
ENTER_CONSTANT P0=101325. Defined constants can be used as values in condition 
assignments, for example, SET-COND P=P0.

 l FUNCTIONS are expressions of state variables or other functions. These expressions are 
saved, and whenever a function value is requested all functions are evaluated. The reason 
for this is that they may depend on each other.

 l VARIABLES are similar to functions because they can also be expressions of state variables. 
However, contrary to functions, they are only evaluated when they are entered or if they 
are explicitly named in an EVALUATE_FUNCTIONS command. It is possible to enter a variable 
with a new expression any time. This expression is evaluated directly and its value stored as 
the value of the variable. Defined variables can be used as values in the SET_CONDITION 
command.

 l TABLES are used for listing results from the STEP or MAP commands. A table consists of a 
list of any number of state variables, functions, or variables. Defined tables can also be used 
in the POST (post-processor) module.

There is a special connection between tables and variables. If a variable is used in a 
table, it is evaluated for each line of the table in the TABULATE command or when the 
table is used in a plot.

 

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 
8 characters.  Legal characters include letters (either UPPER or lower case), digits and 
underscore _. Any other special character, such as parentheses ( and ), plus +, minus 
-, slash / or \, full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line; these must be separated 
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Syntax ENTER_SYMBOL

with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a definition of 
temperature in Celsius. Otherwise, these questions are asked.

For different types of symbols (constant, function, variable, or table), the questions 
have different prompts.

 

Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or other functions, 
constants, or variables. The expression is a FORTRAN-like expression and operators +,  -, *, = and ** 
can be used (** only with integer powers). 

Unary functions like LOG, LOG10, EXP, SIN, COS, and ERF can also be used. An expression can be 
continued on more than one line. An expression should be terminated by a semicolon (;) or an 
empty line (press <Enter> at the next prompt). 

Examples of function expressions:

 l GM(LIQUID): The Gibbs energy of liquid per mole component

 l H.T/4.184: The heat capacity of the system in calories

 l ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

 l T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is 
not enough for the function. If you finish the function press <Enter> again.

 
Value: <Value for a constant>

A constant can only be assigned a numeric value once.

 

Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is evaluated immediately 
and discarded. Only the numeric value is kept. This gives a possibility to save a value between 
calculations with different conditions because all state variables and functions are evaluated for the 
new conditions.

 

Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP 
command is through a table.  

Example:

ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole fractions 
of C and Cr in the LIQUID phase, and the activity of C.

To show the temperature in Celsius in a table, give the command ENTER_FUNCTION TC=T-273; and 
then use the symbol TC in the table.

& <Continuation of the definition for the table>
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Syntax ENTER_SYMBOL

The ampersand & means that you can continue to write the table on the new line if one line is not 
enough for the table. If you finish the table press <Enter> again.
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EVALUATE_FUNCTIONS

This command is available with the POLY and ED-EXP modules.

The value of one or more or all entered functions or variables are evaluated and listed. 

Syntax EVALUATE_FUNCTIONS 

Prompt

Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By typing a wildcard *, 
all functions and variables are evaluated.

Variables are evaluated only if these are explicitly named.
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EXPERIMENT

This command is for the ED-EXP module.

This command is used in original experimental data files (*.POP or *.DOP), but 
can also be given interactively inside the ED-EXP module, to change the value or 
uncertainty of an experiment or to add more experimental information. 

In the DICTRA module, you work with a .DOP file instead of a .POP file.

An experiment usually consists of two parts with a colon (:) separating them: 

 l as a quantity relation, and 
 l as the uncertainty of the value for the quantity, 

The quantity relation can be a normal POLY module condition or an inequality (which is 
similar to condition but the relation between the quantity and given value is not in equality, 
i.e. < or >). The uncertainty can be expressed as an absolute value or relative to the value 
(x%).

An experiment that uses an inequality gives zero contribution to the sum of 
errors in the optimization procedure of PARROT if the value is on the right side. 
If the value is on the wrong side, the value after the colon determines how 
steeply the error increases with the value.

Syntax EXPERIMENT 

 

The experiment must be typed after the command. Several experiments can be given on the same 
line.

The syntax of EXPERIMENT is similar to a CONDITION. Usually, a state variable set equal to a value 
with a given uncertainty is specified after the colon (:). For example, T=1273.15:5.

An inequality, < or >, can also be used. For example:
ACR(C)<-0.01:0.001, W(BCC,AG)>0.05:10%
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Additional Information About the Experiment Command

A typical experiment added interactively specifies that a phase should not be stable in a 
certain experiment, because a phase may appear in a range of composition or of 
temperature where it has never been observed during the optimization. A phase is unstable 
if its driving force is negative, and you can add experimental information to enforce that. For 
example, you can suppress the HCP phase in an existing experimental point:

CHANGE-STATUS HCP=DORMANT

EXPERIMENT DGM(HCP)<-.001:.0001

DGM is the POLY variable for the driving force that is already divided by RT, and 
it is dimensionless. Only dormant phases can have driving forces larger than 
zero, as this indicates that these would be stable if allowed to form. The 
experiment in the above case tries to modify the model parameters to make 
the HCP phase unstable.

More general examples of experiment definitions:

EXPERIMENT X(LIQ,PB)=.10:.01 X(FCC,PB)=0.02:.01

EXPERIMENT ACR(PB)=0.8:5%

EXPERIMENT T=700:5

The first experiment above describes a tie-line where the experimentally measured mole 
fraction of Pb is 0.1 in the liquid phase and 0.02 in the FCC phase, and its uncertainty is 0.01 
for both measurements. The second experiment is that the activity of Pb should be 0.8 with 
an uncertainty of 5 percent. 

The reference state of the component Pb must be set with the command SET_
REFERENCE_STATE. The final one is that the temperature should be 700 K with an 
uncertainty of 5 degrees.

Experiments that are functions of states variable(s) must be described as the defined 
functions. For example:

ENTER_FUNCTION HTR=HM(LIQUID)-HM(FCC);

EXPERIMENT HTR=7000:1000
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EXPORT

This command is for the ED-EXP module.

Transfer/export a calculated value from an equilibrium to an optimizing variable in the 
PARROT workspace. Thus the value can be used, for example, in the Gibbs energy 
description of a phase. This variable should not be optimized (i.e. it should be set as a fixed 
variable in PARROT).

Syntax EXPORT 

Prompt

Function name: <Function name>#<n>

Specify the name of the function, the value of which should be transferred to a V variable. The 
number (n) of the V variable must be given after the function name, separated by hash character #.

The function name is UPPER/lowercase sensitive, and it should normally be given in 
UPPER case. 

 

Example
Enter_function strngy=gm(fcc).x(cu);

Export strngy#6

This transfers the value of the partial derivative of the Gibbs energy of the FCC phase with respect to 
the mole fraction of Cu to the optimizing variable 6 (i.e. V6).



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 430 of 622

FLUSH_BUFFER

This command is for the ED-EXP module.

This command is only used in the *.POP file (i.e. it can also be used in the experimental data 
files). It is needed if the number of experiments require more space than can be fitted into 
one buffer. 

In the DICTRA module, you work with a .DOP file instead of a .POP file.

When the PARROT program compiles experiments, it informs if any FLUSH commands are 
needed. FLUSH_BUFFER terminates the current block, saves it to the work file and starts a 
new block. With the READ command in the EDIT-EXP module, you can select the block to 
edit.

Syntax FLUSH_BUFFER

 
After a FLUSH_BUFFER command, the workspace is reinitiated and all functions or constants must be 
entered again in the *.POP file. You can take advantage of this; for example, you can use the FLUSH 
command to have blocks with different components in one *.POP file.
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GRAPHICS_PLOT

This command is for the ED-EXP module.

This command can help create a experimental data file from the *.POP file. Several data sets 
and different symbols are allowed.

In the DICTRA module, you work with a .DOP file instead of a .POP file.

Syntax GRAPHICS_PLOT

 <Dataset#> <X value> <Y value> <Symbol index>
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IMPORT

This command is for the ED-EXP module.

Transfer/import the value of one of the optimizing variables to a constant. Normally, it is 
directly used inside an experimental data (*.POP) file. It is the opposite of the EXPORT 
command. 

In the DICTRA module, you work with a .DOP file instead of a .POP file.

The IMPORT command is useful if several experiments are done at the same activity of a 
component, but this activity is not known. The activity should then be optimized and all 
equilibria with the same activity should use the same value. In this case the variable must be 
set as an optimizing variable, and an initial guess of the activity should be given. During the 
optimization, the PARROT program tries to find the activity that gives the best fit. 

If an approximate value of the activity is known, it can be supplied as an 
experiment.

Syntax IMPORT 

Prompt

Constant name: <Constant name>#<n>

The value of the V variable must be assigned a symbolic constant. The number (n) of the V variable 
must be given after the constant name, separated by hash character #. 

The constant name is UPPER/lowercase sensitive, and it should normally be given in 
UPPER case. 

 

Example
Enter_constant acu=0.1

Import acu#2

This transfers the value of the optimizing variable 2 (i.e. V2) to the constant ACU.
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LABEL_DATA

This command is for the ED-EXP module.

Add a label to the experimental equilibrium point, either as a single point or several points 
given individually or in a table. The label is maximum four characters and must start with the 
letter A. Normally, it is directly used inside an experimental data file (*.POP).

In the DICTRA module, you work with a .DOP file instead of a .POP file.

Several experimental equilibria can be given the same label, and the label can be used with 
SET_WEIGHT to assign the same weight to all equilibria with the same label.

Syntax LABEL_DATA 

Prompt

Label? /A1/: a<bcd>

Specify a textual label (as maximum characters and must start with the letter A) for the current 
experimental equilibrium point(s).
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LIST_ALL_EQUILIBRIA

This command is for the ED-EXP module.

Syntax LIST_ALL_EQUILIBRIA

 

List all the details (including equilibrium indicators, labels, iteration numbers, weight, and fixed 
phases or comments) of all equilibrium points from the current one to the last one on screen. You can 
always use SELECT_EQUILIBRIUM to select a specific point as the current equilibrium point for such a 
list.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 435 of 622

LIST_CONDITIONS

This command is available with the POLY and ED-EXP modules.

All the conditions that are set by the SET_CONDITION command and the command-sequence 
CHANGE_STATUS PHASE =FIXED <0 or 1 or alike>, are listed.  The current conditions are 
also listed by the LIST_EQUILIBRIUM command. The degree of freedom in the defined system 
is also shown. 

 l If this is zero, you can perform a COMPUTE_EQUILIBRIUM command. 
 l If it is larger than zero, some more conditions are required, and you must further set 

additional ones, using SET_CONDITION or CHANGE_STATUS. 
 l If it is negative, then too many conditions are defined and the unnecessary ones 

conditions need to be removed using the SET_CONDITION command (with a value of 
NONE for the to-be-deleted condition) or the CHANGE_STATUS command (i.e. 
changing a FIXED status of a phase to another type of phase status, ENTERED or 
DORMANT or SUSPENDED).

Syntax LIST_CONDITIONS

Example

P=100000, T=800, N(NI)=1E-1, N=1

FIXED PHASES

FCC_A1=1 LIQUID=0   DEGREE OF 
FREEDO 0
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LIST_EQUILIBRIUM

This command is available with the POLY and ED-EXP modules.

The result (always in SI units) from the last calculated equilibrium is listed on screen or in a 
text file. 

You can also execute this command if no calculation is made or if the 
calculation fails. Make sure to interpret the results accordingly.

Syntax LIST_EQUILIBRIUM 

Prompt
Output to screen or file /Screen/: <File name>

The name of the text file where the list of the calculation results shall be written. 

 

Options /VWCS/: <Option(s)>

Select the output units and formats by optionally specifying a combination of these letters.

 l Fraction order:V means VALUE ORDER; A means ALPHABETICAL ORDER.

 l Fraction type: W means MASS FRACTION; X means MOLE FRACTION.

 l Composition: C means only COMPOSITION; N means CONSTITUTION and COMPOSITION.

 l Phase: S means including only STABLE PHASES; P means including ALL NON-SUSPENDED 
PHASES.

 

Default options are VWCS. If the output fraction type should be in mole fraction (rather than mass 
fraction), then give VXCS or type X (implying that in this case the options V, C and S are accepted as 
the listing manners for fraction order, composition and phase).

If accepting all the default options, or if accepting all the altered options that had already changed 
when using this command previously, you can type L_E,,, or LIST_EQUILIBRIUM ,,,

LIST_EQUILIBRIUM displays ORD (ordered) or DISORD (disordered) (when available). 
See CHANGE_LEGEND for details.
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LIST_STATUS

This command is for the ED-EXP module.

There is also a POLY module command with the same name.

List the status of components, species or phases.

Syntax LIST_STATUS 

Prompt

Specify what to list:

Option /CPS/:<keyword(s)>

keyword = C or P or S, or any combination

 l C: list component status

 l P: list phase status

 l S: list species status

 l CS: list both components and species

Default is CPS. 

 

The results depend on the key word specified in the options for CHANGE_STATUS, a table with the 
current status of phases or species or components, or the combinations, is shown:

 l For components, the statuses and reference states are listed.

 l For species, only the status is listed.

 l For ENTERED and FIXED phases, the status, driving forces and equilibrium amounts are 
listed. 

 

The metastable phases are listed in descending order of stability. To avoid long 
outputs only 10 metastable phases (in ENTERED status) are listed by lines, while all 
other less stable phases are merged onto one line. For DORMANT phases, their 
phase names and driving forces are listed. For SUSPENDED phases, only the phase 
names are listed.
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LIST_SYMBOLS

This command is for the ED-EXP module.

There are also POLY and POST module commands with the same name. 

Use this command to list the definitions for all constants, functions, variables and tables.  In 
order to find the value of a function or variable, use SHOW_VALUE or EVALUATE_FUNCTIONS. A 
table is tabulated with the TABULATE command.

Syntax LIST_SYMBOLS

 The defined variables are listed up together with the defined functions, but variable names are 
followed by a percentage sign %.
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MAKE_POP_FILE

This command is for the ED-EXP module.

In the DICTRA module, you work with a .DOP file instead of a .POP file.

Use this command to make interactive changes and additions to the original experimental 
data file (the *.POP or *.DOP file). For example, to document or transfer the current or final 
experimental data to a *.POP file, this command will write it to a new *.POP file or overwrite 
previous versions. 

Check the output carefully for errors. Tables in original *.POP files are written 
as individual experimental points. The output can be shown on screen or be 
saved as a new *.POP file where to write or overwrite the edited experimental 
information in a simple text format. 

Syntax MAKE_POP_FILE 

Prompt

Output to screen or file /Screen/: <POP/DOP-file name>

Specify a name of the new *.POP file where to write or overwrite the edited experimental 
information in a simple text format. If an existing *.POP file name is specified, it is overwritten.
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READ_WORKSPACES 

This command must be given each time the ED_EXP module is entered, unless 
it is already given once in ED_EXP and does not use LIST_RESULT or OPTIMIZE_
VARIABLES in PARROT in between.

Syntax READ_WORKSPACES

Prompt

Block number /#/: <n>

The number of a data block that should be edited must be given. If there is no FLUSH_BUFFER 
command in the original POP file, then there is only one data block with the number 1.

 

READ_WORKSPACE = READ

This command is equivalent to READ_WORKSPACES in the POLY module, but it only reads the POLY 
workspace from the work file set by SET_STORE_FILE in the PARROT module.
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REINITIATE_MODULE

This command is for the ED-EXP module.

The REINITIATE_MODULE command makes sure that the entire ED-EXP module is reinitiated to 
the original state. 

Syntax REINITIATE_MODULE

 

All the defined components, defined conditions, changed status, entered symbols, defined 
independent axis-variables, calculated starting equilibrium-points, added initial equilibrium points, 
stepped/mapped equilibrium data, and so forth, are removed completely. The saved file name is 
restored to the default.
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RESTORE_ALL_WEIGHTS

This command is for the ED-EXP module.

Restore a specific weight-set (previously saved by STORE_ALL_WEIGHTS) and assign all the 
different experimental points in the current data block with the previously-set weights in the 
sequential assessments.

Syntax RESTORE_ALL_WEIGHTS 

Prompt
Set number (0 for list) /0/: <weight-set number>

The default value 0 is for a list on screen.
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SAVE_WORKSPACES 

This command is for the ED-EXP module.

In the PARROT workspace this command saves the current status of the ED_EXP submodule 
before you switch back to the PARROT module. This is required when you want to save 
equilibria changes, including changes to conditions, experimental data, and/or computed 
equilibria results, as well as any newly added equilibria.

With this command all the changes made in the ED_EXP submodule are saved in the 
PARROT workspace. This means you do not need to execute SAVE_PARROT_WORKSPACES in 
the PARROT module.

However, when in the PARROT module, additional changes can only be saved with the SAVE_
PARROT_WORKSPACES command even if they have been made prior to executing SAVE_
WORKSPACES in ED_EXP.

When you exit the ED_EXP (or Thermo-Calc), the next time the file is opened it is in the same 
state as when you executed the SAVE_WORKSPACES command. However, if you use 
OPTIMIZE_VARIABLES the computed results are automatically updated.

Syntax SAVE_WORKSPACES

Prompt

<File name> 

Sometimes good starting values (SET_START_VALUE) are required to successfully get 
or compute an equilibrium correctly. In this case, it is important to save the 
computed equilibrium in the PARROT workspace. It is important to remember that 
the computed results can be ruined by improper optimizations. For this reason, it is 
suggested you save the .PAR file with a different name to back up the PARROT 
workspace.
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SELECT_EQUILIBRIUM

This command is available with the POLY and ED-EXP modules.

If you create more than one initial equilibrium (during data-assessments using the 
PARROT/ED_EXP modules), you can switch between them using this command.

Syntax SELECT_EQUILIBRIUM 

Prompt

Number /Next/: <Choice on equilibrium>

Options: FIRST, LAST, NEXT, PREVIOUS or PRESENT.

Most commands affect only the PRESENT equilibrium. However, the REINITIATE_MODULE and DEFINE_
COMPONENTS commands remove all the stored equilibria.
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SET_ALL_START_VALUES

This command is available for the  POLY and ED-EXP modules.

Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If 
temperature and pressure are not conditions, you are asked for values of them. Then for 
each phase prompt on if it should be stable and on its constitution.

Syntax SET_ALL_START_VALUES

 
T /XXXX/: <Temperature in K>

If the temperature is not a condition, supply a guess of its final value (in K).

 
P /100000/: <Pressure in Pa>

If the pressure is not a condition supply a guess of its final value (in Pa).

Prompts

Automatic start values for phase constitutions? /N/: <Y, N or F>

 l For N, enter an initial amount of each entered phase and the major constituents or site 
fraction of each constituent.

 l For Y, the program automatically sets the start values for phase constitutions in all 
possible phases.

 l F is for force. In some cases the calculation fails because impossible conditions are set, e.g. 
W(C)=1.5 [W(C) is mass fraction and must thus be less than unity. The program tries to 
fulfill this condition by putting maximum amount of carbon in all phases, but can fail 
anyway. When you detect the error and set W(C) to 0.015, the calculation may still fail 
because it could start from the previous values. To get back to ‘fresh’ start values, choose 
F.

 

Should <phase> be stable /N/: <Y/1 or N/2>

A guess if this phase should be stable or not is requested. All entered phases are prompted for this 
question and next two. 

You cannot have more phases stable than you have components, but at least one 
(which dissolves all constituents) must be set as stable. For backward compatibility, 
this question can be answered by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2. For phases with 
miscibility gaps, there should be two phases with the same name but with different numbers after 
the hash sign.

 

Major constituent(s): <Name of major constituent(s) in the phase>

The constituent with the largest fraction in the phase should be specified. If there are more than 
one constituent with a large fraction, give them all on the same line. If the default major 
constituents should be used answer with an asterisk (*). By giving $ the constitution is not changed. 
If there should be no major constituent give NONE and or if the major constituent(s) are improperly 
specified, you are asked for individual fractions in the phase.
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Syntax SET_ALL_START_VALUES

 

Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by pressing <Enter> or give a 
new value (.YYYYY).

The phase name or constituent name may have a hash sign # followed by a digit, e.g. Y(BCC_
A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility gaps, there should be two phases with the 
same name but with different numbers after the hash sign. For phases with sublattices, the 
constituents in sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.
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SET_ALTERNATE_CONDITION

This command is for the ED-EXP module.

A special command used in the experimental data *.POP file but also possible in 
the ED_EXP module. It is used only when you have specified that the alternate 
mode is set in the PARROT module. 

In the DICTRA module, you work with a .DOP file instead of a .POP file.

The command syntax is almost the same as for the POLY command SET_CONDITION while the 
uncertainty should also be specified.

The alternate condition (including the normally POLY module condition plus 
uncertainly; see below) must be given explicitly, but can be given on the same 
line or on separate lines with each one started with the command.

Syntax SET_ALTERNATE_CONDITION 

Prompt
State variable expression: <State variable name or linear expression>

Give either a state variable or a linear expression of state variables.

Options Description and Information

State 
variables

Some of the state variables that can be used in conditions are:

 l T: temperature in the system (in K)

 l P: pressure in the system (in Pascal)

 l N: system size (mole number in moles)

 l B: system size (mass in grams)

 l N(<component>): mole number of a component in the system

 l X(<component>): mole fraction of a component in the system

 l W(<component>): weight fraction of a component in the system

 l For the SET_CONDITION command this is ACR(<component>): activity of a component in 
the system. For the SET-ALTERNATIVE_CONDITION command, this is ACR
(<phase>,<component>) (activity of a component in a phase)

 l For the SET_CONDITION command this is MUR(<component>): chemical potential of a 
component in the system. For the SET-ALTERNATIVE_CONDITION command, this is MUR
(<phase>,<component>) (chemical potential of a component in a phase)
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Syntax SET_ALTERNATE_CONDITION 

 l X(<phase>,<component>): mole fraction of a component in a phase

 l W(<phase>,<component>): weight fraction of a component in a phase

 l ACR(<species>,<phase>): activity of a species referred to a phase

 l MUR(<species>,<phase>): chemical potential of a species referred to a phase

 l H: enthalpy in the system (in J)

 l HM(<phase>): enthalpy of a phase (in J/mol)

Additional 
prompts

Factor: <A factor for the state variable, or a continuation>

This question means that the previous question was not answered. The program is then expecting 
a single state variable or a complete state variable expression, or the numeric factor in an 
expression with only one state variable. In a state variable expression a state variable may be 
preceded by a constant factor. An example of this is:

2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential of FE plus three 
times the chemical potential of O should be -35000 J/mol.

 

State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt State 
variable expression or Factor, or a state variable expression is given but the expression is 
incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a 
continuation of the unfinished expression. You need to specify a state variable or a complete state 
variable expression, or complete the unfinished state variable expression. If a numeric factor is 
given before this prompt, only one state variable can be specified; otherwise, the program only 
takes the first state variable to complete the expression (i.e. the factor times the state variable).

 

Value /X/:  <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is 
given as the default value. The special value NONE means that the condition is removed.

 

Uncertainty /None/:  <Uncertainty of the condition>

The uncertainty of the condition. This can be a numeric value, a constant or a variable. The 
default value NONE means that the uncertainty for the value specified above is zero. The 
uncertainty can either be expressed as an absolute value or relative to the value of the condition 
in percent (x%).

Notes

There are more state variables that can be used in conditions. For more information, type an INFO 
STATE_VARIABLES command in the POLY module. A condition is normally a value of a single state 
variable with its value. 

Example
T=1273.15  P=1E5

X(C)=.002

W(CR)=1.5

ACR(CR)=0.85

X(FCC,C)=.001

H=-250000
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Syntax SET_ALTERNATE_CONDITION 

HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one state variable. 

Example
X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S should be the same in the LIQUID and 
PYRRHOTITE phases. In practice that should be the congruent melting point. 

After the equal sign only a numeric value is allowed.
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SET_CONDITION

This command is available with the POLY and ED-EXP modules.

Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as 
most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state 
variables (with respect to chosen reference states), can be used as conditions. In addition to 
temperature and pressure conditions, a multicomponent system can have mixed types of 
conditions. You should repeat this command for a multicomponent system until the degree 
of freedom in the defined system becomes zero. When a FIXED phase status is used on a 
specific phase (use CHANGE_STATUS), it is equivalent to one condition (implying that 
particular phase is stable in the defined system).

Syntax SET_CONDITION 

 

Each condition must be given explicitly, but can be given on the same line (separated by a comma (,) 
or an empty space) or on separate lines with each one started with the command.

Example
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2

or

SET_COND T=1273, P=1E5

SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5 Pascal), the mass 
(weight) fraction of C to 0.0015 and the mole fraction of Cr to 0.22 and the activity of N to 0.2.

Prompt

State variable expression: <State variable name or linear expression> or a linear 
expression of state variables.

Some of the state variables that can be used in conditions are:

 l T: temperature in the system (in K)

 l P: pressure in the system (in Pascal)

 l N: system size (mole number in moles)

 l B: system size (mass in grams)

 l N(<component>): mole number of a component in the system

 l X(<component>): mole fraction of a component in the system

 l W(<component>): weight fraction of a component in the system

 l For the SET_CONDITION command this is ACR(<component>): activity of a component in the 
system. For the SET-ALTERNATIVE_CONDITION command, this is ACR(<phase>,<component>) 
(activity of a component in a phase)

 l For the SET_CONDITION command this is MUR(<component>): chemical potential of a 
component in the system. For the SET-ALTERNATIVE_CONDITION command, this is MUR
(<phase>,<component>) (chemical potential of a component in a phase)
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Syntax SET_CONDITION 

 l X(<phase>,<component>): mole fraction of a component in a phase

 l W(<phase>,<component>): weight fraction of a component in a phase

 l ACR(<species>,<phase>): activity of a species referred to a phase

 l MUR(<species>,<phase>): chemical potential of a species referred to a phase

 l H: enthalpy in the system (in J)

 l HM(<phase>): enthalpy of a phase (in J/mol)

There are many state variables that can be used in conditions. For more information, enter an INFO 
STATE_VARIABLES command. A condition is normally a value of a single state variable with its value. 

Example
T=1273.15  P=1E5

X(C)=.002

W(CR)=0.5

ACR(CR)=0.85

X(FCC,C)=.001

H=-250000

HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one state variable. For 
example,

X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S component should be the same in the 
LIQUID and PYRRHOTITE phases. In practice, that should be the congruent melting point. 

After the equal sign only a numeric value is allowed in the expression.

 

Factor: <A factor for the state variable, or a continuation>

This question means you did not answer the previous question. The program is then expecting a 
single state variable or a complete state variable expression, or the numeric factor in an expression 
with only one state variable. In a state variable expression a state variable may be preceded by a 
constant factor. An example of this is:

2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential of FE plus three times 
the chemical potential of O should be -35000 J/mol.

 

State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt State 
variable expression or Factor, or a state variable expression is given but the expression is 
incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a continuation 
of the unfinished expression. You need to specify a state variable or a complete state variable 
expression, or complete the unfinished state variable expression. If a numeric factor is given before 
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Syntax SET_CONDITION 

this prompt, only one state variable can be specified; otherwise, the program only takes the first 
state variable to complete the expression (i.e. the factor times the state variable).

 

Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is 
given as the default value. The special value NONE means that the condition is removed; for example 
T=NONE takes away the temperature condition.
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SET_NUMERICAL_LIMITS

This command is available for the POLY, Scheil, and ED-EXP modules.

Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a 
calculation procedure enforced by COMPUTE_EQUILIBRIUM, STEP_WITH_OPTIONS, MAP or 
ADVANCED_OPTIONS), this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 
to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-
LIMITS

This implies that smallest site fraction in the current POLY workspace is automatically 
increased from the default value 1.00E-30 to the hardware-dependent precision (under 
Linux, as 2.00E-14). For other subsequent POLY module calculations, you can use this 
command to restore or reset the smallest site fraction to the previous or another preferred 
value, as well as to reset other numerical limits.

Syntax SET_NUMERICAL_LIMITS

Prompt

Maximum number of iterations /500/:

By default, the program tries 500 iterations before it gives up. As some models give computation 
times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the 
calculation stops if 500 CPU seconds/iterations are used.

 

Required accuracy /1E-6/:

This is a relative accuracy, and the program requires that the relative difference in each variable 
must be lower than this value before it has converged. A larger value normally means fewer 
iterations but less accurate solutions. The value should be at least one order of magnitude larger 
than the machine precision.

 

Smallest fraction /1E-12/:

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you 
can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with 
one sublattice site (such as the GAS mixture phase in many databases) for which the default value is 
always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an even-
lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).

 

Approximate driving force for metastable phases /Y/:

Y is the default. Enter N to change the default as required and based on the options described below.

This setting involves the convergence of metastable phases and affects their driving forces. It can 
also have an effect on when an equilibrium is considered successful.

The default is to allow an equilibrium with metastable phases that have not converged, as long as 
the stable phases have converged. This is efficient but often causes approximate values of the 
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Syntax SET_NUMERICAL_LIMITS

driving forces for the metastable phases.

If you change the default, it enforces metastable phases to converge. This gives accurate driving 
forces for metastable phases as well as stable phases. It can however take a slightly longer time, and 
if metastable phases do not converge it causes the equilibrium calculation to fail.
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SET_REFERENCE_STATE

This command is available for the POLY, ED-EXP and POST modules.

The reference state for a component is important when calculating activities, chemical 
potentials, and enthalpies and is determined by the database being used. For each 
component the data must be referred to a selected phase, temperature, and pressure, i.e. 
the reference state. 

All data in all phases where this component dissolves must use the same 
reference state. However, different databases can use different reference 
states for the same element/component. It is important to be careful when 
combining data obtained from different databases.

By default, activities, chemical potentials, and so forth are computed relative to the 
reference state used by the database.  If the reference state in the database is not suitable 
for your purposes, use this command to set the reference state for a component using SER, 
i.e. the Stable Element Reference (which is usually set as default for a major component in 
alloys dominated by the component). In such cases, the temperature and pressure for the 
reference state is not needed.

In order to specify conditions in the specific reference state, you can append an R to the 
state variables. Thus, AC is the activity (of a system component or of a species in a phase) 
with respect to the default reference state, and ACR is the activity with respect to the 
selected reference state; MU is the chemical potential of a system component with respect 
to the default reference state, and MUR stands for the chemical potential with respect to the 
selected reference state. The AC and ACR variables, for both components in a system and 
species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).

For the POST module, and after calculating with the STEP_WITH_OPTIONS or MAP commands, 
the reference state for a component can also be changed to plot various properties of the 
component in the entire system or in a specific phase. Then you can set the diagram axes as 
the chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR
(comp,ph), ACR(comp),  ACR(comp,ph) or the common logarithms [e.g. LNACR(comp,ph)].

Syntax SET_REFERENCE_STATE 

Prompts
Component: <Name of the component>

The name of the component must be given.

 Reference phase: <Name of a phase used as the new reference state>
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Syntax SET_REFERENCE_STATE 

Enter the Name of a phase for the system. 

For a phase to be usable as a reference for a component, the component needs to 
have the same composition as an end member of the phase. The reference state is 
an end member of a phase. The selection of the end member associated with the 
reference state is only performed once this command is executed. 

If a component has the same composition as several end members of the chosen reference phase, 
then the end member that is selected at the specified temperature and pressure will have the 
lowest Gibbs energy. 

The following are example using temperature. Pressure is used in the same way:

 l In the Fe-C system, BCC can be a reference state for Fe but not for C since BCC can exist as 
pure Fe but cannot exist as pure C. 

 l If GAS is chosen as the reference phase of component O at such a high temperature that 
O1 has the lowest energy, then O1 remains the reference state even at calculations 
performed at lower temperatures where O2 has a lower energy than O1.

 l Setting the reference state for component O as gas (one sublattice) with constituents O1, 
O2 and O3 results in O2 being the reference state if, at the present temperature, pure O2 
has the lowest energy of O1, O2 and O3. If the reference state is set above a critical higher 
temperature, then O1 has the lowest energy and consequently becomes the reference 
state. 

 

Temperature /*/: <Temperature for the reference state>

Select the Temperature (in K) for the reference state. The wildcard value * means the current 
temperature is used at the time of evaluation of the reference energy for the calculation. 

The temperature set with this command does not affect the temperature used 
when evaluating the energy of the reference state during the end member 
selection process.

 

Pressure /1E5/: <Pressure for the reference state>

Select the Pressure (in Pa) for the reference state. The wildcard value * means the current pressure 
is used for evaluating the reference energy at the time of calculation.

 

Examples
S-R-S Fe SER

S-R-S Cr FCC * 100000

S-R-S H2O AQUEOUS * 100000

S-R-S ZE REF_ELECTRODE * 100000
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SET_START_CONSTITUTION

This command is available with the POLY and ED-EXP modules.

This command is similar to SET_ALL_START_VALUES, but is used for an individual phase that 
may have a wrong constitution.

Syntax SET_START_CONSTITUTION

Prompts

Phase name: <Name of a phase, and possible major constituent(s)>

Specify the name of a phase for which the constitution shall be set.

If there is a major constituent of the phase, you must specify this on the same line as 
the phase name. By giving an*, select the default major constituents. A $ means 
keeping the same constitution, and NONE means to give individual site-fractions.

 

Y(<Phase>#<Composition_set>,<Constituent>#<Sublattice>) /xxx/: <SF>

The site fraction (SF) of the constituent shall be given. The default value xxx is the last 
calculated one.
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SET_START_VALUE

This command is available with the POLY and ED-EXP modules.

This command is not often required as the automatic start values can be 
handled for most problems.

Set a start value of an individual variable.

Syntax SET_START_VALUE

Prompts
State variable: <Name of a state variable>

The state variable must be given.

 
Value

Specify the value to be assigned the state variable as start value.
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SET_WEIGHT

This command is for the ED-EXP module.

Each experimental value has an uncertainty associated with it, specified by the value after 
the colon (:) with the command EXPERIMENT. During an optimization the absolute difference 
between the experimental and calculated values gives a contribution to the sum of error.

With the SET_WEIGHT command, you can change the scale of such a contribution (the 
uncertainty) for a single experimental point, or the contributions (all uncertainties) for a set 
of equilibria.  The default weight is always unity. A value smaller than one means that the 
experiments should have less weight. A value larger than one that these should have higher 
weight. The special value zero means that the set of equilibria should be ignored in editing in 
ED_EXP (as  is given) and in OPTIMIZE_VARIABLES in PARROT.

The weight may be needed to obtain a balance between different kinds of 
experiments. For example, if there are only five experimental values of the 
composition of a phase diagram but 500 experimental values of activities or 
enthalpies, then the five composition points may have to be given higher 
weight than unity, otherwise these are not well described by the optimizing 
procedure.

Syntax SET_WEIGHT 

Prompts

Value /1/: <Weight value>

Specify a weight of the experiments in the specified equilibria (asked in the next prompt). The 
contribution to the sum of errors of these experiments are multiplied by this weight. 

The weight is squared, thus use 0.7 to make the error half (0.49) as big, and 1.4 to 
make it twice (1.96) as large.

 

Equilibria (range) or label(s) /Present/:<Selection>

Define the equilibria. These are available in the read data block from the current work file and are 
given the above-defined weight.

The selection may be given as a range but the equilibrium numbers must then be separated only by 
a minus sign. 
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Syntax SET_WEIGHT 

The start and end equilibrium numbers must be available in the read data block 
read from the current work file. 

For example, 5-101, means that all equilibria starting from the identifier 5 until the identifier 101. 
Some of numbers between these two identifiers may not exist in the data block.

The selection may also be given as one or more labels (which should be separated only by a space). 
All equilibria with the specified label(s) in the read data block are given the above-defined weight. 

By pressing <Enter> to accept the default value present, the above defined weight is only assigned 
to the current or present experimental point (which is selected by the POLY SELECT_EQUILIBRIUM 
command). 

If  is used but no specific equilibrium point is selected afterwards, the last point in 
the read data block remains the present point.
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SHOW_VALUE

This command is available for the  POLY and ED-EXP modules.

Show the current value of any state variable, function or variable.

Syntax SHOW_VALUE 

Prompt
State variable or symbol: <Name(s) of state variable(s) or symbol(s)>

A single or several state variables or symbols (entered functions or variables) can be specified. 

 

The wildcard * can be used to denote all phases or all components. 

You can use the dollar-sign $ to denote all stable phases. Thus, the command SHOW W(*,*)lists the 
mass fraction of all phases, whereas SHOW W($,*)lists the mass fraction of all stable phases.

If you SHOW a function, all functions are evaluated using the current values of the 
state variables. But if you SHOW a variable, it retains its value from the time it was 
ENTERED or last EVALUATED. 

Therefore to save a value from one calculation to another, ENTER it to a variable. This is frequently 
done in the PARROT module to transfer values between equilibria.
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STORE_ALL_WEIGHTS

Store a new weight-set that is the current situation of specified weights for all the different 
experimental points read from the currently-selected experimental data block in an 
assessment. This is useful when you want to try various weight-settings for some 
experimental points or for all the points, and then compare the assessment results from 
different weight-sets. Such a saved weight-set can be recalled and restored for all 
experimental data point with RESTORE_ALL_WEIGHTS sequentially.

Syntax STORE_ALL_WEIGHTS 

Prompt
Command line: <Weight-set name>

Give a weight-set name (comment line texts) for the current weight set for all experimental points.
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TABLE_HEAD, TABLE_VALUES and TABLE_END

These commands are used only in the *.POP file. It represents a convenient way to enter 
many experimental measurements of the same type in a table format.

In the DICTRA module, you work with a .DOP file instead of a .POP file.

These commands should always be used together and in a sequence, meaning 
that a table should always start with the TABLE-HEAD command, then TABLE-
VALUES, and finish with TABLE-END. Between TABLE_HEAD and TABLE-VALUES 
also add definition lines (e.g. on phase status, reference states, conditions, 
experiments, labels, etc.) for the experimental measurements of the current 
information type.

Syntax

TABLE_HEAD 
TABLE_VALUES
TABLE_END

Prompt  

 

After the TABLE-HEAD command, there must be an equilibrium description similar to a single 
experimental equilibrium but with some special notation. Then, there is always a TABLE-VALUES 
command, after which the actual data is given in columns. At the end of each table, there must be a 
TABLE-END command.

The TABLE-HEAD command must be followed by a numeric value. This is used to generate unique 
numeric identifiers for all the equilibria in the table. The numeric identifier is incremented by one for 
each experimental (equilibrium) point in the table. 

 

Example
An example of the use of a table for enthalpy measurements in the liquid is given here. Much more 
elaborate tables can be used

$ Enthalpies of mixing, Topor and Kleppa, Met Trans 1984 TABLE-HEAD 1

CREATE—NEW @@ 1

CHANGE-STATUS PHASE LIQ=FIX 1

SET-REFERENCE-STATE AU LIQ * 1E5

SET-REFERENCE-STATE CU LIQ * 1E5

SET-CONDITION P=1E5 T=1379 X(LIQ,AU)=@1

LABEL ALH

EXPER HMR=@2:5%

TABLE—VALUES

0.0115 -322
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Syntax

TABLE_HEAD 
TABLE_VALUES
TABLE_END

0.0563 -1520

0.8499 -2976

0.9002 -2114

TABLE—END

 

The equilibrium description between TABLE-HEAD and TABLE-VALUES is similar as for a single 
experiment, except for these details:

 l @@ Used to automatically generate a series of identifying numbers instead of creating only 
one with the command CREATE_NEW_EQUILIBRIUM. The program automatically generates 
the identifying numbers starting after the number given after the TABLE-HEAD command (in 
this case it is 1).

 l @1 values in the table are specified by an @ sign followed by a column number. In the 
above case, the mole fraction of Au in the liquid is in column 1 (see the line for SET_
CONDITION). The columns may have other information than values, and you can use phase 
names or any text. If the text contains spaces or special characters, it must be surrounded 
by double quotes in the table, e.g. “ABC DEF&ghi”.

 l For the syntax checker all commands describing the equilibrium must be in UPPER case 
after the TABLE_HEAD command.

 l After the TABLE-VALUES command, there should be one line for each experimental 
measurement of the same type giving the values or texts that should be copied into the 
places of the condition or experiment defined by @1, t, etc. You can have columns that are 
not used but there must be exactly the same number of columns of each line, otherwise 
the syntax checker gives an error message in the PARROT module.
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TRANSFER_START_VALUES

This command is for the ED-EXP module.

In the ED_EXP module it is time consuming to calculate all equilibria when the optimization 
is sensitive to start values of the composition of the phases. Usually in one data block there 
are several experimental points with the same kind of equilibrium and each must have its 
start value set. When you manage to calculate equilibriums of such experimental points, this 
command is useful to transfer the site fractions from a successfully-calculated equilibria to 
the present experimental point.

Syntax TRANSFER_START_VALUES 

Prompt

From equilibrium /Previous/: <Equilibrium number>

The equilibrium number is the numeric identifier for the equilibrium from which the start values 
should be copied to the present experimental point. Previous is the default if you press <Enter>.
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Tabulation Reaction (TAB) Commands

In this section:
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ENTER_FUNCTION

This command is available with the GES and TAB modules.

Used to define a new thermodynamic function to be included in the sixth column of tabular 
output. The last entered function is listed in the 6th column of all tables, and can be plotted 
(if choosing the Plot Column value 6) in all graphs, for all subsequently tabulated substances 
or reactions.

Syntax ENTER_FUNCTION

Prompt
Name: <Name>

Function: <Definition>

 

A limited number of state variables, G, H, S, T, P, V and H298 can be used in the function definition. 
For example, -(G-H)/T can be defined as a function which is identical to S for a substance or ΔS for a 
reaction, G+T*S-P*V can be defined as a function which is U (internal energy) for a substance or ΔU 
(internal energy change) for a reaction.

Options Nameof the function (maximum 8 characters) and Definition of the function. A long function can be 
typed over several lines. A function should be terminated by a semicolon (;) or an empty line.

Example

For the pure substance Fe (using the SSUB database), by entering a function as G+T*S-P*V, 
the following table is obtained by typing <Enter> in the prompt Output file /Screen/:, 
and the figure by typing 6 in the prompt Plot column /2/:

TAB: ENTER-FUNCTION

Name: InEnergy

Function: G+T*S-P*V;

TAB: TABULATE_SUBSTANCE

Substance (phase): Fe

Pressure /100000/: <Enter>

Low temperature limit /298.15/: <Enter>

High temperature limit /2000/: <Enter>

Step in temperature /100/: <Enter>

Output file /try1/: try2

Graphical output? /Y/: <Enter>

Plot column? /2/: 6

This gives the following output:
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O U T P U T  F R O M  T H E R M O - C A L C

Column 6: InEnergy G+T*S-P*V

Phase : FE_S                       Pressure :      100000.00

Specie: FE

***************************************************************

    T      Cp            H             S             G             InEnergy

   (K)    (Joule/K)      (Joule)      (Joule/K)      (Joule)

***************************************************************

  298.15   2.48446E+01   2.17972E-06   2.72800E+01  -8.13353E+03   2.17972E-06

  300.00   2.48905E+01   4.60049E+01   2.74338E+01  -8.18414E+03   4.60049E+01

  400.00   2.71299E+01   2.64957E+03   3.49085E+01  -1.13138E+04   2.64957E+03

  500.00   2.93561E+01   5.47211E+03   4.11976E+01  -1.51267E+04   5.47211E+03

  600.00   3.19293E+01   8.53245E+03   4.67701E+01  -1.95296E+04   8.53245E+03

  700.00   3.50985E+01   1.18777E+04   5.19207E+01  -2.44667E+04   1.18777E+04

  800.00   3.92042E+01   1.55830E+04   5.68623E+01  -2.99068E+04   1.55830E+04

  900.00   4.49645E+01   1.97726E+04   6.17903E+01  -3.58387E+04   1.97726E+04

1000.00   5.42147E+01   2.46891E+04   6.69619E+01  -4.22728E+04   2.46891E+04

1100.00   4.55851E+01   2.99025E+04   7.19412E+01  -4.92328E+04   2.99025E+04 $ 
Stable phase is FE_S2

1200.00   3.40840E+01   3.51037E+04   7.64466E+01  -5.66322E+04   3.51037E+04

1300.00   3.49398E+01   3.85549E+04   7.92086E+01  -6.44162E+04   3.85549E+04  
1400.00   3.57994E+01   4.20918E+04   8.18293E+01  -7.24692E+04   4.20918E+04

1500.00   3.66636E+01   4.57149E+04   8.43287E+01  -8.07780E+04   4.57149E+04

1600.00   3.75330E+01   4.94247E+04   8.67226E+01  -8.93314E+04   4.94247E+04 $ 
Stable phase is FE_S3

1700.00   4.05217E+01   5.41173E+04   8.95609E+01  -9.81363E+04   5.41173E+04

1800.00   4.12595E+01   5.82055E+04   9.18975E+01  -1.07210E+05   5.82055E+04 $ 
Stable phase is FE_L

1900.00   4.60000E+01   7.74165E+04   1.02377E+02  -1.17099E+05   7.74165E+04  
2000.00   4.60000E+01   8.20165E+04   1.04736E+02  -1.27456E+05   8.20165E+04
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ENTER_REACTION

This command is for the TABULATE_REACTION (TAB) module.

This is the same as TABULATE_REACTION in that both the chemical reaction can be specified 
and the thermodynamic property changes for the reaction can be generated as a table, and 
plotted as a graph or saved as an experimental file (with an extension of .EXP). The 
thermodynamic data are automatically retrieved from the SSUB database (by default), or the 
current database set by SWITCH_DATABASE (thus there is no need to use the TDB module 
before this command). You can select any other database by using the SWITCH_DATABASE 
command in the TAB module. The rules to specify a reaction are the same as TABULATE_
REACTION.

Syntax ENTER_REACTION

Prompts

Same reaction? /Y/: 

This displays if there is at least one reaction already defined either by ENTER_REACTION or TABULATE_
REACTION. For Y the next prompt for defining reaction is not asked.

 

Reaction: <Chemical reaction equation> & <RA+RB=PC+PD>

A long reaction can be typed over several lines. A reaction should be terminated by a semicolon (;) 
or an empty line. A list showing the used database, defined elements, getting-data sequence, 
references, etc.:

Pressure /100000/: <Pressure of interest, in pa>

Low temperature limit /298.15/: <T-low, in K>

High temperature limit /2000/: <T-high, in K> Step in temperature /100/: <T-step>

 

Output file /Screen: <Return for screen, or type a file name>

If you type Return for screen a list of thermodynamic property changes for the defined/chosen 
reaction is shown up as a table (which is demonstrated in the example outputs given below), and 
the command is terminated.

If typing a file name, the table is displayed and saved as an *.EXP or an *.TAB file. Then prompts:

 

Graphical output /Y/: 

For N a table is output to the screen and this table is saved as a basic text file with the default 
extension .TAB under the current working directory. In this case, the graph cannot be plotted.

By default a table is created with all thermodynamic functions as normal (which is displayed on 
screen) and generates a graph with temperature on the X-axis and a chosen property on a certain 
column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP file). You are 
also prompted for the plot column. 

 

Plot column? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus temperature as X-
axis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e. 
the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The 
default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional 
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Syntax ENTER_REACTION

column 6 is a user-entered function. The table displays on the screen. The plot then displays on the 
screen, followed by a POST prompt. The POST module (postprocessor) automatically opens, and all 
types of the POST-module commands to refine the plotted diagram may be used. Possibilities 
include scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST 
prompt always takes you back to the TAB module.
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LIST_SUBSTANCES

This command is for the TABULATE_REACTION (TAB) module.

List all species in the current database with a certain set of elements. This is useful to specify 
species as pure substances in the command TABULATE_SUBSTANCE.

Syntax LIST_SUBSTANCES

Prompts

With elements /*/ <* or a set of elements>

The elements building up various species must be specified. The wildcard * means all elements in 
the current database.

If some elements are specified, it also prompts for how to list species with such elements.

 

Exclusively with those elements /Y/: 

All species (not phases) in the current database are searched. Keep the default (Y) if you do not 
want other elements included in the search except for those specified. Enter N to list all species 
containing at least one of the specified elements.

Example

For the SSOL database, there are different lists, as shown below:

TAB: l-sub

With elements /*/: <Enter>

VA                      AG                      AL

AM                      AS                      AU

B                       BA                     BE BI   BR C

CA                      CD                      CE

CL                      CO                      CR

CS                      CU                      DY

ER                      EU                      F

FE                      GA                      GD

GE                      H                       HF

HG                      HO                      I

IN                      IR                      K

LA                      LI                      LU

MG                      MN                      MO

NA                      NB
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ND                      NI                      NP

OS                      P

PA                      PB                      PD

PR                      PT                      PU

RB                      RE                      RH

RU                      S                       SB

SC                      SE                      SI

SM                      SN                      SR

TA                      TB                      TC

TE                      TH                      TI

TL                      TM                      U

V                       W                       Y

YB                      ZN                      ZR

C1                      C2                      C3

C4                      C5                      C6

C7                      N2                      O2

P1                      P2                      P4

NA/+1                   K/+1                    CL/-1

H2O                     H1/+                    LI1/+

CS1/+                   RB1/+                   O1H1/-

F1/-                    BR1/-                   I1/-

H1/+1                   H1O1/-1                 SI1O2 CA1O1 TAB:

TAB: l-sub

With elements /*/: fe cr ni c n o

Exclusively with those elements? /Y/: <Enter>

C               CR                    FE

N               NI                    O

C               C2                    C3

C               C5                    C6

C               N2                    O2

TAB:l-sub fe cr ni c n o

Exclusively with those elements? /Y/: n

C               CR                    FE N   NI O

C1              C2                    C3

C4              C5                    C6

C7              N2                    O2
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H2O             O1H1/-                H1O1/-1 SI1O2 CA1O1 TAB:
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SET_ENERGY_UNIT

Set the energy unit as calories or Joule, in all the subsequent outputs (tables, graphs, and 
files) in the current calculation operation.

Syntax SET_ENERGY_UNIT 

Prompt Energy unit (C=Cal, J=Joule) /J/: <Unit>
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SET_PLOT_FORMAT

This command is for the TABULATE_REACTION (TAB) module.

Set the plotting format while the result is plotted on screen or the file is saved as EXP file 
[using DATAPLOT graphical format] and TAB file (as a basic text file and as displayed on 
screen). 

This command is different from SET_PLOT_FORMAT in the POST module, but is 
identical to SET_PLOT_ENVIRONMENT in the SYS (system utility) monitor.

Syntax SET_PLOT_FORMAT

Options

The default set Unitis 1 (Windows) or 9 (Linux) for graphical presentation on screen, or all other 
units for outputs as *.EXP and *.TAB files.

Also set the format of the graphical output to different graphical devices. The default unit 22 (1 for 
legacy Windows, and 9 for legacy Linux) may be altered with SET_PLOT_ENVIRONMENT in the SYS 
monitor or by the TC.INI file.
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SWITCH_DATABASE

This command is for the TABULATE_REACTION (TAB) module.

By default, the TAB module always automatically retrieves thermodynamic data for 
substances or reactant/product substances in a defined reaction, or for pure phases or ideal 
solution phases, from the SSUB Substances database. However, you can select 
thermodynamic data for complex non-ideal solution phases from another database, which is 
possible with this command.

Syntax SWITCH_DATABASE 

Prompt

Database /XYZ/: <new database name>

Specify a New database name. XYZ stands for the default SSUB database or the current database 
which is switched on. 

If an appropriate database name is not given and the USER option is not used, a list displays of 
available databases. 

Use one of these databases:

 l PURE = SGTE Pure Elements Database 

 l SSUB = SGTE Substances Database 

 l USER = user defined database

This command switches (or changes) from the current database to a new one, and 
reinitializes the entire TAB module for defining a substance or reaction and the GIBBS 
workspace for storing retrieved data. All the directly connected databases as predefined by 
the original database initiation file tc_initd.tdb are listed by pressing the <Enter> key 
without giving any argument. You can also supply your own database by giving the argument 
USER and then the database name and, if it is not located in the current working directory, 
its correct path.

This command (when required to use another database for subsequent tabulations) must be 
used before executing the TAB commands TABULATE_SUBSTANCE for substances, and ENTER_
REACTION or TABULATE_REACTION for reactions.

When a predefined database or an appropriate USER database is switched on, the DATA 
command GET_DATA is automatically executed.

DATABASE NAME: The new database is specified by typing the abbreviation given in the 
front of one of the available predefined databases. For convenience when 
switching/appending databases you can add them to the predefined database list in the 
database initiation file tc_initd.tdb of your installed software. 
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When this command is used in a macro (*.TCM) file, if the USER option is selected, the 
database setup file name (*setup.TDB) containing the setup definitions of the user database, 
and its correct path, must be provided.

If a USER database name or its path is not given on the same line of the SWITCH_DATABASE 
command, or if it is incomplete or incorrect, an Open window displays to specify the 
filename of the database setup file name (*setup.TDB) of the to-be-switched USER database.

Unlike in the TDB module, if a user database is chosen, the Gibbs energy system 
is also reinitialized and only data from the user databases are retrieved for 
tabulations.

After this command, those commands to define systems (in terms of either elements or 
species), to reject/restore phases or species, retrieve data, as well as to append data from 
additional database(s), can be done.
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TABULATE

This command is for the TABULATE_REACTION (TAB) module.

Gives the values of an already-defined table (with various properties varied with the 
stepping axis variable) from equilibria calculated with a STEP command. You can tabulate a 
table even if the table is entered after the step calculation.

Syntax TABULATE 

Prompts
Name: <Name of a defined table>

The name of the table must be given. The table must be entered.

 

Output to Screen or file /Screen/: <File name>

The table can be listed on the screen (by pressing <Enter>), on a file (the file name 
must be specified here).
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TABULATE_DERIVATIVES

This command is for the TABULATE_REACTION (TAB) module.

This command is mainly for system debugging purposes and for experienced 
users. It automatically calculates all partial derivatives for a pure phase or 
solution phase at a given composition. 

This is not the same as the chemical potential.

Before using this command, the system must be defined and thermodynamic data retrieved 
from an appropriate solution database in the TDB module. The phase name can be given in 
either upper, lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc, BCC, 
cem, Liq, etc. as the SSOL database is used for the tabulations, or GAS, FE-S, wustite, Fe2O3-
hem, etc. as the SSUB database is used. The module then optionally goes through a specific 
sublattice or all the possible sublattices for the specified phase, as well as through the whole 
framework of a currently defined system (including all the defined elements/species, as well 
as the default defined vacancy and electron if necessary for the current database), when it 
prompts for inputs of site fractions for various species possibly occupying such sublattices. 
Therefore, thermodynamic properties can be tabulated for a pure phase, or for a solution 
phase as a pure end-member (with a composition definition for the corresponding non-
interacting species on all necessary sublattices in the end-member), or for a solution phase 
as a real solution (with a composition definition for related interacting species on all 
necessary sublattices in the solution).

Syntax TABULATE_DERIVATIVES

Prompts

Phase name /XXXX/: <Name of the phase>

Specify the phase name of a pure phase or a solution phase.

XXXX is the last phase the TAB module accounted for. It automatically prompts for other options 
and necessary inputs for the definition of the composition of the specified phase.

For a pure phase (such as Fe-S, Wustite, and Fe2O3-Hematite), no further composition definition is 
needed. For a solution phase with one sublattice (such as AQUEOUS solution, GAS mixture and SLAG 
solution), it requests n-1 site-fraction inputs for the phase constituents (if there are n species in the 
defined phase within the whole framework of currently defined system, including all the defined 
elements/species, as well as the default defined vacancy and electron if necessary for the current 
database); the nth species is automatically assigned as the rest. 
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Syntax TABULATE_DERIVATIVES

The sum of input site fractions must not exceed unity. 

 

Example Prompts
For example, these prompts and inputs can be seen for a LIQUID solution phase (from the SSOL 
database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the unprompted Ni species 
are assigned as the rest):

FRACTION OF CONSTITUENT (RETURN FOR PROMPT): <RETURN> C /1/: .05

CR /1/: .1

FE /1/: < RETURN>

SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER

FE /1/: .8

N /1/: .005

For a solution phase with two or more sublattices (such as FCC alloy solution, and ION_LIQ ionic 
liquid solution), it first asks for which sublattice the site-fractions of constituents shall be specified: 
the default value 0 for all possible sublattices, and a given positive number for a specific sublattice 
(of course, this number must be reasonable for the currently specified phase, i.e. it must be smaller 
than the total sublattice number of the phase). Then, for the given sublattice or for all sublattices, it 
prompts for all the necessary inputs of site-fractions for the possible constituents on each sublattice 
n-1 times if there are n species on such a sublattice in the defined phase; the nth species on each of 
the sublattices is automatically assigned as the rest. For example, the following prompts and inputs 
can be seen for an FCC solution phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O 
framework (Note that by default, the unprompted O species on its sublattice 1 and VA on its 
sublattice 2 are assigned as the rest):

SPECIFY SUBLATTICE (0 FOR ALL) /0/: <RETURN>

FRACTIONS IN SUBLATTICE 1

CR /1/: .1

FE /1/: .8

NI /1/: .0995

FRACTIONS IN SUBLATTICE 2

C /1/: .05

N /1/: .05

 
Temperature /2000/: <Temperature of interest, in K>

Specify the temperature of interest in K.

 
Pressure /100000/: <Pressure of interest, in pa>

Specify the pressure of interest in Pa.
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Example Output

For the FCC phase in the Fe-Cr-Ni-C-N-O system (using the SSOL database), the following 
table is obtained at a specified composition:

TAB: TAB_DER

Phase name /BCC/: FCC

SPECIFY SUBLATTICE (0 FOR ALL) /0/: <Enter>

FRACTIONS IN SUBLATTICE 1

CR /1/: .1

FE /1/: .8

NI /1/: .3

SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER

NI /0/: .0995

FRACTIONS IN SUBLATTICE 2

C /1/: .05

N /1/: .05

Temperature /1800/: <Enter>

Pressure /100000/: <Enter>

Gibbs energy: ..................... -1.27432533E+05

Helmholz energy: .................. -1.27433205E+05

Enthalpy: .........................  5.95773994E+04

Internal energy: ..................  5.95767279E+04

Entropy: ..........................  1.03894407E+02

Molar volume: .....................  6.71473258E-06

Thermal expansivity: ..............  7.63886416E-05

Isothermal compressibility: .......  6.02925387E-12

Heat capacity at constant pressure:  4.33555074E+01

First partial derivative with respect to CR in sublattice  1     of Gibbs energy: 
................ -1.26034739E+05     of enthalpy: ....................  
4.63000206E+04     of entropy: .....................  9.57415334E+01     of 
volume: ......................  6.87203263E-06

Second partial derivative of Gibbs energy with respect to also

  CR                       in  1:  1.54392858E+05

  FE                       in  1: -1.53353158E+04

  NI                       in  1: -1.71750366E+04

  O                        in  1:  0.00000000E+00
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  C                        in  2: -1.82016870E+05

in  2: -3.73062665E+05

  VA                       in  2: -9.36260878E+04

irst partial derivative with respect to FE in sublattice  1     of Gibbs energy: 
................ -1.02869265E+05

    of enthalpy: ....................  6.11738912E+04     of entropy: 
.....................  9.11350866E+01     of volume: ......................  
7.53441165E-06

Second partial derivative of Gibbs energy with respect to also

FE                       in  1:  1.82508696E+04

NI                       in  1: -3.07043434E+03

in  1:  0.00000000E+00

C                        in  2: -1.36027071E+05

in  2: -2.13007485E+05

VA                       in  2: -1.11741180E+05

First partial derivative with respect to NI in sublattice  1     of Gibbs energy: 
................ -1.32427029E+05     of enthalpy: ....................  
5.21563580E+04     of entropy: .....................  1.02546326E+02     of 
volume: ......................  0.00000000E+00

    Second partial derivative of Gibbs energy with respect to also

  NI                       in  1:  1.48390257E+05

in  1:  0.00000000E+00

  C                        in  2: -7.70620431E+04

in  2: -1.61551726E+05

VA                       in  2: -1.12772206E+05

First partial derivative with respect to O in sublattice  1     of Gibbs energy: 
................ -2.62929308E+05     of enthalpy: ....................  
5.02555370E+04     of entropy: .....................  1.73991581E+02     of 
volume: ......................  0.00000000E+00

Second partial derivative of Gibbs energy with respect to also

in  1:  2.99322360E+07

C                        in  2:  0.00000000E+00

N                        in  2:  0.00000000E+00

VA                       in  2: -1.82377137E+05

First partial derivative with respect to C in sublattice  2     of Gibbs energy: 
................ -1.59508417E+05     of enthalpy: ....................  
1.21269096E+05     of entropy: .....................  1.55987507E+02     of 
volume: ......................  1.06885187E-05

Second partial derivative of Gibbs energy with respect to also

C                        in  2:  2.99322360E+05

N                        in  2: -1.90144000E+04
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VA                       in  2: -2.78465070E+04

First partial derivative with respect to N in sublattice  2     of Gibbs energy: 
................ -2.39671400E+05     of enthalpy: ....................  
4.04456947E+04     of entropy: .....................  1.55620608E+02     of 
volume: ......................  0.00000000E+00

Second partial derivative of Gibbs energy with respect to also

N                        in  2:  2.99322360E+05

VA                       in  2: -3.30383665E+04

First partial derivative with respect to VA in sublattice  2     of Gibbs energy: 
................ -9.52042686E+04     of enthalpy: ....................  
5.37142294E+04     of entropy: .....................  8.27324989E+01     of 
volume: ......................  6.86700739E-06

Second partial derivative of Gibbs energy with respect to also

VA                       in  2:  1.66290200E+04
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TABULATE_REACTION

This command is for the TABULATE_REACTION (TAB) module.

Tabulate thermodynamic property changes for a chemical reaction as a table, or variation of 
one chosen property can be plotted against temperature as a graph, or saved as an 
experimental file (with an extension of .EXP). The thermodynamic data are automatically 
retrieved from the SSUB5 database (by default), or the current database set by the SWITCH_
DATABASE command (thus there is no need to use the DATA module before this command). 
You can select any other database by using SWITCH_DATABASE.

It is important to remember the rules to specify a reaction:

 l The reaction is specified, by giving the reactants and products, such as Ga+S=GaS, 
5Al+2Fe=Al5Fe2.

 l Under Linux environments, the notation for a chemical formula treats upper and 
lower cases as the same (such as ga+s=GaS, 5Al+2Fe=al5fe2); but under Windows, 
the TAB module only accepts upper cases, e.g. GA+S=GAS, 5AL+2FE=AL5FE2.

 l Elements with a single letter symbol must be followed by a stoichiometry factor, 
even if it is 1; thus, the symbol CO is taken as cobalt, carbon monoxide must be given 
as C1O1 (or O1C1).

 l All the reactants and products must be defined as species-stoichiometries in the 
currently-used database; in other words, the reaction definition only accepts already-
defined species-stoichiometries as reactants and products. For example, if a 
database does not have a species defined with a stoichiometry of Al5Fe2 {e.g. the Al 
and Fe (but not Al5Fe2) may be defined as species, and the Al5Fe2 phase may be 
defined as a two-sublattice stoichiometric phase [Al]5[Fe]2, rather than a single 
sublattice stoichiometric phase [Al5Fe2]}, then the reaction 5Al+2Fe=Al5Fe2 cannot 
be tabulated.

 l Make sure that the Gibbs free energy expression for a stoichiometric phase is really 
corresponding to the species-stoichiometry. For example, if a database has a 
definition of Function GAL5FE2 for 1/7 of the AL5FE2 formula, then the relation G
(Al5Fe2)=7*GAL5FE2 must be defined; otherwise, the tabulated thermodynamic 
properties for the reaction 5Al+2Fe=Al5Fe2 is wrong.

Syntax TABULATE_REACTION

Prompts

Same reaction? /Y/: 

This prompt displays if there is at least one reaction already defined either with the commands 
ENTER_REACTION or TABULATE_REACTION. The following prompts only display if N is entered.

 Reaction: <Chemical reaction equation> & <RA+RB=PC+PD>
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Syntax TABULATE_REACTION

A long reaction can be typed over several lines. A reaction should be terminated by a semicolon (;) 
or an empty line. A list showing the used database, defined elements, getting-data sequence, 
references, etc.

Pressure /100000/: <pressure of interest, in pa>

Low temperature limit /298.15/: <T-low, in K> Specify the starting temperature K.

High temperature limit /298.15/: <T-high, in K> Specify the ending temperature K. Step 
in temperature /100/: <T-step> Specify the temperature step for the tabulation.

 

Output file /Screen/: <Return for screen, or type a file name>

If you type Return for screen, a list of thermodynamic property changes for the defined/chosen 
reaction is shown as a table (which is demonstrated in the example outputs given below), and the 
command is terminated.

If typing a file name, the table is both displayed on screen and saved as an *.EXP or a *.TAB file, and 
the program prompts:

 

Graphical output /Y/: 

 l For N a table is output to the screen, and the same table is saved as a basic text file with 
the default extension .TAB under the current working directory. In this case, the graph 
cannot be plotted.

 l For Y a table is created with all thermodynamic functions as normal (which is displayed on 
screen) and generates a graph with temperature on the X-axis and a chosen property on a 
certain column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP 
file), and it also asks which column is to be plotted on the resulting graph:

 

Plot column? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus temperature as X-
axis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e. 
the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The 
default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional 
column 6 is a user-entered function. The table displays on the screen. The plot then displays on the 
screen, followed by a POST: prompt. The POST module automatically opens, and all types of the 
POST module commands to refine the plotted diagram may be used. Possibilities include scaling the 
X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST: prompt always 
takes you back to the TAB module.

Example

For the reaction Ga+S=GaS (using the SSUB database), the following table is obtained by 
typing <Enter> in the prompt Output file /SCREEN/, and the figure by typing 2 in the prompt 
Plot column /2/:

  O U T P U T  F R O M  T H E R M O - C A L C

   Reaction:  S+GA=GA1S1

stable as S_S

GA stable as GA_S
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GA1S1 stable as GA1S1_S

Delta-Cp      Delta-H       Delta-S       Delta-G

(K)    (Joule/K)      (Joule)      (Joule/K)      (Joule)

***************************************************************

298.15  -2.79489E+00  -2.09200E+05  -1.50580E+01  -2.04710E+05

300.00  -2.87516E+00  -2.09205E+05  -1.50755E+01  -2.04683E+05

302.   ---- GA becomes GA_L ,delta-H =   5589.80

367.   ---- S becomes S_S2 ,delta-H =    401.00

389.   ---- S becomes S_L ,delta-H =   1721.00

400.00  -1.22278E+01  -2.17521E+05  -4.07488E+01  -2.01222E+05

500.00  -1.57686E+01  -2.19323E+05  -4.47280E+01  -1.96959E+05

600.00  -1.02518E+01  -2.20583E+05  -4.70410E+01  -1.92359E+05

700.00  -6.58954E+00  -2.21430E+05  -4.83534E+01  -1.87583E+05

800.00  -4.46246E+00  -2.21963E+05  -4.90686E+01  -1.82709E+05

900.00  -2.82671E+00  -2.22328E+05  -4.94995E+01  -1.77778E+05

1000.00  -1.21787E+00  -2.22530E+05  -4.97138E+01  -1.72816E+05

1100.00   3.71702E-01  -2.22572E+05  -4.97552E+01  -1.67841E+05
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TABULATE_SUBSTANCE

This command is for the TABULATE_REACTION (TAB) module.

Tabulate thermodynamic properties of a substance (with a given chemical formula but it is 
not certain in which phase/state it may form) or a pure stoichiometric phase (getting data 
from a specific substance database such as SSUB, or from a specific solution database such 
as SSOL and TCFE), or of a solution phase with a fixed composition (getting data from a 
specific solution database such as SSOL and TCFE), under a constant pressure and various 
temperatures.

In case of a pure stoichiometric phase or a solution phase with a fixed composition, you 
must already define the system and get thermodynamic data from an appropriate solution 
database in the TDB module before using this TAB command. The phase name can be given 
either upper or lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc, BCC, 
Liq, cem, Al5Fe2, etc. as the SSOL database is used for the tabulations, or GAS, FE-S, 
wustite, Fe2O3-hem, etc. as the SSUB database is used. The module then optionally goes 
through a specific sublattice or all the possible sublattices for the specified phase, as well as 
through the whole framework of a currently defined system (including all the defined 
elements/species, as well as the default defined vacancy and electron if necessary for the 
current database), when it prompts for inputs of site fractions for various species possibly 
occupying such sublattices. Therefore, you can tabulate thermodynamic properties for a 
pure phase, or for a solution phase as a pure end-member (with a composition definition for 
the corresponding non-interacting species on all necessary sublattices in the end-member), 
or for a solution phase as a real solution (with a composition definition for related 
interacting species on all necessary sublattices in the solution).

Moreover, the variation for one of the tabulated properties for a substance, a pure 
stoichiometric phase, or a solution phase with a fixed composition can be plotted against 
temperature as a graph or saved as an experimental file (with an extension of .EXP).

Syntax TABULATE_SUBSTANCE

Prompt

Substance (phase): <Name of the species or phase>

In case of a substance, give its chemical formula, e.g. Fe, H2, C1H6, FeC1, CaC1O3, MgSiO3, etc. 
When the TABULATE_SUBSTANCE <SUBSTANCE> command sequence is used for the first time in the 
TAB module, it always uses the SSUB Substances database as the default. If SSUB is not available  and 
a specific database has not been switched on yet, it may prompt to specify an appropriate substance 
or solution database (e.g. typing SSUB<version number>; SSOL<version number>; TCFE<version 
number> etc.). Prior to this command, you can also use SWITCH_DATABASE  to set the current database. 
If a solution database is set as the current database, only the neutral species that are valid substance 
standing by themselves as phases can be tabulated.
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Syntax TABULATE_SUBSTANCE

Before other prompts, a list of the used database, defined elements, getting-data 
sequence, references, etc. is displayed on screen. From such information, you know 
what the TAB module is performing.

In case of a pure stoichiometric phase or a solution phase, give its phase name, e.g. FCC, CEMENTITE, 
LIQUID, SLAG, AQUEOUS, GAS, Al5Fe2, Fe-S, Wustite, Fe2O3-Hematite, etc.

REMEMBER: It is important that you have already defined the system and gotten 
thermodynamic data from an appropriate solution database in the TDB module 
before using this TAB_SUB command. It automatically prompts for other options and 
necessary inputs for the definition of the composition of the specified phase.

For a pure stoichiometric phase defined with one single sublattice (such as Fe-S, Wustite, and Fe2O3-
Hematite), no further composition definition is needed.

For a solution phase defined with one sublattice (such as AQUEOUS solution, GAS mixture and SLAG 
solution), it requests n-1 site-fraction inputs for the phase constituents (if there are n species in the 
defined phase within the whole framework of currently defined system, including all the defined 
elements/species, as well as the default defined vacancy and electron if necessary for the current 
database); the nth species is automatically assigned as the rest. 

The sum of input site fractions must not exceed unity. For example, the following 
prompts and inputs can be seen for a LIQUID solution phase (from the SSOL 
database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the 
unprompted Ni species is assigned as the rest):

 

Fraction of constituent (return for prompt): <Return>

C /1/: .05

CR /1/: .1

FE /1/: <RETURN>

 

Sum of fractions exceed unity, please reenter

FE /1/: .8

N /1/: .005

For a pure stoichiometric phase defined with two or more sublattices (such as Al5Fe2 inter-metallic 
stoichiometric phase) and for a solution phase defined with two or more sublattices (such as FCC 
alloy solution, and ION_LIQ ionic liquid solution, Al5Fe4 inter-metallic solution phase), it first asks for 
which sublattice the site-fractions of constituents shall be specified: the default value 0 for all 
possible sublattices, and a given positive number for a specific sublattice (this number must be 
reasonable for the currently specified phase, i.e. it must be smaller than the total sublattice number 
of the phase). Then, for the given sublattice or for all sublattices, it prompts for all the necessary 
inputs of site-fractions for the possible constituents on each sublattice n-1 times if there are n 
species on such a sublattice in the defined phase; the nth species on each of the sublattices are 
automatically assigned as the rest. For example, these prompts and inputs can be seen for an FCC 
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Syntax TABULATE_SUBSTANCE

solution phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, 
the unprompted O species on its sublattice 1 and VA on its sublattice 2 is assigned as the rest):

 

Specify sublattice (0 for all) /0/: 

FRACTIONS IN SUBLATTICE            1

CR /1/: .1

FE /1/: .8

NI /1/: .0995

FRACTIONS IN SUBLATTICE            2

C /1/: .05

N /1/: .05

 
Pressure /100000/: <Pressure of interest, in pa> 

Specify the constant pressure condition in Pa.

 
Low temperature limit /298.15/: <T-low, in K> 

Specify the starting temperature K.

 
High temperature limit /298.15/: <T-high, in K> 

Specify the ending temperature K.

 Step in temperature /100/: <T-step> Specify the temperature step for the tabulation.

 

Output file /Screen/: <Return for screen, or type a file name>

If you type Return for screen a list of basic thermodynamic functions for the chosen substance or 
for the specified pure or solution phase with the fixed composition is shown up as a table (which is 
demonstrated in the example outputs given below), and the command is terminated.

If typing a file name, the table is both displayed on screen and saved as an *.EXP or a *.TAB file, and 
the program further prompts:

 

Graphical output /Y/: 

 l For N a table is output to the screen, and the same table is saved as a basic text file with 
the default extension .TAB under the current working directory. In this case, the graph 
cannot be plotted.

 l For Y a table is created with all the thermodynamic functions as normal (which is displayed 
on screen) as well as generates a graph with temperature on the X-axis and a chosen 
property on a certain column in the table on the Y-axis (which is plotted on screen and 
saved as an *.EXP file), and it also ask which column is to be plotted on the resulting graph:

 

Plot column ? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus temperature as X-axis) 
as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e. the 
plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The default 
column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional column 6 is a 
user-entered function. The table displays on the screen. The plot then displays on the screen, 
followed by a POST: prompt. The POST module (postprocessor) automatically opens, and all types of 
the POST-module commands to refine the plotted diagram may be used. Possibilities include scaling 
the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST: prompt always 
takes you back to the TAB module.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 490 of 622

Example 1

For the FCC alloy phase as a non-ideal solution with a fixed composition

[Fe0.80,Cr0.10,Ni0.0995,O0.005][C0.05,N0.05,VA0.90]

The following table is obtained by typing Return for screen at the prompt Output file 
/SCREEN/:

O U T P U T  F R O M  T H E R M O - C A L C

Phase : FCC                        Pressure :      100000.00

Specie: CR1/--2

***************************************************************

    T      Cp            H             S             G

   (K)    (Joule/K)      (Joule)      (Joule/K)      (Joule)

***************************************************************

298.15   2.70517E+01   6.23824E+03   4.40241E+01  -6.88755E+03

300.00   2.70889E+01   6.28832E+03   4.41916E+01  -6.96915E+03

400.00   2.87304E+01   9.08420E+03   5.22235E+01  -1.18052E+04

500.00   2.99904E+01   1.20222E+04   5.87742E+01  -1.73649E+04

600.00   3.10889E+01   1.50770E+04   6.43408E+01  -2.35275E+04

700.00   3.21116E+01   1.82375E+04   6.92106E+01  -3.02100E+04

800.00   3.30994E+01   2.14982E+04   7.35633E+01  -3.73524E+04

900.00   3.40742E+01   2.48569E+04   7.75182E+01  -4.49094E+04

1000.00   3.50483E+01   2.83130E+04   8.11586E+01  -5.28456E+04

1100.00   3.60268E+01   3.18667E+04   8.45449E+01  -6.11327E+04

1200.00   3.70143E+01   3.55187E+04   8.77219E+01  -6.97476E+04

1300.00   3.80149E+01   3.92700E+04   9.07241E+01  -7.86713E+04

1400.00   3.90311E+01   4.31222E+04   9.35784E+01  -8.78875E+04

1500.00   4.00649E+01   4.70768E+04   9.63064E+01  -9.73827E+04

1600.00   4.11174E+01   5.11358E+04   9.89256E+01  -1.07145E+05

1700.00   4.21896E+01   5.53010E+04   1.01450E+02  -1.17165E+05

1800.00   4.33555E+01   5.95774E+04   1.03894E+02  -1.27433E+05

1900.00   4.58528E+01   6.40379E+04   1.06306E+02  -1.37943E+05

2000.00   4.75402E+01   6.87138E+04   1.08704E+02  -1.48694E+05
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Example 2

For a phase, as either an end-member or real solution, the listed species name 
is irrelevant.

For the H2 species as a pure substance (using the SSUB5 database), the following table is 
obtained by typing  Return for screen  at the prompt Output file /SCREEN/, whilst the 
figure is generated by typing 5 at the prompt Plot column /2/:

         O U T P U T F R O M T H E R M O - C A L C

  Phase : GAS                        Pressure :      100000.00

Specie: H2

***************************************************************    T      Cp            
H             S             G

   (K)    (Joule/K)      (Joule)      (Joule/K)      (Joule)

***************************************************************  298.15   
2.88369E+01   3.17684E-06   1.30680E+02  -3.89622E+04

300.00   2.88473E+01   5.33580E+01   1.30858E+02  -3.92042E+04

400.00   2.91591E+01   2.95686E+03   1.39209E+02  -5.27268E+04

500.00   2.92650E+01   5.87874E+03   1.45729E+02  -6.69856E+04

600.00   2.93441E+01   8.80908E+03   1.51071E+02  -8.18336E+04

700.00   2.94579E+01   1.17488E+04   1.55602E+02  -9.71730E+04

800.00   2.96320E+01   1.47027E+04   1.59547E+02  -1.12935E+05

900.00   2.98786E+01   1.76776E+04   1.63050E+02  -1.29068E+05

1000.00   3.02043E+01   2.06810E+04   1.66214E+02  -1.45533E+05

1100.00   3.05319E+01   2.37171E+04   1.69108E+02  -1.62302E+05

1200.00   3.09281E+01   2.67897E+04   1.71781E+02  -1.79348E+05

1300.00   3.13615E+01   2.99040E+04   1.74274E+02  -1.96652E+05

1400.00   3.18115E+01   3.30625E+04   1.76614E+02  -2.14197E+05

1500.00   3.22641E+01   3.62664E+04   1.78824E+02  -2.31970E+05

1600.00   3.27094E+01   3.95151E+04   1.80921E+02  -2.49958E+05

1700.00   3.31406E+01   4.28078E+04   1.82917E+02  -2.68151E+05

1800.00   3.35526E+01   4.61426E+04   1.84823E+02  -2.86539E+05

1900.00   3.39415E+01   4.95175E+04   1.86648E+02  -3.05113E+05

2000.00   3.43045E+01   5.29300E+04   1.88398E+02  -3.23866E+05
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REACTOR (REACTOR_SIMULATOR) Commands

In this section:

CREATE_DIVIDERS 493

CREATE_PIPES 494

CREATE_STAGE_BOXES 495

EXECUTE_POLY3_COMMAND 497

LIST_RECORDS 498

READ_WORKSPACE 499

SAVE_WORKSPACES 500

START_SIMULATION 501
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CREATE_DIVIDERS

This command is for the REACTOR_SIMULATOR (REACTOR) module.

Define the segment boundaries and the ways on how to distribute phases between various 
segments and to split the feeds of heat and mass.

Syntax CREATE_DIVIDERS

Prompts

Number of dividers /4/: <The number of dividers>

Specify the number of dividers (boundaries between various segments) in the reactor. It is normally 
the segment number plus one: for example, if the stage box number is defined as 4, the divider 
number should be defined as 5.

 
Number of outputs for divider # /3/: <The number of outputs>

Specify the number of outputs for a specific divider #.

 
Percent of input to output 1 /100/: <Percent of input>

Define the percentage of input to the output 1 in the current divider #.

 

Percent of input to output ## /100/: <Percent(s) of input(s)>

Define the percentages of inputs to the outputs ## in the current divider #. It is repeated till the last 
output is specified.
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CREATE_PIPES

This command is for the REACTOR_SIMULATOR (REACTOR) module.

Define the pipes between various segments and the ways on how the mass and heat 
transport between the surroundings (with the record number as 0) and the reactor, among 
various segments in the reactor, and along various dividers (segment boundaries in the 
reactor).

Syntax CREATE_PIPES

Prompts

From record: <A record number>

Specify a record number. If there are four segments in the reactor, these records are available:

 l 0 surroundings

 l 1-4 stage boxes (segments)

 l 5-9 dividers (segment boundaries)

 

Pipe to record: <Another record number>

Specify another record number to which the mass or heat flows from the current record (specified 
above).  Before this prompt, a message shown on the screen indicates what kind of mass or heat 
flow (according to the definitions of stage boxes and dividers, which have already been created 
prior to this command) should be specified in the pipe. This is repeated for all inputs and/or outputs 
for mass and/or heat in current record.
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CREATE_STAGE_BOXES

This command is for the REACTOR_SIMULATOR (REACTOR) module.

Create several reaction stages as boxes (segments), where the you define the feed in either 
mass input and initial temperature or heat input from surroundings, as well as the mass out 
and initial temperature in each of the segments.

Syntax CREATE_STAGE_BOXES

Prompts

Number of stage boxes /4/: <The number of stage boxes>

Specify the number of stage boxes in the reactor. Then define the feed of mass and/or energy (from 
surroundings to) the rector.

 

Give feed to system: <Feed>

One feed (of mass or heat) to the reactor must be specified here. Two types of feeds can be used:

 l As input amount of heat (enthalpy): H=Value.

 l As input amount of specific species or element and its initial temperature: N
(SPECIES)=Value, Input temperature (in one line, or the input temperature in the next 
prompt).

 Input temperature /298.15/: <Input temperature>

 

Give feed to system: <Feed>

Specify other feeds (mass or energy) to the reactor. Press <Enter> to finish the feed inputs, and 
then:

Give for stage box #

Now start to define the type of stage box (segment is specifically numbered as #), and to specify a 
guess of initial temperature and an output for each phase in the segment.

 
Type of box/Equilibrium/: <Type of box>

Only the EQUILIBRIUM type is allowed. Press <Enter> to accept it.

 
Is the stage heat controlled? /Y/: <Yes or No>

Y means the current segment is heat controlled.

 

Initial guess of temperature? /1000/: <Initial temperature>

Give a guess of initial temperature (in K) for the current segment; press <Enter> to accept the 
default.

 

Give initial amount: <Initial amount of mass or heat>

The initial amount of mass and/or heat in the current segment can be specified here. Two types of 
initial amount can be used:

 l As initial amount of heat (enthalpy): H=Value.

 l As initial amount of specific species or element and its initial temperature: N
(SPECIES)=Value, Input temperature (in one line, or the input temperature in the next 
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Syntax CREATE_STAGE_BOXES

prompt).

 Input temperature /298.15/: <Input temperature>

 

Give initial amount: <Initial amount of mass or heat>

Specify initial amount (mass or energy) in the current segment. Press <Enter> to finish the initial 
amount inputs, and then this message displays:

Each phase may have a separate output, give these

Now start to define the output for each phase.

 

Phase name /Rest/: <Name of phase>

Specify a phase that has a separate output, e.g. GAS; by pressing <Enter> to accept that all REST 
phases do not have separate outputs. Then the program asks for further definitions of all the other 
segments (one by one), repeating some of the above questions, till the last segment in the reactor 
is defined.
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EXECUTE_POLY3_COMMAND

This command is for the REACTOR_SIMULATOR (REACTOR) module.

Syntax EXECUTE_POLY3_COMMAND 

 

To directly use all kinds of POLY commands inside the REACTOR module. Any legal POLY commands 
can be entered.

POLY Module Commands
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LIST_RECORDS

This command is for the REACTOR_SIMULATOR (REACTOR) module.

Syntax LIST_RECORDS

 Lists all the already-created records for the reactor (including stage boxes, dividers, pipes, etc.).
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READ_WORKSPACE

This command is for the REACTOR_SIMULATOR (REACTOR) module.

The REACTOR workspace (along with the related POLY and GIBBS workspaces) and the 
simulated results from the SIMULATE command can be read by this command from a binary 
file where they must be saved with  SAVE_WORKSPACE. The *.RCT file is not printable.

Syntax READ_WORKSPACE

Options

File name: The name of a saved *.RCT file where the REACTOR and POLY/GIBBS workspaces shall be 
read from must be specified. You do not need to type the extension if it is the default .RCT, 
otherwise type the whole *.RCT file name.

An Open window displays if a file name is not given after the command or its path is incorrect, so 
that the path (in the Look in field) and File name can be specified. The Files of type (i.e. RCT) cannot 
be changed. 
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SAVE_WORKSPACES

This command is for the REACTOR_SIMULATOR (REACTOR) module.

The POLY module and Gibbs (GES) module also have a command with the same 
name.

The  workspaces are saved to a file with this command. In the REACTOR workspace, all 
definitions of multi-stage steady-state rector and its distribution coefficients are saved, 
together with the GIBBS and POLY workspaces. 

After using this command, you can always return to the state when you issued the command 
by giving a READ command.

After saving the  workspaces to a file, you can exit the software and at a later time READ the 
file and continue from the saved state. 

START_SIMULATION automatically saves on the work file with the most lately 
specified name. To avoid destroying the simulated results, do not SAVE after a 
START_SIMULATE command is enforced, similar to that you should not use SAVE 
after a STEP or MAP command. You may append several results by START_
SIMULATE without destroying the previous results but SAVE erases them all. 

Syntax SAVE_WORKSPACES

 

File name

A file name must be specified. The default extension of the RCT file is .RCT, while or any other 
extension as required.

 

A Save window displays if a file name is not given after the command, so that the path (in the Save in 
field) and File name can be specified. The Files of type (i.e. RCT) cannot be changed. If there is 
already a file with the same file name under the directory a warming message displays. Click OK to 
overwrite the current REACTOR (and POLY3/GIBBS) workspaces onto the existing *.RCT file. Click 
Cancel to return to the REACTOR module. You can use the SAVE command with an unspecified name 
(i.e. through SAVE ,,, command-sequence) to save the REACTOR (and POLY3/GIBBS) workspaces.
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START_SIMULATION

This command is for the REACTOR_SIMULATOR (REACTOR) module.

Start the reactor simulation, and list the results for all iterations. The output for each 
iteration consists of the conditions set in each segment, and you can also select some state 
variables to list. After each loop, the temperatures in all segments are listed.

Syntax START_SIMULATION

Prompts
Max number of loops /10/: <The max number of loops>

Give the max number of loops. The reactor simulation repeats until this loop number is reached.

 

Output to screen or file /Screen/: <File name or return>

Decide on either listing simulation results on the screen (by pressing <Enter>) or saving them on an 
experimental file (with the default extension .EXP). 

The conditions in each segment are not saved in the file, only on the screen.

 

Output variables /T BP($)/: <Variable name(s)>

Specify the variable name(s) that is also listed on the screen together with the conditions in each 
segment, or in the output experimental file.

Example

For a four-stage reactor, the output at a certain iteration may look like this:

H=-991745.1, P=100000, N(C)=2.8468936, N(N)=6.78399966E-4, N(O)=3.8171615,

N(SI)=1.77031

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588099,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

H=-924751,87, P=100000, N(C)=2.0594558, N(N)=5.17999978E-4, N(O)=4.0142358,
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N(SI)=2.7551438

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

H=-813239., P=100000, N(C)=1.6592668, N(N)=3.59999988E-4, N(O)=3.7549293,

N(SI)=2.896635

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

H=7374.6403, P=100000, N(C)=8.84911857E-1, N(N)=1.99999996E-4, N(O)=1.9379203,N
(SI)=1.853872

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175982, BP(C_S)=8.1588097,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

10  1788.03  2065.69  2086.91  2208.31     0.00     0.00     0.00
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POST Module Commands

The POST module (post-processor) is available from the these modules: POLY, TAB, BIN, 
TERN, POT, SCHEIL and POURBAIX.

Using the POST Module

In this section:

ADD_LABEL_TEXT 506

APPEND_EXPERIMENTAL_DATA 508

CHANGE_LEGEND 509

DUMP_DIAGRAM 510

ENTER_SYMBOL 511

FIND_LINE 514

LIST_DATA_TABLE 515

LIST_PLOT_SETTINGS 516

LIST_SYMBOLS 517

LIST_TIME_STEPS 517

MAKE_EXPERIMENTAL_DATAFILE 518

MODIFY_LABEL_TEXT 519

PLOT_DIAGRAM 520

PRINT_DIAGRAM 521

QUICK_EXPERIMENTAL_PLOT 522

REDUCE_TIMESTEPS_TO_PLOT 522

REINITIATE_PLOT_SETTINGS 523

RESTORE_PHASE_IN_PLOT 524

SELECT_CELL 524

SELECT_PLOT 525

SET_AXIS_LENGTH 526
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SET_AXIS_PLOT_STATUS 527

SET_AXIS_TEXT_STATUS 528

SET_AXIS_TYPE 529

SET_COLOR 530

SET_CORNER_TEXT 532

SET_DIAGRAM_AXIS 533

SET_DIAGRAM_TYPE 535

SET_FONT 536

SET_INTERACTIVE_MODE 537

SET_LABEL_CURVE_OPTION 538

SET_PLOT_FORMAT 539

SET_PLOT_OPTIONS 540

SET_PLOT_SIZE 542

SET_PREFIX_SCALING 543

SET_RASTER_STATUS 544

SET_REFERENCE_STATE 545

SET_SCALING_STATUS 547

SET_TIC_TYPE 548

SET_TIELINE_STATUS 549

SET_TITLE 550

SET_TRUE_MANUAL_SCALING 551

SUSPEND_PHASE_IN_PLOT 552

TABULATE 553
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ADD_LABEL_TEXT

Add a text to an area in a phase diagram or a property diagram. The label is written starting 
from the specified coordinates. Optionally, you can also let the program automatically add 
the text by first calculating an equilibrium state at the specified coordinates and then 
making a label out of the stable phase names.

The label texts and coordinates, either added by this command or modified with MODIFY_
LABEL_TEXT (or manually edited in the Console Results window), are stored in the 
workspace, and these may later be saved onto an *.EXP file (with MAKE_EXPERIMENTAL_
DATAFILE).

In some cases such an optional calculation for automatic phase region labeling 
may not work. It is not possible to automatically add labels for certain sets of 
axes, like entropy, enthalpy, pH, Eh, etc.

Plot Labels 

Syntax ADD_LABEL_TEXT

Prompts
Give X coordinate in axis units: <Value of the X coordinate>

Specify the value of the X coordinate where the label is to start.

 

Give Y coordinate in axis units: <Value of the X coordinate>

The labels disappear if any axis is changed after wards.

Specify the value of the Y coordinate where the label is to start.

 

Automatic phase labels? /Y/:

By default the program automatically calculates the equilibrium at the given coordinates and 
generates a label with the names of the stable phases. However, the automatic calculation works 
only for phase diagrams that are mapped with two axes in the POLY module, and sometimes it may 
not work correctly especially for complex heterogeneous interaction systems; in such cases, a 
message displays.

 

Text: <Text for the label>

If you answer N enter text at the prompt. You can enter simple text, use LaTeX, rotate the text, as 
well as adjust the font size.

LaTeX: You can use LaTeX commands to enter text and symbols. First enter the command followed 
by the expression or string, for example to display Al2O3 with subscripts:

\latex Mole-fraction Al_2O_3
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Syntax ADD_LABEL_TEXT

By default when using the LaTeX command, you are in math mode and Thermo-Calc 
automatically interprets the entered text as math. The above link uses the dollar 
sign ($) in all the examples but this is NOT required. For example, if you enter 
$E=mc^2$ this is displayed including the $ instead of the equation.

To add a mixture of plain text and equation text, you can exit math mode using the 
string \textsf followed by the text to display enclosed in curly brackets. 

For example \latex \textsf{Mole-fraction }Al_2O_3 displays this sans serif label 

White space has to be entered in the text context and not outside in math mode.

Rotate the text: If you want to rotate the label, start a text string with the rotation command 
(which is case sensitive and must be in lower case letters) then enter the number of degrees to 
rotate the label. For example, to rotate the label 45 degrees enter:

\rotation 45

To rotate the text and use LaTeX, the rotation command must be used first. For example:

\rotation 45 \latex Mole-fraction Al_2O_3

Rotates the text 45° and includes subscripts in the title Mole-fraction Al2O3.

 

Text size: /.35/: <Size for the label>

A smaller size of the text may be necessary to fit the label text into the diagram. A default size is 
given using the latest size in adding label texts, or .35 if the command is called for the first time. A 
recommended size is e.g. 0.25.

These changes to plot labels can also be manually edited in the Console Results 
window.

 

Examples
To produce a label with the unit Celsius: 

\textsf{Temperature [}^\circ C\textsf{]}

Text with white space, suitable for an axis label: 

\textsf{Text with space} Al_2O_3
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APPEND_EXPERIMENTAL_DATA

Add experimental data and text onto a calculated diagram. This is done by placing the 
experimental data and text on a formatted textual file (always having an extension of EXP) 
that is prepared outside of Thermo-Calc software (Console Mode and Graphical Mode), 
according to the syntax of the DATAPLOT Graphical Language. 

The picture generated from the data is superimposed on the ordinary graphical output from 
the postprocessor. Such an experimental data file (*.EXP) may be created by an ordinary 
textual editor.

Another important usage of this command is to superimpose plots from several 
independent calculations. For this purpose, there is a command MAKE_EXPERIMENTAL_
DATAFILE, which dumps a calculated diagram on an EXP file according to the DATAPLOT 
syntax. With the aid of a normal text editor, many such files may be merged together. 
Remember that you can only have one prologue section on each such EXP file.

DATAPLOT User Guide included with this documentation set.

Syntax APPEND_EXPERIMENTAL_DATA

Prompts

Use experimental data (Y or N) /N/: 

By default, no experimental data are plotted. Enter Y to use the data from an experimental data file 
in the next plot. An Open window displays to specify the name of the file with the experimental 
data.

 

Prologue number: /0/: <Prologue number>

Select which prologue to use. In a prologue, you can, for example, give the scaling of an axis, the 
axis texts, and so on. 

By answering -1, a list of all prologues on the file is given; and by 0, no experimental 
data are appended.

 

Dataset number(s) /-1/: <Dataset number(s)>

Select from which dataset(s) data should be read. Several datasets may be given separated with 
commas or spaces. By answering -1, a list of all datasets on the file is given; and by 0, no 
experimental data are appended.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 509 of 622

CHANGE_LEGEND

When there is a legend in the diagram you can append constitution and/or ordering 
descriptions to the phase name. 

LIST_EQUILIBRIUM also displays ORD (ordered) or DISORD (disordered) (when 
available).

In some cases the legend only shows the phase name for a line when SET_
LABEL_CURVE_OPTION is set to F.

Syntax CHANGE_LEGEND

Prompt

Set suffix for phase names in legend? (All, None, Constitution, Ordering)/None/:

 l None: the legend includes the standard information about the phases.

 l All: the Constitution description and the Ordering description (when there is ordering) are 
also included.

 l Constitution: it is added to the standard description. 

 l Ordering (when applicable): it is added to the standard description.

 For examples and more details about what these options show, see About Legend 
Styles and Legend and Label Styles where it is described for Graphical Mode.
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DUMP_DIAGRAM

This is an alternative command used to create output. First use the PLOT_DIAGRAM 
command to send output to the Console Results window. Then you can save it to a file 
either using this command or right-click the diagram in the Console Results window and 
select Save as.

Similar to PRINT_DIAGRAM, it does not matter what graphic device/printer is 
set up. The command can convert the diagram shown in the Console Results 
window to the selected format.

Syntax DUMP_DIAGRAM 

Prompt Output format/: (jpg,ps,pdf,svg,emf,gif,png) /png/

 

Enter a format or press <Enter> to accept the default (png).

If you choose to enter the parameters and file name in one line (i.e. when you are 
entering the command), the Save window does not open as described below. For 
example, if you enter dump_diagram png test at the prompt, an image file called 
test.png is output to the same folder where the macro file is stored. If a file with the 
specified name already exists, you are prompted to overwrite the old file. You can 
alternatively add Y or N to the command string to specify whether to overwrite the 
file or not e.g. dump_diagram png test y.

A Save window opens if you have not specified a file name. Select a directory path and enter a File 
name. If a file with the specified name already exists, then you are prompted whether to overwrite 
the old file or not. The third argument of the command (Y) allows you to specify whether to 
overwrite  the old file or not (N).

After the output is done, the temporarily set graphic device for conversion and 
printing is switched back to the one set by the command SET_PLOT_FORMAT, so 
that you can save the graph in file(s) using PLOT_DIAGRAM.
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ENTER_SYMBOL

This command is for the  POST module.

There are also a GES and POLY module commands with the same name.

Symbols are a useful feature of the POLY and POST modules to define quantities that are 
convenient. Symbols can be constants, variables, functions or tables.

Functions or tables (with defined functions as values) can be entered in the POST module 
after a stepping or mapping calculation, for purposes of plotting such entered functions or 
tables as axis variables.

Within the POLY module, symbols are normally defined prior to an equilibrium calculation 
(enforced by a C_E command), stepping calculation (enforced by the command STEP_WITH_
OPTIONS) or mapping calculation (enforced by MAP). These can be entered after an 
equilibrium calculation; however, for defined functions, variable or tables, it requires using 
EVALUATE_FUNCTIONS before showing the corresponding values in the calculated equilibrium 
state. 

The symbols entered in the POST module are not saved in the currently-loaded POLY3 
workspaces. Therefore, if you want to apply such symbols in other similar calculations for 
the same defined system, you must use the ENTER_SYMBOL command prior to the 
STEPPING or MAPPING calculation in the POLY module.

See example 44  for an example of using variables and functions.

Symbols are a useful feature modules to define quantities that are convenient. Symbols can 
be constants, variables, functions, or tables.

Syntax ENTER_SYMBOL

Prompt

Constant, Variable, Function or Table? /Function/: <Keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION, or TABLE.

 l CONSTANTS can only be entered once and is a means of using a name for a numeric value. 
For example, the value of 1 atmosphere in Pascal can be denoted by P0 after the command 
ENTER_CONSTANT P0=101325. Defined constants can be used as values in condition 
assignments, for example, SET-COND P=P0.

 l FUNCTIONS are expressions of state variables or other functions. These expressions are 
saved, and whenever a function value is requested all functions are evaluated. The reason 
for this is that they may depend on each other.

 l VARIABLES are similar to functions because they can also be expressions of state variables. 
However, contrary to functions, they are only evaluated when they are entered or if they 
are explicitly named in an EVALUATE_FUNCTIONS command. It is possible to enter a variable 
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Syntax ENTER_SYMBOL

with a new expression any time. This expression is evaluated directly and its value stored as 
the value of the variable. Defined variables can be used as values in the SET_CONDITION 
command.

 l TABLES are used for listing results from the STEP or MAP commands. A table consists of a 
list of any number of state variables, functions, or variables. Defined tables can also be used 
in the POST (post-processor) module.

There is a special connection between tables and variables. If a variable is used in a 
table, it is evaluated for each line of the table in the TABULATE command or when the 
table is used in a plot.

 

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 
8 characters.  Legal characters include letters (either UPPER or lower case), digits and 
underscore _. Any other special character, such as parentheses ( and ), plus +, minus 
-, slash / or \, full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line; these must be separated 
with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a definition of 
temperature in Celsius. Otherwise, these questions are asked.

For different types of symbols (constant, function, variable, or table), the questions 
have different prompts.

 

Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or other functions, 
constants, or variables. The expression is a FORTRAN-like expression and operators +,  -, *, = and ** 
can be used (** only with integer powers). 

Unary functions like LOG, LOG10, EXP, SIN, COS, and ERF can also be used. An expression can be 
continued on more than one line. An expression should be terminated by a semicolon (;) or an 
empty line (press <Enter> at the next prompt). 

Examples of function expressions:

 l GM(LIQUID): The Gibbs energy of liquid per mole component

 l H.T/4.184: The heat capacity of the system in calories

 l ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

 l T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is 
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Syntax ENTER_SYMBOL

not enough for the function. If you finish the function press <Enter> again.

 
Value: <Value for a constant>

A constant can only be assigned a numeric value once.

 

Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is evaluated immediately 
and discarded. Only the numeric value is kept. This gives a possibility to save a value between 
calculations with different conditions because all state variables and functions are evaluated for the 
new conditions.

 

Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP 
command is through a table.  

Example:

ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole fractions 
of C and Cr in the LIQUID phase, and the activity of C.

To show the temperature in Celsius in a table, give the command ENTER_FUNCTION TC=T-273; and 
then use the symbol TC in the table.

& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new line if one line is not 
enough for the table. If you finish the table press <Enter> again.
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FIND_LINE

Identifies various property curves on a plotted property diagram (after a stepping 
calculation); it also works well in find stable phase regions on a phase diagram (after a 
mapping calculation).

Syntax FIND_LINE

Prompts

X coordinate /.484623611/: <Value of the X coordinate>

Specify the value of the X coordinate where you want to find the details of property curve (or 
phase region).

 

Y coordinate /.5153737962/: <Value of the Y coordinate>

Specify the value of the Y coordinate where you want to find the details of property curve (or 
phase region).

The POST module displays the identified property (for a property curve on a property diagram), or 
the identified stable phase-assemblage (for a phase region on a phase diagram).
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LIST_DATA_TABLE

This is a POST module command.

This command is used for listing various properties (i.e. the Y-axis variable on a property 
diagram) that change with an independent variable (i.e. the X-axis variable on a property 
diagram), which have already been defined in the POST module (and often are plotted on 
the Console Results window), but only after a STEP calculation. 

The listing output can be either on screen or in a spreadsheet file in the MS Excel format 
(under specified file name with the default file extension of XLS), which can be further 
edited or used for graphical handling by opening the file (using the MS-Excel program) 
outside of the Thermo-Calc software system.

Syntax LIST_DATA_TABLE

Prompt

Output to screen or file /Screen/: <File name or return >

Specify a file name if you want to save on a spreadsheet file (in the MS Excel format, with the default 
extension of XLS) on which the already-defined properties on a property diagram (after a STEP 
calculation) is saved, or press <Enter> if want to see a simple textual table on screen (for the already-
defined properties that change alone with an independent variable).

This command only works for a property diagram after a stepping calculation but not 
for any phase diagram after a mapping calculation.
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LIST_PLOT_SETTINGS

This is a POST module command.

Syntax LIST_PLOT_SETTINGS

 Lists the present values of most parameters specifying the type of diagram to be plotted.
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LIST_SYMBOLS

This command is for the  POST module.

There is also a POLY module command with the same name. 

Use this command to list the definitions for all constants, functions, variables and tables.  In 
order to find the value of a function or variable, use SHOW_VALUE or EVALUATE_FUNCTIONS. A 
table is tabulated with the TABULATE command.

Syntax LIST_SYMBOLS

 The defined variables are listed up together with the defined functions, but variable names are 
followed by a percentage sign %.

LIST_TIME_STEPS

This for the POST PROCESSOR module.

Use the LIST_TIME_STEPS command to list all integration time steps. 
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MAKE_EXPERIMENTAL_DATAFILE

Write the graphical information onto screen or a formatted text file (always having an 
extension of .EXP) using the DATAPLOT graphical format. In order to merge two or more 
diagrams from separate calculations, you can write them out on files with this command, 
and then add/edit them together with a normal text editor.

There is another type of experimental data file that is generated in Thermo-Calc 
when working with the PARROT module. For more information seeExperimental 
Data Files (*.POP, *.DOP).

Syntax MAKE_EXPERIMENTAL_DATAFILE 

Prompt

Output to screen or file /Screen/: <Name of a file or return>

Specify the name of the desired file. Press <Enter> for a list. Otherwise enter a file name where the 
graphical information is written. The default file extension is EXP (for Windows) or exp (for Linux).
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MODIFY_LABEL_TEXT

Move a label created with the command ADD_LABEL_TEXT to another position, or replace its 
text with another one.

The label texts and the coordinates, either added by ADD_LABEL_TEXT command or 
modified by this command or manually edited on the Console Results window, are stored in 
the workspace, and can be saved onto an *.EXP file (through MAKE_EXPERIMENTAL_DATAFILE).

Syntax MODIFY_LABEL_TEXT

Prompts

Which label to modify? /#/: <Number of the label>

Before this prompt, all the labels created by the ADD_LABEL_TEXT command is listed with an 
identifying number. Specify the Number of the label you want to modify. The default one (#) is 
the last added label.

 
New X coordinate: /xxx/: <New X position>

Specify the New X position. The previous X coordinate is displayed. Press <Enter> to accept.

 
New Y coordinate: /yyy/: <New Y position>

Specify the New Y position. The previous Y coordinate is displayed. Press <Enter> to accept.

 

New text /ABCDEFGH.../: <New labeling text>

Specify the New labeling text. The previous text is displayed. Press <Enter> to accept. 

The new label text must not be longer than the previous text.
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PLOT_DIAGRAM

After you use the SET_PLOT_FORMAT command to define the default graphic device (the 
printer) you can use a PLOT_DIAGRAM command to either save the calculation output to a file 
or display the output in the Console Results window. 

The diagram axes must be set first.

The functionality of this command is shared in two ways: 

 l in PLOT_DIAGRAM for normal screen display and file saving and 
 l Windows OS: If the device is not defined, you can alternatively use PRINT_DIAGRAM for 

a hard copy.

Syntax PLOT_DIAGRAM 

Prompt
Output to screen or file /Screen/: <Name of a file or return for screen>

Specify the name of the file

 

For Linux users, the prompt is PLOTFILE /SCREEN/). 

A file with a proper extension for the selected graphic format (set by SET_PLOT_FORMAT) is saved 
under the current working directory. If no extension is given in the file name, the default extension 
e.g. ps for Postscript portrait/landscape modes, P7 or p7 for HPGL landscape, P8 or p8 for HPGL 
portrait, etc.) is automatically given to the file name.

If the default device is set (SET_PLOT_FORMAT), press <Enter> to plot the diagram on the screen in the 
Console Results window or  give a file name to save it.
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PRINT_DIAGRAM

Saving and Printing the Output in Console Mode

First use PLOT_DIAGRAM to create a diagram that displays in the Console Results window. 
Then after entering the PRINT_DIAGRAM command, the Print window opens where you can 
choose additional settings for a hard copy of the diagram.

PRINT_DIAGRAM functions in the same way as in the Console Results window 
where you can right-click a diagram and choose Print. 
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QUICK_EXPERIMENTAL_PLOT

This is similar to APPEND_EXPERIMENTAL_DATA but can be used when there is no graphical 
information to be plotted in the POLY3 workspace. It defines a pair of axes, sets the axis 
labels to X and Y, and scales both X- and Y-axes between 0.0 and 1.0 unless a prologue is 
read from the DATAPLOT (*.EXP) data file.

Plotting Experimental Data Files in the DATPLOT User Guide included with this 
documentation set.

Syntax QUICK_EXPERIMENTAL_PLOT 

Prompts

Prologue number: /0/: <Prologue number>

An Open window displays. Select the prologue to use. In a prologue, you can, for example, give the 
scaling of an axis, the axis texts, and so on. By answering -1, a list of all prologues on the file is 
given; and with 0, no experimental data are appended.

 

Dataset number(s) /-1/: <Dataset number(s)>

Select from which dataset(s) data should be read. Several datasets may be given separated with 
commas or spaces. By answering -1, a list of all datasets on the file is given; and with 0, no 
experimental data are appended.

REDUCE_TIMESTEPS_TO_PLOT

The REDUCE_TIMESTEPS_TO_PLOT command reduces the number of timesteps used in a plot. 
The command requires a fraction of the total number of stored timesteps, where 1 is to use 
all timesteps and 0 is to use no timesteps.

If post-processing a large store file with too many timesteps, this factor may be 
automatically reduced.

Syntax REDUCE_TIMESTEPS_TO_PLOT

Prompt

Fraction of Timesteps to Use /1/:

The fraction of the total number of stored timesteps to be used in the post-processing, where 1 is to 
use all timesteps and 0 is to use no timesteps.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 523 of 622

REINITIATE_PLOT_SETTINGS

The REINITIATE_PLOT_SETTINGS command gives default values to all parameters describing 
the diagram.  All plot settings made in the POST module are deleted, and it returns to the 
initial settings when the POST module is entered.
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RESTORE_PHASE_IN_PLOT

Restores a phase previously suspended from the plot with SUSPEND_PHASE_IN_PLOT. It works 
only after at least one phase is suspended.

Syntax RESTORE_PHASE_IN_PLOT 

Prompt
Phase name: <Name of a phase>

Give the name of the phase to be restored.

SELECT_CELL

Select the cell data to be processed. You can only plot data from one cell at a time. Type ? to 
get a list of valid cell numbers. This command is for the POST PROCESSOR. 

Also see the DICTRA module prompt of the same name SELECT_CELL.

The current cell number is displayed as a part of the POST PROCESSOR prompt.

Syntax SELECT_CELL

Prompt

Number

Number of the cell to be selected. Specify cell number by giving an integer or one of the key words 
NEXT or PREVIOUS.

 

Tabulate

Tabulate a named table. 

The independent variable is always printed in the first column.

 
Name

Give the symbolic name of the table.

 
Output file /Screen/

Select output device/file. Press Enter to get output on the screen.

../../../../../../Content/DICTRA_Commands/SELECT_CELL.htm
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SELECT_PLOT

Select a plot (diagram) within the current Results tab in the Console Results window.

Syntax SELECT_PLOT

Prompt

Plot <N/New>

Where N is a positive integer. Enter the number of the plot that is selected in the Console Results 
window (in the currently selected Results tab). If a plot with that number does not exist, it is created.

The default parameter value is NEW. If this is entered, then a new plot is created. Create a new plot 
can also be done by pressing <Ctrl+Shift+T>.
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SET_AXIS_LENGTH

Change the real length of an axis in inches. The default number of tic-marks on an axis is 10 
when the relative length is 1. The number and units per tic-mark must be a multiple of 1, 2 
or 5 to obtain a reasonable scaling of an axis.

Syntax SET_AXIS_LENGTH

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis to set the length.

 

Axis length /11.5/: <New relative axis length>

Specify the new real axis length in inches. The relative length 1 corresponds to 10 tic-marks on the 
axis.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 527 of 622

SET_AXIS_PLOT_STATUS

Specify whether the axis title texts and axis label texts are to be plotted or not on a diagram. 
It does not work for the axis lines and tic-marks. If you want to plot a diagram without tic-
marks, use SET_TIC_TYPE first.

This can be used to merge different diagrams on a pen-plotter or to obtain the diagram 
faster. The default status is that all the set axes are to be plotted.

Syntax SET_AXIS_PLOT_STATUS 

Prompt Axis plot (Y or N) /Y/: (Y or N)
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SET_AXIS_TEXT_STATUS

Change the axis text from the automatic text given by the axis specification to a text.

ADD_LABEL_TEXT

Syntax SET_AXIS_TEXT_STATUS

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis text status to change.

 
Automatic axis text (Y or N) /N/: 

Specify if automatic axis text is to be used. 

 
Axis text: <Enter axis text>

You can enter simple text, use LaTeX, rotate the text, as well as adjust the font size. 
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SET_AXIS_TYPE

Change the axis type among linear, logarithmic and inverse axis.

Syntax SET_AXIS_TYPE

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis to change the axis type.

 

Axis type /Linear/: <New axis type>

Specify which new axis type to set. Select LINear (default), LOGarithmic or INVerse. Only the three 
first characters are relevant.
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SET_COLOR

Some devices support colours or line thickness. With this command, select different colors 
or line types on some types of information on a diagram. 

This command can fail if a chosen device does not support colors or line 
thickness. 

This command gives four sequential prompts (i.e. text and axis, invariant equilibria, tie-lines, 
and all other lines), with the keyword and default option (both listed below). Depending on 
if the switched-on graphic device (by SET_PLOT_FORMAT) supports colors or line types, the 
POST automatically switches on the appropriate Keyword.

Syntax SET_COLOR

Prompt

Text and axis keyword /Default option/

<Return or new option>

Invariant equilibria keyword /Default option/: <Return or new option>

Tie-lines color keyword /Default option/: <Return or new option>

Keyword of all other lines /Default option/: <Return or new option>

This is usually for the solubility lines.

  

 
The Keyword is either Color or LineType, depending on if color or line type is 
supported by the switched-on graphic device (by SET_PLOT_FORMAT); the POST 
module automatically switches on the appropriate Keyword .

Color Options

The options for Color are:

BACKGROUND BLUE PURPLE GRAY

FOREGROUND (default) YELLOW GOLD4 ORANGERED3

RED (default for invariant equilibria) MAGENTA TURQUOISE4 MAROON

GREEN (default for tie lines) CYAN PINK PLUM
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 SIENNA OLIVEDRAB SEAGREEN

 ORANGE1 CORAL1 USERDEF

LineType Options

The options for LineType are:

INVISIBLE VERY_THICK  (default for invariant equilibria)

NORMAL (default) THIN (default for tie lines)

THICK VERY_THIN

DASHED DOTTED



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 532 of 622

SET_CORNER_TEXT

Adds text to the corners on a plotted diagram. Normally, you can write such texts as a 
subtitle.

The primary database (not the appended ones) used in calculations and the calculated 
conditions are automatically plotted at the upper-left corner as a part of the header on all 
plotted diagram. Unless the plotting option WRITE CONDITIONS is switched off by the 
command SET_PLOT_OPTIONS, the calculated conditions are always written on plotted 
diagrams; and only when the plotting option PLOT HEADER is switched off by the command 
SET_PLOT_OPTIONS, the used database also always appear. Under such circumstance, avoid 
writing texts at the UPPER_LEFT corners.

Syntax SET_CORNER_TEXT

Prompt

Corner/Lower_Left/: <Return or new option>

Choose an option:

 l LOWER_LEFT

 l UPPER_LEFT

 l UPPER_RIGHT

 l LOWER_RIGHT

 l TOP_OF_TRIANGLE

 
Text: <Texts as a subtitle or a note>

Write the texts that are to be written on the specified diagram corner.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 533 of 622

SET_DIAGRAM_AXIS

Specify an axis variable for a plot or a listing. To be able to plot a diagram, at least two axis 
variables (X and Y) must be specified. In  Console Mode, three axes (X, Y, and Z)  can be 
specified for a diagram. 

The axis variables in the plot can be different from the number of axis used for 
the mapping. 

If you want to plot a phase diagram with tie-lines in the plane after a MAP calculation, then 
the composition axis must be mole-fraction or weight-fraction, or mole-percent or 
weight-percent of one specific component. You must not use the stable variable x(comp) or 
w(comp) even if that is what you used when calculating the diagram, because that only gives 
one side of the two-phase region. It may be sufficient to indicate that mole-fraction is the 
same as the stable variable x(*,comp), and weight-fraction is the same as the stable variable 
w(*,comp).

If you plot a phase diagram where the tie-lines are not in the plane after a MAP calculation, 
then mole-fraction and x(comp) are identical.

When you plot a property diagram after a STEP calculation and want a composition axis 
variable, you should normally use x(comp) and not mole-fraction.

The axis must have exactly the same number of columns, or one axis must have one column. 
In the first case the columns are plotted matching them one by one; in the latter all columns 
on one axis is plotted against the single column. For example, you can have the temperature 
on one axis and the amount of each phase on the other. The amount of each phase is the 
state variable NP(*) in mole fraction or BPW(*) for mass fractions of phases.

Automatic diagram axis:  The POST module can set automatic diagram axis identical to those 
used in the MAP command. 

If the state variable x(comp) is used in a MAP calculation, then mole-fraction of the 
component is used as diagram axis; if a potential or some other state variables are used, 
then that is used as a diagram axis.

After a STEP calculation, automatic diagram axis is not set as there is only one axis used in 
the calculation.

Syntax SET_DIAGRAM_AXIS 

 
Axis (X, Y or Z): <Axis name>

Specify which axis (X or Y or Z) to set with a variable.
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Syntax SET_DIAGRAM_AXIS 

Prompts

Variable type: <Variable name>

Specify a variable for the chosen axis here.

The valid variables are:

 l TEMPERATURE-CELSIUS as temperature in °C

 l TEMPERATURE as temperature in K

 l PRESSURE as pressure in Pa

 l ACTIVITY for a component

 l LNACTIVITY for a component  [ln(ACR(component)]

 l MOLE-FRACTION  for a component

 l MOLE-PERCENT for a component 

 l WEIGHT-FRACTION for a component

 l WEIGHT-PERCENT for a component 

 l ENTHALPY as enthalpy in J/mol

 l ENTROPY as entropy in J/mol/K

 l NONE  to clear the axis

 l Any valid state variable including those with wildcards, e.g. NP(*) or x(*,component). Due 
to the use of wildcard * in such a state variable, the program asks for a column number.

 l Any entered function or variable.

 l Any entered table.

 

If you specify an entered table as the variable, then you are given these prompts:

For component: <Component name>

When an activity, mole or weight fraction or percent of a component shall be plotted, the 
component name must be supplied here.

 

Column number: <Column number(s)>

Specify the column number(s) in the chosen table that are to be plotted onto the earlier specified 
axis.  For example:

 l 1 for column 1

 l 2,3 for columns 2 and 3

 l 2,3 >5 for column 2,3 and all columns above column 5

 l * for all columns
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SET_DIAGRAM_TYPE

Choose the diagram type as perpendicular plot or triangular plot (Gibbs triangle, especially 
for ternary systems). The default is with a perpendicular axes.

For phase diagrams of ternary or pseudo-ternary systems, it is usually need to plot 
isothermal sections as triangular grams. If desired, all lines outside the region limited by a 
line joining the end points of the X- and Y-axis is removed.

Syntax SET_DIAGRAM_TYPE

Prompts

Triangular diagram (Y or N) /N/: 

The default is to set a perpendicular axis. Perpendicular diagrams have (almost) the same scaling on 
both axes. 

Create tetrahedron WRML file (Y or N) /N/:

The 3D plotting in Console Mode does not work. Enter Y to specify a triangular plot 
instead.

 

Plot 3rd axis (Y or N) /N/: 

If a triangular plot is selected, enter Y to specify a 3rd axis and to connect (and plot) the end points 
of the X- and Y-axes.

 

Clip along 3rd axis (Y or N) /N/: 

If a triangular plot is selected, enter Y so that all lines outside the region limited by a line joining the 
end points of the X- and Y-axis are removed.
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SET_FONT

Select the font to use for labels and numbers when plotting the diagram under the currently 
selected graphic device (SET_PLOT_FORMAT). For some devices there may be other fonts 
available and these are selected by SET_PLOT_FORMAT.

Syntax SET_FONT

Prompts

Select font number /1/: <#>

Specify an available font number # as the default font for the current graphic device, or 
accept the font number 1 by pressing <Enter>. By typing a question mark ? here, the 
program lists the available fonts under the currently selected graphic device.

 
Font size /.34/: <##>

The size of the chosen font is specified. A value around 0.34 is recommended.
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SET_INTERACTIVE_MODE

In the  POLY module  this is called SET_INTERACTIVE.

Use the SET_INTERACTIVE_MODE command to use it in demonstration or macro files  to stop 
the execution of the command file and pass over input focus to the keyboard. 
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SET_LABEL_CURVE_OPTION

Identify the curves drawn in the post-processor by marking each curve with a digit and then 
list the meaning of these digits beside the plot.

The number of digits can be quite large in some cases. If so, use SET_FONT and 
reduce the font size; usually, 0.2 is sufficient. 

Syntax SET_LABEL_CURVE_OPTION 

Prompt Curve label option (A, B, C, D, E, F OR N) /A/: <Option>

 

The options:

 l A: List stable phases along line

 l B: As A but curves with same fixed phase have same number

 l C: List axis quantities

 l D: As C but curves with same quantities have same number

 l E: As B with changing colors

 l F: As D with changing colors

 l N: No labels

This question is rather cryptic but usually the option B or E is good for phase diagrams (after a MAP 
command) and option D or F for property diagrams (after a STEP command). Those interested can 
try out the option A and C by themselves. 

Option B or E lists the fixed phases along each curve, whereas option D or F gives the 
axis variables used along each curve. E provides varied colors for different stable-
phase curves on phase diagrams (after a MAP command); F provides varied colors 
for different property curves on property diagrams (after a STEP command). The 
option N (NONE) disables all curve labels and lists.

If, for example, you use T (temperature in K) as the variable axis in a STEP command and then plot 
the amount of stable phases (with SET_DIAGRAM_AXIS Y NP(*)) on the Y-axis versus T-C on the X-axis, 
then the list may have lines like:

1: T-273.15, NP(LIQUID)

2: T-273.15, NP(FCC_A1)

This means that for curve 1 the X-axis is T-273.15 (the same for all curves, of course) and NP
(LIQUID) on the Y-axis. Curve 2 has the same X-axis but NP(FCC_A1) on the Y-axis.
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SET_PLOT_FORMAT

Adjust the format of the graphical output to another graphical device. This default can be 
changed with the SET_PLOT_ENVIRONMENT command in the SYSTEM MONITOR.

Syntax SET_PLOT_FORMAT

Prompt

Graphic device number /#/: <Number of the device>

Specify a graphic device number. Depending on the hardware, different plot formats (graphic 
devices) may be available. These are listed online by giving a question mark ?.

For some formats there can be additional sub-prompts (Y or N) about the available fonts being used 
for the chosen format. Also enter Y for further specifications, e.g. font type and size.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 540 of 622

SET_PLOT_OPTIONS

You are prompted for and can toggle on (Y) or off (N) the plotting of some options on all 
subsequently generated diagrams.

For the Always initiate POST on re-entering prompt, the default is Y which implies that 
the POST module automatically reinitiates whenever the POLY3 workspace is changed upon 
re-entering. If answered N the same diagram axis variables are kept even if the workspaces 
in the POLY module are read from or written to a *.POLY3 file. The N answer is useful when 
there are several sets of *.POLY3 files with the same calculation but for different sets of 
model parameters.

For the Always solid line prompt, the default answer is N which means that the POST 
module plots solid lines for stable phases but dashed lines for metastable phases. This is 
normally for plotting property diagram after a STEPPING calculation; however, when there is 
a metastable extrapolation in a phase region on a phase diagram after a MAPPING 
calculation, this is also enforced. When the alternative answer Y is chosen, all the lines are 
always plotted in solid lines.

Syntax SET_PLOT_OPTIONS

Prompts
Plot header /Y/: 

Toggle the plotting of the header text above a diagram.

 
Plot logo /Y/: 

Toggle the plotting of the Thermo-Calc logo at the lower-left corner of a diagram.

 
Plot footer /Y/: 

Toggle the plotting of the footer identifier text at the right margin of a diagram.

 
White-Contoured-PS-CHARS /Y/:

By default, the PostScript characters are written as a white contoured status. 

 
Plot remote exponent(s) /Y/: 

By default the remote exponent on the axis is plotted.

 
Plot symbols at node points /0/: <#>

This makes it possible to plot symbols at the node points on plotted lines on a diagram.

 
Symbol size /.1/: <.#>

Set the size of symbols which are plotted at the node points.

 

Write condition? /Y/: 

By default, the initial equilibrium conditions for the current calculations are 
automatically plotted at the upper-left corner as a part of the header. If you enter N, 
the calculated conditions are not included on a plotted diagram.

 Write database name? /Y/: 
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Syntax SET_PLOT_OPTIONS

By default, the primary database (not appended ones) used in the current calculations 
are plotted at the upper-left corner as a part of the header.  If you enter N, the 
database name is not included on a plotted diagram.

 

Always initiate POST on re-entering: /Y/: 

By default the POST module automatically reinitiates whenever the POLY3 workspaces 
are changed upon re-entering. 

If you enter N, the same diagram axis variables are kept even if the workspaces in the 
POLY module is read from or written to a *.POLY3 file. This can be useful when there 
are several sets of *.POLY3 files with the same calculation but for different set of 
model parameters.

 

Always solid line: /N/: 

By default the POST module plots solid lines for stable phases and dashed lines for 
metastable phases. This is normally for plotting property diagrams after a STEPPING 
calculation. However, when there is a metastable extrapolation in a phase region on a 
phase diagram after a MAPPING calculation, this is also enforced. Enter Y to always 
plot solid lines in this case, for example.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 542 of 622

SET_PLOT_SIZE

Change the size of the diagram by specifying a global plot size (as a relative scaling factor). 
The default value of the relative scaling factor is 1, while the real size of the plotted diagram 
depends on what output device is chosen with SET_PLOT_FORMAT. The default plot size 
(corresponding to the default global plot size 1) is adjusted to the chosen device.

Syntax SET_PLOT_SIZE 

Prompt

Global plot size /1/: <Relative scaling factor>

Enter the relative scaling factor as a numerical number (e.g. 0.5, 0.8, 1.0, 1.5, etc.).  By pressing 
<Enter>, the default relative scaling factor (1) is accepted.
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SET_PREFIX_SCALING

Specify on which axis is to have a prefix scaling then set the scaling of remote exponents 
with certain powers.

Syntax SET_PREFIX_SCALING

Prompt
Axis (X, Y or Z): <Name of an axis>

Specify which axis is to have a prefix scaling.

 

Use prefix scaling /Y/: (Y or N or #)

 l NO switches off its action.

 l YES arranges the prefix scaling so that the axis scaling is done with the remote exponents 
being powers of three, i.e. ...,-6,-3,0,3,6,.... The default is 3. 

 l # is an integer number that sets the remote exponents as being powers of # (as the powers 
for the remote exponents).
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SET_RASTER_STATUS

Plot a raster (i.e. with gridlines on both axis directions) in the diagram. 

Syntax SET_RASTER_STATUS 

Prompt
Raster plot (Y or N) /N/:

By default no raster is plotted. Enter Y to plot using a raster plot.
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SET_REFERENCE_STATE

This command is available for the POLY, ED-EXP and POST modules.

The reference state for a component is important when calculating activities, chemical 
potentials, and enthalpies and is determined by the database being used. For each 
component the data must be referred to a selected phase, temperature, and pressure, i.e. 
the reference state. 

All data in all phases where this component dissolves must use the same 
reference state. However, different databases can use different reference 
states for the same element/component. It is important to be careful when 
combining data obtained from different databases.

By default, activities, chemical potentials, and so forth are computed relative to the 
reference state used by the database.  If the reference state in the database is not suitable 
for your purposes, use this command to set the reference state for a component using SER, 
i.e. the Stable Element Reference (which is usually set as default for a major component in 
alloys dominated by the component). In such cases, the temperature and pressure for the 
reference state is not needed.

In order to specify conditions in the specific reference state, you can append an R to the 
state variables. Thus, AC is the activity (of a system component or of a species in a phase) 
with respect to the default reference state, and ACR is the activity with respect to the 
selected reference state; MU is the chemical potential of a system component with respect 
to the default reference state, and MUR stands for the chemical potential with respect to the 
selected reference state. The AC and ACR variables, for both components in a system and 
species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).

For the POST module, and after calculating with the STEP_WITH_OPTIONS or MAP commands, 
the reference state for a component can also be changed to plot various properties of the 
component in the entire system or in a specific phase. Then you can set the diagram axes as 
the chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR
(comp,ph), ACR(comp),  ACR(comp,ph) or the common logarithms [e.g. LNACR(comp,ph)].

Syntax SET_REFERENCE_STATE 

Prompts
Component: <Name of the component>

The name of the component must be given.

 Reference phase: <Name of a phase used as the new reference state>
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Syntax SET_REFERENCE_STATE 

Enter the Name of a phase for the system. 

For a phase to be usable as a reference for a component, the component needs to 
have the same composition as an end member of the phase. The reference state is 
an end member of a phase. The selection of the end member associated with the 
reference state is only performed once this command is executed. 

If a component has the same composition as several end members of the chosen reference phase, 
then the end member that is selected at the specified temperature and pressure will have the 
lowest Gibbs energy. 

The following are example using temperature. Pressure is used in the same way:

 l In the Fe-C system, BCC can be a reference state for Fe but not for C since BCC can exist as 
pure Fe but cannot exist as pure C. 

 l If GAS is chosen as the reference phase of component O at such a high temperature that 
O1 has the lowest energy, then O1 remains the reference state even at calculations 
performed at lower temperatures where O2 has a lower energy than O1.

 l Setting the reference state for component O as gas (one sublattice) with constituents O1, 
O2 and O3 results in O2 being the reference state if, at the present temperature, pure O2 
has the lowest energy of O1, O2 and O3. If the reference state is set above a critical higher 
temperature, then O1 has the lowest energy and consequently becomes the reference 
state. 

 

Temperature /*/: <Temperature for the reference state>

Select the Temperature (in K) for the reference state. The wildcard value * means the current 
temperature is used at the time of evaluation of the reference energy for the calculation. 

The temperature set with this command does not affect the temperature used 
when evaluating the energy of the reference state during the end member 
selection process.

 

Pressure /1E5/: <Pressure for the reference state>

Select the Pressure (in Pa) for the reference state. The wildcard value * means the current pressure 
is used for evaluating the reference energy at the time of calculation.

 

Examples
S-R-S Fe SER

S-R-S Cr FCC * 100000

S-R-S H2O AQUEOUS * 100000

S-R-S ZE REF_ELECTRODE * 100000
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SET_SCALING_STATUS

When an axis variable is selected by SET_DIAGRAM_AXIS, the scaling status for the axis is 
always set to automatic scaling. By this command, choose between manual or automatic 
scaling on a specified axis. If manual scaling is chosen, specify a minimum and a maximum 
value. Manual scaling can be used to magnify interesting parts of a diagram.

Syntax SET_SCALING_STATUS 

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis that you want to set the scaling status.

 

Automatic scaling (Y or N) /N/: 

The default is manual scaling. Enter Y for automatic scaling (N). 

For manual scaling specify the Min and Max values. 

 
Min value: <Minimum value>

The minimum value at the start point of the specified axis.

 
Max value: <Maximum value>

The maximum value at the end point of the specified axis.
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SET_TIC_TYPE

Change the drawing of the axis tics. You may alter the placement of tic marks on the axis, 
e.g. inside or outside or no tic marks. The size of tic marks cannot be altered by this 
command, but these are adjusted based on the selected graphic device and the defined 
relative scaling factor (global plot size).

Syntax SET_TIC_TYPE 

Prompt

TIC Type /1/: <1 or -1 or 0>

The tic type 1 is default, i.e. the tics are drawn outside the diagram. -1 means that the tics are inside 
the diagram and 0 means no tics.
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SET_TIELINE_STATUS

If the tie-lines are in the plane of the calculation, you can select to plot the tie-lines in two-
phase fields with this command.

Syntax SET_TIELINE_STATUS

Prompt

Plotting every tie-line no. /0/: <Number of tie-lines>

The tie-lines plotted are not equally spaced by the graphics software. Instead, you can select to plot 
a subset of the calculated tie-lines, i.e. every one (1), every second (2), every three (3), etc. By 
accepting the default value 0, no tie-line is plotted.
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SET_TITLE

Specify a title that displays on all listed tables and plotted diagrams from the POST module.

ADD_LABEL_TEXT

Syntax SET_TITLE 

Prompt

Title

Enter the title you want to appear on all tabulation or graphic outputs. 

There is a maximum length of about 60 characters for the title. You can enter simple 
text, use LaTeX, rotate the text, as well as adjust the font size. 
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SET_TRUE_MANUAL_SCALING

The tic-marks on the axes are normally placed in even intervals using the whole axis length. 
The scaling routine adjusts the given minimum and maximum values slightly to accomplish 
this. If such an automatic adjustment behaviour is unwanted, it can be avoided by using this 
command (followed by a message showing the TRUE MANUAL SCALING set for a specific axis).

The command works like a toggle. To reset the automatic scaling behaviour, repeat the 
command a second time for that specific axis (followed by a message saying the SEMI_
MANUAL SCALING set for the specific axis.

Syntax SET_TRUE_MANUAL_SCALING

Prompt

Axis (X, Y or Z): <Name of an axis>

Specify which axis (X or Y or Z) you want to toggle between automatic adjustments or avoid the 
adjustment of the given maximum and minimum values.
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SUSPEND_PHASE_IN_PLOT

Specify that lines originating from the presence of a certain phase shall not be plotted on a 
diagram. If you want to bring the suspended phase back to the diagram, use RESTORE_PHASE_
IN_PLOT.

Syntax SUSPEND_PHASE_IN_PLOT

Prompt
Phase name: <Name of a phase>

Specify the name of the phase to be suspended from the diagram.
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TABULATE

This command is available for a table entered in either the POLY or POST 
module.

For any entered table, this command gives a table of values from equilibria calculated with a 
STEP command. 

Unlike the TAB module's command (also called TABULATE) it is not possible to 
plot columns from the tabulated tables. For this use normal POST commands.

Syntax TABULATE

Prompts
Name: <Name of a table entered in either POLY or POST>

Specify a table name that is entered in either the POLY or POST module.

 

Output on screen or file /Screen/: 

Specify a file name if you want to save on a file the table values along the defined STEP calculation, 
or press <Enter> if want to see the table values displayed.
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Technical Notes
In this section:

Technical Note: Pipe or Redirect Output Data from Console Mode 555
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Technical Note: Pipe or Redirect Output Data from Console 
Mode

Audience: Advanced Programmers and Users

OS: Windows, Linux, or macOS

Application:
For users who want to pipe or redirect data from Thermo-Calc running a macro in Console Mode.

For example, you can start the application with the Thermo-Calc.bat file and the entire 
application closes when you enter the EXIT command in the Console prompt.

Command 
examples:

WINDOWS

Thermo-Calc.bat macro.tcm > output.log

LINUX

./Thermo-Calc.sh batch macro.tcm > output.log

MACOS

./Thermo-Calc.command batch macro.tcm > output.log

Command line definitions

>

Redirection command. The arrow indicates the flow of data. For example in ./Thermo-Calc.sh  
macro.tcm > output.log, the contents of macro.tcm is used as input to the Thermo-Calc.sh 
script file and the resulting output (standard out) is then written to output.log instead of to the 
screen.
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Console Mode Examples
In this section:

Console Mode Examples 557

Binary Phase Diagram Examples 559

Property  Diagram Examples 563

Ternary Phase Diagram Examples 568

Multicomponent Phase Diagram Examples 572

Thermodynamic and Related Quantities Examples 574

Single Equilibrium Calculation Examples 578

Potential Diagram Example 580

Scheil-Gulliver Examples 581

Chemical Ordering Example 583

Gibbs Energy System (GES) Examples 584

T0 Temperature Example 589

Paraequilibrium Examples 590

Functions and Variables Examples 591

PARROT and EDIT_EXPERIMENT Examples 592

Pourbaix Diagram Examples 594

Pourbaix Examples TCEX40A, 40B, 40C, and 40E 597

POURBAIX_DIAGRAM Commands for Options 1 to 4 601

Tabulate Reaction (TAB) Example 614

REACTOR Module Example 615

Thermophysical Properties Examples 616

Application Examples 619
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Console Mode Examples

There are many examples to examine and to help you learn Thermo-Calc in Console Mode 
(CM). Some of the examples in the table below are included with specific sections, whereas 
some of the general examples are included (repeated) in more than one section.

Opening Console Mode Macro Files

Thermo-Calc and DICTRA Console Mode Example Macros PDF

All the macro files and the outputs are also combined into one file that you can 
search and read. This is included with your installation as a PDF (go to Help > 
Manuals folder > All Thermo-Calc Documentation and open  Thermo-Calc 
Console Mode Example Macros. 

All the macro files and the outputs are also combined into one file that you can 
search and read. This is included with your installation as a PDF (go to Help → 
Manuals folder → Diffusion Module (DICTRA) and open  Diffusion Module 
Console Mode Example Macros. 

Thermo-Calc CM Examples

Each topic  has a brief description of the example and includes some or all of the commands 
used in the macros. 

Topic TCEX Examples included

Binary Phase Diagram Examples 1, 4, 13, 16, 17, 26, 31, 34, 50

Property  Diagram Examples 2, 8, 9, 11, 12, 22, 23, 28, 29, 32, 41, 49, 50

Ternary Phase Diagram Examples 3, 5, 14, 17, 19A, 19B, 21, 33, 37, 42, 43

Multicomponent Phase Diagram Examples 6, 10, 23, 27

Thermodynamic and Related Quantities Examples 2, 13, 14, 18, 22, 26, 34, 39, 51

Single Equilibrium Calculation Examples 7, 18, 20

Potential Diagram Example 35
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Topic TCEX Examples included

Scheil-Gulliver Examples 15, 30A, 30B, 48, 54, 57

Chemical Ordering Example 16

Gibbs Energy System (GES) Examples 31, 38, 39, 49, 52

T0 Temperature Example 23

Paraequilibrium Examples 23, 42, 43

Functions and Variables Examples 44

PARROT and EDIT_EXPERIMENT Examples 36A (consists of various parts). 

Pourbaix Diagram Examples 40, 40A, B, C, and E, 53

Tabulate Reaction (TAB) Example 12

REACTOR Module Example 24

Thermophysical Properties Examples

55 - Viscosity

56 - Surface Tension

58 and 59 - Molar Volume

60 - Electrical Resistivity and Thermal Conductivity

Application Examples

9 - Dew Point

10 - Continuous casting, preventing Cr2O3 clogging

11 - Gas oxidation of Cu2S

20 - Adiabatic decompression in Geological system

24 - Silicon arc furnace

27 - Chemical Vapour Deposition

28 - Materials design of a stainless steel

29 - Gas speciation

41 - Solubility product

44 - Proof strength calculated from empirical functions
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Binary Phase Diagram Examples

tcex01 - Calculating the Binary Fe-C Phase Diagram

This example calculates the binary Fe-C phase diagram using the Binary module. The TCBIN 
database is used and included with your installation.

Some of the main commands used:

 l LIST_EQUILIBRIUM
 l LIST_STATUS
 l LIST_CONDITIONS
 l CHANGE_STATUS
 l COMPUTE_EQUILIBRIUM
 l SET_DIAGRAM_AXIS
 l SET_TIELINE_STATUS
 l PLOT_DIAGRAM
 l SET_SCALING_STATUS
 l SET_LABEL_CURVE_OPTION
 l ADD_LABEL_TEXT
 l MODIFY_LABEL_TEXT

tcex04 - Calculating the Fe-Cr Miscibility Gap

This example calculates the miscibility gap in the Fe-Cr system. The FEDEMO database is 
used and included with your installation.

These commands are used: 

 l SWITCH_DATABASE
 l GET_DATA
 l LIST_EQUILIBRIUM
 l SET_AXIS_VARIABLE
 l DEFINE_SYSTEM
 l AMEND_PHASE_DESCRIPTION
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 l SET_CONDITION
 l SAVE_WORKSPACES 
 l REJECT
 l LIST_STATUS
 l COMPUTE_EQUILIBRIUM
 l SET_TIELINE_STATUS

tcex13 - Calculating the Binary Al-Ti Phase Diagram and its G Curve

This example calculates an Al-Ti binary phase diagram and G curve using the BINARY module. 
The TCBIN database is used and included with your installation.

tcex16 - Second Order Transition of the Al-Fe System

This example calculates the second order transition line in the BCC field of the Al-Fe system.

This uses the SSOL database. A license is required to run the example.

These commands are of note and used in this example:

 l REJECT
 l RESTORE
 l ADVANCED_OPTIONS
 l SET_SCALING_STATUS
 l DEFINE_SYSTEM
 l MAKE_EXPERIMENTAL_DATAFILE
 l LIST_EQUILIBRIUM
 l APPEND_EXPERIMENTAL_DATA
 l STEP_WITH_OPTIONS
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tcex17 - The Pseudo-binary System - CaO-SiO2

This example calculates the pseudo-binary system CaO-SiO2 using the OXDEMO database, 
which is included with your installation.

The oxide demo (OXDEMO) database can be used both for pseudo-binary systems like the 
one in this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O.

For a more advanced example in Graphical Mode using the TCS Metal Oxide 
Solutions Database (TCOX), see T_17: Al2O3-MgO Phase Diagram.

These commands are of note and used in this example:

 l LIST_SYSTEM
 l REJECT and RESTORE
 l AMEND_PHASE_DESCRIPTION
 l LIST_STATUS
 l DEFINE_COMPONENTS
 l SET_CONDITION
 l COMPUTE_EQUILIBRIUM and LIST_EQUILIBRIUM

tcex26 - The As-Ga Phase Diagram: Plotting the Partial Pressures of a 
Gas Species
This is an example of plotting the partial pressures of a gas species along the solubility lines 
in the As-Ga phase diagram. The calculation makes it possible to monitor the input gases to 
a process of depositing solid As-Ga. The data is taken from the PG35 Binary Semi-Conductors 
database.

These commands are of note and used in this example:

 l REJECT
 l RESTORE
 l SET_DIAGRAM_AXIS
 l SET_SCALING_STATUS
 l SET_AXIS_TEXT_STATUS
 l SET_LABEL_CURVE_OPTION
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tcex31 - Using GES to Calculate CVM

Using the Gibbs Energy System (GES) module, this example calculates the CVM and 
compares it with the sublattices of a fictitious A B system. You also learn how to overlay 
diagrams from two calculations.

This example uses some GES commands that are not yet supported by GES6. 
Therefore, we enforce the use of GES5.

These GES commands are of note and used in this example:

 l ENTER_ELEMENT
 l ENTER_SPECIES
 l ENTER_SYMBOL
 l ENTER_PHASE
 l ENTER_PARAMETER
 l LIST_PHASE_DATA

tcex34 - The Al-Zn Phase Diagram and its G Curve

This example uses the BINARY module to calculate the phase diagram and G curves in the Al-
Zn system. It uses the TCBIN database included with your installation.
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Property  Diagram Examples

tcex02 - Plotting Thermodynamic Functions

This example shows how to plot thermodynamic functions in unary, binary, and ternary 
systems. It also involves working with partial derivatives and partial quantities.

This uses the SSOL database. A license is required to run the example.

These commands are used and may be of interest:

GOTO_MODULE GET_DATA SET_CONDITION

SWITCH_DATABASE AMEND_PHASE_DESCRIPTION LIST_EQUILIBRIUM

DEFINE_SYSTEM COMPUTE_EQUILIBRIUM SET_AXIS_VARIABLE

SAVE_WORKSPACES STEP_WITH_OPTIONS SET_DIAGRAM_AXIS

ENTER_SYMBOL PLOT_DIAGRAM SET_LABEL_CURVE_OPTION

REJECT RESTORE LIST_SYSTEM

LIST_STATUS CHANGE_STATUS SHOW_VALUE

SET_INTERACTIVE   

tcex08 - Property Diagrams for a High Speed Steel

This example shows how to calculate property diagrams for a high speed steel i.e. phase 
fraction plots, activity vs temperature, and so forth.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:
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 l DEFINE_DIAGRAM
 l DEFINE_ELEMENTS
 l AMEND_PHASE_DESCRIPTION
 l REINITIATE_PLOT_SETTINGS

tcex09 - Calculating a Dew Point with POLY3

This is an example calculating the dew point in the POLY3 module. The SUBDEMO database 
is used and included with your installation.

The STEP_WITH_OPTIONS and MAP commands are of note and used in this example.

tcex11 - Oxidation of Cu2S with an H2O/O2 Gas Mixture
This example demonstrates the oxidation of Cu2S with an H2O/O2 gas mixture. Thermo-Calc 
is used to find the optimum O/H ratio (i.e. oxygen potential) as certain oxygen potential 
values can desulphurize Cu2S without forming copper oxides.

In Thermo-Calc, the problem reduces to perform equilibria calculations in a Cu-S-H-O 
system. The amounts of the components should be kept to correct ratio corresponding to 
Cu2S and H2O using a command SET_INPUT_AMOUNTS in POLY3. Initially, O/H = 0.5 is given. 
Optimum O/H ratio is calculated with the desired calculation conditions. For example, to 
simulate one phase disappearing, you can FIX the phase with zero amount.

The tcex11.TDB file is used to access data and this is included with your installation.

These commands are of also of note and used in this example:

 l SET_NUMERICAL_LIMITS
 l SET_REFERENCE_STATE
 l SHOW_VALUE

tcex12 - Tabulation of Thermodynamic Data for Reactions
This example shows a number of independent cases using the TABULATE_REACTION (TAB) 
module to tabulate thermodynamic data for reactions.

This uses the SSUB database. A license is required to run the example.
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These commands are of note and used in this example:

 l TABULATE_REACTION
 l DEFINE_SPECIES
 l ENTER_FUNCTION
 l QUICK_EXPERIMENTAL_PLOT
 l SET_SCALING_STATUS
 l LIST_SUBSTANCES
 l TABULATE_SUBSTANCE

tcex22 - Calculating an Adiabatic Flame Temperature

This example examines a heat balance when C3H8 is burned in oxygen by calculating the 
adiabatic flame temperature.

This uses the SSUB database. A license is required to run the example.

tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a Low 
Alloyed Steel

This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.

This uses the TCFE database. A license is required to run the example.

tcex28 -  Pitting Resistance Equivalence (PRE) for a Duplex Stainless Steel

This example  calculates the Pitting Resistance Equivalence (PRE) for a duplex stainless steel.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:
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 l REJECT
 l RESTORE
 l DEFINE_ELEMENTS
 l AMEND_PHASE_DESCRIPTION
 l EVALUATE_FUNCTIONS
 l SET_START_CONSTITUTION

tcex29 - Calculating the Speciation of a Gas

This example shows how to calculate the speciation of a gas.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l SET_INPUT_AMOUNTS
 l LIST_CONDITIONS
 l SET_CONDITION

tcex32 - Calculating Oxide Layers on Steel

This example calculates oxide layers on a steel.

This uses the TCOX database. A license is required to run the example.

These commands are of note and used in this example:

 l SET_START_CONSTITUTION
 l SET_REFERENCE_STATE
 l APPEND_DATABASE

tcex41 - Calculating a Solubility Product

Calculation of a solubility product. 
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This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

 l DEFINE_ELEMENTS
 l REINITIATE_PLOT_SETTINGS
 l SET_DIAGRAM_AXIS

tcex49 - Quasichemical Model Using GES
This example shows how to enter parameters for a FACT quasichemical liquid model and 
how to calculate the sulfur activity using the GIBBS_ENERGY_SYSTEM (GES) module 
commands.

This example uses some GES commands that are not yet supported by GES6. 
Therefore, the example uses  GES5.

These commands are of note and used in this example:

 l ENTER_ELEMENT
 l ENTER_SYMBOL
 l AMEND_ELEMENT_DATA
 l ENTER_PARAMETER
 l ENTER_SPECIES
 l SET_REFERENCE_STATE
 l SHOW_VALUE
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Ternary Phase Diagram Examples

tcex03 - Calculating an Isothermal Section

This example calculates an isothermal section using the Ternary module. The 
FEDEMO database is used and included with your installation.

These commands are used: 

 l AMEND_PHASE_DESCRIPTION
 l ADD_LABEL_TEXT
 l PLOT_DIAGRAM
 l SET_DIAGRAM_AXIS; SET_DIAGRAM_TYPE; and SET_AXIS_TYPE
 l SET_REFERENCE_STATE
 l CHANGE_STATUS
 l SET_SCALING_STATUS

tcex05 - Calculating a Vertical Section in the Al-Cu-Si System

This example calculates a vertical section in the Al-Cu-Si system and of a vertical section 
from Al to 10% Cu2Si. The ALDEMO database is used and included with your installation.

tcex14 - Variations in Solidification of an Al-Mg-Si Alloy

This example calculates the heat and heat capacity variations during solidification of an Al-
Mg-Si alloy. The ALDEMO database is used and included with your installation.

These commands are of note and used in this example:

 l LIST_SYSTEM
 l LIST_CONDITIONS
 l SET_AXIS_TEXT_STATUS

tcex17 - The Pseudo-binary System - CaO-SiO2

This example calculates the pseudo-binary system CaO-SiO2 using the OXDEMO database, 
which is included with your installation.
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The oxide demo (OXDEMO) database can be used both for pseudo-binary systems like the 
one in this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O.

For a more advanced example in Graphical Mode using the TCS Metal Oxide 
Solutions Database (TCOX), see T_17: Al2O3-MgO Phase Diagram.

These commands are of note and used in this example:

 l LIST_SYSTEM
 l REJECT and RESTORE
 l AMEND_PHASE_DESCRIPTION
 l LIST_STATUS
 l DEFINE_COMPONENTS
 l SET_CONDITION
 l COMPUTE_EQUILIBRIUM and LIST_EQUILIBRIUM

tcex19a and tcex19b - Mapping of Univariant Equilibria with the Liquid 
in Al-Cu-Si

 l Part A. Step-by-step calculation using the POLY3 module.
 l Part B. Using the TERNARY module, you can get the information on invariant 

reactions, such as temperature and compositions.

The database used with this example is included with the file named tcex19_cost2.TDB. It is 
in the same folder as this example.

These commands are of note and used in these examples:

 l DEFINE_SYSTEM
 l GET_DATA
 l AMEND_PHASE_DESCRIPTION
 l SET_CONDITION  and LIST_CONDITIONS
 l ADVANCED_OPTIONS
 l SAVE_WORKSPACES  and READ_WORKSPACES
 l APPEND_EXPERIMENTAL_DATA
 l MAKE_EXPERIMENTAL_DATAFILE
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tcex21 - Calculating a Ternary Isotherm in Fe-Cr-Ni

This example calculates a ternary isotherm in Fe-Cr-Ni with a user-defined database included 
with the example in the file named tcex21.TDB.

These commands are of note and used in this example:

 l DEFINE_SYSTEM
 l GET_DATA
 l SET_CONDITION
 l SET_DIAGRAM_TYPE

tcex33 - An Fe-Cr-C Isopleth

This example is a benchmark calculation of an isopleth in the Fe-Cr-C system. The 
FEDEMO database is used and included with your installation.

tcex37 - Calculating an Isothermal Section

This example shows how to use command lines to enter and calculate an isothermal section 
using  the POLY3 module. The FEDEMO database is used and included with your installation.

tcex42 - Paraequilibrium Calculation - Formation of Para-pearlite - 
Isopleth 

This uses the TCFE database. A license is required to run the example.

This example uses an Fe-Mn-C system at 2.5%Mn Mass u-fraction to show a paraequilibrium 
calculation where there is formation of para-pearlite. It is an isopleth calculation and shows 
the STEP_WITH_OPTIONS command using the Paraequilibrium option. 

tcex43 - Paraequilibrium Calculation - Formation of Para-pearlite - 
Isothermal

This uses the TCFE database. A license is required to run the example.
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This example uses an Fe-Mn-C system at 700 °C to show a paraequilibrium calculation where 
there is formation of para-pearlite. It is an isothermal calculation and shows the STEP_
WITH_OPTIONS command using the Paraequilibrium option. 
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Multicomponent Phase Diagram Examples

tcex06 - An Isopleth in Low Alloyed Fe-Mn-Si-Cr-Ni-C Steel
This example calculates a multicomponent phase diagram using the DEFINE_MATERIAL 
command in POLY and the TCFE steel database. The material contains 1.5 %Cr + 0.4 %Mn + 
3.5 %Ni + 0.3 %Si and 1 %C (by weight). These conditions and the temperature are set by the 
DEFINE_MATERIAL command. 

After the first equilibrium results, a phase diagram is calculated with one axis variable as 
temperature and the other as the carbon content.

This uses the TCFE database. A license is required to run the example.

tcex10 - Preventing Cr2O3 Clogging in a Continuous Casting Process
The example calculates an equilibrium with suspended or dormant phases and shows how to 
avoid Cr-oxide clogging in a continuous casting process. 

This uses the TCOX database. A license is required to run the example.

The background of this example is that a manufacturer wanted to increase the Cr content of 
a material from 18 to 25 weight percent. They then had trouble in the continuous casting of 
this material  because solid Cr2O3 was formed. 

Using Thermo-Calc to calculate the equilibria in the steel/slag system, a simple correction 
was found: modify the Mn or Si content to decrease the oxygen potential. 

In Thermo-Calc, you can FIX a phase with zero amount to simulate how to avoid forming this 
phase. You then release one of the conditions, usually one of the compositions, and this 
composition is determined by the equilibrium calculation.

These commands are of note and used in this example:

 l DEFINE_SYSTEM
 l CHANGE_STATUS
 l COMPUTE_EQUILIBRIUM
 l DEFINE_SYSTEM
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 l DEFINE_SYSTEM
 l LIST_CONDITIONS
 l LIST_EQUILIBRIUM
 l LIST_STATUS
 l SET_CONDITION
 l SET_NUMERICAL_LIMITS
 l SET_REFERENCE_STATE
 l SHOW_VALUE

tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a Low 
Alloyed Steel

This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.

This uses the TCFE database. A license is required to run the example.

tcex27 - Calculating Chemical Vapor Depositions (CVD) 

This example calculates the chemical vapor deposition (CVD).

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l DEFINE_COMPONENTS
 l SET_CONDITION
 l ADD_INITIAL_EQUILIBRIUM
 l LIST_AXIS_VARIABLE
 l LIST_INITIAL_EQUILIBRIA
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Thermodynamic and Related Quantities Examples

tcex02 - Plotting Thermodynamic Functions

This example shows how to plot thermodynamic functions in unary, binary, and ternary 
systems. It also involves working with partial derivatives and partial quantities.

This uses the SSOL database. A license is required to run the example.

These commands are used and may be of interest:

GOTO_MODULE GET_DATA SET_CONDITION

SWITCH_DATABASE AMEND_PHASE_DESCRIPTION LIST_EQUILIBRIUM

DEFINE_SYSTEM COMPUTE_EQUILIBRIUM SET_AXIS_VARIABLE

SAVE_WORKSPACES STEP_WITH_OPTIONS SET_DIAGRAM_AXIS

ENTER_SYMBOL PLOT_DIAGRAM SET_LABEL_CURVE_OPTION

REJECT RESTORE LIST_SYSTEM

LIST_STATUS CHANGE_STATUS SHOW_VALUE

SET_INTERACTIVE   

tcex13 - Calculating the Binary Al-Ti Phase Diagram and its G Curve

This example calculates an Al-Ti binary phase diagram and G curve using the BINARY module. 
The TCBIN database is used and included with your installation.

tcex14 - Variations in Solidification of an Al-Mg-Si Alloy

This example calculates the heat and heat capacity variations during solidification of an Al-
Mg-Si alloy. The ALDEMO database is used and included with your installation.

These commands are of note and used in this example:
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 l LIST_SYSTEM
 l LIST_CONDITIONS
 l SET_AXIS_TEXT_STATUS

tcex18 - A3 Temperature of a Steel 

This example calculates the A3 temperature of a steel and examines the influence of each 
alloying element on this temperature.

A3 temperature is the temperature where ferrite starts to form from austenite. You can 
easily read A3 from an Fe-C phase diagram. However, for complex multicomponent steels no 
simple diagram can be used.  Using POLY, it is easy to find out the influence of each alloying 
element on the A3 temperature. This information is useful if you want to modify the 
compositions of a steel but keep A3 unchanged.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

 l DEFINE_ELEMENTS
 l AMEND_PHASE_DESCRIPTION
 l COMPUTE_TRANSITION
 l DEFINE_MATERIAL
 l ENTER_SYMBOL
 l SHOW_VALUE

tcex22 - Calculating an Adiabatic Flame Temperature

This example examines a heat balance when C3H8 is burned in oxygen by calculating the 
adiabatic flame temperature.

This uses the SSUB database. A license is required to run the example.
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tcex26 - The As-Ga Phase Diagram: Plotting the Partial Pressures of a 
Gas Species
This is an example of plotting the partial pressures of a gas species along the solubility lines 
in the As-Ga phase diagram. The calculation makes it possible to monitor the input gases to 
a process of depositing solid As-Ga. The data is taken from the PG35 Binary Semi-Conductors 
database.

These commands are of note and used in this example:

 l REJECT
 l RESTORE
 l SET_DIAGRAM_AXIS
 l SET_SCALING_STATUS
 l SET_AXIS_TEXT_STATUS
 l SET_LABEL_CURVE_OPTION

tcex34 - The Al-Zn Phase Diagram and its G Curve

This example uses the BINARY module to calculate the phase diagram and G curves in the Al-
Zn system. It uses the TCBIN database included with your installation.

tcex39 - Calculating Reversible Carnot Cycles of a Heat Engine
This example shows how to calculate the reversible Carnot cycle of a heat engine using one 
mole of an ideal gas with two fictitious species A and A2. The GES, POLY3, and POST modules 
are used, as well as the SUBDEMO database, which is included with your installation.

One application of the Second Law is to the efficiencies of heat engines, pumps and 
refrigerators. Whenever there is a difference of temperature, work can be produced - the 
principle of heat engines. The Gibbs energy also enables the prediction of the maximum 
work that a process may achieve. The goal of this example is to help relate the results to 
different thermodynamic quantities.  

These commands are of note and used in this example:

 l REINITIATE
 l ENTER_PARAMETER
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 l ENTER_SPECIES
 l SET_PLOT_FORMAT
 l ENTER_PHASE

tcex51 - Calculation of Molar Volume, Thermal Expansivity, and Density

This example uses the POLY3 module to calculate the molar volume, thermal expansivity and 
density of the FCC_A1,                  BCC_A2                  LIQUID, and liquid phases of C-Fe. The FEDMO database is 
used and this example is available to all users. 
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Single Equilibrium Calculation Examples

tcex07 - Single Equilibria in Low Alloyed Fe-Mn-Si-Cr-Ni-C Steel

This example shows how to calculate a single equilibria in a low alloyed Fe-Mn-Si-Cr-Ni-C 
steel. There are two common ways to perform a single equilibrium calculation: 

 l Get data from a database, then in POLY use SET_CONDITION and COMPUTE_
EQUILIBRIUM. 

 l Go directly to POLY and use DEFINE_MATERIAL. 

The COMPUTE_TRANSITION command is also used to determine the temperature or 
composition where one phase forms or disappears. It is the same as the CHANGE_STATUS → 
SET_CONDITION→ COMPUTE_EQUILIBRIUM sequence of commands.

A  STEP_WITH_OPTIONS command using the option normal  is also used in addition to the 
other commands that should be becoming more familiar as you work through the examples.

This uses the TCFE database. A license is required to run the example.

tcex18 - A3 Temperature of a Steel 

This example calculates the A3 temperature of a steel and examines the influence of each 
alloying element on this temperature.

A3 temperature is the temperature where ferrite starts to form from austenite. You can 
easily read A3 from an Fe-C phase diagram. However, for complex multicomponent steels no 
simple diagram can be used.  Using POLY, it is easy to find out the influence of each alloying 
element on the A3 temperature. This information is useful if you want to modify the 
compositions of a steel but keep A3 unchanged.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:
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 l DEFINE_ELEMENTS
 l AMEND_PHASE_DESCRIPTION
 l COMPUTE_TRANSITION
 l DEFINE_MATERIAL
 l ENTER_SYMBOL
 l SHOW_VALUE

tcex20 - Adiabatic Decompression in a Geological System

This example calculates the adiabatic decompression in a geological system using the 
geochemical database. The database is included with the file named PGEO.TDB, which is in 
the same folder as this example.

These commands are of note and used in this example:

 l DEFINE_SYSTEM
 l DEFINE_COMPONENTS
 l SET_INPUT_AMOUNTS
 l LIST_CONDITIONS
 l SET_CONDITION
 l SHOW_VALUE
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Potential Diagram Example

tcex35 - Calculating a Potential Diagram

This example uses the POTENTIAL module to calculate a potential diagram. Note that there 
are no commands for this module, you just follow the prompts. The SUBDEMO database is 
used and included with your installation.
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Scheil-Gulliver Examples

About the Scheil-Gulliver Solidification Simulations

tcex15 - Simulating the Solidification of a Cr-Ni Alloy

This is an example of a solidification simulation of a Cr-Ni alloy. There is no back diffusion in 
the solid, i.e. this is a classic Scheil-Gulliver simulation. The FEDMO database is used and 
included with your installation. 

These commands are of note and used in this example:

 l START_WIZARD
 l COMPUTE_TRANSITION
 l ADD_INITIAL_EQUILIBRIUM
 l ENTER_SYMBOL
 l ADVANCED_OPTIONS
 l STEP_WITH_OPTIONS
 l MAKE_EXPERIMENTAL_DATAFILE
 l CHANGE_STATUS

tcex30a and 30b - Scheil Calculation for an Al-4Mg-2Si-2Cu Alloy

The Equilibrium Calculation Module (POLY3) and About the Scheil-Gulliver 
Solidification Simulations

These examples show two ways to do a Scheil calculation for an Al-4Mg-2Si-2Cu alloy. In part 
A, you use the POLY3 module and the STEP_WITH_OPTIONS command with an EVALUATE 
option. Then in part B you use the SCHEIL module commands to do the same thing. Data 
from the COST2 database is used and included with the example in the file named tcex30_
cost2.TDB.

tcex48 - Scheil Solidification with C Back Diffusion

The FEDEMO database is used and the example is available to all users. 
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This is an example of Scheil solidification with simulated back diffusion of carbon in solid 
phases. The results are compared between a simple Scheil and equilibrium calculation. First 
perform a Partial Equilibrium Scheil by assigning carbon as a fast diffusing element. Plot 
solidification curve and a microsegregation diagram and save to file (so called .exp files). The 
"back diffusion" of C in solid phases is not from any calculation involving kinetics, but comes 
from the equilibration of chemical potential of C at each step in temperature, thus allowing 
each already solidified  part of the system to change its C concentration.

See tcex54 for an example that calculates "real" back diffusion. This model 
requires a kinetic (mobility) database in addition to the thermodynamic one.  
Also see About the Scheil-Gulliver Solidification Simulations for details about 
the different Scheil options.

tcex54 - Scheil Solidification of an Al-2.1Cu-1Si Alloy including Back 
Diffusion

This is an example of a solidification simulation of a Al-2.1Cu-1Si alloy. The back diffusion 
option in the Scheil module is used, i.e. there is back diffusion in the primary phase. The 
example uses both the thermodynamic ALDEMO and mobility MALDEMO demo databases 
included with your installation. 

tcex57 - Scheil Solidification with Solute Trapping

This is an example of a solidification simulation of a Al-7.5Si-0.2Cu system. The solute 
trapping option in the Scheil module is used. The example uses the thermodynamic ALDEMO  
demo database included with your installation. 

See the Graphical Mode example T_13: Scheil Solidification with Solute Trapping 
for an additional comparison to Classic Scheil.
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Chemical Ordering Example

tcex16 - Second Order Transition of the Al-Fe System

This example calculates the second order transition line in the BCC field of the Al-Fe system.

This uses the SSOL database. A license is required to run the example.

These commands are of note and used in this example:

 l REJECT
 l RESTORE
 l ADVANCED_OPTIONS
 l SET_SCALING_STATUS
 l DEFINE_SYSTEM
 l MAKE_EXPERIMENTAL_DATAFILE
 l LIST_EQUILIBRIUM
 l APPEND_EXPERIMENTAL_DATA
 l STEP_WITH_OPTIONS
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Gibbs Energy System (GES) Examples

tcex31 - Using GES to Calculate CVM

Using the Gibbs Energy System (GES) module, this example calculates the CVM and 
compares it with the sublattices of a fictitious A B system. You also learn how to overlay 
diagrams from two calculations.

This example uses some GES commands that are not yet supported by GES6. 
Therefore, we enforce the use of GES5.

These GES commands are of note and used in this example:

 l ENTER_ELEMENT
 l ENTER_SPECIES
 l ENTER_SYMBOL
 l ENTER_PHASE
 l ENTER_PARAMETER
 l LIST_PHASE_DATA

tcex38 - Calculating the Morral “Rose” 

This example uses the Gibbs energy system (GES) module to calculate the Morral rose, which 
are miscibility gaps.

These commands are of note and used in this example:

 l REINITIATE
 l ENTER_ELEMENT
 l AMEND_ELEMENT_DATA
 l ENTER_PARAMETER
 l ENTER_PHASE
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tcex39 - Calculating Reversible Carnot Cycles of a Heat Engine
This example shows how to calculate the reversible Carnot cycle of a heat engine using one 
mole of an ideal gas with two fictitious species A and A2. The GES, POLY3, and POST modules 
are used, as well as the SUBDEMO database, which is included with your installation.

One application of the Second Law is to the efficiencies of heat engines, pumps and 
refrigerators. Whenever there is a difference of temperature, work can be produced - the 
principle of heat engines. The Gibbs energy also enables the prediction of the maximum 
work that a process may achieve. The goal of this example is to help relate the results to 
different thermodynamic quantities.  

These commands are of note and used in this example:

 l REINITIATE
 l ENTER_PARAMETER
 l ENTER_SPECIES
 l SET_PLOT_FORMAT
 l ENTER_PHASE

tcex49 - Quasichemical Model Using GES
This example shows how to enter parameters for a FACT quasichemical liquid model and 
how to calculate the sulfur activity using the GIBBS_ENERGY_SYSTEM (GES) module 
commands.

This example uses some GES commands that are not yet supported by GES6. 
Therefore, the example uses  GES5.

These commands are of note and used in this example:

 l ENTER_ELEMENT
 l ENTER_SYMBOL
 l AMEND_ELEMENT_DATA
 l ENTER_PARAMETER
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 l ENTER_SPECIES
 l SET_REFERENCE_STATE
 l SHOW_VALUE

tcex52 - Changing the Excess Models for Interaction Parameters in a 
Solution Phase

Solution Models in the GIBBS (GES) Module

This example uses some GES commands that are not yet supported by GES6. 
Therefore, the example uses  GES5.

This example shows how to change the excess models for binary and ternary interactions in 
a solution phase, either 

 l through direct interactive amendments of phase descriptions within the GIBBS_
ENERGY_SYSTEM (GES) module, or 

 l enforced by specific type-definitions given in a database file retrieved by the 
DATABASE_RETRIEVAL module (also called the TDB module). 

For binary excess models, the example changes it from the default R-K model to a Mixed-
Excess-Model. The phase has to be a substitutional phase in this case.

For ternary extrapolation models, the example changes it from  the default R-K-M model to a 
Toop_Kohler model. 

Notes Related to the Example 

The following is included in the macro file as part of the instructions but may be of use to 
new users:

AMENDING THE BINARY EXCESS MODEL

The default binary excess model is the Redlich-Kister Model for all the three associated 
binary interaction pairs (A-B, A-C and B-C)  in the substitutional LIQUID solution phase 
(without sublattice)  that consists of three elements (A, B and C).
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Before changing this default binary excess model for the ternary LIQUID solution phase, one 
must have already entered the G  parameters (for standard Gibbs energies of all pure end-
members)  and L parameters (for binary R-K excess interaction energies),  as shown in the 
example.

In this particular example, we want to change from the default R-K  binary excess model to 
the Mixed-Excess-Model (with three different  binary excess models, namely Legendre, 
Polynom and Redlich-Kister  models, applied to the A-B, A-C and B-C binaries, respectively),  
as demonstrated below:

For the A-B interaction, the Legendre binary excess model should      be used (rather than the 
default Redlich-Kister Model), with      the first species (i.e. A) as the independent constituent     
and the second species (i.e. B) as the dependent constituent,      while the L parameters for the 
A-B interaction shall remain     the same as those handled by the R-K model.

For the A-C interaction, the Polynom binary excess model should      be used (rather than the 
default Redlich-Kister Model), with the second species (i.e. C) as the independent 
constituent      and the first species (i.e. A) as the dependent constituent,      while the L 
parameters for the A-C interaction shall remain      the same as those handled by the R-K 
model.

 AMENDING THE TERNARY EXTRAPOLATION MODEL

The default ternary excess model is the Redlich-Kister_Muggianu Model (i.e., the 
MUGGIANU_RESTOR method for ternary extrapolation based on binary parameters) for the 
associated ternary interaction terms; when no ternary L parameter is entered for that, such 
a default Redlich-Kister_Muggianu Model is thus to be used for extrapolation from binary 
excess energies to ternary interactions in the substitutional LIQUID solution phase (without 
sublattice) that consists of three elements (A, B and C).

However, in this particular example as illustrated in the following, we shall change from this 
default R-K-M ternary excess model to the TOOP-KOHLER method for the ternary 
extrapolation method, with the species C as the Toop constituent, while the species A and B 
as the Kohler constituents (entering A and B, or B and A, as the basis constituent and first 
interacting constituent). This will implicitly enforce that, during the ternary extrapolation, 
only the A-B binary interaction parameters are utilized in accordance with the Kohler ternary 
extrapolation formula for A-B-C ternary interaction, while any other binary interaction 
parameters used in line with the Toop-Kohler ternary extrapolation formula (for the A-C-B 
and B-C-A ternary interactions). This makes the extrapolated ternary excess interaction 
terms different from those handled either by the default MUGGIANU_RESTOR method or by 
the alternative KOHLER-ALL method.
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Note that only when all the relevant binary excess energies in a ternary system are treated 
by the default Redlich-Kister Model (i.e., the Mixed-Excess-Model should have not been 
used), the MUGGIANU_RESTOR method for ternary extrapolations is equivalent to the 
Redlich-Kister_Muggianu Model, or the KOHLER-ALL method to the Redlich-Kister_Kohler 
Model.
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T0 Temperature Example

tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a Low 
Alloyed Steel

This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.

This uses the TCFE database. A license is required to run the example.
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Paraequilibrium Examples

tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a Low 
Alloyed Steel

This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.

This uses the TCFE database. A license is required to run the example.

tcex42 - Paraequilibrium Calculation - Formation of Para-pearlite - 
Isopleth 

This uses the TCFE database. A license is required to run the example.

This example uses an Fe-Mn-C system at 2.5%Mn Mass u-fraction to show a paraequilibrium 
calculation where there is formation of para-pearlite. It is an isopleth calculation and shows 
the STEP_WITH_OPTIONS command using the Paraequilibrium option. 

tcex43 - Paraequilibrium Calculation - Formation of Para-pearlite - 
Isothermal

This uses the TCFE database. A license is required to run the example.

This example uses an Fe-Mn-C system at 700 °C to show a paraequilibrium calculation where 
there is formation of para-pearlite. It is an isothermal calculation and shows the STEP_
WITH_OPTIONS command using the Paraequilibrium option. 



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 591 of 622

Functions and Variables Examples

tcex44 - Exploring Variables and Functions
This example uses variables and functions to predict properties e.g. proof strength for an 
austenitic stainless steel at elevated temperatures (20-550 °C). The example was created 
using an expression from [2000Eli]. 

This uses the TCFE database. A license is required to run the example.

In Graphical Mode there is a Yield Strength Property Model that does not 
require user input of empirical functions. See About the Yield Strength Property 
Model.

REFERENCE

[2000Eli] J. Eliasson, R. Sandström, Proof strength values for austenitic stainless steels at 
elevated temperatures. Steel Res. 71, 249–254 (2000).
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PARROT and EDIT_EXPERIMENT Examples

tcex36a - Using PARROT and EDIT EXPERIMENTS

The example is divided into parts corresponding to the files in the tcex36a 
folder. It is recommended you open tcex.36.readme before continuing with this 
advanced exercise.

Also see the Data Optimization User Guide.  

Each problem has "selected" experimental data. The example uses a fictitious binary A-B 
system where element A is BCC until it melts. Element B is BCC up to 1100 K and FCC above. 
There is a compound A2B stable in a limited temperature range.

 l The creation of the "setup" file is described (tcex36a.TCM) where you enter the 
elements and phases into the Gibbs Energy System (GES) module

 l The creation of the experimental data file is described (tcex 36b.TCM). When you run 
the TCEX36a macro, the contents of this macro file is automatically launched and the 
experimental data file created.

 l The actual run in the PARROT module in order to obtain the result (tcex 36cpd.TCM)

There are many commands used in this advanced example (listed in alphabetical order):

ADVANCED_OPTIONS AMEND_ELEMENT_DATA AMEND_PHASE_DESCRIPTION

APPEND_EXPERIMENTAL_DATA COMPILE_EXPERIMENTS  

CONTINUE_OPTIMIZATION CREATE_NEW_EQUILIBRIUM CREATE_NEW_STORE_FILE

DEFINE_COMPONENTS EDIT_EXPERIMENTS ENTER_PARAMETER

ENTER_PHASE LABEL_DATA LIST_ALL_VARIABLES

LIST_PHASE_DATA LIST_RESULT MACRO_FILE_OPEN

OPTIMIZE_VARIABLES QUICK_EXPERIMENTAL_PLOT READ_WORKSPACES

RESCALE_VARIABLES SAVE_PARROT_WORKSPACES SAVE_WORKSPACES 
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SELECT_EQUILIBRIUM SET_ALL_START_VALUES SET_ALTERNATE_CONDITION

SET_ALTERNATE_MODE SET_FIX_VARIABLE SET_OPTIMIZING_VARIABLE

SET_STORE_FILE SET_WEIGHT  
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Pourbaix Diagram Examples

tcex40
This is the first in a series of examples to demonstrate the advanced POURBAIX module 
calculations and plotting. This example automatically calculates and plots a Pourbaix 
diagram for 0.001 m Fe in a 0.1 m NaCl aqueous solution at 25 °C and 1 bar. Other diagrams, 
along various phase boundaries for the     same interactions resulted from the same Pourbaix 
module     calculation, are also plotted.

It is recommended you read the text file TCEX40-README.txt, which is located 
in the Extended subfolder.

 Also see the Pourbaix Diagrams Educational Material Guide.

A so-called Pourbaix diagram is actually a phase diagram with independently-varied acidity 
(pH) and electropotential (Eh), for a heterogeneous interaction system at a certain bulk 
composition (that is by default always set as 1 kg of water dissolving a specified amount of 
metals and other solutes), under a defined temperature and pressure condition. 

The PAQ2 Database

The example uses the PAQ2 (TCS Public Aqueous Solution Database using the SIT aqueous 
solution model) included with your installation. The database contains an AQUEOUS solution 
phase and REF_ELECTRODE phase (as a reference for electron in aqueous electrolyte 
systems), as well as some data for various solid phases (solution or stoichiometric) and 
gaseous mixture phase. The PAQ2 is specially designed for these example calculations of the 
so-called Pourbaix diagrams (i.e., pH-Eh plots) and other types of phase diagrams or 
property diagrams in some aqueous-bearing multicomponent heterogeneous interaction 
systems within the limited chemical framework of Fe-Co-Cr-Ni-C-N-S-H2O-NaCl, via the 
Single-Database Option in the advanced POURBAIX module or through the normal TDB-GES-
POLY-POST routine.

Additional Examples in this Series

Additional examples (TCEX40A, TCEX40B, TCEX40C, and TCEX40E) are provided to 
demonstrate options and features in the Pourbaix module and to show more advanced 
applications of the TCAQ and AQS aqueous solution databases [in the Multiple-Database 
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Option, i.e., with appended data from the SSOL and SSUB databases]. See Pourbaix Examples 
TCEX40A, 40B, 40C, and 40E. 

Example TCEX40D is deprecated as of version 2022a.

tcex53 - Pourbaix Diagram Calculations for a Heterogeneous Interaction 
System

 Also see the Pourbaix Diagrams Educational Material Guide.

This example uses the PAQ2  database to calculate some Pourbaix diagrams. The DATABASE_
RETRIEVAL (TDB), GIBBS_ENERGY_SYSTEM (GES), POLY3, and POST modules are used for the 
Fe-X-H2O-NaCl heterogeneous interaction system, where X = Cr-Ni-Co.

The initial bulk composition of Fe-based alloy in this calculation is just 
preliminarily assigned, in which the BCC_A2 and/or FCC_A1 solution phase(s) 
are considered as of primarily interest. For practical calculations, one shall have 
more precise inputs for the initial bulk compositions of alloys.

Step 1: Single-Point Calculations for H2O-NaCl system

To demonstrate how to define the molality of NaCl in an aqueous-bearing heterogeneous 
interaction system. 

Step 2: Single-Point Calculations for Fe-X (X = Cr-Ni-Co) system

To demonstrate how to define the initial amount of alloy in an aqueous-bearing 
heterogeneous interaction system. In this example, we are interested in only the BCC_A2 
and FCC_A1 phases in the Fe-based alloy. 
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Step 3: Single-Point Calculations for Fe-Cr-Ni-Co + H2O-NaCl system

Step 4: Pourbaix Diagram Mapping for Fe-Cr-Ni-Co + H2O-NaCl system - define 
the variables

From the same mapping calculations you arrive at by the end of the example, you can plot 
more diagrams  using a variety of X-Y axis variables.

For a list of pre-defined symbols, go to the end of the tcex53.TCM macro file 
(open it in a text editor).
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Pourbaix Examples TCEX40A, 40B, 40C, and 40E

These are the extended examples that are described in Pourbaix Diagram Examples.

TCEX 40A

This example shows you how to use Option 1 where you start a completely new calculation. 
It uses a single database. The Pourbaix diagram for 0.001 m Fe in a 0.1 m NaCl solution at 25 
°C and 1 bar is automatically calculated and plotted. 

A more advanced version of 40A can be found in TCEX40E, which also uses 
Option 1 but with multiple databases. However, licenses are required for three 
commercial Thermo-Calc databases.

See POURBAIX_DIAGRAM Commands for Options 1 to 4.

A so-called Pourbaix diagram is actually a phase diagram with independently-varied 
electropotential (Eh) and acidity (pH), for an heterogeneous interaction system at a certain 
bulk composition (that is by default always set as 1 kg of water solving a specified amount of 
metals and other solutes), under defined temperature and pressure conditions. Some 
property diagrams, along various phase boundaries for the same interactions resulting from 
the same Pourbaix module calculation, are also plotted, without leaving Option 1.

At the end of this example, a new POLY3 file called POURBAIX.POLY3 is 
automatically saved.  The following examples (TCEX40B and TCEX40C) use this 
same POLY3 file for the calculations. Therefore it is important to make copies of 
this file and rename these to TCEX40A.POLY3, TCEX40B.POLY3, and 
TCEX40C.POLY3. This must be done outside of the Thermo-Calc software and 
after the TCEX40A calculation and plotting is complete. This is so that the 
required POLY3 file structure is not lost. 
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The reason you do not save from within Thermo-Calc is because of how the file 
is saved. When the command sequence (GO POLY3>SAVE TCEX40A.POLY3>Y) is 
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3 
module monitor and all the initial equilibrium points and the mapping/stepping 
calculation results are lost as well as parts of the POLY3 file structure (e.g., some 
definitions of the previously defined POURBAIX-type calculation system).

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

TCEX 40B

This example shows you how to use Option 2 where you Open an old (existing) file and plot 
other property diagrams. 

Example 40A calculated and plotted the Pourbaix diagram for 0.001 m Fe in a 0.1 m NaCl 
solution at 25 °C and 1 bar. Example 40B reads the original POURBAIX.POLY3 file , and uses 
the calculated results to plot property diagrams for the same heterogeneous interaction 
system.

For example 40B, the POLY3 file is not modified. However, it is still 
recommended that a copy of the original POLY3 file is used so you do not lose 
the file structure and calculated results.

If you have a POLY3 file generated after choosing Option 4, that file can also be 
used for Option 2, and vice versa.

TCEX 40C

This example shows you how to use Option 3 where you Open an old file and make another 
Pourbaix calculation. The previously calculated (and copied) POURBAIX.POLY3 file from 
TCEX40A is edited to make another Pourbaix calculation and plot. 

The same chemical system is used (Fe-H2O-NaCl) but with different P-T-X (pressure-
temperature-composition) conditions and without the GASeous mixture phase. The new 
conditions  are 0.01 m Fe in a 1 m NaCl solution at 200 °C and 1 kbar.   
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In this example, the GASeous mixture phase for the Pourbaix diagram is not 
considered. 

The POLY3 file is modified and rewritten with the new conditions. As previously 
recommended, make a copy of the original POLY3 file and rename it 
(e.g.TCEX40C.POLY3) so you do not lose the file structure and new calculated 
results.

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

After the default Pourbaix diagram is generated and refined, you can also use Option 3 to 
plot property diagrams along different phase boundaries for the same system. These 
settings are possible from within Option 3 and you do not need to go back to Option 2.

TCEX 40E

This example shows you how to use Option 1 where you start a completely new calculation. 
It uses multiple databases (TCAQ, SSUB, and SSOL). The Pourbaix diagram for 0.001 m 
Fe90Co5Ni5 alloy (9E-3 m Fe + 5E-4 m Co + 5E-4 m Ni) in an aqueous solution with 2E-2 m 
H2S and 3 m NaCl at 25 °C and 1 bar is automatically calculated and plotted.

You need licenses for three Thermo-Calc databases, i.e.

 l A: AQS  (TGG Aqueous Solution Database; HKF model) or TCAQ (TCS Aqueous Solution 
Database; SIT model);

 l B: SSUB (SGTE Pure Substances Database)
 l C: SSOL (SGTE Alloy Solutions Database) or TCFE (TCS Steels/Fe-Alloys Database) or 

similar.

The TCAQ database contains only an AQUEOUS solution phase (using the SIT model) and 
REF_ELECTRODE phase (as a reference state for electron in aqueous electrolyte systems). 
The SSUB database is appended for the GASeous mixture phase and some pure solid phases 
(so-called secondary phases formed during aqueous-involving interaction processes), and 
the SSOL database is appended for various solid solution phases.
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The Pourbaix module inside the software also accepts the AQS2 aqueous solution database 
(using the complete Revised HKF model) in the Multiple Database Option, in addition to the 
TCAQ2 aqueous solution database (using the SIT model).
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POURBAIX_DIAGRAM Commands for Options 1 to 4

Option 1: Start a Completely New Pourbaix Diagram Calculation

Option 1 is used to make a completely new Pourbaix diagram calculation and automatically 
plot a pH-Eh diagram. i.e., define a new chemical system; specify the T-P-X conditions; 
calculate the initial equilibria; perform the pH-Eh mapping calculation; plot pH-Eh and 
various property diagrams. 

Many of the commands in Option 1 are also repeated for Options 2 to 4. The 
details for each command are included with this section unless it is specific to 
one of the other option choices. The order that the commands display on 
screen is also different and based on what is entered at the prompts. These 
prompts are also available in other commands and when applicable a link to 
that command is included.

Consider the GAS phase in calculating a Pourbaix diagram? /Y/

You can choose to ignore the GAS mixture phase on a calculated/plotted Pourbaix diagram. 
However, such a plot is actually not a complete Pourbaix diagram because the 
thermodynamically-stable phase boundaries between the AQUEOUS solution phase and GAS 
mixture phase will not be calculated.

 l If you enter Y (the default), GAS mixture phase is always considered.
 l If you enter N the GAS mixture phase is completely ignored.

Use single database? /Y/

If you keep the default you are prompted for a database. 

Combined database: /PAQ2/

The default is PAQ2, a database included with all installations.

The following information is provided on screen if you chose Y at the first prompt, Need any 
instruction on the POURBAIX module? /N/.
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Define a Chemical System and its Initial Bulk Composition

Normally a Pourbaix diagram and its related equilibrium property in a heterogeneous 
interaction system are calculated under a certain bulk composition, which is usually 1 kg of 
water with defined amounts of dissolving solute substances. The solutes may either be 
completely dissolved into the aqueous solution, or be partially dissolved and simultaneously 
form some solid  phases. 

CHEMICAL SYSTEM (ELEMENTS) 

 l Default defined elements  (solvent  H2O): H  and  O and specially assigned ZE
(electron) and VA(vacancy).

 l Prompt specified elements (solutes  ELEM): Fe  Ni  Co  Cr  C   N   S   Na  Cl 

INITIAL BULK COMPOSITION

 l Default defined composition  (solvent): 1.0 kg of H2O  
 l Prompt specified composition (solutes): x mole of ELEM 
 l Mass of Water (weight) = 1 kg 

When entering solutes in chemical formulas, the first element's letter must be 
in UPPER case, and second in lower case, for example NaCl, CO2, CoCl3, 
Fe0.93S, NaSO4-1, and H2SO4.

First solute

Enter a solute, e.g. Fe.

Molality of <first solute> [mol/kg] /.001/

Enter a molality for the first solute, e.g. Fe.

Second solute

Enter a second solute and its molality on the same line, e.g. NaCl .1.

Next solute

You can continue to enter solutes. Press <Enter> to skip to the next prompt.

The following information is provided on screen if you chose Y at the first prompt, Need any 
instruction on the POURBAIX module? /N/.
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Defined Chemical System and Initial Bulk Composition

Solutes have been split up into chemical elements and their mole numbers. If confirmed, the 
Pourbaix module will, in further steps, count the initial bulk composition in terms of 
chemical elements.

Confirm defined system and initial bulk composition? /Y/ 

If you keep the default (Y) thermodynamic data is retrieved from the database. Then it lists 
the database's phases for the defined system.

You can then reject or restore phases as required with the next prompts.

Reject phase(s) /NONE/

Restore phase(s): /NONE/

Then the program lists the phases retained in the system and you prompted whether this is 
OK or not.

OK? /Y/

If you answer Y, then a list of references for the assessed data is displayed on the screen. 
The next prompt is related to miscibility gap checks, global minimization, saving the 
information to a POLY3 file, and setting numerical limits.

Should any phase have a miscibility gap check? /N/

The database usually creates two or more "composition sets" for phases that can have 
miscibility gaps. However, for some phases this is not done automatically, for example the 
miscibility gap in the bcc phase in Fe-Cr is usually ignored. But if it is important to include a 
Cr-rich bcc phase  specify this here. It costs some computation time and may make 
subsequent MAP or STEP processes more difficult to converge. To keep the default (not to 
have any such phase) press <Enter>. Otherwise answer Y and follow the additional prompts. 

Enforce Global Minimization Technique in calculations? /N/

If you choose Y, the Global Minimization is done when possible (depending on the 
conditions setting), and a Global Minimization test is performed when an equilibrium is 
reached. This costs more computer time but the calculations are more robust. 

Save all functions, variables and tables in POLY3 file? /Y/

Choose Y if you want to save all the defined symbols (functions, variables and tables) into 
the POURBAIX.POLY3 file, for further normal POLY3 calculations or normal POST post-
processing. Choosing yes may result in a large POLY3 file.

Set numerical limits? /N/

SET_NUMERICAL_LIMITS



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 604 of 622

The Pourbaix module has a default setting for numerical limits.

 l Maximum number of iterations:    20000
 l Required accuracy:                1E-6
 l Smallest fraction:                1E-15
 l Approximate driving force for metastable phases: Y

If you kept the defaults for the above prompts, the program lists the default and pre-defined 
calculation conditions and you are prompted to confirm.

Confirm defined conditions? /Y/

Now Thermo-Calc calculates the start points. This can take a few moments. Near the end of 
the calculation there is a list of the default axis variables. The maximum pH limit is calculated 
precisely and determined automatically by the Pourbaix module as a function of the 
temperature-pressure conditions and initial bulk compositions of the current defined 
interaction system. You are prompted to accept these settings.

Accept the default settings for two mapping variables? /Y/

The program now lists the initial equilibria for mapping and continues to calculate the 
mapping. Then it sets the automatic diagram axes and starts to plot the diagram. But first 
there are several prompts to guide you.

Any missing phase boundary you could possibly think of? /N/

Sometimes the Pourbaix module may miss some phase boundaries  during the mapping 
process. If you answer Y you can add additional starting point(s) into the calculation. You are 
now prompted to specify a pH-Eh coordinate pair, for instance (4.0, -0.15), which is close to 
the expected phase boundary. However, such additional pH-Eh point should not outside the 
AQUEOUS/GAS(O2) or AQUEOUS/GAS(H2) boundaries; otherwise, the module will fail in 
finding any new starting point.

The next set of prompts relate to plotting.

Change the pH/Eh steps for smoother curves? /N/

You can modify the mapping steps of X/Y axes for smoother curves; sometimes it may help 
finding missing phase boundaries by decreasing the pH and Eh increments.

Zoom in? /N/

Change the scaling status for both X and Y axes. The program then asks for minimum and 
maximum values for the axes. In some cases values are suggested.

Change Curve-Label Option for the diagram? /N/

Change the Curve-Label option to one of the following:
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 l A: List stable phases along phase boundaries
 l B: As A, but curves with same fix phase have same number
 l C: List axis quantities
 l D: As C, but curves with same quantities have same number
 l E: As B, but curves with changing colours
 l F: As D, but curves with changing colours
 l N: No labels

Usually, Option E or B is good for phase diagrams such as pH-Eh plots, and F or D is good for 
property diagrams like pH-RC(Fe+2).

SET_LABEL_CURVE_OPTION

Add Label-Texts onto the Pourbaix diagram? /N/

Add label text to an area in the diagram. The label is written starting from the specified 
coordinates. Optionally,  let the program automatically add the text by calculating an 
equilibrium at some specific coordinates and also make a label as the stable phase names in 
the area. However, such an automatic calculation may fail, especially for a Pourbaix diagram 
where either pH or Eh is not an intensive variables.

In most cases, the program is able to write the label if the coordinates and texts are 
specified. 

Change the Subtitle of the diagram? /N/

This is the same as the POST module commandSET_CORNER_TEXT  → UPPER_RIGHT 
<SUBTITLE>. The default subtitle is automatically assigned by the POURBAIX module and is 
based on the defined conditions in the system (temperature, pressure and initial bulk 
compositions).

If you choose Y then the existing subtitle is displayed and you are prompted to enter a new 
subtitle or to have None.

New Subtitle /NONE/

You can change the subtitle for all the diagrams in the same POURBAIX run (i.e., within the 
same Option). The new subtitle that can be altered later at the same option, when further 
modifying the present graph or when refining any sequentially defined plot. By entering text 
(empty space at any position is allowed), the new subtitle is defined. By typing OLD, the 
existing subtitle is kept.

By pressing <Enter> (i.e., accepting None), the subtitle is deleted from all sequential plots, 
which can be set back later at the same option, too.

Change Axis-Texts? /N/
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Change the axis text for both X and Y axes.

Further Refine the diagram in POST Module? /N/

With this option, you can further change the appearance the plot and use any command in 
the normal POST Module. 

POST Module Commands

Hard copy of the diagram? /N/

Recommended Responses
 l Hard copy of the diagram? /N/: Y
 l CURRENT DEVICE: MS-Windows
 l GRAPHIC DEVICE NUMBER /1/: 5
 l NEW DEVICE: Postscript portrait mode
 l USE POSTSCRIPT FONTS /YES/: Y
 l SELECT FONTNUMBER /9/: 27
 l NEW FONT:  Times-Bold
 l FONT SIZE /.35833/: .32
 l PLOTFILE : /defaultname/: yourfilename

Save X-Y coordinates of curve on text file? /N/

Write all the current graphic information (generated and modified in the above procedure) 
on a text file using the DATAPLOT format (see the DATAPLOT User Guide or search the online 
help). This also makes it possible to merge two or more diagrams from separate but similar 
calculations, or put some experimental data points onto a calculated diagram. You do this by 
first writing them onto text files with this option and then edit them together (using a 
general text editor). The program asks for a file name. Accept the default (usually 
POURBAIX) or use another name. If an extension is not given, the written file is given an 
extension of *.EXP.

Modify the diagram? /N/

Further modify the appearance of the created plot. This brings you back to the above 
prompts for changing various features.

Any more diagram? /N/

Make many other plots using the same POURBAIX module calculation file.
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Option 2: Open an Existing File and Plot Other Property Diagrams

Copy and Rename the POLY3 file

At the end of a Pourbaix module calculation, a new POLY3 file  is automatically saved.  

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended 
examples), it is recommended that you copy and rename the previously-
generated POLY3 file. This is so that the required POLY3 file structure and 
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save 
from within Thermo-Calc.

The reason you do not save from within Thermo-Calc is because of how the file 
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is 
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3 
module monitor and all the initial equilibrium points and the mapping/stepping 
calculation results are lost as well as parts of the POLY3 file structure (e.g., some 
definitions of the previously defined POURBAIX-type calculation system). 

Open an existing POLY3 file created by the Pourbaix module (from a previous Pourbaix 
calculation Option 1 or 3 or  a previous Stepping calculation Option 4), and selectively 
plotting other property diagrams. i.e., open the old GES and POLY3 workspaces; plot pH-Eh 
or various property diagrams.

File name /ABCDEF/

The name of a previously saved POLY3 file where the POLY3 and GES5 workspaces is to be 
read must be specified. You do not need to enter the file extension if it is the default .POLY3 
name. The default file name (e.g. ABCDEF) is the most recent specified POLY3-file name or 
RESULT if there is no workspace already saved in the run. You can press <Enter> or type a 
specific file name to read the POLY3 and GES5 workspaces from the file.

For Windows, and at the prompt, an Open file window displays if a file name is not given or 
the file path is incorrect. The file type (i.e. POLY3) cannot be changed. Click Open or Cancel 
to continue with the selected file.

When the file opens, it confirms on screen what kind of calculation is contained in the POLY3 
file. For example: The loaded POLY3 file is of POURBAIX-MAPPING Calculation.



Thermo-Calc Documentation Set

Thermo-Calc User Guide: Console Mode ǀ 608 of 622

On screen it also lists the system components and the default and predefined calculation 
conditions to enable you to review these.

Next you are given a set of properties that are available to be selected as axis variables for 
making other diagrams from the same calculation.

Abbreviation Definition

pH Acidity

Eh Electronic potential (V)

Ah Electronic affinity (kJ)

pe Electronic activity [log10ACRe)

IS Ionic strength

TM Total concentration

Aw Activity of water

Oc Osmotic coefficient

MF (AQsp) Mole fractions of aqueous species

ML (AQsp) Molalities of aqueous species

AI (AQsp) Activities of aqueous species

RC (AQsp) Activity coefficients of Aq species

Where AQsp is the name of a specific aqueous species, and "*" can be used as a wild sign for all AQSp. It is not 
necessary to give a complete aqueous species name. However, the entered AQsp name must be unique. If 
neither AQsp nor * is given, all species are searched.

The rest of the prompts are the same as with Option 1 and relate to plotting. 
Enter ? at any prompt for details.
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Option 3: Open an Existing File and Make Another Pourbaix 
Calculation

Copy and Rename the POLY3 file

At the end of a Pourbaix module calculation, a new POLY3 file  is automatically saved.  

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended 
examples), it is recommended that you copy and rename the previously-
generated POLY3 file. This is so that the required POLY3 file structure and 
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save 
from within Thermo-Calc.

The reason you do not save from within Thermo-Calc is because of how the file 
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is 
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3 
module monitor and all the initial equilibrium points and the mapping/stepping 
calculation results are lost as well as parts of the POLY3 file structure (e.g., some 
definitions of the previously defined POURBAIX-type calculation system). 

Open an existing POLY3 file created by the Pourbaix module and make another Pourbaix 
diagram calculation i.e. open the old GES and POLY3 workspaces, adopt the defined 
chemical system, modify the T-P-X conditions, calculate the initial equilibria, perform the pH-
Eh mapping calculation and plot pH-Eh or other property diagrams.

The rest of the prompts are the same as with Option 1 or Option 2. Enter ? at 
any prompt for details.

Modify Label-Texts on the Pourbaix diagram? /N/

Once some labels are written by the Add-Label-Text command onto the diagram, you can 
also modify the labels (changing their positions and text contents). The text-size cannot be 
changed. The program asks which label and you enter its new X/Y coordinates with the new 
text. The new text must not be longer than the old one.

Modify Label-Curve-Option on the Pourbaix diagram? /N/
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Because some phase-region labels have been written onto the diagram, the Label-Curve-
Option might need to be modified, normally to the Option N.

Important Information About Option 3

The default definitions of the Eh and pH quantities in the advanced Pourbaix module (and in 
the ordinary TDB-GES-POLY calculation routines) should ALWAYS be as below: 

Eh = MUR(ZE)/RNF 

pH = -log10[AI(H+1,AQUEOUS)] 

= -log10[ACR(H+1,AQUEOUS)*AH2O] 

where RNF is the Faraday constant (96485.309 C/mol), and AH2O is the molecular weight of 
H2O (55.508435 g). MUR(ZE) is the electrochemical potential (ECP; in the unit of J/mol; w.r.t. 
the standard hydrogen electrode). ACR(H+1,AQUEOUS) is the site-fraction-based activity of 
the H+1 aqueous species in AQUEOUS solution phase, but AI(H+1,AQUEOUS) [that equals 
ACR(H+1,AQUEOUS)*AH2O] is the molality-based activity of the H+1 aqueous species that 
should be used for defining the pH quantity. 

Within an aqueous-bearing heterogeneous interaction system, the fundamental system-
components must be H2O, H+1 and ZE, which are corresponding to the basic elements O & 
H and the hypothetical electron (ZE) in the aqueous solution phase. For the additional 
chemical elements in the system, their corresponding system-components shall be defined 
as in their element forms (such as Fe, Cr, Mn, Ni, Na, Cl, S) or (for some) in their molecular 
forms (e.g., NaCl, H2S). The reference state for the H2O component must always be defined 
as the solvent species H2O in the AQUEOUS solution phase under the current temperature 
(*) and 100000 Pascal (i.e., 1 bar). The reference states for the H+1 and ZE components are 
by default set as their SER. 

Various conventional properties of aqueous solute species I are converted in the following 
manners:  

ML = Y(AQUEOUS,I)*AH2O/YH2O 

RC = ACR(I,AQUEOUS)*YH2O/Y(AQUEOUS,I)  

AI = RC*ML 

= ACR(I,AQUEOUS)*AH2O 

where YH2O [i.e., Y(AQUEOUS,H2O)] and Y(AQUEOUS,I) are the site-fractions of solvent H2O 
and solute species I.

LIST THE DEFINED AXIS-VARIABLES: 

Axis No 1: LNACR(H+1)Min: -34.532525Max: 2.3025851 Inc: 0.8

Axis No 2: MUR(ZE)   Min: -150000   Max: 200000    Inc: 7718.85
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The default settings (listed above) for two mapping variables [in terms of lnACR
(H+1) and MUR(ZE), and their minimum/maximum values and increment steps] 
are covering the following pH-Eh ranges/steps:

pH:  0.00 -> 14.00, at a step of 0.35    

Eh: -1.55 ->  2.07, at a step of 0.08 (V)

The maximum pH limit has been calculated precisely and determined automatically by the 
Pourbaix module, as a function of the temperature-pressure conditions and initial bulk 
compositions of the current defined interaction system. 

Option 4: Open an Existing File and Make another Stepping 
Calculation

Open an existing POLY3 file created by POURBAIX Module (from a previous POURBAIX 
calculation Option 1 or 3 or  a previous STEPPING calculation Option 4), and make a normal 
STEPPING calculation. i.e., open the old GES and POLY3 workspaces; adopt the defined 
chemical system; specify one of the T-P-X conditions as the stepping variable; calculate the 
initial equilibria; perform the stepping calculation; plot various property diagrams. 

Many prompts are the same as with Option 1 or Option 2. Enter ? at any 
prompt for details.

Copy and Rename the POLY3 file

At the end of a Pourbaix module calculation, a new POLY3 file  is automatically saved.  

A reminder that Linux and Mac are case sensitive; when applicable ensure you 
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended 
examples), it is recommended that you copy and rename the previously-
generated POLY3 file. This is so that the required POLY3 file structure and 
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save 
from within Thermo-Calc.
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The reason you do not save from within Thermo-Calc is because of how the file 
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is 
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3 
module monitor and all the initial equilibrium points and the mapping/stepping 
calculation results are lost as well as parts of the POLY3 file structure (e.g., some 
definitions of the previously defined POURBAIX-type calculation system). 

The stepping calculation modifies the POLY3 file but this can be used for other 
Stepping calculations inside the Pourbaix module (e.g. repeating Option 4) or in 
normal POLY3 module.

Stepping Parameters

The following parameters are suitable for a STEPPING calculation for the defined aqueous-
bearing system. Choose one of them as the stepping variable: 

T Temperature (C)

P Pressure (bar)

pH Acidity

Eh Electronic Potential (V) 

N(Comp) Mole of One Component 

where "Comp" is the name of a specific component as listed below. One should not use any 
key component (H2O or H+1 or ZE) as such a stepping variable, because of that their 
compositional definitions and variations are determined by the AQUEOUS solution phase in 
the POURBAIX Module.

An interacting component defined as an element (such as Fe or Na or Cl) can be selected as 
a stepping variable.

However, if you want to make a stepping calculation with a non-element chemical formula 
(such as NaCl or CaS2) as the stepping variable, one must have made some necessary 
modifications in the POLY3 Module, before reaching this point, by  conducting some POLY3 
commands as given below (as an example for the system Fe-Na-Cl-H-O): 

POLY_3: def-component H2O H+1 ZE Fe NaCl Cl 

POLY_3: set-ref-state H2O AQUEOUS * 1E5

POLY_3: set-ref-state ZE REF_ELEC * 1E5

POLY_3: change-status phase REF-ELEC=SUSPEND

POLY_3: set-cond b(H2O)=1000 n(H+1)=0 n(ZE)=0

POLY_3: set-cond P=1E5 T=298.15** 
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POLY_3: set-cond n(Fe)=1E-3 n(Cl)=0 n(NaCl)=3 **

** Here the P-T-n(Fe) conditions can be set as what you wanted, while the initial n(NaCl) 
value must be set as between its minimum and maximum values that you are interested in. 
Later on, it will be prompted for specifying the n(NaCl) Min-Max-Step values of the stepping 
calculation.

Stepping variable: /T/

The chosen stepping variable must be one of the suitable parameters listed above.

Minimum temperature (C) /15/

Maximum temperature (C) /35/

Increment in temperature (C) /1/

The AQUEOUS solution phase under the defined bulk composition and pressure condition is 
stable only between 0 and   99° C. However, you can make a stepping calculation outside this 
temperature range, where the AQUEOUS solution phase become metastable. In this case, 
the resulting POLY3 file is possibly able to be opened by any other option within the 
Pourbaix module.
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Tabulate Reaction (TAB) Example

tcex12 - Tabulation of Thermodynamic Data for Reactions
This example shows a number of independent cases using the TABULATE_REACTION (TAB) 
module to tabulate thermodynamic data for reactions.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l TABULATE_REACTION
 l DEFINE_SPECIES
 l ENTER_FUNCTION
 l QUICK_EXPERIMENTAL_PLOT
 l SET_SCALING_STATUS
 l LIST_SUBSTANCES
 l TABULATE_SUBSTANCE
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REACTOR Module Example

tcex24 - Simulation of the Silicon Arc Furnace
This is a simple reactor model with output of gases at the top and output of condensed 
phases at the bottom. The gas phase from one segment flows to higher segments, 80% 
reacts in the first above, 15% in the second above and 5% in the third above.

The condensed phases flow downwards and all of it goes to the next lowest segment. Heat 
can be added at any module. The only way to specify the initial state of the reactants added 
to the reactor is to specify the heat content.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l DEFINE_SPECIES
 l CREATE_STAGE_BOXES
 l CREATE_DIVIDERS
 l CREATE_PIPES
 l START_SIMULATION
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Thermophysical Properties Examples

tcex55 - Plotting Viscosity of Cr-Ni at 1873 K

This is an example of including viscosity in the calculations. 

Using the FEDEMO database, which is the free demonstration version of the TCS Steel and 
Fe-alloys Database (TCFE), the viscosity of metallic liquids is plotted at 1873 K for Cu-Ni and 
compared to experimental data from [2005Sat].

Reference

[2005Sat] Y. Sato, K. Sugisawa, D. Aoki, T. Yamamura, "Viscosities of Fe–Ni, Fe–Co and Ni–Co 
binary melts," Meas. Sci. Technol. 16, 363–371 (2005).

The example includes an experimental data (*.exp) file called Cr-Ni_1873K.exp.

The same example is also provided in Graphical Mode as T_12_Viscosity_in_Cr-
Ni.tcu.

tcex56 - Plotting Surface Tension of Cu-Zr at 1373 K

This is an example of including surface tension in the calculations. 

Using the ALDEMO database, which is the free demonstration version of the TCS Al-based 
Alloy Database (TCAL), the surface tension of liquid metallic is plotted at 1373 K for Cu-Zr 
and compared to experimental data from [2005Kra].

Reference

[2005Kra] V. P. Krasovskyy, Y. V. Naidich, N. A. Krasovskaya, "Surface tension and density of 
copper–Zirconium alloys in contact with fluoride refractories," J. Mater. Sci. 40, 2367–
2369 (2005).

The example includes an experimental data (*.exp) file called Cr-Zr_ALDEMO.exp.

The same example is also provided in Graphical Mode as T_11_Surface_
tension_in_Cu-Zr.tcu.
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tcex58 and tcex59 - Molar Volume

There are two examples that include molar volume in the calculations and use the 
ALDEMO database, which is the free demonstration version of the TCS Al-based Alloy 
Database (TCAL). 

The examples calculate volumetric thermal expansion coefficients of the L12-type Al3Sc 
(tcex58) and the L12-type Al3Zr (tcex59), respectively. Both Al3Zr and Al3Sc are modeled as 
the same phase (named as AL3SC, since Al3Sc is stable while Al3Zr is metastable).

The examples include an experimental data (.exp) file called Al3X.exp, which is the same for 
both examples to read the data from [2015Sah].

The same example, combining both  tcex58 and tcex59 is also provided in 
Graphical Mode as T_15_Molar_Volume_for_Al3Sc-Al3Zr.tcu.

REFERENCE

[2015Sah] S. Saha, T. Z. Todorova, J. W. Zwanziger, Temperature dependent lattice misfit 
and coherency of Al3X (X=Sc, Zr, Ti and Nb) particles in an Al matrix. Acta Mater. 89, 109–
115 (2015).

tcex60 - Electrical Resistivity and Thermal Conductivity

This example calculates the electrical resistivity (ELRS) and thermal conductivity (THCD) or 
pure Cu. It makes a step calculation over a wide temperature range, covering both the FCC_
A1 state and the liquid state. It plots thermal conductivity of the system (both FCC_A1 and 
liquid) and that of a single phase (taking FCC_A1 as an example), respectively. Also plots 
electrical resistivity of the system and that of FCC_A1. 

The example is available to all users as it uses the ALDEMO database, which is the free 
demonstration version of the TCS Al-based Alloy Database (TCAL).

The example includes two experimental data (*.exp) files called 1972Ho_cu_thcd.exp and 
1981Ho_cu_elrs.exp.

The same example is also provided in Graphical Mode as T_16_Electrical_
Resistivity_Thermal_Conductivity_Cu.tcu
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REFERENCES

[1972Ho] C. Y. Ho, R. W. Powell, P. E. Liley, Thermal Conductivity of the Elements. J. Phys. 
Chem. Ref. Data. 1, 279–421 (1972).

[1981Ho] C. Y. Ho, M. W. Ackerman, K. Y. Wu, T. N. Havill, R. H. Bogaard, R. A. Matula, S. G. 
Oh, and H. M. James. Electrical resistivity of ten selected binary alloy systems. CINDAS 
report 59, for Office of standard reference data National Bureau of Standards, 
Department of Commerce (1981).

More Information about the Thermophysical Properties

The thermophysical properties are progressively being added to the Thermo-Calc databases 
starting with Thermo-Calc software version 2020a. 

You can learn more about the models by searching the help (press F1 when in 
Thermo-Calc). 

You can find information on our website about the properties that can be 
calculated with Thermo-Calc and the Add-on Modules. 

https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
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Application Examples

tcex09 - Calculating a Dew Point with POLY3

This is an example calculating the dew point in the POLY3 module. The SUBDEMO database 
is used and included with your installation.

The STEP_WITH_OPTIONS and MAP commands are of note and used in this example.

tcex10 - Preventing Cr2O3 Clogging in a Continuous Casting Process
The example calculates an equilibrium with suspended or dormant phases and shows how to 
avoid Cr-oxide clogging in a continuous casting process. 

This uses the TCOX database. A license is required to run the example.

The background of this example is that a manufacturer wanted to increase the Cr content of 
a material from 18 to 25 weight percent. They then had trouble in the continuous casting of 
this material  because solid Cr2O3 was formed. 

Using Thermo-Calc to calculate the equilibria in the steel/slag system, a simple correction 
was found: modify the Mn or Si content to decrease the oxygen potential. 

In Thermo-Calc, you can FIX a phase with zero amount to simulate how to avoid forming this 
phase. You then release one of the conditions, usually one of the compositions, and this 
composition is determined by the equilibrium calculation.

These commands are of note and used in this example:

 l DEFINE_SYSTEM
 l CHANGE_STATUS
 l COMPUTE_EQUILIBRIUM
 l DEFINE_SYSTEM
 l DEFINE_SYSTEM
 l LIST_CONDITIONS
 l LIST_EQUILIBRIUM
 l LIST_STATUS
 l SET_CONDITION
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 l SET_NUMERICAL_LIMITS
 l SET_REFERENCE_STATE
 l SHOW_VALUE

tcex11 - Oxidation of Cu2S with an H2O/O2 Gas Mixture
This example demonstrates the oxidation of Cu2S with an H2O/O2 gas mixture. Thermo-Calc 
is used to find the optimum O/H ratio (i.e. oxygen potential) as certain oxygen potential 
values can desulphurize Cu2S without forming copper oxides.

In Thermo-Calc, the problem reduces to perform equilibria calculations in a Cu-S-H-O 
system. The amounts of the components should be kept to correct ratio corresponding to 
Cu2S and H2O using a command SET_INPUT_AMOUNTS in POLY3. Initially, O/H = 0.5 is given. 
Optimum O/H ratio is calculated with the desired calculation conditions. For example, to 
simulate one phase disappearing, you can FIX the phase with zero amount.

The tcex11.TDB file is used to access data and this is included with your installation.

These commands are of also of note and used in this example:

 l SET_NUMERICAL_LIMITS
 l SET_REFERENCE_STATE
 l SHOW_VALUE

tcex20 - Adiabatic Decompression in a Geological System

This example calculates the adiabatic decompression in a geological system using the 
geochemical database. The database is included with the file named PGEO.TDB, which is in 
the same folder as this example.

These commands are of note and used in this example:

 l DEFINE_SYSTEM
 l DEFINE_COMPONENTS
 l SET_INPUT_AMOUNTS
 l LIST_CONDITIONS
 l SET_CONDITION
 l SHOW_VALUE
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tcex24 - Simulation of the Silicon Arc Furnace
This is a simple reactor model with output of gases at the top and output of condensed 
phases at the bottom. The gas phase from one segment flows to higher segments, 80% 
reacts in the first above, 15% in the second above and 5% in the third above.

The condensed phases flow downwards and all of it goes to the next lowest segment. Heat 
can be added at any module. The only way to specify the initial state of the reactants added 
to the reactor is to specify the heat content.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l DEFINE_SPECIES
 l CREATE_STAGE_BOXES
 l CREATE_DIVIDERS
 l CREATE_PIPES
 l START_SIMULATION

tcex27 - Calculating Chemical Vapor Depositions (CVD) 

This example calculates the chemical vapor deposition (CVD).

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l DEFINE_COMPONENTS
 l SET_CONDITION
 l ADD_INITIAL_EQUILIBRIUM
 l LIST_AXIS_VARIABLE
 l LIST_INITIAL_EQUILIBRIA
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tcex28 -  Pitting Resistance Equivalence (PRE) for a Duplex Stainless Steel

This example  calculates the Pitting Resistance Equivalence (PRE) for a duplex stainless steel.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

 l REJECT
 l RESTORE
 l DEFINE_ELEMENTS
 l AMEND_PHASE_DESCRIPTION
 l EVALUATE_FUNCTIONS
 l SET_START_CONSTITUTION

tcex29 - Calculating the Speciation of a Gas

This example shows how to calculate the speciation of a gas.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

 l SET_INPUT_AMOUNTS
 l LIST_CONDITIONS
 l SET_CONDITION
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Introduction to Data Optimization

This guide describes the basic idea behind data optimization, contains brief descriptions of 
the modules and file types that you work with while doing your optimization, as well as 
rough outline of overarching workflow that you typically follow when working with 
optimization.

This guide assumes that you are familiar with using Thermo-Calc Console Mode. It also 
assumes that you understand the principles of thermodynamics and are familiar with the 
theoretical foundations of computational thermodynamics.

Press F1 to search the help for information about all the commands available in 
the Thermo-Calc Console Mode, including PARROT and ED_EXP. Note that the 
commands listed under PARROT and ED_EXP are only commands that are 
specific to PARROT and/or ED_EXP. These modules also contain some 
commands that are also available in POLY.

Thermo-Calc Console Mode example tcex36 is a detailed example of assessment 
and optimization in Thermo-Calc.

More about data optimization and PARROT, including a video about how to use 
PARROT, is available on the Thermo-Calc Software website. The video is also 
available on our YouTube playlist.

https://thermocalc.com/about-us/methodology/the-calphad-methodology/data-optimization-module-parrot/
https://youtube.com/playlist?list=PLfv6McToaTGSqlXQJSOMDnbCO3uVOYISc&si=mvvIPlHcO0WW3C8M
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Data Optimization

In a thermodynamic database, each phase in a system is characterized using a mathematical 
model of its Gibbs energy. The Gibbs energy of a phase depends on various state variables. It 
can be defined individually even in a heterogeneous system with many stable phases since 
the properties of one phase are completely independent of the properties of the other 
phases in the system. In most alloy systems, the thermodynamic properties of a phase can 
be modeled by expressing how the Gibbs energy depends on temperature and composition. 
State variables such as pressure, volume or entropy can also serve as parameters in the 
Gibbs energy expression. The Gibbs energy of the whole system is the sum of the products 
of the Gibbs energy of each phase multiplied by the amount of that phase.

How the Gibbs energy of the phase varies with various state variables is determined by a 
mathematical model and how various adjustable parameters of the model is set. By 
optimizing these parameters, you can calculate the thermodynamic properties of a system 
under various conditions (by calculating phase diagrams for example). The thermodynamic 
properties themselves are functions of temperature, pressure or composition. They include, 
among other properties, standard enthalpy of formation, entropy, heat capacity, molar 
volume, thermal expansivity, compressibility and Curie temperature for magnetic 
transformations.

Data optimization is about adjusting the model parameters so that calculated equilibria fit 
well with experimental data. An important part of a data optimization is therefore collecting 
and assessing available experimental and theoretical information about phase equilibria and 
thermochemical properties of a system. 

When you optimize the parameters of the model of a phase, you put what is called 
optimizing variables into the Gibbs energy expressions of those parameters. During the 
optimization, the values of these variables are varied in order to find a fit between the 
calculated equilibria and the experimental data that you base the optimization on. Once you 
have settled on a Gibbs energy expression for a certain parameter of a phase of the 
element, then you must stick to this expression in all future optimizations involving the 
element. If you do not do this, then you must re-optimize all previous systems that involve 
this element when the expression is changed. 

The Thermo-Calc software allows you to optimize parameters that characterize not only 
binary systems, but also ternary system and systems of even higher orders. You can even 
optimize parameters that characterize systems of different orders at the same time. 
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More about data optimization and PARROT, including a video about how to use 
PARROT, is available on the Thermo-Calc Software website. The video is also 
available on our YouTube playlist.

https://thermocalc.com/about-us/methodology/the-calphad-methodology/data-optimization-module-parrot/
https://youtube.com/playlist?list=PLfv6McToaTGSqlXQJSOMDnbCO3uVOYISc&si=mvvIPlHcO0WW3C8M
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The Least-Squares Method

Data optimization in Thermo-Calc is based on the least-squares method for fitting values 
calculated on the basis of a model with observed quantities. The software is accordingly 
trying to find the optimizing variable values that lead the minimized sum of the squares of 
the differences between the calculated values and the observed quantities (that is, of the 
errors or residuals).

The least-squares method works best under the following conditions:

 l The observed quantities have a Gaussian probability distribution. 
 l The observed quantities are only subject to random errors. 
 l The different observations (experiments) are uncorrelated 
 l The standard deviation of each observation can be estimated. 
 l The number of observations is large. 
 l The models used give precise predictions. 

Of course, these conditions are usually not all met in a normal thermodynamic assessment. 
But even in non-ideal conditions, there is no known method that works better than the 
least-squares method.
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The CALPHAD Approach

CALPHAD is originally an abbreviation for CALculation of PHAse Diagrams, but 
was later expanded to refer to computer coupling of phase diagrams and 
thermochemistry. More about the CALPHAD methodology, including some of its 
history, is available on the Thermo-Calc Software website.

The data optimization functionality in Thermo-Calc works according to the CALPHAD 
approach to computational thermodynamics. This approach builds on the development of 
models that accurately represent thermodynamic properties for various phases. These 
models enable you to predict the thermodynamic properties of multicomponent systems-
based data concerning binary and ternary subsystems. The predictions can take many 
factors into accounts, such as, for example, crystallography, type of bonding, order-disorder 
transitions and magnetic properties.

References

For in-depth information about CALPHAD as well as data optimization, see Computational 
Thermodynamics – The Calphad Method by Hans Leo Lukas, Suzana G. Fries and Bo Sundman 
(Cambridge University Press, 2007). CALPHAD was given its first general description in 
Computer Calculations of Phase Diagrams by Larry Kaufman and Harold Bernstein (Academic 
Press, 1970). The book contains some case studies of optimizations using Thermo-Calc.

Information about the concept of ‘lattice stability’ (which is important for the development 
of multicomponent thermodynamic databases) can also be found in the paper Hume-
Rothery and Calphad Thermodynamics by Larry Kaufman, published in Calphad and Alloy 
Thermodynamics, edited by Patrice E.A. Turchi, Antonios Gonis, Robert Shull (The Minerals, 
Metals & Materials Society, 2002), pp. 3-19. 

https://thermocalc.com/about-us/methodology/the-calphad-methodology/
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Data Optimization in Thermo-Calc

More about data optimization and PARROT, including a video about how to use 
PARROT, is available on the Thermo-Calc Software website. The video is also 
available on our YouTube playlist.

The actual performance of the optimization of a system is primarily done in the PARROT 
module, and in its sub-module ED_EXP. The POLY and POST modules are used to calculate 
and plot property or phase diagrams based on the optimized variables. This allows you to 
visually assess how good a fit you have achieved between your calculated results and your 
experimental data. 

The end result of a successful optimization is typically an updated Thermo-Calc database file 
(with filename extension *.TDB) or a new database file.

https://thermocalc.com/about-us/methodology/the-calphad-methodology/data-optimization-module-parrot/
https://youtube.com/playlist?list=PLfv6McToaTGSqlXQJSOMDnbCO3uVOYISc&si=mvvIPlHcO0WW3C8M
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Data Optimization Workflow

When you carry out an optimization using Thermo-Calc, you typically follow a workflow as 
outlined below.

 1. Collect experimental data about your system from various sources such as journal 
articles and reports.

 2. Create a POP file in which you enter the experimental data you have collected.

 3. Create a setup macro file in which you define your system and the variables you 
want to optimize. A useful general procedure is to first find a minimum set of 
variables that allows you to calculate most of the experiments.

 4. Run the setup macro file.

 5. Compile your POP file. This file often contains errors, which need to be corrected, 
and the file recompiled several times before the compilation is completed without 
errors. 

 6. In the ED_EXP module, check that the experiments in your POP file reach equilibrium 
with reasonable results. If any experiments do not reach equilibrium with reasonable 
results, then try changing the starting values on equilibrium conditions (such as 
composition) to see whether the equilibrium can be computed after all. If this does 
not work, then you can temporarily exclude the experiment from the optimization. 
At a later stage in the optimization, when the optimizing variables have different 
values, you can check whether the experiments can be computed with reasonable 
results.

 7. Back in the PARROT module, run the first optimization cycle and evaluate the 
feedback in the console. You can also plot diagrams in the POLY module that allow 
you to visually inspect the fit between calculated optimization results and the 
experimental data. If you are not satisfied with the fit, then enter the ED_EXP 
module again and adjust the weights of the experiments in a way that is likely to 
improve the fit and run another optimization cycle. Reiterate until you are satisfied 
with the fit.

 8. Once you get the optimization stable and smooth with the minimum set of variables 
chosen in step 3 above, try using different sets of variables to see whether 
improvements are possible.

 9. When you are satisfied with the fit between calculated results and experimental data 
with your final set of optimizing variables, update your setup file and POP file. In the 
setup file, enter the calculated optimizing variable values as the variables’ start 
values. In the POP file, enter the final weights of the experiments. With these files 
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updated, you can easily regenerate the parameter values of your optimized system. 
Having the files updated also makes it easier to optimize the system again in light of 
new data or new theoretical models.

 10. Finally, update the database with your calculated results or create a new database 
with information about the system that you have optimized. 
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The PARROT Module

More about data optimization and PARROT, including a video about how to use 
PARROT, is available on the Thermo-Calc Software website. The video is also 
available on our YouTube playlist.

The PARROT module consists of a comprehensive subroutine package for data evaluation of 
thermodynamic model parameters from experimental data. The module has 99 variables 
that you can use for optimization and the module can handle a thousand experimental 
measurements in an optimization. However, there are limits on the simultaneous numbers 
of variables and experiments. These limits are listed at each optimization.

The PARROT module is part of the Thermo-Calc software. The module is not 
included in the software development kits (SDKs).

The experimental data is entered and edited in a sub-module of PARROT: The EDIT_
EXPERIMENTS Module.

https://thermocalc.com/about-us/methodology/the-calphad-methodology/data-optimization-module-parrot/
https://youtube.com/playlist?list=PLfv6McToaTGSqlXQJSOMDnbCO3uVOYISc&si=mvvIPlHcO0WW3C8M
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The EDIT_EXPERIMENTS Module

The EDIT_EXPERIMENTS module, or ED_EXP for short, is used for entering, evaluating, and 
editing experimental data. To enter the module, go to The PARROT Module and then issue 
the command EDIT_EXPERIMENTS.

Since ED_EXP uses the POLY module for doing equilibrium calculations of experimental data 
points, many POLY commands are also available in the ED_EXP module. However, the 
commands may work somewhat differently in the two modules. There are also unique ED_
EXP commands which are not found in POLY.

When you execute ED_EXP commands, the PARROT workspace is modified. However, note 
that you must always first use READ_WORKSPACES in ED_EXP before doing anything in the 
module. The command loads the experimental data that you are going to work with during 
the optimization. Furthermore, before leaving ED_EXP you must use SAVE_WORKSPACES  or 
the results of your work in the ED_EXP module is lost. 
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Data Optimization in Other Modules

All kinds of thermodynamic data, calculated equilibrium states or dynamic parameters are 
transferred back and forth between the PARROT and the GIBBS module as well between 
these and the POLY module. Whenever an optimization run is performed, PARROT calls the 
GIBBS module for stored system definition data and model parameters. 

In Thermo-Calc, the GIBBS module (the Gibbs Energy System) handles the models of the 
various phases that can form in a multicomponent system. It stores thermodynamic data 
and performs various Gibbs energy equilibrium calculations. It contains subroutines to 
analytically calculate the first and second partial derivatives of integral Gibbs energy with 
respect to any set of variables. Many thermodynamic models for various types of substances 
are implemented in the module. Some commands that are available in the PARROT module 
are also available in the GIBBS module. 

In the GIBBS module, parameters of the Gibbs energy models are referred to as TP-
functions. 

PARROT calls the POLY module for equilibrium calculations. The POLY module is used for 
calculating and storing complex heterogeneous equilibria. 
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Optimization File Types

These are the important files you work with when optimizing.

File type Description

POP file

The POP file (Parrot OPtimization file) is the file that contains all the experimental data that 
you use for optimizing Gibbs energy values for your system. The POP file is a plain text file 
that contains ED_EXP commands. By default, the file has the filename extension *.POP in 
Thermo-Calc.

Setup file
The setup file is a Thermo-Calc macro file (*.TCM). This file typically contains commands that 
define your system, opens the PARROT workspace (and associated GIBBS and POLY 
workspaces) and sets optimizing variables.

Other macro files

It is often useful to have other macro files than the setup file at hand while you are doing 
your optimization. For example, it is convenient to have a macro file that automatically plots 
phase diagrams or other diagrams based on the latest values of your optimizing variables. An 
optimization process typically involves many optimization cycles, so this operation needs to 
be done many times during a typical optimization.

Workspace files

The PARROT module has its own workspace with dynamic memories, similar to the 
workspaces of POLY and GIBBS. It is stored and updated in a PARROT workspace file with the 
filename extension *.PAR. The workspace file is a binary file whose format is hardware 
dependent. This means that the format is unique for each type of CPU. Hence, a workspace 
file saved on a computer with one type of CPU cannot be used on a computer with another 
type of CPU.

EXP-file

The EXP-file is a plain text file with information in the form of DATAPLOT Graphical Language 
commands. These commands can specify some or all of the data points in your POP file. This 
allows you to plot these data points on top of your plotted optimization results (with the 
POST commands APPEND_EXPERIMENTAL_DATA or QUICK_EXPERIMENTAL_PLOT). You can 
then visually assess the fit between these results and the experimental data. The PARROT 
workspace is not influenced in any way by the creation or use of EXP-files.

DATPLOT User Guide included with this documentation set.
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Optimization Workspaces

When writing the setup file, you enter a CREATE_NEW_STORE_FILE command which creates 
a PARROT workspace file. Alternatively, select an existing PARROT workspace file with SET_
STORE_FILE. The workspace file is automatically updated and saved with the latest 
optimization results (after each use of the OPTIMIZE_VARIABLES command). You can also 
explicitly instruct Thermo-Calc to save the workspace using SAVE_PARROT_WORKSPACES. If 
you want to get rid of your latest changes and return to the state of your workspace when it 
was last saved, use READ_PARROT_WORKSPACES. 

When the PARROT workspace is saved, parts of the POLY and GIBBS workspaces are also 
saved to the PARROT workspace file, along with the PARROT workspace itself. Using the 
POLY command SAVE_WORKSPACES creates a new POLY3 file, nothing is saved to the 
PARROT workspace file.

If you do any POLY calculations based on data in the current workspace file, then a *.POLY3 
file is created, which contains a copy of the current set of parameters. If you continue on 
your optimization and read the old *.POLY3 file, then the new set of parameters is 
overwritten with the old set. It is therefore recommended that you never read a *.POLY3 or 
*.GES5 file while you are doing an optimization. 
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Method for Optimization and Simulation

The PARROT module typically uses ordinary POLY minimization for equilibrium calculations. 
The global minimization technique that is used in POLY cannot be used because it 
automatically creates new composition sets which corrupt the PARROT workspace. 
Furthermore, the equilibrium definitions that you use as input for your optimization must 
each be attributed to a specific phase. Some of these definitions may specify some local or 
partial equilibrium state rather than a global minimum. However, it is possible to use the 
global minimization technique for some equilibrium calculations by using the ED_EXP 
command ADVANCED_OPTIONS with the Toggle_Alternate option.

Optimization in PARROT is performed on the basis of a ‘maximum likelihood’ principle. 
According to this principle, the best fit between various calculated results and all the input 
of experimental data is found where the sum of the square of the weighted residuals is at its 
minimum. 

Typically, the results of an optimization is considered to be better the fewer optimizing 
variables that are needed to get the same level of fit between computed results and 
experimental data. If you can get almost the same fit using eight instead of twelve 
parameters, then this should be considered to be a significant improvement. When more 
parameters are used, the values of the individual parameters tend to become unrealistic. 
This is particularly true when it comes to temperature-dependent parameters. However, 
relatively small differences in the number of parameters are often insignificant. For example, 
it does not typically matter whether you used 24 or 25 parameters to reach a certain degree 
of fit. 

It is often difficult to compare the quality of different optimizations based on the number of 
optimizing variables that have been optimized. Since you may rely more or less heavily on 
different pieces of available experimental data (and do so with good reason), it is possible 
that two different users could end up with very different numbers of parameters for the 
same system. For example, suppose you optimize the Fe-Al system to incorporate it into an 
Al database, while someone else optimizes the same system to incorporate it into an Fe 
database. In this situation, the two of you would probably make different judgements about 
which experimental information your calculated results must have a good fit with. 
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Creating the POP File
Before starting an optimization in Thermo-Calc, you must collect relevant experimental data 
about your system that is available in the research literature. This data is then entered in the 
POP file. The experimental data points and measurements are entered in this plain text file 
in the form of ED_EXP commands.  

The syntax of the POP file is in principle independent of the models used for describing the 
phases in the system.

In this section:

Experimental Information 19

POP File Syntax 22

Entering Experimental Information 24

Using Stability Conditions 35

Grouping Equilibria with Labels 36

Dividing the POP File into Several Blocks 37
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Experimental Information

An optimization of thermodynamic model parameters should be based on a range of reliable 
experimental results that is as wide as possible, as well as on empirical or semi-empirical 
correlations and theoretical considerations. During an optimization in Thermo-Calc, many 
kinds of thermochemical and thermophysical data can be mixed and used together.

The information needed for an optimization represent measurements of thermodynamic 
parameters in the system at equilibrium. These can be measurements of any of the 
thermodynamic quantities that can be set as conditions in Thermo-Calc. The information 
may represent measurements of activities or enthalpies in single-phase regions for example, 
or solubilities or transformation temperatures in a multi-phase region. 

For each equilibrium that is used in the optimization, at least one quantity must have been 
measured and you also need to know the conditions that must be set to compute the 
system’s equilibrium state. For example, consider a binary system in a single-phase region. 
Suppose that you have measured the temperature, pressure, composition and the chemical 
potential. Three of these quantities are necessary to specify the equilibrium state and the 
forth can be used as experimental information to model the phase. 

If you have a two-phase region and know the temperature and pressure conditions, as well 
as which the stable phases are, then you could use the compositions of one or both phases 
as experimental data. The former information about the conditions is sufficient to determine 
the equilibrium. The experimental information can then be used to optimize the parameters 
that are used to characterise and model the system.

For examples how to enter various kinds of experimental data in the POP file, 
see Experiments and Experimental Data. 

Conflicting or Missing Information

You are likely to sometimes have inconsistent or conflicting experimental information. In 
principle, all available experimental data should still be entered into the POP file, unless you 
have good reasons to exclude some information. For example, if you have reason to believe 
that the samples used in some experiments were not pure, then these experiments could be 
excluded from the POP file. 

For some systems, you have very little experimental data to go on. When this is the case, do 
not try to fit the available data uncritically with high accuracy without considering possible 
errors. You can look for data in systems with similar elements to get an idea about what the 
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reasonable estimates of data that is lacking could be. Or you can use calculations from first 
principles or semi-empirical methods to get reasonable estimates that can be used as 
experimental data.

Invariant Equilibria Information

The most valuable experimental information for an optimization is information about stable 
invariant equilibria. An invariant equilibrium is such that neither pressure, temperature nor 
composition can be changed without there being a change in the set of phases present in 
the system. It is recommended that all information about invariant equilibria for a system is 
included in the POP file. These equilibria need not all be based on explicit experimental 
measurements of thermodynamic properties. 

Reasonable estimates from available experimental data are often useful to include in the 
POP file. Such estimates, which should be based on the available experimental data, helps 
Thermo-Calc find a good set of start values on the optimization variables. However, at the 
end of the assessment, these estimated equilibria should be excluded and you should 
complete the optimization based only on the experimental information that is based on 
measurements.

With some experience from phase diagram evaluation, it is possible to make reasonable 
estimates of metastable invariant equilibria. Such estimates helps reduce the number of 
phases that are assessed simultaneously during the optimization. For example, you may 
assume that a certain intermediate phase does not form in a system. Then extrapolate the 
liquidus curves below the stable three-phase equilibria and finally, estimate temperatures 
and compositions of metastable three-phase equilibria between two other phases and the 
liquid. 

Another useful technique is to extrapolate a liquidus line from a peritectic equilibrium to 
estimate the congruent melting temperature of a compound. This estimate may be more 
useful than the information about the peritectic equilibrium itself as the equilibrium involves 
only two phases. 

Equilibria in Higher-Order Systems Information

When you optimize a binary system, the available experimental information can often be 
described equally well by very different sets of parameters. Information about ternary and 
higher order systems that include the components of the binary system are then often 
useful for optimizing the binary system (the same is true of information about quaternary 
system with respect to optimizing ternary systems). Often, it is only when you extrapolate 
the optimized parameters to a higher-order system that you can judge which of the sets of 
model parameters that is best. Sometimes information from several ternary systems is 
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required to make a reliable judgement about which set of parameters best describes a 
particular binary system.

Heat Capacity Information

If you want to optimize your system based on data about heat capacities, then the 
corresponding parameters should first be optimized separately before you perform the 
general optimization of your system. The parameters should be kept fixed during the general 
optimization. This is because it is normally not possible to optimize heat capacity data 
together with other data in a meaningful way. If you do this, then it is very likely that the 
parameters related to the heat capacity are badly determined.
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POP File Syntax

It is recommended that you specify an experimental equilibrium as close as possible to 
actual experimental conditions. Ideally, there is information about the set of stable phases, 
temperature, pressure and some or all compositions for the equilibrium. 

In addition, it is recommended that you keep the POP file well-organised and extensively 
commented. This is especially important if someone else reassesses the system when new 
experimental information is available.

If you have too many equilibria defined in your file, or if you define equilibria with different 
sets of components in the same file, then you must divide the POP file in blocks (using the 
FLUSH_BUFFER command). You know whether you have defined too many equilibria for one 
block when you compile the file. A too large number of equilibria leads to an error message 
when the file is compiled.

If you use the DEFINE_COMPONENTS command, then it must be the first command in the 
POP file (or if you have several blocks, DEFINE_COMPONENTS can also be put as the first 
command after FLUSH_BUFFER). This is because the command automatically reinitiates the 
current workspace, so the effect of any commands placed before it are not saved.

The last command in the POP file should always be SAVE_WORKSPACES .

Legal Commands in a POP File

The following commands can be used in a POP file. 

 l ADVANCED_OPTIONS
 l CHANGE_STATUS
 l COMMENT
 l CREATE_NEW_EQUILIBRIUM
 l DEFINE_COMPONENTS
 l ENTER_SYMBOL
 l EVALUATE_FUNCTIONS
 l EXPERIMENT
 l EXPORT
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 l FLUSH_BUFFER
 l IMPORT
 l LABEL_DATA
 l SAVE_WORKSPACES
 l SET_ALL_START_VALUES
 l SET_ALTERNATE_CONDITION
 l SET_CONDITION
 l SET_NUMERICAL_LIMITS
 l SET_REFERENCE_STATE
 l SET_START_VALUE
 l SET_WEIGHT
 l TABLE_HEAD, TABLE_VALUES and TABLE_END
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Entering Experimental Information

A POP file in Thermo-Calc (*.POP) mainly consists of descriptions of equilibria, each 
equilibrium describing a data point that is based on an experiment from the existing 
literature on your system. An equilibrium is specified using ED_EXP commands. 

The following is an example of a specification of an equilibrium with a single stable phase in 
the Au-Cu system. Equilibria with a single stable phase are often from experiments where 
enthalpies of mixing or chemical potentials have been measured. 

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID=FIX 1

SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563

SET_REFERENCE_STATE AU LIQ * 1E5

SET_REFERENCE_STATE CU LIQ * 1E5

EXPERIMENT HMR=-1520:200

COMMENT Measurement by Topor and Kleppa, Met trans 1984
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Creating a New Equilibrium

The first command in an equilibrium specification is always CREATE_NEW_EQUILIBRIUM. 
This command takes two integers as arguments. The first integer should specify a unique 
identifier that can be used later to refer to the equilibrium in question. The second integer is 
an initialisation code 0, 1 or 2: 

 l Code 1: This means that all components are entered but all phases are suspended. 
This code is appropriate in most cases.

 l Code 0: This means that all components and phases in the equilibrium are suspended 
initially. This code is needed if you are using experimental data about systems of 
different orders simultaneously, such as data about both binary and ternary systems 
for example.

 l Code 2: This means that all components and phases are initially entered.

For example, the first command in the example above creates an equilibrium data point with 
the unique identifier 1. All components of the system are entered but all phases are 
suspended:

CREATE_NEW_EQUILIBRIUM 1 1
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Setting Equilibrium Conditions and  Uncertainty

All the equilibrium-related commands that are placed in between two  CREATE_NEW_
EQUILIBRIUM commands are interpreted as specifying the conditions of the equilibrium 
created by the first command. The values of these conditions should be based on the 
conditions specified in the experiment that you base the equilibrium definition on.

In the example, the CHANGE_STATUS command specifies that the equilibrium is a single-
phase equilibrium with the liquid phase.

CHANGE_STATUS PHASE LIQUID=FIX 1

Furthermore, the temperature is 1379 K, the pressure is 1 bar (1E5 Pa) and the mole fraction 
of Au is 0.0563.

SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563

Sometimes you have reason to think that some information about an equilibrium condition 
may not be accurate. If this is the case, then you specify the degree of uncertainty for a 
condition with a colon after the condition quantity, directly followed by either an absolute 
value or a percentage. For example, if you have reason to doubt the reliability of the Au 
mole fraction measurement, then you could write:

SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563:10%

This indicates that you think the Au mole fraction is between 0.0507 and 0.0619. PARROT 
calculates the equilibrium twice, once for 0.0507 and once for 0.0619, and then computes 
the change of each experimental value between these two equilibria. This change is used to 
modify the uncertainty specified for the experimental value.

Entering the Experimental Value and its Uncertainty

The possibility of specifying uncertainties on conditions may be useful when you have 
experimental data about a ternary system. In a binary system, a tie-line is determined by the 
two phases, the temperature and the pressure. Measurements of the compositions of both 
phases can then be used as experimental data. To specify the tie-line in a ternary two-phase 
equilibrium one of the four compositions must also be set as a condition. If the 
measurement of this composition has the same uncertainty as the other compositions, then 
you can assign this same degree of uncertainty both to the composition selected as a 
condition and the compositions selected as experimental data. Alternatively, the sample 
(overall) composition could be used as a condition and all four phase compositions could be 
used as experiment values. These phases must have the status entered (not fixed) since the 
relative amount of each is unknown.
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Setting Reference States

If you want to specify a non-default reference state for one or several of your system 
components, then you do this with the SET_REFERENCE_STATE command. In the following 
example, the reference states for Au and Cu are set to the liquid phase at current 
temperature (*) and a pressure of 1E5 Pa.

SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5 

In order for these reference states to be taken into account, the R suffix must 
be used when the measurement of the enthalpy per mole of the system is 
entered for an experiment.

The Reference State Suffix R

Suffixes

You can use the reference state suffix R for some thermodynamic variables to calculate their 
value with respect to a reference state that you have previously set for a system component 
with the SET_REFERENCE_STATE command in POLY (or in  response-driven modules such as the 
POURBAIX module). The value of energy-related variables that are used with the R suffix 
depends on the reference states of all the components in the defined system. 

It is possible to use an R suffix on all compositional extensive state variables as 
well, but the value of the state variable is always the same, with or without the 
suffix.

If the reference state for a system component is the default reference state (the stable 
reference state (SER) which is defined in a Thermo-Calc database), then MUR(comp)= MU
(comp), ACR(comp)= AC(comp) and LNACR(comp)= LNAC(comp). 

In the case of some thermodynamic variables, you can also use the R suffix to express 
chemical potentials and activities of species relative to some single-substitutional-lattice 
solution phases (such as aqueous solution, gaseous mixture, metallic liquid solution, slag 
mixture or MO solid solution). These state variables are MU(sp,ph),  MUR(sp,ph),  AC(sp,ph), 

 

ACR(sp,ph), LNAC(sp,ph) and LNACR(sp,ph). 
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The reference states and standard states of various solution species are pre-defined for 
some solution phases in some databases. For all solution species in any solution model in 
any database, it is always the case that MUR(sp,ph)= MU(sp,ph), ACR(sp,ph)= AC(sp,ph) and 
LNACR(sp,ph)= LNAC(sp,ph).
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Entering the Experimental Value and its Uncertainty

The EXPERIMENT command is used to specify the quantity that the calculated results should 
be fitted to. When specifying this quantity, you both specify the measured quantity itself 
and your estimation of the uncertainty of this value. 

In the example, the EXPERIMENT command specifies the enthalpy per mole of the system, 
where this value is specified with respect to non-default reference states that you have set 
in the equilibrium specification:

EXPERIMENT HMR=-1520:200

The value before the colon is the quantity of the variable. The value after the colon is an 
assessment of the uncertainty of this quantity. A higher value means a greater uncertainty. 
In the example, the uncertainty has been specified with an absolute value but it could also 
be specified in percent of the quantity:

EXPERIMENT HMR=-1520:13%

Several experiments can be specified after the experiment command. Besides assigning 
values to conditions, it is also possible to specify that a certain quantity is greater than or 
less than a certain value. For instance, the following command would specify that the 
activity of the C-component is less than 0.01 and the mass fraction of the BCC phase of Ag is 
greater than 0.05:

EXPERIMENT ACR(C)<0.01:0.001 W(BCC,AG)>0.05:10%

Note that an experimental quantity can typically also be treated as an equilibrium condition, 
and vice versa. Which measured quantities that you treat as conditions and which quantities 
you treat as experimental data should be based on the accuracy of the different 
measurements. In most cases, the quantity that is based on the experimental technique with 
the lowest accuracy should be used as the experimental value.
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Entering Many Equilibria as a Table

When one thermodynamic variable (e.g. heat capacity) has been measured as a function of 
another (e.g. temperature), then experimental data is often presented as a table. By using 
the TABLE_HEAD, TABLE_VALUES and TABLE_END commands, you can enter such experimental 
information into the POP file in the form of a table. These three commands should always be 
used together and must be entered in the right order. See TABLE_HEAD, TABLE_VALUES and 
TABLE_END.

The TABLE_HEAD command is followed by a number. This number identifies the table as a 
whole, but also uniquely identifies the first equilibrium that is included in the table. This 
numeric identifier is incremented by one for each additional equilibrium in the table. Each 
row in the table represents one equilibrium. Thus, the equilibrium defined by the first row in 
the table above (on the line immediately below TABLE_VALUE) is uniquely identified with 
the number 1, the equilibrium defined by the second row by number 2, and so on until the 
last equilibrium on the sixth row, which is identified by the number 6. 

Since the unique identifiers of the equilibria in the table are automatically generated from 
the unique numerical identifier that you give to the table, the unique numerical identifier 
that is normally given to the CREATE_NEW_EQUILIBRIUM command is replaced by two at 
signs (@@).

At least one of the equilibria conditions specified with the SET_CONDITION command must 
be a condition whose value is set by the numbers in one of the table columns. To assign the 
numbers in a column to a condition, use the syntax SET_CONDITION <condition>=@<column 
number>. For instance, in the example above, the mole fraction of X(ALO3/2) is for each 
equilibrium given by the number in the first column of the table. 

At least one of the measured variables that are entered with the experiment command must 
be a variable whose value is set by the numbers in a table column. To assign the numbers in 
a column to a measured variable, use the syntax EXPERIMENT <variable>=@<column 
number>. In the example above, the measured temperature for each equilibrium is given by 
the number in the second table column.

The actual table should be entered between TABLE_VALUES and TABLE_END. Separate the 
columns with tabs or any number of spaces. The columns do not have to contain numbers, 
but can also contain other types of values, such as phase names for example. If a column 
contains text with spaces or special characters, then the text must be surrounded by double 
quotes (“ABC DEF&ghi”, for example). The table may have columns that are not used, but 
each row must have exactly the same number of columns.

The following block of commands exemplifies how a table can be entered into a POP file:

TABLE_HEAD 1

CREATE_NEW_EQUILIBRIUM @@ 1
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CHANGE_STATUS PHASE TETR=FIX 0

CHANGE_STATUS PHASE ION=ENT 1

SET_CONDITION P=101325 N=1 ACR(O2,GAS)=.21 X(ALO3/2)=@1

EXPERIMENT T=@2:5

TABLE_VALUE

0.4608 2476

0.5714 2380

0.6682 2276

0.7496 2176

0.5038 2426

0.6313 2249

TABLE_END
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Setting Site Fraction Start Values

In some systems, you have to set non-default composition start values on some experiments 
in order to get them to converge properly during optimization. This may be important if your 
system has a miscibility gap for example, in which case several equilibria with different 
compositions exist at certain temperatures. In such cases, you have to make sure it is 
specified in the POP file which side of the miscibility gap the equilibrium is on. The calculated 
equilibrium could otherwise end up on the wrong side, resulting in a large error. 

In the POP file, you can set the site fraction of a constituent on an equilibrium with SET_
START_VALUE. 

For example, the following command sets the composition start value of VA constituent of 
the FCC_A1 phase to 0.99:

SET_START_VALUE Y(FCC_A1,VA#2)=0.99

Setting the mole fraction for a component in a phase is not as reliable as setting the site 
fraction. 

Additional equilibria entered after the last SET_START_VALUE command are automatically 
given a similar start value if the following command appears previously in the POP file:

SET_ALL_START_VALUES Y

If start values are not set automatically for phase constituents, then you may have to set the 
composition start value for each equilibrium (or table of equilibria) separately. 
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Commenting About an Equilibrium

The COMMENT command inserts a comment about the equilibrium that is saved to the 
PARROT workspace file when the POP file is compiled. The comment must be entered on 
one line. 

Comments can also be entered immediately after a dollar sign ($), but these are not saved to 
the PARROT workspace. Instead, these comments are ignored by Thermo-Calc when the POP 
file is compiled.
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Simultaneous Use of Binary and Ternary Experiments

You can use experimental information about binary and ternary systems (as well as systems 
of even higher order) in the same POP file and optimization. To do this, you must inform the 
PARROT module that not all components of the ternary system (or system of even higher 
order) should be considered. This allows you, for example, to use experimental information 
about a binary equilibrium that exists within a ternary system.

Use CHANGE_STATUS with the keyword component and which components that should be 
entered. You should also give the initialization code 0 (rather than 1) to the CREATE_NEW_
EQUILIBRIUM command. This code indicates that all components must be entered.

For example, the following set of ED_EXP commands characterises a binary (A-B) three-
phase equilibrium (FCC-BCC-LIQ) in a ternary system (A-B-C). It can be used in a POP file that 
otherwise only contain experimental information about the ternary system (A-B-C):

CREATE_NEW_EQUILIBRIUM 1 0 

CHANGE_STATUS COMPONENT A B = ENTERED 

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1 

SET_CONDITION P=1E5 

EXPERIMENT T=1177:10 

COMMENT from A-B
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Using Stability Conditions

Early in the optimization when parameter values are not so good it is often useful to set the 
driving force for precipitation of a phase (per mole of components) to make sure that it 
appears where it should. The DGM condition is very useful for making sure that phases 
appear where they should. It can be removed when the optimization becomes stable.

The DGM condition is also useful for suppressing phases that appear where they should not 
appear. Do this by setting the value and the uncertainty to something reasonable. For 
example, the driving force for precipitation of the BCC phase could be set as follows:

DGM(BCC)<-0.1:0.1

This produces an error even before BCC becomes stable and the weight of the experiment in 
question can be adjusted as needed. If you specify that the driving force for the BCC phase 
should be below 0 (DGM(BCC)<0:1E-4 for example), then the optimization converges 
extremely slowly (if at all). With such a sharp error condition, calculating the equilibrium is 
like finding the minimum point on a lawn that gently slopes towards a rock wall. The 
optimization keeps bouncing into the wall.

Another useful stability condition is the phase stability function, abbreviated QF. This can be 
used to specify that a phase is outside the miscibility gap for a solution phase. If QF(phase) is 
negative, then the phase is inside the miscibility gap; if QF(phase) is positive, then it is 
outside the miscibility gap.
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Grouping Equilibria with Labels 

If you have several equilibria describing experiments that you want to be able to treat 
collectively, you can give all of the equilibria one and the same label. 

Use LABEL to give an equilibrium a label. The label must start with the letter A and can only 
be up to four characters long. For example, you can insert the following command in several 
equilibria specifications: 

LABEL ALH

During the optimization, you could use this label to, for example, set all the equilibria that 
have it to the same weight in the ED_EXP module.
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Dividing the POP File into Several Blocks

For two different reasons, you may have to divide your POP file into different blocks: 

 l PARROT uses a buffer for storing compiled experimental data. If there is not enough 
memory in this buffer for storing all the experiments from the POP file, then the POP 
file can be divided into several blocks. When PARROT encounters the end of a POP 
file block, it saves the experimental data that has been compiled to PARROT 
workspace, clears out the memory buffer and then proceeds to read the next block 
in the POP file. This goes on until the experimental data from all the blocks have 
been saved to the PARROT workspace. 

 l If you want to put equilibria with different sets of components in one and the same 
POP file, then you must divide the file up into blocks. Each block should only contain 
equilibria that all have the same set of components. 

To divide the equilibria in the POP file into different blocks, enter the FLUSH_BUFFER 
command between two equilibria. This command marks the beginning of new block. When 
the command is encountered during the compilation of the POP file, the compilation of the 
current block is terminated, the equilibria saved to the PARROT workspace file and a new 
block is initiated. That the buffer is reinitiated means that all functions and constants that 
were entered in the previous block must be entered again in new block in order to be used.

When editing your experimental data in the ED_EXP module, you can select which block to 
load and edit using READ_WORKSPACES <block number>. The block before the first instance 
of FLUSH_BUFFER is block number 1, the block after the first instance and before the second 
instance is block number 2, and so on.
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Creating the Setup File

The second step is to create the setup file. This is an ordinary Thermo-Calc macro file 
(*.TCM). Typically, your setup file should contain the following:

 l A system definition.
 l A section where you enter model parameters and optimizing variables. 
 l A GO PARROT command.
 l A section where initial values are assigned to the optimizing variables for the first 

optimization cycle.
 l A CREATE_NEW_STORE_FILE <filename.par> which creates the PARROT workspace 

file onto which the results of your optimization are continuously saved and updated. 
By default this workspace file has the same filename as the setup file, but with the 
*.PAR filename extension. 

 l A COMPILE_EXPERIMENTS <filename.pop> command. Since you often encounter 
syntax errors when you first try to compile a POP file, it may be useful to execute this 
command from the console rather than as part of the setup macro file.

 l Normally, you also have a SET_INTERACTIVE at the end of the setup file. This 
command returns control over Thermo-Calc to the console.

It is possible to interactively execute all these commands one at a time in the console. It may 
be instructive to enter the commands that would normally go into the setup file interactively 
while using the on-line help while you are learning to use the PARROT module.
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Defining the System 

If you have an existing database with information about your system, then you can write the 
system definition part of your setup file in two different ways.

 l If you have an unencrypted user database, then you can define your system by 
entering DATA module commands directly in the setup file. Use the DATA commands 
that you normally use to define a system when doing equilibrium calculations in 
Thermo-Calc Console Mode.

 l Define your system by entering DATA module commands directly in the console, 
then generate a macro file with the GIBBS command LIST_DATA <name of setup 
file>.tcm p . This command saves all the data that has been loaded in the GIBBS 
workspace as a macro file. This file can then be modified as required into an 
optimization setup file. 

Creating Additional Composition Sets of a Phase

If you need several composition sets of a phase, then these should be created with the 
GIBBS command AMEND_PHASE_DESCRIPTION <phase name> composition_sets 
<composition set number> in the setup file.

If you add composition sets of a phase after the POP file has been compiled, the 
data structure in the workspace is corrupted and you have to recompile the 
POP file.
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Entering the Optimizing Variables

When you have retrieved the data about your system for the setup file, you must manually 
enter the model parameters that you want to optimize. This is done using the GIBBS 
command ENTER_PARAMETER, but when you specify the Gibbs energy expression for the 
parameter, you enter variables that can be given various values into the expression. It is the 
values of these variables (and thus, the Gibbs energy of the parameter) that you are 
optimizing. 

How you in detail specify the optimizing variables in your set up file depends on which phase 
you are trying to optimize and what thermodynamic model that is used in the optimization. 

Thermodynamic Models
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Entering Optimizing Variables in Parameter Specifications

There are ninety-nine predefined variables in the PARROT module which you can use in your 
optimization. These variables are referred to as V1, V2, V3, … V98 and V 99. When the GIBBS 
workspace is initialized, all optimizing variables are set to a fixed numerical value of zero. 
When you do an optimization, there is always some variable for which you want to evaluate 
the best value, but you can assign fixed values to optimizing variables too. It is often useful 
to enter all the variables that you can conceivably want to optimize, and then you can 
interactively select and change which variable to focus at various stages of the optimization. 

The setup file excerpts that follow show how optimizing variables are entered. However, 
before the optimizing variables are introduced in this example, the following command 
enters an ionic liquid solution phase (a phase for which you have some experimental 
information):

ENTER_PHASE IONIC_LIQ  Y, 
AL+3,ZR+4 ; ALO2-1,O-2 ; N N

This ENTER_PHASE command enters a phase called IONIC_LIQ into the GIBBS workspace. 
This phase is of the type ionic liquid solution, which is specified by type code Y. Such a phase 
is modeled by the Ionic Two Sublattice Liquid Model. The next two arguments specify the 
two sublattices, in this case the cations AL+3,ZR+4 and the anions ALO2-1,O-2. Components 
that interact in a sublattice are separated by a comma. The first N at the end means that no 
additional constituents are added to the phase. The second N means that a list of possible 
parameters for the phase should not be shown in the console.

There are model parameters that describe the phase which you do not want to optimize, in 
which case the Gibbs energy expression of the parameter does not contain any optimizing 
variables. 

Example 1

For example, the following parameters of the IONIC_LIQ phase do not contain any 
optimizing variables:

ENTER_PARAMETER G(IONIC_LIQ,AL+3:ALO2-1;0) 298.15 +2*GAL2O3_L; 6000 N

ENTER_PARAMETER G(IONIC_LIQ,AL+3:O-2;0) 298.15 +GAL2O3_L+400000; 6000 
N

ENTER_PARAMETER G(IONIC_LIQ,ZR+4:O-2;0) 298.15 +2*GZRO2L; 6000 N
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These parameters define the Gibbs energy expressions for three constituents in the 
constituent array, namely AL+3:ALO2-1, AL+3:O-2 and ZR+4:O-2. The names that occur in 
these expressions—that is, GAL2O3_L and GZRO2L—are the names of complex functions of 
temperature that are entered in the GIBBS workspace with the ENTER_SYMBOL command.

The numbers that frame the Gibbs energy expressions specify the temperature range within 
which the expression should be applied. In the above, the expressions are applied in a 
temperature range from 298.15 K to 6000 K. 

Example 2

In this example, suppose that you want to optimize the model parameter for the ZR+4:ALO2-
1 combination, then you could enter the variables V1 and V2 in the Gibbs energy expression 
for that parameter in the following way:

ENTER_PARAMETER G(IONIC_LIQ,ZR+4:ALO2-1;0) 298.15 +GZRO2L +2*GAL2O3_L 
+V1+V2*T; 6000 N

You normally have different optimizing variables in different parameters, but in some cases 
you may want several parameters to vary together, in which case you can use the same 
variable in the Gibbs energy expressions of several parameters.
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Entering Interaction Parameters

For some systems, you have to consider interaction parameters in order to take excess Gibbs 
energy into account and correctly model the phase. By default, the software uses a Redlich-
Kister expression for the excess Gibbs energy. The coefficient is entered after the 
constituent array when you use the ENTER_PARAMETER command. In the last section, all 
the parameters were entered with a coefficient of zero (0). 

To take account of the excess Gibbs energy, you might enter the following:

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;0) 298.15  +V11+V12*T; 
6000 N

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;1) 298.15  +V13+V14*T; 
6000 N

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;2) 298.15  +V15+V16*T; 
6000 N

Parameters with interaction coefficients are referred to as interaction parameters. The 
regular parameter has a coefficient of 0. The subregular parameter has a coefficient of 1. It is 
possible to interaction coefficients up to a value of 9, but you are advised not to use more 
than three coefficients (that is, with coefficient values of 0, 1 and 2).
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Initializing Optimizing Variables in PARROT

Variables that have been entered into Gibbs energy expressions for model parameters in the 
setup file have to be initialized and given start values before they are optimized. 

You have to estimate what start values to give to the optimizing variables based on your 
knowledge of the system or of relevantly similar systems. There are no general rules for 
what start values your optimizing variables should have. If you are not able to make any 
informed estimation about what start values to use, then you may not be able to find a good 
fit between your experimental data and your calculated results.  In this case, it is often best 
to start the optimization in the so-called alternate mode. In alternate mode, the PARROT 
module helps you find some reasonable start values for your optimizing variables. 

About Alternate Mode

Even if you are starting your optimization in alternate mode, you still have to initialize the 
optimizing variables though (you can all give them a start value of 0).

To initialize an optimizing variable and to give it a start value, use either SET_OPTIMIZING_
VARIABLE or SET_SCALED_VARIABLE. Using SET-OPTIMZING_VARIABLE  results in a scaling 
factor equal to the current value of the parameter unless the current value is zero, in which 
case the scaling factor is 1000. This is typically appropriate for enthalpic parameters, but not 
necessarily for other parameters. The scaling factor is the factor by which the optimizing 
variable value is varied during the optimization. 

For example, if you want to optimize the variables V1, V2, V11, V13 and V17, then you could 
enter the following in the setup file:

SET_OPTIMIZING_VARIABLE 1 +43000

SET_OPTIMIZING_VARIABLE 2 -35.2

SET_OPTIMIZING_VARIABLE 11 +72000

SET_OPTIMIZING_VARIABLE 13 +27000

SET_OPTIMIZING_VARIABLE 17 -100000

The value given to each optimizing variable (+43000 for variable V1 for example) is also that 
variable’s initial scaling factor. If you want to set the initial scaling factor of a variable to a 
value that is lower or higher than its start value, then use SET-SCALED_VARIABLE <start 
value><scaling factor><min value><max value>.
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Creating the Workspace File

In the setup file, after the system definition and the entered optimizing variables, use the 
PARROT command CREATE_NEW_STORE_FILE to create and save a PARROT workspace file 
for the system defined in the setup file. For example, the following command saves all 
current data on system definitions (elements, species, components, phases), symbol 
definitions (constants, variables, functions, tables) and parameters that are stored in the 
workspace used by GIBBS, POLY and PARROT into a file called AL2O3-ZRO2.PAR:

CREATE_NEW_STORE_FILE AL2O3-ZRO2

The experimental information in the POP file is not saved to this PARROT 
workspace file.
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Compiling the POP File

At the end of the setup file, use the command COMPILE_EXPERIMENTS followed by the 
name of your POP file to compile the data in that file and save it to the current PARROT 
workspace file. Note that you must first have opened or created a new PARROT workspace 
file before you compile your POP file. The other argument to the command can typically be 
given default values with comma signs (,):

COMPILE_EXPERIMENTS AL2O3-ZRO2.POP,,,

If Thermo-Calc encounters errors in the syntax of the POP file, then error messages are 
displayed in the console. Normally, the compilation also stops when syntax errors are 
encountered. If this happens, then you must correct the errors and recompile the file. It is 
useful to have two console windows open when you do this. That way, you can use one 
console for editing the experimental data and another console for compiling and reading any 
further error messages.
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Returning Control to the Console

Put the command SET_INTERACTIVE at the end of the setup file if you want to return control 
to the console when the commands in the setup file have all been executed.
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Optimizing the System in PARROT

When you have created a POP file, a setup macro file, and (optionally) EXP files, you should 
start doing optimization runs interactively in the console. This process can be divided into a 
number of steps (such as running optimization, evaluating optimization results, modifying 
weights and models and adding new information), but usually, you have to go through many 
optimization cycles before achieving a satisfactory fit between calculation results and 
experimental data.

Typically, it is not obvious when an optimization is finished. You must exercise your 
judgment about when the fit you have achieved is good enough.

It is possible to interactively change almost everything in the initial setup macro 
file and in the POP file. For example, you can add more parameters to be 
optimized and modify or add more experimental information.
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Changes that Require POP File Recompilation

Some changes that you do interactively in the PARROT module or the ED_EXP sub-module 
destroys the data structure in the workspace. For example, if you add more composition sets 
to a phase, then the number of phases actually change and the links break between the 
experimental data and the thermodynamic models. Note that if the global minimization 
technique is used in POLY, then new composition sets that corrupts the PARROT workspace 
may be created automatically. If this happens, then you have to compile the POP file again. 

If you recompile the POP file, then the experimental equilibria are calculated with the 
default start values. 
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Optimization Workflow

Normally, the workflow during an optimization is the following:

 1. In the PARROT module, run the setup macro file using MACRO_FILE_OPEN.

 2. Go to ED_EXP with EDIT_EXPERIMENTS, use READ_WORKSPACES to load your 
experimental data and then execute . 

 3. If an equilibrium cannot be computed, then this either means that the start values 
(site fractions, for example) were inappropriate or that the equilibrium cannot be 
calculated with the current set of parameters. If the latter, then the equilibrium may 
have to be excluded from the optimization. However, you should make an effort to 
exclude the possibility that the reason is just that you do not have the appropriate 
start values for the equilibrium. 

 4. When each equilibrium is either successfully computed or excluded from the 
calculation, go back to the PARROT module and run the OPTIMIZE_VARIABLES 
command. Give the number of optimization iterations you want the Thermo-Calc 
program to carry out as an argument to the command. This number specifies how 
many different sets of values for the optimizing variables that PARROT tries to fit 
with the experimental data. It is recommended that you run 0 iterations first to see 
the discrepancy between the experimental data and the initial calculated results. The 
current workspace file is automatically updated with the last set of optimized 
variables and calculated results. 

 5. List and evaluate the result of the optimization using LIST_RESULT. Typically, what is 
of interest in the results are the relative standard deviation of the optimizing 
variables and the error values in the list of calculated experimental data results. If the 
relative standard deviation for an optimizing variable is very large, this means that 
the variable doesn’t have any effect on the computed results and that the variable 
should not be used (you can make PARROT ignore the variable by setting its value to 
0 with SET_FIX_VARIABLE). If the relative standard deviation is close to zero for a 
variable, then this might indicate that you need to use more variables. When it 
comes to errors in the calculated equilibrium results, these can be decreased by 
lowering the weight that PARROT gives the experiment in the calculation (the more 
weight, the more the experiment affects the calculated results).

 6. Use  OPTIMIZE_VARIABLES or CONTINUE_OPTIMIZATION to carry out a new 
optimization cycle. Go back to step 5 above and continue to do optimization cycles 
until you judge that there is a good enough fit between your calculated results and 
your experimental data. It is recommended that you do not only rely on feedback 
from LIST_RESULT but also frequently plot various diagrams and compare them 
visually to some of your experimental data.
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Ensuring Computation of all Equilibria

When you have run the setup macro file, you should start by trying to compute all the 
equilibria that were created when your POP file was compiled. To do this, you must first go 
to the ED_EXP submodule, and load the experimental data from the current PARROT 
workspace file with the READ_WORKSPACES <block #> command (normally, the block 
number is 1). 

When you have loaded all equilibria, you should try to compute them all using the ED_EXP 
command . A list of calculated equilibrium results are shown in the console, but the software 
is not able to reach an equilibrium for an experiment, then the program cancels the 
calculations and displays an error message. 

The following list shows an example output where the first two experiments in the POP file 
have been successfully computed, but an equilibrium is not reached for the third 
experiment. No other equilibria are computed, since the calculations are aborted when the 
error occurs.

Eq  Lab  Iter Weight Temp   Exp  Fix phases or comments

  1 A1    22   1.    2575.3      IONIC_ FLUORI TETR 

  2 A1    18   1.    2156.9      IONIC_ CORUND TETR 

*** ERROR  1614 IN QTHISS

*** CONDITIONS CAN NOT BE FULLFILLED

When this happens, try to find out why the equilibrium calculation fail. Are the condition 
start values that you have given the equilibrium inappropriate for example? If you have a 
similar equilibrium that has already been successfully computed, then you can select the 
equilibrium that does not work, use the ED_EXP command SET_ALL_START_VALUES   and 
accept all the suggestions for the site fractions. Alternatively, use TRANSFER_START_VALUE 
<equilibrium number> to make the currently selected equilibrium inherit the start values of 
the indicated equilibrium. Run COMPUTE_EQUILIBRIUM again to see if the equilibrium can 
be computed with the inherited start value.

If you cannot find an explanation of why the equilibrium cannot be computed, then it may 
be that the experiment is faulty. If so, then this experiment should be excluded from the 
optimization by being given a weight of 0. You should then run COMPUTE_EQUILIBRIUM 
again to make sure that all equilibria can be computed. However, experiments that fail to 
reach equilibria could succeed in doing so if the optimizing variables have other values. It is 
therefore sometimes worth trying to include experiments later in the optimization process 
(when the optimizing variables are relatively close to their final values), even if they had to 
be excluded at its start. In some cases, it might also be appropriate to change the error 
tolerance for in an experiment (using the ED_EXP command EXPERIMENT).
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You must save the PARROT workspace with SAVE_WORKSPACES  before you 
exit the ED_EXP module.
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Setting Weights

To change the weight of an experiment, first enter the ED_EXP module from PARROT using 
EDIT_EXPERIMENTS. Then use the SET_WEIGHT command to set the weight for a specific 
equilibrium (equilibrium number 3 for example), for a range of equilibria (the equilibria 10-
19) or all the equilibria that have a certain label (such as all the equilibria with the label A1). 
To save the new weight(s), use SAVE_WORKSPACES .

By default, all the experimental information in your POP file is treated equally: each 
experiment has a weight of 1. However, experiments that you excluded because they did not 
reach equilibrium now have a weight of 0. The higher the weight of an experiment is, the 
more Thermo-Calc tries to ensure that the computed result fits the condition measured in 
that experiment.

The contribution of an experiment’s error to the sum of errors is multiplied by the square of 
the weight set for that experiment. In other words, if you want to cut the error of an 
experiment with weight 1.0 by half, then you should use a weight of 0.7. This makes the 
experiment’s error 0.49. Setting the weight to 1.4 instead makes the error twice as large 
(1.96).

Note that if you use READ_WORKSPACES after you have changed weights on the 
experiments, your changes are lost unless you have saved those changes. In the ED_EXP 
module, you can get a list of all the experiments in the console if you first read the 
experimental data from the workspace file (with READ_WORKSPACES) and then use LIST_
ALL_EQUILIBRIA. 
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Optimizing and Evaluating Results

When you have ensured that all the experimental data points can reach equilibrium, go back 
to the PARROT module and use OPTIMIZE_VARIABLES <number of iterations> with 0 
iterations. Present the result of this initial optimization by using LIST_RESULT. 

When evaluating the optimization results, the most important information is found in the list 
of experiments at the end of the listed results. The rightmost column shows the difference 
between the value of the experimental data and the value computed by Thermo-Calc in the 
last optimization cycle. 

The following shows part of list of experiments in the output of a LIST_RESULT command:

The experiments for which the optimization has not found a good fit are marked with an 
asterisk (*) or a hash sign (#) in the rightmost column. An asterisk in this column indicates 
that the experiment has an error that is larger than the error tolerance and a hash sign 
indicates that the error is much larger. The error tolerance depends on the degree of 
accuracy set for that particular piece of experimental information. The error values are 
presented in the next to rightmost column. 

Note that if you are optimizing in alternate mode, then you usually do not need to change 
the weights for the experiments. Instead, you can simply run OPTIMIZE_VARIABLES  again, 
specifying, say, thirty iterations, evaluate the results again, and continue in that way until 
you are satisfied with the results. 

About Alternate Mode
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The Critical Set of Experiments

The set of weighted experiments that you end up with as a result of your optimization is 
referred to as the critical set of experiments. When you work to determine this set and the 
weights of the experiments, the following factors should be reflected in both the selection of 
experiments and the weights of those experiments:

 l The reliability of the experimental technique. 
 l The extent of agreement/disagreement between independent measurements of the 

same quantity. 
 l The extent of agreement/disagreement between data obtained with different 

experimental methods.
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Continuing the Optimization and Resetting Variables

To continue the optimization after you have used OPTIMIZE_VARIABLES, you can either use 
this command and enter <Number of iterations> again or CONTINUE_OPTIMIZATION 
<Number of iterations>. 

If you use CONTINUE_OPTIMIZATION, then PARROT continues the optimization using the 
same Hessian matrix. If the optimization is going well but you run out of iterations, then 
continuing with the same Hessian matrix may be useful. 

As before, use LIST_RESULT to inspect the fit between the calculated and the experimental 
values for your experiments. If necessary, adjust the weights of the experiments again in the 
ED_EXP module. You may even discover that you have to exclude additional experiments 
from the optimization.

Besides looking at the rightmost column in the list of experiments (that is produced when 
you use LIST_RESULT), it is also useful to look at the sum of squares of the errors of all the 
variables. This is shown in the output of OPTIMIZE_VARIABLES and CONTINUE_
OPTIMIZATION. This sum should be as low as possible. 

The following shows part of the output that you get when using LIST_RESULT:

In the example you can see that the sum of squares have decreased slightly. (The final sum 
of squares that you get after an optimization run is also presented directly in the output 
from OPTIMIZE_VARIABLES and CONTINUE_OPTIMIZATION.) As long as the sum of squares 
figure is decreasing, the optimization is working as it should. 

When your calculated results have been improving for a while, that is, when the sum of 
squares has been decreasing, and you are confident that you are making definitive progress, 
then you should use the PARROT command RESCALE_VARIABLES to reset the starting values 
of the optimizing variables to their current values. When you do this, the start values and 



Thermo-Calc Documentation Set

Data Optimization User Guide ǀ 59 of 107

scaling factors of the optimizing variables (shown in the table’s third column in the 
preceding screen shot), are all set to the current values (shown in the table’s second 
column).

If your optimization is not going well, then you may want to reset the values of your 
optimization variables to their current start values. To do this, use RECOVER_VARIABLES.

After rescaling the variables, continue the optimization using OPTIMIZE_VARIABLES again. 
Cycle through calls of the commands OPTIMIZE_VARIABLES/CONTINUE_OPTIMIZATION, 
CONTINUE_OPTIMIZATION, RESCALE_VARIABLES  and OPTIMIZE_VARIABLES again until your 
set of optimizing variables does not seem to improve anymore. Even when it seems to you 
that you have reached this point, it is recommended that you use OPTIMIZE_
VARIABLES/CONTINUE_OPTIMIZATION a few extra times to make sure that the variable 
values cannot be further improved, that is, that the sum of squares of the errors of all the 
variables cannot be reduced further. If the final solution is repeatedly calculated after the 
same number of iterations and reaching the same result, then it is generally reasonable to 
accept the current variable values.
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Updating the Set of Optimizing Variables

Besides evaluating the fit between the calculated results and the experimental data, you 
should also ensure that you have the right number of optimizing variables. If you have too 
many or too few optimizing variables, then you may not be able to use your model to 
accurately extrapolate thermodynamic properties in a wide range of temperature, pressure 
and composition conditions.

With more optimization parameters, the sum of errors usually decrease, but the parameters 
also tend to become less precisely determined. A measure of this precision is the Relative 
Standard Deviation (RSD) of each optimizing variable. However, the RSD is only significant if 
you have used RESCALE_VARIABLES followed by an optimization which converges and the 
values of the variables do not change much. The RSD tells you how much the parameter can 
be changed in either a positive or in a negative direction without changing the reduced sum 
of errors with more than one unit. 

A large RSD value thus means that the parameter has not been determined well.

If such a significant RSD has a value larger than 1, then this typically means that you are 
using too many optimizing variables. However, the RSD values also depend on the weighting 
of the experiments, so it is sometimes possible to reduce the RSD by changing weights. 

The RSD should not be too low either. If one or more of them is very close to 0, then this 
suggests that you are trying to optimize the system with too few optimizing variables. You 
can add optimizing variables interactively using ENTER_PARAMETER in GIBBS. However, it is 
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recommended that you add a sufficient number of variables in the setup file from the start 
so that do not need to do this. You can fix variables to a value of 0 until you discover that 
they are needed.

Besides the RSD, you should also keep an eye on the variable values themselves (shown in 
the VALUE column, next to the leftmost column in the table shown in the preceding 
screenshot). If the value of a variable is in the order of 1E5 or higher and this variable has 
been put in the temperature-independent part of an interaction parameter’s Gibbs energy 
expression, then you may not have the right weights on your experiments or you are using 
too many optimizing variables. This is also typically the case if a variable with a value in the 
order of 10 or more (per mole atoms) is in the temperature-dependent part of the Gibbs 
energy expression of an interaction parameter. Such a high parameter value may lead to 
inverted miscibility gaps or re-stabilisation of a phase at high temperature. It is important to 
keep an eye on this since the temperature-independent and the temperature-dependent 
interaction parameter often varies together. If the temperature-dependent interaction 
parameter cannot be reliably determined, you may have to fix its value. 

Note that even if you have found a good enough fit between calculated and experimental 
values after an optimization run, a parameter value may suddenly start to change by several 
orders of magnitude when you use OPTIMIZE_VARIABLES is used again. If this happens, then 
careful reconsideration of the weighting of the experiments of the set of optimizing 
variables is required. However, when the optimization has converged and the parameter 
values remain stable after repeated use of OPTIMZE_VARIALBES, this should usually not 
happen.
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Reducing the Number of Optimizing Variables

If you have one or more optimizing variables with RSD larger than 1, then you should 
remove one or more of the variables by setting them to a value of 0, or alternately, set them 
to a reliably estimated value (estimated based on, for example, semi-empirical methods). 

To fix an optimizing variable to certain value, use the PARROT command SET_FIX_VARIABLE  
<variable number> <value>. 
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Plotting Intermediate Results

It is typically not sufficient to look at the plain text output of LIST_RESULT to reliably judge 
how the optimization is progressing. Plotting a phase or property diagram of the system you 
are optimizing using the POLY and POST modules is often very useful. 

It is recommended that you create a macro file for plotting the diagram since you probably 
want to repeatedly plot the diagram as you progress with the optimization. This macro file 
can then be called directly from the PARROT module with the MACRO_FILE_OPEN 
command.
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Superimposing Experimental Data from EXP Files

If you create one or several EXP files based on the experiments in your POP file, you can 
visually compare the fit your plot and the experimental data you are optimizing the system 
against. An EXP-file contains data points specified in the DATAPLOT format. You could make 
an EXP-file for each type of data that you are using in the optimization. 

Use the POST command APPEND_EXPERIMENTAL_DATA to superimpose the data points in 
an EXP-file on a phase or property diagram that you have plotted. For example, to put the 
experimental data points from a file entitled DP.EXP onto a plotted diagram, you could enter 
the following:

APPEND_EXPERIMENTAL_DATA Y DP.EXP 0 1

Such a command call tells Thermo-Calc to superimpose the data points in dataset 1 of 
DP.EXP onto the plot in the Console Results window, but not to impose any information 
about axis scaling, labels and other information which is normally found in the prologue of 
the DP.EXP file. 

The POST command QUICK_EXPERIMENTAL_PLOT can also be used to superimpose data 
points on a plotted phase or property diagram.

DATPLOT User Guide included with this documentation set.
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Finalizing the Optimization
In this section:

Finishing the Optimization 66

Rounding off Optimizing Variable Values 67

Updating the Database File 68

Creating a Database File 69

Updating the Setup File and the POP file 70
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Finishing the Optimization

When to stop optimizing is a matter of judgment. It is rarely the case that you finish 
optimizing a system with the feeling that it cannot be improved. 

The final step is to update your files with the final results. Besides updating your database 
file (or alternatively, creating a new database file), it is advised that you also update your 
setup and POP files with the final weights and optimizing variable values. 
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Rounding off Optimizing Variable Values

When you save the optimizing variable values, it is important that you round off the values 
correctly. When you have a metallic system, it is usually best to keep whatever number of 
decimal digits that you need to make less than one J/mol difference at 1000 K. When you 
have an aqueous system or a system that you are optimizing based on data from very 
different temperature ranges, then this is not always the only appropriate guideline. 
However, rounding off the values in such a way that it gives a difference that is larger than 
one J/mol may lead to differences in the phase diagram.

Another approach you can take when rounding off variable values is by progressively fixing 
the value of more and more of the variables. This allows you to round-off all but one of the 
variables values so that each only has a few significant digits. Variables whose values have 
been rounded off in this way are easier to handle compared with those that that are 
rounded off so that they continue to have many significant (non-zero) digits.

To round off the variable values according to this second approach, first use SET_FIX_
VARIABLE to set the variable(s) with the highest RSD to a rounded off value (such as, say, 
0.4). When you then re-optimize using OPTIMIZE_VARIABLES, the sum or errors changes. 
However, you should get almost exactly the same sum of errors as before after you rescale 
the variable values using RESCALE_VARIABLES. (If the sum of errors is different, then this 
means that the variable with the highest RSD was not rounded off in a good way.) If you 
successfully round off the first variable value, then continue to round of the optimizing 
variable which now has the highest RSD. Continue doing this until you have fixed all but one 
of the optimizing variables to their rounded-off values. The final sum of errors that you get 
after having fixed the variable values should not deviate significantly from the initial sum of 
errors you had before starting to round-off the variable values. 
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Updating the Database File

About the Database Files

To update the database file (with filename extension TDB) open it in a text editor and enter 
or update each of the parameters that you have optimized. 

For example, suppose you have the following command in your setup file:

ENTER_PARAMETER L(IONIC_LIQ,AL+3,ZR+4:O-2;0) 298.15  +V17; 6000 N

If you then end up with a value for optimizing variable V17 of -100000, then you should 
enter the following under the IONIC_LIQ phase in the database file:

PARAM L(IONIC_LIQ,AL+3,ZR+4:O-2;0) 298.15 -100000; 6000 N REF !

If you often need to round-off the optimizing variable value in some way, see 
Rounding off Optimizing Variable Values. 

When you have updated or entered the parameters that you optimized, save the database 
file.
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Creating a Database File

In some circumstances you may want to save all the information about your system into a 
new database file. To do this, go to the GIBBS module and use LIST_DATA <Filename> N. 
This creates a new user database file that contains all the information about the system that 
is in the workspace. 

The N-argument tells the LIST_DATA command to save the output into database file rather 
than some other type of file, such as a macro file for example. Note that the output 
database file that you get from LIST_DATA have to undergo some manual editing before it 
can be used as proper database file.
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Updating the Setup File and the POP file

It may be useful for you to be able to recreate your optimization from scratch. It is therefore 
recommended that you do the following when you are done with the optimization:

 l Update your POP file so that it contains the weights of your critical set of 
experiments. Use SET_WEIGHT to set the weights directly in the POP file. You may 
also have to use SET_START_VALUE for some conditions in the POP file. Otherwise, 
you may not be able to compute the equilibria with .

 l Copy the final values of your optimizing variables and set them as start values of the 
variables in the setup macro file (with SET_FIX_VARIABLE).

It is important that you round off the values of the optimizing variables 
correctly. See Rounding off Optimizing Variable Values. When you have done 
this, you can run the setup macro file to recreate the final result of the 
optimization.
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Alternate Mode
In this section:

About Alternate Mode 72

Optimizing in Alternate Mode 73

Preparing the POP File for Alternate Mode 74

Examples of SET_ALTERNATE_CONDITION 75
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About Alternate Mode

To turn Alternate Mode ON or OFF, use the PARROT command SET_ALTERNATE_MODE. 

When you have one or more multi-phase equilibria (that is, with the fixed phase-status) in 
your POP file and the optimizing values lack appropriate starting values (such as the default 
value of 0 for example), then Thermo-Calc may not be able to compute the equilibria for the 
experiments. In these cases, a common tangent cannot be found, that is, a state where the 
chemical potentials for all components are the same in all phases cannot be found. A 
common tangent may not exist or it be found at the wrong composition or temperature 
given the initial set of model parameters.

If you are not able to estimate reasonable starting values for the optimizing variables, then 
this problem can be overcome by initially running your optimization in alternate mode. The 
alternate mode in PARROT module should help you find reasonable starting values for the 
optimizing variables. Note that you are only supposed to use alternate mode in the 
beginning of the optimization. Once you have achieved a reasonable fit between calculated 
results and experimental data, turn off alternate mode and calculate all equilibria again in 
the normal mode. 

In alternate mode, PARROT modifies multi-phase equilibria so that the chemical potentials 
for each stable phases is calculated separately. For example, consider the following 
experimental equilibrium:

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQ FCC=FIX 1

SET_CONDITION T=1000 P=1E5

EXPERIMENT X(LIQ,B)=.2:.01 X(FCC,B)=.1

When PARROT optimizes in alternate mode, the computation of this equilibrium is done by 
way of the following two calculations:

CHANGE_STATUS PHASE LIQ=FIX 1

SET_CONDITION T=1000 P=1E5 X(LIQ,B)=.2

CHANGE_STATUS PHASE FCC=FIX 1

SET_CONDITION T=1000 P=1E5 X(FCC,B)=.1

The difference between the chemical potentials in every pair of phases is calculated and 
PARROT tries to adjust the parameters of the phases so that these differences are 
minimized. In other words, PARROT tries to make the chemical potentials equal in all phases. 
For PARROT to be able to do this, some additional information about the experimental 
multi-phase equilibria is required, at least for all invariant equilibria.
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Optimizing in Alternate Mode

When you are optimizing in the alternate mode, you usually do not need to enter the ED_
EXP module and manually change the weights of experiments that the computed results 
have not been fitted well with. Instead, after using OPTIMIZE_VARIABLES initially with no 
iterations, and listing the result with LIST_RESULT, simply run OPTIMIZE_VARIABLES again 
specifying, say, thirty iterations. Continue to optimize until your optimization seems to be 
going in the right direction, then set the optimizing variables’ starting values to their current 
values use RESCALE_VARIABLES before you turn alternate mode off by answering N at the 
SET_ALTERNATE_MODE  prompt.
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Preparing the POP File for Alternate Mode

Information in your POP file that concerns equilibria with ENTERED or DORMANT phases is 
ignored when you optimize in alternate mode.

To use the alternate mode, ensure that there is enough information about each phase in a 
given equilibrium. In addition to the temperature and pressure of the system, you should 
specify the composition of all phases in a given equilibrium. This is done with, SET_
CONDITION, EXPERIMENT, or SET_ALTERNATE_CONDITION.

If both compositions of a binary tie-line have been measured, then you could specify this in 
the POP file in the following way: 

CREATE_NEW_EQUILIBRIUM 1 1 

CHANGE_STATUS PHASE FCC BCC=FIX 1

SET_CONDITION P=1E5 T=1000 

EXPERIMENT X(BCC,B)=.2:.01 X(FCC,B)=.3:.01 

This equilibrium could be calculated with alternate mode without any modification. The 
compositions specified with the experiment command is used as condition when the 
thermodynamic properties of each phase are calculated. 
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Examples of SET_ALTERNATE_CONDITION

The following topics demonstrate how SET_ALTERNATE_CONDITION is used to prepare 
different kinds of equilibria for optimization in alternate mode.

How to Specify the Composition of One Side of a Binary Tie-Line

If only one side of the tie-line has been measured, then you must provide an estimate of the 
composition of the other phase. You can make such an estimate with SET_ALTERNATE_
CONDITION. This command has no effect unless alternate mode is turned on. The 
equilibrium described could thus be specified in the following way: 

CREATE_NEW_EQUILIBRIUM 1 1 

CHANGE_STATUS PHASE FCC BCC=FIX 1 

SET_CONDITION P=1E5 T=1000 

EXPERIMENT X(BCC,B)=.2:.01 

SET_ALTERNATE_CONDITION X(FCC,B)=.3

When the alternate mode is turned on, the composition given by the SET_ALTERNATE_
CONDITION command is used for the FCC phase. The properties of the BCC phase is 
calculated using the composition specified by experiment as a condition.

How to Specify the Compositions of a Three-Phase Equilibrium

If you have a three-phase equilibrium in your POP file, then one of its compositions can be 
specified as experimentally determined, while two can be provided as alternate conditions: 

CREATE_NEW_EQUILIBRIUM 1 1 

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1 

SET_CONDITION P=1E5 

EXPERIMENT T=912:5 X(LIQ,B)=0.2:.02 

SET_ALTERNATE_CONDITION X(FCC,B)=0.1 X(BCC,B)=.4 

How to Specify the Composition of a Stoichiometric Phase

When you specify the composition of stoichiometric phase with SET_ALTERNATE_
CONDITION, the value must be given with at least seven decimal digits, as in the following 
example:

CREATE_NEW_EQUILIBRIUM 1 1 
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CHANGE_STATUS PHASE LIQ A2B=FIX 1 

SET_CONDITION P=1E5 X(LIQ,B)=0.2 

EXPERIMENT T=992:5 

SET_ALTERNATE_CONDITION X(A2B,B)=.6666667

Entering Other Experiments in the POP with Alternate Mode

The following table shows some additional examples of how to enter different kinds of 
experiments in the POP file when you are using the alternate mode.

Example ED_EXP commands

Two-phase equilibrium: 
The melting 
temperature of an Au-
Cu alloy

CHANGE_STATUS PHASE LIQUID FCC=FIX 1 SET_CONDITION X(FCC,CU)=0.14 P=1E5 
EXPERIMENT T=970:2 SET_ALTERNATE_CONDITION X(LIQUID,CU)=0.16

Invariant equilibrium 
experiment: A three-
phase equilibrium in a 
binary system

CREATE_NEW_EQUILIBRIUM 1 1 CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1 SET_
CONDITION P=1E5 

EXPERIMENT T=912:5 SET_ALTERNATE_CONDITION X(FCC,B)=0.1SET_ALTERNATE_
CONDITION X(BCC,B)=0.4SET_ALTERNATE_CONDITION X(LIQ,B)=0.2

Ternary system, with 
two compositions 
measured (both with 
uncertainty 0.02)

CREATE_NEW_EQUILIBRUM 1 1 CHANGE_STATUS PHASE FCC BCC=FIX 1 SET_CONDITION 
T=1273 P=1E5 SET_CONDITION X(FCC,B)=0.1:0.02 EXPERIMENT X(FCC,C)=0.12:.02 
SET_ALTERNATE_CONDITION X(BCC,B)=0.17 SET_ALTERNATE_CONDITION X
(BCC,C)=0.07
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Troubleshooting
During an optimization, you are likely to run into many different problems and challenges. 
This topic gives some general guidelines that can help avoid common mistakes and 
problems.

In this section:

Useful Guidelines 78

Excluding and Including the Correct Equilibria 80

Conflicting Data 81
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Useful Guidelines

The following rules of thumb are generally good to adhere to when you are planning and 
executing an optimization:

 l Do not use data from thermochemical tables of unknown origin.
 l Use experimentally determined properties; avoid converted quantities.
 l Carefully estimate the accuracy of the experiments. 
 l Correct systematic errors (by adjusting a temperature scale for example).
 l Use negative information such as, for example, the information that a phase should 

not be stable in a composition or temperature region.
 l With a hundred activity measurements in a system but only ten composition points 

from the phase diagram, it is often appropriate to decrease the weights on the 
activity experiments. 

 l If you initially exclude any intermediate phases to only optimize the liquid and the 
terminal or end-member phases for the pure components, then it is often useful to 
compute a metastable phase diagram with just these phases.  In the metastable 
phase diagram, the metastable solubility lines should not have any strange kinks or 
turns. Such a diagram is often also useful to compute at later stages in the 
optimization.

 l When you have fitted the liquid phase and some solution phases reasonably well, 
then you can fix the optimizing variables that characterise these phases. You can 
then go on and optimize the variables for the intermediate phases.

 l Phases with miscibility gaps are always difficult to optimize. Try to keep control of 
the miscibility gaps by using real or estimated experimental information. (Note that it 
is not possible to calculate the top of a miscibility gap as a single equilibrium.)

 l Phases with order/disorder transformation are often difficult to optimize. It may be 
difficult to find the right start values on the optimizing variables. The TABULATION 
module can be useful sometimes. Properties for specified site fractions can be 
calculated in the TABULATION module. This is not possible in the POLY module since 
this module only calculates for equilibrium site fractions. The ordered state may also 
disappear during the optimization of these phases. If this happens, you may be able 
to add an experiment that controls the state of order.

 l Only use the alternate mode to find an initial set of model parameters that can then 
be make it possible to calculate the experimental equilibria in the normal mode.
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 l When you have achieved a satisfactory fit between calculated results and 
experimental data with an appropriate number of optimization variables, perform a 
couple of final optimization runs to make sure that your results are stable.

 l Make sure that the values of the optimizing variables keep within a reasonable 
range. If a variable starts to change several orders of magnitudes, then you must 
consider whether you have the right weights on the experiments and whether you 
are using too many optimizing variables. 
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Excluding and Including the Correct Equilibria

Use as few experiments as possible initially to get a reasonable overall fit. It is generally best 
to first focus on the invariant equilibria, as well as metastable states that can be estimated 
by excluding some phases. Crucially, any experiments for which the computed results are 
clearly faulty should be excluded from the final critical set, while all important invariant 
equilibria are calculated and included in this critical set.

If you cannot compute some invariant equilibria with intermediate phases, then it may be 
best to first exclude those phases from the optimization and only optimize the liquid and the 
most important solution phases. After you have obtained reasonable results for these 
phases, you can enter the intermediate phases back in again. With the variables for the 
optimized liquid and solid phases set fixed, you can finally optimize the intermediate phases.
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Conflicting Data

It is important that you do not include conflicting sets of data at the same time during an 
optimization. After all, if they are genuinely conflicting, then at least one of the sets must be 
incorrect. If you have conflicting sets of data, then only use one of these sets at a time 
together with the rest of the data. Often, the optimization makes it clear which dataset 
coheres best with the other information that is available about the system. 

Sometimes, conflicting data cannot be detected directly. For example, you may have activity 
data which is inconsistent with solubility data from the phase diagram. This would be 
indicated by large errors in the fit when both the activity data and the solubility data are 
included. To find these inconsistencies, let alone correct the errors, you may thus have to 
optimize with some datasets excluded. 
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Experiments and Experimental Data
These topics contain examples of different kinds of equilibria in different kinds of systems. 
They are intended to help you figure out how to use various kinds of experimental data 
when creating POP files. The topics that follow contain examples how to enter various kinds 
of experimental data into a POP file.

In this section:

Phase Diagram Data 83

Data for Individual Compounds 84

Single Phase Mixing Enthalpies or Partial Enthalpies 86

Enthalpies of Formation and Enthalpies of Reactions 87

Chemical Potentials via EMF Measurements 88

Driving Force for Metastable Phases 89

Pressure-Temperature-Volume EOS Data 90

Crystal Structure, Lattice Parameters, and Site-Occupancy 91

Magnetism and Other Atomistic Properties 92

Data About Systems of Different Orders 93
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Phase Diagram Data

P-T-X phase diagram data for binary and ternary systems, or systems of even higher order 
can be used in the POP file. This includes data of the following types:

 l Data about the temperature- and composition-dependence of various properties 
(obtained from differential thermal analysis (DTA) measurements for example), 
including enthalpy, lattice parameter, dilatometric length, electronic conductivity and 
magnetic susceptibility;

 l Data about reaction types (invariant/monovariant) and phase relations obtained 
from qualitative or quantitative metallographic studies; 

 l Data about phase amounts or compositions obtained from microprobe 
measurements (using X-ray spectroscopy or transmission electron microscopy 
(TEM));

 l Data about the positions or directions of two-phase tie-lines and three-phase 
equilibria for ternary systems.

The following table shows a POP file excerpt that demonstrates how some kinds of phase 
diagram data can be entered.

Example ED_EXP commands

Solidus (melting temperature) 
of an Au-Cu alloy

CREATE_NEW_EQUILIBRIUM 1 1 

CHANGE_STATUS PHASE LIQUID FCC=FIX 1 

SET_CONDITION X(FCC,CU)=0.14 P=1E5 

EXPERIMENT T=970:2

Three-phase equilibrium in a 
binary A-B system

CREATE_NEW_EQUILIBRIUM 1 1 

CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1

SET_CONDITION P=1E5 

EXPERIMENT T=912:5

Congruent transformation in a 
binary A-B system

CREATE_NEW_EQUILIBRIUM 1 1 

CHANGE_STATUS PHASE BCC LIQUID=FIX 1 

SET_CONDITION P=1E5 X(BCC,B)-X(LIQ,B)=0 

EXPERIMENT T=1213:10

Tie-line in a ternary A-B-C 
system

An uncertainty factor is set not only for the experimental measurement, but 
also for the X(FCC,B) condition. The factor is 0.02.
CREATE_NEW_EQUILIBRUM 1 1 

CHANGE_STATUS PHASE FCC BCC=FIX 1 

SET_CONDITION T=1273 P=1E5 X(FCC,B)=0.1:0.02 

EXPERIMENT X(FCC,C)=0.12:.02
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Data for Individual Compounds

You can use data about individual components in the POP file. Such data includes activity, 
heat capacity, heat content, entropy, Gibbs energy of phase transformations, heat of 
transition, and heat of melting. 

Example ED_EXP commands

Carbon activity data in the fcc phase

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1=FIX 1

CHANGE_STATUS PHASE GRAPHITE=D

SET_REFERENCE_STATE C GRAPHITE,,,,

SET_CONDITION P=101325 T=1273 X(MN)=0.03 

SET_CONDITION X(C)=0.03

EXPERIMENT ACR(C)=0.29:5%

Ln(activity coefficient for O)

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE IONIC_LIQ=FIX 1

CHANGE_STATUS PHASE GAS=D

SET_CONDITION X(O)=0.02 T=1523 P=101325

SET_REFERENCE_STATE O GAS,,,,

ENTER_SYMBOL FUNCTION LNFO=LOG(ACR(O)/X(O));

EXPERIMENT LNFO=-1.5:0.01

Entropy at 298.15 K of Cu2O

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE CU2O=FIX 1

CHANGE_STATUS PHASE CUO=FIX 0

SET_CONDITION P=101325 T=298.15

EXPERIMENT S=92.36:1

Gibbs energy of formation of NiAl2O4

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

CHANGE_STATUS PHASE FCC O2GAS=DORM

SET_REFERENCE_STATE NI FCC,,,,

SET_REFERENCE_STATE AL FCC,,,,

SET_REFERENCE_STATE O O2GAS,,,,

SET_CONDITION P=101325 T=1000 N(NI)=1 N(AL)=2

SET_CONDITION N(O)=4

EXPERIMENT GM=-298911:5%

Heat capacity of MgFe2O4

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 N(FE)=2 N(MG)=1 N(O)=4
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Example ED_EXP commands
SET_CONDITION T=800

ENTER_SYMBOL FUNCTION CP=H.T;

EXPERIMENT CP=207:5%

Heat content (H-H298) for MnFe2O4

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 T=298.15 N(MN)=1 N(FE)=2

SET_CONDITION N(O)=4

ENTER_SYMBOL VAR H298=H;

ENTER_SYMBOL FUN HMNFE2O4=H-H298;

CREATE_NEW_EQUILIBRIUM 2 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 N(MN)=1 N(FE)=2 N(O)=4

SET_CONDITION T=400

EXPERIMENT HMNFE2O4=16610:5%
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Single Phase Mixing Enthalpies or Partial Enthalpies

You can use calorimetric data for mixing in the POP file. This data could be the result of, for 
example, drop calorimetry or scanning calorimetry. This includes data about, for example, 
enthalpy of mixing of liquids, series of mixing-enthalpy and about partial enthalpy. 
Information about enthalpies of mixing can also be derived from theoretical principles using 
special quasi-random structures (SQSs).

Example ED_EXP commands

Enthalpy of mixing in the liquid state of an Au-Cu alloy

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID=FIX 1 

SET_CONDITION T=1379 P=1E5

SET_CONDITION X(LIQUID,AU)=0.0563 

SET_REFERENCE_STATE AU LIQ * 1E5 

SET_REFERENCE_STATE CU LIQ * 1E5 

EXPERIMENT HMR=-1520:200
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Enthalpies of Formation and Enthalpies of Reactions

You can use calorimetric data for phase transformations in the POP file. This data could be 
the result of, for example, direct-reaction calorimetry, solution calorimetry or combustion 
calorimetry. Information about enthalpies of formation can also be derived from theoretical 
principles.

Example ED_EXP commands

Enthalpy of melting of the eutectic in the Al2O3-ZrO2 
binary (J/g)

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE CORUNDUM ZRO2_TETR=FIX 0

CHANGE_STATUS PHASE IONIC_LIQ=ENT 1

SET_CONDITION P=101325 N=1 LNAC(O)=-80

SET_REFERENCE_STATE ZRO2 TETR,,,,,,

SET_REFERENCE_STATE AL2O3 CORUND,,,,,,

EXPERIMENT HWR=1080:90

Enthalpy of formation of o-CaZrO3 from the component 
oxides

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE ZRO2_MONO HALITE CAZRO3_
O=ENT 1

SET_CONDITION T=298.15 P=101325 N(CAO)=.5

SET_CONDITION N(ZRO2)=.5 LNAC(O)=-20 

SET_REFERENCE_STATE CAO HALITE,,,,

SET_REFERENCE_STATE ZRO2 ZRO2_MONO,,,,

EXPERIMENT HMR(CAZRO3_O)=-15960:5%
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Chemical Potentials via EMF Measurements

You can use chemical potentials and activities/activity coefficients from electromagnetic 
field (EMF) measurements in the POP file. 

Example ED_EXP commands

Emf data on Cu(s)/Cu2O(s)

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC CU2O=FIX 1

CHANGE_STATUS PHASE O2GAS=DORM

SET_CONDITION P=101325 T=1000

SET_REFERENCE_STATE O O2GAS,, 100000

EXPERIMENT MUR(O)=-95387:1000
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Driving Force for Metastable Phases

You can use chemical driving forces for metastable phases in the POP file.

Example ED_EXP commands

To prevent BCC_A2 to be stable

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1 M7C3 M23C6=FIX 1

CHANGE_STATUS PHASE BCC_A2=D

SET_CONDITION P=101325 T=1473

EXPERIMENT DGM(BCC)<-0.1:0.1

To promote CEMENTITE to be stable

CHANGE_STATUS PHASE BCC M7C3 GRAPHITE=FIX 1

CHANGE_STATUS PHASE CEMENTITE=DORMANT

SET_CONDITION P=P0 T=973

EXPERIMENT DGM(CEM)>0.1:0.01
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Pressure-Temperature-Volume EOS Data

You can use Pressure-Temperature-Volume Equation of State (EOS) data in the POP file. 
Such data includes, for example, molar volume, density, thermal expansion and bulk 
modulus/compressibility.

Example ED_EXP commands

Volume of liquid Pt

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID=ENT 1

SET_CONDITION P=101325 N=1 T=1873

EXPERIMENT VM=1.00758E-5:5%

Thermal expansion

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1=ENT 1

SET_CONDITION P=101325 N=1 T=400

ENTER_SYMBOL FUNCTION ALPHA=VM.T/VM/3;

EXPERIMENT ALPHA=2.35E-5:5%
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Crystal Structure, Lattice Parameters, and Site-Occupancy

You use information about defects, ordering or site occupancy, as well as information about 
crystal structures in the form of lattice parameter values. This information may come from 
measurements made by X-ray, neutron diffraction, Mössbauer spectroscopy or perturbed 
angular-correlation. 

Example ED_EXP commands

Lattice parameter for fcc

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1=ENT 1

SET_CONDITION P=101325 N=1 T=298.15

SET_CONDITION X(CR)=0.05

ENTER_SYMBOL FUNCTION LPFCC=((4*VM/6.02214179E23)**
(1/3))*1E10; 

EXPERIMENT LPFCC=4.02:5%

Lattice parameter for bcc

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE BCC_A2=ENT 1

SET_CONDITION P=101325 N=1 T=298.15

SET_CONDITION X(AL)=0.08

ENTER_SYMBOL FUNCTION LPBCC=((2*VM/6.02214179E23)**
(1/3))*1E10; 

EXPERIMENT LPBCC=2.90:5%

Site-occupancy, degree of inversion for 
spinel

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 N(MG)=1 N(AL)=2 N(O)=4

SET_CONDITION T=1073

EXPERIMENT Y(SPINEL,AL+3#1)=0.31:5%
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Magnetism and Other Atomistic Properties

You can use data about atomistic properties such as magnetism and Curie temperatures in 
the POP file.

Example ED_EXP commands

Curie temperature of MnxFe3-xO4, x=1.26

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION  T=520 P=101325 N(O)=4

SET_CONDITION N(FE)+N(MN)=3 N(MN)=1.26

EXPERIMENT TC(SPINEL)=520:5
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Data About Systems of Different Orders

You might want to use data about systems of different orders in the same optimization, such 
as data about a binary equilibrium with components A and B in a ternary system with 
components A, B and C, together with data about equilibria in the binary system with 
components A and B. To do this, you must first suspend all components in the ternary 
system (A, B and C), and then set the two components you want binary information on (A 
and B) to status ENTERED.

Suspending all components is done by giving the initialization code 0 to the CREATE_NEW_
EQUILIBRIUM command. The components about which you want to use binary information 
must then be entered again using the CHANGE_STATUS command.

Example ED_EXP commands

A binary (A-B) three-phase equilibrium (FCC-
BCC-LIQ) in a ternary system (A-B-C)

CREATE_NEW_EQUILIBRIUM 1 0 

CHANGE_STATUS COMPONENT A B = ENTERED 

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1 

SET_CONDITION P=1E5 

EXPERIMENT T=1177:10
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Thermodynamic Models
The most common models used in assessments are described briefly in these topics. 
Examples of how to write the phase definitions in the setup-file are also given for each of 
these models. In addition to the models described here, a large number of thermodynamic 
models for various phases in different states have been implemented. 

In this section:

Gas 95

Compound Energy Formalism (CEF) 96

Substitutional Liquid 97

Ionic Two-Sublattice Liquid Model 98

Models for Ordered Phases 99

4SL Model for FCC, HCP, and BCC 100

2SL Model for FCC, HCP, and BCC 102

Magnetic Ordering 103

Molar Volumes and High Pressure 104

Excess Models 105

General Einstein Model 106
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Gas

The gaseous mixture phase is usually treated as a substitutional phase without sublattice. In 
the gaseous mixture phase, there are usually molecules formed, and the number of 
constituents of the gas phase is often much larger than the number of elements. These 
complex constituents have to be defined as species. The ideal gas model may handle a gas 
phase under low pressures (and low temperatures). This implies that the P-V-T relations and 
thermodynamic properties of pure gaseous species are calculated as for ideal gas, and that 
there is interaction between gaseous species in the mixture. In a defined system, there may 
only exist one gaseous mixture phase. Type code G is used for the gas phase:

ENTER_PHASE GAS G, 1 H,H1O1,H1O2,H2,H2O1,H2O2,O,O2,O3; N N
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Compound Energy Formalism (CEF)

If the atoms are sufficiently different in size, electronegativity or charge, they may prefer 
different types of sites in the lattice of crystalline solids. In some cases, a solute atom may 
even occupy interstitial sites between the normal lattice sites. All such phenomena are 
treated in Thermo-Calc by the sublattice concept. The Compound Energy Formalism (CEF) 
has proved to be the most general formalism for many different types of solution phases. It 
is therefore by default applied to various solid solution phases in the Thermo-Calc software 
package. CEF can also take ionic constraints (charged cation/anion species) into account. For 
a comprehensive description on the CEF, please see Hillert (2001), Frisk and Selleby (2001), 
Sundman and Ågren (1981).

Since the CEF is used by default, no special notation is needed in the phase definition, except 
for ionic phases, where type code I is given. 

Examples of phase definitions in a setup-file using the CEF:

ENTER_PHASE SPINEL I, 4 1 2 2 4

     FE+2,FE+3; FE+2,FE+3,VA; FE+2,VA; O-2; N N

ENTER_PHASE SIGMA, 3 10 4 16

     AL,CO,CR,FE,NB; AL,CO,CR,FE,NB; AL,CO,CR,FE,NB; N N

ENTER_PHASE FCC_A1, 2 1 1

     CR,FE,MN; C,N,VA; N N

ENTER_PHASE BCC_A2, 2 1 3

     CR,FE,MN,VA; C,N,VA; N N
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Substitutional Liquid

The liquid phase is normally (but not always) modeled as a substitutional phase with no 
sublattice, which is occupied by two or more constituents. The constituents are normally the 
elements, but molecules or associates can also be used. Type code L is used for the liquid 
phase.

ENTER_PHASE LIQUID L, 1   

     AL,C,CR,FE,MO,NI,SI ;  N N

ENTER_PHASE LIQUID L, 1   

     C,FE,FEO,FEO3/2,NI,NIO ;  N N
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Ionic Two-Sublattice Liquid Model

Within the framework of the CEF, the ionic two-sublattice liquid (I2SL) model was developed 
to be used when there is a tendency for ionization in the liquid, which happens in liquid 
oxides and sulphides for example. The same model can be used both for metallic and oxide 
melts. At low levels of oxygen, the model becomes equivalent to a substitutional solution 
model between metallic atoms. Two sublattices are assumed, one containing charged 
cations and one containing charged anions, neutrals and vacancies. The complication for an 
ionic liquid is that the numbers of sites on the cation sublattice and anion sublattice vary 
with the composition to preserve electroneutrality. For a comprehensive description on the 
I2SL model, see [1985Hil; 1991Sun]. In these references, the possible excess parameters are 
also discussed. Type code Y is used for the I2SL model.

Examples of phase definitions in a setup-file:

ENTER_PHASE LIQUID Y,

     AL+3,CR+2,FE+2,NI+2; VA; N N

ENTER_PHASE IONIC_LIQ Y,

     CA+2,MG+2; O-2; N N

ENTER_PHASE IONIC_LIQ Y,

     AL+3,CA+2,FE+2,MG+2,SI+4;

     ALO2-1,O-2,SIO4-4,VA,FEO3/2,SIO2; N N

References
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Models for Ordered Phases

Some solution phases have chemical order-disorder transformations: for example, the 
disordered FCC_A1 phase can transform to the ordered L12 or L10 structure where the 
atoms of different kinds occupy different sublattices. In some cases, it may be advantageous 
and easy to describe such ordered structures as completely different phases; but in some 
other cases, like the B2-ordered BCC structure in Al-Fe, the disordered and ordered 
structures must be described as one singe phase because the transformation is of second 
order along a line in temperature and composition.

The ordering can easily be described by the CEF. For instance, an ordered FCC phase with 
only L12 or L10 ordering can be efficiently handled by the so-called Two Substitutional-
Sublattice Ordering Model (2SL model), while an ordered FCC with both L12 and L10 ordering 
must be described with four sublattices using the so-called Four Substitutional-Sublattice 
Ordering Model (4SL model). Please note that in both these models, all the substitutional 
constituents must enter into these sublattices. In addition, you may also have one sublattice 
for interstitials.

Thermo-Calc supports a feature of splitting the parameters of a chemically ordered phase 
onto two different phase descriptions. This is very convenient. In this way, you can have one 
phase for all parameters describing the disordered state (the configuration independent 
state) and in the other phase only those parameters needed to describe the remaining part 
(the configuration dependent part), that is, the Gibbs energy contribution due to the 
ordering transformation. This has been implemented in such a way that the contribution 
from the configuration dependent part is zero when the solution phase is disordered. The 
optimization of the disordered phase is independent of the order-disorder transformation; 
the ordering energy is an add-on to the disordered part. This is particularly useful in higher 
order systems, as an ordered phase can dissolve several elements that have no particular 
contribution to the actual ordering. The phases Gibbs energy add together by giving this 
command in the setup-file: AMEND_PHASE_DESCRIPTION <ordered phase> disordered_part 
<disordered phase>

Since PARROT does not automatically create new composition sets, it is necessary to create 
composition sets for both the ordered and disordered phases in the setup-file: Amend_
phase_description <phase> composition_sets <new highest set number>,,,,

Example of phase definitions for the corresponding disordered and ordered parts in a setup-
file:

ENTER_PHASE FCC_A1, 2 1 1

     AL,CR,FE,NI; VA; N N

ENTER_PHASE FCC_L12, 3 .75 .25 1

     AL,CR,FE,NI ; AL,CR,FE,NI; VA; N N

AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART FCC_A1
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4SL Model for FCC, HCP, and BCC

Ordered FCC, HCP and BCC solution phases handled by the 4SL model requires four 
sublattices for substitutional ordering and can additionally have an interstitial sublattice. A 
4SL model is especially useful for modelling different kinds of ordered phases that are based 
on the same disordered phase, such as L10 and L12 based on FCC_A1, and B2, D03, L21 and 
B32 based on BCC_A2 etc.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners 
of the regular tetrahedron on these lattices, all of which are the nearest neighbours. These 
corners are equivalent lattice points, thus all G parameters for each end-member with the 
same elements, but distributed on different sites, must be identical. It should be emphasized 
that the end-member energy here represents the ordering energy rather than the formation 
energy of the compound. 

The constraints on the parameters in the 4SL model can be derived based on the symmetry 
of the lattice:

GA:B:B:B=GB:A:B:B=GB:B:A:B=GB:B:B:A

GA:A:B:B=GA:B:A:B=GA:B:B:A=GB:A:A:B=GB:A:B:A=GB:B:A:A

GB:A:A:A=GA:B:A:A=GA:A:B:A=GA:A:A:B

LA,B:*:*:*=L*:A,B:*:*=L*:*:A,B:*=L*:*:*:A,B

The asterisk * means that the interaction parameter is independent of the occupation of 
that sublattice. For the disordered phase to be completely disordered, i.e. that all site 
fractions are equal on all four sublattices, all constraints must be correct.

For ordered BCC phases, the situation is a bit more complicated, as the four sublattice 
ordering phase represents an irregular tetrahedron with two pairs of sites that are next 
nearest neighbors. Thus, for an A-B binary solution phase, with A located on two sublattice 
sites and B on the other two, the end-member described by GA:A:B:B has four nearest 
neighbour bonds between A and B atoms, whereas the end-member described by GA:B:A:B 
has two nearest neighbour bonds between A and B atoms and two next nearest neighbour 
bonds. Many parameters thus have a relation:

GA:B:B:B=GB:A:B:B=GB:B:A:B=GB:B:B:A

GB:A:A:A=GA:B:A:A=GA:A:B:A=GA:A:A:B

GA:A:B:B=GB:B:A:A

GA:B:A:B=GA:B:B:A=GB:A:A:B=GB:A:B:A
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LA,B:*:*:*=L*:A,B:*:*=L*:*:A,B:*=L*:*:*:A,B

The GA:B:B:B term represents D03, GA:A:B:B B2 and the GA:B:A:B B32 ordering. There are also 
two kinds of reciprocal interaction parameters:

LA,B:A,B:*:*;0…9

LA,B:*:A,B:*;0…9

Kusoffsky et al. (2001) have shown the influence of different parameters available in the 4SL 
model applied to fcc ordering. The possibility to use the 4SL model to BCC ordering has been 
studied by Sundman et al. (2009) in the Al-Fe system.
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2SL Model for FCC, HCP, and BCC

The reason for using a 2SL model instead of a 4SL model is that the calculations are faster, 
but on the other hand it can only model one kind of ordered phase(s). For instance, it is not 
possible to model FCC with both L10 and L21, or BCC with D03 and B2, etc.

In order to get the fully disordered phase to form, constraints are needed as for the 4SL 
model. For the symmetric phases, e.g. B2 and L10, the relation between parameters are:

GA:B=GB:A

LA,B:*=L*:A,B

For a 2SL asymmetric model including, but not limited to, L12, more constraints are needed. 
This model has many complicated relations between the parameters. The relation between 
the parameters for the 2SL L12 model can be derived from a 4SL model. The conversion from 
4SL model parameters to 2SL parameters for L12 can be found in Dupin et al. (2001) and for 
L10 in Yuan et al. (2012). Higher-order systems with an L12 phase modeled with two 
sublattices require a lot of ternary and some quaternary interaction parameters in order to 
make the disordered state stable. These parameters have been derived by e.g. Dupin (1995), 
also found in Kusoffsky et al. (2001). 

Many publications exist on how to model order/disorder transformations using a two-
sublattice model, see e.g. Dupin, Ansara (1999), De Keyzer et al. (2009).
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Magnetic Ordering

The magnetic contribution to the Gibbs energy is given by a model proposed by Inden (1975) 
and adapted by Hillert and Jarl (1978), and is described by:

G=RTln(b+1)f(t)

where t=T/TC. 

The values of the Curie temperature, TC, and Bohr magneton number, b, at a certain 
composition are then used in an optimization procedure to calculate the contribution to 
Gibbs energy due to magnetic ordering. Curie temperature and Bohr magneton number are 
given in the command ENTER_PARAMETER for phases that undergo a magnetic transition:

AMEND_PHASE_DESCRIPTION BCC_A2 MAGNETIC -1.0 0.4

ENTER_PARAMETER TC(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N

ENTER_PARAMETER BMAGN(BCC_A2,FE:VA;0) 298.15 +V2; 6000 N

The arguments -1 and 0.4 specify the values of parameters in the magnetic model: -1 is the 
antiferromagnetic factor and 0.4 is the structure factor. Usually the antiferromagnetic factor 
=-1 for bcc and =-3 for fcc (and other non-bcc phases). The structure factor corresponds to 
the short range order fraction of the enthalpy. This factor is 0.4 for bcc and 0.28 for non-bcc 
phases.
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Molar Volumes and High Pressure

Including volumes in a thermodynamic database enable calculations of volume changes, 
volume fraction, lattice mismatch in cubic structures and phase diagrams at increased 
pressure. Pressure independent volumes can be used up to about 1 GPa. At pressures above 
1 GPa the pressure dependence of the volumes must be included by using a proper equation 
of state (EOS). An EOS has been developed by Lu et al. (2005), based on the EOS from Jacobs 
and Oonk (2000). Four parameters are used in the implementation of the model in 
Thermo-Calc:

 l V0: Volume at 1 bar and at reference temperature T0

 l VA: Integrated thermal expansivity

 l VK: Isothermal compressibility at 1 bar

 l VC: Parameter to fit high pressure data

All parameters can be composition dependent in the same way as all other model 
parameters in Thermo-Calc. Experimental information about the temperature, pressure and 
composition dependence of the volume can be assessed using these model parameters. To 
evaluate V0, VA and VK experimental data at 1 bar only are needed. 

Examples on modeling molar volume in a setup-file:

ENTER_PARAMETER V0(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N

ENTER_PARAMETER VA(BCC_A2,FE:VA;0) 298.15 +V2*T+V3*T**2; 6000 N

ENTER_PARAMETER VC(BCC_A2,FE:VA;0) 298.15 +V4+V5*T; 6000 N

ENTER_PARAMETER VK(BCC_A2,FE:VA;0) 298.15 +V6+V7*T; 6000 N

ENTER_PARAMETER V0(FCC_A1,CR,FE:VA;0) 298.15 +V8; 6000 N

ENTER_PARAMETER VA(FCC_A1,CR,FE:VA;0) 298.15 +V9*(T-298.15); 6000 N
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Excess Models

Unless specifically amended, the excess Gibbs energy terms are modeled by the Redlich-
Kister-Muggianu Model. Other excess models for the Gibbs energy are also implemented in 
Thermo-Calc, such as e.g. Kohler and Toop-Kohler extrapolation models. 

Thermo-Calc is not restricted to binary interaction parameters. Ternary, quaternary and 
higher-order interaction parameters can also be used if there is enough information to 
evaluate these from experimental data. The ternary interaction parameters are identified by 
the degrees of the so-called ternary L parameter (i.e. 0, 1 and 2) in the command ENTER_
PARAMETER. If the parameter is composition-independent, you only need a single 
interaction parameter with a degree of zero, i.e. only the 0L term. If there is a ternary 
composition-dependent interaction parameter, you must enter all three parameters (0,1 
and 2). If such a ternary interaction parameter should be zero, then assign it a function 
which is zero. If the three interaction parameters have the same value, then that is identical 
to having a composition-independent ternary parameter.

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;1) 298.15 +1000; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;2) 298.15 +1000; 6000 N

is identical to 

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

This also means that 

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;1) 298.15 +ZERO#; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;2) 298.15 +ZERO#; 6000 N

is NOT identical to 

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N
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General Einstein Model

An Einstein model implemented in a general way with multiple Einstein temperatures and 
accompanying weight functions.

It describes the vibrational contribution to Cp at low and intermediate temperatures.

The model is implemented as:

Where

 l  is the Einstein temperature.  is entered as the database parameters 
LNTHETA1, LNTHETA2, LNTHETA3, LNTHETA4, and LNTHETA5.

 l  is a weight function, entered as the database parameters THETAF1, THETAF2, 
THETAF3, THETAF4, and THETAF5.

 l  is the number of atoms per mole formula unit
 l  is the universal gas constant
 l  is the temperature

Examples of parameters for this model:

PARAMETER LNTHETA1(GRAPHITE,C;0) 298.15 +LN(1953); 6000 N REF0 !

PARAMETER THETAF1(GRAPHITE,C;0) 298.15 +0.484786; 6000 N REF0 !

PARAMETER LNTHETA2(GRAPHITE,C;0) 298.15 +LN(947); 6000 N REF0 !

PARAMETER THETAF2(GRAPHITE,C;0) 298.15 +0.349135; 6000 N REF0 !

PARAMETER LNTHETA3(GRAPHITE,C;0) 298.15 +LN(448); 6000 N REF0 !

PARAMETER THETAF3(GRAPHITE,C;0) 298.15 +0.121463; 6000 N REF0 !

PARAMETER LNTHETA4(GRAPHITE,C;0) 298.15 +LN(193); 6000 N REF0 !

PARAMETER THETAF4(GRAPHITE,C;0) 298.15 +0.0387523; 6000 N REF0 !

PARAMETER LNTHETA5(GRAPHITE,C;0) 298.15 +LN(65); 6000 N REF0 !

PARAMETER THETAF5(GRAPHITE,C;0) 298.15 +0.0058637; 6000 N REF0 !

The Einstein function also can used with the GEIN(THETA) function.
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For more information about this see FUNCTION and PARAMETER in the 
Database Manager User Guide.
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Thermodynamic and Kinetic/Mobility Databases

This guide describes how to define and construct a thermodynamic or kinetic database. It 
includes details about the data structures and formats of the Thermo-Calc databases as well 
as the Diffusion Module (DICTRA) database-extensions. 

The Thermo-Calc databases are created and maintained in the Thermo-Calc Database 
Format (TDB) which is an international standard for the CALPHAD-type thermodynamic 
calculations and kinetic simulations. This document gives a full description of the TDB format 
(with the Diffusion Module (DICTRA) database extension) and is a comprehensive guide 
about how to create and manage a Thermo-Calc (and Diffusion Module (DICTRA)) database. 

Usually, a Thermo-Calc or Diffusion Module (DICTRA) database is constructed as a single text 
file with an extension of TDB, for example, PAQ2setup.TDB. For some databases (especially 
large databases used with older versions of Thermo-Calc or Diffusion Module (DICTRA)) a 
database may consist of one primary-definition file (***setup.TDB) and several additional-
definition TDB files (such as ***param.TDB, ***funct.TDB, ***refer.TDB, etc. These are 
built for a variety of defined parameters, functions, references and so forth, and are linked 
to the ***setup.TDB file through the correct use of the TYPE_DEFINITION   and/or FTP_FILE 
commands inside the ***setup.TDB file. 

With  Thermo-Calc,  the Add-on Modules and Thermo-Calc Software 
Development Kits (SDKs), you can code everything into a single ***setup.TDB 
file for a database at any scale. 
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Initialization of the TDB Module

The following explains how a database initialization file is constructed to work with the so-
called TDB (database) module. When you start, the TDB module looks for a file that has 
information about the available standard databases. The database initialization file is called 
tc_initd.tdb. By default it is located in the data subdirectory of the Thermo-Calc 
installation directory.

See Database Installation Folder in the Thermo-Calc User Guide.

The location can be overridden by:

 l A command line parameter -t followed by the path to the directory containing the 
tc_initd.tdb file.

 l The environment variable TC_DATABASE_DIRECTORY pointing to the directory 
containing the tc_initd.tdb file. This overrides both the default value and a 
directory given with the -t command line argument.

Each database defined in tc_initd.tdb represents a database that can be used within 
Thermo-Calc. Each entry has three parts:

 1. The database short-name (e.g. FEDEMO, maximum seven characters, no white space, 
no commas).

 2. The path to the database setup file (max 78 characters, no commas, can contain 
white space if it is a quoted absolute path).

 3. A short description of the database (max 60 characters, can contain white space). 
The entry must end with an exclamation mark (!).

The paths can be relative to the tc_initd.tdb file or absolute. For platform independence, 
the recommendation is to always use forward slashes (/) in the paths, but on Windows 
backslash (\) also works.

You can add comment lines in the database initialization file. Comments must start with a $ 
sign.

Examples

The following are examples of an initialization file defining two databases:

SSOL8 SSOL8\SSOL8SETUP.TDC  SGTE Solutions Database version 8.0 !

MYDB1 ../../../MYDATABASES/ABC.TDB My database 1.0 !
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In the initialization file you can also add databases with absolute file names with white 
space, if the path is surrounded by quotation marks ("):

TEST "G:\My Drive\My Folder\Test.TDB" My test database v0.1!

The use of absolute paths should be used with caution as these are not 
portable.
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Database Definition File Syntax

The database definition (*.TDB) file (normally named ***setup.TDB) consists of a set of 
keyword codes each followed by one or several parameters (arguments). 

 l A complete keyword entry must end with an exclamation mark (!). 
 l A single keyword entry can be up to 2000 characters long. However, the maximum 

length of a line in an *.TDB file is 78 characters--it may be necessary to continue the 
keyword parameter (arguments) on several lines. The ! must be at the end of the last 
line. 

 l It is recommended to always have at least one empty space at the beginning of each 
continuation line for the keyword parameters (arguments); otherwise, the DATA 
module can misunderstand the parameters (or arguments), or issue an error 
message.

 l The keyword and its various parameters (arguments) are separated by a space or a 
comma. 

 l A dollar sign ($) in the first position of the line indicates that the line is a comment 
line, which is ignored by the DATA module.

When the database is selected the DATA module only reads the database definition file 
(***setup.TDB) once, from beginning to end. The DATA module checks continuously when 
reading the definition file. This implies that (nearly) everything must be declared or defined 
before it is used in any other way. 

For example, if the GRAPHITE phase is to be included in the database definition, the element 
C (carbon) and the phase GRAPHITE must be defined before declaring that carbon dissolves 
in graphite. This definition order is necessary to build the internal data structure acceptable 
by the DATA module (during its consistency checking). 

This topic gives a description of the available keywords and the appropriate arguments. A 
basic knowledge of the Gibbs Energy System (GIBBS) module is assumed. 

This syntax is used: 

KEYWORD [arg.1]*# [arg.2]*## {optional arg.3}!

The keywords are written in full length but can be abbreviated as long as the abbreviation is 
unique. A keyword may have syntax consisting of several arguments and optional 
arguments. The number, # or ##, in the notation, [...]*# or [...]*##, indicates an argument 
with a maximum length of # ASCII characters. 
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Arguments within square brackets [...] must always be given, but are optional 
when enclosed in curly brackets {...}.
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ELEMENT

ELEMENT [element name]*2 [ref. state]*24 [mass] [H298] [S298] !

The element name (maximum two characters) is the one found in the periodic chart but 
there are no naming restrictions. However, the GIBBS module only recognizes UPPER-case 
element names (if the Upper Case Mode is selected by the GIBBS command REINITIATE), 
which means that lower-case (if defined in a database) is automatically converted to UPPER-
case by the DATA/GIBBS module.

The elements are automatically entered as species using the same names of the elements. If, 
for example, the species corresponding to FE needs to be named FE1, you can define the 
species as FE1, which results in an element named FE and a species named FE1. Vacancies 
(VA) and electrons (denoted either as /- in gaseous, liquid or solid phases, or ZE in an 
aqueous solution phase), need to be entered as special elements for correct handling by the 
DATA module. 

The reference (ref.) state (maximum 24 characters) is the stable phase (at 298.15 K and 1 
bar) that should contain this element and be used as the reference state for all element 
thermodynamic data. The mass, given in gram per mole, is used in various calculation 
programs and should always be given the correct value. H298 and S298 denote the enthalpy 
and entropy difference between 0 and 298.15 K for the element in SI units. If these are 
unknown, the values can be set to zero. All this information (reference state, H298 and 
S298) define the SER (Stable Element Reference state). 

Examples
ELEMENT /- ELECTRON_GAS       0.0  0.0  0.0 !

ELEMENT VA VACUUM             0.0  0.0  0.0 !

ELEMENT ZE UNIT_CHARGE        0.0000000001  0.0  0.0 !     

ELEMENT AL FCC_A1             26.98154 4577.296 28.3215 ! 

ELEMENT C  GRAPHITE           12.011  1054.0    5.74 !    

ELEMENT FE BCC_A2             55.847  4489     27.28 !    

ELEMENT O  1/2_MOLE_O2(G)     15.9994 4341    102.5158 !  

ELEMENT TI HCP_A3             47.88   4810     30.648 !   

ELEMENT ZR HCP_A3             91.224  5566.27  39.181 !   

ELEMENT ZY DUMMY               1         1         1 !    
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SPECIES

SPECIES [species name]*24 [stoichiometric formula] ! 

This keyword defines species in the data structure. Every species name (maximum 24 
characters) must be unique. The species are built from the predefined set of elements in the 
stoichiometric formula. If an undefined element is referenced, DATA displays an error 
message and the data structure is probably damaged. 

The species names do not have to be the same as the stoichiometry formula, although in 
general this is recommended. The elements are automatically entered as species using the 
same names of the elements. 

You can define a species name as a mixture of UPPER-case and lower-case 
letters in a database, but the DATA module automatically converts all lower-
case to UPPER-case because the GIBBS module only recognizes UPPER-case 
species names.

When naming the species in a database, use special characters (such as +, -, _, / and .) in 
species names. Avoid using other special characters (such as ( and )). 

The stoichiometric formula is written with a simplified chemical notation, in which the 
chemical elements should always be given in UPPER-case and in any preferred order, and 
the stoichiometric coefficients are written in either real numerical factors or integer digits. 

It is important that the numerical factor of 1 is not left out. Subgroups are not 
allowed in a stoichiometry formula; however, while specifying the 
stoichiometry formula for a specific species in a database, you can specify it in a 
way that some elements (always together with the corresponding partial 
stoichiometric coefficients) are repeated (as in the examples below).

Examples
SPECIES AL2O3      AL2O3 ! 

SPECIES Silica     SI1O2 ! 

SPECIES NaSb_6OH   NA1SB1O6H6 ! 
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SPECIES FE+2        FE/+2 ! 

SPECIES SB-3        SB/-3 ! 

SPECIES AlCl2/3            AL.33333CL.666667 !

SPECIES AL1CL1H2O2         AL1CL1H2O2 !

SPECIES AlCl3_3H2O         AL1CL3H6O3 !

SPECIES AlO2H2Cl.H6O3      AL1O2H2CL1H6O3 !

SPECIES AlCl2-OH.3H2O      AL1CL2O1H1H6O3 !

SPECIES AlCl2OH.3Water     AL1O1H1CL2H6O3 !
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PHASE

PHASE [phase name]*24 [data-type code]*8 [numb. subl.] [sites in 
subl. 1] [sites in subl. 2] etc... {auxiliary text string} ! 

This keyword defines a phase and its properties (except for what species are allowed to 
enter it and for its parameters). 

The phase name (maximum 24 characters) must be unique; otherwise the DATA module 
sees it as an attempt to redefine a previously defined phase. This causes DATA to display an 
error message and ignore the rest of the line. A phase name can be suffixed by an 
underscore (_and letters to identify the physical state(s) or structure type(s) of the phase. 

Examples of Recommended Suffixes

Suffix Definition

ABC_S The  ABC phase in solid state.

ABC_S2 The  ABC phase in solid state 2.

ABC_S3 The ABC  phase in solid state 3.

ABC_LT The ABC  phase in solid state at low temperatures.

ABC_HT The ABC  phase in solid state at high temperatures.

ABC_L The ABC  phase in liquid state.

ABC_LIQ The ABC  phase in liquid state.

FCC_A1 The FCC phase in disordered structure type A1.

FCC_L12 The FCC phase in ordered structure type L12.

The phase name can also be attached with a colon sign (:) and a letter for a legal GIBBS 
phase-type code (e.g. IONIC_LIQ:Y and GAS:G). 
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GIBBS Phase-type Codes

Code Definition

G Bit set for a gaseous mixture phase.

A Bit set for an aqueous solution phase.

Y Bit set for an ionic liquid solution phase (specially treated by the Ionic Two-Sublattice Liquid Model).

L Bit set for a liquid solution phase (but not A (aqueous) or Y (ionic liquid)).

I Bit set for a phase with charged species (but not G (gaseous), A (aqueous) or Y (ionic liquid)).

F
Bit set for an ordered FCC or HCP solution phase using the Four Substitutional-Sublattice Ordering 
Model  (additionally, such a phase can also have interstitial sublattices).

B
Bit set for an ordered BCC solution phase using the Four Substitutional-Sublattice Ordering Model 
(additionally, such a phase can also have interstitial sublattices).

Other invalid characters (e.g. M or P) are eventually treated, together with the 
colon (:) as a part of a phase name.

A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a 
substitutional phase without sublattice, and an L phase (ordinary liquid solution) is normally 
(but not always) modeled as a substitutional phase without sublattice, too.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners 
of the regular tetrahedron on these lattices, all of which are the nearest neighbours, as 
shown.

FCC Unit Cell Example

An FCC unit cell with the lattice positions indicated that correspond to the G (FCC,A:B:C:D) 
end member. All lattice positions are equivalent for a four substitutional-sublattice ordering 
model.



Thermo-Calc Documentation Set

Database Manager User Guide ǀ 16 of 99

A Normal 4-Sublattice Model requires that all the G parameters for each of the end-members 
with the same elements but distributed on different sites be given separately. However, as 
these corners are identical lattice points, the phase-type option F means that the G 
parameters need be given only once. The possible permutations are handled automatically.

Additional Clarification

An A-B binary solution phase (with the element A located on one sublattice site and B on the 
other three sublattice sites) treated by the Normal 4-Sublattice Model has to have four G 
parameters for four end-members, i.e. 

 l G(phase,A:B:B:B)
 l G(phase,B:A:B:B)
 l G(phase,B:B:A:B, and
 l G(phase,B:B:B:A)

This is because in the general case these G parameters can be different from each other. But 
for the FCC and HCP orderings, they are identical and thus all G parameters of such end-
members need to be given only once, and the possible permutations are then automatically 
handled by the GIBBS module. Also, only one of the identical permutations is listed; in this 
example, G(phase,A:B:B:B)where it is alphabetically the first in the list of permutations. 
This significantly simplifies the usage of this model (Four Substitutional-Sublattice Ordering 
Model) in multicomponent alloys. 
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For ordered BCC phases, the phase-type option B means the same thing but it is more 
complicated since the 4-substitutional-sublattice ordering phase represents an irregular 
tetrahedron with two pairs of sites that are next nearest neighbours as shown: 

BCC Unit Cell Example

Two BCC unit cells with the lattice positions indicated that correspond to the G 
(BCC,A:B:C:D,0) end member. Lattice positions (A) and (B) are equivalent, as are lattice 
positions (C) and (B) for a four substitutional-sublattice ordering model.

For an end member described by the parameter G (phase,A:B:C:D) A and B are next 
nearest neighbours, as are C and D. And the nearest neighbours of A (or B) are C and D. 
Thus, for an A-B binary solution phase (with the element A located on two sublattice sites 
and B on two sublattice sites) treated by the Normal 4-Sublattice Model, the end-member 
described by the G(phase,A:A:B:B) term has four nearest neighbour bonds between A and 
B atoms, whereas the end-member described by the G(phase,A:B:A:B) term has two 
nearest neighbour bonds between A and B atoms and three next nearest neighbour bonds.

The first end-member (described by the G(phase,A:A:B:B) term) represents B2-ordering 
and the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There 
are two permutations of the G(phase,A:A:B:B) term and four permutations of the G
(phase,A:B:A:B) term, automatically conducted in the Four Substitutional-Sublattice 
Ordering Model. If you enter the unary, binary, ternary and quaternary parameters you are 
dealing with 1, 6, 21, 55 parameters for BCC:B, 1, 5, 15, 35 parameters for FCC:F and 1, 16, 
81, 256 parameters for phases without F/B.
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An additional feature with the phase-type options F and B is that a composition set that 
represents the solution phase has a suffix (indicating what ordering the phase has) that is 
automatically added to its phase name in some listings of equilibrium calculations (when 
performing either single-point or stepping or mapping calculations, and when plotting the 
calculated property diagrams or phase diagrams). 

Such suffix indications can be:

Solution Phase Suffix for Disordered Phase Suffix for Ordered Phase

FCC PHASE FCC_A1

FCC_L12

FCC_L10

BCC PHASE BCC_A2

BCC_B2

BCC_B32

BCC_D03

BCC_L21

HCP PHASE HCP_A3

HCP_D019

HCP_B19

If you want to convert an existing database TDB file to use the F/B feature, add 
the phase-type code to the corresponding phase name in the PHASE and 
CONSTITUENT commands in the TDB-file, then when running the LIST_DATA 
command in the Gibbs (GES) module. The created database file is in this less 
verbose format.

The data-type code consists of 1 to 8 characters where each character must stand for an 
action, which is to be coupled to this phase. The keyword TYPE_DEFINITION, described 
below, must be used in the current database to specify what action should be taken by 
DATA for each character code. 

The data entries [numb. subl.] [sites in subl. 1] [sites in subl. 2] etc., specify 
the total number of sublattices (always as an integer digit) and the sites (i.e. stoichiometric 
coefficients) of each of the sublattices (given in either integer digits or real numerical 
factors) for the phase. 
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Optionally, an auxiliary text string (maximum 10,000 characters) can be given after the last 
[sites in sublattice #] but before the exclamation mark !. This string displays in connection 
with the phase name in some listings within the DATA module. 

Examples
PHASE GAS:G  % 1 1.0 ! 

PHASE LIQUID:L %ZCDQ  2  1.0  1.0 

> Metallic liquid solution, modeled by CEF Model. !

PHASE IONIC-LIQ:Y %ZCDQ  2  1.0  1.0 

> Ionic liquid solution, modeled by Ionic Two-Sublattice Model. !

PHASE SPINEL:I    %ZA   4   1  2  2  4  

> Complex Spinel Solution, by CEF model with ionic constraints. !

PHASE M23C6  % 3 20.0 3.0 6.0 !

PHASE FCC_A1    %&A  2  1 1 

> Disordered FCC phase; also as MX carbides/nitrides. !

PHASE FCC_L10   %&AX  3  0.75 0.25 1 

> Ordered FCC phase, modeled by 2-Sublattice Model for Ordering. !

PHASE FCC_L12:F %&AX  5  0.25 0.25 0.25 0.25 1.0 

> Ordered FCC phase, modeled by 4-Sublattice Model for Ordering. !

PHASE AQUEOUS:A %HIJMR 1 1.0 

> Aqueous Solution: using the Complete Revised HKF Model. !
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CONSTITUENT

CONSTITUENT [phase name]*24 [constituent description]*2000 ! 

This keyword (and the ADD_CONSTITUENT keyword for large solution phase) defines the 
phase-constitution as a list of constituents (for a substitutional phase with no sublattice) or 
of constituent arrays (for a sublattice phase). 

The phase name (maximum 24 characters) must be a predefined phase (i.e. already through 
the PHASE keyword). 

It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F and 
B) in its phase definition (already by the PHASE keyword; such as GAS:G, 
SLAG:L, LIQUID:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B, 
AQUEOUS:A), such a valid phase-type code must also always be attached to the 
phase name in the CONSTITUENT keyword (and the ADD_CONSTITUENT 
keyword).

Specifying the phase name in UPPER-case is recommended. You can define a 
phase name as a mixture of UPPER-case and lower-case letters in a database, 
but the DATA module automatically converts all lower-case to UPPER-case 
because the GIBBS module only recognizes UPPER-case phase names.

The constituent description (maximum 2000 characters) is a list of the species that enter a 
phase. The list starts with a colon (:), indicating the start of the sub-list of species for the 
first sublattice, and different sublattices are separated by colons. The complete sequence 
ends with a final colon.

Optionally, each sublattice may specify which species are considered to be major 
constituents. This is done by adding a percent sign (%) directly to the species name. The start 
values on the site fractions of the major constituents should sum to 0.99 on a specific 
sublattice. Thus, the minor constituents (i.e. those without a %) add up to 0.01. A maximum 
of 2000 characters can be coded in the constituent description, continuing in sequent lines. 
If the phase has a constituent description longer than 2000 characters, the rest can be coded 
in one or several ADD_CONSTITUENT keywords. 
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Examples
CONSTITUENT BCC_A2 :FE 

CONSTITUENT IONIC-LIQ:Y :FE+2 : SB-3: ! 

CONSTITUENT M23C6 :CR FE :FE CR W MO : C: ! 

CONSTITUENT AQUEOUS:A :H2O% AG+1 AGF AGCL AGCL2-1 AGI3-2 AGSO4-1 
AGC2H4+1 

   AGN2H6+1 AGC2N2-1 AGC2H4NO2 AL+3 ALF3 ALO2-1, ... : !  

CONSTITUENT SPINEL:I  : AL+3% CR+3 FE+2% FE+3 MG+2% NI+2 

                     : AL+3% CA+2 CR+3 FE+2 FE+3 MG+2% NI+2 VA 

                     : FE+2 MG+2 VA% 

                     : N-3 O-2% :!
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ADD_CONSTITUENT

ADD_CONSTITUENT [phase name]*24 [constituent description]*2000 ! 

This keyword adds more constituents to a phase that already has some constituents. Its 
syntax is the same as for the CONSTITUENT keyword. This keyword can be used several 
times, if the phase is very large, e.g. a gaseous mixture or a complex aqueous solution. This 
is useful when there are so many constituents in a phase that the 2000 characters available 
for the constituent description list is not enough.

Constituents are not necessary on all sublattices. In the second example below, 
no addition is made to the first sublattice.

Examples
ADD_CONSTITUENT GAS :S1 S2 S3 ... : ! 

ADD_CONSTITUENT IM-PHASE : :CR:W ... : ! 

ADD_CONSTITUENT AQUEOUS:A :CUCL+1 CUCL2 CUCL2-1 CUCL3-2 CUOH+1 CUO2H2 
CUO3H3-1 

    CUO4H4-2 CU2OH+3 CU2O2H2+2 CU3O4H4+2 NIO2H2 NIO3H3-1 NIO4H4-2 
NI2OH+3 

    NI4O4H4+4 ZNOH+1 ZNO2H2 ZNO3H3-1 ZNO4H4-2 ... : !
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COMPOUND_PHASE

COMPOUND_PHASE [phase name]*24 [data-type code]*8 [constituent] ! 

The keyword is a compact way to simultaneously define a species, a compound phase 
(maximum 24 characters) and its phase-constituent. It is useful for stoichiometric phases 
with constant compositions. The species name and stoichiometric formula must be identical, 
i.e. being the given constituent. The phase has this species as its only constituent. This 
keyword allows the database definition file for a large substance database to be more 
compact; it is a combination of the SPECIES, PHASE and CONSTITUENT keywords. 

Examples
COMPOUND_PHASE AL2O3 % AL2O3 !

COMPOUND_PHASE MAGNETITE %MF FE3O4 !

COMPOUND_PHASE QUARTZ % SIO2 !
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ALLOTROPIC_PHASE

ALLOTROPIC_PHASE [phase name]*24 [data-type code]*8 [constituent] !

This keyword does the same as the COMPOUND_PHASE keyword for entering an allotropic 
phase (maximum 24 characters), but does not enter the constituent as a species to the data 
structure. Use this if the species is already defined. 

Examples
ALLOTROPIC_PHASE BETHA-AL2O3 % AL2O3 !

ALLOTROPIC_PHASE CRISTOBALITE % SIO2 !

ALLOTROPIC_PHASE TRIDYMITE % SIO2 !
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TEMPERATURE_LIMITS

TEMPERATURE_LIMITS [lower limit] [upper limit] ! 

This keyword sets the default upper and lower temperature limits used by the GIBBS module 
for Gibbs energy parameters and functions. It can be used only once in one database 
definition file and all its sequential files. 

Example
TEMPERATURE_LIMITS 500.0 1800.0 ! 
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DEFINE_SYSTEM_DEFAULT

DEFINE_SYSTEM_DEFAULT [keyword] {G-ref. type index} ! 

This keyword sets the default value to ELEMENT or SPECIES in the DATA command DEFINE_
SYSTEM.

For a substance database, it can be appropriate to have ELEMENT as a default value whereas 
a large solution database can benefit from having SPECIES as a default value. A proper 
default value is useful for beginners. An advanced user is more likely to use the DATA 
commands DEFINE_ELEMENT and DEFINE_SPECIES to override the default value. 

{G-ref. type index} is an integer indicating the reference state type for an element when 
entering and listing data in the GIBBS module. The following lists legal numbers and the 
corresponding meaning (the reference state type for an element):

Number Definition

1 symbol: G

2 symbol: H298

3 symbol: H0

For example:

DEFINE_SYSTEM_DEFAULT element 2 ! 
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DEFAULT_COMMAND 

DEFAULT_COMMAND [secondary keyword and parameters] !

This keyword specifies commands to be executed by the DATA module at database 
initialization. The syntax of the available command is currently not the same as the user 
available DATA commands but the actions are similar. The available secondary keyword and 
parameters in syntax are: 

DEFINE_SYSTEM_ELEMENT [element names] 

DEFINE_SYSTEM_SPECIES [species names] 

DEFINE_SYSTEM_CONSTITUENT [phase] [sublattice] [species] 

REJECT_SYSTEM_ELEMENT [element names] 

REJECT_SYSTEM_SPECIES [species names] 

REJECT_SYSTEM_CONSTITUENT [phase] [sublattice] [species] 

REJECT_PHASE [phase names] 

RESTORE_PHASE [phase names] 

Examples
DEFAULT_COMMAND DEFINE_SYSTEM_ELEMENT FE VA ! 

DEFAULT_COMMAND REJECT_SYSTEM_CONSTITUENT LIQUID 2 C ! 

DEFAULT_COMMAND REJECT_PHASE LIQUID ! 

DEFAULT_COMMAND RESTOR_PHASE GAS ! 
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DATABASE_INFORMATION 

DATABASE_INFORMATION [text]*10000 ! 

This keyword defines a text for the detailed description of the current database. The text can 
be listed with the DATA command DATBASE_INFORMATION. An apostrophe (') can be used 
in the text to indicate a new line; and two apostrophes, ('') can be used in the text to 
indicate a new line plus an empty line. 

The continuous text length (each line with max 78 characters) is 10,000 
characters.

Example
DATABASE_INFORMATION This is the XXX-Alloy Solution Database '

      in the A-B-C-D-...... System. ' 

   Developed by TCS, released in May 2001. ''

... more ... ! 
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TYPE_DEFINITION 

TYPE_DEFINITION [data-type code]*1 [secondary keyword with 
parameters] !

This keyword couples phases to an action performed by the DATA module when the DATA 
command GET_DATA is executed. 

Secondary Keywords

The secondary keywords and associated parameters in syntax are: 

SEQ [filename]

RND# [filename] 

GES [valid GIBBS command with parameters] 

POLY3 [valid POLY command with parameters] 

TDB [valid DATA command with parameters] 

IF [conditional statement] THEN [keyword with parameters] 

AFTER [valid GIBBS command with parameters]

The secondary keyword SEQ specifies a sequential file that stores parameters belonging to 
the phases using the associated data type code (which is defined by this keyword). A special 
case where the filename is given as an asterisk (*) implies that the database definition file 
also acts as a sequential data storage file. This case makes it possible to have a single file for 
a small database, which is especially suited for personal databases. 

The secondary keyword RND should be concatenated with a positive integer # to indicate the 
type of the random file. Currently, there are these types of random files:

 l RND0, the default, is used for complete Gibbs energy expressions (G0 parameters), 
where the search field is the unabbreviated parameter name. 

 l RND1 is designated for functions, where the function name is used as the search field. 

 l RND2 is reserved for binary interaction parameters, where its search field is also the 
unabbreviated parameter name without any interaction order notation. 
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Ternary and higher order interaction parameters must be specified on a 
sequential file. Moreover, the internal structures of these random files are 
subject to changes with different versions of DATA, and with implementations 
of DATA on various computer systems. For more information, see the FORTRAN 
program TDBSORT, which is available from Thermo-Calc Software AB.

The secondary keywords GES, POLY3, or TDB specifies a modification of, or addition to, 
phases having the associated data type code, such as magnetic contribution, another excess 
model, or any other valid GIBBS/POLY/DATA command that applies to a certain phase. By 
implementing this as a call to the interactive GIBBS/POLY/DATA module, flexibility is 
achieved. If a new type of addition is implemented in a GIBBS/POLY/DATA module, it can be 
immediately used in the database definition file without reprogramming the DATA module. 

In several examples below, the use of the at (@) sign indicates any phase to 
which the relevant type definition (e.g. A, B, 4, or E) applies.

The secondary keywords IF and THEN allow specification of a conditional statement 
structured with respect to the phase constitution that controls the execution of a following 
type-definition (keyword with parameters) string. See the last four examples. 

The secondary keyword AFTER is similar to the GES keyword except the defined GIBBS 
command is executed after all parameters are entered. The reason for this is that the 
command has no effect unless there is a parameter. Following the AFTER keyword, a GIBBS 
command must be given and it is executed after entering the parameters of the phase. 

The data-type code (always as one string) can be any normal or special character, e.g. 0, 5, A, 
F, M, %, &, and so forth, and is referred in the definition keywords PHASE, COMPOUND_
PHASE and ALLOTROPIC_PHASE for various phases. 

A phase can have several ADDITIONAL parts of different types (that are enforced by certain 
TYPE_DEFINITIONS which call the GIBBS command AMEND_PHASE_DESCRIPTION for 
describing various contributions to Gibbs energy). However, the DATA/GIBBS module 
automatically deletes any early-defined ADDITIONAL part(s) of the same type.

The DATA module can selectively retrieve functions that are necessary for a defined system 
from a database that has functions stored in its setup file or SEQ sequential function file, 
while all other functions irrelevant for the defined system are ignored and are not saved in 
associated GIBBS and POLY workspaces. 
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Examples
TYPE_DEF % SEQ  TCPATH\DATA\[DATABASE]\PARAMETERS.TDB ! 

TYPE_DEF I SEQ  TCPATH\DATA\[DATABASE]\INTERACTION-PARAMS.TDB ! 

TYPE_DEF G RND0 TCPATH\DATA\[DATABASE]\GZERO-PARAMS.TDB ! 

TYPE_DEF F RND1 TCPATH\DATA\[DATABASE]\FUNCTIONS.TDB ! 

TYPE_DEF & RND2 TCPATH\DATA\[DATABASE]\BINARY-INTERACTIONS.TDB ! 

TYPE_DEF A GES AM_PH_DES @ MAGNETIC -1 0.40 ! 

TYPE_DEF B GES AM_PH_DES @ MAGNETIC -3 0.28 !

TYPE_DEF 4 GES AM_PH_DES @ EXCESS_MODEL REDLICH-KISTER_KOHLER ! 

TYPE_DEF 5 GES AM_PH_DES AQUEOUS EXCESS_MODEL HKF ! 

TYPE_DEF 6 GES AM_PH_DES AQUEOUS HKF_ELECTROSTATIC ! 

TYPE_DEF 7 GES AM_PH_DES AQUEOUS STATUS 02084000,,, ! 

TYPE_DEF 8 GES AM_PH_DES AQUEOUS MAJOR_CONST 1 H2O ! 

TYPE_DEF E AFTER AM_PH_DES LIQUID EXCESS MIXED-EXCESS 

                         A B LEGENDRE   C A POLYNOM ,,,, !

TYPE_DEF T AFTER AM_PH_DES LIQUID TERN-EXT TOOP-KOHLER  B A C ,,,, !

TYPE_DEF Q AFTER AM_PH_DES LIQUID TERN-EXT KOHLER FE CR NI !

TYPE_DEF C IF (PD AND PT AND SN)  THEN TDB RESTORE_PHASE BCT_A5 !

TYPE_DEF D IF (PD AND (PT OR SN)) THEN TDB REJECT_PHASE BCC_A2 ! 

TYPE_DEF E IF ((NB OR TI OR V) AND (C OR N)) THEN 

          GES AM_PH_DES @ COMP_SET ,, CR NB TI V: C N: ! 

TYPE_DEF F IF (ALO3/2 OR CRO3/2 OR FEO OR MNO OR SIO2) THEN

          GES AM_PH_DES LIQUID COMP_SET ,, ALN%,ALO3/2%,CRO3/2%,

             FEO%,FEO3/2,MNO3/2%,MNS%,SIO2%,TIO2% : !

TYPE_DEF R GES AM_PH_DES FE_LIQUID FRACTION_LIMITS  Fe 0 0.6 

         Ag 0 0.01  Al 0 0.05  Ca 0 0.05  Co 0 0.01  Cr 0 0.01  

         Cu 0 0.02  Mg 0 0.05  Mn 0 0.05  Mo 0 0.05  Nb 0 0.05  

         Ni 0 0.05  Pb 0 0.05  Si 0 0.10  Sn 0 0.02  Ti 0 0.05  

         U  0 0.01  V  0 0.02  W  0 0.02  Zr 0 0.03  

         B  0 0.01  C  0 0.01  H  0 0.01  N  0 0.01  O  0 0.01  

         P  0 0.01  S  0 0.01  !
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Ordered Phase Restores Disorder Contribution

When an ordered phase with disordered contribution is restored, the disordered 
contribution is automatically restored as well. You can also restore the disordered phase 
without restoring the ordered phase. 

However the DIS_PART TYPE_DEFINITION must always be set on the ordered 
phase. It is important that the disordered phase is declared before the ordered 
phase. Otherwise it causes an error when DIS_PART TYPE_DEFINITION is 
executed and then either the ordered or disordered phase is rejected.

Example
TYPE_DEFINITION & GES A_P_D FCC_A1 MAGNETIC  -3.0    2.80000E-01 !

PHASE FCC_A1  %&  2 1   1 !

    CONSTITUENT FCC_A1  :CR,NI% : C%,VA :  !

$ THIS PHASE HAS A DISORDERED CONTRIBUTION FROM FCC_A1

TYPE_DEFINITION ' GES AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART FCC_
A1,,,!

TYPE_DEFINITION ( GES A_P_D FCC_L12 MAGNETIC  -3.0    2.80000E-01 !

PHASE FCC_L12  %'(  3 .75   .25   1 !

    CONSTITUENT FCC_L12  :CR,NI% : CR,NI% : C,VA% :  !

For example a GES command such as the following only affects phases defined above or at 
the phase with this TYPE_DEFINITION in the TDB file:

TYPE_DEFINITION ( GES A_P_D FCC_L12 DIS_PART FCC_A1,,, !

For example a TDB command such as the following only affects phases defined below the 
phase with this TYPE_DEFINITION in the TDB file:

TYPE_DEFINITION ( TDB RESTORE_PHASE FCC_A1 !
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FTP_FILE

FTP_FILE [filename] !

FTP_FILE is a special function random file and the function names correspond to the record 
numbers where these record names and the functions are stored. The FTP_FILE decreases 
search time for the associated database in the DATA module. The file is used for large 
substance databases along with a SEQ sequential or RND0 random file for storage of G0 
parameters referring the functions named FxxxxT that are stored in the FTP file. The integer 
number xxxx is a search code used by DATA when such files are processed. 

No modification of this file type is allowed.

Example
FTP_FILE TCPATH\DATA\[DATABASE]\FTP-FILE.DATA ! 
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FUNCTION

FUNCTION [function name]*8 [lowest temp. limit]

[expression 2]; [upper temp. limit 2] Y

[expression 1]; [upper temp. limit 1] Y

[expression 3]; [upper temp. limit 2] Y

   .......... ; ..... Y

[expression n-1]; [upper temp. limit n-1] Y

[expression n]; [upper temp. limit n] N {Ref. Index} !

GIBBS can use predefined functions in the expression (TP-Function) of a Gibbs energy 
parameter or in other functions. This is often used when several parameters (or functions) 
have a common sub-expression, such as for metastable modifications of elements. This 
keyword can appear in both files for database definition and sequential storage, but not in 
FTP files. A valid function name can have up to 8 characters.

A function always starts with a lowest temperature limit of its applicability, followed by one 
or more (up to 10) expressions (TP-Functions) that are coded as mathematical relations of 
constants, functions of stable variables (T and P) and other entered functions (normally with 
a # suffix, e.g. +3*GHSERAL#).

ENTER_PARAMETER

The expression is a FORTRAN-like expression and operators +,  -, *, = and ** can be used (** 
only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP 
(for exponential) can also be used. There is also the GEIN function available for the Einstein 
Model.

GEIN(THETA) = 1.5*R*THETA + 3*R*T*LN(1-EXP(-THETA/T))

General Einstein Model

Each expression (TP-Function) should end with a semicolon (;), and be followed by its upper 
applicable temperature limit and a continuation indicator (Y to continue with the next 
expression or N to end the function’s expression). If there is no continuation after a specific 
expression (TP-Function), the reference index can optionally be given after the N indicator.

A complete/valid function entry can be written in several continuation lines if the function’s 
expression (TP-Function) is too long or if there is more than one applicable expression (TP-
Function), as the maximum length of each line is 78 characters.
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It is recommended to always have at least one empty space at the beginning of 
each continuation line. Otherwise, the DATA module may misunderstand the 
expression or issue some error messages when reading the function entry. 
Avoid entering functions like the one below.

FUNCTION GHSERXY  298.15

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

Such a function is read by the DATA module as

1000+1058*T-38.9*T*LOG(T)+GFUNXY#

rather than

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#

This is because the DATA module concatenates all lines and removes extra spaces before 
trying to enter the function in the GIBBS workspace. Thus, the - sign is taken as a delimiter 
between 298.15 and 1000, and the function incorrectly becomes:

FUNCTION GHSERXY 298.15 1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

Avoid this mistake by giving at least one empty space as the first character of a 
new line, such as

FUNCTION GHSERXY  298.15

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

which is read correctly as

FUNCTION GHSERXY  298.15 -1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a 
function is normally set by default as 298.15 K, in most cases. However, you can set another 
limit when it is applicable (according to experimental data and assessments).

An upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each 
TP-Function in a function must be given after the semicolon (;) immediately following the 
specific TP-Function. The highest-temperature limit (in Kelvin) for the applicability of the 
current function is always followed by the N sign. If a negative number is given as the 
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lowest-temperature limit, it assumes there are breakpoints in pressure for this function. In 
these cases, it is interpreted as the lowest-pressure limit (in Pascal), and the other limits in 
the current function is also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the functions are checked during calculations. An 
indicator is set if the actual temperature/pressure condition is below the lowest 
temperature/pressure limit or above the highest temperature/pressure limit. In these cases, 
an extrapolation is done using the TP-Function valid in the nearest temperature/pressure 
range.

The optional reference index {Ref. Index} is an integer number indicating where to find the 
particular function in a special reference file. The references are listed when doing the GET_
DATA command in the DATA module. They can also be listed in the GIBBS module with the 
command LIST_DATA with the option R.

For accounting for the reference indices, also see the keyword REFERENCE_FILE.

The reference index field can also be an abbreviation (such as REF:250, REF_002, or REF-
SGTE) which denotes the original reference. In this case, the reference cannot be obtained 
when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the 
option R).

However, the references directly coded in the database definition file (***setup.TDB) 
starting with a letter can be shown when issuing the DATA command GET_DATA or the 
GIBBS command LIST_DATA (with the option N or R). Normally, such references must be 
located after the LIST_OF_REFERENCE keyword. It is recommended to use reference code 
names such as REF001, REF018, etc. The reference list, which is generated by the GIBBS 
command LIST_DATA <file> with the N or R option, is also possible to be directly read by the 
DATA module.

The DATA module can selectively retrieve functions which are necessary for a defined 
system from a database that has functions stored in its setup file or SEQ sequential function 
file, while all other functions irrelevant for the defined system are ignored and are not saved 
in associated GIBBS and POLY workspaces. Previously, this can only be done for large 
databases that have functions stored in RND1 random or FTP function files.

Examples
FUNCTION GFREE  298.15  1000+GFUNXY#; 6000 N !

FUNCTION GFUNXY 298.15 -1000+200*T+30*T*LOG(T); 6000 N 505 !

FUNCTION G0_CAO 298.15 -663538.11+352.67749*T-57.7533*T*LN(T)

        +5.3895E-03*T**2-8.879385E-07*T**3+575530*T**(-1);
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     1400.00 Y -625196.99+78.896993*T-20.40145*T*LN(T)

        -1.112923E-02*T**2+5.1896733E-07*T**3-6917350*T**(-1);

     2900.00 Y -499226.55-490.37695*T+51.95912*T*LN(T)

       -2.961051E-02*T**2+1.4033905E-06*T**3-48114685*T**(-1);

     3172.00 Y -587711.89+375.04117-62.76*T*LN(T); 

     6000.00 N REF020 !
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PARAMETER

PARAMETER <parameter name> [lowest temp. limit]

[expression 1]; [upper temp. limit 1] Y

[expression 2]; [upper temp. limit 2] Y

[expression 3]; [upper temp. limit 2] Y

   .......... ; ..... Y

[expression n-1]; [upper temp. limit n-1] Y

[expression n]; [upper temp. limit n] N {Ref. Index} !

This keyword can appear in both files for database definition and sequential storage, but not 
in FTP files. After the keyword, a valid < parameter name> in some cases should be given.

It is used to define standard Gibbs energies (i.e. the G parameters for Gibbs energy of 
formations) of all valid end-members of various stoichiometric and solution phases, and 
excess Gibbs energies (i.e. the L parameters for Gibbs energy of interactions) of all binary, 
ternary, quaternary or higher-order interactions in various solution phases; both standard 
Gibbs energies and excess energies can also have parameters for contributions from PT-
depended volume variations (i.e. the V0, VA, VC and VK parameters for molar volume, 
thermal expansivity, bulk modulus, isothermal compressibility and high-pressure fitting 
parameter), magnetic ordering (i.e. the TC and BM parameters for Curie temperature and 
Bohr magneton number) and hypothetical electrostatic interactions (i.e. BM parameter for 
Born functions ωPr,Tr of aqueous solute species).

The general form of a parameter is:

<identifier>(<phase>, <constituent array>; <digit>) <xxx> 
<expression> <yyy> <keyword Y or N> <zzz> !

General Form

Name Description

identifier The parameter type.

phase The phase name (maximum 24 characters).

constituent 
array The specific constituent array in the phase.
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Name Description

digit

The degree of composition-dependent interaction contribution (an integer number from 0 to 9), 
that is only for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), 
as well as for volume-related parameters (V0 or VA or VB or VC or VK); if it is valued as zero, or if 
it is for the standard Gibbs energy (G) for which the degree is always zero, it can be omitted.

expression The mathematical relation to describe the parameter.

xxx and yyy The low and high temperature limits respectively for the applicable temperature range of the 
parameter expression

keyword Y or N The indicator on if there is continuation for the parameter expression or not

zzz The reference index/number for the assessment of this parameter;

! The exclamation mark is used to indicate that the current parameter definition is ended

GIBBS Parameter Name

The GIBBS parameter name has a general form of:

<identifier>(<phase>,<constituent array>;<digit>)

Type-Identifier and Definition

The GIBBS parameter name consists of several parts. The first is a type-identifier. The 
following type-identifiers are legal:

Type-Identifier Definition

G Standard energy parameter (Gibbs energy of formation)

L Excess energy parameter (Gibbs energy of interaction)

TC Curie temperature for magnetic ordering

BMAGN or BM Bohr magneton number for magnetic ordering (or Born function  Pr,Tr for aqueous 
solute species).

LNTHETA1, LNTHETA2, 
LNTHETA3, LNTHETA4, 
and LNTHETA5

 where  is the Einstein temperature. Used by the general Einstein model and 
together with a corresponding THETAF parameter with the same number. See General 
Einstein Model in the Database Optimization User Guide.
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Type-Identifier Definition

THETAF1, THETAF2, 
THETAF3, THETAF4, 
and THETAF5

A weight function used together with a corresponding LNTHETA parameter with the same 
number. Used by the general Einstein model. See General Einstein Model in the Database 
Optimization User Guide.

V0 Molar volume at 298.15 K and 1 bar (a numeric value only)

VA
Integrated thermal expansivity 

VC High-pressure fitting parameter

VK Isothermal compressibility

VISC RT*ln(η) where η is the dynamic viscosity

ELRS Electric resistivity

THCD Thermal conductivity

SIGM Surface tension of a liquid end-member

XI Surface tension dampening factor/interaction for one constituent in a two-constituent 
combination. See the examples for how to use these parameters

ECij Elastic constant parameter

ECijMAG Scaling factor for magnetic contribution to elastic constants

Examples

Parameter Definition

G(GAS,C1O2) The Gibbs energy of formation of a CO2 molecule in gas.

G(FCC,FE:VA) The Gibbs energy of formation of fcc Fe with interstitials.

L(LIQ,Fe,Cr;0) The regular solution parameter for Fe and Cr in liquid.

L(LIQ,Fe,Cr;1) The sub-regular solution parameter.
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Parameter Definition

TC(BCC,Fe:Va) The Curie temperature of bcc Fe.

BMAGN(BCC,Fe:Va) The Bohr magneton number parameter of bcc Fe.

SIGM(LIQUID,AL;0) Surface tension of Al in LIQUID. Constant value or linear temperature dependence.

XI(LIQUID,AL,CU;0)
Surface tension dampening factor for Al in the Al-Cu combination in LIQUID. Constant 
value.

XI(LIQUID,AL,CU;1)
Surface tension dampening factor for Cu in the Al-Cu combination in LIQUID. Constant 
value.

EC11(HCP_A3, TI:VA;0) The regular solution parameter for elastic constant C11 of HCP Ti with interstitials.

EC11MAG(BCC_A2, 
FE:VA; 0)

The scaling factor for the magnetic contribution to elastic constant C11 for BCC Fe with 
interstitials.

You can also use G for interaction parameters; and on output list (performed by the GIBBS 
command LIST_PARAMETER or LIST_PHASE_DATA) the type-identifier L is always used for 
interaction parameters. Note that the type-identifier BM is also used for Born functions 
ωPr,Tr of aqueous solute species.

The identifier must be followed by an opening parenthesis, a phase name, a comma and a 
constituent array. Optionally, the constituent array can be followed by a semicolon and a 
digit. The parameter name is terminated by a closing parenthesis.

It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F and 
B) in its phase definition (already by the PHASE keyword; such as GAS:G, 
LIQUID:L, SLAG:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B, 
AQUEOUS:A), such a valid phase-type code should not be attached to the phase 
name in the PARAMETER keyword.

Specifying the phase name in UPPER-case is recommended. You can define a 
phase name as a mixture of UPPER-case and lower-case letters in a database, 
but the DATA module automatically converts all lower-case to UPPER-case 
because the GIBBS module only recognizes UPPER-case phase names.
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The constituent array consists of a list of constituent names. Interaction parameters have 
two or more constituents from the same sublattice separated by a comma. If the phase has 
sublattices, at least one constituent in each sublattice must be specified. The exception is if 
the phase is ionic liquid (specified with the "phase bit" :Y), then neutral endmember and 
interaction parameters are written as if the first sublattice does not exist, e.g. PARAM G
(IONIC_LIQ,FEO3/2;0), i.e. the constituent array does not contain any constituents from the 
first (cation) sublattice.

For more ionic liquid specific parameters, see Parameters for the Two Sublattice 
Ionic Liquid Model.

The constituents in different sublattices must be given in sublattice order and are separated 
by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit 
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess 
energy model used for the phase. If no semicolon and digit are given, the sub-index value is 
assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary 
parameters, are multiplied with two or more fractions of the constituents from the same 
sublattice of the solution phase. These additional constituents must be given as interacting 
constituents.

Be careful about the sign of odd terms, for example, L(BCC, B, A:VA;1) is treated 
as L(BCC,A,B:VA;1), i.e. it is always put into alphabetical order.

Solution phases with sublattices may have interacting constituents in each 
sublattice.

You can use an asterisk (*) to denote that the excess interaction parameter is independent 
of the constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that the 
interaction parameter is for the binary interaction between constituents AL and NI on the 
first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on 
the second sublattice. A interaction parameter in the list of constituents is always added to 
the Gibbs energy and the asterisk (*) is calculated with the term of [1-∑y(specified 
constituents)], which implies that in an A-B binary system the following three L parameters 
are identical (but in higher-order systems, they are different):
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 l L(phase,A,B)is multiplied withX(A)*X(B)

 l L(phase,A,*)is multiplied withX(A)*(1-X(A))

 l L(phase,B,*)is multiplied withX(B)*(1-X(B))

A parameter always starts with a lowest temperature limit of its applicability, followed by 
one or more (up to 10) expressions (TP-Functions) coded as mathematical relations of 
constants, functions of stable variables (T and P) and entered functions (normally with a # 
suffix, e.g. +3*GSERAL#).

The expression is a FORTRAN-like expression and operators +,  -, *, = and ** can be used (** 
only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP 
(for exponential) can also be used.

There is also the Einstein function GEIN available:

GEIN(THETA) = 1.5*R*THETA + 3*R*T*LN(1-EXP(-THETA/T))

General Einstein Model

Each expression (TP-Function) should ends with a semicolon (;) and be followed by its upper 
applicable temperature limit and a continuation indicator (Y to continue with the next 
expression, or N to end the parameter’s expression). If there is no continuation after a 
specific expression (TP-Function), the reference index can be optionally given after the N 
indicator.

A complete/valid parameter entry can be written in several continuation lines if the 
parameter’s expression (TP-Function) is too long or if there is more than one applicable 
expression (TP-Function), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of 
each continuation line. Avoid entering parameters such as:

PARAMETER G(LIQUID,A,B) 298.15

-2000+4568*T+2*GFUNAB#; 6000 N !

Such a parameter is read by the DATA module as 2000+4568*T+2*GFUNAB#, rather than as 
-2000 +4568*T+2*GFUNAB#.
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Avoid this mistake by giving at least one empty space as the first character of a 
new line, such as

PARAMETER G(LIQUID,A,B) 298.15

-2000+4568*T+2*GFUNAB#; 6000 N !

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a 
parameter is normally set by default as 298.15 K, in most cases; however, you can set 
another limit when it is applicable (according to experimental data and assessments). An 
upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each TP-
Function in a parameter must be given after the semicolon (;) immediately following the 
specific TP-Function; and the highest-temperature limit (in Kelvin) for the applicability of the 
current parameter is always followed by the N sign. If a negative number is given as the 
lowest-temperature limit, it is assumed that there are breakpoints in pressure for this 
parameter. In such cases, it is interpreted as the lowest-pressure limit (in Pascal), and the 
other limits in the current parameter are also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the parameters are checked during calculations. An 
indicator is set if the actual temperature/pressure condition is below the lowest 
temperature/pressure limit or above the highest temperature/pressure limit. In these cases, 
an extrapolation is done using the TP-Function valid in the nearest temperature/pressure 
range.

The optional reference index {Ref. Index} is an integer number indicating where to find the 
particular parameter in a special reference file. The references are listed when doing the 
GET_DATA command in the DATA module. These can also be listed in the GIBBS module with 
the command LIST_DATA and the option R or N.

For accounting the reference indices, also see the keyword REFERENCE_FILE.

The reference index field can also be an abbreviation (such as REF:250, REF_002, or REF-
SGTE) denoting the original reference. In this case, the reference cannot be obtained when 
issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option R 
or N).

However, the references directly coded in the database definition file (***setup.TDB) that 
starts with a letter can be shown when issuing the DATA command GET_DATA or the GIBBS 
command LIST_DATA (with the option R or N). Normally, such references must be located 
after the LIST_OF_REFERENCE keyword. It is recommended to use reference code names 
such as REF001, REF018, etc. The reference list, which is generated by the GIBBS command 
LIST_DATA <file> with the N option, is thus also possible to be directly read by the DATA 
module.
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Examples
PARAMETER G(BCC,FE:VA) 298.15 1000+200*T+...; 6000 N 91DIN !

PARAMETER TC(BCC,FE:VA)    298.15 +1043; 6000 N 91DIN !

PARAMETER BMAGN(BCC,FE:VA) 298.15 +2.22; 6000 N 91DIN !

PARAMETER G(SIGMA,FE:CR:CR;0) 298.15 1000+200*T+...; 6000 N 101 !

PARAMETER G(LIQUID,AL;0)  298.15  +11005.553-11.840873*T

        +7.9401E-20*T**7+GHSERAL#; 

933.60 Y +10481.974-11.252014*T+1.234264E+28*T**(-9)+GHSERAL#; 

   2900.00 N  REF:283 !

PARAMETER G(BCC_A2,PB:C)   298.15 UN_ASS#; 300 N REF:0 !

PARAMETER G(BCC_A2,NI:C;0) 298.15 +GHSERNI#+3*GHSERCC#

                                    +400000-100*T; 6000 N REF071 !

PARAMETER G(BCC_A2,MN:VA)  298.15 +GMNBCC#; 6000 N REF285 !

PARAMETER G(PHASE,A:B) 298.15 +3*GEIN(800); 6000 N 101 !

PARAMETER BM(AQUEOUS,OH-1) 298.15 +Z0002PW0#; 1600 N 155 !

PARAMETER L(BCC,FE,CO:VA;0) 298.15 1000+200*T+...; 6000 N !

PARAMETER L(BCC,FE,CO:VA;1) 298.15 1000+200*T+...; 6000 N !

PARAMETER L(BCC,FE,CO:VA;2) 298.15 1000+200*T+...; 6000 N !

PARAM    TC(BCC_A2,CO,MO:VA;0) 298.15  -3700;    6000 N R454 !

PARAM    TC(BCC_A2,CO,MO:VA;1) 298.15  +2300;    6000 N R454 !

PARAM BMAGN(BCC_A2,CO,MO:VA;0) 298.15 -3.445;    6000 N R454 !

PARAM V0(BCC_A2,CR,FE:VA;0) 298.15 +ZERO#; 6000 N REF06V !

PARAM V0(BCC_A2,CR,FE:VA;1) 298.15 -1.10524097E-7; 6000 N REF06V !

PARAM V0(BCC_A2,CR,FE:VA;2) 298.15 +1.40024130E-7; 6000 N REF06V !

PARAM VA(BCC_A2,CR,FE:VA;0) 298.15 -6.49444634E-6*DELTAT#; 6000 N 
REF06V !

PARAM VA(BCC_A2,CR,FE:VA;1) 298.15 +2.91269321E-5*DELTAT#; 6000 N 
REF06V !

Parameters for the Two Sublattice Ionic Liquid Model

For the two sublattice ionic liquid model (specified with the "phase bit" :Y in the phase 
declaration), there are some additional requirements on the allowed parameters. While in 
the regular case all combinations of a phase’s constituents are allowed as end-members, 
there are some constraints on the allowed parameters for ionic liquid.
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In the ionic liquid model, the vacancy has been given an “induced” charge -Q, where Q is the 
average charge of the first (cation) sublattice.

All allowed parameters are listed below. The following notations are used:

 l C= Cation
 l C1= Cation 1 if more than one. Similar for anions and neutrals.
 l A= Anion
 l VA= Vacancy
 l N= Neutral
 l D= Anion or vacancy or neutral (i.e. anything on the second sublattice)

The phase description is:

(C1,C2…Ci)P(A1,A2...Ai,VA,N1, N2...Ni)Q

In the ionic liquid model,the Vacancy has been given an “induced” charge -Q, where Q is the 
average charge of the first (cation) sublattice.

Allowed end-members, assuming the phase name is IONIC_LIQ:

G(IONIC_LIQ,C:A;0)

G(IONIC_LIQ,C:VA;0)

G(IONIC_LIQ,N;0)

(The last line is an exception to the case that the constituent array must contain constituents 
from all sublattices)

This leaves one not allowed end-member:

G(IONIC_LIQ,C:N;0)

Allowed binary interaction parameters, where i is the interaction order in a Redlich-Kister 
expansion.

G(IONIC_LIQ,C1,C2:A;i)

G(IONIC_LIQ,C1,C2:VA;i)

G(IONIC_LIQ,C:VA,N;i)

G(IONIC_LIQ,N1,N2;i)

G(IONIC_LIQ,C:A1,A2;i)

G(IONIC_LIQ,C:A,VA;i)

G(IONIC_LIQ,C:A,N;i)

No other binary interactions are allowed.



Thermo-Calc Documentation Set

Database Manager User Guide ǀ 47 of 99

Allowed ternary interaction parameters. The interaction is composition independent if there 
is one parameter with i = 0. It is composition dependent if there are three parameters with i 
= 0, 1 and 2. There can only be one or three parameters for one combination of constituents

G(IONIC_LIQ,C1,C2,C3:A;i)

G(IONIC_LIQ,C1,C2,C3:VA;i)

G(IONIC_LIQ,N1,N2,N3;i)

G(IONIC_LIQ,C1,C2:VA,N;i)

G(IONIC_LIQ,C:VA,N1,N2;i)

G(IONIC_LIQ,C:A,D1,D2;i)

G(IONIC_LIQ,C1,C2:A,D;i)

No other ternary interactions are allowed.
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OPTIONS

OPTIONS /[alloy name]([composition limitations for all alloying 
elements]) ! 

This keyword defines an alloy in a database. An alloy has a name, a major component and a 
number of alloying elements. The purpose for defining an alloy is to be able to tell you about 
applicable composition limits of the current database in applications to that particular type 
of alloy. It is possible to have several alloys in the same database. The alloys are given after 
the keyword in the database. 

The alloy name must be proceeded by a slash (/) and terminated by the opening 
parenthesis, with no spaces are allowed in between. 

 l The alloy name is maximum 8 characters. 
 l After the parenthesis, follows the major element and a parenthesis with its minimum 

mass and minimum mole percent given inside. 
 l Then, the alloying element names, each with its maximum mass and mole percent 

are given within parenthesis. 
 l There must a space between definitions for each alloying element. 
 l The alloy definition is terminated by a closing parenthesis, and the whole OPTIONS 

keyword by the exclamation mark (!).

Example
OPTIONS /SSteel(Fe(60,60) CR(30,30) NI(15,15) SI(1,1) N(.1,1)) !
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TABLE

It is recommended to always have at least one empty space at the beginning of 
each continuation line. Otherwise, the DATA module may issue some error 
messages when reading the table entry.

TABLE [name]*8 [start temp] [end temp] [delta temp] [table values] ! 

This keyword can appear in both files for database definition and sequential storage, but not 
in FTP files. It makes a table of Gibbs energy as a function of temperature where the values 
are given from the start temperature to the end temperature, at a step of the delta 
temperature. 

Example
TABLE DEMTAB 1000.0 1500.0 100.0 -2912.9008 -2834.2416 -2755.5824 

              -2677.7600 -2600.7744 -2524.2072 ! 
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ASSESSED_SYSTEMS 

ASSESSED_SYSTEM [descriptions on special treatments for specific 
assessed systems]*8000 ! 

This keyword can be included in the database definition file (the ***setup.TDB file). A 
maximum of 8000 characters after the keyword (to describe some special options when the 
DATA, GIBBS and POLY models deal with the existing systems with assessed data) is allowed 
until the exclamation mark (!). 

Several ASSESSED_SYSTEMS keywords can be used in the same TDB file in order to have 
more lists of assessed systems. There is no limit to the number of the entries in the same 
TDB file. 

The assessed systems in the database, and the special treatment options, are typed after the 
keyword. The elements (always in UPPER CASE) in each assessed system must be in 
alphabetical order and be separated by a hyphen, such as C-FE for the Fe-C binary system, 
and C-CR-FE for the Fe-Cr-C ternary system. A space must be between each assessed 
system. Information on assessed binary, ternary or higher-order systems may also be given 
in this way. 

A ternary system like C-CR-FE does not imply that the binary C-CR, C-FE and CR-
FE are assessed. There is no way to indicate partially assessed systems.

 l There is a field to give some descriptive information for a specific system, with 
various options about how to: 

 l Reject or restore phase(s) from the current database in the DATA module;
 l Set major constituent(s) in the first composition set and to set a second composition 

set for a specific phase available in the current database in the GIBBS module; and  
 l Calculate this specific system in the POLY module. 
 l This is the facility used by the BIN (binary phase diagrams) and TERN (ternary phase 

diagrams) modules in the Thermo-Calc software/database package. 

The descriptive information must immediately follow the specific system name, and must be 
enclosed within parenthesis ( and ), and the left parenthesis must follow directly after the 
system, such as :

AL-NI(TDB +L12 ;G5 C—S:L12/NI:AL:VA ;P3 STP:.8/1200/1 STP:.2/600/1)
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The syntax TDB means that the commands to the DATA module proceed, and +L12 in the 
example means that the phase called L12 should be restored (it has been rejected by 
default).

The directive ;G5 means that the following are commands to the GIBBS module. C_S: means 
creating a second composition set, after the colon follows the phase name and after the 
slash the major constituents. 

After the directive ;P3 follows commands to the POLY module. STP: means setting a start 
point with the value of the X-axis first (composition for the second element in a binary 
system), the slash separates the Y-axis value (temperature), and possibly one or more 
directions (-1, 1, -2 or 2). 

A summary of the allowed syntax is: 

TDB accepts 

 l +phase and -phase for restore/reject. 
 l ;G5 accepts 
 l MAJ:phase/constituent-array for major constituents of the first composition set. 
 l C_S:phase/constituent-array for a second composition set. 
 l ;P3 accepts 
 l TMM:lt/ht for the low-/high-temperature limits (lt and ht; for instance 

TMM:500/4000) suitable for calculating phase diagrams and property diagrams of a 
binary system. 

 l * for a default start point which is set as:
 l for a binary system: at the composition X(2nd element)=.1234, temperature T=1100 

K and with the default directions; or
 l for a ternary system: at the compositions X(2nd element)=.1234 and X(3rd 

element)=.1234 and with the default directions. 
 l STP:x/t/d1/d2/d3 for a specific start point in a binary system which is set as at the 

composition X(2nd element)=x and temperature T=t (in K), and with the directions 
d1, d2 and/or d3. 

 l STP:x1/x2/d1/d2/d3 for a specific start point in a ternary system which is set as at 
the compositions X(2nd element)=x1 and X(3rd element)=x2 and with the 
directions d1, d2 and/or d3. 

 l The direction(s) can be defined as -1, 1, -2 or 2. If no direction is specified, all default 
directions are used (meaning no ADD command is enforced in the POLY module). 
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 l If only one start point is specified, the direction(s) may be omitted; if more than one 
start points are specified, at least one direction for each start point must be given for 
all start points. 

Each entry for a specific binary or ternary sub-system can be written in one or several lines 
(each line with 78 characters).

Other Examples
ASSESSED_SYSTEMS 

AL-NI(TDB +L12 +BCC_B2 ;G5 C_S:L12/NI:AL:VA

       ;P3 STP:.8/1000/1 STP:.45/700/1 STP:.7/700/1)

AL-PB(TDB -HCP -BCC

       ;G5 MAJ:LIQ/AL MAJ:FCC/AL:VA C—S:LIQ/PB C—S:FCC/PB:VA ;P3 *)

CR-FE(;G5 C—S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)

AG-CU(;G5 MAJ:FCC/AG:VA C_S:FCC/CU:VA ;P3 STP:.3/1000)

C-NB(;P3 STP:.9/1100/1)

C-SI(;P3 *)

CO-CR(;G5 MAJ:FCC/CO:VA C_S:FCC/CR:VA ;P3 STP:.1/1100)

CR-FE(TDB -HCP ;G5 C_S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)

CR-NI(;P3 *)

CR-W(;G5 MAJ:BCC/W:VA C_S:BCC/CR:VA

       ;P3 TMM:500/4000 STP:.3/700/1 STP:.3/1800/2 )

CU-FE(TDB -HCP ;G5 MAJ:LIQ/CU MAJ:FCC/FE:VA C_S:FCC/CU:VA

       ;P3 STP:.9/1400)

FE-N(TDB +FE4N ;P3 *)

FE-O(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:O-2 MAJ:ION_LIQ/FE+2:VA

      ;P3 STP:.2/2000/1 )

FE-S(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:S MAJ:ION_LIQ/FE+2:S-2 
;P3 *)

AL-MG-SI(;P3 *)

C-CR-FE ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA ;P3 *) !



Thermo-Calc Documentation Set

Database Manager User Guide ǀ 53 of 99

The semicolon (;) is a part of the ;G5 and ;P3 directives. A long descriptive 
information can be written in more than one line, such as for the AL-NI, AL-PB , 
CU-FE and FE-O systems shown above.

The directive ;P3 * is needed if the default start point should be used. If there is no P3 
directive, the BIN or TERN module generates some 20 different start points in order to cover 
all possible compositions and temperatures (for a binary system) or all possible 
compositions (for a ternary system under any specific temperature).  
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REFERENCE_FILE

REFERENCE_FILE [file name] ! 

This keyword takes a reference file name as its argument. This reference file (that must be 
edited in a restrictive way and be saved as a blocked file with a fixed line-length for each line 
in the file, as described below) contains a complete list of the references for the various 
parameters (and sometimes functions) in the database. The file must have a fixed record 
structure: each reference entry with one or several records, and each record with exactly 78 
characters written in one single blocked line; and no empty space is allowed at the beginning 
of all lines in the file. If there are more than one record entered for a reference entry, all the 
continuation lines must start with an ampersand (&). The line number of the first record for a 
specific reference entry is then accounted as the unique integer for that specific reference, 
which is referred when a parameter or function calls this integer as the optional {Ref. Index}. 

Keywords PARAMETER or FUNCTION have information about specifying a 
reference index. 

Example
/-1<G>            T.C.R.A.S. Class 1 

AG1.64TE1         THERMODATA 01/93

&28/01/93

&SILVER 1.64-TELLURIDE. Solid Standard State.

AG1               HULTGREN SELECTED VAL.        SGTE ** 

&AT.WEIGHT 107.870,STANDARD STATE:CODATA KEY VALUE.MPT=1234.93K. &--
U.D. 30/10/85. 

AG1<G>            T.C.R.A.S  Class: 1 

AG1/+1<G>         T.C.R.A.S  Class: 1 

AG1BR1            N.P.L.                        SGTE ** 

&Tfusion uncertain and heat vaporization estimated. 

AG1BR1<G>         THERMODATA 01/93 

&28/01/93

&Gaseous Standard State. 

AG1BR1O3          BARIN & KNACKE.SUPPL.REF:62,* SGTE ** 

&AGO3BR           SILVER OXYTRIBROMIDE 
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In the example, the unique integers of related references (for assessed elements, species, 
phases, interactions, etc.) are: 

1/-1<G>

2AG1.64TE1

5 AG1

8AG1<G>

9AG1/+1<G>

10AG1BR1

12AG1BR1<G>

15AG1BR1O3
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LIST_OF_REFERENCE

LIST_OF_REFERENCE

NUMBER SOURCE

  [REFxxx]  '[Detailed reference]'

.......... 

.......... !

This keyword starts a reference list that is directly coded in the database definition file 
(***setup.TDB). Its argument begins on the following line, and normally has an explanation 
line (NUMBER SOURCE) that is followed by various reference codes. Each reference code 
may occupy one or more lines (each line with maximum 78 characters), but must have a 
reference code name (that starts with a letter) and the detailed reference information (that 
is written within two single-quotation marks, ''). It is recommended to use reference code 
names such as REF001, REF018, etc. A maximum of 400,000 characters after the keyword is 
allowed until the exclamation mark (!).

Such a reference list can be shown when issuing the DATA command GET_DATA or the 
GIBBS command LIST_DATA (with the R option). The reference list, which is generated by the 
GIBBS command LIST_DATA <file> with the N option, has this structure, and is thus possible 
to be directly read by the DATA module. 

Example
LIST_OF_REFERENCES

NUMBER  SOURCE

REF283 'Alan Dinsdale, SGTE Data for Pure Elements, 

          Calphad Vol 15(1991) p 317-425, 

          also in NPL Report DMA(A)195 Rev. August 1990'

REF224 'P-Y Chevalier, Thermochimica Acta, 130 (1988) p 33-41; AG-SI'

! 
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ADD_REFERENCE

ADD_REFERENCE

  [REFxxx]  '[Detailed reference]'   

.......... 

.......... !

Use this keyword to have an unlimited number of references. The use of this is the same as 
that of LIST_OF_REFERENCE, and is used after it. Several ADD_REFERENCES sections can be 
used in a single database if there are too many references.

It is recommended to always start with a so-called empty reference (such as the DUMP0 
reference in the following example) as the first entry in each of the ADD_REFERENCE sections 
to make sure that all references are listed appropriately as retrieving data by issuing the 
GET_DATA command. 

Example
ADD_REFERENCE

   DUMP0  'Empty reference 0'

   REF4 'J-O Andersson, B. Sundman, CALPHAD Vol 11, (1987), p 83-92 

          TRITA 0270 (1986); CR-FE'

   REF5 'J-O Andersson, Met. Trans A, Vol 19A, (1988) p 627-636 

          TRITA 0207 (1986); C-CR-FE'

   REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys 
Database, 

          v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters 

          at high temperatures.' 

   ... ... 

! 

ADD_REFERENCE

   DUMP1  'Empty reference 1'

   REF275 'A. Fernandez Guillermet, Z. Metallkde. Vol 79(1988) p.524-
536, 

          TRITA-MAC 362 (1988); C-CO-NI AND C-CO-FE-NI'

   REF393   'K. Frisk, Metall. Trans. Vol 21A (1990) p 2477-2488, 

          TRITA 0409 (1989); CR-FE-N'
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   REF1096  'P. Gustafson, Metall. Trans. 19A(1988) p 2547-2554, 

          TRITA-MAC 348, (1987); C-CR-FE-W'

   ... ... 

! 
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CASE and ENDCASE

CASE [ELEMENT/SPECIE/PHASE] ! 

  IF (boolean algebra on element, species or phase names) THEN

       [GIBBS/POLY/DATA command] ! 

ENDCASE !

This keyword takes as its argument, a definition on which type of the following Boolean 
algebra operates. A simple Boolean algebra using AND and OR with a maximum of four levels 
of parentheses works. The CASE construction must end with the ENDCASE keyword. This 
makes it possible to have additional GIBBS or POLY commands executed depending on the 
user selection of elements, species or phases. The DATA commands that can be given as 
secondary keyword to DEFAULT_COMMAND  can also be executed.

Example 1
CASE ELEMENT ! 

   IF((CR OR TI OR V) AND N) 

   THEN GES AM_PH_DES @ C_S ,, CR MO TI V:C N: !

ENDCASE ! 

Example 2
CASE ELEMENT !

   IF(O) THEN TDB DEFINE_SYSTEM_ELEMENT /- !

ENDCASE !

Example 3
CASE ELEMENT !

   IF(AL AND FE) 

   THEN TDB DEF_SYS_ELEMENT VA !

ENDCASE !
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VERSION_DATA 

VERSION_DATE [string]*78 ! 

The string is denoted as the version/revision date and database manager of the database. 
Nowadays, this directive is used mainly for the purpose of keeping the development and 
revision history mostly updated. 

Example
VERSION_DATE Last update and adjustment: Database Manager, 2015-09-25 
!
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Working with the Mobility Databases
In this section:

Extensions to Database Definition File Syntax 62

PARAMETER 63

DIFFUSION 64

ZEROVOLUME_SPECIES 65
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Extensions to Database Definition File Syntax

Software packages for simulation of diffusional phase transformations, such as the Diffusion 
Module (DICTRA) and Precipitation Module (TC-PRISMA), need both thermodynamic data 
and kinetic data (i.e. diffusivities or mobilities). Naturally, the handling and storage of kinetic 
data also benefits from the use of some kind of database management. Thus, the TDB 
database definition file syntax has been extended to incorporate some keywords needed for 
storing kinetic data - PARAMETER, DIFFUSION, and ZEROVOLUME_SPECIES .
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PARAMETER

PARAMETER [special GIBBS parameter name] [low temp. limit] 

[expression 1]; [upper temp. limit 1] Y 

[expression 2]; [upper temp. limit 2] Y 

[expression 3]; [upper temp. limit 2] Y 

   .......... ; ..... Y

[expression n-1]; [upper temp. limit n-1] Y 

[expression n]; [upper temp. limit n] N {Ref. Index} ! 

This keyword allows you to enter all types of normal GIBBS parameters for thermodynamic 
data as well as five special extensions suitable for kinetic data used in the Diffusion Module 
(DICTRA). 

Valid extensions to special GIBBS parameter names are: 

 l MQ: Activation enthalpy for mobility equation. 
 l MF: Pre-exponential factor for mobility equation. 
 l DQ: Activation enthalpy for diffusivity equation. 
 l DF: Pre-exponential factor for diffusivity equation. 
 l VS: Volume counted per mole of volume carrying species. 

Example

See the TDB file for DICTRA example exa4: Carburization of binary Fe-C alloy: 
Comparison to an analytical erf solution. Press F1 in Thermo-Calc to search the 
help for more information.
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DIFFUSION

DIFFUSION [model keyword] [phase name] [additional parameter(s)] ! 

This keyword specifies the type of diffusion model to use for a phase if the default model is 
not desired. The default model calculates the full diffusion matrix. A diffusivity is calculated 
from the different mobilities and the thermodynamic factors. The former ones are 
calculated as: 

M = exp (∑MF/RT) exp (∑MQ/RT) / RT 

where ∑ stands for a weighted summation of the different MF’s and MQ’s plus possibly a 
Redlich-Kister term. 

Valid Model Keywords

Keyword Description

NONE No diffusion in this phase

DILUTE Constitution list of dependent species in each sublattice must be given as an additional parameter. 
Only the diagonal terms in the diffusion matrix are calculated. D = exp (∑ DF/RT) exp (∑DQ/RT).

SIMPLE Constitution list of dependent species in each sublattice must be given as additional parameter. 
Only the diagonal terms in the diffusion matrix are calculated. D = ∑ DF + ∑ DQ.

MAGNETIC

The so-called ALPHA and ALPHA2 parameters must be given as additional parameters. ALPHA is 
for the substitutional magnetic model and ALPHA2 for the interstitial one. By appending an & sign 
and a species name after the alpha keyword one can supply individual values for the different 
species. The full diffusion matrix is calculated.

Examples
DIFFUSION NONE SIGMA ! 

DIFFUSION DILUTE CEMENTITE : FE : C : ! 

DIFFUSION MAGNETIC BCC_A2 ALPHA=0.3 ALPHA2&C=1.8 ALPHA2&N=0.6 ! 
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ZEROVOLUME_SPECIES 

ZEROVOLUME_SPECIES [list of species] ! 

In the Diffusion Module (DICTRA), the assumption that the volume is carried by the 
substitutional elements only is applied. The interstitial elements are assumed to have zero 
molar volumes. This keyword uses a list of which species are to be considered as zero 
volume ones for an argument. 

There is no underscore (_) between Zero and Volume.

Example
ZEROVOLUME_SPECIES VA C N ! 
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Database Definition File Examples
In this section:

Example 1: A Steel Database 67

Example 2: A Custom Database for the Sb-Sn Binary System 69

Example 3: A Public Database for the Fe-Cr-C Ternary System 73
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Example 1: A Steel Database

TEMP-LIM 500.0 2000.0 ! 

$ 

$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 ! 

ELEMENT VA VACUUM            0.0    0.0 0.0 ! 

ELEMENT C  GRAPHITE         12.011  0.0 0.0 ! 

ELEMENT V  BCC              50.9415 0.0 0.0 ! 

ELEMENT CR BCC-PARAMAGNETIC 51.996  0.0 0.0 ! 

ELEMENT FE FCC-PARAMAGNETIC 55.847  0.0 0.0 ! 

ELEMENT NI FCC-PARAMAGNETIC 58.69   0.0 0.0 ! 

ELEMENT MO BCC              95.94   0.0 0.0 ! 

ELEMENT W  BCC             183.85   0.0 0.0 ! 

$ 

$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !

PHASE BCC       B1M  2 1.0 3.0 ! 

PHASE FCC       F2M  2 1.0 1.0 ! 

PHASE HCP       0    2 2.0 1.0 ! 

PHASE LIQUID    3    2 1.0 1.0 ! 

PHASE CEMENTITE 4    2 3.0 1.0 ! 

PHASE M23C6     4    2 23.0 6.0 ! 

PHASE M7C3      4    2 7.0 3.0 ! 

PHASE M6C       4    4 2.0 2.0 2.0 1.0 ! 

PHASE SIGMA     0    3 10.0 4.0 16.0 ! 

PHASE MU-PHASE  0    3 7.0 2.0 4.0 ! 

PHASE R-PHASE   0    3 27.0 14.0 12.0 ! 

PHASE GRAPHITE  4    1 1.0 ! 

$

$CONSTITUENT, PHASE-NAME : CONSTITUENTS ! 

CONSTITUENT BCC :V CR FE NI MO W:VA C: ! 

CONSTITUENT FCC :V CR FE NI MO W:VA C: ! 

CONSTITUENT HCP :CR FE NI:VA C N: ! 

CONSTITUENT LIQUID :C V CR FE NI MO W VA:VA C: ! 

CONSTITUENT CEMENTITE :CR FE:C: ! 

CONSTITUENT M23C6 :CR FE:C: ! 
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CONSTITUENT M7C3 :CR FE:C: ! 

CONSTITUENT M6C :FE:W:FE W:C: ! 

CONSTITUENT SIGMA :FE:V CR MO:FE V CR MO: ! 

CONSTITUENT MU-PHASE :FE:MO W:FE MO W: ! 

CONSTITUENT R-PHASE :FE:MO :FE MO: ! 

CONSTITUENT GRAPHITE :C: ! 

$ 

$TYPE_DEFINITIIONS: 

TYPE-DEFINITION 0 SEQ TCPATH\DATA\METDATA\TC-THEREST.TDB ! 

TYPE-DEFINITION 1 SEQ TCPATH\DATA\METDATA\TC-BCC.TDB ! 

TYPE-DEFINITION 2 SEQ TCPATH\DATA\METDATA\TC-FCC.TDB ! 

TYPE-DEFINITION 3 SEQ TCPATH\DATA\METDATA\TC-LIQUID.TDB ! 

TYPE-DEFINITION 4 SEQ TCPATH\DATA\METDATA\TC-CARBIDES.TDB ! 

TYPE-DEFINITION M SEQ TCPATH\DATA\METDATA\TC-CURIE-BOHR.TDB ! 

TYPE-DEFINITION B GES AM-PH BCC MAGNETIC -1 .4 ! 

TYPE-DEFINITION F GES AM-PH FCC MAGNETIC -3 .28 ! 

$

$DEFAULT_COMMANDS: 

DEFAULT-COMMAND DEF_ELEMENT VA ! 

DEFAULT-COMMAND REJ_SYS-CONST LIQUID 1 VA ! 

$DATABASE_INFORMATION:

DATABASE-INFO The following binary and ternary systems are available: ' 

  FE-CR-NI by Hertzman' 

  FE-MO       Fernandez' 

  FE-CR-C     Andersson' 

  FE-W-C      Gustafson' 

  FE-W        Andersson & Gustafson' ! 
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Example 2: A Custom Database for the Sb-Sn Binary System

$ 

$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 ! 

ELEM VA VACUUM             0.0   0.0 0.0 ! 

ELEM MG HCP(A3)           24.305 0.0 0.0 ! 

ELEM SB RHOMBOHEDRAL(A7) 121.75  0.0 0.0 ! 

ELEM SN BCT(A5)          118.69  0.0 0.0 ! 

ELEM /- ELECTRON-GAS       0     0   0 ! 

$

$SPECIES, NAME, STOICHIOMETRIC-FORMULA !

SPECIE MG1 MG1! 

SPECIE MG2 MG2! 

SPECIE MG2+ MG/+2! 

SPECIE SB1 SB1! 

SPECIE SB2 SB2! 

SPECIE SB4 SB4! 

SPECIE SB3- SB/-3! 

SPECIE SB5- SB/-5! 

SPECIE SN1 SN1! 

SPECIE SN4- SN/-4! 

$ 

$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !

PHASE BCT        Z 1 1.0! 

PHASE HCP        Z 1 1.0! 

PHASE RHOMBO     Z 1 1.0! 

PHASE GAS:G      Z 1 1.0! 

PHASE LIQUID:L   Z 1 1.0! 

PHASE IONICLIQ:Y Z 2 1 1! 

PHASE SPLIQ:Y    Z 2 1 1! 

PHASE BMG3SB2:I  Z 2 3 2! 

PHASE AMG3SB2:I  Z 2 3 2! 

PHASE MG2SN:I    Z 2 2 1! 

PHASE SBSN       Z 2 1 1! 

PHASE SB2SN3     Z 2 2 3! 
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$ 

$CONSTITUENT, PHASE-NAME : CONSTITUENTS ! 

CONSTITUENT RHOMBO :SB SN:! 

CONSTITUENT HCP :MG SN:! 

CONSTITUENT BCT :SB SN:! 

CONSTITUENT GAS:G :MG1 MG2 SB1 SB2 SB4 SN1:

  > Gas phase, using the Ideal EOS and Mixing Model. ! 

CONSTITUENT LIQUID:L :SB SN:! 

CONSTITUENT IONICLIQ:Y :MG2+:SB SB3- SN SN4- VA: 

  > This is the Ionic Liquid Solution Phase. ! 

CONSTITUENT SPLIQ:Y :MG2+:SB SB3- SN SN4- VA:! 

CONSTITUENT BMG3SB2:I :MG2+:SB3- SB5- VA SN4-:! 

CONSTITUENT AMG3SB2:I :MG2+:SB3- VA SN4-:! 

CONSTITUENT MG2SN:I :MG2+ VA:SB3- SN4-:! 

CONSTITUENT SBSN :SB SN:SB SN:! 

CONSTITUENT SB2SN3 :SB:SN:! 

$ 

$DEFAULT_COMMANDS: 

DEFAULT-COM DEF-ELEM VA /-! 

DEFAULT-COM REJ-PHASE LIQUID! 

DEFAULT-COM REJ-PHASE SPLIQ! 

$ 

$TYPE_DEFINITIIONS: 

TYPE-DEFINITION Z SEQ * ! 

$ 

$DATABASE_INFORMATION:

DATABASE_INFO The Sb-Sn system with isentropic temperatures! 

$ 

$VERSION_DATE:

VERSION_DATE Last update 1986-05-18 11:39:49 ! 

$ 

$ 

$ HERE COMES THE THERMODYNAMIC DATA (expressed in functions & 
parameters): 

$ 

FUNCTION MGLIQUID 298.15 -4630.90976+192.994374*T-34.0888057*T*LOG(T) 
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   -36544605.6*T**(-2); 6000 N! 

$ 

FUNCTION MGSOLID 298.15 -8367.34+143.677876*T-26.1849785*T*LOG(T) 

   +4.858E-4*T**2-1.393669E-6*T**3+78950*T**(-1); 

    923.00 Y -13804.4772 +202.909445*T-34.0888057*T*LOG(T)

   -3.65446056E7*T**(-2) +1.06753982E28*T**(-9); 6000 N! 

$ 

FUNCTION SBLIQUID 298.15 9071.98+146.800*T-31.38*T*LOG(T) 

   -2.441646E8*T**(-2); 6000 N! 

$ 

..... 

..... <more>

$ 

FUNCTION LFCT 298.15 -17325.6+5.03600*T; 6000 N! 

FUNCTION GFCTSBSN 298.15 LFCT+SBSOLID+SNSOLID+2948.291+3721.286; 

   6000 N! 

FUNCTION ISB 298.15 15000; 6000 N! 

FUNCTION ISN 298.15 47199.9-95.6270*T; 6000 N! 

$ 

..... 

..... <more>

$ 

PARAMETER G(RHOMBO,SB;0) 298.15 SBSOLID; 6000 N! 

PARAMETER G(RHOMBO,SN;0) 298.15 2035+SNSOLID; 6000 N! 

$ 

PARAMETER G(HCP,MG;0) 298.15 MGSOLID; 6000 N! 

PARAMETER G(HCP,SN;0) 298.15 32000+SNSOLID; 6000 N! 

PARAMETER G(HCP,MG,SN;0) 298.15 -69566-9.23183*T; 6000 N! 

$ 

PARAMETER G(BCT,SN;0) 298.15 SNSOLID; 6000 N! 

PARAMETER G(BCT,SB;0) 298.15 1000+SBSOLID; 6000 N! 

PARAMETER G(BCT,SB,SN;0) 298.15 0.5*ISB+0.5*ISN; 6000 N! 

PARAMETER G(BCT,SB,SN;1) 298.15 0.5*ISB-0.5*ISN; 6000 N! 

$ 

PARAMETER G(IONICLIQ,MG2+:SB3-;0) 298.15 -204389-4.98506*T 

   -2.75637E9*T**(-2)+3*MGLIQUID+2*SBLIQUID; 6000 N! 
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PARAMETER G(IONICLIQ,MG2+:SN4-;0) 298.15 -98639.5+881.073*T 

   -174.523*T*LOG(T)-1.79808E9*T**(-2); 6000 N! 

PARAMETER G(IONICLIQ,MG2+:SB;0) 298.15 SBLIQUID; 6000 N! 

$ 

...... 

...... <more>

$ 
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Example 3: A Public Database for the Fe-Cr-C Ternary 
System

$ 

$   Revision history: 

$       Created as PDEMO  by Pingfang Shi  on 2004-10-05

$       Renamed to DFeCrC by Pingfang Shi  on 2006-10-25

$

$ FURTHER MODIFICATIONS:

$ ======================

$ pfs: /20041005 (PDEMO)

$       * Retrieved all definitions from PTERN for the Fe-Cr-C ternary !

$

$ pfs: /20061025 (DFeCrC)

$       * Ignore ELEMENT /- definition.

$       * Modify the L(BCC_A2,FE:C,VA;0) [and L(BCC_A2,CR:C,VA;0)] 

$         parameters, in order to avoid BCC-appearance (Fe-C) 

$         at temperatures higher than 3900 K.

$           $L(BCC_A2,CR:C,VA;0) 298.15 -190*T;           6000 N REF1 !

$            L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REF1 !

$           $L(BCC_A2,FE:C,VA;0) 298.15 -190*T;           6000 N REF3 !

$            L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REF3 !

$       * Add Cr into HCP_A3 phase, and 

$         add all necessary G0/L parameters (according to SSOL2/TCFE3):

$           G(HCP_A3,CR:VA;0) 

$           TC(HCP_A3,CR:VA;0)    

$           BMAGN(HCP_A3,CR:VA;0) 

$           G(HCP_A3,FE:C;0) 

$           G(HCP_A3,CR:C;0) 

$           L(HCP_A3,CR:C,VA;0)  

$           L(HCP_A3,CR,FE:VA;0) 

$       * Add "TMM:300/3000" limits to all three binary joins in the  

$           ASSESSED_SYSTEM section.

$       * Change the reference indices, e.g., 101 to REF1, in order to 

$           always get the reference list correctly. 
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$       * Re-arrange database format slightly.

$       * Updated the DATABASE_INFO section. 

$------------------------------------------------------------------------

$

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ DATABASE INFORMATION: 

$************************************************************************

$ 

DATABASE_INFO                                   DFeCrC '

                TCS Demo Fe-Cr-C Alloy Solutions Database' 

         (only for demonstration purposes in TCC-Demo/TCW-Demo)'

      ************************************************************ '

                        (Version 1.2, Oct. 2006) ''

         Copyright @ 2004-2012: Thermo-Calc Software AB, Sweden ''

The DFeCrC database (previously called PDEMO) is the TCS Demo Fe-Cr-C '

Alloy Solutions Database, which is especially designed for primarily '

demonstrating the uses of: '

  * TCC-Demo software: BIN, TERN, SCHEIL and some other modules; '

  * TCW-Demo software: '

     "Binary" module calculations of phase diagrams and property 
diagrams'

                 in available binary systems; '

     "Ternary" module calculations of phase diagrams (e.g., isothermal' 

                 sections, monovariant lines involving liquid, liquidus'

                 surface projections) and property diagrams in available'

                 ternary systems; '

     "Scheil" module simulations of alloy solidifications; and/or '

     "Equilibrium" calculation routines for phase diagrams and property'

                 diagrams in available binary or ternary systems. '

It can also be used for other types of calculations/simulations in both'

TCC and TCW software, and in their application programming interfaces.''

It includes critically-assessed data for all possible three binary joins'

(i.e. Cr-C, Fe-Cr and Fe-Cr) and one complete ternary alloy solutions '

within the Fe-Cr-C system. However, due to the fact that experimental'

data for the Fe-C and Cr-C binary joins and Fe-Cr-C ternary system at '

extremely-high temperatures are not sufficient, the available assessed'
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data can not be applied to temperature conditions higher than 4000 K.''

Included thermodynamic data are available for various stoichiometric '

and solution phases, e.g. liquid mixture, various alloy solutions and ' 

intermetallic phases. But the gaseous mixture phase is excluded in this'

DEMO version.''

The DFeCrC database can be used not only in calculating various types '

of phase diagrams (binary phase diagrams, ternary isothermal sections,'

ternary monovariant lines involving liquid, ternary liquidus surface '

projections, ternary isopleth sections, etc.) and property diagrams '

(the easiest ways are through the BIN and TERN modules), but also in '

simulating alloy solidification processes (with the SCHEIL module) of'

Fe-based or Cr-based alloys (but limited within the Fe-Cr-C ternary '

system in this DEMO version). Many unique features of the TCC/TCW '

software can be demonstrated using this and other specially-designed '

DEMO databases. '' 

However, this DFeCrC database (similar to other DEMO and/or PUBLIC TC '

databases) is provided within the TCC-Demo/TCW-Demo software only for '

the purposes of demonstration, testing and evaluation. For R&D projects'

and teaching activities, you are highly encouraged to only use the FULL'

versions of the TCC and/or TCW software together with some commercial '

databases that are appropriate for your specific applications. Please '

contact us for all kinds of details. ''

Release History: Version 1.1 with minor improvements,  Oct. 2004 '

                 Version 1.2 with minor modifications, Oct. 2006 ''

Edited by: Dr. Pingfang Shi (Thermo-Calc Software, Oct. 2006). ''

!

 

$ -----------------------------------------------------------------------

$VERSION_DATE Last update and adjustment: Pingfang Shi, 2004-10-05 !

VERSION_DATE Last update and adjustment: Pingfang Shi, 2006-10-25 !

 

$

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ Definition of Elements in the Database System:  

$------------------------------------------------------------------------

$ELEM NAME STABLE_ELEMENT_REF         ATOMIC MASS  H298-H0     S298 !
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$------------------------------------------------------------------------

$ELEMENT /-   ELECTRON_GAS            0.0000E+00  0.0000E+00  0.0000E+00!

ELEMENT VA   VACUUM                  0.0000E+00  0.0000E+00  0.0000E+00!

ELEMENT C    GRAPHITE                1.2011E+01  1.0540E+03  5.7400E+00!

ELEMENT CR   BCC_A2                  5.1996E+01  4.0500E+03  2.3560E+01!

ELEMENT FE   BCC_A2                  5.5847E+01  4.4890E+03  2.7280E+01!

 

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ TYPE_DEFINITIONS for data inclusions:

$------------------------------------------------------------------------

TYPE_DEFINITION % SEQ *!

 

$  

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$  TYPE_DEFINITIONS for phase descriptions: 

$------------------------------------------------------------------------

$... For magnetic contributions: 

TYPE_DEFINITION A GES AMEND_PHASE_DES @ MAGNETIC  -1.0  4.00000E-01 !

TYPE_DEFINITION B GES AMEND_PHASE_DES @ MAGNETIC  -3.0  2.80000E-01 !

  

$... For Cr/Fe-C in FCC phase and Cr/Fe-C in HCP phase: 

TYPE_DEFINITION C IF(C) THEN GES AMEND_PHASE_DES @ C_S ,, :C: !

 

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ Default Commands:

$------------------------------------------------------------------------

$DEFINE_SYSTEM_DEFAULT SPECIES 2 !

DEFINE_SYSTEM_DEFAULT ELEMENT 2 !

 

DEFAULT_COMMAND DEF_SYS_ELEMENT VA !

 

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ FUNCTIONS for various phases:  
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$------------------------------------------------------------------------

$

FUNCT GHSERCC  298.15 -17368.441+170.73*T-24.3*T*LN(T)

     -4.723E-04*T**2+2562600*T**(-1)-2.643E+08*T**(-2)

     +1.2E+10*T**(-3); 6000 N!

FUNCT GHSERCR  298.15 -8856.94+157.48*T-26.908*T*LN(T)

     +.00189435*T**2-1.47721E-06*T**3+139250*T**(-1);  2180 Y

      -34869.344+344.18*T-50*T*LN(T)-2.88526E+32*T**(-9); 6000 N!

FUNCT GHSERFE  298.15 +1225.7+124.134*T-23.5143*T*LN(T)

     -.00439752*T**2-5.8927E-08*T**3+77359*T**(-1);  1811.00 Y

     -25383.581+299.31255*T-46*T*LN(T)+2.29603E+31*T**(-9); 6000 N!

 

FUNCT GFELIQ   298.15 +GHSERFE#+12040.17-6.55843*T

     -3.6751551E-21*T**7;  1811 Y

      -10839.7+291.302*T-46*T*LN(T);  6000 N!

FUNCT GFEFCC   298.15 +GHSERFE#-1462.4+8.282*T

     -1.15*T*LN(T)+6.4E-04*T**2;  1811 Y

      -27098.266+300.25256*T-46*T*LN(T)+2.78854E+31*T**(-9);  6000 N!

FUNCT GFECEM   298.15 +GPCEM1#-10745+706.04*T-120.6*T*LN(T); 6000 N!

FUNCT GFEM23C6  298.15 +7.666667*GFECEM#-1.666667*GHSERCC#

     +66920-40*T; 6000 N!

 

FUNCT GCRFCC   298.15 +GHSERCR#+7284+.163*T;  6000 N!

FUNCT GCRM23C6 298.15 -521983+3622.24*T-620.965*T*LN(T)

     -.126431*T**2;   6000 N!

FUNCT GCRM3C2  298.15 -100823.8+530.66989*T-89.6694*T*LN(T)

     -.0301188*T**2;  6000 N!

FUNCT GCRM7C3  298.15 -201690+1103.128*T-190.177*T*LN(T)

     -.0578207*T**2;  6000 N!

 

FUNCT GPCLIQ   298.15 +YCLIQ#*EXP(ZCLIQ#);    6000 N!

FUNCT ACLIQ    298.15 +2.32E-05*T+2.85E-09*T**2;  6000 N!

FUNCT BCLIQ    298.15 +1+3.2E-10*P;               6000 N!

FUNCT CCLIQ    298.15 1.6E-10;                    6000 N!

FUNCT DCLIQ    298.15 +1*LN(BCLIQ#);              6000 N!

FUNCT ECLIQ    298.15 +1*LN(CCLIQ#);              6000 N!
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FUNCT VCLIQ    298.15 +7.626E-06*EXP(ACLIQ#);     6000 N!

FUNCT XCLIQ    298.15 +1*EXP(.5*DCLIQ#)-1;        6000 N!

FUNCT YCLIQ    298.15 +VCLIQ#*EXP(-ECLIQ#);       6000 N!

FUNCT ZCLIQ    298.15 +1*LN(XCLIQ#);              6000 N!

 

FUNCT GPCGRA   298.15 +YCGRA#*EXP(ZCGRA#);    6000 N!

FUNCT ACGRA    298.15 +2.32E-05*T+2.85E-09*T**2;  6000 N!

FUNCT BCGRA    298.15 +1+3.6E-10*P;               6000 N!

FUNCT CCGRA    298.15 3.3E-10;                    6000 N!

FUNCT DCGRA    298.15 +1*LN(BCGRA#);              6000 N!

FUNCT ECGRA    298.15 +1*LN(CCGRA#);              6000 N!

FUNCT VCGRA    298.15 +5.259E-06*EXP(ACGRA#);     6000 N!

FUNCT XCGRA    298.15 +1*EXP(.9166667*DCGRA#)-1;  6000 N!

FUNCT YCGRA    298.15 +VCGRA#*EXP(-ECGRA#);       6000 N!

FUNCT ZCGRA    298.15 +1*LN(XCGRA#);              6000 N!

 

FUNCT GPCFCC   298.15 +YCFCC#*EXP(ZFEFCC#);   6000 N!

FUNCT ACFCC    298.15 +1.44E-04*T;              6000 N!

FUNCT VCFCC    298.15 +1.031E-05*EXP(ACFCC#);   6000 N!

FUNCT YCFCC    298.15 +VCFCC#*EXP(-EFEFCC#);    6000 N!

 

FUNCT GPCRLIQ  298.15 +YCRLIQ#*EXP(ZCRLIQ#);    6000 N!

FUNCT ACRLIQ   298.15 +1.7E-05*T+9.2E-09*T**2;  6000 N!

FUNCT BCRLIQ   298.15 +1+4.65E-11*P;            6000 N!

FUNCT CCRLIQ   298.15 3.72E-11;                 6000 N!

FUNCT DCRLIQ   298.15 +1*LN(BCRLIQ#);           6000 N!

FUNCT ECRLIQ   298.15 +1*LN(CCRLIQ#);           6000 N!

FUNCT VCRLIQ   298.15 +7.653E-06*EXP(ACRLIQ#);  6000 N!

FUNCT XCRLIQ   298.15 +1*EXP(.8*DCRLIQ#)-1;     6000 N!

FUNCT YCRLIQ   298.15 +VCRLIQ#*EXP(-ECRLIQ#);   6000 N!

FUNCT ZCRLIQ   298.15 +1*LN(XCRLIQ#);           6000 N!

 

FUNCT GPCRBCC  298.15 +YCRBCC#*EXP(ZCRBCC#);  6000 N!

FUNCT ACRBCC   298.15 +1.7E-05*T+9.2E-09*T**2;  6000 N!

FUNCT BCRBCC   298.15 +1+2.6E-11*P;             6000 N!

FUNCT CCRBCC   298.15 2.08E-11;                 6000 N!
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FUNCT DCRBCC   298.15 +1*LN(BCRBCC#);           6000 N!

FUNCT ECRBCC   298.15 +1*LN(CCRBCC#);           6000 N!

FUNCT VCRBCC   298.15 +7.188E-06*EXP(ACRBCC#);  6000 N!

FUNCT XCRBCC   298.15 +1*EXP(.8*DCRBCC#)-1;     6000 N!

FUNCT YCRBCC   298.15 +VCRBCC#*EXP(-ECRBCC#);   6000 N!

FUNCT ZCRBCC   298.15 +1*LN(XCRBCC#);           6000 N!

 

FUNCT GPFELIQ  298.15 +YFELIQ#*EXP(ZFELIQ#);  6000 N!

FUNCT AFELIQ   298.15 +1.135E-04*T;                           6000 N!

FUNCT BFELIQ   298.15 +1+4.98009787E-12*P+3.20078924E-14*T*P; 6000 N!

FUNCT CFELIQ   298.15 +4.22534787E-12+2.71569924E-14*T;       6000 N!

FUNCT DFELIQ   298.15 +1*LN(BFELIQ#);                         6000 N!

FUNCT EFELIQ   298.15 +1*LN(CFELIQ#);                         6000 N!

FUNCT VFELIQ   298.15 +6.46677E-06*EXP(AFELIQ#);              6000 N!

FUNCT XFELIQ   298.15 +1*EXP(.8484467*DFELIQ#)-1;             6000 N!

FUNCT YFELIQ   298.15 +VFELIQ#*EXP(-EFELIQ#);                 6000 N!

FUNCT ZFELIQ   298.15 +1*LN(XFELIQ#);                         6000 N!

 

FUNCT GPFEFCC  298.15 +YFEFCC#*EXP(ZFEFCC#);  6000 N!

FUNCT AFEFCC   298.15 +7.3097E-05*T;                          6000 N!

FUNCT BFEFCC   298.15 +1+3.25236341E-11*P+3.36607808E-16*T*P; 6000 N!

FUNCT CFEFCC   298.15 +2.62285341E-11+2.71455808E-16*T;       6000 N!

FUNCT DFEFCC   298.15 +1*LN(BFEFCC#);                         6000 N!

FUNCT EFEFCC   298.15 +1*LN(CFEFCC#);                         6000 N!

FUNCT VFEFCC   298.15 +6.688726E-06*EXP(AFEFCC#);             6000 N!

FUNCT XFEFCC   298.15 +1*EXP(.8064454*DFEFCC#)-1;             6000 N!

FUNCT YFEFCC   298.15 +VFEFCC#*EXP(-EFEFCC#);                 6000 N!

FUNCT ZFEFCC   298.15 +1*LN(XFEFCC#);                         6000 N!

 

FUNCT GPFEBCC  298.15 +YFEBCC#*EXP(ZFEBCC#);  6000 N!

FUNCT AFEBCC   298.15 +2.3987E-05*T+1.2845E-08*T**2;          6000 N!

FUNCT BFEBCC   298.15 +1+2.80599565E-11*P+3.06481523E-16*T*P; 6000 N!

FUNCT CFEBCC   298.15 +2.20949565E-11+2.41329523E-16*T;       6000 N!

FUNCT DFEBCC   298.15 +1*LN(BFEBCC#);                         6000 N!

FUNCT EFEBCC   298.15 +1*LN(CFEBCC#);                         6000 N!

FUNCT VFEBCC   298.15 +7.042095E-06*EXP(AFEBCC#);             6000 N!
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FUNCT XFEBCC   298.15 +1*EXP(.7874195*DFEBCC#)-1;             6000 N!

FUNCT YFEBCC   298.15 +VFEBCC#*EXP(-EFEBCC#);                 6000 N!

FUNCT ZFEBCC   298.15 +1*LN(XFEBCC#);                         6000 N!

 

FUNCT GPFEHCP  298.15 +YFEHCP#*EXP(ZFEHCP#);  6000 N!

FUNCT AFEHCP 298.15 +7.3646E-5*T;                           6000 N!

FUNCT BFEHCP 298.15 +1+32.5236341E-12*P+3.36607808E-16*P*T; 6000 N!

FUNCT CFEHCP 298.15 +26.2285341E-12+2.71455808E-16*T;       6000 N!

FUNCT DFEHCP 298.15 +LOG(BFEHCP#);                          6000 N!

FUNCT EFEHCP 298.15 +LOG(CFEHCP#);                          6000 N!

FUNCT VFEHCP 298.15 +6.59121E-6*EXP(AFEHCP#);               6000 N!

FUNCT XFEHCP 298.15 +EXP(0.8064454*DFEHCP#)-1;              6000 N!

FUNCT YFEHCP 298.15 +VFEHCP#*EXP(-1*EFEHCP#);               6000 N!

FUNCT ZFEHCP 298.15 +LOG(XFEHCP#);                          6000 N!

 

FUNCT GPCEM1   298.15 +VCEM1#*P;     6000 N!

FUNCT ACEM1    298.15 -1.36E-05*T+4E-08*T**2;    6000 N!

FUNCT VCEM1    298.15 +2.339E-05*EXP(ACEM1#);    6000 N!

 

FUNCT GPSIG1   298.15 +1.09E-04*P;        6000 N!

FUNCT GPSIG2   298.15 +1.117E-04*P;       6000 N!

 

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ Define the various Phase and their Constituents, and 

$ Assign parameters to phases:

$------------------------------------------------------------------------

$PHASE  NAME:TYPE  MARKCODE  #SUBL  SITES_IN_EACH_SUBL. !

$------------------------------------------------------------------------

 

$***** LIQUID (Solution) ************************************************

PHASE LIQUID:L %  1  1.0  

  > This is metallic liquid solution phase, with C species !

CONST LIQUID:L  : C,CR,FE :  !

 

PARAM G(LIQUID,C;0)  298.15 +GHSERCC#+GPCLIQ#
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                               +117369-24.63*T; 6000 N REF0 !

PARAM G(LIQUID,CR;0)  298.15 +GHSERCR#+GPCRLIQ#

                  +24339.955-11.420225*T+2.37615E-21*T**7;  2180 Y

                              +GHSERCR#+GPCRLIQ#

                  +18409.36-8.563683*T+2.88526E+32*T**(-9); 6000 N REF0 !

PARAM G(LIQUID,FE;0)  298.15 +GFELIQ#+GPFELIQ#;  6000 N REF0 !

 

PARAM L(LIQUID,C,CR;0)  298.15 -90526-25.9116*T; 6000 N REF1 !

PARAM L(LIQUID,C,CR;1)  298.15 +80000;           6000 N REF1 !

PARAM L(LIQUID,C,CR;2)  298.15 +80000;           6000 N REF1 !

PARAM L(LIQUID,C,FE;0)  298.15 -124320+28.5*T;  6000 N REF3 !

PARAM L(LIQUID,C,FE;1)  298.15  +19300;         6000 N REF3 !

PARAM L(LIQUID,C,FE;2)  298.15  +49260-19*T;    6000 N REF3 !

PARAM L(LIQUID,CR,FE;0)  298.15 -14550+6.65*T;   6000 N REF4 !

PARAM L(LIQUID,C,CR,FE;0)  298.15 -496063;  6000 N REF2 !

PARAM L(LIQUID,C,CR,FE;1)  298.15  +57990;  6000 N REF2 !

PARAM L(LIQUID,C,CR,FE;2)  298.15  +61404;  6000 N REF2 !

 

$***** FCC_A1 (Solution) ************************************************

$PHASE FCC_A1  %BC  2 1   1 !

$ Note the C TYPE_DEF for 2nd FCC composition-set (MC) is not necessary 

$    for the (Fe,Cr)-C system. 

PHASE FCC_A1  %B   2 1   1 !

CONST FCC_A1  : CR,FE% 

               : C,VA% :  !

 

PARAM G(FCC_A1,CR:VA;0)  298.15 +GCRFCC#+GPCRBCC#;  6000 N REF0 !

PARAM TC(FCC_A1,CR:VA;0)     298.15 -1109;  6000 N REF0 !

PARAM BMAGN(FCC_A1,CR:VA;0)  298.15 -2.46;  6000 N REF0 !

PARAM G(FCC_A1,FE:VA;0)  298.15 +GFEFCC#+GPFEFCC#;  6000 N REF0 !

PARAM TC(FCC_A1,FE:VA;0)     298.15 -201;  6000 N REF0 !

PARAM BMAGN(FCC_A1,FE:VA;0)  298.15 -2.1;  6000 N REF0 !

 

PARAM G(FCC_A1,CR:C;0)  298.15 +GHSERCR#+GHSERCC#

                                  +1200-1.94*T;     6000 N REF2 !

PARAM G(FCC_A1,FE:C;0)  298.15 +GFEFCC#+GHSERCC#+GPCFCC#
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                                  +77207-15.877*T;  6000 N REF3 !

PARAM TC(FCC_A1,FE:C;0)     298.15 -201;  6000 N REF3 !

PARAM BMAGN(FCC_A1,FE:C;0)  298.15 -2.1;  6000 N REF3 !

 

PARAM L(FCC_A1,CR:C,VA;0)  298.15 -11977+6.8194*T; 6000 N REF2 !

PARAM L(FCC_A1,FE:C,VA;0)  298.15 -34671;          6000 N REF3 !

PARAM L(FCC_A1,CR,FE:VA;0) 298.15 +10833-7.477*T;  6000 N REF4 !

PARAM L(FCC_A1,CR,FE:VA;1) 298.15  +1410;          6000 N REF4 !

PARAM L(FCC_A1,CR,FE:C;0)  298.15 -74319+3.2353*T; 6000 N REF2 !

 

$***** BCC_A2 (Solution) ************************************************

PHASE BCC_A2  %A  2 1   3 !

CONST BCC_A2  : CR%,FE%

               : C,VA% :  !

 

PARAM G(BCC_A2,CR:VA;0)  298.15 +GHSERCR#+GPCRBCC#;  6000 N REF0 !

PARAM TC(BCC_A2,CR:VA;0)     298.15 -311.5;  6000 N REF0 !

PARAM BMAGN(BCC_A2,CR:VA;0)  298.15   -.01;  6000 N REF0 !

PARAM G(BCC_A2,FE:VA;0)  298.15 +GHSERFE#+GPFEBCC#;  6000 N REF0 !

PARAM TC(BCC_A2,FE:VA;0)     298.15 1043;  6000 N REF0 !

PARAM BMAGN(BCC_A2,FE:VA;0)  298.15 2.22;  6000 N REF0 !

 

PARAM G(BCC_A2,CR:C;0)  298.15 +GHSERCR#+3*GHSERCC#+GPCRBCC#+3*GPCGRA#

                                  +416000;            6000 N REF1 !

PARAM TC(BCC_A2,CR:C;0)     298.15 -311.5;  6000 N REF1 !

PARAM BMAGN(BCC_A2,CR:C;0)  298.15  -.008;  6000 N REF1 !

PARAM G(BCC_A2,FE:C;0)  298.15 +GHSERFE#+3*GHSERCC#+GPFEBCC#+3*GPCGRA#

                                  +322050+75.667*T;   6000 N REF3 !

PARAM TC(BCC_A2,FE:C;0)     298.15 1043;  6000 N REF3 !

PARAM BMAGN(BCC_A2,FE:C;0)  298.15 2.22;  6000 N REF3 !

 

$ PF-20061025: Modify the L(BCC_A2,FE:C,VA;0) [and L(BCC_A2,CR:C,VA;0)] 

$         parametera, in order to avoid BCC-appearance (Fe-C) 

$         at temperatures higher than 3900 K.

$PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T;           6000 N REF1 !

PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REFS !
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$PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T;           6000 N REF3 !

PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REFS !

$

PARAM L(BCC_A2,CR,FE:VA;0) 298.15 +20500-9.68*T;   6000 N REF4 !

PARAM TC(BCC_A2,CR,FE:VA;0)     298.15 1650;  6000 N REF4 !

PARAM TC(BCC_A2,CR,FE:VA;1)     298.15  550;  6000 N REF4 !

PARAM BMAGN(BCC_A2,CR,FE:VA;0)  298.15 -.85;  6000 N REF4 !

 

PARAM L(BCC_A2,CR,FE:C;0)  298.15 -1250000+667.7*T; 6000 N REF2 !

PARAM TC(BCC_A2,CR,FE:C;0)    298.15 1650;  6000 N REF5 !

PARAM TC(BCC_A2,CR,FE:C;1)    298.15  550;  6000 N REF5 !

PARAM BMAGN(BCC_A2,CR,FE:C;0) 298.15 -.85;  6000 N REF5 !

 

$***** HCP_A3 (Solution) ************************************************

$PHASE HCP_A3  %BC  2 1   .5 !

$ Note the C TYPE_DEF for 2nd HCP composition-set (M2C) is not necessary 

$    for the (Fe,Cr)-C system. 

PHASE HCP_A3  %B   2 1   .5 !

CONST HCP_A3  : CR,FE,

               : VA%,C :  !

 

PARAM G(HCP_A3,CR:VA;0) 298.15 +GHSERCR#+4438;           6000 N REF1 !

PARAM TC(HCP_A3,CR:VA;0)    298.15 -1109;  6000 N REF1 !

PARAM BMAGN(HCP_A3,CR:VA;0) 298.15 -2.46;  6000 N REF1 !

PARAM G(HCP_A3,FE:VA;0) 298.15 +GHSERFE#+GPFEHCP#

               -3705.78+12.591*T-1.15*T*LN(T)+6.4E-04*T**2; 1811 Y

                                +GHSERFE#+GPFEHCP#

               -3957.199+5.24951*T+4.9251E+30*T**(-9);      6000 N REF0 !

PARAM G(HCP_A3,CR:C;0) 298.15 +GHSERCR#+.5*GHSERCC#

               -18504+9.4173*T-2.4997*T*LN(T)+.001386*T**2; 6000 N REF1 !

PARAM G(HCP_A3,FE:C;0) 298.15 +GFEFCC#+.5*GHSERCC#+GPCFCC#

                                 +52905-11.9075*T;          6000 N REF3 !

 

PARAM L(HCP_A3,CR:C,VA;0)  298.15  +4165;  6000 N REF1 !

PARAM L(HCP_A3,FE:C,VA;0)  298.15 -22126;  6000 N REF3 !

$PARAM L(HCP_A3,FE:C,VA;0)  298.15 -17335;  6000 N TCFE3 !
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PARAM L(HCP_A3,CR,FE:VA;0) 298.15 +10833-7.477*T; 6000 N REF4 ! 

 

$***** SIGMA (Solution) *************************************************

PHASE SIGMA  %  3 8   4   18 !

CONST SIGMA  : FE 

              : CR 

              : CR,FE :  !

 

PARAM G(SIGMA,FE:CR:CR;0)  298.15 +8*GFEFCC#+22*GHSERCR#

                                +92300-95.96*T+GPSIG1#;   6000 N REF4 !

PARAM G(SIGMA,FE:CR:FE;0)  298.15 +8*GFEFCC#+4*GHSERCR#+18*GHSERFE#

                                +117300-95.96*T+GPSIG2#;  6000 N REF4 !

 

$***** CEMENTITE (Solution) *********************************************

PHASE CEMENTITE  %  2 3   1 !

CONST CEMENTITE  : CR,FE% 

                  : C :  !

 

PARAM G(CEMENTITE,CR:C;0)  298.15 +3*GHSERCR#+GHSERCC#

                                     -48000-9.2888*T; 6000 N REF2 !

PARAM G(CEMENTITE,FE:C;0)  298.15 +GFECEM#;          6000 N REF3 !

 

PARAM L(CEMENTITE,CR,FE:C;0)  298.15 +25278-17.5*T;  6000 N REF2 !

 

$***** M3C2 (Compound) **************************************************

PHASE M3C2  %  2 3   2 !

CONST M3C2  : CR 

             : C :  !

 

PARAM G(M3C2,CR:C;0)  298.15 +GCRM3C2#;  6000 N REF2 !

 

$***** M7C3 (Solution) **************************************************

PHASE M7C3  %  2 7   3 !

CONST M7C3  : CR%,FE 

             : C :  !
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PARAM G(M7C3,CR:C;0)  298.15 +GCRM7C3#;          6000 N REF2 !

PARAM G(M7C3,FE:C;0)  298.15 +7*GHSERFE#+3*GHSERCC#

                                +75000-48.2168*T; 6000 N REF2 !

 

PARAM L(M7C3,CR,FE:C;0)  298.15 -4520-10*T;  6000 N REF2 !

 

$***** M23C6 (Solution) *************************************************

PHASE M23C6  %  3 20   3   6 !

CONST M23C6  : CR%,FE% 

              : CR%,FE% 

              : C :  !

 

PARAM G(M23C6,CR:CR:C;0)  298.15 +GCRM23C6#;           6000 N REF5 !

PARAM G(M23C6,FE:CR:C;0)  298.15 +.1304348*GCRM23C6#

                                   +.8695652*GFEM23C6#; 6000 N REF5 !

PARAM G(M23C6,CR:FE:C;0)  298.15 +.8695652*GCRM23C6#

                                   +.1304348*GFEM23C6#; 6000 N REF5 !

PARAM G(M23C6,FE:FE:C;0)  298.15 +GFEM23C6#;           6000 N REF5 !

 

PARAM L(M23C6,CR,FE:CR:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !

PARAM L(M23C6,CR,FE:FE:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !

 

$***** GRAPHITE (Compound) **********************************************

PHASE GRAPHITE  %  1  1.0  !

CONST GRAPHITE  : C :  !

 

PARAM G(GRAPHITE,C;0)  298.15 +GHSERCC#+GPCGRA#; 6000 N REF0 !

 

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ ASSESSED_SYSTEMS information:  

$    *  necessary for the BIN and TERN modules in TCC

$                      the Binary Phase Diagram module in TCW

$                  and the Equilibrium calculation routine in TCW

$------------------------------------------------------------------------

ASSESSED_SYSTEM 
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$... Binary ...

  C-FE(;P3 TMM:300/4000 *) 

  C-CR(;P3 TMM:300/4000 *) 

  CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA 

        ;P3 TMM:300/3000 STP:.6/1200/1/-2/2) 

$ CR-FE(TDB -HCP ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA 

$       ;P3 TMM:300/3000 STP:.6/1200/1/-2/2) 

$

$... Ternary ...

  C-CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA 

          ;P3 STP:.4/.5/1 STP:0.1/0.5/1) 

!

 

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ 

$ LIST OF REFERENCE:  

$

$------------------------------------------------------------------------

LIST_OF_REFERENCES

NUMBER  SOURCE

REF0 'Alan Dinsdale, SGTE Data for Pure Elements, Calphad Vol 15(1991) 

       p 317-425, also in NPL Report DMA(A)195 Rev. August 1990'

REF1 'J-O Andersson, Calphad Vol 11 (1987) p 271-276, TRITA 0314; C-CR'

REF2 'Byeong-Joo Lee, unpublished revision (1991); C-Cr-Fe-Ni'

REF3 'P. Gustafson, Scan. J. Metall. vol 14, (1985) p 259-267 

       TRITA 0237 (1984); C-FE'

REF4 'J-O Andersson, B. Sundman, CALPHAD Vol 11, (1987), p 83-92 

       TRITA 0270 (1986); CR-FE'

REF5 'J-O Andersson, Met. Trans A, Vol 19A, (1988) p 627-636 

       TRITA 0207 (1986); C-CR-FE'

REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys Database, 

       v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters 

       at high temperatures.'

!
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Database Checker
In this section:

About the Database Checker 88

Using the Database Checker 90
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About the Database Checker

The Thermo-Calc software package includes a program to check that the syntax of 
unencrypted database files is correct. The program applies the syntax rules set out in the 
Database Manager User Guide and reports errors and issues warnings. This program is 
intended for advanced users who develop and manage databases. 

Thermo-Calc  accepts some deviations from these syntax rules. Although 
warnings can be ignored, errors must be corrected. Reported errors must be 
corrected in the TDB file before the database can be loaded by the application. 
Sometimes the warnings can also reveal the need for additional corrections as 
shown in the example below. 

For example,  a warning is generated if a phase name is detected that is also an abbreviation 
of another phase name in the database. Although allowed, it is not recommended as this 
can (in some cases) lead to unexpected results because abbreviations are also used  when 
entering commands in the Console and included in macro files. The following shows why in 
this case an abbreviation is not recommended. 

Imagine that a macro file uses the abbreviation ABC to refer to a phase in a database that is 
named ABCDE. As long as there is no other phase in the database with the same exact name 
or initial abbreviation, it works. But if a new phase is added to the database and is actually 
named ABC then the macro can in error refer to the wrong phase. The macro still runs but 
now refers to the phase ABC instead of ABCDE because ABC is an exact match, which takes 
precedence over abbreviations.  The Database Checker displays a warning because this 
situation can only occur when one phase name is an abbreviation of another.

With respect to using this tool, the executable DatabaseChecker file is found in the 
Thermo-Calc home directory. 

The program can also be launched by selecting Tools → Database Checker  from the main 
menu in Thermo-Calc.

Large amounts of RAM can be required when checking large databases.

The Database Checker application is standalone and available as indicated from the Tools 
menu in Thermo-Calc.  However, as required, you can run the DatabaseChecker.exe file as a 
stand-alone program from the  file  Thermo-Calc installation directory.  
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Installation Default Directory: Windows, Installation Default Directory: macOS, 
or Installation Default Directory: Linux

Using the Database Checker

Custom Databases: GES5 and GES6 Calculation Engine Version

As of Thermo-Calc version 2019b, the default calculation engine is set to GES6. For custom 
database users, you may sometimes see messages in the log indicating that additional 
preparation is being done by Thermo-Calc prior to a calculation. The preparation is carried 
out automatically; it is usually fast and only needed the first time a custom database is used 
after a modification. While databases with warnings are tolerated, databases that contain 
errors can only be loaded by GES6 after the errors are corrected. 

The Database Checker tool uses the same parser as GES6 and can be used to verify the 
consistency and correctness of databases during development, before the databases are 
actually used.

Database Checker 

To globally set the default from GES6 back to GES5, go to the Options  window 
Global General Settings tab and click Version 5 for the Preferred Gibbs Energy 
System setting. The SET_GES_VERSION Console Mode command is used to 
change GES versions for a single Thermo-Calc session.  

Contact Thermo-Calc Software AB at info@thermocalc.com for more 
information about the changes or if you encounter any issues you think are 
related to the new version of the calculation engine. 

mailto:info@thermocalc.com
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Using the Database Checker

About the Database Checker

Once you have installed the Thermo-Calc and are familiar with the TDB database file concept 
you can start working with the file to ensure it does not contain errors that prevent it from 
working with Thermo-Calc. 

Example of Working with the Database Checker

The following shows a couple of the features available when using an unencrypted TDB 
database file included with Thermo-Calc Console Mode example tcex11 - Oxidation of Cu2S 
with an H2O/O2 Gas Mixture.

Console Mode Examples

Open a TDB file. This example uses tcex11.TDB, which is the user-defined database referred 
to from the Thermo-Calc macro file tcex11.TCM.

 1. In Thermo-Calc, from the menu select Tools→Database Checker.

 2. In the Thermo-Calc Database Checker window, click the File  button and navigate 
to a directory with TDB files or a file with a  .TDB extension. 

If two databases are selected at the same time, these can be tested for 
compatibility i.e., whether the databases can be appended. The tool 
generates error messages for database entities e.g., phases, that are not 
compatible but this does not necessarily mean that the databases 
cannot be appended, only that the erroneous phases cannot be 
appended and must be rejected from the system.

 3. Click Select directory or file.With the file loaded, click Check syntax of database. 
Choose how to show the information: Show summaries only, Show errors, Show 
errors and warnings, or Show all messages. The Database Checker lists the 
information in the window.
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 4. Click Save messages as needed to save a .txt file and use this to help improve your 
database.
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TDB Editor
In this section:

About the TDB Editor 93

Installing VSCode and the TDB Editor 94

Using the TDB Editor 97
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About the TDB Editor

In order to use this tool, it is important to understand how to work with the 
standard TDB database format. For example, see Thermodynamic and 
Kinetic/Mobility Databases in the Database Manager User Guide, which is part 
of the Thermo-Calc Documentation Set, or press F1 in Thermo-Calc and search 
for TDB file in the help.

The TDB Editor is an editing tool for those who develop their own custom databases for use 
with Thermo-Calc or other applications. The tool speeds up the database editing process by 
providing immediate feedback through syntax coloring, syntax checking, and by allowing 
formatting and easy navigation to items of interest in the TDB file.  

The advantage to using the TDB Editor compared to a basic text editor includes features 
such as syntax coloring and checking, formatting of TDB files, and generally easier 
navigation.

The TDB Editor has two components (see Installing VSCode and the TDB Editor for details):  

 l As an installed extension to the open source code editor Microsoft Visual Studio 
Code (VSCode), which has the user interface for the TDB Editor. VSCode is available 
for free. 

 l A server application that runs invisibly in the background and provides the VSCode 
extension with services specific to the TDB format, such as syntax checking, 
formatting and the location within the document of various items, such as functions 
and references. 

The syntax checker uses the same text parsing engine as the Database 
Checker tool and the Thermo-Calc application itself. This means that an 
edited TDB file with no errors shown in the TDB Editor, is also accepted 
by the Thermo-Calc application. For more information see About the 
Database Checker.
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Installing VSCode and the TDB Editor

About the TDB Editor

To use the TDB Editor, you install the Visual Studio Code (VSCode) and then in VSCode you 
install the TDB Editor extension, which is included with your Thermo-Calc installation.

In order to access the most-up-to-date version of the VSCode plugin, it must be 
updated every time a new version of Thermo-Calc is installed. 

System Requirements

The same system requirements apply to the TDB Editor as to the Thermo-Calc installation.

A full list of system requirements and program availability is found on the Thermo-Calc 
website. You can also see the roadmap for platform support to use for planning purposes. 

How to Install the TDB Editor Extension

 1. Navigate to the Thermo-Calc distribution directory based on your operating system. 
Locate the file tdb-language-support.vsix. 

 a. On Windows, the file is typically located under C:\Program Files\Thermo-
Calc-<version>.

 b. On Linux, the file is typically located under <user>/Thermo-Calc/<version>. 

 c. On macOS, the file is typically located under /Applications/Thermo-Calc-
<version>.

 2. Copy the tdb-language-support.vsix file to your desktop.

 3. Install VSCode for your platform from https://code.visualstudio.com/download.

 4. In VSCode, press Ctrl+Shift+X (or from the menu, select View→Extensions). The 
Extensions panel opens. 

https://thermocalc.com/system-requirements/
https://thermocalc.com/roadmap-for-platform-support/
https://code.visualstudio.com/download
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 5. In the upper right corner of the Extensions panel, click the three dots (...) Views and 
More Actions button. Select Install from VSIX and select the tdb-language-
support.vsix file on your desktop.

 6. Locate TDB Language Support in the Extensions panel. For example, click Filter 
Extensions → Installed and the file displays in the panel.

 7. Click TDB Language Support to see the README file, which includes current version 
information, known bugs, and limitations.

READ ME Section Included with the Extension

After installing the TDB Editor, there is a READ ME section available on the front 
page of the extension in VSCode has the most recent information, some of 
which is listed below.
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 l The syntax checker cannot resolve references to TDB files with partial database 
information and gives errors in such cases. Only databases contained in single files 
can be handled. For syntax checking of multi-file databases, use the stand-alone 
Database Checker tool. See About the Database Checker.

 l If you encounter warning messages that do not match the content in the TDB Editor, 
a possible solution is to save the file to disk (press Ctrl+S on the keyboard), which 
reloads the file and restarts the syntax checker.

 l Very large files can sometimes cause issues with the language support functionality 
although the actual editing should be unaffected by this.
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Using the TDB Editor

About the TDB Editor

Once you have installed the TDB Editor and are familiar with the TDB database file concept 
you can start working with it to edit an existing file or create a new TDB file. 

How to Create a TDB File

To create a new TDB file, save an empty text file with a .TDB extension.

How to Open a TDB File 

In VSCode, from the menu select File→Open and navigate to a file with a .TDB extension. 

Example of Working with the TDB Editor

The following shows a couple of the features available when using an unencrypted TDB 
database file included with Thermo-Calc Console Mode example tcex11 - Oxidation of Cu2S 
with an H2O/O2 Gas Mixture.

Console Mode Examples

Open a TDB file. This example uses tcex11.TDB, which is the user-defined database referred 
to from the Thermo-Calc macro file tcex11.TCM.

The unencrypted database opens in the TDB Editor where you can quickly see the color 
syntax of the commands making it easy to navigate. 

Where there are definitions or references included with the file, you can also navigate 
quickly to these using Go To Definition (press F12 or right-click to select from the menu).
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There are many other VSCode features available that you can learn more about from the 
Visual Studio Code Help menu. One such item of particular use is to be able to customize the 
color scheme. 

Customize the Color 

VSCode comes with a number of pre-defined color themes and additional themes can be 
downloaded as extensions. 

To select a color theme, in VSCode press Ctrl+K then Ctrl+T. 
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A preview of each theme is shown. Use the arrow keys to try each and select the theme that 
best suits your preferences.
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Using this Guide

The DATAPLOT User Guide gives all the details on the graphical language DATAPLOT that a 
phase diagram or property diagram calculated by Thermo-Calc or a kinetic profile simulated 
by the Diffusion Module (DICTRA) can be defined.

This guide 

 l Discusses the important features of the DATAPLOT language. 
 l Describes the commands to define PROLOGUE and DATASET.
 l Several examples and the standard codes for formatting are provided. 

One topic introduces the method of formatting DIGLIB symbols in LaTeX documents, for the 
purpose of necessarily/appropriately referring to the corresponding LaTeX symbols (closest 
to those DIGLIB symbols which have been plotted on a diagram using the DATAPLOT 
Graphical Language) in the texts of LaTeX documents for publications/reports.
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About the DATAPLOT Graphical Language

In order to obtain graphical output of any numerical data and informative strings, a graphical 
language called DATAPLOT was developed in connection with the graphical software DIGLIB. 
Using this graphical language, you can store information in a normal text file (*.EXP), which 
can be plotted as graphical symbols, lines, texts or Greek letters on any plot device support 
by DIGLIB.

You can generate and plot DATAPLOT (*.EXP) files together with various calculation and/or 
experimental results from, for example, phase and property diagrams calculated with the 
Thermo-Calc software composition profiles or other diagrams simulated by the Diffusion 
Module (DICTRA).

An EXP file automatically generated by the POST-processor (using the MAKE_
EXPERIMENTAL_DATAFILE command) in the Thermo-Calc  software is a DATAPLOT (*.EXP) 
file and may contain all types of legal DATAPLOT commands and parameters. With a text 
editor, you can modify or add some DATAPLOT commands and related parameters in an 
existing EXP file. This is useful when appending experimental information to 
calculated/simulated plots, and when specifying user-defined texts, symbols, colors, fonts, 
filled patterns, diagram types, diagram sizes, symbol/character sizes, titles, special 
characters, etc.

There is another type of experimental data file that is generated in Thermo-Calc 
when working with the PARROT module. For more information seeExperimental 
Data Files (*.POP, *.DOP).

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

DATAPLOT Examples

To help you prepare your EXP (experimental) files to use for your plotted diagrams 
generated by Thermo-Calc simulations, there are examples of EXP files using the DATAPLOT 
graphical language standard, which are normally independent of software versions. 

Examples, Manuals, and Materials Folders

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/


Thermo-Calc Documentation Set

DATAPLOT User Guide ǀ 5 of 93

Plotting Experimental Data Files

You can read and plot experimental data files in both Console Mode and Graphical Mode.

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

Graphical Mode

In Graphical Mode, the Experimental File Reader activity can only be created from the top 
My Project node. This activity allows you to read an experimental data file (*.EXP). This type 
of file has information specifying a plotted diagram, written in the DATAPLOT graphical 
language. From this activity node you can plot the EXP file or save a copy of the file to 
another location. 

How to Plot an EXP file in Experimental File Reader

 1. Right-click  My Project and from the Create New Activity submenu choose 
Experimental File Reader.

 2. In the Configuration window in the EXP file field, enter the name of the EXP file to 
plot. Or click the Select Exp file  button to navigate to a location on the computer 
to add the dataset.

 3. Once the .EXP file is added, under Dataset Selection you can choose to include or 
exclude specific datasets. Use the Select/Deslect all datasets checkbox as required.

 4. Right-click the Experimental File Reader node and from the Create New Successor 
submenu choose Plot Renderer.

If the source EXP file is changed, you can also click the Reload the selected EXP file 
from disk  button to refresh the data. If you want to save or export the loaded file, 
click the Save EXP file  button, then navigate to where you want to save it and 
give it a file name. 

 5. In the Configuration window click Perform or right-click the Plot Renderer node and 
select Perform.

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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Console Mode

In Console Mode you use the QUICK EXPERIMENTAL PLOT command found in the POLY-3 
POST module (as well as in the Diffusion Module (DICTRA) POST module) to plot the .EXP 
files. This command can be used when there is no graphical information to be plotted in the 
POLY3 workspace. It defines a pair of axes, sets the axis labels to X and Y, and scales both X- 
and Y-axes between 0.0 and 1.0 unless a prologue is read from the DATAPLOT (*.EXP) data 
file.

How to Plot an EXP file in POST

 1. Go to the POLY-3 Module: At the SYS prompt type Go Poly.

 2. Go to the POST module: At the POLY_3 prompt type Post.

 3. At the POST prompt, type Quick. 

 4. Enter Prolog and Dataset numbers (if applicable). See QUICK_EXPERIMENTAL_PLOT.

 5. AT the POST prompt, type Plot.
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Using DATAPLOT Graphical Language
In this section:
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DATAPLOT File Structure

A DATAPLOT file is a normal text file with the extension EXP that can be created with a text 
editor or by a program. The file must contain one or more DATASETS and possibly also one or 
more PROLOGUES. Each PROLOGUE/DATASET is an entity that can be individually selected for 
plotting.

A PROLOGUE/DATASET is identified by a unique positive number in the file. A PROLOGUE 
normally contains various DATASET commands for defining information about axis scaling, 
axis text, axis length, title and so on. A PROLOGUE is terminated by another PROLOGUE or by 
the first DATASET. This means that all PROLOGUES must be placed at the beginning of the 
file, before the first DATASET.

A DATASET normally contains DATASET commands that are associated to separate data 
points, as well as with one or more BLOCKS of data (calculated or experimental). A DATASET 
is terminated by another DATASET command or the end of file.
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DATAPLOT Language Syntax

The DATAPLOT language consists of commands with or without parameters:

COMMAND {parameter(s)}

The basic graphical command consists of an X/Y coordinate pair and a Graphical Operation 
Code (GOC). With other commands, the interpretation of this basic command can be 
modified. There are separate commands to draw a polygon or a function and ways to get 
texts in different fonts.

To edit a DATAPLOT file, the graphical commands can be abbreviated.

A command (with parameters) must not exceed 80 characters. If it is too long 
(normally as writing necessary codes in a command’s parameters for a complex 
expression), two or more lines can be edited.
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Coordinate Systems

The DATAPLOT language accepts coordinates in three different coordinate systems, which 
are called world, virtual and normalized.

 l The world coordinates are selected to represent any kind of data and be of “any” 
magnitude.

 l The virtual coordinate system uses centimeters as units. However, the actual size of 
one unit is dependent on the implementation of the device driver in DIGLIB. It is not 
recommended to use this coordinate system if different output devices are used for 
preliminary and final plots.

 l The normalized coordinate system goes from zero to one. When plotting, you 
interactively scale each axis by selecting the minimum and maximum word 
coordinates on the axis. In the normalized coordinate system, the minimum axis 
value is represented by zero and the maximum by one. DIGLIB draws a square 
between the four points (of the X and Y axes) that are determined by the coordinates 
zero and one in the normalized coordinates. 

It is also possible to draw triangular plots as described below. However, in most 
places, it only references square diagrams. All data points within the minimum 
and maximum word coordinates are plotted inside this square. DIGLIB also 
writes tic marks and corresponding word values at such tic marks.

It may be convenient to use normalized coordinates to draw boxes and texts. You can give 
normalized coordinates outside zero and one if you want to write texts outside the area 
enclosed by the square. To ensure proper operation outside the normalized box, the clipping 
must be turned off.
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Graphical Operation Codes

The Graphical Operation Code (GOC) determines how the coordinates are interpreted and 
what is done at the point determined by the coordinates. For an individual data point, its 
GOC codes must be given. For each data BLOCK, you define a default GOC that is used for 
the whole BLOCK, unless a GOC is explicitly defined for a specific point.

 l If S is omitted, no symbol is plotted. A number selecting the symbol can optionally 
follow the character S. The DIGLIB software determines which symbol the number 
represents. See Plotting a Symbol.

 l If any of the other characters are omitted, the default defined for the BLOCK is used. 
Absolute values imply the current coordinates; relative values mean that these are 
added to the current coordinates. The GOC must be written without any space 
between various characters, but the order for the characters is irrelevant.

 l If no GOC is defined for a BLOCK, the system default is MWA, (Move Word Absolute), 
i.e., move to the given point that is interpreted as absolute word coordinates. 
GOC=DNA means draw a line from the current point to the new one interpreting the 
coordinates as normalized. After each draw or move operation, the so-called current 
point is the new point.

 l The TEXT following the ’ command is interpreted and expanded by the DIGLIB 
software, if it includes any ^ operator or STRING names using the ~ descriptor. To get 
PostScript outputs, the TEXT must be edited by the LaTeX Text Formatting Program 
instead (see LaTeX Formatting Codes).

GOC Character Definitions

The GOC is a combination of the following characters:

Character Meaning

W, V or N To use world (W), virtual (V) or normalized (N) coordinates. W is the default.

A or R XY are absolute (A) or relative (R) values. A is the default.

M or D To perform a move (M) or draw (D) operation to XY. M is the default.

B To apply “soft” splines on a line drawn between the coordinate pairs (used only on BLOCK data).
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Character Meaning

S To plot default symbol at XY.

S# To change default symbol to No # symbol and plot it at XY.

‘TEXT
To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT following the ’ command 
is interpreted and expanded by the DIGLIB software, if it includes any ^ operator or STRING names 
using the ~ descriptor. 
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Tables or Blocks

In many cases, you have (calculated or experimental) data in the form of tables, and want to 
plot one or several columns as X-axis and one or more columns as Y-axis. A single table can 
contain many sets of data records of the same kind of information for a specific data BLOCK. 
There can be many data BLOCKS in a DATASET.

By enclosing these tables in a data BLOCK, you can select which column(s) is the X-axis and 
which is the Y-axis. For example,

BLOCK X=C1; Y1=C3; Y2=C2; GOC=C4,DAW

Where the X-axis values are in column 1, the Y-axis values are in columns 2 and 3, and any 
GOC codes are in column 4. The default GOC for this BLOCK is Draw Absolute Word. The 
GOC code inside the table is only necessary if the default GOC is not applicable.

A more elaborate use of the table is shown in this example:

BLOCK X=C3; Y=1E3/(C3+273); GOC=C8,MAWS1

Where the X-axis values are in column 3, the Y-axis values are in column 1 with some 
additional calculations applied. Any GOC is in column 8, and the default GOC is Move 
Absolute Word and plot the symbol no. 1.

Columns in a table must be separated by one or more space characters and do not have to 
be justified.

It is possible to have tables with mixed text and numbers, but each word followed by a space 
is counted as one column. The columns used for plotting also must be numerical. An 
example of a legal line in a table is

298.15 This_is_the_second_column 11.5 This_is_the_fourth_column

A line in the table must not exceed 80 characters. A BLOCK must be terminated 
by a line with the BLOCKEND command.

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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Drawing a Polygon

Normally, each point is written on a separate line. But in order to draw a line in a more 
compact way, use the command DRAWLINE. DRAWLINE is followed by a couple of X/Y 
number pairs. The X/Y pairs must be separated by a space, and there must be a comma sign 
between the X and Y values. DRAWLINE makes a move operation to the first pair of X/Y 
coordinates, and then draws a line among all pairs up to the last one. All pairs must fit on 
one line of 80 characters, but there can be several consequent DRAWLINE commands.

Example 2 – Draw Polygons and Symbols 
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Drawing an Analytical Function

Use a BLOCK command to set an axis to a function. It is not necessary to use a value from 
any column in order to compute the function value to be plotted. Use the FUNCTION 
command to plot a function with an even increment of the independent variable.

Example 4 – Draw Curves Defined by Functions
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Painting of an Enclosed Area

Use the PAINT command to paint or fill an area in a specified pattern in the plot. Available 
patterns are determined by the DIGLIB software. A related command to PAINT is 
PCFUNCTION. 
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Writing a Text

Use the TEXT command to write a text at the current point. You can write a text at any X/Y 
pair by appending a single quote followed by the text on the same line. For example:

1.1 1.0 NAM’This is a text 

writes This is a text at the normalized coordinates (1.1, 1.0).

Use the command FONT to select the font used for the text, and CHARSIZE to select the size 
of the characters. Set this size of the symbols with SYMBOLSIZE.

If a text or a single character should be of a different font than all the other text, or to use 
subscripts or superscripts in a text, use the ^ operators or STRING command to create the 
text. The command STRING stores the text in a specified variable that includes all text-
formatting information defined by the DIGLIB software. 

Example 3 – Using Strings and Various Line Types and Example 5 – Use Included 
Files for Predefined Symbols.

However, if a graphical output is done on a PostScript device using the PostScript hardcopy 
fonts, special text formatting codes as LaTeX Formatting Codes should be used and the 
STRING formatting syntax is then not valid.
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Plotting a Symbol

As described in Graphical Operation Codes, a GOC code in a data BLOCK may contain an S 
option to plot a symbol for an X/Y pair or the same symbols for the data BLOCK. A number 
selecting the symbol can optionally follow the character S. You can plot a symbol at any 
current X/Y position by appending a quote specified by the symbol number in the GOC code 
(e.g., 1.1 1.0 MANS5’This is a text).

You can also insert DIGLIB symbols into LaTeX-edited documents.

Example 1 – Draw Lines and Symbols, Example 2 – Draw Polygons and Symbols 
and Example 8 - DIGLIB Symbols
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Other Commands

General

 l When plotting symbols representing various experimental data, it is important that 
the symbols are centered around the coordinate values.

 l The dollar sign $ as the first character of a line stands for a comment character, 
which means the whole line is ignored when plotting.

ATTRIBUTE

Use the ATTRIBUTE command to change the coordinates where text is displayed. The default 
is the lower left corner of the first character in the text. 

CLIP

Use the CLIP command to change the default where all data outside the normalized 
coordinates zero and one are not plotted. 

COLOR

If you are using a color device, use the COLOR command to change color of the lines. On 
some black and white devices, colors are simulated with different width and dashing of the 
lines.

INCLUDE

Use the INCLUDE command to create libraries with texts and include these in similar plots.

LINETYPE

Use the LINETYPE command to define line types as solid, long dashed, short dashed or 
dotted. 
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Interactive Plotting

The DATAPLOT file is read into the POST module in the workspace with APPEND_
EXPERIMENTAL_DATA or QUICK_EXPERIMENTAL_PLOT. These commands ask for the name 
of the DATAPLOT file and also which PROLOGUE(S) and DATASET(S) are to be plotted.

Press F1 and search the Help for details.

By giving the PROLOGUE/DATASET number as -1, you get a list of the available 
PROLOGUES/DATASETS in the file. Note that if DATASET 0 is in a DATAPLOT file, its data is 
always used even if other DATASETS are chosen.
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Formatting DIGLIB Symbols in LaTeX Documents

When using the LaTeX editor, you can use the DIGLIB symbols in texts and in figures. This 
then refers to the corresponding LaTeX symbols (closest to those DIGLIB symbols which are 
plotted on a plot using the DATAPLOT Graphical Language) in the texts of LaTeX documents 
for publications/reports.

This topic shows how to generate some DIGLIB symbols in texts, through the attached LaTeX 
source file and its converted jpg file.

Example 8 - DIGLIB Symbols

DIGLIB_Sym.tex 
\documentclass[dvips,12pt]{article}

\textwidth 165mm

\textheight 225mm

\oddsidemargin 1mm

\evensidemargin 1mm

\topmargin 1mm

%%\usepackage{amssymb}

%% next replace amssymb and to get udtimes

\usepackage[utopia]{mathdesign}

\usepackage{rotating}

\usepackage[latin1]{inputenc}

\usepackage{graphics}

\usepackage{graphicx,subfigure}% with figures

%\usepackage[draft]{graphicx}% without figures

\usepackage{subfigure}% with figures

\topmargin 1mm

\oddsidemargin 1mm

\evensidemargin 1mm

\begin{document}

{\Large \bf Diglib symbols and their corresponding LaTeX symbols}

\vspace{5mm}
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The information below gives the closest corresponding LaTeX symbol. All symbols (except +) 
must be generated in math mode. Most of these require the package amssymb, i.e., you need 
a directive usepackage{amssymb} in the preamble. Two of the symbols require the more 
extensive mathdesign that can be included with usepackage[utopia]{mathdesign}.

\vspace{5mm}

{\Large

\begin{tabular}{llll}

Diglib & Latex & Latex name & Note\\

1& $\vartriangle$& $\backslash$vartriangle & amssymb \\

2& $\square$& $\backslash$square\\

3& {\Huge $\diamond$} & $\backslash$diamond & size $\backslash$Large \\

4& $\udtimes$& $\backslash$udtimes & mathdesign \\

5& $\triangledown$& $\backslash$triangledown & amssymb\\ 6 & +& normal + \\

7& $\ast$& $\backslash$ast & amssymb\\

8& $\times$& $\backslash$times \\

9& {\Huge $\circ$}& $\backslash$circ & size $\backslash$Large \\

10& {\Huge $\star$}& $\backslash$star & size $\backslash$Large, amssymb\\

11& $\curlyvee$& $\backslash$curlyvee & amssymb\\

12& $\Join$& $\backslash$Join\\

13&& - & nothing similar, overlapping $> <$\\

14&& - & nothing similar, 10-edged star \\

15& $\maltese$& $\backslash$maltese& mathdesign \\

16&& - & nothing similar, a pentagon \\

17& $\curlywedge$& $\backslash$curlywedge & amssymb\\

\end{tabular}}

\end{document}
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LaTeX Formatting Codes

By default when using the LaTeX command, you are in math mode and 
Thermo-Calc automatically interprets the entered text as math. The above link 
uses the dollar sign ($) in all the examples but this is NOT required. For 
example, if you enter $E=mc^2$ this is displayed including the $ instead of the 
equation.

As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For 
existing users who may have plots and files that use the LTEXT format, and 
especially when using Console Mode, the following examples show the 
command changes from LTEXT and its LaTeX equivalent.

LTEXT vs LaTeX Commands for Labels

Symbol or text 
format LTEXT LaTeX

Subscripts in an axis 
text

S-A-TEXT Y N Mole-fraction 
Al^DO2$O^DO3$

S-A-TEXT Y N \latex \textsf{Mole-fraction } Al_
2O_3

Label with subscript add .13 .15 n c-ZrO^DO2$ add .13 .15 n \latex c-ZrO_2

Greek symbol ADD .05 .50 N ^GRd$ ADD .05 .50 N \latex \delta
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PROLOGUE Commands
In this section:

PROLOG 25

DIAGRAM_TYPE 26

TIC_TYPE 27

TITLE 28

XLENGTH 29

XSCALE 30

XTEXT 31

XTYPE 32

YLENGTH 33

YSCALE 34

YTEXT 35

YTYPE 36
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PROLOG

PROLOG is the beginning of a number of consequent lines of user-defined diagram layout 
commands. The lines are displayed with the optional text when using the -1 option in the 
POST-processor as prompted for the PROLOG number with APPEND_EXPERIMENTAL_DATA 
or QUICK_EXPERIMENTAL_PLOT.

Examples of DATAPLOT Files and Outputs

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

Syntax PROLOGUE # optional text

 # is an unsigned integer identifying the PROLOG.

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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DIAGRAM_TYPE

DIAGRAM_TYPE sets the diagram type to square (the default) or triangular. 

Example 6 – Triangular Diagrams for Ternary Systems

Syntax DIAGRAM_TYPE type plot_3rd_axis clip_along_third-axis

 
type is  a character string reading SQUARE (default) or TRIANGULAR. If type reads 
TRIANGULAR, then two additional parameters are given: plot_3rd_axis and clip_
along_third-axis that are characters strings reading YES or NO.
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TIC_TYPE

TIC_TYPE sets the relative length of the tic marks. 

Syntax TIC_TYPE #

 # is a real number. Default value is 1. Negative number gives tics on the inside of the 
diagram frame. 0 gives no tics.
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TITLE

TITLE sets the title text string to be printed above the diagram.

Syntax TITLE text

 text is an arbitrary text string that may contain text-formatting codes
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XLENGTH

XLENGTH sets the X-axis length to approximately # centimeters.

Syntax XLENGTH #

 # is a positive real number (the approximate X-axis length in centimeters).
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XSCALE

XSCALE sets the scaling in word coordinates of the X-axis.

Syntax XSCALE min max

 min and max are real numbers.
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XTEXT

XTEXT sets the X-axis text.

Syntax XTEXT text

 text is an arbitrary text string that may contain text-formatting codes.
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XTYPE

XTYPE sets the X-axis type as linear (default), logarithmic or inverse.

Syntax XTYPE type

 type is a character string reading LIN, LOG or INV.
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YLENGTH

YLENGTH sets the Y-axis length to approximately # centimeters.

Syntax Y LENGTH #

 # is a positive real number (the approximate Y-axis length in centimeters).
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YSCALE

YSCALE sets the scaling in word coordinates of the Y-axis.

Syntax YSCALE min max

 min and max are real numbers.
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YTEXT

YTEXT sets the Y-axis text.

Syntax Y TEXT text

 text is an arbitrary text string that may contain text-formatting codes.
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YTYPE

YTYPE sets the Y-axis type as linear (default), logarithmic or inverse.

Syntax Y TYPE type

 type is a character string reading LIN, LOG or INV.
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DATASET Commands
In this section:

ATTRIBUTE 38

BLOCK 39

BLOCKEND 40

CHARSIZE 41

CLIP 42

COLOR 43

DATASET 45

DATAPOINT 46

DRAWLINE 47

FONT 48

FUNCTION 49

GLOBALSIZE 50

INCLUDE 51

LINETYPE 52

PAINT 53

PCFUNCTION 54

SYMBOLSIZE 55

STRING 56

TEXT 58
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ATTRIBUTE

ATTRIBUTE specifies where the current XY position is in the character or symbol plotbox.

Example 2 – Draw Polygons and Symbols, Example 3 – Using Strings and Various 
Line Types, and Example 5 – Use Included Files for Predefined Symbols

Syntax ATTRIBUTE 

Prompts attribute

 attribute may be TOP, CENTER or BOTTOM. ATTRIBUTE CENTER is default for symbols; ATTRIBUTE 
BOTTOM is default for characters.
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BLOCK

BLOCK defines how the following numeric data block shall be interpreted. The definitions of 
X and Y coordinates may also be expressed as a function of the column values, making it 
possible to perform transformations.

Syntax BLOCK X&=C#; ...; Y&=C#; ...; GOC=C#,@@@...

 

&’ are optional unsigned integers that make it possible to plot several (maximum 9) X- or Y- axis 
columns. #’ are unsigned integers identifying the column numbers. The column number # in 
“GOC=C#” is the location of any possible GOC codes in the current data BLOCK; @@@ stands for the 
default Graphical Operation Code (GOC) for the current BLOCK. The GOC code inside the current table 
is only necessary if the current default GOC is not applicable.

GOC Characters

The GOC is a combination of the following characters:

Character Meaning

W, V or N To use world (W), virtual (V) or normalized (N) coordinates. W is the default.

A or R XY are absolute (A) or relative (R) values. A is the default.

M or D To perform a move (M) or draw (D) operation to XY. M is the default.

B To apply “soft” splines on a line drawn between the coordinate pairs (used only on BLOCK data).

S To plot default symbol at XY.

S# To change default symbol to No # symbol and plot it at XY.

‘TEXT
To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT following the ’ command 
is interpreted and expanded by the DIGLIB software, if it includes any ^ operator or STRING names 
using the ~ descriptor. 
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BLOCKEND

Use BLOCKEND to terminate the local definition of the graphical operation code defined by 
the earlier BLOCK command.
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CHARSIZE

CHARSIZE redefines the default size of the characters in the plot. The character size has an 
initial default value, which may vary with the current font setting and the output device (the 
plot format).

Examples of DATAPLOT Files and Outputs

Syntax CHARSIZE $$

 $$ must be an unsigned real.
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CLIP

CLIP turns clipping on or off. If it is OFF, it allows output outside the ordinary plot area 
defined by normalized coordinates zero and one.

Example 2 – Draw Polygons and Symbols and Example 9 - DIGLIB Fonts and Lines

Syntax CLIP CLP

 clp is a character string reading ON or OFF.
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COLOR

Use COLOR to redefine the current color setting. There are 22 legal color codes (from 0 to 
21).

Example 7 – Color Codes

Syntax COLOR code

 code is an unsigned integer number (from 0 to 21) identifying the color, or a character 
string specifying the color.

DIGLIB Color Codes 

Code Color Equivalent Character

0 Background Invisible

1 Black Normal

2 Red Very_Thick

3 Green Thin

4 Blue Thick

5 Yellow Very_Thin

6 Magenta Dashed

7 Cyan Dotted

8 Purple  

9 Gold  

10 Turquoise  

11 Pink  

12 Gray  
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Code Color Equivalent Character

13 Orange-red  

14 Maroon  

15 Plum  

16 Sea green  

17 Olive  

18 Sienna  

19 Orange  

20 Coral  

21 UserDef  

22 and higher Any digit larger than 21 has the color effect as 1 
(black).
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DATASET

DATASET indicates the beginning of a number of consequent lines comprising a set of user-
defined data. The DATASET lines are displayed on the terminal along with the optional 
text when using the -1 option in the POST-processor as prompted for the DATASET number 
in the APPEND_EXPERIMENTAL_DATA or QUICK_EXPERIMENTAL_PLOT command.

See the Tips and Tricks: How to Plot Experimental Data blog post on our 
website for useful guidance about this topic.

Syntax DATASET # optional text

 # is an unsigned integer identifying this set of data.

https://thermocalc.com/blog/tips-and-tricks-how-to-plot-experimental-data/
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DATAPOINT

DATAPOINT is not a DATASET command, but the basic DATAPLOT command (see synopsis 
below) performs an action at the current point determined by the specified X/Y- 
coordinates. A DATASET may contain various data points, in addition to one or more data 
BLOCKs. Such data points are separated and independent on each other.

Syntax X Y GOC

 

X and Y are unsigned real numbers identifying the X/Y-coordinates for the current data point. GOC 
stands for Graphical Operation Code (GOC) for the current point. Legal GOC characters.

Example

0.7 0.95 N'Example 6

0.5 0.08 MNA'E^FS18^SQ(^SK^FS10A+5#8*C#^FS10 -!a^FS18)^FS11+B^DIa#b#$
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DRAWLINE

DRAWLINE draws a line starting at (x1,y1) to (xn,yn) through (x2,y2) à (x(n-1), y(n-1)).

Example 1 – Draw Lines and Symbols and Example 2 – Draw Polygons and 
Symbols

Syntax DRAWLINE x1,y1 x2,y2 .... xn,yn

 

x and y may be reals or integers of any value. This is the same as connecting all points 
in a table:
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FONT

FONT redefines the default font setting in the POST-processor.

Example 9 - DIGLIB Fonts and Lines

Syntax FONT #

 # is an unsigned integer. 

Font Numbers

Number Font 

1 Bold

2 Normal

3 Italic

5 Bold and Italic

10 Monotype Normal

11 Monotype Italic

12 Monotype Bold

13 Monotype Bold and Italic

14 Narrow Normal 

15 Narrow Italic
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FUNCTION

FUNCTION defines and plots a user-defined function.

Example 4 – Draw Curves Defined by Functions

Syntax
FUNCTION Y=f(X); start end number_of_XY_pairs; GOC;

FUNCTION X=f(Y); start end number_of_XY_pairs; GOC;

 
f(X) or f(Y) are legal mathematical functions of X or Y, understandable by a FORTRAN program. 
start and end are unsigned real  numbers, and number_of_XY_pairs an unsigned integer. GOC is a 
legal graphical operation code as defined with BLOCK.
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GLOBALSIZE

GLOBALSIZE redefines the default global size of the plot. The global size has an initial default 
value.

Syntax GLOBALSIZE $$

 $$ must be an unsigned real.
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INCLUDE

INCLUDE adds a file into the current input stream.

Example 5 – Use Included Files for Predefined Symbols.

Syntax INCLUDE filename

 filename is a legal filename (with its correct path) for the operation 
system.



Thermo-Calc Documentation Set

DATAPLOT User Guide ǀ 52 of 93

LINETYPE

LINETYPE redefines the current linetype in the plot.

Example 3 – Using Strings and Various Line Types, Example 8 - DIGLIB Symbols 
and Example 9 - DIGLIB Fonts and Lines

Syntax LINETYPE #

 

# must be an unsigned integer. Legal linetypes are (for both normal graphical outputs and for 
PostScript formats):

 l Solid (default)

 l Long dashed

 l Short dashed

 l Dotted

Line Types

Number Type

1 Straight line

2 Dashed line

3 Dotted line

4 Dash-Dot line
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PAINT

PAINT paints the area enclosed by the current path in the current pattern. The current path 
starts at the last MOVETO given and includes all subsequent DRAWs.  This command only 
works for the PostScript format (as graphical files or on printed hardcopy).

PCFUNCTION

Syntax PAINT <code> <video> <mode>

 

<> denotes optional parameters. To set a new current pattern, supply any or all of the 
optional parameters.

 l <code> is a single letter 0-9, A-Z or a-t (if <code>=t, also supply a space and a 
number in the range 0.00-1.00). The default is 0.

 l <video> is a string reading NORMAL (the default) or INVERSE.

 l <mode> is a string reading TRANSPARENT (the default) or OPAQUE.
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PCFUNCTION

PCFUNCTION appends a user-defined function to the current path. It is used with PAINT.

Syntax
PCFUNCTION Y=f(X); start end number_of_XY_pairs; GOC;

PCFUNCTION X=f(Y); start end number_of_XY_pairs; GOC;

 
f(X) or f(Y) are legal mathematical functions of X or Y, understandable by a FORTRAN 
program. start and end are unsigned real  numbers, and number_of_XY_pairs an 
unsigned integer. GOC is a legal graphical operation code as defined with BLOCK.
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SYMBOLSIZE

SYMBOLSIZE redefines the current symbol size setting. The symbol size  has an initial default 
value.

Example 3 – Using Strings and Various Line Types, Example 7 – Color Codes and 
Example 8 - DIGLIB Symbols

Syntax SYMBOLSIZE $$

 $$ must be an unsigned real.
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STRING

STRING defines a string containing a text and operation codes (e.g., to change the default 
font settings).

Example 3 – Using Strings and Various Line Types and Example 5 – Use Included 
Files for Predefined Symbols

Syntax STRING name text_with_each_character_in_^S#^G^F#^U#^D#^R#^L#^N

 

name is a valid alphanumeric name (variable) to represent the text including all text 
formatting codes. It is highly recommended that all the characters in the name are in 
CAPITAL CASE (e.g. ACA2SO4); otherwise, the defined STRING can be incorrectly 
plotted.

text_with_each_character_in_^S#^G^F#^U#^D#^R#^L#^N 

means the text is coded with each of its characters (and/or numeric numbers) that are 
formatted with various operators (^S#, ^G, ^F#, ^U#, ^D#, ^R#, ^L# and/or ^N). #’ are 
unsigned integers. ^ is the caret character and does not mean a control character. 
Between an # (in an operator) and a numeric number (as a part of the text), there must 
always be a comma sign (,) or the number is not plotted in the text, because the # with 
the number is interpreted as another incorrect #. In some of the commands, #=0 
resets the option to previous (or default) value.

String Operation Codes in the DIGLIB Software

For the PostScript hardcopy fonts, these operation codes are not valid; see LaTeX Formatting 
Codes:

Operator Operation

^S# Set character size to size #

^G Set font to Greek

^F# Set font to font number #

^U# Move up # units

^D# Move down # units

^R# Move right # units
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Operator Operation

^L# Move left # units

^N Do not move, remain at current

Examples
STRING Alpha1 ^Ga^F0^D0^S8,1^S0^U0

is set to α1

STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0

is set to M23C6

STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0

is set to Ca2CO3 
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TEXT

TEXT outputs, at the current position, the text following the keyword TEXT or the text in the 
string string_name that is defined with STRING.

Syntax TEXT text or ~string_name

 It is possible to mix ^ operators and previously defined string names using the ~ 
operator.
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Examples of DATAPLOT Files and Outputs
Once your Thermo-Calc software is installed you can open the Examples and PDF 
documentation (Manuals) from the main menu:

 l To open the Manuals folder select Help → Manuals Folder.  Note for Linux openSUSE 
users: This link is not functional. To access the folder, navigate to the default location 
based on your installation type

 l To open the Examples  based on whether you are in Console Mode or Graphical 
Mode,  select File → Examples Files or Help → Examples Files. 

In this section:

Example 1 – Draw Lines and Symbols 60

Example 2 – Draw Polygons and Symbols 62

Example 3 – Using Strings and Various Line Types 64

Example 4 – Draw Curves Defined by Functions 67

Example 5 – Use Included Files for Predefined Symbols 69

Example 6 – Triangular Diagrams for Ternary Systems 72

Example 7 – Color Codes 78

Example 8 - DIGLIB Symbols 83

Example 9 - DIGLIB Fonts and Lines 91
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Example 1 – Draw Lines and Symbols

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 1 - Draw Lines and Symbols.EXP available with 
your installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

Macro Text

DATAPLOT Example 1

PROLOG 1 EXAMPLE 1  0<X<100, 0<Y<100

XSCALE        0.00000       100

YSCALE        0.00000       100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  EXAMPLE 1
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XTEXT  X

YTEXT  Y

DATASET 1 Two lines started with two symbols

ATTRIBUTE CENTER

0.05  0.95 N'Example 1

0.7   0.95 NS'Line 1

0.7   0.90 NS2'Line 2

10    10  S1

20    80  D

80    80  S2

80    10  D

50    60
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Example 2 – Draw Polygons and Symbols

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 2 - Draw Polygons and Symbols.EXP available 
with your installation. To open the folder: From the Thermo-Calc menu, select Help → 
Manuals Folder.

Output Example

Macro Text

$DATAPLOT Example 2

PROLOG 2 EXAMPLE 2  0<X<100, 0<Y<100

XSCALE        0.00000       100

YSCALE        0.00000       100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  EXAMPLE 2

XTEXT  X
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YTEXT  Y

DATASET 2 Two ploygons with three types of symbols

ATTRIBUTE CENTER

CLIP OFF

0.05  0.95 N'Example 2

1.1   0.95 NS1'SYMBOL 1

1.1   0.90 NS2'SYMBOL 2

1.1   0.85 NS3'SYMBOL 3

BLOCK X=C1; Y=C2; GOC=C3,DSWA

40    40  M

40    60

60    60  S2'CHANGE OF SYMBOL

60    40

40    40  S0

BLOCKEND

BLOCK X=C1*100; Y=C2*100; GOC=C3,DSWA

0.2   0.2 MS1

0.2   0.8

0.8   0.8

0.8   0.2

0.2   0.2

BLOCKEND

$Draw an additional polygon:

DRAWLINE 20,10 30,15 40,30 50,80

DRAWLINE 50,80 60,60 90,30
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Example 3 – Using Strings and Various Line Types

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 3 - Using String and Line Types.EXP 
available with your installation. To open the folder: From the Thermo-Calc menu, select Help 
→ Manuals Folder.

Output Example

Macro Text

$DATAPLOT Example 3

PROLOG 3 EXAMPLE 3  0<X<10, 0<Y<100

XSCALE        0.00000       10

YSCALE        0.00000       100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  EXAMPLE 3

XTEXT  X

YTEXT  Y

DATASET 3 Draw curves; plot formatted texts and symbols



Thermo-Calc Documentation Set

DATAPLOT User Guide ǀ 65 of 93

$Define some strings:

STRING BCC \latex \alpha

STRING BCC1 \latex \alpha_1 + M_23C_8

STRING M23C6 M_23C_6

STRING ACA2CO3 \latex \alpha Ca_2CO_3

STRING AMG2SO4 \latex \alpha Mg_2SO_4

ATTRIBUTE CENTER

CLIP OFF

FONT 2

0.05   0.95 NS1'SYMBOL 1

CHARSIZE 0.2

0.05   0.90 NS2' SYMBOL 2

CHARSIZE 0.3

0.05  0.85 NS3'SYMBOL 3

0.05   0.80 N' ~BCC

0.05   0.75 NS1'~BCC1

SYMBOLSIZE 0.4

CHARSIZE 0.4

0.45  0.42 N'~ACA2CO3

0.58  0.30 N'~AMG2SO4

CLIP ON

LINETYPE 1

BLOCK X=C1; Y=C1*C1; GOC=C2, DWA

0 M

1

2

3

4

5

6

7

8

9

10

BLOCKEND
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LINETYPE 2

BLOCK X=C1; Y=C1*C1+10; GOC=C2, DWA

0 M

1

2

3

4

5

6

7

8

9

10

BLOCKEND
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Example 4 – Draw Curves Defined by Functions

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 4 - Curves and Functions.EXP available with 
your installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

Macro Text

$DATAPLOT Example 4

PROLOG 4 EXAMPLE 4  0<X<100, 0<Y<100

XSCALE        0.00000       100

YSCALE        0.00000       100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  EXAMPLE 4

XTEXT  X
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YTEXT  Y

DATASET 4 Plot two functions as lines:

ATTRIBUTE CENTER

0.05  0.95 N'Example 4

$ Draw two lines defined by FUNCTIONS:

FUNCTION Y=10+0.5*X+20*Sin(X/5); 0 100 100; DWA;

FUNCTION Y=50+0.5*X; 0 100 10; DS1WA;

$ Write functions beside the lines:

$    Note the real rotation angle (27 degree) can be seen

$      only on the PostScript hardcopy

0.25  0.68 N'^RO27Y=50+0.5*X

0.25  0.45 N'^RO27Y=10+0.5*X+20*Sin(X/5)
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Example 5 – Use Included Files for Predefined Symbols

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 5 - Predefined Symbols.EXP available with your 
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

In the plot result, the hard-to-read LaTeX line is intended to highlight how to 
type readable text using LaTeX. 

Macro Text

$DATAPLOT Example 5 Symbols
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PROLOG 5 EXAMPLE 5  0<X<100, 0<Y<100

XSCALE        0.00000       100

YSCALE        0.00000       100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  EXAMPLE 5

XTEXT  X

YTEXT  Y

DATASET 5 Write equations and strings with different properties

STRING TEST1A \latex \alpha \beta \gamma \delta \epsilon \zeta \eta \theta

STRING TEST1B \latex \iota \kappa \lambda \mu \nu \xi \omicron

STRING TEST1C \latex  \pi \rho \sigma \tau \upsilon \phi \chi \psi \omega

STRING TEST2A   a b c d e f g h i j k

STRING TEST2B   l m n o p q r s t u v w x y z

STRING BCC1 \latex \alpha_1

STRING ACA2CO3 \latex \alpha_{Ca_2CO_3}

ATTRIBUTE CENTER

CHARSIZE 1

0.05  0.95 N'Example 5

CLIP OFF

0.01  0.85 N'~TEST1A

0.01  0.80 N'~TEST1B

0.01  0.75 N'~TEST1C

FONT 1

0.01  0.65 N'~TEST2A

FONT 2

0.01  0.60 N'~TEST2B

0.01  0.55 N'\latex \textsf{Sans serif in LaTeX}

0.01  0.50 N'\latex \textrm{Roman text in LaTeX}

0.01  0.45 N'\latex \texttt{Monospaced text in LaTeX}

0.01  0.40 N'\latex as opposed to math mode LaTeX

0.01  0.35 N'~BCC1

CHARSIZE 0.8
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0.01  0.30 N'\latex M_{23}C_6

0.01  0.25 N'~ACA2CO3
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Example 6 – Triangular Diagrams for Ternary Systems

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 6 - Ternary Plots.EXP available with your 
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

In the DATAPLOT language, this type of diagram is only available for Console 
Mode.

Macro Text

$DATAPLOT Example 6 - Ternary Phase Diagram

PROLOG 6 EXAMPLE 6  0<X<0.969224, 0<Y<1.00000

XSCALE        0.00000          0.969224

YSCALE       0.307492E-01       1.00000
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XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  A-B-C at T=1000 K

XTEXT  MOLE_FRACTION B

YTEXT  MOLE_FRACTION C

DIAGRAM_TYPE TRIANGULAR YES YES

DATASET 6 Plot a ternary phase diagram

CLIP OFF

0.80  0.90 N'Example 6

0.86  0.31 N'B2C

0.52  0.97 N'Diamond

CHARSIZE 0.25

1.4E+01  1.10E+01 MVA'1:*B2C Liquid

1.4E+01  1.05E+01 MVA'2:*Diamond Liquid

0.10  0.10 N'Liquid

0.48  0.45 N'Diamond+

0.48  0.40 N' B2C+Liquid

5.80E-01  5.40E-02 MWA'  1

1.90E-01  2.40E-01 MWA'  1

0.65E-01  2.50E-01 MWA'  2

CHARSIZE 0.45

-0.10  -0.05 N'A

1.06  -0.05 N'B

0.48   1.05 N'C

CHARSIZE 0.35
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$$ Calculated A-B-C Phase Equilibrium Data:

$ PHASE REGION FOR:

$F0 LIQUID

$E DIAMOND_A4

$F0 B2C

$ INVARIANT EQUILIBRIUM

COLOR   2

BLOCK X=C1; Y=C2;       GOC=C3,WAD;

2.4555855989E-01   3.5568857193E-01   M

0.0000000000E+00   9.9999523163E-01

2.4555855989E-01   3.5568857193E-01   M

6.6666668653E-01   3.3333334327E-01

0.0000000000E+00   9.9999523163E-01   M

6.6666668653E-01   3.3333334327E-01

COLOR   1

BLOCKEND

$ PHASE REGION FOR:

$E LIQUID

$F0 B2C

BLOCK X=C1; Y=C2;       GOC=C3,WAD;

$ PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)

2.2030337155E-01   1.2340000272E-01   M

2.2632879019E-01   1.1058768630E-01

2.3371633887E-01   9.9345825613E-02

2.4253317714E-01   8.9345827699E-02

2.6429468393E-01   7.2744041681E-02

2.8429466486E-01   6.2814079225E-02
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2.9617273808E-01   5.8319382370E-02

3.2811737061E-01   4.9470417202E-02

3.6353862286E-01   4.3130427599E-02

3.9895987511E-01   3.8979098201E-02

4.5209178329E-01   3.5266116261E-02

5.2293431759E-01   3.3152002841E-02

6.1148744822E-01   3.3077053726E-02

6.4690870047E-01   3.3490389585E-02

6.8232995272E-01   3.4017231315E-02

7.3546189070E-01   3.4814555198E-02

7.5317251682E-01   3.5033416003E-02

8.0630439520E-01   3.5373892635E-02

8.5943627357E-01   3.4983776510E-02

9.1256815195E-01   3.3575300127E-02

9.6747112274E-01   3.0857827514E-02

9.6922445297E-01   3.0749246478E-02

2.2030337155E-01   1.2340000272E-01   M

2.1294665337E-01   1.5308913589E-01

2.1171525121E-01   1.8851040304E-01

2.1532440186E-01   2.2393165529E-01

2.2180187702E-01   2.5935292244E-01

2.2992117703E-01   2.9477417469E-01

2.3888295889E-01   3.3019542694E-01

2.4555855989E-01   3.5568857193E-01

$ PLOTTED COLUMNS ARE : X(B2C,B) and X(B2C,C)

6.6666668653E-01   3.3333334327E-01   M

6.6666668653E-01   3.3333334327E-01
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$ TIELINES

COLOR   3

6.6666668653E-01   3.3333334327E-01   M

8.7775242329E-01   3.4625384957E-02

6.6666668653E-01   3.3333334327E-01   M

7.9250496626E-01   3.5342670977E-02

6.6666668653E-01   3.3333334327E-01   M

2.4555824697E-01   3.5568737984E-01

6.6666668653E-01   3.3333334327E-01   M

2.3944084346E-01   9.2542596161E-02

6.6666668653E-01   3.3333334327E-01   M

2.3359020054E-01   3.0954307318E-01

6.6666668653E-01   3.3333334327E-01   M

2.2585247457E-01   2.7766343951E-01

6.6666668653E-01   3.3333334327E-01   M

2.1618695557E-01   1.3621240854E-01

2.2632879019E-01   1.1058768630E-01   M

6.6666668653E-01   3.3333334327E-01

COLOR   1

BLOCKEND

$ PHASE REGION FOR:

$F0 DIAMOND_A4

$E B2C

BLOCK X=C1; Y=C2;       GOC=C3,WAD;

$ PLOTTED COLUMNS ARE : X(DIAMOND_A4,B) and X(DIAMOND_A4,C)

0.0000000000E+00   9.9999523163E-01   M

0.0000000000E+00   9.9999976158E-01
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BLOCKEND

$ PHASE REGION FOR:

$E LIQUID

$F0 DIAMOND_A4

BLOCK X=C1; Y=C2;       GOC=C3,WAD;

$ PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)

2.4555855989E-01   3.5568857193E-01   M

2.0263540745E-01   3.3483061194E-01

1.6243904829E-01   3.1375369430E-01

1.2243904918E-01   2.9153180122E-01

8.2439050078E-02   2.6854267716E-01

4.2439054698E-02   2.4548016489E-01

2.4390530307E-03   2.2313812375E-01

2.4999999937E-07   2.2181616724E-01

$ TIELINES

COLOR   3

0.0000000000E+00   9.9999511242E-01   M

2.3529186845E-01   3.5085919499E-01

0.0000000000E+00   9.9999469519E-01   M

1.9826586545E-01   3.3260950446E-01

0.0000000000E+00   9.9999409914E-01   M

1.3240024447E-01   2.9716023803E-01

0.0000000000E+00   9.9999397993E-01   M

1.1439975351E-01   2.8695335984E-01

BLOCKEND
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Example 7 – Color Codes

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 7 - Color Codes.EXP available with your 
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

Macro Text

$DATAPLOT Example 7 - DIGLIB Colors

PROLOG 1 DIGLIB Colors

XSCALE        0.0       1.0

YSCALE        0.0       1.0

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        15.5000

YLENGTH        11.5000

TITLE  DIGLIB Colors

XTEXT X

YTEXT Y
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DATASET 1 DIGLIB Colors:

$ DIGLIB Colors:

CHARSIZE 0.3

SYMBOLSIZE 0.5

COLOR 1

0.05 0.95 N' Black 1

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.95 M

0.275 0.95 D

BLOCKEND

COLOR 2

0.05 0.85 N' Red 2

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.85 M

0.275 0.85 D

BLOCKEND

COLOR 3

0.05 0.75 N' Green 3

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.75 M

0.275 0.75 D

BLOCKEND

COLOR 4

0.05 0.65 N' Blue 4

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.65 M

0.275 0.65 D

BLOCKEND

COLOR 5

0.05 0.55 N' Yellow 5

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.55 M

0.275 0.55 D

BLOCKEND

COLOR 6
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0.05 0.45 N' Magenta 6

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.45 M

0.275 0.45 D

BLOCKEND

COLOR 7

0.05 0.35 N' Cyan 7

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.35 M

0.275 0.35 D

BLOCKEND

COLOR 8

0.05 0.25 N' Purple 8

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.25 M

0.275 0.25 D

BLOCKEND

COLOR 9

0.05 0.15 N' Gold 9

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.15 M

0.275 0.15 D

BLOCKEND

COLOR 10

0.05 0.05 N' Turquoise 10

BLOCK X=C1; Y=C2; GOC=C3,N

0.175 0.05 M

0.275 0.05 D

BLOCKEND

COLOR 11

0.5 0.95 N' Pink 11

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.95 M

0.725 0.95 D

BLOCKEND
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COLOR 12

0.5 0.85 N' Gray 12

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.85 M

0.725 0.85 D

BLOCKEND

COLOR 13

0.5 0.75 N' Orange-red 13

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.75 M

0.725 0.75 D

BLOCKEND

COLOR 14

0.5 0.65 N' Maroon 14

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.65 M

0.725 0.65 D

BLOCKEND

COLOR 15

0.5 0.55 N' Plum 15

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.55 M

0.725 0.55 D

BLOCKEND

COLOR 16

0.5 0.45 N' Sea green 16

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.45 M

0.725 0.45 D

BLOCKEND

COLOR 17

0.5 0.35 N' Olive 17

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.35 M

0.725 0.35 D
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BLOCKEND

COLOR 18

0.5 0.25 N' Sienna 18

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.25 M

0.725 0.25 D

BLOCKEND

COLOR 19

0.5 0.15 N' Orange 19

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.15 M

0.725 0.15 D

BLOCKEND

COLOR 20

0.5 0.05 N' Coral 20

BLOCK X=C1; Y=C2; GOC=C3,N

0.625 0.05 M

0.725 0.05 D

BLOCKEND
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Example 8 - DIGLIB Symbols

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 8 - DIGLIB Symbols.EXP available with your 
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

A default symbol is the current symbol in the run of the  software (it is usually the No 1 
symbol if the POST-processor is switched on for the first time). S (i.e., # is not specified) 
means that the current symbol is plotted. S0 (i.e., #=0) means that no symbol is plotted.

Macro Text

$DATAPLOT DIGLIB Symbols 2

PROLOG 1 DIGLIB Symbols 2 0<X<2.0, 0<Y<1.2

XSCALE        0.0       2.0

YSCALE        0.0       1.2

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        15.5000
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YLENGTH        11.5000

TITLE  DIGLIB Symbols

XTEXT  DIGLIB SYMBOLS

DATASET 1 Various DIGLIB Symbols:

$ DIGLIB Symbols:

CHARSIZE 0.3

SYMBOLSIZE 0.5

0.05   0.95 WS1'   1

0.05   0.85 WS2'   2

0.05   0.75 WS3'   3

0.05   0.65 WS4'   4

0.05   0.55 WS5'   5

0.05   0.45 WS6'   6

0.05   0.35 WS7'   7

0.05   0.25 WS8'   8

0.05   0.15 WS9'   9

0.05   0.05 WS10'   10

0.15   0.95 WS11'   11

0.15   0.85 WS12'   12

0.15   0.75 WS13'   13

0.15   0.65 WS14'   14

0.15   0.55 WS15'   15

0.15   0.45 WS16'   16

0.15   0.35 WS17'   17

0.15   0.25 WS18'   18

0.15   0.15 WS19'   19

0.15   0.05 WS20'   20

0.25   0.95 WS100'   100

0.25   0.85 WS101'   101

0.25   0.75 WS102'   102

0.25   0.65 WS103'   103

0.25   0.55 WS104'   104

0.25   0.45 WS105'   105

0.25   0.35 WS106'   106

0.25   0.25 WS107'   107
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0.25   0.15 WS108'   108

0.25   0.05 WS109'   109

0.35   0.95 WS110'   110

0.35   0.85 WS111'   111

0.35   0.75 WS112'   112

0.35   0.65 WS113'   113

0.35   0.55 WS114'   114

0.35   0.45 WS115'   115

0.35   0.35 WS116'   116

0.35   0.25 WS117'   117

0.35   0.15 WS118'   118

0.35   0.05 WS119'   119

0.45   0.95 WS120'   120

0.45   0.85 WS121'   121

0.45   0.75 WS122'   122

0.45   0.65 WS123'   123

0.45   0.55 WS124'   124

0.45   0.45 WS125'   125

0.45   0.35 WS126'   126

0.45   0.25 WS127'   127

0.45   0.15 WS128'   128

0.45   0.05 WS129'   129

0.55   0.95 WS130'   130

0.55   0.85 WS131'   131

0.55   0.75 WS132'   132

0.55   0.65 WS133'   133

0.55   0.55 WS134'   134

0.55   0.45 WS135'   135

0.55   0.35 WS136'   136

0.55   0.25 WS137'   137

0.55   0.15 WS138'   138

0.55   0.05 WS139'   139

0.65   0.95 WS140'   140

0.65   0.85 WS141'   141

0.65   0.75 WS142'   142
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0.65   0.65 WS143'   143

0.65   0.55 WS144'   144

0.65   0.45 WS145'   145

0.65   0.35 WS146'   146

0.65   0.25 WS147'   147

0.65   0.15 WS148'   148

0.65   0.05 WS149'   149

0.75   0.95 WS200'   200

0.75   0.85 WS201'   201

0.75   0.75 WS202'   202

0.75   0.65 WS203'   203

0.75   0.55 WS204'   204

0.75   0.45 WS205'   205

0.75   0.35 WS206'   206

0.75   0.25 WS207'   207

0.75   0.15 WS208'   208

0.75   0.05 WS209'   209

0.85   0.95 WS210'   210

0.85   0.85 WS211'   211

0.85   0.75 WS212'   212

0.85   0.65 WS213'   213

0.85   0.55 WS214'   214

0.85   0.45 WS215'   215

0.85   0.35 WS216'   216

0.85   0.25 WS217'   217

0.85   0.15 WS218'   218

0.85   0.05 WS219'   219

0.95   0.95 WS220'   220

0.95   0.85 WS221'   221

0.95   0.75 WS222'   222

0.95   0.65 WS223'   223

0.95   0.55 WS224'   224

0.95   0.45 WS225'   225

0.95   0.35 WS226'   226

0.95   0.25 WS227'   227
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0.95   0.15 WS228'   228

0.95   0.05 WS229'   229

1.05   0.95 WS300'   300

1.05   0.85 WS301'   301

1.05   0.75 WS302'   302

1.05   0.65 WS303'   303

1.05   0.55 WS304'   304

1.05   0.45 WS305'   305

1.05   0.35 WS306'   306

1.05   0.25 WS307'   307

1.05   0.15 WS308'   308

1.05   0.05 WS309'   309

1.15   0.95 WS310'   310

1.15   0.85 WS311'   311

1.15   0.75 WS312'   312

1.15   0.65 WS313'   313

1.15   0.55 WS314'   314

1.15   0.45 WS315'   315

1.15   0.35 WS316'   316

1.15   0.25 WS317'   317

1.15   0.15 WS318'   318

1.15   0.05 WS319'   319

1.25   0.95 WS320'   320

1.25   0.85 WS321'   321

1.25   0.75 WS322'   322

1.25   0.65 WS323'   323

1.25   0.55 WS324'   324

1.25   0.45 WS325'   325

1.25   0.35 WS326'   326

1.25   0.25 WS327'   327

1.25   0.15 WS328'   328

1.25   0.05 WS329'   329

1.35   0.95 WS330'   330

1.35   0.85 WS331'   331

1.35   0.75 WS332'   332
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1.35   0.65 WS333'   333

1.35   0.55 WS334'   334

1.35   0.45 WS335'   335

1.35   0.35 WS336'   336

1.35   0.25 WS337'   337

1.35   0.15 WS338'   338

1.35   0.05 WS339'   339

1.45   0.95 WS340'   340

1.45   0.85 WS341'   341

1.45   0.75 WS342'   342

1.45   0.65 WS343'   343

1.45   0.55 WS344'   344

1.45   0.45 WS345'   345

1.45   0.35 WS346'   346

1.45   0.25 WS347'   347

1.45   0.15 WS348'   348

1.45   0.05 WS349'   349

1.55   0.95 WS350'   350

1.55   0.85 WS351'   351

1.55   0.75 WS352'   352

1.55   0.65 WS353'   353

1.55   0.55 WS354'   354

1.55   0.45 WS355'   355

1.55   0.35 WS356'   356

1.55   0.25 WS357'   357

1.55   0.15 WS358'   358

1.55   0.05 WS359'   359

1.65   0.95 WS360'   360

1.65   0.85 WS361'   361

1.65   0.75 WS362'   362

1.65   0.65 WS363'   363

1.65   0.55 WS364'   364

1.65   0.45 WS365'   365

1.65   0.35 WS366'   366

1.65   0.25 WS367'   367
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1.65   0.15 WS368'   368

1.65   0.05 WS369'   369

1.75   0.95 WS370'   370

1.75   0.85 WS371'   371

1.75   0.75 WS372'   372

1.75   0.65 WS373'   373

1.75   0.55 WS374'   374

1.75   0.45 WS375'   375

1.75   0.35 WS376'   376

1.75   0.25 WS377'   377

1.75   0.15 WS378'   378

1.75   0.05 WS379'   379

1.85   0.95 WS380'   380

1.85   0.85 WS381'   381

1.85   0.75 WS382'   382

1.85   0.65 WS383'   383

1.85   0.55 WS384'   384

1.85   0.45 WS385'   385

1.85   0.35 WS386'   386

1.85   0.25 WS387'   387

1.85   0.15 WS388'   388

1.85   0.05 WS389'   389

$ DIGLIB Line Types:

LINETYPE 1

BLOCK X=C1; Y=C2; GOC=C3,DWA

0.05 1.10 M

0.35 1.10

BLOCKEND

LINETYPE 2

BLOCK X=C1; Y=C2; GOC=C3,DWA

0.45 1.10 M

0.75 1.10

BLOCKEND

LINETYPE 3

BLOCK X=C1; Y=C2; GOC=C3,DWA
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0.85 1.10 M

1.15 1.10

BLOCKEND

LINETYPE 4

BLOCK X=C1; Y=C2; GOC=C3,DWA

1.25 1.10 M

1.60 1.10

BLOCKEND

0.10 1.12 W' LINETYPE 1

0.50 1.12 W' LINETYPE 2

0.90 1.12 W' LINETYPE 3

1.30 1.12 W' LINETYPE 4
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Example 9 - DIGLIB Fonts and Lines

The macro text below produces the example output. You can copy the text into your own 
EXP file, or use the example file DATAPLOT 9 - DIGLIB Fonts.EXP available with your 
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals 
Folder.

Output Example

Macro Text

$DATAPLOT Example 9 - DIGLIB Fonts

PROLOG 1 DIGLIB Fonts & Line Types 0<X<1, 0<Y<1

XSCALE        0.0       1.0

YSCALE        0.0       1.0

XTYPE LINEAR

YTYPE LINEAR

XLENGTH        11.5000

YLENGTH        11.5000

TITLE  DIGLIB Fonts

XTEXT  X

YTEXT  Y
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DATASET 1 Various DIGLIB Fonts and Line Types:

$ DIGLIB Fonts:

CHARSIZE .35

FONT 1

0.05   0.95 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 2

0.05   0.90 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 3

0.05   0.85 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 5

0.05   0.80 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 10

0.05   0.75 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 11

0.05   0.70 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 12

0.05   0.65 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 13

0.05   0.60 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 14

0.05   0.55 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 15

0.05   0.50 N'ABCDEFGHIJKLmnopqrstuvwxyz

FONT 1

CLIP OFF

CHARSIZE .30

1.10   0.95 N'FONT 1

1.10   0.90 N'FONT 2

1.10   0.85 N'FONT 3

1.10   0.80 N'FONT 5

1.10   0.75 N'FONT 10

1.10   0.70 N'FONT 11

1.10   0.65 N'FONT 12

1.10   0.60 N'FONT 13

1.10   0.55 N'FONT 14
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1.10   0.50 N'FONT 15

CLIP ON

$ DIGLIB Line Types:

LINETYPE 1

BLOCK X=C1; Y=C2; GOC=C3,DWA

0.05 0.40 M

0.50 0.40

BLOCKEND

$DRAWLINE 0.05,0.40 0.5,0.40

LINETYPE 2

BLOCK X=C1; Y=C2; GOC=C3,DWA

0.05 0.30 M

0.50 0.30

BLOCKEND

$DRAWLINE 0.05,0.30 0.5,0.30

LINETYPE 3

BLOCK X=C1; Y=C2; GOC=C3,DWA

0.05 0.20 M

0.50 0.20

BLOCKEND

$DRAWLINE 0.05,0.20 0.5,0.20

LINETYPE 4

BLOCK X=C1; Y=C2; GOC=C3,DWA

0.05 0.10 M

0.50 0.10

BLOCKEND

$DRAWLINE 0.05,0.10 0.5,0.10

0.55   0.40 N' LINETYPE 1

0.55   0.30 N' LINETYPE 2

0.55   0.20 N' LINETYPE 3

0.55   0.10 N' LINETYPE 4
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About Pourbaix Diagrams in Thermo-Calc

This guide is for Thermo-Calc software users who know the basics of thermodynamics and 
want to know more about Pourbaix Diagrams.

You are introduced to the concept of a Pourbaix diagram and shown how to interpret such 
diagrams through a series of examples.

Materials corrosion occurs almost everywhere. It may lead to serious material damages, 
unexpected application failures, tremendous economic costs and environmental 
degradations.  Consequently, scientists and engineers must often conduct expensive and 
time-consuming corrosion experiments as part of failure analyses, risk evaluations, quality 
improvements and application enhancements.

Under certain conditions, when a metal or alloy is exposed to an aqueous solution with a 
concentration of inorganic/organic mixture, corrosion phenomena occur at a corresponding 
degree. During corrosion, some metallic phases dissolve, the metal or alloy surface gets 
damaged and some secondary solid phases form at the solid-liquid interfaces (such as 
oxides, hydroxides, silicates, sulphides, sulphates, carbonates, nitrates, phosphates, borates, 
or halides). Such corrosive chemical or electrochemical reactions can be studied by means of 
the so-called Pourbaix diagrams if the reactions reach their equilibrium states 
[1973/1974Pou; 2003Cra; 2011Ver; 2011Tho]. 

GES5 and GES6 Calculation Engine Version

As of Thermo-Calc version 2019b, the default calculation engine is set to GES6. For  
POURBAIX module users, you need to use GES5. When you try to enter this module, you are 
instructed to switch to GES5 using the SET_GES_VERSION command. 

About the Gibbs Energy System (GES) Module

To globally set the default from GES6 back to GES5, go to the Options window 
Global General Settings tab and click Version 5 for the Preferred Gibbs Energy 
System setting. The SET_GES_VERSION Console Mode command is used to 
change GES versions for a single Thermo-Calc session.  
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Contact Thermo-Calc Software AB at info@thermocalc.com for more 
information about the changes or if you encounter any issues you think are 
related to the new version of the calculation engine. 

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. However, not all GES5 functionality is implemented in GES6. In such 
cases (except for  the POURBAIX module), GES6 falls back silently and uses 
functionality from GES5 in the background. 
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Pourbaix Diagrams

Marcel Pourbaix applied thermodynamics to predict materials corrosion resistance. He 
determined the phase stability relations in terms of varied pH and Eh values for an 
interaction system of metal and pure water or dilute aqueous solution. He presented the 
stability regions of metal and secondary phases (such as metal-oxides/hydroxides) on a pH-
Eh diagram, which is now known as a Pourbaix diagram. 

A Pourbaix diagram is a kind of phase diagram that shows the stability boundaries for a 
metal-aqueous interaction system. The phase boundaries are shown as a function of pH 
(acidity) and Eh (standard hydrogen electronic potential). An aqueous solution phase is 
always present in such a system. At a given pH and Eh, a metal may lose its stability to a 
soluble or corrosive aqueous solution, or be in equilibrium with either the aqueous solution 
(insoluble/immune) or with a secondary-phase file that has formed (consisting of oxides, 
hydroxides, sulphides or other solids). In the latter case, further dissolution of the passive or 
protective metal is prevented. 

The speciation and partition in the aqueous solution and the interacting phases depend not 
only on pH and Eh, but also on other factors such as the bulk composition, temperature and 
pressure in the system. The interacting phases may be gas mixtures, stoichiometric solids or 
solid solutions.

A Pourbaix diagram is divided in regions of immunity, corrosion and passivity. These regions 
provides information about the stability of a particular metal or alloy in a specific aqueous 
electrochemical environment under certain pH, Eh, pressure and temperature conditions. 

 l The immunity region is the region in which there is no metal dissolution.
 l The corrosion region is the region in which there is active metal dissolution.
 l The passivation region is the region in which a protective metal-oxide film that 

prevents metal dissolution is formed.   

The following shows these three regions in a Pourbaix diagram for the heterogeneous 
interaction between 0.001 mole of austenite steel (Fe-19Cr-9Ni [at%]) and 1 kg of water 
(with 3 m NaCl), at 200° C and 100 bar:
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Depending on the system’s bulk chemical composition, secondary phases may form during 
the transformation process. These can not only be oxides, but also be, for example, 
hydroxides, sulphides, sulphates, carbonates, nitrates, phosphates, borates, silicates, 
hydrous silicates and halides. Information about these secondary phases may help one 
understand the passivation behaviours in corrosion processes. For example, it may be 
important to understand whether any secondary phases are formed in different pH-Eh 
regions during hydrolysis, oxidation, reduction or other reaction processes. 

In a Pourbaix diagram, the predominant ion boundaries are often represented by dashed 
and straight lines imposed on a traditional Pourbaix diagram for a simple interaction system 
(Pourbaix, 1973, 1974; Cramer and Covino, 2003; Verink, 2011; Thompson et al., 2011). Such 
a predominance boundary is normally an equal molality (or equal activity) line for a pair of 
two most-concentrated aqueous solute species (charged or neutral) involving a common 
metal. A line is then simply determined by a reaction constant of its corresponding 
electrochemical reaction in the homogeneous aqueous solution phase. However, this is not 
the case in Thermo-Calc. 

You cannot get any information about predominant ion boundaries from a 
Pourbaix diagram in Thermo-Calc.
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Working with Pourbaix Diagrams

With the Thermo-Calc software package, Pourbaix diagrams can be calculated over a wide 
range of pressure, temperature and composition conditions for complex heterogeneous 
interactions between multicomponent primary alloy solution or compound phases, 
concentrated aqueous solutions (with dissolved inorganic and organic substances), 
complicated secondary solids and oxidizing/reducing gaseous mixtures. In the Console 
Mode, diagrams can be calculated and plotted either using the response-driven POURBAIX 
module or directly using the DATA, GIBBS, POLY and POST modules. 

This command or module is not available with GES6. 

GES6 is a re-write and new implementation of the Gibbs Energy System module 
of Thermo-Calc and it is the default engine. The previous version, GES5, is still 
available and will continue to work in the background of the program where 
necessary. The main purpose of GES6 is to support faster development of new 
features. However, not all GES5 functionality is implemented in GES6. In such 
cases (except for  the POURBAIX module), GES6 falls back silently and uses 
functionality from GES5 in the background. 

It is possible in Thermo-Calc to set aqueous properties other than pH and Eh as axis 
variables. For example, the following properties can also be set as axis variables: Ah 
(electronic affinity), pe (electronic activity log10ACRe), IS (ionic strength), TM (total aqueous 
concentration, in molality), OC (Osmotic coefficient), activity or activity coefficient of solvent 
H2O, and activities or activity coefficients or concentrations in m (molality) of charged or 
neutral solute species.

Beside a concentrated aqueous solution phase handled by a proper thermodynamic model 
named SIT, HKF or PITZ, it is also possible to consider complex alloy solution phases or 
compound phases, as well as secondary solid phases and gaseous mixtures, which are 
treated by specific solution models. 

Most frequently, a Pourbaix diagram is calculated for a specific alloyed phase with the initial 
alloying composition, such as the FCC solution phase in an austenite steel. However, it is 
possible to calculate a Pourbaix diagram for two co-existing phases, such as the FCC+BCC 
solution phases in a duplex steel for example, or even for more than two co-existing phases 
in a steel/alloy.
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Each point on the line in a pH-Eh diagram in Thermo-Calc represents a certain 
minimum state of Gibbs energy. When a line is crossed, a phase transformation 
should occur. This means that a Pourbaix diagram in Thermo-Calc does not 
provide any information about any predominant ion boundary.  
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Key Concepts

The following are two key concepts important for understanding how aqueous solutions 
behave and  how an aqueous-bearing heterogeneous interaction system is properly defined 
and calculated in Thermo-Calc.

Effective Interaction Ratio

A pH-Eh plot is always related to a certain amount of initial alloys or other condensed 
materials that has effectively reacted with an aqueous solution in the system. This is the 
amount of condensed material that is fully in equilibrium with the defined aqueous solution 
phase. The amount is specified relative to an aqueous solution that is normally comprised of 
1 kg of water with certain specified solute concentrations at certain temperature and 
pressure conditions. (This is why a calculated Pourbaix diagram is typically presented for an 
initial amount of the interacting metal or alloy at a certain level, such as 10-6, 1E-3, 0.1 or 1 
mole of metal or alloy.) It is called the Effective Interaction Ratio (between the initial alloy or 
alloyed phases and the initial aqueous solution) and it is expressed in terms of molality 
(mol/kg). 

The Effective Interaction Ratio is important for two reasons. First, the ratio has implications 
for kinetic or dynamic effects such as chemical reaction mechanism and kinetics, fluid flow 
dynamics, surface area and interaction time. Secondly, the ratio, being expressed as 10-6 
mole of metal (or alloy), is the solubility limit that can be detected for cathodic corrosion 
protection by immunity.

One should always be careful when setting initial amounts and compositions in the original 
condensed materials, as well as when setting the initial concentrations of dissolved solutes 
in the original aqueous solution phase. It is often useful to make a series of calculations for 
different levels of initial amount of the interacting metal/alloy while the conditions are fixed 
for other settings (such as initial aqueous concentration, pressure, temperature, pH, and Eh).

Solubility

When a heterogeneous equilibrium has a dissolving solution or mixture phase and a 
stoichiometric or solution phase, then the concept of solubility becomes important. A 
solubility of a phase (the solute) is its property of dissolving in the solvent phase.  This 
concept concerns the constitution of a phase and is applied where one or several of the 
constituents are dominant (which is highly concentrated and dissolving) while there are only 
small amounts of the other remaining species (which are less concentrated and dissolved). 
The dissolving solution or mixture phase can be liquid, gas, aqueous or solid, as long as it has 
dissolving capacity. The stoichiometric or solution phase has some constituents which tend 
to be dissolved into the dissolving solution or mixture phase.
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Key Points about Solubility
 l Under certain temperature, pressure and composition conditions, a Fe- or Cr-

dominant BCC phase can dissolve certain amounts of Ni and C from a carbide phase 
such as M23C6, M7C3 or M3C. The Ni and C elements in the carbides have the 
solubility defined relative to the BCC phase.

 l An aqueous solution phase is always dominant in the solvent water, that is, H2O. 
Under specific temperature, pressure and aqueous composition conditions, any 
other element (such as Fe and C) or substance (such as a pure SO2 gas, 
stoichiometric phase Cu2S and solution phase (Fe,Ni)1(O,Va)1) have a certain 
solubility limit in the defined aqueous solution.

 l Under certain temperature and pressure conditions, and under given certain 
concentrations of other dissolved species in the mixture, an O2-dominant gaseous 
mixture phase can dissolve certain amounts of Fe+2 or Fe+3 species from magnetite 
(Fe3O4). The magnetite solid has solubility defined relative to the gaseous mixture 
under the given conditions.

 l Under certain temperature and pressure condition, under specific concentrations of 
other dissolved species in the liquid phase, a Fe-dominant liquid mixture phase can 
dissolve certain amounts of, for example, Cr and O. The Cr and O components have 
the solubility defined in the liquid mixture.
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Basic Settings and Definitions

In a homogeneous aqueous solution or an aqueous-bearing heterogeneous interaction 
system, the most essential definition is for system-components there must be H2O, H+1 and 
ZE (electron) plus those for elements dissolved in aqueous solution (such as Na, Cl, S) and 
associated in interacting metals/alloys (such as Fe, Cr, Mn, Mg, Ni, Al, Si, Zn). Three 
fundamental phases in a system are the AQUEOUS solution, the GAS mixture and the REF_
ELECTRODE. The REF_ELECTRODE phase is used for setting the reference state for electrostatic 
potential in the system and for calculating the Eh condition (defined as MUR(ZE)/RNF). Other 
phases should be appropriately selected and retrieved from critically-assessed databases 
that cover not only the target phases (solution or stoichiometric) in interacting metals/alloys 
but also the secondary phases (solution or stoichiometric). The two public databases PAQ 
and PAQS are specially designed as single-database choices that cover all kinds of phases 
necessary for calculations. However, these databases are each limited to a framework of a 
very small number of elements. When it comes to simulations of complex multicomponent 
systems with a wide variety of elements and phases, the thermodynamic data must be 
selected and retrieved from several databases: AQUEOUS solution and REF_ELCTRODE phases 
must be retrieved from TCAQ or AQS; alloy phases (such as FCC_A1, BCC_A2, HCP_A3, 
CEMENTITE) from alloy solution databases (such as SSOL for general alloy phases, TCFE for 
steel/Fe-alloy phases, TCAL for Al-based alloy phases; TCMG for Mg-based alloy phases, and 
TCNI for Ni-based superalloy phases); gaseous mixture phase and secondary phases from 
specific substance or solution databases (such as SSUB for GAS phase and various solid 
compound phases or TCOX for oxide solution phases). Note that the REF_ELECTRODE phase 
should always be suspended in equilibrium calculations, while GAS phase could be set as 
ENTERED, SUSPENDED or DORMANT, depending on the purpose of the calculation. 

When defining an interaction system, the initial condition for the H2O component is always 
set as 1 kg of water. The initial composition conditions for dissolving and interacting 
elements are normally defined in moles (such as n(Fe)=0.009, n(Cr)=5E-4, n(Ni)=3E-4, n
(Mn)=5E-5, n(S)=5E-5, n(Na)=3, n(Cl)=3). This makes it straightforward and convenient to 
count various related aqueous solution properties based on molality. The initial conditions 
for the H+1 and ZE components can be given as molar compositions (such as n(H+1)=0, n
(ZE)=0) or their activities or potentials (such as lnACR(H+1)=-9.21, MUR(ZE)=8400). 

The pH and Eh properties of the aqueous solution in the interacting system are always 
defined in the following way: 

pH = -log10[ACR(H+1,AQUEOUS)*AH2O]]Eh = MUR(ZE)/RNF

The symbol AH2O is the molecular weight of solvent H2O (equals 55.508435) and RNF is the 
Faraday constant (equals 96485.309). 
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The activity of the solvent water (ACRH2O, Aw), the osmatic coefficient of aqueous solution 
(OSMC, Os), electronic affinity (Ah), electronic activity log10ACRe (pe), ionic strength (IS), total 
aqueous concentration, in molality (TM) and total alkaline concentrations under two 
definitions (At1/AT2) are calculated and listed for each equilibrium state. 

POLY3 calculations for mass balances in Thermo-Calc are always based on site-fractions. 
Consequently, when functions for describing various properties of aqueous solutes are 
defined, such as molality (MLi), activity coefficient (RCi) and activity (AIi), they should be 
converted to molality-based quantities:

MLi = Y(AQUEOUS,i)*AH2O/YH2O

RCi = ACR(i,AQUEOUS)*YH2O/Y(AQUEOUS,i)

AIi = ACR(i,AQUEOUS)*AH2O

Here, YH2O is the site-fraction of solvent H2O and AH2O equals 55.508435.

Many more variables, functions and tables can be entered for various purposes. For 
instance, an equilibrium constant for a homogeneous reaction or a solubility product for a 
solid dissolution reaction can be entered. 
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Thermodynamic Data Requirements
In this section:

Required Thermodynamic Data 14

Including or Excluding the Gas Phase 15



Thermo-Calc Documentation Set

Pourbaix Diagrams ǀ 14 of 29

Required Thermodynamic Data

To calculate a Pourbaix diagram, thermodynamic data for at least the following four types of 
phases must be available:

 l The aqueous solution phase which applies a certain aqueous solution model. In 
Thermo-Calc, information about this phase could be retrieved from, for instance, the 
TCAQ or AQS database (these also include data for the REF_ELECTRODE phase that is 
used for setting the reference state of the standard hydrogen electrode).

 l The alloy solution and/or compound phases for the primary matrix phases (and 
possibly also for the precipitated phases in the alloy. Examples of such phases include 
FCC_A1, BCC_A2, HCP_A3, SIGMA and CEMENTITE. In Thermo-Calc, information 
about such phases could be retrieved from, for example, the TCFE database for 
steels/Fe-alloys, the TCNI database for Ni-based superalloys, the TCAL database for 
Al-based alloys, the TCMG database for Mg-based alloys, the TCSLD for Sn-/Au-/Bi-
/Zn-based solder alloys or the SSOL for general alloys. 

 l The secondary solid phases that would form as a result of the heterogeneous 
chemical or electrochemical reactions. These phases could be, for example, oxides, 
hydroxides, silicates, hydrous silicates, sulphides, sulphates, carbonates, nitrates, 
phosphates, borates or halides. In Thermo-Calc, information about such phases could 
be retrieved from, for example, the SSUB database for pure solid compounds or the 
TCOX database for complex oxide solids.

 l The gaseous mixture phase. Information about this phase could be retrieved from, 
for example, the SSUB database. However, note that is also possible to perform 
Pourbaix diagram calculations that ignore the gaseous mixture phase.

All this thermodynamic data about the various phases must be critically assessed and 
internally consistent. Furthermore, when the data is retrieved from several databases, the 
data taken from each database must be consistent with the data taken from the other 
databases. When Pourbaix diagrams and other diagrams of steel corrosion processes are 
calculated, it is typically recommended that the TCAQ, TCFE, SSUB and TCOX databases or 
the AQS, TCFE, SSUB and TCOX are used in combination. 

The public PAQ database contains thermodynamic data for all four phase types and can be 
used for calculating Pourbaix diagrams. They have been designed specifically for the purpose 
of demonstrating the POURBAIX module functionality in Thermo-Calc. However, these 
databases only allow you to perform test calculations for simple cases with major phases in 
which only a few elements can be considered.
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Including or Excluding the Gas Phase

Under defined pressure and temperature conditions, the solvent water’s thermodynamic 
stability limits are determined by the following two electrochemical reactions:

H2O(water) + 2e- = H2(gas) + 2OH-1

2H2O(water) = O2(gas) + 4H+1 + 4e-

The first reaction describes the formation of H2-dominated gaseous mixture, under reducing 
conditions. The second reaction describes the formation of O2-dominated gaseous mixture, 
under oxidising conditions. 

If the system reaches global equilibrium, then the water component is electrolyzed to H+ 
and O-2 at all pH conditions. The degree of electrolysis depends on the pH value in the 
aqueous solution phase. If Eh gets high enough, then the O-2 anion is oxidized to O2 (aqs). 
On the other hand, if Eh gets low enough, then the H+ cation is reduced to H2 (aqs). The 
major electrolysis and redox reactions are the following:

H2O (water) = H+ + OH-  → Electrolysis of water at all pH.

H2O (water) = 2H+ + O-2  → Electrolysis of water at all pH.

O-2 - 2e- = 0.5O2 (aqs) → Oxidation or de-electronization of O-2 at high 
Eh.

2H+ + 2e- = H2 (aqs)  → Reduction or electronization of H+ at low Eh.

At a critically high Eh value under a given pH condition, an aqueous solution phase with a 
high enough O2 activity becomes less stable than an O2-dominated gaseous mixture phase. 
At this point, the gas phase replaces the aqueous solution phase in the system. The 
replacement process can be characterised by the following phase-transformation on the 
aqueous-gas phase boundary and oxidation of remaining water: 

O2 (aqs)  = O2 (gas)

H2O (water) - 2e- = 2H+(gas) + 0.5O2 (gas) 

Similarly, at a critically low Eh value under a given pH condition, an aqueous solution phase 
with a high enough H2 activity becomes less stable than a H2-dominated gaseous mixture 
phase. At this point, the gas phase replaces the aqueous solution phase in the system, 
through the following phase-transformation on the aqueous-gas phase boundary and 
reduction of remaining water:  

H2 (aqs)  = H2 (gas)

H2O (water) + 2e- = O-2 (gas) + H2 (gas) 
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The phase transformation from an aqueous solution phase to an O2- or H2-dominated 
gaseous mixture phase also depends on the total molar Gibbs energies of the phases (which 
are complex functions of the phase constituents, the temperature and the pressure). The 
Gibbs energy minimization technique used in Thermo-Calc ensures that the phase 
transformation is accurately simulated.

The following Pourbaix diagrams show the result of a calculation where the gaseous mixture 
phase was included. In the upper region (high Eh) and lower region (low Eh), the aqueous 
solution phase has been oxidized and reduced, respectively, to an O2- or H2-dominated 
gaseous mixture phase. 

The two example diagrams show that the upper and lower boundaries between the aqueous 
phase (water) and the gas phase (dominated by either O2 or H2) can shift when solutes 
dissolve or when the temperature and pressure change.  

Accordingly, if one does not take a gaseous mixture phase into account when performing a 
calculation of Pourbaix diagram (as above), then the aqueous solution phase may end up 
with an extremely high O2 (aqs) concentration at high Eh condition, or an extremely high H2 
(aqs) concentration at low Eh condition. Under either of these two extreme circumstances, 
the concept of “aqueous solution phase” is no longer valid and consequently no proper 
aqueous solution model can actually be applied. Therefore, from a restrictive 
thermodynamic equilibrium point of view, one shall normally include a gaseous mixture 
phase in an aqueous-bearing heterogeneous interaction system. This is true for all types of 
equilibrium calculations for an aqueous-bearing heterogeneous interaction system, not only 
of Pourbaix diagram calculations.

Hence, to perform a completely accurate Pourbaix diagram calculation, the gaseous mixture 
phase must be taken into account. However, since these electrochemical reactions normally 
have much higher kinetic barriers and are slower than other electrochemical and chemical 
reactions in the interaction system, one can sometimes ignore the gaseous mixture phase in 
the calculation. Note that if the gaseous mixture phase is ignored in this way, then the 
Pourbaix diagram does not show the H2O-stability limiting lines.
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Examples

Figure 1: A pH-Eh diagram for pure water at 25° C and 1 bar.
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Figure 2: A pH-Eh diagram for 3mNaCl-0.001mCO2-0.001mSO2 aqueous solution at 150° C and 
100 bar.
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Examples of Pourbaix Diagrams for Fe
The following two topics are examples of Pourbaix diagrams for Fe. For the first example, 
the calculations on which the diagrams are based have not taken the gas phase into account. 
The diagrams in the second example are based on calculations that have taken the gas phase 
into account. 

In this section:

Pourbaix Diagrams with Gas Phase Excluded 20

Pourbaix Diagrams with Gas Phase Included 21
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Pourbaix Diagrams with Gas Phase Excluded

This is an example of a Pourbaix diagram of Fe, in which the gas phase has not been 
considered in the calculation. The system has 0.001 mole of Fe in 1 kg of pure water at a 
temperature of 25oC and a pressure of 1 bar. Magnetite (Mt, Fe3O4) and hematite (Hm, 
Fe2O3) co-exist with the Fe-containing dilute aqueous solution. The formation of magnetite 
and hematite represent the passivation of iron in the upper right pH-Eh field. 

If pH is low and Eh is relatively high, then Fe eventually completely dissolves into the 
aqueous solution phase. Under conditions of low Eh, Fe remains in its stable solid state, the 
BCC phase, and neither dissolves into water nor into alternates to Fe (the immunity of Fe).
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Pourbaix Diagrams with Gas Phase Included

With all the possible redox reactions involving the aqueous solution phase and gaseous 
mixture phase being considered in the equilibrium system, that is, the gaseous mixture 
phase is included in the calculation, the Pourbaix diagram of Fe in a system with 0.001 mole 
of Fe in 1 kg of pure water at 25oC and 1 bar. 

Comparing this Pourbaix diagram with that from Basic Settings and Definitions, you can see 
that both diagrams are for the same interaction system under the same temperature-
pressure condition, but the present diagram shows the results of calculations where the 
gaseous mixture phase has been included. It presents the complete Pourbaix diagram for the 
defined interaction system, in a full thermodynamic equilibrium. In the upper region (high 
Eh) and lower region (low Eh), the aqueous solution phase is oxidised and reduced to the 
O2- or H2-dominated gas phase. Hematite coexists with the O2-dominated gas, while Fe-BCC 
is stable with the H2-dominated gas. The stability field of magnetite may extend slightly into 
the H2-dominated gas region, where it coexists with the gaseous mixture instead of the 
aqueous solution. Its boundary with Fe (BCC) cannot be drawn due to the absence of 
aqueous solution phase.

It is not possible to calculate the pH value in both the O2- and H2-dominated gaseous 
mixture phase stability regions where the aqueous solution phase is absent. Hence, in a 
normal Pourbaix diagram, no line is drawn that indicates a phase boundary between the gas 
phase and the metallic phases or secondary phases (that is, metal-oxides).
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Other Examples of Pourbaix Diagrams
In this section:

Variations of Pourbaix Diagrams 23

Pourbaix Diagrams for Complex Alloys 26
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Variations of Pourbaix Diagrams

The shape of a Pourbaix diagram of an alloy or condensed material and the stability relations 
of various secondary phases depend upon the following system factors:  

 l Initial amount of the alloy or other condensed materials 
 l Initial composition of the alloy or other condensed materials 
 l Initial amount of the interacting aqueous solution phase 
 l Initial composition of the interacting aqueous solution phase 
 l Temperature and pressure conditions 

In the interaction system that the diagrams in Pourbaix Diagrams with Gas Phase Excluded 
and Pourbaix Diagrams with Gas Phase Included are based on, the initial amount of pure Fe 
that was taken to have effectively reacted with 1 kg of pure water at 25° C and 1 bar was 
0.001 m. The following diagrams are Pourbaix diagrams of Fe where other initial amounts of 
pure Fe have been used, or where the interacting aqueous solution compositions have been 
alternated, or the temperature and/or pressure have been changed. Gaseous mixture 
phases have been included in all the calculations that these diagrams are based on.

Figure 1: 1E-3 m Fe actively reacted with 1 kg of pure water at 25° C and 1 bar (as in the 
calculation in Pourbaix Diagrams with Gas Phase Included).
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Figure 2: 1E-6 m Fe actively reacted with 1 kg of pure water at 25° C and 1 bar. Note that the 
active metal corrosion region gets enlarged as the initial Fe amount decreases from 1E-3m to 1E-
6m.

Figure 3: 1E-6 m Fe actively reacted with 1 kg of water, 3m NaCl and 1E-5 m SO2 at 25° C and 1 
bar. Introducing SO2 into the system leads to the formation of various metal-sulphides (Py-pyrite, 
Popyrrhotite, Tr-troilite). In addition, the passivation region becomes larger.
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Figure 4: 1E-6 m Fe actively reacted with 1 kg of water, 3m NaCl and 1E-5 m SO2 at 150° C and 
100 bar. Here, changing the temperature and pressure affects the stability fields of various Fe-
oxides/sulphides. 

As you can see from the figures, the aqueous-gas phase boundaries shift as the initial bulk 
compositions, pressure and temperature conditions in the interaction system change.
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Pourbaix Diagrams for Complex Alloys

Thermo-Calc can not only be used to simulate how pure metals interact with pure water or 
simple aqueous solutions under normal pressure and temperature conditions. It can also be 
used to calculate how complex alloys and concentrated aqueous solutions interact over a 
very wide pressure, temperature and composition ranges. This is illustrated with the two 
examples.

The first example is a Pourbaix diagram calculated for the heterogeneous interaction 
between 0.001 mole of steel (Fe-7.676Cr-5.0Ni-2.1887Mn-1.0Cu [at%]) and 1 kg of water 
(and with 1.2 m H3BO3, 0.022 m Li and 0.001 m NH3), at 25° C and 1 bar. This application is 
particularly useful for safety assessments of nuclear reactors and nuclear waste repositories.

The next example is a Pourbaix diagram calculated for the heterogeneous interaction 
systems between 0.1 mole of AISI4340 stainless steel (Fe-0.80Cr-1.85Ni-0.70Mn-0.25Mo-
0.25Si-0.40C [wt%]) and 1 kg of seawater (with the equivalent of 0.6054 m NaCl), at 25° C 
and 1 bar. This application is particularly useful for failure analysis of petroleum exploitation 
industry.
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Miscellaneous Information 

Generally applicable to multiple applications within Thermo-
Calc, i.e. in both Console Mode and Graphical Mode, or 
needed for a specific database calculation in Thermo-Calc 
(i.e. thermophysical properties), etc.
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Parameters, Functions, and Variables

This section is applicable to both Console Mode and Graphical Mode with 
respect to understanding the format these are to be written in for Thermo-Calc 
to use the parameter, function, or variable. However, many of the sections are 
specific to Console Mode where the explicit use of these terms is more often 
used.

To learn about using variables and functions, in Graphical Mode, see T_07: User-
Defined Functions and in Console Mode, see example 44  .

In this section:

Specifying Parameters 3

About Operators and Functions 5

Thermodynamic Variables 6

Intensive Variables 8

Extensive Variables 9

Special Quantities 13

The u-Fraction Variable 15

Suffixes 16

Derived Variables and Partial Derivatives 23

Units of State Variables and Derived Variables 30

User-Specified Units 31

Examples of User-Defined Units 32

State Variables for Scheil 41

State Variables in Console Mode DICTRA 43
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Specifying Parameters

This section or topic is specific to Console Mode.

Running a command typically requires that several parameter values are specified, which 
can be done directly in the command line after the command name. For example, to set an 
axis variable for a stepping or mapping operation, enter:

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

You can also use SET_AXIS_VARIABLE and press <Enter>. At the command line prompt, you 
then specify the parameters one at a time. 

On all command lines, you can enter a question mark (?) for help. For some parameters, 
enter two question marks (??) for more detailed information.

Default Parameters Values

When you are requested to specify a parameter, Thermo-Calc usually suggests an 
appropriate default value, which is displayed at the prompt between two slash signs (//). For 
example, this prompt means the default answer is TERMINAL:

OUTPUT FILE /TERMINAL/:

Press <Enter> to accept the default. 

If you specify some parameters directly after the command name, then you can still choose 
to accept default values for some parameters. 

To accept the default value for a parameter, type a comma (,) instead of a value for that 
parameter. For the comma to be interpreted correctly, type a blank space on each side of 
the comma. However, if you accept the default values for several parameters that follow 
each other, then the commas can be typed in without blank spaces separating them: (,,,) is 
interpreted in the same way as (, , ,). 

For some commands and parameters, Thermo-Calc treats the values previously assigned as 
default values if the command is used again. For example, if the first stepping or mapping 
axis variable is specified as: 

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

Then if you want to change a parameter value for this axis variable, type:

SET_AXIS_VARIABLE 1 , 0.1 ,,, 
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This changes the minimum value from 0 to 0.1 at which a stepping or mapping operation 
halts. The other parameter values remain the same. Consequently, what is typed is 
equivalent to: 

SET_AXIS_VARIABLE 1 X(FCC,FE) 0.1 0.89 0.025
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About Operators and Functions

Sometimes you need to specify functions when setting up a system. For example, to make 
global conditions vary as a function of time. 

The following operators can be used in writing functions. Use a semi-colon (;) to mark the 
end of a function. 

Available Operators for Writing Functions

Operator Description

+, -, *, / Addition, subtraction, multiplication, division

** Exponentiation,  raising one quantity to the power of 
another, e.g. x2.

ABS() Absolute value

ERF(X) Error function

EXP(X) Exponential

LOG(X) Natural logarithm

LOG10(X) Base 10 logarithm

SIGN(X)
Sign function

SIGN(X) is -1 when X<0, is 0 when X=0 and is 1 when X>0.

SIN(X), COS(X), TAN(X), ASIN(X), ACOS(X), ATAN(X)
 l Trigonometric functions: sine, cosine, tangent

 l Inverse trigonometric functions: arcsine, arccosine, 
arctangent

SINH(X), COSH(X), TANH(X), ASINH(X), ACOSH(X), 
ATANH(X)

 l Hyperbolic trigonometric functions

 l Inverse hyperbolic functions

SQRT(X) Square root
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Thermodynamic Variables

Thermophysical Properties Variables  and Elastic Properties Variables

There are different thermodynamic variables in Thermo-Calc. Some are state variables, for 
example temperature, pressure and mole fraction. These characterize the equilibrium state 
of a system. You set them when you define your system in the POLY module before 
performing a calculation. They are also used in other modules such as DATA, GIBBS and 
PARROT. State variables that involve components can be used for the defined components, 
but not for any species. (To define new components in a defined system, use DEFINE_
COMPONENTS). 

Other useful thermodynamic variables are derive from state variables with a mathematical 
function. Some derived variables are pre-defined by Thermo-Calc, such as normalized 
energetic and compositional extensive state variables for example. You use these by 
appending various normalizing suffixes to abbreviations that are associated with the state 
variables.

Thermodynamic variables can also be divided into extensive variables and intensive 
variables. An extensive variable is a variable whose value depends on the size of the system, 
whereas an intensive variable is a variable whose value is independent of system size. 

More information about thermodynamic variables is available in the online help in 
Thermo-Calc Console Mode. Use the command INFORMATION, with a subject keyword such 
as one of the following as argument: STATE VARIABLES, INTENSIVE VARIABLES, EXTENSIVE 
VARIABLES, DERIVED VARIABLES, CONDITIONS (for condition settings), AXIS-VARIABLES (for 
stepping/mapping variable settings). 

Common Thermodynamic Variables

The tables below list common thermodynamic variables. Most of these can be used to 
define equilibrium conditions in the POLY module unless otherwise indicated.

The variables are divided into the following tables:

 l Intensive variables
 l Energy-related extensive variables for whole system or for a phase
 l Compositional extensive variables (overall amount of components in the whole 

system, or amount of a component in system or in a phase)
 l Constitutional composition-related extensive variables (amount of a 
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constituent/species on a sublattice site in a phase)
 l Special quantities

How to Read the Tables

 l The Abbrev. column shows the abbreviation that you use in the POLY module for 
referring to the variable. If the variable must be given any arguments, then these are 
given in parenthesis directly after the abbreviation. For most variables, this is also 
the abbreviation that you use to refer to the variable in other modules. However, 
some variables are referred to with a different abbreviation in the POST module. If 
this is the case, then this is noted at the bottom of the table. 

 l Variables that are specific to a species, in which case the species is specified as an 
argument (sp in the table below). If there are two or more sublattices in a given 
phase, then this argument is given as constituent#sublattice. This indicates a 
constituent on a specific sublattice or site in the phase (referred to by the # sign and 
a digit). For example, y(BCC,C#2) stands for the site fraction of the C species on the 
second sublattice site of the BCC_A2 solution phase.

 l The Unit column show which unit that you can use to express the variable in the 
POLY module. This unit is always the SI unit. In other modules, state variables may be 
expressed in other units. 

 l The Suffix column shows the suffixes you can append to the variables. The R suffix 
can be used with all compositional extensive state variables, but the suffix does not 
always change the value of the variable. This is indicated by putting the R in 
parenthesis.

These types of variables are listed in the following topics:

 l Intensive Variables
 l Extensive Variables
 l Special Quantities
 l The u-Fraction Variable
 l Suffixes
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Intensive Variables

V Abbrev. Unit Descript. Domain Suffix

T T1 K Temperature System  

P P Pa Pressure System  

μ

MU(comp)

J/mol Chemical 
potential

Component R

MU(sp,ph)2
Species relative 
to a solution 
phase

R

a

AC(comp)

N/A

Activity

Component R

AC(sp,ph)2
Species relative 
to a solution 
phase

R

LNAC (comp)3

ln(Activity)

Component R

LNAC (sp,ph) 2
Species relative 
to a solution 
phase

R

1 When plotting in POST, besides T (Kelvin), you can also use T_C or T_F to plot temperature in °C or °F.

2 Only for single-substitutional-lattice solution phases such as AQUEOUS solution and GASeous mixture phases 
and for interacting species on the substitutional sublattice of two-sublattice solution phases (such as the 
phases BCC_A2 and M6C phases).

3 In natural logarithm (lnAC=MU/RT)
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Extensive Variables

Energy-Related Extensive Variables for Whole System or for a Phase

V Abbrev. Unit Descript. Domain Suffix

V

V

m3 Volume

System M, W, V, R

V(ph)1 Phase M, W, F, R

VP(ph) 2 Phase M, W, V, R

G

G

J Gibbs energy

System M, W, V, R

G(ph) 1 Phase M, W, V, F, R

A

A

J Helmholtz energy

System M, W, V, R

A(ph) 1 Phase M, W, V, F, R

U

U

J Internal energy

System M, W, V, R

U(ph) 1 Phase M, W, V, F, R

H
H

J Enthalpy6
System M, W, V, R

H(ph) Phase M, W, V, F

S

S

J/K Entropy6
System M, W, V, R

S(ph) 1 Phase M, W, V, F, R

Cp

HM.T3

J/mol/K Heat capacity at 
constant pressure

System R

HM(ph).T3 Phase R

Cv UM.T4 J/mol/K Heat capacity at 
constant volume System R
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V Abbrev. Unit Descript. Domain Suffix

UM(ph).T4 Phase R

D DG(ph) 5 N/A
Driving force 
(thermodynamic 
factor)

Phase

Always use 
with M, W, V 
or F. R can 
also be used.

1 For this variable, if the phase is unstable, then the variable gets a value of zero.

2 Do not use VP(ph) as a condition in POLY. Instead, use CHANGE_STATUS PHASE <PHASE>=FIX <AMOUNT> 
where the fixed <AMOUNT> is roughly equal to VPF(ph), which cannot be directly evaluated or listed. If the 
phase is unstable, then VP(ph) and its normalized quantities get zero value.

3 Use only if pressure has been set as a condition.

4 Use only if volume has been set as a condition.

5 Already divided by RT.

6 When working in the POST module you can also enter the abbreviation for this variable into the Console, for 
example, enth or enthalpy, which corresponds to HM, and entr and entropy, which corresponds to SM.

Compositional Extensive Variables 

These are for the overall amount of components in whole system, or amount of a 
component in system or in a phase.

Do not use NP(ph) or BP(ph) as conditions in the POLY module. Instead use CHANGE_STATUS 
PHASE <PHASE>=FIX <AMOUNT> where the fixed <AMOUNT> is roughly equal to NPF(ph) or 
BPF(ph), which cannot be directly evaluated or listed. If the phase is unstable, then NP(ph) 
or BP(ph) (and its normalized quantities) get zero value.

When plotting the following quantities in POST, refer to each as indicated:

 l X(comp) ->  Mole-Fraction <comp> (or M_F)
 l W(comp) ->  Weight-Fraction <comp> (or W_F)
 l X%(comp) ->  Mole-Percent <comp> (or M_P)
 l W%(comp) ->  Weight-Percent <comp> (or W_P).
 l u-f(ph,comp) ->  U-F
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V Abbrev. Unit Descript. Domain Suffix Comment

n

N

mole Moles

All 
components

M, W, V, 
(R)  

N(comp) Component M, W, V, 
(R)  

N(ph,comp) Component in 
a phase

M, W, V, 
(R)  

NP(ph)1 Phase M, W, V, 
(R) See above

b

B

gram Mass

All 
components

M, W, V, 
(R)  

B(comp) Component M, W, V, 
(R)  

B(ph,comp) Component in 
a phase

M, W, V, 
(R)  

BP(ph) 1 Phase M, W, V, 
(R) See above

x

X(comp)

N/A Mole fraction

Component (R) See above 

X(ph,comp) Component in 
a phase (R)  

w

W(comp)

N/A Mass (weight) 
fraction

Component (R) See above 

W(ph,comp) Component in 
a phase (R)  

x% X%(comp)2 N/A Mole percent Component (R) See above 

w% W%(comp)2 N/A Mass (weight) 
percent Component (R) See above 

u u-f 
(ph,comp)1 N/A u-fraction Component in 

a stable phase (R) See above 

in IN(sp)2 mole Input mole Phase species (R) See above 
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V Abbrev. Unit Descript. Domain Suffix Comment

number in the system

im IM(sp)2 gram Input mass 
unit

Phase species 
in the system (R) See above 

1 Do not use as a condition in the POLY module.

2 Only available in TQ-Interface.

Constitutional Composition-Related Extensive Variable

This is the amount of a constituent/species on a sublattice site in a phase.

V Abbrev. Unit Descript. Domain

y Y(ph,cons#sub) N/A Site fraction Constituent on a sublattice site (denoted by 
# and a digit) in a phase
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Special Quantities

Variable Abbrev. Unit Description or 
Example Domain Suffix

Q QF(ph)1 n/a Phase stability function Phase

R

Under a 
condition 
and system 
definition, 
QFR(ph) = QF
(ph)

Tc TC(ph) 2 K Curie temperature Phase

R

Under a 
condition 
and system 
definition, 
TCR(ph) = TC
(ph)

Mb BMAG(ph)3 n/a Bohr magneton number Phase

R

Under a 
condition 
and system 
definition, 
BMAGR
(ph) = BMAG
(ph)

D1G D1G(phase, 
site-fraction) n/a

For example, D1G(FCC_
A1#1, Cr#1) for first 
derivative of G for first 
composition set of FCC_A1 
phase with respect to Cr 
site fraction on first 
sublattice.

Search for 
TQGMDY 
in the TQ-
Interface 
Guide

Phase n/a

D2G D2G(phase, 
site-fraction, n/a

For example, D2G(FCC_
A1#2, Cr#1, Cr#1) for Phase n/a
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Variable Abbrev. Unit Description or 
Example Domain Suffix

site-fracton) 

second derivative of G for 
second composition set of 
FCC_A1 phase with 
respect to Cr site fraction 
on first sublattice.

Search for 
TQDGYY in 
the TQ-
Interface 
Guide

1 Negative when phase composition is inside a spinodal, otherwise positive. Can be used to find out if an 
equilibrium is within the miscibility gap for a solution phase. Cannot be used as a condition.

2 Calculated for phases with magnetic contributions in an equilibrium state. Cannot be used as a condition, but 
can be plotted in POST or evaluated in POLY using SHOW_VALUE.

3 Calculated for phases with magnetic contributions in an equilibrium state.

n/a = not applicable
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The u-Fraction Variable

The u-fraction is an important quantity in some single-point or stepping paraequilibrium 
calculations in the POLY module and in the DICTRA module. You can apply the variable in a 
paraequilibrium calculation to the substitutional matrix component, the substitutional 
alloying components or the interstitial component. The u-fraction is denoted as ui for the i-
th system component n of a whole system or of a specific phase in various equilibrium states 
(such as full-equilibria, partial-equilibria, para-equilibria, local-equilibria).

Generally, the u-fraction is defined as:

 

The sum of in the denominator is calculated for all substitutional alloying elements in the 
whole system or in a specific phase. The variable  in the numerator stands for the mole-
fraction of the i-th component in the whole system or in the specific phase. 
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Suffixes

Suffixes may be appended to all extensive variables and to some intensive variables. Some 
suffixes can be used to enter the value of variables in normalized form. These are referred to 
as normalizing suffixes. If the variable that you create with a normalizing suffix is based on a 
state variable that can be set as a condition in POLY, then the normalized variable can also 
be set as a condition in POLY.

The normalizing suffixes are M (per mole), W (per mass in gram), V (per volume in m3) and F 
(per mole formula unit). There is also a reference state suffix R, which you can use if you 
want the value of a thermodynamic variable to be calculated with respect to a reference 
state that have previously set.

Normalizing Suffixes

When variables that express system and phase quantities are normalized, the following 
general rules are used:

 l System quantities are normalized by the total system size (in terms of N, B or V).
 l Phase quantities are normalized by the phase amount [in terms of NP(ph), BP(ph) or 

VP(ph)].

The normalized quantities of G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) are calculated 
according to the thermodynamic model used for the phase (e.g. GM(ph), AM(ph), UM(ph), 
HM(ph), SM(ph) and VM(ph)). These quantities are calculated using the first derivatives of 
the Gibbs energy expressed for the phase with respect to the current composition of the 
system.

The tables describe the normalizing suffixes for the different state variables.

G, A, U, H, S and V of a Whole System

Suffix Description Example

M (per mole) Total system size in terms of N.

GM is the Gibbs energy per mole of the system 
(J/mol).

W (per mass in 
gram)

The total system size in terms 
of B.

GW is the Gibbs energy per mass of the system 
(J/g).
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Suffix Description Example

V (per volume in 
m3)

The total system size in terms 
of V.

VV does not have to be 
evaluated.

GV is the Gibbs energy per volume of the system 
(J/m3).

G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) of a Phase

Suffix Example

M (per mole)
For example, GM(ph) is Gibbs energy of the phase per mole of the phase (J/mol).

W (per mass in gram)
For example, GW(ph) is Gibbs energy of the phase per mass of the phase (J/mol).

V (per volume in m3)
For example, GV(ph) is Gibbs energy of the phase per volume of the phase (J/mol).

F (per mole formula 
unit)

For example, GF(ph) is the Gibbs energy of the phase per formula unit of the phase 
(J/mol).

DG(ph) of a Phase

Suffix Description Example(s)

M (per mole)

Theoretically, the first derivative of the variable 
with regard to the phase amount in terms of 
NP(ph). Since DG(ph) is not directly calculated, 
the second derivative of the Gibbs energy 
expressed for the phase in question with 
respect to the current compositions in the 
equilibrium state of the system is calculated 
instead.

DGM(ph) is driving force for 
precipitation of the phase per mole 
of components.
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Suffix Description Example(s)

DGM(ph) cannot not be set as a condition since 
it is only calculated under a certain type of 
equilibrium state.

W (per mass in 
gram)

Theoretically, the first derivative of the variable 
with regard to the phase amount in terms of 
BP(ph). Since DG(ph) is not directly calculated, 
the second derivative of the Gibbs energy 
expressed for the phase in question with 
respect to the current compositions in the 
equilibrium state of the system is calculated 
instead.

DGW(ph) cannot not be set as a condition since 
it is only calculated under a certain type of 
equilibrium state.

DGW(ph) is driving force for 
precipitation of the phase per mass 
of components.

V (per volume in 
m3)

Theoretically, the first derivative of the variable 
with regard to the phase amount in terms of 
VP(ph). Since DG(ph) is not directly calculated, 
the second derivative of the Gibbs energy 
expressed for the phase in question with 
respect to the current compositions in the 
equilibrium state of the system is calculated 
instead.

DGV(ph) cannot not be set as a condition since 
it is only calculated under a certain type of 
equilibrium state.

DGV(ph) is driving force for 
precipitation of the phase per volume 
of components.

F (per mole 
formula unit)

Theoretically, the first derivative of the variable 
with regard to the phase amount in terms of 
NP(ph) and NA (NA is the total atomic number 
in the phase formula). Since DG(ph) is not 
directly calculated, the second derivative of the 
Gibbs energy expressed for the phase in 
question with respect to the current 
compositions in the equilibrium state of the 
system is calculated instead.

DGF(ph) cannot not be set as a condition since 
it is only calculated under a certain type of 
equilibrium state.

DGF(ph) is driving force for 
precipitation of the phase per 
formula unit of components.
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N and B of a System

Suffix Description Example(s)

M (per mole)

The total system size in terms 
of N.

NM does not have to be 
evaluated. 

BM cannot be set as a 
condition.

BM is mass (gram) of components per mole of the 
system (g/mol).

W (per mass in 
gram)

The total system size in terms 
of B. 

BW does not have to be 
evaluated.

NW cannot be set as a 
condition.

NW is mole number of components per mass of the 
system (mol/g).

V (per volume 
in m3)

The total system size in terms 
of V.

BV is the density of the entire 
system.

NV is mole number of components per volume of the 
system (mol/m3).

BV is the density of the entire system (g/m3).

N (comp) and B(comp) of a Component in the System

Suffix Description Example(s)

M (per 
mole)

The total system size 
in terms of N.

BM(comp) cannot be 
set as a condition.  

NM(comp) is the mole of a component per mole of the system (i.e. 
mole fraction, which also is expressed as X(comp)).

W (per 
mass in 
gram)

The total system size 
in terms of B.

NW(comp) cannot be 
set as a condition.

BW(comp) is mass (gram) of a component per mass of the system 
(i.e. mass fraction, which also is expressed as W(comp)).
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Suffix Description Example(s)

V (per 
volume in 
m3)

The total system size 
in terms of V.

NV(comp) is mole number of a component per volume of the system 
(mol/m3).

NP(ph), BP(ph) and VP(ph) of a Phase in the System

Suffix Description Example(s)

M (per 
mole)

BPM(ph) and VPM(ph): The phase 
amount in terms of NP(ph). 

NPM(ph): The total system size in 
terms of N.

BPM(ph) is mass (gram) of a phase per moles of 
the system (g/mol).

NPM(ph) is number of moles of a phase per moles 
of the system (mole fraction).

W (per mass 
in gram)

NPW(ph) and VPW(ph): The phase 
amount in terms of BP(ph).

BPW(ph):The total system size in terms 
of B.

VPW(ph) is volume (m3) of a phase per mass of 
the system (m3/g)

BPW(ph) is mass (gram) of a phase per mass of the 
system (mass fraction)

V (per 
volume in 
m3)

NPV(ph) and BPV(ph): The phase 
amount in terms of VP(ph).

VPV(ph): The total system size in terms 
of V.

NPV(ph) is number of moles of a phase per volume 
of the system (mol/m3).

VPV(ph) is volume (m3) of a phase per volume of 
the system (volume fraction).
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N(ph,comp) and B(ph,comp) of a Component in a Phase

Suffix Description Example(s)

M (per 
mole)

The phase amount in 
terms of NP(ph) of 
the phase.

NM(ph,comp) is number of moles of a component per mole of a 
phase (i.e. mole fraction of a component in a phase, which is 
equivalent to X(ph, comp)).

W (per 
mass in 
gram)

The phase amount in 
terms of BP(ph) of 
the phase.

BW(ph,comp) is mass (gram) of a component per mass of a phase 
(i.e. mass fraction of a component in a phase, which is equivalent to  
W(ph,comp)).

V (per 
volume in 
m3)

The phase amount in 
terms of VP(ph) of 
the phase.

NV(ph,comp) is mole number of a component per volume of a phase 
(mol/m3).

The Reference State Suffix R

SET_REFERENCE_STATE

You can use the reference state suffix R for some thermodynamic variables to calculate their 
value with respect to a reference state that you have previously set for a system component 
with the SET_REFERENCE_STATE command in POLY (or in  response-driven modules such as the 
POURBAIX module). The value of energy-related variables that are used with the R suffix 
depends on the reference states of all the components in the defined system. 

It is possible to use an R suffix on all compositional extensive state variables as 
well, but the value of the state variable is always the same, with or without the 
suffix.

If the reference state for a system component is the default reference state (the stable 
reference state (SER) which is defined in a Thermo-Calc database), then MUR(comp)= MU
(comp), ACR(comp)= AC(comp) and LNACR(comp)= LNAC(comp). 
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In the case of some thermodynamic variables, you can also use the R suffix to express 
chemical potentials and activities of species relative to some single-substitutional-lattice 
solution phases (such as aqueous solution, gaseous mixture, metallic liquid solution, slag 
mixture or MO solid solution). These state variables are MU(sp,ph),  MUR(sp,ph),  AC(sp,ph), 

 

ACR(sp,ph), LNAC(sp,ph) and LNACR(sp,ph). 

The reference states and standard states of various solution species are pre-defined for 
some solution phases in some databases. For all solution species in any solution model in 
any database, it is always the case that MUR(sp,ph)= MU(sp,ph), ACR(sp,ph)= AC(sp,ph) and 
LNACR(sp,ph)= LNAC(sp,ph).
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Derived Variables and Partial Derivatives

Many derived variables can be obtained easily by using partial derivatives of state variables, 
such as heat capacity, thermal expansivity, isothermal compressibility, among others.

Derivatives of state variables can be defined or evaluated by putting a dot (.) between two 
state variables. The variable after the dot must be a condition that you have set when you 
defined your system. For example, the heat capacity (at constant pressure or volume) of a 
system is the partial derivative of the state variable enthalpy with respect to temperature. 
To evaluate this derivative, use the designation HM.T, where temperature is a state variable 
that you have set already. 

Any partial derivative of a state variable with respect to another can be defined or evaluated 
as a derived variable by using the dot (.) notation. 

Derived Variables Dot Notation Examples

The following table shows some examples:

Derived Variable Description

Heat capacity for the system at either constant P if pressure is a 
condition or constant V if volume is a condition.

Heat capacity for a phase at either constant P if pressure is a condition 
or constant V if volume is a condition.

Heat capacity for the system multiplied by total mole number of 
components, i.e.,  if pressure is a condition in a 

closed system or  if volume is a condition in a closed 
system.

Heat capacity for a phase multiplied by the sum of  and 
, i.e., 

 if pressure is a 

condition or  if volume is 

a condition.

Thermal expansivity of the system (already multiplied by the total 
molar volume), i.e., . 
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Derived Variable Description

Thermal expansivity of a phase (already multiplied by its molar 
volume), i.e., .

Thermal expansivity of the system (already multiplied by the total 
volume), i.e., .

Thermal expansivity of a phase (already multiplied by the phase 
volume) plus the  term, i.e.,

.

Isothermal compressibility of the system (already multiplied by the 
total molar volume), i.e., .

Isothermal compressibility of a phase (already multiplied by its molar 
volume), i.e., .

Isothermal compressibility of the system (already multiplied by the 
total volume), i.e.,

Isothermal compressibility of a phase (already multiplied by the phase 
volume) plus the  term, i.e.,

.

Slope of a phase boundary on a T-X(comp) phase diagram with respect 
to mole fraction of the component in the system.

Slope of a phase boundary on a T-W(comp) phase diagram with 
respect to mass of the component in the system.

Slope of a phase boundary on a T-X(ph,comp) phase diagram with 
respect to mole fraction of the component in the phase.

Slope of a phase boundary on a T-W(ph,comp) phase diagram with 
respect to mole fraction of the component in the phase.

Slope of a phase boundary on a P-T phase diagram (Note that the 
equilibrium with phase assemblage must be calculated first).
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Defining New Derived Variables and Functions

You can define additional derived variables or functions based on a state variable by using 
ENTER_SYMBOL. Any derived variable or function must have a unique name that starts with a 
letter and has a maximum number of eight characters. These characters can include both 
uppercase and lowercase letters, numerical digits and the underscore (_). No other 
characters are allowed.

The difference between new derived variables introduced with the ENTER_SYMBOL 
command and new functions introduced with the same command is as follows. Whenever 
Thermo-Calc calculates the value of a function (as part of an equilibrium calculation for 
example), all functions related to the defined system is evaluated. An entered derived 
variable, on the other hand, is only evaluated when it is defined and when it is re-evaluated 
with EVALUATE_FUNCTIONS.

Derived Variables for Aqueous Solutions

Standard state variables used for other phases can be directly applied to the aqueous 
solution phase. In addition, there are pre-defined derived variables for the aqueous solution 
phase in particular. 

Examples of predefined derived variables for the aqueous solution phase are listed and 
briefly described in the following tables. Some derived variables for a gaseous mixture phase 
are also shown. This is because EOS (Equation of State) expressions, standard 
thermodynamic properties and transport properties of the pure solvent H2O are also 
expressions and properties of the pure gaseous species H2O.

For Aqueous Solution Phase

Name Abbrev. Units Description Comments

pH PH N/A Acidity 
of the aqueous solution phase

pH = -log10(AC(H+)) = -log10
(ACR(H+,AQ))

Eh EH V, mV Hypothetical 
electric potential 

of the aqueous solution phase

Eh = u(ZE)/96485.309 

Pe PE N/A
Logarithm of the 
hypothetical 
electron activity 

of the aqueous solution phase

pe = u(ZE)/(2.3025851*RT)
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Name Abbrev. Units Description Comments

Ah AH kJ, kcal Thermodynamic 
affinity per electron 

of a redox couple wrt the 
standard hydrogen electrode  in 
the aqueous solution phase

Ah = u(ZE)

yw YH2O N/A Mole fraction
of the solvent H2O in the 
aqueous solution phase

YH2O = Y(AQ,H2O)

Nw AH2O mole Mole number 
of 1.0 kg of solvent H2O

AH2O = 55.508435

Nsp

NSH2O

mole

Mole number, 

NS(AQ,H2O)

of the solvent (H2O) in the 
aqueous solution phase

NS(AQ,H2O) = YH2O*NP(AQ)

NS#
Mole number, 

NS(AQ,sp)

of a solute species in the 
aqueous solution phase

NS(AQ,sp) = Y(AQ,sp)*NP(AQ)

M ML# mol/kg_H2O
Molality, 

ML(AQ,sp)

of a solute species in the 
aqueous phase

ML(AQ,sp) = Y
(AQ,sp)*AH2O/YH2O

m* TIM equivalent 
molality Total molality

of all solute species in the 
aqueous solution phase

TIM = sum[ML(AQ,sp)]ions + 
sum[ML(AQ,sp)]complexes

mt TIC# equivalent 
molality

Total ionic 
concentration, TIC
(AQ,sp)

of a cation I in the aqueous 
phase

TIC(AQ,spI) = sum[ML
(AQ,spJ)*V(spI-in-spJ)]

I ISTR N/A Ionic strength 
of the aqueous solution phase

ISTR=1/2*sum[ML(AQ,sp)*Z
(AQ,sp)**2]

γ RCH2O N/A Activity coefficient,  of the solvent (H2O)
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Name Abbrev. Units Description Comments

RC(H2O,AQ) RC(H2O,AQ) = ACR
(H2O,AQ)/YH2O

RC#
Activity coefficient,  

RC(sp,AQ)

of a solute species

RC(sp,AQ) = ACR(sp,AQ)/Y
(AQ,sp)*YH2O

αi

AIH2O

N/A

Activity, 

AI(H2O,AQ)

of the solvent (H2O), 

    AI(H2O,AQ) = ACR(H2O,AQ)

AI#
Activity, 

AI(sp,AQ)

of a solute species related to 
the aqueous solution phase,

    AI(sp,AQ) = ACR
(sp,AQ)*AH2O

LogAI#
Log10 Activity, 
LogAI(H2O,AQ), 

LogAI(sp,AQ)

of the solvent or a solute 
species related to the aqueous 
solution phase in common 
logarithm,

    LogAI(H2O,AQ) = log10[AI
(H2O,AQ)]

    LogAI(sp,AQ)  = log10[AI
(sp,AQ)]

αw AW N/A Activity 
of H2O in the aqueous solution 
phase

AW = ACR(H2O,AQ)

ɸ OS N/A Osmotic coefficient 
of aqueous solution phase

OS = -55.508435*lnAW/TIM

At1 AT1 equil_mol/kg_
H2O

Titration alkalinity 
(definition 1) 

of the aqueous solution phase

Generally defined as the 
equivalent molality of 
carbonate and bicarbonate at 
the methyl orange endpoint 
(pH=4.5).

At2 AT2 equil_mol/kg_
H2O

Titration alkalinity 
(definition 2)

of the aqueous solution phase

Generally defined as the 
equivalent molality of 
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Name Abbrev. Units Description Comments

carbonate and bicarbonate, plus 
sulfide, at the methyl orange 
endpoint (pH=4.5).

For Gaseous Mixture Phase

Name Abbrev. Units Description Comments

γ RA# N/A
Activity 
coefficient, 

RA(sp,GAS)

of a gaseous species in the gaseous 
mixture

RA(sp,GAS) = function(Y,T,P)

γ* RF# N/A
Fugacity 
coefficient, 

RF(sp,GAS) 

of a pure gaseous species under TP

RF(sp,GAS) = function(T,P/V)

F FUG# pa, bar, psi
Fugacity, 

FUG(sp,GAS)

of a gaseous species in the gaseous 
mixture

FUG(sp,GAS) = RA(sp,GAS)*RF
(sp,GAS)*Y(GAS,sp)*P

ft TFUG pa, bar, psi Total gas fugacity
of the gaseous mixture phase

TFUG = sum[FUG(sp,GAS)]

Defining New Derived Variables for Aqueous Solutions

You can define many different additional derived variables and functions. For instance, the 
partition coefficient of a component between two phases is defined as follows:

Pc<name> = X(phase1,component)/X(phase2,component)

Another example is the activity coefficient of a component in the system. It is defined as 
follows:

Rc<name> = ACR(component)/X(component)

The activity coefficient of a species in a solution phase depends on which model definitions 
on the reference states that are used and it depends on the standard states for the species. 
If the standard state of a species is defined to be the same as the pure species in a 
substitutional phase, then the activity coefficient of the species can be calculated as:

RC<name> = ACR(species,phase)/Y(phase,species)
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In some cases, there are more than one sublattice in the phase and the reference states for 
the phase species cannot be presented by the pure species, as in the case of C in FCC [(Fe)1
(C,N,VA)1], where the model may end at fifty percent C and fifty percent Fe. In those cases, 
the chemical potential and activity of all phase constituents is not well defined and you 
cannot properly define the activity coefficients of the species in the phase.

For an aqueous solution phase, no matter what model is used, the reference state and 
standard state for both the solvent and solutes are defined in a special way in the 
Thermo-Calc software. The reference state for the solvent is set as pure water, the same as 
its standard state (according to Raoults's Law). The standard state for a solute species is set 
the hypothetical solute species, whilst its reference state is defined as the hypothetical state 
at unit molality (one mole dissolved into 1.0 kg of solvent) but in which the environment of 
each molecular is the same as at infinite dilution (according to Henry's Law). Under these 
definitions, the activity coefficients for solvent species can be calculated as follows:

RC<H2O> = ACR(H2O,aqueous)/ Y(aqueous,H2O)

The coefficients for the solute species can be calculated as follows:

RC<spec> = AI(species,aqueous)/ML(aqueous,species)
= ACR(species,aqueous)/ Y(aqueous,species)*Y(aqueous,H2O)

AI is here the activity of solute species calculated from the model, and ML is the molality of 
the species.

Thermodynamic Variables and Wildcard Characters

The ACR (species,phase) and the MUR (species,phase) quantities can only be appropriately 
and meaningfully applied to substitutional solution phases (such as GAS, AQUEOUS, LIQUID) 
and to solution phases without an interstitial sublattice set. This means that the wild card 
characters * and $ normally don’t work properly for the activity and/or chemical potential 
properties. 

For example, do not use ACR(*,*) or MUR(*,*) for all the species relative to all phases, nor 
ACR(*,phase) or MUR(*,phase) for all the species relative to a specific phase, nor ACR
(species,*) or MUR(species,*) for a specific species relative to all phases. 

Instead, use specific names for species and (applicable) phase, as in the following examples:

SHOW_VALUE acr(fe+2,aqueous)Lists activity of the Fe+2 species referred to 
AQUEOUS solution phase

SHOW_VALUE mur(c2,gas)Lists chemical potential of the C2 species referred to GAS 
mixture phase

SET_AXIS_VAR y ac(o2,gas)Sets activity of the O2 species referred to GAS mixture 
phase as Y-axis
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Units of State Variables and Derived Variables

The units for the state variables in the Units column in the table in User-Specified Units are 
the SI units that are used in the POLY module. However, in the POST module, you can both 
use pre-defined symbols and define your own symbols which are based on state variables 
and derived variables. By doing this, you can express the value of the thermodynamic 
variables in non-default units. The following topic briefly describes how you can create your 
own symbols and suggests expressions that you can use to convert default units into other 
standard units which are not default units in Thermo-Calc.

The topic Examples of User-Defined Units describes some variables of specific species in a 
phase and the units in which they are expressed. These variables are not used in POLY or 
POST, but in the GIBBS, DATA, PARROT and ED_EXP modules. 
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User-Specified Units

You do not always need to use the default units for variables. Using ENTER_SYMBOL, you 
can convert the value of variable from the default unit to your preferred unit. (Some 
response-driven modules also allow you to set conditions in non-default units.) User-defined 
symbols in the form of functions can be used for plotting in the POST module, but they 
cannot be used as conditions in POLY. User defined symbols in the form of variables can be 
used as conditions.

For example, if you want pressure to be plotted in bar rather than Pa, then you define the 
following function PB:

Enter_symbol function PB = P/1E5 ;

If you wanted heat capacity of a system to be shown as in terms of J/mol/K, then you can 
define the following function Cp:

Enter_symbol function Cp = Hm.T ;

If the variable you want to convert is a function of one or more derivatives, then you must 
enter the symbol as a variable rather as a function. For instance, a symbol expressing heat 
capacity of a system in a unit of cal/mol/K can be defined as the following variable Cp2:

Enter_symbol variable Cp2 = Hm.T/4.1858 ;

Examples of User-Defined Units for information about entering conventional 
functions and the associated units.
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Examples of User-Defined Units

The following tables give examples of expressions you can use to enter symbols. This 
enables you to show the values of thermodynamic variables in a variety of units. 

Units of State Variables and Derived Variables and User-Specified Units

You can also use thermodynamic variables with normalizing suffixes in the 
expression when you enter a symbol. However, the tables do not have 
examples of these expressions.

In the expressions these are defined as follows:

 l i is for an auxiliary index or letter that corresponds to the component c
 l j is for an auxiliary index or letter that corresponds to the phase ph, and 
 l ij stands for an auxiliary index or letter that corresponds to the component c in the 

phase ph.

Intensive and Extensive Variables of a Defined System

Quantity Suggested Name and Expression Unit 

For Intensive Variables of a Defined System

Temperature

TempC = T-273.15 Celsius (C) 

TempF = 1.8*T-459.67 
Fahrenheit (F) 

TempF = 1.8*TempC+32 
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Quantity Suggested Name and Expression Unit 

Pressure

PB    = P/1E5 bars (bar) 

PKb   = P/1E8 kilobars (kbar) 

PAtm  = P/101325 atmosphere (atm) 

PSI   = P/6894.76 pounds/sq. inch (psi) 

PIHg  = P/3342.11 inches of Hg 

PTor  = P/133.322 Tors (millimeters of Hg) 

For Extensive Variables of a Defined System

Amount
BKg  = 1E-3*B kilograms (kg) 

BTon = 1E-6*B tons 

Volume

VDM = 1E-3*V cubic decimeters (dm3, l) 

VCM = 1E-6*V cubic centimeters (cm3) 

VMM = 1E-9*V cubic millimeters (mm3) 

VCI = 1.6387064E-5*V cubic inches (in3) 

VLi = 1E-3*V liters (l) 

Energy

GCal = G/4.1858 cal 

ACal = A/4.1858 cal 

UCal = U/4.1858 cal 

HCal = H/4.1858 cal 

SCal = S/4.1858 Cal/K 



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 34 of 129

Quantity Suggested Name and Expression Unit 

Heat Capacity

Cp2 = HM.T/4.1858 cal/mol/K 

Cp3 = HW.T/4.1858 cal/g/K 

Cp4 = HV.T/4.1858 cal/m3/K 

Thermal Expansion
A2 = VM.T*1E-6/VM 1/K

A3 = VW.T*1E-6/VW 1/K

Isothermal Compressibility
B2 = -VM.P*1E-9/VM 1/Pa

B3 = -VW.P*1E-9/VW 1/Pa

Intensive and Extensive Variables of a System Component

Quantity Suggested Name and Expression Unit 

For Intensive Variables of a System Component

Chemical Potential
MUi  = MU(c)/4.1858 cal/mol 

MURi = MUR(c)/4.1858 cal/mol 

Special quantity for aqueous solution
pH = -LOG10(ACR(H+1)) dimensionless 

Eh = MUR(ZE)/RNF where RNF=96485.309 volts (V) 

For Extensive Variables of a System Component
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Quantity Suggested Name and Expression Unit 

Amount

MFi = N(c)/N = X(c) dimensionless 

MPi = N(c)/N*100 dimensionless 

WFi = B(c)/B = W(c) dimensionless 

WPi   = B(c)/B*100 dimensionless 

BKgi  = 1E-3*B(c) kilograms (kg) 

BToni = 1E-6*B(c) tons 

Extensive Variables of a Phase

Quantity Suggested Name and Expression Unit 

Amount

MFj   = NP(ph)/N dimensionless 

MPj   = NP(ph)/N*100 dimensionless 

WFj   = BP(ph)/B dimensionless 

WPj   = BP(ph)/B*100 dimensionless 

BKgj  = 1E-3*BP(ph) kilograms (kg) 

BTonj = 1E-6*BP(ph) tons 

Volume

VCMj = 1E-3*V(ph) cubic decimeters (dm3, l) 

VCMj = 1E-6*V(ph) cubic centimeters (cm3) 

VMMj = 1E-9*V(ph) cubic millimeters (mm3) 

Energy
GCalj = G(ph)/4.1858 cal 

ACalj = A(ph)/4.1858 cal 
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Quantity Suggested Name and Expression Unit 

Isothermal Compressibility B2j = -VM(ph).P/VM(ph)  1/Pa

Extensive Variables of a Component in a Phase

Quantity Suggested Name and Expression Unit 

Amount

MFij   = N(ph,c)/NP(ph)   = X(ph,c) dimensionless 

MPij   = N(ph,c)/NP(ph)*100 dimensionless 

WFi    = B(ph,c)/BP(ph)  = W(ph,c) dimensionless 

WPij   = B(ph,c)/BP(ph)*100 dimensionless 

BKgij  = 1E-3*B(ph,c) kilograms (kg) 

BTonij = 1E-6*B(ph,c) tons 

Intensive and Extensive Variables of a Species in a Phase

Quantity Suggested Name and Expression Unit 

For Intensive Variables of a Species in a Phase

Chemical Potential
MUCalij = MU(sp,ph)/4.1858 cal/mol 

MUErgij = MU(sp,ph)*1E7 cal/mol 

Fugacity

FAij   = AC(sp,ph)*PATM atmosphere (atm) 

FBij   = AC(sp,ph)*PB bars (bar) 

FCij   = AC(sp,ph)*PKB kilobars (kbar) 

FTij   = AC(sp,ph)*PTOR Tors (millimeters 
of Hg) 



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 37 of 129

Quantity Suggested Name and Expression Unit 

ln(Fugacity)

LnFAij = LNAC(sp,ph)+LN(PATM) atmosphere (atm) 

LnFBij = LNAC(sp,ph)+LN(PB) bars (bar) 

LnFCij = LNAC(sp,ph)+LN(PKB) kilobars (kbar) 

LnFTij = LNAC(sp,ph)+LN(PTOR) Tors (millimeters 
of Hg) 

Special quantity for 
aqueous solution

AIij=ACR(FE+3,AQ)*AH2O dimensionless 

RCij=ACR(FE+3,AQ)*YH2O/Y(AQ,FE+3)

where AH2O=55.508435 and YH2O=Y(AQ,H2O) 
dimensionless 

WRCalij = WR(AQ,sp)/4.1858 

(WR(AQ,sp) is only valid for aqueous species in a system in 
which the AQUEOUS solution phase is considered)

cal/mol 

For Extensive Variables of a Species in a Phase

Special quantity for 
aqueous solution

MLij=Y(AQ,FE+3)*AH2O/YH2O molality (m) 

ISTR=1*IS1+1*IS2+1*IS3

where AH2O=55.508435, YH2O=Y(AQ,H2O) and 
ISn=.5*MLi*Zi**2+.5*MLj*Zj**2+.5*MLk*Zk**2

molality (m) 

Units for Variables of Specific Species in a Phase

In the GIBBS, DATA, PARROT and ED_EXP modules, there are quantities that describe various 
thermodynamic, physical, chemical and transport properties for a compound phase, and for 
a certain species or a given species combination in a specific solution phase. The following 
table describes the units for those variables. 

These variables cannot be directly used in the POLY or POST modules.
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Variables Description and Unit

G(ph,sp)

G(ph,sp;0)

G(ph,sp1;sp2;...;0)

Gibbs energy (J/mol) of a pure substance or end-member.

G(ph,sp1,sp2,...)

L(ph,sp1,sp2,...)

G(ph,sp1,sp2,...;0)

L(ph,sp1,sp2,...;0)

G(ph,sp1,sp2,...;...;0)

L(ph,sp1,sp2,...;...;0)

Zero-order interaction parameter (J/mol) of a specified binary, ternary or higher-
order interactions on a certain sublattice site in a solution phase. 

G(ph,sp1,sp2,...;i)

L(ph,sp1,sp2,...;i)

G(ph,sp1,sp2,...;...;i)

L(ph,sp1,sp2,...;...;i)

The ith -order interaction parameter (J/mol) of a specified binary, ternary or 
higher-order interactions on a certain sublattice site in a solution phase.

TC(ph,sp)

TC(ph,sp;0)

TC(ph,sp1;sp2;...;0)

Curie temperature (K) of a pure substance or end-member. 

TC(ph,sp1,sp2,...)

TC(ph,sp1,sp2,...;0)

TC(ph,sp1,sp2,...;...;0)

Zero-order Curie-temperature contribution (K) to a specified binary, ternary or 
higher-order interactions on a certain sublattice site in a solution phase. 

TC(ph,sp1,sp2,...;i)

TC(ph,sp1,sp2,...;...;i)
The ith -order Curie-temperature contribution (K) to a specified binary, ternary or 
higher-order interactions on a certain sublattice site in a solution phase.

BMAGN(ph,sp)

BMAGN(ph,sp;0)

BMAGN
(ph,sp1;sp2;...;0)

Bohr magneton number (dimensionless) of a pure substance or end-member.

BMAGN(ph,sp1,sp2,...)

BMAGN 
(ph,sp1,sp2,...;0)

Zero-order Bohr magneton number (dimensionless) to a specified binary, ternary or 
higher-order interactions on a certain sublattice site in a solution phase.
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Variables Description and Unit

BMAGN 
(ph,...;sp1,sp2,...;0)

BMAGN
(ph,sp1,sp2,...;i)

BMAGN
(ph,sp1,sp2,...;...;i)

The ith -order Bohr magneton number (dimensionless) to a specified binary, 
ternary or higher-order interactions on a certain sublattice site in a solution phase.  

V0(ph,sp)

V0(ph,sp;0)

V0(ph,sp1;sp2;...;0)

Molar volume (m3) at 1 bar and reference T0 of a pure substance or end-member.

V0(ph,sp1,sp2,...)

V0(ph,sp1,sp2,...;0)

V0(ph,sp1,sp2,...;...;0)

Zero-order composition-dependent molar volume (m3) of a specified binary, 
ternary or higher-order interactions on a certain sublattice site in a solution phase.

V0(ph,sp1,sp2,...;i)

V0(ph,sp1,sp2,...;...;i)
The ith-order composition-dependent molar volume (m3) of a specified binary, 
ternary or higher-order interactions on a certain sublattice site in a solution phase.  

VA(ph,sp)

VA(ph,sp;0)

VA(ph,sp1;sp2;...;0)

Integrated thermal expansivity (m3/mol/K) of a pure substance or end-member.

VA(ph,sp1,sp2,...)

VA(ph,sp1,sp2,...;0)

VA(ph,sp1,sp2,...;...;0)

Zero-order composition-dependent thermal expansivity (m3/mol/K) of a specified 
binary, ternary or higher-order interactions on a certain sublattice site in a solution 
phase.  

VA(ph,sp1,sp2,...;i)

VA(ph,sp1,sp2,...;...;i)  

The ith -order composition-dependent thermal expansivity (m3/mol/K) of a 
specified binary, ternary or higher-order interactions on a certain sublattice site in 
a solution phase.  

VC(ph,sp) High pressure fitting parameter (m3/mol) of a pure substance or endmember.

VC(ph,sp1,sp2,...)
Zero-order composition-dependent high pressure fitting parameter (m3/mol)  of a 
specified binary, ternary or higher-order interactions on a certain sublattice site in 
a solution phase. 

VC(ph,sp1,sp2,...i) The ith -order composition-dependent high pressure fitting parameter (m3/mol)  of 
a specified binary, ternary or higher-order interactions on a certain sublattice site 
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Variables Description and Unit

in a solution phase.

VK(ph,sp) Isothermal compressibility (m3/mol/Pa) of a pure substance or endmember.

VK(ph,sp1,sp2,...)
Zero-order composition-dependent isothermal compressibility (m3/mol/Pa) of a 
specified binary, ternary or higher-order interactions on a certain sublattice site in 
a solution phase. 

VK(ph,sp1,sp2,...i)
The ith -order composition-dependent isothermal compressibility (m3/mol/Pa)  of a 
specified binary, ternary or higher-order interactions on a certain sublattice site in 
a solution phase.

WR(ph,sp)

WR(ph,sp;0)

Standard Born function (J/mol) of a specific aqueous species in the AQUEOUS 
solution phase (always with a single sublattice) under the reference-state 
temperature and pressure.
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State Variables for Scheil

Post processing is done the same way as POLY-3: specific variables for plotting in the Scheil 
module are listed. 

POLY Module Commands

For a comparable list in Graphical Mode, see Scheil Calculator Available Plot 
Variables.

The variables can be plotted along the X- and Y-axes. In the table, ph is an abbreviation of 
phase, and el is an abbreviation of element. An asterisk (*) can be used as a wild character 
for el and ph. Use the abbreviations of the variables when you specify what the X- and Y-
axes represent in a diagram.

Abbreviation State Variable

T Temperature in Celsius

NL/BL/VL Mole/mass fraction of liquid

NS/BS/VS Mole/mass fraction of all solid phases

NS(ph)/BS(ph) Mole/mass fraction of a solid phase

VS(ph) Volume fraction of a solid phase

W(ph,el) Weight fraction of an element in a phase

X(ph,el) Mole fraction of an element in a phase

Y(ph,el) Site fraction of an element in a phase

NN(ph,el) Distribution of an element in a phase

NH/BH Total heat per mole/gram (top curve) and Latent heat per mole/gram (bottom curve)

CP/BCP Apparent heat capacity per mole/gram

NV/NV(ph) Molar volume of the system or a phase

DS/DS(ph) Average density of the system or a phase
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Abbreviation State Variable

BT Apparent volumetric CTE of the system

DVIS(ph) Dynamic viscosity of a phase

KVIS(ph) Kinematic viscosity of a phase

SURF(ph) Surface tension of a liquid phase

ELRS/ELRS(ph) Electrical resistivity of the system or a phase

ELCD/ELCD(ph) Electrical conductivity of the system or a phase

THCD/THCD(ph) Thermal conductivity of the system or a phase

THRS/THRS(ph) Thermal resistivity of the system or a phase

THDF/THDF(ph) Thermal diffusivity of the system or a phase

DGV Driving force for evaporation

DHV Evaporation enthalpy

MMG Molar mass of gas

XAVG(el) Mole fraction of an element in solid phases

WAVG(el) Mass fraction of an element in solid phases
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State Variables in Console Mode DICTRA

State variables in the DICTRA POST module are similar to those defined in Thermo-Calc 
POLY-3 module. Examples of state variables are temperature, mole fraction, enthalpy, etc. In 
POLY-3 a general notation method based on character mnemonics is designed for a 
predefined set of state variables. 

The numerical values of some state variables, e.g. activity, chemical potential, and the 
energetic extensive properties, are given relative to some reference state which has been 
defined in the thermodynamic database file. Sometimes you may have specified a reference 
state using SET_REFERENCE_STATE. To get numerical values relative to the user-defined 
reference state, append an R to the mnemonic names as defined.

Intensive Properties

Mnemonic Description

T temperature

P pressure

AC(component) activity

MU(component) chemical potential

 Extensive Properties

NORMALIZATION of extensive properties: For all extensive properties a suffix can be added 
to the mnemonic name to indicate a normalized extensive property. The following tables 
describe each mnemonic .

Extensive Property `Z at Each Grid Point

Mnemonic Description

Z Extensive property `Z at each grid point.

ZM Extensive property `Z per moles of atoms.
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Mnemonic Description

ZW Extensive property `Z per mass (gram).

ZV Extensive property `Z per volume (m3).

Extensive Property `Z for a Phase at Each Grid Point

Mnemonic Description

Z Extensive property `Z for the current amount of the phase.

ZM Extensive property `Z per mole of atoms of the phase.

ZW Extensive property `Z per mass (gram) of the phase.

ZV Extensive property `Z per volume (m3) of the phase.

ZF Extensive property `Z per mole formula unit of the phase.

Energetic Extensive Properties 

Suffixes M, W, V and F can be applied.

Mnemonic Description

S entropy

S(phase) entropy of a phase

V volume

V(phase) volume of a phase

G Gibbs energy
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Mnemonic Description

G(phase) Gibbs energy of a phase

H enthalpy

H(phase) enthalpy of a phase

A Helmholtz energy

A(phase) Helmholtz energy of a phase

Amount of Components 

Suffixes M, W and V can be applied.

Mnemonic Description

N(component) Number of moles of a component.

N(phase,component) Number of moles of a component in a phase.

B(component) Mass of a component.

B(phase,component) Mass of a component in a phase.

Total Amount

Suffixes M, W and V can be applied. 

Mnemonic Description

N Number of moles
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Mnemonic Description

B

Mass 

The legal combination BW is not very interesting as it will always be 
unity. BV is the density

Amount of a Phase

Suffixes M, W and V can be applied. 

The normalizing properties are calculated at each grid point.

Mnemonic Description

NP(phase) Number of moles of a phase.

BP(phase) Mass of a phase.

VP(phase) Volume of a phase.

Y(phase,species#sublattice)

site fraction 

This quantity is dependent upon the model 
chosen for the phase.

Constitution

This quantity is dependent upon the model chosen for the phase.
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Mnemonic Description

Y(phase,species#sublattice) site fraction 
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Thermophysical Properties Data and Variables
In this section:

About Thermophysical Properties Data Parameters 49
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Electrical Resistivity Model 55

Electrical Conductivity for Ionic Liquid Model 59

Thermal Conductivity Model 61

Surface Tension of Metallic Liquid Alloys Model 65

Surface Tension Model for Oxide Slag 69

Viscosity of the Metallic Liquids Model 70

Viscosity of the Ionic Liquids Model 73

Molar Volume Model 74
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About Thermophysical Properties Data Parameters

Parameters, Functions, and Variables and Thermophysical Properties Variables 

The so-called classic syntax is used in the examples below. It can be used in 
Console Mode or when using the APIs, e.g. TC-Python or TC-Toolbox for 
MATLAB®. Graphical Mode in Thermo-Calc has readable names for all of these.

You can find information on our website about the properties that can be 
calculated with Thermo-Calc and the Add-on Modules. Additional resources are 
added on a regular basis so keep checking back or subscribe to our newsletter.

All Available Properties Data Parameters and Variables

Below is a summary of the available parameters and variables for the databases when 
working in Thermo-Calc. There are differences when you are working in Console Mode 
versus Graphical Mode as well as if you use an SDK such as TC-Python or TC-Toolbox for 
MATLAB®.

Property (and Graphical 
Mode Variable Name) Model Parameters 

Variables to Show or Plot in Console 
Mode or the SDKs (TC-Python, or TC-
Toolbox for MATLAB®)***

Molar volume V0, VA VM for a system VM(PHI) for phase PHI

Electrical conductivity ELQ∗∗ ELCD for a system ELCD(PHI) for phase PHI

Electrical resistivity ELRS, ESPD ELRS for a system ELRS(PHI) for a phase 
PHI

Thermal conductivity THCD THCD for a system THCD(PHI) for phase PHI

Thermal resistivity  THRS for a system THRS(PHI) for phase PHI

Thermal diffusivity  THDF for a system THDF(PHI) for phase PHI

https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
https://thermocalc.com/news-events/#subscribe


Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 50 of 129

Property (and Graphical 
Mode Variable Name) Model Parameters 

Variables to Show or Plot in Console 
Mode or the SDKs (TC-Python, or TC-
Toolbox for MATLAB®)***

Surface tension SIGM, XI*
SURF(LIQUID)

SURF(ION)**

Dynamic viscosity VISC 
DVIS(LIQUID)

DVIS(ION)**

Kinematic viscosity  
KVIS(LIQUID)

KVIS(ION)**

* XI is not used in the TCOX database (all versions). As of 2023b it is also not used starting with the following versions 
of these databases: TCFE13, TCNI12.1, TCTI5.1, TCNOBL3, TCPMAG2, and TCCU6. As of 2024a, TCMG7, TCAL9, and 
TCHEA7. As of 2024b, TCSLD5. 

** ION is used in the TCS Metal Oxide Solutions Database (TCOX)

*** The examples listed for the SDKs are using Console Mode syntax. The quantities can also be accessed in both 
ThermodynamicQuantity and ScheilQuantity classes. See the various model descriptions or the SDK help for details.

Viscosity Model

Viscosity of the Metallic Liquids Model

Viscosity of the Ionic Liquids Model

To use this model, the database parameter VISC is needed.  It can be used for liquids.

 l Dynamic viscosity (DVIS)
 l Kinematic viscosity (KVIS)

Examples in Console Mode:

 l In POLY module: SHOW DVIS(LIQUID)

 l Set as plot variable: SET-DIAGRAM-AXIS Y KVIS(LIQUID)

Thermal Conductivity Model

Thermal Conductivity Model
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To use the thermal conduction parameters, the database parameter THCD is needed. The 
other two related properties are derived from THCD. These properties can be obtained for a 
phase or for the whole system.

 l Thermal conductivity (THCD)
 l Thermal diffusivity (THDF)
 l Thermal resistivity (THRS)

Examples in Console Mode:

 l In POLY module: SHOW THCD

 l Set as plot variable: SET-DIAGRAM-AXIS Y THDF(FCC_A1)

Electrical Conductivity and Electrical Resistivity Models

Electrical Resistivity Model

To use the electric properties parameters, the database parameter ELRS is needed. ELCD is 
derived from that. These properties can be obtained for a phase or for the whole system.

 l Electrical conductivity (ELCD)
 l Electrical resistivity (ELRS)

Examples in Console Mode:

 l In POLY module: SHOW ELCD

 l Set as plot variable: SET-DIAGRAM-AXIS Y ELRS(FCC_A1)

Electrical Conductivity of Molten Slag Model

Electrical Conductivity for Ionic Liquid Model

To use the electric properties parameters, the database parameter ELQ is needed. The 
model parameters are the activation Gibbs energy of end-members and excess activation 
Gibbs energy. 

 l Electrical conductivity of molten slags ELCD(IONIC)
 l Electrical resistivity of molten slags ELRS(IONIC)
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Surface Tension Model

Surface Tension of Metallic Liquid Alloys Model

Surface Tension Model for Oxide Slag 

Surface tension for liquids can be calculated if the database contains the two database 
parameters SIGM and XI. From these, the surface energy is calculated:

 l Surface energy (SURF)

XI is not used in the TCS Metal Oxide Solutions Database (TCOX)

Examples in Console Mode:

 l In POLY module: SHOW SURF(LIQUID)

 l Set as plot variable: SET-DIAGRAM-AXIS Y SURF(LIQUID)
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Thermophysical Properties Variables 

The Thermo-Calc databases have a variety of properties data included such as molar volume, 
thermal conductivity, dynamic and kinematic viscosity, thermal resistivity, electrical 
resistivity, and surface tension. These properties data are being integrated into databases as 
each new version of a database is released. 

Availability of properties data is dependent on both the database and its 
version. Some information is specific to use in Console Mode. There is more 
information also available   for Graphical Mode, TC-Python, or TC-Toolbox for 
MATLAB® for each of the databases where the properties data is included. 
More advanced information is also contained in the Database Manager User 
Guide  PARAMETER section included with this documentation set.

To determine if the database you are using has this properties data, search the 
help (press F1) to review the technical information. The availability of 
properties data is also included with the Database Overview document 
available on the Thermo-Calc website. 

Variables Abbrev. Unit Descript. Domain

DVIS DVIS(ph) Pa·s Dynamic viscosity Liquid phase

KVIS KVIS(ph) m2/s Kinematic 
viscosity Liquid phase

ELCD ELCD S/m Electric 
conductivity System

ELCD ELCD(ph) S/m Electric 
conductivity Phase

ELRS ELRS Ωm Electric resistivity System

ELRS ELRS(ph) Ωm Electric resistivity Phase

THCD THCD W/(mK) Thermal 
conductivity System

https://thermocalc.com/wp-content/uploads/Brochures_and_Flyers/Current/marketing-database-overview.pdf
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Variables Abbrev. Unit Descript. Domain

THCD THCD(ph) W/(mK) Thermal 
conductivity Phase

THRS THRS mK/W Thermal 
resistivity System

THRS THRS(ph) mK/W Thermal 
resistivity Phase

THDF THDF m2/s Thermal 
diffusivity System

THDF THDF(ph) m2/s Thermal 
diffusivity Phase

SURF SURF(ph) J/m2 Surface tension Liquid phase



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 55 of 129

Electrical Resistivity Model

The modeling starts with unaries in their stable and metastable structures. The temperature 
dependence of electrical resistivity is described with polynomials for each unary and each 
end-member of compounds. In order to guarantee the reliability of the extrapolation, 
experimental data were first fitted to a semi-empirical model, which was established based 
on relevant theories. The experimental data, together with the extrapolated values, are then 
used for deriving the polynomials that are saved in the database. The magnetic contribution 
to electrical resistivity can be separately treated with a model implemented in Thermo-Calc.

The composition dependence of electrical resistivity is described with the Redlich-Kister 
expression. All binary systems are modeled by using experimental data or theoretical 
estimations. Ternary and higher-order parameters can be used if necessary.

Electrical resistivity is modeled and its descriptions are stored in the databases. Electrical 
conductivity is derived from electrical resistivity and can be retrieved from calculated results 
as well.

Model Description

The semi-empirical model for electrical resistivity is built based on the Matthiessen’s rule 
[1997DeB]. In general, the electrical resistivity of a metallic alloy consists of residual 
resistivity ( ) and electron-phonon resistivity ( ), as well as magnetic resistivity ( ). The 
residual resistivity is due to the scatterings of impurities and defects that exist in well-
annealed and high purity alloys, and the value of   is generally considered independent of 
temperature. 

[Eq. 1]         

 is described with the modified Bloch-Grüneisen equation [1928Blo; 1933Gru] and 
corrections can be made in cases where other types of scatterings play considerable roles.

[Eq. 2]         

[Eq. 3]         

[Eq. 4]         
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The characteristic temperature  plays a similar role and is also approximated as the Debye 
temperature ( ), which can be readily obtained from low-temperature heat capacity and 
elastic constants data as well as theoretical computations. The approximation of  as  
indicates that transverse phonons play a role in electron scattering.  is the electron wave 
number at the Fermi surface.  is the phonon Debye wave number.  is the Planck 
constant.  is a constant representing the strength of the e-p interaction and cannot be 
easily estimated.  is the electron effective mass.  is the number of unit cells per unit 
volume.  is the electron velocity at the Fermi surface. 

To describe the drastic change of the magnetic resistivity ( ) around the Curie (or Neel) 
temperature, , of a magnetic alloy, an empirical model is proposed using the 
dimensionless temperature  and a parameter  that stands for the resistivity due to 
spin disordering. According to this model, Eq. 5,   approaches ,  when the temperature 
is well above , and is 0 when the temperature is far below .   depends only on 
composition and is described with the Redlich-Kister (R-K) expression. Apparently,   has a 
positive value for magnetic elements, and compounds as well as endmembers, and is 0 for 
non-magnetic ones. 

In a typical binary system made of a magnetic element A and a non-magnetic element B,   

decreases usually from   to 0 at a certain composition ( ). Such a behavior is also seen in 
magnetic moment and Curie temperature.   is expected to be zero in the composition 
range from  to element B, and will be forced to zero when the R-K expansion leads 
inevitably to negative values over this composition range.  is available from the 
thermodynamic description in the database.

[Eq. 5]         

The semi-empirical model (as given in Eq. 1 to Eq. 5) is first fitted to experimental data. The 
description is then extrapolated to a wider temperature range if necessary, either to 
extreme temperatures where the structure is no longer stable or to where experimental 
data are missing. Polynomials are then derived with the experimental data, together with 
the extrapolated values, and stored in the database. The model as given in Eq. 5 is 
implemented in Thermo-Calc, so the magnetic contribution can be excluded from the 
polynomials and separately modeled, and it will be automatically included during the 
calculations. 
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Model Parameters

The extended TDB format accepts parameters describing electrical resistivity and thermal 
conductivity, together with spin disordering resistivity. Examples for unary and binary 
systems are given below:

ELRS(FCC_A1,AL:VA;0)

ELRS(FCC_A1,AL,CO:VA;0)

ESPD(FCC_A1,CO:VA;0)

ESPD(FCC_A1,AL,CO:VA;0)

Calculation and Plot Variables
 l ELRS – Electrical resistivity
 l ELCD – Electrical conductivity

All the above quantities can be calculated, retrieved, shown and plot in Thermo-Calc via the 
variables in the Console Mode or via the quantity names in the Graphical Mode (see sections 
below).   

CONSOLE MODE

The quantities corresponding to the variables of ELRS and ELCD can be calculated in Console 
Mode for a phase, e.g. ELRS(FCC_A1), or for a system, i.e.  ELRS. The results can be shown in 
the POLY module with the command SHOW_VALUE or illustrated as a plot in the POST module 
with the command PLOT_DIAGRAM.

GRAPHICAL MODE

On the Plot Renderer in Graphical Mode, electrical resistivity, electrical conductivity, 
thermal conductivity, thermal resistivity, and thermal diffusivity can be selected from the 
axes lists, tabulated and plotted using the quantity names, with options for a specific phase, 
all phases or for a system. 

TC-PYTHON AND TC-TOOLBOX FOR MATLAB®

With these Software Development Kits (SDKs), the quantities of ELRS and ELCD can be 
retrieved, for a phase, e.g. ELRS(FCC_A1), or for a system, i.e.  ELRS, via get_value_of() or 
get_values_of(), from most phase equilibrium calculations in TC-Python, for instance, 
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 l with_single_equilibrium_calculation(), 
 l with_property_digram_calculation() or
 l with_batch_equilibrium_calculation().

These can also be accessed in both ThermodynamicQuantity and ScheilQuantityclasses. 
You can, for example, use ThermodynamicQuantity.electrical_resistivity() for 
electrical resistivity.

References

[1928Blo] F. Bloch, Über die Quantenmechanik der Elektronen in Kristallgittern (About the 
quantum mechanics of electrons in crystal lattices). Zeitschrift fur Phys. 52, 555–600 
(1928).

[1933Gru] E. Grüneisen, The dependence of the electrical resistance of pure metals on the 
temperature. Ann. Phys. 16, 530–540 (1933).

[1997DeB] R. De-Bruyn-Ouboter, Heike Kamerlingh Onnes’s discovery of superconductivity. 
Sci. Am., 98–103 (1997).
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Electrical Conductivity for Ionic Liquid Model

The model for the electrical conductivity of molten slags is mainly based on the theory of the 
electrical conductivity of ionic solutions. The total conductivity is the sum of the 
contributions from all cations including those network-forming cations modeled as neutrals 
in the two sublattice ionic liquid model, such as liquid silicon oxide. For slags containing 
transition metal ions of different oxidation states, the electronic contribution due to the 
electron or hole exchange between these ions is also considered.

In short, the electrical conductivity of molten slags consists of the following:

 1. Ionic conductions contributed by cations in the ionic liquid. 

 2. Electronic conductions from the cations having more than one oxidation states (Fe2+- 
Fe3+, Mn2+- Mn3+ and so on).

The composition and temperature dependence of the total electrical conductivity of molten 
slags, , is represented by:

where  is the mole fraction of cation , and its electrical conductivity, , is written in 
the form of the Nernst-Einstein equation as:

where  is the activation Gibbs energy, of which the composition dependence has been 
expanded in a CALPHAD fashion.

Model Parameters

The model parameters are the activation Gibbs energy of end-members and excess 
activation Gibbs energy in the above equation. They can be entered in the GES module or 
TDB file by using the keyword ELQ, for example,

PARAM ELQ(IONIC_LIQ&Ca+2,CA+2:O-2;0)

PARAM ELQ(IONIC_LIQ&Ca+2,CA+2:SIO4-4;0)

PARAM ELQ(IONIC_LIQ&Ca+2,CA+2:SIO2;0)
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Calculation and Plot Variables

All the quantities can be calculated, retrieved, shown and plot in Thermo-Calc via the 
variables in the Console Mode or via the quantity names in the Graphic Mode.   

CONSOLE MODE

The electrical conductivity and resistivity of molten slags modeled as the ionic liquid phase 
can be calculated usually through a single point or step equilibrium calculation in Console 
Mode. The results can be shown or plotted by using the variables ELCD(IONIC) and ELRS
(IONIC), respectively.

GRAPHICAL MODE

On the Plot Renderer in Graphical Mode, the electrical conductivity and resistivity of molten 
slags modeled as the ionic liquid phase can be calculated by using the Single point or One 
Axis calculation type in Graphical Mode. The corresponding tabulation or plot variables are 
Electrical Conductivity and Electrical Resistivity, respectively.

TC-PYTHON AND TC-TOOLBOX FOR MATLAB®

With these Software Development Kits (SDKs), this property can be plotted using property-
diagram_calculation() or with_batch_ equilibrium_calculation(). The plot variables 
are ELCD(IONIC) and ELRS(IONIC). 

These can also be accessed in both ThermodynamicQuantity and ScheilQuantityclasses. 
You can, for example, use ThermodynamicQuantity.electrical_conductivity("IONIC") 
and ThermodynamicQuantity.electrical_resitivity("IONIC") for electrical conductivity 
and electrical resistivity, respectively.

You can also get the individual values e.g. from an equilibrium calculation and use in 
whatever way you want, e.g. feed into other models: result.get_value_of("ELCD(IONIC_
LIQ)"), where 'result' is the result of one equilibrium calculation. It matches SHOW_VALUE in 
Console Mode.

This can also be written result.get_value_of(ThermodynamicQuantity.electrical_
conductivity("IONIC_LIQ")) or result.get_value_of
(ThermodynamicQuantity.electrical_resitivity("IONIC_LIQ")).
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Thermal Conductivity Model

The modeling starts with unaries in their stable and metastable structures. The temperature 
dependence of thermal conductivity is described with polynomials for each unary and each 
end-member of compounds. Thermal resistivity and thermal diffusivity can be derived from 
thermal conductivity and retrieved from calculated results. The composition dependence is 
described with the Redlich-Kister expression in the CALPHAD spirit, but the relation is 
applied to thermal resistivity (or the inverse of thermal conductivity).

Model Description

Experimental data of thermal conductivity are used to derive descriptions in polynomials, 
which are stored in the database, despite that it consists of two components, electronic 
thermal conductivity ( ) and lattice thermal conductivity . In other words, they are not 
separately treated. 

In cases where experimental data are absent or sparse, however,  and  can be 
separately predicted and summed up to give the total thermal conductivity.  can be 
predicted from  or vice versa, by employing the Wiedemann-Franz Law [1853Fra; 1985Jon], 
respectively, to the residual resistivity, magnetic resistivity and intrinsic resistivity. 

[Eq. 1]         

 is known as the Sommerfeld value of the Lorenz number: .

[Eq. 2]         

[Eq. 3]         

The intrinsic resistivity ( ) is based on Eq. 4

[Eq. 4]         

for the e-p processes, but corrections are provided, as given in Eq. 3: the first term 
corresponds to large-angle scattering that satisfies the original Wiedemann-Franz Law; the 
second one is due to inelastic small-angle (vertical processes) and has no counterpart in the 
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electrical resistivity; the third term is a correction that accounts for situations where large-
angle scattering can reverse the electron direction without actually assisting to restore the 
distribution back to equilibrium. 

 can be predicted with the Slack model in a temperature range where only anharmonic 
Umklapp phonon-phonon interactions are important. In other words, normal processes are 
neglected as a first approximation [1979Sla; 2002Mor]. The most reasonable version among 
several ones is given below [1965Jul].

[Eq. 5]         

[Eq. 6]         

The Debye temperature,  can be obtained from low-temperature heat capacity or elastic 
constant data.  is the average atomic mass,  the volume per atom,  the number of 
atoms in a unit cell, and  the Grüneisen coefficient. A typical value for  is evaluated to be 

 using   as the Grüneisen coefficient, and can be used in the absence of 
experimental information. It can also be obtained from e.g. DFT calculations of elastic 
properties.

Model Parameters

The extended TDB format accepts parameters describing electrical resistivity and thermal 
conductivity, together with spin disordering resistivity. Examples for unary and binary 
systems are given below:

THCD(FCC_A1,AL:VA;0)

THCD(FCC_A1,AL,CO:VA;0)

Calculation and Plot Variables
 l THCD – Thermal conductivity
 l THRS – Thermal resistivity
 l THDF – Thermal diffusivity 

All the above quantities can be calculated, retrieved, shown and plot in Thermo-Calc via the 
variables in the Console Mode or via the quantity names in the Graphic Mode (see sections 
below).   
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CONSOLE MODE

The quantities corresponding to the variables of  THCD, THRS, and THDF can be calculated in 
Console Mode for a phase, e.g. THCD(FCC_A1), or for a system, i.e.  THCD. The results can be 
shown in the POLY module with the command SHOW_VALUE or illustrated as a plot in the 
POST module with the command PLOT_DIAGRAM.

GRAPHICAL MODE

On the Plot Renderer in Graphical Mode, electrical resistivity, electrical conductivity, 
thermal conductivity, thermal resistivity, and thermal diffusivity can be selected from the 
axes lists, tabulated and plotted using the quantity names, with options for a specific phase, 
all phases or for a system. 

TC-PYTHON AND TC-TOOLBOX FOR MATLAB®

The quantities of THCD, THRS, and THDF can be retrieved, for a phase, e.g. THCD(FCC_A1), or 
for a system, i.e.  THCD, via get_value_of() or get_values_of(), from most phase 
equilibrium calculations in these Software Development Kits (SDKs), for instance, 

 l with_single_equilibrium_calculation(), 
 l with_property_diagram_calculation() or
 l with_batch_equilibrium_calculation().

These can also be accessed in both ThermodynamicQuantity and ScheilQuantity classes. 
You can, for example, use ThermodynamicQuantity.thermal_resistivity() for thermal 
resistivity.
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Surface Tension of Metallic Liquid Alloys Model

In general, for liquid metal alloys, the surface tension is assessed for all the elements and 
binary systems where experimental data are available. When experimental data are not 
available, the Butler model [1932But] is used to estimate the composition dependence of 
the surface tension. The experimental or estimated data are modeled with either the 
modified Guggenheim model [2019Ver] or the Redlich-Kister-Muggianu sub-regular solution 
model [1948Red; 1975Mug].

Search the help (press F1) to review the technical information for the database 
you are using. 

Modified Guggenheim Model Description

The surface tension of metallic liquid alloys by the modified Guggenheim model [2019Ver] 
and is expressed as:

where 

 l  is the bulk composition

 l  is the surface tension
 l  and   are the total and the partial molar surface of species  defined as 

 l  being the Avogadro number and  the molar volume of the system or the 
species . 

 l  is the composition of  in surface, which is a function of bulk composition and  
and defined as follows:
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 l  and  are called damping factors and these parameters are fitted for species 1 
and 2 of binary systems. 

The extrapolation to higher-order systems is straightforward. The ideal surface composition 
for a multicomponent system is:

and the surface tension of a multicomponent alloy is obtained from:

Corresponding Variable - Modified Guggenheim

The corresponding variable for surface energy of pure elements is SIGM. For instance, the 
surface tension of pure A is written as SIGM(LIQUID,A;0). The corresponding X1 and X2 
parameters for A-B binary system are respectively written as following:

PARAMETER XI(LIQUID,A,B:0) 

PARAMETER XI(LIQUID,A,B:1) 

Redlich-Kister-Muggianu Model Description

In the case of using the Redlich-Kister-Muggianu (R-K-M) [1948Red; 1975Mug] sub-regular 
solution model for modeling the surface tension, the surface tension is given by: 

where  and  are the site fraction and surface tension for pure component , and the 
excess term is expressed using (R-K) for binary and (R-K-M) for ternary interactions.

Corresponding Variable Redlich-Kister-Muggianu

The corresponding variable for surface energy of pure elements is SIGM. For instance, the 
surface tension of pure A is written as SIGM(LIQUID,A;0). The corresponding   parameters  
for the A-B binary system are written as follows:

PARAMETER SIGM (IONIC_LIQ, A, B; 0)



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 67 of 129

PARAMETER SIGM (IONIC_LIQ, A, B; 1)

PARAMETER SIGM (IONIC_LIQ, A, B; 2)

Plot Variables (Both Models)

Console Mode

The surface energy can be calculated through various calculations in Console Mode, e.g. a 
step. The plot variable is  SURF(LIQUID).  

Graphical Mode

On the Plot Renderer in Graphical Mode,  the plot variable Surface tension can be selected 
from the axes lists, tabulated and plotted using the quantity names, with options for a 
specific liquid phase based on the database. 

TC-Python and TC-Toolbox for MATLAB®

The quantity SURF(LIQUID) can be retrieved, for a liquid phase, e.g. SURF(LIQUID)), via get_
value_of() or get_values_of(), from most phase equilibrium calculations in these 
Software Development Kits (SDKs), for instance, 

 l with_single_equilibrium_calculation(), 
 l with_property_diagram_calculation() or
 l with_batch_equilibrium_calculation().

These can also be accessed in both ThermodynamicQuantity and ScheilQuantity classes. 
You can, for example, use ThermodynamicQuantity.surface_tension("LIQUID").

Graphical Mode and Console Mode Examples

There are two basic examples  included with your software installation and that use 
demonstration (DEMO) databases.

Search the help (press F1 when in Thermo-Calc) for brief descriptions of these examples, or 
browse to the examples located in your installation. From the main menu, Help→ Examples 
Files:

 l Graphical Mode T_11_Surface_tension_in_Cu-Zr.tcu
 l Console Mode tcex56
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Surface Tension Model for Oxide Slag 

The model for TCS Metal Oxide Solutions Database (TCOX) surface tension of oxide slag:

where  and  indicate the site fraction and surface tension for pure component . For pure 
component, the surface tension is described with . The excess term is expressed 
using Redlich-Kister polynomial, as one can find the example of a binary A-B.

SIGM is the parameter used for optimization, for example,

PARAMETER SIGM (IONIC_LIQ, A;0)

PARAMETER SIGM (IONIC_LIQ, B;0)

PARAMETER SIGM (IONIC_LIQ, A:B,0)

The user can calculate the surface tension of liquid oxide by calling the variable SURF
(IONIC).
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Viscosity of the Metallic Liquids Model

This section provides details about calculating the dynamic and kinematic viscosities.

Model Description

The viscosity of metallic liquid alloys is modeled as follows:

where

 l  is the dynamic (or shear) viscosity of the liquid,
 l  is the viscosity at finite temperatures,
 l  is the activation energy in J/mole,
 l  is the gas constant, and
 l  is the absolute temperature.

The SI unit of viscosity is pascal.second (Pa.s). The viscosity parameters are expanded via 
Redlich-Kister polynomials.

For example, viscosity of a liquid A-B alloy is:

The two first terms are the contributions for the end-members, A and B elements and the 
last term accounts for the excess viscosity. Basically, the activation energies are optimized. 

 and etc. are the parameters that are optimized to fit the viscosity data.

The kinematic viscosity, , is the ratio of the dynamic viscosity, , to the density, , of the 
alloy:

The SI unit of kinematic viscosity is square meter per second (m2/s).
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Calculation and Plot Variables

Both the dynamic viscosity and kinematic viscosity can be calculated, retrieved, shown, and 
plotted in Thermo-Calc via the variables in Console Mode, using the quantity names in 
Graphical Mode, and also via the quantities in the SDKs.

CONSOLE MODE

The values for dynamic viscosity and kinematic viscosity in Console Mode are obtained with 
the variables DVIS (dynamic viscosity) and KVIS (kinematic viscosity). For example, once the 
equilibrium is calculated in Console Mode, you can get the viscosity value by show DVIS
(LIQUID) or show KVIS(LIQUID).

GRAPHICAL MODE

On the Plot Renderer in Graphical Mode, the dynamic viscosity and kinematic viscosity each 
can be directly plotted when the variables are available to select.

TC-PYTHON AND TC-TOOLBOX FOR MATLAB®

The quantities of DVIS (dynamic viscosity) and KVIS (kinematic viscosity) can be retrieved, 
for a phase, e.g. DVIS(FCC_A1), or for a system, i.e. DVIS, via get_value_of() or get_
values_of(), from most phase equilibrium calculations in these Software Development Kits 
(SDKs), for instance, 

 l with_single_equilibrium_calculation(), 
 l with_property_diagram_calculation() or
 l with_batch_equilibrium_calculation().

These can also be accessed in both ThermodynamicQuantity.kinematic_viscosity
("LIQUID") or ThermodynamicQuantity.dynamic_viscosity("LIQUID").

Graphical Mode and Console Mode Examples

There are two basic examples included with your software installation and that use 
demonstration (DEMO) databases.

Search the help (press F1 when in Thermo-Calc) for brief descriptions of these examples, or 
browse to the examples located in your installation. From the main menu, Help→ Examples 
Files:
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 l Graphical Mode T_12_Viscosity_in_Cr-Ni.tcu
 l Console Mode tcex55
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Viscosity of the Ionic Liquids Model

The model for TCS Metal Oxide Solutions Database (TCOX) viscosity of slag:

where  is viscosity,  and  is activation energy.

The excess parameters are expanded via R-K. An example of viscosity of A-B liquid oxide:

The parameter of VISC stands for R⋅ T⋅ ln(viscosity). In Thermo-Calc software, 
VISC is implemented as VISC(ionic). In order to quickly acquire the actual 
viscosity, the parameter of DVIS(ionic) should be used. By coupling to the  
database, it makes use of the site fractions of each species, which reflects the 
structural change in the oxide melt.

Units for the viscosity of oxide slag:

 l Pa·s (pascal-second) is the SI unit, mostly used for oxide slag
 l CGS unit is poise (P), 1 poise=0.1 Pa·s
 l Centipoise is also common (cP) because it is equivalent to mPa·s.



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 74 of 129

Molar Volume Model

Molar volume can be used to establish a connection with some significant physical 
properties, for example, viscosity, electrical conductivity and surface tension. It is the 
reciprocal of density multiplied by molar mass. 

Model Description

The model used to describe the molar volume at ambient pressures is:

A simple polynomial is used to model non-magnetic volumetric expansivity above 298 K:

The model described above is implemented in Thermo-Calc software with two parameters, 
V0 and VA, and α is the linear thermal expansivity at 1 bar and 3α is the volumetric thermal 
expansivity.

Molar Volume Descriptions

Parameter Unit Description

V0 (phase, constituent array) m3/mol Volume at 1 bar and reference temperature T0

VA (phase, constituent array) None
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Elastic Properties Variables
In this section:

Elastic Properties Variables 76

About the Elastic Properties 78



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 76 of 129

Elastic Properties Variables

As of Thermo-Calc version 2024b, elastic properties are available with 
Thermo-Calc and the TCS Ti/TiAl-based Alloys Database (TCTI) starting with the 
most recent version (TCTI6). These elastic properties will be added to additional 
databases over time. Subscribe to our newsletter to be kept up-to-date on the 
latest product releases, webinars, user group meetings, applications examples, 
and more.

You can find information on our website about the properties that can be 
calculated with Thermo-Calc and the Add-on Modules. Additional resources are 
added on a regular basis so keep checking back or subscribe to our newsletter.

About the Elastic Properties.

For information about thermophysical properties such as surface tension, 
viscosity, etc, see About Thermophysical Properties Data Parameters.

Elastic Constants and Moduli Variables

The so-called classic syntax is used in the examples below. It can be used in 
Console Mode or when using the APIs, e.g. TC-Python or TC-Toolbox for 
MATLAB®. Graphical Mode in Thermo-Calc has readable names for all of these.

The quantities corresponding to individual elastic constants and elastic moduli (derived from 
the elastic constants) can be calculated in Console Mode for individual phases or for all 
phases. The results can be shown in the POLY module with the command SHOW_VALUE or 
shown as a plot in the POST module with the command PLOT_DIAGRAM using:

https://thermocalc.com/news-events/#subscribe
https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
https://thermocalc.com/content/uploads/Documentation/Current_Static/properties-that-thermo-calc-can-calculate.pdf
https://thermocalc.com/news-events/#subscribe
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 l Cij(<phase name>) or Cij(*)
 l Bulk modulus: BULKMOD(<phase name>) or BULKMOD(*)
 l Shear modulus: SHEARMOD(<phase name>) or SHEARMOD(*)
 l Young's modulus: YOUNGMOD(<phase name>) or YOUNGMOD(*)

Variables Unit Description

BULKMOD Pascal Bulk modulus

SHEARMOD Pascal Shear modulus

YOUNGMOD Pascal Young's modulus

Cij Pascal
Elastic constants

i.e. C11, C12, C13, C33, or C44
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About the Elastic Properties

As of Thermo-Calc version 2024b, elastic properties are available with 
Thermo-Calc and the TCS Ti/TiAl-based Alloys Database (TCTI) starting with the 
most recent version (TCTI6). These elastic properties will be added to additional 
databases over time. Subscribe to our newsletter to be kept up-to-date on the 
latest product releases, webinars, user group meetings, applications examples, 
and more.

To use the elastic properties parameters, the database parameter ECij is needed. The 
elastic stiffness tensor is described by its independent tensor elements (elastic constants) 
given by the indices  in Voigt notation. Both indices  and  run from 1 to 6 and the number 
of independent tensor elements depends on the symmetry of the crystal lattice (i.e., three 
independent constants for cubic crystals and five for hexagonal crystals). The elastic moduli 
are derived from the elastic constants. The elastic properties can be obtained for cubic (FCC 
and BCC) or hexagonal (HCP) phases.

An example of the effect of oxygen concentration on Young’s modulus in HCP_
A3 titanium is included with the Thermo-Calc installation. The installed T_19_
Elastic_Properties_YoungsModulus_Ti-O.tcu example is available from the 
Thermo-Calc Examples folder. 

The TCS Ti/TiAl-based Alloys Database (TCTI) Validation and Calculation 
Examples Collection has examples using elastic properties. You can find these 
either in the Thermo-Calc help or via the Examples Collection PDF, which is 
available on our website. 

Elastic Properties Model

The modeling process begins with determining the independent elastic constants for each 
phase.

 l For cubic (FCC, BCC) phases, the independent elastic constants are: .
 l For hexagonal (HCP) phases, the independent elastic constants are: 

.

The temperature dependence of the elastic constants is represented by exponential and 
polynomial functions for each phase's end-member. To ensure reliable interpolation and 
extrapolation, both experimental and theoretical data are fitted to a robust model based on 

https://thermocalc.com/news-events/#subscribe
https://thermocalc.com/products/databases/titanium-and-titanium-aluminide-based-alloys/
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relevant theories, following the CALPHAD methodology. For magnetic materials, the 
magnetic contribution to the elastic constants is treated separately and incorporated into 
the model implemented in Thermo-Calc [2021Joh].

The elastic constants assessed for single crystalline phases are related to the polycrystalline 
elastic moduli (bulk, shear, and Young’s moduli) using the Voigt-Reuss-Hill averaging 
method. These moduli are expressed in terms of the Voigt (upper bound) and Reuss (lower 
bound) limits of the elastic moduli as follows:

Bulk modulus

Shear modulus

Young's modulus

Cubic Symmetry

The Voigt and Reuss bounds depend on crystal symmetry. For cubic (FCC, BCC) phases with 3 
independent elastic constants ( ), the Voigt and Reuss bounds are given as:  

Hexagonal Symmetry

For hexagonal (HCP) phase with 5 independent elastic constants ( ), the 
Voigt and Reuss bounds are calculated as: 
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Where the symmetry relation  and help function 
 are used to further condense .

Learn more on our website about the CALPHAD Method and how it is applied 
to the Thermo-Calc databases.

Model Parameters

The extended TDB format accepts parameters describing elastic constants and magnetic 
ordering effects. Examples for unary and binary systems are given below for C11:

EC11(HCP_A3,TI:VA;0)

EC11(HCP_A3,TI,MO:VA;0)

EC11(BCC_A2,FE:VA;0)

EC11MAG(BCC_A2,FE:VA;0)

EC11(BCC_A2,FE,CR:VA;0)

Where EC11MAG is the scaling factor for the magnetic contribution.

PARAMETER in the Database Manager User Guide.

Calculation and Plot Variables

 l Elastic constants (Cij)
 l Bulk modulus
 l Shear modulus
 l Young’s modulus

All of the above quantities can be calculated, retrieved, shown, and plotted in Thermo-Calc 
via the variables in Console Mode or via the axes quantity names in Graphical Mode.

Elastic Properties Variables

Graphical Mode

In the Plot Renderer in Graphical Mode, elastic constants and moduli can be selected from 
the drop-down list of axis variables. 

https://thermocalc.com/about-us/methodology/the-calphad-methodology/
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The independent elastic constants are selected on the Plot Renderer as an axis variable 
Elastic constant and then choose an option (C11, C12, C13, C33, or C44) from the drop-down 
list.

The elastic moduli, Bulk modulus, Shear modulus, and Young's modulus, are directly 
available from the Axis variable list.

All can be tabulated and plotted using the quantity names, with options for a specific phase 
or all phases.

Console Mode

The quantities corresponding to the individual elastic constants and elastic moduli (derived 
from the elastic constants) can be can be calculated in Console Mode for individual phases 
or all phases. The results can be shown in the POLY module with the command SHOW_VALUE 
or shown as a plot in the POST module with the command PLOT_DIAGRAM using:

 l Cij(<phase name>) or Cij(*)
 l Bulk modulus: BULKMOD(<phase name>) or BULKMOD(*)
 l Shear modulus: SHEARMOD(<phase name>) or SHEARMOD(*)
 l Young's modulus: YOUNGMOD(<phase name>) or YOUNGMOD(*)

TC-Python and TC-Toolbox for MATLAB®

For the Software Development Kits (SDKs), i.e. TC-Python and TC-Toolbox, the quantities of 
elastic constants, bulk modulus, shear modulus, and Young’s modulus can be retrieved for 
individual phases or all phases via get_value_of() or get_values_of() from any 
equilibrium calculation types using:

 l Cij(<phase name>) or Cij(ALL_PHASES/*)
 l ThermodynamicQuantity.bulk_modulus(<phase name>) or 

ThermodynamicQuantity.bulk_modulus(ALL_PHASES/*)

 l ThermodynamicQuantity.shear_modulus (<phase name>) or 
ThermodynamicQuantity.shear_modulus(ALL_PHASES/*)

 l ThermodynamicQuantity.youngs_modulus(<phase name>) or 
ThermodynamicQuantity.youngs_modulus(ALL_PHASES/*)

See the relevant SDK documentation for details.
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Units

When plotting or tabulating the elastic moduli in Graphical Mode you can choose between 
several units of pressure. The default unit for elastic moduli in the Plot Renderer and Table 
Renderer is GPa.

The elastic moduli and elastic constants are given in SI units, i.e. the values calculated in 
TC-Python, TC-Toolbox, and Console Mode are in Pascal.

Reference

[2021Joh] E. Johansson, PhD thesis, Theoretical studies of the coupling between electronic, 
vibrational, configurational and structural effects in metal borides, Linköping University 
(2021).
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Database Files
In this section:

About the Database Files 84

Database Installation Folder 86

About Cached Database Files 87

Editing the Database Initialization File or Unencrypted Database File 88

Database Checker 89
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About the Database Files

Database Manager User Guide

Encrypted vs Unencrypted Database Files

Any licensed databases purchased from Thermo-Calc Software are encrypted in files with 
the extension .TDC; these files cannot be edited. These are referred to as encrypted 
databases.

Unencrypted databases have the file extension .TDB and can be edited. For example, PURE5 
or PG35 (the free databases), or a user-defined database file. 

Editing the Database Initialization File or Unencrypted Database File

If you develop your own databases on a regular basis, also see About the TDB 
Editor.

Database Initialization File

The database initialization file is called tc_initd.tdb.  Individual licenses are still required to 
use each database.

The file is used differently by the program depending on whether you are working with 
databases in Console Mode or Graphical Mode. For this reason, editing the file can be 
problematic if you do not understand the differences. 

About Cached Database Files and Editing the Database Initialization File or 
Unencrypted Database File

User Database Files

A user-defined database is considered to be an unencrypted database because you can 
make changes to it.

In Graphical Mode you can add user databases via the Options window. Once you have 
added the user database it is available from the database list in the System Definer 
Configuration window. 

Global Settings: System Definer to add a user database.
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In Console Mode, users can decide to add their own user-defined database to the database 
initiation file, which then makes it available in the Console window. 

Editing the Database Initialization File or Unencrypted Database File

Custom Databases: GES5 and GES6 Calculation Engine Version

As of Thermo-Calc version 2019b, the default calculation engine is set to GES6. For custom 
database users, you may sometimes see messages in the log indicating that additional 
preparation is being done by Thermo-Calc prior to a calculation. The preparation is carried 
out automatically; it is usually fast and only needed the first time a custom database is used 
after a modification. While databases with warnings are tolerated, databases that contain 
errors can only be loaded by GES6 after the errors are corrected. 

The Database Checker tool uses the same parser as GES6 and can be used to verify the 
consistency and correctness of databases during development, before the databases are 
actually used.

Database Checker 

To globally set the default from GES6 back to GES5, go to the Options  window 
Global General Settings tab and click Version 5 for the Preferred Gibbs Energy 
System setting. The SET_GES_VERSION Console Mode command is used to 
change GES versions for a single Thermo-Calc session.  

Contact Thermo-Calc Software AB at info@thermocalc.com for more 
information about the changes or if you encounter any issues you think are 
related to the new version of the calculation engine. 

mailto:info@thermocalc.com
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Database Installation Folder

The standard Thermo-Calc databases and the database initialization file tc_initd.tdb are 
located in a subfolder to the Thermo-Calc installation. For example, in a Windows 
Standalone installation, you can find these in a folder called data where the file path is 
C:\Program Files\Thermo-Calc\<version>\data.
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About Cached Database Files

This is applicable to Graphical Mode.

Also see Global Settings Global General Settings where you can set the default 
database directory path. There is also an option to clear the database cache, 
which may be helpful if you are having issues.

The first time you open a database in Graphical Mode it can take a little while for it to load, 
especially if it is one of the large databases such as TCFE or TCNI. However, the next time the 
database opens quickly because the databases are now cached, or stored, in Graphical 
Mode.

Think of a cache as an intermediate storage area. Once a database cache is 
established the file is made easily accessible, even if you close the software 
program. It is the same concept as when you load a web page for the first time. 
The next time the page opens faster. This is also how it works for the databases 
in Thermo-Calc Graphical Mode.

Thermo-Calc caches the database files, both encrypted and unencrypted types, at two 
points—when you first open a database, sometimes called an in-memory cache, and then as 
a disk-based cache. The disk-based cache is what speeds up database loading and it is at this 
point that Thermo-Calc refers to the database initialization file for information. The disk-
based cache uses a lookup key to find the abbreviated database name (e.g. TCFE or TCNI) 
contained in this initialization file.

It is important to understand the way databases are cached in Graphical Mode 
to ensure best practices for those who also use Console Mode, especially if the 
database initialization file is edited. If you plan to edit this file, see Editing the 
Database Initialization File or Unencrypted Database File.



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 88 of 129

Editing the Database Initialization File or Unencrypted 
Database File

Some advanced users may decide to edit the database initialization file, for example to 
reorder the list of encrypted databases displaying in the Console window or to add a user-
defined database for use in Console Mode. It is important to understand that changes to this 
file impact the database caching process used in Graphical Mode.

About the Database Files

About Cached Database Files

The following recommendations are also applicable if you edit an unencrypted database file, 
which includes user databases and free databases such as PURE5 or PG35.

Best Practice Recommendations

Database Installation Folder

If you edit the database initialization file (tc.initd.tdb in Windows or initd.tdb in Mac 
and Linux), then:

 l If a user database is added to the file, it is subject to the same caching as the 
encrypted databases. This means that further changes (to the user database) are not 
detected when you are working with databases in the System Definer in Graphical 
Mode.

If you have a user database, which is subject to regular updates, then:

 l If you make changes to a user database, you then need to clear the cache.
 l It is recommended that you create a separate directory to store unencrypted 

database files.

If you edit an unencrypted database file included with the installation (such as the PURE5 
and PG35 files):

 l Do not edit the file in the installation folder. Instead make a local copy and load it 
into the application as a user database.
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Database Checker

The Thermo-Calc software package includes a program to check that the syntax of 
unencrypted database files is correct. The program applies the syntax rules set out in the 
Database Manager User Guide and reports errors and issues warnings. This program is 
intended for advanced users who develop and manage databases. 

Thermo-Calc  accepts some deviations from these syntax rules. Although 
warnings can be ignored, errors must be corrected. Reported errors must be 
corrected in the TDB file before the database can be loaded by the application. 
Sometimes the warnings can also reveal the need for additional corrections as 
shown in the example below. 

For example,  a warning is generated if a phase name is detected that is also an abbreviation 
of another phase name in the database. Although allowed, it is not recommended as this 
can (in some cases) lead to unexpected results because abbreviations are also used  when 
entering commands in the Console and included in macro files. The following shows why in 
this case an abbreviation is not recommended. 

Imagine that a macro file uses the abbreviation ABC to refer to a phase in a database that is 
named ABCDE. As long as there is no other phase in the database with the same exact name 
or initial abbreviation, it works. But if a new phase is added to the database and is actually 
named ABC then the macro can in error refer to the wrong phase. The macro still runs but 
now refers to the phase ABC instead of ABCDE because ABC is an exact match, which takes 
precedence over abbreviations.  The Database Checker displays a warning because this 
situation can only occur when one phase name is an abbreviation of another.

With respect to using this tool, the executable DatabaseChecker file is found in the 
Thermo-Calc home directory. 

The program can also be launched by selecting Tools → Database Checker  from the main 
menu in Thermo-Calc.

Database Manager User Guide
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Global Settings
In the Options window you can globally set general settings for Graphical Mode as well as 
default settings for any new activities for both Graphical Mode and Console Mode. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

In this section:

Global General Settings 91

Graphical Mode: Default Units 96

Graphical Mode: Activities 98

Global Settings: System Definer 99

Global Settings: Equilibrium Calculator 101

Global Settings: Diffusion Calculator 102

Global Settings: Precipitation Calculator 103

Global Settings: Process Metallurgy 104

Global Settings: Scheil Calculator 105

Global Settings: Tables 106

Global Settings: Graphical and Console Mode Plotting 107

Global Plot Settings: Themes 110

Predefined Theme Settings 117

Global Plot Settings: Plot Area Size 120

Global Plot Settings: Design the Look and Feel 122

Global Settings: Console Mode Default Appearance 128
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Global General Settings

Make global changes to the various defaults used for the settings for both Graphical Mode 
and Console Mode. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the General tab.

TOOLTIPS ENABLED

Select whether to turn on tooltips information. By default the Tooltips enabled checkbox is 
selected. Hover the cursor above some buttons or other settings to display text with more 
information about the settings.  

LOCALIZATION

To change the GUI language from the Localization list choose English (the default), Swedish, 
Spanish, German, Russian, Chinese, Japanese, or French. 

LOOK AND FEEL

To change the Look and feel of the GUI layout, choose Light (the default) or Dark. 

For macOS, there are also the options macOS Light and macOS Dark. 
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The primary difference for the macOS themes is that the buttons and panels 
are a closer match to the Mac operating system. In addition, macOS Dark is 
darker than the standard Dark (more black than gray), although the macOS 
Light version is only slightly darker. It is recommended that users experiment 
with the options to determine which is best for your needs.

Also see Global Plot Settings: Design the Look and Feel for details about the 
Color switching options available and related to the Light and Dark modes. The 
use of these modes is also related to being able to right-click and access the Plot 
Properties options for local plots. See Changing the Plot Properties.

LOG LEVEL

Select the level and type of information to display in the Event Log window using the Log 
level slide bar. Choose from a Debug, Info (the default), Warning, or Error level of detail. 

DATABASE DIRECTORY

In the Database directory field, the default path is to the data directory where all the 
database files and data are located. Click Modify  to open the default folder to change this 
default but first review the important information below. 

MODIFYING THE DATABASE DIRECTORY PATH (GRAPHICAL MODE ONLY)

Important Note: Database Directory Path (Graphical Mode only)

When you open a database for the first time, it is stored in a cache (an intermediate storage 
area), that is maintained even if you close the program. This improves the speed of loading 
the next time you open that database. The cache is used for all databases that are listed in 
the database initialization file, typically all the standard databases that are included with 
Thermo-Calc.

If you modify your own user-defined database, or if you choose to edit an unencrypted 
database, it is recommended that you create a separate directory to store these database 
files. This way the most recent version of the user-defined or edited databases are loaded 
into the program when the System Definer is performed.



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 93 of 129

About the Database Files

MODEL DIRECTORY

In the Model directory field, this is the default file location where the predefined and 
custom Property Models (used with the Property Model Calculator or TC-Python) are saved 
and stored. Click Modify to open the default folder or to create a custom folder for your 
own models.

All Property Models (whether these are predefined or custom models) must be 
located in a subdirectory of the Property Model directory. For that reason it is 
recommended that you do not change the directory location.

See Property Model Calculator for information about using the predefined 
models. Also see the TC-Python help on the website for details about creating 
custom models.

TEMPORARY DIRECTORY

In the Temporary directory field this is the default file path to the temporary folder, where 
files are stored during calculation, such as Console Mode state files (e.g. State_
4064824901731140183.POLY3), log files, and so forth. 

Click Modify to open the default folder, which is set during installation and based on your 
operating system. 

PROPERTY MODEL PYTHON INTERPRETER

This is the path to the executable Python file that is needed to work with custom property 
models. 

See the Property Model Framework → Best Practices section in the TC-Python 
help on the website.

CHECK UPDATE INTERVAL

From the Check update interval list, choose Do not check (the default) or On startup. 

https://www2.thermocalc.com/docs/tc-python/latest-version/html/
https://www2.thermocalc.com/docs/tc-python/latest-version/html/
https://www2.thermocalc.com/docs/tc-python/latest-version/html/
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You can also manually check for updates – choose Help → Check for Updates.

PREFERRED GIBBS ENERGY SYSTEM

Use this setting to globally set the default GES version to be either  GES6 (Version 6 the 
default) or GES5 (Version 5).

About the Gibbs Energy System (GES) Module 

This setting is useful if you are using the POURBAIX module (aqueous solutions) 
or if you have a custom database that is not compatible with GES6. The SET_
GES_VERSION Console Mode command can also be used to change GES 
versions for a single Thermo-Calc session.  

Contact Thermo-Calc Software AB at info@thermocalc.com for more 
information about the changes or if you encounter any issues you think are 
related to the new version of the calculation engine. 

PARALLEL CALCULATION FOR PROPERTY MODEL CALCULATOR

By default, the Parallel calculation (Property Model Calculator Configuration window) and 
Parallel calculation for Property Model Calculator (Options window for a Global setting) 
checkbox is selected. 

The number of parallel branches (the No. of worker processes) can only be changed globally 
via the Options window.  The default number of worker processes is based on the number of 
physical cores available on the computer. You can adjust the number of worker processes as 
needed, however it is still dependent on the available cores on the computer. 

This checkbox is used for all the calculation types available with the Property Model 
Calculator in Graphical Mode. When you click Perform, the grid points calculated are 
distributed among these worker processes, which enables parallel calculations and speeds 
up the calculation. Click to deselect the checkbox as needed to not use these worker 
processes.

mailto:info@thermocalc.com
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RESET ALL SETTINGS AND THE DATABASE CACHE TO DEFAULTS

Click Factory reset to reset all the settings to the original defaults, including clearing the 
database cache. The changes are applied when Thermo-Calc is restarted. 

This may be useful when there are several versions of Thermo-Calc installed 
and there are conflicts between settings or loading databases becomes 
problematic. See About Cached Database Files.

RESET TO ORIGINAL SETTINGS

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.
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Graphical Mode: Default Units

Make global changes to the default units used for the settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode → Default Units tabs.

RESET TO ORIGINAL SETTINGS

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.

Setting Options

Temperature Kelvin (the default), Celsius, or Fahrenheit

Pressure Pascal (the default), Atmospheres, or Bar

Amount Mole (the default), Gram, Kilogram, Tonne, or Pound

Mass Tonne (the default), Kilogram, Gram, or Pound

Composition Mass percent (the default), Mole percent, Mass fraction, or Mole fraction
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Setting Options

Mass 
composition Mass percent (the default) or Mass fraction

Energy Joule (the default), Calorie, Electron volt, Gigajoule, Watt hour, or Kilowatt hour

Power Watt (the default), Kilowatt, or Megawatt

Volume Cubic meter (the default), Cubic decimeter, Cubic centimeter, or Normal cubic meter

Density Kilogram per cubic meter, Gram per cubic meter, Gram per cubic centimeter   (the default), or 
Pound per cubic inch. 

Heat capacity Joule per mole Kelvin (the default), Calorie per mole Kelvin, Joule per kilogram Kelvin, or 
BTU per pound Fahrenheit

Entropy Joule per Kelvin (the default), Calorie per Kelvin, or Electron volt per Kelvin

Dynamic viscosity Pascal-second (the default), milliPascal-second, Poise, or centiPoise

Kinematic 
viscosity Square meter per second (the default), Stokes, or Centistokes

Length Meter (the default), Millimeter, Micrometer, Nanometer, or Ångström

Time Seconds (the default), Minutes, Hours, or Days

Velocity m/s (the default), mm/s, μm/s, or nm/s

Strength Mega Pascal (the default) or Kilogram-force per square millimeter

Vickers hardness Mega Pascal (the default) or Kilogram-force per square millimeter

Surface tension Joule per m2 (the default) or Millijoule per m2

Surface energy Joule per m2 (the default) or Millijoule per m2
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Graphical Mode: Activities

Make global changes to the various defaults used for the settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode → Activities tabs.

Under Default Configurations, there are System definition, Calculation, Precipitation, 
Diffusion, Scheil, Process Metallurgy, Plotting, and Tabulation setting nodes. These are 
described individually.

 l Global Settings: System Definer
 l Global Settings: Equilibrium Calculator
 l Global Settings: Precipitation Calculator
 l Global Settings: Diffusion Calculator
 l Global Settings: Scheil Calculator
 l Global Settings: Process Metallurgy
 l Global Settings: Graphical and Console Mode Plotting
 l Global Settings: Tables
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Global Settings: System Definer

When you create a new System Definer, the default databases are taken from these 
defaults. The database selections for each System Definer can then be configured 
individually. Once created, the specific (local) settings for a System Definer are not affected 
if you later make changes to the global defaults.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the System definition node in the tree. 

System Definer

Creating a Database Package and Clearing a Database Package Message

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.

DEFAULT DATABASE SELECTION

The Default database selection can be either for a Database or a Database Package.
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 l If you choose Database, then select the default installed database to use globally for 
all System Definer nodes. For example, choose the latest version of the TCS Steel and 
Fe-alloys Database (TCFE) from the list if you have a license.

 l If you choose Database Package, select an option from the list. These Database 
Packages are defined in the Database Packages section described below.

USER DATABASES

Under User Databases, define the Database name after adding a custom database. 

Click Add to navigate to a custom database on your computer. After you have added the 
user database it is available from the list to choose as the default.

Once a user database is added to the Database name list, you can also click the Remove 
button to delete it from your project.

DATABASE PACKAGES

Based on the installed databases, there are also default Database Packages available. Use 
this section to organize your own sets of databases that you use together often.

Create and remove Database Packages by clicking the Add a database package  button or 
Remove this database package  button.

The addition or removal of a database package does not take effect until a new 
System Definer node is defined.

Click Show Details to display the list of databases included with the package. Click Hide 
Details to only display the name of the package. 

Creating a Database Package
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Global Settings: Equilibrium Calculator

When you create a new Equilibrium Calculator, its initial settings are taken from these 
defaults. The settings of each Equilibrium Calculator can then be configured individually. 
Once created, the specific (local) settings for an Equilibrium Calculator are not affected if 
you later make changes to the global defaults.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Calculation node in the tree. 

The available default settings are described in the topic Options Tab Settings.

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.
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Global Settings: Diffusion Calculator

When you create a new Diffusion Calculator, its initial settings are taken from these defaults. 
The settings for each Diffusion Calculator can then be configured individually. Once created, 
the specific (local) settings  are not affected if you later make changes to the global defaults.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Diffusion node in the tree.  

The available default settings are described in the topic  Options Tab Settings.

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 103 of 129

Global Settings: Precipitation Calculator

When you create a new Precipitation Calculator, some of its initial settings are taken from 
these defaults. The settings for each Precipitation Calculator can then be configured 
individually. Once created, the specific (local) settings for a Precipitation Calculator are not 
affected if you later make changes to the global defaults.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Precipitation node in the tree.  

The available default settings are described in the topics Matrix Phase Settings 
and Precipitate Phase Settings

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.
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Global Settings: Process Metallurgy

When you create a new Process Metallurgy Calculator, its initial settings are taken from 
these defaults. The settings for each Process Metallurgy Calculator can then be configured 
individually. Once created, the specific (local) settings  are not affected if you later make 
changes to the global defaults.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Graphical Mode  and Activities tabs, followed by the Process Metallurgy node 
in the tree. 

The available default settings are described in the topic Options Tab.

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.



Thermo-Calc Documentation Set

Thermo-Calc: General Reference ǀ 105 of 129

Global Settings: Scheil Calculator

When you create a new Scheil Calculator, its initial settings are taken from these defaults. 
The settings of each Scheil Calculator can then be configured individually. Once created, the 
specific (local) settings for a Scheil Calculator are not affected if you later make changes to 
the global defaults.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Scheil node in the tree.  

The available default settings are described in the topic Advanced Options.

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.
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Global Settings: Tables

When you create a new Table Renderer, its initial settings are taken from these default 
settings. The settings of each Table Renderer can then be configured individually. Once 
created, the settings of a Table Renderer are not affected by changes in the default settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Activities tab and the Tabulation node in the tree. 

Configuration Settings

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.
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Global Settings: Graphical and Console Mode Plotting

Globally configure several default plot settings or work with a Theme.

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

On the Options window you can access the same settings either from the Graphical Mode 
or Console Mode tabs.

 l Click the Graphical Mode → Activities tabs and then click the Plotting node in the 
tree, or 

 l Click the Console Mode  → Plotting tabs. 

The Console Mode and Graphical Mode plot settings are independent of each 
other once you start making changes to any predefined or custom Themes, or 
when applying changes to individual plots in either Mode.

There are many options available and these are generally divided into these topics:
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 l Global Plot Settings: Design the Look and Feel to set a variety of options for titles, 
legends, labels, fonts, colors, lines, grids, data points, anchors, data points, numbers, 
and to adjust image quality.

 l Global Plot Settings: Themes to create, edit, import, export, rename, or delete plot 
themes.

 l Global Plot Settings: Plot Area Size to set the Plot Area Size.

Global vs Local Plot Settings

For both Graphical Mode and Console  Mode, you can work with plots and themes from both 
the global or local settings windows. Global settings are accessed on the Options window 
and local plot settings from the Visualizations window when you right-click an individual 
plot and choose Properties.

Local Plot Property Settings

Plot Renderer (Graphical Mode)

When you create a new Plot Renderer in Graphical Mode, its initial settings are 
taken from the default settings and theme. The settings can then be configured 
individually. Once created, the settings of a Plot Renderer are not affected by 
changes to the default global settings unless you are working with themes and 
then save or create a custom theme. See Global Plot Settings: Themes.
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Visualizations Window Individual Plots (Graphical or Console Mode)

To make local changes to the appearance of a specific plot for either Graphical Mode or 
Console  Mode, in the Visualizations window right-click a plot and select Properties. In the 
Plot Properties window a variety of settings can be made. These are mostly the same 
settings as in the Options window.

You can also edit some properties for individual plot lines (the color, the line width and type, 
and whether data points are included). In the Visualizations window, hover the mouse over 
a plot line. The crosshair cursor turns into a cursor resembling a pointing hand when it is 
over a line that can be clicked. Alternatively, hold down the <Ctrl> key while you move the 
cursor around the plot to only display it as a crosshair and prevent unintended edits. 

When changes are made that differ from the plot theme applied (i.e. a predefined or custom 
theme) then blue text next to the theme section alerts you to the change. See Global Plot 
Settings: Themes for details.

Reset to Original Settings

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.
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Global Plot Settings: Themes

Make global changes to the various defaults used for the settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

On the Options window you can access the same settings either from the Graphical Mode 
or Console Mode tabs.

 l Click the Graphical Mode → Activities tabs and then click the Plotting node in the 
tree, or 

 l Click the Console Mode  → Plotting tabs. 

The Console Mode and Graphical Mode plot settings are independent of each 
other once you start making changes to any predefined or custom Themes, or 
when applying changes to individual plots in either Mode.

About Plot Themes

Location of Local and Global Theme Settings

Plot Theme settings are accessed in the Theme for plot settings section:

 l Locally on the Plot Properties window (right-click any plot in the Visualizations 
window). 

 l Globally on the Options window for both Graphical Mode and Console Mode.

Predefined Plot Themes

There are these predefined plot themes available: Default, Large, Small, or Publication. For 
these themes, you can use them as a template to create your own custom theme or export 
the json file for use elsewhere. 
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The predefined plot themes have many of the same settings where key differences include 
font sizes, plot area size and type, scaling, data point marker radius, tick mark length, and 
line width. For all predefined themes, the default font is SansSerif with the style Plain 
(normal). 

See Predefined Theme Settings for details and differences.

Custom Themes

You can create, edit, delete, rename, import, and export custom themes. 

Plotting Input is Changed: Ignore, Create, Update, or Discard the 
Changes

When any change is made to a predefined or custom theme, either locally or 
globally, a blue text message  under the Theme for plot settings section reminds 
you that at least one plotting input has changed. 

When you see this blue text you can:

 l Ignore it and apply the local changes to a specific plot. In this case when you click 
Perform or Perform Tree to update the plot in the Visualizations window the change 
only applies to this one plot. The blue text continues to be visible.

 l Create a new custom theme (click Save as). If this is done locally on the Plot 
Properties window, the new theme is added to the global list but only applied locally 
to the plot. The blue text is gone. 

 l Update an existing custom theme (click Save). If this is done on the Plot Properties 
window, the changes are applied globally and applied locally to the plot. The blue 
text is gone. 

 l Discard the changes and click Reset to original settings (for global Options windows 
you may need to scroll, it is in the bottom right of the window) or Reset (for local 
settings on the Plot Properties window). The blue text is gone.

Working with Plot Themes

Whether working with a predefined or custom theme, there are common tasks you can do 
such as using a theme as a template to create a new custom theme, or you can import and 
export .json files. 
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Once created, there is more flexibility with the custom themes. 

Applying Predefined or Custom Themes to a Plot Globally or Locally

 1. In the Theme for plot settings section, choose an option from the Theme list.

 2. Click OK to apply the theme. Click close (X) or Cancel to exit without saving, or Reset 
to revert any changes to the original saved settings. 

 l On the Options window this is applied globally.
 l On the Plot Properties window this is applied locally to the specific plot in the 

Visualizations window.

Applying Plot Themes to Project Files (Graphical Mode Only)

When opening project files, a predefined or custom plot theme can be automatically applied 
to all plots. There are two checkboxes that control this, one is a global setting and one is a 
local setting applied to a specific file as it is opened.

If you double-click or drag and drop to open a project file it automatically uses 
the global settings in Thermo-Calc (which may or may not be to apply a theme). 
This means you may inadvertently apply a theme to your plots without realizing 
it.

There is some interaction between these checkboxes as detailed in the table below.
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Checkbox Location Actions Comments

Apply the selected 
theme to opened 
file [.tcu]

Options 
window.

Select the checkbox to 
apply a theme globally 
to all project files 
being opened.

Click to clear the 
checkbox to allow 
each file to keep 
existing plot settings.

When this checkbox is selected or deselected, it 
also changes the Apply plot theme from 
Tools/Options checkbox to match, i.e. these are 
connected in one direction. 

Apply plot theme 
from 
Tools/Options

Open File 
window.

See Opening 
Project Files

Select the checkbox to 
apply a theme locally 
to the specific project 
file being opened. 

Click to clear the 
checkbox to allow the 
specific file to keep 
existing plot settings.

 If this checkbox is selected or deselected it only 
applies to the specific project file being opened, 
i.e. the Apply the selected theme to opened 
file [.tcu] checkbox does not change. 

If you have a project file with calculated results and local settings applied to 
plots i.e. applied from the Visualizations window to a specific plot via the Plot 
Properties settings window, then click to clear the local setting as you open the 
file using Apply plot theme from Tools/Options checkbox. Otherwise the 
default global settings are applied to all plots and you would need to 
individually change these settings back to your original design. Alternatively, 
experiment with applying a predefined theme, e.g. Publication, as this could be 
sufficient for your final output.

Creating a Custom Plot Theme in Thermo-Calc

To create a custom theme, you start by making changes to the selected theme type and 
then save it with a new name using the Save as option.
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You can work with themes from both the global or local settings windows. 
Global settings are accessed on the Options window (Windows: Tools →  
Options; Mac: Thermo-Calc <version> → Preferences) and local plot settings 
accessed from the Visualizations window when you right-click an individual plot 
and choose Properties. 

For example, the Background color is changed to RGB #FF4EE2 for the Default theme. Next 
to the Theme for plot settings section, a message in blue alerts you that at least one plotting 
input has changed.

To save the new settings including the change to the background color (you cannot replace 
the predefined themes), you also must make sure to click OK at the end.

HOW TO CREATE A CUSTOM PLOT THEME

 1. In the Theme for plot settings section, click Save as. The New theme plot setting 
window opens. 

 2. In the Theme name field enter the new custom theme name. The new theme is now 
available from the list.

 3. On the Plot Properties or Options window, click OK to finish. Click close (X) or Cancel 
to exit without saving, or Reset to revert any changes to the original saved settings.

Importing a Custom Theme

Use the Import option to add your own theme with the file type of *.json. Once the file is 
imported, you can make further changes and save the new theme settings as needed. If you 
import a theme that uses the same name one already in the list (e.g. Publication), the 
imported theme name is changed automatically by adding a number at the end of its name 
(e.g. Publication_1). You can then Rename the theme to give it a unique name.

HOW TO IMPORT A CUSTOM PLOT THEME
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 1. In the Theme for plot settings section, click Import. 

 2. Navigate to where you saved the .json file, select it, then click Open.

 3. During the import, and if there are incorrect input values, you are prompted with an 
error message describing the issue with the file. 

This could be for various reasons, such as entering a value that is not available (i.e. it 
is out of bounds), or the file contains information about an unavailable setting. In 
particular these settings must be correctly entered in the import file: font sizes, tie 
line, number of decimals, border width, data points marker radius, x and y axis tick 
marks length, and jpeg compression level. 

 4. If it is a successful import,  click Rename to give the theme a unique name.

 5. On the Plot Properties or Options window, click OK to finish. Click close (X) or Cancel 
to exit without saving, or Reset to revert any changes to the original saved settings.

Exporting a Theme

Use the Export option to export an existing theme or after creating a custom theme.

You can also export an existing theme, edit it in a text editor (making sure to 
save the file with file extension .json), and then Import this new .json file. 
However, it is better to use the Graphical User Interface to prepare your 
custom theme in order to minimize errors during import.

HOW TO EXPORT A PLOT THEME

 1. In the Theme for plot settings section, select the Theme to export. 

 2. Click Export. 

 3. Navigate to where you want to save the .json file. Enter a File name as required then 
click Save.

Deleting a Custom Theme

After you have created a custom theme, it can be deleted from the list. Predefined themes 
cannot be deleted.
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If the selected theme is deleted from the global Options section, and you open a project or 
plot that uses the now deleted theme, the default theme is selected but it includes the 
message in blue next to the section to remind you that at least one plotting input has 
changed. In the example the custom theme, BackgroundPink, was deleted at the global level 
but at the local level for the specific plot open in the Visualizations window the settings are 
retained and the message displays.

HOW TO DELETE A CUSTOM PLOT THEME

 1. In the Theme for plot settings section, select the Theme to delete. 

 2. Click Delete. 

 3. Click OK on the window that opens. 

 4. On the Plot Properties or Options window, click OK to finish. Click close (X) or Cancel 
to exit without saving, or Reset to revert any changes to the original saved settings.

Renaming a Custom Theme

After you have created or imported a custom theme, it can be renamed.  Predefined themes 
cannot be renamed.  

HOW TO RENAME A CUSTOM PLOT THEME

 1. In the Theme for plot settings section, select the custom Theme to rename. 

 2. Click Rename. 

 3. Enter the new name in the field. Click OK. 

 4. On the Plot Properties or Options window, click OK to finish. Click close (X) or Cancel 
to exit without saving, or Reset to revert any changes to the original saved settings.
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Predefined Theme Settings

The following lists the applied attributes for each of the predefined themes: Default, Large, 
Small, or Publication.

Global Plot Settings: Themes

Image Quality

Plot 
Setting Default Large Small Publication 

Default file 
format and 
DPI 

.png and Use 
default 
resolution 
(300 DPI)

.png and Use 
default resolution 
(400 DPI)

.png and Use 
default resolution 
(300 DPI)

.png and 600 DPI

Fonts, Style, Size, and Format

Plot Setting Default Large Small Publication 

Title font (SansSerif) and Style (Plain/normal). 
The size is different for each. 18 26 16 24 

Legend font (SansSerif) and Style (Plain/normal). 
The size is different for each 11 22 9 20 

Label font (SansSerif) and Style (Plain/normal). 
The size is different for each. 16 24 14 22 

Header font (SansSerif) and Style (Plain/normal). 
The size is different for each. 12 18 10 16 

X and Y Axis Label font (SansSerif) and Style 
(Plain/normal). The size is different for each. 18 28 16 26 

X and Y Axis Tick Label font (SansSerif) and Style 
(Plain/normal). The size is different for each. 14 24 12 22 

Title format, Label format, Axis label format (X- 
and Y-axis) Plain text
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Colors

Plot Setting Default Large Small Publication 

Title color, Legend color, Label color, Header 
color, Border color, Axis label color (X- and Y-
axis), Axis tick label color (X- and Y-axis) 

rgb ff000000

Legend background color, Background color, and 
Canvas color rgb ffffffff

Color option Vivid (in json file it is PlotColorOption 6)

Checkbox Selections

Selected = Yes

Plot Setting Default Large Small Publication 

Show grid No 

Show legend Yes 

Show anchor Yes 

Retain labels Yes 

Show header No 

Show tick labels (X- and Y-axis) Yes 

Tick marks outside (X- and Y-axis) Yes 

Plot Area Size

Plot Setting Default Large Small Publication 

Fit the plot area size to the enclosing window 
(selected), with the plot area height and width 
preset as indicated

400 x 400 700 x 700 400 x 400 
Not selected. By 
default it is 600 
x 600
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Plot Setting Default Large Small Publication 

Fit the plot area size to a square with a 
width/height of the enclosing window

Not selected (in json file it is 
plotAreaSizeType: Window_Fit)

Selected (in json 
file it is Square_
Fit)

Define the plot area size Not selected

Scale plot attributes using the system scaling 
factor yes

Other Settings

Plot Setting Default Large Small Publication 

Show every Nth tieline (only relevant for phase 
diagrams) 1

Border width 1

Data points marker None (in json file this is called Symbol and set to 0)

Legend phase caption style None (in json file it is set to 0)

Data points marker size (if you choose a data 
points marker symbol, then this is the default 
size applied) 

3 5 3 5

Tick mark length (X- and Y-axis) 6 8 4 6

Number of decimals 2

Numeric format Auto (in json file it is 2)

Line width 0 2 0 1
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Global Plot Settings: Plot Area Size

Make global changes to the various defaults used for the settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

On the Options window you can access the same settings either from the Graphical Mode 
or Console Mode tabs.

 l Click the Graphical Mode → Activities tabs and then click the Plotting node in the 
tree, or 

 l Click the Console Mode  → Plotting tabs. 

The Console Mode and Graphical Mode plot settings are independent of each 
other once you start making changes to any predefined or custom Themes, or 
when applying changes to individual plots in either Mode.

For local or global application, the default settings applied in the Plot Area Size section are 
initially based on the selected predefined theme. Once a custom theme is available from the 
list, these default settings can also be related to how the custom theme is set up.

See Predefined Theme Settings for details and differences between the 
predefined themes initially available in the list.

In the Plot Area Size section, choose an option.

Click Fit the plot area size to the enclosing window and as the Visualizations window is 
resized, the plot moves and adjusts at the same time. This setting is the default for the 
Default, Large, and Small themes.

Click Fit the plot area size to a square with a width/height of the enclosing window. With 
this option, the minimum value of the width and height of the Visualizations window is used 
as the dimension of the fixed plot area and in a square. 

Click Define the plot area size to enter a Plot area height and Plot area width (not 
applicable to triangular plots. The units are pixels and the size is kept as the size on the 
screen (96 dpi). This is the default for the Publication theme.
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For the predefined themes this is already set for each as indicated below. As needed, you 
can change these defaults for one plot or create a new theme.

 l Default and Small are set to 400 x 400
 l Large is set to 700 x 700
 l Publication is set to 600 x 600

Click to deselect the Scale plot attributes using the system scaling factor checkbox to scale 
all plot attributes (i.e. labels, font size, axes, tick marks, etc.) independently of the screen 
size and resolution. This maintains consistent attribute sizing between different plots.

The minimum value of the width and height of the Visualizations window, or the fixed plot is 
used for resizing, in the following parts of the plot:

 l X- and Y-axis label
 l Legend font
 l Tick label font
 l Tick mark length
 l Title
 l Header
 l Line width
 l Data point width
 l Experiment data size
 l Logo
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Global Plot Settings: Design the Look and Feel

Make global changes to the various defaults used for the settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

On the Options window you can access the same settings either from the Graphical Mode 
or Console Mode tabs.

 l Click the Graphical Mode → Activities tabs and then click the Plotting node in the 
tree, or 

 l Click the Console Mode  → Plotting tabs. 

The Console Mode and Graphical Mode plot settings are independent of each 
other once you start making changes to any predefined or custom Themes, or 
when applying changes to individual plots in either Mode.

The following global design settings are available for both Graphical Mode and Console  
Mode from the General tab or as indicated for the X-axis, Y-axis, and Image Quality tabs.

The plot settings listed below are grouped into these general categories

 l Titles, Legends, Headers, and Labels
 l Fonts and Colors
 l Lines and Grids
 l Data Points, Anchors, and Numbers
 l Image Quality
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Titles, Legends, Headers, and Labels

TITLE FORMAT, LABEL FORMAT, AND AXIS LABEL FORMAT

On the General tab (Title format and Label format) and the X-axis and Y-axis tabs (Axis 
label format) select Plain text (the default) or LaTeX formatted text.

For LaTeX formatted text you can use the LaTeX math text to enter text. See 
ADD_LABEL_TEXT and Plot Labels  for more details.

SHOW LEGEND

Select the Show legend checkbox to include a legend on the plot. By default no legend is 
displayed.

TICK MARK LENGTH, LOCATION, AND SHOW TICK LABELS

On the X-axis and Y-axis tabs, choose or enter a Tick mark length (6 is the default).

The defaults are to have the Tick marks outside the chart and to Show tick labels. Click to 
clear the checkboxes as required.

LEGEND PHASE CAPTION STYLE

For the Legend phase caption style, choose None, All, Constitution description, or Ordering 
description.

About Legend Styles

RETAIN LABELS

By default the Retain labels checkbox is selected. Plot labels are kept (retained) when plots 
are updated. It can be applied globally or locally to individual plots.
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SHOW HEADER

Click to select the Show header checkbox to display the basic details about the plot along 
the top. This includes the date and time the plot is generated, the database used, and the 
properties.

Fonts and Colors

COLOR SWITCHING

This is related to the Light and Dark look and feel modes set under Tools → Options then on 
the General tab. See Global General Settings. 

This section is about Global changes to the default output for all plots for any 
future project files. Global settings take effect for new project files and/or new 
plots added to existing projects. That is, the default setting only affects how the 
plots start out initially. Once a plot is created the settings are locked to the 
mode and can only be changed locally. 

You can locally change an existing plot in a project. See Changing the Plot 
Properties for details.

Select a Color switching option: Switch automatically between Light mode and Dark mode 
(the default), Always use Light mode colors, or Always use Dark mode colors.

Tie lines and invariant lines are the same color for both Light and Dark modes, 
i.e. these colors do not change. 
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Use the Color switching option to override the look and feel settings that may 
not be optimal. For example, when preparing a plot for publication, the Dark 
mode plot or line colors may not work well or do not follow a journal's 
guidelines. In other words, you can view and export the plot with Light mode 
color settings even though the interface is using Dark mode, and vice versa. 

FONTS: TITLE, LEGEND, LABEL, HEADER, AXIS LABEL, AND TICK LABEL

On the General tab (Title, Legend, Label, Header, and on the X-axis and Y-axis tabs (Axis 
Label, Tick Label, click Modify to edit the Font Name, Style, Size, and Color.

LEGEND BACKGROUND COLOR, BACKGROUND COLOR, CANVAS COLOR, BORDER COLOR

To change various background color attributes, click Modify to choose a color or enter a 
specific color.

Lines and Grids

SHOW GRID

Click to select the Show grid checkbox to include a grid on the plot. By default no grid is 
displayed.

SHOW EVERY NTH TIELINE

Tielines are only applicable to phase diagrams.

Choose an integer value ranging from 0 to 99.

COLOR OPTION (PLOT LINES)
For the for plot line colors, choose a Color option from the list: Legacy, Printer friendly, 
JFree chart, Pastel, Medium dark, Bright dark, Vivid, or Earth.
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This option is also available for specific plot lines. To change the color of an individual plot 
line double-click it in the Visualizations window and use the color palette to define it or 
enter a specific color.

BORDER WIDTH

Choose a plot Border width between 1 (thin, the default) and 10 (thick).

LINE WIDTH

For the plot line width, choose a Line width from the list. These options are also available for 
specific plot lines. To change an individual plot line width double-click it in the Visualizations 
window.

LINE TYPE

This option is only available for individual plot lines. To change an individual plot line type 
double-click it in the Visualizations window and choose a Line type from the list.

Data Points, Anchors, and Numbers

SHOW ANCHOR

Click to select the Show anchor checkbox. By default, an anchor between the label and the 
plot point is displayed.

DATA POINTS MARKER

From the Data points marker list, scroll to select a symbol to use to display the data points 
on plot lines. This option is also available for specific plot lines. To show data points on an 
individual plot line double-click it in the Visualizations window and select a symbol from the 
Marker list.

DATA POINTS MARKER SIZE

Choose the Data points marker size between 1 (small) and 10 (large). The default is 3.
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NUMBER OF DECIMALS

Choose the Number of decimals to display in the plot. The default is 2.

NUMERIC FORMAT

Choose the Numeric format to display in the plot Auto, Decimal, or Scientific.

Image Quality

Click the Image Quality tab to access the settings below.

Choose a Default file format: Portable Network Graphics .png (the default), Graphical 
Interchange Format .gif, Enhanced Windows Metafile .emf, Portable Document Format 
.pdf, PostScript .ps, Scalable Vector Graphics .svg, or Joint Photographic Experts Group
 .jpg.

The following settings are only available for .png and .jpg file formats.

To change the resolution of a *.png or *.jpg image, click to clear the Use default resolution 
checkbox. Then enter a numerical value in the Dots per inch (DPI) field. For .*jpg files, you 
can also use the slider to choose a number between 0 and 1 for the JPG quality. The default 
is 0.9. The lower the number, the smaller the file. 
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Global Settings: Console Mode Default Appearance 

Make global changes to the various defaults used for the settings. 

To open the Options window: 

 l Windows: Select Tools →  Options.
 l Mac: Select Thermo-Calc <version> → Preferences or Settings or press <⌘> on the 

keyboard.

then click the Console Mode → Default Appearance tabs.

To change these defaults for an individual  Console tab, in Console Mode, right-click the tab  
and select Properties. 

Reset to original settings: In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. You may have to scroll 
or expand the window to see the button. For local plot settings, there is a Reset 
button available instead.

CONSOLE NAME

The default Console name prefix is Console or enter another name to display as the tab 
label.
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BUFFER SIZE

The default Buffer size is 40,000. 

In Console Mode, sometimes the output overflows the window text buffer. This is how to 
increase the buffer size.

 1. In the Console window right-click the tab to edit. For example, if this is the first tab, it 
is labeled Console 1.

 2. Select Properties and either enter a number in the field or use the arrows to increase 
or decrease the Buffer size. 

FONTS: SYSTEM OUTPUT, COMMAND PROMPT, OR USER INPUT

Click Modify to open the Select Font window and makes changes to the Font Name, Style, 
Size, or choose from a variety of color options for the font as required. The Show only fonts 
that support Greek characters checkbox is selected by default. 

BACKGROUND COLOR

Click Modify to open the Select Color window to choose a background color for the Console 
Mode window where you enter commands.

DEFAULT DIRECTORY

Click Modify to change the default directory file path to where the various file types are 
saved.
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